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     [bookmark: pgfId-3426942]Introduction to the Cisco ASA FirePOWER Module 
      
      
 
     
 
 
    [bookmark: pgfId-3659774]The Cisco ASA FirePOWER module is a module that can be deployed on Cisco ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5512-X, ASA5515-X, ASA5516-X, ASA5525-X, ASA5545-X, ASA5555-X, ASA5585-X-SSP-10, ASA5585-X-SSP-20, ASA5585-X-SSP-40, ASA5585-X-SSP-60, and ISA3000 devices. The module is designed to help you handle network traffic in a way that complies with your organization’s security policy—your guidelines for protecting your network. A security policy may also include an acceptable use policy (AUP), which provides employees with guidelines of how they may use your organization’s systems.
 
    [bookmark: pgfId-3592894]This guide provides information about onbox configuration of the features and functionality of the ASA FirePOWER module, accessible via ASDM. The explanatory text, diagrams, and procedures in each chapter provide detailed information to help you navigate the user interface, maximize the performance of your system, and troubleshoot complications.
 
     
      
    
 
    
 
    [bookmark: pgfId-3640446]Note If you enable command authorization on the ASA that hosts the ASA FirePOWER module, you must log in with a user name that has privilege level 15 to see the ASA FirePOWER home, configuration, and monitoring pages. Read-only or monitor-only access to ASA FirePOWER pages other than the status page is not supported.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3617632]The topics that follow introduce you to the ASA FirePOWER module, describe its key components, and help you understand how to use this guide:
 
     
     	 [bookmark: pgfId-3617640]Introduction to the ASA FirePOWER Module
 
     	 [bookmark: pgfId-3617648]ASA FirePOWER Module Components
 
     	 [bookmark: pgfId-2661634]License Conventions
 
     	 [bookmark: pgfId-2934374]IP Address Conventions
 
    
 
   
 
    
     [bookmark: pgfId-3594610][bookmark: 70136]Introduction to the ASA FirePOWER Module
 
    [bookmark: pgfId-3594611]The ASA FirePOWER module runs on an ASA device installed on network segments monitor traffic for analysis.
 
    [bookmark: pgfId-3594612]Deployed inline, the system can affect the flow of traffic using access control, which allows you to specify, in a granular fashion, how to handle the traffic entering, exiting, and traversing your network. The data that you collect about your network traffic and all the information you glean from it can be used to filter and control that traffic based on:
 
     
     	 [bookmark: pgfId-3594613]simple, easily-determined transport and network layer characteristics: source and destination, port, protocol, and so on
 
     	 [bookmark: pgfId-3617744]the latest contextual information on the traffic, including characteristics such as reputation, risk, business relevance, application used, or URL visited
 
     	 [bookmark: pgfId-3617745]Microsoft Active Directory LDAP users in your organization
 
    
 
    [bookmark: pgfId-3594618]Each type of traffic inspection and control occurs where it makes the most sense for maximum flexibility and performance. For example, reputation-based blacklisting, because it uses simple source and destination data, can block prohibited traffic early in the process, while detecting and blocking intrusions and exploits is a last-line defense.
 
   
 
    
     [bookmark: pgfId-3619378][bookmark: 85784]ASA FirePOWER Module Components
 
    [bookmark: pgfId-3619382]The topics that follow describe some of the key capabilities of the ASA FirePOWER module that contribute to your organization’s security, acceptable use policy, and traffic management strategy:
 
     
     	 [bookmark: pgfId-3610424]Access Control
 
     	 [bookmark: pgfId-3610429]Intrusion Detection and Prevention
 
     	 [bookmark: pgfId-3380276]Advanced Malware Protection and File Control
 
     	 [bookmark: pgfId-3380284]Application Programming Interfaces
 
    
 
     
      [bookmark: pgfId-3380345][bookmark: 62508][bookmark: marker-3380324][bookmark: 22665][bookmark: 74363]Access Control
 
     [bookmark: pgfId-3610147]Access control is a policy-based feature that allows you to specify, inspect, and log the traffic that can traverse your network. An access control policy determines how the system handles traffic on your network. 
 
     [bookmark: pgfId-3610148]The simplest access control policy handles all traffic using its default action. You can set this default action to block or trust all traffic without further inspection, or to inspect traffic for intrusions.
 
     [bookmark: pgfId-3610158]A more complex access control policy can blacklist traffic based on Security Intelligence data, as well as use access control rules to exert granular control over network traffic logging and handling. These rules can be simple or complex, matching and inspecting traffic using multiple criteria; you can control traffic by security zone, network or geographical location, port, application, requested URL, and user. Advanced access control options include preprocessing and performance. 
 
     [bookmark: pgfId-3610219]Each access control rule also has an action, which determines whether you monitor, trust, block, or allow matching traffic. When you allow traffic, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.
 
    
 
     
      [bookmark: pgfId-3380356][bookmark: 64826][bookmark: 22716]Intrusion Detection and Prevention
 
     [bookmark: pgfId-3610532]Intrusion detection and prevention is the system’s last line of defense before traffic is allowed to its destination. Intrusion policies are defined sets of intrusion detection and prevention configurations invoked by your access control policy. Using intrusion rules and other settings, these policies inspect traffic for security violations and, in inline deployments, can block or alter malicious traffic. 
 
     [bookmark: pgfId-3610704]If the system-provided policies do not fully address the security needs of your organization, custom policies can improve the performance of the system in your environment and can provide a focused view of the malicious traffic and policy violations occurring on your network. By creating and tuning custom policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.
 
    
 
     
      [bookmark: pgfId-3422158][bookmark: 54741]Advanced Malware Protection and File Control
 
     [bookmark: pgfId-3422021]To help you identify and mitigate the effects of malware, the ASA FirePOWER module’s file control and advanced malware protection components can detect, track, capture, analyze, and optionally block the transmission of files (including malware files and nested files inside archive files) in network traffic.
 
     [bookmark: pgfId-3380364][bookmark: 72592]File Control
 
     [bookmark: pgfId-3380365]File control allows devices to detect and block your users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. You configure file control as part of your overall access control configuration; file policies associated with access control rules inspect network traffic that meets rule conditions.
 
     [bookmark: pgfId-3380366][bookmark: 43653]Network-Based Advanced Malware Protection (AMP)
 
     [bookmark: pgfId-3380367]Network-based advanced malware protection (AMP) allows the system to inspect network traffic for malware in several types of files. 
 
     [bookmark: pgfId-3485677]Regardless of whether you store a detected file, you can submit it to the Collective Security Intelligence Cloud for a simple known-disposition lookup using the file’s SHA-256 hash value. Using this contextual information, you can configure the system to block or allow specific files.
 
     [bookmark: pgfId-3393413]You configure malware protection as part of your overall access control configuration; file policies associated with access control rules inspect network traffic that meets rule conditions.
 
    
 
     
      [bookmark: pgfId-3380420][bookmark: 80259]Application Programming Interfaces
 
     [bookmark: pgfId-3538387]There are several ways to interact with the system using application programming interfaces (APIs). For detailed information, you can download additional documentation from either of the following Support Sites:
 
      
      	 [bookmark: pgfId-3538444] Cisco: ( http://www.cisco.com/cisco/web/support/index.html )
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3256954][bookmark: 29096]License Conve[bookmark: marker-3283623]ntions
 
    [bookmark: pgfId-3313248]The License statement at the beginning of a section indicates the license required to use the feature described in the section, as follows:
 
    [bookmark: pgfId-3391836]Protection
 
    [bookmark: pgfId-3391840]A Protection license allows devices to perform intrusion detection and prevention, file control, and Security Intelligence filtering.
 
    [bookmark: pgfId-3391844]Control
 
    [bookmark: pgfId-3391848]A Control license allows devices to perform user and application control. A Control license requires a Protection license.
 
    [bookmark: pgfId-3391856]URL Filtering
 
    [bookmark: pgfId-3391857]A URL Filtering license allows devices to use regularly updated cloud-based category and reputation data to determine which traffic can traverse your network, based on the URLs requested by monitored hosts. A URL Filtering license requires a Protection license.
 
    [bookmark: pgfId-3391868]Malware
 
    [bookmark: pgfId-3391872]A Malware license allows devices to perform network-based advanced malware protection (AMP), that is, to detect, capture, and block malware in files transmitted over your network. It also allows you to view trajectories, which track files transmitted over your network. A Malware license requires a Protection license.
 
    [bookmark: pgfId-3625228]Because licensed capabilities are often additive, this documentation only provides the highest required license for each feature. For example, if a feature requires Protection and Control licenses, only Control is listed. However, if functionality requires licenses that are not additive, the documentation lists them with a plus (+) character. 
 
    [bookmark: pgfId-3337906]An “or” statement in a License statement indicates that a particular license is required to use the feature described in the section, but an additional license can add functionality. For example, within a file policy, some file rule actions require a Protection license while others require a Malware license. So, the License statement for the documentation on file rules lists “Protection or Malware.”
 
   
 
    
     [bookmark: pgfId-3315385][bookmark: 65605]IP Address Conventi[bookmark: marker-3315384]ons
 
    [bookmark: pgfId-3288307]You can use IPv4 Classless Inter-Domain Routing (CIDR) notation and the similar IPv6 prefix length notation to define address blocks in many places in the ASA FirePOWER module.
 
     
      
       
       [bookmark: pgfId-2941102]Table 1-1 [bookmark: 10268]CIDR Notation Syntax Examples 
 
       
       
        
        	 
          
          [bookmark: pgfId-2941110]CIDR Block 
         
  
        	 
          
          [bookmark: pgfId-2941112]IP Addresses in CIDR Block 
         
  
        	 
          
          [bookmark: pgfId-2941114]Subnet Mask 
         
  
        	 
          
          [bookmark: pgfId-2941116]Number of IP Addresses 
         
  
       
 
        
        	[bookmark: pgfId-2941118]10.0.0.0/8
  
        	[bookmark: pgfId-2941120]10.0.0.0 - 10.255.255.255
  
        	[bookmark: pgfId-2941122]255.0.0.0
  
        	[bookmark: pgfId-2941124]16,777,216
  
       
 
        
        	[bookmark: pgfId-2941126]172.16.0.0/12
  
        	[bookmark: pgfId-2941128]172.16.0.0 - 172.31.255.255
  
        	[bookmark: pgfId-2941130]255.240.0.0
  
        	[bookmark: pgfId-2941132]1,048,576
  
       
 
        
        	[bookmark: pgfId-2941134]192.168.0.0/16
  
        	[bookmark: pgfId-2941136]192.168.0.0 - 192.168.255.255
  
        	[bookmark: pgfId-2941138]255.255.0.0
  
        	[bookmark: pgfId-2941140]65,536
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2935220]Similarly, IPv6 uses a network IP address combined with a prefix length to define the IP addresses in a specified block. For example, 2001:db8::/32 specifies the IPv6 addresses in the 2001:db8:: network with a prefix length of 32 bits, that is, 2001:db8:: through 2001:db8:ffff:ffff:ffff:ffff:ffff:ffff.
 
    [bookmark: pgfId-3288510]When you use CIDR or prefix length notation to specify a block of IP addresses, the ASA FirePOWER module uses only the portion of the network IP address specified by the mask or prefix length. For example, if you type 10.1.2.3/8, the ASA FirePOWER module uses 10.0.0.0/8.
 
    [bookmark: pgfId-2935228]In other words, although Cisco recommends the standard method of using a network IP address on the bit boundary when using CIDR or prefix length notation, the ASA FirePOWER module does not require it.
 
    [bookmark: pgfId-2660514]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7965447][bookmark: 17304]Managing Reusable Ob[bookmark: marker-7965445]jects 
      
      
 
     
 
 
    [bookmark: pgfId-7889016]For increased flexibility and ease-of-use, the ASA FirePOWER module allows you to create named objects, which are reusable configurations that associate a name with a value so that when you want to use that value, you can use the named object instead.
 
    [bookmark: pgfId-8059418]You can create the following types of objects:
 
     
     	 [bookmark: pgfId-8059419]network-based objects that represent IP addresses and networks, port/protocol pairs, security zones, and origin/destination country (geolocation) 
 
     	 [bookmark: pgfId-8059420]objects that help you handle traffic, including Security Intelligence feeds and lists, application filters, URLs, file lists, and intrusion policy variable sets 
 
    
 
    [bookmark: pgfId-7941981]You can use these objects in various places in the ASA FirePOWER module, including access control policies, network analysis policies, intrusion policies and rules, reports, dashboards, and so on.
 
    [bookmark: pgfId-8068569]Grouping objects allows you to reference multiple objects with a single configuration. You can group network, port, and URL objects.
 
     
      
    
 
    
 
    [bookmark: pgfId-7618623]Note In most cases, editing an object used in a policy requires a policy reapply for your changes to take effect. Editing a security zone also requires that you reapply the appropriate device configurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618624]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7618628]Using the Object Manager
 
     	 [bookmark: pgfId-7618632]Working with Network Objects
 
     	 [bookmark: pgfId-7618636]Working with Security Intelligence Lists and Feeds
 
     	 [bookmark: pgfId-7618640]Working with Port Objects
 
     	 [bookmark: pgfId-7618648]Working with URL Objects
 
     	 [bookmark: pgfId-7618652]Working with Application Filters
 
     	 [bookmark: pgfId-7618656]Working with Variable Sets
 
     	 [bookmark: pgfId-8207399]Working with Sinkhole Objects
 
     	 [bookmark: pgfId-7618660]Working with File Lists
 
     	 [bookmark: pgfId-7618664]Working with Security Zones
 
     	 [bookmark: pgfId-8207863]Working with Cipher Suite Lists
 
     	 [bookmark: pgfId-8207609]Working with Distinguished Name Objects
 
     	 [bookmark: pgfId-8194566]Working with PKI Objects
 
     	 [bookmark: pgfId-7618668]Working with Geolocation Objects
 
    
 
   
 
    
     [bookmark: pgfId-7618671][bookmark: 12440]Using the Object Mana[bookmark: marker-7618670]ger
 
    [bookmark: pgfId-7618672]License: Any
 
    [bookmark: pgfId-7618673]Create and manage objects, including application filters, variable sets, and security zones, using the object manager (Configuration > ASA FirePOWER Configuration > Object Management). You can group network, port, and URL objects; you can also sort, filter, and browse the list of objects and object groups.
 
    [bookmark: pgfId-7618679]For more information, see:
 
     
     	 [bookmark: pgfId-7618683]Grouping Objects
 
     	 [bookmark: pgfId-7618687]Browsing, Sorting, and Filtering Objects
 
    
 
     
      [bookmark: pgfId-7618694][bookmark: 94397]Grouping Obj[bookmark: marker-7618692]ects
 
     [bookmark: pgfId-7618695]License: Any
 
     [bookmark: pgfId-7618700]You can group network, port, and URL objects. The system allows you to use objects and object groups interchangeably. For example, anywhere you would use a port object, you can also use a port object group. Objects and object groups of the same type cannot have the same name.
 
     [bookmark: pgfId-7934983]When you edit an object group used in a policy (for example, a network object group used in an access control policy), you must reapply the policy for your changes to take effect.
 
     [bookmark: pgfId-7618702]Deleting a group does not delete the objects in the group, just their association with each other. Additionally, you cannot delete a group that is in use. For example, you cannot delete a URL group that you are using in a URL condition in a saved access control policy.
 
     [bookmark: pgfId-7618703]To group reusable objects:
 
     
 
     [bookmark: pgfId-7618705]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-7618706]The Object Management page appears.
 
     [bookmark: pgfId-8059540]Step 2 Under the type of Network, Port, or URL object you want to group, select Object Groups.
 
     [bookmark: pgfId-7618708]The page for the type of object you are grouping appears.
 
     [bookmark: pgfId-8059560]Step 3 Click the Add button that corresponds with the object you want to group.
 
     [bookmark: pgfId-7618710]A pop-up window appears where you can create the group.
 
     [bookmark: pgfId-7618715]Step 4 Type a Name for the group. You can use any printable standard ASCII characters except curly braces ({}).
 
     [bookmark: pgfId-7618716]Step 5 Select one or more objects and click Add.
 
      
       
       	 [bookmark: pgfId-7618717]Use Shift and Ctrl to select multiple objects, or right-click and  Select All . 
 
       	 [bookmark: pgfId-7618721]Use the filter field (
 
      
 
      [image: ] ) to search for existing objects to include, which updates as you type to display matching items. Click the reload icon ( 
      [image: ] ) above the search field or click the clear icon ( 
      [image: ] ) in the search field to clear the search string. 
     
 
      
       
       	 [bookmark: pgfId-7618731]Click the add icon (
 
      
 
      [image: ] ) to create objects on the fly if no existing objects meet your needs. 
     
 
     [bookmark: pgfId-7618732]Step 6 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-7618733]The group is created.
 
     [bookmark: pgfId-7994436]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7618736][bookmark: 20396]Browsing, Sorting, and F[bookmark: marker-7618735]iltering Objects
 
     [bookmark: pgfId-7618737]License: Any
 ) to refresh your view. 
     
 ) arrow next to a column heading indicates that the page is sorted by that column in that direction. You can also filter the objects on the page by name or value. 
     
 
     [bookmark: pgfId-7618753]To sort objects or groups:
 
     
 
     [bookmark: pgfId-7618755]Step 1 Click a column heading. To sort in the opposite direction, click the heading again.
 
     [bookmark: pgfId-7994486]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7618756]To filter objects or groups:
 
     
 
     [bookmark: pgfId-7618758]Step 1 Type your filter criteria in the Filter field.
 
     [bookmark: pgfId-7618759]The page updates as you type to display matching items. The field accepts one or more asterisks (*) as wild cards.
 
     [bookmark: pgfId-7994502]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7618763][bookmark: 30722]Working with Network [bookmark: marker-7618761]Objects
 
    [bookmark: pgfId-7618764]License: Any
 
    [bookmark: pgfId-7618766]A network object represents one or more IP addresses that you can specify either individually or as address blocks. You can use network objects and groups (see Grouping Objects) in various places in the ASA FirePOWER module, including access control policies, network variables, intrusion rules, reports, and so on.
 
    [bookmark: pgfId-7618771]You also cannot delete a network object that is in use. Additionally, after you edit a network object used in an access control or intrusion policy, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7618772]To create a network object:
 
    
 
    [bookmark: pgfId-7618774]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-7618775]The Object Management page appears.
 
    [bookmark: pgfId-7618776]Step 2 Under Network, select Individual Objects.
 
    [bookmark: pgfId-7618777]Step 3 Click Add Network.
 
    [bookmark: pgfId-7618778]The Network Objects pop-up window appears.
 
    [bookmark: pgfId-7618783]Step 4 Type a Name for the network object. You can use any printable standard ASCII characters except curly braces ({}).
 
    [bookmark: pgfId-7618784]Step 5 For each IP address or address block you want to add to the network object, type its value and click Add.
 
    [bookmark: pgfId-7618785]Step 6 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-7618786]The network object is added.
 
    [bookmark: pgfId-7994540]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7618790][bookmark: 30903]Working with Security Int[bookmark: marker-7618788]elligence Lists and Feeds
 
    [bookmark: pgfId-7618794]License: Protection
 
    [bookmark: pgfId-7618804]The Security Intelligence feature allows you to, per access control policy, specify the traffic that can traverse your network based on the source or destination IP address. This is especially useful if you want to blacklist — deny traffic to and from — specific IP addresses, before the traffic is subjected to analysis by access control rules. Similarly, you can add IP addresses to the whitelist to force the system to handle their connections using access control.
 
    [bookmark: pgfId-7618805]If you are not sure whether you want to blacklist a particular IP address, you can use a “monitor-only” setting, which allows the system to handle the connection using access control, but also logs the connection’s match to the blacklist.
 
    [bookmark: pgfId-7618807]A [bookmark: marker-7618806]global whitelist and global blacklist are included by default in every access control policy, and apply to any zone. Additionally, within each access control policy, you can build a separate whitelist and blacklist using a combination of network objects and groups as well as Security Intelligence lists and feeds, all of which you can constrain by security zone.
 
    [bookmark: pgfId-7618815]Comparing Feeds and Lists
 
    [bookmark: pgfId-7618816]A Security Intelligence feed is a dynamic collection of IP addresses that the system downloads from an HTTP or HTTPS server at the interval you configure. Because feeds are regularly updated, the system can use up-to-date information to filter your network traffic. To help you build blacklists, the ASA FirePOWER module provides the Intelligence Feed, which represents IP addresses determined by the VRT to have a poor reputation.
 
    [bookmark: pgfId-7618832]Although it may take a few minutes for a feed update to take effect, you do not have to reapply access control policies after you create or modify a feed, or after a scheduled feed update. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7618836]Note If you want strict control over when the system downloads a feed from the Internet, you can disable automatic updates for that feed. However, Cisco recommends that you allow automatic updates. Although you can manually perform on-demand updates, allowing the system to download feeds on a regular basis provides you with the most up-to-date, relevant data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618840]A Security Intelligence list, contrasted with a feed, is a simple static list of IP addresses that you manually upload to the system. Use custom lists to augment and fine-tune feeds and the global whitelist and blacklist. Note that editing custom lists (as well as editing network objects and removing IP addresses from the global whitelist or blacklist) require an access control policy apply for your changes to take effect.
 
    [bookmark: pgfId-7618844]Formatting and Corrupt Feed Data
 
    [bookmark: pgfId-7618845]Feed and list source must be a simple text file no larger than 500MB, with one IP address or address block per line. Comment lines must start with the # character. List source files must use the .txt extension.
 
    [bookmark: pgfId-8098277]If the system downloads a corrupt feed or a feed with no recognizable IP addresses, the system continues using the old feed data (unless it is the first download). However, if the system can recognize even one IP address in the feed, it updates the addresses it can recognize.
 
    [bookmark: pgfId-7618858]Internet Ac[bookmark: marker-7618857]cess and High Availability
 
    [bookmark: pgfId-7618862]The system uses port 443/HTTPS to download the Intelligence Feed, and either 443/HTTP or 80/HTTP to download custom or third-party feeds. To update feeds, you must open the appropriate port, both inbound and outbound, on the device. If your system does not have direct access to the feed site, it can use a proxy server.
 
     
      
    
 
    
 
    [bookmark: pgfId-7618875]Note The system does not perform peer SSL certificate verification when downloading custom feeds, nor does the system support the use of certificate bundles or self-signed certificates to verify the remote peer.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618895]Managing Feeds and Lists
 
    [bookmark: pgfId-7618896]You create and manage Security Intelligence lists and feeds, collectively called Security Intelligence objects, using the object manager’s Security Intelligence page. (For information on creating and managing network objects and groups, see Working with Network Objects.)
 
    [bookmark: pgfId-7618904]Note that you cannot delete a custom list or feed that is currently being used in a saved or applied access control policy. You also cannot delete a global list, although you can remove individual IP addresses. Similarly, although you cannot delete the Intelligence Feed, editing it allows you to disable or change the frequency of its updates.
 
    [bookmark: pgfId-7618908]Security Intelligence Object Quick Reference
 
     
      
       
       [bookmark: pgfId-7618916]Table 2-1 [bookmark: 29847]Security Intelligence Object Capabilities 
 
       
       
        
        	 
          
          [bookmark: pgfId-7618928]Capability 
         
  
        	 
          
          [bookmark: pgfId-7618930]Global Whitelist or Blacklist 
         
  
        	 
          
          [bookmark: pgfId-7618932]Intelligence Feed 
         
  
        	 
          
          [bookmark: pgfId-7618934]Custom Feed 
         
  
        	 
          
          [bookmark: pgfId-7618936]Custom List 
         
  
        	 
          
          [bookmark: pgfId-7618938]Network Object 
         
  
       
 
        
        	[bookmark: pgfId-7618940]method of use
  
        	[bookmark: pgfId-7618942]in access control policies by default
  
        	 [bookmark: pgfId-7618944]in any access control policy as either a whitelist or blacklist object
  
       
 
        
        	[bookmark: pgfId-7618952]can be constrained by security zone?
  
        	[bookmark: pgfId-7618954]no
  
        	[bookmark: pgfId-7618956]yes
  
        	[bookmark: pgfId-7618958]yes
  
        	[bookmark: pgfId-7618960]yes
  
        	[bookmark: pgfId-7618962]yes
  
       
 
        
        	[bookmark: pgfId-7618964]can be deleted?
  
        	[bookmark: pgfId-7618966]no
  
        	[bookmark: pgfId-7618968]no
  
        	 [bookmark: pgfId-7618970]yes, unless currently being used in a saved or applied access control policy
  
       
 
        
        	[bookmark: pgfId-7618976]object manager edit capabilities
  
        	[bookmark: pgfId-7618978]delete IP addresses only
  
        	[bookmark: pgfId-7618980]disable or change update frequency
  
        	[bookmark: pgfId-7618982]fully modify
  
        	[bookmark: pgfId-7618984]upload a modified list only
  
        	[bookmark: pgfId-7618986]fully modify
  
       
 
        
        	[bookmark: pgfId-7618988]requires access policy control reapply when modified?
  
        	[bookmark: pgfId-7618990]yes when deleting (adding IP addresses does not require reapply)
  
        	[bookmark: pgfId-7618992]no
  
        	[bookmark: pgfId-7618994]no
  
        	[bookmark: pgfId-7618996]yes
  
        	[bookmark: pgfId-7618998]yes
  
       
 
       
     
 
    
 
    [bookmark: pgfId-7619000]For more information on creating, managing, and using Security Intelligence lists and feeds, see:
 
     
     	 [bookmark: pgfId-7619004]Working with the Global Whitelist and Blacklist
 
     	 [bookmark: pgfId-7619008]Working with the Intelligence Feed
 
     	 [bookmark: pgfId-7619012]Working with Custom Security Intelligence Feeds
 
     	 [bookmark: pgfId-7619016]Manually Updating Security Intelligence Feeds
 
     	 [bookmark: pgfId-7619020]Working with Custom Security Intelligence Lists
 
     	 [bookmark: pgfId-7619024]Blacklisting Using Security Intelligence IP Address Reputation
 
    
 
     
      [bookmark: pgfId-7619027][bookmark: 80956]Working with the Global W[bookmark: marker-7619026]hitelist and Blacklist
 
     [bookmark: pgfId-7619031]License: Protection
 
     [bookmark: pgfId-7619041]The system’s global whitelist and blacklist are included by default in every access control policy, and apply to any zone. You can opt not to use these global lists on a per-policy basis. 
 
     [bookmark: pgfId-7619045]You do not have to reapply access control policies after adding an IP address to a global list. Conversely, after you delete IP addresses from the global whitelist or blacklist, you must apply your access control policies for your changes to take effect.
 
     [bookmark: pgfId-7619046]Note that although you can add network objects with a netmask of /0 to the whitelist or blacklist, address blocks using a /0 netmask in those objects will be ignored and whitelist and blacklist filtering will not occur based on those addresses. Address blocks with a /0 netmask from security intelligence feeds will also be ignored. If you want to monitor or block all traffic targeted by a policy, use an access control rule with the Monitor or Block rule action, respectively, and a default value of any for the Source Networks and Destination Networks, instead of security intelligence filtering.
 
     [bookmark: pgfId-7619077]To remove IP addresses from the global whitelist or blacklist:
 
     
 ). 
     
 
     [bookmark: pgfId-7619083]The Global Whitelist or Global Blacklist pop-up window appears.
 ). 
     
 
     [bookmark: pgfId-7619092]To delete multiple IP addresses at once, use the Shift and Ctrl keys to select them, then right-click and select Delete.
 
     [bookmark: pgfId-7619093]Step 3 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-7619094]Your changes are saved, but you must apply your access control policies for them to take effect
 
     [bookmark: pgfId-7994599]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619100][bookmark: 77067]Working with the [bookmark: marker-7619099]Intelligence Feed
 
     [bookmark: pgfId-7619104]License: Protection
 
     [bookmark: pgfId-7619119]To help you build blacklists, the ASA FirePOWER module provides the Intelligence Feed, which is comprised of several regularly updated lists of IP addresses determined by the VRT to have a poor reputation. Each list in the feed represents a specific category: open relays, known attackers, bogus IP addresses (bogon), and so on. In an access control policy, you can blacklist any or all of the categories. 
 
     [bookmark: pgfId-7619120]Because the intelligence feed is regularly updated, the system can use up-to-date information to filter your network traffic. Malicious IP addresses that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies.
 
     [bookmark: pgfId-7619124]Although you cannot delete the Intelligence Feed, editing it allows you to change the frequency of its updates. By default, the feed updates every two hours.
 
     [bookmark: pgfId-7619125]To modify the intelligence feed’s update frequency:
 
     
 ). 
     
 
     [bookmark: pgfId-7619137]The Security Intelligence pop-up window appears.
 
     [bookmark: pgfId-7619142]Step 2 Edit the Update Frequency.
 
     [bookmark: pgfId-7619143]You can select from various intervals from two hours to one week. You can also disable feed updates.
 
     [bookmark: pgfId-7619144]Step 3 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-7619145]Your changes are saved.
 
     [bookmark: pgfId-7994615]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619147][bookmark: 83849]Working with Custom Security Intelligence Feeds
 
     [bookmark: pgfId-7619151]License: Protection
 
     [bookmark: pgfId-8126144]Custom or third-party Security Intelligence feeds allow you to augment the Intelligence Feed with other regularly-updated reputable whitelists and blacklists on the Internet. You can also set up an internal feed.
 
     [bookmark: pgfId-8126145]When you configure a feed, you specify its location using a URL; the URL cannot be Punycode-encoded. By default, the system downloads the entire feed source on the interval you configure.
 
     [bookmark: pgfId-7619171]Optionally, you can configure the system to use an md5 checksum to determine whether to download an updated feed. If the checksum has not changed since the last time the module downloaded the feed, the system does not need to re-download it. You may want to use md5 checksums for internal feeds, especially if they are large. The md5 checksum must be stored in a simple text file with only the checksum. Comments are not supported.
 
     [bookmark: pgfId-7619175]To configure a Security Intelligence feed:
 
     
 
     [bookmark: pgfId-7619177]Step 1 On the object manager’s Security Intelligence page, click Add Security Intelligence.
 
     [bookmark: pgfId-7619178]The Security Intelligence pop-up window appears.
 
     [bookmark: pgfId-7619183]Step 2 Type a Name for the feed. You can use any printable standard ASCII characters except curly braces ({}).
 
     [bookmark: pgfId-7619184]Step 3 From the Type drop-down list, specify that you want to configure a Feed.
 
     [bookmark: pgfId-7619185]The pop-up window updates with new options.
 
     [bookmark: pgfId-7619190]Step 4 Specify a Feed URL and optionally, an MD5 URL.
 
     [bookmark: pgfId-7619191]Step 5 Select an Update Frequency.
 
     [bookmark: pgfId-7619192]You can select from various intervals from two hours to one week. You can also disable feed updates.
 
     [bookmark: pgfId-7619193]Step 6 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-7619194]The Security Intelligence feed object is created. Unless you disabled feed updates, the system attempts to download and verify the feed. You can now use the feed object in access control policies.
 
     [bookmark: pgfId-7994656]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619199][bookmark: 75247]Manually Updating Security Intelligence Feeds
 
     [bookmark: pgfId-7619203]License: Protection
 
     [bookmark: pgfId-7917992]Manually updating Security Intelligence feeds updates all feeds, including the Intelligence Feed.
 
     [bookmark: pgfId-7917996]To update all Security Intelligence feeds:
 
     
 
     [bookmark: pgfId-7619218]Step 1 On the object manager’s Security Intelligence page, click Update Feeds.
 
     [bookmark: pgfId-7619219]Step 2 Confirm that you want to update all feeds.
 
     [bookmark: pgfId-7619220]A confirmation dialog appears, warning you that it can take several minutes for the update to take effect.
 
     [bookmark: pgfId-7619221]Step 3 Click OK.
 
     [bookmark: pgfId-7619225]After the system downloads and verifies the feed updates, it begins filtering traffic using the updated feeds.
 
     [bookmark: pgfId-7994675]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619228][bookmark: 96122]Working with Custom [bookmark: marker-7619227]Security Intelligence Lists
 
     [bookmark: pgfId-7619232]License: Protection
 
     [bookmark: pgfId-7619241]A Security Intelligence list is a simple static list of IP addresses and address blocks that you manually upload. Custom lists are useful if you want to augment and fine-tune feeds or one of the global lists.
 
     [bookmark: pgfId-7619248]Note that netmasks for address blocks can be integers from 0 to 32 or 0 to 128, for IPv4 and IPv6, respectively. 
 
     [bookmark: pgfId-7619249]For example, if a reputable feed improperly blocks your access to vital resources but is overall useful to your organization, you can create a custom whitelist that contains only the improperly classified IP addresses, rather than removing the Security Intelligence feed object from the access control policy’s blacklist.
 
     [bookmark: pgfId-7619250]Note that to modify a Security Intelligence list, you must make your changes to the source file and upload a new copy. For more information, see Updating a Security Intelligence List.
 
     [bookmark: pgfId-7619257]To upload a new Security Intelligence list:
 
     
 
     [bookmark: pgfId-7619259]Step 1 On the object manager’s Security Intelligence page, click Add Security Intelligence.
 
     [bookmark: pgfId-7619260]The Security Intelligence pop-up window appears.
 
     [bookmark: pgfId-7619265]Step 2 Type a Name for the list. You can use any printable standard ASCII characters except curly braces ({}).
 
     [bookmark: pgfId-7619266]Step 3 From the Type drop-down list, specify that you want to upload a List.
 
     [bookmark: pgfId-7619267]The pop-up window updates with new options.
 
     [bookmark: pgfId-7619272]Step 4 Click Browse to browse to the list .txt file, then click Upload.
 
     [bookmark: pgfId-7619273]The list is uploaded. The pop-up window displays the total number of IP addresses and address blocks that the system found in the list.
 
     [bookmark: pgfId-7619278]If the number is not what you expected, check the formatting of the file and try again.
 
     [bookmark: pgfId-7619279]Step 5 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-7619280]The Security Intelligence list object is saved. You can now use it in access control policies.
 
     [bookmark: pgfId-7994706]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619282][bookmark: 66859]Updating a Security Intelligence List
 
     [bookmark: pgfId-7619286]License: Protection
 
     [bookmark: pgfId-7619295]To edit a Security Intelligence list, you must make your changes to the source file and upload a new copy. You cannot modify the file’s contents using ASDM. If you do not have access to the source file, you can download a copy using the ASDM interface.
 
     [bookmark: pgfId-7619302]To modify a Security Intelligence list:
 
     
 ). 
     
 
     [bookmark: pgfId-7619308]The Security Intelligence pop-up window appears.
 
     [bookmark: pgfId-7619313]Step 2 If you need a copy of the list to edit, click Download, then follow the prompts to save the list as a text file.
 
     [bookmark: pgfId-7619314]Step 3 Make changes to the list as necessary.
 
     [bookmark: pgfId-7619315]Step 4 On the Security Intelligence pop-up window, click Browse to browse to the modified list, then click Upload.
 
     [bookmark: pgfId-7619316]The list is uploaded.
 
     [bookmark: pgfId-7619317]Step 5 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-7619318]Your changes are saved. If the list is being used by an active access control policy, you must apply the policy for your changes to take effect.
 
     [bookmark: pgfId-7994722]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7619322][bookmark: 41283]Working wi[bookmark: marker-7619321]th Port Objects
 
    [bookmark: pgfId-7619323]License: Any
 
    [bookmark: pgfId-7619324]Port objects represent different protocols in slightly different ways:
 
     
     	 [bookmark: pgfId-7619326]For TCP and UDP, a port object represents the transport layer protocol, with the protocol number in parentheses, plus an optional associated port or port range. For example:  TCP(6)/22 . 
 
     	 [bookmark: pgfId-7619327]For ICMP and ICMPv6 (IPv6-ICMP), the port object represents the internet layer protocol plus an optional type and code. For example:  ICMP(1):3:3 . 
 
     	 [bookmark: pgfId-7619328]A port object can also represent other protocols that do not use ports. 
 
    
 
    [bookmark: pgfId-7619332]Note that the system provides default port objects for well-known ports. You can modify or delete these objects, but Cisco recommends that you create custom port objects instead. 
 
    [bookmark: pgfId-7619339]You can use port objects and groups (see Grouping Objects) in various places in the ASA FirePOWER module, including access control policies and port variables, and event searches.
 
    [bookmark: pgfId-7619340]You cannot delete a port object that is in use. Additionally, after you edit a port object used in an access control, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7619341]Note that you cannot add any protocol other than TCP or UDP for source port conditions in access control rules. Also, you cannot mix transport protocols when setting both source and destination port conditions in a rule. 
 
    [bookmark: pgfId-7619342]If you add an unsupported protocol to a port object group used in a source port condition, the rule where it is used does not apply on policy apply. Additionally, if you create a port object containing both TCP and UDP ports, then add it as a source port condition in a rule, you cannot add a destination port, and vice versa. 
 
    [bookmark: pgfId-7619343]To create a port object:
 
    
 
    [bookmark: pgfId-7619345]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-7619346]The Object Management page appears.
 
    [bookmark: pgfId-7619347]Step 2 Under Port, select Individual Objects.
 
    [bookmark: pgfId-7619348]Step 3 Click Add Port.
 
    [bookmark: pgfId-7619349]The Port Objects pop-up window appears.
 
    [bookmark: pgfId-7619354]Step 4 Type a Name for the port object. You can use any printable standard ASCII characters except curly braces ({}).
 
    [bookmark: pgfId-7619355]Step 5 Select a Protocol.
 
    [bookmark: pgfId-7619356]You can quickly select TCP, UDP, IP, ICMP, or IPv6-ICMP, or you can use the Other drop-down list to select either a different protocol or All protocols.
 
    [bookmark: pgfId-7619357]Step 6 Optionally, restrict a TCP or UDP port object using a Port or port range.
 
    [bookmark: pgfId-7619358]You can specify any port from 1 to 65535 or any to match all ports. Use a hyphen to specify a range of ports.
 
    [bookmark: pgfId-7619359]Step 7 Optionally, restrict an ICMP or IPV6-ICMP port object using a Type and, if appropriate, a related Code. 
 
    [bookmark: pgfId-7619360]When you create an ICMP or IPv6-ICMP object, you can specify the type and, if applicable, the code. For more information on ICMP types and codes, see http://www.iana.org/assignments/icmp-parameters/icmp-parameters.xml and http://www.iana.org/assignments/icmpv6-parameters/icmpv6-parameters.xml. You can set the type to any to match any type or set the code to any to match any code for the specified type.
 
    [bookmark: pgfId-7619363]Step 8 Optionally, select Other and a protocol from the drop-down list. If you select All protocols, type a port number in the Port field. 
 
    [bookmark: pgfId-7619364]Step 9 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-7619365]The port object is added.
 
    [bookmark: pgfId-7994738]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619396][bookmark: 19424][bookmark: 85339]Working with URL Obj[bookmark: marker-7619395]ects
 
    [bookmark: pgfId-7619397]License: Any
 
    [bookmark: pgfId-7619407]Each URL object you configure represents a single URL or IP address. You can use URL objects and groups (see Grouping Objects) in access control policies. For example, you could write an access control rule that blocks a specific URL.
 
    [bookmark: pgfId-7619411]Note that to block HTTPS traffic, you can enter the URL from the Secure Sockets Layer (SSL) certificate for the traffic. When entering a URL from a certificate, enter the domain name and omit subdomain information. (For example, type example.com rather than www.example.com.) If you block traffic based on the certificate URL, both HTTP and HTTPS traffic to that website are blocked. 
 
    [bookmark: pgfId-7619412]You cannot delete a URL object that is in use. Additionally, after you edit a URL object used in an access control policy, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7619413]To add a URL object:
 
    
 
    [bookmark: pgfId-7619415]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-7619416]The Object Management page appears.
 
    [bookmark: pgfId-7619417]Step 2 Under URL, select Individual Objects.
 
    [bookmark: pgfId-7619418]Step 3 Click Add URL.
 
    [bookmark: pgfId-7619419]The URL Objects pop-up window appears.
 
    [bookmark: pgfId-7619424]Step 4 Type a Name for the URL object. You can use any printable standard ASCII characters except curly braces ({}).
 
    [bookmark: pgfId-7619425]Step 5 Type the URL or IP address for the URL object.
 
    [bookmark: pgfId-7619426]Step 6 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-7619427]The URL object is added.
 
    [bookmark: pgfId-7994892]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619431][bookmark: 11726]Working with Applic[bookmark: marker-7619430]ation Filters
 
    [bookmark: pgfId-7619436]License: Any
 
    [bookmark: pgfId-7619447]When the ASA FirePOWER module analyzes IP traffic, it attempts to identify the commonly used applications on your network. Application awareness is crucial to performing application-based access control. The system is delivered with detectors for many applications, and Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. 
 
    [bookmark: pgfId-7619451]Application filters group applications according to criteria associated with the applications’ risk, business relevance, type, categories, and tags. Using application filters allows you to quickly create application conditions for access control rules because you do not have to search for and add applications individually; for more information, see Matching Traffic with Application Filters.
 
    [bookmark: pgfId-7619458]Another advantage to using application filters is that you do not have to update access control rules that use filters when you modify or add new applications. For example, if you configure your access control policy to block all social networking applications, and a VDB update includes a new social networking application detector, the policy is updated when you update the VDB. Although you must reapply the policy before the system can block the new application, you do not have to update the access control rule that blocks the application.
 
    [bookmark: pgfId-7619462]If the Cisco-provided application filters do not group applications according to your needs, you can create your own filters. User-defined filters can group and combine ASA FirePOWER module-provided filters. For example, you could create a filter that would allow you to block all very high risk, low business relevance applications. You can also create a filter by manually specifying individual applications, although you should keep in mind those filters do not automatically update when you update the module software or the VDB.
 
    [bookmark: pgfId-7619469]As with ASA FirePOWER module-provided application filters, you can use user-defined application filters in access control rules.
 
    [bookmark: pgfId-7619482]You use the object manager (Configuration > ASA FirePOWER Configuration > Object Management) to create and manage application filters. Note that you can also create an application filter on the fly while adding an application condition to an access control rule.
 
    [bookmark: pgfId-7619490]The Application Filters list contains the ASA FirePOWER module-provided application filters that you can select to build your own filter. You can constrain the filters that appear by using a search string; this is especially useful for categories and tags. 
 
    [bookmark: pgfId-7619491]The Available Applications list contains the individual applications in the filters you select. You can also constrain the applications that appear by using a search string.
 
    [bookmark: pgfId-7619492]The system links multiple filters of the same filter type with an OR operation. Consider a scenario where the medium risk filter contains 100 applications and the high risk filter contains 50 applications. If you select both filters, the system would display 150 available applications.
 
    [bookmark: pgfId-7619493]The system links different types of filters with an AND operation. For example, if you select the medium and high risk filters and the medium and high business relevance filters, the system displays the applications that have medium or high risk, and also have medium or high business relevance.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7619498]After you determine the applications you want to add to the filter, you can add them either individually, or, if you selected an application filter, All apps matching the filter. You can add multiple filters and multiple applications, in any combination, as long as the total number of items in the Selected Applications and Filters list does not exceed 50.
 
   [bookmark: pgfId-7619499]After you create the application filter, it is listed on the Application Filters page of the object manager. The page displays the total number of conditions that comprise each filter.
 
   [bookmark: pgfId-7619504]For information on sorting and filtering the application filters that appear, see Using the Object Manager. Note that you cannot delete an application filter that is in use. Additionally, after you edit an application filter used in an access control policy, you must reapply the policy for your changes to take effect.
 
   [bookmark: pgfId-7619508]To create an application filter:
 
   
 
   [bookmark: pgfId-7619510]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
   [bookmark: pgfId-7619511]The Object Management page appears.
 
   [bookmark: pgfId-7619512]Step 2 Click Application Filters.
 
   [bookmark: pgfId-7619513]The Application Filters section appears.
 
   [bookmark: pgfId-7619514]Step 3 Click Add Application Filter.
 
   [bookmark: pgfId-7619515]The Application Filter pop-up window appears.
 
   [bookmark: pgfId-7619516]Step 4 Give the filter a Name. You can use any printable standard ASCII characters except curly braces ({}).
 
   [bookmark: pgfId-7619520]Step 5 Optionally, use ASA FirePOWER module-provided filters in the Application Filters list to narrow the list of applications you want to add to the filter:
 
    
     
     	 [bookmark: pgfId-7619521]Click the arrow next to each filter type to expand and collapse the list.
 
     	 [bookmark: pgfId-7619522]Right-click a filter type and click  Check All or  Uncheck All . Note that the list indicates how many filters you have selected of each type. 
 
     	 [bookmark: pgfId-7619523]To narrow the filters that appear, type a search string in the  Search by name field; this is especially useful for categories and tags. To clear the search, click the clear icon (
 
    
 
    [image: ] ). 
   
 
    
     
     	 [bookmark: pgfId-7619527]To refresh the filters list and clear any selected filters, click the reload icon (
 
    
 
    [image: ] ). 
   
 
    
     
     	 [bookmark: pgfId-7619531]To clear all filters and search fields, click  Clear All Filters .
 
    
 
   
 
   [bookmark: pgfId-7619532]The applications that match the filters you select appear in the Available Applications list. The list displays 100 applications at a time.
 
   [bookmark: pgfId-7619533]Step 6 Select the applications that you want to add to the filter from the Available Applications list:
 
    
     
     	 [bookmark: pgfId-7619534]Select  All apps matching the filter to add all the applications that meet the constraints you specified in the previous step.
 
     	 [bookmark: pgfId-7619535]To narrow the individual applications that appear, type a search string in the  Search by name field. To clear the search, click the clear icon (
 
    
 
    [image: ] ). 
   
 
    
     
     	 [bookmark: pgfId-7619539]Use the paging icons at the bottom of the list to browse the list of individual available applications.
 
     	 [bookmark: pgfId-7619540]Use Shift and Ctrl keys to select multiple individual applications. Right-click to  Select All currently displayed individual applications. 
 
     	 [bookmark: pgfId-7619541]To refresh the applications list and clear any selected applications, click the reload icon (
 
    
 
    [image: ] ). 
   
 
   [bookmark: pgfId-7619545]You cannot select individual applications and All apps matching the filter at the same time.
 
   [bookmark: pgfId-7619546]Step 7 Add the selected applications to the filter. You can click and drag, or you can click Add to Rule.
 
   [bookmark: pgfId-7619547]The result is the combination of:
 
    
     
     	 [bookmark: pgfId-7619548]the selected Application Filters
 
     	 [bookmark: pgfId-7619549]either the selected individual Available Applications, or  All apps matching the filter 
 
    
 
   
 . 
   
 
   [bookmark: pgfId-7619554]Step 8 Click Store ASA FirePOWER Changes.
 
   [bookmark: pgfId-7849350]The application filter is saved.
 
   [bookmark: pgfId-7994916]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7849355][bookmark: 37086]Working with Vari[bookmark: marker-7849354]able Sets
 
    [bookmark: pgfId-7849359]License: Protection
 
    [bookmark: pgfId-7849332]Variables represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions, adaptive profiles, and dynamic rule states.
 
     
      
    
 
    
 
    [bookmark: pgfId-7837621]Tip Preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7837622]You use variable sets to manage, customize, and group your variables. You can use the default variable set provided by the ASA FirePOWER module or create your own cus[bookmark: marker-7843392]tom sets. Within any set you can modify predefined default variables and add and modify user-defined variables.
 
    [bookmark: pgfId-7783149]Most of the shared object rules and standard text rules that the ASA FirePOWER module provides use predefined default variables to define networks and port numbers. For example, the majority of the rules use the variable $HOME_NET to specify the protected network and the variable $EXTERNAL_NET to specify the unprotected (or outside) network. In addition, specialized rules often use other predefined variables. For example, rules that detect exploits against web servers use the $HTTP_SERVERS and $HTTP_PORTS variables.
 
    [bookmark: pgfId-7783151]Rules are more effective when variables more accurately reflect your network environment. At a minimum, you should modify default variables in the default set as described in Optimizing Predefined Default Variables. By ensuring that a variable such as $HOME_NET correctly defines your network and $HTTP_SERVERS includes all web servers on your network, processing is optimized and all relevant systems are monitored for suspicious activity.
 
    [bookmark: pgfId-7767413]To use your variables, you link variable sets to intrusion policies associated with access control rules or with the default action of an access control policy. By default, the default variable set is linked to all intrusion policies used by access control policies.
 
    [bookmark: pgfId-7619594]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7672666]Optimizing Predefined Default Variables
 
     	 [bookmark: pgfId-7783056]Understanding Variable Sets
 
     	 [bookmark: pgfId-7672672]Managing Variable Sets
 
     	 [bookmark: pgfId-7804104]Managing Variables
 
     	 [bookmark: pgfId-7804108]Adding and Editing Variables
 
     	 [bookmark: pgfId-7804112]Resetting Variables
 
     	 [bookmark: pgfId-7804116]Linking Variable Sets to Intrusion Policies
 
     	 [bookmark: pgfId-7756138]Understanding Advanced Variables
 
    
 
     
      [bookmark: pgfId-7756166][bookmark: 56306]Optimizing Predefined Default Varia[bookmark: marker-7756165]bles
 
     [bookmark: pgfId-7768411]License: Protection
 
     [bookmark: pgfId-7768415]By default, the ASA FirePOWER module provides a single default variable set, which is comprised of predefined default variables. The Vulnerability Research Team (VRT) uses rule updates to provide new and updated intrusion rules and other intrusion policy elements, including default variables. See Importing Rule Updates and Local Rule Files for more information.
 
     [bookmark: pgfId-7815350]Because many intrusion rules provided by the ASA FirePOWER module use predefined default variables, you should set appropriate values for these variables. Depending on how you use variable sets to identify traffic on your network, you can modify the values for these default variables in any or all variable sets. See Adding and Editing Variables for more information.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7857736] 
      Caution Importing an access control or an intrusion policy overwrites existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved. For more information, see 
      Importing Configurations. 
       
       
 
      
 
     
 
      
       
        
        [bookmark: pgfId-7619674]Table 2-2 Variables Provided by the ASA FirePower Module 
 
        
        
         
         	 
           
           [bookmark: pgfId-7619680]Variable Name 
          
  
         	 
           
           [bookmark: pgfId-7619682]Description 
          
  
         	 
           
           [bookmark: pgfId-7619684]Modify? 
          
  
        
 
         
         	[bookmark: pgfId-7619687][bookmark: marker-7619686]$AIM_SERVERS
  
         	[bookmark: pgfId-7619689]Defines known AOL Instant Messenger (AIM) servers, and is used in chat-based rules and rules that look for AIM exploits.
  
         	[bookmark: pgfId-7619691]Not required.
  
        
 
         
         	[bookmark: pgfId-7619694][bookmark: marker-7619693]$DNS_SERVERS
  
         	[bookmark: pgfId-7619696]Defines Domain Name Service (DNS) servers. If you create a rule that affects DNS servers specifically, you can use the $DNS_SERVERS variable as a destination or source IP address.
  
         	[bookmark: pgfId-7619698]Not required in current rule set.
  
        
 
         
         	[bookmark: pgfId-7619701][bookmark: marker-7619700]$EXTERNAL_NET
  
         	[bookmark: pgfId-7619705]Defines the network that the ASA FirePOWER module views as the unprotected network, and is used in many rules to define the external network.
  
         	[bookmark: pgfId-7619708]Yes, you should adequately define $HOME_NET and then exclude $HOME_NET as the value for $EXTERNAL_NET.
  
        
 
         
         	[bookmark: pgfId-7619711][bookmark: marker-7619710]$FILE_DATA_PORTS
  
         	[bookmark: pgfId-7619713]Defines non-encrypted ports used in intrusion rules that detect files in a network stream.
  
         	[bookmark: pgfId-7619715]Not required.
  
        
 
         
         	[bookmark: pgfId-7619717]$[bookmark: marker-7808449]FTP_PORTS
  
         	[bookmark: pgfId-7619719]Defines the ports of FTP servers on your network, and is used for FTP server exploit rules.
  
         	[bookmark: pgfId-7619721]Yes, if your FTP servers use ports other than the default ports (you can view the default ports in the module interface).
  
        
 
         
         	[bookmark: pgfId-7619724][bookmark: marker-7619723]$GTP_PORTS
  
         	[bookmark: pgfId-7619726]Defines the data channel ports where the packet decoder extracts the payload inside a GTP (General Packet Radio Service [GPRS] Tunneling Protocol) PDU.
  
         	[bookmark: pgfId-7619728]Not required.
  
        
 
         
         	[bookmark: pgfId-7619731][bookmark: marker-7619730]$HOME_NET
  
         	[bookmark: pgfId-7619733]Defines the network that the associated intrusion policy monitors, and is used in many rules to define the internal network.
  
         	[bookmark: pgfId-7619735]Yes, to include the IP addresses for your internal network.
  
        
 
         
         	[bookmark: pgfId-7619738][bookmark: marker-7619737]$HTTP_PORTS
  
         	[bookmark: pgfId-7619740]Defines the ports of web servers on your network, and is used for web server exploit rules.
  
         	[bookmark: pgfId-7619742]Yes, if your web servers use ports other than the default ports (you can view the default ports in the module interface).
  
        
 
         
         	[bookmark: pgfId-7619745][bookmark: marker-7619744]$HTTP_SERVERS
  
         	[bookmark: pgfId-7619747]Defines the web servers on your network. Used in web server exploit rules.
  
         	[bookmark: pgfId-7619749]Yes, if you run HTTP servers.
  
        
 
         
         	[bookmark: pgfId-7619752][bookmark: marker-7619751]$ORACLE_PORTS
  
         	[bookmark: pgfId-7619754]Defines Oracle database server ports on your network, and is used in rules that scan for attacks on Oracle databases.
  
         	[bookmark: pgfId-7619756]Yes, if you run Oracle servers.
  
        
 
         
         	[bookmark: pgfId-7619759][bookmark: marker-7619758]$SHELLCODE_PORTS
  
         	[bookmark: pgfId-7619761]Defines the ports you want the system to scan for shell code exploits, and is used in rules that detect exploits that use shell code.
  
         	[bookmark: pgfId-7619763]Not required.
  
        
 
         
         	[bookmark: pgfId-7619766][bookmark: marker-7619765]$SIP_PORTS
  
         	[bookmark: pgfId-7619768]Defines the ports of SIP servers on your network, and is used for SIP exploit rules.
  
         	[bookmark: pgfId-7619770]Not required.
  
        
 
         
         	[bookmark: pgfId-7619773][bookmark: marker-7619772]$SIP_SERVERS
  
         	[bookmark: pgfId-7619775]Defines SIP servers on your network, and is used in rules that address SIP-targeted exploits.
  
         	[bookmark: pgfId-7619777]Yes, if you run SIP servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SIP_SERVERS.
  
        
 
         
         	[bookmark: pgfId-7619780][bookmark: marker-7619779]$SMTP_SERVERS
  
         	[bookmark: pgfId-7619782]Defines SMTP servers on your network, and is used in rules that address exploits that target mail servers.
  
         	[bookmark: pgfId-7619784]Yes, if you run SMTP servers.
  
        
 
         
         	[bookmark: pgfId-7619787]$[bookmark: marker-7619786]SNMP_SERVERS
  
         	[bookmark: pgfId-7619789]Defines SNMP servers on your network, and is used in rules that scan for attacks on SNMP servers.
  
         	[bookmark: pgfId-7619791]Yes, if you run SNMP servers.
  
        
 
         
         	[bookmark: pgfId-7791414]$[bookmark: marker-7791413]SNORT_BPF
  
         	[bookmark: pgfId-7791416]Identifies a legacy advanced variable that appears only when it existed on your system in a ASA FirePOWER module software release before Version 5.3.0 that you subsequently upgraded to Version 5.3.0 or greater. See Understanding Advanced Variables.
  
         	[bookmark: pgfId-7791418]No, you can only view or delete this variable. You cannot edit it or recover it after deleting it.
  
        
 
         
         	[bookmark: pgfId-7619794][bookmark: marker-7619793]$SQL_SERVERS
  
         	[bookmark: pgfId-7619796]Defines database servers on your network, and is used in rules that address database-targeted exploits.
  
         	[bookmark: pgfId-7619798]Yes, if you run SQL servers.
  
        
 
         
         	[bookmark: pgfId-7619801][bookmark: marker-7619800]$SSH_PORTS
  
         	[bookmark: pgfId-7619803]Defines the ports of SSH servers on your network, and is used for SSH server exploit rules.
  
         	[bookmark: pgfId-7619805]Yes, if your SSH servers use ports other than the default port (you can view the default ports in the module interface).
  
        
 
         
         	[bookmark: pgfId-7619808][bookmark: marker-7619807]$SSH_SERVERS
  
         	[bookmark: pgfId-7619810]Defines SSH servers on your network, and is used in rules that address SSH-targeted exploits.
  
         	[bookmark: pgfId-7619812]Yes, if you run SSH servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SSH_SERVERS.
  
        
 
         
         	[bookmark: pgfId-7619815][bookmark: marker-7619814]$TELNET_SERVERS
  
         	[bookmark: pgfId-7619817]Defines known Telnet servers on your network, and is used in rules that address Telnet server-targeted exploits.
  
         	[bookmark: pgfId-7619819]Yes, if you run Telnet servers.
  
        
 
         
         	[bookmark: pgfId-7791605]$[bookmark: marker-7791604]USER_CONF
  
         	[bookmark: pgfId-7792400]Provides a general tool that allows you to configure one or more features not otherwise available via the module interface. See Understanding Advanced Variables.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-7792137]Caution Conflicting or duplicate 
           $USER_CONF configurations will halt the system. See 
           Understanding Advanced Variables. 
            
            
 
           
 
          
  
         	[bookmark: pgfId-7791612]No, only as instructed in a feature description or with the guidance of Support.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7763478][bookmark: 98253]Understanding Variable Sets[bookmark: marker-7843109]
 
     [bookmark: pgfId-7763482]License: Protection
 
     [bookmark: pgfId-7769389]Adding a variable to any set adds it to all sets; that is, each variable set is a collection of all variables currently configured on your system. Within any variable set, you can add user-defined variables and customize the value of any variable.
 
     [bookmark: pgfId-7769622]Initially, the ASA FirePOWER module provides a single, default variable set comprised of predefined default values. Each variable in the default set is initially set to its default value, which for a predefined variable is the value set by the VRT and provided in rule updates.
 
     [bookmark: pgfId-7769634]Although you can leave predefined default variables configured to their default values, Cisco recommends that you modify a subset of predefined variables as described in Optimizing Predefined Default Variables.
 
     [bookmark: pgfId-7769640]You could work with variables only in the default set, but in many cases you can benefit most by adding one or more custom sets, configuring different variable values in different sets, and perhaps even adding new variables.
 
     [bookmark: pgfId-7815887]When using multiple sets, it is important to remember that the current value of any variable in the default set determines the default value of the variable in all other sets. 
 
     [bookmark: pgfId-7845475]Example: Adding a User-Defined Variable to the Default Set
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7818702]Optionally, you can customize the value of Var1 in any set. In Custom Set 2 where Var1 has not been customized, its value is 192.168.1.0/24. In Custom Set 1 the customized value 192.168.2.0/24 of Var1 overrides the default value. Resetting a user-defined variable in the default set resets its default value to any in all sets.
 
     [bookmark: pgfId-7817650]It is important to note in this example that, if you do not update Var1 in Custom Set 2, further customizing or resetting Var1 in the default set consequently updates the current, default value of Var1 in Custom Set 2, thereby affecting any intrusion policy linked to the variable set.
 
     [bookmark: pgfId-7825780]Although not shown in the example, note that interactions between sets are the same for user-defined variables and default variables except that resetting a default variable in the default set resets it to the value configured by the system in the current rule update.
 
     [bookmark: pgfId-7845621]Examples: Adding a User-Defined Variable to a Custom Set
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7822152]Note that, except for the origin of Var1 from Custom Set 1, this example is identical to the example above where you added Var1 to the default set. Adding the customized value 192.168.1.0/24 for Var1 to Custom Set 1 copies the value to the default set as a customized value with a default value of any. Thereafter, Var1 values and interactions are the same as if you had added Var1 to the default set. As with the previous example, keep in mind that further customizing or resetting Var1 in the default set consequently updates the current, default value of Var1 in Custom Set 2, thereby affecting any intrusion policy linked to the variable set.
 
     [bookmark: pgfId-7820021]In the next example, you add Var1 with the value 192.168.1.0/24 to Custom Set 1 as in the previous example, but you elect not to use the configured value of Var1 as the default value in other sets.
 
      
       [bookmark: pgfId-8238100]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-7826177]This approach adds Var1 to all sets with a default value of any. After adding Var1, you can customize its value in any set. An advantage of this approach is that, by not initially customizing Var1 in the default set, you decrease your risk of customizing the value in the default set and thus inadvertently changing the current value in a set such as Custom Set 2 where you have not customized Var1.
 
     
 
    
 
     
      [bookmark: pgfId-7826179][bookmark: 55747]Managing Varia[bookmark: marker-7843139]ble Sets
 
     [bookmark: pgfId-7619825]License: Protection
 
     [bookmark: pgfId-7619826]When you select Variable Sets on the Object Manager page (Configuration > ASA FirePOWER Configuration > Object Management), the object manager lists the default variable set and any custom sets you created. 
 
     [bookmark: pgfId-7785887]On a freshly installed system, the default variable set is comprised only of the default variables predefined by the ASA FirePOWER module.
 
     [bookmark: pgfId-7845716]Each variable set includes the default variables provided by Cisco and all custom variables you have added from any variable set. Note that you can edit the default set, but you cannot rename or delete the default set.
 
     [bookmark: pgfId-7619835]The following table summarizes the actions you can take to manage your variable sets.
 
     [bookmark: pgfId-7619899]
 
      
      
 
      
 
      
 
       
        
        [bookmark: pgfId-7619842]Table 2-3 [bookmark: 68656]Variable Set Management Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7619846]To... 
          
  
         	 
           
           [bookmark: pgfId-7619848]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7619850]display your variable sets
  
         	[bookmark: pgfId-7619852]select Configuration > ASA FirePOWER Configuration > Object Management, then select Variable Set.
  
        
 
         
         	[bookmark: pgfId-7619854]filter variable sets by name
  
         	[bookmark: pgfId-7619856]begin typing a name; as you type, the page refreshes to display matching names.
  
        
 
         
         	[bookmark: pgfId-7619858]clear name filtering
  ) in the filter field. 
        
 
         
         	[bookmark: pgfId-7619865]add a custom variable set
  
         	[bookmark: pgfId-7619867]click Add Variable Set.
 [bookmark: pgfId-7619868]For your convenience, new variable sets contain all currently defined default and customized variables.
  
        
 
         
         	[bookmark: pgfId-7619870]edit a variable set
  ) next to the variable set you want to edit. . 
        
 
         
         	[bookmark: pgfId-7619878]delete a custom variable set
  . You cannot delete the default variable set. Note that variables created in a variable set you delete are not deleted or otherwise affected in other sets. . Use the Ctrl and Shift keys to select multiple sets. 
        
 
        
      
 
     
 
     [bookmark: pgfId-7826424]After you configure variable sets, you can link them to intrusion policies.
 
     [bookmark: pgfId-7619900]To create or edit a variable set:
 
     
 
     [bookmark: pgfId-7619902]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-7619903]The Object Management page appears.
 
     [bookmark: pgfId-7619904]Step 2 Select Variable Set.
 
     [bookmark: pgfId-7619905]Step 3 Add a variable set or edit an existing set:
 
      
       
       	 [bookmark: pgfId-7619906]To add a variable set, click  Add Variable Set .
 
       	 [bookmark: pgfId-7619910]To edit a variable set, click the edit icon (
 
      
 
      [image: ] ) next to the variable set. 
     
 
     [bookmark: pgfId-7619913]The new or edit variable set page appears. See Adding and Editing Variables for information on adding and editing variables within a variable set.
 
     [bookmark: pgfId-7995423]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619915][bookmark: 16392]Managing Vari[bookmark: marker-7843155]ables
 
     [bookmark: pgfId-7619919]License: Protection
 
     [bookmark: pgfId-7619920]You manage variables on the new or edit variables page within a variable set. The variables page for all variable sets separates variables into Customized Variables and Default Variables page areas.
 
     [bookmark: pgfId-7843171]A default variable is a variable provided by the ASA FirePOWER module. You can customize the value of a default variable. You cannot rename or delete a default variable, and you cannot change its default value.
 
     [bookmark: pgfId-7843172]A customized variable[bookmark: marker-7843352] is one of the following:
 
      
      	 [bookmark: pgfId-7843173]customized default variables
 
     
 
     [bookmark: pgfId-7619937]When you edit the value for a default variable, the system moves the variable from the Default Variables area to the Customized Variables area. Because variable values in the default set determine the default values of variables in custom sets, customizing a default variable in the default set modifies the default value of the variable in all other sets.
 
      
      	 [bookmark: pgfId-7619938]us[bookmark: marker-7843361]er-defined variables
 
     
 
     [bookmark: pgfId-7619939]You can add and delete your own variables, customize their values within different variable sets, and reset customized variables to their default values. When you reset a user-defined variable, it remains in the Customized Variables area.
 
      
      
 
      
 
      [bookmark: pgfId-8071164]See Adding and Editing Variables for more information.
 
      
 
      [bookmark: pgfId-8071180]You cannot delete default variables, and you cannot delete user-defined variables that are used by intrusion rules or other variables.
 
       
        
        [bookmark: pgfId-8071123]Table 2-4 Variable Management Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8071127]To... 
          
  
         	 
           
           [bookmark: pgfId-8071129]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8071131]display the variables page
  ) next to the variable set you want to edit. 
        
 
         
         	[bookmark: pgfId-8071138]name and, optionally, describe your variable set
  
         	[bookmark: pgfId-8071140]enter an alphanumeric string including spaces and special characters in the Name and Description fields.
  
        
 
         
         	[bookmark: pgfId-8071147]add a variable
  
         	[bookmark: pgfId-8071149]click Add.
 [bookmark: pgfId-8071153]See Adding and Editing Variables for more information.
  
        
 
         
         	[bookmark: pgfId-8071155]edit a variable
  ) next to the variable you want to edit. 
        
 
         
         	[bookmark: pgfId-8071166]reset a modified variable to its default value
  
         	) next to a modified variable. A shaded reset icon indicates that the current value is already the default value.  
        
 
         
         	[bookmark: pgfId-8071174]delete a user-defined customized variable
  to confirm that you want to delete the variable. 
        
 
         
         	[bookmark: pgfId-8071182]save changes to a variable set
  
         	[bookmark: pgfId-8071184]click Store ASA FirePOWER Changes, then click Yes if the variable set is in use by an access control policy to confirm that you want to save your changes.
 [bookmark: pgfId-8071185]Because the current value in the default set determines the default value in all other sets, modifying or resetting a variable in the default set changes the current value in other sets where you have not customized the default value.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7796869]To view the variables in a variable set:
 
     
 
     [bookmark: pgfId-7796871]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-7796872]The Object Management page appears.
 
     [bookmark: pgfId-7796873]Step 2 Select Variable Set.
 
     [bookmark: pgfId-7796874]Step 3 Add a variable set or edit an existing set:
 
      
       
       	 [bookmark: pgfId-7796875]To add a variable set, click  Add Variable Set .
 
       	 [bookmark: pgfId-7796879]To edit a variable set, click the edit icon (
 
      
 
      [image: ] ) next to the variable set. 
     
 
     [bookmark: pgfId-7796882]The new or edit variable set page appears.
 
     [bookmark: pgfId-7797044]Step 4 Add a variable or edit an existing variable:
 
      
       
       	 [bookmark: pgfId-7797045]To add a variable, click  Add .
 
       	 [bookmark: pgfId-7797049]To edit a variable, click the edit icon (
 
      
 
      [image: ] ) next to the variable. 
     
 
     [bookmark: pgfId-7797050]The new or edit variable page appears.
 
     [bookmark: pgfId-7797036]See Adding and Editing Variables for information on adding and editing variables within a variable set.
 
     [bookmark: pgfId-7995468]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7620041][bookmark: 41076]Adding and Editing Var[bookmark: marker-7620040]iables
 
     [bookmark: pgfId-7620045]License: Protection
 
     [bookmark: pgfId-7779924]You can modify variables in any custom set.
 
     [bookmark: pgfId-7829198]If you create custom standard text rules, you might also want to add your own user-defined variables to more accurately reflect your traffic or as shortcuts to simplify the rule creation process. For example, if you create a rule that you want to inspect traffic in the “demilitarized zone” (or DMZ) only, you can create a variable named $DMZ whose value lists the server IP addresses that are exposed. You can then use the $DMZ variable in any rule written for this zone.
 
     [bookmark: pgfId-7840620]Adding a variable to a variable set adds it to all other sets. With one exception as explained below, the variable is added to other sets as the default value, which you can then customize.
 
     [bookmark: pgfId-7841714]When you add a variable from a custom set, you must choose whether to use the configured value as the customized value in the default set. 
 
      
      	 [bookmark: pgfId-7845101]If you  do use the configured value (for example, 192.168.0.0/16), the variable is added to the default set using the configured value as a customized value with a default value of  any . Because the current value in the default set determines the default value in other sets, the initial, default value in other custom sets is the configured value (which in the example is 192.168.0.0/16). 
 
      	 [bookmark: pgfId-7845177]If you  do not use the configured value, the variable is added to the default set using only the default value  any and, consequently, the initial, default value in other custom sets is  any .
 
     
 
     [bookmark: pgfId-7845203]See Understanding Variable Sets for more information.
 
     [bookmark: pgfId-7827782]You add variables within a variable set on the New Variable page and edit existing variables on the Edit Variable page. You use the two pages identically except that when you edit an existing variable you cannot change the variable name or variable type.
 
     [bookmark: pgfId-7797162]Each page consists mainly of three windows:
 
      
      	 [bookmark: pgfId-7797163]available items, including existing network or port variables, objects, and network object groups
 
      	 [bookmark: pgfId-7797164]networks or ports to include in the variable definition
 
      	 [bookmark: pgfId-7797165]networks or ports to exclude from the variable definition
 
     
 
     [bookmark: pgfId-7683764]You can create or edit two types of variables:
 
      
      	 [bookmark: pgfId-7671666] network variables specify the IP addresses of hosts in your network traffic. See Working with Network Variables.
 
      	 [bookmark: pgfId-7671688] port variables specify TCP or UDP ports in network traffic, including the value  any for either type. See Working with Port Variables.
 
     
 
     [bookmark: pgfId-7620056]When you specify whether you want to add a network or port variable type, the page refreshes to list available items. A search field above the list allows you to constrain the list, which updates as you type.
 
     [bookmark: pgfId-7620057]You can select and drag available items the list of items to include or exclude. You can also select items and click the Include or Exclude button. Use the Ctrl and Shift keys to select multiple items. You can use the configuration field below the list of included or excluded items to specify literal IP addresses and address blocks for network variables, and ports and port ranges for port variables.
 
     [bookmark: pgfId-7828929]A list of items to include or exclude can be comprised of any combination of literal strings and existing variables, objects, and network object groups in the case of network variables.
 
      
      
 
      Working with Network Objects 
      
 
      
 
      [bookmark: pgfId-7792837]Although you can add any port type, only TCP and UDP ports, including the value any for either type, are valid variable values, and the list of available ports only displays variables that use these value types. See Working with Port Objects for information on adding port objects using the object manager.
 
      
 
      
 
      [bookmark: pgfId-7620143]Note that only network groups, not port groups, are available.
 
      
 
       
        
        [bookmark: pgfId-7620067]Table 2-5 [bookmark: 20370]Variable Edit Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7620071]To... 
          
  
         	 
           
           [bookmark: pgfId-7620073]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7620075]display the variables page
  ) next to an existing variable. 
        
 
         
         	[bookmark: pgfId-7620082]name your variable
  
         	[bookmark: pgfId-7620084]in the Name field, type a unique, case-sensitive alphanumeric string that includes no special characters other than the underscore character (_).
 [bookmark: pgfId-7805515]Note that variable names are case-sensitive; for example, var and Var are each unique.
  
        
 
         
         	[bookmark: pgfId-7620086]specify a network or port variable
  
         	[bookmark: pgfId-7620088]select Network or Port from the Type drop-down list.
 [bookmark: pgfId-7620092]See Working with Network Variables and Working with Port Variables for detailed information on how you can use and configure network and port variables.
  
        
 
         
         	[bookmark: pgfId-7620094]add an individual network object so you can then select it from the list of available networks
  ). See for information on adding network objects using the object manager. 
        
 
         
         	[bookmark: pgfId-7620104]add an individual port object so you can then select it from the list of available ports
  ). 
        
 
         
         	[bookmark: pgfId-7620114]search for available port or network items by name
  
         	[bookmark: pgfId-7620116]begin typing a name in the search field above the list of available items; as you type, the page refreshes to display matching names.
  
        
 
         
         	[bookmark: pgfId-7620118]clear name searching
  ) in the search field. 
        
 
         
         	[bookmark: pgfId-7620128]differentiate between available items
  ). 
        
 
         
         	[bookmark: pgfId-7620145]select objects to include or exclude in the variable definition
  
         	[bookmark: pgfId-7620147]click the object in the list of available networks or ports; use the Ctrl and Shift keys to select multiple objects.
  
        
 
         
         	[bookmark: pgfId-7620149]add selected items to the list of included or excluded networks or ports
  
         	[bookmark: pgfId-7620151]drag and drop selected items. Alternately, click Include or Exclude.
 [bookmark: pgfId-7828995]You can add network and port variables and objects from the list of available items. You can also add network object groups.
  
        
 
         
         	[bookmark: pgfId-7620154]add a literal network or port to the list of networks or ports to include or exclude
  
         	[bookmark: pgfId-7620156]click to remove the prompt from the literal Network or Port field, type the literal IP address or address block for network variables, or the literal port or port range for port variables, then click Add.
 [bookmark: pgfId-7620157]Note that you cannot enter domain names or lists; to add multiple items, add each individually.
  
        
 
         
         	[bookmark: pgfId-7787432]add a variable with the value any
  
         	[bookmark: pgfId-7787434]name the variable and select the variable type, then click Store ASA FirePOWER Changes without configuring a value.
  
        
 
         
         	[bookmark: pgfId-7620159]delete a variable or object from the included or excluded list
  ) next to the variable. 
        
 
         
         	[bookmark: pgfId-7620166]save a new or modified variable
  
         	[bookmark: pgfId-7620168]click Store ASA FirePOWER Changes; if you are adding a variable from custom set, then click Yes to use the configured value as the default value in other sets, or No to use a default value of any.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7677169]See the following sections for more information:
 
      
      	 [bookmark: pgfId-7677232]Working with Network Variables
 
      	 [bookmark: pgfId-7677236]Working with Port Variables
 
     
 
     [bookmark: pgfId-7793378]To add or edit a variable:
 
     
 
     [bookmark: pgfId-7793380]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-7793381]The Object Management page appears.
 
     [bookmark: pgfId-7793382]Step 2 Select Variable Set.
 
     [bookmark: pgfId-7793383]Step 3 Add a variable set or edit an existing set:
 
      
       
       	 [bookmark: pgfId-7793384]To add a variable set, click  Add Variable Set .
 
       	 [bookmark: pgfId-7793388]To edit an existing variable set, click the edit icon (
 
      
 
      [image: ] ) next to the variable set. 
     
 
     [bookmark: pgfId-7793389]The new or edit variable set page appears.
 
     [bookmark: pgfId-7793390]Step 4 Add a new variable or edit an existing variable:
 
      
       
       	 [bookmark: pgfId-7793391]To add a new variable, click  Add .
 
       	 [bookmark: pgfId-7793395]To edit an existing variable, click the edit icon (
 
      
 
      [image: ] ) next to the variable. 
     
 
     [bookmark: pgfId-7793396]The new or edit variable page appears.
 
     [bookmark: pgfId-7793401]Step 5 If you are adding a new variable:
 
      
       
       	 [bookmark: pgfId-7793402]Enter a unique variable  Name .
 
      
 
     
 
     [bookmark: pgfId-7793403]You can use alphanumeric characters and the underscore (_) character.
 
      
       
       	 [bookmark: pgfId-7793404]Select the  Network or  Port variable  Type from the drop-down list.
 
      
 
     
 
     [bookmark: pgfId-7793406]Step 6 Optionally, move items from the list of available networks or ports to the list of included or excluded items. 
 
     [bookmark: pgfId-7793407]You can select one or more items and then drag and drop, or click Include or Exclude. Use the Ctrl and Shift keys to select multiple items. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7793408]Tip If addresses or ports in the included and excluded lists for a network or port variable overlap, excluded addresses or ports take precedence.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7793409]Step 7 Optionally, enter a single literal value, then click Add.
 
     [bookmark: pgfId-7793410]For network variables, you can enter a single IP address or address block. For port variables you can add a single port or port range, separating the upper and lower values with a hyphen (-).
 
     [bookmark: pgfId-7793411]Repeat this step as needed to enter multiple literal values.
 
     [bookmark: pgfId-7793412]Step 8 Click Store ASA FirePOWER Changes to save the variable. If you are adding a new variable from a custom set, you have the following options:
 
      
       
       	 [bookmark: pgfId-7793413]Click  Yes to add the variable using the configured value as the customized value in the default set and, consequently, the default value in other custom sets.
 
       	 [bookmark: pgfId-7793414]Click  No  to add the variable as the default value of  any  in the default set and, consequently, in other custom sets.
 
      
 
     
 
     [bookmark: pgfId-7793415]Step 9 When you have finished making changes, click Store ASA FirePOWER Changes to save the variable set, then click Yes.
 
     [bookmark: pgfId-7793416]Your changes are saved and any access control policy the variable set is linked to displays an out-of-date status. For your changes to take effect, you must apply the access control policy where the variable set is linked to an intrusion policy; see Deploying Configuration Changes.
 
     [bookmark: pgfId-7995495]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7671340][bookmark: 12697]Working with Netw[bookmark: marker-7843254]ork Variables
 
     [bookmark: pgfId-7829975]License: Protection
 
     [bookmark: pgfId-7830004]Network variables represent IP addresses you can use in intrusion rules that you enable in an intrusion policy and in intrusion policy rule suppressions, dynamic rule states, and adaptive profiles. Network variables differ from network objects and network object groups in that network variables are specific to intrusion policies and intrusion rules, whereas you can use network objects and groups to represent IP addresses in various places in the ASA FirePOWER module, including access control policies, network variables, intrusion rules, reports, and so on. See Working with Network Objects for more information.
 
     [bookmark: pgfId-7835952]You can use network variables in the following configurations to specify the IP addresses of hosts on your network:
 
      
      	 [bookmark: pgfId-7829980]intrusion rules
 
     
 
     [bookmark: pgfId-7671345]Intrusion rule Source IPs and Destination IPs header fields allow you to restrict packet inspection to the packets originating from or destined to specific IP addresses. See Specifying IP Addresses In Intrusion Rules.
 
      
      	 [bookmark: pgfId-7671349]suppressions
 
     
 
     [bookmark: pgfId-7830007]The Network field in source or destination intrusion rule suppressions allows you to suppress intrusion event notifications when a specific IP address or range of IP addresses triggers an intrusion rule or preprocessor. See Configuring Suppression Per Intrusion Policy.
 
      
      	 [bookmark: pgfId-7830013]dynamic rule states
 
     
 
     [bookmark: pgfId-8143285]The Network field in source or destination dynamic rule states allows you to detect when too many matches for an intrusion rule or preprocessor rule occur in a given time period. See Adding Dynamic Rule States.
 
      
      	 [bookmark: pgfId-8143289]adaptive profiles
 
     
 
     [bookmark: pgfId-8143290]The adaptive profiles Networks field identifies hosts in the network where you want to improve reassembly of packet fragments and TCP streams in passive deployments. See Tuning Preprocessing in Passive Deployments.
 
     [bookmark: pgfId-7831219]When you use variables in the fields identified in this section, the variable set you link to an intrusion policy determines the variable values in the network traffic handled by an access control policy that uses the intrusion policy.
 
     [bookmark: pgfId-7671375]You can add any combination of the following network configurations to a variable:
 
      
      	 [bookmark: pgfId-7671376]any combination of network variables, network objects, and network object groups that you select from the list of available networks
 
     
 
     [bookmark: pgfId-7671377]See Working with Network Objects for information on creating individual and group network objects using the object manager.
 
      
      	 [bookmark: pgfId-7671381]individual network objects that you add from the New Variable or Edit Variable page, and can then add to your variable and to other existing and future variables
 
      	 [bookmark: pgfId-7671382]literal, single IP addresses or address blocks
 
     
 
     [bookmark: pgfId-7682369]You can list multiple literal IP addresses and address blocks by adding each individually. You can list IPv4 and IPv6 addresses and address blocks alone or in any combination. When specifying IPv6 addresses, you can use any addressing convention defined in RFC 4291.
 
     [bookmark: pgfId-7671384]The default value for included networks in any variable you add is the word any, which indicates any IPv4 or IPv6 address. The default value for excluded networks is none, which indicates no network. You can also specify the address :: in a literal value to indicate any IPv6 address in the list of included networks, or no IPv6 addresses in the list of exclusions. 
 
     [bookmark: pgfId-7671385]Adding networks to the excluded list negates the specified addresses and address blocks. That is, you can match any IP address with the exception of the excluded IP address or address blocks. 
 
     [bookmark: pgfId-7671386]For example, excluding the literal address 192.168.1.1 specifies any IP address other than 192.168.1.1, and excluding 2001:db8:ca2e::fa4c specifies any IP address other than 2001:db8:ca2e::fa4c.
 
     [bookmark: pgfId-7671387]You can exclude any combination of networks using literal or available networks. For example, excluding the literal values 192.168.1.1 and 192.168.1.5 includes any IP address other than 192.168.1.1 or 192.168.1.5. That is, the system interprets this as “not 192.168.1.1 and not 192.168.1.5,” which matches any IP address other than those listed between brackets.
 
     [bookmark: pgfId-7802351]Note the following points when adding or editing network variables:
 
      
      	 [bookmark: pgfId-7671388]You cannot logically exclude the value  any which, if excluded, would indicate no address. For example, you cannot add a variable with the value  any to the list of excluded networks.
 
      	 [bookmark: pgfId-7794297]Network variables identify traffic for the specified intrusion rule and intrusion policy features. Note that preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules.
 
      	 [bookmark: pgfId-7802335]Excluded values must resolve to a subset of included values. For example, you cannot include the address block 192.168.5.0/24 and exclude 192.168.6.0/24. An error message warns you and identifies the offending variable, and you cannot save your variable set when you exclude a value outside the range of included values.
 
     
 
     [bookmark: pgfId-7794414]For information on adding and editing network variables, see Adding and Editing Variables.
 
    
 
     
      [bookmark: pgfId-7671390][bookmark: 76312]Working with [bookmark: marker-7843259]Port Variables
 
     [bookmark: pgfId-7671391]License: Protection
 
     [bookmark: pgfId-7836662]Port variables represent TCP and UDP ports you can use in the Source Port and Destination Port header fields in intrusion rules that you enable in an intrusion policy. Port variables differ from port objects and port object groups in that port variables are specific to intrusion rules. You can create port objects for protocols other than TCP and UDP, and you can use port objects in port variables and access control policies. See Working with Port Objects for more information.
 
     [bookmark: pgfId-7673965]You can use port variables in the intrusion rule Source Port and Destination Port header fields to restrict packet inspection to packets originating from or destined to specific TCP or UDP ports.
 
     [bookmark: pgfId-7673967]When you use variables in these fields, the variable set you link to the intrusion policy associated with an access control rule or policy determines the values for these variables in the network traffic where you apply the access control policy.
 
     [bookmark: pgfId-7675643]You can add any combination of the following port configurations to a variable:
 
      
      	 [bookmark: pgfId-7675644]any combination of port variables and port objects that you select from the list of available ports
 
     
 
     [bookmark: pgfId-7675645]Note that the list of available ports does not display port object groups, and you cannot add these to variables. See Working with Port Objects for information on creating port objects using the object manager.
 
      
      	 [bookmark: pgfId-7801551]individual port objects that you add from the New Variable or Edit Variable page, and can then add to your variable and to other existing and future variables
 
     
 
     [bookmark: pgfId-7801552]Only TCP and UDP ports, including the value any for either type, are valid variable values. If you use the new or edit variables page to add a valid port object that is not a valid variable value, the object is added to the system but is not displayed in the list of available objects. When you use the object manager to edit a port object that is used in a variable, you can only change its value to a valid variable value.
 
      
      	 [bookmark: pgfId-7675650]single, literal port values and port ranges
 
     
 
     [bookmark: pgfId-7675651]You must separate port ranges with a dash (-). Port ranges indicated with a colon (:) are supported for backward compatibility, but you cannot use a colon in port variables that you create.
 
     [bookmark: pgfId-7675652]You can list multiple literal port values and ranges by adding each individually in any combination.
 
     [bookmark: pgfId-7801563]Note the following points when adding or editing port variables:
 
      
      	 [bookmark: pgfId-7801578]The default value for included ports in any variable you add is the word  any , which indicates any port or port range. The default value for excluded ports is  none , which indicates no ports.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7801619]Tip To create a variable with the value any, name and save the variable without adding a specific value.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-7685133]You cannot logically exclude the value  any which, if excluded, would indicate no ports. For example, you cannot save a variable set when you add a variable with the value  any to the list of excluded ports.
 
      	 [bookmark: pgfId-7811031]Adding ports to the excluded list negates the specified ports and port ranges. That is, you can match any port with the exception of the excluded ports or port ranges.
 
      	 [bookmark: pgfId-7811033]Excluded values must resolve to a subset of included values. For example, you cannot include the port range 10-50 and exclude port 60. An error message warns you and identifies the offending variable, and you cannot save your variable set when you exclude a value outside the range of included values.
 
     
 
     [bookmark: pgfId-7793812]For information on adding and editing port variables, see Adding and Editing Variables.
 
    
 
     
      [bookmark: pgfId-7676938][bookmark: 92046]Resetting Var[bookmark: marker-7843264]iables
 
     [bookmark: pgfId-7849407]License: Protection
 
      
       
        
        [bookmark: pgfId-7834110]Table 2-6 Variable Reset Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-7834132]Resetting this variable type... 
          
  
         	 
           
           [bookmark: pgfId-7834114]In this set type... 
          
  
         	 
           
           [bookmark: pgfId-7834116]Resets it to... 
          
  
        
 
         
         	[bookmark: pgfId-7834134]default
  
         	[bookmark: pgfId-7834118]default
  
         	[bookmark: pgfId-7834120]the rule update value
  
        
 
         
         	[bookmark: pgfId-7834136]user-defined
  
         	[bookmark: pgfId-7834122]default
  
         	[bookmark: pgfId-7834124]any
  
        
 
         
         	[bookmark: pgfId-7834138]default or user-defined
  
         	[bookmark: pgfId-7834126]custom
  
         	[bookmark: pgfId-7834128]the current default set value (modified or unmodified)
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7731444]Resetting a variable in a custom set simply resets it to the current value for that variable in the default set.
 
     [bookmark: pgfId-7738787]Conversely, resetting or modifying the value of a variable in the default set always updates the default value of that variable in all custom sets. When the reset icon is grayed out, indicating that you cannot reset the variable, this means that the variable has no customized value in that set. Unless you have customized the value for a variable in a custom set, a change to the variable in the default set updates the value used in any intrusion policy where you have linked the variable set.
 
      
       
     
 
     
 
     [bookmark: pgfId-7834202]Note It is good practice when you modify a variable in the default set to assess how the change affects any intrusion policy that uses the variable in a linked custom set, especially when you have not customized the variable value in the custom set.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7795024]When the customized value and the reset value are the same, this indicates one of the following:
 
      
      	 [bookmark: pgfId-7740823]you are in the custom or default set where you added the variable with the value  any 
 
      	 [bookmark: pgfId-7740824]you are in the custom set where you added the variable with an explicit value and elected to use the configured value as the default value
 
     
 
    
 
     
      [bookmark: pgfId-7795406][bookmark: 43090]Linking Variable Sets to Intrusion Policies[bookmark: marker-7843272]
 
     [bookmark: pgfId-7795407]License: Control
 
     [bookmark: pgfId-7795411]By default, the ASA FirePOWER module links the default variable set to all intrusion policies used in an access control policy. When you apply an access control policy that uses an intrusion policy, intrusion rules that you have enabled in the intrusion policy use the variable values in the linked variable set. 
 
     [bookmark: pgfId-7834211]When you modify a custom variable set used by an intrusion policy in an access control policy, the system reflects the status for that policy as out-of-date on the Access Control page. You must reapply the access control policy to implement changes in your variable set. When you modify the default set, the system reflects the status of all access control policies that use intrusion policies as out-of-date, and you must reapply all access control policies to implement your changes.
 
     [bookmark: pgfId-7795412]See the following sections for information:
 
      
      	 [bookmark: pgfId-8079548]To link a variable set other than the default set to an access control rule, see the procedure in Configuring an Access Control Rule to Perform Intrusion Prevention.
 
      	 [bookmark: pgfId-8079553]To link a variable set other than the default set to the default action of an access control policy, see Setting Default Handling and Inspection for Network Traffic.
 
      	 [bookmark: pgfId-7795421]To apply access control policies, including policies that link variable sets to intrusion policies, see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-7620609][bookmark: 86060]Understanding [bookmark: marker-7620608]Advanced Vari[bookmark: marker-7843277]ables
 
     [bookmark: pgfId-7620613]License: Protection
 
     [bookmark: pgfId-7620614]Advanced variables allow you to configure features that you cannot otherwise configure via the module interface. The ASA FirePOWER module currently provides only two advanced variables, and you can only edit the USER_CONF advanced variable.
 
     [bookmark: pgfId-7620618]USER_CONF
 
     [bookmark: pgfId-7620619]USER_CONF provides a general tool that allows you to configure one or more features not otherwise available via the module interface.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7620620] 
      Caution Do 
      not use the advanced variable USER_CONF to configure an intrusion policy feature unless you are instructed to do so in the feature description or by Support. Conflicting or duplicate configurations will halt the system. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7686089]When editing USER_CONF, you can type up to 4096 total characters on a single line; the line wraps automatically. You can include any number of valid instructions or lines until you reach the 8192 maximum character length for a variable or a physical limit such as disk space. Use the backslash (\) line continuation character after any complete argument in a command directive. 
 
     [bookmark: pgfId-7686090]Resetting USER_CONF empties it.
 
    
 
   
 
    
     [bookmark: pgfId-8205633][bookmark: 12003]Working with Sinkhole Objects
 
    [bookmark: pgfId-8207713]License: Protection
 
    [bookmark: pgfId-8207715]A sinkhole object represents either a DNS server that gives non-routeable addresses for all domain names within the sinkhole, or an IP address that does not resolve to a server. You can reference the sinkhole object within a DNS policy rule to redirect matching traffic to the sinkhole. You must assign the object both an IPv4 address and an IPv6 address.
 
    [bookmark: pgfId-8205838]You cannot delete a sinkhole object that is in use. Additionally, after you edit a sinkhole object used in a DNS policy, you must re-deploy configurations for your changes to take effect.
 
    [bookmark: pgfId-8207031]To create a sinkhole object:
 
    
 
    [bookmark: pgfId-8207064]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-8207065]The Object Management page appears.
 
    [bookmark: pgfId-8207033]Step 2 Choose Sinkhole from the list of object types.
 
    [bookmark: pgfId-8206155]Step 3 Click Add Sinkhole.
 
    [bookmark: pgfId-8206170]Step 4 Enter a Name.
 
    [bookmark: pgfId-8206185]Step 5 Enter the IPv4 Address and IPv6 Address of your sinkhole.
 
    [bookmark: pgfId-8206215]Step 6 You have the following options:
 
     
     	 [bookmark: pgfId-8206230]If you want to redirect traffic to a sinkhole server, select  Log Connections to Sinkhole .
 
     	 [bookmark: pgfId-8206265]If you want to redirect traffic to a non-resolving IP address, select  Block and Log Connections to Sinkhole .
 
    
 
    [bookmark: pgfId-8206571]Step 7 If you want to assign an Indication of Compromise (IoC) type to your sinkhole, choose one from the Type drop-down.
 
    [bookmark: pgfId-8206871]Step 8 Click Store ASA FirePOWER Changes. 
 
    [bookmark: pgfId-8206845]Step 9 Reapply all access control policies with DNS policies that use the sinkhole object.
 
    [bookmark: pgfId-8206664]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8206123][bookmark: 98873]Working with File [bookmark: marker-8206122]Lists
 
    [bookmark: pgfId-7620768]License: Malware
 
    [bookmark: pgfId-7620779]If you use network-based advanced mal[bookmark: marker-7620778]ware protection (AMP), and the Collective Security Intelligence Cloud incorrectly identifies a file’s disposition, you can add the file to a file list using a SHA-256 hash value to better detect the file in the future. Depending on the type of file list, you can do the following:
 
     
     	 [bookmark: pgfId-7843887]To treat a file as if the cloud assigned a clean disposition, add the file to the  clean list [bookmark: marker-7846242].
 
     	 [bookmark: pgfId-7843888]To treat a file as if the cloud assigned a malware disposition, add the file to the  custom detection list. [bookmark: marker-7846251]
 
    
 
    [bookmark: pgfId-7620785]Because you manually specify the blocking behavior for these files, the system does not perform malware cloud lookups, even if the files are otherwise identified as malware by the cloud. Note that you must configure a rule in the file policy with either a Malware Cloud Lookup or Block Malware action and a matching file type to calculate a file’s SHA value. For more information, see Working with File Rules. 
 
    [bookmark: pgfId-7620789]The system’s clean list and custom detection list are included by default in every file policy. You can opt not to use either or both lists on a per-policy basis. 
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7620790] 
     Caution Do 
     not include files on this list that are actually malware. The system does not block them, even if the cloud assigned the file’s a Malware disposition, or if you added the file to the custom detection list. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7620791]Each file list can contain up to 10000 unique SHA-256 values. To add files to the file list, you can:
 
     
     	 [bookmark: pgfId-7620793]upload a file so the system calculates and adds the file’s SHA-256 value.
 
     	 [bookmark: pgfId-7620794]enter a file’s SHA-256 value directly.
 
     	 [bookmark: pgfId-7620795]create and upload a comma-separated value (CSV) source file containing multiple SHA-256 values. All non-duplicate SHA-256 values are added to the file list.
 
    
 
    [bookmark: pgfId-7620796]When you add a file to a file list, edit a SHA-256 value in the file list, or delete SHA-256 values from the file list, you must reapply any access control policies with file policies that use the list for the changes to take effect. 
 
    [bookmark: pgfId-7620804]For more information on using file lists, see the following topics:
 
     
     	 [bookmark: pgfId-7620812]Uploading Multiple SHA-256 Values to a File List
 
     	 [bookmark: pgfId-7620816]Uploading an Individual File to a File List
 
     	 [bookmark: pgfId-7620820]Adding a SHA-256 Value to the File List
 
     	 [bookmark: pgfId-7620824]Modifying Files on a File List
 
     	 [bookmark: pgfId-7620828]Downloading a Source File from a File List
 
    
 
     
      [bookmark: pgfId-7620865][bookmark: 16834]Uploading [bookmark: marker-7846256]Multiple SHA-256 Values to a File List
 
     [bookmark: pgfId-7620869]License: Malware
 
     [bookmark: pgfId-7620879]You can add multiple SHA-256 values to a file list by uploading a comma-separated value (CSV) source file containing a list of SHA-256 values and descriptions. The system validates the contents and populates the file list with valid SHA-256 values.
 
     [bookmark: pgfId-7620883]The source file must be a simple text file with a .csv file name extension. Any header must start with a pound sign (#); it is treated as a comment and not uploaded. Each entry should contain a single SHA-256 value followed by a description of up to 256 alphanumeric or special characters and end with either the LF or CR+LF Newline character. The system ignores any additional information in the entry.
 
     [bookmark: pgfId-7620884]Note the following:
 
      
      	 [bookmark: pgfId-7620885]Deleting a source file from the file list also removes all associated SHA-256 hashes from the file list.
 
      	 [bookmark: pgfId-7620886]You cannot upload multiple files to a file list if the successful source file upload results in the file list containing more than 10000 distinct SHA-256 values.
 
      	 [bookmark: pgfId-7620887]The system truncates descriptions exceeding 256 characters to the first 256 characters on upload. If the description contains commas, you must use an escape character ( \, ). If no description is included, the source file name is used instead.
 
      	 [bookmark: pgfId-7620888]If a file list contains a SHA-256 value, and you upload a source file containing that value, the newly uploaded value does not modify the existing SHA-256 value. When viewing captured files, file events, or malware events related to the SHA-256 value, any threat name or description is derived from the individual SHA-256 value.
 
      	 [bookmark: pgfId-7620889]The system does not upload invalid SHA-256 values in a source file.
 
      	 [bookmark: pgfId-7831400]If multiple uploaded source files contain an entry for the same SHA-256 value, the system uses the most recent value.
 
      	 [bookmark: pgfId-7620890]If a source file contains multiple entries for the same SHA-256 value, the system uses the last one. 
 
      	 [bookmark: pgfId-7620891]You cannot directly edit a source file within the object manager. To make changes, you must first modify your source file directly, delete the copy on the system, then upload the modified source file. See Downloading a Source File from a File List for more information. 
 
     
 
     [bookmark: pgfId-7620895]To upload a source file to a file list:
 
     
 
     [bookmark: pgfId-7620897]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-7620898]The Object Management page appears.
 
     [bookmark: pgfId-7620899]Step 2 Click File List.
 
     [bookmark: pgfId-7620900]The File List section appears.
 ) next to the file list where you want to add values from a source file. 
     
 
     [bookmark: pgfId-7620905]The File List pop-up window appears.
 
     [bookmark: pgfId-7620910]Step 4 Select List of SHAs from the Add by field.
 
     [bookmark: pgfId-7620911]The pop-up window updates to include new fields.
 
     [bookmark: pgfId-7620916]Step 5 Optionally, enter a description of the source file in the Description field. 
 
     [bookmark: pgfId-7620917]If you do not enter a description, the system uses the file name.
 
     [bookmark: pgfId-7620918]Step 6 Click Browse to browse to the source file, then click Upload and Add List to add the list.
 
     [bookmark: pgfId-7620919]The source file is added to the file list. The SHA-256 column lists how many SHA-256 values the file contains.
 
     [bookmark: pgfId-7620920]Step 7 Click Store ASA FirePOWER Changes. 
 
     [bookmark: pgfId-7620921]Step 8 Reapply all access control policies with file policies that use the file list.
 
     [bookmark: pgfId-7620922]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
     [bookmark: pgfId-7995511]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7620924][bookmark: 28463]Uploading an [bookmark: marker-7846282]Individual File to a File List
 
     [bookmark: pgfId-7620928]License: Malware
 
     [bookmark: pgfId-7620938]If you have a [bookmark: marker-7620937]copy of the file you want to add to a file list, you can upload the file to the system for analysis; the system calculates the file’s SHA-256 value and adds the file to the list. The system does not enforce a limit on the size of files for SHA-256 calculation. 
 
     [bookmark: pgfId-7620945]To add a file by having the system calculate its SHA-256 value:
 
     
 ) next to the clean list or custom detection list where you want to add a file. 
     
 
     [bookmark: pgfId-7620951]The File List pop-up window appears.
 
     [bookmark: pgfId-7620956]Step 2 Select Calculate SHA from the Add by field.
 
     [bookmark: pgfId-7620957]The pop-up window updates to include new fields.
 
     [bookmark: pgfId-7620962]Step 3 Optionally, enter a description of the file in the Description field. 
 
     [bookmark: pgfId-7620963]If you do not enter a description, the file name is used for the description on upload.
 
     [bookmark: pgfId-7620964]Step 4 Click Browse to browse to the source file, then click Calculate and Add SHA to add the list.
 
     [bookmark: pgfId-7620965]The file is added to the file list.
 
     [bookmark: pgfId-7620966]Step 5 Click Store ASA FirePOWER Changes. 
 
     [bookmark: pgfId-7620967]Step 6 Reapply all access control policies with file policies that use the file list.
 
     [bookmark: pgfId-7620968]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
     [bookmark: pgfId-7995531]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7620970][bookmark: 14164]Adding a SHA-256 Value to the [bookmark: marker-7846315]File List
 
     [bookmark: pgfId-7620974]License: Malware
 
     [bookmark: pgfId-7620984]You can submit a file’s SHA-256 v[bookmark: marker-7620983]alue to add it to a file list. You cannot add duplicate SHA-256 values.
 
     [bookmark: pgfId-7620986]To add a file by manually entering the file’s SHA-256 value:
 
     
 ) next to the clean list or custom detection list where you want to add a file. 
     
 
     [bookmark: pgfId-7620992]The File List pop-up window appears.
 
     [bookmark: pgfId-7620997]Step 2 Select Enter SHA Value from the Add by field.
 
     [bookmark: pgfId-7620998]The pop-up window updates to include new fields.
 
     [bookmark: pgfId-7621003]Step 3 Enter a description of the source file in the Description field. 
 
     [bookmark: pgfId-7621004]Step 4 Type or paste the file’s entire SHA-256 value. The system does not support matching partial values.
 
     [bookmark: pgfId-7621005]Step 5 Click Add to add the file.
 
     [bookmark: pgfId-7621006]The file is added to the file list. 
 
     [bookmark: pgfId-7621007]Step 6 Click Store ASA FirePOWER Changes. 
 
     [bookmark: pgfId-7621008]Step 7 Reapply all access control policies with file policies that use the file list.
 
     [bookmark: pgfId-7621009]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
     [bookmark: pgfId-7995591]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7621011][bookmark: 71416]Modifying Files on a [bookmark: marker-7846347]File List
 
     [bookmark: pgfId-7621015]License: Malware
 
     [bookmark: pgfId-7621025]You can e[bookmark: marker-7621024]dit or delete individual SHA-256 values on a file list. Note that you cannot directly edit a source file within the object manager. To make changes, you must first modify your source file directly, delete the copy on the system, then upload the modified source file. See Downloading a Source File from a File List for more information. To edit a file on a file list:
 
     
 ) next to the clean list or custom detection list where you want to modify a file. 
     
 
     [bookmark: pgfId-7621034]The File List pop-up window appears.
 ). 
     
 
     [bookmark: pgfId-7621043]The Edit SHA-256 pop-up window appears.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7621052]Step 3 Update the SHA-256 value or Description. 
 
    [bookmark: pgfId-7621053]Step 4 Click Save.
 
    [bookmark: pgfId-7621054]The File List pop-up window appears. The system updates the file entry in the list.
 
    [bookmark: pgfId-7621055]Step 5 Click Store ASA FirePOWER Changes. 
 
    [bookmark: pgfId-7621056]Step 6 Reapply all access control policies with file policies that use the file list.
 
    [bookmark: pgfId-7621057]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
    [bookmark: pgfId-7995603]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7621059][bookmark: 38522]Downloading a Source File from a [bookmark: marker-7846384]File List
 
    [bookmark: pgfId-7621063]License: Malware
 
    [bookmark: pgfId-7621072]You can view, download, or delete existing source file entries on a file list. Note that you cannot edit a source file once uploaded. You must first delete the source file from the file list, then upload an updated file. For more information on uploading a source file, see Uploading Multiple SHA-256 Values to a File List.
 
    [bookmark: pgfId-7621076]The number of entries associated with a source file refers to the number of distinct SHA-256 values. If you delete a source file from a file list, the total number of SHA-256 entries the file list contains decreases by the number of valid entries in the source file.
 
    [bookmark: pgfId-7621077]To download a source file:
 
    
 ) next to the clean list or custom detection list where you want to download a source file. 
    
 
    [bookmark: pgfId-7621083]The File List pop-up window appears.
 ). 
    
 
    [bookmark: pgfId-7621092]The View SHA-256’s in list pop-up window appears.
 
    [bookmark: pgfId-7621097]Step 3 Click Download SHA List and follow the prompts to save the source file. 
 
    [bookmark: pgfId-7621098]Step 4 Click Close.
 
    [bookmark: pgfId-7621099]The File List pop-up window appears.
 
    [bookmark: pgfId-7995640]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7621103][bookmark: 11391]Working with Secu[bookmark: marker-7621101]rity Zones
 
    [bookmark: pgfId-7621104]License: Any
 
    [bookmark: pgfId-7621105]Supported Devices: Any
 
    [bookmark: pgfId-7621107]A security zone is a grouping of one or more ASA interfaces that you can use to manage and classify traffic flow in various policies and configurations. You can configure multiple zones on a single device. This allows you to divide the network into segments where you can apply various policies. You must assign at least one interface to a security zone to match traffic against that security zone, and each interface can belong to only one zone.
 
    [bookmark: pgfId-7621108]In addition to using security zones to group interfaces, you can use zones in access control policies. For example, you could write an access control rule that applies only to a specific source or destination zone.
 
    [bookmark: pgfId-8140530]The Security Zones page of the object manager lists the zones configured on your ASA FirePOWER module.
 
    [bookmark: pgfId-8140534]You cannot delete a security zone that is in use. After you add or remove interfaces from a zone, you must reapply the device configuration. You must also reapply the access control policies that use the zone.
 
    [bookmark: pgfId-7621124]To add a security zone:
 
    
 
    [bookmark: pgfId-7621126]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-7621127]The Object Management page appears.
 
    [bookmark: pgfId-7621128]Step 2 Select Security Zones.
 
    [bookmark: pgfId-7621129]Step 3 Click Add Security Zone.
 
    [bookmark: pgfId-7621130]The Security Zones pop-up window appears.
 
    [bookmark: pgfId-7621135]Step 4 Type a Name for the zone. You can use any printable standard ASCII characters except curly braces ({}) and pound signs (#).
 
    [bookmark: pgfId-7621136]Step 5 Select an interface Type for the zone.
 
    [bookmark: pgfId-7621137]After you create a security zone, you cannot change its type.
 
    [bookmark: pgfId-7621140]Step 6 Select one or more interfaces.
 
    [bookmark: pgfId-7621141]Use the Shift and Ctrl keys to select multiple objects. If you have not yet configured interfaces, you can create an empty zone and add interfaces to it later; skip to step 9.
 
    [bookmark: pgfId-7621146]Step 7 [bookmark: 56852]Click Add.
 
    [bookmark: pgfId-7621147]The interfaces you selected are added to the zone, grouped by device.
 
    [bookmark: pgfId-7621154]Step 8 Repeat steps 6 through 8 to add interfaces on other devices to the zone.
 
    [bookmark: pgfId-7621156]Step 9 [bookmark: 32416]Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-7621157]The security zone is added.
 
    [bookmark: pgfId-7995651]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8204992][bookmark: 20774]Working with Cipher [bookmark: marker-8204991]Suite Lists
 
    [bookmark: pgfId-8204996]License: Any
 
    [bookmark: pgfId-8205005]A cipher suite list is an object comprised of several cipher suites. Each pre-defined cipher suite value represents a cipher suite used to negotiate an SSL- or TLS-encrypted session. You can use cipher suites and cipher suite lists in SSL rules to control encrypted traffic based on whether the client and server negotiated the SSL session using that cipher suite. If you add a cipher suite list to an SSL rule, SSL sessions negotiated with any of the cipher suites in the list match the rule.
 
     
      
    
 
    
 
    [bookmark: pgfId-8205006]Note Although you can use cipher suites in the ASDM interface in the same places as cipher suite lists, you cannot add, modify, or delete cipher suites.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8205007]You cannot delete a cipher suite list that is in use. Additionally, after you edit a cipher suite list used in an SSL policy, you must reapply the associated access control policy for your changes to take effect. 
 
    [bookmark: pgfId-8205008]To create a cipher suite list:
 
    
 
    [bookmark: pgfId-8205013]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-8205014]The Object Management page appears.
 
    [bookmark: pgfId-8205015]Step 2 Select Cipher Suite List.
 
    [bookmark: pgfId-8205016]Step 3 Click Add Cipher Suites.
 
    [bookmark: pgfId-8205017]The Cipher Suite List pop-up window appears.
 
    [bookmark: pgfId-8205018]Step 4 Type a Name for the cipher suite list. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-8205019]Step 5 Select one or more cipher suites and click Add.
 
     
      
      	 [bookmark: pgfId-8205020]Use Shift and Ctrl to select multiple cipher suites, or right-click and  Select All . 
 
      	 [bookmark: pgfId-8205024]Use the filter field (
 
     
 
     [image: ] ) to search for existing cipher suites to include, which updates as you type to display matching items. Click the reload icon ( 
     [image: ] ) above the search field or click the clear icon ( 
     [image: ] ) in the search field to clear the search string. 
    
 
    [bookmark: pgfId-8205031]Step 6 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-8205032]The cipher suite list is created.
 
    [bookmark: pgfId-8205033]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8205112][bookmark: 47932]Working with Distinguished [bookmark: marker-8205111]Name Objects
 
    [bookmark: pgfId-8205116]License: Any
 
    [bookmark: pgfId-8205125]Each distinguished name object represents the distinguished name listed for a public key certificate’s subject or issuer. You can use distinguished name objects and groups (see Grouping Objects) in SSL rules to control encrypted traffic based on whether the client and server negotiated the SSL session using a server certificate with the distinguished name as subject or issuer. 
 
    [bookmark: pgfId-8205129]Your distinguished name object can contain the common name attribute (CN). If you add a common name without “CN=” then the system prepends “CN=” before saving the object. 
 
    [bookmark: pgfId-8205130]You can also add a distinguished name with one of each attribute listed in the following table, separated by commas.
 
    [bookmark: pgfId-8205169]
 
     
      
       
       [bookmark: pgfId-8205134]Table 2-7 [bookmark: 51641]Distinguished Name Attributes
 
       
       
        
        	 
          
          [bookmark: pgfId-8205140]Attribute 
         
  
        	 
          
          [bookmark: pgfId-8205142]Description 
         
  
        	 
          
          [bookmark: pgfId-8205144]Allowed Values 
         
  
       
 
        
        	[bookmark: pgfId-8205146]C
  
        	[bookmark: pgfId-8205148]Country Code
  
        	[bookmark: pgfId-8205150]two alphabetic characters
  
       
 
        
        	[bookmark: pgfId-8205152]CN
  
        	[bookmark: pgfId-8205154]Common Name
  
        	 [bookmark: pgfId-8205156]up to 64 alphanumeric, backslash (/), hyphen (-), quotation ("), or asterisk (*) characters, or spaces
  
       
 
        
        	[bookmark: pgfId-8205158]O
  
        	[bookmark: pgfId-8205160]Organization
  
       
 
        
        	[bookmark: pgfId-8205164]OU
  
        	[bookmark: pgfId-8205166]Organizational Unit
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8205170]You can define one or more asterisks (*) as wild cards in an attribute. In a common name attribute, you can define one or more asterisks per domain name label. Wild cards match only within that label, though you can define multiple labels with wild cards. See the following table for examples.
 
    [bookmark: pgfId-8205232]
 
     
      
       
       [bookmark: pgfId-8205173]Table 2-8 Common Name Attribute Wild Card Examples
 
       
       
        
        	 
          
          [bookmark: pgfId-8205179]Attribute 
         
  
        	 
          
          [bookmark: pgfId-8205181]Matches 
         
  
        	 
          
          [bookmark: pgfId-8205183]Does Not Match 
         
  
       
 
        
        	[bookmark: pgfId-8205185]CN=”*ample.com”
  
        	[bookmark: pgfId-8205187]example.com
  
        	[bookmark: pgfId-8205189]mail.example.com
 [bookmark: pgfId-8205190]example.text.com
 [bookmark: pgfId-8205191]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8205193]CN=”exam*.com”
  
        	[bookmark: pgfId-8205195]example.com
  
        	[bookmark: pgfId-8205197]mail.example.com
 [bookmark: pgfId-8205198]example.text.com
 [bookmark: pgfId-8205199]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8205201]CN=”*xamp*.com”
  
        	[bookmark: pgfId-8205203]example.com
  
        	[bookmark: pgfId-8205205]mail.example.com
 [bookmark: pgfId-8205206]example.text.com
 [bookmark: pgfId-8205207]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8205209]CN=”*.example.com”
  
        	[bookmark: pgfId-8205211]mail.example.com
  
        	[bookmark: pgfId-8205213]example.com
 [bookmark: pgfId-8205214]example.text.com
 [bookmark: pgfId-8205215]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8205217]CN=”*.com”
  
        	[bookmark: pgfId-8205219]example.com
 [bookmark: pgfId-8205220]ampleexam.com
  
        	[bookmark: pgfId-8205222]mail.example.com
 [bookmark: pgfId-8205223]example.text.com
  
       
 
        
        	[bookmark: pgfId-8205225]CN=”*.*.com”
  
        	[bookmark: pgfId-8205227]mail.example.com
 [bookmark: pgfId-8205228]example.text.com
  
        	[bookmark: pgfId-8205230]example.com
 [bookmark: pgfId-8205231]ampleexam.com
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8205233]You cannot delete a distinguished name object that is in use. Additionally, after you edit a distinguished name object used in an SSL policy, you must reapply the associated access control policy for your changes to take effect.
 
    [bookmark: pgfId-8205234]To add a distinguished name object:
 
    
 
    [bookmark: pgfId-8205239]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-8205240]The Object Management page appears.
 
    [bookmark: pgfId-8205241]Step 2 Under Distinguished Name, select Individual Objects.
 
    [bookmark: pgfId-8205242]Step 3 Click Add Distinguished Name.
 
    [bookmark: pgfId-8205243]The Distinguished Name pop-up window appears.
 
    [bookmark: pgfId-8205244]Step 4 Type a Name for the distinguished name object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-8205245]Step 5 In the DN field, type a value for the distinguished name or common name. You have the following options:
 
     
      
      	 [bookmark: pgfId-8205248]If you add a distinguished name, you can include one of each attribute listed in Table 2-7 separated by commas. 
 
      	 [bookmark: pgfId-8205250]If you add a common name, you can include multiple labels and wild cards.
 
     
 
    
 
    [bookmark: pgfId-8205251]Step 6 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-8205252]The distinguished name object is added.
 
    [bookmark: pgfId-8205253]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8193856][bookmark: 71963]Working with PKI [bookmark: marker-8193855]Objects
 
    [bookmark: pgfId-8193860]License: Any
 
    [bookmark: pgfId-8193868]PKI objects represent the public key certificates and paired private keys required to support your SSL inspection deployment. Internal and trusted CA objects consist of certificate authority (CA) certificates; internal CA objects also contain the private key paired with the certificate. Internal and external certificate objects consist of server certificates; internal certificate objects also contain the private key paired with the certificate. Using these objects in SSL rules, you can decrypt:
 
     
     	 [bookmark: pgfId-8193869]outgoing traffic by re-signing the server certificate with an internal CA object
 
     	 [bookmark: pgfId-8193870]incoming traffic using the known private key in an internal certificate object
 
    
 
    [bookmark: pgfId-8193871]You can also create SSL rules and match traffic encrypted with:
 
     
     	 [bookmark: pgfId-8193872]the certificate in an external certificate object
 
     	 [bookmark: pgfId-8193873]a certificate either signed by the CA in a trusted CA object, or within the CA’s chain of trust
 
    
 
    [bookmark: pgfId-8193874]You can manually input certificate and key information, upload a file containing that information, or in some cases, generate a new CA certificate and private key.
 
    [bookmark: pgfId-8193875]When you view a list of PKI objects in the object manager, the system displays the certificate’s Subject distinguished name as the object value. Hover your pointer over the value to view the full certificate Subject distinguished name. To view other certificate details, edit the PKI object.
 
     
      
    
 
    
 
    [bookmark: pgfId-8193879]Note The ASA FirePOWER module encrypts all private keys stored in internal CA objects and internal certificate objects with a randomly generated key before saving them. If you upload private keys that are password protected, the appliance decrypts the key using the user-supplied password, then reencrypts it with the randomly generated key before saving it. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8193880]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-8193884]Working with Internal Certificate Authority Objects
 
     	 [bookmark: pgfId-8193888]Working with Trusted Certificate Authority Objects
 
     	 [bookmark: pgfId-8193892]Working with External Certificate Objects
 
     	 [bookmark: pgfId-8193896]Working with Internal Certificate Objects
 
    
 
     
      [bookmark: pgfId-8193900][bookmark: 49055]Working with Internal Certificate [bookmark: marker-8193899]Authority Objects
 
     [bookmark: pgfId-8193904]License: Any
 
     [bookmark: pgfId-8193913]Each internal certificate authority (CA) object you configure represents the CA public key certificate of a CA your organization controls. The object consists of the object name, CA certificate, and paired private key. You can use internal CA objects and groups (see Grouping Objects) in SSL rules to decrypt outgoing encrypted traffic by re-signing the server certificate with the internal CA.
 
      
       
     
 
     
 
     [bookmark: pgfId-8193917]Note If you reference an internal CA object in a Decrypt - Resign SSL rule and the rule matches an encrypted session, the user’s browser may warn that the certificate is not trusted while negotiating the SSL handshake. To avoid this, add the internal CA object certificate to either the client or domain list of trusted root certificates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8193918]You can create an internal CA object in the following ways:
 
      
      	 [bookmark: pgfId-8193919]import an existing RSA-based or elliptic curve-based CA certificate and private key
 
      	 [bookmark: pgfId-8193920]generate a new self-signed RSA-based CA certificate and private key 
 
      	 [bookmark: pgfId-8193921]generate an unsigned RSA-based CA certificate and private key. You must submit a certificate signing request (CSR) to another CA to sign the certificate before using the internal CA object.
 
     
 
     [bookmark: pgfId-8193922]After you create an internal CA object containing a signed certificate, you can download the CA certificate and private key. The system encrypts downloaded certificates and private keys with a user-provided password. 
 
     [bookmark: pgfId-8193923]Whether system-generated or user-created, you can modify the internal CA object name, but cannot modify other object properties.
 
     [bookmark: pgfId-8193924]You cannot delete an internal CA object that is in use. Additionally, after you edit an internal CA object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8193925]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-8193929]Importing a CA Certificate and Private Key
 
      	 [bookmark: pgfId-8193933]Generating a New CA Certificate and Private Key
 
      	 [bookmark: pgfId-8193937]Obtaining and Uploading a New Signed Certificate
 
      	 [bookmark: pgfId-8193941]Downloading a CA Certificate and Private Key
 
     
 
    
 
     
      [bookmark: pgfId-8193945][bookmark: 68161]Importing a CA Certificate and [bookmark: marker-8193944]Private Key
 
     [bookmark: pgfId-8193949]License: Any
 
     [bookmark: pgfId-8193958]You can configure an internal CA object by importing an X.509 v3 CA certificate and private key. You can upload files encoded in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8193959]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8193960]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8193961]If the private key file is password-protected, you can supply the decryption password. If the certificate and key are encoded in the PEM format, you can also copy and paste the information. 
 
     [bookmark: pgfId-8193962]You can upload only files that contain proper certificate or key information, and that are paired with each other. The system validates the pair before saving the object.
 
      
       
     
 
     
 
     [bookmark: pgfId-8193963]Note If you configure a rule with the Decrypt - Resign action, the rule matches traffic based on the referenced internal CA certificate’s encryption algorithm type, in addition to any configured rule conditions. You must upload an elliptic curve-based CA certificate to decrypt outgoing traffic encrypted with an elliptic curve-based algorithm, for example. For more information, see Decrypt Actions: Decrypting Traffic for Further Inspection. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8193967]To import an internal CA certificate and private key:
 
     
 
     [bookmark: pgfId-8194870]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8193973]The Object Management page appears.
 
     [bookmark: pgfId-8193974]Step 2 Under PKI, select Internal CAs.
 
     [bookmark: pgfId-8193975]Step 3 Click Import CA.
 
     [bookmark: pgfId-8193976]The Import Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8193977]Step 4 Type a Name for the internal CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8193978]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file. 
 
     [bookmark: pgfId-8193979]Step 6 Above the Key field, click Browse to upload a DER or PEM-encoded paired private key file.
 
     [bookmark: pgfId-8193980]Step 7 If the uploaded file is password-protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8193981]Step 8 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8193982]The internal CA object is added.
 
     [bookmark: pgfId-8193983]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8193987][bookmark: 90329]Generating a New CA Certificate and [bookmark: marker-8193986]Private Key
 
     [bookmark: pgfId-8193991]License: Any
 
     [bookmark: pgfId-8194000]You can configure an internal CA object by providing identification information to generate a self-signed RSA-based CA certificate and private key. The following table describes the identification information you provide to generate the certificate.
 
     [bookmark: pgfId-8194051]
 
      
       
        
        [bookmark: pgfId-8194004]Table 2-9 [bookmark: 57956]Generated Internal CA Attributes
 
        
        
         
         	 
           
           [bookmark: pgfId-8194010]Field 
          
  
         	 
           
           [bookmark: pgfId-8194012]Allowed Values 
          
  
         	 
           
           [bookmark: pgfId-8194014]Required 
          
  
        
 
         
         	[bookmark: pgfId-8194016]Country Name (two-letter code)
  
         	[bookmark: pgfId-8194018]two alphabetic characters
  
         	[bookmark: pgfId-8194020]yes
  
        
 
         
         	[bookmark: pgfId-8194022]State or Province
  
         	 [bookmark: pgfId-8194024]up to 64 alphanumeric, backslash (/), hyphen (-), quotation ("), asterisk (*), period (.), or space characters
  
         	 [bookmark: pgfId-8194026]no
  
        
 
         
         	[bookmark: pgfId-8194028]Locality or City
  
        
 
         
         	[bookmark: pgfId-8194034]Organization
  
        
 
         
         	[bookmark: pgfId-8194040]Organizational Unit
  
        
 
         
         	[bookmark: pgfId-8194046]Common Name
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8194052]The generated CA certificate is valid for ten years. The Valid From date is a week before generation. 
 
     [bookmark: pgfId-8194053]To generate a self-signed CA certificate:
 
     
 
     [bookmark: pgfId-8194854]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194059]The Object Management page appears.
 
     [bookmark: pgfId-8194060]Step 2 Under PKI, select Internal CAs.
 
     [bookmark: pgfId-8194061]Step 3 Click Generate CA.
 
     [bookmark: pgfId-8194062]The Generate Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194063]Step 4 Type a Name for the internal CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8194067]Step 5 Type the identification attributes, as described in Table 2-9.
 
     [bookmark: pgfId-8194068]Step 6 Click Generate self-signed CA.
 
     [bookmark: pgfId-8194069]The internal CA object is added.
 
     [bookmark: pgfId-8194070]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8194072][bookmark: 28976]Obtaining and Uploading a New Signed Certificate
 
     [bookmark: pgfId-8194076]License: Any
 
     [bookmark: pgfId-8194084]You can configure an internal CA object by obtaining a signed certificate from a CA. This involves two steps: 
 
      
      	 [bookmark: pgfId-8194085]Provide identification information to configure the internal CA object. This generates an unsigned certificate and paired private key, and creates a certificate signing request (CSR) to a CA you specify. 
 
      	 [bookmark: pgfId-8194086]After the CA issues the signed certificate, upload it to the internal CA object, replacing the unsigned certificate. 
 
     
 
     [bookmark: pgfId-8194087]You can only reference an internal CA object in an SSL rule if it contains a signed certificate. 
 
     [bookmark: pgfId-8194088]To create an unsigned CA certificate and CSR:
 
     
 
     [bookmark: pgfId-8194840]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194094]The Object Management page appears.
 
     [bookmark: pgfId-8194095]Step 2 Under PKI, select Internal CAs.
 
     [bookmark: pgfId-8194096]Step 3 Click Generate CA.
 
     [bookmark: pgfId-8194097]The Generate Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194098]Step 4 Type a Name for the internal CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8194102]Step 5 Type the identification attributes, as described in Table 2-9.
 
     [bookmark: pgfId-8194103]Step 6 Click Generate CSR.
 
     [bookmark: pgfId-8194104]The Generate Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194105]Step 7 Copy the CSR to submit to a CA.
 
     [bookmark: pgfId-8194106]Step 8 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194107]The CA object is created. Note that before you can use it, you must upload a signed certificate issued by a CA.
 
     [bookmark: pgfId-8194108]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8194109]To upload a signed certificate issued in response to a CSR:
 
     
 
     [bookmark: pgfId-8194828]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194115]The Object Management page appears.
 
     [bookmark: pgfId-8194116]Step 2 Under PKI, select Internal CAs.
 ) next to the CA object containing the unsigned certificate awaiting the CSR. 
     
 
     [bookmark: pgfId-8194121]The Edit Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194122]Step 4 Click Install Certificate.
 
     [bookmark: pgfId-8194123]The Install Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194124]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file. 
 
     [bookmark: pgfId-8194125]Step 6 If the uploaded file is password protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8194126]Step 7 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194127]The CA object contains a signed certificate, and can be referenced in SSL rules.
 
     [bookmark: pgfId-8194128]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8194132][bookmark: 35953]Downloading a CA Certificate and [bookmark: marker-8194131]Private Key
 
     [bookmark: pgfId-8194136]License: Any
 
     [bookmark: pgfId-8194145]You can back up or transfer a CA certificate and paired private key by downloading a file containing the certificate and key information from an internal CA object.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8194146] 
      Caution Always store downloaded key information in a secure location. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8194147]The system encrypts the private key stored in an internal CA object with a randomly generated key before saving it to disk. If you download a certificate and private key from an internal CA object, the system first decrypts the information before creating a file containing the certificate and private key information. You must then provide a password the system uses to encrypt the downloaded file.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8194148] 
      Caution Private keys downloaded as part of a system backup are decrypted, then stored in the unencrypted backup file. For more information, see 
      Creating Backup Files. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8194152]To download an internal CA certificate and private key:
 
     
 
     [bookmark: pgfId-8194816]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194158]The Object Management page appears.
 
     [bookmark: pgfId-8194159]Step 2 Under PKI, select Internal CAs.
 ) next to the internal CA object whose certificate and private key you want to download. 
     
 
     [bookmark: pgfId-8194164]The Edit Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194165]Step 4 Click Download.
 
     [bookmark: pgfId-8194166]The Encrypt Download File pop-up window appears.
 
     [bookmark: pgfId-8194167]Step 5 Type an encryption password in the Password and Confirm Password fields.
 
     [bookmark: pgfId-8194168]Step 6 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194169]You are prompted to save the file.
 
     [bookmark: pgfId-8194170]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8194175][bookmark: 43848]Working with Trusted Certificate [bookmark: marker-8194174]Authority Objects
 
     [bookmark: pgfId-8194179]License: Any
 
     [bookmark: pgfId-8194189]Each trusted certificate authority (CA) object you configure represents a CA public key certificate belonging to a trusted CA outside your organization. The object consists of the object name and CA public key certificate. You can use external CA objects and groups (see Grouping Objects) in the SSL policy to control traffic encrypted with a certificate signed either by the trusted CA, or any CA within the chain of trust. 
 
     [bookmark: pgfId-8194193]After you create the trusted CA object, you can modify the name and add certificate revocation lists (CRL), but cannot modify other object properties. There is no limit on the number of CRLs you can add to an object. If you want to modify a CRL you have uploaded to an object, you must delete the object and recreate it. 
 
     [bookmark: pgfId-8194194]You cannot delete a trusted CA object that is in use. Additionally, after you edit a trusted CA object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8194195]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-8194199]Working with Geolocation Objects
 
      	 [bookmark: pgfId-8194203]Adding a Certificate Revocation List to a Trusted CA Object
 
     
 
    
 
     
      [bookmark: pgfId-8194206]Adding a [bookmark: marker-8194205]Trusted CA Object
 
     [bookmark: pgfId-8194210]License: Any
 
     [bookmark: pgfId-8194218]You can configure an external CA object by uploading an X.509 v3 CA certificate. You can upload a file encoded in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8194219]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8194220]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8194221]If the file is password-protected, you must supply the decryption password. If the certificate is encoded in the PEM format, you can also copy and paste the information. 
 
     [bookmark: pgfId-8194222]You can upload a CA certificate only if the file contains proper certificate information; the system validates the certificate before saving the object.
 
     [bookmark: pgfId-8194223]To import a trusted CA certificate:
 
     
 
     [bookmark: pgfId-8194804]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194229]The Object Management page appears.
 
     [bookmark: pgfId-8194230]Step 2 Under PKI, select Trusted CAs.
 
     [bookmark: pgfId-8194231]Step 3 Click Add Trusted CAs.
 
     [bookmark: pgfId-8194232]The Import Trusted Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194233]Step 4 Type a Name for the trusted CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8194234]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file. 
 
     [bookmark: pgfId-8194235]Step 6 If the file is password-protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8194236]Step 7 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194237]The trusted CA object is added.
 
     [bookmark: pgfId-8194238]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8194241][bookmark: 27054]Adding a Certificate Revocation List to a [bookmark: marker-8194240]Trusted CA Object
 
     [bookmark: pgfId-8194245]License: Any
 
     [bookmark: pgfId-8194253]You can upload CRLs to a trusted CA object. If you reference that trusted CA object in an SSL policy, you can control encrypted traffic based on whether the CA that issued the session encryption certificate subsequently revoked the certificate. You can upload files encoded in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8194254]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8194255]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8194256]After you add the CRL, you can view the list of revoked certificates. If you want to modify a CRL you have uploaded to an object, you must delete the object and recreate it.
 
     [bookmark: pgfId-8194257]You can upload only files that contain a proper CRL. There is no limit to the number of CRLs you can add to a trusted CA object. However, you must save the object each time you upload a CRL, before adding another CRL.
 
     [bookmark: pgfId-8194258]To upload a CRL:
 
     
 
     [bookmark: pgfId-8194792]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194264]The Object Management page appears.
 
     [bookmark: pgfId-8194265]Step 2 Under PKI, select Trusted CAs.
 ) next to a trusted CA object. 
     
 
     [bookmark: pgfId-8194270]The Edit Trusted Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8194271]Step 4 Click Add CRL to upload a DER or PEM-encoded CRL file.
 
     [bookmark: pgfId-8194272]Step 5 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194273]Your changes are saved.
 
     [bookmark: pgfId-8194274]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8194279][bookmark: 18936]Working with External Certificate [bookmark: marker-8194278]Objects
 
     [bookmark: pgfId-8194283]License: Any
 
     [bookmark: pgfId-8194293]Each external certificate object you configure represents a server public key certificate that does not belong to your organization. The object consists of the object name and certificate. You can use external certificate objects and groups (see Grouping Objects) in SSL rules to control traffic encrypted with the server certificate. For example, you can upload a self-signed server certificate that you trust, but cannot verify with a trusted CA certificate.
 
     [bookmark: pgfId-8194297]You can configure an external certificate object by uploading an X.509 v3 server certificate. You can upload a file in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8194298]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8194299]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8194300]You can upload only files that contains proper server certificate information; the system validates the file before saving the object. If the certificate is encoded in the PEM format, you can also copy and paste the information. 
 
     [bookmark: pgfId-8194301]After you create the external certificate object, you can modify the name, but cannot modify other object properties. 
 
     [bookmark: pgfId-8194302]You cannot delete an external certificate object that is in use. Additionally, after you edit an external certificate object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8194303]To add an external certificate object:
 
     
 
     [bookmark: pgfId-8194751]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194752]The Object Management page appears.
 
     [bookmark: pgfId-8194310]Step 2 Under PKI, select External Certs.
 
     [bookmark: pgfId-8194311]Step 3 Click Add External Cert.
 
     [bookmark: pgfId-8194312]The Add Known External Certificate pop-up window appears.
 
     [bookmark: pgfId-8194313]Step 4 Type a Name for the external certificate object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8194314]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 server certificate file. 
 
     [bookmark: pgfId-8194315]Step 6 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194316]The internal CA object is added.
 
     [bookmark: pgfId-8194317]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8194322][bookmark: 98828]Working with Internal Certificate [bookmark: marker-8194321]Objects
 
     [bookmark: pgfId-8194326]License: Any
 
     [bookmark: pgfId-8194336]Each internal certificate object you configure represents a server public key certificate belonging to your organization. The object consists of the object name, public key certificate, and paired private key. You can use internal certificate objects and groups (see Grouping Objects) in SSL rules to decrypt traffic incoming to one of your organization’s servers using the known private key.
 
     [bookmark: pgfId-8194340]You can configure an internal certificate object by uploading an X.509 v3 RSA-based or elliptic curve-based server certificate and paired private key. You can upload a file in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8194341]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8194342]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8194343]If the file is password-protected, you must supply the decryption password. If the certificate and key are encoded in the PEM format, you can also copy and paste the information.
 
     [bookmark: pgfId-8194344]You can upload only files that contain proper certificate or key information, and that are paired with each other. The system validates the pair before saving the object.
 
     [bookmark: pgfId-8194345]After you create the internal certificate object, you can modify the name, but cannot modify other object properties. 
 
     [bookmark: pgfId-8194346]You cannot delete an internal certificate object that is in use. Additionally, after you edit an internal certificate object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8194347]To add an internal certificate object:
 
     
 
     [bookmark: pgfId-8194732]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
     [bookmark: pgfId-8194733]The Object Management page appears.
 
     [bookmark: pgfId-8194737]Step 2 Under PKI, select Internal Certs.
 
     [bookmark: pgfId-8194355]Step 3 Click Add Internal Cert.
 
     [bookmark: pgfId-8194356]The Add Known Internal Certificate pop-up window appears.
 
     [bookmark: pgfId-8194357]Step 4 Type a Name for the internal certificate object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8194358]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 server certificate file. 
 
     [bookmark: pgfId-8194359]Step 6 Above the Key field, or click Browse to upload a DER or PEM-encoded paired private key file.
 
     [bookmark: pgfId-8194360]Step 7 If the uploaded private key file is password-protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8194361]Step 8 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-8194362]The internal certificate object is added.
 
     [bookmark: pgfId-8194363]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7859396][bookmark: 25469][bookmark: 51004][bookmark: 48697]Working[bookmark: marker-7859395] with Geolocation Objects
 
    [bookmark: pgfId-7621163]License: Any
 
    [bookmark: pgfId-7806732]Each geolocation object you configure represents one or more countries or continents that the system has identified as the source or destination of traffic on your monitored network. You can use geolocation objects in access control policies. For example, you could write an access control rule that blocks traffic to or from certain countries. For information on filtering traffic by geographical location, see Controlling Traffic by Network or Geographical Location.
 
    [bookmark: pgfId-7621188]To ensure that you are using up-to-date information to filter your network traffic, Cisco strongly recommends that you regularly update your Geolocation Database (GeoDB). For information on downloading and installing GeoDB updates, see Updating the Geolocation Database.
 
    [bookmark: pgfId-7621192]You cannot delete a geolocation object that is in use. Additionally, after you edit a geolocation object used in an access control policy, you must reapply the access control policy for your changes to take effect.
 
    [bookmark: pgfId-7621193]To add a geolocation object:
 
    
 
    [bookmark: pgfId-7621195]Step 1 Select Configuration > ASA FirePOWER Configuration > Object Management.
 
    [bookmark: pgfId-7621196]The Object Management page appears.
 
    [bookmark: pgfId-7621197]Step 2 Select Geolocation.
 
    [bookmark: pgfId-7621198]The Geolocation Objects page appears.
 
    [bookmark: pgfId-7621199]Step 3 Click Add Geolocation.
 
    [bookmark: pgfId-7621200]The Geolocation Object pop-up window appears.
 
    [bookmark: pgfId-7621205]Step 4 Type a Name for the geolocation object. You can use any printable standard ASCII characters except curly braces ({}).
 
    [bookmark: pgfId-7621206]Step 5 Select the check boxes for the countries and continents you want to include in your geolocation object. 
 
    [bookmark: pgfId-7806960]Selecting a continent selects all countries within that continent, as well as any countries that GeoDB updates may add under that continent in the future. Deselecting any country under a continent deselects the continent. You can select any combination of countries and continents.
 
    [bookmark: pgfId-7621207]Step 6 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-7621208]The geolocation object is added.
 
    [bookmark: pgfId-7995839]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7621209]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-8085878][bookmark: 40568]Managing Device Configuration 
      
      
 
     
 
 
    [bookmark: pgfId-8103916]The Device Management page allows you to manage the device and interface configurations for the ASA FirePOWER module.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8159931] 
     Caution If you configure the ASA in a failover pair, the ASA FirePOWER configuration does not automatically synchronize with the ASA FirePOWER module on the secondary device. You must manually export the ASA FirePOWER configuration from the primary and import it into the secondary every time you make a change. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8115829]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-8115866]Editing Device Configuration
 
     	 [bookmark: pgfId-8139565]Managing ASA FirePOWER Module Interfaces
 
     	 [bookmark: pgfId-8160387]Applying Changes to Device Configuration
 
     	 [bookmark: pgfId-8276813]Configuring Remote Management
 
     	 [bookmark: pgfId-8276823]Configuring eStreamer on the eStreamer Server
 
    
 
   
 
    
     [bookmark: pgfId-8116026][bookmark: 98630]Editing Device Configuration
 
    [bookmark: pgfId-8220648]The Device tab of the Device Management page displays detailed device configuration and information, as it applies to the ASA FirePOWER module. It also allows you to make changes to some parts of device configuration, such as changing the displayed module name and modifying management settings.
 
    [bookmark: pgfId-8103917]See the following sections for more information:
 
     
     	 [bookmark: pgfId-8103921]Editing General Device Configuration
 
     	 [bookmark: pgfId-8103929]Viewing Device System Settings
 
     	 [bookmark: pgfId-8234456]Understanding Advanced Device Settings
 
    
 
     
      [bookmark: pgfId-8104332][bookmark: 60974]Editing General Device Configuration
 
     [bookmark: pgfId-8104336]License: Any
 
     [bookmark: pgfId-8104339]The General section of the Device tab shows the module name, which you can change. Here, you can also specify whether or not the device can transfer packets to the ASA FirePOWER module.
 
     [bookmark: pgfId-8104340]To edit general device configuration:
 
     
 
     [bookmark: pgfId-8104345]Step 1 Select Configuration > ASA FirePOWER Configuration > Device Management > Device.
 
     [bookmark: pgfId-8104346]The Device page appears.
 ). 
     
 
     [bookmark: pgfId-8104359]The General pop-up window appears.
 
     [bookmark: pgfId-8104360]Step 3 In the Name field, type a new assigned name for the module. You may enter alphanumeric characters and special characters, with the exception of the following characters, which are invalid: +, (, ), {, }, #, &, \, <, >, ?, ‘, and “.
 
     [bookmark: pgfId-8114856]Step 4 Select the Transfer Packets check box to allow packet data to be stored in the ASA FirePOWER module with events. Clear the check box to prevent the device from sending packet data with the events.
 
     [bookmark: pgfId-8104361]Step 5 Click Save.
 
     [bookmark: pgfId-8104512]The changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Device Configuration for more information.
 
     [bookmark: pgfId-8104516]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8104621][bookmark: 97879]Viewing Device System Settings
 
     [bookmark: pgfId-8104626]License: Any
 
     [bookmark: pgfId-8104627]The System section of the Device tab displays a read-only table of system information, as described in the following table.
 
     [bookmark: pgfId-8104660]
 
      
       
        
        [bookmark: pgfId-8104633]Table 3-1 System Section Table Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-8104637]Field 
          
  
         	 
           
           [bookmark: pgfId-8104639]Description 
          
  
        
 
         
         	[bookmark: pgfId-8104641]Model
  
         	[bookmark: pgfId-8104643]The model name and number for the device.
  
        
 
         
         	[bookmark: pgfId-8104645]Serial
  
         	[bookmark: pgfId-8104647]The serial number of the chassis of the device.
  
        
 
         
         	[bookmark: pgfId-8104649]Time
  
         	[bookmark: pgfId-8104651]The current system time of the device.
  
        
 
         
         	[bookmark: pgfId-8104653]Version
  
         	[bookmark: pgfId-8104655]The version of the software currently installed on the ASA FirePOWER module.
  
        
 
         
         	[bookmark: pgfId-8104657]Policy
  
         	[bookmark: pgfId-8104659]A link to the system policy currently applied to the ASA FirePOWER module.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-8234757][bookmark: 73167][bookmark: 12945]Understanding Advanced Device Settings
 
     [bookmark: pgfId-8234766]The Advanced section of the Device tab displays advanced configuration settings, as described in the following table.
 
     [bookmark: pgfId-8234825]
 
      
       
        
        [bookmark: pgfId-8241796]Table 3-2 Advanced Section Table Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-8241800]Field 
          
  
         	 
           
           [bookmark: pgfId-8241802]Description 
          
  
        
 
         
         	[bookmark: pgfId-8241804]Application Bypass
  
         	[bookmark: pgfId-8241806]The state of Automatic Application Bypass on the module.
  
        
 
         
         	[bookmark: pgfId-8241808]Bypass Threshold
  
         	[bookmark: pgfId-8241810]The Automatic Application Bypass threshold, in milliseconds.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8234826]You can use the Advanced section to edit any of these settings. See the following sections for more information:
 
      
      	 [bookmark: pgfId-8234830]Automatic Application Bypass
 
      	 [bookmark: pgfId-8234834]Editing Advanced Device Settings
 
     
 
    
 
     
      [bookmark: pgfId-8234841][bookmark: 74071]Automatic Appli[bookmark: marker-8234840]cation Bypass
 
     [bookmark: pgfId-8234845]License: Any
 
     [bookmark: pgfId-8234846]The Automatic Application Bypass (AAB) feature limits the time allowed to process packets through an interface and allows packets to bypass detection if the time is exceeded. The feature functions with any deployment; however, it is most valuable in inline deployments.
 
     [bookmark: pgfId-8234847]You balance packet processing delays with your network’s tolerance for packet latency. When a malfunction within Snort or a device misconfiguration causes traffic processing time to exceed a specified threshold, AAB causes Snort to restart within ten minutes of the failure, and generates troubleshoot data that can be analyzed to investigate the cause of the excessive processing time.
 
     [bookmark: pgfId-8234868]You can change the bypass threshold if the option is selected. The default setting is 3000 milliseconds (ms). The valid range is from 250 ms to 60,000 ms.
 
      
       
     
 
     
 
     [bookmark: pgfId-8234873]Note AAB is activated only when an excessive amount of time is spent processing a single packet. If AAB engages, the system kills all Snort processes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8234878]For more information about enabling Automatic Application Bypass and setting the bypass threshold, see Editing Advanced Device Settings.
 
    
 
     
      [bookmark: pgfId-8234884][bookmark: 59249]Editing Advanced Device Settings
 
     [bookmark: pgfId-8234894]You can use the Advanced section of the Devices tab to modify the Automatic Application Bypass. 
 
     [bookmark: pgfId-8234907]To modify advanced device settings:
 
     
 
     [bookmark: pgfId-8241840]Step 1 Select Configuration > ASA FirePOWER Configuration > Device Management > Device.
 
     [bookmark: pgfId-8241841]The Device page appears.
 ). 
     
 
     [bookmark: pgfId-8234926]The Advanced pop-up window appears.
 
     [bookmark: pgfId-8234927]Step 3 Optionally, select Automatic Application Bypass if your network is sensitive to latency. Automatic Application Bypass is most useful in inline deployments. For more information, see Automatic Application Bypass.
 
     [bookmark: pgfId-8234931]Step 4 When you select the Automatic Application Bypass option, you can type a Bypass Threshold in milliseconds (ms). The default setting is 3000 ms and the valid range is from 250 ms to 60,000 ms.
 
     [bookmark: pgfId-8234937]Step 5 Click Save.
 
     [bookmark: pgfId-8234938]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Device Configuration for more information.
 
     [bookmark: pgfId-8234942]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8105545][bookmark: 48241]Managing ASA FirePOWER Module Interfaces[bookmark: marker-8105544]
 
    [bookmark: pgfId-8105553]License: Control, Protection
 
    [bookmark: pgfId-8105564]When editing an ASA FirePOWER interface, you can configure only the interface’s security zone from the ASA FirePOWER module. See Working with Security Zones for more information.
 
    [bookmark: pgfId-8105577]You configure interfaces using ASDM and CLI.
 
    [bookmark: pgfId-8105591]To edit an ASA FirePOWER Interface:
 
    
 
    [bookmark: pgfId-8117308]Step 1 Select Configuration > ASA FirePOWER Configuration > Device Management > Interfaces.
 
    [bookmark: pgfId-8117309]The Interfaces page appears.
 ). 
    
 
    [bookmark: pgfId-8105607]The Edit Interface pop-up window appears.
 
    [bookmark: pgfId-8105608]Step 3 From the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
    [bookmark: pgfId-8105609]Step 4 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-8105610]The security zone is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Device Configuration for more information.
 
    [bookmark: pgfId-8184926]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8185334][bookmark: 33601]Applying Changes to Device Configuration
 
    [bookmark: pgfId-8185338]License: Any
 
    [bookmark: pgfId-7796521]After you make changes to the ASA FirePOWER configuration of a device, you must apply the changes before they take effect throughout the module. Note that the device must have unapplied changes or this option remains disabled.
 
    [bookmark: pgfId-7796522]Note that if you edit interfaces and reapply a device policy, Snort restarts for all interface instances on the device, not just those that you edited.
 
    [bookmark: pgfId-7208697]To apply changes to the device:
 
    
 
    [bookmark: pgfId-7213451]Step 1 Select Configuration > ASA FirePOWER Configuration > Device Management > Device or Configuration > ASA FirePOWER Configuration > Device Management > Interfaces.
 
    [bookmark: pgfId-7213452]The Device Management page appears.
 
    [bookmark: pgfId-7482815]Step 2 Click Apply ASA FirePOWER Changes.
 
    [bookmark: pgfId-7482819]Step 3 When prompted, click Apply.
 
    [bookmark: pgfId-7214316]The device changes are applied.
 
     
      
    
 
    
 
    [bookmark: pgfId-7214323]Tip Optionally, from the Apply Device Changes dialog box, click View Changes. The Device Management Revision Comparison Report page appears in a new window. For more information, see Using the Device Management Revision Comparison Report.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7214705]Step 4 Click OK.
 
    [bookmark: pgfId-7214759]You are returned to the Device Management page.
 
    [bookmark: pgfId-7876391]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-7208680][bookmark: 37619]Using the Device Management Revis[bookmark: marker-7368489]ion Comparison Report
 
     [bookmark: pgfId-7214662]License: Any
 
     [bookmark: pgfId-7214908]A device management comparison report allows you to view the changes you have made to an appliance before you apply them. The report displays all differences between the current appliance configuration and the proposed appliance configuration. This gives you an opportunity to discover any potential configuration errors.
 
     [bookmark: pgfId-7214917]To compare appliance changes before applying them:
 
     
 
     [bookmark: pgfId-7214919]Step 1 Select Configuration > ASA FirePOWER Configuration > Device Management > Device or Configuration > ASA FirePOWER Configuration > Device Management > Interfaces.
 
     [bookmark: pgfId-7214920]The Device Management page appears.
 
     [bookmark: pgfId-7214921]Step 2 Click Apply Changes.
 
     [bookmark: pgfId-7246795]The Apply Device Changes pop-up window appears. Note that the appliance must have unapplied changes or the Apply Changes button remains disabled.
 
     [bookmark: pgfId-7215283]Step 3 Click View Changes.
 
     [bookmark: pgfId-7215284]The Device Management Revision Comparison Report page appears in a new window.
 
     [bookmark: pgfId-7215288]Step 4 Click Previous and Next to scroll through the differences between the current appliance configuration and the proposed appliance configuration.
 
     [bookmark: pgfId-7345916]Step 5 Optionally, click Comparison Report to produce a PDF version of the report.
 
     [bookmark: pgfId-7876407]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8277172][bookmark: 18221]Configuring[bookmark: marker-8277169] Remote Management
 
    [bookmark: pgfId-8282158]License: Any
 
    [bookmark: pgfId-8277182]Before you can manage one FireSIGHT System appliance with another, you must set up a two-way, SSL-encrypted communication channel between the two appliances. The appliances use the channel to share configuration and event information. High availability peers also use the channel, which is by default on port 8305/tcp.
 
    [bookmark: pgfId-8277183]You must configure remote management on the appliance that will be managed, that is, on the device that you want to manage with a Defense Center. After you configure remote management, you can use the managing appliance’s web interface to add the managed appliance to your deployment.
 
     
      
    
 
    
 
    [bookmark: pgfId-8277189]Note After you establish remote management and register the Cisco ASA with FirePOWER Services to a Defense Center, you must manage the ASA FirePOWER module from the Defense Center instead of ASDM.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8277204]To enable communications between two appliances, you must provide a way for the appliances to recognize each other. There are three criteria the FireSIGHT System uses when allowing communications:
 
     
     	 [bookmark: pgfId-8277208]the hostname or IP address of the appliance with which you are trying to establish communication
 
    
 
    [bookmark: pgfId-8277209]In NAT environments, even if the other appliance does not have a routable address, you must provide a hostname or an IP address either when you are configuring remote management, or when you are adding the managed appliance.
 
     
     	 [bookmark: pgfId-8277210]a self-generated alphanumeric registration key up to 37 characters in length that identifies the connection
 
     	 [bookmark: pgfId-8277214]an optional unique alphanumeric NAT ID that can help the FireSIGHT System establish communications in a NAT environment
 
    
 
    [bookmark: pgfId-8277215]The NAT ID must be unique among all NAT IDs used to register managed appliances.
 
    [bookmark: pgfId-8277296]When you register a managed device to a Defense Center, the access control policy you select applies to the device. However, if you do not enable licenses for the device required by features used in the access control policy you select, the access control policy apply fails.
 
    [bookmark: pgfId-8277303]To configure remote management of the local appliance:
 
    [bookmark: pgfId-8277307]Access: Admin
 
    
 
    [bookmark: pgfId-8277308]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > Configuration > Registration.
 
    [bookmark: pgfId-8277309]The Remote Management page appears.
 
    [bookmark: pgfId-8277317]Step 2 Click Add Manager.
 
    [bookmark: pgfId-8277318]The Add Remote Management page appears.
 
    [bookmark: pgfId-8277319]Step 3 In the Management Host field, type the IP address or the hostname of the appliance that you want to use to manage this appliance.
 
    [bookmark: pgfId-8277320]The hostname is the fully qualified domain name or the name that resolves through the local DNS to a valid IP address.
 
    [bookmark: pgfId-8277321]In a NAT environment, you do not need to specify an IP address or hostname here if you plan to specify it when you add the managed appliance. In this case, the FireSIGHT System uses the NAT ID you will provide later to identify the remote manager on the managed ASA FirePOWER module interface.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8277325] 
     Caution Use a hostname rather than an IP address if your network uses DHCP to assign IP addresses. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8277326]Step 4 In the Registration Key field, type the registration key that you want to use to set up communications between appliances.
 
    [bookmark: pgfId-8277327]Step 5 For NAT environments, in the Unique NAT ID field, type a unique alphanumeric NAT ID that you want to use to set up communications between appliances.
 
    [bookmark: pgfId-8277328]Step 6 Click Save.
 
    [bookmark: pgfId-8277329]After the appliances confirm that they can communicate with each other, the Pending Registration status appears.
 
    [bookmark: pgfId-8277330]Step 7 Use the managing appliance’s web user interface to add this appliance to your deployment.
 
     
      
    
 
    
 
    [bookmark: pgfId-8277365]Note When enabling remote management of a device, in some high availability deployments that use NAT, you may also need to add the secondary Defense Center as a manager. For more information, contact Support.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8277369]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-8277388]Editing Rem[bookmark: marker-8277386]ote Management
 
     [bookmark: pgfId-8277393]License: Any
 
     [bookmark: pgfId-8277394]Use the following procedure to edit the hostname or IP address of the managing appliance. You can also change the display name of the managing appliance, which is a name only used within the context of the FireSIGHT System. Although you can use the hostname as the display name of the appliance, entering a different display name does not change the hostname.
 
     [bookmark: pgfId-8277409]To edit remote management:
 
     [bookmark: pgfId-8277413]Access: Admin
 
     
 
     [bookmark: pgfId-8277414]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > Configuration > Registration.
 
     [bookmark: pgfId-8277415]The Remote Management page appears.
 ) next to the manager for which you want to edit remote management settings. 
     
 
     [bookmark: pgfId-8277420]The Edit Remote Management page appears.
 
     [bookmark: pgfId-8277421]Step 3 In the Name field, change the display name of the managing appliance.
 
     [bookmark: pgfId-8277422]Step 4 In the Host field, change the IP address or the hostname of the managing appliance.
 
     [bookmark: pgfId-8277423]The hostname is the fully qualified domain name or the name that resolves through the local DNS to a valid IP address. 
 
     [bookmark: pgfId-8277424]Step 5 Click Save.
 
     [bookmark: pgfId-8277425]Your changes are saved.
 
     [bookmark: pgfId-8277426]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8277477][bookmark: 83515]Configuring eStreamer o[bookmark: marker-8277473]n the eStreamer Server
 
     [bookmark: pgfId-8277488]License: FireSIGHT + Protection
 
     [bookmark: pgfId-8277495]Before the appliance you want to use as an eStreamer server can begin streaming eStreamer events to an external client, you must configure the eStreamer server to send events to clients, provide information about the client, and generate a set of authentication credentials to use when establishing communication.
 
     [bookmark: pgfId-8277503][bookmark: 58979]Configuring eStreamer Event Types
 
     [bookmark: pgfId-8277507]You can control which types of events the eStreamer server is able to transmit to clients that request them. 
 
     [bookmark: pgfId-8277511]Available event types on either a managed device or a Defense Center are:
 
      
      	 [bookmark: pgfId-8277512]Intrusion events
 
      	 [bookmark: pgfId-8277513]Intrusion event packet data
 
      	 [bookmark: pgfId-8277514]Intrusion event extra data
 
     
 
     [bookmark: pgfId-8277561]To configure the types of events transmitted by eStreamer:
 
     
 
     [bookmark: pgfId-8277566]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > Configuration > Registration.
 
     [bookmark: pgfId-8277567]The Registration page appears.
 
     [bookmark: pgfId-8277571]Step 2 Select the eStreamer tab.
 
     [bookmark: pgfId-8277575]The eStreamer page appears.
 
     [bookmark: pgfId-8277579]Step 3 Under eStreamer Event Configuration, select the check boxes next to the types of events you want eStreamer to forward to requesting clients. 
 
     [bookmark: pgfId-8277586]You can select any or all of the following on a managed device or Defense Center:
 
      
       
       	 [bookmark: pgfId-8277587] Intrusion Events to transmit intrusion events.
 
       	 [bookmark: pgfId-8277588] Intrusion Event Packet Data  to transmit packets associated with intrusion events.
 
       	 [bookmark: pgfId-8277589] Intrusion Event Extra Data to transmit additional data associated with an intrusion event such as the originating IP addresses of a client connecting to a web server through an HTTP proxy or load balancer.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8277606]Note Note that this controls which events the eStreamer server can transmit. Your client must still specifically request the types of events you want it to receive in the request message it sends to the eStreamer server. For more information, see the FireSIGHT System eStreamer Integration Guide.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8277625]Step 4 Click Save.
 
     [bookmark: pgfId-8277629]Your settings are saved and the events you selected will be forwarded to eStreamer clients when requested.
 
     [bookmark: pgfId-8277630]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8277659][bookmark: 38601]Adding Authentication for eStreamer Clients
 
     [bookmark: pgfId-8277669]Before eStreamer can send eStreamer events to a client, you must add the client to the eStreamer server’s peers database from the eStreamer page. You must also copy the authentication certificate generated by the eStreamer server to the client.
 
     [bookmark: pgfId-8277692]To add an eStreamer client:
 
     
 
     [bookmark: pgfId-8277697]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > Configuration > Registration.
 
     [bookmark: pgfId-8277698]The Registration page appears.
 
     [bookmark: pgfId-8277702]Step 2 Select the eStreamer tab.
 
     [bookmark: pgfId-8277706]The eStreamer page appears.
 
     [bookmark: pgfId-8277707]Step 3 Click Create Client.
 
     [bookmark: pgfId-8277708]The Create Client page appears.
 
     [bookmark: pgfId-8277712]Step 4 In the Hostname field, enter the host name or IP address of the host running the eStreamer client.
 
      
       
     
 
     
 
     [bookmark: pgfId-8277716]Note If you use a host name, the eStreamer server must be able to resolve the host to an IP address. If you have not configured DNS resolution, you should configure it first or use an IP address. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8277751]Step 5 If you want to encrypt the certificate file, enter a password in the Password field.
 
     [bookmark: pgfId-8277752]Step 6 Click Save.
 
     [bookmark: pgfId-8277759]The eStreamer server now allows the host to access port 8302 on the eStreamer server and creates an authentication certificate to use during client-server authentication. The eStreamer page reappears, with the new client listed under Hostname.
 ) next to the client hostname to download the certificate file. 
     
 
     [bookmark: pgfId-8277767]Step 8 Save the certificate file to the appropriate directory used by your client for SSL authentication.
 
     [bookmark: pgfId-8277774]The client can now connect to the eStreamer server. You do not need to restart the eStreamer service.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-8277782]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7877742]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 54587]Getting Started with Access Control Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1555895]An access control policy determines how the system handles traffic on your network. Each ASA FirePOWER module can have one currently applied policy.
 
    [bookmark: pgfId-1584451]The simplest access control policy handles all traffic using its default action. You can set this default action to block or trust all traffic without further inspection, or to inspect traffic for intrusions.
 
    [bookmark: pgfId-1832407]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1677380]Note that only ASA FirePOWER modules deployed inline can affect the flow of traffic. Applying an access control policy configured to block or alter traffic to passively deployed devices can have unexpected results. In some cases, the system prevents you from applying inline configurations to passively deployed ASA FirePOWER modules.
 
    [bookmark: pgfId-1581013]This chapter explains how to create and apply a simple access control policy. It also contains basic information on managing access control policies: editing, updating, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-1531230]Access Control License and Role Requirements
 
     	 [bookmark: pgfId-1531279]Creating a Basic Access Control Policy
 
     	 [bookmark: pgfId-1626024]Managing Access Control Policies
 
     	 [bookmark: pgfId-1531309]Editing Access Control Policies
 
     	 [bookmark: pgfId-1531331]Understanding Out-of-Date Policy Warnings
 
     	 [bookmark: pgfId-1531353]Deploying Configuration Changes
 
     	 [bookmark: pgfId-1649088]Troubleshooting Access Control Policies and Rules
 
     	 [bookmark: pgfId-1531406]Generating a Report of Current Access Control Settings
 
     	 [bookmark: pgfId-1531436]Comparing Access Control Policies
 
    
 
    [bookmark: pgfId-1581185]A more complex access control policy can blacklist traffic based on Security Intelligence data, as well as use access control rules to exert granular control over network traffic logging and handling. These rules can be simple or complex, matching and inspecting traffic using multiple criteria. Advanced access control policy options control preprocessing, performance, and other general preferences. 
 
    [bookmark: pgfId-1642870]After you create a basic access control policy, see the following chapters for more information on tailoring it to your deployment:
 
     
     	 [bookmark: pgfId-1557907]Blacklisting Using Security Intelligence IP Address Reputation explains how to immediately blacklist (block) connections based on the latest reputation intelligence.
 
     	 [bookmark: pgfId-1642993]Understanding Network Analysis and Intrusion Policies explains how network analysis and intrusion policies preprocess and examine packets, as part of the system’s intrusion detection and prevention feature.
 
     	 [bookmark: pgfId-1642997]Tuning Traffic Flow Using Access Control Rules explains how access control rules provide a granular method of handling network traffic across multiple ASA FirePOWER modules.
 
     	 [bookmark: pgfId-1557073]Controlling Traffic Using Intrusion and File Policies explains how intrusion and file policies provide the last line of defense before traffic is allowed to its destination, by detecting and optionally blocking intrusions, prohibited files, and malware.
 
    
 
   
 
    
     [bookmark: pgfId-1533028][bookmark: 50093]Access Control License and Role Requirements
 
    [bookmark: pgfId-1558221]Although you can create access control policies regardless of the licenses on your ASA FirePOWER module, many features require that you enable the appropriate licenses before you apply the policy. 
 
    [bookmark: pgfId-1790180]For more information, see License Requirements for Access Control.
 
     
      [bookmark: pgfId-1530919][bookmark: 68674]Lice[bookmark: marker-1533082]nse Requirements for Access Control
 
     [bookmark: pgfId-1531529]Although you can create access control policies regardless of the licenses on your ASA FirePOWER module, certain aspects of access control require that you enable specific licensed capabilities before you can apply the policy.
 
     [bookmark: pgfId-1532045]Warning icons and confirmation dialog boxes designate unsupported features for your deployment. For details, see Troubleshooting Access Control Policies and Rules.
 
      
       
        
        [bookmark: pgfId-1674531]Table 4-1 License Requirements for Access Control 
 
        
        
         
         	 
           
           [bookmark: pgfId-1674535]To apply an access control policy that... 
          
  
         	 
           
           [bookmark: pgfId-1674537]License 
          
  
        
 
         
         	[bookmark: pgfId-1674539]performs access control based on zone, network, or port
 [bookmark: pgfId-1674540]performs URL filtering using literal URLs and URL objects
  
         	[bookmark: pgfId-1674542]Any
  
        
 
         
         	[bookmark: pgfId-1674544]performs access control using geolocation data (source or destination country or continent)
  
         	[bookmark: pgfId-1674549]Any
  
        
 
         
         	[bookmark: pgfId-1674551]performs intrusion detection and prevention, file control, or Security Intelligence filtering
  
         	[bookmark: pgfId-1674556]Protection
  
        
 
         
         	[bookmark: pgfId-1674558]performs advanced malware protection, that is, network-based malware detection and blocking
  
         	[bookmark: pgfId-1674563]Malware
  
        
 
         
         	[bookmark: pgfId-1674565]performs user or application control
  
         	[bookmark: pgfId-1674570]Control
  
        
 
         
         	[bookmark: pgfId-1674572]performs URL filtering using category and reputation data
  
         	[bookmark: pgfId-1674577]URL Filtering
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1655629][bookmark: 94965]Creating a Basic Access Control Policy
 
    [bookmark: pgfId-1530990]License: Any
 
    [bookmark: pgfId-1566200]When you create a new access control policy you must give it a unique name and specify a default action. At this point, the default action determines how the ASA FirePOWER modules handles all traffic; you will add other configurations that affect traffic flow later.
 
     
     [image: ] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1663488]Tip When you first create an access control policy, you cannot choose to trust traffic as the default action. If you want to trust all traffic by default, change the default action after you create the policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1675724]Use the Access Control Policy page (Policies > Access Control) to create new and manage existing access control policies.
 
    [bookmark: pgfId-1762451]Optionally, you can use and modify the initial system-provided policy named Default Trust All Traffic.
 
    [bookmark: pgfId-1533385]To create an access control policy:
 
    
 
    [bookmark: pgfId-1663480]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1663481]The Access Control Policy page appears.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1533389]Step 2 Click New Policy.
 
   [bookmark: pgfId-1533390]The New Access Control Policy pop-up window appears.
 
   [bookmark: pgfId-1533391]Step 3 Give the policy a unique Name and, optionally, a Description.
 
   [bookmark: pgfId-1533392]You can use all printable characters, including spaces and special characters, except for the pound sign (#), a semi-colon (;), or either brace ({}). The name must include at least one non-space character.
 
   [bookmark: pgfId-1533709]Step 4 Specify the initial Default Action:
 
    
     
     	 [bookmark: pgfId-1533710] Block all traffic creates a policy with the  Access Control: Block All Traffic default action.
 
     	 [bookmark: pgfId-1533711] Intrusion Prevention creates a policy with the  Intrusion Prevention: Balanced Security and Connectivity default action.
 
    
 
   
 
   [bookmark: pgfId-1533612]For guidance on choosing an initial default action, as well as how to change it later, see Setting Default Handling and Inspection for Network Traffic.
 
   [bookmark: pgfId-1712130]Step 5 Click Store ASA FirePOWER Changes.
 
   [bookmark: pgfId-1712133]The access control policy editor appears. For information on configuring your new policy, see Editing Access Control Policies. Note that you must apply the policy for it to take effect; see Deploying Configuration Changes.
 
   [bookmark: pgfId-1611899]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1581225][bookmark: 56491]Setting Default Handling and Inspection for Network Traffic
 
    [bookmark: pgfId-1531016]License: Any
 
    [bookmark: pgfId-1559622]When you create an access control policy, you must select a default action. The default action for an access control policy determines how the system handles traffic that:
 
     
     	 [bookmark: pgfId-1534055]is not blacklisted by Security Intelligence
 
     	 [bookmark: pgfId-1564806]matches none of the rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic)
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1599193]The following table describes how the different default actions handle traffic, and lists the types of inspection you can perform on traffic handled by each default action. Note that you cannot perform file or malware inspection on traffic handled by the default action. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1534101]:
 
     
      
       
       [bookmark: pgfId-1559917]Table 4-2 [bookmark: 43759]Access Control Policy Default Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1559923]Default Action 
         
  
        	 
          
          [bookmark: pgfId-1559925]Effect on Traffic 
         
  
        	 
          
          [bookmark: pgfId-1559927]Inspection Type and Policy 
         
  
       
 
        
        	[bookmark: pgfId-1559929]Access Control: Block All Traffic
  
        	[bookmark: pgfId-1559931]block without further inspection
  
        	[bookmark: pgfId-1559933]none
  
       
 
        
        	[bookmark: pgfId-1559935]Access Control: Trust All Traffic
  
        	[bookmark: pgfId-1559937]trust (allow to its final destination without further inspection)
  
        	[bookmark: pgfId-1559939]none
  
       
 
        
        	[bookmark: pgfId-1575248][bookmark: marker-1575247]Intrusion Prevention
  
        	[bookmark: pgfId-1575250]allow, as long as it is passed by the intrusion policy you specify (requires a Protection license)
  
        	[bookmark: pgfId-1575256]intrusion, using the specified intrusion policy and associated variable set
  
       
 
       
     
 
    
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1562345]When you first create an access control policy, logging connections that are handled by the default action is disabled by default. If you select a default action that performs intrusion inspection, the system automatically associates the default intrusion variable set with the intrusion policy you select. You can change either of these options, as well as the default action itself, after you create the policy.
 
    [bookmark: pgfId-1534136]To change an access control policy’s default action and related options:
 
    
 
    [bookmark: pgfId-1678847]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1663473]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1534144]The access control policy editor appears.
 
    [bookmark: pgfId-1534145]Step 3 Select a Default Action.
 
     
      
      	 [bookmark: pgfId-1534146]To block all traffic, select  Access Control: Block All Traffic .
 
      	 [bookmark: pgfId-1534147]To trust all traffic, select  Access Control: Trust All Traffic .
 
      	 [bookmark: pgfId-1534149]To inspect all traffic with an intrusion policy, select an intrusion policy, all of which begin with the label Intrusion Prevention . Keep in mind that an intrusion policy can block traffic.
 
     
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1534154] 
     Caution Do 
     not use 
     Experimental Policy 1 unless instructed to do so by a Cisco representative. Cisco uses this policy for testing. 
      
      
 
     
 
    
 ) to change the variable set associated with the intrusion policy you selected. 
    
 ). If you do not change the variable set, the system uses a default set. For more information, see 
    Working with Variable Sets. 
    
 ) to change logging options for connections handled by the default action. 
    
 
    [bookmark: pgfId-1563423]You can log a matching connection at its beginning and end. Note that the system cannot log the end of blocked traffic. You can log connections to the ASA FirePOWER module event viewer, external system log (syslog) or SNMP trap server. For more information, see Logging Connections Handled by the Access Control Default Action.
 
    [bookmark: pgfId-1677528]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1677613][bookmark: 96544][bookmark: 13111]Managing Access Control Pol[bookmark: marker-1677612]icies
 
    [bookmark: pgfId-1625759]License: Any
 
    [bookmark: pgfId-1663429]On the Access Control Policy page (Configuration > ASA FirePOWER Configuration > Policies > Access Control) you can view your current custom access control policies, along information on whether a policy is applied.
 
    [bookmark: pgfId-1730957]In addition to custom policies that you create, the system provides a custom policy Default Allow All Traffic that you can edit and use.
 
    [bookmark: pgfId-1677649]Options on the Access Control Policy page allow you to take the actions in the following table.
 
    [bookmark: pgfId-1625862]
 
     
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1625773]Table 4-3 [bookmark: 22107]Access Control Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1625779]To... 
         
  
        	 
          
          [bookmark: pgfId-1625781]You can... 
         
  
        	 
          
          [bookmark: pgfId-1625783]See... 
         
  
       
 
        
        	[bookmark: pgfId-1625785]create a new access control policy
  
        	[bookmark: pgfId-1625787]click New Policy.
  
        	[bookmark: pgfId-1625792]Creating a Basic Access Control Policy
  
       
 
        
        	[bookmark: pgfId-1625794]edit an existing access control policy
  ). 
        	[bookmark: pgfId-1625804]Editing Access Control Policies
  
       
 
        
        	[bookmark: pgfId-1625806]reapply an access control policy
  ). 
        	[bookmark: pgfId-1625816]Deploying Configuration Changes
  
       
 
        
        	[bookmark: pgfId-1625818]export an access control policy to import on another ASA FirePOWER module
  ) 
        	[bookmark: pgfId-1625831]Exporting Configurations
  
       
 
        
        	[bookmark: pgfId-1625833]view a PDF report that lists the current configuration settings in an access control policy
  ). 
        	[bookmark: pgfId-1625842]Generating a Report of Current Access Control Settings
  
       
 
        
        	[bookmark: pgfId-1625845]compare access control policies
  
        	[bookmark: pgfId-1625847]click Compare Policies.
  
        	[bookmark: pgfId-1625851]Comparing Access Control Policies
  
       
 
        
        	[bookmark: pgfId-1625854]delete an access control policy
  
        	 ), then confirm that you want to delete the policy. You cannot delete an applied access control policy or one that is currently applying.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1530924][bookmark: 81356]Editing Access Control Policies
 
    [bookmark: pgfId-1629623]License: Any
 
    [bookmark: pgfId-1629625]When you first create a new access control policy, the access control policy editor appears, focused on the Rules tab. The following graphic shows a newly created policy. Because a new policy does not yet have rules or other configurations, the default action handles all traffic. In this case, the default action inspects traffic with the system-provided Balanced Security and Connectivity intrusion policy before allowing it to its final destination.
 
    [bookmark: pgfId-1832650]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1586188]Use the access control policy editor to add and organize rules, and so on. The following list provides information on the policy configurations you can change.
 
    [bookmark: pgfId-1587569]Name and Description
 
    [bookmark: pgfId-1587542]To change the policy’s name and description, click the appropriate field and type the new name or description.
 
    [bookmark: pgfId-1586216]Security Intelligence
 
    [bookmark: pgfId-1586218]Security Intelligence is a first line of defense against malicious Internet content. This feature allows you to immediately blacklist (block) connections based on the latest reputation intelligence. To ensure continual access to vital resources, you can override blacklists with custom whitelists. This traffic filtering takes place before any other policy-based inspection, analysis, or traffic handling, including rules and the default action. For more information, see Blacklisting Using Security Intelligence IP Address Reputation.
 
    [bookmark: pgfId-1587344]Rules
 
    [bookmark: pgfId-1587345]Rules provide a granular method of handling network traffic. Rules in an access control policy are numbered, starting at 1. The system matches traffic to access control rules in top-down order by ascending rule number.
 
    [bookmark: pgfId-1633555]In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. These conditions include security zone, network or geographical location, port, application, requested URL, or user. Conditions can be simple or complex; their use often depends on certain licenses. 
 
    [bookmark: pgfId-1633556]Use the Rules tab to add, categorize, enable, disable, filter, and otherwise manage rules. For more information, see Tuning Traffic Flow Using Access Control Rules.
 
    [bookmark: pgfId-1587430]Default Action
 
    [bookmark: pgfId-1713215]The default action determines how the system handles traffic that is not blacklisted by Security Intelligence and does not match any access control rules. Using the default action, you can block or trust all traffic without further inspection, or inspect traffic for intrusions. You can also enable or disable logging of connections handled by the default action.
 
    [bookmark: pgfId-1713219]For more information, see Setting Default Handling and Inspection for Network Traffic and Logging Connections Based on Access Control Handling.
 
    [bookmark: pgfId-1586223]HTTP Responses
 
    [bookmark: pgfId-1586225]You can specify what the user sees in a browser when the system blocks that user’s website request—either display a generic system-provided response page, or enter custom HTML. You can also display a page that warns users, but also allows them to click a button to continue or refresh the page to load the originally requested site. For more information, see Displaying a Custom Web Page for Blocked URLs.
 
    [bookmark: pgfId-1852870]Advanced Access Control Options
 
    [bookmark: pgfId-1852871]Advanced access control policy settings typically require little or no modification. The default settings are appropriate for most deployments. Advanced settings you can modify include:
 
    [bookmark: pgfId-1852872]General Settings:
 
    [bookmark: pgfId-1852873]Maximum URL characters to store in connection events—the number of characters you store in the ASA FirePOWER module database for each URL requested by your users; see Logging URLs Detected in Connections.
 
    [bookmark: pgfId-1852880]Allow an Interactive Block to bypass blocking for (seconds)—the length of time before you re-block a website after a user bypasses an initial block; see Setting the User Bypass Timeout for a Blocked Website
 
    [bookmark: pgfId-1852884]Retry URL cache miss lookup—when disabled, allows the system to immediately pass traffic to a URL without a cloud lookup when the category is not cached. The system treats URLs that require a cloud lookup as Uncategorized until the cloud lookup completes with a different category.
 
    [bookmark: pgfId-1852885]Inspect traffic during policy apply—when enabled (the default setting), inspects traffic when you deploy configuration changes unless specific configurations require restarting the Snort process. When enabled, resource demands could result in a small number of packets dropping without inspection.
 
    [bookmark: pgfId-1852886]Identity/SSL Policy Settings
 
    [bookmark: pgfId-1852887]Use advanced settings to associate subpolicies (SSL, identity) with access control;
 
    [bookmark: pgfId-1852888]Network Analysis and Intrusion Policies
 
    [bookmark: pgfId-1852889]Change the access control policy’s default intrusion policy and associated variable set, which are used to initially inspect traffic before the system can determine exactly how to inspect that traffic; change the access control policy’s default network analysis policy, which governs many preprocessing options:
 
    [bookmark: pgfId-1852892]Intrusion Policy used before Access Control rule is determined— see Setting the Default Intrusion Policy for Access Control.
 
    [bookmark: pgfId-1852897]Intrusion Policy Variable Set—see Working with Variable Sets.
 
    [bookmark: pgfId-1852900]Default Network Analysis Policy—see Setting the Default Network Analysis Policy for Access Control.
 
    [bookmark: pgfId-1852902]Use custom network analysis rules and policies to tailor preprocessing options to specific security zones, networks, and VLANs:
 
    [bookmark: pgfId-1852905]Custom Rules/Policies—see Customizing Preprocessing with Network Analysis Policies.
 
    [bookmark: pgfId-1852907]Files and Malware Settings
 
    [bookmark: pgfId-1852911]Tuning File and Malware Inspection Performance and Storage provides information on configuring performance options for file control and AMP for Firepower.
 
    [bookmark: pgfId-1852912]Intelligent Application Bypass Settings
 
    [bookmark: pgfId-1852913]Intelligent Application Bypass (IAB) is an expert-level configuration that specifies applications to bypass or test for bypass if traffic exceeds a combination of inspection performance and flow thresholds. For more information, see Intelligent Application Bypass (IAB).
 
    [bookmark: pgfId-1852917]Transport/Network Layer Preprocessor Settings
 
    [bookmark: pgfId-1852918]Advanced transport and network preprocessor settings apply globally to all networks, zones, and VLANs where you deploy your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy. For more information, see Configuring Advanced Transport/Network Settings.
 
    [bookmark: pgfId-1852922]Detection Enhancement Settings
 
    [bookmark: pgfId-1852923]Advanced detection enhancement settings allow you to use adaptive profiles to improve reassembly of packet fragments and TCP streams in passive deployments, based on your hosts' operating systems. For more information, see Tuning Preprocessing in Passive Deployments. 
 
    [bookmark: pgfId-1852927]Performance Settings
 
    [bookmark: pgfId-1852931]Tuning Intrusion Prevention Performance provides information on improving the performance of your system as it analyzes traffic for attempted intrusions. 
 
    [bookmark: pgfId-1852932]Latency-Based Performance Settings
 
    [bookmark: pgfId-1852935]For information specific to latency-based performance settings, see Configuring Packet and Intrusion Rule Latency Thresholds.
 
    [bookmark: pgfId-1576329]When you edit an access control policy, a message indicates that you have unsaved changes. To retain your changes, you must save the policy before exiting the policy editor. If you attempt to exit the policy editor without saving your changes, you are cautioned that you have unsaved changes; you can then discard your changes and exit the policy, or return to the policy editor.
 
    [bookmark: pgfId-1576330]To protect the privacy of your session, after sixty minutes of inactivity on the policy editor, changes to your policy are discarded and you are returned to the Access Control Policy page. After the first thirty minutes of inactivity, a message appears and updates periodically to provide the number of minutes remaining before changes are discarded. Any activity on the page cancels the timer.
 
    [bookmark: pgfId-1576400]To edit an access control policy:
 
    
 
    [bookmark: pgfId-1678861]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1663425]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1576408]The access control policy editor appears.
 
    [bookmark: pgfId-1576409]Step 3 Edit your policy. Take any of the actions summarized above. 
 
    [bookmark: pgfId-1712099]Step 4 Save or discard your configuration:
 
     
      
      	 [bookmark: pgfId-1712100]To save your changes and continue editing, click Store ASA FirePOWER Changes. 
 
      	 [bookmark: pgfId-1712103]To save your changes and apply your policy, click Apply ASA FirePOWER Changes . See Deploying Configuration Changes.
 
      	 [bookmark: pgfId-1576431]To discard your changes, click  Cancel and, if prompted, click  OK .
 
     
 
    
 
    [bookmark: pgfId-1611980]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1575908][bookmark: 63505]Understanding Out-of-Date Policy Warnings
 
    [bookmark: pgfId-1663412]License: Any
 
    [bookmark: pgfId-1663413]On the Access Control Policy page (Configuration > ASA FirePOWER Configuration > Policies > Access Control), out-of-date policies are marked with red status text.
 
    [bookmark: pgfId-1633872]In almost every case, whenever you change an access control policy, you must reapply it for the change to take effect. If the access control policy invokes other policies or relies on other configurations, changing those also requires that you reapply the access control policy (or, for intrusion policy changes, you can reapply just the intrusion policy). 
 
    [bookmark: pgfId-1572040]Configuration changes that require a policy reapply include:
 
     
     	 [bookmark: pgfId-1572041]Modifying the access control policy itself: any changes to access control rules, the default action, Security Intelligence filtering, advanced options including NAP rules, and so on.
 
     	 [bookmark: pgfId-1572042]Changing any of the intrusion and file policies that the access control policy invokes: network analysis policies, intrusion policies, and file policies.
 
     	 [bookmark: pgfId-1633843]Changing any reusable object or configuration used in the access control policy or the policies it invokes: network, port, URL, and geolocation objects; Security Intelligence lists and feeds; application filters or detectors; intrusion policy variable sets; file lists; security zones, and so on. 
 
     	 [bookmark: pgfId-1677703]Updating the system software, intrusion rules, or the vulnerability database (VDB).
 
    
 
    [bookmark: pgfId-1677704]Keep in mind that you can change some of these configurations from multiple places in the ASA FirePOWER module interface. For example, you can modify security zones using the object manager (Configuration > ASA FirePOWER Configuration > Object Management).
 
    [bookmark: pgfId-1572046]Note that the following updates do not require policy reapply:
 
     
     	 [bookmark: pgfId-1572048]automatic updates to URL filtering data
 
     	 [bookmark: pgfId-1572049]scheduled geolocation database (GeoDB) updates
 
    
 
    [bookmark: pgfId-1573296]To determine why an access control or intrusion policy is out of date, use the comparison viewer.
 
    [bookmark: pgfId-1572050]To determine why an access control policy is out of date:
 
    
 
    [bookmark: pgfId-1678874]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1677764]The Access Control Policy page appears. Policies that are out of date are marked with red status text that indicates that the ASA FirePOWER module needs a policy update.
 
    [bookmark: pgfId-1677765]Step 2 Click the policy status for an out-of-date policy.
 
    [bookmark: pgfId-1573465]The detailed Apply Access Control Policy pop-up window appears.
 
    [bookmark: pgfId-1572056]Step 3 Click Out-of-date next to the changed component you are interested in.
 
    [bookmark: pgfId-1572057]A policy comparison report appears in a new window. For more information, see Comparing Access Control Policies and Comparing Two Intrusion Policies or Revisions.
 
    [bookmark: pgfId-1572101]Step 4 Optionally, reapply the policy.
 
    [bookmark: pgfId-1572134]See Deploying Configuration Changes.
 
    [bookmark: pgfId-1612000]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1530926][bookmark: 20491]Deploying Configuration Changes
 
    [bookmark: pgfId-1531070]License: Any
 
    [bookmark: pgfId-1817362]After you use the ASA FirePOWER module to configure your deployment, and any time you make changes to that configuration, you must deploy the new configuration.
 
    [bookmark: pgfId-1817335]This deploy action distributes the following configuration components:
 
     
     	 [bookmark: pgfId-1817341]Access control policies and all associated policies: DNS, file, identity, intrusion, network analysis, SSL
 
     	 [bookmark: pgfId-1817528]Any associated rule configurations and objects associated with a policy to be deployed
 
     	 [bookmark: pgfId-1818008]Intrusion rule updates
 
     	 [bookmark: pgfId-1818009]Device and interface configurations
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1818040] 
     Caution In special cases, deploying configuration changes may cause a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected. To minimize inconvenience, deploy during a change window. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1818010]To deploy configuration changes:
 
    
 
    [bookmark: pgfId-1817813]Step 1 Click Deploy and select Deploy FirePOWER Changes.
 
    [bookmark: pgfId-1817903]Step 2 Click Deploy.
 
    [bookmark: pgfId-1817918]Step 3 If the system identifies errors or warnings in the changes to be deployed, you have the following choices:
 
     
     	 [bookmark: pgfId-1817937]Click  Proceed to continue deploying without resolving error or warning conditions.
 
     	 [bookmark: pgfId-1817968]Click  Cancel to exit without deploying. Resolve the error and warning conditions, and attempt to deploy the configuration again.
 
    
 
    [bookmark: pgfId-1846368]ASA FirePOWER module Applying includesASA FirePOWER module a or you might be able to select as few as three intrusion policies across an entire access control policy.
 
    [bookmark: pgfId-1847362]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1846349][bookmark: 31246][bookmark: 53405]Troubleshooting Ac[bookmark: marker-1846358]cess Control Policies and Rules
 
    [bookmark: pgfId-1648681]License: Any
 
    [bookmark: pgfId-1649787]Properly configuring access control policies, especially creating and ordering access control rules, is a complex task. However, it is a task that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules or contain invalid configurations. Both rules and other policy settings can require additional licenses. 
 
    [bookmark: pgfId-1651586]To help ensure that the system handles traffic as you expect, the access control policy interface has a robust feedback system. Icons in the access control policy and rule editors mark warnings and errors, as described in the Access Control Error Icons table. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1651804]Tip In the access control policy editor, click Show Warnings to display a pop-up window that lists all the warnings for the policy.
 
     
     
 
    
 
    
 
     
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1648690]Table 4-4 [bookmark: 16039]Access Control Error Icons 
 
       
       
        
        	 
          
          [bookmark: pgfId-1648696]Icon 
         
  
        	 
          
          [bookmark: pgfId-1648698]Description 
         
  
        	 
          
          [bookmark: pgfId-1648700]Details 
         
  
       
 
       
          
        	[bookmark: pgfId-1648717]error
  
        	[bookmark: pgfId-1648719]If a rule or configuration has an error, you cannot apply the policy until you correct the issue, even if you disable any affected rules.
  
       
 
       
          
        	[bookmark: pgfId-1650749]warning
  
        	[bookmark: pgfId-1652678]You can apply an access control policy that displays rule or other warnings. However, misconfigurations marked with warnings have no effect. 
 [bookmark: pgfId-1652914]For example, you can apply a policy that contains preempted rules or rules that cannot match traffic due to misconfiguration—conditions using empty object groups, configuring URL conditions without having enabled cloud communications, and so on. These rules do not evaluate traffic. If you disable a rule with a warning, the warning icon disappears. It reappears if you enable the rule without correcting the underlying issue.
 [bookmark: pgfId-1652682]As another example, many features require a specific license. An access control policy successfully applies only to an eligible device.
  
       
 
       
          
        	[bookmark: pgfId-1648726]information
  
        	[bookmark: pgfId-1648728]Information icons convey helpful information about configurations that may affect the flow of traffic. These issues do not prevent you from applying the policy.
 [bookmark: pgfId-1648729]For example, if you are performing application control or URL filtering, the system may skip matching the first few packets of a connection against some access control rules, until the system identifies the application or web traffic in that connection. This allows connections to be established so that applications and HTTP requests can be identified. For more information, see Limitations to Application Control and Limitations to URL Detection and Blocking.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1648737]Properly configuring access control policies and rules can also reduce the resources required to process network traffic. Creating complex rules, invoking many different intrusion policies, and mis-ordering rules can all affect performance.
 
    [bookmark: pgfId-1648738]For more information, see:
 
     
     	 [bookmark: pgfId-1648746]Simplifying Rules to Improve Performance
 
     	 [bookmark: pgfId-1648750]Understanding Rule Preemption and Invalid Configuration Warnings
 
     	 [bookmark: pgfId-1648754]Ordering Rules to Improve Performance and Avoid Preemption
 
    
 
     
      [bookmark: pgfId-1648891][bookmark: 20624]Simplifying Rules to Improve Performance
 
     [bookmark: pgfId-1648892]Complex access control policies and rules can command significant resources. When you apply an access control policy, the system evaluates all the rules together and creates an expanded set of criteria that the ASA FirePOWER module uses to evaluate network traffic. A pop-up window may warn that you have exceeded the maximum number of access control rules or intrusion policies supported. 
 
     [bookmark: pgfId-1648893]Simplifying Access Control Rules
 
     [bookmark: pgfId-1648894]The following guidelines can help you simplify access control rules and improve performance:
 
      
      	 [bookmark: pgfId-1648895]When constructing a rule, use as few individual elements in your conditions as possible. For example, in network conditions, use IP address blocks rather than individual IP addresses. In port conditions, use port ranges. Use application filters and URL categories and reputations to perform application control and URL filtering, and LDAP user groups to perform user control.
 
     
 
     [bookmark: pgfId-1648896]Note that combining elements into objects that you then use in access control rule conditions does not improve performance. For example, using a network object that contains 50 individual IP addresses gives you only an organizational—not a performance—benefit over including those IP addresses in the condition individually.
 
      
      	 [bookmark: pgfId-1648897]Restrict rules by security zones whenever possible. If a device’s interfaces are not in one of the zones in a zone-restricted rule, the rule does not affect performance on that device.
 
      	 [bookmark: pgfId-1648898]Do not overconfigure rules. If one condition is enough to match the traffic you want to handle, do not use two.
 
     
 
     [bookmark: pgfId-1648899]Avoiding Intrusion Policy and Variable Set Proliferation
 
     [bookmark: pgfId-1792389]The number of unique intrusion policies you can use to inspect traffic in an access control policy depends on the complexity of your policies: you can associate one intrusion policy with each Allow and Interactive Block rule, as well as with the default action. Every unique pair of intrusion policy and variable set counts as one policy. You might be able to select as few as three intrusion policies across an entire access control policy. 
 
     [bookmark: pgfId-1792362]If you exceed the number of intrusion policies supported, reevaluate your access control policy. You may want to consolidate intrusion policies or variable sets.
 
     [bookmark: pgfId-1792363]Check to see how many policies you select and how many variable sets those policies use in each of the following locations in your access control policy: the Intrusion Policy used before Access Control rule is determined option in the Advanced access control policy settings, the default action for the access control policy, and the inspection settings for any access control rules in the policy.
 
    
 
     
      [bookmark: pgfId-1677929][bookmark: 91652]Understanding Rule Preemption and Invalid Configuration Warnings
 
     [bookmark: pgfId-1648907]License: Any
 
     [bookmark: pgfId-1648908]Properly configuring and ordering access control rules (and, in advanced deployments, network analysis rules) is essential to building an effective deployment. Within an access control policy, access control rules can preempt other rules or contain invalid configurations. Similarly, network analysis rules, which you configure using the access control policy’s advanced settings, can have the same issues. The system uses warning and error icons to mark these.
 
     [bookmark: pgfId-1648909]Understanding Rule Preemption Warnings
 
     [bookmark: pgfId-1648910]The conditions of an access control rule may preempt a subsequent rule from matching traffic. For example:
 
      
      [bookmark: pgfId-1648911]Rule 1: allow Admin users 
     
 
      
      [bookmark: pgfId-1648912]Rule 2: block Admin users 
     
 
     [bookmark: pgfId-1648913]The second rule above will never block traffic because the first rule will have already allowed the traffic.
 
     [bookmark: pgfId-1678295]Note the following:
 
      
      	 [bookmark: pgfId-1678333]Any type of rule condition can preempt a subsequent rule.
 
      	 [bookmark: pgfId-1678401]A rule also preempts an identical subsequent rule where all configured conditions are the same. 
 
      	 [bookmark: pgfId-1678461]A subsequent rule would not be preempted if any condition is different. 
 
     
 
     [bookmark: pgfId-1678402]Understanding Invalid Configuration Warnings
 
     [bookmark: pgfId-1678403]Because outside settings that the access control policy depends on may change, an access control policy setting that was valid may become invalid. Consider the following examples:
 
      
      	 [bookmark: pgfId-1648932]If you add a port group to the source ports in a rule, then change the port group to include an ICMP port, the rule becomes invalid and a warning icon appears next to it. You can still apply the policy, but the rule will have no effect on network traffic.
 
      	 [bookmark: pgfId-1648933]If you add a user to a rule, then change your LDAP user awareness settings to exclude that user, the rule will have no effect because the user is no longer an access controlled user. 
 
     
 
    
 
     
      [bookmark: pgfId-1648935][bookmark: 54525]Ordering Rules to Improve Performance and Avoid Preemption
 
     [bookmark: pgfId-1648939]License: Any
 
     [bookmark: pgfId-1648940]Rules in an access control policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
     [bookmark: pgfId-1648941]Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs.
 
     [bookmark: pgfId-1648942]Order Rules from Most to Least Critical
 
     [bookmark: pgfId-1648943]First, you must order rules to suit your organization's needs. Place priority rules that must apply to all traffic near the top of the policy. For example, if you want to inspect traffic from a single user for intrusions (using an Allow rule), but trust all other users in the department (using a Trust rule), place two access control rules in that order.
 
     [bookmark: pgfId-1648944]Order Rules from Specific to General
 
     [bookmark: pgfId-1648945]You can improve performance by placing specific rules earlier, that is, rules that narrowly define the traffic they handle. This is also important because rules with broad conditions can match many different types of traffic, and can preempt later, more specific rules.
 
     [bookmark: pgfId-1648946]Consider a scenario where you want to block most social networking sites, but allow access to certain others. For example, you may want your graphic designers to be able to access Creative Commons Flickr and deviantART content, but not access other sites such as Facebook or Google+. You should order your rules as follows:
 
      
      [bookmark: pgfId-1648947]Rule 1: Allow Flickr, deviantART for the “Design” LDAP user group 
     
 
      
      [bookmark: pgfId-1648948]Rule 2: Block social networking 
     
 
     [bookmark: pgfId-1648949]If you reverse the rules:
 
      
      [bookmark: pgfId-1648950]Rule 1: Block social networking 
     
 
      
      [bookmark: pgfId-1648951]Rule 2: Allow Flickr, deviantART for the “Design” LDAP user group 
     
 
     [bookmark: pgfId-1648952]the first rule blocks all social networking traffic, including Flickr and deviantART. Because no traffic will ever match the second rule, your designers cannot access the content you wanted to make available.
 
     [bookmark: pgfId-1648953]Place Rules that Inspect Traffic Later
 
     [bookmark: pgfId-1648954]Because intrusion, file, and malware inspection require processing resources, placing rules that do not inspect traffic (Trust, Block) before rules that do (Allow, Interactive Block) can improve performance. This is because Trust and Block rules can divert traffic that the system might otherwise have inspected. All other factors being equal, that is, given a set of rules where none is more critical and preemption is not an issue, consider placing them in the following order:
 
      
      	 [bookmark: pgfId-1648955]Monitor rules that log matching connections, but take no other action on traffic
 
      	 [bookmark: pgfId-1648956]Trust and Block rules that handle traffic without further inspection
 
      	 [bookmark: pgfId-1648957]Allow and Interactive Block rules that do not inspect traffic further
 
      	 [bookmark: pgfId-1648958]Allow and Interactive Block rules that optionally inspect traffic for malware, intrusions, or both
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1530930][bookmark: 94414]Generating a Report of Current Acce[bookmark: marker-1535054]ss Control Settings
 
    [bookmark: pgfId-1531144]License: Any
 
     
      
       
       [bookmark: pgfId-1535283]Table 4-5 [bookmark: 90226]Access Control Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-1535287]Section 
         
  
        	 
          
          [bookmark: pgfId-1535289]Description 
         
  
       
 
        
        	[bookmark: pgfId-1535299]Policy Information
  
        	[bookmark: pgfId-1535301]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified.
  
       
 
        
        	[bookmark: pgfId-1535307]HTTP Block Response 
 [bookmark: pgfId-1535308]HTTP Interactive Block Response
  
        	[bookmark: pgfId-1535310]Provides details on the pages you display to users when you block a website using the policy.
  
       
 
        
        	[bookmark: pgfId-1535315]Security Intelligence
  
        	[bookmark: pgfId-1535317]Provides details on the policy’s Security Intelligence whitelist and blacklist.
  
       
 
        
        	[bookmark: pgfId-1535322]Default Action
  
        	[bookmark: pgfId-1535326]Lists the default action and associated variable set, if any.
  
       
 
        
        	[bookmark: pgfId-1535329]Rules
  
        	[bookmark: pgfId-1535331]Lists each access control rule in the policy, and provides details about its configuration.
  
       
 
        
        	[bookmark: pgfId-1535339]Advanced Settings
  
        	[bookmark: pgfId-1535341]Detailed information on the policy’s advanced settings, including: 
 
          
          	 [bookmark: pgfId-1539703]network analysis policies used to preprocess traffic for the access control policy, as well as global preprocessing options
 
          	 [bookmark: pgfId-1540878]adaptive profile settings for passive deployments
 
          	 [bookmark: pgfId-1539874]performance settings for detecting files, malware, and intrusions
 
          	 [bookmark: pgfId-1540957]other policy-wide settings
 
         
  
       
 
        
        	[bookmark: pgfId-1535343]Referenced Objects
  
        	[bookmark: pgfId-1535345]Provides details on the reusable objects referenced by the access control policy, including intrusion policy variable sets.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1535142]You can also generate an access control comparison report that compares a policy with the currently applied policy or with another policy. For more information, see Comparing Access Control Policies.
 
    [bookmark: pgfId-1534995]To view an access control policy report:
 
    
 
    [bookmark: pgfId-1679247]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1663371]The Access Control Policy page appears.
 ) next to the policy for which you want to generate a report. Remember to save any changes before you generate an access control policy report; only saved changes appear in the report. 
    
 
    [bookmark: pgfId-1535003]The system generates the report. You are prompted to save the report to your computer.
 
    [bookmark: pgfId-1648418]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1648422][bookmark: 14479]Comparing Access Control Po[bookmark: marker-1648421]licies
 
    [bookmark: pgfId-1648426]License: Any
 
    [bookmark: pgfId-1534875]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two access control policies. You can compare any two policies or the currently applied policy with another policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies.
 
    [bookmark: pgfId-1534711]There are two tools you can use to compare policies:
 
     
     	 [bookmark: pgfId-1534712]The comparison view displays only the differences between two policies in a side-by-side format. The name of each policy appears in the title bar on the left and right sides of the comparison view except when you select  Running Configuration , in which case a blank bar represents the currently active policy.
 
    
 
    [bookmark: pgfId-1534713]You can use this to view and navigate both policies on the module interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-1534714]The comparison report creates a record of only the differences between two policies in a format similar to the policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-1534715]You can use this to save, copy, print, and share your policy comparisons for further examination.
 
    [bookmark: pgfId-1534716]For more information on understanding and using the policy comparison tools, see:
 
     
     	 [bookmark: pgfId-1534720]Using the Access Control Policy Comparison View
 
     	 [bookmark: pgfId-1534724]Using the Access Control Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-1534726][bookmark: 29486]Using the Access Control Policy Comparison View
 
     [bookmark: pgfId-1534727]License: Any
 
     [bookmark: pgfId-1534728]The comparison view displays both policies in a side-by-side format, with each policy identified by name in the title bar on the left and right sides of the comparison view. When comparing two policies other than the running configuration, the time of last modification and the last user to modify are displayed with the policy name.
 
     [bookmark: pgfId-1534729]Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-1534730]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-1534731]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
     [bookmark: pgfId-1534732]You can perform any of the actions in the following table.
 
     [bookmark: pgfId-1534767]
 
      
       
        
        [bookmark: pgfId-1534739]Table 4-6 [bookmark: 91381]Access Control Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534743]To... 
          
  
         	 
           
           [bookmark: pgfId-1534745]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1534747]navigate individually through changes
  
         	[bookmark: pgfId-1534749]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-1534755]generate a new policy comparison view
  
         	[bookmark: pgfId-1534757]click New Comparison.
 [bookmark: pgfId-1534758]The Select Comparison window appears. See Using the Access Control Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-1534763]generate a policy comparison report
  
         	[bookmark: pgfId-1534765]click Comparison Report. 
 [bookmark: pgfId-1534766]The policy comparison report creates a PDF document that lists only the differences between the two policies.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1534770][bookmark: 14990]Using the Access Control Policy Comparison Report
 
     [bookmark: pgfId-1534771]License: Any
 
     [bookmark: pgfId-1534772]An access control policy comparison report is a record of all differences between two access control policies or a policy and the currently applied policy identified by the policy comparison view, presented in PDF format. You can use this report to further examine the differences between two policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-1534773]You can generate an access control policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-1676635]The format of the policy comparison report is the same as the policy report with one exception: the policy report contains all configurations in the policy, and the policy comparison report lists only those configurations that differ between the policies. An access control policy comparison report contains the sections described in Table 4-5. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1676639]Tip You can use a similar procedure to compare network analysis, intrusion, file, or system policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534779]To compare two access control policies:
 
     
 
     [bookmark: pgfId-1679260]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1663363]The Access Control Policy page appears.
 
     [bookmark: pgfId-1534783]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-1534784]The Select Comparison window appears.
 
     [bookmark: pgfId-1534786]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-1534787]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-1534788]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-1534789]To compare another policy to the currently active policy, select  Running Configuration. 
 
      
 
     
 
     [bookmark: pgfId-1534790]The page refreshes and the Target/Running Configuration A and Policy B drop-down lists appear.
 
     [bookmark: pgfId-1534791]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1534792]If you are comparing two different policies, select the policies you want to compare from the Policy A and Policy B drop-down lists.
 
       	 [bookmark: pgfId-1534793]If you are comparing the running configuration to another policy, select the second policy from the Policy B drop-down list.
 
      
 
     
 
     [bookmark: pgfId-1534794]Step 5 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-1534795]The comparison view appears.
 
     [bookmark: pgfId-1534796]Step 6 Optionally, click Comparison Report to generate the access control policy comparison report. 
 
     [bookmark: pgfId-1534797]The access control policy comparison report appears. You are prompted to save the report to your computer.
 
     [bookmark: pgfId-1803892]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1540523][bookmark: 13066]Blackl[bookmark: marker-1540522]isting Using Security Intelligence IP Address Reputation 
      
      
 
     
 
 
    [bookmark: pgfId-1534567]As a first line of defense against malicious Internet content, the ASA FirePOWER module includes the Security Intelligence feature, which allows you to immediately blacklist (block) connections based on the latest reputation intelligence, removing the need for a more resource-intensive, in-depth analysis. Security Intelligence filtering requires a Protection license.
 
    [bookmark: pgfId-1534321]Security Intelligence works by blocking traffic to or from IP addresses that have a known bad reputation. This traffic filtering takes place before any other policy-based inspection, analysis, or traffic handling.
 
    [bookmark: pgfId-1534322]Note that you could create access control rules that perform a similar function to Security Intelligence filtering by manually restricting traffic by IP address. However, access control rules are wider in scope, more complex to configure, and cannot automatically update using dynamic feeds.
 
    [bookmark: pgfId-1543624]Traffic blacklisted by Security Intelligence is immediately blocked and therefore is not subject to any further inspection—not for intrusions, exploits, malware, and so on. Optionally, and recommended in passive deployments, you can use a “monitor-only” setting for Security Intelligence filtering. This allows the system to analyze connections that would have been blacklisted, but also logs the match to the blacklist and generates an end-of-connection security intelligence event.
 
    [bookmark: pgfId-1532437]For your convenience, Cisco provides the Intelligence Feed (sometimes called the Sourcefire Intelligence Feed), which is comprised of several regularly updated collections of IP addresses determined by the VRT to have a poor reputation. The Intelligence Feed tracks open relays, known attackers, bogus IP addresses (bogon), and so on. You can also customize the feature to suit the unique needs of your organization, for example:
 
     
     	 [bookmark: pgfId-1532449] third-party feeds —you can supplement the Intelligence Feed with third-party reputation feeds, which the system can automatically update just as it does the Cisco feed
 
     	 [bookmark: pgfId-1532453] custom blacklists —the system allows you to manually blacklist specific IP addresses in many ways depending on your needs
 
     	 [bookmark: pgfId-1532454] enforcing blacklisting by security zone —to improve performance, you may want to target enforcement, for example, restricting spam blacklisting to a zone that handles email traffic
 
     	 [bookmark: pgfId-1532455] monitoring instead of blacklisting —especially useful in passive deployments and for testing feeds before you implement them; you can merely monitor the violating sessions instead of blocking them, generating end-of-connection events
 
     	 [bookmark: pgfId-1532456] whitelisting to eliminate false positives — when a blacklist is too broad in scope, or incorrectly blocks traffic that you want to allow (for example, to vital resources), you can override a blacklist with a custom whitelist 
 
    
 
    [bookmark: pgfId-1534415]For detailed information on configuring your access control policy to perform Security Intelligence to perform Security Intelligence filtering and viewing the event data that this filtering produces, see the following sections:
 
     
     	 [bookmark: pgfId-1531980]Choosing a Security Intelligence Strategy
 
     	 [bookmark: pgfId-1531772]Building the Security Intelligence Whitelist and Blacklist
 
     	 [bookmark: pgfId-1532098]Logging Security Intelligence (Blacklisting) Decisions
 
    
 
   
 
    
     [bookmark: pgfId-1531871][bookmark: 30307]Choosing a Security Intelligence Strategy
 
    [bookmark: pgfId-1531875]License: Protection
 
    [bookmark: pgfId-1533200]The easiest way to construct a blacklist is to use the Intelligence Feed, which tracks IP addresses known to be open relays, known attackers, bogus IP addresses (bogon), and so on. Because the Intelligence Feed is regularly updated, using it ensures that the system uses up-to-date information to filter your network traffic. Malicious IP addresses that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies. 
 
    [bookmark: pgfId-1533202]To aug[bookmark: marker-1533201]ment the Intelligence Feed, you can perform Security Intelligence filtering using custom or third-party IP address lists and feeds, where:
 
     
     	 [bookmark: pgfId-1533206]a  list is a static list of IP addresses that you upload to the ASA FirePOWER module
 
     	 [bookmark: pgfId-1533210]a  feed is a dynamic list of IP addresses that the ASA FirePOWER module downloads from the Internet on a regular basis; the Intelligence Feed is a special kind of feed
 
    
 
    [bookmark: pgfId-1533214]For detailed information on configuring Security Intelligence lists and feeds, including Internet access requirements, see Working with Security Intelligence Lists and Feeds.
 
    [bookmark: pgfId-1532358]Using the Security Intelligence Global Blacklist
 
    [bookmark: pgfId-1533233]In the course of your analysis, you can build a global blacklist. For example, if you notice a set of routable IP addresses in intrusion events associated with exploit attempts, you can blacklist those IP addresses. The ASA FirePOWER module uses this global blacklist (and a related global whitelist) to perform Security Intelligence filtering in all access control policies. For information on managing these global lists, see Working with the Global Whitelist and Blacklist.
 
     
      
    
 
    
 
    [bookmark: pgfId-1534125]Note Although feed updates and additions to the global blacklist (or global whitelist; see below) automatically implement changes throughout your deployment, any other change to a Security Intelligence object requires you to reapply the access control policy. For more information, see Table 2-1.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531915]Using Network Objects
 
    [bookmark: pgfId-1534759]Finally, a simple way to construct a blacklist is to use network objects or network object groups that represent an IP address, IP address block, or collection of IP addresses. For information on creating and modifying network objects, see Working with Network Objects.
 
    [bookmark: pgfId-1531933]Using Security Int[bookmark: marker-1531932]elligence Whitelists
 
    [bookmark: pgfId-1531934]In addition to a blacklist, each access control policy has an associated whitelist, which you can also populate with Security Intelligence objects. A policy’s whitelist overrides its blacklist. That is, the system evaluates traffic with a whitelisted source or destination IP address using access control rules, even if the IP address is also blacklisted. In general, use the whitelist if a blacklist is still useful, but is too broad in scope and incorrectly blocks traffic that you want to inspect.
 
    [bookmark: pgfId-1531935]For example, if a reputable feed improperly blocks your access to vital resources but is overall useful to your organization, you can whitelist only the improperly classified IP addresses, rather than removing the whole feed from the blacklist.
 
    [bookmark: pgfId-1531937]Enforcing Security Intelli[bookmark: marker-1531936]gence Filtering by Security Zone
 
    [bookmark: pgfId-1531938]For added granularity, you can enforce Security Intelligence filtering based on whether the source or destination IP address in a connection resides in a particular security zone.
 
    [bookmark: pgfId-1531939]To extend the whitelist example above, you could whitelist the improperly classified IP addresses, but then restrict the whitelist object using a security zone used by those in your organization who need to access those IP addresses. That way, only those with a business need can access the whitelisted IP addresses. As another example, you could use a third-party spam feed to blacklist traffic on an email server security zone.
 
    [bookmark: pgfId-1531940][bookmark: 22650]Monitoring—Rather than Blacklisting—Connections
 
    [bookmark: pgfId-1531941]If you are not sure whether you want to blacklist a particular IP address or set of addresses, you can use a “monitor-only” setting, which allows the system to pass the matching connection to access control rules, but also logs the match to the blacklist and generates an end-of-connection Security Intelligence event. Note that you cannot set the global blacklist to monitor-only.
 
    [bookmark: pgfId-1531942]Consider a scenario where you want to test a third-party feed before you implement blocking using that feed. When you set the feed to monitor-only, the system allows connections that would have been blocked to be further analyzed by the system, but also logs a record of each of those connections for your evaluation.
 
    [bookmark: pgfId-1542412]In passive deployments, to optimize performance, Cisco recommends that you always use monitor-only settings. Devices that are deployed passively cannot affect traffic flow; there is no advantage to configuring the system to block traffic. Additionally, because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection.
 
   
 
    
     [bookmark: pgfId-1530994][bookmark: 88286]Building the Security Intelligence White[bookmark: marker-1530993]list and Blacklist
 
    [bookmark: pgfId-1536592]License: Protection
 
    [bookmark: pgfId-1531010]To build a whitelist and blacklist, you populate them with any combination of network objects and groups, as well as Security Intelligence feeds and lists, all of which you can constrain by security zone.
 
    [bookmark: pgfId-1531014]By default, access control policies use the ASA FirePOWER module’s global whitelist and blacklist, which apply to any zone. These lists are populated by your analysts. You can opt not to use these global lists on a per-policy basis.
 
     
      
    
 
    
 
    [bookmark: pgfId-1533500]Note You cannot apply an access control policy that uses a populated global whitelist or blacklist to a device not licensed for Protection. If you added IP addresses to either global list, you must remove the non-empty list from the policy’s Security Intelligence configuration before you can apply the policy. For more information, see Working with the Global Whitelist and Blacklist.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531018]After you build your whitelist and blacklist, you can log blacklisted connections. You can also set individual blacklisted objects, including feeds and lists, to monitor-only. This allows the system to handle connections involving blacklisted IP addresses using access control, but also logs the connection’s match to the blacklist.
 ) represent the different categories in the Intelligence Feed. 
    
 ). Because the whitelist overrides the blacklist, if you add the same object to both lists, the system displays the blacklisted object with a strikethrough. 
    
 
    [bookmark: pgfId-1531036]You can add up to a total of 255 objects to the whitelist and the blacklist. That is, the number of objects in the whitelist plus the number in the blacklist cannot exceed 255.
 
    [bookmark: pgfId-1531037]Note that although you can add network objects with a netmask of /0 to the whitelist or blacklist, address blocks using a /0 netmask in those objects will be ignored and whitelist and blacklist filtering will not occur based on those addresses. Address blocks with a /0 netmask from Security Intelligence feeds are also ignored. If you want to monitor or block all traffic targeted by a policy, use an access control rule with the Monitor or Block rule action, respectively, and a default value of any for the Source Networks and Destination Networks, instead of Security Intelligence filtering.
 
    [bookmark: pgfId-1531042]To build the Security Intelligence whitelist and blacklist for an access control policy:
 
    
 
    [bookmark: pgfId-1539465]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1539466]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1531050]The access control policy editor appears.
 
    [bookmark: pgfId-1531051]Step 3 Select the Security Intelligence tab.
 
    [bookmark: pgfId-1531052]Security Intelligence settings for the access control policy appear.
 ) to log blacklisted connections. 
    
 
    [bookmark: pgfId-1531057]You must enable logging before you can set blacklisted objects to monitor-only. For details, see Logging Security Intelligence (Blacklisting) Decisions.
 
    [bookmark: pgfId-1531062]Step 5 [bookmark: 14249]Begin building your whitelist and blacklist by selecting one or more Available Objects.
 
    [bookmark: pgfId-1531063]Use Shift and Ctrl to select multiple objects, or right-click and Select All.
 
     
      
    
 
    
 
    [bookmark: pgfId-1531064]Tip You can search for existing objects to include, or create objects on the fly if no existing objects meet the needs of your organization. For more information, see Searching for Objects to Whitelist or Blacklist.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531071]Step 6 Optionally, constrain the selected objects by zone by selecting an Available Zone.
 
    [bookmark: pgfId-1531072]By default, objects are not constrained, that is, they have a zone of Any. Note that other than using Any, you can constrain by only one zone. To enforce Security Intelligence filtering for an object on multiple zones, you must add the object to the whitelist or blacklist separately for each zone. Also, the global whitelist or blacklist cannot be constrained by zone.
 
    [bookmark: pgfId-1531074]Step 7 [bookmark: 56449]Click Add to Whitelist or Add to Blacklist.
 
    [bookmark: pgfId-1531075]You can also click and drag the selected objects to either list.
 
    [bookmark: pgfId-1538636]The objects you selected are added to the whitelist or blacklist.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1543833]Step 8 Repeat steps 5 through 7 until you are finished adding objects to your whitelist and blacklist.
 
   [bookmark: pgfId-1543834]Step 9 Optionally, set blacklisted objects to monitor-only by right-clicking the object under Blacklist, then selecting Monitor-only (do not block).
 
   [bookmark: pgfId-1531094]In passive deployments, Cisco recommends you set all blacklisted objects to monitor-only. Note, however, that you cannot set the global blacklist to monitor-only. 
 
   [bookmark: pgfId-1531095]Step 10 Click Store ASA FirePOWER Changes.
 
   [bookmark: pgfId-1531096]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
   [bookmark: pgfId-1536393]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1531101][bookmark: 88257]Searching for Objects to Whitelist or Blacklist
 
    [bookmark: pgfId-1536618]License: Protection
 
    [bookmark: pgfId-1531117]If you have multiple network objects, groups, feeds, and lists, use the search feature to narrow the objects you want to blacklist or whitelist.
 
    [bookmark: pgfId-1531118]To search for objects to whitelist or blacklist:
 
    
 
    [bookmark: pgfId-1531120]Step 1 Type your query in the Search by name or value field.
 ) in the search field. 
    
 
    [bookmark: pgfId-1531128]You can search on network object names and on the values configured for those objects. For example, if you have an individual network object named Texas Office with the configured value 192.168.3.0/24, and the object is included in the group object US Offices, you can display both objects by typing a partial or complete search string such as Tex, or by typing a value such as 3.
 
    [bookmark: pgfId-1536404]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1623889][bookmark: 24637]Tuning Traffic Flow Using Access Control Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1687380]Within an access control policy, access control rules provide a granular method of handling network traffic.
 
    [bookmark: pgfId-1623895]Security Intelligence-based traffic filtering, and some decoding and preprocessing occur before network traffic is evaluated by access control rules.The system matches traffic to access control rules in the order you specify. In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, port, application, requested URL, and user.
 
    [bookmark: pgfId-1623896]Each rule also has an action, which determines whether you monitor, trust, block, or allow matching traffic. When you allow traffic, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network. However, after the system trusts or blocks traffic, it does not perform further inspection.
 
    [bookmark: pgfId-1685064]The following scenario summarizes the ways that traffic can be evaluated by access control rules in an inline, intrusion prevention deployment. 
 
    [bookmark: pgfId-1726374]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1681847]In this scenario, traffic is evaluated as follows:
 
     
     	 [bookmark: pgfId-1677713] Rule 1: Monitor evaluates traffic first. Monitor rules track and log network traffic but do not affect traffic flow. The system continues to match traffic against additional rules to determine whether to permit or deny it.
 
     	 [bookmark: pgfId-1623904] Rule 2: Trust evaluates traffic next. Matching traffic is allowed to pass to its destination without further inspection. Traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-1623905] Rule 3: Block evaluates traffic third. Matching traffic is blocked without further inspection. Traffic that does not match continues to the final rule.
 
     	 [bookmark: pgfId-1623906] Rule 4: Allow is the final rule. For this rule, matching traffic is allowed; however, prohibited files, malware, intrusions, and exploits within that traffic are detected and blocked. Remaining non-prohibited, non-malicious traffic is allowed to its destination. Note that you might have additional Allow rules that perform only file inspection, or only intrusion inspection, or neither.
 
     	 [bookmark: pgfId-1674315] Default Action handles all traffic that does not match any of the rules. In this scenario, the default action performs intrusion prevention before allowing non-malicious traffic to pass. In a different deployment, you might have a default action that trusts or blocks all traffic, without further inspection. (You cannot perform file or malware inspection on traffic handled by the default action.)
 
    
 
    [bookmark: pgfId-1625784]For more information on access control rules, see:
 
     
     	 [bookmark: pgfId-1623916]Creating and Editing Access Control Rules
 
     	 [bookmark: pgfId-1623920]Managing Access Control Rules in a Policy
 
     	 [bookmark: pgfId-1623924]Troubleshooting Access Control Policies and Rules
 
    
 
   
 
    
     [bookmark: pgfId-1623926][bookmark: 42436]Creating and Editing Access Control Rules
 
    [bookmark: pgfId-1623930]License: Any
 
    [bookmark: pgfId-1639344]Within an access control policy, access control rules provide a granular method of handling network traffic. In addition to its unique name, each access control rule has the following basic components: 
 
    [bookmark: pgfId-1623932]State
 
    [bookmark: pgfId-1623933]By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.
 
    [bookmark: pgfId-1623934]Position
 
    [bookmark: pgfId-1623935]Rules in an access control policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
    [bookmark: pgfId-1623936]Conditions
 
    [bookmark: pgfId-1623937]Conditions specify the specific traffic the rule handles. Conditions can match traffic by security zone, network or geographical location, port, application, requested URL, or user. Conditions can be simple or complex; their use often depends on license.
 
    [bookmark: pgfId-1623938]Action
 
    [bookmark: pgfId-1623939]A rule’s action determines how the system handles matching traffic. You can monitor, trust, block, or allow (with or without further inspection) matching traffic. Note that the system does not perform inspection on trusted or blocked traffic.
 
    [bookmark: pgfId-1623940]Inspection
 
    [bookmark: pgfId-1623941]Inspection options for an access control rule govern how the system inspects and blocks malicious traffic you would otherwise allow. When you allow traffic with a rule, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.
 
    [bookmark: pgfId-1623942]Logging
 
    [bookmark: pgfId-1686839]A rule’s logging settings govern the records the system keeps of the traffic it handles. You can keep a record of traffic that matches a rule. In general, you can log sessions at the beginning and end of a connection. You can log connections to the ASA FirePOWER module, as well as to the system log (syslog) or to an SNMP trap server.
 
    [bookmark: pgfId-1686791]Comments
 
    [bookmark: pgfId-1623948]Each time you save changes to an access control rule, you can add a comment.
 
    [bookmark: pgfId-1623949]Use the access control rule editor to add and edit access control rules; access the rule editor from the Rules tab of the access control policy editor. In the rule editor, you:
 
     
     	 [bookmark: pgfId-1623950]Configure basic properties such as the rule’s name, state, position, and action in the upper portion of the editor.
 
     	 [bookmark: pgfId-1623951]Add conditions using the tabs on the left side of the lower portion of the editor. 
 
     	 [bookmark: pgfId-1623952]Use the tabs on the right side of the lower portion to configure inspection and logging options, and also to add comments to the rule. For your convenience, the editor lists the rule’s inspection and logging options regardless of which tab you are viewing.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1623953]Note Properly creating and ordering access control rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the system handles traffic as you expect, the access control policy interface has a robust warning and error feedback system for rules. For more information, see Troubleshooting Access Control Policies and Rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1623957]To create or modify an access control rule:
 
    
 
    [bookmark: pgfId-1688556]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1623963]The Access Control Policy page appears.
 ) next to the access control policy where you want to add a rule. 
    
 
    [bookmark: pgfId-1623968]The policy page appears, focused on the Rules tab.
 
    [bookmark: pgfId-1623969]Step 3 You have the following options:
 
     
      
      	 [bookmark: pgfId-1623970]To add a new rule, click  Add Rule .
 
      	 [bookmark: pgfId-1623974]To edit an existing rule, click the edit icon (
 
     
 
     [image: ] ) next to the rule you want to edit. 
    
 
    [bookmark: pgfId-1623975]The access control rule editor appears.
 
    [bookmark: pgfId-1623976]Step 4 Type a Name for the rule.
 
    [bookmark: pgfId-1623977]Each rule must have a unique name. You can use up to thirty printable characters, including spaces and special characters, with the exception of the colon (:).
 
    [bookmark: pgfId-1623978]Step 5 Configure the rule components, as summarized above. You can configure the following, or accept the defaults:
 
     
      
      	 [bookmark: pgfId-1623979]Specify whether the rule is  Enabled .
 
      	 [bookmark: pgfId-1623983]Specify the rule position; see Specifying a Rule's Order of Evaluation.
 
      	 [bookmark: pgfId-1623986]Select a rule  Action ; see Using Rule Actions to Determine Traffic Handling and Inspection.
 
      	 [bookmark: pgfId-1623990]Configure the rule’s conditions; see Using Conditions to Specify the Traffic a Rule Handles.
 
      	 [bookmark: pgfId-1623994]For Allow and Interactive Block rules, configure the rule’s  Inspection options; see Controlling Traffic Using Intrusion and File Policies. 
 
      	 [bookmark: pgfId-1623998]Specify  Logging options; see Logging Connections in Network Traffic.
 
      	 [bookmark: pgfId-1624003]Add  Comments ; see Adding Comments to a Rule.
 
     
 
    
 
    [bookmark: pgfId-1624004]Step 6 Click Store FirePOWER Changes to save the rule.
 ) to delete the rule. You must apply the access control policy for your changes to take effect; see 
    Deploying Configuration Changes. 
    
 
    [bookmark: pgfId-1624012]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1624014][bookmark: 66701]Specifying a Rule's Order of Evaluation
 
     [bookmark: pgfId-1624018]License: Any
 
     [bookmark: pgfId-1624019]When you first create an access control rule, you specify its position using the Insert drop-down list in the rule editor. Rules in an access control policy are numbered, starting at 1. The system matches traffic to access control rules in top-down order by ascending rule number. 
 
     [bookmark: pgfId-1624020]In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. Except in the case of Monitor rules (which log traffic but do not affect traffic flow), the system does not continue to evaluate traffic against additional, lower-priority rules after that traffic matches a rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-1624021]Tip Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs. For more information, see Ordering Rules to Improve Performance and Avoid Preemption.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1624025]In addition to ordering rules by number, you can group rules by category. By default the system provides three categories: Administrator, Standard, and Root. You can add custom categories, but you cannot delete the Cisco-provided categories or change their order. For information on changing the position or category of an existing rule, see Changing a Rule's Position or Category.
 
     [bookmark: pgfId-1624032]To add a rule to a category while editing or creating a rule:
 
     
 
     [bookmark: pgfId-1624037]Step 1 In the access control rule editor, from the Insert drop-down list, select Into Category, then select the category you want to use.
 
     [bookmark: pgfId-1624038]When you save the rule, it is placed last in that category.
 
     [bookmark: pgfId-1624039]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1624040]To position a rule by number while editing or creating a rule:
 
     
 
     [bookmark: pgfId-1624045]Step 1 In the access control rule editor, from the Insert drop-down list, select above rule or below rule, then type the appropriate rule number.
 
     [bookmark: pgfId-1624046]When you save the rule, it is placed where you specified.
 
     [bookmark: pgfId-1624047]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624049][bookmark: 31965]Using Conditions to Specify the Traffic a Rule Handles
 
     [bookmark: pgfId-1624053]License: feature dependent
 
     [bookmark: pgfId-1663901]An access control rule’s conditions identify the type of traffic that rule handles. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, port, application, requested URL, and user. 
 
     [bookmark: pgfId-1663902]When adding conditions to access control rules, keep the following points in mind:
 
      
      	 [bookmark: pgfId-1660750]You can configure multiple conditions per rule. Traffic must match  all the conditions in the rule for the rule to apply to traffic. For example, you can use a single rule to perform URL filtering (URL condition) for specific hosts (zone or network condition).
 
      	 [bookmark: pgfId-1661728]For each condition in a rule, you can add up to 50 criteria. Traffic that matches  any of a condition’s criteria satisfies the condition. For example, you can use a single rule to perform user control for up to 50 users and groups.
 
     
 
     [bookmark: pgfId-1683084]Note that you can constrain zone and network conditions by source and destination, using up to 50 source and up to 50 destination criteria. If you add both source and destination criteria to a zone or network condition, matching traffic must originate from one of the specified source zones/networks and egress through one of the destination zones/networks. In other words, the system links multiple condition criteria of the same type with an OR operation, and links multiple condition types with an AND operation. For example, if your rule conditions are:
 
      
      [bookmark: pgfId-1660343]Source Networks: 10.0.0.0/8, 192.168.0.0/16 
     
 
      
      [bookmark: pgfId-1665010]Application Category: peer to peer 
     
 
     [bookmark: pgfId-1660344]the rule would match peer-to-peer application traffic from a host on one of your private IPv4 networks—a packet must originate from either one OR the other source network, AND represent peer-to-peer application traffic. Both of the following connections trigger the rule: 
 
      
      [bookmark: pgfId-1663533]10.42.0.105 to anywhere, using LimeWire 
     
 
      
      [bookmark: pgfId-1663535]192.168.42.105 to anywhere, using Kazaa 
     
 
     [bookmark: pgfId-1662488]If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a network condition but no application condition evaluates traffic based on its source or destination, regardless of the application used in the session.
 
      
       
     
 
     
 
     [bookmark: pgfId-1687591]Note When you apply an access control policy, the system evaluates all its rules and creates an expanded set of criteria that the ASA FirePOWER module uses to evaluate network traffic. Complex access control policies and rules can command significant resources. For tips on simplifying access control rules and other ways to improve performance, see Troubleshooting Access Control Policies and Rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1664110]When you add or edit an access control rule, use the tabs on the left side of the lower portion of the rule editor to add and edit rule conditions. The following table summarizes the types of conditions you can add.
 
      
       [bookmark: pgfId-1664194] 
 
       
        
         
         [bookmark: pgfId-1664120]Table 6-1 [bookmark: 69858]Access Control Rule Condition Types 
 
         
         
          
          	 
            
            [bookmark: pgfId-1664126]These Conditions... 
           
  
          	 
            
            [bookmark: pgfId-1664128]Match Traffic... 
           
  
          	 
            
            [bookmark: pgfId-1664130]Details 
           
  
         
 
          
          	[bookmark: pgfId-1664132]Zones
  
          	[bookmark: pgfId-1664134]entering or leaving a device via an interface in a specific security zone
  
          	[bookmark: pgfId-1664136]A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. To build a zone condition, see Controlling Traffic by Security Zone.
  
         
 
          
          	[bookmark: pgfId-1664141]Networks
  
          	[bookmark: pgfId-1664143]by its source or destination IP address, country, or continent
  
          	[bookmark: pgfId-1664145]You can explicitly specify IP addresses or address blocks. The geolocation feature also allows you to control traffic based on its source or destination country or continent. To build a network condition, see Controlling Traffic by Network or Geographical Location.
  
         
 
          
          	[bookmark: pgfId-1664159]Ports
  
          	[bookmark: pgfId-1664161]by its source or destination port
  
          	[bookmark: pgfId-1664163]For TCP and UDP, you can control traffic based on the transport layer protocol. For ICMP and ICMPv6 (IPv6-ICMP), you can control traffic based on its Internet layer protocol plus an optional type and code. Using port conditions, you can also control traffic using other protocols that do not use ports. To build a port condition, see Controlling Traffic by Port and ICMP Codes.
  
         
 
          
          	[bookmark: pgfId-1664168]Applications
  
          	[bookmark: pgfId-1664170]by the application detected in a session
  
          	[bookmark: pgfId-1664172]You can control access to individual applications, or filter access according to basic characteristics: type, risk, business relevance, categories, and tags. To build an application condition, see Controlling Application Traffic.
  
         
 
          
          	[bookmark: pgfId-1664177]URLs
  
          	[bookmark: pgfId-1664179]by the URL requested in the session
  
          	[bookmark: pgfId-1664181]You can limit the websites that users on your network can access either individually or based on the URL’s general classification and risk level. To build a URL condition, see Blocking URLs.
  
         
 
          
          	[bookmark: pgfId-1664186]Users
  
          	[bookmark: pgfId-1664188]by the user involved in the session
  
          	[bookmark: pgfId-1664190]You can control traffic based on the LDAP user logged into a host involved in a monitored session. You can control traffic based on individual users or groups retrieved from a Microsoft Active Directory server. To build a user condition, see Access Control Rules: Realms and Users.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-1664195]Note that although you can create access control rules with any license, certain rule conditions require that you enable specific licensed capabilities before you can apply the policy. For more information, see License Requirements for Access Control.
 
     
 
    
 
     
      [bookmark: pgfId-1624151][bookmark: 71854]Using Rule Actions to Determine Traffic Handling and Inspection
 
     [bookmark: pgfId-1624155]License: Any
 
     [bookmark: pgfId-1624156]Every access control rule has an action that determines the following for matching traffic:
 
      
      	 [bookmark: pgfId-1624157]handling—foremost, the rule action governs whether the system will monitor, trust, block, or allow traffic that matches the rule’s conditions
 
      	 [bookmark: pgfId-1624158]inspection—certain rule actions allow you, when properly licensed, to further inspect matching traffic before allowing it to pass
 
      	 [bookmark: pgfId-1624159]logging—the rule action determines when and how you can log details about matching traffic
 
     
 
     [bookmark: pgfId-1624160]The access control policy’s default action handles traffic that does not meet the conditions of any non-Monitor access control rule; see Setting Default Handling and Inspection for Network Traffic. 
 
     [bookmark: pgfId-1624164]Keep in mind that only devices deployed inline can block or modify traffic. Devices deployed passively can analyze and log, but not affect, the flow of traffic. For detailed information on rule actions and how they affect traffic handling, inspection, and logging, see the following sections:
 
      
      	 [bookmark: pgfId-1624168]Monitor Action: Postponing Action and Ensuring Logging
 
      	 [bookmark: pgfId-1624172]Trust Action: Passing Traffic Without Inspection
 
      	 [bookmark: pgfId-1624176]Blocking Actions: Blocking Traffic Without Inspection
 
      	 [bookmark: pgfId-1624180]Interactive Blocking Actions: Allowing Users to Bypass Website Blocks
 
      	 [bookmark: pgfId-1624184]Allow Action: Allowing and Inspecting Traffic
 
      	 [bookmark: pgfId-1624188]Controlling Traffic Using Intrusion and File Policies
 
      	 [bookmark: pgfId-1624192]Logging Connections Based on Access Control Handling
 
     
 
    
 
     
      [bookmark: pgfId-1624194][bookmark: 75026]Monitor Action: Postponing Action and Ensuring Logging
 
     [bookmark: pgfId-1624198]License: Any
 
     [bookmark: pgfId-1624199]The Monitor action does not affect traffic flow; matching traffic is neither immediately permitted nor denied. Rather, traffic is matched against additional rules to determine whether to permit or deny it. The first non-Monitor rule matched determines traffic flow and any further inspection. If there are no additional matching rules, the system uses the default action.
 
     [bookmark: pgfId-1624200]Because the primary purpose of Monitor rules is to track network traffic, the system automatically logs end-of connection events for monitored traffic. That is, connections are logged even if the traffic matches no other rules and you do not enable logging on the default action. For more information, see Understanding Logging for Monitored Connections.
 
    
 
     
      [bookmark: pgfId-1624206][bookmark: 47986]Trust Action: Passing Traffic Without Inspection
 
     [bookmark: pgfId-1624210]License: Any
 
     [bookmark: pgfId-1624211]The Trust action allows traffic to pass without further inspection of any kind.
 
     [bookmark: pgfId-1726472]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1653622]You can log trusted network traffic at both the beginning and end of connections. For more information, see Understanding Logging for Trusted Connections.
 
    
 
     
      [bookmark: pgfId-1653634][bookmark: 80114]Blocking Actions: Blocking Traffic Without Inspection
 
     [bookmark: pgfId-1653638]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1710726]For HTTP traffic, when the system blocks a web request, you can override the default browser or server page with a custom page that explains that the connection was denied. The system calls this custom page an HTTP response page; see Displaying a Custom Web Page for Blocked URLs.
 
     [bookmark: pgfId-1710739]You can log blocked network traffic only at the beginning of connections. Note that only devices deployed inline can block traffic. Because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection. For more information, see Understanding Logging for Blocked and Interactively Blocked Connections.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1669663] 
      Caution Logging blocked TCP connections during a Denial of Service (DoS) attack can affect system performance with multiple similar events. Before you enable logging for an Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1624238][bookmark: 76698]Interactive Blocking Actions: Allowing Users to Bypass Website Blocks
 
     [bookmark: pgfId-1687411]License: Any
 
     [bookmark: pgfId-1687412]For HTTP traffic, the Interactive Block and Interactive Block with reset actions give users a chance to bypass a website block by clicking through a customizable warning page, called an HTTP response page. Interactive Block with reset rules also reset the connection.
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1624256][bookmark: 32625]Allow Action: Allowing and Inspecting Traffic
 
     [bookmark: pgfId-1624260]License: Any
 
     [bookmark: pgfId-1624261]The Allow action allows matching traffic to pass. When you allow traffic, you can use an associated intrusion or file policy (or both) to further inspect and block network traffic:
 
      
      	 [bookmark: pgfId-1624266]With a Protection license, you can use an i[bookmark: marker-1624265]ntrusion policy to analyze network traffic according to intrusion detection and prevention configurations and, optionally, drop offending packets.
 
      	 [bookmark: pgfId-1624270]Also with a Protection license, you can perform file control using a file policy. File control allows you to detect and block your users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. 
 
      	 [bookmark: pgfId-1624274]With a Malware license, you can perform network-based advanced malware protection (AMP), also using a file policy. Network-based AMP can inspect files for malware, and optionally block detected malware.
 
     
 
     [bookmark: pgfId-1624275]For instructions on how to associate an intrusion or file policy with an access control rule, see Controlling Traffic Using Intrusion and File Policies.
 
     [bookmark: pgfId-1624279]The diagram below illustrates the types of inspection performed on traffic that meets the conditions of an Allow rule (or a user-bypassed Interactive Block rule; see Interactive Blocking Actions: Allowing Users to Bypass Website Blocks). Notice that file inspection occurs before intrusion inspection; blocked files are not inspected for intrusion-related exploits.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1688229]You can log allowed network traffic at both the beginning and end of connections.
 
    
 
     
      [bookmark: pgfId-1688288][bookmark: 53927]Adding Comments to a Rule
 
     [bookmark: pgfId-1624322]License: Any
 
     [bookmark: pgfId-1687254]When you create or edit an access control rule, you can add a comment. For example, you might summarize the overall configuration for the benefit of other users, or note when you change a rule and the reason for the change. You can display a list of all comments for a rule along with the user who added each comment and the date the comment was added.
 
     [bookmark: pgfId-1624332]When you save a rule, all comments made since the last save become read-only.
 
     [bookmark: pgfId-1624333]To add a comment to a rule:
 
     
 
     [bookmark: pgfId-1624338]Step 1 In the access control rule editor, select the Comments tab.
 
     [bookmark: pgfId-1624339]The Comments page appears.
 
     [bookmark: pgfId-1624340]Step 2 Click New Comment.
 
     [bookmark: pgfId-1624341]The New Comment pop-up window appears.
 
     [bookmark: pgfId-1624342]Step 3 Type your comment and click OK.
 
     [bookmark: pgfId-1624343]Your comment is saved. You can edit or delete this comment until you save the rule.
 
     [bookmark: pgfId-1624344]Step 4 Save or continue editing the rule.
 
     [bookmark: pgfId-1624345]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1624347][bookmark: 93138]Managing Access Control Rules in a Policy
 
    [bookmark: pgfId-1624351]License: Any
 
    [bookmark: pgfId-1624352]The Rules tab of the access control policy editor, shown in the following graphic, allows you to add, edit, search, move, enable, disable, delete, and otherwise manage access control rules within your policy.
 
    [bookmark: pgfId-1726547]
 
     
     [image: ] 
    
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1624364]Table 6-2 Understanding the Access Control Policy Editor 
 
       
       
        
        	 
          
          [bookmark: pgfId-1624370]Icon 
         
  
        	 
          
          [bookmark: pgfId-1624372]Description 
         
  
        	 
          
          [bookmark: pgfId-1624374]You can... 
         
  
       
 
       
          
        	 
        	 [bookmark: pgfId-1624383]Click an active (yellow) inspection icon to edit the inspection options for the rule; see Controlling Traffic Using Intrusion and File Policies. If the icon is inactive (white), no policy of that type is selected for the rule. 
  
       
 
       
          
        	[bookmark: pgfId-1624393]file and malware inspection
  
       
 
       
          
        	[bookmark: pgfId-1624402]logging
  
        	[bookmark: pgfId-1624404]Click an active (blue) logging icon to edit the logging options for the rule; see Logging Connections Based on Access Control Handling. If the icon is inactive (white), connection logging is disabled for the rule. 
  
       
 
       
          
        	[bookmark: pgfId-1624414]comment
  
        	[bookmark: pgfId-1624416]Click the number in the comment column to add a comment to a rule; see Adding Comments to a Rule. The number indicates how many comments the rule already contains.
  
       
 
       
          
        	[bookmark: pgfId-1624426]warning
  
        	 [bookmark: pgfId-1629804]In the access control policy editor, click Show Warnings to display a pop-up window that lists all the warnings for the policy; see Troubleshooting Access Control Policies and Rules.
  
       
 
       
          
        	[bookmark: pgfId-1624439]error
  
       
 
       
          
        	[bookmark: pgfId-1624448]information
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1624452]For information on managing access control rules, see:
 
     
     	 [bookmark: pgfId-1624456]Creating and Editing Access Control Rules
 
     	 [bookmark: pgfId-1624460]Searching Access Control Rules
 
     	 [bookmark: pgfId-1624468]Enabling and Disabling Rules
 
     	 [bookmark: pgfId-1624472]Changing a Rule's Position or Category
 
    
 
     
      [bookmark: pgfId-1624479][bookmark: 70646]Searc[bookmark: marker-1624478]hing Access Control Rules
 
     [bookmark: pgfId-1624483]License: Any
 
     [bookmark: pgfId-1624484]You can search the list of access control rules for matching values using an alphanumeric string, including spaces and printable, special characters. The search inspects the rule name and any rule condition you have added to the rule. For rule conditions, the search matches any name or value you can add for each condition type (zone, network, application, and so on). This includes individual object names or values, group object names, individual object names or values within a group, and literal values.
 
     [bookmark: pgfId-1624485]You can use complete or partial search strings. The column for matching values is highlighted for each matching rule. For example, if you search on all or part of the string 100Bao, at a minimum, the Applications column is highlighted for each rule where you have added the 100Bao application. If you also have a rule named 100Bao, both the Name and Applications columns are highlighted.
 
     [bookmark: pgfId-1624486]You can navigate to each previous or next matching rule. A status message displays the current match and the total number of matches.
 
     [bookmark: pgfId-1624487]Matches may occur on any page of a multi-page rule list. When the first match is not on the first page, the page where the first match occurs is displayed. Selecting the next match when you are at the last match takes you to the first match, and selecting the previous match when you are at the first match takes you to the last match.
 
     [bookmark: pgfId-1624488]To search for rules:
 
     
 
     [bookmark: pgfId-1624493]Step 1 In the access control policy editor for the policy you want to search, click the Search Rules prompt, type a search string, then press Enter. You can also use the Tab key or click a blank page area to initiate the search.
 
     [bookmark: pgfId-1624494]Columns for rules with matching values are highlighted, with differentiated highlighting for the indicated (first) match.
 
     [bookmark: pgfId-1624495]Step 2 Find the rules you are interested in:
 
      
       
       	 [bookmark: pgfId-1624502]To navigate between matching rules, click the next-match (
 
      
 
      [image: ] ) or previous-match ( 
      [image: ] ) icon. 
     
 
      
       
       	 [bookmark: pgfId-1624506]To refresh the page and clear the search string and any highlighting, click the clear icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-1624507]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624532][bookmark: 16685]Enabling and Disabling Rules
 
     [bookmark: pgfId-1624536]License: Any
 
     [bookmark: pgfId-1624537]When you create an access control rule, it is enabled by default. If you disable a rule, the system does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in an access control policy, disabled rules are grayed out, although you can still modify them. Note that you can also enable or disable an access control rule using the rule editor; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1624541]To change an access control rule’s state:
 
     
 
     [bookmark: pgfId-1624546]Step 1 In the access control policy editor for the policy that contains the rule you want to enable or disable, right-click the rule and choose a rule state:
 
      
       
       	 [bookmark: pgfId-1624547]To enable an inactive rule, select  State > Enable . 
 
       	 [bookmark: pgfId-1688732]To disable an active rule, select  State > Disable . 
 
      
 
     
 
     [bookmark: pgfId-1688733]Step 2 Click Store FirePOWER Changes to save the policy.
 
     [bookmark: pgfId-1688736]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1624554]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624556][bookmark: 21681]Changing a Rule's Position or Category
 
     [bookmark: pgfId-1624560]License: Any
 
     [bookmark: pgfId-1624561]To help you organize access control rules, every access control policy has three system-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories.
 
     [bookmark: pgfId-1624563]For more information, see: 
 
      
      	 [bookmark: pgfId-1624567]Moving a Rule
 
      	 [bookmark: pgfId-1624571]Adding a New Rule Category
 
     
 
    
 
     
      [bookmark: pgfId-1624573][bookmark: 72746]Moving a Rule
 
     [bookmark: pgfId-1624577]License: Any
 
     [bookmark: pgfId-1624578]Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. 
 
     [bookmark: pgfId-1624579]The following procedure explains how to move one or more rules at a time using the access control policy editor. You can also move individual access control rules using the rule editor; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1624583]To move a rule:
 
     
 
     [bookmark: pgfId-1624588]Step 1 In the access control policy editor for the policy that contains the rules you want to move, select the rules by clicking in a blank area for each rule. Use the Ctrl and Shift keys to select multiple rules.
 
     [bookmark: pgfId-1624589]The rules you selected are highlighted.
 
     [bookmark: pgfId-1624590]Step 2 Move the rules. You can cut and paste or drag and drop.
 
     [bookmark: pgfId-1688794]To cut and paste rules into a new location, right-click a selected rule and select Cut. Then, right-click a blank area for a rule next to where you want to paste the cut rules and select Paste above or Paste below. Note that you cannot copy and paste access control rules between two different access control policies.
 
     [bookmark: pgfId-1688795]Step 3 Click Store FirePOWER Changes to save the policy.
 
     [bookmark: pgfId-1688798]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1624597]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624600][bookmark: 58752]Adding a New Rule Catego[bookmark: marker-1624599]ry
 
     [bookmark: pgfId-1624604]License: Any
 
     [bookmark: pgfId-1624605]To help you organize access control rules, every access control policy has three system-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories between the Standard Rules and Root Rules. 
 
     [bookmark: pgfId-1624606]Adding custom categories allows you to further organize your rules without having to create additional policies. You can rename and delete categories that you add. You cannot move these categories, but you can move rules into, within, and out of them.
 
     [bookmark: pgfId-1624608]To add a new category:
 
     
 
     [bookmark: pgfId-1624613]Step 1 In the access control policy editor for the policy where you want to add a rule category, click Add Category.
 
      
       
     
 
     
 
     [bookmark: pgfId-1624614]Tip If your policy already contains rules, you can click a blank area in the row for an existing rule to set the position of the new category before you add it. You can also right-click an existing rule and select Insert new category.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1624615]The Add Category pop-up window appears.
 
     [bookmark: pgfId-1624616]Step 2 Type a unique category Name.
 
     [bookmark: pgfId-1624617]You can enter an alphanumeric name, including spaces and special printable characters, with up to 30 characters.
 
     [bookmark: pgfId-1624618]Step 3 You have the following choices:
 
      
       
       	 [bookmark: pgfId-1624619]To position the new category immediately above an existing category, select  above Category from the first  Insert drop-down list, then select the category above which you want to position the rule from the second drop-down list.
 
       	 [bookmark: pgfId-1624620]To position the new category rule below an existing rule, select  below rule from the drop-down list, then enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
       	 [bookmark: pgfId-1624621]To position the rule above an existing rule, select  above rule from the drop-down list, then, enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
      
 
     
 
     [bookmark: pgfId-1624622]Step 4 Click OK.
 ) to delete the category. Rules in a category you delete are added to the category above. 
     
 
     [bookmark: pgfId-1624630]Step 5 Click Store FirePOWER Changes to save the policy.
 
     [bookmark: pgfId-1624631]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1631774]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 45216]Controlling Traffic with Network-Based Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1567177]Access control rules within access control policies exert granular control over network traffic logging and handling. Network-based conditions allow you to manage which traffic can traverse your network, using one or more of the following criteria:
 
     
     	 [bookmark: pgfId-1558901]source and destination security zones
 
     	 [bookmark: pgfId-1558959]source and destination IP addresses or geographical locations
 
     	 [bookmark: pgfId-1559071]source and destination port, which also includes transport layer protocol and ICMP code options
 
    
 
    [bookmark: pgfId-1578033]You can combine network-based conditions with each other and with other types of conditions to create an access control rule. These access control rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on access control rules, see Tuning Traffic Flow Using Access Control Rules.
 
     
      
    
 
    
 
    [bookmark: pgfId-1578037]Note Security Intelligence-based traffic filtering, and some decoding and preprocessing occur before network traffic is evaluated by access control rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1578676]
 
     
      
       
       [bookmark: pgfId-1578803]Table 7-1 License Requirements for Network-Based Access Control Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1578809]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1578811]Geolocation Control 
         
  
        	 
          
          [bookmark: pgfId-1578813]All Other Network-Based Control 
         
  
       
 
        
        	[bookmark: pgfId-1578815]license
  
        	[bookmark: pgfId-1578820]Any
  
        	[bookmark: pgfId-1578822]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1558693]For information on building network-based access control rules, see:
 
     
     	 [bookmark: pgfId-1530991]Controlling Traffic by Security Zone
 
     	 [bookmark: pgfId-1531132]Controlling Traffic by Network or Geographical Location
 
     	 [bookmark: pgfId-1531160]Controlling Traffic by Port and ICMP Codes
 
    
 
   
 
    
     [bookmark: pgfId-1530963][bookmark: 64628]Controlling Traffic by Security Zone
 
    [bookmark: pgfId-1531017]License: Any
 
    [bookmark: pgfId-1578283]Zone conditions in access control rules allow you to control traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces. 
 
    [bookmark: pgfId-1578536]As a simple example, you could create two zones: Internal and External, and assign the first pair of interfaces on the device to those zones. Hosts connected to the network on the Internal side represent your protected assets.
 
    [bookmark: pgfId-1539358]To extend this scenario, you could deploy additional identically configured devices to protect similar resources in several different locations. Each of these devices protects the assets in its Internal security zone.
 
     
      
    
 
    
 
    [bookmark: pgfId-1539543]Tip You are not required to group all internal (or external) interfaces into a single zone. Choose the grouping that makes sense for your deployment and security policies. For more information on creating zones, see Working with Security Zones.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1534133]In this deployment, you may decide that although you want these hosts to have unrestricted access to the Internet, you nevertheless want to protect them by inspecting incoming traffic for intrusions and malware. 
 
    [bookmark: pgfId-1569752]To accomplish this using access control, configure an access control rule with a zone condition where the Destination Zone is set to Internal. This simple access control rule matches traffic that leaves the device from any interface in the Internal zone.
 
    [bookmark: pgfId-1542684]To ensure that the system inspects matching traffic for intrusions and malware, choose a rule action of Allow, then associate this rule with an intrusion and a file policy. For more information, see Using Rule Actions to Determine Traffic Handling and Inspection and Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1543843]If you want to build a more complex rule, you can add a maximum of 50 zones to each of the Source Zones and Destination Zones in a single zone condition:
 
     
     	 [bookmark: pgfId-1542425]To match traffic  leaving the device from an interface in the zone, add that zone to the  Destination Zones .
 
    
 
    [bookmark: pgfId-1542904]Because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a Destination Zone condition.
 
     
     	 [bookmark: pgfId-1542594]To match traffic  entering the device from an interface in the zone, add that zone to the  Source Zones .
 
     	 [bookmark: pgfId-1543792]If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones  and egress through one of the destination zones. 
 
    
 
    [bookmark: pgfId-1575619]When building a zone condition, warning icons indicate invalid configurations. For details, Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1540267]To control traffic by zone:
 
    
 
    [bookmark: pgfId-1535259]Step 1 In the access control policy where you want to control traffic by zone, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1535325]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1535342]Step 2 In the rule editor, select the Zones tab.
 
    [bookmark: pgfId-1540095]The Zones tab appears.
 
    [bookmark: pgfId-1540090]Step 3 Find and select the zones you want to add from the Available Zones. 
 
    [bookmark: pgfId-1543163]To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones. 
 
    [bookmark: pgfId-1554235]Click to select a zone. To select multiple zones, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1542306]Step 4 Click Add to Source or Add to Destination to add the selected zones to the appropriate list. 
 
    [bookmark: pgfId-1543119]You can also drag and drop selected zones.
 
    [bookmark: pgfId-1543927]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-1544090]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-1567037]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531004][bookmark: 20007]Controlling Traffic by Network or Geographical Location
 
    [bookmark: pgfId-1531029]License: feature dependent
 
    [bookmark: pgfId-1544390]Network conditions in access control rules allow you to control traffic by its source and destination IP address. You can either:
 
     
     	 [bookmark: pgfId-1545658]explicitly specify the source and destination IP addresses for the traffic you want to control, or
 
     	 [bookmark: pgfId-1552298]use the geolocation feature, which associates IP addresses with geographical locations, to control traffic based on its source or destination country or continent
 
    
 
    [bookmark: pgfId-1552299]When you build a network-based access control rule condition, you can manually specify IP address and geographical locations. Alternately, you can configure network conditions with network and geolocation objects, which are reusable and associate a name with one or more IP addresses, address blocks, countries, continents, and so on. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1550333]Tip After you create a network or geolocation object, you can use it not only to build access control rules, but also to represent IP addresses in various other places in the system’s module interface. You can create these objects using the object manager; you can also create network objects on-the-fly while you are configuring access control rules. For more information, see Managing Reusable Objects.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1574051]Table 7-2 License Requirements for Network Conditions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1574057]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1574084]Geolocation Control 
         
  
        	 
          
          [bookmark: pgfId-1574061]IP Address Control 
         
  
       
 
        
        	[bookmark: pgfId-1574063]license
  
        	[bookmark: pgfId-1574089]Any
  
        	[bookmark: pgfId-1574067]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1551274]You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition, and you can mix network and geolocation-based configurations:
 
     
     	 [bookmark: pgfId-1547805]To match traffic  from an IP address or geographical location, configure the  Source Networks .
 
     	 [bookmark: pgfId-1547811]To match traffic  to an IP address or geographical location, configure the  Destination Networks .
 
    
 
    [bookmark: pgfId-1552042]If you add both source and destination network conditions to a rule, matching traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses. 
 
    [bookmark: pgfId-1548865]When building a network condition, warning icons indicate invalid configurations. For details, see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1545468]To control traffic by network or geographical location:
 
    
 
    [bookmark: pgfId-1544449]Step 1 In the access control policy where you want to control traffic by network, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1559562]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1544451]Step 2 In the rule editor, select the Networks tab.
 
    [bookmark: pgfId-1544452]The Networks tab appears.
 
    [bookmark: pgfId-1544453]Step 3 Find and select the networks you want to add from the Available Networks, as follows:
 
     
      
      	 [bookmark: pgfId-1544454]Click the Networks tab to display network objects and groups to add; click the Geolocation tab to display geolocation objects. 
 
      	 [bookmark: pgfId-1553093]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
     
 
     [image: ] ) above the 
      Available Networks list; see 
     Working with Network Objects. 
    
 
     
      
      	 [bookmark: pgfId-1544455]To search for network or geolocation objects to add, select the appropriate tab, click the  Search by name or value  prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
     
 
    
 
    [bookmark: pgfId-1552816]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1544456]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
    [bookmark: pgfId-1544457]You can also drag and drop selected objects.
 
    [bookmark: pgfId-1553181]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually.
 
    [bookmark: pgfId-1553290]Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
    [bookmark: pgfId-1544458]Step 6 Save or continue editing the rule.
 
    [bookmark: pgfId-1544459]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-1567069]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531087][bookmark: 98442][bookmark: 32313]Controlling Traffic by Port and ICMP Codes
 
    [bookmark: pgfId-1531088]License: Any 
 
    [bookmark: pgfId-1554568]Network conditions in access control rules allow you to control traffic by its source and destination port. In this context, “port” refers to one of the following:
 
     
     	 [bookmark: pgfId-1555750]For TCP and UDP, you can control traffic based on the transport layer protocol. The system represents this configuration using the protocol number in parentheses, plus an optional associated port or port range. For example: TCP(6)/22.
 
     	 [bookmark: pgfId-1556466]For ICMP and ICMPv6 (IPv6-ICMP), you can control traffic based on its Internet layer protocol plus an optional type and code. For example: ICMP(1):3:3.
 
     	 [bookmark: pgfId-1556467]You can control traffic using other protocols that do not use ports. 
 
    
 
    [bookmark: pgfId-1556468]When you build a port-based access control rule condition, you can manually specify ports. Alternately, you can configure port conditions with port objects, which are reusable and associate a name with one or more ports. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1555422]Tip After you create a port object, you can use it not only to build access control rules, but also to represent ports in various other places in the system’s module interface. You can create port objects either using the object manager or on-the-fly while you are configuring access control rules. For more information, see Working with Port Objects.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1555946]You can add a maximum of 50 items to each of the Selected Source Ports and Selected Destination Ports lists in a single network condition:
 
     
     	 [bookmark: pgfId-1557513]To match traffic  from a port, configure the  Selected Source Ports .
 
    
 
    [bookmark: pgfId-1557514]If you add only source ports to a condition, you can add ports that use different transport protocols. For example, you can add both DNS over TCP and DNS over UDP as source port conditions in a single access control rule.
 
     
     	 [bookmark: pgfId-1554651]To match traffic  to a port, configure the  Selected Destination Ports .
 
    
 
    [bookmark: pgfId-1574915]If you add only destination ports to a condition, you can add ports that use different transport protocols.
 
     
     	 [bookmark: pgfId-1574916]To match traffic both originating from specific  Selected Source Ports  and destined for specific  Selected Destination Ports , configure both.
 
    
 
    [bookmark: pgfId-1557856]If you add both source and destination ports to a condition, you can only add ports that share a single transport protocol (TCP or UDP). For example, if you add DNS over TCP as a source port, you can add Yahoo Messenger Voice Chat (TCP) as a destination port but not Yahoo Messenger Voice Chat (UDP). 
 
    [bookmark: pgfId-1574217]Keep the following points in mind when building a port condition:
 
     
     	 [bookmark: pgfId-1557253]When you add a destination ICMP port with the type set to 0 or a destination ICMPv6 port with the type set to 129, the access control rule only matches unsolicited echo replies. ICMP echo replies sent in response to ICMP echo requests are ignored. For a rule to match on any ICMP echo, use ICMP type 8 or ICMPv6 type 128.
 
     	 [bookmark: pgfId-1574324]When you use the GRE (47) protocol as a destination port condition, you can only add other network-based conditions to the access control rule, that is, zone, and network conditions. You cannot save the rule if you add reputation or user-based conditions.
 
    
 
    [bookmark: pgfId-1554660]When building a port condition, warning icons indicate invalid configurations. For example, you can use the object manager to edit in-use port objects so that the rules that use those object groups become invalid. For details, see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1554661]To control traffic by port:
 
    
 
    [bookmark: pgfId-1554663]Step 1 In the access control policy where you want to control traffic by port, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1559598]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1554665]Step 2 In the rule editor, select the Ports tab.
 
    [bookmark: pgfId-1554666]The Ports tab appears.
 
    [bookmark: pgfId-1554667]Step 3 Find and select the ports you want to add from the Available Ports, as follows:
 
     
      
      	 [bookmark: pgfId-1556303]To add a port object on the fly, which you can then add to the condition, click the add icon (
 
     
 
     [image: ] ) above the Available Ports list; see 
     Working with Port Objects. 
    
 
     
      
      	 [bookmark: pgfId-1556304]To search for port objects and groups to add, click the  Search by name or value  prompt above the  Available Ports  list, then type either the name of the object, or the value of a port in the object. The list updates as you type to display matching objects. For example, if you type 80, the ASA FirePOWER module displays the Cisco-provided HTTP port object.
 
     
 
    
 
    [bookmark: pgfId-1556417]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1556418]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
    [bookmark: pgfId-1556413]You can also drag and drop selected objects.
 
    [bookmark: pgfId-1556414]Step 5 Add any source or destination ports that you want to specify manually.
 
     
      
      	 [bookmark: pgfId-1556512]For source ports, select either  TCP or  UDP from the  Protocol drop-down list under the  Selected Source Ports list. Then, enter a  Port . You can specify a single port with a value from 0 to 65535.
 
      	 [bookmark: pgfId-1575242]For destination ports, select a protocol (including  All for all protocols) from the  Protocol drop down list under the  Selected Destination Ports list. You can also type the number of an unassigned protocol that does not appear in the list.
 
     
 
    
 
    [bookmark: pgfId-1575243]If you select ICMP or IPv6-ICMP, a pop-up window appears where you can select a type and a related code. For more information on ICMP types and codes, see http://www.iana.org/assignments/icmp-parameters/icmp-parameters.xml and http://www.iana.org/assignments/icmpv6-parameters/icmpv6-parameters.xml.
 
    [bookmark: pgfId-1557895]If you do not want to specify a protocol, or optionally if you specified TCP or UDP, enter a Port. You can specify a single port with a value from 0 to 65535.
 
    [bookmark: pgfId-1556483]Click Add. Note that the ASA FirePOWER module will not add a port to a rule condition that results in an invalid configuration.
 
    [bookmark: pgfId-1554676]Step 6 Save or continue editing the rule.
 
    [bookmark: pgfId-1554677]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-1567121]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531076]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1575170]Controlling Traffic with Reputation-Based Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1584556]Access control rules within access control policies exert granular control over network traffic logging and handling. Reputation-based conditions in access control rules allow you to manage which traffic can traverse your network, by contextualizing your network traffic and limiting it where appropriate. Access control rules govern the following types of reputation-based control:
 
     
     	 [bookmark: pgfId-1585520]Application conditions allow you to perform  application control , which controls application traffic based on not only individual applications, but also applications’ basic characteristics: type, risk, business relevance, categories, and tags.
 
     	 [bookmark: pgfId-1586256]URL conditions allow you to perform  URL filtering , which controls web traffic based on individual websites, as well as websites’ system-assigned category and reputation.
 
    
 
    [bookmark: pgfId-1588115]You can combine reputation-based conditions with each other and with other types of conditions to create an access control rule. These access control rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on access control rules, see Tuning Traffic Flow Using Access Control Rules.
 
     
      
       
       [bookmark: pgfId-1584590]Table 8-1 License Requirements for Reputation-Based Access Control Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1584598]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1584600]Application Control 
         
  
        	 
          
          [bookmark: pgfId-1584602]URL Filtering (cat. & rep.) 
         
  
        	 
          
          [bookmark: pgfId-1584604]URL Filtering (manual) 
         
  
       
 
        
        	[bookmark: pgfId-1584606]license
  
        	[bookmark: pgfId-1584608]Control
  
        	[bookmark: pgfId-1584613]URL Filtering
  
        	[bookmark: pgfId-1584615]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1575172]For information on adding reputation-based conditions to access control rules, see:
 
     
     	 [bookmark: pgfId-1531026]Controlling Application Traffic
 
     	 [bookmark: pgfId-1634197]Blocking URLs
 
    
 
    [bookmark: pgfId-1634198]The ASA FirePOWER module can perform other types of reputation-based control, but you do not configure these using access control rules. For more information, see:
 
     
     	 [bookmark: pgfId-1587327]Blacklisting Using Security Intelligence IP Address Reputation  explains how to limit traffic based on the reputation of a connection’s origin or destination as a first line of defense. 
 
     	 [bookmark: pgfId-1587463]Tuning Intrusion Prevention Performance explains how to detect, track, store, analyze, and block the transmission of malware and other types of prohibited files.
 
    
 
   
 
    
     [bookmark: pgfId-1576835][bookmark: 18784]Controlling Application Traffic
 
    [bookmark: pgfId-1576839]License: Control
 
    [bookmark: pgfId-1572616]When the ASA FirePOWER module analyzes IP traffic, it can identify and classify the commonly used applications on your network.
 
    [bookmark: pgfId-1627901]Understanding Application Control
 
    [bookmark: pgfId-1573272]Application conditions in access control rules allow you to perform this application control. Within a single access control rule, there are a few ways you can specify applications whose traffic you want to control:
 
     
     	 [bookmark: pgfId-1558740]You can select individual applications, including custom applications.
 
     	 [bookmark: pgfId-1558744]You can use system-provided  application filters , which are named sets of applications organized according to the applications’ basic characteristics: type, risk, business relevance, categories, and tags.
 
     	 [bookmark: pgfId-1558745]You can create and use custom application filters, which group applications (including custom applications) in any way you choose.
 
    
 
    [bookmark: pgfId-1558746]Application filters allow you to quickly create application conditions for access control rules. They simplify policy creation and administration, and grant you assurance that the system will control web traffic as expected. For example, you could create an access control rule that identifies and blocks all high risk, low business relevance applications. If a user attempts to use one of those applications, the session is blocked.
 
    [bookmark: pgfId-1568876]In addition, Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. By using filters based on application characteristics, you can ensure that the system uses the most up-to-date detectors to monitor application traffic.
 
    [bookmark: pgfId-1627946]Building Application Conditions
 
    [bookmark: pgfId-1574790]For traffic to match an access control rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list.
 
    [bookmark: pgfId-1575760]In a single application condition, you can add a maximum of 50 items to the Selected Applications and Filters list. Each of the following counts as an item:
 
     
     	 [bookmark: pgfId-1566267]One or more filters from the  Application Filters list, individually or in custom combination. This item represents set of applications, grouped by characteristic.
 
     	 [bookmark: pgfId-1566268]A filter created by saving an application search in the  Available Applications list. This item represents a set of applications, grouped by substring match.
 
     	 [bookmark: pgfId-1620098]An individual application from the  Available Applications list.
 
    
 
    [bookmark: pgfId-1620099]In the module interface, filters added to a condition are listed above and separately from individually added applications.
 
    [bookmark: pgfId-1643309]Note that when you apply an access control policy, for each rule with an application condition, the system generates a list of unique applications to match. In other words, you may use overlapping filters and individually specified applications to ensure complete coverage.
 
     
      
    
 
    
 
    [bookmark: pgfId-1643310]Note For encrypted traffic, the system can identify and filter traffic using only the applications tagged SSL Protocol. Applications without this tag can only be detected in unencrypted traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1643300]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1562643]Matching Traffic with Application Filters
 
     	 [bookmark: pgfId-1562805]Matching Traffic from Individual Applications
 
     	 [bookmark: pgfId-1572852]Adding an Application Condition to an Access Control Rule
 
     	 [bookmark: pgfId-1572886]Limitations to Application Control
 
    
 
     
      [bookmark: pgfId-1564936][bookmark: 69738]Matching Traffic with Application Filters
 
     [bookmark: pgfId-1584130]License: Control
 
     [bookmark: pgfId-1573134]When building an application condition in an access control rule, use the Application Filters list to create a set of applications, grouped by characteristic, whose traffic you want to match.
 
     [bookmark: pgfId-1587736]Note that the mechanism for filtering applications within an access control rule is the same as that for creating reusable, custom application filters using the object manager; see Working with Application Filters. You can also save many filters you create on-the-fly in access control rules as new, reusable filters. You cannot save a filter that includes another user-created filter because you cannot nest user-created filters.
 
     [bookmark: pgfId-1569755]Understanding How Filters Are Combined
 
     [bookmark: pgfId-1569794]When you select filters, singly or in combination, the Available Applications list updates to display only the applications that meet your criteria. You can select system-provided filters in combination, but not custom filters.
 
     [bookmark: pgfId-1569756]The system links multiple filters of the same filter type with an OR operation. For example, if you select the Medium and High filters under the Risks type, the resulting filter is:
 
      
      [bookmark: pgfId-1569757]Risk: Medium OR High 
     
 
     [bookmark: pgfId-1569758]If the Medium filter contains 110 applications and the High filter contains 82 applications, the system displays all 192 applications in the Available Applications list.
 
     [bookmark: pgfId-1569759]The system links different types of filters with an AND operation. For example, if you select the Medium and High filters under the Risks type, and the Medium and High filters under the Business Relevance type, the resulting filter is:
 
      
      [bookmark: pgfId-1569760]Risk: Medium OR High
AND
Business Relevance: Medium OR High 
     
 
     [bookmark: pgfId-1569761]In this case, the system displays only those applications that are included in both the Medium or High Risk type AND the Medium or High Business Relevance type.
 
     [bookmark: pgfId-1568671]Finding and Selecting Filters
 
     [bookmark: pgfId-1570169]To select filters, click the arrow next to a filter type to expand it, then select or clear the check box next to each filter whose applications you want to display or hide. You can also right-click a system-provided filter type (Risks, Business Relevance, Types, Categories, or Tags) and select Check All or Uncheck All.
 
     [bookmark: pgfId-1571026]To search for filters, click the Search by name prompt above the Available Filters list, then type a name. The list updates as you type to display matching filters.
 
     [bookmark: pgfId-1571022]After you are done selecting filters, use the Available Applications list to add those filters to the rule; see Matching Traffic from Individual Applications.
 
    
 
     
      [bookmark: pgfId-1558774][bookmark: 60208]Matching Traffic from Individual Applications
 
     [bookmark: pgfId-1584235]License: Control
 
     [bookmark: pgfId-1562866]When building an application condition in an access control rule, use the Available Applications list to select the applications whose traffic you want to match. 
 
     [bookmark: pgfId-1563411]Browsing the List of Applications
 
     [bookmark: pgfId-1563413]When you first start to build the condition the list is unconstrained, and displays every application the system detects, 100 at a time:
 
      
      	 [bookmark: pgfId-1561750]To page through the applications, click the arrows underneath the list. 
 
      	 [bookmark: pgfId-1561801]To display a pop-up window with summary information about the application’s characteristics, as well as Internet search links that you can follow, click the information icon (
 
      [image: ] ) next to an application. 
     
 
     [bookmark: pgfId-1561898][bookmark: 42058]Finding Applications to Match
 
     [bookmark: pgfId-1563379]To help you find the applications you want to match, you can constrain the Available Applications list in the following ways:
 
      
      	 [bookmark: pgfId-1561862]To search for applications, click the  Search by name prompt above the list, then type a name. The list updates as you type to display matching applications.
 
      	 [bookmark: pgfId-1624527]To constrain the applications by applying a filter, use the  Application Filters list (see Matching Traffic with Application Filters). The  Available Applications list updates as you apply filters. 
 
     
 
     [bookmark: pgfId-1624529]Once constrained, an All apps matching the filter option appears at the top of the Available Applications list. This option allows you to add all the applications in the constrained list to the Selected Applications and Filters list, all at once.
 
      
       
     
 
     
 
     [bookmark: pgfId-1563964]Note If you select one or more filters in the Application Filters list and also search the Available Applications list, your selections and the search-filtered Available Applications list are combined using an AND operation. That is, the All apps matching the filter condition includes all the individual conditions currently displayed in the Available Applications list as well as the search string entered above the Available Applications list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1563965]Selecting Single Applications to Match in a Condition
 
     [bookmark: pgfId-1563966]After you find an application you want to match, click to select it. To select multiple applications, use the Shift and Ctrl keys, or right-click and select Select All to select all applications in the current constrained view.
 
     [bookmark: pgfId-1564320]In a single application condition, you can match a maximum of 50 applications by selecting them individually; to add more than 50 you must either create multiple access control rules or use filters to group applications.
 
     [bookmark: pgfId-1563576]Selecting All Applications Matching a Filter for a Condition
 
     [bookmark: pgfId-1566972]Once constrained by either searching or using the filters in the Application Filters list, the All apps matching the filter option appears at the top of the Available Applications list.
 
     [bookmark: pgfId-1566973]This option allows you to add the entire set of applications in the constrained Available Applications list to the Selected Applications and Filters list, at once. In contrast to adding applications individually, adding this set of applications counts as only one item against the maximum of 50, regardless of the number of individual applications that comprise it.
 
     [bookmark: pgfId-1566522]When you build an application condition this way, the name of the filter you add to the Selected Applications and Filters list is a concatenation of the filter types represented in the filter plus the names of up to three filters for each type. More than three filters of the same type are followed by an ellipsis (...). For example, the following filter name includes two filters under the Risks type and four under Business Relevance:
 
      
      [bookmark: pgfId-1558778]Risks: Medium, High Business Relevance: Low, Medium, High,... 
     
 
     [bookmark: pgfId-1643095]Filter types that are not represented in a filter you add with All apps matching the filter are not included in the name of the filter you add. These filter types are set to any; that is, these filter types do not constrain the filter, so any value is allowed for these.
 
     [bookmark: pgfId-1611652]You can add multiple instances of All apps matching the filter to an application condition, with each instance counting as a separate item in the Selected Applications and Filters list. For example, you could add all high risk applications as one item, clear your selections, then add all low business relevance applications as another item. This application condition matches applications that are high risk OR have low business relevance.
 
    
 
     
      [bookmark: pgfId-1531151][bookmark: 67401]Adding an Application Condition to an Access Control Rule
 
     [bookmark: pgfId-1584260]License: Control
 
     [bookmark: pgfId-1573386]For traffic to match an access control rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list. 
 
     [bookmark: pgfId-1573605]You can add a maximum of 50 items per condition, and filters added to a condition are listed above and separately from individually added applications. When building an application condition, warning icons indicate invalid configurations. For details, see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-1577124]To control application traffic:
 
     
 
     [bookmark: pgfId-1577126]Step 1 In the access control policy where you want to control traffic by application, create a new access control rule or edit an existing rule.
 
     [bookmark: pgfId-1560033]For detailed instructions, see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1560034]Step 2 In the rule editor, select the Applications tab.
 
     [bookmark: pgfId-1560035]The Applications tab appears.
 
     [bookmark: pgfId-1567451]Step 3 Optionally, use filters to constrain the list of applications displayed in the Available Applications list.
 
     [bookmark: pgfId-1570031]Select one or more filters in the Application Filters list. For more information, see Matching Traffic with Application Filters.
 
     [bookmark: pgfId-1571235]Step 4 Find and select the applications you want to add from the Available Applications list.
 
     [bookmark: pgfId-1571389]You can search for and select individual applications, or, when the list is constrained, All apps matching the filter. For more information, see Matching Traffic from Individual Applications. 
 
     [bookmark: pgfId-1571711]Step 5 Click Add to Rule to add the selected applications to the Selected Applications and Filters list. 
 
     [bookmark: pgfId-1571784]You can also drag and drop selected applications and filters. Filters appear under the heading Filters, and applications appear under the heading Applications.
 
      
       
     
 
     
 
     [bookmark: pgfId-1571857]Tip Before you add another filter to this application condition, click Clear All Filters to clear your existing selections.
 
      
      
 
     
 
     
 list to save a custom filter comprised of all the individual applications and filters currently in the list. 
     
 
     [bookmark: pgfId-1571820]Use the object manager to manage this on-the-fly-created filter; see Working with Application Filters. Note that you cannot save a filter that includes another user-created filter; you cannot nest user-created filters.
 
     [bookmark: pgfId-1560047]Step 7 Save or continue editing the rule.
 
     [bookmark: pgfId-1560048]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1580965]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1552081][bookmark: 67476]Limitations to Application Control
 
     [bookmark: pgfId-1584285]License: Control
 
     [bookmark: pgfId-1552090]Keep the following points in mind when performing application control.
 
     [bookmark: pgfId-1552091]Speed of Application Identification
 
     [bookmark: pgfId-1552092]The system cannot perform application control before:
 
      
      	 [bookmark: pgfId-1552093]a monitored connection is established between a client and server, and 
 
      	 [bookmark: pgfId-1552094]the system identifies the application in the session
 
     
 ). 
     
 
     [bookmark: pgfId-1552097]The allowed packets are inspected by the access control policy’s default intrusion policy (not the default action intrusion policy nor the almost-matched rule’s intrusion policy). For more information, see Setting the Default Intrusion Policy for Access Control.
 
     [bookmark: pgfId-1552098]After the system completes its identification, the system applies the access control rule action, as well as any associated intrusion and file policy, to the remaining session traffic that matches its application condition.
 
     [bookmark: pgfId-1624559]Handling Encrypted Traffic
 
     [bookmark: pgfId-1626988]The system can identify and filter unencrypted application traffic that becomes encrypted using StartTLS, such as SMTPS, POPS, FTPS, TelnetS, and IMAPS. In addition, it can identify certain encrypted applications based on the Server Name Indication in the TLS client hello message, or the server certificate subject distinguished name value.
 
     [bookmark: pgfId-1626980]These applications are tagged SSL Protocol. Applications without this tag can only be detected in unencrypted traffic. 
 
     [bookmark: pgfId-1552375]Handling Application Traffic Packets Without Payloads
 
     [bookmark: pgfId-1592237]The system applies the default policy action to packets that do not have a payload in a connection where an application is identified.
 
     [bookmark: pgfId-1592238]Handling Referred Traffic
 
     [bookmark: pgfId-1552489]To create a rule to act on traffic referred by a web server, such as advertisement traffic, add a condition for the referred application rather than the referring application.
 
     [bookmark: pgfId-1583941]Controlling Application Traffic That Uses Multiple Protocols (Sky[bookmark: marker-1612766]pe)
 
     [bookmark: pgfId-1596814]The system can detect multiple types of Skype application traffic. When building an application condition to control Skype traffic, select the Skype tag from the Application Filters list rather than selecting individual applications. This ensures that the system can detect and control all Skype traffic the same way. For more information, see Matching Traffic with Application Filters.
 
    
 
   
 
    
     [bookmark: pgfId-1531028][bookmark: 77351]Blocking URLs
 
    [bookmark: pgfId-1531053]License: feature dependent
 
    [bookmark: pgfId-1533906]URL conditions in access control rules allow you to limit the websites that users on your network can access. This feature is called URL filtering. There are two ways you can use access control to specify URLs you want to block (or, conversely, allow):
 
     
     	 [bookmark: pgfId-1533907]With any license, you can manually specify individual URLs or groups of URLs to achieve granular, custom control over web traffic.
 
     	 [bookmark: pgfId-1533988]With a URL Filtering license, you can also control access to websites based on the URL’s general classification, or  category , and risk level, or  reputation . The system displays this category and reputation data in connection logs, intrusion events, and application details. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1618814]Note To see URL category and reputation information in events, you must create at least one access control rule with a URL condition.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1634454]When you block a website, you can either allow the user’s browser its default behavior, or you can display a generic system-provided or custom page. You can also give users a chance to bypass a website block by clicking through a warning page.
 
    [bookmark: pgfId-1665640]Due to memory resources, the ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5512-X, ASA5515-X, ASA5516-X, ASA5525-X, and 71xx Family devices use a smaller URL category database than the database used by other models, including the ASA5545-X, ASA5555-X, and the ASA5585-X. 
 
     
      
       
       [bookmark: pgfId-1588420]Table 8-2 License Requirements for URL Filtering 
 
       
       
        
        	 
          
          [bookmark: pgfId-1588426]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1588428]Category & Reputation-Based 
         
  
        	 
          
          [bookmark: pgfId-1588430]Manual 
         
  
       
 
        
        	[bookmark: pgfId-1588432]license
  
        	[bookmark: pgfId-1588437]URL Filtering
  
        	[bookmark: pgfId-1588439]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1547124]For more information, see:
 
     
     	 [bookmark: pgfId-1547128]Performing Reputation-Based URL Blocking
 
     	 [bookmark: pgfId-1588156]Performing Manual URL Blocking
 
     	 [bookmark: pgfId-1588279]Limitations to URL Detection and Blocking
 
     	 [bookmark: pgfId-1588192]Allowing Users to Bypass URL Blocks
 
     	 [bookmark: pgfId-1588197]Displaying a Custom Web Page for Blocked URLs
 
    
 
     
      [bookmark: pgfId-1531045][bookmark: 91509]Performing Reputation-Based URL Blocking
 
     [bookmark: pgfId-1537250]License: URL Filtering
 
     [bookmark: pgfId-1536219]With a URL Filtering license, you can control your users’ access to websites based on the category and reputation of requested URLs, which the ASA FirePOWER module obtains from the Cisco cloud:
 
      
      	 [bookmark: pgfId-1536220]The URL  category is a general classification for the URL. For example, ebay.com belongs to the  Auctions category, and monster.com belongs to the  Job Search category. A URL can belong to more than one category.
 
      	 [bookmark: pgfId-1628654]The URL  reputation represents how likely the URL is to be used for purposes that might be against your organization’s security policy. A URL’s risk can range from  High Risk (level 1) to  Well Known (level 5).
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1628662]Note Before access control rules with category and reputation-based URL conditions can take effect, you must enable communications with the Cisco cloud. This allows the ASA FirePOWER module to retrieve URL data. For more information, see Enabling Cloud Communications.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1628566]Advantages to Reputation-Based URL Blocking
 
     [bookmark: pgfId-1628805]URL categories and reputations allow you to quickly create URL conditions for access control rules. For example, you could create an access control rule that identifies and blocks all High Risk URLs in the Abused Drugs category. If a user attempts to browse to any URL with that category and reputation combination, the session is blocked.
 
     [bookmark: pgfId-1628570]Using category and reputation data from the Cisco cloud also simplifies policy creation and administration. It grants you assurance that the system will control web traffic as expected. Finally, because the cloud is continually updated with new URLs, as well as new categories and risks for existing URLs, you can ensure that the system uses up-to-date information to filter requested URLs. Malicious sites that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies.
 
     [bookmark: pgfId-1536915]Some examples include:
 
      
      	 [bookmark: pgfId-1536916]If a rule blocks all gaming sites, as new domains get registered and classified as  Gaming , the system can block those sites automatically.
 
      	 [bookmark: pgfId-1536917]If a rule blocks all malware sites, and a blog page gets infected with malware, the cloud can recategorize the URL from  Blog to  Malware and the system can block that site.
 
      	 [bookmark: pgfId-1536918]If a rule blocks high-risk social networking sites, and somebody posts a link on their profile page that contains links to malicious payloads, the cloud can change the reputation of that page from  Benign sites to  High Risk so the system can block it.
 
     
 
     [bookmark: pgfId-1540720]Note that if the cloud does not know the category or reputation of a URL, or if the ASA FirePOWER module cannot contact the cloud, that URL does not trigger access control rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
 
     [bookmark: pgfId-1541534]Building URL Conditions
 
     [bookmark: pgfId-1551734]You can add a maximum of 50 items to the Selected URLs to match in a single URL condition. Each URL category, optionally qualified by reputation, counts as a single item. Note that you can also use literal URLs and URL objects in URL conditions, but you cannot qualify these items with a reputation. For more information, see Performing Manual URL Blocking.
 
     [bookmark: pgfId-1542269]Note that you cannot qualify a literal URL or URL object with a reputation.
 
     [bookmark: pgfId-1547034]When building a URL condition, warning icons indicate invalid configurations. For details, see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-1538373]To control traffic by requested URL using category and reputation data:
 
     
 
     [bookmark: pgfId-1589244]Step 1 In the access control policy where you want to control traffic by URL, create a new access control rule or edit an existing rule.
 
     [bookmark: pgfId-1538378]For detailed instructions, see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1538380]Step 2 In the rule editor, select the URLs tab.
 
     [bookmark: pgfId-1543528]The URLs tab appears.
 
     [bookmark: pgfId-1544159]Step 3 Find and select the categories of URL you want to add from the Categories and URLs list. To match web traffic regardless of category, select Any category.
 
     [bookmark: pgfId-1544161]To search for categories to add, click the Search by name or value prompt above the Categories and URLs list, then type the category name. The list updates as you type to display matching categories.
 
     [bookmark: pgfId-1551788]To select a category, click it. To select multiple categories, use the Shift and Ctrl keys. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1551789]Tip Although you can right-click and Select All categories, adding all categories this way exceeds the 50-item maximum for an access control rule. Instead, use Any.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1544199]Step 4 Optionally, qualify your category selections by clicking a reputation level from the Reputations list. If you do not specify a reputation level, the system defaults to Any, meaning all levels. 
 
     [bookmark: pgfId-1544369]You can only select one reputation level. When you choose a reputation level, the access control rule behaves differently depending on its purpose:
 
      
       
       	 [bookmark: pgfId-1544337]If the rule blocks or monitors web access (the rule action is  Block ,  Block with reset ,  Interactive Block ,  Interactive Block with reset , or  Monitor ) selecting a reputation level also selects all reputations more severe than that level. For example, if you configure a rule to block or monitor  Suspicious sites (level 2), it also automatically blocks or monitors  High risk (level 1) sites.
 
       	 [bookmark: pgfId-1544339]If the rule allows web access, whether to trust or further inspect it (the rule action is  Allow  or  Trust ), selecting a reputation level also selects all reputations less severe than that level. For example, if you configure a rule to allow  Benign sites (level 4), it also automatically allows  Well known (level 5) sites.
 
      
 
     
 
     [bookmark: pgfId-1544302]If you change the rule action for a rule, the system automatically changes the reputation levels in URL conditions according to the above points.
 
     [bookmark: pgfId-1544578]Step 5 Click Add to Rule or drag and drop the selected items to add them to the Selected URLs list. 
 
     [bookmark: pgfId-1539328]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1539329]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1580972]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537119][bookmark: 88336]Performing Manual URL Blocking
 
     [bookmark: pgfId-1575439]License: Any
 
     [bookmark: pgfId-1575447]To supplement or selectively override URL filtering by category and reputation, you can control web traffic by manually specifying individual URLs or groups of URLs. This allows you to achieve granular, custom control over allowed and blocked web traffic. You can also perform this type of URL filtering without a special license.
 
     [bookmark: pgfId-1544810]To manually specify URLs to allow or block in an access control rule, you can type in a single literal URL. Or, you can configure URL conditions using URL objects, which are reusable and associate a name with a URL or IP address.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537539]Tip After you create a URL object, you can use it not only to build access control rules, but also to represent URLs in various other places in the system’s module interface. You can create these objects using the object manager; you can also create URL objects on-the-fly while you are configuring access control rules. For more information, see Working with URL Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537693]Manually Specifying URLs in URL Conditions
 
     [bookmark: pgfId-1628962]Although manual entry gives you precise control over allowed and blocked web traffic, you cannot qualify a manually specified URL with a reputation. Additionally, you must make sure that your rules do not have unintended consequences. To determine whether network traffic matches a URL condition, the system performs a simple substring match. If the value of a URL object or manually typed URL matches any part of a URL requested by a monitored host, the URL condition of the access control rule is satisfied.
 
     [bookmark: pgfId-1546314]Therefore, when manually specifying URLs in URL conditions, including in URL objects, carefully consider other traffic that might be affected. For example, if you allow all traffic to example.com, your users could browse to URLs including:
 
      
      	 [bookmark: pgfId-1537584]http://example.com/
 
      	 [bookmark: pgfId-1537585]http://example.com/newexample
 
      	 [bookmark: pgfId-1537586]http://www.example.com/
 
     
 
     [bookmark: pgfId-1634289]As another example, consider a scenario where you want to explicitly block ign.com (a gaming site). However, substring matching means that blocking ign.com also blocks verisign.com, which might not be your intent.
 
     [bookmark: pgfId-1634290]Manually Blocking Encrypted Web Traffic 
 
     [bookmark: pgfId-1634291]URL conditions in access control rules:
 
      
      	 [bookmark: pgfId-1634295]disregard the encryption protocol of web traffic (HTTP vs HTTPS)
 
     
 
     [bookmark: pgfId-1634296]For example, access control rules treat traffic to http://example.com/ the same as traffic to https://example.com/. To configure an access control rule that matches only HTTP or HTTPS traffic, add an application condition to the rule. For more information, see Blocking URLs.
 
      
      	 [bookmark: pgfId-1634300]match HTTPS traffic based on the subject common name in the public key certificate used to encrypt the traffic, and also disregard subdomains within the subject common name
 
     
 
     [bookmark: pgfId-1634301]Do not include subdomain information when manually filtering HTTPS traffic.
 
     [bookmark: pgfId-1634302]When building a URL condition, warning icons indicate invalid configurations. For details, see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-1634306]To control web traffic by manually specifying URLs to allow or block:
 
     
 
     [bookmark: pgfId-1634311]Step 1 In the access control policy where you want to control traffic by URL, create a new access control rule or edit an existing rule.
 
     [bookmark: pgfId-1634315]For detailed instructions, see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1634316]Step 2 In the rule editor, select the URLs tab.
 
     [bookmark: pgfId-1634317]The URLs tab appears.
 
     [bookmark: pgfId-1634318]Step 3 Find and select the URL objects and groups you want to add from the Categories and URLs list:
 
      
       
       	 [bookmark: pgfId-1634322]To add a URL object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Categories and URLs list; see 
      Working with URL Objects. 
     
 
      
       
       	 [bookmark: pgfId-1634326]To search for URL objects and groups to add, click the  Search by name or value  prompt above the  Categories and URLs  list, then type either the name of the object, or the value of a URL or IP address in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-1634327]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys. Although you can right-click and Select All URL objects and categories, adding URLs this way exceeds the 50-item maximum for an access control rule.
 
     [bookmark: pgfId-1634328]Step 4 Click Add to Rule or to add the selected items to the Selected URLs list.
 
     [bookmark: pgfId-1634329]You can also drag and drop selected items.
 
     [bookmark: pgfId-1634330]Step 5 Add any literal URLs that you want to specify manually. You cannot use wildcards (*) in this field.
 
     [bookmark: pgfId-1634331]Click the Enter URL prompt below the Selected URLs list; then type a URL or IP address and click Add.
 
     [bookmark: pgfId-1634332]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1634335]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1634337]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1634339][bookmark: 12501]Limitations to URL Detection and Blocking
 
     [bookmark: pgfId-1548535]License: Any
 
     [bookmark: pgfId-1536501]Keep the following points in mind when performing URL detection and blocking.
 
     [bookmark: pgfId-1536641]Speed of URL Identification
 
     [bookmark: pgfId-1536689]The system cannot filter URLs before:
 
      
      	 [bookmark: pgfId-1547252]a monitored connection is established between a client and server
 
      	 [bookmark: pgfId-1547264]the system identifies the HTTP or HTTPS application in the session
 
      	 [bookmark: pgfId-1627201]the system identifies the requested URL (for encrypted sessions, from either the client hello message or the server certificate)
 
     
 ). 
     
 
     [bookmark: pgfId-1547145]The allowed packets are inspected by the access control policy’s default intrusion policy (not the default action intrusion policy nor the almost-matched rule’s intrusion policy). For more information, see Setting the Default Intrusion Policy for Access Control.
 
     [bookmark: pgfId-1629230]After the system completes its identification, the system applies the access control rule action, as well as any associated intrusion and file policy, to the remaining session traffic that matches its URL condition.
 
     [bookmark: pgfId-1629231]Handling Encrypted Web Traffic
 
     [bookmark: pgfId-1629232]When evaluating encrypted web traffic using access control rules with URL conditions, the system:
 
      
      	 [bookmark: pgfId-1629545]disregards the encryption protocol; an access control rule matches both HTTPS and HTTP traffic if the rule has a URL condition but not an application condition that specifies the protocol
 
      	 [bookmark: pgfId-1629233]matches HTTPS traffic based on the subject common name in the public key certificate used to encrypt the traffic, and disregards subdomains within the subject common name
 
      	 [bookmark: pgfId-1629236]does not display an HTTP response page, even if you configured one
 
     
 
     [bookmark: pgfId-1536940]Search Query Parameters in URLs
 
     [bookmark: pgfId-1536941]The system does not use search query parameters in the URL to match URL conditions. For example, consider a scenario where you block all shopping traffic. In that case, using a web search to search for amazon.com is not blocked, but browsing to amazon.com is.
 
    
 
     
      [bookmark: pgfId-1538475][bookmark: 70087]Allowing Users to Bypass URL Blocks
 
     [bookmark: pgfId-1584470]License: Any
 
     [bookmark: pgfId-1633738]When you block a user’s HTTP web request using an access control rule, setting the rule action to Interactive Block or Interactive Block with reset gives that user a chance to bypass the block by clicking through a warning HTTP response page. You can display a generic system-provided response page or you can enter custom HTML. 
 
     [bookmark: pgfId-1632573]By default, the system allows users to bypass blocks for 10 minutes (600 seconds) without displaying the warning page on subsequent visits. You can set the duration to as long as a year, or you can force the user to bypass the block every time.
 
     [bookmark: pgfId-1632495]If the user does not bypass the block, matching traffic is denied without further inspection; you can also reset the connection. On the other hand, if a user bypasses the block, the system allows the traffic. Allowing this traffic means that you can continue to inspect unencrypted payloads for intrusions, malware and prohibited files. Note that users may have to refresh after bypassing the block to load page elements that did not load.
 
     [bookmark: pgfId-1632580]Note that you configure the interactive HTTP response page separately from the response page you configure for Block rules. For example, you could display the system-provided page to users whose sessions are blocked without interaction, but a custom page to users who can click to continue. For more information, see Displaying a Custom Web Page for Blocked URLs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1632671]Tip To quickly disable interactive blocking for all rules in an access control policy, display neither the system-provided page nor a custom page. This causes the system to block all connections that match an Interactive Block rule without interaction.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1550239]To allow users to bypass a website block:
 
     
 
     [bookmark: pgfId-1549830]Step 1 Create an access control rule that matches web traffic with a URL condition.
 
     [bookmark: pgfId-1550419]See Performing Reputation-Based URL Blocking and Performing Manual URL Blocking.
 
     [bookmark: pgfId-1550160]Step 2 Make sure the access control rule action is Interactive Block or Interactive Block with reset.
 
     [bookmark: pgfId-1551192]See Using Rule Actions to Determine Traffic Handling and Inspection.
 
     [bookmark: pgfId-1551194]Step 3 Assume users will bypass the block and choose inspection and logging options for the rule accordingly. As with Allow rules:
 
      
       
       	 [bookmark: pgfId-1551245]You can associate either type of Interactive Block rule with a file and intrusion policy. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
       	 [bookmark: pgfId-1551237]Logging options for interactively blocked traffic are identical to those in allowed traffic, but keep in mind that if a user does not bypass the interactive block, the system can log only beginning-of-connection events. 
 
      
 
     
 
     [bookmark: pgfId-1550862]Note that when the system initially warns the user, it marks any logged beginning-of-connection event with the Interactive Block or Interactive Block with reset action. If the user bypasses the block, additional connection events logged for the session have an action of Allow. For more information, see Logging Connections Based on Access Control Handling.
 
     [bookmark: pgfId-1593131]Step 4 Optionally, set the amount of time that elapses after a user bypasses a block before the system displays the warning page again.
 
     [bookmark: pgfId-1593127]See Setting the User Bypass Timeout for a Blocked Website.
 
     [bookmark: pgfId-1583899]Step 5 Optionally, create and use a custom page to display to allow users to bypass a block.
 
     [bookmark: pgfId-1583903]See Displaying a Custom Web Page for Blocked URLs.
 
     [bookmark: pgfId-1592982]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1593027][bookmark: 59809]Setting the User Bypass Timeout for a Blocked Website
 
     [bookmark: pgfId-1593031]License: Any
 
     [bookmark: pgfId-1593032]By default, the system allows a user to bypass interactive blocks for 10 minutes (600 seconds) without displaying the warning page on subsequent visits. You can set the duration to as long as a year, or to zero to force the user to bypass the block every time. This limit applies to every Interactive Block rule in the policy. You cannot set the limit per rule.
 
     [bookmark: pgfId-1593033]To customize the length of time before a user bypass expires:
 
     
 
     [bookmark: pgfId-1634781]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1593039]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
     
 
     [bookmark: pgfId-1593044]The access control policy editor appears.
 
     [bookmark: pgfId-1593045]Step 3 Select the Advanced tab. 
 
     [bookmark: pgfId-1593046]Advanced settings for the access control policy appear. 
 ) next to General Settings. 
     
 
     [bookmark: pgfId-1593051]The General Settings pop-up window appears.
 
     [bookmark: pgfId-1593052]Step 5 In the Allow an Interactive Block to bypass blocking for (seconds) field, type the number of seconds that must elapse before the user bypass expires.
 
     [bookmark: pgfId-1593053]You can specify any number of seconds from zero to 31536000 (one year). Specifying zero forces your users to bypass the block every time.
 
     [bookmark: pgfId-1593054]Step 6 Click OK.
 
     [bookmark: pgfId-1593665]Advanced settings for the access control policy appear.
 
     [bookmark: pgfId-1638656]Step 7 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-1593668]You must apply the access control policy for your changes to take effect. For more information, see Deploying Configuration Changes.
 
     [bookmark: pgfId-1593669]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1592986][bookmark: 49497]Displaying a Custo[bookmark: marker-1592984]m Web Page for Blocked URLs
 
     [bookmark: pgfId-1592990]License: Any
 
     [bookmark: pgfId-1551677]When the system blocks a user’s HTTP web request, what the user sees in a browser depends on how you block the session, using the access control rule’s action. You should select:
 
      
      	 [bookmark: pgfId-1548904] Block or  Block with reset to deny the connection. A blocked session times out; the system resets Block with reset connections. However, for both blocking actions, you can override the default browser or server page with a custom page that explains that the connection was denied. The system calls this custom page an  HTTP response page . 
 
      	 [bookmark: pgfId-1598262] Interactive Block or  Interactive Block with reset if you want to display an  interactive HTTP response page that warns users, but also allows them to click a button to continue or refresh the page to load the originally requested site. Users may have to refresh after bypassing the response page to load page elements that did not load.
 
     
 
     [bookmark: pgfId-1609529]You can either display a generic system-provided response page, or you can enter custom HTML. When you enter custom text, a counter shows how many characters you have used.
 
     [bookmark: pgfId-1632991]In each access control policy, you configure the interactive HTTP response page separately from the response page you use to block traffic without interaction, that is, using a Block rule. For example, you could display the system-provided page to users whose sessions are blocked without interaction, but a custom page to users who can click to continue.
 
     [bookmark: pgfId-1631368]Reliable display of HTTP response pages to your users depends on your network configuration, traffic loads, and size of the page. If you build a custom response page, keep in mind that a smaller page is more likely to display successfully. 
 
     [bookmark: pgfId-1598271]To configure HTTP response pages:
 
     
 
     [bookmark: pgfId-1549100]Step 1 Edit the access control policy monitoring your web traffic.
 
     [bookmark: pgfId-1549119]For more information, see Editing Access Control Policies.
 
     [bookmark: pgfId-1549111]Step 2 Select the HTTP Responses tab.
 
     [bookmark: pgfId-1549096]HTTP response page settings for the access control policy appear.
 
     [bookmark: pgfId-1548699]Step 3 For the Block Response Page and the Interactive Block Response Page, select responses from the drop-down lists. For each page, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1548703]To use a generic response, select  System-provided . You can click the view icon (
 
      
 
      [image: ] ) to view the HTML code for this page. 
     
 
      
       
       	 [bookmark: pgfId-1548707]To create a custom response, select  Custom .
 
      
 
     
 ). 
     
 
      
       
       	 [bookmark: pgfId-1548715]To prevent the system from displaying an HTTP response page, select  None . Note that selecting this option for interactively blocked sessions prevents users from clicking to continue; the session is blocked without interaction.
 
      
 
     
 
     [bookmark: pgfId-1638639]Step 4 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-1548717]You must apply the access control policy for your changes to take effect. For more information, see Deploying Configuration Changes.
 
     [bookmark: pgfId-1581275]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1624428][bookmark: 97785]Access Control Rules: Realms and Users 
      
      
 
     
 
 
    [bookmark: pgfId-1624538]The following topics describe how to control user traffic on your network:
 
     
     	 [bookmark: pgfId-1624761]Realm, User, User Group, and ISE Attribute Access Control Rule Conditions
 
     	 [bookmark: pgfId-1624810]Troubleshooting Issues with User Access Control Rules
 
     	 [bookmark: pgfId-1624828]Adding a Realm, User, or User Group Condition to an Access Control Rule
 
     	 [bookmark: pgfId-1624846]Adding an ISE Attribute Condition to an Access Control Rule
 
    
 
   
 
    
     [bookmark: pgfId-1624429][bookmark: 73073]Realm, User, User Group, and ISE Attribute Access Control Rule Conditions
 
    [bookmark: pgfId-1628388]License: Control
 
    [bookmark: pgfId-1624982]Before you can perform user control (create access control rule conditions based on entire realms, individual users, user groups, or ISE attributes), you must:
 
     
     	 [bookmark: pgfId-1625078]Configure a realm for each Microsoft Active Directory or LDAP server you want to monitor. If you enable user download for the realm, the Firepower Management Center regularly and automatically queries the server to download metadata for newly or already-reported authoritative users and user groups.
 
     	 [bookmark: pgfId-1625175]Create an identity policy to associate the realm with an authentication method.
 
     	 [bookmark: pgfId-1625194]Configure one or more User Agents or ISE devices, or captive portal. If you want to use an ISE attribute condition, you must configure ISE.
 
    
 
    [bookmark: pgfId-1625085]User Agents, ISE, and captive portal collect authoritative user data that can be used for user control in access control rule conditions. The identity sources monitor specified users as they log in or out of hosts or authenticate using LDAP or AD credentials.
 
     
      
    
 
    
 
    [bookmark: pgfId-1625258]Note If you configure a User Agent or ISE device to monitor a large number of user groups, or if you have a very large number of users mapped to hosts on your network, the system may drop user mappings based on groups, due to your Firepower Management Center user limit. As a result, access control rules with realm, user, or user group conditions may not fire as expected.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1625453]You can add a maximum of 50 realms, users, and groups to the Selected Users in a single user condition. Conditions with user groups match traffic to or from any of the group’s members, including members of any sub-groups, with the exception of individually excluded users and members of excluded sub-groups.
 
    [bookmark: pgfId-1625456]Including a user group automatically includes all of that group’s members, including members of any secondary groups. However, if you want to use the secondary group in access control rules, you must explicitly include the secondary group.
 
     
      
    
 
    
 
    [bookmark: pgfId-1625516]Note Hardware-based fast-path rules, Security Intelligence-based traffic filtering, SSL inspection, user identification, and some decoding and preprocessing occur before access control rules evaluate network traffic.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1624985][bookmark: 86316]Troubleshooting Issues with User Access Control Rules
 
    [bookmark: pgfId-1628362]License: Control
 
    [bookmark: pgfId-1624218]If you notice unexpected user access control rule behavior, consider tuning your rule, identity source, or realm configurations.
 
    [bookmark: pgfId-1625806]Access control rules targeting realms, users, or user groups are not firing
 
    [bookmark: pgfId-1625924]If you configure a User Agent or ISE device to monitor a large number of user groups, or if you have a very large number of users mapped to hosts on your network, the system may drop user records due to your Firepower Management Center user limit. As a result, access control rules with realm or user conditions may not fire as expected.
 
    [bookmark: pgfId-1625975]Access control rules targeting user groups or users within user groups are not firing as expected
 
    [bookmark: pgfId-1625976]If you configure an access control rule with a user group condition, your LDAP or Active Directory server must have user groups configured. The Firepower Management Center cannot perform user group control if the server organizes the users in basic object hierarchy.
 
    [bookmark: pgfId-1625979]Access control rules targeting users in secondary groups are not firing as expected
 
    [bookmark: pgfId-1625980]If you configure an access control rule with a user group condition that includes or excludes users who are members of a secondary group on your Active Directory server, your server may be limiting the number of users it reports.
 
    [bookmark: pgfId-1626288]By default, Active Directory servers limit the number of users they report from secondary groups. You must customize this limit so that all of the users in your secondary groups are reported to the Firepower Management Center and eligible for use in access control rules with user conditions.
 
    [bookmark: pgfId-1626417]Access control rules are not matching users when seen for the first time
 
    [bookmark: pgfId-1626503]After the system detects activity from a previously-unseen user, the system retrieves information from the server. Until the system successfully retrieves this information, activity seen by this user is not handled by matching access control rules. Instead, the user session is handled by the next access control rule it matches (or the access control policy default action).
 
    [bookmark: pgfId-1626928]For example, this may explain when:
 
     
     	 [bookmark: pgfId-1626971]Users who are members of user groups are not matching access control rules with user group conditions.
 
     	 [bookmark: pgfId-1627097]Users who were reported by ISE or the User Agent are not matching access control rules, when the server used for user data retrieval is an Active Directory server.
 
    
 
    [bookmark: pgfId-1627301]Note that this may also cause the system to delay the display of user data in event views and analysis tools.
 
   
 
    
     [bookmark: pgfId-1626293][bookmark: 53090]Adding a Realm, User, or User Group Condition to an Access Control Rule
 
    [bookmark: pgfId-1628336]License: Control
 
    [bookmark: pgfId-1627860]Before You Begin
 
     
     	 [bookmark: pgfId-1627893]Configure one or more authoritative user identity sources as described in User Identity Sources.
 
     	 [bookmark: pgfId-1628030]Configure a realm as described in Creating a Realm. A user download (automatic or on-demand) must be performed before you can configure realm, user, or user group conditions in an access control rule.
 
    
 
    
 
    [bookmark: pgfId-1627436]Step 1 In the access control rule editor, select the Users tab.
 
    [bookmark: pgfId-1627438]Step 2 Search by name or value above the Available Realms list and select a realm.
 
    [bookmark: pgfId-1627609]Step 3 Search by name or value above the Available Users list and select a user or group.
 
    [bookmark: pgfId-1627441]Step 4 Click Add to Rule, or drag and drop.
 
    [bookmark: pgfId-1627443]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-1627448]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1624223]What to Do Next
 
     
     	 [bookmark: pgfId-1627843]Deploy configuration changes; see Deploying Configuration Changes.
 
    
 
   
 
    
     [bookmark: pgfId-1624087][bookmark: 86475]Adding an ISE Attribute Condition to an Access Control Rule
 
    [bookmark: pgfId-1628431]License: Control
 
    [bookmark: pgfId-1628432]Before You Begin
 
     
     	 [bookmark: pgfId-1628435]Configure ISE as described in Configuring an ISE Connection.
 
    
 
    
 
    [bookmark: pgfId-1628441]Step 1 In the access control rule editor, select the ISE Attributes tab.
 
    [bookmark: pgfId-1628442]Step 2 Search by name or value above the Available ISE Session Attributes list and select an attribute.
 
    [bookmark: pgfId-1628443]Step 3 Search by name or value above the Available ISE Metadata list and select metadata.
 
    [bookmark: pgfId-1628444]Step 4 Click Add to Rule, or drag and drop.
 
     
      
    
 
    
 
    [bookmark: pgfId-1628690]Tip You can also use the Add a Location IP Address field to add a Location IP attribute to the condition. The System builds a separate network map for each leaf domain. In a multidomain deployment, using literal IP addresses to constrain this configuration can have unexpected results.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1628445]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-1628446]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1628447]What to Do Next
 
     
     	 [bookmark: pgfId-1628451]Deploy configuration changes; see Deploying Configuration Changes.
 
    
 
    [bookmark: pgfId-1614434]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1610983][bookmark: 22198]Controlling Traffic Using Intrusion and File Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1610987]Intrusion and file policies work together, as the last line of defense before traffic is allowed to its destination:
 
     
     	 [bookmark: pgfId-1569812] Intrusion policies govern the system’s intrusion prevention capabilities; see Understanding Network Analysis and Intrusion Policies.
 
     	 [bookmark: pgfId-1569859] File policies govern the system’s network-based file control and advanced malware protection (AMP) capabilities; see Understanding and Creating File Policies.
 
    
 
    [bookmark: pgfId-1569909]Security Intelligence-based traffic filtering (blacklisting) and traffic decoding and preprocessing occur before network traffic is examined for intrusions, prohibited files, and malware. Access control rules and the access control default action determine which traffic is inspected by intrusion and file policies. 
 
    [bookmark: pgfId-1572222]By associating an intrusion or file policy with an access control rule, you are telling the system that before it passes traffic that matches the access control rule’s conditions, you first want to inspect the traffic with an intrusion policy, a file policy, or both.
 
    [bookmark: pgfId-1568717]Intrusion prevention and AMP require that you enable specific licensed capabilities as described in the following table.
 
    [bookmark: pgfId-1570234]
 
     
      
       
       [bookmark: pgfId-1611188]Table 10-1 License Requirements for Intrusion and File Inspection 
 
       
       
        
        	 
          
          [bookmark: pgfId-1611194]Feature 
         
  
        	 
          
          [bookmark: pgfId-1611196]Description 
         
  
        	 
          
          [bookmark: pgfId-1611198]License 
         
  
       
 
        
        	[bookmark: pgfId-1611200]intrusion prevention
  
        	[bookmark: pgfId-1611202]detect and optionally block intrusions and exploits
  
        	[bookmark: pgfId-1611207]Protection
  
       
 
        
        	[bookmark: pgfId-1611209]file control
  
        	[bookmark: pgfId-1611211]detect and optionally block the transmission of file types 
  
        	[bookmark: pgfId-1611216]Protection
  
       
 
        
        	[bookmark: pgfId-1611218]advanced malware protection (AMP)
  
        	[bookmark: pgfId-1611221]detect, track, and optionally block the transmission of malware
  
        	[bookmark: pgfId-1611229]Malware
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1568769]For more information on inspecting traffic for intrusions, prohibited files, and malware, see: 
 
     
     	 [bookmark: pgfId-1531267]Inspecting Allowed Traffic For Intrusions and Malware
 
     	 [bookmark: pgfId-1531297]Tuning Intrusion Prevention Performance
 
     	 [bookmark: pgfId-1531357]Tuning File and Malware Inspection Performance and Storage
 
    
 
   
 
    
     [bookmark: pgfId-1590132][bookmark: 61352]Inspecting Allowed Traffic For Intrusions and Malware
 
    [bookmark: pgfId-1590142]License: Protection or Malware
 
    [bookmark: pgfId-1608553]Intrusion and file policies govern the system’s intrusion prevention, file control, and AMP capabilities as a last line of defense before traffic is allowed to its destination. Security Intelligence-based traffic filtering, decoding and preprocessing, and access control rule selection occur before intrusion and file inspection.
 
    [bookmark: pgfId-1609073]By associating an intrusion or file policy with an access control rule, you are telling the system that before it passes traffic that matches the access control rule’s conditions, you first want to inspect the traffic with an intrusion policy, a file policy, or both. Access control rule conditions can be simple or complex; you can control traffic by security zone, network or geographical location, port, application, requested URL, and user.
 
    [bookmark: pgfId-1606115]The system matches traffic to access control rules in the order you specify. In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. An access control rule’s action determines how the system handles matching traffic. You can monitor, trust, block, or allow (with or without further inspection) matching traffic; see Using Rule Actions to Determine Traffic Handling and Inspection.
 
    [bookmark: pgfId-1576547]Note that an Interactive Block rule has the same inspection options as an Allow rule. This is so you can inspect traffic for malicious content when a user bypasses a blocked website by clicking through a warning page. For more information, see Interactive Blocking Actions: Allowing Users to Bypass Website Blocks.
 
    [bookmark: pgfId-1576812]Traffic that does not match any of the non-Monitor access control rules in a policy is handled by the default action. Note that the system can inspect traffic allowed by the default action for intrusions, but not prohibited files or malware. You cannot associate a file policy with the access control default action.
 
     
      
    
 
    
 
    [bookmark: pgfId-1605716]Note Sometimes, when a connection is analyzed by an access control policy, the system must process the first few packets in that connection, allowing them to pass, before it can decide which access control rule (if any) will handle the traffic. However, so these packets do not reach their destination uninspected, you can use an intrusion policy—called the default intrusion policy—to inspect them and generate intrusion events. For more information, see Setting the Default Intrusion Policy for Access Control.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1605720]For more information on the above scenario and instructions on associating file and intrusion policies with access control rules and the access control default action, see:
 
     
     	 [bookmark: pgfId-1566930]Understanding File and Intrusion Inspection Order
 
     	 [bookmark: pgfId-1590923]Configuring an Access Control Rule to Perform AMP or File Control
 
     	 [bookmark: pgfId-1575146]Configuring an Access Control Rule to Perform Intrusion Prevention
 
     	 [bookmark: pgfId-1577222]Setting Default Handling and Inspection for Network Traffic
 
    
 
     
      [bookmark: pgfId-1577224][bookmark: 44943]Understanding File and Intrusion Inspection Order
 
     [bookmark: pgfId-1577439]License: Protection or Malware
 
      
       
     
 
     
 
     [bookmark: pgfId-1577355]Note Traffic allowed by an Intrusion Prevention default action can be inspected for intrusions, but cannot be inspected for prohibited files or malware. You cannot associate a file policy with the access control default action.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1565445]You do not have to perform both file and intrusion inspection in the same rule. For a connection matching an Allow or Interactive Block rule:
 
      
      	 [bookmark: pgfId-1565307]without a file policy, traffic flow is determined by the intrusion policy
 
      	 [bookmark: pgfId-1565308]without an intrusion policy, traffic flow is determined by the file policy
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1582134]Tip The system does not perform any kind of inspection on trusted traffic. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1564602]For any single connection handled by an access control rule, file inspection occurs before intrusion inspection. That is, the system does not inspect files blocked by a file policy for intrusions. Within file inspection, simple blocking by type takes precedence over malware inspection and blocking.
 
      
       
     
 
     
 
     [bookmark: pgfId-1622122]Note Until a file is detected and blocked in a session, packets from the session may be subject to intrusion inspection.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1562274]For example, consider a scenario where you normally want to allow certain network traffic as defined in an access control rule. However, as a precaution, you want to block the download of executable files, examine downloaded PDFs for malware and block any instances you find, and perform intrusion inspection on the traffic. 
 
     [bookmark: pgfId-1565084]You create an access control policy with a rule that matches the characteristics of the traffic you want to provisionally allow, and associate it with both an intrusion policy and a file policy. The file policy blocks the download of all executables, and also inspects and blocks PDFs containing malware:
 
      
      	 [bookmark: pgfId-1562275]First, the system blocks the download of all executables, based on simple type matching specified in the file policy. Because they are immediately blocked, these files are subject to neither malware cloud lookup nor intrusion inspection.
 
      	 [bookmark: pgfId-1562276]Next, the system performs malware cloud lookups for PDFs downloaded to a host on your network. Any PDFs with a malware file disposition are blocked, and are not subject to intrusion inspection.
 
      	 [bookmark: pgfId-1577021]Finally, the system uses the intrusion policy associated with the access control rule to inspect any remaining traffic, including files not blocked by the file policy.
 
     
 
    
 
     
      [bookmark: pgfId-1578596][bookmark: 48642]Configuring an Access Control Rule to Perform AMP or File Control
 
     [bookmark: pgfId-1578606]License: Protection or Malware
 
     [bookmark: pgfId-1579107]An access control policy can have multiple access control rules associated with file policies. You can configure file inspection for any Allow or Interactive Block access control rule, which permits you to match different file and malware inspection profiles against different types of traffic on your network before it reaches its final destination.
 
     [bookmark: pgfId-1580004]When the system detects a prohibited file (including malware) according to the settings in the file policy, it automatically logs an event. If you do not want to log file or malware events, you can disable this logging on a per-access-control-rule basis. After you associate the file policy with the access control rule, clear the Log Files check box on the Logging tab of the access control rule editor. For more information, see Disabling File and Malware Event Logging for Allowed Connections.
 
     [bookmark: pgfId-1579963]The system also logs the end of the associated connection, regardless of the logging configuration of the invoking access control rule; see Connections Associated with File and Malware Events (Automatic).
 
     [bookmark: pgfId-1578623]To associate a file policy with an access control rule:
 
     
 
     [bookmark: pgfId-1589015]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1589016]The Access Control Policy page appears.
 ) next to the access control policy where you want to configure AMP or file control using access control rules. 
     
 
     [bookmark: pgfId-1578637]Step 3 Create a new rule or edit an existing rule; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1578638]The access control rule editor appears.
 
     [bookmark: pgfId-1578639]Step 4 Ensure the rule action is set to Allow, Interactive Block, or Interactive Block with reset.
 
     [bookmark: pgfId-1578640]Step 5 Select the Inspection tab.
 
     [bookmark: pgfId-1578641]The Inspection tab appears.
 
     [bookmark: pgfId-1578642]Step 6 Select a File Policy to inspect traffic that matches the access control rule, or select None to disable file inspection for matching traffic.
 ) that appears to edit the policy; see 
     Creating a File Policy. 
     
 
     [bookmark: pgfId-1590998]Step 7 Click Add to save the rule.
 
     [bookmark: pgfId-1591001]Your rule is saved. You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1578652]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1577023][bookmark: 22055]Configuring an Access Control Rule to Perform Intrusion Prevention
 
     [bookmark: pgfId-1580571]License: Protection
 
     [bookmark: pgfId-1580613]An access control policy can have multiple access control rules associated with intrusion policies. You can configure intrusion inspection for any Allow or Interactive Block access control rule, which permits you to match different intrusion inspection profiles against different types of traffic on your network before it reaches its final destination.
 
     [bookmark: pgfId-1591580]Whenever the system uses an intrusion policy to evaluate traffic, it uses an associated variable set. Variables in a set represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions and dynamic rule states.
 
      
       
     
 
     
 
     [bookmark: pgfId-1591584]Tip Even if you use system-provided intrusion policies, Cisco strongly recommends you configure the system’s intrusion variables to accurately reflect your network environment. At a minimum, modify default variables in the default set; see Optimizing Predefined Default Variables.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1606089]Although you can associate a different intrusion policy-variable set pair with each Allow and Interactive Block rule (as well as with the default action), you cannot apply an access control policy if the target devices have insufficient resources to perform inspection as configured. For more information, see Simplifying Rules to Improve Performance.
 
     [bookmark: pgfId-1611998]Understanding System-Provided and Custom Intrusion Policies
 
     [bookmark: pgfId-1612005]Cisco delivers several intrusion policies with the ASA FirePOWER module. By using system-provided intrusion policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for advanced settings. You can use system-provided policies as-is, or you can use them as the base for custom policies. Building custom policies can improve the performance of the system in your environment and provide a focused view of the malicious traffic and policy violations occurring on your network. 
 
     [bookmark: pgfId-1583322]In addition to custom policies that you create, the system provides two custom policies: Initial Inline Policy and Initial Passive Policy. These two intrusion policies use the Balanced Security and Connectivity intrusion policy as their base. The only difference between them is their Drop When Inline setting, which enables drop behavior in the inline policy and disables it in the passive policy. For more information, see Comparing System-Provided with Custom Policies.
 
     [bookmark: pgfId-1586123]Connection and Intrusion Event Logging
 
     [bookmark: pgfId-1591038]When an intrusion policy invoked by an access control rule detects an intrusion, it generates an intrusion event. The system also automatically logs the end of the connection where the intrusion occurred, regardless of the logging configuration of the access control rule; see Connections Associated with Intrusions (Automatic).
 
     [bookmark: pgfId-1574902]To associate an intrusion policy with an access control rule:
 
     
 
     [bookmark: pgfId-1574907]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1574908]The Access Control Policy page appears.
 ) next to the access control policy where you want to configure intrusion inspection using access control rules. 
     
 
     [bookmark: pgfId-1574916]Step 3 Create a new rule or edit an existing rule; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1574917]The access control rule editor appears.
 
     [bookmark: pgfId-1574918]Step 4 Ensure the rule action is set to Allow, Interactive Block, or Interactive Block with reset.
 
     [bookmark: pgfId-1574919]Step 5 Select the Inspection tab.
 
     [bookmark: pgfId-1574920]The Inspection tab appears.
 
     [bookmark: pgfId-1574921]Step 6 Select a system-provided or custom Intrusion Policy, or select None to disable intrusion inspection for traffic that matches the access control rule.
 ) that appears to edit the policy; see 
     Editing Intrusion Policies. 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1574932] 
      Caution Do 
      not select 
      Experimental Policy 1 unless instructed to by a Cisco representative. Cisco uses this policy for testing. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1574933]Step 7 Optionally, change the Variable Set associated with the intrusion policy. 
 ) that appears to edit the variable set; see 
     Working with Variable Sets. 
     
 
     [bookmark: pgfId-1574941]Step 8 Click Save to save the rule.
 
     [bookmark: pgfId-1574944]Your rule is saved. You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1574946]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1543562][bookmark: 18731][bookmark: 50313]Tuning Intrusion Prevention Performance
 
    [bookmark: pgfId-1543569]License: Protection
 
    [bookmark: pgfId-1537444]Cisco provides several features for improving the performance of your system as it analyzes traffic for attempted intrusions. You configure these performance settings on a per-access-control-policy basis, and they apply to all intrusion policies invoked by that parent access control policy.
 
    [bookmark: pgfId-1540817]For more information, see:
 
     
     	 [bookmark: pgfId-1536999]Limiting Pattern Matching for Intrusions describes how you can specify the number of packets to allow in the event queue, and enable or disable inspection of packets that will be rebuilt into larger streams.
 
     	 [bookmark: pgfId-1537571]Overriding Regular Expression Limits for Intrusion Rules describes how you can override default match and recursion limits on Perl-compatible regular expressions (PCRE).
 
     	 [bookmark: pgfId-1537581]Limiting Intrusion Events Generated Per Packet describes how you can configure rule processing event queue settings.
 
     	 [bookmark: pgfId-1537595]Configuring Packet and Intrusion Rule Latency Thresholds describes how you can balance security with the need to maintain device latency at an acceptable level with packet and rule latency thresholding.
 
     	 [bookmark: pgfId-1537599]Configuring Intrusion Performance Statistic Logging describes how you can configure basic performance monitoring and reporting parameters.
 
    
 
     
      [bookmark: pgfId-1530914][bookmark: 58015]Limiting Pattern Matching for Intru[bookmark: marker-1537547]sions
 
     [bookmark: pgfId-1537462]License: Protection
 
     [bookmark: pgfId-1537463]You can specify the number of packets to allow in the event queue. You can also, before and after stream reassembly, enable or disable inspection of packets that will be rebuilt into larger streams.
 
     [bookmark: pgfId-1537465]To configure event queue settings:
 
     
 
     [bookmark: pgfId-1540138]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1540139]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1540144]The access control policy editor appears.
 
     [bookmark: pgfId-1540145]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1540146]The access control policy advanced settings page appears.
 tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1537492]Step 5 You can modify the following options:
 
      
       
       	 [bookmark: pgfId-1537494]Type a value for the maximum number of events to queue in the  Maximum Pattern States to Analyze Per Packet  field.
 
       	 [bookmark: pgfId-1537495]To inspect packets which will be rebuilt into larger streams of data before and after stream reassembly, select  Disable Content Checks on Traffic Subject to Future Reassembly . Inspection before and after reassembly requires more processing overhead and may decrease performance.
 
       	 [bookmark: pgfId-1537496]To disable inspection of packets which will be rebuilt into larger streams of data before and after stream reassembly, clear  Disable Content Checks on Traffic Subject to Future Reassembly . Disabling inspection decreases the processing overhead for inspection of stream inserts and may boost performance.
 
      
 
     
 
     [bookmark: pgfId-1540260]Step 6 Click OK.
 
     [bookmark: pgfId-1540263]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1540265]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530915][bookmark: 10526]Overriding Regular Expression Limits for Int[bookmark: marker-1539859]rusion Rules
 
     [bookmark: pgfId-1537648]License: Protection
 
     [bookmark: pgfId-1537649]You can override default match and recursion limits on PCRE that are used in intrusion rules to examine packet payload content. See Searching for Content Using PCRE for information on using the pcre keyword in intrusion rules. The default limits ensure a minimum level of performance. Overriding these limits could increase security, but could also significantly impact performance by permitting packet evaluation against inefficient regular expressions.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1537653] 
      Caution Do not override default PCRE limits unless you are an experienced intrusion rule writer with knowledge of the impact of degenerative patterns. 
       
       
 
      
 
     
 
      
       
        
        [bookmark: pgfId-1539755]Table 10-2 [bookmark: 90281]Regular Expression Constraint Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539759]Option 
          
  
         	 
           
           [bookmark: pgfId-1539761]Description 
          
  
        
 
         
         	[bookmark: pgfId-1539763]Match Limit State
  
         	[bookmark: pgfId-1539765]Specifies whether to override Match Limit. You have the following options:
 
           
           	 [bookmark: pgfId-1539766]select  Default to use the value configured for  Match Limit 
 
           	 [bookmark: pgfId-1539767]select  Unlimited to permit an unlimited number of attempts
 
           	 [bookmark: pgfId-1539768]select  Custom to specify either a limit of 1 or greater for  Match Limit , or to specify 0 to completely disable PCRE match evaluations
 
          
  
        
 
         
         	[bookmark: pgfId-1539770]Match Limit
  
         	[bookmark: pgfId-1539772]Specifies the number of times to attempt to match a pattern defined in a PCRE regular expression.
  
        
 
         
         	[bookmark: pgfId-1539774]Match Recursion Limit State
  
         	[bookmark: pgfId-1539776]Specifies whether to override Match Recursion Limit. You have the following options:
 
           
           	 [bookmark: pgfId-1539777]select  Default to use the value configured for  Match Recursion Limit 
 
           	 [bookmark: pgfId-1539778]select  Unlimited to permit an unlimited number of recursions
 
           	 [bookmark: pgfId-1539779]select  Custom to specify either a limit of 1 or greater for  Match Recursion Limit , or to specify 0 to completely disable PCRE recursions
 
          
 [bookmark: pgfId-1539780]Note that for Match Recursion Limit to be meaningful, it must be smaller than Match Limit.
  
        
 
         
         	[bookmark: pgfId-1539782]Match Recursion Limit
  
         	[bookmark: pgfId-1539784]Specifies the number of recursions when evaluating a PCRE regular expression against the packet payload. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1537696]To configure PCRE overrides:
 
     
 
     [bookmark: pgfId-1540302]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1540303]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1540308]The access control policy editor appears.
 
     [bookmark: pgfId-1540309]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1540310]The access control policy advanced settings page appears.
 , then select the Regular Expression Limits tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1537726]Step 5 You can modify any of the options in the Regular Expression Constraint Options table.
 
     [bookmark: pgfId-1540850]Step 6 Click OK.
 
     [bookmark: pgfId-1540872]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1540874]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1540877][bookmark: 86305]Limiting Intrusion Events Genera[bookmark: marker-1540876]ted Per Packet
 
     [bookmark: pgfId-1537801]License: Protection
 
     [bookmark: pgfId-1537802]When the rules engine evaluates traffic against rules, it places the events generated for a given packet or packet stream in an event queue, then reports the top events in the queue to the user interface. You can elect to have the rules engine log more than one event per packet or packet stream when multiple events are generated. Logging these events allows you to collect information beyond the reported event. When configuring this option, you can specify how many events can be placed in the queue and how many are logged, and select the criteria for determining event order within the queue.
 
      
       
        
        [bookmark: pgfId-1588412]Table 10-3 [bookmark: 55074]Intrusion Event Logging Limits Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1588416]Option 
          
  
         	 
           
           [bookmark: pgfId-1588418]Description 
          
  
        
 
         
         	[bookmark: pgfId-1588420]Maximum Events Stored Per Packet
  
         	[bookmark: pgfId-1588422]The maximum number of events that can be stored for a given packet or packet stream.
  
        
 
         
         	[bookmark: pgfId-1588424]Maximum Events Logged Per Packet
  
         	[bookmark: pgfId-1588426]The number of events logged for a given packet or packet stream. This cannot exceed the Maximum Events Stored Per Packet value.
  
        
 
         
         	[bookmark: pgfId-1588428]Prioritize Event Logging By
  
         	[bookmark: pgfId-1588430]The value used to determine event ordering within the event queue. The highest ordered event is reported through the user interface. You can select from:
 
           
           	 [bookmark: pgfId-1588431] priority , which orders events in the queue by the event priority.
 
           	 [bookmark: pgfId-1588432] content_length , which orders events by the longest identified content match. When events are ordered by content length, rule events always take precedence over decoder and preprocessor events.
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1588434]To configure how many events are logged per packet or stream:
 
     
 
     [bookmark: pgfId-1540514]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1540515]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1540520]The access control policy editor appears.
 
     [bookmark: pgfId-1540521]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1540522]The access control policy advanced settings page appears.
 tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1537858]Step 5 You can modify any of the options in the Intrusion Event Logging Limits Options table.
 
     [bookmark: pgfId-1542333]Step 6 Click OK.
 
     [bookmark: pgfId-1542336]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1537867]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530917][bookmark: 34550]Configuring Packet and Intrusion Rule Latency Thresholds
 
     [bookmark: pgfId-1539497]License: Protection
 
     [bookmark: pgfId-1538484]You can balance security with the need to maintain device latency at an acceptable level with packet and rule latency thresholding. For more information, see:
 
      
      	 [bookmark: pgfId-1539382]Understanding Packet Latency Thresholding
 
      	 [bookmark: pgfId-1539403]Configuring Packet Latency Thresholding
 
      	 [bookmark: pgfId-1539447]Understanding Rule Latency Thresholding
 
      	 [bookmark: pgfId-1539458]Configuring Rule Latency Thresholding
 
     
 
    
 
     
      [bookmark: pgfId-1537937][bookmark: 82847]Understanding Packet Latency Thres[bookmark: marker-1538516]holding
 
     [bookmark: pgfId-1537944]License: Protection
 
     [bookmark: pgfId-1537945]You can balance security with the need to maintain latency at an acceptable level by enabling packet latency thresholding. Packet latency thresholding measures the total elapsed time taken to process a packet by applicable decoders, preprocessors, and rules, and ceases inspection of the packet if the processing time exceeds a configurable threshold.
 
     [bookmark: pgfId-1537947]Packet latency thresholding measures elapsed time, not just processing time, in order to more accurately reflect the actual time required for the rule to process a packet. However, latency thresholding is a software-based latency implementation that does not enforce strict timing.
 
     [bookmark: pgfId-1537948]The trade-off for the performance and latency benefits derived from latency thresholding is that uninspected packets could contain attacks. However, packet latency thresholding gives you a tool you can use to balance security with connectivity.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1577515]As illustrated in the above figure, packet latency timing is tested at the following test points:
 
      
      	 [bookmark: pgfId-1537959]after the completion of all decoder and preprocessor processing and before rule processing begins
 
      	 [bookmark: pgfId-1537960]after processing by each rule
 
     
 
     [bookmark: pgfId-1537961]If the processing time exceeds the threshold at any test point, packet inspection ceases.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537962]Tip Total packet processing time does not include routine TCP stream or IP fragment reassembly times.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537963]Packet latency thresholding has no effect on events triggered by a decoder, preprocessor, or rule processing the packet. Any applicable decoder, preprocessor, or rule triggers normally until a packet is fully processed, or until packet processing ends because the latency threshold is exceeded, whichever comes first. If a drop rule detects an intrusion in an inline deployment, the drop rule triggers an event and the packet is dropped.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537964]Note No packets are evaluated against rules after processing for that packet ceases because of a packet latency threshold violation. A rule that would have triggered an event cannot trigger that event, and for drop rules, cannot drop the packet.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537968]For more information on drop rules, see Setting Rule States.
 
     [bookmark: pgfId-1537969]Packet latency thresholding can improve system performance in both passive and inline deployments, and can reduce latency in inline deployments, by stopping inspection of packets that require excessive processing time. These performance benefits might occur when, for example:
 
      
      	 [bookmark: pgfId-1537970]for both passive and inline deployments, sequential inspection of a packet by multiple rules requires an excessive amount of time
 
      	 [bookmark: pgfId-1537971]for inline deployments, a period of poor network performance, such as when someone downloads an extremely large file, slows packet processing
 
     
 
     [bookmark: pgfId-1537972]In a passive deployment, stopping the processing of packets might not contribute to restoring network performance because processing simply moves to the next packet.
 
    
 
     
      [bookmark: pgfId-1538062][bookmark: 57665]Configuring Packet [bookmark: marker-1538061]Latency Thresh[bookmark: marker-1538539]olding
 
     [bookmark: pgfId-1538070]License: Protection
 
      
       
        
        [bookmark: pgfId-1538760]Table 10-4 [bookmark: 59012]Packet Latency Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1538764]Option 
          
  
         	 
           
           [bookmark: pgfId-1538766]Description 
          
  
        
 
         
         	[bookmark: pgfId-1538768]Threshold (microseconds)
  
         	[bookmark: pgfId-1538770]Specifies the time, in microseconds, when inspection of a packet ceases. See the Minimum Packet Latency Threshold Settings table for recommended minimum threshold settings.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1538775]You can enable rule 134:3 to generate an event when the system stops inspecting a packet because the packet latency threshold is exceeded. See Setting Rule States for more information.
 
      
       
        
        [bookmark: pgfId-1540890]Table 10-5 [bookmark: 94345]Minimum Packet Latency Threshold Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1540894]For this data rate... 
          
  
         	 
           
           [bookmark: pgfId-1540896]Set threshold microseconds to at least... 
          
  
        
 
         
         	[bookmark: pgfId-1540898]1 Gbps
  
         	[bookmark: pgfId-1540900]100 
  
        
 
         
         	[bookmark: pgfId-1540902]100 Mbps
  
         	[bookmark: pgfId-1540904]250
  
        
 
         
         	[bookmark: pgfId-1540906]5 Mbps
  
         	[bookmark: pgfId-1540908]1000
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1538812]Determine the following when calculating your settings:
 
      
      	 [bookmark: pgfId-1538813]average packets per second
 
      	 [bookmark: pgfId-1538814]average microseconds per packet
 
     
 
     [bookmark: pgfId-1538815]Multiply the average microseconds per packet for your network by a significant safety factor to ensure that you do not unnecessarily discontinue packet inspections.
 
     [bookmark: pgfId-1538071]For example, the Minimum Packet Latency Threshold Settings table recommends a minimum packet latency threshold of 100 microseconds in a one gigabit environment. This minimum recommendation is based on test data showing an average of 250,000 packets per second, which is 0.25 packets per microsecond, or 4 microseconds per packet. Multiplying by a factor of twenty-five results in a recommended minimum threshold of 100 microseconds.
 
     [bookmark: pgfId-1540967]To configure packet latency thresholding:
 
     
 
     [bookmark: pgfId-1541055]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1541056]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1541061]The access control policy editor appears.
 
     [bookmark: pgfId-1541062]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1541063]The access control policy advanced settings page appears.
 , then select the Packet Handling tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1540997]Step 5 See the Minimum Packet Latency Threshold Settings table for recommended minimum Threshold settings.
 
     [bookmark: pgfId-1541015]Step 6 Click OK.
 
     [bookmark: pgfId-1541018]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1538109]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1538112][bookmark: 98214]Understanding Rule Lat[bookmark: marker-1538111]ency Threshold[bookmark: marker-1539030]ing
 
     [bookmark: pgfId-1538119]License: Protection
 
     [bookmark: pgfId-1538120]You can balance security with the need to maintain latency at an acceptable level by enabling rule latency thresholding. Rule latency thresholding measures the elapsed time each rule takes to process an individual packet, suspends the violating rule along with a group of related rules for a specified time if the processing time exceeds the rule latency threshold a configurable consecutive number of times, and restores the rules when the suspension expires.
 
     [bookmark: pgfId-1538122]Rule latency thresholding measures elapsed time, not just processing time, in order to more accurately reflect the actual time required for the rule to process a packet. However, latency thresholding is a software-based latency implementation that does not enforce strict timing.
 
     [bookmark: pgfId-1538123]The trade-off for the performance and latency benefits derived from latency thresholding is that uninspected packets could contain attacks. However, rule latency thresholding gives you a tool you can use to balance security with connectivity.
 
     [bookmark: pgfId-1538124]A timer measures the processing time each time a packet is processed against a group of rules. Any time the rule processing time exceeds a specified rule latency threshold, the system increments a counter. If the number of consecutive threshold violations reaches a specified number, the system takes the following actions:
 
      
      	 [bookmark: pgfId-1538125]suspends the rules for the specified period
 
      	 [bookmark: pgfId-1538126]triggers an event indicating the rules have been suspended
 
      	 [bookmark: pgfId-1538127]re-enables the rules when the suspension expires
 
      	 [bookmark: pgfId-1538128]triggers an event indicating the rules have been re-enabled
 
     
 
     [bookmark: pgfId-1538129]The system zeroes the counter when the group of rules has been suspended, or when rule violations are not consecutive. Permitting some consecutive violations before suspending rules lets you ignore occasional rule violations that might have negligible impact on performance and focus instead on the more significant impact of rules that repeatedly exceed the rule latency threshold.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1601837]In the above example, the time required to process each of the first three packets violates the rule latency threshold of 1000 microseconds, and the violations counter increments with each violation. Processing of the fourth packet does not violate the threshold, and the violations counter resets to zero. The fifth packet violates the threshold and the violations counter restarts at one.
 
     [bookmark: pgfId-1601838]The following example shows five consecutive rule processing times that do result in rule suspension.
 
     [bookmark: pgfId-1641079]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1538149]In the second example, the time required to process each of the five packets violates the rule latency threshold of 1000 microseconds. The group of rules is suspended because the rule processing time of 1100 microseconds for each packet violates the threshold of 1000 microseconds for the specified five consecutive violations. Any subsequent packets, represented in the figure as packets 6 through n, are not examined against suspended rules until the suspension expires. If more packets occur after the rules are re-enabled, the violations counter begins again at zero.
 
     [bookmark: pgfId-1538150]Rule latency thresholding has no effect on intrusion events triggered by the rules processing the packet. A rule triggers an event for any intrusion detected in the packet, regardless of whether the rule processing time exceeds the threshold. If the rule detecting the intrusion is a drop rule in an inline deployment, the packet is dropped. When a drop rule detects an intrusion in a packet that results in the rule being suspended, the drop rule triggers an intrusion event, the packet is dropped, and that rule and all related rules are suspended. For more information on drop rules, see Setting Rule States.
 
      
       
     
 
     
 
     [bookmark: pgfId-1538154]Note Packets are not evaluated against suspended rules. A suspended rule that would have triggered an event cannot trigger that event and, for drop rules, cannot drop the packet.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1538155]Rule latency thresholding can improve system performance in both passive and inline deployments, and can reduce latency in inline deployments, by suspending rules that take the most time to process packets. Packets are not evaluated again against suspended rules until a configurable time expires, giving the overloaded device time to recover. These performance benefits might occur when, for example:
 
      
      	 [bookmark: pgfId-1538156]hastily written, largely untested rules require an excessive amount of processing time
 
      	 [bookmark: pgfId-1538157]a period of poor network performance, such as when someone downloads an extremely large file, causes slow packet inspection
 
     
 
    
 
     
      [bookmark: pgfId-1538251][bookmark: 38502]Configuring Rule Latency Thres[bookmark: marker-1538250]holding
 
     [bookmark: pgfId-1538259]License: Protection
 
     [bookmark: pgfId-1538260]You can modify the rule latency threshold, the suspension time for suspended rules, and the number of consecutive threshold violations that must occur before suspending rules.
 
     [bookmark: pgfId-1539151]Rule latency thresholding suspends rules for the time specified by Suspension Time when the time rules take to process a packet exceeds Threshold for the consecutive number of times specified by Consecutive Threshold Violations Before Suspending Rule. 
 
     [bookmark: pgfId-1539152]You can enable rule 134:1 to generate an event when rules are suspended, and rule 134:2 to generate an event when suspended rules are enabled. See Setting Rule States for more information.
 
     [bookmark: pgfId-1539159]The following table further describes the options you can set to configure rule latency thresholding.
 
     [bookmark: pgfId-1539188]
 
      
       
        
        [bookmark: pgfId-1539166]Table 10-6 [bookmark: 71567]Rule Latency Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539170]Option 
          
  
         	 
           
           [bookmark: pgfId-1539172]Description 
          
  
        
 
         
         	[bookmark: pgfId-1539174]Threshold
  
         	[bookmark: pgfId-1539176]Specifies the time in microseconds that rules should not exceed when examining a packet. See the Minimum Rule Latency Threshold Settings table for recommended minimum threshold settings.
  
        
 
         
         	[bookmark: pgfId-1539181]Consecutive Threshold Violations Before Suspending Rule
  
         	[bookmark: pgfId-1539183]Specifies the consecutive number of times rules can take longer than the time set for Threshold to inspect packets before rules are suspended.
  
        
 
         
         	[bookmark: pgfId-1539185]Suspension Time
  
         	[bookmark: pgfId-1539187]Specifies the number of seconds to suspend a group of rules.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1539189]Many factors affect measurements of system performance, such as CPU speed, data rate, packet size, and protocol type. For this reason, Cisco recommends that you use the threshold settings in the following table until your own calculations provide you with settings tailored to your network environment.
 
     [bookmark: pgfId-1539218]
 
      
       
        
        [bookmark: pgfId-1539199]Table 10-7 [bookmark: 54086]Minimum Rule Latency Threshold Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539203]For this data rate... 
          
  
         	 
           
           [bookmark: pgfId-1539205]Set threshold microseconds to at least... 
          
  
        
 
         
         	[bookmark: pgfId-1539207]1 Gbps
  
         	[bookmark: pgfId-1539209]500
  
        
 
         
         	[bookmark: pgfId-1539211]100 Mbps
  
         	[bookmark: pgfId-1539213]1250
  
        
 
         
         	[bookmark: pgfId-1539215]5 Mbps
  
         	[bookmark: pgfId-1539217]5000
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1539219]Determine the following when calculating your settings:
 
      
      	 [bookmark: pgfId-1539220]average packets per second
 
      	 [bookmark: pgfId-1539221]average microseconds per packet
 
     
 
     [bookmark: pgfId-1539222]Multiply the average microseconds per packet for your network by a significant safety factor to ensure that you do not unnecessarily suspend rules.
 
     [bookmark: pgfId-1538261]To configure rule latency thresholding:
 
     
 
     [bookmark: pgfId-1541117]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1541118]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1541123]The access control policy editor appears.
 
     [bookmark: pgfId-1541124]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1541125]The access control policy advanced settings page appears.
 , then select the Rule Handling tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1538290]Step 5 You can configure any of the options in the Rule Latency Thresholding Options table. 
 
     [bookmark: pgfId-1593730]See the Minimum Rule Latency Threshold Settings table for recommended minimum Threshold settings.
 
     [bookmark: pgfId-1541033]Step 6 Click OK.
 
     [bookmark: pgfId-1541036]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1538297]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530918][bookmark: 27608]Configuring Intrusion Performance Statistic Log[bookmark: marker-1535455]ging
 
     [bookmark: pgfId-1535356]License: Protection
 
     [bookmark: pgfId-1535357]You can configure the basic parameters of how devices monitor and report their own performance. This allows you to specify the intervals at which the system updates performance statistics on your devices by configuring the following options.
 
     [bookmark: pgfId-1535585]Sample time (seconds) and Minimum number of packets
 
     [bookmark: pgfId-1536259]When the number of seconds specified elapses between performance statistics updates, the system verifies it has analyzed the specified number of packets. If it has, the system updates performance statistics. Otherwise, the system waits until it analyzes the specified number of packets.
 
     [bookmark: pgfId-1535679]Troubleshooting Options: Log Session/Protocol Distribution
 
     [bookmark: pgfId-1536452]Support might ask you during a troubleshooting call to log protocol distribution, packet length, and port statistics.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1536411] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1535756]Troubleshooting Options: Summary
 
     [bookmark: pgfId-1536484]Support might ask you during a troubleshooting call to configure the system to calculate the performance statistics only when the Snort process is shut down or restarted. To enable this option, you must also enable the Log Session/Protocol Distribution troubleshooting option.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1536393] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1535362]To configure basic performance statistics parameters:
 
     
 
     [bookmark: pgfId-1535485]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
     [bookmark: pgfId-1535486]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1535491]The access control policy editor appears.
 
     [bookmark: pgfId-1535492]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1535493]The access control policy advanced settings page appears.
 , then select the Performance Statistics tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1535388]Step 5 Modify the Sample time or Minimum number of packets as described above.
 
     [bookmark: pgfId-1535391]Step 6 Optionally, expand the Troubleshoot Options section and modify those options only if asked to do so by Support.
 
     [bookmark: pgfId-1535548]Step 7 Click OK.
 
     [bookmark: pgfId-1535794]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1535400]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1530432][bookmark: 78959]Tuning File and Malware Inspection Performance and Stor[bookmark: marker-1531618]age
 
    [bookmark: pgfId-1612519]License: Protection or Malware
 
    [bookmark: pgfId-1612522]If you use file policies to perform file control or malware detection or blocking, you can set the options listed in the following table. Keep in mind that increasing the file sizes can affect the performance of the system.
 
    [bookmark: pgfId-1531547]
 
     
      
       
       [bookmark: pgfId-1531442]Table 10-8 [bookmark: 41569]Advanced Access Control File and Malware Detection Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-1531452]Field 
         
  
        	 
          
          [bookmark: pgfId-1531454]Description 
         
  
        	 
          
          [bookmark: pgfId-1531456]Default Value 
         
  
        	 
          
          [bookmark: pgfId-1531458]Range 
         
  
        	 
          
          [bookmark: pgfId-1531460]Notes 
         
  
       
 
        
        	[bookmark: pgfId-1531462]Limit the number of bytes inspected when doing file type detection
  
        	[bookmark: pgfId-1531464]Specify the number of bytes inspected when performing file type detection.
  
        	[bookmark: pgfId-1531466]1460 bytes, or the maximum segment size of a TCP packet
  
        	[bookmark: pgfId-1531468]0 - 4294967295 (4GB)
  
        	[bookmark: pgfId-1531470]Set to 0 to remove the restriction.
 [bookmark: pgfId-1531471]In most cases, the system can identify common file types using the first packet.
  
       
 
        
        	[bookmark: pgfId-1531473]Do not calculate SHA-256 hash values for files larger than (in bytes)
  
        	[bookmark: pgfId-1531475]Prevent the system from storing files larger than a certain size, performing a Collective Security Intelligence Cloud lookup on the files, or blocking the files if added to the custom detection list.
  
        	[bookmark: pgfId-1531480]10485760 (10MB)
  
        	[bookmark: pgfId-1531482]0 - 4294967295 (4GB)
  
        	[bookmark: pgfId-1592691]Set to 0 to remove the restriction.
  
        	[bookmark: pgfId-1592774]Specify how long the system will hold the last byte of a file that matches a Block Malware rule and that does not have a cached disposition, while malware cloud lookup occurs. If the time elapses without the system obtaining a disposition, the file passes. Dispositions of Unavailable are not cached.
  
        	[bookmark: pgfId-1531491]2 seconds
  
        	[bookmark: pgfId-1531493]0 - 30 seconds
  
        	[bookmark: pgfId-1531496]Although this option accepts values of up to 30 seconds, Cisco recommends that you use the default value to avoid blocking traffic because of connection failures. Do not set this option to 0 without contacting Support.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1621389]To configure file and malware inspection performance and storage:
 
    
 
    [bookmark: pgfId-1621391]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control.
 
    [bookmark: pgfId-1621392]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1541530]The access control policy editor appears.
 
    [bookmark: pgfId-1541531]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1541532]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1541962]The Files and Malware Settings pop-up window appears.
 
    [bookmark: pgfId-1541540]Step 5 You can set any of the options in the Advanced Access Control File and Malware Detection Options table.
 
    [bookmark: pgfId-1541543]Step 6 Click OK.
 
    [bookmark: pgfId-1541546]You must save and apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-1541548]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 54587]Intelligent Application Bypass (IAB) 
      
      
 
     
 
 
    [bookmark: pgfId-1555895]The following topics describe how to configure access control polices to use Intelligent Application Bypass: 
 
     
     	 [bookmark: pgfId-1849322]Introduction to IAB
 
     	 [bookmark: pgfId-1849353]IAB Options
 
     	 [bookmark: pgfId-1849384]Configuring IAB
 
     	 [bookmark: pgfId-1855989]IAB Logging and Analysis
 
    
 
   
 
    
     [bookmark: pgfId-1849413][bookmark: 35684]Introduction to IAB
 
    [bookmark: pgfId-1850963]Intelligent Application Bypass (IAB) identifies applications that you trust to traverse your network without further inspection if performance and flow thresholds are exceeded. For example, if a nightly backup significantly impacts system performance, you can configure thresholds that, if exceeded, trust traffic generated by your backup application. Optionally, you can configure IAB so that, when an inspection performance threshold is exceeded, IAB trusts all traffic that exceeds any flow bypass threshold, regardless of the application type; this option requires a Version 6.0.1.4 or subsequent 6.0.1.x patch.
 
    [bookmark: pgfId-1850964]The system implements IAB on traffic allowed by access control rules or the access control policy's default action, before the traffic is subject to deep inspection. A test mode allows you to determine whether thresholds are exceeded and, if so, to identify the application flows that would have been bypassed if you had actually enabled IAB (called bypass mode). 
 
    [bookmark: pgfId-1849954] The following graphic illustrates the IAB decision-making process: 
 
    [bookmark: pgfId-1856889]
 
     
     [image: ] 
    
 
   
 
    
     [bookmark: pgfId-1850609][bookmark: 99909]IAB Options
 
    [bookmark: pgfId-1850841]State
 
    [bookmark: pgfId-1850842]Enables or disables IAB. 
 
    [bookmark: pgfId-1850843]Performance Sample Interval 
 
    [bookmark: pgfId-1850844]Specifies the time in seconds between IAB performance sampling scans, during which the system collects system performance metrics for comparison to IAB performance thresholds. A value of 0 disables IAB. 
 
    [bookmark: pgfId-1850845]Bypassable Applications and Filters 
 
    [bookmark: pgfId-1853746]This feature provides two mutually exclusive options:
 
    [bookmark: pgfId-1853788]Applications/Filters
 
    [bookmark: pgfId-1853869]Provides an editor where you can specify bypassable applications and sets of applications (filters) in essentially the same ways you specify application conditions in access control rules. See Controlling Application Traffic for more information.
 
    [bookmark: pgfId-1853795]All applications including unidentified application
 
    [bookmark: pgfId-1853908]When an inspection performance threshold is exceeded, trusts all traffic that exceeds any flow bypass threshold, regardless of the application type. This option requires a Version 6.0.1.4 or subsequent 6.0.1.x patch.
 
    [bookmark: pgfId-1853768]Inspection Performance Thresholds 
 
    [bookmark: pgfId-1850852]Inspection performance thresholds provide intrusion inspection performance limits that, if exceeded, trigger inspection of flow thresholds. IAB does not use inspection performance thresholds set to 0. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1850853]Note Inspection performance and flow bypass thresholds are disabled by default. You must enable at least one of each, and one of each must be exceeded for IAB to trust traffic. If you enable more than one inspection performance or flow bypass threshold, only one of each must be exceeded for IAB to trust traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1850854]Drop Percentage 
 
    [bookmark: pgfId-1850855]Average packets dropped as a percentage of total packets, when packets are dropped because of performance overloads caused by expensive intrusion rules, file policies, decompression, and so on. This does not refer to packets dropped by normal configurations such as intrusion rules. Note that specifying an integer greater than 1 activates IAB when the specified percentage of packets is dropped. When you specify 1, any percentage from 0 through 1 activates IAB. This allows a small number of packets to activate IAB. 
 
    [bookmark: pgfId-1850856]Processor Utilization Percentage 
 
    [bookmark: pgfId-1850857] Average percentage of processor resources used. 
 
    [bookmark: pgfId-1850858]Package Latency 
 
    [bookmark: pgfId-1850859]Average packet latency in microseconds. 
 
    [bookmark: pgfId-1850860]Flow Rate 
 
    [bookmark: pgfId-1850861]The rate at which the system processes flows, measured as the number of flows per second. Note that this option configures IAB to measure flow rate, not flow count.
 
    [bookmark: pgfId-1850862]Flow Bypass Thresholds 
 
    [bookmark: pgfId-1850863]Flow bypass thresholds provide flow limits that, if exceeded, trigger IAB to trust bypassable application traffic in bypass mode or allow application traffic subject to further inspection in test mode. IAB does not use flow bypass thresholds set to 0.
 
     
      
    
 
    
 
    [bookmark: pgfId-1850864]Note Inspection performance and flow bypass thresholds are disabled by default. You must enable at least one of each, and one of each must be exceeded for IAB to trust traffic. If you enable more than one inspection performance or flow bypass threshold, only one of each must be exceeded for IAB to trust traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1850865]Bytes per Flow
 
    [bookmark: pgfId-1850866]The maximum number of kilobytes a flow can include. 
 
    [bookmark: pgfId-1850867]Packets per Flow
 
    [bookmark: pgfId-1850868]The maximum number of packets a flow can include. 
 
    [bookmark: pgfId-1850869]Flow Duration
 
    [bookmark: pgfId-1850870]The maximum number of seconds a flow can remain open. 
 
    [bookmark: pgfId-1850871]Flow Velocity
 
    [bookmark: pgfId-1848983]The maximum transfer rate in kilobytes per second. 
 
   
 
    
     [bookmark: pgfId-1849001][bookmark: 23800]Configuring IAB
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1851212] 
     Caution Not all deployments require IAB, and those that do might use it in a limited fashion. Do not enable IAB unless you have expert knowledge of your network traffic, especially application traffic, and system performance, including the causes of predictable performance issues. Before you run IAB in bypass mode, make sure that trusting the specified traffic does not expose you to risk. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1855835]To identify applications that you trust to traverse your network when thresholds are exceeded:
 
    
 . 
    
 ) appears instead, settings are inherited from an ancestor policy, or you do not have permission to modify the settings. If the configuration is unlocked, uncheck Inherit from base policy to enable editing. 
    
 
    [bookmark: pgfId-1851215]Step 2 Configure IAB options: 
 
     
      
      	 [bookmark: pgfId-1851216]State—Turn IAB  Off or  On , or enable IAB in  Test mode.
 
      	 [bookmark: pgfId-1854306]Performance Sample Interval—Enter the time in seconds between IAB performance-sampling scans. If you enable IAB, even in test mode, enter a non-zero value. Entering 0 disables IAB.
 
      	 [bookmark: pgfId-1854295]Bypassable Applications and Filters—Choose from:
 
     
 
    
 
    [bookmark: pgfId-1851217] – Click the number of bypassed applications and filters and specify the applications whose traffic you want to bypass; specify in essentially the same ways you specify application conditions in access control rules. See Controlling Application Traffic for more information.
 
    [bookmark: pgfId-1851218] – Click All applications including unidentified applications so that, when an inspection performance threshold is exceeded, IAB trusts all traffic that exceeds any flow bypass threshold, regardless of the application type. This option requires a Version 6.0.1.4 or subsequent 6.0.1.x patch.
 
     
      
      	 [bookmark: pgfId-1851219]Inspection Performance Thresholds—Click  Configure and enter at least one threshold value. 
 
      	 [bookmark: pgfId-1854381]Flow Bypass Thresholds—Click  Configure and enter at least one threshold value.
 
     
 
    
 
    [bookmark: pgfId-1851220]You must specify at least one inspection performance threshold and one flow bypass threshold; both must be exceeded for IAB to trust traffic. If you enter more than one threshold of each type, only one of each type must be exceeded. For detailed information, see IAB Options. 
 
    [bookmark: pgfId-1851221]Step 3 Click OK to save IAB settings. 
 
    [bookmark: pgfId-1854536]Step 4 Click Save to save the policy. 
 
    [bookmark: pgfId-1854554]What to Do Next
 
     
     	 [bookmark: pgfId-1854558]Deploy configuration changes; see Deploying Configuration Changes.
 
    
 
    [bookmark: pgfId-1855802]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1851697][bookmark: 45849]IAB Logging and Analysis
 
    [bookmark: pgfId-1851904]IAB forces an end-of-connection event that logs bypassed flows and flows that would have been bypassed, regardless of whether you have enabled connection logging. Connection events indicate flows that are bypassed in bypass mode or that would have been bypassed in test mode. Custom dashboard widgets and reports based on connection events can display long-term statistics for bypassed and would-have-bypassed flows. 
 
    [bookmark: pgfId-1851905]IAB Connection Events
 
    [bookmark: pgfId-1851906]Action 
 
    [bookmark: pgfId-1851907]When Reason includes Intelligent App Bypass: 
 
    [bookmark: pgfId-1854651]Allow—indicates that the applied IAB configuration was in test mode and traffic for the application specified by Application Protocol remains available for inspection.
 
    [bookmark: pgfId-1854653]Trust - indicates that the applied IAB configuration was in bypass mode and traffic for the application specified by Application Protocol has been trusted to traverse the network without further inspection. 
 
    [bookmark: pgfId-1851912]Reason 
 
    [bookmark: pgfId-1851913] Intelligent App Bypass indicates that IAB triggered the event in bypass or test mode. 
 
    [bookmark: pgfId-1851914]Application Protocol 
 
    [bookmark: pgfId-1851915]This field displays the application protocol that triggered the event. 
 
    [bookmark: pgfId-1852169]Example
 
    [bookmark: pgfId-1852170]In the following truncated graphic, some fields are omitted. The graphic shows the Action, Reason, and Application Protocol fields for two connection events resulting from different IAB settings in two separate access control policies. 
 
    [bookmark: pgfId-1851918] For the first event, the Trust action indicates that IAB was enabled in bypass mode and Bonjour protocol traffic was trusted to pass without further inspection. 
 
    [bookmark: pgfId-1851919]For the second event, the Allow action indicates that IAB was enabled in test mode, so Ubuntu Update Manager traffic was subject to further inspection but would have been bypassed if IAB had been in bypass mode. 
 
    [bookmark: pgfId-1856897]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1852165]Example
 
    [bookmark: pgfId-1852166]In the following truncated graphic, some fields are omitted. The flow in the second event was both bypassed (Action: Trust; Reason: Intelligent App Bypass) and inspected by an intrusion rule (Reason: Intrusion Monitor). The Intrusion Monitor reason indicates that an intrusion rule set to Generate Events detected but did not block an exploit during the connection. In the example, this happened before the application was detected. After the application was detected, IAB recognized the application as bypassable and trusted the flow. 
 
    [bookmark: pgfId-1856905]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1856459]IAB Custom Dashboard Widgets
 
    [bookmark: pgfId-1851925]You can create a Custom Analysis dashboard widget to display long-term IAB statistics based on connection events. Specify the following when creating the widget: 
 
     
     	 [bookmark: pgfId-1851926] Preset :  None 
 
     	 [bookmark: pgfId-1851927] Table :  Application Statistics 
 
     	 [bookmark: pgfId-1851928] Field :  any 
 
     	 [bookmark: pgfId-1851929] Aggregate : either of: 
 
    
 
    [bookmark: pgfId-1851930] – IAB Bypassed Connections 
 
    [bookmark: pgfId-1851931] – IAB Would Bypass Connections 
 
     
     	 [bookmark: pgfId-1851932]Filter:  any 
 
    
 
    [bookmark: pgfId-1851933]Examples
 
    [bookmark: pgfId-1851934]In the following Custom Analysis dashboard widget examples: 
 
     
     	 [bookmark: pgfId-1851935]The  Bypassed example shows statistics for application traffic bypassed because the applications were specified as bypassable and IAB was enabled in bypass mode in the deployed access control policy. 
 
     	 [bookmark: pgfId-1851936]The  Would Have Bypassed example shows statistics for application traffic that would have been bypassed because the applications were specified as bypassable and IAB was enabled in test mode in the deployed access control policy.
 
    
 
    [bookmark: pgfId-1852426]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1851938]IAB Custom Reports
 
    [bookmark: pgfId-1851939]You can create a custom report to display long-term IAB statistics based on connection events. Specify the following when creating the report: 
 
     
     	 [bookmark: pgfId-1851940] Table :  Application Statistics 
 
     	 [bookmark: pgfId-1851941] Preset :  None 
 
     	 [bookmark: pgfId-1851942] Filter :  any 
 
     	 [bookmark: pgfId-1851943] X-Axis :  any 
 
     	 [bookmark: pgfId-1851944] Y-Axis : either of: 
 
    
 
    [bookmark: pgfId-1851945] – IAB Bypassed Connections 
 
    [bookmark: pgfId-1851946] – IAB Would Bypass Connections 
 
    [bookmark: pgfId-1851947]Examples
 
    [bookmark: pgfId-1851948]The following graphic shows two abbreviated report examples: 
 
     
     	 [bookmark: pgfId-1851949]The  Bypassed  example shows statistics for application traffic bypassed because the applications were specified as bypassable and IAB was enabled in bypass mode in the deployed access control policy. The  Would Have Bypassed example shows statistics for application traffic that would have been bypassed because the applications were specified as bypassable and IAB was enabled in test mode in the deployed access control policy. 
 
    
 
    [bookmark: pgfId-1855238]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1164863]
 
    [bookmark: pgfId-1857167]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3626974][bookmark: 53624]Understanding Traffic Decryption 
      
      
 
     
 
 
    [bookmark: pgfId-3638456]By default, the ASA FirePOWER module cannot inspect traffic encrypted with the Secure Socket Layer (SSL) or Transport Layer Security (TLS) protocols. As part of access control, the SSL inspection[bookmark: marker-3638457] feature allows you to either block encrypted traffic without inspecting it, or inspect encrypted or decrypted traffic with access control. As the module handles encrypted sessions, it logs details about the traffic. The combination of inspecting encrypted traffic and analyzing encrypted session data allows greater awareness and control of the encrypted applications and traffic in your network.
 
    [bookmark: pgfId-3583114]If the module detects an SSL or TLS handshake over a TCP connection, it determines whether it can decrypt the detected traffic. If it cannot, it applies a configured action:
 
     
     	 [bookmark: pgfId-3585603]block the encrypted traffic, and optionally reset the TCP connection
 
     	 [bookmark: pgfId-3585604]not decrypt the encrypted traffic 
 
    
 
    [bookmark: pgfId-3635490]Note that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection. However, some access control rule conditions require unencrypted traffic, so encrypted traffic may match fewer rules. Also, by default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured. For more information, see Creating and Editing Access Control Rules and Using the SSL Preprocessor.
 
    [bookmark: pgfId-3635226]If the module can decrypt the traffic, it blocks the traffic without further inspection, evaluates undecrypted traffic with access control, or decrypts it using one of the following methods:
 
     
     	 [bookmark: pgfId-3585434]Decrypt with a known private key. When an external host initiates an SSL handshake with a server on your network, the system matches the exchanged server certificate with a server certificate previously uploaded to the appliance. It then uses the uploaded private key to decrypt the traffic.
 
     	 [bookmark: pgfId-3633154]Decrypt by re-signing the server certificate. When a host on your network initiates an SSL handshake with an external server, the system re-signs the exchanged server certificate with a previously uploaded certificate authority (CA) certificate. It then uses the uploaded private key to decrypt the traffic.
 
    
 
    [bookmark: pgfId-3633155]Decrypted traffic is subject to the same traffic handling and analysis as originally unencrypted traffic: network, reputation, and user-based access control; intrusion detection and prevention; and advanced malware protection. If the system does not block the decrypted traffic post-analysis, it reencrypts the traffic before passing it to the destination host.
 
     
      
    
 
    
 
    [bookmark: pgfId-3641580]Note Certain SSL inspection actions, such as blocking traffic and decrypting outgoing traffic, modify the flow of traffic. ASA FirePOWER modules deployed inline can perform these actions. ASA FirePOWER modules deployed passively cannot affect the flow of traffic. However, these devices can still decrypt incoming traffic; see Example: Decrypting Traffic in a Passive Deployment for more information. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3486290]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3605846]SSL Inspection Requirements
 
     	 [bookmark: pgfId-3605713]Analyzing SSL Inspection Appliance Deployments
 
    
 
   
 
    
     [bookmark: pgfId-3605721][bookmark: 51678]SSL Inspection Requirements
 
    [bookmark: pgfId-3606901]License: feature dependent
 
    [bookmark: pgfId-3606902]How you deploy devices on your network, in addition to your configuration settings and licenses, influences the actions you can take to control and decrypt encrypted traffic.
 
    [bookmark: pgfId-3608506]SSL inspection requires public key certificates and paired private keys for certain features. You must upload certificates and paired private keys to the ASA FirePOWER module to decrypt and control traffic based on encryption session characteristics.
 
    [bookmark: pgfId-3607130]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3607155]Deploying ASA FirePOWER Modules that Support SSL Inspection
 
     	 [bookmark: pgfId-3607159]License Requirements for SSL Inspection
 
     	 [bookmark: pgfId-3607680]Collecting Prerequisite Information to Configure SSL Rules
 
    
 
     
      [bookmark: pgfId-3606904][bookmark: 30081]Deploying ASA FirePOWER Modules that Support SSL Inspection
 
     [bookmark: pgfId-3621292]License: Any
 
     [bookmark: pgfId-3606242]ASA FirePOWER modules configured and deployed inline can modify the flow of traffic. These devices can monitor, block, allow, and decrypt incoming and outgoing traffic.
 
     [bookmark: pgfId-3621332]ASA FirePOWER modules configured and deployed passively cannot affect the flow of traffic. They can only monitor, allow, and decrypt incoming traffic. Note that passive deployments do not support decrypting traffic encrypted with the ephemeral Diffie-Hellman (DHE) or the elliptic curve Diffie-Hellman (ECDHE) cipher suites. 
 
     [bookmark: pgfId-3621525]Review your list of mapped actions, existing network deployment, and overall requirements to determine whether one or the other type of deployment better suits your organization. See Analyzing SSL Inspection Appliance Deployments for more information.
 
    
 
     
      [bookmark: pgfId-3606273][bookmark: 73176]License Requirements for SSL Inspection
 
     [bookmark: pgfId-3606274]License: feature dependent
 ) and confirmation dialog boxes to designate unsupported features for your deployment. For details, hover your pointer over a warning icon. 
     
 
     [bookmark: pgfId-3606289]You apply an SSL policy as part of an access control policy, and the access control policy inspects traffic decrypted by the SSL policy. See Access Control License and Role Requirements for more information on access control licensing.
 
     [bookmark: pgfId-3606294]Th[bookmark: marker-3606293]e following table explains the license requirements to apply an SSL policy as part of an access control policy. 
 
     [bookmark: pgfId-3606321]
 
      
       
        
        [bookmark: pgfId-3641737]Table 12-1 License Requirements for SSL Inspection 
 
        
        
         
         	 
           
           [bookmark: pgfId-3641741]To apply an SSL policy that... 
          
  
         	 
           
           [bookmark: pgfId-3641743]Licenses 
          
  
        
 
         
         	[bookmark: pgfId-3641745]handles encrypted traffic on the basis of zone, network, port, or SSL-related criteria
  
         	[bookmark: pgfId-3641747]Any
  
        
 
         
         	[bookmark: pgfId-3641749]handles encrypted traffic using geolocation data
  
         	[bookmark: pgfId-3641754]Any
  
        
 
         
         	[bookmark: pgfId-3641756]handles encrypted traffic using application or user criteria
  
         	[bookmark: pgfId-3641758]Control
  
        
 
         
         	[bookmark: pgfId-3641760]filters encrypted traffic using URL category and reputation data
  
         	[bookmark: pgfId-3641765]URL Filtering
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3521890][bookmark: 10856][bookmark: 91519]Collecting Prerequisite Information to Configure SSL Rules
 
     [bookmark: pgfId-3565582]License: feature-dependent
 
      
       
        
        [bookmark: pgfId-3559215]Table 12-2 [bookmark: 70715]SSL Rule Condition Prerequisites 
 
        
        
         
         	 
           
           [bookmark: pgfId-3559219]To match on... 
          
  
         	 
           
           [bookmark: pgfId-3559221]Collect the... 
          
  
        
 
         
         	[bookmark: pgfId-3559263]detected server certificates, including self-signed server certificates
  
         	[bookmark: pgfId-3559265]server certificate
  
        
 
         
         	[bookmark: pgfId-3587020]trusted server certificates
  
         	[bookmark: pgfId-3587022]CA certificate
  
        
 
         
         	[bookmark: pgfId-3559271]detected server certificate subject or issuer
  
         	[bookmark: pgfId-3559273]server certificate subject DN or issuer DN
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3522812]For more information, see Tuning Traffic Decryption Using SSL Rules.
 
      
       
        
        [bookmark: pgfId-3561258]Table 12-3 [bookmark: 11996]SSL Decryption Prerequisites 
 
        
        
         
         	 
           
           [bookmark: pgfId-3561262]To decrypt... 
          
  
         	 
           
           [bookmark: pgfId-3561264]Collect... 
          
  
        
 
         
         	[bookmark: pgfId-3561266]incoming traffic to a server you control
  
         	[bookmark: pgfId-3561268]the server’s certificate file and paired private key file
  
        
 
         
         	[bookmark: pgfId-3561270]outgoing traffic to an external server
  
         	[bookmark: pgfId-3561272]a CA certificate file and paired private key file
 [bookmark: pgfId-3561273]You can also generate a CA certificate and private key.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3561278]For more information, see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection.
 
     [bookmark: pgfId-3607332]After you have collected this information, upload it to the system and configure reusable objects. See Managing Reusable Objects for more information. 
 
    
 
   
 
    
     [bookmark: pgfId-3522940][bookmark: 12223]Analyzing SSL Inspection Appliance Deployments
 
    [bookmark: pgfId-3630517]License: feature-dependent
 
    [bookmark: pgfId-3515223]This section presents several scenarios in which the Life Insurance Example, Inc. life insurance company (LifeIns) uses SSL inspection on encrypted traffic to help audit their processes. Based on their business processes, LifeIns plans to deploy:
 
     
     	 [bookmark: pgfId-3621603]one ASA FirePOWER device in a passive deployment for the Customer Service department
 
     	 [bookmark: pgfId-3621649]one ASA FirePOWER device in an inline deployment for the Underwriting Department
 
    
 
    [bookmark: pgfId-3504986]Customer Service Business Processes
 
    [bookmark: pgfId-3515440]LifeIns created a customer-facing website for their customers. LifeIns receives encrypted questions and requests regarding policies from prospective customers through their website and through e-mail. LifeIns’s Customer Service department processes them and returns the requested information within 24 hours. Customer Service wants to expand its incoming contact metrics collection. LifeIns has an established internal audit review for Customer Service. 
 
    [bookmark: pgfId-3504957]LifeIns also receives encrypted applications online. The Customer Service department processes the applications within 24 hours before sending the case file to the Underwriting department. Customer Service filters out any obvious false applications sent through the online form, which consumes a fair portion of their time.
 
    [bookmark: pgfId-3515489]Underwriting Business Processes
 
    [bookmark: pgfId-3434579]LifeIns’s underwriters submit encrypted medical information requests online to the Medical Repository Example, LLC medical data repository (MedRepo). MedRepo reviews the requests and transmits the encrypted records to LifeIns within 72 hours. The underwriters subsequently underwrite an application and submit policy and rate decisions. Underwriting wants to expand its metrics collection.
 
    [bookmark: pgfId-3507669]Lately, an unknown source has been sending spoofed responses to LifeIns. Though LifeIns’s underwriters receive training on proper Internet use, LifeIns’s IT department first wants to analyze all encrypted traffic that takes the form of medical responses, then wants to block all spoof attempts.
 
    [bookmark: pgfId-3434833]LifeIns places junior underwriters on six-month training periods. Lately, these underwriters have been incorrectly submitting encrypted medical regulation requests to MedRepo’s customer service department. MedRepo has submitted multiple complaints to LifeIns in response. LifeIns plans on extending their new underwriter training period to also audit underwriter requests to MedRepo.
 
    [bookmark: pgfId-3432075]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3432090]Example: Decrypting Traffic in a Passive Deployment
 
     	 [bookmark: pgfId-3432083]Example: Decrypting Traffic in an Inline Deployment
 
    
 
     
      [bookmark: pgfId-3427117][bookmark: 97158]Example: Decrypting Traffic in a Passive [bookmark: marker-3577850]Deployment
 
     [bookmark: pgfId-3622715]License: feature-dependent
 
     [bookmark: pgfId-3427119]LifeIns’s business requirements state that Customer Service must:
 
      
      	 [bookmark: pgfId-3427120]process all requests and applications within 24 hours
 
      	 [bookmark: pgfId-3505951]improve its incoming contact metrics collection process
 
      	 [bookmark: pgfId-3528908]identify and discard incoming false applications
 
     
 
     [bookmark: pgfId-3427121]Customer Service does not require additional audit review.
 
     [bookmark: pgfId-3645226]LifeIns plans to passively deploy a Customer Service device.
 
     [bookmark: pgfId-3590850]Traffic from an external network goes to LifeIns’s router. The router routes traffic to the Customer Service department, and mirrors a copy of the traffic to the ASA FirePOWER module for inspection. 
 
     [bookmark: pgfId-3508496]On the ASA FirePOWER module, a user in the Access Control and SSL Editor custom role configures SSL inspection to:
 
      
      	 [bookmark: pgfId-3591071]log all encrypted traffic sent to the Customer Service department
 
      	 [bookmark: pgfId-3591178]decrypt encrypted traffic sent using the online application form to Customer Service
 
      	 [bookmark: pgfId-3591305]not decrypt all other encrypted traffic sent to Customer service, including traffic sent using the online request form
 
     
 
     [bookmark: pgfId-3530350]The user also configures access control to inspect the decrypted application form traffic for fake application data and log when fake data is detected.
 
     [bookmark: pgfId-3576184]In the following scenarios, the user submits an online form to Customer Service. The user’s browser establishes a TCP connection with the server, then initiates an SSL handshake. The ASA FirePOWER module receives a copy of this traffic. The client and server complete the SSL handshake, establishing the encrypted session. Based on handshake and connection details, the system logs the connection and acts upon the copy of the encrypted traffic.
 
     [bookmark: pgfId-3529472]For more information, see the following:
 
      
      	 [bookmark: pgfId-3529476]Monitoring Encrypted Traffic in a Passive Deployment
 
      	 [bookmark: pgfId-3529487]Not Decrypting Encrypted Traffic in a Passive Deployment
 
      	 [bookmark: pgfId-3528182]Inspecting Encrypted Traffic with a Private Key in a Passive Deployment
 
     
 
    
 
     
      [bookmark: pgfId-3529262][bookmark: 69054]Monitoring Encrypted Traffic in a Passive Deployment
 
     [bookmark: pgfId-3622769]License: Any
 
     [bookmark: pgfId-3662052]For all SSL-encrypted traffic sent to Customer Service, the system logs the connection.
 
     [bookmark: pgfId-3529348]The following steps occur:
 
     [bookmark: pgfId-3529349] 1. The user submits the plain text request (info). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3529350] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the ASA FirePOWER module.
 
     [bookmark: pgfId-3529351] 3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (info).
 
     [bookmark: pgfId-3529352] 4. The module does not decrypt the traffic.
 
     [bookmark: pgfId-3641939]The access control policy continues to process the encrypted traffic and allows it. The module generates a connection event after the session ends.
 
     [bookmark: pgfId-3653078] 5. The ASA FirePOWER module receives the connection event.
 
    
 
     
      [bookmark: pgfId-3641945][bookmark: 71179]Not Decrypting Encrypted Traffic in a Passive Deployment
 
     [bookmark: pgfId-3641949]License: Any
 
     [bookmark: pgfId-3514289]For all SSL-encrypted traffic that contains requests about policies, the system allows the traffic without decrypting it and logs the connection.
 
     [bookmark: pgfId-3614332]The following steps occur:
 
     [bookmark: pgfId-3514300] 1. The user submits the plain text request (info). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3514301] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the ASA FirePOWER module.
 
     [bookmark: pgfId-3514302] 3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (info).
 
     [bookmark: pgfId-3514303] 4. The ASA FirePOWER module does not decrypt the traffic.
 
     [bookmark: pgfId-3633869]The access control policy continues to process the encrypted traffic and allows it. The module generates a connection event after the session ends.
 
     [bookmark: pgfId-3633857] 5. The ASA FirePOWER module receives the connection event.
 
    
 
     
      [bookmark: pgfId-3427139][bookmark: 69541]Inspecting Encrypted Traffic with a Private Key in a Passive Deployment
 
     [bookmark: pgfId-3622869]License: Any
 
     [bookmark: pgfId-3510158]For all SSL-encrypted traffic that contains application form data, the system decrypts the traffic and logs the connection. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3622465]Note In a passive deployment, if traffic is encrypted with either the DHE or ECDHE cipher suite, you cannot decrypt it with a known private key.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3657868]For traffic with legitimate application form information, the system logs the connection. 
 
     [bookmark: pgfId-3647013]The following steps occur:
 
     [bookmark: pgfId-3510133] 1. The user submits the plain text request (form). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3510134] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the ASA FirePOWER module.
 
     [bookmark: pgfId-3427155] 3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (form).
 
     [bookmark: pgfId-3427156] 4. The ASA FirePOWER module uses the session key obtained with the uploaded known private key to decrypt the encrypted traffic to plain text (form). 
 
     [bookmark: pgfId-3632695]The access control policy continues to process the decrypted traffic and does not find fake application information. The module generates a connection event after the session ends.
 
     [bookmark: pgfId-3653118] 5. The ASA FirePOWER module receives a connection event with information about the encrypted and decrypted traffic.
 
     [bookmark: pgfId-3657873]In contrast, if the decrypted traffic contains fake application data, the system logs the connection and the fake data. 
 
     [bookmark: pgfId-3621896]The following steps occur:
 
     [bookmark: pgfId-3530952] 1. The user submits the plain text request (fake). The client encrypts this (CcDd) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3530953] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the device.
 
     [bookmark: pgfId-3530954] 3. The Customer Service department server receives the encrypted information request (CcDd) and decrypts it to plain text (fake).
 
     [bookmark: pgfId-3532104] 4. The ASA FirePOWER module uses the session key obtained with the uploaded known private key to decrypt the encrypted traffic to plain text (fake). 
 
     [bookmark: pgfId-3549588]The access control policy continues to process the decrypted traffic and finds fake application information. The module generates an intrusion event. After the session ends, it generates a connection event.
 
     [bookmark: pgfId-3653131] 5. The ASA FirePOWER module receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the fake application data.
 
    
 
     
      [bookmark: pgfId-3427194][bookmark: 75117]Example: Decrypting Traffic in an Inline [bookmark: marker-3577872]Deployment
 
     [bookmark: pgfId-3622912]License: feature-dependent
 
     [bookmark: pgfId-3427196]LifeIns’s business requirements state that Underwriting must:
 
      
      	 [bookmark: pgfId-3506915]audit new and junior underwriters, verifying that their information requests to MedRepo comply with all applicable regulations
 
      	 [bookmark: pgfId-3532715]improve its underwriting metrics collection process
 
      	 [bookmark: pgfId-3532706]examine all requests that appear to come from MedRepo, then drop any spoofing attempts
 
      	 [bookmark: pgfId-3427199]drop all improper regulatory requests to MedRepo’s Customer Service department from the Underwriting department
 
      	 [bookmark: pgfId-3427200]not audit senior underwriters
 
     
 
     [bookmark: pgfId-3649187]LifeIns plans to deploy a device in an inline deployment for the Underwriting department. 
 
     [bookmark: pgfId-3614460]Traffic from MedRepo’s network goes to MedRepo’s router. It routes traffic to LifeIns’s network. The device receives the traffic, passes allowed traffic to LifeIns’s router, and sends events to the ASA FirePOWER module. LifeIns’s router routes traffic to the destination host.
 
     [bookmark: pgfId-3511719]On the ASA FirePOWER module, a user configures SSL inspection to:
 
      
      	 [bookmark: pgfId-3592970]log all encrypted traffic sent to the Underwriting department
 
      	 [bookmark: pgfId-3593325]block all encrypted traffic incorrectly sent from LifeIns’s underwriting department to MedRepo’s customer service department
 
      	 [bookmark: pgfId-3593489]decrypt all encrypted traffic sent from MedRepo to LifeIns’s underwriting department, and from LifeIns’s junior underwriters to MedRepo’s requests department
 
      	 [bookmark: pgfId-3593203]not decrypt encrypted traffic sent from the senior underwriters
 
     
 
     [bookmark: pgfId-3593709]The user also configures access control to inspect decrypted traffic with a custom intrusion policy and:
 
      
      	 [bookmark: pgfId-3593799]block decrypted traffic if it contains a spoof attempt, and log the spoof attempt
 
      	 [bookmark: pgfId-3593932]block decrypted traffic that contains information not compliant with regulations, and log the improper information
 
      	 [bookmark: pgfId-3594089]allow all other encrypted and decrypted traffic
 
     
 
     [bookmark: pgfId-3596057]The system reencrypts allowed decrypted traffic before sending it to the destination host.
 
     [bookmark: pgfId-3552765]In the following scenarios, the user submits information online to a remote server. The user’s browser establishes a TCP connection with the server, then initiates an SSL handshake. The module receives this traffic; based on handshake and connection details, the system logs the connection and acts on the traffic. If the system blocks the traffic, it also closes the TCP connection. Otherwise, the client and server complete the SSL handshake, establishing the encrypted session. 
 
     [bookmark: pgfId-3511327]For more information, see the following:
 
      
      	 [bookmark: pgfId-3533957]Monitoring Encrypted Traffic in an Inline Deployment
 
      	 [bookmark: pgfId-3511335]Allowing Specific Users’ Encrypted Traffic in an Inline Deployment
 
      	 [bookmark: pgfId-3511339]Blocking Encrypted Traffic in an Inline Deployment
 
      	 [bookmark: pgfId-3511342]Inspecting Encrypted Traffic with a Private Key in an Inline Deployment
 
      	 [bookmark: pgfId-3511346]Inspecting Specific Users’ Encrypted Traffic with a Re-signed Certificate in an Inline Deployment
 
     
 
    
 
     
      [bookmark: pgfId-3533761][bookmark: 94564]Monitoring Encrypted Traffic in an Inline Deployment
 
     [bookmark: pgfId-3622963]License: Any
 
     [bookmark: pgfId-3649222]For all SSL-encrypted traffic sent to and from the Underwriting department, the system logs the connection.
 
     [bookmark: pgfId-3621908]The following steps occur:
 
     [bookmark: pgfId-3533834] 1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to MedRepo’s Requests department server.
 
     [bookmark: pgfId-3533835] 2. LifeIns's router receives the encrypted traffic and routes it to the Requests department server. 
 
     [bookmark: pgfId-3533836] 3. The ASA FirePOWER module does not decrypt the traffic. 
 
     [bookmark: pgfId-3633949]The access control policy continues to process the encrypted traffic and allows it, then generates a connection event after the session ends.
 
     [bookmark: pgfId-3533840] 4. The external router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3533841] 5. The Underwriting department server receives the encrypted information request (AaBb) and decrypts it to plain text (help).
 
     [bookmark: pgfId-3533923] 6. The ASA FirePOWER module receives the connection event.
 
    
 
     
      [bookmark: pgfId-3533925][bookmark: 88980]Allowing Specific Users’ Encrypted Traffic in an Inline Deployment
 
     [bookmark: pgfId-3623046]License: Control
 
     [bookmark: pgfId-3483254]For all SSL-encrypted traffic originating from the senior underwriters, the system allows the traffic without decrypting it and logs the connection.
 
     [bookmark: pgfId-3621956]The following steps occur:
 
     [bookmark: pgfId-3621942] 1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to MedRepo’s Requests department server.
 
     [bookmark: pgfId-3427235] 2. LifeIns's router receives the encrypted traffic and routes it to the Requests department server. 
 
     [bookmark: pgfId-3427236] 3. The ASA FirePOWER module does not decrypt this traffic. 
 
     [bookmark: pgfId-3634009]The access control policy continues to process the encrypted traffic and allows it, then generates a connection event after the session ends.
 
     [bookmark: pgfId-3512160] 4. The external router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3512161] 5. The Requests department server receives the encrypted information request (AaBb) and decrypts it to plain text (help).
 
     [bookmark: pgfId-3653197] 6. The ASA FirePOWER module receives the connection event.
 
    
 
     
      [bookmark: pgfId-3427246][bookmark: 82209]Blocking Encrypted Traffic in an Inline Deployment
 
     [bookmark: pgfId-3623093]License: Any
 
     [bookmark: pgfId-3649751]For all SMTPS email traffic improperly sent from LifeIns’s underwriting department to MedRepo’s Customer Service department, the system blocks the traffic during the SSL handshake without further inspection and logs the connection.
 
     [bookmark: pgfId-3621968]The following steps occur:
 
     [bookmark: pgfId-3485656] 1. Having received the request to establish an SSL handshake from a client’s browser, the Customer Service department server sends the server certificate (cert) as the next step in the SSL handshake to the LifeIns underwriter.
 
     [bookmark: pgfId-3427261] 2. MedRepo’s router receives the certificate and routes it to the LifeIns underwriter. 
 
     [bookmark: pgfId-3427262] 3. The ASA FirePOWER module blocks the traffic without further inspection and ends the TCP connection. It generates a connection event. 
 
     [bookmark: pgfId-3427266] 4. The internal router does not receive the blocked traffic.
 
     [bookmark: pgfId-3427267] 5. The underwriter does not receive the blocked traffic.
 
     [bookmark: pgfId-3427271] 6. The ASA FirePOWER module receives the connection event.
 
    
 
     
      [bookmark: pgfId-3427273][bookmark: 88502]Inspecting Encrypted Traffic with a Private Key in an Inline Deployment
 
     [bookmark: pgfId-3623148]License: Any
 
     [bookmark: pgfId-3457714]For all SSL-encrypted traffic sent from MedRepo to LifeIns’s underwriting department, the system uses an uploaded server private key to obtain session keys, then decrypts the traffic and logs the connection. Legitimate traffic is allowed and reencrypted before being sent to the Underwriting department. 
 
     [bookmark: pgfId-3621980]The following steps occur:
 
     [bookmark: pgfId-3466075] 1. The user submits the plain text request (stats). The client encrypts this (AaBbC) and sends the encrypted traffic to the Underwriting department server.
 
     [bookmark: pgfId-3427288] 2. The external router receives the traffic and routes it to the Underwriting department server.
 
     [bookmark: pgfId-3427289] 3. The ASA FirePOWER module uses the session key obtained with the uploaded known private key to decrypt this traffic to plain text (stats). 
 
     [bookmark: pgfId-3514796]The access control policy continues to process the decrypted traffic with the custom intrusion policy and does not find a spoof attempt. The device passes the encrypted traffic (AaBbC), then generates a connection event after the session ends.
 
     [bookmark: pgfId-3427293] 4. The internal router receives the traffic and routes it to the Underwriting department server.
 
     [bookmark: pgfId-3427294] 5. The Underwriting department server receives the encrypted information (AaBbC) and decrypts it to plain text (stats).
 
     [bookmark: pgfId-3480335] 6. The ASA FirePOWER module receives the connection event with information about the encrypted and decrypted traffic.
 
     [bookmark: pgfId-3641336]In contrast, any decrypted traffic that is a spoof attempt is dropped. The system logs the connection and the spoof attempt.
 
     [bookmark: pgfId-3641345]The following steps occur:
 
     [bookmark: pgfId-3525263] 1. The user submits the plain text request (spoof), altering the traffic to appear to originate from MedRepo, LLC. The client encrypts this (FfGgH) and sends the encrypted traffic to the Underwriting department server.
 
     [bookmark: pgfId-3525265] 2. The ASA FirePOWER module uses the session key obtained with the uploaded known private key to decrypt this traffic to plain text (spoof).
 
     [bookmark: pgfId-3525266]The access control policy continues to process the decrypted traffic with the custom intrusion policy and finds a spoof attempt. The ASA FirePOWER module blocks the traffic, then generates an intrusion event. It generates a connection event after the session ends.
 
     [bookmark: pgfId-3594558] 3. The internal router does not receive the blocked traffic.
 
     [bookmark: pgfId-3525272] 4. The Underwriting department server does not receive the blocked traffic.
 
     [bookmark: pgfId-3525276] 5. The ASA FirePOWER module receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the spoofing attempt.
 
    
 
     
      [bookmark: pgfId-3480336][bookmark: 24605]Inspecting Specific Users’ Encrypted Traffic with a Re-signed Certificate in an Inline Deployment
 
     [bookmark: pgfId-3623187]License: Control
 
     [bookmark: pgfId-3480337]For all SSL-encrypted traffic sent from the new and junior underwriters to MedRepo’s requests department, the system uses a re-signed server certificate to obtain session keys, then decrypts the traffic and logs the connection. Legitimate traffic is allowed and reencrypted before being sent to MedRepo. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3571290]Note When decrypting traffic in an inline deployment by re-signing the server certificate, the ASA FirePOWER module acts as a man-in-the-middle. It creates two SSL sessions, one between client and ASA FirePOWER module, one between ASA FirePOWER module and server. As a result, each session contains different cryptographic session details.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3622012]The following steps occur:
 
     [bookmark: pgfId-3427315] 1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to the Requests department server.
 
     [bookmark: pgfId-3427317] 2. The internal router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3516692] 3. The ASA FirePOWER module uses the session key obtained with a re-signed server certificate and private key to decrypt this traffic to plain text (help).
 
     [bookmark: pgfId-3626616]The access control policy continues to process the decrypted traffic with the custom intrusion policy and does not find an improper request. The module reencrypts the traffic (CcDd), allowing it to pass. It generates a connection event after the session ends.
 
     [bookmark: pgfId-3427322] 4. The external router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3427323] 5. The Requests department server receives the encrypted information (CcDd) and decrypts it to plain text (help).
 
     [bookmark: pgfId-3427327] 6. The ASA FirePOWER module receives the connection event with information about the encrypted and decrypted traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-3603798]Note Traffic encrypted with a re-signed server certificate causes client browsers to warn that the certificate is not trusted. To avoid this, add the CA certificate to the organization’s domain root trusted certificates store or the client trusted certificates store.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3650003]In contrast, any decrypted traffic that contains information that does not meet regulatory requirements is dropped. The system logs the connection and the non-conforming information.
 
     [bookmark: pgfId-3650011] 
 
     [bookmark: pgfId-3650036]The following steps occur:
 
     [bookmark: pgfId-3526076] 1. The user submits the plain text request (regs), which does not comply with regulatory requirements. The client encrypts this (EeFf) and sends the encrypted traffic to the Requests department server.
 
     [bookmark: pgfId-3526077] 2. The internal router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3526862] 3. The ASA FirePOWER module uses the session key obtained with a re-signed server certificate and private key to decrypt this traffic to plain text (regs). 
 
     [bookmark: pgfId-3574299]The access control policy continues to process the decrypted traffic with the custom intrusion policy and finds an improper request. The module blocks the traffic, then generates an intrusion event. It generates a connection event after the session ends.
 
     [bookmark: pgfId-3526081] 4. The external router does not receive the blocked traffic.
 
     [bookmark: pgfId-3526082] 5. The Requests department server does not receive the blocked traffic.
 
     [bookmark: pgfId-3526086] 6. The ASA FirePOWER module receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the improper request.
 
      
       [bookmark: pgfId-3405144]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3400437][bookmark: 94448]Getting Started with SSL Policies 
      
      
 
     
 
 
    [bookmark: pgfId-3400416]An SSL policy[bookmark: marker-3468749] determines how the system handles encrypted traffic on your network. You can configure one or more SSL policies. You associate an SSL policy with an access control policy, then apply the access control policy. When the ASA FirePOWER module detects a TCP handshake, the access control policy first handles and inspects the traffic. If it subsequently identifies an SSL-encrypted session over the TCP connection, the SSL policy takes over, handling and decrypting the encrypted traffic. You can have one currently applied SSL policy.
 
    [bookmark: pgfId-3419157]The simplest SSL policy, as shown in the following diagram, directs the device where it is applied to handle encrypted traffic with a single default action. You can set the default action to block decryptable traffic without further inspection, or inspect undecrypted decryptable traffic with access control. The system can then either allow or block the encrypted traffic. If the ASA FirePOWER module detects undecryptable traffic, it either blocks the traffic without further inspection or does not decrypt it, inspecting it with access control. 
 
    [bookmark: pgfId-3482611]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3405638]This chapter explains how to create and apply a simple SSL policy. It also contains basic information on managing SSL policies: editing, updating, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-3406082]Creating a Basic SSL Policy
 
     	 [bookmark: pgfId-3406089]Editing an SSL Policy
 
     	 [bookmark: pgfId-3430021]Applying Decryption Settings Using Access Control
 
     	 [bookmark: pgfId-3412610]Generating a Report of Current Traffic Decryption Settings
 
     	 [bookmark: pgfId-3406096]Comparing SSL Policies
 
    
 
    [bookmark: pgfId-3429807]A more complex SSL policy can handle different types of undecryptable traffic with different actions, control traffic based on whether a certificate authority (CA) issued or trusts the encryption certificate, and use SSL rules to exert granular control over encrypted traffic logging and handling. These rules can be simple or complex, matching and inspecting encrypted traffic using multiple criteria. After you create a basic SSL policy, see the following chapters for more information on tailoring it to your deployment:
 
     
     	 [bookmark: pgfId-3430502]Managing Reusable Objects describes how to configure reusable public key infrastructure (PKI) objects and other SSL inspection-related objects to enhance encrypted traffic control and decrypt traffic.
 
     	 [bookmark: pgfId-3431320]Logging Connections in Network Traffic describes how to configure logging for encrypted traffic, whether decryptable or undecryptable.
 
     	 [bookmark: pgfId-3455296]Applying Decryption Settings Using Access Control describes how to associate an SSL policy with an access control policy.
 
     	 [bookmark: pgfId-3430431]Getting Started with Access Control Policies describes how to apply an access control policy to a device.
 
     	 [bookmark: pgfId-3431934]Tuning Traffic Flow Using Access Control Rules describes how to configure access control rules to inspect decrypted traffic.
 
     	 [bookmark: pgfId-3430562]Getting Started with SSL Rules describes how to configure SSL rules to handle and log encrypted traffic. 
 
     	 [bookmark: pgfId-3430451]Tuning Traffic Decryption Using SSL Rules describes how to configure SSL rule conditions to better match specific encrypted traffic.
 
    
 
   
 
    
     [bookmark: pgfId-3405300][bookmark: 31181][bookmark: 41531][bookmark: 30403]Creating a Basic SSL [bookmark: marker-3419122]Policy
 
    [bookmark: pgfId-3443130]License: Any
 
    [bookmark: pgfId-3419250]When you create a new SSL policy you must, at minimum, give it a unique name and specify a policy default action. You have the following options when selecting a default action for a new policy:
 
     
     	 [bookmark: pgfId-3419251] Do not decrypt creates a policy with the Do not decrypt default action.
 
     	 [bookmark: pgfId-3419252] Block creates a policy with the Block default action.
 
     	 [bookmark: pgfId-3419253] Block with reset creates a policy with the Block with reset default action.
 
    
 
    [bookmark: pgfId-3433223]After you create the SSL policy, you can modify the default action. For guidance on choosing a default action, see Setting Default Handling and Inspection for Encrypted Traffic.
 
    [bookmark: pgfId-3433393]The new SSL policy also contains default actions for traffic the system cannot decrypt: either it inherits the default action you just selected for undecryptable traffic, blocks it, or does not decrypt the traffic and inspects it with access control. You can modify the undecryptable traffic actions after you create the SSL policy. For guidance on selecting undecryptable traffic actions, see Setting Default Handling for Undecryptable Traffic
 
    [bookmark: pgfId-3420194]On the SSL policy page (Configuration > ASA FirePOWER Configuration > Policies > SSL) you can view all your current SSL policies by name with optional description. Options on this page allow you to compare policies, create a new policy, copy a policy, view a report that lists all of the most recently saved settings in each policy, edit a policy, or delete a policy.
 
    [bookmark: pgfId-3420202]The following table describes the actions you can take to manage your policies on the SSL Policy page:
 
    [bookmark: pgfId-3420252]
 
     
     Editing an SSL Policy 
     
 
     Editing an SSL Policy 
     
 
     Generating a Report of Current Traffic Decryption Settings 
     
 
     
 
      
       
       [bookmark: pgfId-3420209]Table 13-1 [bookmark: 22107]SSL Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-3420213]To... 
         
  
        	 
          
          [bookmark: pgfId-3420215]You can... 
         
  
       
 
        
        	[bookmark: pgfId-3420217]create a new SSL policy
  
        	[bookmark: pgfId-3420219]click New Policy. See Creating a Basic SSL Policy for more information.
  
       
 
        
        	[bookmark: pgfId-3420221]modify the settings in an existing SSL policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-3420228]compare SSL policies
  
        	[bookmark: pgfId-3420230]click Compare Policies. See Comparing SSL Policies for more information.
  
       
 
        
        	[bookmark: pgfId-3420232]copy an SSL policy
  ). See for more information on editing a copied policy. 
       
 
        
        	[bookmark: pgfId-3420239]view a PDF report that lists the current configuration settings in an SSL policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-3420246]delete an SSL policy
  . When prompted whether to continue, you are also informed if another user has unsaved changes in the policy. 
       
 
       
     
 
    
 
    [bookmark: pgfId-3415263]To create an SSL policy:
 
    
 
    [bookmark: pgfId-3406394]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
    [bookmark: pgfId-3406650]The SSL Policy page appears.
 
    [bookmark: pgfId-3409385]Step 2 Give the policy a unique Name and, optionally, a Description.
 
    [bookmark: pgfId-3406985]You can use all printable characters, including spaces and special characters.
 
    [bookmark: pgfId-3406991]Step 3 Specify the Default Action.
 
    [bookmark: pgfId-3407805]Note that you can modify your selected default action after you create your SSL policy. See Setting Default Handling and Inspection for Encrypted Traffic for more information.
 
    [bookmark: pgfId-3407072]Step 4 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-3419693]The SSL Policy Editor page appears. See Editing an SSL Policy for more information.
 
    [bookmark: pgfId-3452717]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3420286][bookmark: 69473]Setting Default Handling and Inspection for Encrypted Traffic
 
     [bookmark: pgfId-3420345]License: Any
 
     [bookmark: pgfId-3420379]The default action for an SSL policy determines how the system handles decryptable encrypted traffic that does not match any non-Monitor rule in the policy. When you apply an SSL policy that does not contain any SSL rules, the default action determines how all decryptable traffic on your network is handled. See Setting Default Handling for Undecryptable Traffic for more information on how the system handles undecryptable encrypted traffic. 
 
     [bookmark: pgfId-3420383]The following table lists the default actions you can choose, as well as their effect on encrypted traffic. Note that the system does not perform any kind of inspection on encrypted traffic blocked by the default action.
 
     [bookmark: pgfId-3420426]:
 
      
       
        
        [bookmark: pgfId-3420777]Table 13-2 [bookmark: 54105]SSL Policy Default Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3420781]Default Action 
          
  
         	 
           
           [bookmark: pgfId-3420783]Effect on Encrypted Traffic 
          
  
        
 
         
         	[bookmark: pgfId-3420789]Block
  
         	[bookmark: pgfId-3420791]block the SSL session without further inspection
  
        
 
         
         	[bookmark: pgfId-3420793]Block with reset
  
         	[bookmark: pgfId-3420795]block the SSL session without further inspection and reset the TCP connection
  
        
 
         
         	[bookmark: pgfId-3421110]Do not decrypt
  
         	[bookmark: pgfId-3421112]inspect the encrypted traffic with access control
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3428557]When you first create an SSL policy, logging connections that are handled by the default action is disabled by default. You can change this, as well as the default action itself, after you create the policy.
 
     [bookmark: pgfId-3420456]The following procedure explains how to set the default action for an SSL policy while editing the policy. See Editing an SSL Policy for the complete procedure for editing an SSL policy.
 
     [bookmark: pgfId-3420460]To set the default action of an SSL policy:
 
     
 
     [bookmark: pgfId-3420462]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
     [bookmark: pgfId-3420463]The SSL policy page appears.
 ) next to the SSL policy you want to configure. 
     
 
     [bookmark: pgfId-3420468]The SSL policy editor appears.
 
     [bookmark: pgfId-3420469]Step 3 Select a Default Action. See the SSL Policy Default Actions table for more information.
 
     [bookmark: pgfId-3420485]Step 4 Configure logging options for the default action as described in Logging Decryptable Connections with SSL Rules.
 
     [bookmark: pgfId-3455679]Step 5 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3455683]The SSL Policy Editor page appears. See Editing an SSL Policy for more information.
 
     [bookmark: pgfId-3452738]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3432812][bookmark: 62601]Setting Default Handling for [bookmark: marker-3432811]Undecryptable Traffic
 
     [bookmark: pgfId-3432816]License: Any
 
     [bookmark: pgfId-3439057]You can set undecryptable traffic actions at the SSL policy level to handle certain types of encrypted traffic the system cannot decrypt or inspect. When you apply an SSL policy that does not contain any SSL rules, the undecryptable traffic actions determine how all undecryptable encrypted traffic on your network is handled. 
 
     [bookmark: pgfId-3439058]Depending on the type of undecryptable traffic, you can choose to: 
 
      
      	 [bookmark: pgfId-3432830]block the connection
 
      	 [bookmark: pgfId-3432831]block the connection, then reset it
 
      	 [bookmark: pgfId-3432832]inspect the encrypted traffic with access control
 
      	 [bookmark: pgfId-3432833]inherit the default action from the SSL policy
 
     
 
     [bookmark: pgfId-3433964]The following table describes the undecryptable traffic types:
 
     [bookmark: pgfId-3432912]
 
      
       
        
        [bookmark: pgfId-3432840]Table 13-3 Undecryptable Traffic Types
 
        
        
         
         	 
           
           [bookmark: pgfId-3432848]Type 
          
  
         	 
           
           [bookmark: pgfId-3432850]Description 
          
  
         	 
           
           [bookmark: pgfId-3432852]Default Action 
          
  
         	 
           
           [bookmark: pgfId-3432854]Available Actions 
          
  
        
 
         
         	[bookmark: pgfId-3432856]Compressed Session
  
         	[bookmark: pgfId-3432858]The SSL session applies a data compression method.
  
         	[bookmark: pgfId-3432860]Inherit default action
  
         	[bookmark: pgfId-3432862]Do not decrypt
 [bookmark: pgfId-3455777]Block
 [bookmark: pgfId-3455780]Block with reset
 [bookmark: pgfId-3455803]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432864]SSLv2 Session
  
         	[bookmark: pgfId-3432866]The session is encrypted with SSL version 2.
 [bookmark: pgfId-3432867]Note that traffic is decryptable if the client hello message is SSL 2.0, and the remainder of the transmitted traffic is SSL 3.0. 
  
         	[bookmark: pgfId-3432869]Inherit default action
  
         	[bookmark: pgfId-3432871]Do not decrypt
 [bookmark: pgfId-3455806]Block
 [bookmark: pgfId-3455809]Block with reset
 [bookmark: pgfId-3455812]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432873]Unknown Cipher Suite
  
         	[bookmark: pgfId-3432875]The system does not recognize the cipher suite.
  
         	[bookmark: pgfId-3432877]Inherit default action
  
         	[bookmark: pgfId-3432879]Do not decrypt
 [bookmark: pgfId-3455815]Block
 [bookmark: pgfId-3455818]Block with reset
 [bookmark: pgfId-3455821]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432881]Unsupported Cipher Suite
  
         	[bookmark: pgfId-3432883]The system does not support decryption based on the detected cipher suite.
  
         	[bookmark: pgfId-3432885]Inherit default action
  
         	[bookmark: pgfId-3432887]Do not decrypt
 [bookmark: pgfId-3455845]Block
 [bookmark: pgfId-3455856]Block with reset
 [bookmark: pgfId-3455863]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432889]Session not cached
  
         	[bookmark: pgfId-3432891]The SSL session has session reuse enabled, the client and server reestablished the session with the session identifier, and the system did not cache that session identifier.
  
         	[bookmark: pgfId-3432893]Inherit default action
  
         	[bookmark: pgfId-3432895]Do not decrypt
 [bookmark: pgfId-3455870]Block
 [bookmark: pgfId-3455877]Block with reset
 [bookmark: pgfId-3455884]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432905]Handshake Errors
  
         	[bookmark: pgfId-3432907]An error occurred during SSL handshake negotiation.
  
         	[bookmark: pgfId-3432909]Inherit default action
  
         	[bookmark: pgfId-3462975]Do not decrypt
 [bookmark: pgfId-3462976]Block
 [bookmark: pgfId-3462977]Block with reset
 [bookmark: pgfId-3462978]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3460935]Decryption Errors
  
         	[bookmark: pgfId-3460937]An error occurred during traffic decryption.
  
         	[bookmark: pgfId-3460939]Block
  
         	[bookmark: pgfId-3460941]Block
 [bookmark: pgfId-3461056]Block with Reset
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3432913]When you first create an SSL policy, logging connections that are handled by the default action is disabled by default. Because the logging settings for the default action also apply to undecryptable traffic handling, logging connections handled by the undecryptable traffic actions is disabled by default. For more information on configuring default logging, see Logging Decryptable Connections with SSL Rules.
 
      
       
     
 
     
 
     [bookmark: pgfId-3464123]Note The system cannot decrypt traffic if an HTTP proxy is positioned between a client and your device, and the client and server establish a tunneled SSL connection using the CONNECT HTTP method. The Handshake Errors undecryptable action determines how the system handles this traffic. See Decrypt Actions: Decrypting Traffic for Further Inspection for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3471719]Note that if your browser uses certificate pinning to verify a server certificate, you cannot decrypt this traffic by re-signing the server certificate. Because you can still inspect this traffic with access control, it is not handled by the undecryptable traffic actions. If you want to allow this traffic, configure an SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name.
 
     [bookmark: pgfId-3432914]To set the default handling for undecryptable traffic:
 
     
 
     [bookmark: pgfId-3432916]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
     [bookmark: pgfId-3432917]The SSL Policy page appears.
 ) next to the SSL policy you want to configure. 
     
 
     [bookmark: pgfId-3432922]The SSL policy editor appears.
 
     [bookmark: pgfId-3432923]Step 3 Select the Undecryptable Actions tab. 
 
     [bookmark: pgfId-3432924]The Undecryptable Actions tab appears.
 
     [bookmark: pgfId-3432925]Step 4 For each field, select the action you want to take on the type of undecryptable traffic, or if you want to apply the SSL policy’s default action. See the SSL Policy Default Actions table for more information.
 
     [bookmark: pgfId-3432926]Step 5 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3432927]You must apply the associated access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3452758]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3405727][bookmark: 74144]Editing an SSL [bookmark: marker-3419127]Policy
 
    [bookmark: pgfId-3405571]License: Any
 
    [bookmark: pgfId-3419294]On the SSL policy editor, you can configure your policy and organize SSL rules. To configure an SSL policy, you must give the policy a unique name and specify a default action. You can also:
 
     
     	 [bookmark: pgfId-3419306]add, edit, delete, enable, and disable SSL rules
 
     	 [bookmark: pgfId-3419307]add trusted CA certificates
 
     	 [bookmark: pgfId-3419308]determine the handling for encrypted traffic the system cannot decrypt
 
     	 [bookmark: pgfId-3419309]log traffic that is handled by the default action and undecryptable traffic actions
 
    
 
    [bookmark: pgfId-3419310]After you create or modify an SSL policy, you can associate it with an access control policy, then apply the access control policy. You can also create custom user roles that allow you to assign different permissions to different users for configuring, organizing, and applying policies.
 
    [bookmark: pgfId-3419311]The following table summarizes the configuration actions you can take on the SSL policy editor.
 
    [bookmark: pgfId-3419404]
 
     
     Understanding and Creating SSL Rules 
     
 
     
 
      
       
       [bookmark: pgfId-3419318]Table 13-4 [bookmark: 51002]SSL Policy Configuration Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-3419322]To... 
         
  
        	 
          
          [bookmark: pgfId-3419324]You can... 
         
  
       
 
        
        	[bookmark: pgfId-3419326]modify the policy name or description
  
        	[bookmark: pgfId-3419328]click the name or description field, delete any characters as needed, then type the new name or description.
  
       
 
        
        	[bookmark: pgfId-3419330]set the default action
  
        	[bookmark: pgfId-3419335]find more information at Setting Default Handling and Inspection for Encrypted Traffic.
  
       
 
        
        	[bookmark: pgfId-3439501]set default handling for undecryptable traffic
  
        	[bookmark: pgfId-3439505]find more information at Setting Default Handling for Undecryptable Traffic.
  
       
 
        
        	[bookmark: pgfId-3419337]log connections for the default action and undecryptable traffic actions
  
        	[bookmark: pgfId-3419341]find more information at Logging Decryptable Connections with SSL Rules.
  
       
 
        
        	[bookmark: pgfId-3439516]add trusted CA certificates
  
        	[bookmark: pgfId-3439520]find more information at Trusting External Certificate Authorities.
  
       
 
        
        	[bookmark: pgfId-3419344]assign different rights to different users
  
        	[bookmark: pgfId-3419348]find more information at Collecting Prerequisite Information to Configure SSL Rules.
  
       
 
        
        	[bookmark: pgfId-3419351]save your policy changes
  
        	[bookmark: pgfId-3419353]click Save.
  
       
 
        
        	[bookmark: pgfId-3419355]cancel your policy changes
  
        	[bookmark: pgfId-3419357]click Cancel, then, if you have made changes, click OK.
  
       
 
        
        	[bookmark: pgfId-3419359]add a rule to a policy
  
        	[bookmark: pgfId-3419363]click Add Rule. See Understanding and Creating SSL Rules for more information.
 .  
       
 
        
        	[bookmark: pgfId-3419367]edit an existing rule
  ) next to the rule. See for more information. . 
       
 
        
        	[bookmark: pgfId-3419378]delete a rule
  . to delete one or more selected rules. 
       
 
        
        	[bookmark: pgfId-3419386]enable or disable an existing rule
  
        	[bookmark: pgfId-3419388]right-click a selected rule, select State, then select Disable or Enable. Disabled rules are grayed and marked (disabled) beneath the rule name.
  
       
 
        
        	[bookmark: pgfId-3419390]display the configuration page for a specific rule attribute
  
        	[bookmark: pgfId-3419392]click the name, value, or icon in the column for the condition on the row for the rule. For example, click the name or value in the Source Networks column to display the Networks page for the selected rule. See Tuning Traffic Decryption Using SSL Rules for more information.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3420019]When you change your configuration, a message indicates that you have unsaved changes. To retain your changes, you must save the policy before exiting the policy editor. If you attempt to exit the policy editor without saving your changes, you are cautioned that you have unsaved changes; you can then discard your changes and exit the policy, or return to the policy editor.
 
    [bookmark: pgfId-3420020]To protect the privacy of your session, after sixty minutes of inactivity on the policy editor, changes to your policy are discarded and you are returned to the SSL Policy page. After the first thirty minutes of inactivity, a message appears and updates periodically to provide the number of minutes remaining before changes are discarded. Any activity on the page cancels the timer.
 
    [bookmark: pgfId-3420022]When multiple users edit the same policy concurrently, a message on the policy editor identifies other users who have unsaved changes. Any user who attempts to save changes is cautioned that his changes will overwrite changes by other users. When the same policy is saved by multiple users, the last saved changes are retained.
 
    [bookmark: pgfId-3419405]To edit an SSL policy:
 
    
 
    [bookmark: pgfId-3419407]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
    [bookmark: pgfId-3419408]The SSL Policy page appears.
 
    [bookmark: pgfId-3419414]Step 2 You have the following choices:
 
     
      
      	 [bookmark: pgfId-3419417]To configure your policy, you can take any of the actions summarized in the  SSL Policy Configuration Actions  table. 
 
      	 [bookmark: pgfId-3419424]To organize rules in your policy, you can take any of the actions described in Managing SSL Rules in a Policy.
 
     
 
    
 
    [bookmark: pgfId-3419429]Step 3 Save or discard your configuration. You have the following choices:
 
     
      
      	 [bookmark: pgfId-3419430]To save your changes and continue editing, click  Store ASA FirePOWER Changes .
 
      	 [bookmark: pgfId-3419431]To discard your changes, click  Cancel and, if prompted, click  OK .
 
     
 
    
 
    [bookmark: pgfId-3419432]Your changes are discarded and the SSL Policy page appears. 
 
    [bookmark: pgfId-3452774]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3484157][bookmark: 93135]Applying [bookmark: marker-3484156]Decryption Settings Using Access Control
 
    [bookmark: pgfId-3484162]License: Any
 
    [bookmark: pgfId-3429964]After making any changes to an SSL policy, you must apply the access control policy it is associated with. For more information, see Deploying Configuration Changes.
 
    [bookmark: pgfId-3429965]Keep the following points in mind when applying SSL policies:
 
     
     	 [bookmark: pgfId-3429966]You cannot delete an SSL policy that has been applied or is currently applying.
 
     	 [bookmark: pgfId-3429967]Applying an access control policy automatically applies the associated SSL policy. You cannot apply an SSL policy independently.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3429968]Note In a passive deployment, the system cannot influence the flow of traffic. If you attempt to apply an access control policy that references an SSL policy that blocks encrypted traffic, or that is configured to decrypt traffic by re-signing the server certificate, the system displays a warning. Also, passive deployments do not support decrypting traffic encrypted with the ephemeral Diffie-Hellman (DHE) or the elliptic curve Diffie-Hellman (ECDHE) cipher suites. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3429972]To associate an SSL policy with an access control policy:
 
    
 
    [bookmark: pgfId-3463779]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-3463780]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-3429980]The access control policy editor appears.
 
    [bookmark: pgfId-3429981]Step 3 Select the Advanced tab. 
 
    [bookmark: pgfId-3429982]Advanced settings for the access control policy appear. 
 ) next to General Settings. 
    
 
    [bookmark: pgfId-3429987]The General Settings pop-up window appears.
 
    [bookmark: pgfId-3429988]Step 5 Select an SSL policy from the SSL Policy to use for inspecting encrypted connections drop-down.
 
    [bookmark: pgfId-3429989]Step 6 Click OK.
 
    [bookmark: pgfId-3429990]Advanced settings for the access control policy appear.
 
    [bookmark: pgfId-3456093]Step 7 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-3457042]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-3452801]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3456137][bookmark: 88882]Generating a [bookmark: marker-3456136]Report of Current Traffic Decryption Settings
 
    [bookmark: pgfId-3456141]License: Any
 
    [bookmark: pgfId-3412361]An SSL policy report is a record of the policy and rules configuration at a specific point in time. You can use the report for auditing purposes or to inspect the current configuration.
 
     
      
    
 
    
 
    [bookmark: pgfId-3412362]Tip You can also generate an SSL comparison report that compares a policy with the currently applied policy or with another policy. For more information, see Comparing SSL Policies.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-3412372]Table 13-5 SSL Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-3412376]Section 
         
  
        	 
          
          [bookmark: pgfId-3412378]Description 
         
  
       
 
        
        	[bookmark: pgfId-3412380]Title Page
  
        	[bookmark: pgfId-3412382]Identifies the name of the policy report, the date and time the policy was last modified, and the name of the user who made that modification.
  
       
 
        
        	[bookmark: pgfId-3412384]Table of Contents
  
        	[bookmark: pgfId-3412386]Describes the contents of the report.
  
       
 
        
        	[bookmark: pgfId-3412388]Policy Information
  
        	[bookmark: pgfId-3412390]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified.
  
       
 
        
        	[bookmark: pgfId-3412395]Default Action
  
        	[bookmark: pgfId-3412399]Provides the default action.
  
       
 
        
        	[bookmark: pgfId-3412402]Default Logging
  
        	[bookmark: pgfId-3412404]Provides the default connection logging settings.
  
       
 
        
        	[bookmark: pgfId-3412409]Rules
  
        	[bookmark: pgfId-3412411]Provides the rule action and conditions for each rule in the policy, by rule category.
  
       
 
        
        	[bookmark: pgfId-3412419]Trusted CA Certificates
  
        	[bookmark: pgfId-3412421]Provides the CA certificates that are automatically trusted if detected traffic is encrypted using these certificates or other certificates within the chain of trust.
  
       
 
        
        	[bookmark: pgfId-3412426]Undecryptable Actions
  
        	[bookmark: pgfId-3412428]Provides the action taken on detected types of traffic that cannot be decrypted.
  
       
 
        
        	[bookmark: pgfId-3412433]Referenced Objects
  
        	[bookmark: pgfId-3412435]Provides the name and configuration of all individual objects and group objects used in the policy, by type of condition (networks, ports, and so on) where the object is configured. 
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3412443]To view an SSL policy report:
 
    
 
    [bookmark: pgfId-3412445]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
    [bookmark: pgfId-3412446]The SSL Policy page appears.
 ) next to the policy for which you want to generate a report. Remember to save any changes before you generate an SSL policy report; only saved changes appear in the report. 
    
 
    [bookmark: pgfId-3412451]The system generates the report. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-3452859]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3412453][bookmark: 90844]Comparing SSL [bookmark: marker-3419140]Policies
 
    [bookmark: pgfId-3456236]License: Any
 
    [bookmark: pgfId-3412457]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two SSL policies. You can compare any two policies or the currently applied policy with another policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies.
 
    [bookmark: pgfId-3412458]There are two tools you can use to compare policies:
 
     
     	 [bookmark: pgfId-3412459]The comparison view displays only the differences between two policies in a side-by-side format. The name of each policy appears in the title bar on the left and right sides of the comparison view except when you select  Running Configuration , in which case a blank bar represents the currently active policy.
 
    
 
    [bookmark: pgfId-3412460]You can use this to view and navigate both policies on the web interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-3412461]The comparison report creates a record of only the differences between two policies in a format similar to the policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-3412462]You can use this to save, copy, print, and share your policy comparisons for further examination.
 
    [bookmark: pgfId-3412463]For more information on understanding and using the policy comparison tools, see:
 
     
     	 [bookmark: pgfId-3412467]Using the SSL Policy Comparison View
 
     	 [bookmark: pgfId-3412471]Using the SSL Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-3412473][bookmark: 29486]Using the SSL Policy Comparison View
 
     [bookmark: pgfId-3456277]License: Any
 
     [bookmark: pgfId-3412475]The comparison view displays both policies in a side-by-side format, with each policy identified by name in the title bar on the left and right sides of the comparison view. When comparing two policies other than the running configuration, the time of last modification and the last user to modify are displayed with the policy name. Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-3412476]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-3412477]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
      
       
        
        [bookmark: pgfId-3412484]Table 13-6 SSL Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3412488]To... 
          
  
         	 
           
           [bookmark: pgfId-3412490]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3412492]navigate individually through changes
  
         	[bookmark: pgfId-3412494]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-3412500]generate a new policy comparison view
  
         	[bookmark: pgfId-3412502]click New Comparison.
 [bookmark: pgfId-3412503]The Select Comparison window appears. See Using the SSL Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-3412508]generate a policy comparison report
  
         	[bookmark: pgfId-3412510]click Comparison Report. 
 [bookmark: pgfId-3412511]The policy comparison report creates a PDF document that lists only the differences between the two policies.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3412515][bookmark: 14990]Using the SSL Policy Comparison Report
 
     [bookmark: pgfId-3456303]License: Any
 
     [bookmark: pgfId-3412518]An SSL policy comparison report is a record of all differences between two SSL policies or a policy and the currently applied policy identified by the policy comparison view, presented in PDF format. You can use this report to further examine the differences between two policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-3412519]You can generate an SSL policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-3412520]The format of the policy comparison report is the same as the policy report with one exception: the policy report contains all configurations in the policy, and the policy comparison report lists only those configurations that differ between the policies. An SSL policy comparison report contains the sections described in Generating a Report of Current Traffic Decryption Settings. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3412524]Tip You can use a similar procedure to compare access control, network analysis, intrusion, file, system, or health policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3412525]To compare two SSL policies:
 
     
 
     [bookmark: pgfId-3412527]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
     [bookmark: pgfId-3412528]The SSL Policy appears.
 
     [bookmark: pgfId-3412529]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-3412530]The Select Comparison window appears.
 
     [bookmark: pgfId-3412531]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-3412532]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-3412533]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-3412534]To compare another policy to the currently active policy, select  Running Configuration. 
 
      
 
     
 
     [bookmark: pgfId-3412535]The page refreshes and the Target/Running Configuration A and Policy B drop-down lists appear.
 
     [bookmark: pgfId-3412536]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-3412537]If you are comparing two different policies, select the policies you want to compare from the Policy A and Policy B drop-down lists.
 
       	 [bookmark: pgfId-3412538]If you are comparing the running configuration to another policy, select the second policy from the Policy B drop-down list.
 
      
 
     
 
     [bookmark: pgfId-3412539]Step 5 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-3412540]The comparison view appears.
 
     [bookmark: pgfId-3412541]Step 6 Optionally, click Comparison Report to generate the SSL policy comparison report. 
 
     [bookmark: pgfId-3412542]The SSL policy comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-3452886]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3351539]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3535792][bookmark: 68255]Getting Started with SSL Rules 
      
      
 
     
 
 
    [bookmark: pgfId-3535795]Within an SSL policy, SSL rules provide a granular method of handling encrypted traffic, whether blocking the traffic without further inspection, not decrypting the traffic and inspecting it with access control, or decrypting the traffic for access control analysis.
 
    [bookmark: pgfId-3535743]The ASA FirePOWER module matches traffic to SSL rules in the order you specify. In most cases, the module handles encrypted traffic according to the first SSL rule where all the rule’s conditions match the traffic. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, port, application, requested URL, user, certificate, certificate distinguished name, certificate status, cipher suite, or encryption protocol version.
 
    [bookmark: pgfId-3535744]Each rule also has an action, which determines whether you monitor, block, or inspect matching traffic with access control, optionally after decrypting matching traffic. Note that the module does not further inspect encrypted traffic it blocks. It does inspect encrypted and undecryptable traffic with access control. However, some access control rule conditions require unencrypted traffic, so encrypted traffic may match fewer rules. Also, by default, the module disables intrusion and file inspection of encrypted payloads. 
 
    [bookmark: pgfId-3535745]The following scenario summarizes the ways that SSL rules handle traffic in an inline deployment.
 
    [bookmark: pgfId-3560956]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3501332]In this scenario, traffic is evaluated as follows:
 
     
     	 [bookmark: pgfId-3501333] Undecryptable Traffic Action  evaluates encrypted traffic first. For traffic the module cannot decrypt, the module either blocks it without further inspection or passes it for access control inspection. Encrypted traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-3501334] SSL Rule 1: Monitor evaluates encrypted traffic next. Monitor rules track and log encrypted traffic but do not affect traffic flow. The module continues to match traffic against additional rules to determine whether to permit or deny it.
 
     	 [bookmark: pgfId-3500627] SSL Rule 2: Do Not Decrypt  evaluates encrypted traffic third. Matching traffic is not decrypted; the module inspects this traffic with access control, but not file or intrusion inspection. Traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-3500628] SSL Rule 3: Block evaluates encrypted traffic fourth. Matching traffic is blocked without further inspection. Traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-3500629] SSL Rule 4: Decrypt - Known Key  evaluates encrypted traffic fifth. Matching traffic incoming to your network is decrypted using a private key you upload. The decrypted traffic is then evaluated against access control rules. Access control rules handle decrypted and unencrypted traffic identically. The module can block traffic as a result of this additional inspection. All remaining traffic is reencrypted before being allowed to the destination. Traffic that does not match the SSL rule continues to the next rule. 
 
     	 [bookmark: pgfId-3501953] SSL Rule 5: Decrypt - Resign  is the final rule. If traffic matches this rule, the module re-signs the server certificate with an uploaded CA certificate, then acts as a man-in-the-middle to decrypt traffic. The decrypted traffic is then evaluated against access control rules. Access control rules treat decrypted and unencrypted traffic identically. The module can block traffic as a result of this additional inspection. All remaining traffic is reencrypted before being allowed to the destination. Traffic that does not match the SSL rule continues to the next rule.
 
     	 [bookmark: pgfId-3503003] SSL Policy Default Action handles all traffic that does not match any of the SSL rules. The default action either blocks encrypted traffic without further inspection or does not decrypt it, passing it for access control inspection. 
 
    
 
    [bookmark: pgfId-3432068]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3499593]Configuring Supporting Inspection Information
 
     	 [bookmark: pgfId-3405330]Understanding and Creating SSL Rules
 
     	 [bookmark: pgfId-3405631]Managing SSL Rules in a Policy
 
    
 
   
 
    
     [bookmark: pgfId-3499171][bookmark: 14361][bookmark: 92939]Configuring Supporting Inspection Information
 
    [bookmark: pgfId-3505538]License: Any
 
    [bookmark: pgfId-3475921]You must create reusable public key infrastructure (PKI) objects to control encrypted traffic based on encrypted session characteristics and decrypt encrypted traffic. You can add this information on the fly when uploading trusted certificate authority (CA) certificates to the SSL policy and creating SSL rule conditions, creating the associated object in the process. However, configuring these objects ahead of time reduces the chance of improper object creation. 
 
    [bookmark: pgfId-3475922]Decrypting Encrypted Traffic with Certificates and Paired Keys
 
    [bookmark: pgfId-3475923]The ASA FirePOWER module can decrypt incoming encrypted traffic if you configure an internal certificate object by uploading the server certificate and private key used to encrypt the session. If you reference that object in an SSL rule with an action of Decrypt - Known Key and traffic matches that rule, the module uses the uploaded private key to decrypt the session. 
 
    [bookmark: pgfId-3475924]The module can also decrypt outgoing traffic if you configure an internal CA object by uploading a CA certificate and private key. If you reference that object in an SSL rule with an action of Decrypt - Resign and traffic matches that rule, the module re-signs the server certificate passed to the client browser, then acts as a man-in-the-middle to decrypt the session. 
 
    [bookmark: pgfId-3475925]See the following for more information:
 
     
     	 [bookmark: pgfId-3475929]Working with Internal Certificate Objects
 
     	 [bookmark: pgfId-3475933]Working with Internal Certificate Authority Objects
 
    
 
    [bookmark: pgfId-3475934]Controlling Traffic Based on Encrypted Session Characteristics
 
     
      
       
        
        	 
          
          [bookmark: pgfId-3504089]If you configure... 
         
  
        	 
          
          [bookmark: pgfId-3504091]You can control encrypted traffic based on whether... 
         
  
       
 
        
        	[bookmark: pgfId-3504093]a cipher suite list containing one or more cipher suites
  
        	[bookmark: pgfId-3504095]the cipher suite used to negotiate the encrypted session matches a cipher suite in the cipher suite list
  
       
 
        
        	[bookmark: pgfId-3504097]a trusted CA object by uploading a CA certificate your organization trusts
  
        	[bookmark: pgfId-3504099]the trusted CA trusts the server certificate used to encrypt the session, whether: 
 
          
          	 [bookmark: pgfId-3522238]the CA issued the certificate directly
 
          	 [bookmark: pgfId-3522245]the CA issued a certificate to an intermediate CA that issued the server certificate
 
         
  
       
 
        
        	[bookmark: pgfId-3504101]an external certificate object by uploading a server certificate
  
        	[bookmark: pgfId-3504103]the server certificate used to encrypt the session matches the uploaded server certificate
  
       
 
        
        	[bookmark: pgfId-3504105]a distinguished name object containing a certificate subject or issuer distinguished name
  
        	[bookmark: pgfId-3504107]the subject or issuer common name, country, organization, or organizational unit on the certificate used to encrypt the session matches the configured distinguished name
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3475962]See the following for more information:
 
     
     	 [bookmark: pgfId-3475966]Working with Geolocation Objects
 
     	 [bookmark: pgfId-3475970]Working with Trusted Certificate Authority Objects
 
     	 [bookmark: pgfId-3475974]Working with External Certificate Objects
 
     	 [bookmark: pgfId-3475978]Working with Distinguished Name Objects 
 
    
 
   
 
    
     [bookmark: pgfId-3405213][bookmark: 93402]Understanding and Creating SSL [bookmark: marker-3432470]Rules
 
    [bookmark: pgfId-3405341]License: Any
 
    [bookmark: pgfId-3482824]Within an SSL policy, SSL rules provide a granular method of handling network traffic. In addition to its unique name, each SSL rule has the following basic components. 
 
    [bookmark: pgfId-3482825]State
 
    [bookmark: pgfId-3482826]By default, rules are enabled. If you disable a rule, the module does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.
 
    [bookmark: pgfId-3482827]Position
 
    [bookmark: pgfId-3482828]Rules in an SSL policy are numbered, starting at 1. The module matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
    [bookmark: pgfId-3482829]Conditions
 
    [bookmark: pgfId-3482830]Conditions specify the specific traffic the rule handles. Conditions can match traffic by security zone, network or geographical location, port, application, requested URL, user, certificate, certificate subject or issuer, certificate status, cipher suite, or encryption protocol version. Conditions can be simple or complex; their use can depends on device licenses.
 
    [bookmark: pgfId-3482831]Action
 
    [bookmark: pgfId-3482832]A rule’s action determines how the module handles matching traffic. You can monitor, trust, block, or decrypt matching traffic. Decrypted traffic is subject to further inspection. Note that the module does not perform inspection on blocked or trusted encrypted traffic.
 
    [bookmark: pgfId-3482835]Logging
 
    [bookmark: pgfId-3482836]A rule’s logging settings govern the records the module keeps of the traffic it handles. You can keep a record of traffic that matches a rule. You can log a connection when the module blocks an encrypted session or allows it to pass uninspected, according to the settings in an SSL policy. You can also force the module to log connections that it decrypts for further evaluation by access control rules, regardless of how the module later handles or inspects the traffic. You can log connections to the module log (syslog) or to an SNMP trap server.
 
     
      
    
 
    
 
    [bookmark: pgfId-3482846]Tip Properly creating and ordering SSL rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the module handles traffic as you expect, the SSL policy interface has a robust warning and error feedback system for rules. For more information, see Troubleshooting SSL Rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3482850]To create or modify an SSL rule:
 
    
 
    [bookmark: pgfId-3482855]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
    [bookmark: pgfId-3482856]The SSL Policy page appears.
 ) next to the SSL policy where you want to add a rule. 
    
 
    [bookmark: pgfId-3482861]The SSL policy editor appears, focused on the Rules tab.
 
    [bookmark: pgfId-3482862]Step 3 You have the following options:
 
     
      
      	 [bookmark: pgfId-3482863]To add a new rule, click  Add Rule .
 
      	 [bookmark: pgfId-3482867]To edit an existing rule, click the edit icon (
 
     
 
     [image: ] ) next to the rule you want to edit. 
    
 
    [bookmark: pgfId-3482868]The SSL rule editor appears.
 
    [bookmark: pgfId-3482869]Step 4 Type a Name for the rule.
 
    [bookmark: pgfId-3482870]Each rule must have a unique name. You can use up to thirty printable characters, including spaces and special characters, with the exception of the colon (:).
 
    [bookmark: pgfId-3482871]Step 5 Configure the rule components, as summarized above. You can configure the following, or accept the defaults:
 
     
      
      	 [bookmark: pgfId-3490691]Specify whether the rule is  Enabled .
 
      	 [bookmark: pgfId-3490692]Specify the rule position; see Specifying an SSL Rule’s Order of Evaluation.
 
      	 [bookmark: pgfId-3490695]Select a rule  Action ; see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection.
 
      	 [bookmark: pgfId-3482883]Configure the rule’s conditions; see Using Conditions to Specify the Encrypted Traffic a Rule Handles.
 
      	 [bookmark: pgfId-3482891]Specify  Logging options; see Logging Decryptable Connections with SSL Rules.
 
     
 
    
 
    [bookmark: pgfId-3482897]Step 6 Click Save to save the rule.
 
    [bookmark: pgfId-3482901]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-3482905]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3485133][bookmark: 90432]Specifying an SSL Rule’s Order of Evaluation
 
     [bookmark: pgfId-3511235]License: Any
 
     [bookmark: pgfId-3485139]When you first create an SSL rule, you specify its position using the Insert drop-down list in the rule editor. SSL rules in an SSL policy are numbered, starting at 1. The ASA FirePOWER module matches traffic to SSL rules in top-down order by ascending rule number. 
 
     [bookmark: pgfId-3485140]In most cases, the module handles network traffic according to the first SSL rule where all the rule’s conditions match the traffic. Except in the case of Monitor rules (which log traffic but do not affect traffic flow), the module does not continue to evaluate traffic against additional, lower-priority rules after that traffic matches a rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3485729]Tip Proper SSL rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs. For more information, see Ordering SSL Rules to Improve Performance and Avoid Preemption.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3485141]In addition to ordering rules by number, you can group rules by category. By default the module provides three categories: Administrator, Standard, and Root. You can add custom categories, but you cannot delete the ASA FirePOWER module-provided categories or change their order. For information on changing the position or category of an existing rule, see Changing an SSL Rule’s Position or Category.
 
     [bookmark: pgfId-3485143]To add a rule to a category while editing or creating a rule:
 
     
 
     [bookmark: pgfId-3485148]Step 1 In the SSL rule editor, from the Insert drop-down list, select Into Category, then select the category you want to use.
 
     [bookmark: pgfId-3485149]When you save the rule, it is placed last in that category.
 
     [bookmark: pgfId-3485150]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3485151]To position a rule by number while editing or creating a rule:
 
     
 
     [bookmark: pgfId-3485156]Step 1 In the SSL rule editor, from the Insert drop-down list, select above rule or below rule, then type the appropriate rule number.
 
     [bookmark: pgfId-3485157]When you save the rule, it is placed where you specified.
 
     [bookmark: pgfId-3485158]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3483556][bookmark: 31965][bookmark: 45259]Using Conditions to Specify the Encrypted Traffic a Rule Handles
 
     [bookmark: pgfId-3483955]License: feature dependent
 
     [bookmark: pgfId-3483566]An SSL rule’s conditions identify the type of encrypted traffic that rule handles. Conditions can be simple or complex, and you can specify more than one condition type per rule. Only if traffic meets all the conditions in a rule does the rule apply to the traffic.
 
     [bookmark: pgfId-3483567]If you do not configure a particular condition for a rule, the module does not match traffic based on that criterion. For example, a rule with a certificate condition but no version condition evaluates traffic based on the server certificate used to negotiate the session, regardless of the session SSL or TLS version.
 
     [bookmark: pgfId-3483568]When you add or edit an SSL rule, use the tabs on the left side of the lower portion of the rule editor to add and edit rule conditions. The conditions you can add to an SSL rule are described in the following table.
 
     [bookmark: pgfId-3483693]
 
      
       
        
        [bookmark: pgfId-3483574]Table 14-1 SSL Rule Condition Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-3483580]This Condition... 
          
  
         	 
           
           [bookmark: pgfId-3483582]Matches Encrypted Traffic... 
          
  
         	 
           
           [bookmark: pgfId-3483584]Details 
          
  
        
 
         
         	[bookmark: pgfId-3483586]Zones
  
         	[bookmark: pgfId-3483588]entering or leaving a device via an interface in a specific security zone
  
         	[bookmark: pgfId-3483590]A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. To build a zone condition, see Controlling Encrypted Traffic by Network Zone.
  
        
 
         
         	[bookmark: pgfId-3483595]Networks
  
         	[bookmark: pgfId-3483597]by its source or destination IP address, country, or continent
  
         	[bookmark: pgfId-3483599]You can explicitly specify IP addresses. The geolocation feature also allows you to control traffic based on its source or destination country or continent. To build a network condition, see Controlling Encrypted Traffic by Network or Geographical Location.
  
        
 
         
         	[bookmark: pgfId-3483613]Ports
  
         	[bookmark: pgfId-3483615]by its source or destination port
  
         	[bookmark: pgfId-3483617]You can control encrypted traffic based on the TCP port. To build a port condition, see Controlling Encrypted Traffic by Port.
  
        
 
         
         	[bookmark: pgfId-3483622]Users
  
         	[bookmark: pgfId-3483624]by the user involved in the session
  
         	[bookmark: pgfId-3483626]You can control encrypted traffic based on the LDAP user logged into a host involved in an encrypted, monitored session. You can control traffic based on individual users or groups retrieved from a Microsoft Active Directory server. To build a user condition, see Controlling Encrypted Traffic Based on User.
  
        
 
         
         	[bookmark: pgfId-3483631]Applications
  
         	[bookmark: pgfId-3483633]by the application detected in a session
  
         	[bookmark: pgfId-3483635]You can control access to individual applications in encrypted sessions, or filter access according to basic characteristics: type, risk, business relevance, and categories. To build an application condition, see Controlling Encrypted Traffic Based on Application.
  
        
 
         
         	[bookmark: pgfId-3483640]Categories
  
         	[bookmark: pgfId-3483642]by the URL requested in the session, based on the certificate subject distinguished name
  
         	[bookmark: pgfId-3483644]You can limit the websites that users on your network can access based on the URL’s general classification and risk level. To build a URL condition, see Controlling Encrypted Traffic by URL Category and Reputation.
  
        
 
         
         	[bookmark: pgfId-3483649]Distinguished Names
  
         	[bookmark: pgfId-3483651]by the subject or issuer distinguished name of the server certificate used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483653]You can control encrypted traffic based on the CA that issued a server certificate, or the server certificate holder. To build a distinguished name condition, see Controlling Encrypted Traffic by Certificate Distinguished Name.
  
        
 
         
         	[bookmark: pgfId-3483658]Certificates
  
         	[bookmark: pgfId-3483660]by the server certificate used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483662]You can control encrypted traffic based on the server certificate passed to the user’s browser in order to negotiate the encrypted session. To build a certificate condition, see Controlling Encrypted Traffic by Certificate Status.
  
        
 
         
         	[bookmark: pgfId-3483667]Certificate Status
  
         	[bookmark: pgfId-3483669]by properties of the server certificate used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483671]You can control encrypted traffic based on a server certificate’s status. To build a certificate status condition, see Controlling Encrypted Traffic by Certificate Status.
  
        
 
         
         	[bookmark: pgfId-3483676]Cipher Suites
  
         	[bookmark: pgfId-3483678]by the cipher suite used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483680]You can control encrypted traffic based on the cipher suite selected by the server to negotiate the encrypted session. To build a cipher suite condition, see Controlling Encrypted Traffic by Cipher Suite.
  
        
 
         
         	[bookmark: pgfId-3483685]Versions
  
         	[bookmark: pgfId-3483687]by the version of SSL or TLS used to encrypt the session
  
         	[bookmark: pgfId-3483689]You can control encrypted traffic based on the version of SSL or TLS used to encrypt the session. To build a version condition, see Controlling Traffic by Encryption Protocol Version. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3483703]Note that while you can control and inspect encrypted traffic, controlling traffic using detected application, URL category, or user requires additional licenses. Also, overly complex rules can consume excessive resources and in some cases prevent you from applying the policy. For more information, see Troubleshooting SSL Rules.
 
    
 
     
      [bookmark: pgfId-3482778][bookmark: 42634]Using Rule Actions to Determine Encrypted Traffic Handling and Inspection
 
     [bookmark: pgfId-3507109]License: Any
 
     [bookmark: pgfId-3476533]Every SSL rule has an associated action that determines the following for matching encrypted traffic:
 
      
      	 [bookmark: pgfId-3476534]handling — foremost, the rule action governs whether the ASA FirePOWER module will monitor, trust, block, or decrypt encrypted traffic that matches the rule’s conditions
 
      	 [bookmark: pgfId-3525470]logging — the rule action determines when and how you can log details about matching encrypted traffic. 
 
     
 
     [bookmark: pgfId-3525471]Your SSL inspection configuration handles, inspects, and logs decrypted traffic:
 
      
      	 [bookmark: pgfId-3522651]The SSL policy’s undecryptable actions handle traffic that the ASA FirePOWER module cannot decrypt; see Setting Default Handling for Undecryptable Traffic. 
 
      	 [bookmark: pgfId-3522658]The policy’s default action handles traffic that does not meet the condition of any non-Monitor SSL rule; see Setting Default Handling and Inspection for Encrypted Traffic. 
 
     
 
     [bookmark: pgfId-3525556]You can log a connection event when the ASA FirePOWER module blocks or trusts an encrypted session. You can also force the module to log connections that it decrypts for further evaluation by access control rules, regardless of how the module later handles or inspects the traffic. Connection logs for encrypted sessions contain details about the encryption, such as the certificate used to encrypt that session. You can log only end-of-connection events, however: 
 
      
      	 [bookmark: pgfId-3525557]for blocked connections (Block, Block with reset), the module immediately ends the sessions and generates an event
 
      	 [bookmark: pgfId-3525558]for trusted connections (Do not decrypt), the module generates an event when the session ends
 
     
 
     [bookmark: pgfId-3525484]For detailed information on rule actions and how they affect handling and logging, see the following sections:
 
      
      	 [bookmark: pgfId-3515391]Monitor Action: Postponing Action and Ensuring Logging
 
      	 [bookmark: pgfId-3515405]Do Not Decrypt Action: Passing Encrypted Traffic Without Inspection
 
      	 [bookmark: pgfId-3515411]Blocking Actions: Blocking Encrypted Traffic Without Inspection
 
      	 [bookmark: pgfId-3515417]Decrypt Actions: Decrypting Traffic for Further Inspection
 
      	 [bookmark: pgfId-3515423]Managing SSL Rules in a Policy
 
     
 
    
 
     
      [bookmark: pgfId-3476537][bookmark: 45207]Monitor Action: Postponing Action and Ensuring Logging
 
     [bookmark: pgfId-3511274]License: Any
 
     [bookmark: pgfId-3476539]The Monitor action does not affect encrypted traffic flow; matching traffic is neither immediately permitted nor denied. Rather, traffic is matched against additional rules, if present, to determine whether to trust, block, or decrypt it. The first non-Monitor rule matched determines traffic flow and any further inspection. If there are no additional matching rules, the ASA FirePOWER module uses the default action.
 
     [bookmark: pgfId-3511307]Because the primary purpose of Monitor rules is to track network traffic, the module automatically logs end-of connection events for monitored traffic. That is, the module always logs the end of the connection , regardless of the logging configuration of the rule or default action that later handles the connection. In other words, if a packet matches a Monitor rule, the connection is always logged, even if the packet matches no other rules and you do not enable logging on the default action.
 
    
 
     
      [bookmark: pgfId-3522873][bookmark: 22481]Do Not Decrypt Action: Passing Encrypted Traffic Without Inspection
 
     [bookmark: pgfId-3522880]License: Any
 
     [bookmark: pgfId-3537718]The Do not decrypt action passes encrypted traffic for evaluation by the access control policy’s rules and default action. Because some access control rule conditions require unencrypted traffic, this traffic may match fewer rules. The module cannot perform deep inspection on encrypted traffic, such as intrusion or file inspection.
 
    
 
     
      [bookmark: pgfId-3537724][bookmark: 59880]Blocking Actions: Blocking Encrypted Traffic Without Inspection
 
     [bookmark: pgfId-3537711]License: Any
 
     [bookmark: pgfId-3476549]The Block and Block with reset actions are analogous to the access control rule actions Block and Block with reset. These actions prevent the client and server from establishing the SSL-encrypted session and passing encrypted traffic. Block with reset rules also reset the connection. 
 
     [bookmark: pgfId-3533023]Note that the ASA FirePOWER module does not display the configured response page for blocked encrypted traffic. Instead, users requesting prohibited URLs have their connection either reset or time out. See Displaying a Custom Web Page for Blocked URLs for more information.
 
      
       
     
 
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3476553][bookmark: 29589]Decrypt Actions: Decrypting Traffic for Further Inspection
 
    [bookmark: pgfId-3511057]License: Any
 
    [bookmark: pgfId-3476555]The Decrypt - Known Key and Decrypt - Resign actions decrypt encrypted traffic. The ASA FirePOWER module inspects decrypted traffic with access control. Access control rules handle decrypted and unencrypted traffic identically — you can detect and block intrusions, prohibited files, and malware. The module reencrypts allowed traffic before passing it to its destination.
 
    [bookmark: pgfId-3507179]When you configure the Decrypt - Known Key action, you can associate one or more server certificates and paired private keys with the action. If traffic matches the rule, and the certificate used to encrypt the traffic matches the certificate associated with the action, the module uses the appropriate private key to obtain the session encryption and decryption keys. Because you must have access to the private key, this action is best suited to decrypt traffic incoming to servers your organization controls.
 
    [bookmark: pgfId-3507941]Similarly, you can associate one Certificate Authority certificate and private key with the Decrypt - Resign action. If traffic matches this rule, the module re-signs the server certificate with the CA certificate, then acts as a man-in-the-middle. It creates two SSL sessions, one between client and device, one between device and server. Each session contains different cryptographic session details, and allows the module to decrypt and reencrypt traffic. This action is more suited for outgoing traffic, as you replace the certificate’s private key with one you control to obtain the session keys.
 
    [bookmark: pgfId-3527974]Re-signing a server certificate involves either replacing the certificate’s public key with a CA certificate public key, or replacing the entire certificate. Normally, if you replace an entire server certificate, the client browser warns the certificate is not signed by a trusted authority when establishing the SSL connection. However, if your client’s browser trusts the CA in the policy, the browser does not warn that the certificate is not trusted. If the original server certificate is self-signed, the ASA FirePOWER module replaces the entire certificate, and trusts the re-signing CA, but the user’s browser does not warn that the certificate is self-signed. In this case, replacing only the server certificate public key causes the client browser does warn that the certficate is self-signed.
 
    [bookmark: pgfId-3528117]If you configure a rule with the Decrypt - Resign action, the rule matches traffic based on the referenced internal CA certificate’s signature algorithm type, in addition to any configured rule conditions. Because you associate one CA certificate with a Decrypt - Resign action, you cannot create an SSL rule that decrypts multiple types of outgoing traffic encrypted with different signature algorithms. In addition, any external certificate objects and cipher suites you add to the rule must match the associated CA certificate encryption algorithm type. 
 
    [bookmark: pgfId-3528601]For example, outgoing traffic encrypted with an elliptic curve (EC) algorithm matches a Decrypt - Resign rule only if the action references an EC-based CA certificate; you must add EC-based external certificates and cipher suites to the rule if you want to create certificate and cipher suite rule conditions. Similarly, a Decrypt - Resign rule that references an RSA-based CA certificate matches only outgoing traffic encrypted with an RSA algorithm; outgoing traffic encrypted with an EC algorithm does not match the rule, even if all other configured rule conditions match. 
 
    [bookmark: pgfId-3476557]Note the following:
 
     
     	 [bookmark: pgfId-3527572]You cannot use the  Decrypt - Known Key action in a passive deployment if the cipher suite used to establish the SSL connection applies either the Diffie-Hellman ephemeral (DHE) or the elliptic curve Diffie-Hellman ephemeral (ECDHE) key exchange algorithm. If your SSL policy targets passive or inline (tap mode) interfaces, and contains a  Decrypt - Known Key rule with a cipher suite condition containing either a DHE or an ECDHE cipher suite, the ASA FirePOWER module displays an information icon (
 
     [image: ] ) next to the rule. If you later add a zone condition to the SSL rule that contains passive or inline (tap mode) interfaces, the module displays a warning icon ( 
     [image: ] ). 
    
 
     
     	 [bookmark: pgfId-3506495]You cannot use the  Decrypt - Resign action in a passive or inline (tap mode) deployment, as the device does not directly inspect traffic. If you create a rule with the  Decrypt - Resign action that contains passive or inline (tap mode) interfaces within a security zone, the policy editor displays a warning icon (
 
     [image: ] ) next to the rule. If your SSL policy targetspassive or inline (tap mode) interfaces, and contains a 
      Decrypt - Resign rule, the module displays an information icon ( 
     [image: ] ) next to the rule. If you later add a zone condition to the SSL rule that contains passive or inline (tap mode) interfaces, the module displays a warning icon ( 
     [image: ] ). If you apply an SSL policy that contains a Decrypt - Resign rule to a device with passive or inline (tap mode) interfaces, any SSL sessions that match the rule fail. 
    
 
     
     	 [bookmark: pgfId-3506822]If the client does not trust the CA used to re-sign the server certificate, it warns the user that the certificate should not be trusted. To prevent this, import the CA certificate into the client trusted CA store. Alternatively, if your organization has a private PKI, you can issue an intermediate CA certificate signed by the root CA which is automatically trusted by all clients in the organization, then upload that CA certificate to the device.
 
     	 [bookmark: pgfId-3526077]The ASA FirePOWER module cannot decrypt traffic encrypted with an anonymous cipher suite. You cannot use either the Decrypt - Resign or  Decrypt - Known Key action in an SSL rule if you add an anonymous cipher suite to the  Cipher Suite condition. 
 
     	 [bookmark: pgfId-3530879]The ASA FirePOWER module cannot decrypt traffic if an HTTP proxy is positioned between a client and yourdevice, and the client and server establish a tunneled SSL connection using the CONNECT HTTP method. The  Handshake Errors undecryptable action determines how the module handles this traffic. See Setting Default Handling for Undecryptable Traffic for more information.
 
     	 [bookmark: pgfId-3476560]You cannot match on  Distinguished Name or  Certificate conditions when creating an SSL rule with a  Decrypt - Known Key action. The assumption is that if this rule matches traffic, the certificate, subject DN, and issuer DN already match the certificate associated with the rule. For more information, see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection.
 
     	 [bookmark: pgfId-3506562]If you create an internal CA object and choose to generate a certificate signing request (CSR), you cannot use this CA for a  Decrypt - Resign action until you upload the signed certificate to the object. For more information, see Obtaining and Uploading a New Signed Certificate.
 
     	 [bookmark: pgfId-3529254]If you configure a rule with the  Decrypt - Resign action, and mismatch signature algorithm type for one or more external certificate objects or cipher suites, the policy editor displays an information icon (
 
     [image: ] ) next to the rule. If you mismatch signature algorithm type for all external certificate objects, or all cipher suites, the policy displays a warning icon ( 
     [image: ] ) next to the rule, and you cannot apply the access control policy associated with the SSL policy. For more information, see 
     Controlling Encrypted Traffic by Certificate and 
     Controlling Encrypted Traffic by Cipher Suite. 
    
 
     
     	 [bookmark: pgfId-3505682]If decrypted traffic matches an access control rule with an action of  Interactive Block or  Interactive Block with reset , the ASA FirePOWER module blocks the matching connection without interaction and the module does  not display a response page.
 
     	 [bookmark: pgfId-3505752]If you enable the  Normalize Excess Payload option in the inline normalization preprocessor, when the preprocessor normalizes decrypted traffic, it may drop a packet and replace it with a trimmed packet. This does not end the SSL session. If the traffic is allowed, the trimmed packet is encrypted as part of the SSL session. For more information on this option, see Normalizing Inline Traffic.
 
     	 [bookmark: pgfId-3546857]If your browser uses certificate pinning to verify a server certificate, you cannot decrypt this traffic by re-signing the server certificate. If you want to allow this traffic, configure an SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name.
 
    
 
   
 
    
     [bookmark: pgfId-3405297][bookmark: 77107][bookmark: 27732]Managing SSL Rules in a Policy
 
    [bookmark: pgfId-3405377]License: Any
 
    [bookmark: pgfId-3497446]The Rules tab of the SSL policy editor, shown in the following graphic, allows you to add, edit, search, move, enable, disable, delete, and otherwise manage SSL rules within your policy. 
 
    [bookmark: pgfId-3561221]
 
     
     [image: ] 
    
 
     
      [bookmark: pgfId-3516780]
 
     [bookmark: pgfId-3516706]For each rule, the policy editor displays its name, a summary of its conditions, and the rule action. Icons represent warnings, errors, and other important information. Disabled rules are grayed out and marked (disabled) beneath the rule name. See Troubleshooting SSL Rules for more information about the icons. 
 
     [bookmark: pgfId-3487511]For information on managing SSL rules, see:
 
      
      	 [bookmark: pgfId-3486257]Searching SSL Rules
 
      	 [bookmark: pgfId-3486265]Enabling and Disabling SSL Rules
 
      	 [bookmark: pgfId-3486269]Changing an SSL Rule’s Position or Category
 
     
 
    
 
     
      [bookmark: pgfId-3475101][bookmark: 70646]Searc[bookmark: marker-3475100]hing SSL Rules
 
     [bookmark: pgfId-3511947]License: Any
 
     [bookmark: pgfId-3432307]You can search the list of SSL rules for matching values using an alphanumeric string, including spaces and printable, special characters. The search inspects the rule name and any rule condition you have added to the rule. For rule conditions, the search matches any name or value you can add for each condition type (zone, network, application, and so on). This includes individual object names or values, group object names, individual object names or values within a group, and literal values.
 
     [bookmark: pgfId-3432308]You can use complete or partial search strings. The column for matching values is highlighted for each matching rule. For example, if you search on all or part of the string 100Bao, at a minimum, the Applications column is highlighted for each rule where you have added the 100Bao application. If you also have a rule named 100Bao, both the Name and Applications columns are highlighted.
 
     [bookmark: pgfId-3432309]You can navigate to each previous or next matching rule. A status message displays the current match and the total number of matches.
 
     [bookmark: pgfId-3432310]Matches may occur on any page of a multi-page rule list. When the first match is not on the first page, the page where the first match occurs is displayed. Selecting the next match when you are at the last match takes you to the first match, and selecting the previous match when you are at the first match takes you to the last match.
 
     [bookmark: pgfId-3486503]To search for rules:
 
     
 
     [bookmark: pgfId-3486508]Step 1 In the SSL policy editor for the policy you want to search, click the Search Rules prompt, type a search string, then press Enter. You can also use the Tab key or click a blank page area to initiate the search.
 
     [bookmark: pgfId-3486509]Columns for rules with matching values are highlighted, with differentiated highlighting for the indicated (first) match.
 
     [bookmark: pgfId-3486510]Step 2 Find the rules you are interested in:
 
      
       
       	 [bookmark: pgfId-3486517]To navigate between matching rules, click the next-match (
 
      
 
      [image: ] ) or previous-match ( 
      [image: ] ) icon. 
     
 
      
       
       	 [bookmark: pgfId-3486521]To refresh the page and clear the search string and any highlighting, click the clear icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-3486522]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3441778][bookmark: 98504]Enabling and Disabling SSL Rules
 
     [bookmark: pgfId-3536537]License: Any
 
     [bookmark: pgfId-3486678]When you create an SSL rule, it is enabled by default. If you disable a rule, the ASA FirePOWER module does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in an SSL policy, disabled rules are grayed out, although you can still modify them. Note that you can also enable or disable an SSL rule using the rule editor; see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3486682]To change an SSL rule’s state:
 
     
 
     [bookmark: pgfId-3486789]Step 1 In the SSL policy editor for the policy that contains the rule you want to enable or disable, right-click the rule and choose a rule state:
 
      
       
       	 [bookmark: pgfId-3486688]To enable an inactive rule, select  State > Enable . 
 
       	 [bookmark: pgfId-3486689]To disable an active rule ,  State > Disable .
 
      
 
     
 
     [bookmark: pgfId-3486690]Step 2 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3511158]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3486774]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3486777][bookmark: 87369]Changing an SSL Rule’s [bookmark: marker-3486776]Position or Category
 
     [bookmark: pgfId-3536583]License: Any
 
     [bookmark: pgfId-3536557]To help you organize SSL rules, every SSL policy has three ASA FirePOWER module-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories.
 
     [bookmark: pgfId-3486848]For more information, see: 
 
      
      	 [bookmark: pgfId-3486852]Moving an SSL Rule
 
      	 [bookmark: pgfId-3486856]Adding a New SSL Rule Category
 
     
 
    
 
     
      [bookmark: pgfId-3442113][bookmark: 28954]Moving an SSL Rule
 
     [bookmark: pgfId-3536610]License: Any
 
     [bookmark: pgfId-3486940]Proper SSL rule order reduces the resources required to process network traffic, and prevents rule preemption.
 
     [bookmark: pgfId-3486941]The following procedure explains how to move one or more rules at a time using the SSL policy editor. You can also move individual SSL rules using the rule editor; see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3486945]To move a rule:
 
     
 
     [bookmark: pgfId-3486950]Step 1 In the SSL policy editor for the policy that contains the rules you want to move, select the rules by clicking in a blank area for each rule. Use the Ctrl and Shift keys to select multiple rules.
 
     [bookmark: pgfId-3486951]The rules you selected are highlighted.
 
     [bookmark: pgfId-3486952]Step 2 Move the rules. You can cut and paste or drag and drop.
 
     [bookmark: pgfId-3486953]To cut and paste rules into a new location, right-click a selected rule and select Cut. Then, right-click a blank area for a rule next to where you want to paste the cut rules and select Paste above or Paste below. Note that you cannot copy and paste SSL rules between two different SSL policies.
 
     [bookmark: pgfId-3486954]Step 3 Click Store ASA FirePOWER Changes..
 
     [bookmark: pgfId-3511180]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3486959]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3487123][bookmark: 59239]Adding a New SSL Rule Category
 
     [bookmark: pgfId-3536637]License: Any
 
     [bookmark: pgfId-3487161]To help you organize SSL rules, every SSL policy has three ASA FirePOWER module-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories between the Standard Rules and Root Rules. 
 
     [bookmark: pgfId-3487162]Adding custom categories allows you to further organize your rules without having to create additional policies. You can rename and delete categories that you add. You cannot move these categories, but you can move rules into, within, and out of them.
 
     [bookmark: pgfId-3487164]To add a new category:
 
     
 
     [bookmark: pgfId-3487169]Step 1 In the SSL policy editor for the policy where you want to add a rule category, click Add Category.
 
      
       
     
 
     
 
     [bookmark: pgfId-3487170]Tip If your policy already contains rules, you can click a blank area in the row for an existing rule to set the position of the new category before you add it. You can also right-click an existing rule and select Insert new category.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3487171]The Add Category pop-up window appears.
 
     [bookmark: pgfId-3487172]Step 2 Type a unique category Name.
 
     [bookmark: pgfId-3487173]You can enter an alphanumeric name, including spaces and special printable characters, with up to 30 characters.
 
     [bookmark: pgfId-3487174]Step 3 You have the following choices:
 
      
       
       	 [bookmark: pgfId-3487175]To position the new category immediately above an existing category, select  above Category from the first  Insert drop-down list, then select the category above which you want to position the rule from the second drop-down list.
 
       	 [bookmark: pgfId-3487176]To position the new category rule below an existing rule, select  below rule from the drop-down list, then enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
       	 [bookmark: pgfId-3487177]To position the rule above an existing rule, select  above rule from the drop-down list, then, enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
      
 
     
 
     [bookmark: pgfId-3487178]Step 4 Click OK.
 ) to delete the category. Rules in a category you delete are added to the category above. 
     
 
     [bookmark: pgfId-3487186]Step 5 Click Store ASA FirePOWER Changes to save the policy.
 
     [bookmark: pgfId-3487187]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3442290][bookmark: 33868]Troubleshooting SSL Rules
 
     [bookmark: pgfId-3512027]License: Any
 
     [bookmark: pgfId-3551230]Properly creating and ordering SSL rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the ASA FirePOWER module handles traffic as you expect, the SSL policy interface has a robust warning and error feedback system for rules. 
 
      
      
 
      
 
      
 
       
        
        [bookmark: pgfId-3491103]Table 14-2 SSL Error Icons 
 
        
        
         
         	 
           
           [bookmark: pgfId-3491109]Icon 
          
  
         	 
           
           [bookmark: pgfId-3491111]Description 
          
  
         	 
           
           [bookmark: pgfId-3491113]Details 
          
  
        
 
        
           
         	[bookmark: pgfId-3491120]warning
  
         	[bookmark: pgfId-3491122]Depending on the issue, you may be able to apply an SSL policy that displays rule or other warnings. In these cases, the misconfigured settings will have no effect. For example, a preempted rule never evaluates traffic. However, if a warning icon marks a licensing error or model mismatch, you cannot apply the policy until you correct the issue.
 [bookmark: pgfId-3491123]If you disable a rule with a warning, the warning icon disappears. It reappears if you enable the rule without correcting the underlying issue.
  
        
 
        
           
         	[bookmark: pgfId-3491130]error
  
         	[bookmark: pgfId-3491132]If a rule or other SSL policy configuration has an error, you cannot apply the policy until you correct the issue.
  
        
 
        
           
         	[bookmark: pgfId-3491139]information
  
         	[bookmark: pgfId-3491141]Information icons convey helpful information about configurations that may affect the flow of traffic. These issues are minor and will not prevent you from applying the policy.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3491150]Properly configuring SSL rules can also reduce the resources required to process network traffic. Creating complex rules and mis-ordering rules can affect performance.
 
     [bookmark: pgfId-3491151]For more information, see:
 
      
      	 [bookmark: pgfId-3515709]Understanding Rule Preemption and Invalid Configuration Warnings
 
      	 [bookmark: pgfId-3515714]Ordering SSL Rules to Improve Performance and Avoid Preemption
 
     
 
    
 
     
      [bookmark: pgfId-3497435][bookmark: 19894]Understanding Rule Preemption and Invalid Configuration Warnings
 
     [bookmark: pgfId-3540605]License: Any
 
     [bookmark: pgfId-3491914]Properly configuring and ordering SSL rules is essential to building an effective deployment. Within an SSL policy, SSL rules can preempt other rules or contain invalid configurations. The module uses warning and error icons to mark these issues.
 
     [bookmark: pgfId-3491915]Understanding Rule Preemption Warnings
 
     [bookmark: pgfId-3491916]The conditions of an SSL rule may preempt a subsequent rule from matching traffic. For example:
 
      
      [bookmark: pgfId-3491917]Rule 1: do not decrypt Administrators 
     
 
      
      [bookmark: pgfId-3491918]Rule 2: block Administrators 
     
 
     [bookmark: pgfId-3491919]The second rule above will never block traffic because the first rule will have already allowed the traffic.
 
     [bookmark: pgfId-3491932]Understanding Invalid Configuration Warnings
 
     [bookmark: pgfId-3491933]Because outside settings that the SSL policy depends on may change, an SSL policy setting that was valid may become invalid. Consider the following examples:
 
      
      	 [bookmark: pgfId-3526801]A rule that contains a URL category condition might be valid until you target a module that does not have a URL Filtering license. At that point, an error icon appears next to the rule, and you cannot apply the policy to that device until you edit or delete the rule, retarget the policy, or enable the appropriate license. 
 
      	 [bookmark: pgfId-3526805]If you create a Decrypt-Resign rule, and later add a security zone with passive interfaces to a zone condition, the module displays a warning icon next to the rule. Because you cannot decrypt traffic by re-signing a certificate in a passive deployment, the rule has no effect until you remove the passive interfaces from the rule or change the rule action.
 
      	 [bookmark: pgfId-3491939]If you add a user to a rule, then change your LDAP user awareness settings to exclude that user, the rule will have no effect because the user is no longer an access-controlled user. 
 
     
 
    
 
     
      [bookmark: pgfId-3442398][bookmark: 60943]Ordering SSL Rules to Improve Performance and Avoid Preemption
 
     [bookmark: pgfId-3540624]License: Any
 
     [bookmark: pgfId-3492884]Rules in an SSL policy are numbered, starting at 1. The ASA FirePOWER module matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
     [bookmark: pgfId-3492885]Proper SSL rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs.
 
     [bookmark: pgfId-3492886]Order Rules from Most to Least Critical
 
     [bookmark: pgfId-3492887]First, you must order rules to suit your organization's needs. Place priority rules that must apply to all traffic near the top of the policy. For example, if you want to decrypt outgoing traffic from a single user for further analysis (using a Decrypt-Resign rule), but not decrypt traffic from all other users in the department (using a Do not decrypt rule), place two SSL rules in that order.
 
     [bookmark: pgfId-3492888]Order Rules from Specific to General
 
     [bookmark: pgfId-3492889]You can improve performance by placing specific rules earlier, that is, rules that narrowly define the traffic they handle. This is also important because rules with broad conditions can match many different types of traffic, and can preempt later, more specific rules.
 
     [bookmark: pgfId-3492890]Consider a scenario where a trusted CA (Good CA) mistakenly issued a CA certificate to a malicious entity (Bad CA), but has not yet revoked that certificate. You want to block traffic encrypted with certificates issued by the untrusted CA, but otherwise allow traffic within the trusted CA’s chain of trust. You should upload the CA certificates and all intermediate CA certificates, then order your rules as follows:
 
      
      [bookmark: pgfId-3496095]Rule 1: Block issuer CN=www.badca.com 
     
 
      
      [bookmark: pgfId-3496096]Rule 2: Do not decrypt issuer CN=www.goodca.com 
     
 
     [bookmark: pgfId-3496291]If you reverse the rules:
 
      
      [bookmark: pgfId-3496318]Rule 1: Do not decrypt issuer CN=www.goodca.com 
     
 
      
      [bookmark: pgfId-3496326]Rule 2: Block issuer CN=www.badca.com 
     
 
     [bookmark: pgfId-3496320]the first rule matches all traffic trusted by Good CA, including traffic trusted by Bad CA. Because no traffic ever matches the second rule, malicious traffic may be allowed instead of blocked.
 
     [bookmark: pgfId-3546810]Order Rules to Allow Traffic from Certificate Pinned Sites
 
     [bookmark: pgfId-3546821]Certificate pinning forces a client's browser to verify that a server's public key certificate matches a certificate the browser already associated with the server before establishing an SSL session. Because the Decrypt - Resign action involves modifying a server certificate before passing it to the client, these modified certificates are rejected if the browser already pinned that certificate. 
 
     [bookmark: pgfId-3546823]For example, if a client browser connects to windowsupdate.microsoft.com, a site that uses certificate pinning, and you configure an SSL rule that matches that traffic with a Decrypt - Resign action, the ASA FirePOWER module re-signs the server certificate before passing it to the client browser. Because this modified server certificate does not match the browser's pinned certificate for windowsupdate.microsoft.com, the client browser rejects the connection. 
 
     [bookmark: pgfId-3546849]If you want to allow this traffic, configure an SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name. In the SSL policy, order this rule before all Decrypt - Resign rules that also match the traffic. You can retrieve the pinned certificate from the client's browser after a successful connection to the website. You can also view the certificate from the logged connection event, whether the connection succeeded or failed. 
 
     [bookmark: pgfId-3546850]Place Rules that Decrypt Traffic Later
 
     [bookmark: pgfId-3546812]Because traffic decryption requires processing resources, placing rules that do not decrypt traffic (Do not decrypt, Block) before rules that do (Decrypt-Known Key, Decrypt-Resign) can improve performance. This is because traffic decryption can command significant resources. In addition, Block rules can divert traffic that the ASA FirePOWER module might otherwise have decrypted or inspected. All other factors being equal, that is, given a set of rules where none is more critical and preemption is not an issue, consider placing them in the following order:
 
      
      	 [bookmark: pgfId-3492899]Monitor rules that log matching connections, but take no other action on traffic
 
      	 [bookmark: pgfId-3537888]Block rules that block traffic without further inspection
 
      	 [bookmark: pgfId-3537952]Do not decrypt rules that do not decrypt encrypted traffic
 
      	 [bookmark: pgfId-3493148]Decrypt-Known Key rules that decrypt incoming traffic with a known private key
 
      	 [bookmark: pgfId-3493243]Decrypt-Resign rules that decrypt outgoing traffic by re-signing the server certificate
 
     
 
    
 
     
      [bookmark: pgfId-3492945]Configuring SSL Inspection to Improve Performance
 
     [bookmark: pgfId-3540643]License: Any
 
     [bookmark: pgfId-3493742]Complex SSL policies and rules can command significant resources. When you apply an SSL policy, the ASA FirePOWER module evaluates all the rules together and creates an expanded set of criteria that the device uses to evaluate network traffic. A pop-up window may warn that you have exceeded the maximum number of SSL rules supported by a device. This maximum depends on a number of factors, including the physical memory and the number of processors on the device. 
 
     [bookmark: pgfId-3493743]Simplifying Rules
 
     [bookmark: pgfId-3493744]The following guidelines can help you simplify your SSL rules and improve performance:
 
      
      	 [bookmark: pgfId-3492926]When constructing a rule, use as few individual elements in your conditions as possible. For example, in network conditions, use IP address blocks rather than individual IP addresses. In port conditions, use port ranges. Use application filters and URL categories and reputations to perform application control and URL filtering, and LDAP user groups to perform user control.
 
     
 
     [bookmark: pgfId-3492927]Note that combining elements into objects that you then use in SSL rule conditions does not improve performance. For example, using a network object that contains 50 individual IP addresses gives you only an organizational—not a performance—benefit over including those IP addresses in the condition individually.
 
      
      	 [bookmark: pgfId-3492928]Restrict rules by security zones whenever possible. If a device’s interfaces are not in one of the zones in a zone-restricted rule, the rule does not affect performance on that device.
 
      	 [bookmark: pgfId-3492929]Do not overconfigure rules. If one condition is enough to match the traffic you want to handle, do not use two.
 
     
 
     [bookmark: pgfId-3493749]Configuring Traffic Decryption
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3405103][bookmark: 41231]Tuning Traffic Decryption Using SSL Rules 
      
      
 
     
 
 
    [bookmark: pgfId-3451684]A basic SSL rule applies its rule action to all encrypted traffic inspected by the ASA FirePOWER module. To better control and decrypt encrypted traffic, you can configure rule conditions to handle and log specific types of traffic. Each SSL rule can contain 0, 1, or more rule conditions; a rule only matches traffic if the traffic matches every condition in that SSL rule.
 
     
      
    
 
    
 
    [bookmark: pgfId-3507868]Note When traffic matches a rule, the ASA FirePOWER module applies the configure rule action to the traffic. When the connection ends, the module logs the traffic if configured to do so. For more information, see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection and Logging Connections Based on Access Control Handling.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3507588]Each rule condition allows you to specify one or more properties of traffic you want to match against; these properties include details of: 
 
     
     	 [bookmark: pgfId-3501774]the flow of traffic, including the security zone through which it travels, IP address and port, and country of origin or destination
 
     	 [bookmark: pgfId-3547773]the user associated with a detected IP address
 
     	 [bookmark: pgfId-3508315]the traffic payload, including the application detected in the traffic
 
     	 [bookmark: pgfId-3508524]the connection encryption, including the SSL/TLS protocol version and cipher suite and server certificate used to encrypt the connection
 
     	 [bookmark: pgfId-3547927]the category and reputation of the URL specified in the server certificate’s distinguished name
 
    
 
    [bookmark: pgfId-3407211]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3407217]Logging Decryptable Connections with SSL Rules
 
     	 [bookmark: pgfId-3411462]Controlling Encrypted Traffic with Network-Based Conditions
 
     	 [bookmark: pgfId-3407238]Controlling Encrypted Traffic by Reputation
 
     	 [bookmark: pgfId-3524411]Controlling Traffic Based on Encryption Properties
 
    
 
   
 
    
     [bookmark: pgfId-3551799][bookmark: 91788]Controlling Encrypted Traffic with [bookmark: marker-3551798]Network-Based Conditions
 
    [bookmark: pgfId-3551806]License: Any
 
    [bookmark: pgfId-3529976]SSL rules within SSL policies exert granular control over encrypted traffic logging and handling. Network-based conditions allow you to manage which encrypted traffic can traverse your network, using one or more of the following criteria:
 
     
     	 [bookmark: pgfId-3529977]source and destination security zones
 
     	 [bookmark: pgfId-3529978]source and destination IP addresses or geographical locations
 
     	 [bookmark: pgfId-3529980]source and destination port
 
    
 
    [bookmark: pgfId-3529981]You can combine network-based conditions with each other and with other types of conditions to create an SSL rule. These SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on SSL rules, see Getting Started with SSL Rules.
 
    [bookmark: pgfId-3530720]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3410211]Controlling Encrypted Traffic by Network Zone
 
     	 [bookmark: pgfId-3410225]Controlling Encrypted Traffic by Network or Geographical Location
 
     	 [bookmark: pgfId-3410245]Controlling Encrypted Traffic by Port
 
    
 
     
      [bookmark: pgfId-3405548][bookmark: 37378]Controlling Encrypted Traffic by Network Zone
 
     [bookmark: pgfId-3405756]License: Any
 
     [bookmark: pgfId-3570127]Zone conditions in SSL rules allow you to control encrypted traffic by its source and destination security zones.
 
     [bookmark: pgfId-3570128]A security zone is a grouping of one or more interfaces. An option you choose during a device’s initial setup, called its detection mode, determines how the ASA FirePOWER module initially configures the device’s interfaces, and whether those interfaces belong to a security zone.
 
     [bookmark: pgfId-3570117]As a simple example, when you register a device with an Inline detection mode, the ASA FirePOWER module creates two zones: Internal and External, and assigns the first pair of interfaces on the device to those zones. Hosts connected to the network on the Internal side represent your protected assets.
 
     [bookmark: pgfId-3526402]In this deployment, you may decide that although you want these hosts to have unrestricted access to the Internet, you nevertheless want to protect them by decrypting and inspecting incoming encrypted traffic.
 
     [bookmark: pgfId-3526403]To accomplish this with SSL inspection, configure an SSL rule with a zone condition where the Destination Zone is set to Internal. This simple SSL rule matches traffic that leaves the device from any interface in the Internal zone.
 
     [bookmark: pgfId-3526413]If you want to build a more complex rule, you can add a maximum of 50 zones to each of the Sources Zones and Destination Zones in a single zone condition:
 
      
      	 [bookmark: pgfId-3464116]To match encrypted traffic  leaving the device from an interface in the zone, add that zone to the  Destination Zones .
 
     
 
     [bookmark: pgfId-3464117]Because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a Destination Zone condition.
 
      
      	 [bookmark: pgfId-3464122]To match encrypted traffic  entering the device from an interface in the zone, add that zone to the  Source Zones .
 
     
 
     [bookmark: pgfId-3464123]If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones and egress through one of the destination zones. 
 
     [bookmark: pgfId-3464124]Note that just as all interfaces in a zone must be of the same type (all inline, all passive, all switched, or all routed), all zones used in a zone condition for an SSL rule must be of the same type. That is, you cannot write a single rule that matches encrypted traffic to or from zones of different types.
 
     [bookmark: pgfId-3464128]Warning icons indicate invalid configurations, such as zones that contain no interfaces. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3464129]To control encrypted traffic by zone:
 
     
 
     [bookmark: pgfId-3464134]Step 1 In the SSL policy where you want to control encrypted traffic by zone, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3464138]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3464139]Step 2 In the SSL rule editor, select the Zones tab.
 
     [bookmark: pgfId-3464140]The Zones tab appears.
 
     [bookmark: pgfId-3464141]Step 3 Find and select the zones you want to add from the Available Zones. 
 
     [bookmark: pgfId-3464142]To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones. 
 
     [bookmark: pgfId-3464143]Click to select a zone. To select multiple zones, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3464144]Step 4 Click Add to Source or Add to Destination to add the selected zones to the appropriate list. 
 
     [bookmark: pgfId-3464145]You can also drag and drop selected zones.
 
     [bookmark: pgfId-3464146]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-3464149]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes. 
 
     [bookmark: pgfId-3464151]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3405607][bookmark: 34365]Controlling Encrypted Traffic by Network or Geographical Location
 
     [bookmark: pgfId-3405766]License: Any
 
     [bookmark: pgfId-3464300]Network conditions in SSL rules allow you to control and decrypt encrypted traffic by its source and destination IP address. You can either:
 
      
      	 [bookmark: pgfId-3464301]explicitly specify the source and destination IP addresses for the encrypted traffic you want to control, or
 
      	 [bookmark: pgfId-3464302]use the geolocation feature, which associates IP addresses with geographical locations, to control encrypted traffic based on its source or destination country or continent
 
     
 
     [bookmark: pgfId-3464303]When you build a network-based SSL rule condition, you can manually specify IP address and geographical locations. Alternately, you can configure network conditions with network and geolocation objects, which are reusable and associate a name with one or more IP addresses, address blocks, countries, continents, and so on. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3464304]Tip After you create a network or geolocation object, you can use it not only to build SSL rules, but also to represent IP addresses in various other places in the module interface. You can create these objects using the object manager; you can also create network objects on-the-fly while you are configuring SSL rules. For more information, see Managing Reusable Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3464308]Note that if you want to write rules to control traffic by geographical location, to ensure you are using up-to-date geolocation data to filter your traffic, Cisco strongly recommends you regularly update the geolocation database (GeoDB) on your ASA FirePOWER module; see Updating the Geolocation Database. 
 
     [bookmark: pgfId-3464375]The following graphic shows the network condition for an SSL rule that blocks encrypted connections originating from your internal network and attempting to access resources either in the Cayman Islands or an offshore holding corporation server at 182.16.0.3.
 
     [bookmark: pgfId-3587677]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3491877]The example manually specifies the offshore holding corporation’s server IP address, and uses a ASA FirePOWER module-provided Cayman Islands geolocation object to represent Cayman Island IP addresses.
 
     [bookmark: pgfId-3464388]You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition, and you can mix network and geolocation-based configurations:
 
      
      	 [bookmark: pgfId-3464389]To match encrypted traffic  from an IP address or geographical location, configure the  Source Networks .
 
      	 [bookmark: pgfId-3464390]To match encrypted traffic  to an IP address or geographical location, configure the  Destination Networks .
 
     
 
     [bookmark: pgfId-3464395]If you add both source and destination network conditions to a rule, matching encrypted traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses. 
 
     [bookmark: pgfId-3464399]When building a network condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3464400]To control traffic by network or geographical location:
 
     [bookmark: pgfId-3464404]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3464405]Step 1 In the SSL policy where you want to control encrypted traffic by network, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3464409]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3464410]Step 2 In the SSL rule editor, select the Networks tab.
 
     [bookmark: pgfId-3464411]The Networks tab appears.
 
     [bookmark: pgfId-3464412]Step 3 Find and select the networks you want to add from the Available Networks, as follows:
 
      
       
       	 [bookmark: pgfId-3464413]Click the Networks tab to display network objects and groups to add; click the Geolocation tab to display geolocation objects. 
 
       	 [bookmark: pgfId-3464417]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the Available Networks list; see 
      Working with Network Objects. 
     
 
      
       
       	 [bookmark: pgfId-3464421]To search for network or geolocation objects to add, select the appropriate tab, click the  Search by name or value  prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3464422]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3464423]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
     [bookmark: pgfId-3464424]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3464425]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually.
 
     [bookmark: pgfId-3464426]Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
     [bookmark: pgfId-3464427]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3464430]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3406776]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3587704][bookmark: 48411]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-3405696][bookmark: 25656]Controlling Encrypted Traffic by Port
 
     [bookmark: pgfId-3405788]License: Any
 
     [bookmark: pgfId-3463735]Port conditions in SSL rules allow you to control encrypted traffic by its source and destination TCP port. When you build a port-based SSL rule condition, you can manually specify TCP ports. Alternately, you can configure port conditions with port objects, which are reusable and associate a name with one or more ports. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3463740]Tip After you create a port object, you can use it not only to build SSL rules, but also to represent ports in various other places in the module interface. You can create port objects either using the object manager or on-the-fly while you are configuring SSL rules. For more information, see Working with Port Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3469528]You can add a maximum of 50 items to each of the Selected Source Ports and Selected Destination Ports lists in a single network condition:
 
      
      	 [bookmark: pgfId-3463745]To match encrypted traffic  from a TCP port, configure the  Selected Source Ports .
 
      	 [bookmark: pgfId-3463747]To match encrypted traffic  to a TCP port, configure the  Selected Destination Ports .
 
      	 [bookmark: pgfId-3463749]To match encrypted traffic both originating from TCP  Selected Source Ports  and destined for TCP  Selected Destination Ports , configure both.
 
     
 
     [bookmark: pgfId-3549932]You can only configure the Selected Source Ports and Selected Destination Ports lists with TCP ports. Port objects containing non-TCP ports are greyed out in the Available Ports list.
 
     [bookmark: pgfId-3549936]When building a port condition, warning icons indicate invalid configurations. For example, you can use the object manager to edit in-use port objects so that the rules that use those object groups become invalid. For details, hover your pointer over the icon. 
 
     [bookmark: pgfId-3463759]To control traffic by port:
 
     
 
     [bookmark: pgfId-3463764]Step 1 In the SSL policy where you want to control encrypted traffic by TCP port, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3463768]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3463769]Step 2 In the SSL rule editor, select the Ports tab.
 
     [bookmark: pgfId-3463770]The Ports tab appears.
 
     [bookmark: pgfId-3463771]Step 3 Find and select the TCP ports you want to add from the Available Ports, as follows:
 
      
       
       	 [bookmark: pgfId-3463775]To add a TCP port object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the Available Ports list; see 
      Working with Port Objects. 
     
 
      
       
       	 [bookmark: pgfId-3463779]To search for TCP-based port objects and groups to add, click the  Search by name or value  prompt above the  Available Ports  list, then type either the name of the object, or the value of a port in the object. The list updates as you type to display matching objects. For example, if you type 443, the ASA FirePOWER module displays the ASA FirePOWER module-provided HTTPS port object. 
 
      
 
     
 
     [bookmark: pgfId-3463786]To select a TCP-based port object, click it. To select multiple TCP-based port objects, use the Shift and Ctrl keys, or right-click and then select Select All. If the object includes non-TCP-based ports, you cannot add it to your port condition.
 
     [bookmark: pgfId-3463787]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
     [bookmark: pgfId-3463788]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3463789]Step 5 Enter a Port under the Selected Source Ports or Selected Destination Ports list to manually specify source or destination ports. You can specify a single port with a value from 0 to 65535.
 
     [bookmark: pgfId-3465773]Step 6 Click Add. 
 
     [bookmark: pgfId-3527422]Note that the ASA FirePOWER module will not add a port to a rule condition that results in an invalid configuration.
 
     [bookmark: pgfId-3463800]Step 7 Save or continue editing the rule.
 
     [bookmark: pgfId-3509479]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3532586]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3532625][bookmark: 29657]Controlling Encrypted Traffic Based on User
 
    [bookmark: pgfId-3532632]License: Control
 
    [bookmark: pgfId-3534913]You can configure SSL rules to match traffic for users retrieved from a Microsoft Active Directory Server. User conditions in SSL rules allow you perform user control—to manage which traffic can traverse your network, by limiting traffic based on the LDAP user logged into a host. 
 
    [bookmark: pgfId-3534914]User control works by associating access controlled users with IP addresses. Deployed agents monitor specified users as they log in and out of hosts or authenticate with Active Directory credentials for other reasons. For example, your organization may use services or applications that rely on Active Directory for centralized authentication.
 
    [bookmark: pgfId-3534915]For traffic to match an SSL rule with a user condition, the IP address of either the source or destination host in the monitored session must be associated with a logged in access controlled user. You can control traffic based on individual users or the groups those users belong to.
 
    [bookmark: pgfId-3532648]You can combine user conditions with each other and with other types of conditions to create an SSL rule. These SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on SSL rules, see Understanding and Creating SSL Rules.
 
    [bookmark: pgfId-3535025]User control requires a Control license and is supported only for LDAP users and groups (access controlled users), using login and logoff records reported by a User Agent monitoring Microsoft Active Directory servers. 
 
    [bookmark: pgfId-3535288]Before you can write SSL rules with user conditions, you must configure a connection between the ASA FirePOWER module and at least one of your organization’s Microsoft Active Directory servers. This configuration, called an authentication object, contains connection settings and authentication filter settings for the server. It also specifies the users you can use in user conditions.
 
    [bookmark: pgfId-3535295]In addition, you must install User Agents. The agents monitor users when they authenticate against Active Directory credentials, and send records of those logins to the ASA FirePOWER module. These records associate users with IP addresses, which is what allows SSL rules with user conditions to trigger.
 
    [bookmark: pgfId-3532663]To control encrypted traffic by user:
 
    
 
    [bookmark: pgfId-3532668]Step 1 In the SSL policy where you want to control encrypted traffic by user, create a new SSL rule or edit an existing rule.
 
    [bookmark: pgfId-3532672]For detailed instructions, see Understanding and Creating SSL Rules.
 
    [bookmark: pgfId-3532673]Step 2 In the SSL rule editor, select the Users tab.
 
    [bookmark: pgfId-3532674]The Users tab appears.
 
    [bookmark: pgfId-3532675]Step 3 To search for users to add, click the Search by name or value prompt above the Available Users list, then type the username. The list updates as you type to display matching users.
 
    [bookmark: pgfId-3532676]To select a user, click it. To select multiple users, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-3532677]Step 4 Click Add to Rule or to add the selected users to the Selected Users list. 
 
    [bookmark: pgfId-3532678]You can also drag and drop selected users.
 
    [bookmark: pgfId-3532679]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-3532680]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-3532684]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3532589][bookmark: 48838]Controlling Encrypted Traffic by Reputation[bookmark: marker-3532588]
 
    [bookmark: pgfId-3532599]License: Control or URL Filtering
 
    [bookmark: pgfId-3530776]Reputation-based conditions in SSL rules allow you to manage which encrypted traffic can traverse your network, by contextualizing your network traffic and limiting it where appropriate. SSL rules govern the following types of reputation-based control:
 
     
     	 [bookmark: pgfId-3530777]Application conditions allow you to perform  application control , which controls application traffic based on not only individual applications, but also applications’ basic characteristics: type, risk, business relevance, and categories.
 
     	 [bookmark: pgfId-3530778]URL conditions allow you to control web traffic based on a websites’ assigned category and reputation.
 
    
 
    [bookmark: pgfId-3530779]You can combine reputation-based conditions with each other and with other types of conditions to create an SSL rule. These SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions. 
 
    [bookmark: pgfId-3405524]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3410382]Controlling Encrypted Traffic Based on Application
 
     	 [bookmark: pgfId-3410385]Controlling Encrypted Traffic by URL Category and Reputation
 
    
 
     
      [bookmark: pgfId-3405841][bookmark: 86203]Controlling Encrypted Traffic Based on Application
 
     [bookmark: pgfId-3405957]License: Control
 
     [bookmark: pgfId-3469739]When the FireSIGHT System analyzes encrypted IP traffic, it can identify and classify commonly used encrypted applications on your network prior to decrypting the encrypted session. The ASA FirePOWER module uses this discovery-based application awareness feature to allow you to control encrypted application traffic on your network. 
 
     [bookmark: pgfId-3469740]Application conditions in SSL rules allow you to perform this application control. Within a single SSL rule, there are a few ways you can specify applications whose traffic you want to control:
 
      
      	 [bookmark: pgfId-3469741]You can select individual applications, including custom applications.
 
      	 [bookmark: pgfId-3469745]You can use ASA FirePOWER module-provided  application filters , which are named sets of applications organized according to its basic characteristics: type, risk, business relevance, and categories.
 
      	 [bookmark: pgfId-3469746]You can create and use custom application filters, which group applications (including custom applications) in any way you choose.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3557791]Note When you filter application traffic using access control rules, you can use application tags as a criterion. to filter. However, you cannot use application tags to filter encrypted traffic because there is no benefit. All applications that the ASA FirePOWER module can detect in encrypted traffic are tagged SSL Protocol; applications without this tag can only be detected in unencrypted or decrypted traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3557795]Application filters allow you to quickly create application conditions for SSL rules. They simplify policy creation and administration, and grant you assurance that the module will control web traffic as expected. For example, you could create an SSL rule that identifies and decrypts all high risk, low business relevance applications in encrypted traffic. If a user attempts to use one of those applications, the session is decrypted and inspected with access control.
 
     [bookmark: pgfId-3469751]In addition, Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. You can also create your own detectors and assign characteristics (risk, relevance, and so on) to the applications they detect. By using filters based on application characteristics, you can ensure that the module uses the most up-to-date detectors to monitor application traffic.
 
     [bookmark: pgfId-3469752]For traffic to match an SSL rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list.
 
     [bookmark: pgfId-3533689]The following graphic shows the application condition for an SSL rule that decrypts a custom group of applications for MyCompany, all applications with high risk and low business relevance, gaming applications, and some individually selected applications.
 
     [bookmark: pgfId-3587873]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3469896]In a single application condition, you can add a maximum of 50 items to the Selected Applications and Filters list. Each of the following counts as an item:
 
      
      	 [bookmark: pgfId-3469897]One or more filters from the  Application Filters list, individually or in custom combination. This item represents set of applications, grouped by characteristic.
 
      	 [bookmark: pgfId-3469898]A filter created by saving search of the applications in the  Available Applications list. This item represents a set of applications, grouped by substring match.
 
      	 [bookmark: pgfId-3469899]An individual application from the  Available Applications list.
 
     
 
     [bookmark: pgfId-3469900]In the module interface, filters added to a condition are listed above and separately from individually added applications.
 
     [bookmark: pgfId-3469901]Note that when you apply an SSL policy, for each rule with an application condition, the ASA FirePOWER module generates a list of unique applications to match. In other words, you may use overlapping filters and individually specified applications to ensure complete coverage.
 
     [bookmark: pgfId-3527845]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-3527895]Matching Encrypted Traffic with Application Filters
 
      	 [bookmark: pgfId-3527974]Matching Traffic from Individual Applications
 
      	 [bookmark: pgfId-3527986]Adding an Application Condition to an SSL Rule
 
      	 [bookmark: pgfId-3528157]Limitations to Encrypted Application Control
 
     
 
    
 
     
      [bookmark: pgfId-3469992][bookmark: 30464]Matching Encrypted Traffic with Application Filters
 
     [bookmark: pgfId-3504041]License: Control
 
     [bookmark: pgfId-3470013]When building an application condition in an SSL rule, use the Application Filters list to create a set of applications, grouped by characteristic, whose traffic you want to match. 
 
     [bookmark: pgfId-3470014]For your convenience, the ASA FirePOWER module characterizes each application that it detects using a specified criteria. You can use these criteria as filters or create custom combinations of filters to perform application control. 
 
     [bookmark: pgfId-3546083]Note that the mechanism for filtering applications within an SSL rule is the same as that for creating reusable, custom application filters using the object manager; see Working with Application Filters. You can also save many filters you create on-the-fly in access control rules as new, reusable filters. You cannot save a filter that includes another user-created filter because you cannot nest user-created filters.
 
     [bookmark: pgfId-3470070]Understanding How Filters Are Combined
 
     [bookmark: pgfId-3470071]When you select filters, singly or in combination, the Available Applications list updates to display only the applications that meet your criteria. You can select ASA FirePOWER module-provided filters in combination, but not custom filters.
 
     [bookmark: pgfId-3470075]The module links multiple filters of the same filter type with an OR operation. For example, if you select the Medium and High filters under the Risks type, the resulting filter is:
 
      
      [bookmark: pgfId-3470076]Risk: Medium OR High 
     
 
     [bookmark: pgfId-3470077]If the Medium filter contained 110 applications and the High filter contained 82 applications, the module displays all 192 applications in the Available Applications list.
 
     [bookmark: pgfId-3470078]The module links different types of filters with an AND operation. For example, if you select the Medium and High filters under the Risks type, and the Medium and High filters under the Business Relevance type, the resulting filter is:
 
      
      [bookmark: pgfId-3470079]Risk: Medium OR High
AND
Business Relevance: Medium OR High 
     
 
     [bookmark: pgfId-3470080]In this case, the module displays only those applications that are included in both the Medium or High Risk type AND the Medium or High Business Relevance type.
 
     [bookmark: pgfId-3470081]Finding and Selecting Filters
 
     [bookmark: pgfId-3470082]To select filters, click the arrow next to a filter type to expand it, then select or clear the check box next to each filter whose applications you want to display or hide. You can also right-click a Cisco-provided filter type (Risks, Business Relevance, Types, or Categories) and select Check All or Uncheck All.
 
     [bookmark: pgfId-3470086]To search for filters, click the Search by name prompt above the Available Filters list, then type a name. The list updates as you type to display matching filters.
 
     [bookmark: pgfId-3470087]After you are done selecting filters, use the Available Applications list to add those filters to the rule; see Matching Traffic from Individual Applications.
 
    
 
     
      [bookmark: pgfId-3470092][bookmark: 60208]Matching Traffic from Individual Applications
 
     [bookmark: pgfId-3504077]License: Control
 
     [bookmark: pgfId-3470113]When building an application condition in an SSL rule, use the Available Applications list to select the applications whose traffic you want to match. 
 
     [bookmark: pgfId-3470114]Browsing the List of Applications
 
     [bookmark: pgfId-3470115]When you first start to build the condition the list is unconstrained, and displays every application the module detects, 100 at a time:
 
      
      	 [bookmark: pgfId-3470116]To page through the applications, click the arrows underneath the list. 
 
      	 [bookmark: pgfId-3470117]To display a pop-up window with summary information about the application’s characteristics, as well as Internet search links that you can follow, click the information icon (
 
      [image: ] ) next to an application. 
     
 
     [bookmark: pgfId-3470122][bookmark: 42058]Finding Applications to Match
 
     [bookmark: pgfId-3470123]To help you find the applications you want to match, you can constrain the Available Applications list in the following ways:
 
      
      	 [bookmark: pgfId-3470124]To search for applications, click the  Search by name prompt above the list, then type a name. The list updates as you type to display matching applications.
 
      	 [bookmark: pgfId-3470127]To constrain the applications by applying a filter, use the  Application Filters list (see Matching Encrypted Traffic with Application Filters). The  Available Applications list updates as you apply filters.
 
     
 
     [bookmark: pgfId-3470129]Once constrained, an All apps matching the filter option appears at the top of the Available Applications list. This option allows you to add all the applications in the constrained list to the Selected Applications and Filters list, all at once.
 
      
       
     
 
     
 
     [bookmark: pgfId-3470130]Note If you select one or more filters in the Application Filters list and also search the Available Applications list, your selections and the search-filtered Available Applications list are combined using an AND operation. That is, the All apps matching the filter condition includes all the individual conditions currently displayed in the Available Applications list as well as the search string entered above the Available Applications list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470131]Selecting Single Applications to Match in a Condition
 
     [bookmark: pgfId-3470132]After you find an application you want to match, click to select it. To select multiple applications, use the Shift and Ctrl keys, or right-click and select Select All to select all applications in the current constrained view.
 
     [bookmark: pgfId-3470133]In a single application condition, you can match a maximum of 50 applications by selecting them individually; to add more than 50 you must either create multiple SSL rules or use filters to group applications.
 
     [bookmark: pgfId-3470134]Selecting All Applications Matching a Filter for a Condition
 
     [bookmark: pgfId-3470135]Once constrained by either searching or using the filters in the Application Filters list, the All apps matching the filter option appears at the top of the Available Applications list.
 
     [bookmark: pgfId-3470136]This option allows you to add the entire set of applications in the constrained Available Applications list to the Selected Applications and Filters list, at once. In contrast to adding applications individually, adding this set of applications counts as only one item against the maximum of 50, regardless of the number of individual application that comprise it.
 
     [bookmark: pgfId-3470137]When you build an application condition this way, the name of the filter you add to the Selected Applications and Filters list is a concatenation of the filter types represented in the filter plus the names of up to three filters for each type. More than three filters of the same type are followed by an ellipsis (...). For example, the following filter name includes two filters under the Risks type and four under Business Relevance:
 
      
      [bookmark: pgfId-3470138]Risks: Medium, High Business Relevance: Low, Medium, High,... 
     
 
     [bookmark: pgfId-3470139]Filter types that are not represented in a filter you add with All apps matching the filter are not included in the name of the filter you add. The instructional text that is displayed when you hover your pointer over the filter name in the Selected Applications and Filters list indicates that these filter types are set to any; that is, these filter types do not constrain the filter, so any value is allowed for these.
 
     [bookmark: pgfId-3546147]You can add multiple instances of All apps matching the filter to an application condition, with each instance counting as a separate item in the Selected Applications and Filters list. For example, you could add all high risk applications as one item, clear your selections, then add all low business relevance applications as another item. This application condition matches applications that are high risk OR have low business relevance.
 
    
 
     
      [bookmark: pgfId-3470142][bookmark: 67401]Adding an Application Condition to an SSL Rule
 
     [bookmark: pgfId-3504144]License: Control
 
     [bookmark: pgfId-3470163]For encrypted traffic to match an SSL rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list. 
 
     [bookmark: pgfId-3470164]You can add a maximum of 50 items per condition, and filters added to a condition are listed above and separately from individually added applications. When building an application condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3470168]To control encrypted application traffic:
 
     
 
     [bookmark: pgfId-3470173]Step 1 In the SSL policy where you want to control traffic by application, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3470174]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3470175]Step 2 In the SSL rule editor, select the Applications tab.
 
     [bookmark: pgfId-3470176]The Applications tab appears.
 
     [bookmark: pgfId-3470177]Step 3 Optionally, use filters to constrain the list of applications displayed in the Available Applications list.
 
     [bookmark: pgfId-3470180]Select one or more filters in the Application Filters list. For more information, see Matching Encrypted Traffic with Application Filters.
 
     [bookmark: pgfId-3470182]Step 4 Find and select the applications you want to add from the Available Applications list.
 
     [bookmark: pgfId-3470183]You can search for and select individual applications, or, when the list is constrained, All apps matching the filter. For more information, see Matching Traffic from Individual Applications.
 
     [bookmark: pgfId-3470187]Step 5 Click Add to Rule to add the selected applications to the Selected Applications and Filters list. 
 
     [bookmark: pgfId-3470188]You can also drag and drop selected applications and filters. Filters appear under the heading Filters, and applications appear under the heading Applications.
 
      
       
     
 
     
 
     [bookmark: pgfId-3470189]Tip Before you add another filter to this application condition, click Clear All Filters to clear your existing selections.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470198]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3509634]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3470200]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3470359][bookmark: 26373]Limitations to Encrypted Application Control
 
     [bookmark: pgfId-3504180]License: Control
 
     [bookmark: pgfId-3470380]Keep the following points in mind when performing application control.
 
     [bookmark: pgfId-3470381]Encrypted Application Identification
 
     [bookmark: pgfId-3504257]The ASA FirePOWER module can identify unencrypted applications that become encrypted using StartTLS. This includes such applications as SMTPS, POPS, FTPS, TelnetS, and IMAPS. In addition, it can identify certain encrypted applications based on the Server Name Indication in the TLS client hello message, or the server certificate subject distinguished name value.
 
     [bookmark: pgfId-3504205]Speed of Application Identification
 
     [bookmark: pgfId-3470382]The ASA FirePOWER module cannot perform application control on encrypted traffic before:
 
      
      	 [bookmark: pgfId-3470383]an encrypted connection is established between a client and server, and 
 
      	 [bookmark: pgfId-3470384]the module identifies the application in the encrypted session
 
     
 ). 
     
 
     [bookmark: pgfId-3470387]After the module completes its identification, it applies the SSL rule action to the remaining session traffic that matches its application condition.
 
    
 
     
      [bookmark: pgfId-3405889][bookmark: 23330]Controlling Encrypted Traffic by URL Category and Reputation
 
     [bookmark: pgfId-3405974]License: URL Filtering
 
     [bookmark: pgfId-3470488]URL conditions in SSL rules allow you to handle and decrypt encrypted website traffic that users on your network can access. The module detects the requested URL based on information passed during the SSL handshake. With a URL Filtering license, you can control access to websites based on the URL’s general classification, or category, and risk level, or reputation.
 
      
       
     
 
     
 
     [bookmark: pgfId-3550020]Note You can handle and decrypt traffic to specific URLs by defining a distinguished name SSL rule condition. The common name attribute in a certificate’s subject distinguished name contains the site’s URL. For more information, see Controlling Encrypted Traffic by Certificate Distinguished Name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3488358]For more information, see:
 
      
      	 [bookmark: pgfId-3470557]Performing Reputation-Based URL Blocking
 
      	 [bookmark: pgfId-3470560]Limitations on URL Detection and Blocking
 
     
 
    
 
     
      [bookmark: pgfId-3470563][bookmark: 91509]Performing Reputation-Based URL Blocking
 
     [bookmark: pgfId-3504750]License: URL Filtering
 
     [bookmark: pgfId-3470591]With a URL Filtering license, you can control your users’ access to websites based on the category and reputation of requested URLs:
 
      
      	 [bookmark: pgfId-3470592]The URL  category is a general classification for the URL. For example, ebay.com belongs to the  Auctions category, and monster.com belongs to the  Job Search category. A URL can belong to more than one category.
 
      	 [bookmark: pgfId-3470593]The URL  reputation represents how likely the URL is to be used for purposes that might be against your organization’s security policy. A URL’s risk can range from  High Risk (level 1) to  Well Known (level 5).
 
     
 
     [bookmark: pgfId-3470600]URL categories and reputations, which the FireSIGHT System obtains from the Cisco cloud, allow you to quickly create URL conditions for SSL rules. For example, you could create an SSL rule that identifies and blocks all High risk URLs in the Abused Drugs category. If a user attempts to browse to any URL with that category and reputation combination over an encrypted connection, the session is blocked.
 
      
       
     
 
     
 
     [bookmark: pgfId-3470601]Note Before SSL rules with category and reputation-based URL conditions can take effect, you must enable communications with the Cisco cloud. This allows the ASA FirePOWER module to retrieve URL data. For more information, see Enabling Cloud Communications.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470614]Using category and reputation data from the Cisco cloud simplifies policy creation and administration. It grants you assurance that the module controls encrypted web traffic as expected. Finally, because the cloud is continually updated with new URLs, as well as new categories and risks for existing URLs, you can ensure that the module uses up-to-date information to filter requested URLs. Malicious sites that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies.
 
     [bookmark: pgfId-3470615]For example:
 
      
      	 [bookmark: pgfId-3470616]If a rule blocks all gaming sites, as new domains get registered and classified as  Gaming , the module can block those sites automatically.
 
      	 [bookmark: pgfId-3470617]If a rule blocks all malware, and a blog page gets infected with malware, the cloud can recategorize the URL from  Blog to  Malware and the module can block that site.
 
      	 [bookmark: pgfId-3470618]If a rule blocks high-risk social networking sites, and somebody posts a link on their profile page that contains links to malicious payloads, the cloud can change the reputation of that page from  Benign sites to  High risk so the module can block it.
 
     
 
     [bookmark: pgfId-3547635]Note that if the cloud does not know the category or reputation of a URL, or if the ASA FirePOWER module cannot contact the cloud, that URL does not trigger SSL rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
 
     [bookmark: pgfId-3547636]The following graphic shows the URL condition for an access control rule that blocks: all malware sites, all high-risk sites, and all non-benign social networking sites.
 
     [bookmark: pgfId-3587981]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3473036]Tip If you decrypt traffic, then block it with access control, you can give users a chance to bypass the block by clicking through a warning page. See Interactive Blocking Actions: Allowing Users to Bypass Website Blocks for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3473001]You can add a maximum of 50 Selected Categories to match in a single URL condition. Each URL category, optionally qualified by reputation, counts as a single item.
 
     [bookmark: pgfId-3547302]The following table summarizes how you build the condition shown above. Note that you cannot qualify a literal URL or URL object with a reputation.
 
     [bookmark: pgfId-3547343]
 
      
       
        
        [bookmark: pgfId-3547308]Table 15-1 Example: Building A URL Condition 
 
        
        
         
         	 
           
           [bookmark: pgfId-3547314]To block... 
          
  
         	 
           
           [bookmark: pgfId-3547316]Select this Category or URL Object... 
          
  
         	 
           
           [bookmark: pgfId-3547318]And this Reputation... 
          
  
        
 
         
         	[bookmark: pgfId-3547320]malware sites, regardless of reputation
  
         	[bookmark: pgfId-3547322]Malware Sites
  
         	[bookmark: pgfId-3547324]Any
  
        
 
         
         	[bookmark: pgfId-3547326]any URL with a high risk (level 1)
  
         	[bookmark: pgfId-3547328]Any
  
         	[bookmark: pgfId-3547330]1 - High Risk
  
        
 
         
         	[bookmark: pgfId-3547332]social networking sites with a risk greater than benign (levels 1 through 3)
  
         	[bookmark: pgfId-3547334]Social Network
  
         	[bookmark: pgfId-3547336]3 - Benign sites with security risks
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3547344]When building a URL condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-3470677]To control traffic by requested URL using category and reputation data:
 
     
 
     [bookmark: pgfId-3470682]Step 1 In the SSL policy where you want to control encrypted traffic by URL, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3470683]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3470684]Step 2 In the SSL rule editor, select the Categories tab.
 
     [bookmark: pgfId-3470685]The Categories tab appears.
 
     [bookmark: pgfId-3470686]Step 3 Find and select the categories of URL you want to add from the Categories list. To match encrypted web traffic regardless of category, select Any category.
 
     [bookmark: pgfId-3470687]To search for categories to add, click the Search by name or value prompt above the Categories list, then type the category name. The list updates as you type to display matching categories.
 
     [bookmark: pgfId-3470688]To select a category, click it. To select multiple categories, use the Shift and Ctrl keys. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3470689]Tip Although you can right-click and Select All categories, adding all categories this way exceeds the 50-item maximum for an SSL rule. Instead, use Any.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470690]Step 4 Optionally, qualify your category selections by clicking a reputation level from the Reputations list. If you do not specify a reputation level, the module defaults to Any, meaning all levels. 
 
     [bookmark: pgfId-3470691]You can only select one reputation level. When you choose a reputation level, the SSL rule behaves differently depending on its purpose:
 
      
       
       	 [bookmark: pgfId-3474254]If the rule blocks web access or decrypts traffic (the rule action is Block ,  Block with reset ,  Decrypt - Known Key ,  Decrypt - Resign , or  Monitor ) selecting a reputation level also selects all reputations more severe than that level. For example, if you configure a rule to block  Suspicious sites (level 2), it also automatically blocks  High Risk (level 1) sites.
 
       	 [bookmark: pgfId-3470693]If the rule allows web access, subject to access control (the rule action is  Do not decrypt ), selecting a reputation level also selects all reputations less severe than that level. For example, if you configure a rule to allow  Benign sites (level 4), it also automatically allows  Well known (level 5) sites.
 
      
 
     
 
     [bookmark: pgfId-3473009]If you change the rule action for a rule, the module automatically changes the reputation levels in URL conditions according to the above points.
 
     [bookmark: pgfId-3473010]Step 5 Click Add to Rule or to add the selected items to the Selected Categories list. 
 
     [bookmark: pgfId-3473011]You can also drag and drop selected items.
 
     [bookmark: pgfId-3473004]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3509650]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3473006]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3470760][bookmark: 88336][bookmark: 12501]Limitations on URL Detection and Blocking
 
     [bookmark: pgfId-3470764]License: URL Filtering
 
     [bookmark: pgfId-3470778]Keep the following points in mind when performing URL detection and blocking.
 
     [bookmark: pgfId-3470779]Speed of URL Identification
 
     [bookmark: pgfId-3470780]The module cannot categorize URLs before:
 
      
      	 [bookmark: pgfId-3470781]a monitored connection is established between a client and server
 
      	 [bookmark: pgfId-3470782]the module identifies the HTTPS application in the session
 
      	 [bookmark: pgfId-3470783]the module identifies the requested URL from either the client hello message or the server certificate
 
     
 ). 
     
 
     [bookmark: pgfId-3470786]After the module completes its identification, it applies the SSL rule action to the remaining session traffic that matches its URL condition.
 
     [bookmark: pgfId-3590957]Due to memory limitations, some device models perform URL filtering with a smaller, less granular, set of categories and reputations. For example, if a parent URL's subsites have different URL categories and reputations, some devices may use the parent URL's data for all subsites. As a specific example, the system might evaluate mail.google.com using the google.com category and reputation. Affected devices include the 71xx Family and the following ASA models: ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5512-X, ASA5515-X, ASA5516-X, and ASA5525-X.
 
     [bookmark: pgfId-3590961]For virtual devices, see the installation guide for information on allocating the correct amount of memory to perform category and reputation-based URL filtering. 
 
     [bookmark: pgfId-3470788]Search Query Parameters in URLs
 
     [bookmark: pgfId-3470789]The module does not use search query parameters in the URL to match URL conditions. For example, consider a scenario where you block all shopping traffic. In that case, using a web search to search for amazon.com is not blocked, but browsing to amazon.com is.
 
    
 
   
 
    
     [bookmark: pgfId-3405442][bookmark: 34380]Controlling Traffic Based on Encryption[bookmark: marker-3423966] Properties
 
    [bookmark: pgfId-3405531]License: Any
 
    [bookmark: pgfId-3405541]You can create SSL rules that handle and decrypt encrypted traffic based on encrypted connection characteristics. You can detect the protocol version or cipher suite used to encrypt the session, and handle traffic accordingly. You can also detect the server certificate and handle traffic, based on the following certificate characteristics:
 
     
     	 [bookmark: pgfId-3485183]the server certificate itself
 
     	 [bookmark: pgfId-3485236]the certificate issuer, whether an issuing CA or if the certificate is self-signed
 
     	 [bookmark: pgfId-3485322]the certificate holder
 
     	 [bookmark: pgfId-3485346]various certificate statuses, such as whether the certificate is valid, or revoked by the issuing CA
 
    
 
    [bookmark: pgfId-3483492]To detect multiple cipher suites in a rule, the certificate issuer, or the certificate holder, you can create reusable cipher suite list and distinguished name objects and add them to your rule. To detect the server certificate and certain certificate statuses, you must create external certificate and external CA objects for the rule. 
 
    [bookmark: pgfId-3405985]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3410536]Controlling Encrypted Traffic by Certificate Distinguished Name
 
     	 [bookmark: pgfId-3410545]Controlling Encrypted Traffic by Certificate
 
     	 [bookmark: pgfId-3410557]Controlling Encrypted Traffic by Certificate Status
 
     	 [bookmark: pgfId-3410560]Controlling Encrypted Traffic by Cipher Suite
 
     	 [bookmark: pgfId-3505332]Controlling Traffic by Encryption Protocol Version
 
    
 
     
      [bookmark: pgfId-3505381][bookmark: 58389]Controlling Encrypted Traffic by Certificate Distinguished Name
 
     [bookmark: pgfId-3505388]License: Any
 
     [bookmark: pgfId-3505404]Distinguished name conditions in SSL rules allow you to handle and inspect encrypted traffic based on the CA that issued a server certificate, or the certificate holder. Based on the issuer distinguished name, you can handle traffic based on the CA that issued a site’s server certificate. 
 
     [bookmark: pgfId-3505405]When configuring the rule condition, you can manually specify a literal value, reference a distinguished name object, or reference a distinguished name group containing multiple objects.
 
      
       
     
 
     
 
     [bookmark: pgfId-3505406]Note You cannot configure a distinguished name condition if you also select the Decrypt - Known Key action. Because that action requires you to select a server certificate to decrypt traffic, the certificate already matches the traffic. See Decrypt Actions: Decrypting Traffic for Further Inspection for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3505407]You can match against multiple subject and issuer distinguished names in a single certificate status rule condition; only one common or distinguished name needs to match to match the rule. 
 
     [bookmark: pgfId-3505408]If you add a distinguished name manually, it can contain the common name attribute (CN). If you add a common name without CN= then the module prepends CN= before saving the object.
 
      
       
        
        [bookmark: pgfId-3505411]Table 15-2 Distinguished Name Attributes
 
        
        
         
         	 
           
           [bookmark: pgfId-3505417]Attribute 
          
  
         	 
           
           [bookmark: pgfId-3505419]Description 
          
  
         	 
           
           [bookmark: pgfId-3505421]Allowed Values 
          
  
        
 
         
         	[bookmark: pgfId-3505423]C
  
         	[bookmark: pgfId-3505425]Country Code
  
         	[bookmark: pgfId-3505427]two alphabetic characters
  
        
 
         
         	[bookmark: pgfId-3505429]CN
  
         	[bookmark: pgfId-3505431]Common Name
  
         	 [bookmark: pgfId-3505433]up to 64 alphanumeric, backslash (\), hyphen (-), quotation ("), asterisk (*), period (.), or space characters
  
        
 
         
         	[bookmark: pgfId-3505435]O
  
         	[bookmark: pgfId-3505437]Organization
  
        
 
         
         	[bookmark: pgfId-3505441]OU
  
         	[bookmark: pgfId-3505443]Organizational Unit
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3505447]The following graphic illustrates a distinguished name rule condition searching for certificates issued to goodbakery.example.com or issued by goodca.example.com. Traffic encrypted with these certificates is allowed, subject to access control.
 
     [bookmark: pgfId-3588035]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3505465]You can add a maximum of 50 literal values and distinguished name objects to the Subject DNs, and 50 literal values and distinguished name objects to the Issuer DNs, in a single DN condition.
 
     [bookmark: pgfId-3537133]The ASA FirePOWER module-provided DN object group, Sourcefire Undecryptable Sites, contains websites whose traffic the module cannot decrypt. You can add this group to a DN condition to block or not decrypt traffic to or from these websites, without wasting system resources attempting to decrypt that traffic. You can modify individual entries in the group. You cannot delete the group. System updates can modify the entries on this list, but the module preserves user changes.
 
     [bookmark: pgfId-3537134]To inspect encrypted traffic based on certificate subject or issuer distinguished name:
 
     
 
     [bookmark: pgfId-3505471]Step 1 In the SSL policy where you want to control encrypted traffic by certificate subject or issuer distinguished name, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3505475]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3505476]Step 2 In the SSL rule editor, select the DN tab.
 
     [bookmark: pgfId-3505477]The DN tab appears.
 
     [bookmark: pgfId-3505478]Step 3 Find and select the distinguished names you want to add from the Available DNs, as follows:
 
      
       
       	 [bookmark: pgfId-3505479]To add a distinguished name object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available DNs  list; see 
      Working with Distinguished Name Objects. 
     
 
      
       
       	 [bookmark: pgfId-3505483]To search for distinguished name objects and groups to add, click the  Search by name or value  prompt above the  Available DNs  list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3505484]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3505485]Step 4 You have the following options:
 
      
       
       	 [bookmark: pgfId-3505486]Click  Add to Subject to add the selected objects to the  Subject DNs  list. 
 
       	 [bookmark: pgfId-3505487]Click  Add to Issuer to add the selected objects to the  Issuer DNs  list. 
 
      
 
     
 
     [bookmark: pgfId-3505488]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3505489]Step 5 Add any literal common names or distinguished names that you want to specify manually.
 
     [bookmark: pgfId-3505490]Click the Enter DN or CN prompt below the Subject DNs or Issuer DNs list; then type a common name or distinguished name and click Add.
 
     [bookmark: pgfId-3505491]Step 6 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509670]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3505499]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3505334][bookmark: 28093]Controlling Encrypted Traffic by Certificate 
 
     [bookmark: pgfId-3505341]License: Any
 
     [bookmark: pgfId-3415927]Certificate conditions in SSL rules allow you to handle and inspect encrypted traffic based on the server certificate used to encrypt that traffic. You can configure a condition with one or more certificates; traffic matches the rule if the certificate matches any of the condition’s certificates.
 
     [bookmark: pgfId-3474793]When you build a certificate-based SSL rule condition, you can upload a server certificate; you save the certificate as an external certificate object, which is reusable and associates a name with a server certificate. Alternately, you can configure certificate conditions with existing external certificate objects and object groups.
 
     [bookmark: pgfId-3474784]You can search the Available Certificates field in the rule condition based for external certificate objects and object groups based on the following certificate distinguished name characteristics:
 
      
      	 [bookmark: pgfId-3449137]subject or issuer common name (CN)
 
      	 [bookmark: pgfId-3449185]subject or issuer organization (O)
 
      	 [bookmark: pgfId-3449231]subject or issuer organizational unit (OU)
 
     
 
     [bookmark: pgfId-3449038]You can choose to match against multiple certificates in a single certificate rule condition; if the certificate used to encrypt the traffic matches any of the uploaded certificates, the encrypted traffic matches the rule. 
 
     [bookmark: pgfId-3480353]You can add a maximum of 50 external certificate objects and external certificate object groups to the Selected Certificates in a single certificate condition.
 
     [bookmark: pgfId-3519536]Note the following:
 
      
      	 [bookmark: pgfId-3519592]You cannot configure a certificate condition if you also select the  Decrypt - Known Key action. Because that action requires you to select a server certificate to decrypt traffic, the implication is that the certificate already matches the traffic. See Decrypt Actions: Decrypting Traffic for Further Inspection for more information.
 
      	 [bookmark: pgfId-3520613]If you configure a certificate condition with an external certificate object, any cipher suites you add to a cipher suite condition, or internal CA objects you associate with the  Decrypt - Resign action, must match the external certificate’s signature algorithm type. For example, if your rule’s certificate condition references an EC-based server certificate, any cipher suites you add, or CA certificates you associate with the  Decrypt - Resign action, must also be EC-based. If you mismatch signature algorithm types in this case, the policy editor displays a warning icon next to the rule. For more information, see Controlling Encrypted Traffic by Cipher Suite and Decrypt Actions: Decrypting Traffic for Further Inspection.
 
     
 
     [bookmark: pgfId-3449799]To inspect encrypted traffic based on server certificate:
 
     
 
     [bookmark: pgfId-3449801]Step 1 In the SSL policy where you want to control encrypted traffic based on server certificate, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3449804]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3449806]Step 2 In the SSL rule editor, select the Certificate tab.
 
     [bookmark: pgfId-3449807]The Certificate tab appears.
 
     [bookmark: pgfId-3449808]Step 3 Find and select the server certificates you want to add from the Available Certificates, as follows;
 
      
       
       	 [bookmark: pgfId-3449809]To add an external certificate object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Certificates list; see 
      Working with External Certificate Objects. 
     
 
      
       
       	 [bookmark: pgfId-3449813]To search for certificate objects and groups to add, click the  Search by name or value  prompt above the  Available Certificates  list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3449814]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3449816]Step 4 Click Add to Rule to add the selected objects to the Subject Certificates list. 
 
     [bookmark: pgfId-3449818]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3449821]Step 5 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509716]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3462159]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3406065][bookmark: 32205]Controlling Encrypted Traffic by Certificate Status
 
     [bookmark: pgfId-3415826]License: Any
 
     [bookmark: pgfId-3439403]Certificate status conditions in SSL rules allow you to handle and inspect encrypted traffic based on the status of the server certificate used to encrypt the traffic, including whether a certificate is valid, revoked, expired, not yet valid, self-signed, or signed by a trusted CA. 
 
     [bookmark: pgfId-3439957]Checking whether a CA issued or revoked a certificate requires uploading root and intermediate CA certificates and associated CRLs as objects. You then add these trusted CA objects to an SSL policy’s list of trusted CA certificates.
 
     [bookmark: pgfId-3440150]For each certificate status SSL rule condition you configure, you can match traffic against the presence or absence of a given status. You can select several statuses in one rule condition; if the certificate matches any of the selected statuses, the rule matches the traffic. 
 
     [bookmark: pgfId-3418899]For more information, see:
 
      
      	 [bookmark: pgfId-3420347]Trusting External Certificate Authorities
 
      	 [bookmark: pgfId-3420370]Matching Traffic on Certificate Status
 
     
 
    
 
     
      [bookmark: pgfId-3410843][bookmark: 22445]Trusting External Certificate [bookmark: marker-3423951]Authorities
 
     [bookmark: pgfId-3410844]License: Any
 
     [bookmark: pgfId-3410848]You can trust CAs by adding root and intermediate CA certificates to your SSL policy, then use these trusted CAs to verify server certificates used to encrypt traffic. Verified server certificates include certificates signed by trusted CAs.
 
     [bookmark: pgfId-3424967]If a trusted CA certificate contains an uploaded certificate revocation list (CRL), you can also verify whether a trusted CA revoked the encryption certificate. See Adding a Certificate Revocation List to a Trusted CA Object for more information.
 
     [bookmark: pgfId-3420885]After you add trusted CA certificates to the SSL policy, you can configure an SSL rule with various Certificate Status conditions to match against this traffic. See Working with Trusted Certificate Authority Objects and Controlling Encrypted Traffic by Certificate Status for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-3421833]Tip Upload all certificates within a root CA’s chain of trust to the list of trusted CA certificates, including the root CA certificate and all intermediate CA certificates. Otherwise, it is more difficult to detect trusted certificates issued by intermediate CAs.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3410946]When you create an SSL policy, the ASA FirePOWER module populates the Trusted CA Certificates tab with a default Trusted CA object group, Cisco Trusted Authorities. You can modify individual entries in the group, and choose whether to include this group in your SSL policy. You cannot delete the group. System updates can modify the entries on this list, but user changes are preserved. See Creating a Basic SSL Policy for more information.
 
     [bookmark: pgfId-3410950]To add trusted CAs to your policy:
 
     
 
     [bookmark: pgfId-3410952]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
     [bookmark: pgfId-3410953]The SSL Policy page appears.
 ) next to the SSL policy you want to configure. 
     
 
     [bookmark: pgfId-3410958]The SSL policy editor appears.
 
     [bookmark: pgfId-3410959]Step 3 Select the Trusted CA Certificates tab. 
 
     [bookmark: pgfId-3410960]The Trusted CA Certificates page appears. 
 
     [bookmark: pgfId-3529109]Step 4 Find and select the trusted CAs you want to add from the Available Trusted CAs, as follows:
 
      
       
       	 [bookmark: pgfId-3529110]To add a trusted CA object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Trusted CAs  list; see 
      Working with Trusted Certificate Authority Objects. 
     
 
      
       
       	 [bookmark: pgfId-3529117]To search for trusted CA objects and groups to add, click the  Search by name or value  prompt above the  Available Trusted CAs  list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3529118]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3529314]Step 5 Click Add to Rule to add the selected objects to the Selected Trusted CAs list. 
 
     [bookmark: pgfId-3529315]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3410971]Step 6 Add or continue editing the rule.
 
     [bookmark: pgfId-3509740]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3462200]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3419893][bookmark: 18728]Matching Traffic on Certificate Status
 
     [bookmark: pgfId-3420062]License: Any
 
     [bookmark: pgfId-3420721]Based on the certificate status rule condition configuration, you can match encrypted traffic based on the status of the server certificate used to encrypt traffic. You can:
 
      
      	 [bookmark: pgfId-3429110]check for a server certificate status
 
      	 [bookmark: pgfId-3429203]check that a certificate does not have a status
 
      	 [bookmark: pgfId-3429290]skip checking for the presence or absence of a certificate status 
 
     
 
     [bookmark: pgfId-3429102]You can choose to match against the presence or absence of multiple certificate statuses in a single certificate status rule condition; the certificate needs to only match one of the criteria to match the rule. 
 
     [bookmark: pgfId-3429573]The following table describes how the ASA FirePOWER module evaluates encrypted traffic based on the encrypting server certificate’s status. 
 
     [bookmark: pgfId-3419969]
 
      
       
        
        [bookmark: pgfId-3420389]Table 15-3 Certificate Status Rule Condition Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-3420393]Status Check 
          
  
         	 
           
           [bookmark: pgfId-3420395]Status Set to Yes 
          
  
         	 
           
           [bookmark: pgfId-3425645]Status Set to No 
          
  
        
 
         
         	[bookmark: pgfId-3420397]Revoked
  
         	[bookmark: pgfId-3420399]The policy trusts the CA that issued the server certificate, and the CA certificate uploaded to the policy contains a CRL that revokes the server certificate. 
  
         	[bookmark: pgfId-3425647]The policy trusts the CA that issued the server certificate, and the CA certificate uploaded to the policy does not contain a CRL that revokes the certificate.
  
        
 
         
         	[bookmark: pgfId-3420401]Self-signed
  
         	[bookmark: pgfId-3420403]The detected server certificate contains the same subject and issuer distinguished name.
  
         	[bookmark: pgfId-3425649]The detected server certificate contains different subject and issuer distinguished names.
  
        
 
         
         	[bookmark: pgfId-3420405]Valid
  
         	[bookmark: pgfId-3547115]All of the following are true:
 
           
           	 [bookmark: pgfId-3547116]The policy trusts the CA that issued the certificate
 
           	 [bookmark: pgfId-3524093]The signature is valid
 
           	 [bookmark: pgfId-3524124]The issuer is valid
 
           	 [bookmark: pgfId-3426986]None of the policy’s trusted CAs revoked the certificate.
 
           	 [bookmark: pgfId-3427009]The current date is between the certificate Valid From and Valid To date
 
          
  
         	[bookmark: pgfId-3425651]At least one of the following is true:
 
           
           	 [bookmark: pgfId-3427604]The policy does not trust the CA that issued the certificate
 
           	 [bookmark: pgfId-3524152]The signature is invalid
 
           	 [bookmark: pgfId-3524190]The issuer is invalid
 
           	 [bookmark: pgfId-3427605]A trusted CA in the policy revoked the certificate
 
           	 [bookmark: pgfId-3427593]The current date is before the certificate Valid From date
 
           	 [bookmark: pgfId-3426583]The current date is after the certificate Valid To date
 
          
  
        
 
         
         	[bookmark: pgfId-3420409]Invalid signature
  
         	[bookmark: pgfId-3420411]The certificate’s signature cannot be properly validated against the certificate’s content.
  
         	[bookmark: pgfId-3425653]The certificate’s signature is properly validated against the certificate’s content.
  
        
 
         
         	[bookmark: pgfId-3420413]Invalid issuer
  
         	[bookmark: pgfId-3420415]The issuer CA certificate is not stored in the policy’s list of trusted CA certificates. 
  
         	[bookmark: pgfId-3529704]The issuer CA certificate is stored in the policy’s list of trusted CA certificates. 
  
        
 
         
         	[bookmark: pgfId-3420417]Expired
  
         	[bookmark: pgfId-3420419]The current date is after the certificate Valid To date.
  
         	[bookmark: pgfId-3425657]The current date is before or on the certificate Valid To date.
  
        
 
         
         	[bookmark: pgfId-3420421]Not yet valid
  
         	[bookmark: pgfId-3420423]The current date is before the certificate Valid From date.
  
         	[bookmark: pgfId-3425659]The current date is after or on the certificate Valid From date.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3429580]Consider the following example. The organization trusts the Verified Authority certificate authority. The organization does not trust the Spammer Authority certificate authority. The system administrator uploads the Verified Authority certificate and an intermediate CA certificate issued by Verified Authority to the module. Because Verified Authority revoked a certificate it previously issued, the system administrator uploads the CRL that Verified Authority distributed. 
 
     [bookmark: pgfId-3529904]The following graphic illustrates a certificate status rule condition checking for valid certificates, those issued by Verified Authority, not on the CRL, and still within the Valid From and Valid To date. Because of the configuration, traffic encrypted with these certificates is not decrypted and inspected with access control.
 
     [bookmark: pgfId-3588120]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3433893]Note that even though a certificate may match more than one status, the rule only takes an action on the traffic once. 
 
     [bookmark: pgfId-3479635]To inspect encrypted traffic by server certificate status:
 
     
 
     [bookmark: pgfId-3438911]Step 1 In the SSL policy where you want to control encrypted traffic based on server certificate status, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3438914]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3438916]Step 2 In the SSL rule editor, select the Cert Status tab.
 
     [bookmark: pgfId-3438917]The Cert Status tab appears.
 
     [bookmark: pgfId-3438975]Step 3 For each certificate status, you have the following options:
 
      
       
       	 [bookmark: pgfId-3439026]Select  Yes to match against the presence of that certificate status.
 
       	 [bookmark: pgfId-3439119]Select  No to match against the absence of that certificate status.
 
       	 [bookmark: pgfId-3439179]Select  Do Not Match to not match that certificate status. 
 
      
 
     
 
     [bookmark: pgfId-3439316]Step 4 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509768]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3462211]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3406107][bookmark: 85738]Controlling Encrypted Traffic by Cipher Suite
 
     [bookmark: pgfId-3415797]License: Any
 
     [bookmark: pgfId-3410070]Cipher suite conditions in SSL rules allow you to handle and inspect encrypted traffic based on the cipher suite used to negotiate the encrypted session. Cisco provides predefined cipher suites you can add to a cipher suite rule condition. You can also add cipher suite list objects containing multiple cipher suites. For more information on cipher suite lists, see Working with Geolocation Objects. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3519382]Note You cannot add new cipher suites. You can neither modify nor delete predefined cipher suites. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3417786]You can add a maximum of 50 cipher suites and cipher suite lists to the Selected Cipher Suites in a single Cipher Suite condition.
 
     [bookmark: pgfId-3521510]Note the following:
 
      
      	 [bookmark: pgfId-3521585]If you add cipher suites not supported for your deployment, you cannot apply the access control policy associated with the SSL policy. For example, passive deployments do not support decrypting traffic with the any of the ephemeral Diffie-Hellman (DHE) or ephemeral elliptic curve Diffie-Hellman (ECDHE) cipher suites. Creating a rule with these cipher suites prevents you from applying your access control policy. 
 
      	 [bookmark: pgfId-3521577]If you configure a cipher suite condition with a cipher suite, any external certificate objects you add to a certificate condition, or internal CA objects you associate with the  Decrypt - Resign action, must match the cipher suite’s signature algorithm type. For example, if your rule’s cipher suite condition references an EC-based cipher suite, any server certificates you add, or CA certificates you associate with the  Decrypt - Resign action, must also be EC-based. If you mismatch signature algorithm types in this case, the policy editor displays a warning icon next to the rule. For more information, see Controlling Encrypted Traffic by Cipher Suite and Decrypt Actions: Decrypting Traffic for Further Inspection.
 
      	 [bookmark: pgfId-3536135]The ASA FirePOWER module cannot decrypt traffic encrypted with an anonymous cipher suite. You cannot use either the Decrypt - Resign or  Decrypt - Known Key action in an SSL rule if you add an anonymous cipher suite to the  Cipher Suite condition. 
 
     
 
     [bookmark: pgfId-3418361]To inspect encrypted traffic by cipher suite:
 
     
 
     [bookmark: pgfId-3418474]Step 1 In the SSL policy where you want to control encrypted traffic by cipher suite, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3418477]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3418479]Step 2 In the SSL rule editor, select the Cipher Suite tab.
 
     [bookmark: pgfId-3418480]The Cipher Suite tab appears.
 
     [bookmark: pgfId-3418526]Step 3 Find and select the cipher suites you want to add from the Available Cipher Suites, as follows;
 
      
       
       	 [bookmark: pgfId-3418638]To add a cipher suite list on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Cipher Suites  list; see 
      Working with Geolocation Objects. 
     
 
      
       
       	 [bookmark: pgfId-3418645]To search for cipher suites and lists to add, click the  Search by name or value  prompt above the  Available Cipher Suites  list, then type either the name of the cipher suite, or a value in the cipher suite. The list updates as you type to display matching cipher suites.
 
      
 
     
 
     [bookmark: pgfId-3418646]To select a cipher suite, click it. To select multiple cipher suites, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3418744]Step 4 Click Add to Rule to add the selected cipher suites to the Selected Cipher Suites list. 
 
     [bookmark: pgfId-3418745]You can also drag and drop selected cipher suites.
 
     [bookmark: pgfId-3418786]Step 5 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509817]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3462233]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3406143][bookmark: 40214]Controlling Traffic by Encryption Protocol Version
 
     [bookmark: pgfId-3406304]License: Any
 
     [bookmark: pgfId-3410085]Session conditions in SSL rules allow you to inspect encrypted traffic based on the SSL or TLS version used to encrypt the traffic. You can choose to match against traffic encrypted with SSL version 3.0, or TLS version 1.0, 1.1, or 1.2. By default, all protocol versions are selected when you create a rule; if you select multiple versions, encrypted traffic that matches any of the selected versions matches the rule. You must select at least one protocol version when saving the rule condition.
 
      
       
     
 
     
 
     [bookmark: pgfId-3478544]Note You cannot select SSL v2.0 in a version rule condition; the ASA FirePOWER module does not support decrypting traffic encrypted with SSL version 2.0. You can configure an undecryptable action to allow or block this traffic without further inspection. For more information, see Logging Decryptable Connections with SSL Rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3415110]To inspect encrypted traffic by SSL or TLS version:
 
     
 
     [bookmark: pgfId-3415184]Step 1 In the SSL policy where you want to control encrypted traffic by encryption protocol version, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3415284]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3415326]Step 2 In the SSL rule editor, select the Version tab.
 
     [bookmark: pgfId-3415372]The Version tab appears.
 
     [bookmark: pgfId-3415400]Step 3 Select the protocol versions you want to match against: SSL v3.0, TLS v1.0, TLS v1.1, or TLS v1.2.
 
     [bookmark: pgfId-3415540]Step 4 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509836]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-3462242]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3351539]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1633586][bookmark: 19322]Understanding Network Analysis and Intrusion Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1543216]Network analysis and intrusion policies work together as part of the ASA FirePOWER module intrusion detection and prevention feature. The term intrusion detection generally refers to the process of passively analyzing network traffic for potential intrusions and storing attack data for security analysis. The term intrusion prevention includes the concept of intrusion detection, but adds the ability to block or alter malicious traffic as it travels across your network.
 
    [bookmark: pgfId-1555135]In an intrusion prevention deployment, when the system examines packets:
 
     
     	 [bookmark: pgfId-1555136]A  network analysis policy governs how traffic is  decoded and  preprocessed so that it can be further evaluated, especially for anomalous traffic that might signal an intrusion attempt.
 
     	 [bookmark: pgfId-1544078]An  intrusion policy uses  intrusion and preprocessor rules (sometimes referred to collectively as  intrusion rules ) to examine the decoded packets for attacks based on patterns. Intrusion policies are paired with  variable sets , which allow you to use named values to accurately reflect your network environment.
 
    
 
    [bookmark: pgfId-1544177]Both network analysis and intrusion policies are invoked by a parent access control policy, but at different times. As the system analyzes traffic, the network analysis (decoding and preprocessing) phase occurs before and separately from the intrusion prevention (additional preprocessing and intrusion rules) phase. Together, network analysis and intrusion policies provide broad and deep packet inspection. They can help you detect, alert on, and protect against network traffic that could threaten the availability, integrity, and confidentiality of hosts and their data.
 
    [bookmark: pgfId-1544402]The ASA FirePOWER module is delivered with several similarly named network analysis and intrusion policies (for example, Balanced Security and Connectivity) that complement and work with each other. By using system-provided policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings.
 
    [bookmark: pgfId-1621300]You can also create custom network analysis and intrusion policies. You can tune settings in custom policies to inspect traffic in the way that matters most to you. You create, edit, save, and manage network analysis and intrusion policies using similar policy editors. When you are editing either type of policy, a navigation panel appears on the left side of the user interface; the right side displays various configuration pages.
 
    [bookmark: pgfId-1621268]This chapter contains a brief overview of the types of configurations the network analysis and intrusion policies govern, explains how the policies work together to examine traffic and generate records of policy violations, and provides basic information on navigating the policy editors. This chapter also explains the benefits and limitations of using custom versus system-provided policies. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1546715]Understanding How Policies Examine Traffic For Intrusions
 
     	 [bookmark: pgfId-1565214]Comparing System-Provided with Custom Policies
 
     	 [bookmark: pgfId-1565153]Using the Navigation Panel
 
     	 [bookmark: pgfId-1565158]Resolving Conflicts and Committing Policy Changes
 
    
 
    [bookmark: pgfId-1576133]To customize your intrusion deployment, see the following for your next steps:
 
     
     	 [bookmark: pgfId-1580974]Working with Variable Sets explains how to configure the system’s intrusion variables to accurately reflect your network environment. Even if you do not use custom policies, Cisco  strongly recommends that you modify the default variables in the default variable set. Advanced users can create and use custom variable sets for pairing with one or more custom intrusion policies.
 
     	 [bookmark: pgfId-1580952]Getting Started with Intrusion Policies explains how to create and edit a simple custom intrusion policy.
 
     	 [bookmark: pgfId-1576073]Controlling Traffic Using Intrusion and File Policies explains how to configure the system to use intrusion policies to examine only the traffic you are interested in by associating intrusion policies with a parent access control policy. It also explains how to configure advanced intrusion policy performance options.
 
     	 [bookmark: pgfId-1580584]Configuring Advanced Transport/Network Settings explains how to configure advanced transport and network preprocessor settings that apply globally to all traffic. You configure these advanced settings in an access control policy rather than in a network analysis or intrusion policy.
 
     	 [bookmark: pgfId-1576077]Getting Started with Network Analysis Policies explains how to create and edit a simple custom network analysis policy.
 
     	 [bookmark: pgfId-1572937]Customizing Preprocessing with Network Analysis Policies explains how to change the default network analysis policy. For advanced users, this section also explains how to tailor preprocessing to specific security zones and networks by assigning custom network analysis policies to preprocess matching traffic.
 
     	 [bookmark: pgfId-1599893]Using Layers in a Network Analysis or Intrusion Policy explain how, in larger organizations or complex deployments, you can use building blocks called policy  layers  to more efficiently manage multiple network analysis or intrusion policies.
 
    
 
   
 
    
     [bookmark: pgfId-1599895][bookmark: 44402]Understanding How Policies Examine Traffic For Intrusions
 
    [bookmark: pgfId-1599902]License: Protection
 
    [bookmark: pgfId-1567562]When the system analyzes traffic as part of your access control deployment, the network analysis (decoding and preprocessing) phase occurs before and separately from the intrusion prevention (intrusion rules and advanced settings) phase.
 
    [bookmark: pgfId-1581050]The following diagram shows, in a simplified fashion, the order of traffic analysis in an inline, intrusion prevention and advanced malware protection (AMP) deployment. It illustrates how the access control policy invokes other policies to examine traffic, and in which order those policies are invoked. The network analysis and intrusion policy selection phases are highlighted.
 
     
      [bookmark: pgfId-1624675]
 
     [bookmark: pgfId-1656272]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1624683]In an inline deployment, the system can block traffic without further inspection at almost any step in the illustrated process. Security Intelligence, network analysis policies, file policies, and intrusion policies can all either drop or modify traffic. 
 
     [bookmark: pgfId-1598181]Similarly, at each step of the process, a packet could cause the system to generate an event. Intrusion and preprocessor events (sometimes referred to collectively as intrusion events) are indications that a packet or its contents may represent a security risk.
 
     [bookmark: pgfId-1624827]Note that for a single connection, although the system selects a network analysis policy before an access control rule as shown in the diagram, some preprocessing (notably application layer preprocessing) occurs after access control rule selection. This does not affect how you configure preprocessing in custom network analysis policies.
 
     [bookmark: pgfId-1601932]For more information, see:
 
      
      	 [bookmark: pgfId-1601962]Decoding, Normalizing, and Preprocessing: Network Analysis Policies
 
      	 [bookmark: pgfId-1601998]Access Control Rules: Intrusion Policy Selection
 
      	 [bookmark: pgfId-1602004]Intrusion Inspection: Intrusion Policies, Rules, and Variable Sets
 
      	 [bookmark: pgfId-1602010]Intrusion Event Generation
 
     
 
    
 
     
      [bookmark: pgfId-1555674][bookmark: 62449]Decoding, Normalizing, and Pr[bookmark: marker-1586731]epr[bookmark: marker-1586732][bookmark: marker-1586733]oc[bookmark: marker-1586734]essing: Network Analysis Policies
 
     [bookmark: pgfId-1606918]License: Protection
 
     [bookmark: pgfId-1583968]Without decoding and preprocessing, the system could not appropriately evaluate traffic for intrusions because protocol differences would make pattern matching impossible. As shown in the diagram in Understanding How Policies Examine Traffic For Intrusions, network analysis policies govern these traffic-handling tasks:
 
      
      	 [bookmark: pgfId-1624863] after traffic is filtered by Security Intelligence
 
      	 [bookmark: pgfId-1624865] before traffic can be inspected by file or intrusion policies
 
     
 
     [bookmark: pgfId-1584186]A network analysis policy governs packet processing in phases. First the system decodes packets through the first three TCP/IP layers, then continues with normalizing, preprocessing, and detecting protocol anomalies. 
 
      
      	 [bookmark: pgfId-1583886]The packet decoder converts packet headers and payloads into a format that can be easily used by the preprocessors and later, intrusion rules. Each layer of the TCP/IP stack is decoded in turn, beginning with the data link layer and continuing through the network and transport layers. The packet decoder also detects various anomalous behaviors in packet headers. For more information, see Understanding Packet Decoding.
 
      	 [bookmark: pgfId-1584328]In inline deployments, the inline normalization preprocessor reformats (normalizes) traffic to minimize the chances of attackers evading detection. It prepares packets for examination by other preprocessors and intrusion rules, and helps ensure that the packets the system processes are the same as the packets received by the hosts on your network. For more information, see Normalizing Inline Traffic.
 
      	 [bookmark: pgfId-1583890]Various network and transport layers preprocessors detect attacks that exploit IP fragmentation, perform checksum validation, and perform TCP and UDP session preprocessing; see Configuring Transport & Network Layer Preprocessing.
 
     
 
     [bookmark: pgfId-1585739]Note that some advanced transport and network preprocessor settings apply globally to all traffic handled by an access control policy. You configure these in the access control policy rather than in a network analysis policy; see Configuring Advanced Transport/Network Settings.
 
      
      	 [bookmark: pgfId-1583894]Various application-layer protocol decoders normalize specific types of packet data into formats that the intrusion rules engine can analyze. Normalizing application-layer protocol encodings allows the system to effectively apply the same content-related intrusion rules to packets whose data is represented differently, and to obtain meaningful results. For more information, see Using Application Layer Preprocessors.
 
      	 [bookmark: pgfId-1583898]The Modbus and DNP3 SCADA preprocessors detect traffic anomalies and provide data to intrusion rules. Supervisory Control and Data Acquisition (SCADA) protocols monitor, control, and acquire data from industrial, infrastructure, and facility processes such as manufacturing, production, water treatment, electric power distribution, airport and shipping systems, and so on. For more information, see Configuring SCADA Preprocessing.
 
      	 [bookmark: pgfId-1586011]Several preprocessors allow you to detect specific threats, such as Back Orifice, portscans, SYN floods and other rate-based attacks; see Detecting Specific Threats.
 
     
 
     [bookmark: pgfId-1616549]Note that you configure the sensitive data preprocessor, which detects sensitive data such as credit card numbers and Social Security numbers in ASCII text, in intrusion policies; see Detecting Sensitive Data.
 
     [bookmark: pgfId-1616553]In a newly created access control policy, one default network analysis policy governs preprocessing for all traffic for all intrusion policies invoked by the same parent access control policy. Initially, the system uses the Balanced Security and Connectivity network analysis policy as the default, but you can change it to another system-provided or custom network analysis policy. In a more complex deployment, advanced users can tailor traffic preprocessing options to specific security zones and networks by assigning different custom network analysis policies to preprocess matching traffic. For more information, see Comparing System-Provided with Custom Policies.
 
    
 
     
      [bookmark: pgfId-1583640][bookmark: 11949]Access Control Rules: Intrusion Policy Selection
 
     [bookmark: pgfId-1606949]License: Protection
 
     [bookmark: pgfId-1624880]After initial preprocessing, access control rules (when present) evaluate traffic. In most cases, the first access control rule that a packet matches is the rule that handles that traffic; you can monitor, trust, block, or allow matching traffic.
 
     [bookmark: pgfId-1624881]When you allow traffic with an access control rule, the system can inspect the traffic for malware, prohibited files, and intrusions, in that order. Traffic not matching any access control rule is handled by the access control policy’s default action, which can also inspect for intrusions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1586197]Note All packets, regardless of which network analysis policy preprocesses them, are matched to configured access control rules—and thus are potentially subject to inspection by intrusion policies—in top-down order. For more information, see Limitations of Custom Policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1614454]The diagram in Understanding How Policies Examine Traffic For Intrusions shows the flow of traffic through a device in an inline, intrusion prevention and AMP deployment, as follows:
 
      
      	 [bookmark: pgfId-1555787]The access control rule allows matching traffic to proceed. The traffic is then inspected for prohibited files and malware by a file policy, and then for intrusions by an intrusion policy.
 
      	 [bookmark: pgfId-1616804]In this scenario, the access control policy’s default action allows matching traffic. The traffic is then inspected by an intrusion policy. You can (but do not have to) use a different intrusion policy when you associate intrusion policies with access control rules or the default action.
 
     
 
     [bookmark: pgfId-1616805]The example in the diagram does not include any blocking or trusting rules because the system does not inspect blocked or trusted traffic. For more information, see Using Rule Actions to Determine Traffic Handling and Inspection and Setting Default Handling and Inspection for Network Traffic.
 
    
 
     
      [bookmark: pgfId-1565548][bookmark: 19654]Intrusion Inspec[bookmark: marker-1605875][bookmark: marker-1605876]tion: Intrusion Policies, Rules, and Variable Sets
 
     [bookmark: pgfId-1606980]License: Protection
 
     [bookmark: pgfId-1588423]You can use intrusion prevention as the system’s last line of defense before traffic is allowed to proceed to its destination. Intrusion policies govern how the system inspects traffic for security violations and, in inline deployments, can block or alter malicious traffic. The main function of intrusion policies is to manage which intrusion and preprocessor rules are enabled and how they are configured.
 
     [bookmark: pgfId-1602429]Intrusion and Preprocessor Rules
 
     [bookmark: pgfId-1623103]An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network; the system uses an intrusion rule to analyze network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers. 
 
     [bookmark: pgfId-1601294]The system includes the following types of rules created by the VRT: 
 
      
      	 [bookmark: pgfId-1601302] shared object intrusion rules , which are compiled and cannot be modified (except for rule header information such as source and destination ports and IP addresses)
 
      	 [bookmark: pgfId-1601304] standard text intrusion rules , which can be saved and modified as new custom instances of the rule.
 
      	 [bookmark: pgfId-1601255] preprocessor rules , which are rules associated with preprocessors and packet decoder detection options in the network analysis policy. You cannot copy or edit preprocessor rules. Most preprocessor rules are disabled by default; you must enable them to use preprocessors to generate events and, in an inline deployment, drop offending packets.
 
     
 
     [bookmark: pgfId-1601429]When the system processes packets according to an intrusion policy, first a rule optimizer classifies all activated rules in subsets based on criteria such as: transport layer, application protocol, direction to or from the protected network, and so on. Then, the intrusion rules engine selects the appropriate rule subsets to apply to each packet. Finally, a multi-rule search engine performs three different types of searches to determine if the traffic matches the rule:
 
      
      	 [bookmark: pgfId-1601430]The protocol field search looks for matches in particular fields in an application protocol.
 
      	 [bookmark: pgfId-1601431]The generic content search looks for ASCII or binary byte matches in the packet payload.
 
      	 [bookmark: pgfId-1601432]The packet anomaly search looks for packet headers and payloads that, rather than containing specific content, violate well-established protocols.
 
     
 
     [bookmark: pgfId-1602175]In a custom intrusion policy, you can tune detection by enabling and disabling rules, as well as by writing and adding your own standard text rules.
 
     [bookmark: pgfId-1602219]Variable Sets
 
     [bookmark: pgfId-1601467]Whenever the system uses an intrusion policy to evaluate traffic, it uses an associated variable set. Most variables in a set represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions and dynamic rule states.
 
     [bookmark: pgfId-1601719]The system provides a single default variable set, which is comprised of predefined default variables. Most system-provided shared object rules and standard text rules use these predefined default variables to define networks and port numbers. For example, the majority of the rules use the variable $HOME_NET to specify the protected network and the variable $EXTERNAL_NET to specify the unprotected (or outside) network. In addition, specialized rules often use other predefined variables. For example, rules that detect exploits against web servers use the $HTTP_SERVERS and $HTTP_PORTS variables.
 
      
       
     
 
     
 
     [bookmark: pgfId-1604649]Tip Even if you use system-provided intrusion policies, Cisco strongly recommends you modify key default variables in the default set. When you use variables that accurately reflect your network environment, processing is optimized and the system can monitor relevant systems for suspicious activity. Advanced users can create and use custom variable sets for pairing with one or more custom intrusion policies. For more information, see Optimizing Predefined Default Variables.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607002][bookmark: 26686]Intrusion Event Gener[bookmark: marker-1607001]ation
 
     [bookmark: pgfId-1607031]License: Protection
 
     [bookmark: pgfId-1607003]When the system identifies a possible intrusion, it generates an intrusion or preprocessor event (sometimes collectively called intrusion events). You can view the data to gain a greater understanding of the attacks against your network assets. In an inline deployment, thesystem can also drop or replace packets that you know to be harmful.
 
     [bookmark: pgfId-1604070]Each intrusion event includes an event header and contains information about the event name and classification; the source and destination IP addresses; ports; the process that generated the event; and the date and time of the event, as well as contextual information about the source of the attack and its target. For packet-based events, the system also logs a copy of the decoded packet header and payload for the packet or packets that triggered the event. 
 
     [bookmark: pgfId-1588237]The packet decoder, the preprocessors, and the intrusion rules engine can all cause the system to generate an event. For example:
 
      
      	 [bookmark: pgfId-1603080]If the packet decoder (configured in the network analysis policy) receives an IP packet that is less than 20 bytes, which is the size of an IP datagram without any options or payload, the decoder interprets this as anomalous traffic. If, later, the accompanying decoder rule in the intrusion policy that examines the packet is enabled, the system generates a preprocessor event. 
 
      	 [bookmark: pgfId-1603122]If the IP defragmentation preprocessor encounters a series of overlapping IP fragments, the preprocessor interprets this as a possible attack and, when the accompanying preprocessor rule is enabled, the system generates a preprocessor event. 
 
      	 [bookmark: pgfId-1603143]Within the intrusion rules engine, most standard text rules and shared object rules are written so that they generate intrusion events when triggered by packets.
 
     
 
     [bookmark: pgfId-1605898]As the device accumulates intrusion events, you can begin your analysis of potential attacks. The system provides you with the tools you need to review intrusion events and evaluate whether they are important in the context of your network environment and your security policies.
 
    
 
   
 
    
     [bookmark: pgfId-1587538][bookmark: 37349]Comparing System-Provided with Custom Policies
 
    [bookmark: pgfId-1607110]License: Protection
 
    [bookmark: pgfId-1567858]Creating a new access control policy is one of the first steps in managing traffic flow using the ASA FirePOWER module. By default, a newly created access control policy invokes system-provided network analysis and intrusion policies to examine traffic.
 
    [bookmark: pgfId-1577158]The following diagram shows how a newly created access control policy in an inline, intrusion-prevention deployment initially handles traffic. The preprocessing and intrusion prevention phases are highlighted.
 
     
      [bookmark: pgfId-1625452]
 
     [bookmark: pgfId-1625456]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1625457]Note how:
 
      
      	 [bookmark: pgfId-1561654]A default network analysis policy governs the preprocessing of  all traffic handled by the access control policy. Initially, the system-provided  Balanced Security and Connectivity network analysis policy is the default.
 
      	 [bookmark: pgfId-1561616]The default action of the access control policy allows all non-malicious traffic, as determined by the system-provided  Balanced Security and Connectivity intrusion policy . 
 
      	 [bookmark: pgfId-1577220]The policy uses default Security Intelligence options (global whitelist and blacklist only), and does not perform special handling and inspection of network traffic using access control rules.
 
     
 
     [bookmark: pgfId-1562480]A simple step you can take to tune your intrusion prevention deployment is to use a different set of system-provided network analysis and intrusion policies as your defaults. Cisco delivers several pairs of these policies with the ASA FirePOWER module.
 
     [bookmark: pgfId-1623193]Or, you can tailor your intrusion prevention deployment by creating and using custom policies. You may find that the preprocessor options, intrusion rule, and other advanced settings configured in those policies do not address the security needs of your network. By tuning your network analysis and intrusion policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions. 
 
     [bookmark: pgfId-1577291]For more information, see:
 
      
      	 [bookmark: pgfId-1570234]Understanding the System-Provided Policies
 
      	 [bookmark: pgfId-1576190]Benefits of Custom Policies
 
      	 [bookmark: pgfId-1576231]Limitations of Custom Policies
 
     
 
    
 
     
      [bookmark: pgfId-1568005][bookmark: 34357]Understanding the System-Provided Policies
 
     [bookmark: pgfId-1607141]License: Protection
 
     [bookmark: pgfId-1591878]Cisco delivers several pairs of network analysis and intrusion policies with the ASA FirePOWER module. By using system-provided network analysis and intrusion policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings. You can use system-provided policies as-is, or you can use them as the base for custom policies.
 
      
       
     
 
     
 
     [bookmark: pgfId-1593276]Tip Even if you use system-provided network analysis and intrusion policies, you should configure the system’s intrusion variables to accurately reflect your network environment. At a minimum, modify key default variables in the default set; see Optimizing Predefined Default Variables.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1592160]As new vulnerabilities become known, the VRT releases intrusion rule updates. These rule updates can modify any system-provided network analysis or intrusion policy, and can provide new and updated intrusion rules and preprocessor rules, modified states for existing rules, and modified default policy settings. Rule updates may also delete rules from system-provided policies and provide new rule categories, as well as modify the default variable set. 
 
     [bookmark: pgfId-1625059]If a rule update affects your deployment, the system marks affected intrusion and network analysis policies as out of date, as well as their parent access control policies. You must reapply an updated policy for its changes to take effect. 
 
     [bookmark: pgfId-1625060]For your convenience, you can configure rule updates to automatically reapply affected intrusion policies, either alone or in combination with affected access control policies. This allows you to easily and automatically keep your deployment up-to-date to protect against recently discovered exploits and intrusions.
 
     [bookmark: pgfId-1625061]To ensure up-to-date preprocessing settings, you must reapply access control policies, which also reapplies any associated network analysis, and file policies that are different from those currently running, and can also can update default values for advanced preprocessing and performance options. For more information, see Importing Rule Updates and Local Rule Files.
 
     [bookmark: pgfId-1576458]Cisco delivers the following network analysis and intrusion policies with the ASA FirePOWER module:
 
     [bookmark: pgfId-1559890][bookmark: marker-1559889]Balanced Security and Connectivity network analysis and intrusion policies
 
     [bookmark: pgfId-1559891]These policies are built for both speed and detection. Used together, they serve as a good starting point for most organizations. The system uses the Balanced Security and Connectivity policies and settings as defaults in most cases.
 
     [bookmark: pgfId-1559893][bookmark: marker-1559892]Connectivity Over Security network analysis and intrusion policies
 
     [bookmark: pgfId-1559894]These policies are built for organizations where connectivity (being able to get to all resources) takes precedence over network infrastructure security. The intrusion policy enables far fewer rules than those enabled in the Security over Connectivity policy. Only the most critical rules that block traffic are enabled.
 
     [bookmark: pgfId-1559896][bookmark: marker-1559895]Security Over Connectivity network analysis and intrusion policies
 
     [bookmark: pgfId-1559897]These policies are built for organizations where network infrastructure security takes precedence over user convenience. The intrusion policy enables numerous network anomaly intrusion rules that could alert on or drop legitimate traffic.
 
     [bookmark: pgfId-1559898]No Rules Active intrusion policy
 
     [bookmark: pgfId-1559899]In the No Rules Active intrusion policy, all intrusion rules and advanced settings are disabled. This policy provides a starting point if you want to create your own intrusion policy instead of basing it on the enabled rules in one of the other system-provided policies.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1559903] 
      Caution Cisco uses another policy, Experimental Policy 1, for testing purposes. Do not use it unless instructed to do so by a Cisco representative. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1555817][bookmark: 79777]Benefits of Custom Polic[bookmark: marker-1605858]ies
 
     [bookmark: pgfId-1607164]License: Protection
 
     [bookmark: pgfId-1591794]You may find that the preprocessor options, intrusion rules, and other advanced settings configured in the system-provided network analysis and intrusion policies do not fully address the security needs of your organization.
 
     [bookmark: pgfId-1594071]Building custom policies can improve the performance of the system in your environment and can provide a focused view of the malicious traffic and policy violations occurring on your network. By creating and tuning custom policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.
 
     [bookmark: pgfId-1594251]All custom policies have a base policy, also called a base layer, which defines the default settings for all configurations in the policy. A layer is a building block that you can use to efficiently manage multiple network analysis or intrusion policies; see Using Layers in a Network Analysis or Intrusion Policy.
 
     [bookmark: pgfId-1623213]In most cases, you base custom policies on system-provided policies, but you can use another custom policy. However, all custom policies have a system-provided policy as the eventual base in a policy chain. Because rule updates can modify system-provided policies, importing a rule update may affect you even if you are using a custom policy as your base. If a rule update affects your policies, the module interface marks affected policies as out of date. For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1605644]For more information, see:
 
      
      	 [bookmark: pgfId-1605691]Benefits of a Custom Network Analysis Policy
 
      	 [bookmark: pgfId-1605712]Benefits of Custom Intrusion Policies
 
     
 
    
 
     
      [bookmark: pgfId-1577637][bookmark: 85883]Benefits of a Custom Network Analysis Policy
 
     [bookmark: pgfId-1605753]License: Protection
 
     [bookmark: pgfId-1595543]By default, one network analysis policy preprocesses all traffic handled by the access control policy. That means that all packets are decoded and preprocessed according to the same settings, regardless of the intrusion policy (and therefore intrusion rule set) that later examines them. 
 
     [bookmark: pgfId-1606799]Initially, the system-provided Balanced Security and Connectivity network analysis policy is the default. A simple way to tune preprocessing is to create and use a custom network analysis policy as the default; see Setting the Default Network Analysis Policy for Access Control. 
 
     [bookmark: pgfId-1606789]Tuning options available vary by preprocessor, but some of the ways you can tune preprocessors and decoders include: 
 
      
      	 [bookmark: pgfId-1595693]You can disable preprocessors that do not apply to the traffic you are monitoring. For example, the HTTP Inspect preprocessor normalizes HTTP traffic. If you are confident that your network does not include any web servers using Microsoft Internet Information Services (IIS), you can disable the preprocessor option that looks for IIS-specific traffic and thereby reduce system processing overhead.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1607951]Note If you disable a preprocessor in a custom network analysis policy, but the system needs to use that preprocessor to later evaluate packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although the preprocessor remains disabled in the network analysis policy user interface.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1607952]Specify ports, where appropriate, to focus the activity of certain preprocessors. For example, you can identify additional ports to monitor for DNS server responses
 
     
 
     [bookmark: pgfId-1596955]For advanced users with complex deployments, you can create multiple network analysis policies, each tailored to preprocess traffic differently. Then, you can configure the system to use those policies to govern the preprocessing of traffic using different security zones or networks.
 
      
       
     
 
     
 
     [bookmark: pgfId-1597697]Note Tailoring preprocessing using custom network analysis policies—especially multiple network analysis policies—is an advanced task. Because preprocessing and intrusion inspection are so closely related, you must be careful to allow the network analysis and intrusion policies examining a single packet to complement each other. For more information, see Limitations of Custom Policies.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1606892][bookmark: 56388]Benefits of Custom Intrusion Policies
 
     [bookmark: pgfId-1606899]License: Protection
 
     [bookmark: pgfId-1606900]In a newly created access control policy initially configured to perform intrusion prevention, the default action allows all traffic, but first inspects it with the system-provided Balanced Security and Connectivity intrusion policy. Unless you add access control rules or change the default action, all traffic is inspected by that intrusion policy; see the diagram in Comparing System-Provided with Custom Policies.
 
     [bookmark: pgfId-1599814]To customize your intrusion prevention deployment, you can create multiple intrusion policies, each tailored to inspect traffic differently. Then, configure an access control policy with rules that specify which policy inspects which traffic. Access control rules can be simple or complex, matching and inspecting traffic using multiple criteria including security zone, network or geographical location, port, application, requested URL, or user. The scenario in Understanding How Policies Examine Traffic For Intrusions shows a deployment where traffic is inspected by one of two intrusion policies.
 
     [bookmark: pgfId-1598599]The main function of intrusion policies is to manage which intrusion and preprocessor ru[bookmark: marker-1600250]les are enabled and how they are configured, as follows:
 
      
      	 [bookmark: pgfId-1577324]Within each intrusion policy, you should verify that all rules applicable to your environment are enabled, and improve performance by disabling rules that are not applicable to your environment. In an inline deployment, you can specify which rules should drop or modify malicious packets. For more information, see Setting Rule States.
 
      	 [bookmark: pgfId-1600346]You can modify existing rules and write new standard text rules as needed to catch new exploits or to enforce your security policies; see Understanding and Writing Intrusion Rules.
 
     
 
     [bookmark: pgfId-1600266]Other customizations you might make to an intrusion policy include:
 
      
      	 [bookmark: pgfId-1605223]The sensitive data preprocessor detects sensitive data such as credit card numbers and Social Security numbers in ASCII text. Note that other preprocessors that detect specific threats (back orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic) are configured in network analysis policies. For more information, see Detecting Specific Threats.
 
      	 [bookmark: pgfId-1605227]Global thresholds cause the system to generate events based on how many times traffic matching an intrusion rule originates from or is targeted to a specific address or address range within a specified time period. This helps prevent the system from being overwhelmed with a large number of events. For more information, see Globally Limiting Intrusion Event Logging.
 
      	 [bookmark: pgfId-1605436]Suppressing intrusion event notifications and setting thresholds for individual rules or entire intrusion policies can also can prevent the system from being overwhelmed with a large number of events. For more information, see Filtering Intrusion Event Notification Per Policy.
 
      	 [bookmark: pgfId-1605231]In addition to intrusion events, you can enable logging to syslog facilities or send event data to an SNMP trap server. Per policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events. For more information, see Configuring External Alerting for Intrusion Rules.
 
     
 
    
 
     
      [bookmark: pgfId-1595978][bookmark: 77890]Limitations of Custom Policies
 
     [bookmark: pgfId-1607231]License: Protection
 
     [bookmark: pgfId-1572617]Because preprocessing and intrusion inspection are so closely related, you must be careful that your configuration allows the network analysis and intrusion policies processing and examining a single packet to complement each other. 
 
     [bookmark: pgfId-1625313]By default, the system uses one network analysis policy to preprocess all traffic. The following diagram shows how a newly created access control policy in an inline, intrusion-prevention deployment initially handles traffic. The preprocessing and intrusion prevention phases are highlighted.
 
     [bookmark: pgfId-1656562]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1625222]Notice how a default network analysis policy governs the preprocessing of all traffic handled by the access control policy. Initially, the system-provided Balanced Security and Connectivity network analysis policy is the default.
 
     [bookmark: pgfId-1625524]A simple way to tune preprocessing is to create and use a custom network analysis policy as the default, as summarized in Benefits of a Custom Network Analysis Policy. However, if you disable a preprocessor in a custom network analysis policy but the system needs to evaluate preprocessed packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although it remains disabled in the network analysis policy user interface. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1625525]Note In order to get the performance benefits of disabling a preprocessor, you must make sure that none of your intrusion policies have enabled rules that require that preprocessor.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1605963]An additional challenge arises if you use multiple custom network analysis policies. For advanced users with complex deployments, you can tailor preprocessing to specific security zonesand networks by assigning custom network analysis policies to preprocess matching traffic. To accomplish this, you add custom network analysis rules to your access control policy. Each rule has an associated network analysis policy that governs the preprocessing of traffic that matches the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608368]Tip You configure network analysis rules as an advanced setting in an access control policy. Unlike other types of rules in the ASA FirePOWER module, network analysis rules invoke—rather than being contained by—network analysis policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607865]The system matches packets to any configured network analysis rules in top-down order by rule number. Traffic that does not match any network analysis rule is preprocessed by the default network analysis policy. While this allows you a great deal of flexibility in preprocessing traffic, keep in mind that all packets, regardless of which network analysis policy preprocessed them, are subsequently matched to access control rules—and thus to potential inspection by intrusion policies—in their own process. In other words, preprocessing a packet with a particular network analysis policy does not guarantee that the packet will be examined with any particular intrusion policy. You must carefully configure your access control policy so it invokes the correct network analysis and intrusion policies to evaluate a particular packet.
 
     [bookmark: pgfId-1608880]The following diagram shows in focused detail how the network analysis policy (preprocessing) selection phase occurs before and separately from the intrusion prevention (rules) phase. For simplicity, the diagram eliminates the file/malware inspection phases. It also highlights the default network analysis and default-action intrusion policies.
 
     [bookmark: pgfId-1656606]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1625826]In this scenario, an access control policy is configured with two network analysis rules and a default network analysis policy:
 
      
      	 [bookmark: pgfId-1557267]Network Analysis Rule A preprocesses matching traffic with Network Analysis Policy A. Later, you want this traffic to be inspected by Intrusion Policy A.
 
      	 [bookmark: pgfId-1608750]Network Analysis Rule B preprocesses matching traffic with Network Analysis Policy B. Later, you want this traffic to be inspected by Intrusion Policy B.
 
      	 [bookmark: pgfId-1608751]All remaining traffic is preprocessed with the default network analysis policy. Later, you want this traffic to be inspected by the intrusion policy associated with the access control policy’s default action.
 
     
 
     [bookmark: pgfId-1608752]After the system preprocesses traffic, it can examine the traffic for intrusions. The diagram shows an access control policy with two access control rules and a default action:
 
      
      	 [bookmark: pgfId-1558015]Access Control Rule A allows matching traffic. The traffic is then inspected by Intrusion Policy A.
 
      	 [bookmark: pgfId-1558016]Access Control Rule B allows matching traffic. The traffic is then inspected by Intrusion Policy B.
 
      	 [bookmark: pgfId-1609042]The access control policy’s default action allows matching traffic. The traffic is then inspected by the default action’s intrusion policy.
 
     
 
     [bookmark: pgfId-1611213]Each packet’s handling is governed by a network analysis policy and intrusion policy pair, but the system does not coordinate the pair for you. Consider a scenario where you misconfigure your access control policy so that Network Analysis Rule A and Access Control Rule A do not process the same traffic. For example, you could intend the paired policies to govern the handling of traffic on a particular security zone, but you mistakenly use different zones in the two rules’ conditions. This could cause traffic to be incorrectly preprocessed. For this reason, tailoring preprocessing using network analysis rules and custom policies is an advanced task. 
 
     [bookmark: pgfId-1625620]Note that for a single connection, although the system selects a network analysis policy before an access control rule, some preprocessing (notably application layer preprocessing) occurs after access control rule selection. This does not affect how you configure preprocessing in custom network analysis policies.
 
    
 
   
 
    
     [bookmark: pgfId-1611216][bookmark: 99072]Using the Nav[bookmark: marker-1611215]igation Panel
 
    [bookmark: pgfId-1611223]License: Protection
 
    [bookmark: pgfId-1538044]Network analysis and intrusion policies use similar user interfaces to edit and save changes to their configurations; see:
 
     
     	 [bookmark: pgfId-1538048]Editing Network Analysis Policies
 
     	 [bookmark: pgfId-1538052]Editing Intrusion Policies
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1626325]A dividing line separates the navigation panel into links to policy settings you can configure with (below) or without (above) direct interaction with policy layers. To navigate to any settings page, click its name in the navigation panel. Dark shading of an item in the navigation panel highlights your current settings page. For example, in the illustration above the Policy Information page would be displayed to the right of the navigation panel. 
 
    [bookmark: pgfId-1540194]Policy Information
 in the navigation panel when the policy contains unsaved changes. The icon disappears when you save your changes. 
    
 
    [bookmark: pgfId-1540251]Rules (intrusion policy only)
 
    [bookmark: pgfId-1540862]The Rules page in an intrusion policy allows you to configure rule states and other settings for shared object rules, standard text rules, and preprocessor rules. For more information, see Tuning Intrusion Policies Using Rules.
 
    [bookmark: pgfId-1540633]Settings (network analysis policy) and Advanced Settings (intrusion policy)
 
    [bookmark: pgfId-1541370]The Settings page in a network analysis policy allows you to enable or disable preprocessors and access preprocessor configuration pages. Expanding the Settings link displays sublinks to individual configuration pages for all enabled preprocessors in the policy. For more information, see Configuring Preprocessors in a Network Analysis Policy.
 
    [bookmark: pgfId-1626308]The Advanced Settings page in an intrusion policy allows you to enable or disable advanced settings and access configuration pages for those advanced settings. Expanding the Advanced Settings link displays sublinks to individual configuration pages for all enabled advanced settings in the policy. For more information, see Configuring Advanced Settings in an Intrusion Policy.
 
    [bookmark: pgfId-1540227]Policy Layers
 
    [bookmark: pgfId-1541740]The Policy Layers page displays a summary of the layers that comprise your network analysis or intrusion policy. Expanding the Policy Layers link displays sublinks to summary pages for the layers in your policy. Expanding each layer sublink displays further sublinks to the configuration pages for all rules, preprocessors, or advanced settings that are enabled in the layer. For more information, see Using Layers in a Network Analysis or Intrusion Policy.
 
   
 
    
     [bookmark: pgfId-1541764][bookmark: 31630]Resolving Conflicts and Committing Policy Ch[bookmark: marker-1541762][bookmark: marker-1541763]anges
 
    [bookmark: pgfId-1534705]License: Protection
 
    [bookmark: pgfId-1625658]When you edit a network analysis or intrusion policy, you must save (or commit) your changes before the system recognizes them.
 
     
      
    
 
    
 
    [bookmark: pgfId-1625659]Note After you save, you must apply a network analysis or intrusion policy for your changes to take effect. If you apply a policy without saving, the system uses the most recently saved configuration. Although you can reapply an intrusion policy independently, network analysis policies are applied with their parent access control policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1625660]Resolving Editing Conflicts
 
    [bookmark: pgfId-1625661]The Network Analysis Policy page and Intrusion Policy page display whether each policy has unsaved changes; see Editing Network Analysis Policies and Editing Intrusion Policies.
 
    [bookmark: pgfId-1626002]Cisco recommends that only one person edit a policy at a time. If you are editing the same network analysis or intrusion policy via multiple user interface instances as the same user, and you save your changes for one instance, you cannot save your changes for the other instance.
 
    [bookmark: pgfId-1625990]Resolving Configuration Dependencies
 
    [bookmark: pgfId-1625668]To perform their particular analysis, many preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way, or have other dependencies. When you save a network analysis or intrusion policy, the system either automatically enables required settings, or warns you that disabled settings will have no effect on traffic, as follows:
 
     
     	 [bookmark: pgfId-1625669]You cannot save an intrusion policy if you added an SNMP rule alert but did not configure SNMP alerting. You must either configure SNMP alerting or disable the rule alert, then save again.
 
     	 [bookmark: pgfId-1625670]You cannot save an intrusion policy if it includes enabled sensitive data rules but you have not enabled the sensitive data preprocessor. You must either allow the system to enable the preprocessor and save the policy, or disable the rules and save again.
 
     	 [bookmark: pgfId-1625671]If you disable a required preprocessor in a network analysis policy, you can still save the policy. However, the system automatically uses the disabled preprocessor with its current settings, even though the preprocessor remains disabled in the user interface. For more information, see Limitations of Custom Policies.
 
     	 [bookmark: pgfId-1625783]If you disable inline mode in a network analysis policy but enable the Inline Normalization preprocessor, you can still save the policy. However, the system warns you that normalization settings will be ignored. Disabling inline mode also causes the system to ignore other settings that allow preprocessors to modify or block traffic, including checksum verification and rate-based attack prevention. For more information, see Allowing Preprocessors to Affect Traffic in Inline Deployments and Normalizing Inline Traffic. 
 
    
 
    [bookmark: pgfId-1625682]Committing, Discarding, and Caching Policy Changes
 
    [bookmark: pgfId-1625683]While editing a network analysis or intrusion policy, if you exit the policy editor without saving your changes, the system caches those changes. Your changes are cached even when you log out of the system or experience a system crash. The system cache can store unsaved changes for one network analysis and one intrusion policy; you must commit or discard your changes before editing another policy of the same type. The system discards the cached changes when you edit another policy without saving your changes to the first policy, or when you import an intrusion rule update.
 
    [bookmark: pgfId-1625684]You can commit or discard policy changes on the Policy Information page of either the network analysis or intrusion policy editor; see Editing Network Analysis Policies and Editing Intrusion Policies.
 
     
      
       
       [bookmark: pgfId-1625698]Table 12-1 Committing Changes to a Network Analysis or Intrusion Policy 
 
       
       
        
        	 
          
          [bookmark: pgfId-1625702]To... 
         
  
        	 
          
          [bookmark: pgfId-1625704]On the Policy Information page, you can... 
         
  
       
 
        
        	[bookmark: pgfId-1625706]save changes to the policy
  
        	[bookmark: pgfId-1630283]click Commit Changes.
 [bookmark: pgfId-1644964]Optionally, enter a comment; click OK to continue committing.
  
       
 
        
        	[bookmark: pgfId-1625718]discard all unsaved changes
  
        	[bookmark: pgfId-1625720]click Discard Changes, then click OK to discard your changes and go to the Intrusion Policy page. If you do not want to discard your changes, click Cancel to return to the Policy Information page.
  
       
 
        
        	[bookmark: pgfId-1625722]exit the policy, but cache changes
  
        	[bookmark: pgfId-1625724]select any menu or other path to another page. On exiting, click Leave page when prompted, or click Stay on page to remain in the advanced editor.
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1533148][bookmark: 18634]Using Layers in a Network Analysis or Intrusion Policy 
      
      
 
     
 
 
    [bookmark: pgfId-1534998]Larger organizations with many ASA FirePOWER modules may have many intrusion policies and network analysis policies to support the unique needs of different departments, business units or, in some instances, different companies. Configurations in both policy types are contained in building blocks called layers, which you can use to efficiently manage multiple policies.
 
    [bookmark: pgfId-1535207]Layers in intrusion and network analysis policies work in essentially the same way. You can create and edit either policy type without consciously using layers. You can modify your policy configurations and, if you have not added user layers to your policy, the system automatically includes your changes in a single configurable layer that is initially named My Changes. Optionally, you can also add up to 200 layers where you can configure any combination of settings. You can copy, merge, move, and delete user layers and, most important, share individual user layers with other policies of the same type.
 
    [bookmark: pgfId-1619055]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1619059]Understanding the Layer Stack describes the user-configurable and built-in layers that comprise a basic policy.
 
     	 [bookmark: pgfId-1612433]Managing Layers explains how to use layers in your policies.
 
    
 
   
 
    
     [bookmark: pgfId-1612439][bookmark: 17146]Understanding the Layer Stack
 
    [bookmark: pgfId-1561634]License: Protection
 
    [bookmark: pgfId-1619005]A network analysis or intrusion policy where you do not add layers includes the built-in, read-only base policy layer and a single user-configurable layer that is initially named My Changes. You can copy, merge, move, or delete any user-configurable layer and set any user-configurable layer to be shared by other policies of the same type.
 
    [bookmark: pgfId-1619006]Each policy layer contains complete configurations for either all preprocessors in a network analysis policy or all intrusion rules and advanced settings in an intrusion policy. The lowest, base policy layer includes all the settings from the base policy you selected when you created the policy. A setting in a higher layer takes precedence over the same setting in a lower layer. Features not explicitly set in a layer inherit their settings from the next highest layer where they are explicitly set.
 
    [bookmark: pgfId-1621648]The system flattens the layers, that is, it applies only the cumulative effect of all settings, when it handles network traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1621701]Tip You can create an intrusion or network analysis policy based solely on the default settings in the base policy.
 
     
     
 
    
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1621740]Note the following points when working with multiple layers:
 
     
     	 [bookmark: pgfId-1621821]When the highest layer in your policy is a read-only layer, or a shared layer as described in Sharing Layers Between Policies, the system automatically adds a user-configurable layer as the highest layer in your intrusion policy if you do either of the following:
 
    
 
    [bookmark: pgfId-1561649] – modify a rule action (that is, a rule state, event filtering, dynamic state, or alerting) on the intrusion policy Rules page. See Tuning Intrusion Policies Using Rules for more information.
 
    [bookmark: pgfId-1561653] – enable, disable, or modify any preprocessor, intrusion rule, or advanced setting.
 
    [bookmark: pgfId-1561657]All settings in the system-added layer are inherited except for the changes that resulted in the new layer.
 
     
     	 [bookmark: pgfId-1561658]When the highest layer is a shared layer, the system adds a layer when you take either of the following actions:
 
    
 
    [bookmark: pgfId-1589793] – share the highest layer with other policies
 
    [bookmark: pgfId-1589815] – add a shared layer to your policy
 
     
     	 [bookmark: pgfId-1636048]Regardless of whether you allow rule updates to modify your policy, changes in a rule update never override changes you make in a layer. This is because changes in a rule update are made in the base policy, which determines the default settings in your base policy layer; your changes are always made in a higher layer, so they override any changes that a rule update makes to your base policy. See Importing Rule Updates and Local Rule Files for more information.
 
    
 
    [bookmark: pgfId-1636055]See Understanding the Base Layer for more information.
 
     
      [bookmark: pgfId-1561667][bookmark: 28494]Understan[bookmark: BasePolicy]ding the [bookmark: marker-1561666]Base Layer
 
     [bookmark: pgfId-1561674]License: Protection
 
     [bookmark: pgfId-1586877]The base layer, also referred to as the base policy, of an intrusion or network analysis policy defines the default settings for all configurations in the policy, and is the lowest layer in the policy. When you create a new policy and change a setting without adding new layers, the change is stored in the My Changes layer, and overrides—but does not change—the setting in the base policy.
 
     [bookmark: pgfId-1579531]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1579535]Understanding System-Provided Base Policies
 
      	 [bookmark: pgfId-1622070]Understanding Custom Base Policies
 
      	 [bookmark: pgfId-1584937]Changing the Base Policy
 
      	 [bookmark: pgfId-1584824]Allowing Rule Updates to Modify a System-Provided Base Policy
 
     
 
    
 
     
      [bookmark: pgfId-1578576][bookmark: 23026]Understanding System-Provided Base Policies
 
     [bookmark: pgfId-1625755]License: Protection
 
     [bookmark: pgfId-1626207]Cisco delivers several pairs of network analysis and intrusion policies with the ASA FirePOWER module. By using system-provided network analysis and intrusion policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings. You can use these system-provided policies as-is, or you can use them as the base for custom policies.
 
     [bookmark: pgfId-1626255]If you use a system-provided policy as your base, importing rule updates may modify settings in your base policy. However, you can configure a custom policy to not automatically make these changes to its system-provided base policy. This allows you to update system-provided base policies manually, on a schedule independent of rule update imports. In either case, changes that a rule update makes to your base policy do not change or override settings in your My Changes or any other layer. For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1626211]System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. For more information, see Understanding the System-Provided Policies.
 
    
 
     
      [bookmark: pgfId-1580218][bookmark: 30778]Understanding Custom Base Policies
 
     [bookmark: pgfId-1626385]License: Protection
 
     [bookmark: pgfId-1580219]If you do not want to use a system-provided policy as the base policy in your network analysis or intrusion policy, you can use a custom policy as your base. You can tune settings in custom policies to inspect traffic in ways that matter most to you so you can improve both the performance of your device and your ability to respond effectively to the events they generate. 
 
     [bookmark: pgfId-1583459]You can chain up to five custom policies, with four of the five using one of the other four previously created policies as its base policy; the fifth must use a system-provided policy as its base. 
 
     [bookmark: pgfId-1583149]Changes you make to a custom policy that you use as the base for another policy are automatically used as the default settings the of policy that uses the base. Additionally, because all policies have a system-provided policy as the eventual base in a policy chain, importing a rule update may affect your policy even if you use a custom base policy. If the first custom policy in a chain (the one that uses the system-provided policy as its base) allows rule updates to modify its base policy, your policy may be affected. For information on changing this setting, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1583364]Regardless of how they are made, changes to your base policy—whether by a rule update or when you modify a custom policy that you use as a base policy—do not change or override settings in your My Changes or any other layer.
 
    
 
     
      [bookmark: pgfId-1584211][bookmark: 35932][bookmark: 78384]Changing the Base P[bookmark: marker-1584209]olic[bookmark: marker-1584210]y
 
     [bookmark: pgfId-1584219]License: Protection
 
     [bookmark: pgfId-1584220]You can select a different base policy for your network analysis or intrusion policy and, optionally, allow rule updates to modify a system-provided base policy, without affecting modifications in higher layers.
 
     [bookmark: pgfId-1584221]To change the base policy:
 
     
 
     [bookmark: pgfId-1584226]Step 1 While editing your policy, click Policy Information in the navigation panel.
 
     [bookmark: pgfId-1584227]The Policy Information page appears.
 
     [bookmark: pgfId-1584228]Step 2 Select a base policy from the Base Policy drop-down list.
 
     [bookmark: pgfId-1584229]Step 3 Optionally, if you choose a system-provided base policy, click Manage Base Policy to specify whether intrusion rule updates can automatically modify your base policy. 
 
     [bookmark: pgfId-1584233]For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1584234]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626402]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1584240][bookmark: 62976]Allowing Rule Updates to Modify a System-Provided Base Policy
 
     [bookmark: pgfId-1584247]License: Protection
 
     [bookmark: pgfId-1623160]Rule updates that you import provide system-provided policies with modified network analysis preprocessor settings, modified intrusion policy advanced settings, new and updated intrusion rules, and modified states for existing rules. Rule updates can also delete rules and provide new rule categories and default variables. See Importing Rule Updates and Local Rule Files for more information.
 
     [bookmark: pgfId-1587514]Rule updates always modify system-provided policies with any changes to preprocessors, advanced settings, and rules. Changes to default variables and rule categories are handled at the system level. See Understanding System-Provided Base Policies for more information.
 
     [bookmark: pgfId-1587683]When you use a system-provided policy as your base policy, you can allow rule updates to modify your base policy which, in this case, is a copy of the system-provided policy. If you allow rule updates to update your base policy, a new rule update makes the same changes in your base policy that it makes to the system-provided policy that you use as your base policy. If you have not modified the corresponding setting, a setting in your base policy determines the setting in your policy. However, rule updates do not override changes you make in your policy. 
 
     [bookmark: pgfId-1587684]If you do not allow rule updates to update your base policy, you can manually update your base policy after importing one or more rule updates.
 
     [bookmark: pgfId-1623286]Rule updates always delete intrusion rules that VRT deletes, regardless of the rule state in your intrusion policy or whether you allow rule updates to update your base intrusion policy. Until you reapply your changes to network traffic, rules in your currently applied intrusion policies behave as follows:
 
      
      	 [bookmark: pgfId-1623287]Disabled rules remain disabled.
 
      	 [bookmark: pgfId-1584273]Rules set to Generate Events continue to generate events when triggered.
 
      	 [bookmark: pgfId-1584274]Rules set to Drop and Generate Events continue to generate events and drop offending packets when triggered.
 
     
 
     [bookmark: pgfId-1587731]Rule updates do not modify a custom base policy unless both of the following conditions are met:
 
      
      	 [bookmark: pgfId-1584279]You allow rule updates to modify the system-provided base policy of the parent policy, that is, the policy that originated the custom base policy.
 
      	 [bookmark: pgfId-1584280]You have not made changes in the parent policy that override the corresponding settings in the parent’s base policy.
 
     
 
     [bookmark: pgfId-1584281]When both conditions are met, changes in the rule update are passed to the child policy, that is, the policy using the custom base policy, when you save the parent policy.
 
     [bookmark: pgfId-1584282]For example, if a rule update enables a previously disabled intrusion rule, and you have not modified the rule’s state in the parent intrusion policy, the modified rule state is passed to the base policy when you save the parent policy.
 
     [bookmark: pgfId-1584283]Likewise, if a rule update modifies a default preprocessor setting and you have not modified the setting in the parent network analysis policy, the modified setting is passed to the base policy when you save the parent policy. 
 
     [bookmark: pgfId-1590026]See Changing the Base Policy for more information.
 
     [bookmark: pgfId-1584287]To allow rule updates to modify a system-provided base policy:
 
     
 
     [bookmark: pgfId-1584292]Step 1 While editing a policy that uses a system-provided policy as its base policy, click Policy Information in the navigation panel.
 
     [bookmark: pgfId-1584293]The Policy Information page appears.
 
     [bookmark: pgfId-1584294]Step 2 Click Manage Base Policy.
 
     [bookmark: pgfId-1584295]The Base Policy summary page appears.
 
     [bookmark: pgfId-1584296]Step 3 Select or clear the Update when a new Rule Update is installed check box. 
 
     [bookmark: pgfId-1627011]When you save your policy with the check box cleared and then import a rule update, an Update Now button appears on the Base Policy summary page and the status message on the page updates to inform you that the policy is out of date. Optionally, you can click Update Now to update your base policy with the changes in the most recently imported rule update.
 
     [bookmark: pgfId-1584298]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1579609]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1625392][bookmark: 44831]Managing Layers
 
    [bookmark: pgfId-1625399]License: Protection
 
    [bookmark: pgfId-1625695]The Policy Layers page provides a single-page summary of the complete layer stack for your network analysis or intrusion policy. On this page you can add shared and unshared layers, copy, merge, move, and delete layers, access the summary page for each layer, and access configuration pages for enabled, disabled, and overridden configurations within each layer.
 
    [bookmark: pgfId-1619530]For each layer, you can view the following information:
 
     
     	 [bookmark: pgfId-1606955]whether the layer is a built-in, shared user, or unshared user layer
 
     	 [bookmark: pgfId-1607035]which layers contain the highest, that is the effective, preprocessor or advanced setting configurations, by feature name
 
     	 [bookmark: pgfId-1607190]in an intrusion policy, the number of intrusion rules whose states are set in the layer, and the number of rules set to each rule state. 
 
    
 
    [bookmark: pgfId-1607482]The feature name in the summary for each layer indicates which configurations are enabled, disabled, overridden, or inherited in the layer, as follows:
 
     
      [bookmark: pgfId-1607504]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1607485]When the feature is... 
          
  
         	 
           
           [bookmark: pgfId-1607487]The feature name is... 
          
  
        
 
         
         	[bookmark: pgfId-1607489]enabled in the layer
  
         	[bookmark: pgfId-1607491]written in plain text
  
        
 
         
         	[bookmark: pgfId-1607493]disabled in the layer
  
         	[bookmark: pgfId-1607495]struck out
  
        
 
         
         	[bookmark: pgfId-1607497]overridden by the configuration in a higher layer
  
         	[bookmark: pgfId-1607499]written in italic text
  
        
 
         
         	[bookmark: pgfId-1607501]inherited from a lower layer
  
         	[bookmark: pgfId-1607503]not present
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1607927]This page also provides a summary of the net effect of all enabled preprocessors (network analysis) or advanced settings (intrusion) and, for intrusion policies, intrusion rules.
 
     [bookmark: pgfId-1540404]The following table lists the actions available on the Policy Layers page.
 
     [bookmark: pgfId-1609566]
 
      
      
 
      [bookmark: pgfId-1610744]See Sharing Layers Between Policies, Configuring Preprocessors and Advanced Settings in Layers, and Configuring Intrusion Rules in Layers for information on actions you can take on the summary page for a layer.
 
      
 
       
        
        [bookmark: pgfId-1609429]Table 13-1 [bookmark: 85114]Network Analysis and Intrusion Policy Layer Configuration Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1609433]To... 
          
  
         	 
           
           [bookmark: pgfId-1609435]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1609497]display the Policy Information page
  
         	[bookmark: pgfId-1609499]click Policy Summary.
 [bookmark: pgfId-1609503]See Tuning Intrusion Policies Using Rules, Getting Started with Network Analysis Policies, and Getting Started with Intrusion Policies for information on the actions you can take on the Policy Information page.
  
        
 
         
         	[bookmark: pgfId-1609505]display the summary page for a layer
  ) to access the read-only summary page for a shared layer. 
        
 
         
         	[bookmark: pgfId-1609542]access a layer-level preprocessor or advanced setting configuration page
  
         	[bookmark: pgfId-1609544]click the feature name in the row for the layer. Note that configuration pages are read-only in the base policy and in shared layers. See Configuring Preprocessors and Advanced Settings in Layers for more information.
  
        
 
         
         	[bookmark: pgfId-1609553]access a layer-level rule configuration page filtered by rule state type
  ) in the summary for the layer. No rules are displayed if the layer contains no rules set to the selected rule state. 
        
 
         
         	[bookmark: pgfId-1609744]add a layer to your policy
  
         	[bookmark: pgfId-1609746]see Adding a Layer.
  
        
 
         
         	[bookmark: pgfId-1620016]add a shared layer from another policy
  
         	[bookmark: pgfId-1620021]see Sharing Layers Between Policies.
  
        
 
         
         	[bookmark: pgfId-1611880]change a layer’s name or description
  
         	[bookmark: pgfId-1611882]see Changing a Layer's Name and Description.
  
        
 
         
         	[bookmark: pgfId-1610518]move, copy, or delete a layer
  
         	[bookmark: pgfId-1610523]see Moving, Copying, and Deleting Layers.
  
        
 
         
         	[bookmark: pgfId-1610088]merge a layer into the next layer beneath it
  
         	[bookmark: pgfId-1610093]see Merging Layers.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1540582]To use the Policy Layers page:
 
     
 
     [bookmark: pgfId-1591880]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1591892]The Policy Layers summary page appears.
 
     [bookmark: pgfId-1593314]Step 2 You can take any of the actions in the Network Analysis and Intrusion Policy Layer Configuration Actions table.
 
     [bookmark: pgfId-1594776]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1593282]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537274][bookmark: 49526]Adding a Layer
 
     [bookmark: pgfId-1537281]License: Protection
 
     [bookmark: pgfId-1541438]You can add up to 200 layers to a network analysis or intrusion policy. When you add a layer, it appears as the highest layer in your policy. The initial state is Inherit for all features and, in an intrusion policy, no event filtering, dynamic state, or alerting rule actions are set.
 
     [bookmark: pgfId-1542031]To add a layer to your network analysis or intrusion policy:
 
     
 
     [bookmark: pgfId-1542179]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1542180]The Policy Layers page appears.
 ) next to User Layers. 
     
 
     [bookmark: pgfId-1541457]The Add Layer pop-up window appears.
 
     [bookmark: pgfId-1542385]Step 3 Type a unique layer Name and click OK.
 
     [bookmark: pgfId-1594540]The new layer appears as the topmost layer under User Layers.
 
     [bookmark: pgfId-1594888]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626428]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1594542][bookmark: 40211]Changing a Layer's Name and Description
 
     [bookmark: pgfId-1542527]License: Protection
 
     [bookmark: pgfId-1542576]You can change the name of a user-configurable layer in your network analysis or intrusion policy and, optionally, add or modify a description that is visible when you edit the layer.
 
     [bookmark: pgfId-1542720]To change a layer’s name and add or modify its description:
 
     
 
     [bookmark: pgfId-1542725]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1542726]The Policy Layers page appears.
 ) next to the user layer you want to edit. 
     
 
     [bookmark: pgfId-1542942]The summary page for the layer appears.
 
     [bookmark: pgfId-1542934]Step 3 You can take the following actions:
 
      
       
       	 [bookmark: pgfId-1543015]Modify the layer  Name .
 
       	 [bookmark: pgfId-1543057]Add or modify the layer  Description .
 
      
 
     
 
     [bookmark: pgfId-1594970]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626445]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533737][bookmark: 51051]Moving, Copying, and Deleting Layers
 
     [bookmark: pgfId-1534300]License: Protection
 
     [bookmark: pgfId-1543242]You can copy, move, or delete a user layer in your network analysis or intrusion policy, including the initial My Changes layer. Note the following considerations:
 
      
      	 [bookmark: pgfId-1543383]When you copy a layer, the copy appears as the highest layer.
 
      	 [bookmark: pgfId-1543541]Copying a shared layer creates an unshared copy which, optionally, you can then share with other policies.
 
      	 [bookmark: pgfId-1543409]You cannot delete a shared layer; a layer with sharing enabled that you have not shared with another policy is not a shared layer.
 
     
 
     [bookmark: pgfId-1543639]To copy, move, or delete a layer:
 
     
 
     [bookmark: pgfId-1543644]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1543645]The Policy Layers page appears.
 
     [bookmark: pgfId-1543651]Step 2 You can take the following actions:
 
      
      	 [bookmark: pgfId-1544120]To copy a layer, click the copy icon (
 
      [image: ] ) for the layer you want to copy. 
     
 
     [bookmark: pgfId-1544121]The page refreshes and a copy of the layer appears as the highest layer.
 
      
       
       	 [bookmark: pgfId-1544122]To move a layer up or down within the User Layers page area, click any open area in the layer summary and drag until the position arrow (
 
      
 
      [image: ] ) points to a line above or below a layer where you want to move the layer. 
     
 
     [bookmark: pgfId-1544123]The screen refreshes and the layer appears in the new location.
 
      
       
       	 [bookmark: pgfId-1544124]To delete a layer, click the delete icon (
 
      
 
      [image: ] ) for the layer you want to delete, then click 
       OK 
     
 
     [bookmark: pgfId-1544125]The page refreshes and the layer is deleted.
 
     [bookmark: pgfId-1595073]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626498]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533738][bookmark: 31907]Merging Layers
 
     [bookmark: pgfId-1627076]License: Protection
 
     [bookmark: pgfId-1619046]You can merge a user-configurable layer in your network analysis or intrusion policy with the next user layer beneath it. A merged layer retains all settings that were unique to either layer, and accepts the settings from the higher layer if both layers included settings for the same preprocessor, intrusion rule, or advanced setting. The merged layer retains the name of the lower layer.
 
     [bookmark: pgfId-1544586]In the policy where you create a shared layer that you add to other policies, you can merge an unshared layer immediately above the shared layer with the shared layer, but you cannot merge the shared layer with an unshared layer beneath it.
 
     [bookmark: pgfId-1544558]In a policy where you add a shared layer that you created in another policy, you can merge the shared layer into an unshared layer immediately beneath it and the resulting layer is no longer shared; you cannot merge an unshared layer into a shared layer beneath it.
 
     [bookmark: pgfId-1544602]To merge a user layer with a user layer beneath it:
 
     
 
     [bookmark: pgfId-1544607]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1544608]The Policy Layers page appears.
 . 
     
 
     [bookmark: pgfId-1544614]The page refreshes and the layer is merged with the layer beneath it. 
 
     [bookmark: pgfId-1595199]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626539]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1545877][bookmark: 91343]Sharing Layers Between Policies
 
     [bookmark: pgfId-1545884]License: Protection
 
     [bookmark: pgfId-1545978]You can share a user-configurable layer with other policies of the same type (intrusion or network analysis). When you modify a configuration within a shared layer and then commit your changes, the system updates all policies that use the shared layer and provides you with a list of all affected policies. You can only modify shared layer feature configurations in the policy where you created the layer.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1545988]The master policy in the figure includes a company-wide layer with settings applicable to the policies at Site A and Site B. It also includes site-specific layers for each policy. For example, in the case of a network analysis policy Site A might not have web servers on the monitored network and would not require the protection or processing overhead of the HTTP Inspect preprocessor, but both sites would likely require TCP stream preprocessing. You could enable TCP stream processing in the company-wide layer that you share with both sites, disable the HTTP Inspect preprocessor in the site-specific layer that you share with Site A, and enable the HTTP Inspect preprocessor in the site-specific layer that you share with Site B. By editing configurations in a higher layer in the site-specific policies, you could also further tune the policy for each site if necessary with any configuration adjustments.
 
     [bookmark: pgfId-1545989]It is unlikely that the flattened net settings in the example master policy would be useful for monitoring traffic, but the time saved in configuring and updating the site-specific policies makes this a useful application of policy layers. 
 
     [bookmark: pgfId-1545990]Many other layer configurations are possible. For example, you could define policy layers by company, by department, or by network. In the case of an intrusion policy, you could also include advanced settings in one layer and rule settings in another.
 
      
       
     
 
     
 
     [bookmark: pgfId-1545995]Tip You cannot add a shared layer to a policy when your base policy is a custom policy where the layer you want to share was created. When you attempt to save your changes, an error message indicates that the policy includes a circular dependency. See Understanding Custom Base Policies for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1544420]To share a layer with other policies, you must do the following:
 
      
      	 [bookmark: pgfId-1546500]Enable sharing on the layer summary page of the layer you want to share.
 
      	 [bookmark: pgfId-1546756]Add the shared layer on the Policy Layers page of the policy where you want to share it.
 
     
 
     [bookmark: pgfId-1595707]You cannot disable sharing for a layer that is in use in another policy; you must first delete the layer from the other policy or delete the other policy.
 
     [bookmark: pgfId-1546808]To enable or disable sharing a layer with other policies:
 
     
 
     [bookmark: pgfId-1546813]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1546814]The Policy Layers page appears.
 ) next to the layer you want to share with other policies. 
     
 
     [bookmark: pgfId-1547094]The summary page for the layer appears.
 
     [bookmark: pgfId-1546927]Step 3 Select (enable) or clear (disable) the Sharing check box.
 
     [bookmark: pgfId-1595292]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1630638]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1546781]To add a shared layer to your policy:
 
     
 
     [bookmark: pgfId-1546786]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1546787]The Policy Layers page appears.
 ) next to User Layers. 
     
 
     [bookmark: pgfId-1546997]The Add Shared Layer pop-up window appears.
 
     [bookmark: pgfId-1548073]Step 3 Select the shared layer you want to add from the Add Shared Layer drop-down list, then click OK.
 
     [bookmark: pgfId-1548074]The Policy Layers summary page appears and the shared layer you selected appears as the highest layer in your policy. 
 
     [bookmark: pgfId-1546757]If there are no shared layers in any other policies, no drop-down list appears; click OK or Cancel on the pop-up window to return to the Policy Layers summary page.
 
     [bookmark: pgfId-1595323]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626574]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1551703][bookmark: 34253]Configuring Intrusion Rules in Lay[bookmark: marker-1551701]er[bookmark: marker-1551702]s
 
     [bookmark: pgfId-1551710]License: Protection
 
     [bookmark: pgfId-1624210]In an intrusion policy, you can set the rule state, event filtering, dynamic state, alerting, and rule comments for a rule in any user-configurable layer. After accessing the layer where you want to make your changes, you add settings on the Rules page for the layer the same as you would on the intrusion policy Rules page; see Tuning Intrusion Policies Using Rules. 
 
     [bookmark: pgfId-1624217]You can view individual layer settings on the Rules page for the layer, or view the net effect of all settings on the policy view of the Rules page. When you modify rule settings on the policy view of the Rules page, you are modifying the highest user-configurable layer in the policy. You can switch to another layer using the layer drop-down list on any Rules page.
 
     [bookmark: pgfId-1551712]The following table describes the effects of configuring the same type of setting in multiple layers.
 
     [bookmark: pgfId-1551774]
 
      
       
        
        [bookmark: pgfId-1630757]Table 13-2 [bookmark: 95517]Layer Rule Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1630763]You can set... 
          
  
         	 
           
           [bookmark: pgfId-1630765]Of this setting type... 
          
  
         	 
           
           [bookmark: pgfId-1630767]To... 
          
  
        
 
         
         	[bookmark: pgfId-1630769]one
  
         	[bookmark: pgfId-1630771]rule state
  
         	[bookmark: pgfId-1630773]override a rule state set for the rule in a lower layer, and ignore all thresholds, suppressions, rate-based rule states, and alerts for that rule configured in lower layers. See Setting Rule States for more information.
 [bookmark: pgfId-1630777]If you want a rule to inherit its state from the base policy or a lower layer, set the rule state to Inherit. Note that when you are working on the intrusion policy Rules page, you cannot set a rule state to Inherit.
 [bookmark: pgfId-1630778]Note also that rule state settings are color-coded when you view them on the Rules page for a specific layer: rules whose effective state is set in a lower layer are highlighted in yellow; rules whose effective state is set in a higher layer are highlighted in red; rules whose effective state is set in the current layer are not highlighted. Because the intrusion policy Rules page is a composite view of the net effect of all rule settings, rule states are not color-coded on this page.
  
        
 
         
         	[bookmark: pgfId-1630780]one
  
         	[bookmark: pgfId-1630782]threshold
SNMP alert
  
         	[bookmark: pgfId-1630784]override a setting of the same type for the rule in a lower layer. Note that setting a threshold overwrites any existing threshold for the rule in the layer. See Configuring Event Thresholding and Adding SNMP Alerts for more information.
  
        
 
         
         	[bookmark: pgfId-1630792]one or more
  
         	[bookmark: pgfId-1630794]suppression
rate-based rule state
  
         	[bookmark: pgfId-1630796]cumulatively combine settings of the same type for each selected rule down to the first layer where a rule state is set for the rule. Settings below the layer where a rule state is set are ignored. See Configuring Suppression Per Intrusion Policy and Adding Dynamic Rule States for more information.
  
        
 
         
         	[bookmark: pgfId-1630804]one or more
  
         	[bookmark: pgfId-1630806]comment
  
         	[bookmark: pgfId-1630808]add a comment to a rule. Comments are rule-specific, not policy- or layer-specific. You can add one or more comments to a rule in any layer. See Adding a Rule Comment for a Rule for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1551775]For example, if you set a rule state to Drop and Generate Events in one layer and to Disabled in a higher layer, the intrusion policy Rules page shows that the rule is disabled.
 
     [bookmark: pgfId-1551776]In another example, if you set a source-based suppression for a rule to 192.168.1.1 in one layer, and you also set a destination-based suppression for the rule to 192.168.1.2 in another layer, the Rules page shows that the cumulative effect is to suppress events for the source address 192.168.1.1 and the destination address 192.168.1.2. Note that suppression and rate-based rule state settings cumulatively combine settings of the same type for each selected rule down to the first layer where a rule state is set for the rule. Settings below the layer where a rule state is set are ignored.
 
     [bookmark: pgfId-1551777]To modify rules in a layer:
 
     
 
     [bookmark: pgfId-1551782]Step 1 While editing your intrusion policy, expand Policy Layers in the navigation panel and expand the policy layer you want to modify.
 
     [bookmark: pgfId-1551794]Step 2 Click Rules immediately beneath the policy layer you want to modify.
 
     [bookmark: pgfId-1551795]The Rules page for the layer appears.
 
     [bookmark: pgfId-1551799]You can modify any of the settings in the Layer Rule Settings table. See Tuning Intrusion Policies Using Rules for more information on configuring intrusion rules.
 
     [bookmark: pgfId-1630557]To delete an individual setting from an editable layer, double-click the rule message on the Rules page for the layer to display rule details. Click Delete next to the setting you want to delete, then click OK twice.
 
     [bookmark: pgfId-1630558]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626607]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1552688][bookmark: 16548]Removing Multi-Layer Rule Settings
 
     [bookmark: pgfId-1552695]License: Protection
 
     [bookmark: pgfId-1552696]You can select one or more rules on the intrusion policy Rules page and then simultaneously remove a specific type of event filter, dynamic state, or alerting from multiple layers in your intrusion policy.
 
     [bookmark: pgfId-1552697]The system removes the setting type downward through each layer where it is set until it removes all the settings or encounters a layer where a rule state is set for the rule. If it encounters a layer where a rule state is set, it removes the setting from that layer and stops removing the setting type.
 
     [bookmark: pgfId-1552698]When the system encounters the setting type in a shared layer or in the base policy, and if the highest layer in the policy is editable, the system copies the remaining settings and rule state for the rule to that editable layer. Otherwise, if the highest layer in the policy is a shared layer, the system creates a new editable layer above the shared layer and copies the remaining settings and rule state for the rule to that editable layer.
 
      
       
     
 
     
 
     [bookmark: pgfId-1552699]Note Removing rule settings derived from a shared layer or the base policy causes any changes to this rule from lower layers or the base policy to be ignored. To stop ignoring changes from lower layers or the base policy, set the rule state to Inherit on the summary page for the topmost layer. See Setting Rule States for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1552703]To remove rule settings in multiple layers:
 
     
 
     [bookmark: pgfId-1602897]Step 1 While editing your intrusion policy, click Rules immediately beneath Policy Information in the navigation panel.
 
      
       
     
 
     
 
     [bookmark: pgfId-1602662]Tip You can also select Policy from the layer drop-down list on the Rules page for any layer, or select Manage Rules on the Policy Information page.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1602990]The intrusion policy Rules page appears. 
 
     [bookmark: pgfId-1603012]Step 2 Select the rule or rules from which you want to remove multiple settings. You have the following options:
 
      
       
       	 [bookmark: pgfId-1603013]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1603014]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1603020]See Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy for information on locating rules.
 
     [bookmark: pgfId-1603004]Step 3 You have the following options:
 
      
       
       	 [bookmark: pgfId-1602678]To remove all thresholds for a rule, select  Event Filtering > Remove Thresholds .
 
       	 [bookmark: pgfId-1602679]To remove all suppression for a rule, select  Event Filtering > Remove Suppressions .
 
       	 [bookmark: pgfId-1602680]To remove all rate-based rule states for a rule, select  Dynamic State > Remove Rate-Based Rule States .  
 
       	 [bookmark: pgfId-1602681]To remove all SNMP alert settings for a rule, select  Alerting > Remove SNMP Alerts .  
 
      
 
     
 
     [bookmark: pgfId-1602682]A confirmation pop-up window appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1602683]Note Removing rule settings derived from a shared layer or the base policy causes any changes to this rule from lower layers or the base policy to be ignored. To stop ignoring changes from lower layers or the base policy, set the rule state to Inherit on the summary page for the topmost layer. See Setting Rule States for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1602687]Step 4 Click OK.
 
     [bookmark: pgfId-1602688]The system removes the selected setting and copies the remaining settings for the rule to the highest editable layer in the policy. See the introduction to this procedure for conditions that affect how the system copies the remaining settings.
 
     [bookmark: pgfId-1602689]Step 5 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626901]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1602693]Accepting Rule Changes from a Custom Base Policy
 
     [bookmark: pgfId-1602700]License: Protection
 
     [bookmark: pgfId-1602702]When a custom network analysis or intrusion policy where you have not added layers uses another custom policy as its base policy, you must set a rule to inherit its rule state if:
 
      
      	 [bookmark: pgfId-1602703]you delete an event filter, dynamic state, or SNMP alert set for the rule in the base policy, and
 
      	 [bookmark: pgfId-1602704]you want the rule to accept subsequent changes that you make to it in the other custom policy that you use as your base policy
 
     
 
     [bookmark: pgfId-1602716]The following procedure explains how to accomplish this. See Removing Multi-Layer Rule Settings to accept settings for these rules in a policy where you have added layers.
 
     [bookmark: pgfId-1602726]To accept rule changes in a policy where you have not added layers:
 
     
 
     [bookmark: pgfId-1602731]Step 1 While editing your intrusion policy, expand the Policy Layers link in the navigation panel, then expand the My Changes link.
 
     [bookmark: pgfId-1602732]Step 2 Click the Rules link immediately beneath My Changes.
 
     [bookmark: pgfId-1602733]The Rules page for the My Changes layer appears.
 
     [bookmark: pgfId-1586175]Step 3 Select the rule or rules whose settings you want to accept. You have the following options:
 
      
       
       	 [bookmark: pgfId-1586176]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1586177]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1618466]See Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy for information on locating rules.
 
     [bookmark: pgfId-1586178]Step 4 Select Inherit from the Rule State drop-down list.
 
     [bookmark: pgfId-1595416]Step 5 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626922]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1551838][bookmark: 79692]Configuring Preprocessors and Advanced Settings in L[bookmark: marker-1551836]ayers
 
     [bookmark: pgfId-1627965]License: Protection
 
     [bookmark: pgfId-1631049]You use similar mechanisms to configure preprocessors in a network analysis policy and advanced settings in an intrusion policy. You can enable and disable preprocessors on the network analysis Settings page and intrusion policy advanced settings on the intrusion policy Advanced Settings page. These pages also provide summaries of the effective states for all relevant features. For example, if the network analysis SSL preprocessor is disabled in one layer and enabled in a higher layer, the Settings page shows it as enabled. Changes made on these pages appear in the top layer of the policy.
 
     [bookmark: pgfId-1621200]You can also enable or disable preprocessors or advanced settings and access their configuration pages on the summary page for a user-configurable layer. On this page you can modify the layer name and description and configure whether to share the layer with other policies of the same type; see Sharing Layers Between Policies for more information. You can switch to the summary page for another layer by selecting the layer name beneath Policy Layers in the navigation panel. 
 ) appears next to the feature on the summary page for the layer; these disappear when you disable the feature in the layer or set it to Inherit. 
     
 
     [bookmark: pgfId-1604726]Setting the state (enabled or disabled) for a preprocessor or advanced setting overrides the state and configuration settings for that feature in lower layers. If you want a preprocessor or advanced setting to inherit its state and configuration from the base policy or a lower layer, set it to Inherit. Note that the Inherit selection is not available when you are working in the Settings or Advanced Settings page.
 
     [bookmark: pgfId-1604753]Color-coding on each layer summary page indicates as follows whether the effective configuration is in a higher, lower, or the current layer:
 
      
      	 [bookmark: pgfId-1605019]red - the effective configuration is in a higher layer
 
      	 [bookmark: pgfId-1605160]yellow - the effective configuration is in a lower layer
 
      	 [bookmark: pgfId-1605179]unshaded - the effective configuration is in the current layer
 
     
 
     [bookmark: pgfId-1605030]Because the Settings and Advanced Settings pages are composite views of all relevant settings, these page do not use color coding to indicate the positions of effective configurations.
 
     [bookmark: pgfId-1551860]The system uses the configuration in the highest layer where the feature is enabled. Unless you explicitly modify the configuration, the system uses the default configuration. For example, if you enable and modify the network analysis DCE/RPC preprocessor in one layer, and you also enable but do not modify it in a higher layer, the system uses the default configuration in the higher layer.
 
      
      
 
      [bookmark: pgfId-1606139]Note that the Back Orifice preprocessor has no user-configurable options.
 
       
        
        [bookmark: pgfId-1551872]Table 13-3 [bookmark: 42003]Layer Summary Page Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1551876]To... 
          
  
         	 
           
           [bookmark: pgfId-1551878]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1551880]modify the layer name or description
  
         	[bookmark: pgfId-1551882]type a new value for Name or Description.
  
        
 
         
         	[bookmark: pgfId-1551885]share the layer with other intrusion policies
  
         	[bookmark: pgfId-1551887]select Allow this layer to be used by other policies.
 [bookmark: pgfId-1551893]See Sharing Layers Between Policies for more information.
  
        
 
         
         	[bookmark: pgfId-1551897]enable or disable a preprocessor/advanced setting in the current layer
  
         	[bookmark: pgfId-1606240]click Enabled or Disabled next to the feature.
 ) appears on the summary page next to the feature. 
 [bookmark: pgfId-1605937]Disabling removes the sublink and edit icon.
  
        
 
         
         	[bookmark: pgfId-1551911]inherit the preprocessor/advanced setting state and configuration from the settings in the highest layer below the current layer
  
         	[bookmark: pgfId-1619031]click Inherit. 
 [bookmark: pgfId-1551914]The page refreshes and, if the feature was enabled, the feature sublink in the navigation panel and the edit icon no longer appear.
  
        
 
         
         	[bookmark: pgfId-1606028]access the configuration page for an enabled preprocessor/advanced setting
  ) or the feature sublink to modify the current configuration. 
        
 
        
      
 
     
 
     [bookmark: pgfId-1551916]To modify preprocessors/advanced settings in a user layer:
 
     
 
     [bookmark: pgfId-1551921]Step 1 While editing your policy, expand Policy Layers in the navigation panel, then click the name of the layer you want to modify.
 
     [bookmark: pgfId-1551933]The summary page for the layer appears.
 
     [bookmark: pgfId-1551937]Step 2 You can take any of the actions in the Layer Summary Page Actions table.
 
     [bookmark: pgfId-1595431]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626636]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272]Customizing Traffic [bookmark: 58391]Preprocessing 
      
      
 
     
 
 
    [bookmark: pgfId-1547588]Many of the advanced settings in an access control policy govern intrusion detection and prevention configurations that require specific expertise to configure. Advanced settings typically require little or no modification and are not common to every deployment. 
 
    [bookmark: pgfId-1567231]This chapter explains how to set the following preferences:
 
     
     	 [bookmark: pgfId-1561748]Setting the Default Intrusion Policy for Access Control explains how to change the access control policy’s default intrusion policy, which is used to initially inspect traffic before the system can determine exactly how to inspect that traffic
 
     	 [bookmark: pgfId-1567320]Customizing Preprocessing with Network Analysis Policies explains how to tailor certain traffic preprocessing options to specific security zones, and networks by assigning custom network analysis policies to preprocess matching traffic.
 
    
 
    [bookmark: pgfId-1567321]Other chapters describe policy-wide preprocessing and performance options for access control policies. For more information, see:
 
     
     	 [bookmark: pgfId-1567325]Configuring Advanced Transport/Network Settings
 
     	 [bookmark: pgfId-1562017]Tuning Preprocessing in Passive Deployments
 
     	 [bookmark: pgfId-1562018]Tuning Intrusion Prevention Performance
 
     	 [bookmark: pgfId-1562246]Tuning File and Malware Inspection Performance and Storage
 
    
 
   
 
    
     [bookmark: pgfId-1559073][bookmark: 74203]Setting the Default Intrusion Policy for Access Control
 
    [bookmark: pgfId-1559077]License: Any
 
    [bookmark: pgfId-1542816]Each access control policy uses its default intrusion policy to initially inspect traffic before the system can determine exactly how to inspect that traffic. This is needed because sometimes the system must process the first few packets in a connection, allowing them to pass, before it can decide which access control rule (if any) will handle the traffic. However, so that these packets do not reach their destination uninspected, you can use an intrusion policy—called the default intrusion policy—to inspect them and generate intrusion events.
 
    [bookmark: pgfId-1548516]A default intrusion policy is especially useful when performing application control and URL filtering, because the system cannot identify applications or filter URLs before a connection is fully established between the client and the server. For example, if a packet matches all the other conditions in an access control rule with an application or URL condition, it and subsequent packets are allowed to pass until the connection is established and application or URL identification is complete, usually 3 to 5 packets. 
 
    [bookmark: pgfId-1567827]The system inspects these allowed packets with the default intrusion policy, which can generate events and, if placed inline, block malicious traffic. After the system identifies the access control rule or default action that should handle the connection, the remaining packets in the connection are handled and inspected accordingly. 
 
    [bookmark: pgfId-1567487]When you create an access control policy, its default intrusion policy depends on the default action you first chose. Initial default intrusion policies for access control are as follows:
 
     
     	 [bookmark: pgfId-1544036]Balanced Security and Connectivity (a system-provided policy) is the default intrusion policy for an access control policy where you first chose the  Intrusion Prevention default action.
 
     	 [bookmark: pgfId-1550515]No Rules Active is the default intrusion policy for an access control policy where you first chose the  Block all traffic default action. Although choosing this option disables intrusion inspection on the allowed packets described above, it can improve performance if you are not interested in intrusion data.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1550516]Note If you are not performing intrusion inspection, keep the No Rules Active policy as your default intrusion policy. For more information, see Troubleshooting Access Control Policies and Rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1550532]Note that if you change your default action after you create the access control policy, the default intrusion policy does not automatically change. To change it manually, use the access control policy’s advanced options.
 
    [bookmark: pgfId-1545589]To change an access control policy’s default intrusion policy:
 
    
 ) next to the Network Analysis and Intrusion Policies section. 
    
 
    [bookmark: pgfId-1545598]The Network and Analysis Policies dialog box appears.
 
    [bookmark: pgfId-1546115]Step 2 From the Intrusion Policy used before Access Control rule is determined drop-down list, select a default intrusion policy. You can choose a system- or user-created policy. 
 ) to edit the policy in a new window. You cannot edit system-provided policies. 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1546123] 
     Caution Do 
     not use 
     Experimental Policy 1 unless instructed to do so by a Cisco representative. Cisco uses this policy for testing. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1546027]Step 3 Click OK to save your changes.
 
    [bookmark: pgfId-1545569]You must apply the access control policy for your changes to take effect.
 
    [bookmark: pgfId-1548114]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1547089][bookmark: 25956]Customizing Preprocessing with Network Analysis Policies
 
    [bookmark: pgfId-1552527]License: Any
 
    [bookmark: pgfId-1554720]Network analysis policies govern how traffic is decoded and preprocessed so that it can be further evaluated, especially for anomalous traffic that might signal an intrusion attempt. This traffic preprocessing occurs after Security Intelligence blacklisting, but before intrusion policies inspect packets in detail. By default, the system-provided Balanced Security and Connectivity network analysis policy applies to all traffic handled by an access control policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-1560482]Tip The system-provided Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1554869]A simple way to tune preprocessing is to create and use a custom network analysis policy as the default; see Creating a Custom Network Analysis Policy. Tuning options available vary by preprocessor.
 
    [bookmark: pgfId-1567880]For advanced users with complex deployments, you can create multiple network analysis policies, each tailored to preprocess traffic differently. Then, you can configure the system to use those policies to govern the preprocessing of traffic using different security zones or networks. 
 
    [bookmark: pgfId-1568511]To accomplish this, you add custom network analysis rules to your access control policy. Each rule has:
 
     
     	 [bookmark: pgfId-1568070]a set of rule conditions that identifies the specific traffic you want to preprocess
 
     	 [bookmark: pgfId-1568071]an associated network analysis policy that you want to use to preprocess traffic that meets all the rules’ conditions
 
    
 
    [bookmark: pgfId-1572901]When it is time for the system to preprocess traffic, it matches packets to network analysis rules in top-down order by rule number. Traffic that does not match any network analysis rules is preprocessed by the default network analysis policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-1572980]Note If you disable a preprocessor but the system needs to evaluate preprocessed packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although it remains disabled in the network analysis policy interface. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, you must be careful that you allow the network analysis and intrusion policies examining a single packet to complement each other. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1533780]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1534025]Setting the Default Network Analysis Policy for Access Control
 
     	 [bookmark: pgfId-1559211]Specifying Traffic to Preprocess Using Network Analysis Rules
 
     	 [bookmark: pgfId-1547461]Managing Network Analysis Rules
 
    
 
     
      [bookmark: pgfId-1559090][bookmark: 12571]Setting the Default Network Analysis Policy for Access Control
 
     [bookmark: pgfId-1559346]License: Any
 
     [bookmark: pgfId-1559273]By default, the system-provided Balanced Security and Connectivity network analysis policy applies to all traffic handled by an access control policy. If you add network analysis rules to tailor traffic preprocessing options, the default network analysis policy preprocesses all traffic not handled by those rules.
 
     [bookmark: pgfId-1560185]An access control policy’s advanced settings allow you to change this default policy.
 
     [bookmark: pgfId-1560685]To change an access control policy’s default network analysis policy:
 
     
 ) next to the Network Analysis and Intrusion Policies section. 
     
 
     [bookmark: pgfId-1560694]The Network and Analysis Policies dialog box appears.
 
     [bookmark: pgfId-1560695]Step 2 From the Default Network Analysis Policy drop-down list, select a default network analysis policy. You can choose a system- or user-created policy. 
 ) to edit the policy in a new window. You cannot edit system-provided policies. 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1560702] 
      Caution Do 
      not use 
      Experimental Policy 1 unless instructed to do so by a Cisco representative. Cisco uses this policy for testing. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1560703]Step 3 Click OK to save your changes,.
 
     [bookmark: pgfId-1560704]You must apply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-1560705]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1559931][bookmark: 31724]Specifying Traffic to Preprocess Using Network Analysis Rules
 
     [bookmark: pgfId-1559935]License: Any
 
     [bookmark: pgfId-1558158]Within your access control policy’s advanced settings, you can use network analysis rules to tailor preprocessing configurations to network traffic. Similar to access control rules, network analysis rules are numbered, starting at 1.
 
     [bookmark: pgfId-1557396]When it is time for the system to preprocess traffic, it matches packets to network analysis rules in top-down order by ascending rule number, and preprocesses traffic according to the first rule where all the rule’s conditions match. The conditions you can add to a rule are described in the following table.
 
      
       [bookmark: pgfId-1559868] 
 
       
        
         
         [bookmark: pgfId-1559827]Table 14-1 [bookmark: 69858]Network Analysis Rule Condition Types 
 
         
         
          
          	 
            
            [bookmark: pgfId-1559833]This Condition... 
           
  
          	 
            
            [bookmark: pgfId-1559835]Matches Traffic... 
           
  
          	 
            
            [bookmark: pgfId-1559837]Details 
           
  
         
 
          
          	[bookmark: pgfId-1559839]Zones
  
          	[bookmark: pgfId-1559841]entering or leaving a device via an interface in a specific security zone
  
          	[bookmark: pgfId-1559843]A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. To build a zone condition, see Preprocessing Traffic Per Zone.
  
         
 
          
          	[bookmark: pgfId-1559848]Networks
  
          	[bookmark: pgfId-1559850]by its source or destination IP address
  
          	[bookmark: pgfId-1559852]You can explicitly specify IP addresses. To build a network condition, see Preprocessing Traffic Per Network.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-1559869]If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a network condition but no zone condition evaluates traffic based on its source or destination IP address, regardless of its ingress or egress interface. Traffic that does not match any network analysis rules is preprocessed by the default network analysis policy.
 
      [bookmark: pgfId-1534346]To add a custom network analysis rule:
 
      
 ) next to the Intrusion and Network Analysis Policies section. 
      
 
      [bookmark: pgfId-1534698]The Network and Analysis Policies dialog box appears. If you have not added any custom network analysis rules, the module interface indicates that you have No Custom Rules, otherwise it displays how many you have configured.
 
       
        
      
 
      
 
      [bookmark: pgfId-1570023]Tip Click Network Analysis Policy List to display the Network Analysis Policy page in a new window. Use this page to view and edit your custom network analysis policies; see Managing Network Analysis Policies
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1534695]Step 2 Next to Network Analysis Rules, click the statement that indicates how many custom rules you have.
 
      [bookmark: pgfId-1535219]The dialog box expands to show the custom rules, if any.
 
      [bookmark: pgfId-1535282]Step 3 Click Add Rule.
 
      [bookmark: pgfId-1535306]The network analysis rule editor appears.
 
      [bookmark: pgfId-1535345]Step 4 Build your rule’s conditions. You can restrict NAP preprocessing using the following criteria:
 
       
        
        	 [bookmark: pgfId-1535464]Preprocessing Traffic Per Zone
 
        	 [bookmark: pgfId-1535474]Preprocessing Traffic Per Network
 
       
 
      
 
      [bookmark: pgfId-1538743]Step 5 Associate a network analysis policy with the rule by clicking the Network Analysis tab and choosing a policy from the Network Analysis Policy drop-down list.
 ) to edit the policy in a new window. You cannot edit system-provided policies. 
      
 
       
        
      
 
      
 
       
       [bookmark: pgfId-1536911] 
       Caution Do 
       not use 
       Experimental Policy 1 unless instructed to do so by a Cisco representative. Cisco uses this policy for testing. 
        
        
 
       
 
      
 
      [bookmark: pgfId-1535883]Step 6 Click Add.
 
      [bookmark: pgfId-1535698]The rule is added after any other rules. To change the rule’s evaluation order, see Managing Network Analysis Rules.
 
      [bookmark: pgfId-1548197]
 
       
       
 
      
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1535974][bookmark: 76028]Preprocessing Traffic Per Zone
 
     [bookmark: pgfId-1547712]License: Any
 
     [bookmark: pgfId-1536105]Zone conditions in network analysis rules allow you to preprocess traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces. For more information on creating zones, see Working with Security Zones.
 
     [bookmark: pgfId-1536119]You can add a maximum of 50 zones to each of the Source Zones and Destination Zones in a single zone condition:
 
      
      	 [bookmark: pgfId-1536120]To match traffic  leaving the device from an interface in the zone, add that zone to  Destination Zones . Note that because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a  Destination Zone  condition.
 
      	 [bookmark: pgfId-1536123]To match traffic  entering the device from an interface in the zone, add that zone to  Source Zones .
 
     
 
     [bookmark: pgfId-1536124]If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones and egress through one of the destination zones. 
 ) indicate invalid configurations, such as zones that contain no interfaces. For details, see 
     Troubleshooting Access Control Policies and Rules. 
     
 
     [bookmark: pgfId-1536249]To preprocess traffic by zone:
 
     
 
     [bookmark: pgfId-1536251]Step 1 In the access control policy where you want to preprocess traffic by zone, create a new network analysis rule or edit an existing rule.
 
     [bookmark: pgfId-1536252]For detailed instructions, see Specifying Traffic to Preprocess Using Network Analysis Rules.
 
     [bookmark: pgfId-1536253]Step 2 In the network analysis rule editor, select the Zones tab.
 
     [bookmark: pgfId-1536254]The Zones tab appears.
 
     [bookmark: pgfId-1536255]Step 3 Find and select the zones you want to add from the Available Zones. 
 
     [bookmark: pgfId-1536256]To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones. 
 
     [bookmark: pgfId-1536257]Click to select a zone. To select multiple zones, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-1536258]Step 4 Click Add to Source or Add to Destination to add the selected zones to the appropriate list. 
 
     [bookmark: pgfId-1536259]You can also drag and drop selected zones.
 
     [bookmark: pgfId-1536260]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-1536245]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1548224]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1536108][bookmark: 60131]Preprocessing Traffic Per Network
 
     [bookmark: pgfId-1537020]License: Any
 
     [bookmark: pgfId-1537042]Network conditions in network analysis rules allow you to preprocess traffic by its source and destination IP address. You can manually specify the source and destination IP addresses for the traffic you want to preprocess, or you can configure network conditions with network objects, which are reusable and associate a name with one or more IP addresses and address blocks.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537553]Tip After you create a network object, you can use it not only to build network analysis rules, but also to represent IP addresses in various other places in the system’s module interface. You can create these objects using the object manager; you can also create network objects on-the-fly while you are configuring network analysis rules. For more information, see Working with Network Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537562]You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition:
 
      
      	 [bookmark: pgfId-1537563]To match traffic from an IP address, configure  Source Networks .
 
      	 [bookmark: pgfId-1537564]To match traffic to an IP address, configure  Destination Networks .
 
     
 
     [bookmark: pgfId-1537566]If you add both source and destination network conditions to a rule, matching traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses. 
 ) indicate invalid configurations. For details, see 
     Troubleshooting Access Control Policies and Rules. 
     
 
     [bookmark: pgfId-1537593]To preprocess traffic by network:
 
     
 
     [bookmark: pgfId-1537598]Step 1 In the access control policy where you want to preprocess traffic by network, create a new network analysis rule or edit an existing rule.
 
     [bookmark: pgfId-1537601]For detailed instructions, see Specifying Traffic to Preprocess Using Network Analysis Rules.
 
     [bookmark: pgfId-1537603]Step 2 In the network analysis rule editor, select the Networks tab.
 
     [bookmark: pgfId-1537604]The Networks tab appears.
 
     [bookmark: pgfId-1537605]Step 3 Find and select the networks you want to add from the Available Networks, as follows: 
 
      
       
       	 [bookmark: pgfId-1537606]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Networks list; see 
      Working with Network Objects. 
     
 
      
       
       	 [bookmark: pgfId-1537668]To search for networks to add, click the  Search by name or value prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects. 
 
      
 
     
 
     [bookmark: pgfId-1537607]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-1537925]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
     [bookmark: pgfId-1537926]You can also drag and drop selected objects.
 
     [bookmark: pgfId-1537927]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually.
 
     [bookmark: pgfId-1537928]Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
     [bookmark: pgfId-1537610]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1537611]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1565263]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1547542][bookmark: 31649]Managing Network Analysis Rules
 
     [bookmark: pgfId-1548409]License: Any
 
     [bookmark: pgfId-1558584]A network analysis rule is simply a set of configurations and conditions that specifies how you preprocess traffic that matches those qualifications. You create and edit network analysis rules in the advanced options in an existing access control policy. Each rule belongs to only one policy.
 
     [bookmark: pgfId-1558822]To edit a custom network analysis rule:
 
     
 ) next to the Intrusion and Network Analysis Policies section. 
     
 
     [bookmark: pgfId-1558831]The Network and Analysis Policies dialog box appears. If you have not added any custom network analysis rules, the module interface indicates that you have No Custom Rules; otherwise, it displays how many you have configured.
 
     [bookmark: pgfId-1558832]Step 2 Next to Network Analysis Rules, click the statement that indicates how many custom rules you have.
 
     [bookmark: pgfId-1558833]The dialog box expands to show the custom rules, if any.
 
     [bookmark: pgfId-1558890]Step 3 Edit your custom rules. You have the following options:
 
      
       
       	 [bookmark: pgfId-1558990]To edit a rule’s conditions, or change the network analysis policy invoked by the rule, click the edit icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
       	 [bookmark: pgfId-1561020]To change a rule’s order of evaluation, click and drag the rule to the correct location. To select multiple rules, use the Shift and Ctrl keys.
 
       	 [bookmark: pgfId-1561017]To delete a rule, click the delete icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
     [bookmark: pgfId-1561512]Step 4 Click OK to save your changes.
 
     [bookmark: pgfId-1561513]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1561540]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533224]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1577264][bookmark: 72967]Getting Started with Network Analysis Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1577258]Network analysis policies govern many traffic preprocessing options, and are invoked by advanced settings in your access control policy. Network analysis-related preprocessing occurs after Security Intelligence blacklisting, but before access control rules inspect packets in detail, and before any intrusion or file inspection begins.
 
    [bookmark: pgfId-1577248]By default, the system uses the Balanced Security and Connectivity network analysis policy to preprocess all traffic handled by an access control policy. However, you can choose a different default network analysis policy to perform this preprocessing. For your convenience, the system provides a choice of several non-modifiable network analysis policies, which are tuned for a specific balance of security and connectivity by the Vulnerability Research Team (VRT). You can also replace this default policy with a custom network analysis policy with custom preprocessing settings.
 
     
      
    
 
    
 
    [bookmark: pgfId-1577229]Tip System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules. Understanding Network Analysis and Intrusion Policies provides an overview of how network analysis and intrusion policies work together to examine your traffic, as well as some basics on using the navigation panel, resolving conflicts, and committing changes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1577191]You can also tailor traffic preprocessing options to specific security zones, and networks by creating multiple custom network analysis policies, then assigning them to preprocess different traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1578683]Note Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. The system does not coordinate the policies for you, and uses default options in cases of misconfiguration. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1589200]This chapter explains how to create a simple custom network analysis policy. This chapter also contains basic information on managing network analysis policies: editing, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-1540876]Creating a Custom Network Analysis Policy
 
     	 [bookmark: pgfId-1550931]Managing Network Analysis Policies
 
     	 [bookmark: pgfId-1556675]Allowing Preprocessors to Affect Traffic in Inline Deployments
 
     	 [bookmark: pgfId-1556679]Generating a Report of Current Network Analysis Settings
 
     	 [bookmark: pgfId-1556683]Comparing Two Network Analysis Policies or Revisions
 
    
 
   
 
    
     [bookmark: pgfId-1577154][bookmark: 47884]Creating a Custom Network Analysis Policy
 
    [bookmark: pgfId-1577158]License: Any
 
    [bookmark: pgfId-1577144]When you create a new network analysis policy you must give it a unique name, specify a base policy, and choose an inline mode.
 
    [bookmark: pgfId-1585080]The base policy defines the network analysis policy’s default settings. Modifying a setting in the new policy overrides—but does not change—the settings in the base policy. You can use either a system-provided or custom policy as your base policy. For more information, see Understanding the Base Layer.
 
    [bookmark: pgfId-1577119]The network analysis policy’s inline mode allows preprocessors to modify (normalize) and drop traffic to minimize the chances of attackers evading detection. Note that in passive deployments, the system cannot affect traffic flow regardless of the inline mode. For more information, see Allowing Preprocessors to Affect Traffic in Inline Deployments.
 
    [bookmark: pgfId-1577107]To create a network analysis policy:
 
    
 
    [bookmark: pgfId-1593892]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1577090]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1594004]The access control policy editor appears.
 
    [bookmark: pgfId-1593939]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1593945]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1594125]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1594430]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1594482]The Network Analysis Policy List pop-up window appears.
 
    [bookmark: pgfId-1593950]Step 6 Click Create Policy.
 
    [bookmark: pgfId-1582005]If you have unsaved changes in another policy, click Cancel when prompted to return to the Network Analysis Policy page. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1577066]The Create Network Analysis Policy pop-up window appears.
 
    [bookmark: pgfId-1577067]Step 7 Give the policy a unique Name and, optionally, a Description.
 
    [bookmark: pgfId-1533958]Step 8 Specify the initial Base Policy.
 
    [bookmark: pgfId-1534432]You can either use either a system-provided or custom policy as your base policy.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1541867] 
     Caution Do 
     not use 
     Experimental Policy 1 unless instructed to do so by a Cisco representative. Cisco uses this policy for testing. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1587770]Step 9 Specify whether you want to allow preprocessors to affect traffic in an inline deployment:
 
     
      
      	 [bookmark: pgfId-1587771]To allow preprocessors to affect traffic, enable  Inline Mode .
 
      	 [bookmark: pgfId-1587772]To prevent preprocessors from affecting traffic, disable  Inline Mode .
 
     
 
    
 
    [bookmark: pgfId-1577058]Step 10 Create the policy:
 
     
      
      	 [bookmark: pgfId-1577059]Click  Create Policy to create the new policy and return to the Network Analysis Policy page. The new policy has the same settings as its base policy.
 
      	 [bookmark: pgfId-1577051]Click  Create and Edit Policy to create the policy and open it for editing in the advanced network analysis policy editor; see Editing Network Analysis Policies.
 
     
 
    
 
    [bookmark: pgfId-1577055]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1577043][bookmark: 13111]Managing Network Analysis Pol[bookmark: marker-1577042]icies
 
    [bookmark: pgfId-1577047]License: Any
 
    [bookmark: pgfId-1589491]On the Network Analysis Policy page you can view your current custom network analysis policies, along with the following information:
 
     
     	 [bookmark: pgfId-1577023]the time and date the policy was last modified (in local time) and the user who modified it
 
     	 [bookmark: pgfId-1577017]whether the  Inline Mode setting is enabled, which allows preprocessors to affect traffic
 
     	 [bookmark: pgfId-1577018]which access control policies are using the network analysis policy to preprocess traffic
 
     	 [bookmark: pgfId-1577019]whether a policy has unsaved changes, as well as information about who (if anyone) is currently editing the policy
 
    
 
     
     
 
     
 
      
       
       [bookmark: pgfId-1577974]Table 15-1 [bookmark: 22107]Network Analysis Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1577980]To... 
         
  
        	 
          
          [bookmark: pgfId-1577982]You can... 
         
  
        	 
          
          [bookmark: pgfId-1577984]See... 
         
  
       
 
        
        	[bookmark: pgfId-1577986]create a new network analysis policy
  
        	[bookmark: pgfId-1577988]click Create Policy.
  
        	[bookmark: pgfId-1577992]Creating a Custom Network Analysis Policy.
  
       
 
        
        	[bookmark: pgfId-1577995]edit an existing network analysis policy
  ). 
        	[bookmark: pgfId-1578004]Editing Network Analysis Policies.
  
       
 
        
        	[bookmark: pgfId-1578007]view a PDF report that lists the current configuration settings in a network analysis policy
  ). 
        	[bookmark: pgfId-1578016]Generating a Report of Current Network Analysis Settings
  
       
 
        
        	[bookmark: pgfId-1578019]compare the settings of two network analysis policies or two revisions of the same policy
  
        	[bookmark: pgfId-1578021]click Compare Policies.
  
        	[bookmark: pgfId-1578025]Comparing Two Network Analysis Policies or Revisions.
  
       
 
        
        	[bookmark: pgfId-1578028]delete a network analysis policy
  
        	 ), then confirm that you want to delete the policy. You cannot delete a network analysis policy if an access control policy references it.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1578038][bookmark: 64212]Editing Network Analysis Policies
 
    [bookmark: pgfId-1578042]License: Any
 
    [bookmark: pgfId-1577951]When you create a new network analysis policy, it has the same settings as its base policy. The following table lists the most common actions you can take to tailor the new policy to your needs:
 
    [bookmark: pgfId-1591083]
 
     
      
       
       [bookmark: pgfId-1591027]Table 15-2 [bookmark: 35642]Network Analysis Policy Editing Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1591033]To... 
         
  
        	 
          
          [bookmark: pgfId-1591035]You can... 
         
  
        	 
          
          [bookmark: pgfId-1591037]See... 
         
  
       
 
        
        	[bookmark: pgfId-1591039]allow preprocessors to modify or drop traffic
  
        	[bookmark: pgfId-1591041]select the Inline Mode check box on the Policy Information page.
  
        	[bookmark: pgfId-1591045]Allowing Preprocessors to Affect Traffic in Inline Deployments
  
       
 
        
        	[bookmark: pgfId-1591048]change the base policy
  
        	[bookmark: pgfId-1591050]select a base policy from the Base Policy drop-down list on the Policy Information page.
  
        	[bookmark: pgfId-1591055]Changing the Base Policy
  
       
 
        
        	[bookmark: pgfId-1591057]view the settings in the base policy
  
        	[bookmark: pgfId-1591059]click Manage Base Policy on the Policy Information page.
  
        	[bookmark: pgfId-1591063]Understanding the Base Layer
  
       
 
        
        	[bookmark: pgfId-1591066]enable, disable, or edit the settings for a preprocessor
  
        	[bookmark: pgfId-1591068]click Settings in the navigation panel.
  
        	[bookmark: pgfId-1591072]Configuring Preprocessors in a Network Analysis Policy
  
       
 
        
        	[bookmark: pgfId-1591075]manage policy layers
  
        	[bookmark: pgfId-1591077]click Policy Layers in the navigation panel.
  
        	[bookmark: pgfId-1591081]Using Layers in a Network Analysis or Intrusion Policy
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1591084]When tailoring a network analysis policy, especially when disabling preprocessors, keep in mind that some preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy module interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1591085]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1591089]The system caches one network analysis policy per user. While editing a network analysis policy, if you select any menu or other path to another page, your changes stay in the system cache even if you leave the page. In addition to the actions you can perform in the table above, Understanding Network Analysis and Intrusion Policies provides information on using the navigation panel, resolving conflicts, and committing changes.
 
    [bookmark: pgfId-1576768]To edit a network analysis policy:
 
    
 
    [bookmark: pgfId-1595357]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1595358]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1594613]The access control policy editor appears.
 
    [bookmark: pgfId-1594614]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1594615]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1594620]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1594621]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1576761]The Network Analysis Policy List pop-up window appears.
 ) next to the network analysis policy you want to configure. 
    
 
    [bookmark: pgfId-1576745]The network analysis policy editor appears, focused on the Policy Information page and with a navigation panel on the left.
 
    [bookmark: pgfId-1566984]Step 7 Edit your policy. Take any of the actions summarized above. 
 
    [bookmark: pgfId-1566985]Step 8 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
    [bookmark: pgfId-1576730]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1577607][bookmark: 93417]Allowing Preprocessors to Affect Traffic in Inline Deployments
 
     [bookmark: pgfId-1588486]License: Any
 
     [bookmark: pgfId-1588488]In an inline deployment, some preprocessors can modify and block traffic. For example:
 
      
      	 [bookmark: pgfId-1588489]The inline normalization preprocessor normalizes packets to prepare them for analysis by other preprocessors and the intrusion rules engine. You can also use the preprocessor’s  Block Unrecoverable TCP Header Anomalies and  Allow These TCP Options  options to block certain packets. For more information, see Normalizing Inline Traffic.
 
      	 [bookmark: pgfId-1580814]The system can drop packets with invalid checksums; see Verifying Checksums.
 
      	 [bookmark: pgfId-1580815]The system can drop packets matching rate-based attack prevention settings; see Preventing Rate-Based Attacks.
 
     
 
     [bookmark: pgfId-1588290]For a preprocessor configured in the network analysis policy to affect traffic, you must also enable and correctly configure the preprocessor, as well as correctly deploy the device inline. Finally, you must enable the network analysis policy’s Inline Mode setting.
 
     [bookmark: pgfId-1595425]If you want to assess how your configuration would function in an inline deployment without actually modifying traffic, you can disable inline mode. Note that in passive deployments, the system cannot affect traffic regardless of the inline mode.
 
      
       
     
 
     
 
     [bookmark: pgfId-1595429]Tip In an inline deployment, Cisco recommends that you enable inline mode and configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. In a passive deployment,Cisco recommends you configure adaptive profiles. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1577632]To allow preprocessors to affect traffic in an inline deployment:
 
     
 
     [bookmark: pgfId-1594669]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1594670]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1594675]The access control policy editor appears.
 
     [bookmark: pgfId-1594676]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1594677]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1594682]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1594683]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1577638]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1577643]The Policy Information page appears.
 
     [bookmark: pgfId-1577644]Step 7 Specify whether you want to allow preprocessors to affect traffic:
 
      
       
       	 [bookmark: pgfId-1577645]To allow preprocessors to affect traffic, enable  Inline Mode .
 
       	 [bookmark: pgfId-1588428]To prevent preprocessors from affecting traffic, disable  Inline Mode .
 
      
 
     
 
     [bookmark: pgfId-1588430]Step 8 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1577651]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1576733][bookmark: 13049]Configuring Preprocessors in a Network Analysis Policy
 
     [bookmark: pgfId-1576737]License: Any
 
      
      [bookmark: pgfId-1588597] 
       Preprocessors prepare traffic to be further inspected by normalizing traffic and identifying protocol anomalies. Preprocessors generate preprocessor event when packets trigger preprocessor options that you configure. The base policy for your network analysis policy determines which preprocessors are enabled by default and the default configuration for each. 
     
 
     [bookmark: pgfId-1576719]When you select Settings in the navigation panel of a network analysis policy, the policy lists its preprocessors by type. On the Settings page, you can enable or disable preprocessors in your network analysis policy, as well as access preprocessor configuration pages.
 
     [bookmark: pgfId-1576705]A preprocessor must be enabled for you to configure it. When you enable a preprocessor, a sublink to the configuration page for the preprocessor appears beneath the Settings link in the navigation panel, and an Edit link to the configuration page appears next to the preprocessor on the Settings page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1584831]Tip To revert a preprocessor’s configuration to the settings in the base policy, click Revert to Defaults on a preprocessor configuration page. When prompted, confirm that you want to revert.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1584781]When you disable a preprocessor, the sublink and Edit link no longer appear, but your configurations are retained. Note that to perform their particular analysis, many preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy module interface.
 
      
       
     
 
     
 
     [bookmark: pgfId-1587242]Note In most cases, preprocessors require specific expertise to configure and typically require little or no modification. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. For more information, see Limitations of Custom Policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1587246]Modifying a preprocessor configuration requires an understanding of the configuration and its potential impact on your network. The following sections provide links to specific configuration details for each preprocessor.
 
     [bookmark: pgfId-1570154]Application Layer Preprocessors 
 
      
       
        
        [bookmark: pgfId-1570161]Table 15-3 Application Layer Preprocessor Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1570165]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1570167]See... 
          
  
        
 
         
         	[bookmark: pgfId-1570169]DCE/RPC Configuration
  
         	[bookmark: pgfId-1570174]Decoding DCE/RPC Traffic
  
        
 
         
         	[bookmark: pgfId-1570176]DNS Configuration
  
         	[bookmark: pgfId-1570181]Detecting Exploits in DNS Name Server Responses
  
        
 
         
         	[bookmark: pgfId-1570183]FTP and Telnet Configuration
  
         	[bookmark: pgfId-1570188]Decoding FTP and Telnet Traffic
  
        
 
         
         	[bookmark: pgfId-1570190]HTTP Configuration
  
         	[bookmark: pgfId-1572998]Decoding HTTP Traffic
  
        
 
         
         	[bookmark: pgfId-1570197]Sun RPC Configuration
  
         	[bookmark: pgfId-1573003]Using the Sun RPC Preprocessor
  
        
 
         
         	[bookmark: pgfId-1570204]SIP Configuration
  
         	[bookmark: pgfId-1573008]Decoding the Session Initiation Protocol
  
        
 
         
         	[bookmark: pgfId-1570211]GTP Command Channel Configuration
  
         	[bookmark: pgfId-1573013]Configuring the GTP Command Channel
  
        
 
         
         	[bookmark: pgfId-1570218]IMAP Configuration
  
         	[bookmark: pgfId-1573018]Decoding IMAP Traffic
  
        
 
         
         	[bookmark: pgfId-1570225]POP Configuration
  
         	[bookmark: pgfId-1573023]Decoding POP Traffic
  
        
 
         
         	[bookmark: pgfId-1570232]SMTP Configuration
  
         	[bookmark: pgfId-1573028]Decoding SMTP Traffic
  
        
 
         
         	[bookmark: pgfId-1570239]SSH Configuration
  
         	[bookmark: pgfId-1573033]Detecting Exploits Using the SSH Preprocessor
  
        
 
         
         	[bookmark: pgfId-1570246]SSL Configuration
  
         	[bookmark: pgfId-1573038]Using the SSL Preprocessor
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1570636]SCADA Preprocessors
 
      
       
        
        [bookmark: pgfId-1570643]Table 15-4 SCADA Preprocessor Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1570647]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1570649]See... 
          
  
        
 
         
         	[bookmark: pgfId-1570651]Modbus Configuration
  
         	[bookmark: pgfId-1570655]Configuring the Modbus Preprocessor
  
        
 
         
         	[bookmark: pgfId-1570658]DNP3 Configuration
  
         	[bookmark: pgfId-1570663]Configuring the DNP3 Preprocessor
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1565910]Transport/Network Layer Preprocessors
 
      
       
        
        [bookmark: pgfId-1570765]Table 15-5 Transport and Network Layer Preprocessor Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1570769]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1570771]See... 
          
  
        
 
         
         	[bookmark: pgfId-1570773]Checksum Verification
  
         	[bookmark: pgfId-1570778]Verifying Checksums
  
        
 
         
         	[bookmark: pgfId-1570787]Inline Normalization
  
         	[bookmark: pgfId-1570792]Normalizing Inline Traffic
  
        
 
         
         	[bookmark: pgfId-1570794]IP Defragmentation
  
         	[bookmark: pgfId-1570799]Defragmenting IP Packets
  
        
 
         
         	[bookmark: pgfId-1570801]Packet Decoding
  
         	[bookmark: pgfId-1570806]Understanding Packet Decoding
  
        
 
         
         	[bookmark: pgfId-1570808]TCP Stream Configuration
  
         	[bookmark: pgfId-1570813]Using TCP Stream Preprocessing
  
        
 
         
         	[bookmark: pgfId-1570815]UDP Stream Configuration
  
         	[bookmark: pgfId-1570820]Using UDP Stream Preprocessing
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1592957]Note that some advanced transport and network preprocessor settings apply globally to all networks and zones where you apply your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy; see Configuring Advanced Transport/Network Settings.
 
     [bookmark: pgfId-1565940]Specific Threat Detection
 
      
       
        
        [bookmark: pgfId-1571383]Table 15-6 Specific Threat Detection Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1571387]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1571389]See... 
          
  
        
 
         
         	[bookmark: pgfId-1571391]Back Orifice Detection
  
         	[bookmark: pgfId-1571396]Detecting Back Orifice
  
        
 
         
         	[bookmark: pgfId-1571398]Portscan Detection
  
         	[bookmark: pgfId-1571403]Detecting Portscans
  
        
 
         
         	[bookmark: pgfId-1571405]Rate-Based Attack Prevention
  
         	[bookmark: pgfId-1571410]Preventing Rate-Based Attacks
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1565954]Note that you configure the sensitive data preprocessor, which detects sensitive data such as credit card numbers and Social Security numbers in ASCII text, in intrusion policies. For more information, see Detecting Sensitive Data.
 
    
 
   
 
    
     [bookmark: pgfId-1576581][bookmark: 83426]Generating a Report of Current Network Analysis Settings
 
    [bookmark: pgfId-1576585]License: Any
 
    [bookmark: pgfId-1576574]A network analysis policy report is a record of the policy configuration at a specific point in time. The system combines the settings in the base policy with the settings of the policy layers, and makes no distinction between which settings originated in the base policy or policy layer.
 
     
      
       
       [bookmark: pgfId-1576541]Table 15-7 [bookmark: 84936]Network Analysis Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-1576545]Section 
         
  
        	 
          
          [bookmark: pgfId-1576547]Description 
         
  
       
 
        
        	[bookmark: pgfId-1576549]Policy Information
  
        	[bookmark: pgfId-1576551]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified. Also indicates whether inline normalization can be enabled, the current rule update version, and whether the base policy is locked to the current rule update.
  
       
 
        
        	[bookmark: pgfId-1576553]Settings
  
        	[bookmark: pgfId-1576555]Lists all enabled preprocessor settings and their configurations.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1576557]You can also generate a comparison report that compares two network analysis policies, or two revisions of the same policy. For more information, see Comparing Two Network Analysis Policies or Revisions.
 
    [bookmark: pgfId-1576528]To view a network analysis policy report:
 
    
 
    [bookmark: pgfId-1594738]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1594739]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1594744]The access control policy editor appears.
 
    [bookmark: pgfId-1594745]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1594746]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1594751]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1594752]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1576521]The Network Analysis Policy List pop-up window appears.
 ) next to the policy for which you want to generate a report. Remember to commit any changes before you generate a network analysis policy report; only committed changes appear in the report. 
    
 
    [bookmark: pgfId-1595546]The system generates the report. You are prompted to save the report to your computer.
 
    [bookmark: pgfId-1576494]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1576498][bookmark: 48726]Comparing Two Network Analysis Policies or Revi[bookmark: marker-1576497]sions
 
    [bookmark: pgfId-1546181]License: Any
 
    [bookmark: pgfId-1576491]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two network analysis policies. You can compare any two network analysis policies or two revisions of the same network analysis policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies or policy revisions.
 
    [bookmark: pgfId-1576481]There are two tools you can use to compare network analysis policies or policy revisions:
 
     
     	 [bookmark: pgfId-1576482]The comparison view displays only the differences between two network analysis policies or network analysis policy revisions in a side-by-side format; the name of each policy or policy revision appears in the title bar on the left and right sides of the comparison view.
 
    
 
    [bookmark: pgfId-1576469]You can use this to view and navigate both policy revisions on the module interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-1576470]The comparison report creates a record of only the differences between two network analysis policies or network analysis policy revisions in a format similar to the network analysis policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-1572698]You can use this to save, copy, print and share your policy comparisons for further examination.
 
    [bookmark: pgfId-1546189]For more information on understanding and using the policy comparison tools, see:
 
     
     	 [bookmark: pgfId-1546193]Using the Network Analysis Policy Comparison View
 
     	 [bookmark: pgfId-1576454]Using the Network Analysis Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-1576456][bookmark: 29486]Using the Network Analysis Policy Comparison View
 
     [bookmark: pgfId-1576460]License: Any
 
     [bookmark: pgfId-1546204]The comparison view displays both policies or policy revisions in a side-by-side format, with each policy or policy revision identified by name in the title bar on the left and right sides of the comparison view. The time of last modification and the last user to modify are displayed with the policy name.
 
     [bookmark: pgfId-1546205]Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-1546206]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-1546207]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
     [bookmark: pgfId-1546208]You can perform any of the actions in the following table.
 
     [bookmark: pgfId-1576436]
 
      
       
        
        [bookmark: pgfId-1576400]Table 15-8 [bookmark: 91381]Network Analysis Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1576404]To... 
          
  
         	 
           
           [bookmark: pgfId-1576406]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1576408]navigate individually through changes
  
         	[bookmark: pgfId-1576410]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-1576424]generate a new policy comparison view
  
         	[bookmark: pgfId-1576426]click New Comparison.
 [bookmark: pgfId-1576429]The Select Comparison window appears. See Using the Network Analysis Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-1576432]generate a policy comparison report
  
         	[bookmark: pgfId-1576434]click Comparison Report. 
 [bookmark: pgfId-1576435]The policy comparison report creates a PDF document that lists only the differences between the two policies or policy revisions.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1576440][bookmark: 14990]Using the Network Analysis Policy Comp[bookmark: marker-1576439]arison Report
 
     [bookmark: pgfId-1576390]License: Any
 
     [bookmark: pgfId-1576391]A network analysis policy comparison report is a record of all differences between two network analysis policies or two revisions of the same network analysis policy identified by the network analysis policy comparison view, presented as a PDF. You can use this report to further examine the differences between two network analysis policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-1576371]You can generate a network analysis policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-1576360]The format of the policy comparison report is the same as the policy report with one exception: the policy report contains all configurations in the policy, and the policy comparison report lists only those configurations that differ between the policies. A network analysis policy comparison report contains the sections described in Table 15-7.
 
      
       
     
 
     
 
     [bookmark: pgfId-1576352]Tip You can use a similar procedure to compare access control, intrusion, or file policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1576353]To compare two network analysis policies or policy revisions:
 
     
 
     [bookmark: pgfId-1594789]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1594790]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1594795]The access control policy editor appears.
 
     [bookmark: pgfId-1594796]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1594797]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1594802]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1594803]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1576349]The Network Analysis Policy List pop-up window appears.
 
     [bookmark: pgfId-1576341]Step 6 Click Compare Policies.
 
     [bookmark: pgfId-1546266]The Select Comparison window appears.
 
     [bookmark: pgfId-1546267]Step 7 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-1546268]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-1546269]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-1546270]To compare two revisions of the same policy, select  Other Revision. 
 
      
 
     
 
     [bookmark: pgfId-1546271]The page refreshes and the Policy, Revision A, and Revision B drop-down lists appear.
 
     [bookmark: pgfId-1546272]Step 8 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1546742]If you are comparing two different policies, select the policies you want to compare from the Policy A and Policy B drop-down lists.
 
       	 [bookmark: pgfId-1546743]If you are comparing two revision of the same policy, select the Policy, then select the timestamped revisions you want to compare from the Revision A and Revision B drop-down lists.
 
      
 
     
 
     [bookmark: pgfId-1546275]Step 9 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-1576334]The comparison view appears.
 
     [bookmark: pgfId-1593323]Step 10 Optionally, click Comparison Report to generate the network analysis policy comparison report. 
 
     [bookmark: pgfId-1593325]The network analysis policy comparison report appears. You are prompted to save the report to your computer.
 
     [bookmark: pgfId-1546279]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1600148][bookmark: 20122]Using Applic[bookmark: marker-1600147]ation Layer Preprocessors 
      
      
 
     
 
 
    [bookmark: pgfId-1600149]You configure application layer preprocessors in a network analysis policy, which prepares traffic for inspection using the rules enabled in an intrusion policy. See Understanding Network Analysis and Intrusion Policies for more information.
 
    [bookmark: pgfId-1598241]Application-layer protocols can represent the same data in a variety of ways. Cisco provides application layer protocol decoders that normalize specific types of packet data into formats that the intrusion rules engine can analyze. Normalizing application-layer protocol encodings allows the rules engine to effectively apply the same content-related rules to packets whose data is represented differently and obtain meaningful results.
 
    [bookmark: pgfId-1531613]Note that preprocessors do not generate events in most cases unless you enable the accompanying preprocessor rules in an intrusion policy. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531617]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531621]Decoding DCE/RPC Traffic describes the DCE/RPC preprocessor and explains how to configure it to prevent evasion attempts and detect anomalies in DCE/RPC traffic.
 
     	 [bookmark: pgfId-1531625]Detecting Exploits in DNS Name Server Responses describes the DNS preprocessor and explains how to configure it to detect any of three specific exploits in DNS name server responses.
 
     	 [bookmark: pgfId-1531629]Decoding FTP and Telnet Traffic describes the FTP/Telnet decoder and explains how to configure it to normalize and decode FTP and Telnet traffic.
 
     	 [bookmark: pgfId-1531633]Decoding HTTP Traffic describes the HTTP decoder and explains how to configure it to normalize HTTP traffic.
 
     	 [bookmark: pgfId-1531637]Using the Sun RPC Preprocessor describes the RPC decoder and explains how to configure it to normalize RPC traffic.
 
     	 [bookmark: pgfId-1531641]Decoding the Session Initiation Protocol explains how you can use the SIP preprocessor to decode and detect anomalies in SIP traffic. 
 
     	 [bookmark: pgfId-1531645]Configuring the GTP Command Channel explains how you can use the GTP preprocessor to provide the rules engine with GTP command channel messages extracted by the packet decoder.
 
     	 [bookmark: pgfId-1531649]Decoding IMAP Traffic explains how you can use the IMAP preprocessor to decode and detect anomalies in IMAP traffic.
 
     	 [bookmark: pgfId-1531653]Decoding POP Traffic explains how you can use the POP preprocessor to decode and detect anomalies in POP traffic.
 
     	 [bookmark: pgfId-1531657]Decoding SMTP Traffic describes the SMTP decoder and explains how to configure it to decode and normalize SMTP traffic.
 
     	 [bookmark: pgfId-1531661]Detecting Exploits Using the SSH Preprocessor explains how to identify and process exploits in SSH-encrypted traffic.
 
     	 [bookmark: pgfId-1531665]Using the SSL Preprocessor explains how you can use the SSL preprocessor to identify encrypted traffic and eliminate false positives by stopping inspection of that traffic. 
 
     	 [bookmark: pgfId-1531669]Configuring SCADA Preprocessing explains how you can use the Modbus and DNP3 preprocessors to detect anomalies in corresponding traffic and provide data to the intrusion rules engine for inspection of certain protocol fields.
 
    
 
   
 
    
     [bookmark: pgfId-1531674][bookmark: 18799]Dec[bookmark: DCERPC]odin[bookmark: marker-1531672]g DC[bookmark: marker-1531673]E/RPC Traffic
 
    [bookmark: pgfId-1531681]License: Protection
 
    [bookmark: pgfId-1531682]The DCE/RPC protocol allows processes on separate network hosts to communicate as if the processes were on the same host. These inter-process communications are commonly transported between hosts over TCP and UDP. Within the TCP transport, DCE/RPC might also be further encapsulated in the Windows Server Message Block (SMB) protocol or in Samba, an open-source SMB implementation used for inter-process communication in a mixed environment comprised of Windows and UNIX- or Linux-like operating systems. In addition, Windows IIS web servers on your network might use IIS RPC over HTTP, which provides distributed communication through a firewall, to proxy TCP-transported DCE/RPC traffic.
 
    [bookmark: pgfId-1531683]Note that descriptions of DCE/RPC preprocessor options and functionality include the Microsoft implementation of DCE/RPC known as MSRPC; descriptions of SMB options and functionality refer to both SMB and Samba.
 
    [bookmark: pgfId-1531684]Although most DCE/RPC exploits occur in DCE/RPC client requests targeted for DCE/RPC servers, which could be practically any host on your network that is running Windows or Samba, exploits can also occur in server responses. The DCE/RPC preprocessor detects DCE/RPC requests and responses encapsulated in TCP, UDP, and SMB transports, including TCP-transported DCE/RPC using version 1 RPC over HTTP. The preprocessor analyzes DCE/RPC data streams and detects anomalous behavior and evasion techniques in DCE/RPC traffic. It also analyzes SMB data streams and detects anomalous SMB behavior and evasion techniques.
 
    [bookmark: pgfId-1531685]The DCE/RPC preprocessor also desegments SMB and defragments DCE/RPC in addition to the IP defragmentation provided by the IP defragmentation preprocessor and the TCP stream reassembly provided by the TCP stream preprocessor. See Using TCP Stream Preprocessing and Defragmenting IP Packets.
 
    [bookmark: pgfId-1531692]Finally, the DCE/RPC preprocessor normalizes DCE/RPC traffic for processing by the rules engine. See DCE/RPC Keywords for information on using specific DCE/RPC rule keywords to detect DCE/RPC services, operations, and stub data.
 
    [bookmark: pgfId-1531696]You configure the DCE/RPC preprocessor by modifying any of the global options that control how the preprocessor functions, and by specifying one or more target-based server policies that identify the DCE/RPC servers on your network by IP address and by either the Windows or Samba version running on them:
 
    [bookmark: pgfId-1531697]You must enable DCE/RPC preprocessor rules, which have a generator ID (GID) of 132 or 133, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531711]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531715]Selecting Global DCE/RPC Options
 
     	 [bookmark: pgfId-1531719]Understanding Target-Based DCE/RPC Server Policies
 
     	 [bookmark: pgfId-1531723]Understanding DCE/RPC Transports
 
     	 [bookmark: pgfId-1531727]Selecting DCE/RPC Target-Based Policy Options
 
     	 [bookmark: pgfId-1531731]Configuring the DCE/RPC Preprocessor
 
    
 
     
      [bookmark: pgfId-1531734][bookmark: 21864]Selectin[bookmark: marker-1531733]g Global DCE/RPC Options
 
     [bookmark: pgfId-1531741]License: Protection
 
     [bookmark: pgfId-1531742]Global DCE/RPC preprocessor options control how the preprocessor functions. Except for the Memory Cap Reached option, modifying these options could have a negative impact on performance or detection capability. You should not modify them unless you have a thorough understanding of the preprocessor and the interaction between the preprocessor and enabled DCE/RPC rules. In particular, make sure that the Maximum Fragment Size option and Reassembly Threshold option are greater than or equal to the depth to which the rules need to detect. For more information, see Constraining Content Matches and Using Byte_Jump and Byte_Test.
 
     [bookmark: pgfId-1531749]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531751]Max[bookmark: marker-1531750]imum Fragment Size
 
     [bookmark: pgfId-1531752]When Enable Defragmentation is selected, specifies the maximum DCE/RPC fragment length allowed from 1514 to 65535 bytes. The preprocessor truncates larger fragments for processing purposes to the specified size before defragmenting but does not alter the actual packet. A blank field disables this option.
 
     [bookmark: pgfId-1531754]Reas[bookmark: marker-1531753]sembly Threshold
 
     [bookmark: pgfId-1531755]When Enable Defragmentation is selected, 0 disables this option, or 1 to 65535 bytes specifies a minimum number of fragmented DCE/RPC bytes and, if applicable, segmented SMB bytes to queue before sending a reassembled packet to the rules engine. A low value increases the likelihood of early detection but could have a negative impact on performance. You should test for performance impact if you enable this option.
 
     [bookmark: pgfId-1531757][bookmark: marker-1531756]Enable Defragmentation
 
     [bookmark: pgfId-1531758]Specifies whether to defragment fragmented DCE/RPC traffic. When disabled, the preprocessor still detects anomalies and sends DCE/RPC data to the rules engine, but at the risk of missing exploits in fragmented DCE/RPC data.
 
     [bookmark: pgfId-1531759]Although this option provides the flexibility of not defragmenting DCE/RPC traffic, most DCE/RPC exploits attempt to take advantage of fragmentation to hide the exploit. Disabling this option would bypass most known exploits, resulting in a large number of false negatives.
 
     [bookmark: pgfId-1531761][bookmark: marker-1531760]Memory Cap Reached
 
     [bookmark: pgfId-1531762]Detects when the maximum memory limit allocated to the preprocessor is reached or exceeded. When the maximum memory cap is reached or exceeded, the preprocessor frees all pending data associated with the session that caused the memory cap event and ignores the rest of that session.
 
     [bookmark: pgfId-1531766]You can enable rule 133:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531768][bookmark: 34134]Auto-Detect Policy on SMB Session
 
     [bookmark: pgfId-1531769]Detects the Windows or Samba version that is identified in SMB Session Setup AndX requests and responses. When the detected version is different from the Windows or Samba version configured for the Policy configuration option, the detected version overrides the configured version for that session only. See Understanding Target-Based DCE/RPC Server Policies for more information.
 
     [bookmark: pgfId-1531773]For example, if you set Policy to Windows XP and the preprocessor detects Windows Vista, the preprocessor uses a Windows Vista policy for that session. Other settings remain in effect. 
 
     [bookmark: pgfId-1531774]When the DCE/RPC transport is not SMB (that is, when the transport is TCP or UDP), the version cannot be detected and the policy cannot be automatically configured.
 
     [bookmark: pgfId-1531775]To enable this option, select one of the following from the drop-down list:
 
     [bookmark: pgfId-1531776] – Select Client to inspect server-to-client traffic for the policy type.
 
     [bookmark: pgfId-1531777] – Select Server to inspect client-to-server traffic for the policy type.
 
     [bookmark: pgfId-1531778] – Select Both to inspect server-to-client and client-to-server traffic for the policy type.
 
    
 
     
      [bookmark: pgfId-1531781][bookmark: 28081]Understanding[bookmark: marker-1531780] Target-Based DCE/RPC Server Policies
 
     [bookmark: pgfId-1531788]License: Protection
 
     [bookmark: pgfId-1531789]You can create one or more target-based server policies to configure the DCE/RPC preprocessor to inspect DCE/RPC traffic the same as a specified type of server would process it. Target-based policy configuration includes identifying the Windows or Samba version running on hosts you identify on your network, enabling transport protocols and specifying the ports carrying DCE/RPC traffic to those hosts, and setting other server-specific options.
 
     [bookmark: pgfId-1531790]Windows and Samba DCE/RPC implementations differ significantly. For example, all versions of Windows use the DCE/RPC context ID in the first fragment when defragmenting DCE/RPC traffic, and all versions of Samba use the context ID in the last fragment. As another example, Windows Vista uses the opnum (operation number) header field in the first fragment to identify a specific function call, and Samba and all other Windows versions use the opnum field in the last fragment.
 
     [bookmark: pgfId-1531791]There are also significant differences in Windows and Samba SMB implementations. For example, Windows recognizes the SMB OPEN and READ commands when working with named pipes, but Samba does not recognize these commands.
 
     [bookmark: pgfId-1531792]When you enable the DCE/RPC preprocessor, you automatically enable a default target-based policy. Optionally, you can add target-based policies that target other hosts running different Windows or Samba versions by selecting the correct version from the Policy drop-down list. The default target-based policy applies to any host not included in another target-based policy.
 
     [bookmark: pgfId-1531793]In each target-based policy, you can enable one or more transports and specify detection ports for each. You can also enable and specify auto-detection ports. See Understanding DCE/RPC Transports for more information.
 
     [bookmark: pgfId-1531797]You can also configure other target-based policy options. You can set the preprocessor to detect when there is an attempt to connect to one or more shared SMB resources that you identify. You can configure the preprocessor to detect files in SMB traffic, and to inspect a specified number of bytes in a detected file. You can also modify an advanced option that should be modified only by a user with SMB protocol expertise; this option lets you set the preprocessor to detect when a number of chained SMB AndX commands exceed a specified maximum number.
 
     [bookmark: pgfId-1531798]In each target-based policy, you can:
 
      
      	 [bookmark: pgfId-1531799]enable one or more transports and specify  detection ports  for each. 
 
      	 [bookmark: pgfId-1531803]enable and specify  auto-detection ports . See Understanding DCE/RPC Transports for more information.
 
      	 [bookmark: pgfId-1531804]set the preprocessor to detect when there is an attempt to connect to one or more shared SMB resources that you identify. 
 
      	 [bookmark: pgfId-1531805]configure the preprocessor to detect files in SMB traffic, and to inspect a specified number of bytes in a detected file. 
 
      	 [bookmark: pgfId-1531806]modify an advanced option that should be modified only by a user with SMB protocol expertise; this option lets you set the preprocessor to detect when a number of chained SMB AndX commands exceed a specified maximum number.
 
     
 
     [bookmark: pgfId-1531807]Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the policy type configured for a targeted policy on a per session basis when SMB is the DCE/RPC transport. See Auto-Detect Policy on SMB Session.
 
     [bookmark: pgfId-1531811]In addition to enabling SMB traffic file detection in the DCE/RPC preprocessor, you can configure a file policy to optionally capture and block these files. See Creating a File Policy and Working with File Rules for more information.
 
    
 
     
      [bookmark: pgfId-1531823][bookmark: 30205]Understanding DCE/RPC Tra[bookmark: marker-1531822]nsports
 
     [bookmark: pgfId-1531830]License: Protection
 
     [bookmark: pgfId-1531831]In each target-based policy, you can enable one or more of the TCP, UDP, SMB, and RPC over HTTP transports. When you enable a transport, you must also specify one or more detection ports, that is, ports that are known to carry DCE/RPC traffic. Optionally, you can also enable and specify auto-detection ports, that is, ports that the preprocessor tests first to determine if they carry DCE/RPC traffic and continues processing only when it detects DCE/RPC traffic.
 
     [bookmark: pgfId-1531835]Cisco recommends that you use the default detection ports, which are either well-known ports or otherwise commonly-used ports for each protocol. You would add detection ports only if you detected DCE/RPC traffic on a non-default port.
 
     [bookmark: pgfId-1531836]When you enable auto-detection ports, ensure that they are set to the port range from 1024 to 65535 to cover the entire ephemeral port range. Note that it is unlikely that you would enable or specify auto-detection ports for the RPC over HTTP Proxy Auto-Detect Ports option or the SMB Auto-Detect Ports option because there is little likelihood that traffic for either would occur or even be possible except on the specified default detection ports. Note also that auto-detection occurs only for ports not already identified by transport detection ports. See Selecting DCE/RPC Target-Based Policy Options for recommendations for enabling or disabling auto-detection ports for each transport.
 
     [bookmark: pgfId-1531847]You can specify ports for one or more transports in any combination in a Windows target-based policy to match the traffic on your network, but you can only specify ports for the SMB transport in a Samba target-based policy.
 
     [bookmark: pgfId-1531848]Note that you must enable at least one DCE/RPC transport in the default target-based policy except when you have added a DCE/RPC target-based policy that has at least one transport enabled. For example, you might want to specify the hosts for all DCE/RPC implementations and not have the default target-based policy apply to unspecified hosts, in which case you would not enable a transport for the default target-based policy.
 
     [bookmark: pgfId-1531849]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1531853]Understanding Connectionless and Connection-Oriented DCE/RPC Traffic
 
      	 [bookmark: pgfId-1531857]Understanding the RPC over HTTP Transport
 
     
 
    
 
     
      [bookmark: pgfId-1531859][bookmark: 10993]Understanding Connectionless and Connection-Oriented DCE/RPC Traffic
 
     [bookmark: pgfId-1531866]License: Protection
 
     [bookmark: pgfId-1531867]DCE/RPC messages comply with one of two distinct DCE/RPC Protocol Data Unit (PDU) protocols:
 
      
      	 [bookmark: pgfId-1531868]the connection-oriented DCE/RPC PDU protocol
 
     
 
     [bookmark: pgfId-1531869]The DCE/RPC preprocessor detects connection-oriented DCE/RPC in the TCP, SMB, and RPC over HTTP transports.
 
      
      	 [bookmark: pgfId-1531870]the connectionless DCE/RPC PDU protocol
 
     
 
     [bookmark: pgfId-1531871]The DCE/RPC preprocessor detects connectionless DCE/RPC in the UDP transport.
 
     [bookmark: pgfId-1531872]The two DCE/RPC PDU protocols have their own unique headers and data characteristics. For example, the connection-oriented DCE/RPC header length is typically 24 bytes and the connectionless DCE/RPC header length is fixed at 80 bytes. Also, correct fragment order of fragmented connectionless DCE/RPC cannot be handled by a connectionless transport and, instead, must be ensured by connectionless DCE/RPC header values; in contrast, the transport protocol ensures correct fragment order for connection-oriented DCE/RPC. The DCE/RPC preprocessor uses these and other protocol-specific characteristics to monitor both protocols for anomalies and other evasion techniques, and to decode and defragment traffic before passing it to the rules engine.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531882]Note the following in the figure:
 
      
      	 [bookmark: pgfId-1531883]The well-known TCP or UDP port 135 identifies DCE/RPC traffic in the TCP and UDP transports.
 
      	 [bookmark: pgfId-1531884]The figure does not include RPC over HTTP.
 
     
 
     [bookmark: pgfId-1531885]For RPC over HTTP, connection-oriented DCE/RPC is transported directly over TCP as shown in the figure after an initial setup sequence over HTTP. See Understanding the RPC over HTTP Transport for more information.
 
      
      	 [bookmark: pgfId-1531889]The DCE/RPC preprocessor typically receives SMB traffic on the well-known TCP port 139 for the NetBIOS Session Service or the similarly implemented well-known Windows port 445.
 
     
 
     [bookmark: pgfId-1531890]Because SMB has many functions other than transporting DCE/RPC, the preprocessor first tests whether the SMB traffic is carrying DCE/RPC traffic, stops processing if it is not, and continues processing if it is.
 
      
      	 [bookmark: pgfId-1531891]IP encapsulates all DCE/RPC transports.
 
      	 [bookmark: pgfId-1600680]TCP transports all connection-oriented DCE/RPC.
 
      	 [bookmark: pgfId-1600685]UDP transports connectionless DCE/RPC.
 
     
 
    
 
     
      [bookmark: pgfId-1531908][bookmark: 31510]Understandi[bookmark: marker-1531907]ng the RPC over HTTP Transport
 
     [bookmark: pgfId-1531915]License: Protection
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531925]The Microsoft IIS proxy server and the DCE/RPC server can be on the same host or on different hosts. Separate proxy and server options provide for both cases. Note the following in the figure:
 
      
      	 [bookmark: pgfId-1531926]The DCE/RPC server monitors port 593 for DCE/RPC client traffic, but the firewall blocks port 593.
 
     
 
     [bookmark: pgfId-1531927]Firewalls typically block port 593 by default.
 
      
      	 [bookmark: pgfId-1531928]RPC over HTTP transports DCE/RPC over HTTP using well-known HTTP port 80, which firewalls are likely to permit.
 
      	 [bookmark: pgfId-1531929]Example 1 shows that you would select the RPC over HTTP proxy option to monitor traffic between the DCE/RPC client and the Microsoft IIS RPC proxy server.
 
      	 [bookmark: pgfId-1618877]Example 2 shows that you would select the  RPC over HTTP server option when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers.
 
      	 [bookmark: pgfId-1531931]Traffic is comprised solely of connection-oriented DCE/RPC over TCP after RPC over HTTP completes the proxied setup between the DCE/RPC client and server.
 
     
 
    
 
     
      [bookmark: pgfId-1531934][bookmark: 54378]Selecting DCE/RPC T[bookmark: marker-1531933]arget-Based Policy Options
 
     [bookmark: pgfId-1531941]License: Protection
 
     [bookmark: pgfId-1531942]Each target-based policy allows you to specify the various options below. Note that, except for the Memory Cap Reached and Auto-Detect Policy on SMB Session options, modifying these options could have a negative impact on performance or detection capability. You should not modify them unless you have a thorough understanding of the preprocessor and the interaction between the preprocessor and enabled DCE/RPC rules.
 
     [bookmark: pgfId-1531943]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531945][bookmark: marker-1531944]Networks
 
     [bookmark: pgfId-1531946]The host IP addresses where you want to apply the DCE/RPC target-based server policy. 
 
     [bookmark: pgfId-1531947]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 255 total profiles including the default policy. For information on specifying IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1576460]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1576472]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1576462][bookmark: marker-1576461]Policy
 
     [bookmark: pgfId-1531957]The Windows or Samba DCE/RPC implementation used by the targeted host or hosts on your monitored network segment. See Understanding Target-Based DCE/RPC Server Policies for detailed information on these policies.
 
     [bookmark: pgfId-1531961]Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the setting for this option on a per session basis when SMB is the DCE/RPC transport. See Auto-Detect Policy on SMB Session.
 
     [bookmark: pgfId-1531966][bookmark: marker-1531965]SMB Invalid Shares
 
     [bookmark: pgfId-1531967]A case-insensitive, alphanumeric text string that identifies one or more SMB shared resources; the preprocessor will detect when there is an attempt to connect to a shared resource that you specify. You can specify multiple shares in a comma-separated list and, optionally, you can enclose shares in quotes, which was required in previous software versions but is no longer required; for example:
 
      
      [bookmark: pgfId-1531968]"C$", D$, "admin", private 
     
 
     [bookmark: pgfId-1531969]The preprocessor detects invalid shares in SMB traffic when you have enabled both SMB ports and SMB traffic detection.
 
     [bookmark: pgfId-1531970]Note that in most cases you should append a dollar sign to a drive named by Windows that you identify as an invalid share. For example, identify drive C as C$ or "C$".
 
     [bookmark: pgfId-1531974]You can enable rule 133:26 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531976][bookmark: marker-1531975]SMB Maximum AndX Chain
 
     [bookmark: pgfId-1531977]The maximum number between 0 and 255 of chained SMB AndX commands to permit. Typically, more than a few chained AndX commands represent anomalous behavior and could indicate an evasion attempt. Specify 1 to permit no chained commands or 0 to disable detecting the number of chained commands.
 
     [bookmark: pgfId-1531978]Note that the preprocessor first counts the number of chained commands and generates an event if accompanying SMB preprocessor rules are enabled and the number of chained commands equals or exceeds the configured value. It then continues processing.
 
      
       
     
 
     
 
     [bookmark: pgfId-1531979]Note Only someone who is expert in the SMB protocol should modify the default setting for this option.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1531983]You can enable rule 133:20 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531985][bookmark: marker-1531984]RPC proxy traffic only
 
     [bookmark: pgfId-1531986]When RPC over HTTP Proxy Ports is enabled, indicates whether detected client-side RPC over HTTP traffic is proxy traffic only or might include other web server traffic. For example, port 80 could carry both proxy and other web server traffic.
 
     [bookmark: pgfId-1531987]When this option is disabled, both proxy and other web server traffic are expected. Enable this option, for example, if the server is a dedicated proxy server. When enabled, the preprocessor tests traffic to determine if it carries DCE/RPC, ignores the traffic if it does not, and continues processing if it does. Note that enabling this option adds functionality only if the RPC over HTTP Proxy Ports check box is also enabled.
 
     [bookmark: pgfId-1531988]RPC over HTTP Proxy Ports
 
     [bookmark: pgfId-1618871]Enables detection of DCE/RPC traffic tunneled by RPC over HTTP over each specified port when your device is positioned between the DCE/RPC client and the Microsoft IIS RPC proxy server. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1531993]When enabled, you can add any ports where you see DCE/RPC traffic, although this is unlikely to be necessary because web servers typically use the default port for both DCE/RPC and other traffic. When enabled, you would not enable RPC over HTTP Proxy Auto-Detect Ports, but you would enable the RPC Proxy Traffic Only when detected client-side RPC over HTTP traffic is proxy traffic only and does not include other web server traffic.
 
     [bookmark: pgfId-1531994]RPC over HTTP Server Ports
 
     [bookmark: pgfId-1531995]Enables detection of DCE/RPC traffic tunneled by RPC over HTTP on each specified port when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1531999]Typically, when you enable this option you should also enable RPC over HTTP Server Auto-Detect Ports with a port range from 1025 to 65535 for that option even if you are not aware of any proxy web servers on your network. Note that the RPC over HTTP server port is sometimes reconfigured, in which case you should add the reconfigured server port to port list for this option.
 
     [bookmark: pgfId-1532000]TCP Ports
 
     [bookmark: pgfId-1532001]Enables detection of DCE/RPC traffic in TCP on each specified port.
 
     [bookmark: pgfId-1532002]Legitimate DCE/RPC traffic and exploits might use a wide variety of ports, and other ports above port 1024 are common. Typically, when this option is enabled you should also enable TCP Auto-Detect Ports with a port range from 1025 to 65535 for that option.
 
     [bookmark: pgfId-1532003]UDP Ports
 
     [bookmark: pgfId-1532004]Enables detection of DCE/RPC traffic in UDP on each specified port.
 
     [bookmark: pgfId-1532005]Legitimate DCE/RPC traffic and exploits might use a wide variety of ports, and other ports above port 1024 are common. Typically, when this option is enabled you should also enable UDP Auto-Detect Ports with a port range from 1025 to 65535 for that option.
 
     [bookmark: pgfId-1532006]SMB Ports
 
     [bookmark: pgfId-1532007]Enables detection of DCE/RPC traffic in SMB on each specified port.
 
     [bookmark: pgfId-1532008]You could encounter SMB traffic using the default detection ports. Other ports are rare. Typically, use the default settings.
 
     [bookmark: pgfId-1532009]RPC over HTTP Proxy Auto-Detect Ports
 
     [bookmark: pgfId-1532010]Enables auto-detection of DCE/RPC traffic tunneled by RPC over HTTP on the specified ports when your device is positioned between the DCE/RPC client and the Microsoft IIS RPC proxy server. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1532014]When enabled, you would typically specify a port range from 1025 to 65535 to cover the entire range of ephemeral ports.
 
     [bookmark: pgfId-1532015]RPC over HTTP Server Auto-Detect Ports
 
     [bookmark: pgfId-1532016]Enables auto-detection of DCE/RPC traffic tunneled by RPC over HTTP on the specified ports when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1532020]TCP Auto-Detect Ports
 
     [bookmark: pgfId-1532021]Enables auto-detection of DCE/RPC traffic in TCP on the specified ports.
 
     [bookmark: pgfId-1532022]UDP Auto-Detect Ports
 
     [bookmark: pgfId-1532023]Enables auto-detection of DCE/RPC traffic in UDP on each specified port.
 
     [bookmark: pgfId-1532024]SMB Auto-Detect Ports
 
     [bookmark: pgfId-1532025]Enables auto-detection of DCE/RPC traffic in SMB.
 
     [bookmark: pgfId-1532026]SMB File Inspection
 
     [bookmark: pgfId-1532027]Enables inspection of SMB traffic for file detection. You have the following options:
 
     [bookmark: pgfId-1532028] – Select Off to disable file inspection.
 
     [bookmark: pgfId-1532029] – Select Only to inspect file data without inspecting the DCE/RPC traffic in SMB. Selecting this option can improve performance over inspecting both files and DCE/RPC traffic. 
 
     [bookmark: pgfId-1532030] – Select On to inspect both files and the DCE/RPC traffic in SMB. Selecting this option can impact performance. 
 
     [bookmark: pgfId-1532031]Inspection of SMB traffic for the following is not supported:
 
     [bookmark: pgfId-1532032] – files transferred in SMB 2.x and SMB 3.x
 
     [bookmark: pgfId-1532033] – files transferred in an established TCP or SMB session before this option is enabled and the policy applied
 
     [bookmark: pgfId-1532034] – files transferred concurrently in a single TCP or SMB session
 
     [bookmark: pgfId-1532035] – files transferred across multiple TCP or SMB sessions
 
     [bookmark: pgfId-1532036] – files transferred with non-contiguous data, such as when message signing is negotiated
 
     [bookmark: pgfId-1532037] – files transferred with different data at the same offset, overlapping the data
 
     [bookmark: pgfId-1532038] – files opened on a remote client for editing that the client saves to the file server
 
     [bookmark: pgfId-1532039]SMB File Inspection Depth
 
     [bookmark: pgfId-1532040]If SMB File Inspection is set to Only or On, the number of bytes inspected when a file is detected in SMB traffic. Specify one of the following: 
 
     [bookmark: pgfId-1532041] – an integer from 1 to 2147483647 (about 2GB)
 
     [bookmark: pgfId-1532042] – 0 to inspect the entire file
 
     [bookmark: pgfId-1532043] – -1 to disable file inspection
 
     [bookmark: pgfId-1532044]Enter a value in this field equal to or smaller than the one defined in your access control policy. If you set a value for this option larger than the one defined for Limit the number of bytes inspected when doing file type detection, the system uses the access control policy setting as the functional maximum.See Tuning File and Malware Inspection Performance and Storage for more information.
 
     [bookmark: pgfId-1532048]If SMB File Inspection is set to Off, this field is disabled.
 
    
 
     
      [bookmark: pgfId-1532052][bookmark: 24129]Configuring the DCE/RPC Preprocessor
 
     [bookmark: pgfId-1532059]License: Protection
 
     [bookmark: pgfId-1532061]You can configure DCE/RPC preprocessor global options and one or more target-based server policies.
 
     [bookmark: pgfId-1532062]The preprocessor does not generate events unless you enable rules with generator ID (GID) 133. See Selecting Global DCE/RPC Options and Selecting DCE/RPC Target-Based Policy Options for rules associated with specific detection options; see also Setting Rule States.
 
     [bookmark: pgfId-1532072]In addition, most DCE/RPC preprocessor rules generate events against anomalies and evasion techniques detected in SMB, connection-oriented DCE/RPC, or connectionless DCE/RPC traffic. The following table identifies the rules that you can enable for each type of traffic.
 
     [bookmark: pgfId-1532099]
 
      
       
        
        [bookmark: pgfId-1532079]Table 16-1 [bookmark: 59387]Traffic-Associated DCE/RPC Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532083]Traffic 
          
  
         	 
           
           [bookmark: pgfId-1532085]Preprocessor Rule GID:SID 
          
  
        
 
         
         	[bookmark: pgfId-1532087]SMB
  
         	[bookmark: pgfId-1532089]133:2 through 133:26, and 133:48 through 133:57
  
        
 
         
         	[bookmark: pgfId-1532091]Connection-Oriented DCE/RPC
  
         	[bookmark: pgfId-1532093]133:27 through 133:39
  
        
 
         
         	[bookmark: pgfId-1532096][bookmark: marker-1532095]Detect Connectionless DCE/RPC
  
         	[bookmark: pgfId-1532098]133:40 through 133:43
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532100]To configure the DCE/RPC preprocessor:
 
     
 
     [bookmark: pgfId-1625140]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1625141]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1620423]The access control policy editor appears.
 
     [bookmark: pgfId-1620424]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1620425]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1620430]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1620431]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1532106]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532111]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532115]The Policy Information page appears.
 
     [bookmark: pgfId-1532117]Step 7 [bookmark: 19245]Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532118]The Settings page appears.
 
     [bookmark: pgfId-1532119]Step 8 You have two choices, depending on whether DCE/RPC Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532120]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532121]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532122]The DCE/RPC Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532129]Step 9 You can modify any of the options described in Selecting Global DCE/RPC Options.
 
     [bookmark: pgfId-1532130]Step 10 You have two options:
 
      
       
       	 [bookmark: pgfId-1532134]Add a new target-based policy. Click the add icon (
 
      
 
      [image: ] ) next to 
       Servers on the left side of the page. The Add Target pop-up window appears. Specify a one or more IP addresses in the 
       Server Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1532135]You can specify a single IP address or address block, or a comma-separated list of either or both. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1532142]You can configure up to 255 policies, including the default policy. 
 
     [bookmark: pgfId-1601119]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1572617]A new entry appears in the list of servers on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1572618]Modify the settings for an existing target-based policy. Click the configured address for a policy you have added under  Servers on the left side of the page, or click  default .
 
      
 
     
 ) next to the policy you want to remove. 
     
 
     [bookmark: pgfId-1532149]Step 11 You can modify any of the following target-based policy options:
 
      
       
       	 [bookmark: pgfId-1532150]To specify the host or hosts where you want to apply the DCE/RPC target-based server policy, enter a single IP address or address block, or a comma-separated list of either or both in the  Networks field.
 
      
 
     
 
     [bookmark: pgfId-1600819]You can specify up to 255 total profiles including the default policy. Note that you cannot modify the setting for Networks in the default policy. The default policy applies to all servers on your network that are not identified in another policy. 
 
      
       
       	 [bookmark: pgfId-1600821]To specify the type of policy you want to apply to the specified host or hosts on your network segment, select one of the Windows or Samba policy types from the  Policy drop-down list.
 
      
 
     
 
     [bookmark: pgfId-1532153]Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the setting for this option on a per session basis when SMB is the DCE/RPC transport. See Auto-Detect Policy on SMB Session.
 
      
       
       	 [bookmark: pgfId-1532157]To set the preprocessor to detect when there is an attempt to connect to specified shared SMB resources, enter a single or comma-separated list of the case-insensitive strings that identify the shared resources in the  SMB Invalid Shares field. Optionally, enclose individual strings in quotes, which was required in previous software versions but is no longer required.
 
      
 
     
 
     [bookmark: pgfId-1532158]For example, to detect shared resources named C$, D$, admin, and private, you could enter:
 
      
      [bookmark: pgfId-1532159]"C$", D$, "admin", private 
     
 
     [bookmark: pgfId-1532160]Note that to detect SMB invalid shares, you must also enable SMB Ports or SMB Auto-Detect Ports, and enable the global SMB Traffics option.
 
     [bookmark: pgfId-1532161]Note also that in most cases you should append a dollar sign to a drive named by Windows that you identify as an invalid share. For example, you would enter C$ or "C$" to identify drive C.
 
      
       
       	 [bookmark: pgfId-1532162]To inspect files detected in DCE/RPC traffic in SMB without analyzing the DCE/RPC traffic, from the  SMB File Inspection drop-down list, select  Only . To inspect files detected in DCE/RPC traffic in SMB as well as the DCE/RPC traffic, from the  SMB File Inspection drop-down list, select  On . Enter a number of bytes to inspect in a detected file in the  SMB File Inspection Depth field. Enter  0 to inspect detected files in their entirety.
 
       	 [bookmark: pgfId-1532163]To specify a maximum number of chained SMB AndX commands to permit, enter 0 to 255 in the  SMB Maximum AndX Chains field. Specify  1  to permit no chained commands. Specify  0 or leave this option blank to disable this feature.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532164]Note Only someone who is expert in the SMB protocol should modify the setting for the SMB Maximum AndX Chains option.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532165]To enable the processing of DCE/RPC traffic over ports known to carry DCE/RPC traffic for a Windows policy transport, select or clear the check box next to a detection transport and, optionally, add or delete ports for the transport.
 
      
 
     
 
     [bookmark: pgfId-1532166]Select one or any combination of RPC over HTTP Proxy Ports, RPC over HTTP Server Ports, TCP Ports, and UDP Ports for a Windows policy. Select RPC Proxy Traffic Only when RPC over HTTP proxy is enabled and detected client-side RPC over HTTP traffic is proxy traffic only; that is, when it does not include other web server traffic.
 
     [bookmark: pgfId-1532167]Select SMB Ports for a Samba policy.
 
     [bookmark: pgfId-1532171]In most cases, use the default settings. See Understanding DCE/RPC Transports, Understanding the RPC over HTTP Transport, and Selecting DCE/RPC Target-Based Policy Options for more information.
 
     [bookmark: pgfId-1532178]You can type a single port, a range of port numbers separated by a dash (-), or a comma-separated list of port numbers and ranges.
 
      
       
       	 [bookmark: pgfId-1532179]To test whether specified ports carry DCE/RPC traffic and continue processing when they do, select or clear the check box next to an auto-detection transport and, optionally, add or delete ports for the transport.
 
      
 
     
 
     [bookmark: pgfId-1532180]Select one or any combination of RPC over HTTP Server Auto-Detect Ports, TCP Auto-Detect Ports, and UDP Auto-Detect Ports for a Windows policy.
 
     [bookmark: pgfId-1532181]Note that you would rarely, if ever, select RPC over HTTP Proxy Auto-Detect Ports or SMB Auto-Detect Ports.
 
     [bookmark: pgfId-1532182]Typically, specify a port range from 1025 to 65535 for auto-detection ports that you enable to cover the entire range of ephemeral ports. See Understanding DCE/RPC Transports, Understanding the RPC over HTTP Transport, and Selecting DCE/RPC Target-Based Policy Options for more information.
 
     [bookmark: pgfId-1588630]See Selecting DCE/RPC Target-Based Policy Options for more information.
 
     [bookmark: pgfId-1588631]Step 12 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1588635]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1588640][bookmark: 61366]Dete[bookmark: marker-1588637]cting Expl[bookmark: marker-1588638]oits in D[bookmark: DNS]NS Name Server Responses
 
    [bookmark: pgfId-1532215]License: Protection
 
    [bookmark: pgfId-1532216]The DNS preprocessor inspects DNS name server responses for the following specific exploits:
 
     
     	 [bookmark: pgfId-1532217]Overflow attempts on RData text fields
 
     	 [bookmark: pgfId-1532218]Obsolete DNS resource record types
 
     	 [bookmark: pgfId-1532219]Experimental DNS resource record types
 
    
 
    [bookmark: pgfId-1532220]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1532224]Understanding DNS Preprocessor Resource Record Inspection
 
     	 [bookmark: pgfId-1532228]Detecting Overflow Attempts in RData Text Fields
 
     	 [bookmark: pgfId-1532232]Detecting Obsolete DNS Resource Record Types
 
     	 [bookmark: pgfId-1532236]Detecting Experimental DNS Resource Record Types
 
     	 [bookmark: pgfId-1532240]Configuring the DNS Preprocessor
 
    
 
     
      [bookmark: pgfId-1532243][bookmark: 97726]Understanding DNS Preprocessor Res[bookmark: marker-1532242]ource Record Inspection
 
     [bookmark: pgfId-1532250]License: Protection
 
     [bookmark: pgfId-1532251]The most common type of DNS name server response provides one or more IP addresses that correspond to domain names in the query that prompted the response. Other types of server responses provide, for example, the destination for an email message or the location of a name server that can provide information not available from the server originally queried.
 
     [bookmark: pgfId-1532252]A DNS response is comprised of a message header, a Question section that contains one or more requests, and three sections that respond to requests in the Question section (Answer, Authority, and Additional Information). Responses in these three sections reflect the information in resource records (RR) maintained on the name server. The following table describes these three sections.
 
     [bookmark: pgfId-1532288]
 
      
       
        
        [bookmark: pgfId-1532259]Table 16-2 [bookmark: 42311]DNS Name Server RR Responses 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532265]This section... 
          
  
         	 
           
           [bookmark: pgfId-1532267]Includes... 
          
  
         	 
           
           [bookmark: pgfId-1532269]For example... 
          
  
        
 
         
         	[bookmark: pgfId-1532271]Answer
  
         	[bookmark: pgfId-1532273]Optionally, one or more resource records that provide a specific answer to a query
  
         	[bookmark: pgfId-1532275]The IP address corresponding to a domain name
  
        
 
         
         	[bookmark: pgfId-1532277]Authority
  
         	[bookmark: pgfId-1532279]Optionally, one or more resource records that point to an authoritative name server
  
         	[bookmark: pgfId-1532281]The name of an authoritative name server for the response
  
        
 
         
         	[bookmark: pgfId-1532283]Additional Information
  
         	[bookmark: pgfId-1532285]Optionally, one or more resource records that provided additional information related to the Answer sections
  
         	[bookmark: pgfId-1532287]The IP address of another server to query
  
        
 
        
      
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1532298]Theoretically, any type of resource record can be used in the Answer, Authority, or Additional Information section of a name server response message. The DNS preprocessor inspects any resource record in each of the three response sections for the exploits it detects.
 
     [bookmark: pgfId-1532299]The Type and RData resource record fields are of particular importance to the DNS preprocessor. The Type field identifies the type of resource record. The RData (resource data) field provides the response content. The size and content of the RData field differs depending on the type of resource record.
 
     [bookmark: pgfId-1532300]DNS messages typically use the UDP transport protocol but also use TCP when the message type requires reliable delivery or the message size exceeds UDP capabilities. The DNS preprocessor inspects DNS server responses in both UDP and TCP traffic. 
 
     [bookmark: pgfId-1532307]The DNS preprocessor does not inspect TCP sessions picked up in midstream, and ceases inspection if a session loses state because of dropped packets.
 
     [bookmark: pgfId-1532308]The typical port to configure for the DNS preprocessor is well-known port 53, which DNS name servers use for DNS messages in both UDP and TCP.
 
    
 
     
      [bookmark: pgfId-1532311][bookmark: 23655]Detecting Overflow Attem[bookmark: marker-1532310]pts in RData Text Fields
 
     [bookmark: pgfId-1532318]License: Protection
 
     [bookmark: pgfId-1532319]When the resource record type is TXT (text), the RData field is a variable-length ASCII text field.
 
     [bookmark: pgfId-1532320]When selected, the DNS preprocessor Detect Overflow attempts on RData Text fields option detects a specific vulnerability identified by entry CVE-2006-3441 in MITRE’s Current Vulnerabilities and Exposures database. This is a known vulnerability in Microsoft Windows 2000 Service Pack 4, Windows XP Service Pack 1 and Service Pack 2, and Windows Server 2003 Service Pack 1. An attacker can exploit this vulnerability and take complete control of a host by sending or otherwise causing the host to receive a maliciously crafted name server response that causes a miscalculation in the length of an RData text field, resulting in a buffer overflow.
 
     [bookmark: pgfId-1532321]You should enable this feature when your network might include hosts running operating systems that have not been upgraded to correct this vulnerability.
 
     [bookmark: pgfId-1532325]You can enable rule 131:3 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532328][bookmark: 60576]Detecting Obs[bookmark: marker-1532327]olete DNS Resource Record Types
 
     [bookmark: pgfId-1532335]License: Protection
 
     [bookmark: pgfId-1532336]RFC 1035 identifies several resource record types as obsolete. Because these are obsolete record types, some systems do not account for them and may be open to exploits. You would not expect to encounter these record types in normal DNS responses unless you have purposely configured your network to include them.
 
      
       
        
        [bookmark: pgfId-1532344]Table 16-3 [bookmark: 36736]Obsolete DNS Resource Record Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532350]RR Type 
          
  
         	 
           
           [bookmark: pgfId-1532352]Code 
          
  
         	 
           
           [bookmark: pgfId-1532354]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532356]3
  
         	[bookmark: pgfId-1532358]MD
  
         	[bookmark: pgfId-1532360]a mail destination
  
        
 
         
         	[bookmark: pgfId-1532362]4
  
         	[bookmark: pgfId-1532364]MF
  
         	[bookmark: pgfId-1532366]a mail forwarder
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532371]You can enable rule 131:1 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532374][bookmark: 56970]Detecting Experi[bookmark: marker-1532373]mental DNS Resource Record Types
 
     [bookmark: pgfId-1532381]License: Protection
 
     [bookmark: pgfId-1532383]RFC 1035 identifies several resource record types as experimental. Because these are experimental record types, some systems do not account for them and may be open to exploits. You would not expect to encounter these record types in normal DNS responses unless you have purposely configured your network to include them.
 
      
       
        
        [bookmark: pgfId-1532391]Table 16-4 [bookmark: 41386]Experimental DNS Resource Record Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532397]RR Type 
          
  
         	 
           
           [bookmark: pgfId-1532399]Code 
          
  
         	 
           
           [bookmark: pgfId-1532401]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532403]7
  
         	[bookmark: pgfId-1532405]MB
  
         	[bookmark: pgfId-1532407]a mailbox domain name
  
        
 
         
         	[bookmark: pgfId-1532409]8
  
         	[bookmark: pgfId-1532411]MG
  
         	[bookmark: pgfId-1532413]a mail group member
  
        
 
         
         	[bookmark: pgfId-1532415]9
  
         	[bookmark: pgfId-1532417]MR
  
         	[bookmark: pgfId-1532419]a mail rename domain name
  
        
 
         
         	[bookmark: pgfId-1532421]10
  
         	[bookmark: pgfId-1532423]NUL
  
         	[bookmark: pgfId-1532425]a null resource record
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532430]You can enable rule 131:2 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532434][bookmark: 24541]Configurin[bookmark: marker-1532433]g the DNS Preprocessor
 
     [bookmark: pgfId-1532441]License: Protection
 
     [bookmark: pgfId-1532442]Use the following procedure to configure the DNS preprocessor. For more information on configuring the options on this page, see Detecting Overflow Attempts in RData Text Fields, Detecting Obsolete DNS Resource Record Types, and Detecting Experimental DNS Resource Record Types.
 
     [bookmark: pgfId-1532452]To configure the DNS preprocessor:
 
     
 
     [bookmark: pgfId-1620672]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1620673]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1620678]The access control policy editor appears.
 
     [bookmark: pgfId-1620679]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1620680]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1620685]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1620686]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572720]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572725]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572729]The Policy Information page appears.
 
     [bookmark: pgfId-1572731]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572732]The Settings page appears.
 
     [bookmark: pgfId-1532471]Step 8 You have two choices, depending on whether DNS Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532472]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532473]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532474]The DNS Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532478]Step 9 Optionally, you can modify any of the following in the Settings area:
 
      
       
       	 [bookmark: pgfId-1532479]Specify the source port or ports the DNS preprocessor should monitor for DNS server responses in the  Ports field. Separate multiple ports with commas.
 
       	 [bookmark: pgfId-1532480]Select the  Detect Overflow Attempts on RData  Text  fields  check box to enable detection of buffer overflow attempts in RData text fields. 
 
       	 [bookmark: pgfId-1532481]Select the  Detect Obsolete DNS RR Types check box to enable detection of obsolete resource record types. 
 
       	 [bookmark: pgfId-1532482]Select the  Detect Experimental DNS RR Types check box to detect experimental resource record types. 
 
      
 
     
 
     [bookmark: pgfId-1532485]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532489]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532497][bookmark: 88566]Deco[bookmark: FTPTelnet]ding FT[bookmark: marker-1532493]P and Te[bookmark: marker-1532494]lnet Traf[bookmark: marker-1532495][bookmark: marker-1532496]fic
 
    [bookmark: pgfId-1532505]License: Protection
 
    [bookmark: pgfId-1532506]The FTP/Telnet decoder analyzes FTP and telnet data streams, normalizing FTP and telnet commands before processing by the rules engine. 
 
    [bookmark: pgfId-1532515]You must enable FTP and telnet preprocessor rules, which have generator IDs (GIDs) of 125 and 126, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1532519]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-1532523]Understanding Global FTP and Telnet Options
 
     	 [bookmark: pgfId-1532527]Configuring Global FTP/Telnet Options
 
     	 [bookmark: pgfId-1532531]Understanding Telnet Options
 
     	 [bookmark: pgfId-1532535]Configuring Telnet Options
 
     	 [bookmark: pgfId-1532539]Understanding Server-Level FTP Options
 
     	 [bookmark: pgfId-1532543]Configuring Server-Level FTP Options
 
     	 [bookmark: pgfId-1532547]Understanding Client-Level FTP Options
 
     	 [bookmark: pgfId-1532551]Configuring Client-Level FTP Options
 
    
 
     
      [bookmark: pgfId-1532555][bookmark: 27293]Understanding Global [bookmark: marker-1532553]FTP and [bookmark: marker-1532554]Telnet Options
 
     [bookmark: pgfId-1532562]License: Protection
 
     [bookmark: pgfId-1532563]You can set global options to determine whether the FTP/Telnet decoder performs stateful or stateless inspection of packets, whether the decoder detects encrypted FTP or telnet sessions, and whether the decoder continues to check a data stream after it encounters encrypted data. 
 
     [bookmark: pgfId-1532564]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532565]Stateful Inspection
 
     [bookmark: pgfId-1532566]When selected, causes the FTP/Telnet decoder to save state and provide session context for individual packets and only inspects reassembled sessions. When cleared, analyzes each individual packet without session context. 
 
     [bookmark: pgfId-1532567]To check for FTP data transfers, this option must be selected.
 
     [bookmark: pgfId-1532568]Detect Encrypted Traffic
 
     [bookmark: pgfId-1532569]Detects encrypted telnet and FTP sessions.
 
     [bookmark: pgfId-1532572]You can enable rules 125:7 and 126:2 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532574]Continue to Inspect Encrypted Data
 
     [bookmark: pgfId-1532575]Instructs the preprocessor to continue checking a data stream after it is encrypted, looking for eventual decrypted data. 
 
    
 
     
      [bookmark: pgfId-1532579][bookmark: 90640]Configuring Global [bookmark: marker-1532577]FTP/[bookmark: marker-1532578]Telnet Options
 
     [bookmark: pgfId-1532586]License: Protection
 
     [bookmark: pgfId-1532587]You need to configure global options for the FTP/Telnet decoder to control whether stateless or stateful inspection is performed, encrypted traffic is detected, and whether the decoder should continue to check for decrypted data in a data stream that it has identified as encrypted. For more information on global settings, see Understanding Global FTP and Telnet Options.
 
     [bookmark: pgfId-1532591]To configure global options:
 
     
 
     [bookmark: pgfId-1620876]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1620877]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1620882]The access control policy editor appears.
 
     [bookmark: pgfId-1620883]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1620884]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1620889]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1620890]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572751]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572756]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572760]The Policy Information page appears.
 
     [bookmark: pgfId-1572762]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572763]The Settings page appears.
 
     [bookmark: pgfId-1532609]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532610]Step 8 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532611]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532612]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532613]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1532614]A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532620]Tip For more information on configuring the other options on this page, see Configuring Telnet Options, Configuring Server-Level FTP Options, and Configuring Client-Level FTP Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532628]Step 9 Optionally, you can modify any of the following in the Global Settings page area:
 
      
       
       	 [bookmark: pgfId-1532629]Select  Stateful Inspection  to examine reassembled TCP streams containing FTP packets. Clear  Stateful Inspection to inspect only unreassembled packets.
 
       	 [bookmark: pgfId-1532637]Select  Detect Encrypted Traffic  to detect encrypted traffic. Clear  Detect Encrypted Traffic to ignore encrypted traffic.
 
       	 [bookmark: pgfId-1532638]If needed, select  Continue to Inspect Encrypted Data to continue checking a stream after it becomes encrypted, in case it becomes decrypted again and can be processed.
 
      
 
     
 
     [bookmark: pgfId-1532641]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532645]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532648][bookmark: 31910]Understanding [bookmark: marker-1532647]Telnet Options
 
     [bookmark: pgfId-1532655]License: Protection
 
     [bookmark: pgfId-1532656]You can enable or disable normalization of telnet commands by the FTP/Telnet decoder, enable or disable a specific anomaly case, and set the threshold number of Are You There (AYT) attacks to permit.
 
     [bookmark: pgfId-1532657]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532659][bookmark: 83423]Ports
 
     [bookmark: pgfId-1532660]Indicates the ports whose telnet traffic you want to normalize. In the interface, list multiple ports separated by commas.
 
     [bookmark: pgfId-1532665]Normalize
 
     [bookmark: pgfId-1532666]Normalizes telnet traffic to the specified ports.
 
     [bookmark: pgfId-1532667]Detect Anomalies
 
     [bookmark: pgfId-1532668]Enables detection of Telnet SB (subnegotiation begin) without the corresponding SE (subnegotiation end).
 
     [bookmark: pgfId-1532669]Telnet supports subnegotiation, which begins with SB (subnegotiation begin) and must end with an SE (subnegotiation end). However, certain implementations of Telnet servers will ignore the SB without a corresponding SE. This is anomalous behavior that could be an evasion case. Because FTP uses the Telnet protocol on the control connection, it is also susceptible to this behavior.
 
     [bookmark: pgfId-1532670]You can enable rule 126:3 to generate an event when this anomaly is detected in Telnet traffic, and rule 125:9 when it is detected on the FTP command channel. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532674]Are You There Attack Threshold Number
 
     [bookmark: pgfId-1532678]Detects when the number of consecutive AYT commands exceeds the specified threshold. Cisco recommends that you set the AYT threshold to a value no higher than 20.
 
     [bookmark: pgfId-1532682]You can enable rule 126:1 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532685][bookmark: 84398]Configuring [bookmark: marker-1532684]Telnet Options
 
     [bookmark: pgfId-1532692]License: Protection
 
     [bookmark: pgfId-1532693]You can enable or disable normalization, enable or disable a specific anomaly case, and control the threshold number of Are You There (AYT) attacks to permit. For additional information on telnet options, see Understanding Telnet Options.
 
     [bookmark: pgfId-1532697]To configure telnet options:
 
     
 
     [bookmark: pgfId-1621006]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621007]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621012]The access control policy editor appears.
 
     [bookmark: pgfId-1621013]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621014]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621019]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621020]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572799]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572804]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572808]The Policy Information page appears.
 
     [bookmark: pgfId-1572809]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572810]The Settings page appears.
 
     [bookmark: pgfId-1532716]Step 8 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532717]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532718]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532719]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1532720]A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532726]Tip For more information on configuring the other options on this page, see Configuring Global FTP/Telnet Options, Configuring Server-Level FTP Options, and Configuring Client-Level FTP Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532734]Step 9 Optionally, you can modify any of the following in the Telnet Settings page area:
 
      
       
       	 [bookmark: pgfId-1532735]Specify the port or ports where telnet traffic should be decoded in the  Ports field. Telnet typically connects to TCP port 23. Separate multiple ports with commas.
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1532740] 
      Caution Because encrypted traffic (SSL) cannot be decoded, adding port 22 (SSH) could yield unexpected results. 
       
       
 
      
 
     
 
      
       
       	 [bookmark: pgfId-1532741]Select or clear the  Normalize Telnet Protocol Options check box to enable or disable telnet normalization.
 
       	 [bookmark: pgfId-1532742]Select or clear the  Detect Anomalies Telnet Protocol Options check box to enable or disable anomaly detection.
 
       	 [bookmark: pgfId-1532743]Specify an  Are You There Attack Threshold Number  of consecutive AYT commands to permit.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532747]Tip Cisco recommends that you set the AYT threshold to a value no higher than the default value.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532750]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532754]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532757][bookmark: 65781]Understanding Server-Level [bookmark: marker-1532756]FTP Options
 
     [bookmark: pgfId-1532764]License: Protection
 
     [bookmark: pgfId-1532765]You can set options for decoding on multiple FTP servers. Each server profile you create contains the server IP address and the ports on the server where traffic should be monitored. You can specify which FTP commands to validate and which to ignore for a particular server, and set maximum parameter lengths for commands. You can also set the specific command syntax the decoder should validate against for particular commands and set alternate maximum command parameter lengths.
 
     [bookmark: pgfId-1532766]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532767]Networks
 
     [bookmark: pgfId-1532768]Use this option to specify one or more IP addresses of FTP servers.
 
     [bookmark: pgfId-1532769]You can specify a single IP address or address block, or a comma-separated list comprised of either or both. You can configure up to 1024 characters, and you can specify up to 255 profiles including the default profile. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1600858]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or address block for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1600866]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1600860]Ports
 
     [bookmark: pgfId-1532778]Use this option to specify the ports on the FTP server where the device should monitor traffic. In the interface, list multiple ports separated by commas.
 
     [bookmark: pgfId-1532783]File Get Commands
 
     [bookmark: pgfId-1532784]Use this option to define the FTP commands used to transfer files from server to client. Do not change these values unless directed to do so by Support.
 
     [bookmark: pgfId-1532785]File Put Commands
 
     [bookmark: pgfId-1532786]Use this option to define the FTP commands used to transfer files from client to server. Do not change these values unless directed to do so by Support.
 
     [bookmark: pgfId-1532787]Additional FTP Commands
 
     [bookmark: pgfId-1532788]Use this line to specify the additional commands that the decoder should detect. Separate additional commands by spaces.
 
     [bookmark: pgfId-1532789]Default Max Parameter Length
 
     [bookmark: pgfId-1532790]Use this option to detect the maximum parameter length for commands where an alternate maximum parameter length has not been set.
 
     [bookmark: pgfId-1532794]You can enable rule 125:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532795]Alternate Max Parameter Length
 
     [bookmark: pgfId-1532796]Use this option to specify commands where you want to detect a different maximum parameter length, and to specify the maximum parameter length for those commands. Click Add to add lines where you can specify a different maximum parameter length to detect for particular commands.
 
     [bookmark: pgfId-1532797]Check Commands for String Format Attacks
 
     [bookmark: pgfId-1532798]Use this option to check the specified commands for string format attacks.
 
     [bookmark: pgfId-1532802]You can enable rule 125:5 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532803]Command Validity
 
     [bookmark: pgfId-1532806]Use this option to enter a valid format for a specific command. See Creating FTP Command Parameter Validation Statements for information on creating FTP command parameter validation statements to validate the syntax of a parameter received as part of an FTP communication. Click Add to add a command validation line. 
 
     [bookmark: pgfId-1532810]You can enable rules 125:2 and 125:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532812]Ignore FTP Transfers
 
     [bookmark: pgfId-1532813]Use this option to improve performance on FTP data transfers by disabling all inspection other than state inspection on the data transfer channel.
 
     [bookmark: pgfId-1532814]Detect Telnet Escape Codes within FTP Commands
 
     [bookmark: pgfId-1532815]Use this option to detect when telnet commands are used over the FTP command channel.
 
     [bookmark: pgfId-1532819]You can enable rule 125:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532820]Ignore Erase Commands during Normalization 
 
     [bookmark: pgfId-1532821]When Detect Telnet Escape Codes within FTP Commands is selected, use this option to ignore telnet character and line erase commands when normalizing FTP traffic. The setting should match how the FTP server handles telnet erase commands. Note that newer FTP servers typically ignore telnet erase commands, while older servers typically process them.
 
     [bookmark: pgfId-1546149]Troubleshooting Options: Log FTP Command Validation Configuration 
 
     [bookmark: pgfId-1546145]Support might ask you during a troubleshooting call to configure your system to print the configuration information for each FTP command listed for the server.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1546341] 
      Caution Changing the setting for this troubleshooting option affects performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1532823][bookmark: 92394]Creating FTP Command Parameter Validation Statements
 
     [bookmark: pgfId-1532830]License: Protection
 
     [bookmark: pgfId-1532831]When setting up a validation statement for an FTP command, you can specify a group of alternative parameters by separating the parameters with spaces. You can also create a binary OR relationship between two parameters by separating them with a pipe character (|) in the validation statement. Surrounding parameters by square brackets ([]) indicates that those parameters are optional. Surrounding parameters with curly brackets ({}) indicates that those parameters are required.
 
     [bookmark: pgfId-1532832]You can create FTP command parameter validation statements to validate the syntax of a parameter received as part of an FTP communication. See Understanding Server-Level FTP Options for more information.
 
      
       
        
        [bookmark: pgfId-1532842]Table 16-5 FTP Command Parameters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532846]If you use... 
          
  
         	 
           
           [bookmark: pgfId-1532848]The following validation occurs... 
          
  
        
 
         
         	[bookmark: pgfId-1532850]int
  
         	[bookmark: pgfId-1532852]The represented parameter must be an integer.
  
        
 
         
         	[bookmark: pgfId-1532854]number
  
         	[bookmark: pgfId-1532856]The represented parameter must be an integer between 1 and 255.
  
        
 
         
         	[bookmark: pgfId-1532858]char _chars 
  
         	[bookmark: pgfId-1532860]The represented parameter must be a single character and a member of the characters specified in the _chars argument.
 [bookmark: pgfId-1532861]For example, defining the command validity for MODE with the validation statement char SBC checks that the parameter for the MODE command comprises the character S (representing Stream mode), the character B (representing Block mode), or the character C (representing Compressed mode).
  
        
 
         
         	[bookmark: pgfId-1532863]date _datefmt 
  
         	[bookmark: pgfId-1532865]If _datefmt contains #, the represented parameter must be a number.
 [bookmark: pgfId-1532866]If _datefmt contains C, the represented parameter must be a character.
 [bookmark: pgfId-1532867]If _datefmt contains literal strings, the represented parameter must match the literal string.
  
        
 
         
         	[bookmark: pgfId-1532869]string
  
         	[bookmark: pgfId-1532871]The represented parameter must be a string.
  
        
 
         
         	[bookmark: pgfId-1532873]host_port
  
         	[bookmark: pgfId-1532875]The represented parameter must be a valid host port specifier as defined by RFC 959, the File Transfer Protocol specification by the Network Working Group.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532877]You can combine the syntax in the table above as needed to create parameter validation statements that correctly validate each FTP command where you need to validate traffic. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1532878]Note When you include a complex expression in a TYPE command, surround it by spaces. Also, surround each operand within the expression by spaces. For example, type char A | B , not char A|B.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532881][bookmark: 45055]Configuring Server-Level [bookmark: marker-1532880]FTP Options
 
     [bookmark: pgfId-1532888]License: Protection
 
     [bookmark: pgfId-1532889]You can configure several options at the server level. For each FTP server you add, you can specify the ports to be monitored, the commands to validate, the default maximum parameter length for commands, alternate parameter lengths for specific commands, and validation syntax for particular commands. You can also choose whether to check for string format attacks and telnet commands on the FTP channel and whether to print configuration information with each command. For additional information on server-level FTP options, see Understanding Server-Level FTP Options.
 
     [bookmark: pgfId-1532893]To configure server-level FTP options:
 
     
 
     [bookmark: pgfId-1621061]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621062]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621067]The access control policy editor appears.
 
     [bookmark: pgfId-1621068]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621069]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621074]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621075]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572828]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572833]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572837]The Policy Information page appears.
 
     [bookmark: pgfId-1572838]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572839]The Settings page appears.
 
     [bookmark: pgfId-1532912]Step 8 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532913]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532914]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532915]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1532916]A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532922]Tip For more information on configuring the other options on this page, see Configuring Global FTP/Telnet Options, Configuring Telnet Options, and Configuring Client-Level FTP Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532930]Step 9 You have two options:
 
      
       
       	 [bookmark: pgfId-1532934]Add a new server profile. Click the add icon (
 
      
 
      [image: ] ) next to 
       FTP Server on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses for the client in the 
       Server Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1532935]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 1024 characters, and you can configure up to 255 policies, including the default policy. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1601879]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1532942]A new entry appears in the list of FTP servers on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1577355]Modify the settings for an existing server profile. Click the configured address for a profile you have added under  FTP Server on the left side of the page, or click  default .
 
      
 
     
 ) next to the profile you want to remove. 
     
 
     [bookmark: pgfId-1532948]Step 10 Optionally, you can modify any of the following in the Configuration page area:
 
      
       
       	 [bookmark: pgfId-1532949]Modify the address or addresses listed in the  Networks field and click any other area of the page.
 
      
 
     
 
     [bookmark: pgfId-1532950]The highlighted address updates on the left side of the page.
 
     [bookmark: pgfId-1579104]Note that you cannot modify the setting for Network in the default profile. The default profile applies to all servers on your network that are not identified in another profile.
 
      
       
       	 [bookmark: pgfId-1579106][bookmark: 62583]Specify any  Ports that should be monitored for FTP traffic. Port 21 is the well-known port for FTP traffic.
 
       	 [bookmark: pgfId-1532958]Update the FTP commands used to transfer files from server to client in the  File Get Commands field.
 
       	 [bookmark: pgfId-1532959]Update the FTP commands used to transfer files from client to server in the  File Put Commands field.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532960]Note Do not change the values in the File Get Commands and File Put Commands field unless directed to do so by Support.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532961]To detect additional FTP commands outside of those checked by default by the FTP/Telnet preprocessor, type the commands, separated by spaces in the  Additional FTP Commands field.
 
      
 
     
 
     [bookmark: pgfId-1532962]You can add as many additional FTP commands as needed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532963]Note Additional commands you may want to add include XPWD, XCWD, XCUP, XMKD, and XRMD. For more information on these commands, see RFC 775, the Directory oriented FTP commands specification by the Network Working Group.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532964]Specify the default maximum number of bytes for a command parameter in the  Default Max Parameter Length field. 
 
       	 [bookmark: pgfId-1532965]To detect a different maximum parameter length for particular commands, click  Add next to  Alternate Max Parameter Length . In the first text box of the row that appears, specify the maximum parameter length. In the second text box, specify the commands, separated by spaces, where this alternate maximum parameter length should apply.
 
      
 
     
 
     [bookmark: pgfId-1532966]You can add as many alternative maximum parameter lengths as needed.
 
      
       
       	 [bookmark: pgfId-1532967]To check for string format attacks on particular commands, specify the commands, separated by spaces, in the  Check Commands for String Format Attacks text box.
 
       	 [bookmark: pgfId-1532968]To specify the valid format for a command, click  Add next to  Command Validity . Specify the command you want to validate, then type a validation statement for the command parameter. For more information on the validation statement syntax, see Understanding Server-Level FTP Options.
 
       	 [bookmark: pgfId-1532972]To improve performance on FTP data transfers by disabling all inspection other than state inspection on the data transfer channel, enable  Ignore FTP Transfers .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532973]Note To inspect data transfers, the global FTP/Telnet Stateful Inspection option must be selected. For more information on setting global options, see Understanding Global FTP and Telnet Options.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532977]To detect when telnet commands are used over the FTP command channel, select  Detect Telnet Escape Codes within FTP Commands .
 
       	 [bookmark: pgfId-1532978]To ignore telnet character and line erase commands when normalizing FTP traffic, enable  Ignore Erase Commands during Normalization .
 
      
 
     
 
     [bookmark: pgfId-1532981]Step 11 Optionally, modify the related troubleshooting option only if asked to do so by Support; click the + sign next to Troubleshooting Options to expand the troubleshooting options section. 
 
     [bookmark: pgfId-1532985]Step 12 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532989]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532992][bookmark: 14985]Understanding Client-Level [bookmark: marker-1532991]FTP Options
 
     [bookmark: pgfId-1532999]License: Protection
 
     [bookmark: pgfId-1533000]You can create profiles for FTP clients. Within each profile, you can specify the maximum response length for an FTP response from a client. You can also configure whether the decoder detects bounce attacks and use of telnet commands on the FTP command channel for a particular client.
 
     [bookmark: pgfId-1533001]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533002]Networks
 
     [bookmark: pgfId-1533003]Use this option to specify one or more IP addresses of FTP clients.
 
     [bookmark: pgfId-1533004]You can specify a single IP address or address block, or a comma-separated list comprised of either or both. You can specify up to 1024 characters, and you can specify up to 255 profiles including the default profile. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1533011]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or address block for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1600901]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1533012]Max Response Length
 
     [bookmark: pgfId-1533013]Use this option to specify the maximum length of a response string from the FTP client.
 
     [bookmark: pgfId-1533017]You can enable rule 125:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533018]Detect FTP Bounce Attempts
 
     [bookmark: pgfId-1533019]Use this option to detect FTP bounce attacks.
 
     [bookmark: pgfId-1533023]You can enable rule 125:8 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533024]Allow FTP Bounce to
 
     [bookmark: pgfId-1533025]Use this option to configure a list of additional hosts and ports on those hosts on which FTP PORT commands should not be treated as FTP bounce attacks.
 
     [bookmark: pgfId-1533026]Detect Telnet Escape Codes within FTP Commands
 
     [bookmark: pgfId-1533027]Use this option to detect when telnet commands are used over the FTP command channel.
 
     [bookmark: pgfId-1533031]You can enable rule 125:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533032]Ignore Erase Commands During Normalization
 
     [bookmark: pgfId-1533033]When Detect Telnet Escape Codes within FTP Commands is selected, use this option to ignore telnet character and line erase commands when normalizing FTP traffic.The setting should match how the FTP client handles telnet erase commands. Note that newer FTP clients typically ignore telnet erase commands, while older clients typically process them.
 
    
 
     
      [bookmark: pgfId-1533036][bookmark: 47279]Configuring Client-Level [bookmark: marker-1533035]FTP Options
 
     [bookmark: pgfId-1533043]License: Protection
 
     [bookmark: pgfId-1533044]You can configure client profiles for FTP clients to monitor FTP traffic from clients. For additional information on the options you can set for monitoring clients, see Understanding Client-Level FTP Options. For more information on telnet options, see Understanding Telnet Options. For more information on additional FTP options, see Understanding Server-Level FTP Options and Understanding Global FTP and Telnet Options. 
 
     [bookmark: pgfId-1533057]To configure client-level FTP options:
 
     
 
     [bookmark: pgfId-1621230]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621231]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621236]The access control policy editor appears.
 
     [bookmark: pgfId-1621237]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621238]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621243]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621244]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572857]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572862]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572866]The Policy Information page appears.
 
     [bookmark: pgfId-1572867]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572868]The Settings page appears.
 
     [bookmark: pgfId-1533076]Step 8 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533077]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533078]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533079]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1533080]Step 9 You have two options:
 
      
       
       	 [bookmark: pgfId-1533084]Add a new client profile. Click the add icon (
 
      
 
      [image: ] ) next to 
       FTP Client on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses for the client in the 
       Client Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1533085]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 1024 characters, and you can configure up to 255 policies, including the default policy. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1601927]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1533092]A new entry appears in the list of FTP clients on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1533093]Modify the settings for an existing client profile. Click the configured address for a profile you have added under  FTP Client on the left side of the page, or click  default .
 
      
 
     
 ) next to the profile you want to remove. 
     
 
     [bookmark: pgfId-1533098]Step 10 Optionally, you can modify any of the following in the Configuration page area:
 
      
       
       	 [bookmark: pgfId-1533099]Optionally, modify the address or addresses listed in the  Networks field and click any other area of the page.
 
      
 
     
 
     [bookmark: pgfId-1533100]The highlighted address updates on the left side of the page.
 
     [bookmark: pgfId-1579159]Note that you cannot modify the setting for Network in the default profile. The default profile applies to all client hosts on your network that are not identified in another profile.
 
      
       
       	 [bookmark: pgfId-1579162][bookmark: 22373]Specify, in bytes, the maximum length of responses from the FTP client in the  Max Response Length field. 
 
       	 [bookmark: pgfId-1533104]To detect FTP bounce attacks, select  Detect FTP Bounce attempts .
 
      
 
     
 
     [bookmark: pgfId-1533105]The FTP/Telnet decoder detects when an FTP PORT command is issued and the specified host does not match the specified host of the client. 
 
      
       
       	 [bookmark: pgfId-1533106]To configure a list of additional hosts and ports where FTP PORT commands should not be treated as FTP bounce attacks, specify each host (or network in CIDR format) followed by a colon (:) and the port or port range in the  Allow FTP Bounce to field. To enter a range of ports for a host, separate the beginning port in the range and the final port in the range with a dash (-). You can enter multiple hosts by separating the entries for the hosts with a comma.
 
      
 
     
 
     [bookmark: pgfId-1533107]For example, to permit FTP PORT commands directed to the host 192.168.1.1 at port 21 and commands directed to the host 192.168.1.2 at any of the ports from 22 to 1024, type:
 
      
      [bookmark: pgfId-1533108]192.168.1.1:21, 192.168.1.2:22-1024 
     
 
     [bookmark: pgfId-1533114]For information on using CIDR notation and prefix lengths in the ASA FirePOWER module, see IP Address Conventions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533116]Note To specify multiple individual ports for a host, you must repeat the host IP address for each port definition. For example, to specify the ports 22 and 25 on 192.168.1.1, type 192.168.1.1:22, 192.168.1.1:25.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1533117]To detect when telnet commands are used over the FTP command channel, select  Detect Telnet Escape Codes within FTP Commands .
 
       	 [bookmark: pgfId-1533118]To ignore telnet character and line erase commands when normalizing FTP traffic, select  Ignore Erase Commands During Normalization .
 
      
 
     
 
     [bookmark: pgfId-1533121]Step 11 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533125]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533130][bookmark: 52545]De[bookmark: HTTPInspection]cod[bookmark: marker-1533129]ing HTTP Traffic
 
    [bookmark: pgfId-1533138]License: Protection
 
    [bookmark: pgfId-1533140]The HTTP Inspect preprocessor is responsible for:
 
     
     	 [bookmark: pgfId-1533141]decoding and normalizing HTTP requests sent to and HTTP responses received from web servers on your network
 
     	 [bookmark: pgfId-1533142]separating messages sent to web servers into URI, non-cookie header, cookie header, method, and message body components to improve performance of HTTP-related intrusion rules
 
     	 [bookmark: pgfId-1533143]separating messages received from web servers into status code, status message, non-set-cookie header, cookie header, and response body components to improve performance of HTTP-related intrusion rules
 
     	 [bookmark: pgfId-1533144]detecting possible URI-encoding attacks
 
     	 [bookmark: pgfId-1533145]making the normalized data available for additional rule processing
 
    
 
    [bookmark: pgfId-1533146]HTTP traffic can be encoded in a variety of formats, making it difficult for rules to appropriately inspect. HTTP Inspect decodes 14 types of encoding, ensuring that your HTTP traffic gets the best inspection possible.
 
    [bookmark: pgfId-1533147]You can configure HTTP Inspect options globally, on a single server, or for a list of servers. 
 
    [bookmark: pgfId-1533148]Note the following when using the HTTP Inspect preprocessor:
 
     
     	 [bookmark: pgfId-1533149]The preprocessor engine performs HTTP normalization  statelessly . That is, it normalizes HTTP strings on a packet-by-packet basis, and can only process HTTP strings that have been reassembled by the TCP stream preprocessor. 
 
     	 [bookmark: pgfId-1533157]You must enable HTTP preprocessor rules, which have a generator ID (GID) of 119, if you want these rules to generate events. See Setting Rule States for more information.
 
    
 
    [bookmark: pgfId-1533165]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1533169]Selecting Global HTTP Normalization Options
 
     	 [bookmark: pgfId-1533173]Configuring Global HTTP Configuration Options
 
     	 [bookmark: pgfId-1533177]Selecting Server-Level HTTP Normalization Options
 
     	 [bookmark: pgfId-1533181]Selecting Server-Level HTTP Normalization Encoding Options
 
     	 [bookmark: pgfId-1533185]Configuring HTTP Server Options
 
     	 [bookmark: pgfId-1533189]Enabling Additional HTTP Inspect Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1533192][bookmark: 81629]Selecting Glob[bookmark: marker-1533191]al HTTP Normalization Options
 
     [bookmark: pgfId-1533199]License: Protection
 
     [bookmark: pgfId-1533201]The global HTTP options provided for the HTTP Inspect preprocessor control how the preprocessor functions. Use these options to enable or disable HTTP normalization when ports not specified as web server ports receive HTTP traffic.
 
     [bookmark: pgfId-1533202]Note the following:
 
      
      	 [bookmark: pgfId-1533203]If you enable  Unlimited Decompression , the  Maximum Compressed Data Depth and  Maximum Decompressed Data Depth options are automatically set to 65535 when you commit your changes. See Selecting Server-Level HTTP Normalization Options for more information.
 
      	 [bookmark: pgfId-1533207]If the values for the  Maximum Compressed Data Depth and  Maximum Decompressed Data Depth options are different in an intrusion policy associated with the default action of an access control policy and intrusion policies associated with access control rules, the highest value is used.
 
     
 
     [bookmark: pgfId-1533214]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533215]Detect Anomalous HTTP Servers
 
     [bookmark: pgfId-1533216]Detects HTTP traffic sent to or received by ports not specified as web server ports.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533217]Note If you turn this option on, be make to list all ports that do receive HTTP traffic in a server profile on the HTTP Configuration page. If you do not, and you enable this option and the accompanying preprocessor rule, normal traffic to and from the server will generate events. The default server profile contains all ports normally used for HTTP traffic, but if you modified that profile, you may need to add those ports to another profile to prevent events from being generated.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533221]You can enable rule 120:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533222]Detect HTTP Proxy Servers
 
     [bookmark: pgfId-1533223]Detects HTTP traffic using proxy servers not defined by the Allow HTTP Proxy Use option.
 
     [bookmark: pgfId-1533227]You can enable rule 119:17 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1571799]Maximum Compressed Data Depth
 
     [bookmark: pgfId-1571800]Sets the maximum size of compressed data to decompress when Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled. You can specify from 1 to 65535 bytes. 
 
     [bookmark: pgfId-1533230]Maximum Decompressed Data Depth
 
     [bookmark: pgfId-1533231]Sets the maximum size of the normalized decompressed data when Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled. You can specify from 1 to 65535 bytes. 
 
    
 
     
      [bookmark: pgfId-1533234][bookmark: 66260]Configuring Glob[bookmark: marker-1533233]al HTTP Configuration Options
 
     [bookmark: pgfId-1533241]License: Protection
 
     [bookmark: pgfId-1533243]You can configure detection of HTTP traffic to non-standard ports and on HTTP traffic using proxy servers. For more information on global HTTP configuration options, see Selecting Global HTTP Normalization Options.
 
     [bookmark: pgfId-1533247]To configure global HTTP configuration options:
 
     
 
     [bookmark: pgfId-1621279]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621280]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621285]The access control policy editor appears.
 
     [bookmark: pgfId-1621286]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621287]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621292]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621293]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572882]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572887]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572891]The Policy Information page appears.
 
     [bookmark: pgfId-1572892]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572893]The Settings page appears.
 
     [bookmark: pgfId-1533266]Step 8 You have two choices, depending on whether HTTP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533267]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533268]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533269]The HTTP Configuration page appears.
 
     [bookmark: pgfId-1533272]Step 9 You can modify any of the global options described in Selecting Global HTTP Normalization Options.
 
     [bookmark: pgfId-1533276]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533280]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533283][bookmark: 47617]Selecting Server-[bookmark: marker-1533282]Level HTTP Normalization Options
 
     [bookmark: pgfId-1533290]License: Protection
 
     [bookmark: pgfId-1533292]You can set server-level options for each server you monitor, globally for all servers, or for a list of servers. Additionally, you can use a predefined server profile to set these options, or you can set them individually to meet the needs of your environment. Use these options, or one of the default profiles that set these options, to specify the HTTP server ports whose traffic you want to normalize, the amount of server response payload you want to normalize, and the types of encoding you want to normalize.
 
     [bookmark: pgfId-1533293]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533294]Networks
 
     [bookmark: pgfId-1533295]Use this option to specify the IP address of one or more servers. You can specify a single IP address or address block, or a comma-separated list comprised of either or both. 
 
     [bookmark: pgfId-1533296]In addition to a limit of up to 255 total profiles, including the default profile, you can include up to 496 characters, or approximately 26 entries, in an HTTP server list, and specify a total of 256 address entries for all server profiles. For information on using IPv4 CIDR notation and IPv6 prefix lengths in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1533303]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1600940]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1533304]Ports
 
     [bookmark: pgfId-1533305]The ports whose HTTP traffic the preprocessor engine normalizes. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1533310]Oversize Dir Length
 
     [bookmark: pgfId-1533311]Detects URL directories longer than the specified value.
 
     [bookmark: pgfId-1533315]You can enable rule 119:15 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533316]Client Flow Depth
 
     [bookmark: pgfId-1533317]Specifies the number of bytes for rules to inspect in raw HTTP packets, including header and payload data, in client-side HTTP traffic defined in Ports. Client flow depth does not apply when HTTP content rule options within a rule inspect specific parts of a request message. See HTTP Content Options for more information.
 
     [bookmark: pgfId-1533324]You can specify a value from -1 to 1460. Cisco recommends that you set client flow depth to its maximum value. Specify any of the following:
 
     [bookmark: pgfId-1533325] – From 1 to 1460 inspects the specified number of bytes in the first packet. If the first packet contains fewer bytes than specified, inspect the entire packet. Note that the specified value applies to both segmented and reassembled packets.
 
     [bookmark: pgfId-1533326]Note also that a value of 300 typically eliminates inspection of large HTTP Cookies that appear at the end of many client request headers.
 
     [bookmark: pgfId-1533327] – 0 inspects all client-side traffic, including multiple packets in a session and exceeding the 1460 byte limit if necessary. Note that this value is likely to affect performance.
 
     [bookmark: pgfId-1533328] – -1 ignores all client-side traffic. 
 
     [bookmark: pgfId-1533329]Server Flow Depth
 
     [bookmark: pgfId-1533330]Specifies the number of bytes for rules to inspect in raw HTTP packets in server-side HTTP traffic specified by Ports. Inspection includes the raw header and payload when Inspect HTTP Responses disabled and only the raw response body when Inspect HTTP Response is enabled.
 
     [bookmark: pgfId-1533331]Server flow depth specifies the number of bytes of raw server response data in a session for rules to inspect in server-side HTTP traffic defined in Ports. You can use this option to balance performance and the level of inspection of HTTP server response data. Server flow depth does not apply when HTTP content options within a rule inspect specific parts of a response message. See HTTP Content Options for more information.
 
     [bookmark: pgfId-1533335]Unlike client flow depth, server flow depth specifies the number of bytes per HTTP response, not per HTTP request packet, for rules to inspect.
 
     [bookmark: pgfId-1533339]You can specify a value from -1 to 65535. Cisco recommends that you set the server flow depth to its maximum value. You can specify any of the following:
 
     [bookmark: pgfId-1533340] – From 1 to 65535:
 
     [bookmark: pgfId-1533341]When Inspect HTTP Responses is enabled, inspects only the raw HTTP response body, and not raw HTTP headers; also inspects decompressed data when Inspect Compressed Data is enabled.
 
     [bookmark: pgfId-1533342]When Inspect HTTP Responses is disabled, inspects the raw packet header and payload.
 
     [bookmark: pgfId-1533343]If the session includes fewer response bytes than specified, rules fully inspect all response packets in a given session, across multiple packets as needed. If the session includes more response bytes than specified, rules inspect only the specified number of bytes for that session, across multiple packets as needed.
 
     [bookmark: pgfId-1533344]Note that a small flow depth value may cause false negatives from rules that target server-side traffic defined in Ports. Most of these rules target either the HTTP header or content that is likely to be in the first hundred or so bytes of non-header data. Headers are usually under 300 bytes long, but header size may vary.
 
     [bookmark: pgfId-1533345]Note also that the specified value applies to both segmented and reassembled packets.
 
     [bookmark: pgfId-1533346] – 0 inspects the entire packet for all HTTP server-side traffic defined in Ports, including response data in a session that exceeds 65535 bytes.
 
     [bookmark: pgfId-1533347]Note that this value is likely to affect performance.
 
     [bookmark: pgfId-1533348] – -1:
 
     [bookmark: pgfId-1533349]When Inspect HTTP Responses is enabled, inspects only raw HTTP headers and not the raw HTTP response body.
 
     [bookmark: pgfId-1533350]When Inspect HTTP Responses is disabled, ignores all server-side traffic defined in Ports.
 
     [bookmark: pgfId-1533351]Maximum Header Length
 
     [bookmark: pgfId-1533352]Detects a header field longer than the specified maximum number of bytes in an HTTP request; also in HTTP responses when Inspect HTTP Responses is enabled. The value of 0 disables this option. Specify a value from 1 to 65535 to enable it.
 
     [bookmark: pgfId-1533356]You can enable rule 119:19 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533357]Maximum Number of Headers
 
     [bookmark: pgfId-1533358]Detects when the number of headers exceeds this setting in an HTTP request. Specify a value from 1 to 1024 to enable it.
 
     [bookmark: pgfId-1533362]You can enable rule 119:20 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533363]Maximum Number of Spaces
 
     [bookmark: pgfId-1533364]Detects when the number of white spaces in a folded line equals or exceeds this setting in an HTTP request. A value of 0 disables this option. Specify a value from 1 to 65535 to enable it.
 
     [bookmark: pgfId-1533368]You can enable rule 119:26 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533369]HTTP Client Body Extraction Depth
 
     [bookmark: pgfId-1533370]Specifies the number of bytes to extract from the message body of an HTTP client request. You can use an intrusion rule to inspect the extracted data by selecting the content or protected_content keyword HTTP Client Body option. See HTTP Content Options for more information.
 
     [bookmark: pgfId-1533374]Specify a value from -1 to 65495. Specify -1 to ignore the client body. Specify 0 to extract the entire client body. Note that identifying specific bytes to extract can improve system performance. Note also that you must specify a value from 0 to 65495 for the HTTP Client Body option to function in an intrusion rule.
 
     [bookmark: pgfId-1533375]Small Chunk Size
 
     [bookmark: pgfId-1533376]Specifies the maximum number of bytes at which a chunk is considered small. Specify a value of 1 to 255. A value of 0 disables detection of anomalous consecutive small segments. See the Consecutive Small Chunks option for more information.
 
     [bookmark: pgfId-1533377]Consecutive Small Chunks
 
     [bookmark: pgfId-1533378]Specifies how many consecutive small chunks represent an abnormally large number in client or server traffic that uses chunked transfer encoding. The Small Chunk Size option specifies the maximum size of a small chunk.
 
     [bookmark: pgfId-1533379]For example, set Small Chunk Size to 10 and Consecutive Small Chunks to 5 to detect 5 consecutive chunks of 10 bytes or less.
 
     [bookmark: pgfId-1533380]You can enable preprocessor rule 119:27 to trigger events on excessive small chunks in client traffic, and rule 120:7 in server traffic. When Small Chunk Size is enabled and this option is set to 0 or 1, enabling these rules would trigger an event on every chunk of the specified size or less. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533384]HTTP Methods
 
     [bookmark: pgfId-1533385]Specifies HTTP request methods in addition to GET and POST that you expect the system to encounter in traffic. Use a comma to separate multiple values.
 
     [bookmark: pgfId-1533386]Intrusion rules use the content or protected_content keyword with the HTTP Method argument to search for content in HTTP methods. See HTTP Content Options. You can enable rule 119:31 to generate events when a method other than GET, POST, or a method configured for this option is encountered in traffic.
 
     [bookmark: pgfId-1533390]No Alerts
 
     [bookmark: pgfId-1533391]Disables intrusion events when accompanying preprocessor rules are enabled.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533398]Note This option does not disable HTTP standard text rules and shared object rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533399]Normalize HTTP Headers
 
     [bookmark: pgfId-1533400]When Inspect HTTP Responses is enabled, enables normalization of non-cookie data in request and response headers. When Inspect HTTP Responses is not enabled, enables normalization of the entire HTTP header, including cookies, in request and response headers.
 
     [bookmark: pgfId-1533401]Inspect HTTP Cookies
 
     [bookmark: pgfId-1533402]Enables extraction of cookies from HTTP request headers. Also enables extraction of set-cookie data from response headers when Inspect HTTP Responses is enabled. Disabling this option when cookie extraction is not required can improve performance.
 
     [bookmark: pgfId-1533403]Note that the Cookie: and Set-Cookie: header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
     [bookmark: pgfId-1533404]Normalize Cookies in HTTP headers
 
     [bookmark: pgfId-1533405]Enables normalization of cookies in HTTP request headers. When Inspect HTTP Responses is enabled, also enables normalization of set-cookie data in response headers. You must select Inspect HTTP Cookies before selecting this options.
 
     [bookmark: pgfId-1533406]Allow HTTP Proxy Use
 
     [bookmark: pgfId-1533407]Allows the monitored web server to be used as an HTTP proxy. This option is used only in the inspection of HTTP requests.
 
     [bookmark: pgfId-1533408]Inspect URI Only
 
     [bookmark: pgfId-1533409]Inspects only the URI portion of the normalized HTTP request packet.
 
     [bookmark: pgfId-1533410]Inspect HTTP Responses
 
     [bookmark: pgfId-1533411]Enables extended inspection of HTTP responses so, in addition to decoding and normalizing HTTP request messages, the preprocessor extracts response fields for inspection by the rules engine. Enabling this option causes the system to extract the response header, body, status code, and so on, and also extracts set-cookie data when Inspect HTTP Cookies is enabled. For more information, see HTTP Content Options, Generating Events on the HTTP Encoding Type and Location, and Pointing to a Specific Payload Type.
 
     [bookmark: pgfId-1533423]You can enable rules 120:2 and 120:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533425]Normalize UTF Encodings to UTF-8
 
     [bookmark: pgfId-1533426]When Inspect HTTP Responses is enabled, detects UTF-16LE, UTF-16BE, UTF-32LE, and UTF32-BE encodings in HTTP responses and normalizes them to UTF-8.
 
     [bookmark: pgfId-1533430]You can enable rule 120:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533431][bookmark: 60439]Inspect Compressed Data
 
     [bookmark: pgfId-1564917]When Inspect HTTP Responses is enabled, enables decompression of gzip and deflate-compatible compressed data in the HTTP response body, and inspection of the normalized decompressed data. The system inspects chunked and non-chunked HTTP response data. The system inspects decompressed data packet by packet across multiple packets as needed; that is, the system does not combine the decompressed data from different packets for inspection. Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data; see Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1564591]Unlimited Decompression
 
     [bookmark: pgfId-1564592]When Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled, overrides Maximum Decompressed Data Depth across multiple packets; that is, this option enables unlimited decompression across multiple packets. Note that enabling this option does not affect Maximum Compressed Data Depth or Maximum Decompressed Data Depth within a single packet. Note also that enabling this option sets Maximum Compressed Data Depth and Maximum Decompressed Data Depth to 65535 when you commit your changes. See Selecting Global HTTP Normalization Options.
 
     [bookmark: pgfId-1533441]Normalize Javascript
 
     [bookmark: pgfId-1533442]When Inspect HTTP Responses is enabled, enables detection and normalization of Javascript within the HTTP response body. The preprocessor normalizes obfuscated Javascript data such as the unescape and decodeURI functions and the String.fromCharCode method. The preprocessor normalizes the following encodings within the unescape, decodeURI, and decodeURIComponent functions:
 
     [bookmark: pgfId-1533443] – %XX
 
     [bookmark: pgfId-1533444] – %uXXXX
 
     [bookmark: pgfId-1533445] – 0xXX
 
     [bookmark: pgfId-1533446] – \xXX
 
     [bookmark: pgfId-1533447] – \uXXXX
 
     [bookmark: pgfId-1533448]The preprocessor detects consecutive white spaces and normalizes them into a single space. When this option is enabled, a configuration field allows you to specify the maximum number of consecutive white spaces to permit in obfuscated Javascript data. You can enter a value from 1 to 65535. The value 0 disables event generation, regardless of whether the preprocessor rule (120:10) associated with this field is enabled.
 
     [bookmark: pgfId-1533449]The preprocessor also normalizes the Javascript plus (+) operator and concatenates strings using the operator.
 
     [bookmark: pgfId-1533450]You can use the file_data keyword to point intrusion rules to the normalized Javascript data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1533454]You can enable rules 120:9, 120:10, and 120:11 to generate events for this option, as follows:
 
     [bookmark: pgfId-1533479]
 
      
       
        
        [bookmark: pgfId-1533460]Table 16-6 Normalize Javascript Option Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1533464]This rule... 
          
  
         	 
           
           [bookmark: pgfId-1533466]Triggers an event when... 
          
  
        
 
         
         	[bookmark: pgfId-1533468]120:9
  
         	[bookmark: pgfId-1533470]the obfuscation level within the preprocessor is greater than or equal to 2.
  
        
 
         
         	[bookmark: pgfId-1533472]120:10
  
         	[bookmark: pgfId-1533474]the number of consecutive white spaces in the Javascript obfuscated data is greater than or equal to the value configured for the maximum number of consecutive white spaces allowed.
  
        
 
         
         	[bookmark: pgfId-1533476]120:11
  
         	[bookmark: pgfId-1533478]escaped or encoded data includes more than one type of encoding.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1533483]See Setting Rule States for more information.
 
     [bookmark: pgfId-1533484][bookmark: 57591]Decompress SWF File (LZMA) and Decompress SWF File (Deflate)
 
     [bookmark: pgfId-1594508]When HTTP Inspect Responses is enabled, these options decompress the compressed portions of files located within the HTTP response body of HTTP requests. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1594509]Note You can only decompress the compressed portions of files found in HTTP GET responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1594501] – Decompress SWF File (LZMA) decompresses the LZMA-compatible compressed portions of Adobe ShockWave Flash (.swf) files
 
     [bookmark: pgfId-1583223] – Decompress SWF File (Deflate) decompresses the deflate-compatible compressed portions of Adobe ShockWave Flash (.swf) files
 
     [bookmark: pgfId-1583123]Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data; see Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1596862]You can enable rules 120:12 and 120:13 to generate events for this option, as follows:
 
     [bookmark: pgfId-1592971]
 
      
       
        
        [bookmark: pgfId-1592952]Table 16-7 Decompress SWF File Option Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1592956]This rule... 
          
  
         	 
           
           [bookmark: pgfId-1592958]Triggers an event when... 
          
  
        
 
         
         	[bookmark: pgfId-1592960]120:12
  
         	[bookmark: pgfId-1592962]deflate file decompression fails.
  
        
 
         
         	[bookmark: pgfId-1592964]120:13
  
         	[bookmark: pgfId-1592966]LZMA file decompression fails.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1591991]Decompress PDF File (Deflate)
 
     [bookmark: pgfId-1595024]When HTTP Inspect Responses is enabled, Decompress PDF File (Deflate) decompresses the deflate-compatible compressed portions of Portable Document Format (.pdf) files located within the HTTP response body of HTTP requests. The system can only decompress PDF files with the /FlateDecode stream filter. Other stream filters (including /FlateDecode /FlateDecode) are unsupported.
 
      
       
     
 
     
 
     [bookmark: pgfId-1595025]Note You can only decompress the compressed portions of files found in HTTP GET responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1591996]Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data; see Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1596895]You can enable rules 120:14, 120:15, 120:16, and 120:17 to generate events for this option, as follows:
 
     [bookmark: pgfId-1593313]
 
      
       
        
        [bookmark: pgfId-1593294]Table 16-8 Decompress PDF File (Deflate) Option Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1593298]This rule... 
          
  
         	 
           
           [bookmark: pgfId-1593300]Triggers an event when... 
          
  
        
 
         
         	[bookmark: pgfId-1593302]120:14
  
         	[bookmark: pgfId-1593304]file decompression fails.
  
        
 
         
         	[bookmark: pgfId-1593306]120:15
  
         	[bookmark: pgfId-1593308]file decompression fails due to an unsupported compression type.
  
        
 
         
         	[bookmark: pgfId-1593310]120:16
  
         	[bookmark: pgfId-1593312]file decompression fails due to an unsupported PDF stream filter.
  
        
 
         
         	[bookmark: pgfId-1594039]120:17
  
         	[bookmark: pgfId-1594041]file parsing fails.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1563532]Extract Original Client IP Address
 
     [bookmark: pgfId-1533485]Enables extraction of the original client IP address from the X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP header. You can display the extracted original client IP address in the intrusion events view. See Viewing Events for more information.
 
     [bookmark: pgfId-1533491]You can enable rules 119:23, 119:29 and 119:30 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1537511]XFF Header Priority
 
     [bookmark: pgfId-1537735]When Extract Original Client IP Address is enabled, specifies the order in which the system processes original client IP HTTP headers. If, on your monitored network, you expect to encounter original client IP headers other than X-Forwarded-For (XFF) or True-Client-IP, you can click Add to add additional header names to the priority list. You can then use the up and down arrow icons beside each header type to adjust its priority. Note that if multiple XFF headers appear in an HTTP request, the system processes only the header with the highest priority.
 
     [bookmark: pgfId-1537736]Log URI
 
     [bookmark: pgfId-1533494]Enables extraction of the raw URI, if present, from HTTP request packets and associates the URI with all intrusion events generated for the session.
 
     [bookmark: pgfId-1533495]When this option is enabled, you can display the first fifty characters of the extracted URI in the HTTP URI column of the intrusion events table view. You can display the complete URI, up to 2048 bytes, in the packet view. See Viewing Events for more information.
 
     [bookmark: pgfId-1533502]Log Hostname
 
     [bookmark: pgfId-1533503]Enables extraction of the host name, if present, from the HTTP request Host header and associates the host name with all intrusion events generated for the session. When multiple Host headers are present, extracts the host name from the first header.
 
     [bookmark: pgfId-1533504]When this option is enabled, you can display the first fifty characters of the extracted host name in the HTTP Hostname column of the intrusion events table view. You can display the complete host name, up to 256 bytes, in the packet view. See Viewing Events for more information.
 
     [bookmark: pgfId-1533514]You can enable rule 119:25 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533515]Note that when the preprocessor and rule 119:24 are enabled, the preprocessor generates an intrusion event if it detects multiple Host headers in an HTTP request, regardless of the setting for this option. See Enabling Additional HTTP Inspect Preprocessor Rules for more information.
 
     [bookmark: pgfId-1533519]Profile
 
     [bookmark: pgfId-1533520]Specifies the types of encoding that are normalized for HTTP traffic. The system provides a default profile appropriate for most servers, default profiles for Apache servers and IIS servers, and custom default settings that you can tailor to meet the needs of your monitored traffic. See Selecting Server-Level HTTP Normalization Encoding Options for more information.
 
    
 
     
      [bookmark: pgfId-1533526][bookmark: 38097]Selecting Server-[bookmark: marker-1533525]Level HTTP Normalization Encoding Options
 
     [bookmark: pgfId-1533533]License: Protection
 
     [bookmark: pgfId-1533535]You can select server-level HTTP normalization options to specify the types of encoding that are normalized for HTTP traffic, and to cause the system to generate events against traffic containing this type of encoding. 
 
     [bookmark: pgfId-1533537]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533539]A[bookmark: marker-1533538]SCII Encoding
 
     [bookmark: pgfId-1533540]Decodes encoded ASCII characters and specifies whether the rules engine generates an event on ASCII-encoded URIs.
 
     [bookmark: pgfId-1533544]You can enable rule 119:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533546][bookmark: marker-1533545]UTF-8 Encoding
 
     [bookmark: pgfId-1533547]Decodes standard UTF-8 Unicode sequences in the URI.
 
     [bookmark: pgfId-1533551]You can enable rule 119:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533553][bookmark: marker-1533552]Microsoft %U Encoding
 
     [bookmark: pgfId-1533554]Decodes the IIS %u encoding scheme that uses %u followed by four characters where the 4 characters are a hex encoded value that correlates to an IIS Unicode codepoint.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533558]Tip Legitimate clients rarely use %u encodings, so Cisco recommends decoding HTTP traffic encoded with %u encodings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533562]You can enable rule 119:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533564]B[bookmark: marker-1533563]are Byte UTF-8 Encoding
 
     [bookmark: pgfId-1533565]Decodes bare byte encoding, which uses non-ASCII characters as valid values in decoding UTF-8 values.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533566]Tip Bare byte encoding allows the user to emulate an IIS server and interpret non-standard encodings correctly. Cisco recommends enabling this option because no legitimate clients encode UTF-8 this way.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533573]You can enable rule 119:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533575][bookmark: marker-1533574]Microsoft IIS Encoding
 
     [bookmark: pgfId-1533576]Decodes using Unicode codepoint mapping.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533580]Tip Cisco recommends enabling this option, because it is seen mainly in attacks and evasion attempts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533584]You can enable rule 119:7 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533586]Do[bookmark: marker-1533585]uble Encoding
 
     [bookmark: pgfId-1533587]Decodes IIS double encoded traffic by making two passes through the request URI performing decodes in each one. Cisco recommends enabling this option because it is usually found only in attack scenarios.
 
     [bookmark: pgfId-1533594]You can enable rule 119:2 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533596]M[bookmark: marker-1533595]ulti-Slash Obfuscation
 
     [bookmark: pgfId-1533597]Normalizes multiple slashes in a row into a single slash.
 
     [bookmark: pgfId-1533601]You can enable rule 119:8 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533603][bookmark: marker-1533602]IIS Backslash Obfuscation
 
     [bookmark: pgfId-1533604]Normalizes backslashes to forward slashes.
 
     [bookmark: pgfId-1533608]You can enable rule 119:9 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533610]Dir[bookmark: marker-1533609]ectory Traversal
 
     [bookmark: pgfId-1533611]Normalizes directory traversals and self-referential directories. If you enable the accompanying preprocessor rules to generate events against this type of traffic, it may generate false positives because some web sites refer to files using directory traversals.
 
     [bookmark: pgfId-1533614]You can enable rules 119:10 and 119:11 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533617]Ta[bookmark: marker-1533616]b Obfuscation
 
     [bookmark: pgfId-1533618]Normalizes the non-RFC standard of using a tab for a space delimiter. Apache and other non-IIS web servers use the tab character (0x09) as a delimiter in URLs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533619]Note Regardless of the configuration for this option, the HTTP Inspect preprocessor treats a tab as white space if a space character (0x20) precedes it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533623]You can enable rule 119:12 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533625]Inva[bookmark: marker-1533624]lid RFC Delimiter
 
     [bookmark: pgfId-1533626]Normalizes line breaks (\n) in URI data.
 
     [bookmark: pgfId-1533630]You can enable rule 119:13 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533632]We[bookmark: marker-1533631]broot Directory Traversal
 
     [bookmark: pgfId-1533633]Detects directory traversals that traverse past the initial directory in the URL.
 
     [bookmark: pgfId-1533637]You can enable rule 119:18 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533639]Tab UR[bookmark: marker-1533638]I Delimiter
 
     [bookmark: pgfId-1533640]Turns on the use of the tab character (0x09) as a delimiter for a URI. Apache, newer versions of IIS, and some other web servers use the tab character as a delimiter in URLs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533641]Note Regardless of the configuration for this option, the HTTP Inspect preprocessor treats a tab as white space if a space character (0x20) precedes it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533643]N[bookmark: marker-1533642]on-RFC characters
 
     [bookmark: pgfId-1533644]Detects the non-RFC character list you add in the corresponding field when it appears within incoming or outgoing URI data. When modifying this field, use the hexadecimal format that represents the byte character. If and when you configure this option, set the value with care. Using a character that is very common may overwhelm you with events.
 
     [bookmark: pgfId-1533648]You can enable rule 119:14 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533650]M[bookmark: marker-1533649]ax Chunk Encoding Size
 
     [bookmark: pgfId-1533651]Detects abnormally large chunk sizes in URI data. 
 
     [bookmark: pgfId-1533654]You can enable rules 119:16 and 119:22 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533657]Dis[bookmark: marker-1533656]able Pipeline Decoding
 
     [bookmark: pgfId-1533658]Disables HTTP decoding for pipelined requests. When this option is disabled, performance is enhanced because HTTP requests waiting in the pipeline are not decoded or analyzed, and are only inspected using generic pattern matching.
 
     [bookmark: pgfId-1533660]Non-Strict [bookmark: marker-1533659]URI Parsing
 
     [bookmark: pgfId-1533661]Enables non-strict URI parsing. Use this option only on servers that will accept non-standard URIs in the format "GET /index.html abc xo qr \n". Using this option, the decoder assumes that the URI is between the first and second space, even if there is no valid HTTP identifier after the second space.
 
     [bookmark: pgfId-1533663]Extende[bookmark: marker-1533662]d ASCII Encoding
 
     [bookmark: pgfId-1533664]Enables parsing of extended ASCII characters in an HTTP request URI. Note that this option is available in custom server profiles only, and not in the default profiles provided for Apache, IIS, or all servers.
 
    
 
     
      [bookmark: pgfId-1533667][bookmark: 15877]Configurin[bookmark: marker-1533666]g HTTP Server Options
 
     [bookmark: pgfId-1533674]License: Protection
 
     [bookmark: pgfId-1533676]Use the following procedure to configure HTTP server options. For more information on the HTTP server options, see Selecting Server-Level HTTP Normalization Options and Selecting Server-Level HTTP Normalization Encoding Options.
 
     [bookmark: pgfId-1533683]To configure server-level HTTP configuration options:
 
     
 
     [bookmark: pgfId-1621492]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621493]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621498]The access control policy editor appears.
 
     [bookmark: pgfId-1621499]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621500]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621505]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621506]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572907]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572912]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572916]The Policy Information page appears.
 
     [bookmark: pgfId-1572917]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572918]The Settings page appears.
 
     [bookmark: pgfId-1533702]Step 8 You have two choices, depending on whether HTTP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533703]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533704]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533705]The HTTP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1533709]Step 9 You have two options:
 
      
       
       	 [bookmark: pgfId-1533713]Add a new server profile. Click the add icon (
 
      
 
      [image: ] ) next to 
       Servers on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses for the client in the 
       Server Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1601971]You can specify a single IP address or address block, or a comma-separated list of either or both. You can include up to 496 characters in a list, specify a total of 256 address entries for all server profiles, and create a total of 255 profiles including the default profile. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1618886]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1601978]A new entry appears in the list of servers on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1533722]Modify the settings for an existing profile. Click the configured address for a profile you have added under  Servers on the left side of the page, or click  default .
 
      
 
     
 ) next to the profile you want to remove. 
     
 
     [bookmark: pgfId-1533727]Step 10 Optionally, modify the address or addresses listed in the Networks field and click any other area of the page.
 
     [bookmark: pgfId-1533728]The highlighted address updates on the left side of the page.
 
     [bookmark: pgfId-1600990]Note that you cannot modify the setting for Networks in the default profile. The default profile applies to all servers on your network that are not identified in another profile.
 
     [bookmark: pgfId-1600992]Step 11 In the Ports field, list the ports whose traffic you want to inspect with HTTP Inspect. Separate multiple ports with commas.
 
     [bookmark: pgfId-1533733]Step 12 You can modify any of the other options described in Selecting Server-Level HTTP Normalization Options.
 
     [bookmark: pgfId-1533735]Step 13 Select a server profile as follows:
 
      
       
       	 [bookmark: pgfId-1533738]Select  Custom to create your own server profile (see Selecting Server-Level HTTP Normalization Encoding Options for more information).
 
       	 [bookmark: pgfId-1533740]Select  All to use the standard default profile, appropriate for all servers.
 
       	 [bookmark: pgfId-1533741]Select  IIS to use the default IIS profile.
 
       	 [bookmark: pgfId-1533742]Select  Apache to use the default Apache profile.
 
      
 
     
 
     [bookmark: pgfId-1533743]Step 14 If you selected Custom, the custom options appear.
 
     [bookmark: pgfId-1533744]Step 15 Configure the HTTP decoding options you want in your profile.
 
     [bookmark: pgfId-1533748]See Selecting Server-Level HTTP Normalization Options for details on available normalization options.
 
     [bookmark: pgfId-1533751]Step 16 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533755]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533758][bookmark: 58835]Enabling Additional HTTP [bookmark: marker-1533757]Inspect Preprocessor Rules
 
     [bookmark: pgfId-1533765]License: Protection
 
     [bookmark: pgfId-1533767]You can enable the rules in the Preprocessor Rule GID:SID column of the following table to generate events for HTTP Inspect preprocessor rules that are not associated with specific configuration options. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533815]
 
      
       
        
        [bookmark: pgfId-1533777]Table 16-9 [bookmark: 43151]Additional HTTP Inspect Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1533781]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1533783]Description 
          
  
        
 
         
         	[bookmark: pgfId-1533785]120:5
  
         	[bookmark: pgfId-1533787]Generates an event when UTF-7 encoding is encountered in HTTP response traffic; UTF-7 should only appear where 7-bit parity is required, such as in SMTP traffic.
  
        
 
         
         	[bookmark: pgfId-1533789]119:21
  
         	[bookmark: pgfId-1533791]Generates an event when an HTTP request header has more than one content-length field.
  
        
 
         
         	[bookmark: pgfId-1533793]119:24
  
         	[bookmark: pgfId-1533795]Generates an event when an HTTP request has more than one Host header.
  
        
 
         
         	[bookmark: pgfId-1533797]119:28
120:8
  
         	[bookmark: pgfId-1533799]When enabled, these rules do not generate events.
  
        
 
         
         	[bookmark: pgfId-1533801]119:32
  
         	[bookmark: pgfId-1533803]Generates an event when HTTP version 0.9 is encountered in traffic. Note that the TCP stream configuration must also be enabled. See Using TCP Stream Preprocessing.
  
        
 
         
         	[bookmark: pgfId-1533808]119:33
  
         	[bookmark: pgfId-1533810]Generates an event when an HTTP URI includes an unescaped space.
  
        
 
         
         	[bookmark: pgfId-1533812]119:34
  
         	[bookmark: pgfId-1533814]Generates an event when a TCP connection contains 24 or more pipelined HTTP requests.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533820][bookmark: 24852]Using the S[bookmark: marker-1533817]un RP[bookmark: marker-1533818]C Pr[bookmark: RPCDecoding]eprocessor
 
    [bookmark: pgfId-1533828]License: Protection
 
    [bookmark: pgfId-1533829]RPC (Remote Procedure Call) normalization takes fragmented RPC records and normalizes them to a single record so the rules engine can inspect the complete record. For example, an attacker may attempt to discover the port where RPC admind runs. Some UNIX hosts use RPC admind to perform remote distributed system tasks. If the host performs weak authentication, a malicious user could take control of remote administration. The standard text rule (generator ID: 1) with the Snort ID (SID) 575 detects this attack by searching for content in specific locations to identify inappropriate portmap GETPORT requests.
 
    [bookmark: pgfId-1533833]Ports
 
    [bookmark: pgfId-1533834]Specify the ports whose traffic you want to normalize. In the interface, list multiple ports separated by commas. Typical RPC ports are 111 and 32771. If your network sends RPC traffic to other ports, consider adding them.
 
    [bookmark: pgfId-1533839]Detect fragmented RPC records
 
    [bookmark: pgfId-1533840]Detects RPC fragmented records.
 
    [bookmark: pgfId-1533843]You can enable rules 106:1 and 106:5 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1533845]Detect multiple records in one packet
 
    [bookmark: pgfId-1533846]Detects more than one RPC request per packet (or reassembled packet).
 
    [bookmark: pgfId-1533850]You can enable rule 106:2 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1533852][bookmark: marker-1533851]Detect fragmented record sums which exceed one fragment
 
    [bookmark: pgfId-1533853]Detects reassembled fragment record lengths that exceed the current packet length.
 
    [bookmark: pgfId-1533857]You can enable rule 106:3 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1533858]Detect single fragment records which exceed the size of one packet
 
    [bookmark: pgfId-1533859]Detects partial records
 
    [bookmark: pgfId-1533863]You can enable rule 106:4 to generate events for this option. See Setting Rule States for more information.
 
     
      [bookmark: pgfId-1533866][bookmark: 40544]Configuring the Sun RPC Preprocessor
 
     [bookmark: pgfId-1533873]License: Protection
 
     [bookmark: pgfId-1533874]You can use the following procedure to configure the Sun RPC preprocessor. For more information on the Sun RPC preprocessor configuration options, see Using the Sun RPC Preprocessor.
 
     [bookmark: pgfId-1533878]To configure the Sun RPC preprocessor:
 
     
 
     [bookmark: pgfId-1621621]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621622]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621627]The access control policy editor appears.
 
     [bookmark: pgfId-1621628]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621629]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621634]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621635]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572940]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572945]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572949]The Policy Information page appears.
 
     [bookmark: pgfId-1572950]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572951]The Settings page appears.
 
     [bookmark: pgfId-1533897]Step 8 You have two choices, depending on whether Sun RPC Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533898]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533899]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533900]The Sun RPC Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1533904]Step 9 In the Ports field, type the port numbers where you want to decode RPC traffic. Separate multiple ports with commas. 
 
     [bookmark: pgfId-1533905]Step 10 You can select or clear any of the following detection options on the Sun RPC Configuration page:
 
      
       
       	 [bookmark: pgfId-1533906] Detect fragmented RPC records 
 
       	 [bookmark: pgfId-1533907] Detect multiple records in one packet 
 
       	 [bookmark: pgfId-1533908] Detect fragmented record sums which exceed one packet 
 
       	 [bookmark: pgfId-1533909] Detect single fragment records which exceed the size of one packet 
 
      
 
     
 
     [bookmark: pgfId-1533912]Step 11 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533916]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533920][bookmark: 70648]Decoding the Se[bookmark: marker-1533919]ssion Initiation Protocol
 
    [bookmark: pgfId-1533928]License: Protection
 
    [bookmark: pgfId-1533929]The Session Initiation Protocol (SIP) provides call setup, modification, and teardown of one or more sessions for one or more users of such client applications as Internet telephony, multimedia conferencing, instant messaging, online gaming, and file transfer. A method field in each SIP request identifies the purpose of the request, and a Request-URI specifies where to send the request. A status code in each SIP response indicates the outcome of the requested action.
 
    [bookmark: pgfId-1533930]After calls are set up using SIP, the Real-time Transport Protocol (RTP) is responsible for subsequent audio and video communication; this part of the session is sometimes referred to as the call channel, the data channel, or the audio/video data channel. RTP uses the Session Description Protocol (SDP) within the SIP message body for data-channel parameter negotiation, session announcement, and session invitation.
 
    [bookmark: pgfId-1533931]The SIP preprocessor is responsible for:
 
     
     	 [bookmark: pgfId-1533932]decoding and analyzing SIP 2.0 traffic
 
     	 [bookmark: pgfId-1533933]extracting the SIP header and message body, including SDP data when present, and passing the extracted data to the rules engine for further inspection
 
     	 [bookmark: pgfId-1533934]generating events when the following conditions are detected and the corresponding preprocessor rules are enabled: anomalies and known vulnerabilities in SIP packets; out-of-order and invalid call sequences
 
     	 [bookmark: pgfId-1533935]optionally ignoring the call channel
 
    
 
    [bookmark: pgfId-1533936]The preprocessor identifies the RTP channel based on the port identified in the SDP message, which is embedded in the SIP message body, but the preprocessor does not provide RTP protocol inspection.
 
    [bookmark: pgfId-1533937]Note the following when using the SIP preprocessor:
 
     
     	 [bookmark: pgfId-1533938]UDP typically carries media sessions supported by SIP. UDP stream preprocessing provides SIP session tracking for the SIP preprocessor. 
 
     	 [bookmark: pgfId-1533945]SIP rule keywords allow you to point to the SIP packet header or message body and to limit detection to packets for specific SIP methods or status codes. For more information, see SIP Keywords.
 
     	 [bookmark: pgfId-1533949]When enabled, the preprocessor generates no events before sending the extracted data to the rules engine unless you also enable the accompanying rules with generator ID (GID) 140. See Setting Rule States for more information.
 
    
 
    [bookmark: pgfId-1533963]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1533967]Selecting SIP Preprocessor Options
 
     	 [bookmark: pgfId-1533971]Configuring the SIP Preprocessor
 
     	 [bookmark: pgfId-1533975]Enabling Additional SIP Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1533978][bookmark: 28900]Selecting SIP [bookmark: marker-1533977]Preprocessor Options
 
     [bookmark: pgfId-1533985]License: Protection
 
     [bookmark: pgfId-1533986]The following list describes SIP preprocessor options you can modify.
 
     [bookmark: pgfId-1533987]For the Maximum Request URI Length, Maximum Call ID Length, Maximum Request Name Length, Maximum From Length, Maximum To Length, Maximum Via Length, Maximum Contact Length, and Maximum Content Length options, you can specify from 1 to 65535 bytes, or 0 to disable event generation for the option regardless of whether the associated rule is enabled.
 
     [bookmark: pgfId-1533988]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533989]Ports
 
     [bookmark: pgfId-1533990]Specifies the ports to inspect for SIP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1533991]Methods to Check
 
     [bookmark: pgfId-1533992]Specifies SIP methods to detect. You can specify any of the following currently defined SIP methods:
 
      
      [bookmark: pgfId-1533993] ack, benotify, bye, cancel, do, info, invite, join, message, 
     
 
      
      [bookmark: pgfId-1533994] notify, options, prack, publish, quath, refer, register, 
     
 
      
      [bookmark: pgfId-1533995] service, sprack, subscribe, unsubscribe, update 
     
 
     [bookmark: pgfId-1533996]Methods are case-insensitive. The method name can include alphabetic characters, numbers, and the underscore character. No other special characters are permitted. Separate multiple methods with commas.
 
     [bookmark: pgfId-1533997]Because new SIP methods might be defined in the future, your configuration can include an alphabetic string that is not currently defined. The system supports up to 32 methods, including the 21 currently defined methods and an additional 11 methods. The system ignores any undefined methods that you might configure.
 
     [bookmark: pgfId-1533998]Note that, in addition to any methods you specify for this option, the 32 total methods includes methods specified using the sip_method keyword in intrusion rules. See sip_method for more information.
 
     [bookmark: pgfId-1534002]Maximum Dialogs within a Session
 
     [bookmark: pgfId-1534003]Specifies the maximum number of dialogs allowed within a stream session. If more dialogs than this number are created, the oldest dialogs are dropped until the number of dialogs does not exceed the maximum number specified; an event also triggers when rule 140:27 is enabled.
 
     [bookmark: pgfId-1534004]You can specify an integer from 1 to 4194303.
 
     [bookmark: pgfId-1534005]Maximum Request URI Length
 
     [bookmark: pgfId-1534006]Specifies the maximum number of bytes to allow in the Request-URI header field. A longer URI triggers an event when rule 140:3 is enabled. The request URI field indicates the destination path or page for the request.
 
     [bookmark: pgfId-1534007]Maximum Call ID Length
 
     [bookmark: pgfId-1534008]Specifies the maximum number of bytes to allow in the request or response Call-ID header field. A longer Call-ID triggers an event when rule 140:5 is enabled. The Call-ID field uniquely identifies the SIP session in requests and responses.
 
     [bookmark: pgfId-1534009]Maximum Request Name Length
 
     [bookmark: pgfId-1534010]Specifies the maximum number of bytes to allow in the request name, which is the name of the method specified in the CSeq transaction identifier. A longer request name triggers an event when rule 140:7 is enabled.
 
     [bookmark: pgfId-1534011]Maximum From Length
 
     [bookmark: pgfId-1534012]Specifies the maximum number of bytes to allow in the request or response From header field. A longer From triggers an event when rule 140:9 is enabled. The From field identifies the message initiator.
 
     [bookmark: pgfId-1534013]Maximum To Length
 
     [bookmark: pgfId-1534014]Specifies the maximum number of bytes to allow in the request or response To header field. A longer To triggers an event when rule 140:11 is enabled. The To field identifies the message recipient.
 
     [bookmark: pgfId-1534015]Maximum Via Length
 
     [bookmark: pgfId-1534016]Specifies the maximum number of bytes to allow in the request or response Via header field. A longer Via triggers an event when rule 140:13 is enabled. The Via field provides the path followed by the request and, in a response, receipt information.
 
     [bookmark: pgfId-1534017]Maximum Contact Length
 
     [bookmark: pgfId-1534018]Specifies the maximum number of bytes to allow in the request or response Contact header field. A longer Contact triggers an event when rule 140:15 is enabled. The Contact field provides a URI that specifies the location to contact with subsequent messages.
 
     [bookmark: pgfId-1534019]Maximum Content Length
 
     [bookmark: pgfId-1534020]Specifies the maximum number of bytes to allow in the content of the request or response message body. Longer content triggers an event when rule 140:16 is enabled.
 
     [bookmark: pgfId-1534021]Ignore Audio/Video Data Channel
 
     [bookmark: pgfId-1534022]Enables and disables inspection of data channel traffic. Note that the preprocessor continues inspection of other non-data-channel SIP traffic when you enable this option.
 
    
 
     
      [bookmark: pgfId-1534025][bookmark: 82687]Configuring the SIP Prep[bookmark: marker-1534024]rocessor
 
     [bookmark: pgfId-1534032]License: Protection
 
     [bookmark: pgfId-1534033]Use the following procedure to configure the SIP preprocessor.
 
     [bookmark: pgfId-1534034]To configure the SIP preprocessor:
 
     
 
     [bookmark: pgfId-1621673]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621674]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621679]The access control policy editor appears.
 
     [bookmark: pgfId-1621680]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621681]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621686]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621687]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1572969]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572974]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572978]The Policy Information page appears.
 
     [bookmark: pgfId-1572979]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572980]The Settings page appears.
 
     [bookmark: pgfId-1534053]Step 8 You have two choices, depending on whether SIP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534054]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534055]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534056]The SIP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534063]Step 9 You can modify any of the options described in Selecting SIP Preprocessor Options.
 
     [bookmark: pgfId-1534066]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534070]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534073][bookmark: 25926]Enabling Additional SIP [bookmark: marker-1534072]Preprocessor Rules
 
     [bookmark: pgfId-1534080]License: Protection
 
     [bookmark: pgfId-1534081]The SIP preprocessor rules in the following table are not associated with specific configuration options. As with other SIP preprocessor rules, you must enable these rules if you want them to generate events. See Setting Rule States for information on enabling rules.
 
     [bookmark: pgfId-1534170]
 
      
       
        
        [bookmark: pgfId-1534091]Table 16-10 [bookmark: 44208]Additional SIP Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534095]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1534097]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534099]140:1
  
         	[bookmark: pgfId-1534101]Generates an event when the preprocessor is monitoring the maximum number of SIP sessions allowed by the system.
  
        
 
         
         	[bookmark: pgfId-1534103]140:2
  
         	[bookmark: pgfId-1534105]Generates an event when the required Request_URI field is empty in a SIP request.
  
        
 
         
         	[bookmark: pgfId-1534107]140:4
  
         	[bookmark: pgfId-1534109]Generates an event when the Call-ID header field is empty in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534111]140:6
  
         	[bookmark: pgfId-1534113]Generates an event when the value for the sequence number in the SIP request or response CSeq field is not a 32-bit unsigned integer less than 231.
  
        
 
         
         	[bookmark: pgfId-1534115]140:8
  
         	[bookmark: pgfId-1534117]Generates an event an event when the From header field is empty in a SIP request or response. 
  
        
 
         
         	[bookmark: pgfId-1534119]140:10
  
         	[bookmark: pgfId-1534121]Generates an event when the To header field is empty in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534123]140:12
  
         	[bookmark: pgfId-1534125]Generates an event when the Via header field is empty in a SIP request or response
  
        
 
         
         	[bookmark: pgfId-1534127]140:14
  
         	[bookmark: pgfId-1534129]Generates an event when the required Contact header field is empty in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534131]140:17
  
         	[bookmark: pgfId-1534133]Generates an event when a single SIP request or response packet in UDP traffic contains multiple messages. Note that older SIP versions supported multiple messages, but SIP 2.0 supports only one message per packet.
  
        
 
         
         	[bookmark: pgfId-1534135]140:18
  
         	[bookmark: pgfId-1534137]Generates an event when the actual length of the message body in a SIP request or response in UDP traffic does not match the value specified in the Content-Length header field in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534139]140:19
  
         	[bookmark: pgfId-1534141]Generates an event when the preprocessor does not recognize a method name in the CSeq field of a SIP response.
  
        
 
         
         	[bookmark: pgfId-1534143]140:20
  
         	[bookmark: pgfId-1534145]Generates an event when the SIP server does not challenge an authenticated invite message. Note that this occurs in the case of the InviteReplay billing attack.
  
        
 
         
         	[bookmark: pgfId-1534147]140:21
  
         	[bookmark: pgfId-1534149]Generates an event when session information changes before the call is set up. Note that this occurs in the case of the FakeBusy billing attack.
  
        
 
         
         	[bookmark: pgfId-1534151]140:22
  
         	[bookmark: pgfId-1534153]Generates an event when the response status code is not a three-digit number.
  
        
 
         
         	[bookmark: pgfId-1534155]140:23
  
         	[bookmark: pgfId-1534157]Generates an event when the Content-Type header field does not specify a content type and the message body contains data.
  
        
 
         
         	[bookmark: pgfId-1534159]140:24
  
         	[bookmark: pgfId-1534161]Generates an event when the SIP version is not 1, 1.1, or 2.0.
  
        
 
         
         	[bookmark: pgfId-1534163]140:25
  
         	[bookmark: pgfId-1534165]Generates an event when the method specified in the CSeq header and the method field do not match in a SIP request.
  
        
 
         
         	[bookmark: pgfId-1534167]140:26
  
         	[bookmark: pgfId-1534169]Generates an event when the preprocessor does not recognize the method named in the SIP request method field.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534174][bookmark: 19270]Configuring the GTP Com[bookmark: marker-1534173]mand Channel
 
    [bookmark: pgfId-1534182]License: Protection
 
    [bookmark: pgfId-1534183]The General Service Packet Radio (GPRS) Tunneling Protocol (GTP) provides communication over a GTP core network. The GTP preprocessor detects anomalies in GTP traffic and forwards command channel signaling messages to the rules engine for inspection. You can use the gtp_version, gtp_type, and gtp_info rule keywords to inspect GTP command channel traffic for exploits.
 
    [bookmark: pgfId-1534184]A single configuration option allows you to modify the default setting for the ports that the preprocessor inspects for GTP command channel messages.
 
     
      
       
       [bookmark: pgfId-1534200]Table 16-11 GTP Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1534204]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1534206]Description 
         
  
       
 
        
        	[bookmark: pgfId-1534208]143:1
  
        	[bookmark: pgfId-1534210]Generates an event when the preprocessor detects an invalid message length.
  
       
 
        
        	[bookmark: pgfId-1534212]143:2
  
        	[bookmark: pgfId-1534214]Generates an event when the preprocessor detects an invalid information element length.
  
       
 
        
        	[bookmark: pgfId-1534216]143:3
  
        	[bookmark: pgfId-1534218]Generates an event when the preprocessor detects information elements that are out of order.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1534220]You can use the following procedure to modify the ports the GTP preprocessor monitors for GTP command messages.
 
    [bookmark: pgfId-1534221]To configure the GTP command channel:
 
    
 
    [bookmark: pgfId-1621770]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1621771]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1621776]The access control policy editor appears.
 
    [bookmark: pgfId-1621777]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1621778]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1621783]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1621784]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1572998]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1573003]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1573007]The Policy Information page appears.
 
    [bookmark: pgfId-1573008]Step 7 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1573009]The Settings page appears.
 
    [bookmark: pgfId-1534239]Step 8 You have two choices, depending on whether GTP Command Channel Configuration under Application Layer Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1534240]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1534241]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1534242]The GTP Command Channel Configuration page appears.
 
    [bookmark: pgfId-1534243]Step 9 Optionally, modify the ports that the preprocessor inspects for GTP command messages. You can specify an integer from 0 to 65535. Use commas to separate multiple ports.
 
    [bookmark: pgfId-1534246]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1534250]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1534255][bookmark: 22886][bookmark: 61174]Decoding IM[bookmark: marker-1534254]AP Traffic
 
    [bookmark: pgfId-1534263]License: Protection
 
    [bookmark: pgfId-1534264]The Internet Message Application Protocol (IMAP) is used to retrieve email from a remote IMAP server. The IMAP preprocessor inspects server-to-client IMAP4 traffic and, when associated preprocessor rules are enabled, generates events on anomalous traffic. The preprocessor can also extract and decode email attachments in client-to-server IMAP4 traffic and send the attachment data to the rules engine. You can use the file_data keyword in an intrusion rule to point to the attachment data. See Pointing to a Specific Payload Type for more information.
 
    [bookmark: pgfId-1534268]Extraction and decoding include multiple attachments, when present, and large attachments that span multiple packets.
 
    [bookmark: pgfId-1534277]If you want IMAP preprocessor rules to generate events, you must enable the rules. IMAP preprocessor rules have a generator ID (GID) of 141.See Setting Rule States for more information.
 
    [bookmark: pgfId-1534281]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534285]Selecting IMAP Preprocessor Options
 
     	 [bookmark: pgfId-1534289]Configuring the IMAP Preprocessor
 
     	 [bookmark: pgfId-1534293]Enabling Additional IMAP Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1534296][bookmark: 22577]Selecting IMAP [bookmark: marker-1534295]Preprocessor Options
 
     [bookmark: pgfId-1534303]License: Protection
 
     [bookmark: pgfId-1534304]The following list describes the IMAP preprocessor options you can modify.
 
     [bookmark: pgfId-1534305]Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.
 
     [bookmark: pgfId-1602669]Note also that the highest value is used when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in:
 
      
      	 [bookmark: pgfId-1602672]the default network analysis policy
 
      	 [bookmark: pgfId-1602681]any other custom network analysis policy invoked by network analysis rules in the same access control policy
 
     
 
     [bookmark: pgfId-1602684]See Setting the Default Network Analysis Policy for Access Control and Specifying Traffic to Preprocess Using Network Analysis Rules for more information.
 
     [bookmark: pgfId-1534313]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1534314]Ports
 
     [bookmark: pgfId-1534315]Specifies the ports to inspect for IMAP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534320]Base64 Decoding Depth
 
     [bookmark: pgfId-1534321]Specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data.
 
     [bookmark: pgfId-1534322]Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
 
     [bookmark: pgfId-1534323]When Base64 decoding is enabled, you can enable rule 141:4 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.
 
     [bookmark: pgfId-1534324]7-Bit/8-Bit/Binary Decoding Depth
 
     [bookmark: pgfId-1534325]Specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify from 1 to 65535 bytes, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data.
 
     [bookmark: pgfId-1534326]Quoted-Printable Decoding Depth
 
     [bookmark: pgfId-1534327]Specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data.
 
     [bookmark: pgfId-1534328]When quoted-printable decoding is enabled, you can enable rule 141:6 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.
 
     [bookmark: pgfId-1534329]Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-1534330]Specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data.
 
     [bookmark: pgfId-1534331]When Unix-to-Unix decoding is enabled, you can enable rule 141:7 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.
 
    
 
     
      [bookmark: pgfId-1534334][bookmark: 98313]Configuring the [bookmark: IMAP preprocessor]IMAP Preprocessor
 
     [bookmark: pgfId-1534341]License: Protection
 
     [bookmark: pgfId-1534342]Use the following procedure to configure the IMAP preprocessor. For additional information on IMAP preprocessor configuration options, see Selecting IMAP Preprocessor Options. 
 
     [bookmark: pgfId-1534346]To configure the IMAP preprocessor:
 
     
 
     [bookmark: pgfId-1621859]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621860]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621865]The access control policy editor appears.
 
     [bookmark: pgfId-1621866]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621867]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621872]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621873]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1573023]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573028]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573032]The Policy Information page appears.
 
     [bookmark: pgfId-1573033]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573034]The Settings page appears.
 
     [bookmark: pgfId-1534365]Step 8 You have two choices, depending on whether IMAP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534366]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534367]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534368]The IMAP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534372]Step 9 Specify the Ports where IMAP traffic should be decoded. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534377]Step 10 Specify the maximum bytes of data to extract and decode from any combination of the following email attachment types:
 
      
       
       	 [bookmark: pgfId-1534378] Base64 Decoding Depth 
 
       	 [bookmark: pgfId-1534379] 7-Bit/8-Bit/Binary Decoding Depth (includes various multipart content types such as plain text, jpeg images, mp3 files, and so on)
 
       	 [bookmark: pgfId-1534380] Quoted-Printable Decoding Depth 
 
       	 [bookmark: pgfId-1534381] Unix-to-Unix Decoding Depth 
 
      
 
     
 
     [bookmark: pgfId-1534382]For each type, you can specify from 1 to 65535 bytes, or specify 0 to extract and, when necessary, decode all data in the packet. Specify -1 to ignore data for an attachment type.
 
     [bookmark: pgfId-1534383]You can use the file_data rule keyword in intrusion rules to inspect the attachment data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1534389]Step 11 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534393]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534396][bookmark: 62734]Enabling Additional IMAP [bookmark: IMAP preprocessor]Preprocessor Rules
 
     [bookmark: pgfId-1534403]License: Protection
 
     [bookmark: pgfId-1534404]The IMAP preprocessor rules in the following table are not associated with specific configuration options. As with other IMAP preprocessor rules, you must enable these rules if you want them to generate events. See Setting Rule States for information on enabling rules.
 
     [bookmark: pgfId-1534432]
 
      
       
        
        [bookmark: pgfId-1534413]Table 16-12 Additional IMAP Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534417]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1534419]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534421]141:1
  
         	[bookmark: pgfId-1534423]Generates an event when the preprocessor detects a client command that is not defined in RFC 3501.
  
        
 
         
         	[bookmark: pgfId-1534425]141:2
  
         	[bookmark: pgfId-1534427]Generates an event when the preprocessor detects a server response that is not defined in RFC 3501.
  
        
 
         
         	[bookmark: pgfId-1534429]141:3
  
         	[bookmark: pgfId-1534431]Generates an event when the preprocessor is using the maximum amount of memory allowed by the system. At this point, the preprocessor stops decoding until memory becomes available.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534436][bookmark: 20303]Decoding P[bookmark: marker-1534435]OP Traffic
 
    [bookmark: pgfId-1534444]License: Protection
 
    [bookmark: pgfId-1534445]The Post Office Protocol (POP) is used to retrieve email from a remote POP mail server. The POP preprocessor inspects server-to-client POP3 traffic and, when associated preprocessor rules are enabled, generates events on anomalous traffic. The preprocessor can also extract and decode email attachments in client-to-server POP3 traffic and send the attachment data to the rules engine. You can use the file_data keyword in an intrusion rule to point to attachment data. See Pointing to a Specific Payload Type for more information.
 
    [bookmark: pgfId-1534449]Extraction and decoding include multiple attachments, when present, and large attachments that span multiple packets.
 
    [bookmark: pgfId-1534458]If you want POP preprocessor rules to generate events, you must enable the rules. POP preprocessor rules have a generator ID (GID) of 142. See Setting Rule States for more information.
 
    [bookmark: pgfId-1534462]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534466]Selecting POP Preprocessor Options
 
     	 [bookmark: pgfId-1534470]Configuring the POP Preprocessor
 
     	 [bookmark: pgfId-1534474]Enabling Additional POP Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1534477][bookmark: 39673]Selecting POP [bookmark: marker-1534476]Preprocessor Options
 
     [bookmark: pgfId-1534484]License: Protection
 
     [bookmark: pgfId-1534485]The following list describes the POP preprocessor options you can modify.
 
     [bookmark: pgfId-1534486]Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.
 
     [bookmark: pgfId-1534487]Note also that when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in an intrusion policy associated with the default action of an access control policy and intrusion policies associated with access control rules, the highest value is used.
 
     [bookmark: pgfId-1534494]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1534495]Ports
 
     [bookmark: pgfId-1534496]Specifies the ports to inspect for POP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534501]Base64 Decoding Depth
 
     [bookmark: pgfId-1534502]Specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data.
 
     [bookmark: pgfId-1534503]Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
 
     [bookmark: pgfId-1534504]When Base64 decoding is enabled, you can enable rule 142:4 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534508]7-Bit/8-Bit/Binary Decoding Depth
 
     [bookmark: pgfId-1534509]Specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify from 1 to 65535 bytes, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data.
 
     [bookmark: pgfId-1534510]Quoted-Printable Decoding Depth
 
     [bookmark: pgfId-1534511]Specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data.
 
     [bookmark: pgfId-1534512]When quoted-printable decoding is enabled, you can enable rule 142:6 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534516]Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-1534517]Specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data.
 
     [bookmark: pgfId-1534518]When Unix-to-Unix decoding is enabled, you can enable rule 142:7 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1534524][bookmark: 43732]Configuring the [bookmark: POP preprocessor]POP Preprocessor
 
     [bookmark: pgfId-1534531]License: Protection
 
     [bookmark: pgfId-1534532]Use the following procedure to configure the POP preprocessor. For additional information on POP preprocessor configuration options, see Selecting POP Preprocessor Options.
 
     [bookmark: pgfId-1534536]To configure the POP preprocessor:
 
     
 
     [bookmark: pgfId-1621916]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621917]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621922]The access control policy editor appears.
 
     [bookmark: pgfId-1621923]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621924]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621929]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621930]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1573052]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573057]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573061]The Policy Information page appears.
 
     [bookmark: pgfId-1573062]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573063]The Settings page appears.
 
     [bookmark: pgfId-1534555]Step 8 You have two choices, depending on whether POP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534556]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534557]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534558]The POP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534562]Step 9 Specify the Ports where IMAP traffic should be decoded. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534567]Step 10 Specify the maximum bytes of data to extract and decode from any combination of the following email attachment types:
 
      
       
       	 [bookmark: pgfId-1534568] Base64 Decoding Depth 
 
       	 [bookmark: pgfId-1534569] 7-Bit/8-Bit/Binary Decoding Depth (includes various multipart content types such as plain text, jpeg images, mp3 files, and so on)
 
       	 [bookmark: pgfId-1534570] Quoted-Printable Decoding Depth 
 
       	 [bookmark: pgfId-1534571] Unix-to-Unix Decoding Depth 
 
      
 
     
 
     [bookmark: pgfId-1534572]For each type, you can specify from 1 to 65535 bytes, or specify 0 to extract and, when necessary, decode all data in the packet. Specify -1 to ignore data for an attachment type.
 
     [bookmark: pgfId-1534573]You can use the file_data rule keyword in intrusion rules to inspect the attachment data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1534579]Step 11 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534583]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534586][bookmark: 51320]Enabling Additional POP [bookmark: POP preprocessor]Preprocessor Rules
 
     [bookmark: pgfId-1534593]License: Protection
 
     [bookmark: pgfId-1534594]The POP preprocessor rules in the following table are not associated with specific configuration options. As with other POP preprocessor rules, you must enable these rules if you want them to generate events. See Setting Rule States for information on enabling rules.
 
     [bookmark: pgfId-1534622]
 
      
       
        
        [bookmark: pgfId-1534603]Table 16-13 Additional POP Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534607]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1534609]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534611]142:1
  
         	[bookmark: pgfId-1534613]Generates an event when the preprocessor detects a client command that is not defined in RFC 1939.
  
        
 
         
         	[bookmark: pgfId-1534615]142:2
  
         	[bookmark: pgfId-1534617]Generates an event when the preprocessor detects a server response that is not defined in RFC 1939.
  
        
 
         
         	[bookmark: pgfId-1534619]142:3
  
         	[bookmark: pgfId-1534621]Generates an event when the preprocessor is using the maximum amount of memory allowed by the system. At this point, the preprocessor stops decoding until memory becomes available.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534626][bookmark: 85623]Decod[bookmark: marker-1534624]ing S[bookmark: SMTP]MTP Traffic
 
    [bookmark: pgfId-1534633]License: Protection
 
    [bookmark: pgfId-1534634]The SMTP preprocessor instructs the rules engine to normalize SMTP commands. The preprocessor can also extract and decode email attachments in client-to-server traffic and, depending on the software version, extract email file names, addresses, and header data to provide context when displaying intrusion events triggered by SMTP traffic.
 
    [bookmark: pgfId-1534635]Note the following when using the SMTP preprocessor:
 
     
     	 [bookmark: pgfId-1587488]You must enable SMTP preprocessor rules, which have a generator ID (GID) of 124, if you want these rules to generate events. See Setting Rule States for more information.
 
    
 
    [bookmark: pgfId-1587492]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1534651]Understanding SMTP Decoding
 
     	 [bookmark: pgfId-1534655]Configuring SMTP Decoding
 
     	 [bookmark: pgfId-1534659]Enabling SMTP Maximum Decoding Memory Alerting
 
    
 
     
      [bookmark: pgfId-1534662][bookmark: 95434]Understanding SMTP [bookmark: marker-1534661]Decoding
 
     [bookmark: pgfId-1534669]License: Protection
 
     [bookmark: pgfId-1534670]You can enable or disable normalization, and you can configure options to control the types of anomalous traffic the SMTP decoder detects.
 
     [bookmark: pgfId-1534671]Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.
 
     [bookmark: pgfId-1534672]Note also that when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in an intrusion policy associated with the default action of an access control policy and intrusion policies associated with access control rules, the highest value is used.
 
     [bookmark: pgfId-1534679]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1534680]Ports
 
     [bookmark: pgfId-1534681]Specifies the ports whose SMTP traffic you want to normalize. You can specify an integer from 0 to 65535. Separate multiple ports with commas.
 
     [bookmark: pgfId-1534686]Stateful Inspection
 
     [bookmark: pgfId-1534687]When selected, causes SMTP decoder to save state and provide session context for individual packets and only inspects reassembled sessions. When cleared, analyzes each individual packet without session context.
 
     [bookmark: pgfId-1534688]Normalize
 
     [bookmark: pgfId-1534689]When set to All, normalizes all commands. Checks for more than one space character after a command.
 
     [bookmark: pgfId-1534690]When set to None, normalizes no commands.
 
     [bookmark: pgfId-1534691]When set to Cmds, normalizes the commands listed in Custom Commands.
 
     [bookmark: pgfId-1534692]Custom Commands
 
     [bookmark: pgfId-1534693]When Normalize is set to Cmds, normalizes the listed commands. 
 
     [bookmark: pgfId-1534694]Specify commands which should be normalized in the text box. Checks for more than one space character after a command. 
 
     [bookmark: pgfId-1534695]The space (ASCII 0x20) and tab (ASCII 0x09) characters count as space characters for normalization purposes. 
 
     [bookmark: pgfId-1534696]Ignore Data 
 
     [bookmark: pgfId-1534697]Does not process mail data; processes only MIME mail header data.
 
     [bookmark: pgfId-1534698]Ignore TLS Data
 
     [bookmark: pgfId-1534699]Does not process data encrypted under the Transport Layer Security protocol.
 
     [bookmark: pgfId-1534700]No Alerts 
 
     [bookmark: pgfId-1534701]Disables intrusion events when accompanying preprocessor rules are enabled.
 
     [bookmark: pgfId-1534702]Detect Unknown Commands
 
     [bookmark: pgfId-1534703]Detects unknown commands in SMTP traffic.
 
     [bookmark: pgfId-1534706]You can enable rules 124:5 and 124:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534708]Max Command Line Len
 
     [bookmark: pgfId-1534709]Detects when an SMTP command line is longer than this value. Specify 0 to never detect command line length.
 
     [bookmark: pgfId-1534710]RFC 2821, the Network Working Group specification on the Simple Mail Transfer Protocol, recommends 512 as a maximum command line length.
 
     [bookmark: pgfId-1534714]You can enable rule 124:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534715]Max Header Line Len 
 
     [bookmark: pgfId-1534716]Detects when an SMTP data header line is longer than this value. Specify 0 to never detect data header line length. 
 
     [bookmark: pgfId-1534719]You can enable rules 124:2 and 124:7 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534721]Max Response Line Len
 
     [bookmark: pgfId-1534722]Detects when an SMTP response line is longer than this value. Specify 0 to never detect response line length.
 
     [bookmark: pgfId-1534723]RFC 2821 recommends 512 as a maximum response line length.
 
     [bookmark: pgfId-1534727]You can enable rule 124:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534728]Alt Max Command Line Len
 
     [bookmark: pgfId-1534729]Detects when the SMTP command line for any of the specified commands is longer than this value. Specify 0 to never detect command line length for the specified commands. Different default line lengths are set for numerous commands. 
 
     [bookmark: pgfId-1534730]This setting overrides the Max Command Line Len setting for the specified commands.
 
     [bookmark: pgfId-1534734]You can enable rule 124:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534735]Invalid Commands
 
     [bookmark: pgfId-1534736]Detects if these commands are sent from the client side.
 
     [bookmark: pgfId-1534739]You can enable rule 124:5 and 124:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534741]Valid Commands
 
     [bookmark: pgfId-1534742]Permits commands in this list. 
 
     [bookmark: pgfId-1534743]Even if this list is empty, the preprocessor permits the following valid commands: ATRN AUTH BDAT DATA DEBUG EHLO EMAL ESAM ESND ESOM ETRN EVFY EXPN HELO HELP IDENT MAIL NOOP ONEX QUEU QUIT RCPT RSET SAML SEND SIZE SOML STARTTLS TICK TIME TURN TURNME VERB VRFY XADR XAUTH XCIR XEXCH50 X-EXPS XGEN XLICENSE X-LINK2STATE XQUE XSTA XTRN XUSR 
 
      
       
     
 
     
 
     [bookmark: pgfId-1534744]Note RCPT TO and MAIL FROM are SMTP commands. The preprocessor configuration uses command names of RCPT and MAIL, respectively. Within the code, the preprocessor maps RCPT and MAIL to the correct command name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534748]You can enable rule 124:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534749]Data Commands
 
     [bookmark: pgfId-1534750]Lists commands that initiate sending data in the same way the SMTP DATA command sends data per RFC 5321. Separate multiple commands with spaces.
 
     [bookmark: pgfId-1534751]Binary Data Commands
 
     [bookmark: pgfId-1534752]Lists commands that initiate sending data in a way that is similar to how the BDAT command sends data per RFC 3030. Separate multiple commands with spaces.
 
     [bookmark: pgfId-1534753]Authentication Commands
 
     [bookmark: pgfId-1534754]Lists commands that initiate an authentication exchange between client and server. Separate multiple commands with spaces.
 
     [bookmark: pgfId-1534755]Detect xlink2state
 
     [bookmark: pgfId-1534756]Detects packets that are part of X-Link2State Microsoft Exchange buffer data overflow attacks. In inline deployments, the system can also drop those packets. 
 
     [bookmark: pgfId-1534760]You can enable rule 124:8 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534761]Base64 Decoding Depth
 
     [bookmark: pgfId-1534762]When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data. The preprocessor will not decode data when Ignore Data is selected.
 
     [bookmark: pgfId-1534763]Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
 
     [bookmark: pgfId-1534764]When Base64 decoding is enabled, you can enable rule 124:10 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534768]Note that this option replaces the deprecated options Enable MIME Decoding and Maximum MIME Decoding Depth, which are still supported in existing intrusion policies for backward compatibility.
 
     [bookmark: pgfId-1534769]7-Bit/8-Bit/Binary Decoding Depth
 
     [bookmark: pgfId-1534770]When Ignore Data is disabled, specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify from 1 to 65535 bytes, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data. The preprocessor will not extract data when Ignore Data is selected.
 
     [bookmark: pgfId-1534771]Quoted-Printable Decoding Depth
 
     [bookmark: pgfId-1534772]When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. 
 
     [bookmark: pgfId-1534773]You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data. The preprocessor will not decode data when Ignore Data is selected.
 
     [bookmark: pgfId-1534774]When quoted-printable decoding is enabled, you can enable rule 124:11 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534778]Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-1534779]When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data. The preprocessor will not decode data when Ignore Data is selected.
 
     [bookmark: pgfId-1534780]When Unix-to-Unix decoding is enabled, you can enable rule 124:13 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534784]Log MIME Attachment Names
 
     [bookmark: pgfId-1534785]Enables extraction of MIME attachment file names from the MIME Content-Disposition header and associates the file names with all intrusion events generated for the session. Multiple file names are supported.
 
     [bookmark: pgfId-1638489]When this option is enabled, you can view file names associated with events in the Email Attachment column of the intrusion events table view. See Viewing Events for more information.
 
     [bookmark: pgfId-1638493]Log To Addresses
 
     [bookmark: pgfId-1534791]Enables extraction of recipient email addresses from the SMTP RCPT TO command and associates the recipient addresses with all intrusion events generated for the session. Multiple recipients are supported. 
 
     [bookmark: pgfId-1534792]When this option is enabled, you can view recipients associated with events in the Email Recipient column of the intrusion events table view. See Viewing Events for more information.
 
     [bookmark: pgfId-1534796]Log From Addresses
 
     [bookmark: pgfId-1534797]Enables extraction of sender email addresses from the SMTP MAIL FROM command and associates the sender addresses with all intrusion events generated for the session. Multiple sender addresses are supported. 
 
     [bookmark: pgfId-1534798]When this option is enabled, you can view senders associated with events in the Email Sender column of the intrusion events table view. See Viewing Events for more information.
 
     [bookmark: pgfId-1534802]Log Headers
 
     [bookmark: pgfId-1534803]Enables extraction of email headers. The number of bytes to extract is determined by the value specified for Header Log Depth.
 
     [bookmark: pgfId-1534804]You can use the content or protected_content keyword to write intrusion rules that use email header data as a pattern. You can also view the extracted email header in the intrusion event packet view. See Viewing Events for more information. 
 
     [bookmark: pgfId-1534811]Header Log Depth
 
     [bookmark: pgfId-1534812]Specifies the number of bytes of the email header to extract when Log Headers is enabled. You can specify 0 to 20480 bytes. A value of 0 disables Log Headers.
 
    
 
     
      [bookmark: pgfId-1534816][bookmark: 91533]Configuring SMTP [bookmark: marker-1534815]Decoding
 
     [bookmark: pgfId-1534823]License: Protection
 
     [bookmark: pgfId-1534825]You can use the SMTP Configuration page of an intrusion policy to configure SMTP normalization. For more information on SMTP preprocessor configuration options, see Understanding SMTP Decoding.
 
     [bookmark: pgfId-1534829]To configure SMTP decoding options:
 
     
 
     [bookmark: pgfId-1621983]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1621984]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1621989]The access control policy editor appears.
 
     [bookmark: pgfId-1621990]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1621991]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1621996]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1621997]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1573085]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573090]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573094]The Policy Information page appears.
 
     [bookmark: pgfId-1573095]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573096]The Settings page appears.
 
     [bookmark: pgfId-1534848]Step 8 You have two choices, depending on whether SMTP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534849]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534850]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534854]The SMTP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534858]Step 9 Specify the Ports where SMTP traffic should be decoded, separated by commas. 
 
     [bookmark: pgfId-1534859]Step 10 Select Stateful Inspection to examine reassembled TCP streams containing SMTP packets. Clear Stateful Inspection to inspect only unreassembled SMTP packets.
 
     [bookmark: pgfId-1534860]Step 11 Configure the normalization options:
 
      
       
       	 [bookmark: pgfId-1534861]To normalize all commands, select  All .
 
       	 [bookmark: pgfId-1534862]To normalize only commands specified by  Custom Commands , select  Cmds and specify the commands to normalize. Separate commands with spaces.
 
       	 [bookmark: pgfId-1534863]To normalize no commands, select  None .
 
       	 [bookmark: pgfId-1534864]To ignore mail data except for MIME mail header data, check  Ignore Data .
 
       	 [bookmark: pgfId-1534865]To ignore data encrypted under the Transport Security Layer protocol, check  Ignore TLS Data .
 
       	 [bookmark: pgfId-1534866]To disable generating events when accompanying preprocessor rules are enabled, check  No Alerts .
 
       	 [bookmark: pgfId-1534867]To detect unknown commands in SMTP data, select  Detect Unknown Commands .
 
      
 
     
 
     [bookmark: pgfId-1534868]Step 12 Specify a maximum command line length in the Max Command Line Len field. 
 
     [bookmark: pgfId-1534869]Step 13 Specify a maximum data header line length in the Max Header Line Len field. 
 
     [bookmark: pgfId-1534870]Step 14 Specify a maximum response line length in the Max Response Line Len field. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1534871]Note RCPT TO and MAIL FROM are SMTP commands. The preprocessor configuration uses command names of RCPT and MAIL, respectively. Within the code, the preprocessor maps RCPT and MAIL to the correct command name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534872]Step 15 If needed, click Add next to Alt Max Command Line Len to add commands where you want to specify an alternate maximum command line length, then specify the line length and the command or commands, separated by spaces, where you want that length to be enforced. 
 
     [bookmark: pgfId-1534873]Step 16 Specify any commands that you want to treat as invalid and detect in the Invalid Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534874]Step 17 Specify any commands that you want to treat as valid in the Valid Commands field. Separate commands with spaces.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534875]Note Even if the Valid Commands list is empty, the preprocessor treats the following commands as valid: ATRN, AUTH, BDAT, DATA, DEBUG, EHLO, EMAL, ESAM, ESND, ESOM, ETRN, EVFY, EXPN, HELO, HELP, IDENT, MAIL, NOOP, QUIT, RCPT, RSET, SAML, SOML, SEND, ONEX, QUEU, STARTTLS, TICK, TIME, TURN, TURNME, VERB, VRFY, X-EXPS, X-LINK2STATE, XADR, XAUTH, XCIR, XEXCH50, XGEN, XLICENSE, XQUE, XSTA, XTRN, or XUSR. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534876]Step 18 Specify any commands that you want to initiate sending data in the same way the SMTP DATA command sends data per RFC 5321 in the Data Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534877]Step 19 Specify any commands that initiate sending data in a way that is similar to how the BDAT command sends data per RFC 3030 in the Binary Data Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534878]Step 20 Specify any commands that initiate an authentication exchange between client and server in the Authentication Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534879]Step 21 To detect packets that are part of X-Link2State Microsoft Exchange buffer data overflow attacks, select Detect xlink2state.
 
     [bookmark: pgfId-1534880]Step 22 To specify the maximum bytes of data to extract and decode for different types of email attachment, specify a value for any of the following attachment types:
 
      
       
       	 [bookmark: pgfId-1534881] Base64 Decoding Depth 
 
       	 [bookmark: pgfId-1534882] 7-Bit/8-Bit/Binary Decoding Depth (includes various multipart content types such as plain text, jpeg images, mp3 files, and so on)
 
       	 [bookmark: pgfId-1534883] Quoted-Printable Decoding Depth 
 
       	 [bookmark: pgfId-1534884] Unix-to-Unix Decoding Depth 
 
      
 
     
 
     [bookmark: pgfId-1534885]You can specify from 1 to 65535 bytes, or specify 0 to extract and, when necessary, decode all data in the packet for that type. Specify -1 to ignore data for an attachment type.
 
     [bookmark: pgfId-1534888]You can use the file_data rule keyword in intrusion rules to inspect extracted data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1534890]You must also select the SMTP Stateful Inspection option to extract and decode cross-packet data or data crossing multiple TCP segments.
 
     [bookmark: pgfId-1534891]Step 23 Configure options for associating contextual information with intrusion events triggered by SMTP traffic:
 
      
       
       	 [bookmark: pgfId-1534892]To enable extraction of MIME attachment file names to associate with intrusion events, select  Log MIME Attachment Names .
 
       	 [bookmark: pgfId-1534893]To enable extraction of recipient email addresses, select  Log To Addresses .
 
       	 [bookmark: pgfId-1534894]To enable extraction of sender email addresses to associate with intrusion events, select  Log From Addresses .
 
       	 [bookmark: pgfId-1534895]To enable extraction of email headers to associate with intrusion events and for writing rules that inspect email headers, select  Log Headers .
 
      
 
     
 
     [bookmark: pgfId-1534896]Note that header information is displayed in the intrusion event packet view. Note also that you can also write intrusion rules that use the content or protected_content keyword with email header data as a pattern. See Viewing Events for more information.
 
     [bookmark: pgfId-1534903]Optionally, you can specify a Header Log Depth of 0 to 20480 bytes of the email header to extract. A value of 0 disables Log Headers.
 
     [bookmark: pgfId-1534906]Step 24 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534910]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534913][bookmark: 51982]Enabling SMTP [bookmark: marker-1534912]Maximum Decoding Memory Alerting
 
     [bookmark: pgfId-1534920]License: Protection
 
     [bookmark: pgfId-1534921]You can enable SMTP preprocessor rule 124:9 to generate an event when the enabled preprocessor is using the maximum amount of memory allowed by the system for decoding the following types of encoded data:
 
      
      	 [bookmark: pgfId-1534922]Base64
 
      	 [bookmark: pgfId-1534923]7-bit/8-bit/binary
 
      	 [bookmark: pgfId-1534924]Quoted-printable
 
      	 [bookmark: pgfId-1534925]Unix-to-Unix
 
     
 
     [bookmark: pgfId-1534926]When the maximum decoding memory is exceeded, the preprocessor stops decoding these types of encoded data until memory becomes available. This preprocessor rule is not associated with a single, specific configuration option. See Setting Rule States for information on enabling rules.
 
    
 
   
 
    
     [bookmark: pgfId-1534932][bookmark: 65555]Detecting Exploits Using the S[bookmark: marker-1534931]SH Preprocessor
 
    [bookmark: pgfId-1534939]License: Protection
 
    [bookmark: pgfId-1534940]The SSH preprocessor detects the Challenge-Response Buffer Overflow exploit, the CRC-32 exploit, the SecureCRT SSH Client Buffer Overflow exploit, protocol mismatches, and incorrect SSH message direction. The preprocessor also detects any version string other than version 1 or 2.
 
    [bookmark: pgfId-1534941]Challenge-Response Buffer Overflow and CRC-32 attacks occur after the key exchange and are, therefore, encrypted. Both attacks send an uncharacteristically large payload of more than 20 KBytes to the server immediately after the authentication challenge. CRC-32 attacks apply only to SSH Version 1; Challenge-Response Buffer Overflow exploits apply only to SSH Version 2. The version string is read at the beginning of the session. Except for the difference in the version string, both attacks are handled in the same way.
 
    [bookmark: pgfId-1534942]The SecureCRT SSH exploit and protocol mismatch attacks occur when attempting to secure a connection, before the key exchange. The SecureCRT exploit sends an overly long protocol identifier string to the client that causes a buffer overflow. A protocol mismatch occurs when either a non-SSH client application attempts to connect to a secure SSH server or the server and client version numbers do not match.
 
    [bookmark: pgfId-1534943]You can configure the preprocessor to inspect traffic on a specified port or list of ports, or to automatically detect SSH traffic. It will continue to inspect SSH traffic until either a specified number of encrypted packets has passed within a specified number of bytes, or until a specified maximum number of bytes is exceeded within the specified number of packets. If the maximum number of bytes is exceeded, it is assumed that a CRC-32 (SSH Version 1) or a Challenge-Response Buffer Overflow (SSH Version 2) attack has occurred. Additionally, you can detect the SecureCRT exploit, protocol mismatches, and bad message direction. Note that the preprocessor detects without configuration any version string value other than version 1 or 2.
 
    [bookmark: pgfId-1534944]Note the following when using the SSH preprocessor:
 
     
     	 [bookmark: pgfId-1534945]You must enable SSH preprocessor rules, which have a generator ID (GID) of 128, if you want these rules to generate events. See Setting Rule States for more information.
 
     	 [bookmark: pgfId-1534956]The SSH preprocessor does not handle brute force attacks. For information on brute force attempts, see Adding Dynamic Rule States. 
 
    
 
    [bookmark: pgfId-1534960]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534964]Selecting SSH Preprocessor Options
 
     	 [bookmark: pgfId-1534968]Configuring the SSH Preprocessor
 
    
 
     
      [bookmark: pgfId-1534971][bookmark: 40989]Selecting SSH Prepr[bookmark: marker-1534970]ocessor Options
 
     [bookmark: pgfId-1534978]License: Protection
 
     [bookmark: pgfId-1534979]This section describes the options you can use to configure the SSH preprocessor.
 
     [bookmark: pgfId-1534980]The preprocessor stops inspecting traffic for a session when either of the following occurs: 
 
      
      	 [bookmark: pgfId-1534981]a valid exchange between the server and the client has occurred for this number of encrypted packets; the connection continues.
 
      	 [bookmark: pgfId-1534982]the  Number of Bytes Sent Without Server Response  is reached before the number of encrypted packets to inspect is reached; the assumption is made that there is an attack.
 
     
 
     [bookmark: pgfId-1534983]Each valid server response during Number of Encrypted Packets to Inspect resets the Number of Bytes Sent Without Server Response and the packet count continues.
 
     [bookmark: pgfId-1534984]Consider the following example SSH preprocessor configuration:
 
      
      	 [bookmark: pgfId-1534985] Server Ports : 22
 
      	 [bookmark: pgfId-1534986] Autodetect Ports : off
 
      	 [bookmark: pgfId-1534987] Maximum Length of Protocol Version String : 80
 
      	 [bookmark: pgfId-1534988] Number of Encrypted Packets to Inspect : 25
 
      	 [bookmark: pgfId-1534989] Number of Bytes Sent Without Server Response : 19,600
 
      	 [bookmark: pgfId-1534990]All detect options are enabled.
 
     
 
     [bookmark: pgfId-1534991]In the example, the preprocessor inspects traffic only on port 22. That is, auto-detection is disabled, so it inspects only on the specified port.
 
     [bookmark: pgfId-1534992]Additionally, the preprocessor in the example stops inspecting traffic when either of the following occurs:
 
      
      	 [bookmark: pgfId-1534993]The client sends 25 encrypted packets which contain no more than 19,600 bytes, cumulative. The assumption is there is no attack.
 
      	 [bookmark: pgfId-1534994]The client sends more than 19,600 bytes within 25 encrypted packets. In this case, the preprocessor considers the attack to be the Challenge-Response Buffer Overflow exploit because the session in the example is an SSH Version 2 session.
 
     
 
     [bookmark: pgfId-1534995]The preprocessor in the example will also detect any of the following that occur while it is processing traffic:
 
      
      	 [bookmark: pgfId-1534996]a server overflow, triggered by a version string greater than 80 bytes and indicating a SecureCRT exploit
 
      	 [bookmark: pgfId-1534997]a protocol mismatch
 
      	 [bookmark: pgfId-1534998]a packet flowing in the wrong direction
 
     
 
     [bookmark: pgfId-1534999]Finally, the preprocessor will automatically detect any version string other than version 1 or version 2.
 
     [bookmark: pgfId-1535000]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1535001]Server Ports
 
     [bookmark: pgfId-1535002]Specifies on which ports the SSH preprocessor should inspect traffic.
 
     [bookmark: pgfId-1535003]You can configure a single port or a comma-separated list of ports.
 
     [bookmark: pgfId-1535004]Autodetect Ports
 
     [bookmark: pgfId-1535005]Sets the preprocessor to automatically detect SSH traffic. 
 
     [bookmark: pgfId-1535006]When this option is selected, the preprocessor inspects all traffic for an SSH version number. It stops processing when neither the client nor the server packet contains a version number. When disabled, the preprocessor inspects only the traffic identified by the Server Ports option.
 
     [bookmark: pgfId-1535007]Number of Encrypted Packets to Inspect
 
     [bookmark: pgfId-1535008]Specifies the number of encrypted packets to examine per session. 
 
     [bookmark: pgfId-1535009]Setting this option to zero will allow all traffic to pass. 
 
     [bookmark: pgfId-1535010]Reducing the number of encrypted packets to inspect may result in some attacks escaping detection. Raising the number of encrypted packets to inspect may negatively affect performance.
 
     [bookmark: pgfId-1535011]Number of Bytes Sent Without Server Response
 
     [bookmark: pgfId-1535012]Specifies the maximum number of bytes an SSH client may send to a server without getting a response before assuming there is a Challenge-Response Buffer Overflow or CRC-32 attack.
 
     [bookmark: pgfId-1535013]Increase the value for this option if the preprocessor generates false positives on the Challenge-Response Buffer Overflow or CRC-32 exploit.
 
     [bookmark: pgfId-1535014]Maximum Length of Protocol Version String
 
     [bookmark: pgfId-1535015]Specifies the maximum number of bytes allowed in the server’s version string before considering it to be a SecureCRT exploit. 
 
     [bookmark: pgfId-1535016]Detect Challenge-Response Buffer Overflow Attack
 
     [bookmark: pgfId-1535017]Enables or disables detecting the Challenge-Response Buffer Overflow exploit.
 
     [bookmark: pgfId-1535021]You can enable rule 128:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535022]Detect SSH1 CRC-32 Attack
 
     [bookmark: pgfId-1535023]Enables or disables detecting the CRC-32 exploit.
 
     [bookmark: pgfId-1535027]You can enable rule 128:2 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535028]Detect Server Overflow
 
     [bookmark: pgfId-1535029]Enables or disables detecting the SecureCRT SSH Client Buffer Overflow exploit.
 
     [bookmark: pgfId-1535033]You can enable rule 128:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535034]Detect Protocol Mismatch
 
     [bookmark: pgfId-1535035]Enables or disables detecting protocol mismatches.
 
     [bookmark: pgfId-1535039]You can enable rule 128:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535040]Detect Bad Message Direction
 
     [bookmark: pgfId-1535041]Enables or disables detecting when traffic flows in the wrong direction (that is, if the presumed server generates client traffic, or if a client generates server traffic).
 
     [bookmark: pgfId-1535045]You can enable rule 128:5 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535046]Detect Payload Size Incorrect for the Given Payload
 
     [bookmark: pgfId-1535047]Enables or disables detecting packets with an incorrect payload size such as when the length specified in the SSH packet is not consistent with the total length specified in the IP header or the message is truncated, that is, there is not enough data for a full SSH header.
 
     [bookmark: pgfId-1535051]You can enable rule 128:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535052]Detect Bad Version String
 
     [bookmark: pgfId-1535053]Note that, when enabled, the preprocessor detects without configuration any version string other than version 1 or 2.
 
     [bookmark: pgfId-1535057]You can enable rule 128:7 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1535061][bookmark: 48844]Configu[bookmark: marker-1535059]ring the SSH Preprocessor
 
     [bookmark: pgfId-1535069]License: Protection
 
     [bookmark: pgfId-1535070]This section explains how to configure the SSH preprocessor.
 
     [bookmark: pgfId-1535071]To configure the SSH preprocessor:
 
     
 
     [bookmark: pgfId-1622041]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1622042]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1622047]The access control policy editor appears.
 
     [bookmark: pgfId-1622048]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1622049]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1622054]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1622055]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1573118]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573123]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573127]The Policy Information page appears.
 
     [bookmark: pgfId-1573128]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573129]The Settings page appears.
 
     [bookmark: pgfId-1535090]Step 8 You have two choices, depending on whether SSH Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1535091]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1535092]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1535093]The SSH Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1535099]Step 9 You can modify any of the options on the SSH Configuration preprocessor page. See Selecting SSH Preprocessor Options for more information.
 
     [bookmark: pgfId-1535103]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1535107]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1535112][bookmark: 50778]Usi[bookmark: marker-1535109]ng the S[bookmark: SSL]SL Preprocessor
 
    [bookmark: pgfId-1535120]License: Protection
 
    [bookmark: pgfId-1628265]Although the system cannot analyze the contents of encrypted traffic, an SSL preprocessor option can be set to continue to attempt to inspect the traffic, occasionally generating false positives and wasting detection resources. Using the SSL preprocessor, however, the system can analyze the contents of the handshake and key exchange messages exchanged at the beginning of an SSL session to determine when the session becomes encrypted. When SSL preprocessing is active, you can cause the system to suspend inspection of a session as soon as it becomes encrypted. You must ensure that TCP stream preprocessing is enabled to use the SSL preprocessor.
 
    [bookmark: pgfId-1535134]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1535138]Understanding SSL Preprocessing
 
     	 [bookmark: pgfId-1535142]Enabling SSL Preprocessor Rules
 
     	 [bookmark: pgfId-1553333]Configuring the SSL Preprocessor
 
    
 
     
      [bookmark: pgfId-1553336][bookmark: 25159]Understanding SSL Preproc[bookmark: marker-1553335]essing
 
     [bookmark: pgfId-1553343]License: Protection
 
     [bookmark: pgfId-1628420]The SSL preprocessor stops inspection of encrypted data, which can help to eliminate false positives. The SSL preprocessor maintains state information as it inspects the SSL handshake, tracking both the state and SSL version for that session. When the preprocessor detects that a session state is encrypted, the system marks the traffic in that session as encrypted. You can configure the system to stop processing on all packets in an encrypted session when encryption is established.
 
     [bookmark: pgfId-1535166]For each packet, the SSL preprocessor verifies that the traffic contains an IP header, a TCP header, and a TCP payload, and that it occurs on the ports specified for SSL preprocessing. For qualifying traffic, the following scenarios determine whether the traffic is encrypted:
 
      
      	 [bookmark: pgfId-1535167]the system observes all packets in a session,  Server side data is trusted is not enabled, and the session includes a Finished message from both the server and the client and at least one packet from each side with an Application record and without an Alert record
 
      	 [bookmark: pgfId-1535168]the system misses some of the traffic,  Server side data is trusted is not enabled, and the session includes at least one packet from each side with an Application record that is not answered with an Alert record
 
      	 [bookmark: pgfId-1535169]the system observes all packets in a session,  Server side data is trusted is enabled, and the session includes a Finished message from the client and at least one packet from the client with an Application record and without an Alert record
 
      	 [bookmark: pgfId-1535170]the system misses some of the traffic,  Server side data is trusted is enabled, and the session includes at least one packet from the client with an Application record that is not answered with an Alert record
 
     
 
     [bookmark: pgfId-1535171]If you choose to stop processing on encrypted traffic, the system ignores future packets in a session after it marks the session as encrypted.
 
      
       
     
 
     
 
     [bookmark: pgfId-1535172]Note You can add the ssl_state and ssl_version keywords to a rule to use SSL state or version information within the rule. For more information, see Extracting SSL Information from a Session. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1535178][bookmark: 25289]Enabling SSL [bookmark: marker-1535177]Preprocessor Rules
 
     [bookmark: pgfId-1535185]License: Protection
 
     [bookmark: pgfId-1628473]When enabled, the SSL preprocessor inspects the contents of the handshake and key exchange messages exchanged at the beginning of an SSL session.
 
     [bookmark: pgfId-1628460]Note that you must enable SSL preprocessor rules, which have a generator ID (GID) of 137, if you want these rules to generate events. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535191]The following table describes the SSL preprocessor rules you can enable.
 
     [bookmark: pgfId-1535216]
 
      
       
        
        [bookmark: pgfId-1535198]Table 16-14 [bookmark: 71127]SSL Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1535202]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1535204]Description 
          
  
        
 
         
         	[bookmark: pgfId-1535206]137:1
  
         	[bookmark: pgfId-1535208]Detects a client hello after a server hello, which is invalid and considered to be anomalous behavior.
  
        
 
         
         	[bookmark: pgfId-1535210]137:2
  
         	[bookmark: pgfId-1535212]Detects a server hello without a client hello when Server side data is trusted is disabled, which is invalid and considered to be anomalous behavior. See Configuring the SSL Preprocessor for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1535219][bookmark: 73665]Configuring the SSL Preproc[bookmark: marker-1535218]essor
 
     [bookmark: pgfId-1535226]License: Protection
 
     [bookmark: pgfId-1628552]By default, the system attempts to inspect encrypted traffic. When you enable the SSL preprocessor, it detects when a session becomes encrypted. After the SSL preprocessor is enabled, the rules engine can invoke the preprocessor to obtain SSL state and version information. If you enable rules using the ssl_state and ssl_version keywords in an intrusion policy, you should also enable the SSL preprocessor in that policy.
 
     [bookmark: pgfId-1628569]In addition, you can enable the Stop inspecting encrypted traffic option to disable inspection and reassembly for encrypted sessions. The SSL preprocessor maintains state for the session so it can disable inspection of all traffic in the session. The system only stops inspecting traffic in encrypted sessions if SSL preprocessing is enabled and the Stop inspecting encrypted traffic option is selected. 
 
     [bookmark: pgfId-1628583]To base identification of encrypted traffic only on server traffic, you can enable the Server side data is trusted option; that is, server side data is trusted to indicate that the traffic is encrypted. The SSL preprocessor typically checks both client traffic and the server responses to that traffic to determine if a session is encrypted. However, because the system may not mark a transaction as encrypted if it cannot detect both sides of a session, you can rely on the SSL server to indicate a session is encrypted. Note that when you enable the Server side data is trusted option you must also enable the Stop inspecting encrypted traffic option so the system does not continue inspecting traffic in the encrypted session.
 
     [bookmark: pgfId-1579080]You can specify the ports where the preprocessor monitors traffic for encrypted sessions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1579081]Note If the SSL preprocessor detects non-SSL traffic over the ports specified for SSL monitoring, it tries to decode the traffic as SSL traffic, and then flags it as corrupt.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1535232]To configure the SSL preprocessor:
 
     
 
     [bookmark: pgfId-1622082]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1622083]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1622088]The access control policy editor appears.
 
     [bookmark: pgfId-1622089]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1622090]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1622095]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1622096]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1573147]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573152]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573156]The Policy Information page appears.
 
     [bookmark: pgfId-1573157]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573158]The Settings page appears.
 
     [bookmark: pgfId-1535251]Step 8 You have two choices, depending on whether SSL Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1535252]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1535253]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1535254]The SSL Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1535258]Step 9 Type the ports, separated by commas, where the SSL preprocessor should monitor traffic for encrypted sessions. Only ports included in the Ports field will be checked for encrypted traffic.
 
     [bookmark: pgfId-1535259]Step 10 Click the Stop inspecting encrypted traffic check box to enable or disable inspection of traffic in a session after the session is marked as encrypted. 
 
     [bookmark: pgfId-1535260]Step 11 Click the Server side data is trusted check box to enable or disable identification of encrypted traffic based only on the client-side traffic.
 
     [bookmark: pgfId-1612666]Step 12 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1535492]
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1531574][bookmark: 75511]Configuring SCADA Preprocessing 
      
      
 
     
 
 
    [bookmark: pgfId-1533796]You configure Supervisory Control and Data Acquisition (SCADA) preprocessors in a network analysis policy, which prepares traffic for inspection using the rules enabled in an intrusion policy. See Understanding Network Analysis and Intrusion Policies for more information.
 
    [bookmark: pgfId-1534426]SCADA protocols monitor, control, and acquire data from industrial, infrastructure, and facility processes such as manufacturing, production, water treatment, electric power distribution, airport and shipping systems, and so on. The ASA FirePOWER module provides preprocessors for the Modbus and DNP3 SCADA protocols that you can configure as part of your network analysis policy.
 
    [bookmark: pgfId-1534683]If you enable a rule containing Modbus or DNP3 keywords in the corresponding intrusion policy, the system automatically uses the Modbus or DNP3 processor, respectively, with its current settings, although the preprocessor remains disabled in the network analysis policy module interface. For more information, see Modbus Keywords and DNP3 Keywords.
 
    [bookmark: pgfId-1534434]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534438]Configuring the Modbus Preprocessor
 
     	 [bookmark: pgfId-1532206]Configuring the DNP3 Preprocessor
 
    
 
   
 
    
     [bookmark: pgfId-1532210][bookmark: 24867]Configuring the Mod[bookmark: marker-1532209]bus Preprocessor
 
    [bookmark: pgfId-1532218]License: Protection
 
    [bookmark: pgfId-1532219]The Modbus protocol, which was first published in 1979 by Modicon, is a widely used SCADA protocol. The Modbus preprocessor detects anomalies in Modbus traffic and decodes the Modbus protocol for processing by the rules engine, which uses Modbus keywords to access certain protocol fields. See Modbus Keywords for more information.
 
    [bookmark: pgfId-1532223]A single configuration option allows you to modify the default setting for the port that the preprocessor inspects for Modbus traffic.
 
    [bookmark: pgfId-1532224]You must enable the Modbus preprocessor rules in the following table if you want these rules to generate events. See Setting Rule States for information on enabling rules.
 
    [bookmark: pgfId-1532253]
 
     
      
       
       [bookmark: pgfId-1532233]Table 17-1 Modbus Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1532237]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1532239]Description 
         
  
       
 
        
        	[bookmark: pgfId-1532241]144:1
  
        	[bookmark: pgfId-1532243]Generates an event when the length in the Modbus header does not match the length required by the Modbus function code.
 [bookmark: pgfId-1532244]Each Modbus function has an expected format for requests and responses. If the length of the message does not match the expected format, this event is generated.
  
       
 
        
        	[bookmark: pgfId-1532246]144:2
  
        	[bookmark: pgfId-1532248]Generates an event when the Modbus protocol ID is non-zero. The protocol ID field is used for multiplexing other protocols with Modbus. Because the preprocessor does not process these other protocols, this event is generated instead.
  
       
 
        
        	[bookmark: pgfId-1532250]144:3
  
        	[bookmark: pgfId-1532252]Generates an event when the preprocessor detects a reserved Modbus function code.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1532254]Note regarding the use of the Modbus preprocessor that if your network does not contain any Modbus-enabled devices, you should not enable this preprocessor in a network analysis policy that you apply to traffic.
 
    [bookmark: pgfId-1532268]You can use the following procedure to modify the ports the Modbus preprocessor monitors.
 
    [bookmark: pgfId-1532269]To configure the Modbus preprocessor:
 
    
 
    [bookmark: pgfId-1535350]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1535351]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1535356]The access control policy editor appears.
 
    [bookmark: pgfId-1535357]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1535358]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1535363]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1535364]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1532275]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532280]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532284]The Policy Information page appears.
 
    [bookmark: pgfId-1532285]Step 7 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1532286]The Settings page appears.
 
    [bookmark: pgfId-1532287]Step 8 You have two choices, depending on whether Modbus Configuration under SCADA Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1532288]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1532289]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1532290]The Modbus Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1532291]Step 9 Optionally, modify the Ports that the preprocessor inspects for Modbus traffic. You can specify an integer from 0 to 65535. Use commas to separate multiple ports.
 
    [bookmark: pgfId-1532294]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1532298]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532302][bookmark: 51145]Configuring the DNP3 P[bookmark: marker-1532301]reprocessor
 
    [bookmark: pgfId-1532310]License: Protection
 
    [bookmark: pgfId-1532311]The Distributed Network Protocol (DNP3) is a SCADA protocol that was originally developed to provide consistent communication between electrical stations. DNP3 has also become widely used in the water, waste, transportation, and many other industries. 
 
    [bookmark: pgfId-1532312]The DNP3 preprocessor detects anomalies in DNP3 traffic and decodes the DNP3 protocol for processing by the rules engine, which uses DNP3 keywords to access certain protocol fields. See DNP3 Keywords for more information.
 
    [bookmark: pgfId-1532316]You must enable the DNP3 preprocessor rules in the following table if you want these rules to generate events. See Setting Rule States for information on enabling rules.
 
    [bookmark: pgfId-1532356]
 
     
      
       
       [bookmark: pgfId-1532325]Table 17-2 DNP3 Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1532329]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1532331]Description 
         
  
       
 
        
        	[bookmark: pgfId-1532333]145:1
  
        	[bookmark: pgfId-1532335]When Log bad CRC is enabled, generates an event when the preprocessor detects a link layer frame with an invalid checksum.
  
       
 
        
        	[bookmark: pgfId-1532337]145:2
  
        	[bookmark: pgfId-1532339]Generates an event and blocks the packet when the preprocessor detects a DNP3 link layer frame with an invalid length.
  
       
 
        
        	[bookmark: pgfId-1532341]145:3
  
        	[bookmark: pgfId-1532343]Generates an event and blocks the packet during reassembly when the preprocessor detects a transport layer segment with an invalid sequence number.
  
       
 
        
        	[bookmark: pgfId-1532345]145:4
  
        	[bookmark: pgfId-1532347]Generates an event when the DNP3 reassembly buffer is cleared before a complete fragment can be reassembled. This happens when a segment carrying the FIR flag appears after other segments have been queued.
  
       
 
        
        	[bookmark: pgfId-1532349]145:5
  
        	[bookmark: pgfId-1532351]Generates an event when the preprocessor detects a DNP3 link layer frame that uses a reserved address.
  
       
 
        
        	[bookmark: pgfId-1532353]145:6
  
        	[bookmark: pgfId-1532355]Generates an event when the preprocessor detects a DNP3 request or response that uses a reserved function code.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1532357]Note regarding the use of the DNP3 preprocessor that, if your network does not contain any DNP3-enabled devices, you should not enable this preprocessor in a network analysis policy that you apply to traffic. See Configuring TCP Stream Preprocessing for more information.
 
    [bookmark: pgfId-1532371]The following list describes the DNP3 preprocessor options you can configure.
 
    [bookmark: pgfId-1532372]Ports
 
    [bookmark: pgfId-1532373]Enables inspection of DNP3 traffic on each specified port. You can specify a single port or a comma-separated list of ports. You can specify a value from 0 to 65535 for each port.
 
    [bookmark: pgfId-1532374]Log bad CRCs
 
    [bookmark: pgfId-1532375]When enabled, validates the checksums contained in DNP3 link layer frames. Frames with invalid checksums are ignored.
 
    [bookmark: pgfId-1532376]You can enable rule 145:1 to generate events when invalid checksums are detected.
 
    [bookmark: pgfId-1532377]To configure the DNP3 preprocessor:
 
    
 
    [bookmark: pgfId-1535409]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1535410]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1535415]The access control policy editor appears.
 
    [bookmark: pgfId-1535416]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1535417]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1535422]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1535423]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1532383]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532388]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532392]The Policy Information page appears.
 
    [bookmark: pgfId-1532393]Step 7 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1532394]The Settings page appears.
 
    [bookmark: pgfId-1532395]Step 8 You have two choices, depending on whether DNP3 Configuration under SCADA Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1532396]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1532397]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1532398]The DNP3 Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1532399]Step 9 Optionally, modify the Ports that the preprocessor inspects for DNP3 traffic. You can specify an integer from 0 to 65535. Use commas to separate multiple ports.
 
    [bookmark: pgfId-1532400]Step 10 Optionally, select or clear the Log bad CRCs check box to specify whether to validate the checksums contained in DNP3 link layer frames and ignore frames with invalid checksums.
 
    [bookmark: pgfId-1532403]Step 11 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See the Network Analysis Policy Editing Actions table for more information.
 
    [bookmark: pgfId-1532407]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1583886][bookmark: 56912]Configuring Transport & Network Layer Preprocessing 
      
      
 
     
 
 
    [bookmark: pgfId-1583930]You configure most transport at network layer preprocessors in a network analysis policy, which prepares traffic for inspection using the rules enabled in an intrusion policy. See Understanding Network Analysis and Intrusion Policies for more information.
 
    [bookmark: pgfId-1584038]Transport and network layer preprocessors detect attacks that exploit IP fragmentation, checksum validation, and TCP and UDP session preprocessing. Before packets are sent to preprocessors, the packet decoder converts packet headers and payloads into a format that can be easily used by the preprocessors and the intrusion rules engine and detects various anomalous behaviors in packet headers. After packet decoding and before sending packets to other preprocessors, the inline normalization preprocessor normalizes traffic for inline deployments.
 
    [bookmark: pgfId-1584039]You can tailor transport and network layer preprocessor settings that you configure in network analysis policies by zone, or network. Some transport and network layer settings apply globally to all traffic, and you configure these in an access control policy.
 
     
     	 [bookmark: pgfId-1583995]Configuring Advanced Transport/Network Settings
 
     	 [bookmark: pgfId-1530807]Verifying Checksums
 
     	 [bookmark: pgfId-1530815]Normalizing Inline Traffic
 
     	 [bookmark: pgfId-1530819]Defragmenting IP Packets
 
     	 [bookmark: pgfId-1530823]Understanding Packet Decoding
 
     	 [bookmark: pgfId-1534383]Using TCP Stream Preprocessing
 
     	 [bookmark: pgfId-1551166]Using UDP Stream Preprocessing
 
    
 
   
 
    
     [bookmark: pgfId-1551168][bookmark: 18072]Configuring Advanced Transport/Network Settings
 
    [bookmark: pgfId-1557608]License: Protection
 
    [bookmark: pgfId-1580794]Advanced transport and network preprocessor settings apply globally to all networks, and zones where you apply your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy. 
 
    [bookmark: pgfId-1551481]The following sections describe these settings:
 
     
     	 [bookmark: pgfId-1551539]Initiating Active Responses with Intrusion Drop Rules
 
     	 [bookmark: pgfId-1551541]Troubleshooting: Logging Session Termination Messages
 
    
 
     
      [bookmark: pgfId-1576738][bookmark: 63055]Initiating Active Respon[bookmark: marker-1576737]ses with Intrusion Drop Rules
 
     [bookmark: pgfId-1570980]License: Protection
 
     [bookmark: pgfId-1570981]A drop rule is an intrusion rule or preprocessor rule whose rule state is set to Drop and Generate Events. In an inline deployment, the system responds to TCP or UDP drop rules by dropping the triggering packet and blocking the session where the packet originated. In a passive deployment, the system cannot drop the packet and does not block the session except with the use of active responses.
 
      
       
     
 
     
 
     [bookmark: pgfId-1546716]Tip Because UDP data streams are not typically thought of in terms of sessions, see Using UDP Stream Preprocessing for further explanation of how the stream preprocessor uses the source and destination IP address fields in the encapsulating IP datagram header and the port fields in the UDP header to determine the direction of flow and identify a UDP session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1546720]You can configure the Maximum Active Responses option to initiate one or more active responses to more precisely and specifically close a TCP connection or UDP session when an offending packet triggers a TCP or UDP drop rule.
 
     [bookmark: pgfId-1546721]When active responses are enabled in an inline deployment, the system responds to TCP drop rules by dropping the triggering packet and inserting a TCP Reset (RST) packet in both the client and server traffic. The system cannot drop the packet in a passive deployment; when active responses are enabled in a passive deployment, the system responds to TCP drop rules by sending a TCP reset to both the client and server ends of a TCP connection. When active responses are enabled in inline or passive deployments, the system closes a UDP session by sending an ICMP unreachable packet to each end of the session. Active responses are most effective in inline deployments because resets are more likely to arrive in time to affect the connection or session.
 
     [bookmark: pgfId-1546722]Depending on how you configure the Maximum Active Responses option, the system can also initiate additional active responses if it sees additional traffic from either end of the connection or session. The system initiates each additional active response, up to a specified maximum, after a specified number of seconds have elapsed since the previous response.
 
     [bookmark: pgfId-1546729]See Selecting The TCP Global Option for information on setting the maximum number of active responses.
 
     [bookmark: pgfId-1546730]Note that a triggered resp or react rule also initiates an active response regardless of the configuration of Maximum Active Responses; however, Maximum Active Responses control whether the system initiates additional active responses for resp and react rules in the same way it controls the maximum number of active responses for drop rules. See Initiating Active Responses with Rule Keywords for more information.
 
     [bookmark: pgfId-1546734]You can also use the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment. See Setting the Active Response Reset Attempts and Interface for more information.
 
     [bookmark: pgfId-1546746]No preprocessor rules are associated with the following options.
 
     [bookmark: pgfId-1546751][bookmark: marker-1546750]Maximum Active Responses
 
     [bookmark: pgfId-1546752]Specifies a maximum of 1 to 25 active responses per TCP connection. When additional traffic occurs on a connection where an active response has been initiated, and the traffic occurs more than Minimum Response Seconds after a previous active response, the system sends another active response unless the specified maximum has been reached. A setting of 0 disables active responses triggered by drop rules and disables additional active responses triggered by resp or react rules. For more information, see Initiating Active Responses with Intrusion Drop Rules and Initiating Active Responses with Rule Keywords.
 
     [bookmark: pgfId-1546867]Min[bookmark: marker-1546866]imum Response Seconds
 
     [bookmark: pgfId-1546868]Until Maximum Active Responses occur, specifies waiting 1 to 300 seconds before any additional traffic on a connection where the system has initiated an active response results in a subsequent active response.
 
     [bookmark: pgfId-1546937]To initiate active responses with drop rules:
 
     
 
     [bookmark: pgfId-1588229]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1588230]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1588235]The access control policy editor appears.
 
     [bookmark: pgfId-1588236]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1588237]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1588242]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1588243]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1546940]The Network Analysis Policy List pop-up window appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1546945]The access control policy editor appears.
 
     [bookmark: pgfId-1546946]Step 7 Select the Advanced tab.
 
     [bookmark: pgfId-1546947]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1546952]The Transport/Network Layer Preprocessor Settings pop-up window appears.
 
     [bookmark: pgfId-1546953]Step 9 You have the following options:
 
      
       
       	 [bookmark: pgfId-1547569]Specify a value 1 to 25 of  Maximum Active Responses per TCP connection. A setting of 0 disables active responses triggered by drop rules and disables additional active responses triggered by  resp or  react rules.
 
       	 [bookmark: pgfId-1547647]Specify a value 1 to 300 of  Minimum Response Seconds to wait until either  Maximum Active Responses occur or any additional traffic on a connection where the system has initiated an active response results in a subsequent active response.
 
      
 
     
 
     [bookmark: pgfId-1574221]Step 10 Click OK. 
 
     [bookmark: pgfId-1585644]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    
 
     
      [bookmark: pgfId-1585647][bookmark: 72453]Troubleshooting: Logging Session Termination Messages
 
     [bookmark: pgfId-1585651]License: Protection
 
     [bookmark: pgfId-1577626]Support might ask you during a troubleshooting call to configure your system to log a message when an individual connection exceeds the specified threshold. Changing the setting for this option will affect performance and should be done only with Support guidance.
 
     [bookmark: pgfId-1548100]To log session termination messages:
 
     
 
     [bookmark: pgfId-1588310]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1588311]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1588316]The access control policy editor appears.
 
     [bookmark: pgfId-1588317]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1588318]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1588323]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1588324]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1548103]The Network Analysis Policy List pop-up window appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1548108]The access control policy editor appears.
 
     [bookmark: pgfId-1548109]Step 7 Select the Advanced tab.
 
     [bookmark: pgfId-1548110]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1548115]The Transport/Network Layer Preprocessor Settings pop-up window appears.
 
     [bookmark: pgfId-1548116]Step 9 Expand Troubleshooting Options.
 
     [bookmark: pgfId-1581093]Step 10 Specify for Session Termination Logging Threshold the number of bytes that result in a logged message when the session terminates and the specified number was exceeded. 
 
     [bookmark: pgfId-1581102]The upper limit of 1GB is also restricted by the amount of memory on the device allocated for stream processing. 
 
     [bookmark: pgfId-1574245]Step 11 Click OK. 
 
     [bookmark: pgfId-1574248]You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    
 
   
 
    
     [bookmark: pgfId-1534951][bookmark: 43286]Verifyin[bookmark: marker-1534948]g Chec[bookmark: ChecksumMode]ksums
 
    [bookmark: pgfId-1557519]License: Protection
 
    [bookmark: pgfId-1530842]The system can verify all protocol-level checksums to ensure that complete IP, TCP, UDP, and ICMP transmissions are received and that, at a basic level, packets have not been tampered with or accidentally altered in transit. A checksum uses an algorithm to verify the integrity of a protocol in the packet. The packet is considered to be unchanged if the system computes the same value that is written in the packet by the end host.
 
    [bookmark: pgfId-1530843]Disabling checksum verification may leave your network susceptible to insertion attacks. Note that the system does not generate checksum verification events. In an inline deployment, you can configure the system to drop packets with invalid checksums.
 
    [bookmark: pgfId-1530844]To configure checksum verifications:
 
    
 
    [bookmark: pgfId-1588417]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1588418]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1588423]The access control policy editor appears.
 
    [bookmark: pgfId-1588424]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1588425]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1588430]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1588431]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1585762]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1533377]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1533381]The Edit Policy page appears.
 
    [bookmark: pgfId-1533383]Step 7 [bookmark: 34131]Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1530859]The Settings page appears.
 
    [bookmark: pgfId-1530860]Step 8 You have two choices, depending on whether Checksum Verification under Transport/Network Layer Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1530861]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1530862]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1530863]The Checksum Verification page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1530867]Step 9 You can set any of the options in the Checksum Verification section to Enabled or Disabled in a passive or inline deployment, or to Drop in an inline deployment:
 
     
      
      	 [bookmark: pgfId-1530868] ICMP Checksums 
 
      	 [bookmark: pgfId-1530869] IP Checksums 
 
      	 [bookmark: pgfId-1530870] TCP Checksums 
 
      	 [bookmark: pgfId-1530871] UDP Checksums 
 
     
 
    
 
    [bookmark: pgfId-1530872]Note that to drop offending packets, in addition to setting an option to Drop you must also enable Inline Mode in the associated network analysis policy. See Allowing Preprocessors to Affect Traffic in Inline Deployments for more information. Note also that setting these options to Drop in a passive deployment is the same as setting them to Enabled.
 
    [bookmark: pgfId-1576792]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1564364]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535308][bookmark: 39399][bookmark: 43997]Normaliz[bookmark: marker-1535305]ing In[bookmark: marker-1535306]lin[bookmark: marker-1535307]e Traffic
 
    [bookmark: pgfId-1557498]License: Protection
 
    [bookmark: pgfId-1530939]The inline normalization preprocessor normalizes traffic to minimize the chances of attackers evading detection in inline deployments. If you enable the inline normalization preprocessor in a network analysis policy, the system tests the following two conditions to ensure that you are using an inline deployment:
 
     
     	 [bookmark: pgfId-1530940] Inline Mode is enabled in the policy. See Allowing Preprocessors to Affect Traffic in Inline Deployments.
 
     	 [bookmark: pgfId-1530941]The access control policy where inline normalization is enabled is applied to a device that is deployed inline.
 
    
 
    [bookmark: pgfId-1530942]The preprocessor normalizes specified traffic only when both conditions are met.
 
    [bookmark: pgfId-1530943]You can specify normalization of any combination of IPv4, IPv6, ICMPv4, ICMPv6, and TCP traffic. Most normalizations are on a per-packet basis and are conducted by the inline normalization preprocessor. However, the TCP stream preprocessor handles most state-related packet and stream normalizations, including TCP payload normalization.
 
    [bookmark: pgfId-1530944]Inline normalization takes place immediately after decoding by the packet decoder and before processing by other preprocessors. Normalization proceeds from the inner to outer packet layers.
 
    [bookmark: pgfId-1530945]The inline normalization preprocessor does not generate events; it prepares packets for use by other preprocessors and the rules engine in inline deployments. The preprocessor also helps ensure that the packets the system processes are the same as the packets received by the hosts on your network.
 
     
      
    
 
    
 
    [bookmark: pgfId-1530949]Tip In an inline deployment, Cisco recommends that you configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. In a passive deployment, Cisco recommends that you configure adaptive profiles. For more information, see Tuning Preprocessing in Passive Deployments.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1540845]Minimum TTL
 
    [bookmark: pgfId-1531105]When Reset TTL is greater than or equal to the value 1 to 255 set for this option, specifies the following:
 
     
      
      	 [bookmark: pgfId-1531106]the minimum value the system will permit in the IPv4 Time to Live (TTL) field when  Normalize IPv4 is enabled; a lower value results in normalizing the packet value for TTL to the value set for  Reset TTL 
 
      	 [bookmark: pgfId-1531107]the minimum value the system will permit in the IPv6 Hop Limit field when  Normalize IPv6 is enabled; a lower value results in normalizing the packet value for Hop Limit to the value set for  Reset TTL 
 
     
 
    
 
    [bookmark: pgfId-1531108]The system assumes a value of 1 when the field is empty.
 
    [bookmark: pgfId-1531109]Note that you can enable the following rules in the decoder rule category to generate events for this option:
 
     
      
      	 [bookmark: pgfId-1531110]You can enable rule 116:428 to generate an event when the system detects an IPv4 packet with a TTL less than the specified minimum.
 
      	 [bookmark: pgfId-1531111]You can enable rule 116:270 to generate an event when the system detects an IPv6 packet with a hop limit that is less than the specified minimum.
 
     
 
    
 
    [bookmark: pgfId-1531114]See the packet decoder Detect Protocol Header Anomalies option in Configuring Packet Decoding for more information.
 
    [bookmark: pgfId-1531116]Reset TTL
 
    [bookmark: pgfId-1531117]When set to a value 1 to 255 that is greater than or equal to Minimum TTL, normalizes the following:
 
     
      
      	 [bookmark: pgfId-1531118]the IPv4 TTL field when  Normalize IPv4 is enabled
 
      	 [bookmark: pgfId-1531119]the IPv6 Hop Limit field when  Normalize IPv6 is enabled
 
     
 
    
 
    [bookmark: pgfId-1531120]The system normalizes the packet by changing its TTL or Hop Limit value to the value set for this option when the packet value is less than Minimum TTL. Setting this option to a value of 0, or any value less than Minimum TTL, disables the option. The system assumes a value of 0 when the field is empty.
 
    [bookmark: pgfId-1531121]Normalize IPv4
 
    [bookmark: pgfId-1538686]Enables normalization of IPv4 traffic. The system also normalizes the TTL field as needed when this option is enabled and the value set for Reset TTL enables TTL normalization. You can also enable Normalize Don’t Fragment Bits and Normalize Reserved Bits when this option is enabled.
 
    [bookmark: pgfId-1538832]When you enable this option, the system performs the following base IPv4 normalizations:
 
     
      
      	 [bookmark: pgfId-1538833]truncates packets with excess payload to the datagram length specified in the IP header
 
      	 [bookmark: pgfId-1538834]clears the Differentiated Services (DS) field, formerly known as the Type of Service (TOS) field
 
      	 [bookmark: pgfId-1538835]sets all option octets to 1 (No Operation)
 
     
 
    
 
    [bookmark: pgfId-1538687]Normalize Don't Fragment Bit
 
    [bookmark: pgfId-1531127]Clears the single-bit Don’t Fragment subfield of the IPv4 Flags header field. Enabling this option allows a downstream router to fragment packets if necessary instead of dropping them; enabling this option can also prevent evasions based on crafting packets to be dropped. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1531128]Normalize Reserved Bit
 
    [bookmark: pgfId-1540113]Clears the single-bit Reserved subfield of the IPv4 Flags header field. You would typically enable this option. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1540114]Normalize TOS Bit
 
    [bookmark: pgfId-1540115]Clears the one byte Differentiated Services field, formerly known as Type of Service. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1531132]Normalize Excess Payload
 
    [bookmark: pgfId-1531133]Truncates packets with excess payload to the datagram length specified in the IP header plus the Layer 2 (for example, Ethernet) header, but does not truncate below the minimum frame length. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1531134]Normalize IPv6
 
    [bookmark: pgfId-1531135]Sets all Option Type fields in the Hop-by-Hop Options and Destination Options extension headers to 00 (Skip and continue processing). The system also normalizes the Hop Limit field as needed when this option is enabled and the value set for Reset TTL enables hop limit normalization.
 
    [bookmark: pgfId-1531136]Normalize ICMPv4
 
    [bookmark: pgfId-1531137]Clears the 8-bit Code field in Echo (Request) and Echo Reply messages in ICMPv4 traffic.
 
    [bookmark: pgfId-1531138]Normalize ICMPv6
 
    [bookmark: pgfId-1531139]Clears the 8-bit Code field in Echo (Request) and Echo Reply messages in ICMPv6 traffic.
 
    [bookmark: pgfId-1541002]Normalize/Clear Reserved Bits
 
    [bookmark: pgfId-1541039]Clears the Reserved bits in the TCP header.
 
    [bookmark: pgfId-1542781]Normalize/Clear Option Padding Bytes
 
    [bookmark: pgfId-1542782]Clears any TCP option padding bytes.
 
    [bookmark: pgfId-1542786]Clear Urgent Pointer if URG=0
 
    [bookmark: pgfId-1542787]Clears the 16-bit TCP header Urgent Pointer field if the urgent (URG) control bit is not set.
 
    [bookmark: pgfId-1542788]Clear Urgent Pointer/URG on Empty Payload
 
    [bookmark: pgfId-1541754]Clears the TCP header Urgent Pointer field and the URG control bit if there is no payload.
 
    [bookmark: pgfId-1541758]Clear URG if Urgent Pointer is Not Set
 
    [bookmark: pgfId-1541759]Clears the TCP header URG control bit if the urgent pointer is not set.
 
    [bookmark: pgfId-1531148]Normalize Urgent Pointer
 
    [bookmark: pgfId-1545219]Sets the two-byte TCP header Urgent Pointer field to the payload length if the pointer is greater than the payload length.
 
    [bookmark: pgfId-1545208]Normalize TCP Payload
 
    [bookmark: pgfId-1531151]Enables normalization of the TCP Data field to ensure consistency in retransmitted data. Any segments that cannot be properly reassembled are dropped. 
 
    [bookmark: pgfId-1539541]Remove Data on SYN
 
    [bookmark: pgfId-1541311]Removes data in synchronization (SYN) packets if your TCP operating system policy is not Mac OS.
 
    [bookmark: pgfId-1544526]This option also disables event generation for rule 129:2.
 
    [bookmark: pgfId-1541371]Remove Data on RST
 
    [bookmark: pgfId-1541391]Removes any data from a TCP reset (RST) packet.
 
    [bookmark: pgfId-1541393]Trim Data to Window
 
    [bookmark: pgfId-1541420]Trims the TCP Data field to the size specified in the Window field.
 
    [bookmark: pgfId-1541422]Trim Data to MSS
 
    [bookmark: pgfId-1541440]Trims the TCP Data field to the Maximum Segment Size (MSS) if the payload is longer than MSS.
 
    [bookmark: pgfId-1541288]Block Unrecoverable TCP Header Anomalies
 
    [bookmark: pgfId-1539542]When you enable this option, the system blocks anomalous TCP packets that, if normalized, would be invalid and likely would be blocked by the receiving host. For example, the system blocks any SYN packet transmitted subsequent to an established session.
 
    [bookmark: pgfId-1566218]The system also drops any packet that matches any of the following TCP stream preprocessor rules, regardless of whether the rules are enabled:
 
    [bookmark: pgfId-1540090] – 129:1
 
    [bookmark: pgfId-1566115] – 129:3
 
    [bookmark: pgfId-1566132] – 129:4
 
    [bookmark: pgfId-1566135] – 129:6
 
    [bookmark: pgfId-1566138] – 129:8
 
    [bookmark: pgfId-1566141] – 129:11
 
    [bookmark: pgfId-1566213] – 129:14 through 129:19
 
    [bookmark: pgfId-1557132]The Total Blocked Packets performance graph tracks the number of packets blocked in inline deployments and, in passive deployments, the number that would have been blocked in an inline deployment.
 
    [bookmark: pgfId-1540094]Explicit Congestion Notification
 
    [bookmark: pgfId-1540095]Enables per-packet or per-stream normalization of Explicit Congestion Notification (ECN) flags as follows:
 
     
      
      	 [bookmark: pgfId-1531161]select  Packet to clear ECN flags on a per-packet basis regardless of negotiation
 
      	 [bookmark: pgfId-1531162]select  Stream to clear ECN flags on a per-stream basis if ECN use was not negotiated
 
     
 
    
 
    [bookmark: pgfId-1531163]If you select Stream, you must also ensure that the TCP stream preprocessor Require TCP 3-Way Handshake option is enabled for this normalization to take place; see Selecting TCP Policy Options for more information. 
 
    [bookmark: pgfId-1531167]Allow These TCP Options
 
    [bookmark: pgfId-1531168]Disables normalization of specific TCP options you allow in traffic.
 
    [bookmark: pgfId-1531169]The system does not normalize options that you explicitly allow. It normalizes options that you do not explicitly allow by setting the options to No Operation (TCP Option 1).
 
    [bookmark: pgfId-1531170]The system always allows the Maximum Segment Size (MSS), Window Scale, and Time Stamp TCP options because these options are commonly used for optimal TCP performance. The system normalizes these commonly used options regardless of the configuration of Allow These TCP Options. The system does not automatically allow other less commonly used options.
 
    [bookmark: pgfId-1531174]You can allow specific options by configuring a comma-separated list of option keywords, option numbers, or both as shown in the following example:
 
     
     [bookmark: pgfId-1531175] sack, echo, 19 
    
 
    [bookmark: pgfId-1546089]Specifying an option keyword is the same as specifying the number for one or more TCP options associated with the keyword. For example, specifying sack is the same as specifying TCP options 4 (Selective Acknowledgment Permitted) and 5 (Selective Acknowledgment). Option keywords are not case sensitive. 
 
    [bookmark: pgfId-1546267]You can also specify any, which allows all TCP options and effectively disables normalization of all TCP options.
 
    [bookmark: pgfId-1531181]The following table summarizes how you can specify TCP options to allow. If you leave the field empty, the system allows only the MSS, Window Scale, and Time Stamp options.
 
    [bookmark: pgfId-1531219]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1531184]Specify... 
         
  
        	 
          
          [bookmark: pgfId-1531186]To allow... 
         
  
       
 
        
        	[bookmark: pgfId-1531188]sack
  
        	[bookmark: pgfId-1531190]TCP options 4 (Selective Acknowledgment Permitted) and 5 (Selective Acknowledgment)
  
       
 
        
        	[bookmark: pgfId-1531192]echo
  
        	[bookmark: pgfId-1531194]TCP options 6 (Echo Request) and 7 (Echo Reply)
  
       
 
        
        	[bookmark: pgfId-1531196]partial_order
  
        	[bookmark: pgfId-1531198]TCP options 9 (Partial Order Connection Permitted) and 10 (Partial Order Service Profile)
  
       
 
        
        	[bookmark: pgfId-1531200]conn_count
  
        	[bookmark: pgfId-1531202]TCP Connection Count options 11 (CC), 12 (CC.New), and 13 (CC.Echo)
  
       
 
        
        	[bookmark: pgfId-1531204]alt_checksum
  
        	[bookmark: pgfId-1531206]TCP options 14 (Alternate Checksum Request) and 15 (Alternate Checksum)
  
       
 
        
        	[bookmark: pgfId-1531208]md5
  
        	[bookmark: pgfId-1531210]TCP option 19 (MD5 Signature)
  
       
 
        
        	[bookmark: pgfId-1531212]the option number, 2 to 255
  
        	[bookmark: pgfId-1531214]a specific option, including options for which there is no keyword
  
       
 
        
        	[bookmark: pgfId-1531216]any
  
        	[bookmark: pgfId-1531218]all TCP options; this setting effectively disables TCP option normalization
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1539790]When you do not specify any for this option, normalizations include the following:
 
     
     	 [bookmark: pgfId-1539791]except MSS, Window Scale, Time Stamp, and any explicitly allowed options, sets all option bytes to No Operation (TCP Option 1)
 
     	 [bookmark: pgfId-1539792]sets the Time Stamp octets to No Operation if Time Stamp is present but invalid, or valid but not negotiated
 
     	 [bookmark: pgfId-1539793]blocks the packet if Time Stamp is negotiated but not present
 
     	 [bookmark: pgfId-1539794]clears the Time Stamp Echo Reply (TSecr) option field if the Acknowledgment (ACK) control bit is not set
 
     	 [bookmark: pgfId-1551627]sets the MSS and Window Scale options to No Operation (TCP Option 1) if the SYN control bit is not set
 
    
 
    [bookmark: pgfId-1551628]To configure the inline normalizations preprocessor:
 
    
 
    [bookmark: pgfId-1588517]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1588518]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1588523]The access control policy editor appears.
 
    [bookmark: pgfId-1588524]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1588525]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1588530]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1588531]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1585841]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1543741]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1543745]The Edit Policy page appears.
 
    [bookmark: pgfId-1543747]Step 7 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1543748]The Settings page appears.
 
    [bookmark: pgfId-1531236]Step 8 You have two choices depending on whether Inline Normalization is enabled under Transport/Network Layer Preprocessors:
 
     
      
      	 [bookmark: pgfId-1531237]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1531238]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1531239]The Inline Normalization page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1531245]Step 9 You can set any of the options described in Normalizing Inline Traffic.
 
    [bookmark: pgfId-1531247]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1564552]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531254][bookmark: 35118]Defr[bookmark: marker-1531252]agm[bookmark: IPDefragmentation]enting IP Packets
 
    [bookmark: pgfId-1557477]License: Protection
 
    [bookmark: pgfId-1531260]When an IP datagram is broken into two or more smaller IP datagrams because it is larger than the [bookmark: marker-1531261]maximum transmission unit (MTU), it is fragmented. A single IP datagram fragment may not contain enough information to identify a hidden attack. Attackers may attempt to evade detection by transmitting attack data in fragmented packets. The IP defragmentation preprocessor reassembles fragmented IP datagrams before the rules engine executes rules against them so the rules can more appropriately identify attacks in those packets. If fragmented datagrams cannot be reassembled, rules do not execute against them.
 
    [bookmark: pgfId-1531262]Note that you must enable IP defragmentation preprocessor rules, which have a generator ID (GID) of 123, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531266]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531270]Understanding IP Fragmentation Exploits
 
     	 [bookmark: pgfId-1531274]Target-Based Defragmentation Policies
 
     	 [bookmark: pgfId-1531278]Selecting Defragmentation Options
 
     	 [bookmark: pgfId-1531282]Configuring IP Defragmentation
 
    
 
     
      [bookmark: pgfId-1531285][bookmark: 17376]Unders[bookmark: marker-1531284]tanding IP Fragmentation Exploits
 
     [bookmark: pgfId-1557459]License: Protection
 
     [bookmark: pgfId-1531290]Enabling IP defragmentation helps you detect attacks against hosts on your network, like the teardrop attack, and resource consumption attacks against the system itself, like the Jolt2 attack.
 
     [bookmark: pgfId-1531291]The Teardrop attack exploits a bug in certain operating systems that causes them to crash when trying to reassemble overlapping IP fragments. When enabled and configured to do so, the IP defragmentation preprocessor identifies the overlapping fragments. The IP defragmentation preprocessor detects the first packets in an overlapping fragment attack such as Teardrop, but does not detect subsequent packets for the same attack.
 
     [bookmark: pgfId-1531292]The Jolt2 attack sends a large number of copies of the same fragmented IP packet in an attempt to overuse IP defragmentors and cause a denial of service attack. A memory usage cap disrupts this and similar attacks in the IP defragmentation preprocessor, and places the system self-preservation above exhaustive inspection. The system is not overwhelmed by the attack, remains operational, and continues to inspect network traffic.
 
     [bookmark: pgfId-1531293]Different operating systems reassemble fragmented packets in different ways. Attackers who can determine which operating systems your hosts are running can also fragment malicious packets so that a target host reassembles them in a specific manner. Because the system does not know which operating systems the hosts on your monitored network are running, the preprocessor may reassemble and inspect the packets incorrectly, thus allowing an exploit to pass through undetected. To mitigate this kind of attack, you can configure the defragmentation preprocessor to use the appropriate method of defragmenting packets for each host on your network. See Target-Based Defragmentation Policies for more information.
 
     [bookmark: pgfId-1592503]Note that you can also use adaptive profiles to dynamically select target-based policies for the IP defragmentation preprocessor using host operating system information for the target host in a packet. For more information, see Tuning Preprocessing in Passive Deployments.
 
    
 
     
      [bookmark: pgfId-1531303][bookmark: 27446]Target-Based Defragmentation[bookmark: marker-1531302] Policies
 
     [bookmark: pgfId-1557441]License: Protection
 
     [bookmark: pgfId-1531308]A host's operating system uses three criteria to determine which packet fragments to favor when reassembling the packet: the order in which the fragment was received by the operating system, its offset (the fragment's distance, in bytes, from the beginning of the packet), and its beginning and ending position compared to overlap fragments. Although every operating system uses these criteria, different operating systems favor different fragments when reassembling fragmented packets. Therefore, two hosts with different operating systems on your network could reassemble the same overlapping fragments in entirely different ways.
 
     [bookmark: pgfId-1531309]An attacker, aware of the operating system of one of your hosts, could attempt to evade detection and exploit that host by sending malicious content hidden in overlapping packet fragments. This packet, when reassembled and inspected, seems innocuous, but when reassembled by the target host, contains a malicious exploit. However, if you configure the IP defragmentation preprocessor to be aware of the operating systems running on your monitored network segment, it will reassemble the fragments the same way that the target host does, allowing it to identify the attack.
 
     [bookmark: pgfId-1531310]You can configure the IP defragmentation preprocessor to use one of seven defragmentation policies, depending on the operating system of the target host. The following table lists the seven policies and the operating systems that use each one. The First and Last policy names reflect whether those policies favor original or subsequent overlapping packets. 
 
     [bookmark: pgfId-1531360]
 
      
       
        
        [bookmark: pgfId-1531320]Table 18-1 [bookmark: 98686]Target-Based Defragmentation Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531324]Policy 
          
  
         	 
           
           [bookmark: pgfId-1531326]Operating Systems 
          
  
        
 
         
         	[bookmark: pgfId-1531328]BSD
  
         	[bookmark: pgfId-1531330]AIX
 [bookmark: pgfId-1531331]FreeBSD
 [bookmark: pgfId-1531332]IRIX
 [bookmark: pgfId-1531333]VAX/VMS
  
        
 
         
         	[bookmark: pgfId-1531335]BSD-right
  
         	[bookmark: pgfId-1531337]HP JetDirect 
  
        
 
         
         	[bookmark: pgfId-1531339]First
  
         	[bookmark: pgfId-1531341]Mac OS
 [bookmark: pgfId-1531342]HP-UX
  
        
 
         
         	[bookmark: pgfId-1531344]Linux
  
         	[bookmark: pgfId-1531346]Linux
 [bookmark: pgfId-1531347]OpenBSD
  
        
 
         
         	[bookmark: pgfId-1531349]Last
  
         	[bookmark: pgfId-1531351]Cisco IOS
  
        
 
         
         	[bookmark: pgfId-1531353]Solaris
  
         	[bookmark: pgfId-1531355]SunOS
  
        
 
         
         	[bookmark: pgfId-1531357]Windows
  
         	[bookmark: pgfId-1531359]Windows
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1531363][bookmark: 65359]Selecting [bookmark: IP defragmentation]Defragmentation Options
 
     [bookmark: pgfId-1557419]License: Protection
 
     [bookmark: pgfId-1531371]You can choose to simply enable or disable IP defragmentation; however, Cisco recommends that you specify the behavior of the enabled IP defragmentation preprocessor at a more granular level.
 
     [bookmark: pgfId-1531372]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531373]You can configure the global Preallocated Fragments option:
 
     [bookmark: pgfId-1531374]Preallocated Fragments
 
     [bookmark: pgfId-1531375]The maximum number of individual fragments that the preprocessor can process at once. Specifying the number of fragment nodes to preallocate enables static memory allocation.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1531376] 
      Caution Processing an individual fragment uses approximately 1550 bytes of memory. If the preprocessor requires more memory to process the individual fragments than the predetermined allowable memory limit for the device, the memory limit for the device takes precedence. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1531377]You can configure the following options for each IP defragmentation policy:
 
     [bookmark: pgfId-1531378]Networks
 
     [bookmark: pgfId-1531379]The IP address of the host or hosts to which you want to apply the defragmentation policy.
 
     [bookmark: pgfId-1531380]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 255 total profiles, including the default policy. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1531387]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1587346]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1531388]Policy
 
     [bookmark: pgfId-1531389]The defragmentation policy you want to use for a set of hosts on your monitored network segment. You can choose among seven policies: BSD, BSD-Right, First, Linux, Last, Solaris, and Windows. See Target-Based Defragmentation Policies for detailed information on these policies.
 
     [bookmark: pgfId-1531394][bookmark: marker-1531393]Timeout
 
     [bookmark: pgfId-1531395]Specifies the maximum amount of time, in seconds, that the preprocessor engine can use when reassembling a fragmented packet. If the packet cannot be reassembled within the specified time period, the preprocessor engine stops attempting to reassemble the packet and discards received fragments.
 
     [bookmark: pgfId-1531396]Minimum TTL
 
     [bookmark: pgfId-1531397]Specifies the minimum acceptable TTL value a packet may have. This option detects TTL-based insertion attacks.
 
     [bookmark: pgfId-1531400]You can enable rule 123:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531402]Detect Anomalies
 
     [bookmark: pgfId-1531403]Identifies fragmentation problems such as overlapping fragments.
 
     [bookmark: pgfId-1531404]You can enable the following rules to generate events for this option:
 
      
       
       	 [bookmark: pgfId-1531405]123:1 through 123:4
 
       	 [bookmark: pgfId-1531406]123:5 (BSD policy)
 
       	 [bookmark: pgfId-1531407]123:6 through 123:8
 
      
 
     
 
     [bookmark: pgfId-1531408]Overlap Limit
 
     [bookmark: pgfId-1531409]Specifies that when the configured number between 0 (unlimited) and 255 of overlapping segments in a session has been detected, defragmentation stops for that session. You must enable Detect Anomalies to configure this option. A blank value disables this option.
 
     [bookmark: pgfId-1531412]You can enable rule 123:12 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531414]Minimum Fragment Size
 
     [bookmark: pgfId-1531415]Specifies that when a non-last fragment smaller than the configured number between 0 (unlimited) and 255 of bytes has been detected, the packet is considered malicious. You must enable Detect Anomalies to configure this option. A blank value disables this option.
 
     [bookmark: pgfId-1531418]You can enable rule 123:13 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1531423][bookmark: 60541]Configuring [bookmark: marker-1531421]IP Defragmentation
 
     [bookmark: pgfId-1557401]License: Protection
 
     [bookmark: pgfId-1531428]You can use the following procedure to configure the IP defragmentation preprocessor. For more information on the IP defragmentation preprocessor configuration options, see Selecting Defragmentation Options.
 
     [bookmark: pgfId-1531432]To configure IP defragmentation:
 
     
 
     [bookmark: pgfId-1588567]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1588568]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1588573]The access control policy editor appears.
 
     [bookmark: pgfId-1588574]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1588575]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1588580]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1588581]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1585872]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1544007]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1544011]The Edit Policy page appears.
 
     [bookmark: pgfId-1544012]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1544013]The Settings page appears.
 
     [bookmark: pgfId-1531448]Step 8 You have two choices, depending on whether IP Defragmentation under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1531449]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531450]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1574625]The IP Defragmentation page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1531455]Step 9 Optionally, you can modify the setting for Preallocated Fragments in the Global Settings page area.
 
     [bookmark: pgfId-1531456]Step 10 You have two options:
 
      
       
       	 [bookmark: pgfId-1531460]Add a new target-based policy. Click the add icon (
 
      
 
      [image: ] ) next to 
       Servers on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses in the 
       Host Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1531461]You can specify a single IP address or address block, or a comma-separated list of either or both. You can create a total of 255 target-based policies including the default policy. For information on using IP address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1583689]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1531468]A new entry appears in the list of targets on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the policy you added.
 
      
       
       	 [bookmark: pgfId-1531469]Modify the settings for an existing target-based policy. Click the configured address for a policy you have added under  Hosts on the left side of the page, or click  default .
 
      
 
     
 ) next to the policy you want to remove. 
     
 
     [bookmark: pgfId-1531474]Step 11 Optionally, you can modify any of the options in the Configuration page area.
 
     [bookmark: pgfId-1531477]Step 12 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1564625]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531485][bookmark: 48919]Understandin[bookmark: Decoding]g Pa[bookmark: marker-1531483]cket D[bookmark: marker-1531484]ecoding
 
    [bookmark: pgfId-1531490]License: Protection
 
    [bookmark: pgfId-1531491]Before sending captured packets to a preprocessor, the system first sends the packets to the packet decoder. The packet decoder converts packet headers and payloads into a format that preprocessors and the rules engine can easily use. Each stack layer is decoded in turn, beginning with the data link layer and continuing through the network and transport layers.
 
    [bookmark: pgfId-1531495]Note that you must enable packet decoder rules, which have a generator ID (GID) of 116, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531499]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
    [bookmark: pgfId-1531500]Decode GTP Data Channel
 
    [bookmark: pgfId-1531501]Decodes the encapsulated GTP (General Packet Radio Service [GPRS] Tunneling Protocol) data channel. By default, the decoder decodes version 0 data on port 3386 and version 1 data on port 2152. You can use the GTP_PORTS default variable to modify the ports that identify encapsulated GTP traffic. See Optimizing Predefined Default Variables for more information.
 
    [bookmark: pgfId-1531505]You can enable rules 116:297 and 116:298 to generate events for this option.
 
    [bookmark: pgfId-1531509][bookmark: 73808]Detect Tere[bookmark: marker-1531507]d[bookmark: marker-1531508]o on Non-Standard Ports
 
    [bookmark: pgfId-1531510]Inspects Teredo tunneling of IPv6 traffic that is identified on a UDP port other than port 3544.
 
    [bookmark: pgfId-1531511]The system always inspects IPv6 traffic when it is present. By default, IPv6 inspection includes the 4in6, 6in4, 6to4, and 6in6 tunneling schemes, and also includes Teredo tunneling when the UDP header specifies port 3544.
 
    [bookmark: pgfId-1531512]In an IPv4 network, IPv4 hosts can use the Teredo protocol to tunnel IPv6 traffic through an IPv4 Network Address Translation (NAT) device. Teredo encapsulates IPv6 packets within IPv4 UDP datagrams to permit IPv6 connectivity behind an IPv4 NAT device. The system normally uses UDP port 3544 to identify Teredo traffic. However, an attacker could use a non-standard port in an attempt to avoid detection. You can enable Detect Teredo on Non-Standard Ports to cause the system to inspect all UDP payloads for Teredo tunneling.
 
    [bookmark: pgfId-1531513]Teredo decoding occurs only on the first UDP header, and only when IPv4 is used for the outer network layer. When a second UDP layer is present after the Teredo IPv6 layer because of UDP data encapsulated in the IPv6 data, the rules engine uses UDP intrusion rules to analyze both the inner and outer UDP layers. 
 
    [bookmark: pgfId-1531514]Note that intrusion rules 12065, 12066, 12067, and 12068 in the policy-other rule category detect, but do not decode, Teredo traffic. Optionally, you can use these rules to drop Teredo traffic in an inline deployment; however, you should ensure that these rules are disabled or set to generate events without dropping traffic when you enable Detect Teredo on Non-Standard Ports. See Filtering Rules in an Intrusion Policy and Setting Rule States for more information.
 
    [bookmark: pgfId-1531522]Detect Exces[bookmark: marker-1531521]sive Length Value 
 
    [bookmark: pgfId-1531523]Detects when the packet header specifies a packet length that is greater than the actual packet length.
 
    [bookmark: pgfId-1531524]You can enable rules 116:6, 116:47, 116:97, and 116:275 to generate events for this option.
 
    [bookmark: pgfId-1531527][bookmark: 75775]Detect Invali[bookmark: marker-1531526]d IP Options 
 
    [bookmark: pgfId-1531528]Detects invalid IP header options to identify exploits that use invalid IP options. For example, there is a denial of service attack against a firewall which causes the system to freeze. The firewall attempts to parse invalid Timestamp and Security IP options and fails to check for a zero length, which causes an irrecoverable infinite loop. The rules engine identifies the zero length option, and provides information you can use to mitigate the attack at the firewall.
 
    [bookmark: pgfId-1531529]You can enable rules 116:4 and 116:5 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531536][bookmark: 73685]Detect Experi[bookmark: marker-1531534]mental[bookmark: marker-1531535] TCP Options
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1531540]TCP Option 
         
  
        	 
          
          [bookmark: pgfId-1531542]Description 
         
  
       
 
        
        	[bookmark: pgfId-1531544]9
  
        	[bookmark: pgfId-1531546]Partial Order Connection Permitted
  
       
 
        
        	[bookmark: pgfId-1531548]10
  
        	[bookmark: pgfId-1531550]Partial Order Service Profile
  
       
 
        
        	[bookmark: pgfId-1531552]14
  
        	[bookmark: pgfId-1531554]Alternate Checksum Request
  
       
 
        
        	[bookmark: pgfId-1531556]15
  
        	[bookmark: pgfId-1531558]Alternate Checksum Data
  
       
 
        
        	[bookmark: pgfId-1531560]18
  
        	[bookmark: pgfId-1531562]Trailer Checksum
  
       
 
        
        	[bookmark: pgfId-1531564]20
  
        	[bookmark: pgfId-1531566]Space Communications Protocol Standards (SCPS)
  
       
 
        
        	[bookmark: pgfId-1531568]21
  
        	[bookmark: pgfId-1531570]Selective Negative Acknowledgements (SCPS)
  
       
 
        
        	[bookmark: pgfId-1531572]22
  
        	[bookmark: pgfId-1531574]Record Boundaries (SCPS)
  
       
 
        
        	[bookmark: pgfId-1531576]23
  
        	[bookmark: pgfId-1531578]Corruption (SPCS)
  
       
 
        
        	[bookmark: pgfId-1531580]24
  
        	[bookmark: pgfId-1531582]SNAP
  
       
 
        
        	[bookmark: pgfId-1531584]26
  
        	[bookmark: pgfId-1531586]TCP Compression Filter
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531588]Because these are experimental options, some systems do not account for them and may be open to exploits.
 
     
      
    
 
    
 
    [bookmark: pgfId-1531589]Note In addition to the experimental options listed in the above table, the system considers any TCP option with an option number greater than 26 to be experimental.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531592]You can enable rule 116:58 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531597][bookmark: 91074]Detect Obs[bookmark: marker-1531595]ole[bookmark: marker-1531596]te TCP Options
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1531601]TCP Option 
         
  
        	 
          
          [bookmark: pgfId-1531603]Description 
         
  
       
 
        
        	[bookmark: pgfId-1531605]6
  
        	[bookmark: pgfId-1531607]Echo
  
       
 
        
        	[bookmark: pgfId-1531609]7
  
        	[bookmark: pgfId-1531611]Echo Reply
  
       
 
        
        	[bookmark: pgfId-1531613]16
  
        	[bookmark: pgfId-1531615]Skeeter
  
       
 
        
        	[bookmark: pgfId-1531617]17
  
        	[bookmark: pgfId-1531619]Bubba
  
       
 
        
        	[bookmark: pgfId-1531621]19
  
        	[bookmark: pgfId-1531623]MD5 Signature
  
       
 
        
        	[bookmark: pgfId-1531625]25
  
        	[bookmark: pgfId-1531627]Unassigned
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531631]You can enable rule 116:57 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531636][bookmark: 37250]Dete[bookmark: marker-1531634]ct T/T[bookmark: marker-1531635]CP
 
    [bookmark: pgfId-1531637]Detects TCP headers with the CC.ECHO option. The CC.ECHO option confirms that TCP for Transactions (T/TCP) is being used. Because T/TCP header options are not in widespread use, some systems do not account for them and may be open to exploits.
 
    [bookmark: pgfId-1531640]You can enable rule 116:56 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531644][bookmark: 10463]Detect Other T[bookmark: marker-1531643]CP Options
 
    [bookmark: pgfId-1531645]Detects TCP headers with invalid TCP options not detected by other TCP decoding event options. For example, this option detects TCP options with the incorrect length or with a length that places the option data outside the TCP header.
 
    [bookmark: pgfId-1531646]You can enable rules 116:54, 116:55, and 116:59 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531652][bookmark: 74683]Detect Protocol Header Anom[bookmark: marker-1531651]alies
 
    [bookmark: pgfId-1531653]Detects other decoding errors not detected by the more specific IP and TCP decoder options. For example, the decoder might detect a malformed data-link protocol header.
 
    [bookmark: pgfId-1531654]To generate events for this option, you can enable any packet decoder rule other than rules specifically associated with other packet decoder options. See Setting Rule States for more information
 
    [bookmark: pgfId-1531658]Note that the following rules generate events triggered by anomalous IPv6 traffic: 116:270 through 116:274, 116:275 through 116:283, 116:291, 116:292, 116:295, 116:296, 116:406, 116:458, 116:460, 116:461.
 
    [bookmark: pgfId-1531659]Note also the following rules associated with the inline normalization preprocessor Minimum TTL option:
 
     
      
      	 [bookmark: pgfId-1531660]You can enable rule 116:428 to generate an event when the system detects an IPv4 packet with a TTL less than the specified minimum.
 
      	 [bookmark: pgfId-1531661]You can enable rule 116:270 to generate an event when the system detects an IPv6 packet with a hop limit that is less than the specified minimum.
 
     
 
    
 
    [bookmark: pgfId-1531664]See the inline normalization Minimum TTL option in Normalizing Inline Traffic for more information.
 
     
      [bookmark: pgfId-1531669][bookmark: 42145]Configuring Packet [bookmark: marker-1531668]Decoding
 
     [bookmark: pgfId-1531673]License: Protection
 
     [bookmark: pgfId-1531674]You can configure packet decoding on the Packet Decoding configuration page. For more information on packet decoding configuration options, see Understanding Packet Decoding.
 
     [bookmark: pgfId-1531678]To configure packet decoding:
 
     
 
     [bookmark: pgfId-1590008]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1590009]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1588621]The access control policy editor appears.
 
     [bookmark: pgfId-1588622]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1588623]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1588628]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1588629]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1585886]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1546662]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1546666]The Edit Policy page appears.
 
     [bookmark: pgfId-1546668]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1546669]The Settings page appears.
 
     [bookmark: pgfId-1531694]Step 8 You have two choices, depending on whether Packet Decoding under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1531695]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531696]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1531697]The Packet Decoding page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Resolving Conflicts and Committing Policy Changes for more information
 
     [bookmark: pgfId-1531701]Step 9 You can enable or disable any of the detection options on the Packet Decoding page. See Understanding Packet Decoding for more information.
 
     [bookmark: pgfId-1531707]Step 10 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1564640]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531715][bookmark: 56264]Using TCP Str[bookmark: Stream(TCP)]eam Prepro[bookmark: marker-1531713]ces[bookmark: marker-1531714]sing
 
    [bookmark: pgfId-1531719]License: Protection
 
    [bookmark: pgfId-1531720]The TCP protocol defines various states in which connections can exist. Each TCP connection is identified by the source and destination IP addresses and source and destination ports. TCP permits only one connection with the same connection parameter values to exist at a time. 
 
    [bookmark: pgfId-1531721]Note that you must enable TCP stream preprocessor rules, which have a generator ID (GID) of 129, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531743]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531747]Understanding State-Related TCP Exploits
 
     	 [bookmark: pgfId-1531751]Initiating Active Responses with Intrusion Drop Rules
 
     	 [bookmark: pgfId-1531755]Selecting The TCP Global Option
 
     	 [bookmark: pgfId-1531759]Understanding Target-Based TCP Policies
 
     	 [bookmark: pgfId-1531763]Selecting TCP Policy Options
 
     	 [bookmark: pgfId-1531767]Reassembling TCP Streams
 
     	 [bookmark: pgfId-1531771]Configuring TCP Stream Preprocessing
 
    
 
     
      [bookmark: pgfId-1531774][bookmark: 39970]Understanding State-Re[bookmark: marker-1531773]lated TCP Exploits
 
     [bookmark: pgfId-1531778]License: Protection
 
     [bookmark: pgfId-1531779]If you add the flow keyword with the established argument to an intrusion rule, the intrusion rules engine inspects packets matching the rule and the flow directive in stateful mode. Stateful mode evaluates only the traffic that is part of a TCP session established with a legitimate three-way handshake between a client and server. The following diagram illustrates a three-way handshake.
 
     [bookmark: pgfId-1622186]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531788]You can configure the system so that the preprocessor detects any TCP traffic that cannot be identified as part of an established TCP session, although this is not recommended for typical use because the events would quickly overload the system and not provide meaningful data.
 
     [bookmark: pgfId-1531789]Attacks like stick and snot use the system’s extensive rule sets and packet inspection against itself. These tools generate packets based on the patterns in Snort-based intrusion rules, and send them across the network. If your rules do not include the flow or flowbits keyword to configure them for stateful inspection, each packet will trigger the rule, overwhelming the system. Stateful inspection allows you to ignore these packets because they are not part of an established TCP session and do not provide meaningful information. When performing stateful inspection, the rules engine detects only those attacks that are part of an established TCP session, allowing analysts to focus on these rather than the volume of events caused by stick or snot.
 
    
 
     
      [bookmark: pgfId-1531822][bookmark: 62039]Sele[bookmark: marker-1531821]cting The TCP Global Option
 
     [bookmark: pgfId-1556954]License: Protection
 
     [bookmark: pgfId-1531827]The TCP stream preprocessor has one global option that controls how the TCP stream preprocessor functions.
 
     [bookmark: pgfId-1531828]No preprocessor rules are associated with this option.
 
     [bookmark: pgfId-1531830][bookmark: marker-1531829]Packet Type Performance Boost
 
     [bookmark: pgfId-1531831]Enables ignoring TCP traffic for all ports and application protocols that are not specified in enabled intrusion rules, except when a TCP rule with both the source and destination ports set to any has a flow or flowbits option. This performance improvement could result in missed attacks.
 
    
 
     
      [bookmark: pgfId-1531846][bookmark: 45662]Understanding Ta[bookmark: marker-1531845]rget-Based TCP Policies
 
     [bookmark: pgfId-1531850]License: Protection
 
     [bookmark: pgfId-1531851]Different operating systems implement TCP in different ways. For example, Windows and some other operating systems require a TCP reset segment to have a precise TCP sequence number to reset a session, while Linux and other operating systems permit a range of sequence numbers. In this example, the stream preprocessor must understand exactly how the destination host will respond to the reset based on the sequence number. The stream preprocessor stops tracking the session only when the destination host considers the reset to be valid, so an attack cannot evade detection by sending packets after the preprocessor stops inspecting the stream. Other variations in TCP implementations include such things as whether an operating system employs a TCP timestamp option and, if so, how it handles the timestamp, and whether an operating system accepts or ignores data in a SYN packet.
 
     [bookmark: pgfId-1531852]Different operating systems also reassemble overlapping TCP segments in different ways. Overlapping TCP segments could reflect normal retransmissions of unacknowledged TCP traffic. They could also represent an attempt by an attacker, aware of the operating system of one of your hosts, to evade detection and exploit that host by sending malicious content hidden in overlapping segments. However, you can configure the stream preprocessor to be aware of the operating systems running on your monitored network segment so it reassembles segments the same way the target host does, allowing it to identify the attack.
 
     [bookmark: pgfId-1531853]You can create one or more TCP policies to tailor TCP stream inspection and reassembly to the different operating systems on your monitored network segment. For each policy, you identify one of thirteen operating system policies. You bind each TCP policy to a specific IP address or address block using as many TCP policies as you need to identify any or all of the hosts using a different operating system. The default TCP policy applies to any hosts on the monitored network that you do not identify in any other TCP policy, so there is no need to specify an IP address, CIDR block, or prefix length for the default TCP policy.
 
     [bookmark: pgfId-1592539]Note that you can also use adaptive profiles to dynamically select target-based policies for the TCP stream preprocessor using host operating system information for the target host in a packet. For more information, see Tuning Preprocessing in Passive Deployments.
 
      
       
        
        [bookmark: pgfId-1531869]Table 18-2 [bookmark: 28246]TCP Operating System Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531873]Policy 
          
  
         	 
           
           [bookmark: pgfId-1531875]Operating Systems 
          
  
        
 
         
         	[bookmark: pgfId-1531877]First
  
         	[bookmark: pgfId-1531879]unknown OS
  
        
 
         
         	[bookmark: pgfId-1531881]Last
  
         	[bookmark: pgfId-1531883]Cisco IOS
  
        
 
         
         	[bookmark: pgfId-1531885]BSD
  
         	[bookmark: pgfId-1531887]AIX
 [bookmark: pgfId-1531888]FreeBSD
 [bookmark: pgfId-1531889]OpenBSD
  
        
 
         
         	[bookmark: pgfId-1531891]Linux
  
         	[bookmark: pgfId-1531893]Linux 2.4 kernel
 [bookmark: pgfId-1531894]Linux 2.6 kernel
  
        
 
         
         	[bookmark: pgfId-1531896]Old Linux
  
         	[bookmark: pgfId-1531898]Linux 2.2 and earlier kernel
  
        
 
         
         	[bookmark: pgfId-1531900]Windows
  
         	[bookmark: pgfId-1531902]Windows 98
 [bookmark: pgfId-1531903]Windows NT
 [bookmark: pgfId-1531904]Windows 2000
 [bookmark: pgfId-1531905]Windows XP
  
        
 
         
         	[bookmark: pgfId-1531907]Windows 2003
  
         	[bookmark: pgfId-1531909]Windows 2003
  
        
 
         
         	[bookmark: pgfId-1531911]Windows Vista
  
         	[bookmark: pgfId-1531913]Windows Vista
  
        
 
         
         	[bookmark: pgfId-1531915]Solaris
  
         	[bookmark: pgfId-1531917]Solaris OS
 [bookmark: pgfId-1531918]SunOS
  
        
 
         
         	[bookmark: pgfId-1531920]IRIX
  
         	[bookmark: pgfId-1531922]SGI Irix
  
        
 
         
         	[bookmark: pgfId-1531924]HPUX
  
         	[bookmark: pgfId-1531926]HP-UX 11.0 and later
  
        
 
         
         	[bookmark: pgfId-1531928]HPUX 10
  
         	[bookmark: pgfId-1531930]HP-UX 10.2 and earlier
  
        
 
         
         	[bookmark: pgfId-1531932]Mac OS
  
         	[bookmark: pgfId-1531934]Mac OS 10 (Mac OS X)
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1577038]Tip The First operating system policy could offer some protection when you do not know the host operating system. However, it may result in missed attacks. You should edit the policy to specify the correct operating system if you know it.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1531938][bookmark: 21035]Selecting TCP P[bookmark: marker-1531937]olicy Options
 
     [bookmark: pgfId-1556975]License: Protection
 
     [bookmark: pgfId-1531943]The following list describes the options you can set to identify and control TCP traffic that the stream preprocessor inspects.
 
     [bookmark: pgfId-1531944]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531946][bookmark: marker-1531945]Network
 
     [bookmark: pgfId-1531947]Specifies the host IP addresses to which you want to apply the TCP stream reassembly policy.
 
     [bookmark: pgfId-1531948]You can specify a single IP address or address block. You can specify up to 255 total profiles including the default policy. For information on using IPv4 and IPv6 address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1531955]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1583733]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1531957][bookmark: marker-1531956]Policy
 
     [bookmark: pgfId-1531958]Identifies the TCP policy operating system of the target host or hosts. If you select a policy other than Mac OS, the system removes the data from the synchronization (SYN) packets and disables event generation for rule 129:2.
 
     [bookmark: pgfId-1531961]For more information, see Understanding Target-Based TCP Policies.
 
     [bookmark: pgfId-1531964][bookmark: marker-1531963]Timeout
 
     [bookmark: pgfId-1531965]The number of seconds between 1 and 86400 the intrusion rules engine keeps an inactive stream in the state table. If the stream is not reassembled in the specified time, the intrusion rules engine deletes it from the state table.
 
      
       
     
 
     
 
     [bookmark: pgfId-1531966]Note If your device is deployed on a segment where the network traffic is likely to reach the device’s bandwidth limits, you should consider setting this value higher (for example, to 600 seconds) to lower the amount of processing overhead.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1531968][bookmark: marker-1531967]Maximum TCP Window
 
     [bookmark: pgfId-1531969]Specifies the maximum TCP window size between 1 and 1073725440 bytes allowed as specified by a receiving host. Setting the value to 0 disables checking for the TCP window size.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1531970] 
      Caution The upper limit is the maximum window size permitted by RFC, and is intended to prevent an attacker from evading detection, but setting a significantly large maximum window size could result in a self-imposed denial of service. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1531973]You can enable rule 129:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531976][bookmark: marker-1531975]Overlap Limit
 
     [bookmark: pgfId-1531977]Specifies that when the configured number between 0 (unlimited) and 255 of overlapping segments in a session has been detected, segment reassembly stops for that session and, if Stateful Inspection Anomalies is enabled and the accompanying preprocessor rule is enabled, an event is generated.
 
     [bookmark: pgfId-1531980]You can enable rule 129:7 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531983]Flu[bookmark: marker-1531982]sh Factor
 
     [bookmark: pgfId-1531984]In an inline deployment, specifies that when a segment of decreased size has been detected subsequent to the configured number between 1 and 2048 of segments of non-decreasing size, the system flushes segment data accumulated for detection. Setting the value to 0 disables detection of this segment pattern, which can indicate the end of a request or response. Note that the Inline Normalization Normalize TCP Payload option must be enabled for this option the be effective. See Normalizing Inline Traffic for more information.
 
     [bookmark: pgfId-1531989][bookmark: marker-1531988]Stateful Inspection Anomalies
 
     [bookmark: pgfId-1531990]Detects anomalous behavior in the TCP stack. When accompanying preprocessor rules are enabled, this may generate many events if TCP/IP stacks are poorly written.
 
     [bookmark: pgfId-1531991]You can enable the following rules to generate events for this option:
 
     [bookmark: pgfId-1531992] – 129:1 through 129:5
 
     [bookmark: pgfId-1531993] – 129:6 (Mac OS only)
 
     [bookmark: pgfId-1531994] – 129:8 through 129:11
 
     [bookmark: pgfId-1531995] – 129:13 through 129:19
 
     [bookmark: pgfId-1531999]See Setting Rule States for more information:
 
     [bookmark: pgfId-1532000]TCP Session Hijacking
 
     [bookmark: pgfId-1532001]Detects TCP session hijacking by validating the hardware (MAC) addresses detected from both sides of a TCP connection during the 3-way handshake against subsequent packets received on the session. When the MAC address for one side or the other does not match, if Stateful Inspection Anomalies is enabled and one of the two corresponding preprocessor rules are enabled, the system generates events. 
 
     [bookmark: pgfId-1532002]You can enable rules 129:9 and 129:10 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532007]Conse[bookmark: marker-1532006]cutive Small Segments
 
     [bookmark: pgfId-1532008]When Stateful Inspection Anomalies is enabled, specifies a maximum number of 1 to 2048 consecutive small TCP segments allowed. Setting the value to 0 disables checking for consecutive small segments.
 
     [bookmark: pgfId-1532009]You must set this option together with the Small Segment Size option, either disabling both or setting a non-zero value for both. Note that receiving as many as 2000 consecutive segments, even if each segment was 1 byte in length, without an intervening ACK would be far more consecutive segments than you would normally expect.
 
     [bookmark: pgfId-1532012]You can enable rule 129:12 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532015]Small Se[bookmark: marker-1532014]gment Size
 
     [bookmark: pgfId-1532016]When Stateful Inspection Anomalies is enabled, specifies the 1 to 2048 byte TCP segment size that is considered small. Setting the value to 0 disables specifying the size of a small segment.
 
     [bookmark: pgfId-1532017]You must set this option together with the Consecutive Small Segments option, either disabling both or setting a non-zero value for both. Note that a 2048 byte TCP segment is larger than a normal 1500 byte Ethernet frame.
 
     [bookmark: pgfId-1532019]Ports Ig[bookmark: marker-1532018]noring Small Segments
 
     [bookmark: pgfId-1532020]When Stateful Inspection Anomalies, Consecutive Small Segments, and Small Segment Size are enabled, optionally specifies a comma-separated list of one or more ports that ignore small TCP segment detection. Leaving this option blank specifies that no ports are ignored. 
 
     [bookmark: pgfId-1532021]You can add any port to the list, but the list only affects ports specified in one of the Perform Stream Reassembly on port lists in the TCP policy.
 
     [bookmark: pgfId-1532023][bookmark: marker-1532022]Require TCP 3-Way Handshake 
 
     [bookmark: pgfId-1532024]Specifies that sessions are treated as established only upon completion of a TCP three-way handshake. Disable this option to increase performance, protect from SYN flood attacks, and permit operation in a partially asynchronous environment. Enable it to avoid attacks that attempt to generate false positives by sending information that is not part of an established TCP session.
 
     [bookmark: pgfId-1532027]You can enable rule 129:20 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532030][bookmark: marker-1532029]3-Way Handshake Timeout
 
     [bookmark: pgfId-1532031]Specifies the number of seconds between 0 (unlimited) and 86400 (twenty-four hours) by which a handshake must be completed when Require TCP 3-Way Handshake is enabled. You must enable Require TCP 3-Way Handshake to modify the value for this option.
 
     [bookmark: pgfId-1532033][bookmark: marker-1532032]Packet Size Performance Boost
 
     [bookmark: pgfId-1532034]Sets the preprocessor to not queue large packets in the reassembly buffer. This performance improvement could result in missed attacks. Disable this option to protect against evasion attempts using small packets of one to twenty bytes. Enable it when you are assured of no such attacks because all traffic is comprised of very large packets.
 
     [bookmark: pgfId-1532036][bookmark: marker-1532035]Legacy Reassembly
 
     [bookmark: pgfId-1532037]Sets the stream preprocessor to emulate the deprecated Stream 4 preprocessor when reassembling packets, which lets you compare events reassembled by the stream preprocessor to events based on the same data stream reassembled by the Stream 4 preprocessor.
 
     [bookmark: pgfId-1532039]Asyn[bookmark: marker-1532038]chronous Network
 
     [bookmark: pgfId-1532040]Specifies whether the monitored network is an asynchronous network, that is, a network where the system sees only half the traffic. When this option is enabled, the system does not reassemble TCP streams to increase performance. 
 
     [bookmark: pgfId-1532041]Perform Stream Reassembly on Client Ports, Server Ports, Both Ports
 
     [bookmark: pgfId-1532042]Specifies for client ports, server ports, or both, a comma-separated list of ports to identify the traffic for the stream preprocessor to reassemble. See Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-1532046]Perform Stream Reassembly on Client Services, Server Services, Both Services
 
     [bookmark: pgfId-1532047]Specifies for client services, server services, or both, services to identify in the traffic for the stream preprocessor to reassemble. See Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-1571300]Troubleshooting Options: Maximum Queued Bytes
 
     [bookmark: pgfId-1571608]Support might ask you during a troubleshooting call to specify the amount of data that can be queued on one side of a TCP connection. A value of 0 specifies an unlimited number of bytes.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1571436] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1571324]Troubleshooting Options: Maximum Queued Segments
 
     [bookmark: pgfId-1571632]Support might ask you during a troubleshooting call to specify the maximum number of bytes of data segments that can be queued on one side of a TCP connection. A value of 0 specifies an unlimited number of data segment bytes.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1571401] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1532053][bookmark: 73650]Reas[bookmark: marker-1532052]sembling TCP Streams
 
     [bookmark: pgfId-1556993]License: Protection
 
     [bookmark: pgfId-1532058]The stream preprocessor collects and reassembles all the packets that are part of a TCP session’s server-to-client communication stream, client-to-server communication stream, or both. This allows the rules engine to inspect the stream as a single, reassembled entity rather than inspecting only the individual packets that are part of a given stream.
 
     [bookmark: pgfId-1532087]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1532091]Understanding Stream-Based Attacks
 
      	 [bookmark: pgfId-1532095]Selecting Stream Reassembly Options
 
     
 
    
 
     
      [bookmark: pgfId-1532098][bookmark: 77990]Understan[bookmark: marker-1532097]ding Stream-Based Attacks
 
     [bookmark: pgfId-1557011]License: Protection
 
     [bookmark: pgfId-1532103]Stream reassembly allows the rules engine to identify stream-based attacks, which it may not detect when inspecting individual packets. You can specify which communication streams the rules engine reassembles based on your network needs. For example, when monitoring traffic on your web servers, you may only want to inspect client traffic because you are much less likely to receive malicious traffic from your own web server.
 
    
 
     
      [bookmark: pgfId-1532106][bookmark: 52798]Selecting Stream R[bookmark: marker-1532105]eassembly Options
 
     [bookmark: pgfId-1557029]License: Protection
 
     [bookmark: pgfId-1532111]In each TCP policy, you can specify a comma-separated list of ports to identify the traffic for the stream preprocessor to reassemble. If adaptive profiles are enabled, you can also list services that identify traffic to reassemble, either as an alternative to ports or in combination with ports. See Tuning Preprocessing in Passive Deployments for information on enabling and using adaptive profiles. 
 
     [bookmark: pgfId-1532115]You can specify ports, services, or both. You can specify separate lists of ports for any combination of client ports, server ports, and both. You can also specify separate lists of services for any combination of client services, server services, and both. For example, assume that you wanted to reassemble the following:
 
      
      	 [bookmark: pgfId-1532116]SMTP (port 25) traffic from the client
 
      	 [bookmark: pgfId-1532117]FTP server responses (port 21)
 
      	 [bookmark: pgfId-1532118]telnet (port 23) traffic in both directions
 
     
 
     [bookmark: pgfId-1532119]You could configure the following:
 
      
      	 [bookmark: pgfId-1532120]For client ports, specify  23, 25 
 
      	 [bookmark: pgfId-1532121]For server ports, specify  21, 23 
 
     
 
     [bookmark: pgfId-1532122]Or, instead, you could configure the following:
 
      
      	 [bookmark: pgfId-1532123]For client ports, specify  25 
 
      	 [bookmark: pgfId-1532124]For server ports, specify  21 
 
      	 [bookmark: pgfId-1532125]For both ports, specify  23 
 
     
 
     [bookmark: pgfId-1592565]Additionally, consider the following example which combines ports and services and would be valid when adaptive profiles are enabled:
 
      
      	 [bookmark: pgfId-1592566]For client ports, specify  23 
 
      	 [bookmark: pgfId-1592567]For client services, specify  smtp 
 
      	 [bookmark: pgfId-1592568]For server ports, specify  21 
 
      	 [bookmark: pgfId-1592569]For server services, specify  telnet 
 
     
 
     [bookmark: pgfId-1532131]Although you can also specify all as the argument to provide reassembly for all ports, Cisco does not recommend setting ports to all because it may increase the amount of traffic inspected by this preprocessor and slow performance unnecessarily.
 
     [bookmark: pgfId-1577101]TCP reassembly automatically and transparently includes ports that you add to other preprocessors. However, if you do explicitly add ports to TCP reassembly lists that you have added to other preprocessor configurations, these additional ports are handled normally. This includes port lists for the following preprocessors:
 
      
      	 [bookmark: pgfId-1584460]FTP/Telnet (server-level FTP)
 
      	 [bookmark: pgfId-1584464]DCE/RPC
 
      	 [bookmark: pgfId-1584468]HTTP Inspect
 
      	 [bookmark: pgfId-1584479]SMTP
 
      	 [bookmark: pgfId-1584482]Session Initiation Protocol
 
      	 [bookmark: pgfId-1584486]POP
 
      	 [bookmark: pgfId-1584489]IMAP
 
      	 [bookmark: pgfId-1590012]SSL
 
     
 
     [bookmark: pgfId-1590021]Negating a port (for example, !77) can improve performance by preventing the TCP stream preprocessor from processing traffic for that port.
 
     [bookmark: pgfId-1590022]Note that reassembling additional traffic types (client, server, both) increases resource demands.
 
     [bookmark: pgfId-1590018]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532137][bookmark: marker-1532136]Perform Stream Reassembly on Client Ports
 
     [bookmark: pgfId-1532138]Enables stream reassembly based on ports for the client side of the connection. In other words, it reassembles streams destined for web servers, mail servers, or other IP addresses typically defined by the IP addresses specified in $HOME_NET. Use this option when you expect malicious traffic to originate from clients.
 
     [bookmark: pgfId-1532140][bookmark: marker-1532139]Perform Stream Reassembly on Client Services
 
     [bookmark: pgfId-1532141]Enables stream reassembly based on services for the client side of the connection. Use this option when you expect malicious traffic to originate from clients.
 
     [bookmark: pgfId-1532158]This feature requires Protection and Control licenses.
 
     [bookmark: pgfId-1532160][bookmark: marker-1532159]Perform Stream Reassembly on Server Ports
 
     [bookmark: pgfId-1532161]Enables stream reassembly based on ports for the server side of the connection only. In other words, it reassembles streams originating from web servers, mail servers, or other IP addresses typically defined by the IP addresses specified in $EXTERNAL_NET. Use this option when you want to watch for server side attacks. You can disable this option by not specifying ports.
 
     [bookmark: pgfId-1532163][bookmark: marker-1532162]Perform Stream Reassembly on Server Services
 
     [bookmark: pgfId-1532164]Enables stream reassembly based on services for the server side of the connection only. Use this option when you want to watch for server side attacks. You can disable this option by not specifying services.
 
     [bookmark: pgfId-1532181]This feature requires Protection and Control licenses.
 
     [bookmark: pgfId-1532183]Perform Stream Reassembly on Bo[bookmark: marker-1532182]th Ports
 
     [bookmark: pgfId-1532184]Enables stream reassembly based on ports for both the client and server side of the connection. Use this option when you expect that malicious traffic for the same ports may travel in either direction between clients and servers. You can disable this option by not specifying ports.
 
     [bookmark: pgfId-1532186]Perform Stream Reassembly on Bo[bookmark: marker-1532185]th Services
 
     [bookmark: pgfId-1532187]Enables stream reassembly based on services for both the client and server side of the connection. Use this option when you expect that malicious traffic for the same services may travel in either direction between clients and servers.You can disable this option by not specifying services.
 
     [bookmark: pgfId-1532204]This feature requires Protection and Control licenses.
 
    
 
     
      [bookmark: pgfId-1532208][bookmark: 92585]Configuring T[bookmark: marker-1532207]CP Stream Preprocessing
 
     [bookmark: pgfId-1557047]License: Protection
 
     [bookmark: pgfId-1532214]You can configure TCP stream preprocessing, including TCP policies. For more information on the TCP stream preprocessor configuration options, see Selecting TCP Policy Options.
 
     [bookmark: pgfId-1532218]To configure the stream preprocessor to track TCP sessions:
 
     
 
     [bookmark: pgfId-1588660]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1588661]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1588666]The access control policy editor appears.
 
     [bookmark: pgfId-1588667]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1588668]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1588673]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1588674]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1585900]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1549914]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1549918]The Edit Policy page appears.
 
     [bookmark: pgfId-1549920]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1549921]The Settings page appears.
 
     [bookmark: pgfId-1532234]Step 8 You have two choices, depending on whether TCP Stream Configuration under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532235]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532236]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532238]The TCP Stream Configuration page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532244]Step 9 Optionally, modify Packet Type Performance Boost under Global Settings. See Selecting The TCP Global Option for more information.
 
     [bookmark: pgfId-1532246]Step 10 You have two options:
 
      
       
       	 [bookmark: pgfId-1532250]Add a new target-based policy. Click the add icon (
 
      
 
      [image: ] ) next to 
       Hosts on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses in the 
       Host Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1532251]You can specify a single IP address or address block. You can create a total of 255 target-based policies including the default policy. For information on using IP address blocks in the ASA FirePOWER module, see IP Address Conventions.
 
     [bookmark: pgfId-1583799]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, and zones handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1532258]A new entry appears in the list of targets on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the policy you added.
 
      
       
       	 [bookmark: pgfId-1532259]Modify the settings for an existing target-based policy. Click the configured address for a policy you have added under  Hosts on the left side of the page, or click  default .
 
      
 
     
 ) next to the policy you want to remove. 
     
 
     [bookmark: pgfId-1532264]Step 11 Optionally, modify any of the TCP policy options under Configuration.
 
     [bookmark: pgfId-1532265]For specific instructions on modifying settings for stream reassembly based on client services, server services, or both go to step 12; otherwise, go to step 15.
 
     [bookmark: pgfId-1532275]For more information, see Selecting TCP Policy Options, and Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-1532280]Step 12 [bookmark: 57174]To modify settings for stream reassembly based on client, server, or both services, click inside the field you want to modify or click Edit next to the field.
 
     [bookmark: pgfId-1532281]The pop-up window for the field you selected appears.
 
     [bookmark: pgfId-1622219]For example, the following graphic shows the Perform Stream Reassembly on Both Services pop-up window.
 
      
       [bookmark: pgfId-1622223]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-1592584]Note that you can enable adaptive profiles to monitor traffic for the stream preprocessor to reassemble based on services discovered on your network. See Tuning Preprocessing in Passive Deployments for more information.
 
      [bookmark: pgfId-1532294]Step 13 You have two choices:
 
       
        
        	 [bookmark: pgfId-1532295]To add services to monitor, select one or more services from the  Available list on the left, then click the right arrow ( > ) button.
 
        	 [bookmark: pgfId-1532296]To remove a service, select it from the  Enabled list on the right, then click the left arrow ( < ) button.
 
       
 
      
 
      [bookmark: pgfId-1532297]Use Ctrl or Shift while clicking to select multiple service detectors. You can also click and drag to select multiple adjacent service detectors.
 
      [bookmark: pgfId-1532298]Step 14 Click OK to add the selections.
 
      [bookmark: pgfId-1532299]The TCP Stream Configuration page is displayed and the services are updated.
 
      [bookmark: pgfId-1532303]Step 15 [bookmark: 88990]Optionally, expand the Troubleshooting Options and modify either of the TCP stream preprocessing policy settings only if asked to do so by Support. For more information, see Selecting TCP Policy Options.
 
      [bookmark: pgfId-1532310]Step 16 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
      [bookmark: pgfId-1564674]
 
       
       
 
      
 
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532318][bookmark: 46338]Us[bookmark: marker-1532315]ing UD[bookmark: Stream(UDP)]P Stream Preprocessing
 
    [bookmark: pgfId-1557098]License: Protection
 
    [bookmark: pgfId-1532324]UDP stream preprocessing occurs when the rules engine processes packets against a UDP rule that includes the flow keyword (see Applying Rules to a TCP or UDP Client or Server Flow) using any of the following arguments:
 
     
     	 [bookmark: pgfId-1532328] Established 
 
     	 [bookmark: pgfId-1532329] To Client 
 
     	 [bookmark: pgfId-1532330] From Client 
 
     	 [bookmark: pgfId-1532331] To Server 
 
     	 [bookmark: pgfId-1532332] From Server 
 
    
 
    [bookmark: pgfId-1532333]UDP is a connectionless protocol that does not provide a means for two endpoints to establish a communication channel, exchange data, and close the channel. UDP data streams are not typically thought of in terms of sessions. However, the stream preprocessor uses the source and destination IP address fields in the encapsulating IP datagram header and the port fields in the UDP header to determine the direction of flow and identify a session. A session ends when a configurable timer is exceeded, or when either endpoint receives an ICMP message that the other endpoint is unreachable or the requested service is unavailable.
 
    [bookmark: pgfId-1575182]Note that the system does not generate events related to UDP stream preprocessing; however, you can enable related packet decoder rules to detect UDP protocol header anomalies. For information on events generated by the packet decoder, see Understanding Packet Decoding.
 
     
      [bookmark: pgfId-1575194][bookmark: 95928]Confi[bookmark: marker-1575193]guring UDP Stream Preprocessing
 
     [bookmark: pgfId-1557120]License: Protection
 
     [bookmark: pgfId-1532354]You can configure UDP stream preprocessing.
 
     [bookmark: pgfId-1532355]To configure the stream preprocessor to track UDP sessions:
 
     
 
     [bookmark: pgfId-1588709]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1588710]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1588715]The access control policy editor appears.
 
     [bookmark: pgfId-1588716]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1588717]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1588722]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1588723]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1585925]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1550601]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1550605]The Edit Policy page appears.
 
     [bookmark: pgfId-1550607]Step 7 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1550608]The Settings page appears.
 
     [bookmark: pgfId-1532371]Step 8 You have two choices, depending on whether UDP Stream Configuration under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532372]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532373]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1550393]The UDP Stream Configuration page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532380]Step 9 Optionally, configure a Time[bookmark: marker-1532379]out value to specify the number of seconds between 1 and 86400 the preprocessor keeps an inactive stream in the state table. If additional datagrams are not seen in the specified time, the preprocessor deletes the stream from the state table.
 
     [bookmark: pgfId-1532382]Step 10 Optionally, select Packet Type Perf[bookmark: marker-1532381]ormance Boost to ignore UDP traffic for all ports and application protocols that are not specified in enabled rules, except when a UDP rule with both the source and destination ports set to any has a flow or flowbits option. This performance improvement could result in missed attacks.
 
     [bookmark: pgfId-1532383]Step 11 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
      
       [bookmark: pgfId-1532387]
 
      [bookmark: pgfId-1564697]
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1164863]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1540269][bookmark: 83148]Tuning Preprocessing in Passive Deployments 
      
      
 
     
 
 
    [bookmark: pgfId-1540271]Typically, the system uses the static settings in your network analysis policy to preprocess and analyze traffic. With the adaptive profiles feature, however, the system can adapt to network traffic by associating traffic with host information and processing the traffic accordingly.
 
    [bookmark: pgfId-1530800]When a host receives traffic, the operating system running on the host reassembles IP fragments. The order used for that reassembly depends on the operating system. Similarly, each operating system may implement TCP in different ways, and therefore reassemble TCP streams differently. If preprocessors reassemble data using a format other than that used for the operating system of the destination host, the system may miss content that could be malicious when reassembled on the receiving host.
 
     
      
    
 
    
 
    [bookmark: pgfId-1530804]Tip In a passive deployment, Cisco recommends that you configure adaptive profiles. In an inline deployment, Cisco recommends that you configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. For more information, see Normalizing Inline Traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530814]For more information on using adaptive profiles to improve reassembly of packet fragments and TCP streams, see the following topics:
 
     
     	 [bookmark: pgfId-1530818]Understanding Adaptive Profiles
 
     	 [bookmark: pgfId-1530822]Configuring Adaptive Profiles
 
    
 
   
 
    
     [bookmark: pgfId-1537095][bookmark: 45020]Understanding Adapti[bookmark: marker-1537094]ve Profiles
 
    [bookmark: pgfId-1537105]License: Protection
 
    [bookmark: pgfId-1537106]Adaptive profiles enable use of the most appropriate operating system profiles for IP defragmentation and TCP stream preprocessing. For more information on the aspects of the network analysis policy affected by adaptive profiles, see Defragmenting IP Packets and Using TCP Stream Preprocessing.
 
     
      [bookmark: pgfId-1537133]Using Adaptive Profiles with Prepr[bookmark: marker-1537132]ocessors
 
     [bookmark: pgfId-1537789]License: Protection
 
     [bookmark: pgfId-1537144]Adaptive profiles help to defragment IP packets and reassemble streams in the same way as the operating system on the target host. The intrusion rules engine then analyzes the data in the same format as that used by the destination host.
 
     [bookmark: pgfId-1534686]Adaptive profiles switch to the appropriate operating system profile based on the operating system in the host profile for the target host, as illustrated in the following diagram. 
 
     [bookmark: pgfId-1547624]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1534533]For example, you configure adaptive profiles for the 10.6.0.0/16 subnet and set the default IP Defragmentation target-based policy to Linux. The ASA FirePOWER module where you configure the settings includes the 10.6.0.0/16 subnet.
 
     [bookmark: pgfId-1530868]When a device detects traffic from Host A, which is not in the 10.6.0.0/16 subnet, it uses the Linux target-based policy to reassemble IP fragments. However, when it detects traffic from Host B, which is in the 10.6.0.0/16 subnet, it retrieves Host B’s operating system data, where Host B is running Microsoft Windows XP Professional. The system uses the Windows target-based profile to do the IP defragmentation for the traffic destined for Host B.
 
     [bookmark: pgfId-1530872]See Defragmenting IP Packets for information on the IP Defragmentation preprocessor. See Using TCP Stream Preprocessing for information on the stream preprocessor.
 
    
 
   
 
    
     [bookmark: pgfId-1530914][bookmark: 17680]Configuring Adaptive Profi[bookmark: marker-1530913]les
 
    [bookmark: pgfId-1537857]License: Protection
 
    [bookmark: pgfId-1530922]To use host information to determine which target-based profiles are used for IP defragmentation and TCP stream preprocessing, you can configure adaptive profiles. 
 
    [bookmark: pgfId-1538207]When you configure adaptive profiles, you need to bind the adaptive profile setting to a specific network or networks. To successfully use adaptive profiles, that network must be in the segment monitored by the device.
 
    [bookmark: pgfId-1530925]You can indicate the hosts in the network where adaptive profiles should be used to process traffic by specifying an IP address, a block of addresses, or a network variable with the desired value configured in the variable set linked to the default intrusion policy for your access control policy. See Setting the Default Intrusion Policy for Access Control for more information.
 
    [bookmark: pgfId-1530926]You can use any of these addressing methods alone or in any combination as a list of IP addresses, address blocks, or variables separated by commas, as shown in the following example: 
 
     
     [bookmark: pgfId-1530927]192.168.1.101, 192.168.4.0/24, $HOME_NET 
    
 
    [bookmark: pgfId-1530933]For information on specifying address blocks, see IP Address Conventions.
 
     
      
    
 
    
 
    [bookmark: pgfId-1540307]Tip You can apply adaptive profiles to all hosts in the network by using a variable with a value of any or by specifying 0.0.0.0/0 as the network value.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530940]To configure adaptive profiles:
 
    
 
    [bookmark: pgfId-1541026]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1541027]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1535000]The access control policy editor appears.
 
    [bookmark: pgfId-1535001]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1535002]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1535007]The Detection Enhancement Settings pop-up window appears.
 
    [bookmark: pgfId-1530955]Step 5 Select Adaptive Profiles - Enabled to enable adaptive profiles.
 
    [bookmark: pgfId-1540338]Step 6 Optionally, in the Adaptive Profiles - Attribute Update Interval field, type the number of minutes that should elapse between synchronization of data. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1540342]Note Increasing the value for this option could improve performance in a large network.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530968]Step 7 In the Adaptive Profiles - Networks field, type the specific IP address, address block, or variable, or a list that includes any of these addressing methods separated by commas, to identify any host in the network for which you want to use adaptive profiles.
 
    [bookmark: pgfId-1530972]See Working with Variable Sets for information on configuring variables.
 
    [bookmark: pgfId-1535614]Step 8 Click OK to retain your settings.
 
    [bookmark: pgfId-1535615]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1535616]
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1532735][bookmark: 81006]Getting Started with Intrusion Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1548558]Intrusion policies are defined sets of intrusion detection and prevention configurations that inspect traffic for security violations and, in inline deployments, can block or alter malicious traffic. Intrusion policies are invoked by your access control policy and are the system’s last line of defense before traffic is allowed to its destination.
 
    [bookmark: pgfId-1549515]Cisco delivers several intrusion policies with the ASA FirePOWER module. By using system-provided policies you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states (enabled or disabled), as well as provides the initial configurations for other advanced settings. An enabled rule causes the system to generate intrusion events for (and optionally block) traffic matching the rule. Disabling a rule stops processing of the rule. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1551339]Tip System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules. Understanding Network Analysis and Intrusion Policies provides an overview of how network analysis and intrusion policies work together to examine your traffic, as well as some basics on using the navigation panel, resolving conflicts, and committing changes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1552578]If you create a custom intrusion policy, you can:
 
     
     	 [bookmark: pgfId-1552955]Tune detection by enabling and disabling rules, as well as by writing and adding your own rules.
 
     	 [bookmark: pgfId-1552966]Configure various advanced settings such as external alerting, sensitive data preprocessing, and global rule thresholding.
 
     	 [bookmark: pgfId-1552972]Use layers as building blocks to efficiently manage multiple intrusion policies.
 
    
 
    [bookmark: pgfId-1552579]When tailoring your intrusion policy, especially when enabling and adding rules, keep in mind that some intrusion rules require that traffic first be decoded or preprocessed in a certain way. Before an intrusion policy examines a packet, the packet is preprocessed according to configurations in a network analysis policy. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy user interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1552688]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1553436]After you configure a custom intrusion policy, you can use it as part of your access control configuration by associating the intrusion policy with one or more access control rules or an access control policy’s default action. This forces the system to use the intrusion policy to examine certain allowed traffic before the traffic passes to its final destination. A variable set that you pair with the intrusion policy allows you to accurately reflect your home and external networks and, as appropriate, the servers on your network. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1552334]This chapter explains how to create a simple custom intrusion policy. The chapter also contains basic information on managing intrusion policies: editing, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-1545165]Creating a Custom Intrusion Policy
 
     	 [bookmark: pgfId-1545193]Managing Intrusion Policies
 
     	 [bookmark: pgfId-1545198]Editing Intrusion Policies
 
     	 [bookmark: pgfId-1545203]Applying an Intrusion Policy
 
     	 [bookmark: pgfId-1545213]Generating a Report of Current Intrusion Settings
 
     	 [bookmark: pgfId-1545218]Comparing Two Intrusion Policies or Revisions
 
    
 
   
 
    
     [bookmark: pgfId-1535767][bookmark: 86809]Cre[bookmark: marker-1535815]ating a Custom Intrusion Policy
 
    [bookmark: pgfId-1535774]License: Protection
 
    [bookmark: pgfId-1535596]When you create a new intrusion policy you must give it a unique name, specify a base policy, and specify drop behavior.
 
    [bookmark: pgfId-1535597]The base policy defines the intrusion policy’s default settings. Modifying a setting in the new policy overrides—but does not change—the settings in the base policy. You can use either a system-provided or custom policy as your base policy. For more information, see Understanding the Base Layer.
 
    [bookmark: pgfId-1535598]The intrusion policy’s drop behavior, or Drop when Inline setting, determines how the system handles drop rules (intrusion or preprocessor rules whose rule state is set to Drop and Generate Events) and other intrusion policy configurations that affect traffic. You should enable drop behavior in inline deployments when you want to drop or replace malicious packets. Note that in passive deployments, the system cannot affect traffic flow regardless of the drop behavior. For more information, see Setting Drop Behavior in an Inline Deployment.
 
    [bookmark: pgfId-1535608]To create an intrusion policy:
 
    
 
    [bookmark: pgfId-1535613]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1535941]The Intrusion Policy page appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-1535962]Tip You can also import a policy from another ASA FirePOWER module; see Importing and Exporting Configurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1535622]Step 2 Click Create Policy.
 
    [bookmark: pgfId-1556327]If you have unsaved changes in another policy, click Cancel when prompted to return to the Intrusion Policy page. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1535623]The Create Intrusion Policy pop-up window appears.
 
    [bookmark: pgfId-1536108]Step 3 Give the policy a unique Name and, optionally, a Description.
 
    [bookmark: pgfId-1536110]Step 4 Specify the initial Base Policy.
 
    [bookmark: pgfId-1536111]You can use either a system-provided or custom policy as your base policy.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1535634] 
     Caution Do 
     not use 
     Experimental Policy 1 unless instructed to do so by a Cisco representative. Cisco uses this policy for testing. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1535635]Step 5 Set the system’s drop behavior in an inline deployment:
 
     
      
      	 [bookmark: pgfId-1568253]To allow intrusion policies to affect traffic and generate events, enable  Drop when Inline .
 
      	 [bookmark: pgfId-1568254]To prevent intrusion policies from affecting traffic while still generating events, disable  Drop when Inline .
 
     
 
    
 
    [bookmark: pgfId-1535638]Step 6 Create the policy:
 
     
      
      	 [bookmark: pgfId-1535639]Click  Create Policy to create the new policy and return to the Intrusion Policy page. The new policy has the same settings as its base policy.
 
      	 [bookmark: pgfId-1535640]Click  Create and Edit Policy to create the policy and open it for editing in the advanced intrusion policy editor; see Editing Intrusion Policies.
 
     
 
    
 
    [bookmark: pgfId-1535644]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1543349][bookmark: 13111]Managing Intrusion Pol[bookmark: marker-1543348]icies
 
    [bookmark: pgfId-1543353]License: Protection
 
    [bookmark: pgfId-1565637]On the Intrusion Policy page (Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy) you can view your current custom intrusion policies, along with the following information:
 
     
     	 [bookmark: pgfId-1543355]the time and date the policy was last modified (in local time)
 
     	 [bookmark: pgfId-1543356]whether the  Drop when Inline setting is enabled, which allows you to drop and modify traffic in an inline deployment
 
     	 [bookmark: pgfId-1543357]which access control policies are using the intrusion policy to inspect traffic
 
     	 [bookmark: pgfId-1543358]whether a policy has unsaved changes
 
    
 
     
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1566526]Table 20-1 [bookmark: 22107]Intrusion Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1566532]To... 
         
  
        	 
          
          [bookmark: pgfId-1566534]You can... 
         
  
        	 
          
          [bookmark: pgfId-1566536]See... 
         
  
       
 
        
        	[bookmark: pgfId-1566538]create a new intrusion policy
  
        	[bookmark: pgfId-1566540]click Create Policy.
  
        	[bookmark: pgfId-1566544]Creating a Custom Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1566547]edit an existing intrusion policy
  ). 
        	[bookmark: pgfId-1566557]Editing Intrusion Policies
  
       
 
        
        	[bookmark: pgfId-1566559]reapply an intrusion policy
  ). 
        	[bookmark: pgfId-1566568]Applying an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1566571]export an intrusion policy to import on another ASA FirePOWER module
  ). 
        	[bookmark: pgfId-1566584]Exporting Configurations
  
       
 
        
        	[bookmark: pgfId-1566586]view a PDF report that lists the current configuration settings in a intrusion policy
  ). 
        	[bookmark: pgfId-1566595]Generating a Report of Current Intrusion Settings
  
       
 
        
        	[bookmark: pgfId-1566598]compare the settings of two intrusion policies or two revisions of the same policy
  
        	[bookmark: pgfId-1566600]click Compare Policies.
  
        	[bookmark: pgfId-1566604]Comparing Two Intrusion Policies or Revisions
  
       
 
        
        	[bookmark: pgfId-1566607]delete an intrusion policy
  
        	 ), then confirm that you want to delete the policy. You cannot delete an intrusion policy if an access control policy references it.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1533742][bookmark: 61093]Editing Intrusion Policies
 
    [bookmark: pgfId-1533381]License: Protection
 
    [bookmark: pgfId-1558315]When you create a new intrusion policy, it has the same intrusion rule and advanced settings as its base policy. The following table explains the most common actions taken when editing an intrusion policy:
 
    [bookmark: pgfId-1569685]
 
     
      
       
       [bookmark: pgfId-1569585]Table 20-2 [bookmark: 35642]Intrusion Policy Editing Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1569591]To... 
         
  
        	 
          
          [bookmark: pgfId-1569593]You can... 
         
  
        	 
          
          [bookmark: pgfId-1569595]See... 
         
  
       
 
        
        	[bookmark: pgfId-1569597]specify drop behavior in an inline deployment
  
        	[bookmark: pgfId-1569599]select or clear the Drop when Inline check box on the Policy Information page.
  
        	[bookmark: pgfId-1569603]Setting Drop Behavior in an Inline Deployment
  
       
 
        
        	[bookmark: pgfId-1569606]change the base policy
  
        	[bookmark: pgfId-1569608]select a base policy from the Base Policy drop-down list on the Policy Information page.
  
        	[bookmark: pgfId-1569612]Changing the Base Policy
  
       
 
        
        	[bookmark: pgfId-1569615]view the settings in the base policy
  
        	[bookmark: pgfId-1569617]click Manage Base Policy on the Policy Information page
  
        	[bookmark: pgfId-1569621]Understanding the Base Layer
  
       
 
        
        	[bookmark: pgfId-1569624]display or configure intrusion rules
  
        	[bookmark: pgfId-1569626]click Manage Rules on the Policy Information page.
  
        	[bookmark: pgfId-1569630]Viewing Rules in an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1569633]display a filtered view of intrusion rules by current rule state and, optionally, configure those rules
  
        	[bookmark: pgfId-1569635]on the Policy Information page, click View next to the number of rules under Manage Rules that are set to Generate Events or to Drop and Generate Events. 
  
        	[bookmark: pgfId-1569639]Filtering Rules in an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1569668]enable, disable, or edit advanced settings
  
        	[bookmark: pgfId-1569670]click Advanced Settings in the navigation panel
  
        	[bookmark: pgfId-1569674]Configuring Advanced Settings in an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1569677]manage policy layers
  
        	[bookmark: pgfId-1569679]click Policy Layers in the navigation panel
  
        	[bookmark: pgfId-1569683]Using Layers in a Network Analysis or Intrusion Policy
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1569686]When tailoring an intrusion policy, especially when enabling and adding rules, keep in mind that some intrusion rules require that traffic first be decoded or preprocessed in a certain way. Before an intrusion policy examines a packet, the packet is preprocessed according to configurations in a network analysis policy. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy user interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1569687]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1569691]The system caches one intrusion policy. While editing an intrusion policy, if you select any menu or other path to another page, your changes stay in the system cache even if you leave the page. In addition to the actions you can perform in the table above, Understanding Network Analysis and Intrusion Policies provides information on resolving conflicts and committing changes
 
    [bookmark: pgfId-1535300]To edit a intrusion policy:
 
    
 
    [bookmark: pgfId-1573979]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1571082]The Intrusion Policy page appears.
 ) next to the intrusion policy you want to configure. 
    
 
    [bookmark: pgfId-1566298]The intrusion policy editor appears, focused on the Policy Information page and with a navigation panel on the left.
 
    [bookmark: pgfId-1535312]Step 3 Edit your policy. Take any of the actions summarized above. 
 
    [bookmark: pgfId-1535313]Step 4 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
    [bookmark: pgfId-1535317]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1545758][bookmark: 39489]Setting Drop Behavior in an Inline Deployment
 
     [bookmark: pgfId-1545765]License: Protection
 
     [bookmark: pgfId-1558904]In an inline deployment, an intrusion policy can block and modify traffic:
 
      
      	 [bookmark: pgfId-1559169] Drop rules can drop matching packets and generate intrusion events. To configure an intrusion or preprocessor drop rule, set its state to Drop and Generate Events; see Setting Rule States.
 
      	 [bookmark: pgfId-1559204]Intrusion rules can use the  replace keyword to replace malicious content; see Replacing Content in Inline Deployments.
 
     
 
     [bookmark: pgfId-1559040]For intrusion rules to affect traffic, you must correctly configure drop rules and rules that replace content, as well as correctly deploy thesystem inline. Finally, you must enable the intrusion policy’s drop behavior, or Drop when Inline setting.
 
      
       
     
 
     
 
     [bookmark: pgfId-1560238]Note To block the transfer of malware files over FTP, you must not only correctly configure network-based advanced malware protection (AMP), but also enable Drop when Inline in your access control policy’s default intrusion policy. To determine or change the default intrusion policy, see Setting the Default Intrusion Policy for Access Control.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1560472]If you want to assess how your configuration would function in an inline deployment without actually affecting traffic, you can disable drop behavior. In this case, the system generates intrusion events but does not drop packets that trigger drop rules. When you are satisfied with the results, you can enable drop behavior. 
 
     [bookmark: pgfId-1560679]Note that in passive deployments the system cannot affect traffic regardless of the drop behavior. In other words, in a passive deployment, rules set to Drop and Generate Events behave identically to rules set to Generate Events—the system generates intrusion events but cannot drop packets.
 
     [bookmark: pgfId-1545779]When you view intrusion events, workflows can include the inline result, which indicates whether traffic was actually dropped, or whether it only would have dropped. When a packet matches a drop rule, the inline result is:
 
      
      	 [bookmark: pgfId-1558534] Dropped  ,  for packets dropped by a correctly configured inline deployment with drop behavior enabled
 
      	 [bookmark: pgfId-1558707] Would have dropped , for packets that were not dropped either because your device is deployed passively or because drop behavior is disabled. Note that the inline result is always  Would have dropped for packets seen while the system is pruning, regardless of deployment.
 
     
 
     [bookmark: pgfId-1556702]To set the drop behavior of an intrusion policy in an inline deployment:
 
     
 
     [bookmark: pgfId-1574000]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1571146]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1545870]The Policy Information page appears.
 
     [bookmark: pgfId-1545871]Step 3 Set the policy’s drop behavior:
 
      
       
       	 [bookmark: pgfId-1561482]To allow intrusion rules to affect traffic and generate events, enable  Drop when Inline .
 
       	 [bookmark: pgfId-1561483]To prevent intrusion rules from affecting traffic while still generating events, disable  Drop when Inline .
 
      
 
     
 
     [bookmark: pgfId-1557415]Step 4 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1561573]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1535372][bookmark: 13049]Configuring Advanced Settings in an Intrusion Pol[bookmark: marker-1539264][bookmark: marker-1539265]icy
 
     [bookmark: pgfId-1537779]License: Protection
 
     [bookmark: pgfId-1537872]An intrusion policy’s advanced settings require specific expertise to configure. The base policy for your intrusion policy determines which advanced settings are enabled by default and the default configuration for each.
 
     [bookmark: pgfId-1536718]When you select Advanced Settings in the navigation panel of an intrusion policy, the policy lists its advanced settings by type. On the Advanced Settings page, you can enable or disable advanced settings in your intrusion policy, as well as access advanced setting configuration pages.
 
     [bookmark: pgfId-1539124]An advanced setting must be enabled for you to configure it. When you enable an advanced setting, a sublink to the configuration page for the advanced setting appears beneath the Advanced Settings link in the navigation panel, and an Edit link to the configuration page appears next to the advanced setting on the Advanced Settings page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1561862]Tip To revert an advanced setting’s configuration to the settings in the base policy, click Revert to Defaults on the configuration page for the advanced setting. When prompted, confirm that you want to revert.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1563741]When you disable an advanced setting, the sublink and Edit link no longer appear, but your configurations are retained. Note that some intrusion policy configurations (sensitive data rules, SNMP alerts for intrusion rules) require enabled and correctly configured advanced settings. You cannot save an intrusion policy misconfigured in this way; see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1536724]Modifying the configuration of an advanced setting requires an understanding of the configuration you are modifying and its potential impact on your network. The following sections provide links to specific configuration details for each advanced setting.
 
     [bookmark: pgfId-1537999]Specific Threat Detection
 
     [bookmark: pgfId-1538030]The sensitive data preprocessor detects sensitive data such as credit card numbers and Social Security numbers in ASCII text. For information on configuring this preprocessor, see Detecting Sensitive Data.
 
     [bookmark: pgfId-1538057]Note that other preprocessors that detect specific threats (back orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic) are configured in network analysis policies. For more information, see Detecting Specific Threats.
 
     [bookmark: pgfId-1538413]Intrusion Rule Thresholds
 
     [bookmark: pgfId-1538414]Global rule thresholding can prevent your system from being overwhelmed with a large number of events by allowing you to use thresholds to limit the number of times the system logs and displays intrusion events. For more information, see Globally Limiting Intrusion Event Logging.
 
     [bookmark: pgfId-1535215]External Responses
 
     [bookmark: pgfId-1538495]In addition to the various views of intrusion events within the user interface, you can enable logging to system log (syslog) facilities or send event data to an SNMP trap server. Per policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events. For more information, see:
 
      
      	 [bookmark: pgfId-1569103]Configuring SNMP Responses
 
      	 [bookmark: pgfId-1569132]Configuring Syslog Responses
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532783][bookmark: 29037]Applying an Intrusion Policy
 
    [bookmark: pgfId-1532790]License: Protection
 
    [bookmark: pgfId-1535048]After you apply an intrusion policy using access control (see Deploying Configuration Changes), you can reapply the intrusion policy at any time. This allows you to implement intrusion policy changes on your monitored network without reapplying the access control policy. While reapplying, you can also view a comparison report to review the changes made since the last time the intrusion policy was applied.
 
    [bookmark: pgfId-1535050]Note the following when reapplying intrusion policies:
 
     
     	 [bookmark: pgfId-1535053]You can schedule intrusion policy reapply tasks to recur on a regular basis; see Automating Applying an Intrusion Policy.
 
     	 [bookmark: pgfId-1535063]When you import a rule update, you can automatically apply intrusion policies after the import completes. If you do not enable this option, you must manually reapply the policies changed by the rule update. See Importing Rule Updates and Local Rule Files for more information.
 
    
 
    [bookmark: pgfId-1535071]To reapply an intrusion policy:
 
    
 
    [bookmark: pgfId-1574013]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1535077]The Intrusion Policy page appears. 
 ) next to the policy you want to reapply. 
    
 
    [bookmark: pgfId-1535093]The policy is reapplied. You can monitor the status of the apply using the task queue (Monitoring > ASA FirePOWER Monitoring > Task Status). See Viewing the Task Queue for more information.
 
    [bookmark: pgfId-1535116]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532792][bookmark: 37768]Generating a Report of Current Intru[bookmark: marker-1534616]sion Settings
 
    [bookmark: pgfId-1532799]License: Protection
 
    [bookmark: pgfId-1534218]An intrusion policy report is a record of the policy configuration at a specific point in time. The system combines the settings in the base policy with the settings of the policy layers, and makes no distinction between which settings originated in the base policy or policy layer.
 
     
      
       
       [bookmark: pgfId-1534280]Table 20-3 [bookmark: 90226]Intrusion Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-1534284]Section 
         
  
        	 
          
          [bookmark: pgfId-1534286]Description 
         
  
       
 
        
        	[bookmark: pgfId-1534297]Policy Information
  
        	[bookmark: pgfId-1534344]Provides the name and description of the intrusion policy, the name of the user who last modified the policy, and the date and time the policy was last modified. Also indicates whether dropping packets in an inline deployment is enabled or disabled, the current rule update version, and whether the base policy is locked to the current rule update.
  
       
 
        
        	[bookmark: pgfId-1534314]Advanced Settings
  
        	[bookmark: pgfId-1534316]Lists all enabled intrusion policy advanced settings and their configurations.
  
       
 
        
        	[bookmark: pgfId-1534321]Rules
  
        	[bookmark: pgfId-1534323]Provides a list of all enabled rules and their actions.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1534242]You can also generate a comparison report that compares two intrusion policies, or two revisions of the same policy. For more information, see Comparing Two Intrusion Policies or Revisions.
 
    [bookmark: pgfId-1534132]To view an intrusion policy report:
 
    
 
    [bookmark: pgfId-1574030]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1534138]The Intrusion Policy page appears.
 ) next to the intrusion policy for which you want to generate a report. Remember to commit any potential changes before you generate an intrusion policy report; only committed changes appear in the report. 
    
 
    [bookmark: pgfId-1534143]The system generates the intrusion policy report. You are prompted to save the report to your computer.
 
    [bookmark: pgfId-1534144]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532802][bookmark: 22780]Comparing Two Intrusion Policies or Revi[bookmark: marker-1534629]sions
 
    [bookmark: pgfId-1532809]License: Protection
 
    [bookmark: pgfId-1534670]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two intrusion policies. You can compare any two intrusion policies or two revisions of the same intrusion policy, for the intrusion policies you can access. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies or policy revisions.
 
    [bookmark: pgfId-1534671]There are two tools you can use to compare intrusion policies:
 
     
     	 [bookmark: pgfId-1534672]The comparison view displays only the differences between two intrusion policies or intrusion policy revisions in a side-by-side format; the name of each policy appears in the title bar on the left and right sides of the comparison view.
 
    
 
    [bookmark: pgfId-1534673]You can use this to view and navigate both policy revisions on the user interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-1534674]The comparison report creates a record of only the differences between two intrusion policies or intrusion policy revisions in a format similar to the intrusion policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-1534675]You can use this to save, copy, print and share your policy comparisons for further examination.
 
    [bookmark: pgfId-1534676]For more information on understanding and using the intrusion policy comparison tools, see:
 
     
     	 [bookmark: pgfId-1534680]Using the Intrusion Policy Comparison View
 
     	 [bookmark: pgfId-1534684]Using the Intrusion Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-1534687][bookmark: 23989]Using the Intrusion Polic[bookmark: marker-1534686]y Comparison View
 
     [bookmark: pgfId-1534694]License: Protection
 
     [bookmark: pgfId-1572037]The comparison view displays both intrusion policies or policy revisions in a side-by-side format, with each policy or policy revision identified by name in the title bar on the left and right sides of the comparison view. The time of last modification and the last user to modify are displayed to the right of the policy name. Note that the Intrusion Policy page displays the time a policy was last modified in local time, but the intrusion policy report lists the time modified in UTC. Differences between the two intrusion policies or policy revisions are highlighted:
 
      
      	 [bookmark: pgfId-1534696]Blue indicates that the highlighted setting is different in the two policies or policy revisions, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-1534697]Green indicates that the highlighted setting appears in one policy or policy revision but not the other.
 
     
 
      
       
        
        [bookmark: pgfId-1534705]Table 20-4 [bookmark: 91381]Intrusion Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534709]To... 
          
  
         	 
           
           [bookmark: pgfId-1534711]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1534713]navigate individually through changes
  
         	[bookmark: pgfId-1534715]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-1534732]generate a new intrusion policy comparison view
  
         	[bookmark: pgfId-1534734]click New Comparison.
 [bookmark: pgfId-1534737]The Select Comparison window appears. See Using the Intrusion Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-1534740]generate an intrusion policy comparison report
  
         	[bookmark: pgfId-1534742]click Comparison Report. 
 [bookmark: pgfId-1534743]The policy comparison report creates a PDF that lists only the differences between the two policies or policy revisions.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1534748][bookmark: 17664]Using the Intrusion Policy C[bookmark: marker-1534747]omparison Report
 
     [bookmark: pgfId-1534755]License: Protection
 
     [bookmark: pgfId-1534756]An intrusion policy comparison report is a record of all differences between two intrusion policies or two revisions of the same intrusion policy identified by the intrusion policy comparison view, presented as a PDF. You can use this report to further examine the differences between two intrusion policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-1534757]You can generate an intrusion policy comparison report from the comparison view for any intrusion policies to which you have access. Remember to commit any potential changes before you generate an intrusion policy report; only committed changes appear in the report.
 
     [bookmark: pgfId-1534758]The format of the intrusion policy comparison report is the same as the intrusion policy report with one exception: the intrusion policy report contains all settings in the intrusion policy, and the intrusion policy comparison report lists only those settings which differ between the policies.
 
     [bookmark: pgfId-1534759]Depending on your configuration, an intrusion policy comparison report can contain one or more sections as described in the Intrusion Policy Report Sections table.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534913]Tip You can use a similar procedure to compare access control, network analysis, file, or system policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534776]To compare two intrusion policies or two revisions of the same policy:
 
     
 
     [bookmark: pgfId-1574043]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1534782]The Intrusion Policy page appears.
 
     [bookmark: pgfId-1534783]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-1534784]The Select Comparison window appears.
 
     [bookmark: pgfId-1534785]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-1534786]To compare two different policies, select  Other Policy .
 
       	 [bookmark: pgfId-1534787]To compare two revisions of the same policy, select  Other Revision .
 
      
 
     
 
     [bookmark: pgfId-1534788]Remember to commit any changes before you generate an intrusion policy report; only committed changes appear in the report.
 
     [bookmark: pgfId-1534789]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1534790]If you are comparing two different policies, select the policies you want to compare from the  Policy A  and  Policy B  drop-down lists.
 
       	 [bookmark: pgfId-1534791]If you are comparing two revisions of the same policy, select the policy from the  Policy drop-down list, then select the revisions you want to compare from the  Revision A  and  Revision B  drop-down lists.
 
      
 
     
 
     [bookmark: pgfId-1534792]Step 5 Click OK to display the intrusion policy comparison view.
 
     [bookmark: pgfId-1534793]The comparison view appears.
 
     [bookmark: pgfId-1534794]Step 6 Click Comparison Report to generate the intrusion policy comparison report. 
 
     [bookmark: pgfId-1534795]Step 7 The intrusion policy report appears. You are prompted to save the report to your computer.
 
     [bookmark: pgfId-1534796]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1531775][bookmark: 28486]Tuning Intrusion Policies Using Ru[bookmark: marker-1557611][bookmark: marker-1557612]les 
      
      
 
     
 
 
    [bookmark: pgfId-1533610]You can use the Rules page in an intrusion policy to configure rule states and other settings for shared object rules, standard text rules, and preprocessor rules.
 
    [bookmark: pgfId-1533615]You enable a rule by setting its rule state to Generate Events or to Drop and Generate Events. Enabling a rule causes the system to generate events on traffic matching the rule. Disabling a rule stops processing of the rule. Optionally, you can set your intrusion policy so that a rule set to Drop and Generate Events in an inline deployment generates events on, and drops, matching traffic. See Setting Drop Behavior in an Inline Deployment for more information. In a passive deployment, a rule set to Drop and Generate Events just generates events on matching traffic.
 
    [bookmark: pgfId-1533620]You can filter rules to display a subset of rules, enabling you to select the exact set of rules where you want to change rule states or rule settings.
 
    [bookmark: pgfId-1568255]When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s user interface. For more information, see Limitations of Custom Policies.
 
    [bookmark: pgfId-1533622]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1533626]Understanding Intrusion Prevention Rule Types describes the intrusion rules and preprocessor rules you can view and configure in an intrusion policy.
 
     	 [bookmark: pgfId-1533630]Viewing Rules in an Intrusion Policy describes how you can change the order of rules on the Rules page, interpret the icons on the page, and focus in on rule details.
 
     	 [bookmark: pgfId-1533634]Filtering Rules in an Intrusion Policy describes how you can use rule filters to find the rules for which you want to apply rule settings.
 
     	 [bookmark: pgfId-1533638]Setting Rule States describes how to enable and disable rules from the Rules page.
 
     	 [bookmark: pgfId-1533642]Filtering Intrusion Event Notification Per Policy explains how to set event filtering thresholds for specific rules and set suppression on specific rules.
 
     	 [bookmark: pgfId-1533646]Adding Dynamic Rule States explains how to set rule states that trigger dynamically when rate anomalies are detected in matching traffic. 
 
     	 [bookmark: pgfId-1533650]Adding SNMP Alerts describes how to associate SNMP alerts with specific rules.
 
     	 [bookmark: pgfId-1533583]Adding Rule Comments describes how to add comments to rules in an intrusion policy.
 
    
 
   
 
    
     [bookmark: pgfId-1532200][bookmark: 72332]Understanding Intrusion Prevention Rule Types
 
    [bookmark: pgfId-1533841]License: Protection
 
    [bookmark: pgfId-1533842]An intrusion policy contains two types of rules: intrusion rules and preprocessor rules.
 
    [bookmark: pgfId-1533843]An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network; an intrusion rule analyzes network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers. The system includes two types of intrusion rules created by the Cisco Vulnerability Research Team (VRT): shared object rules, which are compiled and cannot be modified (except for rule header information such as source and destination ports and IP addresses), and standard text rules, which can be saved and modified as new custom instances of the rule.
 
    [bookmark: pgfId-1533853]The system also includes preprocessor rules, which are rules associated with preprocessor and packet decoder detection options. You cannot copy or edit preprocessor rules. Most preprocessor rules are disabled by default and must be enabled (that is, set to Generate Events or to Drop and Generate Events) if you want the system to generate events for preprocessor rules and, in an inline deployment, drop offending packets.
 
    [bookmark: pgfId-1534580]The VRT determines the default rule states of Cisco’s shared object rules, standard text rules, and preprocessor rules for each default intrusion policy included with the system.
 
     
      
       
       [bookmark: pgfId-1535114]Table 21-1 [bookmark: 45846]Rule types
 
       
       
        
        	 
          
          [bookmark: pgfId-1535118]Type 
         
  
        	 
          
          [bookmark: pgfId-1535120]Description 
         
  
       
 
        
        	[bookmark: pgfId-1535227][bookmark: marker-1535223]shared object rule
  
        	[bookmark: pgfId-1535124]An intrusion rule created by the Cisco Vulnerability Research Team (VRT) that is delivered as a binary module compiled from C source code. You can use shared object rules to detect attacks in ways that standard text rules cannot. You cannot modify the rule keywords and arguments in a shared object rule; you are limited to either modifying variables used in the rule, or modifying aspects such as the source and destination ports and IP addresses and saving a new instance of the rule as a custom shared object rule. A shared object rule has a GID (generator ID) of 3. See Modifying Existing Rules for more information.
  
       
 
        
        	[bookmark: pgfId-1535201][bookmark: marker-1535197]standard text rule
  
        	[bookmark: pgfId-1535128]An intrusion rule either created by the VRT, copied and saved as a new custom rule, created using the rule editor, or imported as a local rule that you create on a local machine and import. You cannot modify the rule keywords and arguments in a standard rule created by the VRT; you are limited to either modifying variables used in the rule, or modifying aspects such as the source and destination ports and IP addresses and saving a new instance of the rule as a custom standard text rule. See Modifying Existing Rules, Understanding and Writing Intrusion Rules and Importing Local Rule Files for more information. A standard text rule created by the VRT has a GID (generator ID) of 1. Custom standard text rules that you create using the rule editor or import as local rules have a SID (Signature ID) of 1000000 or greater.
  
       
 
        
        	[bookmark: pgfId-1535250]pre[bookmark: marker-1535249]processor rule
  
        	[bookmark: pgfId-1535450]A rule associated with a detection option of the packet decoder or with one of the preprocessors included with the ASA FirePOWER module. You must enable preprocessor rules if you want them to generate events. These rules have a decoder- or preprocessor-specific GID (generator ID).
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1548592][bookmark: 93476]Viewing Rules in an Intrusion Po[bookmark: marker-1548591]licy
 
    [bookmark: pgfId-1535550]License: Protection
 
    [bookmark: pgfId-1535551]You can adjust how rules are displayed in the intrusion policy, and can sort rules by several criteria. You can also display the details for a specific rule to see rule settings, rule documentation, and other rule specifics. 
 
    [bookmark: pgfId-1535552]The Rules page has four primary areas of functionality: 
 
     
     	 [bookmark: pgfId-1535556]the filtering features—for more information, see Filtering Rules in an Intrusion Policy
 
     	 [bookmark: pgfId-1535562]the rule attribute menus—for more information, see Setting Rule States, Filtering Intrusion Event Notification Per Policy, Adding Dynamic Rule States, Adding SNMP Alerts, and Adding Rule Comments
 
     	 [bookmark: pgfId-1535576]the rules listing—for more information, see the  Rules Page Columns  table.
 
     	 [bookmark: pgfId-1535580]the rule details—for more information, see Viewing Rule Details
 
    
 
    [bookmark: pgfId-1535583]You can also sort rules by different criteria; for more information, see Sorting the Rule Display.
 ) as the Rule State column. 
    
 
     
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1536764]Table 21-2 [bookmark: 77863]Rules Page Columns
 
       
       
        
        	 
          
          [bookmark: pgfId-1536770]Heading 
         
  
        	 
          
          [bookmark: pgfId-1536772]Description 
         
  
        	 
          
          [bookmark: pgfId-1536774]For more information, see... 
         
  
       
 
        
        	[bookmark: pgfId-1536776]GID
  
        	[bookmark: pgfId-1536778]Integer which indicates the Generator ID (GID) for the rule.
  
        	[bookmark: pgfId-1536782]Viewing Events
  
       
 
        
        	[bookmark: pgfId-1536785]SID
  
        	[bookmark: pgfId-1536787]Integer which indicates the Snort ID (SID), which acts a unique identifier for the rule.
  
        	[bookmark: pgfId-1536791]Viewing Events
  
       
 
        
        	[bookmark: pgfId-1536794]Message
  
        	[bookmark: pgfId-1536796]Message included in events generated by this rule, which also acts as the name of the rule.
  
        	[bookmark: pgfId-1536800]Defining the Event Message
  
       
 
       
          
        	[bookmark: pgfId-1536808]The rule state for the rule, which may be one of three states:
 
          
          	 [bookmark: pgfId-1536812]drop and generate events (
 
          [image: ] ) 
         
 
          
          	 [bookmark: pgfId-1536816]generate events (
 
          [image: ] ) 
         
 
          
          	 [bookmark: pgfId-1536820]disable (
 
          [image: ] ) 
         
 [bookmark: pgfId-1536822]Note that you can access the Set rule state dialog box for a rule by clicking on its rule state icon.
  
        	[bookmark: pgfId-1536826]Setting Rule States
  
       
 
       
          
        	[bookmark: pgfId-1536849]Event filter, including event thresholds and event suppression, applied to the rule.
  
        	[bookmark: pgfId-1536853]Filtering Intrusion Event Notification Per Policy
  
       
 
       
          
        	[bookmark: pgfId-1536931]Dynamic rule state for the rule, which goes into effect if specified rate anomalies occur.
  
        	[bookmark: pgfId-1536955]Adding Dynamic Rule States
  
       
 
       
          
        	[bookmark: pgfId-1537011]Alerts configured for the rule (currently SNMP alerts only).
  
        	[bookmark: pgfId-1537036]Adding SNMP Alerts
  
       
 
       
          
        	[bookmark: pgfId-1537083]Comments added to the rule.
  
        	[bookmark: pgfId-1537107]Adding Rule Comments
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1537132]You can also use the layer drop-down list to switch to the Rules page for other layers in your policy. Note that, unless you add layers to your policy, the only editable views listed in the drop-down list are the policy Rules page and the Rules page for a policy layer that is originally named My Changes; note also that making changes in one of these views is the same as making the changes in the other. See Using Layers in a Network Analysis or Intrusion Policy for more information. The drop-down list also lists the Rules page for the read-only base policy. See Understanding the Base Layer for information on the base policy.
 
    [bookmark: pgfId-1537177]To view the rules in an intrusion policy:
 
    
 
    [bookmark: pgfId-1579811]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1579772]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1537188]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1537192]The Policy Information page appears.
 
    [bookmark: pgfId-1537194]Step 3 [bookmark: 81363]Click Rules on the Policy Information page.
 
    [bookmark: pgfId-1537195]The Rules page appears. By default, the page lists the rules alphabetically by message.
 
    [bookmark: pgfId-1537196]Note that selecting Rules above the dividing line in the navigation panel takes you to the same rules listing. You can view and set all rule attributes in your policy in this view.
 
    [bookmark: pgfId-1537197]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1548606][bookmark: 38424]Sorting the [bookmark: marker-1548605]Rule Display
 
     [bookmark: pgfId-1537291]License: Protection
 
     [bookmark: pgfId-1537292]You can sort rules by any of the columns in the Rules page by clicking on the heading title or icon. 
 ) arrow on a heading or icon indicates that the sort is on that column in that direction. 
     
 
     [bookmark: pgfId-1537300]To sort rules in an intrusion policy:
 
     
 
     [bookmark: pgfId-1579828]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1537306]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1537311]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1537315]The Policy Information page appears.
 
     [bookmark: pgfId-1537317]Step 3 [bookmark: 53178]Click Rules.
 
     [bookmark: pgfId-1537318]The Rules page appears. By default, the page lists the rules alphabetically by message.
 
     [bookmark: pgfId-1537319]Step 4 Click the title or icon in the top of the column you want to sort by.
 
     [bookmark: pgfId-1537320]The rules are sorted by the column, in the direction indicated by the arrow that appears on the column heading. To sort in the opposite direction, click the heading again. The sort order and the arrow reverse.
 
     [bookmark: pgfId-1537321]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537325][bookmark: 18580]Viewing R[bookmark: marker-1537323][bookmark: marker-1537324]ule Details
 
     [bookmark: pgfId-1537332]License: Protection
 
     [bookmark: pgfId-1537336]You can view rule documentation and rule overhead from the Rule Detail view. You can also view and add rule-specific features.
 
      
       
        
        [bookmark: pgfId-1537343]Table 21-3 Rule Details 
 
        
        
         
         	 
           
           [bookmark: pgfId-1537349]Item 
          
  
         	 
           
           [bookmark: pgfId-1537351]Description 
          
  
         	 
           
           [bookmark: pgfId-1537353]For more information, see... 
          
  
        
 
         
         	[bookmark: pgfId-1537355]Summary
  
         	[bookmark: pgfId-1537357]The rule summary. For rule-based events, this row appears when the rule documentation contains summary information. 
  
         	[bookmark: pgfId-1537362]Viewing Events
  
        
 
         
         	[bookmark: pgfId-1537364]Rule State
  
         	[bookmark: pgfId-1537366]The current rule state for the rule. Also indicates the layer where the rule state is set.
  
         	[bookmark: pgfId-1537373]Setting Rule States; Using Layers in a Network Analysis or Intrusion Policy
  
        
 
         
         	[bookmark: pgfId-1537400]Thresholds
  
         	[bookmark: pgfId-1537402]Thresholds currently set for this rule, as well as the facility to add a threshold for the rule.
  
         	[bookmark: pgfId-1537407]Setting a Threshold for a Rule
  
        
 
         
         	[bookmark: pgfId-1537409]Suppressions
  
         	[bookmark: pgfId-1537411]Suppression settings currently set for this rule, as well as the facility to add suppressions for the rule.
  
         	[bookmark: pgfId-1537416]Setting Suppression for a Rule
  
        
 
         
         	[bookmark: pgfId-1537418]Dynamic State
  
         	[bookmark: pgfId-1537420]Rate-based rule states currently set for this rule, as well as the facility to add dynamic rule states for the rule.
  
         	[bookmark: pgfId-1537425]Setting a Dynamic Rule State for a Rule
  
        
 
         
         	[bookmark: pgfId-1537427]Alerts
  
         	[bookmark: pgfId-1537429]Alerts currently set for this rule, as well as the facility to add an alert for the rule. Currently, only SNMP alerts are supported.
  
         	[bookmark: pgfId-1537439]Setting an SNMP Alert for a Rule
  
        
 
         
         	[bookmark: pgfId-1537441]Comments
  
         	[bookmark: pgfId-1537443]Comments added to this rule, as well as the facility to add comments for the rule.
  
         	[bookmark: pgfId-1537448]Adding a Rule Comment for a Rule
  
        
 
         
         	[bookmark: pgfId-1537450]Documentation
  
         	[bookmark: pgfId-1537452]The rule documentation for the current rule, supplied by the Cisco Vulnerability Research Team (VRT).
  
         	[bookmark: pgfId-1537460]Viewing Events
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1537462]To view rule details:
 
     
 
     [bookmark: pgfId-1579849]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1537468]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1537473]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1537477]The Policy Information page appears.
 
     [bookmark: pgfId-1537479]Step 3 [bookmark: 67092]Click Rules.
 
     [bookmark: pgfId-1537480]The Rules page appears. By default, the page lists the rules alphabetically by message.
 
     [bookmark: pgfId-1537481]Step 4 Highlight the rule whose rule details you want to view.
 
     [bookmark: pgfId-1537482]Step 5 Click Show details.
 
     [bookmark: pgfId-1537483]The Rule Detail view appears. To hide the details again, click Hide details.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537484]Tip You can also open Rule Detail by double-clicking a rule in the Rules view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537485]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537488][bookmark: 25931]Setting a Threshold fo[bookmark: marker-1537487]r a Rule
 
     [bookmark: pgfId-1537495]License: Protection
 
     [bookmark: pgfId-1537496]You can set a single threshold for a rule from the Rule Detail page. Adding a threshold overwrites any existing threshold for the rule. For more information on thresholding, see Configuring Event Thresholding.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1537504]To set a threshold from the rule details:
 
     
 
     [bookmark: pgfId-1537509]Step 1 Click Add next to Thresholds.
 
     [bookmark: pgfId-1537510]The Set Threshold dialog box appears.
 
     [bookmark: pgfId-1537511]Step 2 From the Type drop-down list, select the type of threshold you want to set:
 
      
       
       	 [bookmark: pgfId-1537512]Select  Limit to limit notification to the specified number of event instances per time period.
 
       	 [bookmark: pgfId-1537513]Select  Threshold to provide notification for each specified number of event instances per time period.
 
       	 [bookmark: pgfId-1537514]Select  Both to provide notification once per time period after a specified number of event instances.
 
      
 
     
 
     [bookmark: pgfId-1537515]Step 3 From the Track By drop-down list, select Source or Destination to indicate whether you want the event instances tracked by source or destination IP address.
 
     [bookmark: pgfId-1537516]Step 4 In the Count field, type the number of event instances you want to use as your threshold.
 
     [bookmark: pgfId-1537517]Step 5 In the Seconds field, type a number between 0 and 2147483647 that specifies the time period, in seconds, for which event instances are tracked.
 
     [bookmark: pgfId-1537518]Step 6 Click OK.
 ) next to the rule in the Event Filtering column. If you add multiple event filters to a rule, the system includes an indication over the icon of the number of event filters. 
     
 
     [bookmark: pgfId-1537523]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537526][bookmark: 97473]Setting Suppression f[bookmark: marker-1537525]or a Rule
 
     [bookmark: pgfId-1537533]License: Protection
 
     [bookmark: pgfId-1537534]You can set one or more suppressions for a rule from the Rule Detail page. For more information on suppression, see Configuring Suppression Per Intrusion Policy.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1537542]To set suppression from the rule details:
 
     
 
     [bookmark: pgfId-1537547]Step 1 Click Add next to Suppressions.
 
     [bookmark: pgfId-1537548]The Add Suppression dialog box appears.
 
     [bookmark: pgfId-1537549]Step 2 From the Suppression Type drop-down list, select one of the following options:
 
      
       
       	 [bookmark: pgfId-1537550]Select  Rule to completely suppress events for a selected rule.
 
       	 [bookmark: pgfId-1537551]Select  Source to suppress events generated by packets originating from a specified source IP address.
 
       	 [bookmark: pgfId-1537552]Select  Destination to suppress events generated by packets going to a specified destination IP address.
 
      
 
     
 
     [bookmark: pgfId-1537553]Step 3 If you selected Source or Destination for the suppression type, the Network field appears. In the Network field, enter the IP address, an address block, or a comma-separated list comprised of any combination of these. If the intrusion policy is associated with the default action of an access control policy, you can also specify or list a network variable in the default action variable set. 
 
     [bookmark: pgfId-1537557]For information on using IPv4 CIDR and IPv6 prefix length address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1537561]Step 4 Click OK.
 ) next to the rule in the Event Filtering column next the suppressed rule. If you add multiple event filters to a rule, a number over the icon indicates the number of filters. 
     
 
     [bookmark: pgfId-1537566]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1548627][bookmark: 29052]Setting a Dynamic Ru[bookmark: marker-1548623][bookmark: marker-1548624]le Sta[bookmark: marker-1548625]te f[bookmark: marker-1548626]or a Rule
 
     [bookmark: pgfId-1538169]License: Protection
 
     [bookmark: pgfId-1538170]You can set one or more dynamic rule states for a rule from the Rule Detail page. The first dynamic rule state listed has the highest priority. Note that when two dynamic rule states conflict, the action of the first is carried out. For more information on dynamic rule states, see Understanding Dynamic Rule States.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1538178]To set a dynamic rule state from the rule details:
 
     
 
     [bookmark: pgfId-1538183]Step 1 Click Add next to Dynamic State.
 
     [bookmark: pgfId-1538184]The Add Rate-Based Rule State dialog box appears.
 
     [bookmark: pgfId-1538185]Step 2 From the Track By drop-down list, select an option to indicate how you want the rule matches tracked: 
 
      
       
       	 [bookmark: pgfId-1538186]Select  Source to track the number of hits for that rule from a specific source or set of sources. 
 
       	 [bookmark: pgfId-1538187]Select  Destination to track the number of hits for that rule to a specific destination or set of destinations. 
 
       	 [bookmark: pgfId-1538188]Select  Rule to track all matches for that rule.
 
      
 
     
 
     [bookmark: pgfId-1538189]Step 3 Optionally, if you set Track By to Source or Destination, enter the IP address of each host you want to track in the Network field.
 
     [bookmark: pgfId-1538195]For information on using IPv4 CIDR and IPv6 prefix length notation, see IP Address Conventions.
 
     [bookmark: pgfId-1538197]Step 4 Next to Rate, indicate the number of rule matches per time period to set the attack rate:
 
      
       
       	 [bookmark: pgfId-1538198]In the  Count field, using an integer between 0 and 2147483647, specify the number of rule matches you want to use as your threshold.
 
       	 [bookmark: pgfId-1538199]In the  Seconds field, using an integer between 0 and 2147483647, specify the number of seconds that make up the time period for which attacks are tracked.
 
      
 
     
 
     [bookmark: pgfId-1538200]Step 5 From the New State drop-down list, select the new action to be taken when the conditions are met:
 
      
       
       	 [bookmark: pgfId-1538201]Select  Generate Events  to generate an event.
 
       	 [bookmark: pgfId-1538202]Select  Drop and Generate Events  to generate an event and drop the packet that triggered the event in inline deployments or to generate an event in passive deployments.
 
       	 [bookmark: pgfId-1538203]Select  Disabled  to take no action.
 
      
 
     
 
     [bookmark: pgfId-1538204]Step 6 In the Timeout field, using an integer between 1 and 2147483647 (approximately 68 years), type the number of seconds you want the new action to remain in effect. After the timeout occurs, the rule reverts to its original state. Specify 0 to prevent the new action from timing out.
 
     [bookmark: pgfId-1538205]Step 7 Click OK.
 ) next to the rule in the Dynamic State column. If you add multiple dynamic rule state filters to a rule, a number over the icon indicates the number of filters. 
     
 
     [bookmark: pgfId-1538210]If any required fields are blank, you receive an error message indicating which fields you must fill.
 
     [bookmark: pgfId-1538211]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1538216][bookmark: 44947]Setting an SNMP A[bookmark: marker-1538213]lert f[bookmark: marker-1538214]or a[bookmark: marker-1538215] Rule
 
     [bookmark: pgfId-1538223]License: Protection
 
     [bookmark: pgfId-1538224]You can set an SNMP alert for a rule from the Rule Detail page. For more information on SNMP alerts, see Adding SNMP Alerts.
 
     [bookmark: pgfId-1538228]To add an SNMP alert from the rule details:
 
     
 
     [bookmark: pgfId-1538233]Step 1 Click Add SNMP Alert next to Alerts.
 ) next to the rule in the Alerting column. If you add multiple alerts to a rule, the system includes an indication over the icon of the number of alerts. 
     
 
     [bookmark: pgfId-1538238]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1548739][bookmark: 12931]Adding a Rule Comment for a[bookmark: marker-1548737][bookmark: marker-1548738] Rule
 
     [bookmark: pgfId-1538631]License: Protection
 
     [bookmark: pgfId-1538632]You can add a rule comment for a rule from the Rule Detail page. For more information on rule comments, see Adding Rule Comments. 
 
     [bookmark: pgfId-1538636]To add a comment from the rule details:
 
     
 
     [bookmark: pgfId-1538641]Step 1 Click Add next to Comments.
 
     [bookmark: pgfId-1538642]The Add Comment dialog box appears.
 
     [bookmark: pgfId-1538643]Step 2 In the Comment field, type the rule comment.
 
     [bookmark: pgfId-1538644]Step 3 Click OK.
 ) next to the rule in the Comments column. If you add multiple comments to a rule, a number over the icon indicates the number of comments. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1538649]Tip To delete a rule comment, click Delete in the rule comments section. Note that you can only delete a comment if the comment is cached with uncommitted intrusion policy changes. After intrusion policy changes are committed, the rule comment is permanent.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1538650]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1548864][bookmark: 72678]Filtering Rules in an I[bookmark: marker-1548862]ntrusion Policy
 
    [bookmark: pgfId-1538788]License: Protection
 
    [bookmark: pgfId-1538790]You can filter the rules you display on the Rules page by a single criteria, or a combination of one or more criteria. 
 
    [bookmark: pgfId-1538791]The filter you construct is shown in the Filter text box. You can click keywords and keyword arguments in the filter panel to construct a filter. When you select multiple keywords, the system combines them using AND logic to create a compound search filter. For example, if you select preprocessor under Category and then select Rule Content > GID and enter 116, you get a filter of Category: “preprocessor” GID:”116” which retrieves all rules that are preprocessor rules and have a GID of 116.
 
    [bookmark: pgfId-1538792]The Category, Microsoft Vulnerabilities, Microsoft Worms, Platform Specific, Preprocessor, and Priority filter groups allow you to submit more than one argument for a keyword, separated by commas. For example, you can press Shift and then select os-linux and os-windows from Category to produce the filter Category:"os-windows,os-linux", which retrieves any rules in the os-linux category or in the os-windows category.
 ). 
    
 ). 
    
 
    [bookmark: pgfId-1538801]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-1538805]Understanding Rule Filtering in an Intrusion Policy
 
     	 [bookmark: pgfId-1538809]Setting a Rule Filter in an Intrusion Policy
 
    
 
     
      [bookmark: pgfId-1548878][bookmark: 38233]Understanding Rule Filtering in an Intrusion Po[bookmark: marker-1548877]licy
 
     [bookmark: pgfId-1538942]License: Protection
 
     [bookmark: pgfId-1538943]Rule filter keywords help you find the rules for which you want to apply rule settings, such as rule states or event filters. You can filter by a keyword and simultaneously select the argument for the keyword by selecting the argument you want from the Rules page filter panel.
 
     [bookmark: pgfId-1538944]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1538948]Guidelines for Constructing Intrusion Policy Rule Filters
 
      	 [bookmark: pgfId-1538952]Understanding Rule Configuration Filters
 
      	 [bookmark: pgfId-1538956]Understanding Rule Content Filters
 
      	 [bookmark: pgfId-1538960]Understanding Rule Categories
 
      	 [bookmark: pgfId-1538964]Editing a Rule Filter Directly
 
     
 
    
 
     
      [bookmark: pgfId-1532211][bookmark: 33103]Guidelines for Constructing Intrusion Policy Rule Filters
 
     [bookmark: pgfId-1539036]License: Protection
 
     [bookmark: pgfId-1539037]In most cases, when you are building a filter, you can use the filter panel to the left of the Rules page in the intrusion policy to select the keywords/arguments you want to use. 
 
     [bookmark: pgfId-1539038]Rule filters are grouped into rule filter groups in the filter panel. Many rule filter groups contain sub-criteria so that you can more easily find the specific rules you are looking for. Some rule filters have multiple levels that you can expand to drill down to individual rules. 
 
     [bookmark: pgfId-1539039]Items in the filter panel sometimes represent filter type groups, sometimes represent keywords, and sometimes represent the argument to a keyword. Use the following rules of thumb to help you build your filters: 
 
      
      	 [bookmark: pgfId-1539040]When you select a filter type group heading that is not a keyword (Rule Configuration, Rule Content, Platform Specific, and Priority), it expands to list the available keywords. 
 
     
 
     [bookmark: pgfId-1539041]When you select a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by. 
 
     [bookmark: pgfId-1539042]If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword. 
 
      
      	 [bookmark: pgfId-1539044]When you select a filter type group heading that is a keyword (Category, Classifications, Microsoft Vulnerabilities, Microsoft Worms, Priority, and Rule Update), it lists the available arguments. 
 
     
 
     [bookmark: pgfId-1539045]When you select an item from this type of group, the argument and the keyword it applies to are immediately added to the filter. If the keyword is already in the filter, it replaces the existing argument for the keyword that corresponds to that group. 
 
     [bookmark: pgfId-1539046]For example, if you click os-linux under Category in the filter panel, Category:"os-linux" is added to the filter text box. If you then click os-windows under Category, the filter changes to Category:"os-windows".
 
      
      	 [bookmark: pgfId-1539047]Reference under Rule Content is a keyword, and so are the specific reference ID types listed below it. When you select any of the reference keywords, a pop-up window appears, where you supply an argument and the keyword is added to the existing filter. If the keyword is already in use in the filter, the new argument you supply replaces the existing argument.
 
     
 
     [bookmark: pgfId-1539048]For example, if you click Rule Content > Reference > CVE ID in the filter panel, a pop-up window prompts you to supply the CVE ID. If you enter 2007, then CVE:”2007” is added to the filter text box. In another example, if you click Rule Content > Reference in the filter panel, a pop-up window prompts you to supply the reference. If you enter 2007, then Reference:”2007” is added to the filter text box. 
 
      
      	 [bookmark: pgfId-1539049]When you select rule filter keywords from different groups, each filter keyword is added to the filter and any existing keywords are maintained (unless overridden by a new value for the same keyword). 
 
     
 
     [bookmark: pgfId-1539050]For example, if you click os-linux under Category in the filter panel, Category:"os-linux" is added to the filter text box. If you then click MS00-006 under Microsoft Vulnerabilities, the filter changes to Category:"os-linux" MicrosoftVulnerabilities:"MS00-006".
 
      
      	 [bookmark: pgfId-1539051]When you select multiple keywords, the system combines them using AND logic to create a compound search filter. For example, if you select  preprocessor under  Category and then select  Rule Content > GID  and enter  116 , you get a filter of  Category: “preprocessor” GID:”116” , which retrieves all rules that are preprocessor rules  and have a GID of 116.
 
      	 [bookmark: pgfId-1539052]The Category, Microsoft Vulnerabilities, Microsoft Worms, Platform Specific, and Priority filter groups allow you to submit more than one argument for a keyword, separated by commas. For example, you can press Shift and then select  os-linux and  os-windows from  Category to produce the filter  Category:"os-windows,app-detect" , which retrieves any rules in the  os-linux category or in the  os-windows category.
 
     
 
     [bookmark: pgfId-1532356]The same rule may be retrieved by more than one filter keyword/argument pair. For example, the DOS Cisco attempt rule (SID 1545) appears if rules are filtered by the dos category, and also if you filter by the High priority.
 
      
       
     
 
     
 
     [bookmark: pgfId-1539220]Note The Cisco VRT may use the rule update mechanism to add and remove rule filters.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1556461]Table 21-4 [bookmark: 32731]Rule Filter Groups 
 
        
        
         
         	 
           
           [bookmark: pgfId-1556471]Filter Group 
          
  
         	 
           
           [bookmark: pgfId-1556473]Description 
          
  
         	 
           
           [bookmark: pgfId-1556475]Multiple Argument Support? 
          
  
         	 
           
           [bookmark: pgfId-1556477]Heading is... 
          
  
         	 
           
           [bookmark: pgfId-1556479]Items in List are... 
          
  
        
 
         
         	[bookmark: pgfId-1556481]Rule Configuration
  
         	[bookmark: pgfId-1556483]Finds rules according to the configuration of the rule. See Understanding Rule Configuration Filters.
  
         	[bookmark: pgfId-1556488]No
  
         	[bookmark: pgfId-1556490]A grouping
  
         	[bookmark: pgfId-1556492]keywords
  
        
 
         
         	[bookmark: pgfId-1556494]Rule Content
  
         	[bookmark: pgfId-1556496]Finds rules according to the content of the rule. See Understanding Rule Content Filters.
  
         	[bookmark: pgfId-1556501]No
  
         	[bookmark: pgfId-1556503]A grouping
  
         	[bookmark: pgfId-1556505]keywords
  
        
 
         
         	[bookmark: pgfId-1556507]Category
  
         	[bookmark: pgfId-1556509]Finds rules according to the rule categories used by the rule editor. Note that local rules appear in the local sub-group. See Understanding Rule Categories.
  
         	[bookmark: pgfId-1556514]Yes
  
         	[bookmark: pgfId-1556516]A keyword
  
         	[bookmark: pgfId-1556518]arguments
  
        
 
         
         	[bookmark: pgfId-1556520]Classifications
  
         	[bookmark: pgfId-1556522]Finds rules according to the attack classification that appears in the packet display of an event generated by the rule. See Defining the Intrusion Event Classification.
  
         	[bookmark: pgfId-1556530]No
  
         	[bookmark: pgfId-1556532]A keyword
  
         	[bookmark: pgfId-1556534]arguments
  
        
 
         
         	[bookmark: pgfId-1556536]Microsoft Vulnerabilities
  
         	[bookmark: pgfId-1556538]Finds rules according to Microsoft bulletin number.
  
         	[bookmark: pgfId-1556540]Yes
  
         	[bookmark: pgfId-1556542]A keyword
  
         	[bookmark: pgfId-1556544]arguments
  
        
 
         
         	[bookmark: pgfId-1556546]Microsoft Worms
  
         	[bookmark: pgfId-1556548]Finds rules based on specific worms that affect Microsoft Windows hosts.
  
         	[bookmark: pgfId-1556550]Yes
  
         	[bookmark: pgfId-1556552]A keyword
  
         	[bookmark: pgfId-1556554]arguments
  
        
 
         
         	[bookmark: pgfId-1556556]Platform Specific
  
         	[bookmark: pgfId-1556558]Finds rules according to their relevance to specific versions of operating systems. 
 [bookmark: pgfId-1556559]Note that a rule may affect more than one operating system or more than one version of an operating system. For example, enabling SID 2260 affects multiple versions of Mac OS X, IBM AIX, and other operating systems.
  
         	[bookmark: pgfId-1556561]Yes
  
         	[bookmark: pgfId-1556563]A keyword
  
         	[bookmark: pgfId-1556565]arguments
 [bookmark: pgfId-1556566]Note that if you pick one of the items from the sub-list, it adds a modifier to the argument.
  
        
 
         
         	[bookmark: pgfId-1556568]Preprocessors
  
         	[bookmark: pgfId-1556570]Finds rules for individual preprocessors.
 [bookmark: pgfId-1556571]Note that you must enable preprocessor rules associated with a preprocessor option to generate events for the option when the preprocessor is enabled; see Setting Rule States.
  
         	[bookmark: pgfId-1556576]Yes
  
         	[bookmark: pgfId-1556578]A grouping
  
         	[bookmark: pgfId-1556580]sub-groupings
  
        
 
         
         	[bookmark: pgfId-1556582]Priority
  
         	[bookmark: pgfId-1556584]Finds rules according to high, medium, and low priorities.
 [bookmark: pgfId-1556585]The classification assigned to a rule determines its priority. These groups are further grouped into rule categories. Note that local rules (that is, rules that you create) do not appear in the priority groups.
  
         	[bookmark: pgfId-1556587]Yes
  
         	[bookmark: pgfId-1556589]A keyword
  
         	[bookmark: pgfId-1556591]arguments
 [bookmark: pgfId-1556592]Note that if you pick one of the items from the sub-list, it adds a modifier to the argument.
  
        
 
         
         	[bookmark: pgfId-1556594]Rule Update
  
         	[bookmark: pgfId-1556596]Finds rules added or modified through a specific rule update. For each rule update, view all rules in the update, only new rules imported in the update, or only existing rules changed by the update.
  
         	[bookmark: pgfId-1556598]No
  
         	[bookmark: pgfId-1556600]A keyword
  
         	[bookmark: pgfId-1556602]arguments
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1532212][bookmark: 21239]Understanding Rule Configuration Filters
 
     [bookmark: pgfId-1539495]License: Protection
 
     [bookmark: pgfId-1539496]You can filter the rules listed in the Rules page by several rule configuration settings.
 
     [bookmark: pgfId-1539497]When you select a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by. 
 
     [bookmark: pgfId-1539498]If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword. 
 
     [bookmark: pgfId-1539500]See the following procedures for more information on the rule configuration settings you can use to filter.
 
     [bookmark: pgfId-1539502][bookmark: 80286]To use the Rule State filter:
 
     
 
     [bookmark: pgfId-1539507]Step 1 Under Rule Configuration, click Rule State.
 
     [bookmark: pgfId-1539508]Step 2 From the Rule State drop-down list, select the rule state to filter by: 
 
      
       
       	 [bookmark: pgfId-1539509]To find rules that only generate events, select  Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539510]To find rules that are set to generate events and drop the matching packet, select  Drop and Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539511]To find disabled rules, select  Disabled , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539513]The Rules page updates to display rules according to current rule state.
 
     [bookmark: pgfId-1539514]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539527]To use the Threshold filter:
 
     
 
     [bookmark: pgfId-1539532]Step 1 Under Rule Configuration, click Threshold.
 
     [bookmark: pgfId-1539533]Step 2 From the Threshold drop-down list, select the threshold setting to filter by: 
 
      
       
       	 [bookmark: pgfId-1539534]To find rules with a threshold type of  limit , select  Limit , then click  OK . 
 
       	 [bookmark: pgfId-1539535]To find rules with a threshold type of  threshold , select  Threshold , then click  OK . 
 
       	 [bookmark: pgfId-1539536]To find rules with a threshold type of  both , select  Both , then click  OK . 
 
       	 [bookmark: pgfId-1539537]To find rules with thresholds tracked by  source , select  Source , then click  OK . 
 
       	 [bookmark: pgfId-1539538]To find rules with thresholds tracked by  destination , select  Destination , then click  OK . 
 
       	 [bookmark: pgfId-1539539]To find any rule with a threshold set, select  All , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539540]The Rules page updates to display rules where the type of threshold indicated in the filter has been applied to the rule.
 
     [bookmark: pgfId-1539541]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1576108]To use the Suppression filter:
 
     
 
     [bookmark: pgfId-1576113]Step 1 Under Rule Configuration, click Suppression.
 
     [bookmark: pgfId-1576114]Step 2 From the Suppression drop-down list, select the suppression setting to filter by: 
 
      
       
       	 [bookmark: pgfId-1539549]To find rules where events are suppressed for packets inspected by that rule, select  By Rule , then click  OK . 
 
       	 [bookmark: pgfId-1539550]To find rules where events are suppressed based on the source of the traffic, select  By Source , then click  OK . 
 
       	 [bookmark: pgfId-1539551]To find rules where events are suppressed based on the destination of the traffic, select  By Destination , then click  OK . 
 
       	 [bookmark: pgfId-1539552]To find any rule with suppression set, select  All , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539553]The Rules page updates to display rules where the type of suppression indicated in the filter has been applied to the rule.
 
     [bookmark: pgfId-1539554]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539555]To use the Dynamic State filter:
 
     
 
     [bookmark: pgfId-1539560]Step 1 Under Rule Configuration, click Dynamic State.
 
     [bookmark: pgfId-1539561]Step 2 From the Dynamic State drop-down list, select the suppression setting to filter by: 
 
      
       
       	 [bookmark: pgfId-1539562]To find rules where a dynamic state is configured for packets inspected by that rule, select  By Rule , then click  OK . 
 
       	 [bookmark: pgfId-1539563]To find rules where a dynamic state is configured for packets based on the source of the traffic, select  By Source , then click  OK . 
 
       	 [bookmark: pgfId-1539564]To find rules where a dynamic state is configured based on the destination of the traffic, select  By Destination , then click  OK . 
 
       	 [bookmark: pgfId-1539565]To find rules where a dynamic state of  Generate Events is configured, select  Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539566]To find rules where a dynamic state of  Drop and Generate Events is configured, select  Drop and Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539567]To find where a dynamic state of  Disabled is configured, select  Disabled , then click  OK . 
 
       	 [bookmark: pgfId-1539568]To find any rule with suppression set, select  All , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539569]The Rules page updates to display rules where the dynamic rule state indicated in the filter has been applied to the rule.
 
     [bookmark: pgfId-1539570]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1540410]To use the Alert filter:
 
     
 
     [bookmark: pgfId-1559829]Step 1 Under Rule Configuration, click Alert.
 
     [bookmark: pgfId-1559830]Step 2 From the Alert drop-down list, select the alert setting to filter by: SNMP.
 
     [bookmark: pgfId-1559872]Step 3 Click OK.
 
     [bookmark: pgfId-1540417]The Rules page updates to display rules where you have applied an alert filter.
 
     [bookmark: pgfId-1540418]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539571]To use the Comment filter:
 
     
 
     [bookmark: pgfId-1539576]Step 1 Under Rule Configuration, click Comment.
 
     [bookmark: pgfId-1539577]Step 2 In the Comment field, type the string of comment text to filter by, then click OK. 
 
     [bookmark: pgfId-1539578]The Rules page updates to display rules where comments applied to the rule contain the string indicated in the filter.
 
     [bookmark: pgfId-1539579]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1539581][bookmark: 45895]Understanding Rule Content Filters
 
     [bookmark: pgfId-1539588]License: Protection
 
     [bookmark: pgfId-1539589]You can filter the rules listed in the Rules page by several rule content items. For example, you can quickly retrieve a rule by searching for the rule’s SID. You can also find all rules that inspect traffic going to a specific destination port. 
 
     [bookmark: pgfId-1539590]When you select a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by. 
 
     [bookmark: pgfId-1539591]If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword.
 
     [bookmark: pgfId-1539592]For example, if you click SID under Rule Content in the filter panel, a pop-up window appears, prompting you to supply a SID. If you type 1045, then SID:”1045”is added to the filter text box. If you then click SID again and change the SID filter to 1044, the filter changes to SID:”1044”.
 
     [bookmark: pgfId-1539593]For more information on the rule content you can use to filter, see the following table.
 
     [bookmark: pgfId-1539696]
 
      
       
        
        [bookmark: pgfId-1539600]Table 21-5 [bookmark: 26184]Rule Content Filters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539606]To use this filter, click... 
          
  
         	 
           
           [bookmark: pgfId-1539608]Then... 
          
  
         	 
           
           [bookmark: pgfId-1539610]Result 
          
  
        
 
         
         	[bookmark: pgfId-1539612]Message
  
         	[bookmark: pgfId-1539614]Type the message string to filter by, then click OK. 
  
         	[bookmark: pgfId-1539616]Finds rules that contain the supplied string in the message field.
  
        
 
         
         	[bookmark: pgfId-1539618]SID
  
         	[bookmark: pgfId-1539620]Type the SID number to filter by, then click OK. 
  
         	[bookmark: pgfId-1539622]Finds rules that have the specified SID.
  
        
 
         
         	[bookmark: pgfId-1539624]GID
  
         	[bookmark: pgfId-1539626]Type the GID number to filter by, then click OK. 
  
         	[bookmark: pgfId-1539628]Finds rules that have the specified GID.
  
        
 
         
         	[bookmark: pgfId-1539630]Reference
  
         	[bookmark: pgfId-1539632]Type the reference string to filter by, then click OK. 
 [bookmark: pgfId-1540981]To enter a string for a specific type of reference that you want to filter by, select CVE ID, URL, Bugtraq ID, Nessus ID, Arachnids ID, or Mcafee ID, then type a string and click OK. 
  
         	[bookmark: pgfId-1539634]Finds rules that contain the supplied string in the reference field.
  
        
 
         
         	[bookmark: pgfId-1539636]Action
  
         	[bookmark: pgfId-1539638]Select the action to filter by: 
 
           
           	 [bookmark: pgfId-1539639]To find alert rules, select  Alert , then click  OK . 
 
           	 [bookmark: pgfId-1539640]To find pass rules, select  Pass , then click  OK . 
 
          
  
         	[bookmark: pgfId-1539642]Finds rules that start with alert or pass.
  
        
 
         
         	[bookmark: pgfId-1539644]Protocol
  
         	[bookmark: pgfId-1539646]Select the protocol to filter by: ICMP, IP, TCP, or UDP; then click OK.
  
         	[bookmark: pgfId-1539648]Finds rules that include the selected protocol.
  
        
 
         
         	[bookmark: pgfId-1539650]Direction
  
         	[bookmark: pgfId-1539652]Select a directional setting to filter by:
 
           
           	 [bookmark: pgfId-1539653]To find rules that inspect traffic moving in a specific direction, select  Directional , then click  OK . 
 
           	 [bookmark: pgfId-1539654]To find rules that inspect traffic moving in either direction between a source and destination, select  Bidirectional , then click  OK .
 
          
  
         	[bookmark: pgfId-1539656]Finds rules based on whether the rule includes the indicated directional setting.
  
        
 
         
         	[bookmark: pgfId-1539658]Source IP
  
         	[bookmark: pgfId-1539660]Type the source IP address to filter by, then click OK. 
 [bookmark: pgfId-1539661]Note that you can filter by a valid IP address, a CIDR block/prefix length, or using variables such as $HOME_NET or $EXTERNAL_NET.
  
         	[bookmark: pgfId-1539663]Finds rules that use the specified addresses or variables for the source IP address designation in the rule.
  
        
 
         
         	[bookmark: pgfId-1539665]Destination IP
  
         	[bookmark: pgfId-1539667]Type the destination IP address to filter by, then click OK. 
 [bookmark: pgfId-1539668]Note that you can filter by a valid IP address, a CIDR block/prefix length, or using variables such as $HOME_NET or $EXTERNAL_NET.
  
         	[bookmark: pgfId-1539670]Finds rules that use the specified addresses or variables for the source IP address designation in the rule.
  
        
 
         
         	[bookmark: pgfId-1539672]Source port
  
         	[bookmark: pgfId-1539674]Type the source port to filter by, then click OK. 
 [bookmark: pgfId-1541460]The port value must be an integer between 1 and 65535 or a port variable.
  
         	[bookmark: pgfId-1539676]Finds rules that include the specified source port.
  
        
 
         
         	[bookmark: pgfId-1539678]Destination port
  
         	[bookmark: pgfId-1539680]Type the destination port to filter by, then click OK.
 [bookmark: pgfId-1541481]The port value must be an integer between 1 and 65535 or a port variable.
  
         	[bookmark: pgfId-1539682]Finds rules that include the specified destination port.
  
        
 
         
         	[bookmark: pgfId-1539684]Rule Overhead
  
         	[bookmark: pgfId-1539686]Select the amount of rule overhead to filter by: Low, Medium, High, or Very High; then click OK.
  
         	[bookmark: pgfId-1539688]Finds rules with the selected rule overhead.
  
        
 
         
         	[bookmark: pgfId-1539690]Metadata
  
         	[bookmark: pgfId-1539692]Type the metadata key-value pair to filter by, separated by a space; then click OK.
 [bookmark: pgfId-1539693]For example, type metadata:”service http” to locate rules with metadata relating to the HTTP application protocol. 
  
         	[bookmark: pgfId-1539695]Find rules with metadata containing the matching key-value pair.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1532214][bookmark: 56915]Understanding Rule Categories[bookmark: marker-1548892]
 
     [bookmark: pgfId-1541780]License: Protection
 
     [bookmark: pgfId-1541785]The ASA FirePOWER module places rules in categories based on the type of traffic the rule detects. On the Rules page, you can filter by rule category, so you can set a rule attribute for all rules in a category. For example, if you do not have Linux hosts on your network, you could filter by the os-linux category, then disable all the rules showing to disable the entire os-linux category.
 
      
       
     
 
     
 
     [bookmark: pgfId-1541790]Note The Cisco VRT may use the rule update mechanism to add and remove rule categories.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532215][bookmark: 53047]Editing a Rule F[bookmark: marker-1548905]ilter Directly
 
     [bookmark: pgfId-1541858]License: Protection
 
     [bookmark: pgfId-1541859]You can edit your filter to modify the special keywords and their arguments that are supplied when you click on a filter in the filter panel. Custom filters on the Rules page function like those used in the rule editor, but you can also use any of the keywords supplied in the Rules page filter, using the syntax displayed when you select the filter through the filter panel. To determine a keyword for future use, click on the appropriate argument in the filter panel on the right. The filter keyword and argument syntax appear in the filter text box. 
 
     [bookmark: pgfId-1541862]To see lists of arguments for keywords which only support specific values, see Understanding Rule Configuration Filters, Understanding Rule Content Filters, and Understanding Rule Categories. Remember that comma-separated multiple arguments for a keyword are only supported for the Category and Priority filter types. 
 
     [bookmark: pgfId-1541870]You can use keywords and arguments, character strings, and literal character strings in quotes, with spaces separating multiple filter conditions. A filter cannot include regular expressions, wild card characters, or any special operator such as a negation character (!), a greater than symbol (>), less than symbol (<), and so on. When you type in search terms without a keyword, without initial capitalization of the keyword, or without quotes around the argument, the search is treated as a string search and the category, message, and SID fields are searched for the specified terms.
 
     [bookmark: pgfId-1541871]All keywords, keyword arguments, and character strings are case-insensitive. Except for the gid and sid keywords, all arguments and strings are treated as partial strings. Arguments for gid and sid return only exact matches.
 
     [bookmark: pgfId-1541872]Each rule filter can include one or more keywords in the format:
 
      
      [bookmark: pgfId-1541938]Keyword:”argument” 
     
 
     [bookmark: pgfId-1541942]where keyword is one of the keywords in the filter groups described in the Rule types table and argument is enclosed in double quotes and is a single, case-insensitive, alphanumeric string to search for in the specific field or fields relevant to the keyword. Note that keywords should be typed with initial capitalization.
 
     [bookmark: pgfId-1541943]Arguments for all keywords except gid and sid are treated as partial strings. For example, the argument 123 returns "12345", "41235", "45123", and so on. The arguments for gid and sid return only exact matches; for example, sid:3080 returns only SID 3080.
 
     [bookmark: pgfId-1541944]Each rule filter can also include one or more alphanumeric character strings. Character strings search the rule Message field, Signature ID, and Generator ID. For example, the string 123 returns the strings "Lotus123", "123mania", and so on in the rule message, and also returns SID 6123, SID 12375, and so on. For information on the rule Message field, see Defining the Event Message. You can search for a partial SID by filtering with one or more character strings. 
 
     [bookmark: pgfId-1541951]All character strings are case-insensitive and are treated as partial strings. For example, any of the strings ADMIN, admin, or Admin return "admin", "CFADMIN", "Administrator" and so on.
 
     [bookmark: pgfId-1541952]You can enclose character strings in quotes to return exact matches. For example, the literal string "overflow attempt" in quotes returns only that exact string, whereas a filter comprised of the two strings overflow and attempt without quotes returns "overflow attempt", "overflow multipacket attempt", "overflow with evasion attempt", and so on.
 
     [bookmark: pgfId-1541954][bookmark: 60128]You can narrow filter results by entering any combination of keywords, character strings, or both, separated by spaces. The result includes any rule that matches all the filter conditions.
 
     [bookmark: pgfId-1541955]You can enter multiple filter conditions in any order. For example, each of the following filters returns the same rules:
 
      
      	 [bookmark: pgfId-1541956] url:at login attempt cve:200 
 
      	 [bookmark: pgfId-1541957] login attempt cve:200 url:at 
 
      	 [bookmark: pgfId-1541958] login cve:200 attempt url:at 
 
     
 
    
 
     
      [bookmark: pgfId-1532216][bookmark: 50099]Setting a Rule Filt[bookmark: marker-1548918]er in an Intrusion Policy
 
     [bookmark: pgfId-1542047]License: Protection
 
     [bookmark: pgfId-1542048]You can filter the rules on the Rules page to display a subset of rules. You can then use any of the page features. This can be useful, for example, when you want to set a threshold for all the rules in a specific category. You can use the same features with rules in a filtered or unfiltered list. For example, you can apply new rule states to rules in a filtered or unfiltered list. 
 
     [bookmark: pgfId-1542049]You can select predefined filter keywords from the filter panel on the left side of the Rules page in the intrusion policy. When you select a filter, the page displays all matching rules, or indicates when no rules match. 
 
     [bookmark: pgfId-1542050]For more information on all the keywords and arguments you can use and how you can construct filters from the filter panel, see Understanding Rule Filtering in an Intrusion Policy.
 
     [bookmark: pgfId-1542054]You can add keywords to a filter to further constrain it. Any filter you enter searches the entire rules database and returns all matching rules. When you enter a filter while the page still displays the result of a previous filter, the page clears and returns the result of the new filter instead. 
 
     [bookmark: pgfId-1542131]You can also type a filter using the same keyword and argument syntax supplied when you select a filter, or modify argument values in a filter after you select it. When you type in search terms without a keyword, without initial capitalization of the keyword, or without quotes around the argument, the search is treated as a string search and the category, message, and SID fields are searched for the specified terms.
 
     [bookmark: pgfId-1542132]To filter for specific rules in an intrusion policy:
 
     
 
     [bookmark: pgfId-1579866]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1542138]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1542143]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1542147]The Policy Information page appears.
 
     [bookmark: pgfId-1542149]Step 3 [bookmark: 58772]Click Rules.
 
     [bookmark: pgfId-1542150]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1542151]Step 4 Construct a filter by clicking on keywords or arguments in the filter panel on the left. Note that if you click an argument for a keyword already in the filter, it replaces the existing argument. See the following for more information:
 
      
       
       	 [bookmark: pgfId-1542155]Guidelines for Constructing Intrusion Policy Rule Filters
 
       	 [bookmark: pgfId-1542159]Understanding Rule Configuration Filters
 
       	 [bookmark: pgfId-1542163]Understanding Rule Content Filters
 
       	 [bookmark: pgfId-1542167]Understanding Rule Categories
 
       	 [bookmark: pgfId-1542171]Editing a Rule Filter Directly
 
      
 
     
 
     [bookmark: pgfId-1542172]The page refreshes to display all matching rules, and the number of rules matching the filter is displayed above the filter text box.
 
     [bookmark: pgfId-1542173]Step 5 Select the rule or rules where you want to apply a new setting. You have the following options:
 
      
       
       	 [bookmark: pgfId-1542174]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1542175]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1542176]Step 6 Optionally, make any changes to the rule that you would normally make on the page. See the following sections for more information:
 
      
       
       	 [bookmark: pgfId-1542180]See Setting Rule States for information on enabling and disabling rules on the Rules page.
 
       	 [bookmark: pgfId-1542184]See Filtering Intrusion Event Notification Per Policy for information on adding thresholding and suppression to rules.
 
       	 [bookmark: pgfId-1542188]See Adding Dynamic Rule States for information on setting dynamic rule states that trigger when rate anomalies occur in matching traffic.
 
       	 [bookmark: pgfId-1542192]See Adding SNMP Alerts for information on adding SNMP alerts to specific rules.
 
       	 [bookmark: pgfId-1542196]See Adding Rule Comments for information on adding rule comments to rules.
 
      
 
     
 
     [bookmark: pgfId-1542197]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571666]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1542201]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532217][bookmark: 80766]Setting Rule State[bookmark: marker-1548936]s
 
    [bookmark: pgfId-1542327]License: Protection
 
    [bookmark: pgfId-1542331]The Cisco Vulnerability Research Team (VRT) sets the default state of each intrusion and preprocessor rule in each default policy. For example, a rule may be enabled in the Security over Connectivity default policy and disabled in the Connectivity over Security default policy. Intrusion policy rules you create inherit the default states of the rules in the default policy you use to create your policy.
 
    [bookmark: pgfId-1542332]You can set a rule to Generate Events, to Drop and Generate Events, or to Disable individually, or you can filter the rules by a variety of factors to select the rules for which you want to modify the state. In an inline deployment, you can use the Drop and Generate Events rule state in inline intrusion deployments to drop malicious packets. Note that rules with the Drop and Generate Events rule state generate events but do not drop packets in a passive deployment. Setting a rule to Generate Events or to Drop and Generate Events enables the rule; setting the rule to Disable disables it.
 
    [bookmark: pgfId-1542336]Consider two scenarios. In the first scenario, the rule state for a specific rule is set to Generate Events. When a malicious packet crosses your network and triggers the rule, the packet is sent to its destination and the system generates an intrusion event. In the second scenario, assume that the rule state for the same rule is set to Drop and Generate Events in an inline deployment. In this case, when the malicious packet crosses the network, the system drops the malicious packet and generates an intrusion event. The packet never reaches its target. 
 
    [bookmark: pgfId-1542394]In an intrusion policy, you can set a rule’s state to one of the following:
 
     
     	 [bookmark: pgfId-1542395]Set the rule state to  Generate Events  if you want the system to detect a specific intrusion attempt and generate an intrusion event when it finds matching traffic.
 
     	 [bookmark: pgfId-1542396]Set the rule state to  Drop and Generate Events  if you want the system to detect a specific intrusion attempt, then drop the packet containing the attack and generate an intrusion event when it finds matching traffic in an inline deployment, or to generate an intrusion event when it finds matching traffic in a passive deployment.
 
    
 
    [bookmark: pgfId-1549511]Note that for the system to drop packets, your intrusion policy must be set to drop rules in an inline deployment; see Setting Drop Behavior in an Inline Deployment for more information.
 
     
     	 [bookmark: pgfId-1549515]Set the rule state to  Disable if you do not want the system to evaluate matching traffic.
 
    
 
    [bookmark: pgfId-1542405]To use drop rules, you must:
 
     
     	 [bookmark: pgfId-1542406]Enable the  Drop when Inline option in your intrusion policy.
 
     	 [bookmark: pgfId-1542407]Set the rule state to  Drop and Generate Events for any rules that should drop all packets that match the rule.
 
     	 [bookmark: pgfId-1542408]Apply an access control policy that includes an access control rule that is associated with your intrusion policy in an inline deployment.
 
    
 
    [bookmark: pgfId-1542409]Filtering rules on the Rules page can help you find the rules you want to set as drop rules. For more information, see Filtering Rules in an Intrusion Policy.
 
    [bookmark: pgfId-1542416]See Understanding and Writing Intrusion Rules for information about rule anatomy, rule keywords and their options, and rule writing syntax.
 
    [bookmark: pgfId-1542510]The VRT sometimes uses a rule update to change the default state of one or more rules in a default policy. If you allow rule updates to update your base policy, you also allow the rule update to change the default state of a rule in your policy when the default state changes in the default policy you used to create your policy (or in the default policy it is based on). Note, however, that if you have changed the rule state, the rule update does not override your change.
 
    [bookmark: pgfId-1542511]To change the rule state for one or more rules:
 
    
 
    [bookmark: pgfId-1579883]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1542517]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1542522]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1542526]The Policy Information page appears.
 
    [bookmark: pgfId-1542527]Note that this page indicates the total number of enabled rules, the total number of enabled rules set to Generate Events, and the total number set to Drop and Generate Events. Note also that in a passive deployment, rules set to Drop and Generate Events only generate events.
 
    [bookmark: pgfId-1542529]Step 3 [bookmark: 27150]Click Rules.
 
    [bookmark: pgfId-1542530]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
    [bookmark: pgfId-1542531]Step 4 Locate the rule or rules where you want to set the rule state. You have the following options:
 
     
      
      	 [bookmark: pgfId-1542532]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
      	 [bookmark: pgfId-1542533]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
     
 
    
 
    [bookmark: pgfId-1542540]The page refreshes to display all matching rules.
 
    [bookmark: pgfId-1542541]Step 5 Select the rule or rules where you want to set the rule state. You have the following options:
 
     
      
      	 [bookmark: pgfId-1542542]To select a specific rule, select the check box next to the rule.
 
      	 [bookmark: pgfId-1542543]To select all the rules in the current list, select the check box at the top of the column.
 
     
 
    
 
    [bookmark: pgfId-1542544]Step 6 You have the following options:
 
     
      
      	 [bookmark: pgfId-1542545]To generate events when traffic matches the selected rules, select  Rule State > Generate Events .
 
      	 [bookmark: pgfId-1542546]To generate events and drop the traffic in inline deployments when traffic matches the selected rules, select  Rule State > Drop and Generate Events .
 
      	 [bookmark: pgfId-1542547]To not inspect traffic matching the selected rules, select  Rule State > Disable .
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1542553]Note [bookmark: 14082][bookmark: 84509]Cisco strongly recommends that you do not enable all the intrusion rules in an intrusion policy. The performance of your device is likely to degrade if all rules are enabled. Instead, tune your rule set to match your network environment as closely as possible.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1542554]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    [bookmark: pgfId-1542558]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532218][bookmark: 38828]Filtering [bookmark: marker-1548949]Intrusion Event Notification Per Policy
 
    [bookmark: pgfId-1542694]License: Protection
 
    [bookmark: pgfId-1542695]The importance of an intrusion event can be based on frequency of occurrence, or on source or destination IP address. In some cases you may not care about an event until it has occurred a certain number of times. For example, you may not be concerned if someone attempts to log into a server until they fail a certain number of times. In other cases, you may only need to see a few occurrences to know there is a widespread problem. For example, if a DoS attack is launched against your web server, you may only need to see a few occurrences of an intrusion event to know that you need to address the situation. Seeing hundreds of the same event only overwhelms your system. 
 
    [bookmark: pgfId-1542696]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1542700]Configuring Event Thresholding explains how to set thresholds that dictate how often an event is displayed, based on the number of occurrences. You can configure thresholding per event and per policy.
 
     	 [bookmark: pgfId-1542704]Configuring Suppression Per Intrusion Policy explains how to suppress notification of specified events per source or destination IP address, per policy.
 
    
 
     
      [bookmark: pgfId-1543030][bookmark: 86762]Configu[bookmark: marker-1543027]ring Event Thres[bookmark: RuleThresholdingGlobal]holding
 
     [bookmark: pgfId-1543038]License: Protection
 
     [bookmark: pgfId-1543039]You can set thresholds for individual rules, per intrusion policy, to limit the number of times the system logs and displays an intrusion event based on how many times the event is generated within a specified time period. This can prevent you from being overwhelmed with a large number of identical events. You can set thresholds per shared object rule, standard text rule, or preprocessor rule.
 
     [bookmark: pgfId-1543046]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1543050]Understanding Event Thresholding
 
      	 [bookmark: pgfId-1543054]Adding and Modifying Intrusion Event Thresholds
 
      	 [bookmark: pgfId-1543058]Viewing and Deleting Intrusion Event Thresholds
 
      	 [bookmark: pgfId-1543062]Setting a Threshold for a Rule
 
     
 
    
 
     
      [bookmark: pgfId-1543139][bookmark: 51505]Understanding Event Thresholding
 
     [bookmark: pgfId-1543146]License: Protection
 
     [bookmark: pgfId-1543147]First, you must specify the thresholding type. You can select from the options discussed in the following table.
 
     [bookmark: pgfId-1543176]
 
      
       
        
        [bookmark: pgfId-1543154]Table 21-6 [bookmark: 69467]Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1543158]Option 
          
  
         	 
           
           [bookmark: pgfId-1543160]Description 
          
  
        
 
         
         	[bookmark: pgfId-1543162]Limit
  
         	[bookmark: pgfId-1543164]Logs and displays events for the specified number of packets (specified by the Count argument) that trigger the rule during the specified time period. For example, if you set the type to Limit, the Count to 10, and the Seconds to 60, and 14 packets trigger the rule, the system stops logging events for the rule after displaying the first 10 that occur within the same minute.
  
        
 
         
         	[bookmark: pgfId-1543166]Threshold
  
         	[bookmark: pgfId-1543168]Logs and displays a single event when the specified number of packets (specified by the Count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event. For example, you set the type to Threshold, Count to 10, and Seconds to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.
  
        
 
         
         	[bookmark: pgfId-1543170]Both
  
         	[bookmark: pgfId-1543172]Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule. For example, if you set the type to Both, Count to two, and Seconds to 10, the following event counts result:
 
           
           	 [bookmark: pgfId-1543173]If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)
 
           	 [bookmark: pgfId-1543174]If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)
 
           	 [bookmark: pgfId-1543175]If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time, and following events are ignored)
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1543177]Next, you must specify tracking, which determines whether the event threshold is calculated per source or destination IP address. Select one of the options from the following table to specify how the system tracks event instances. 
 
     [bookmark: pgfId-1543199]
 
      
       
        
        [bookmark: pgfId-1543184]Table 21-7 [bookmark: 36517]Thresholding IP Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1543188]Option 
          
  
         	 
           
           [bookmark: pgfId-1543190]Description 
          
  
        
 
         
         	[bookmark: pgfId-1543192]Source
  
         	[bookmark: pgfId-1543194]Calculates event instance count per source IP address.
  
        
 
         
         	[bookmark: pgfId-1543196]Destination
  
         	[bookmark: pgfId-1543198]Calculates event instance count per destination IP address.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1543200]Finally, you must specify the number of instances and time period that define the threshold.
 
     [bookmark: pgfId-1543221]
 
      
       
        
        [bookmark: pgfId-1543206]Table 21-8 Thresholding Instance/Time Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1543210]Option 
          
  
         	 
           
           [bookmark: pgfId-1543212]Description 
          
  
        
 
         
         	[bookmark: pgfId-1543214]Count
  
         	[bookmark: pgfId-1543216]The number of event instances per specified time period per tracking IP address required to meet the threshold.
  
        
 
         
         	[bookmark: pgfId-1543218]Seconds
  
         	[bookmark: pgfId-1543220]The number of seconds that elapse before the count resets. If you set the threshold type to limit, the tracking to Source IP, the count to 10, and the seconds to 10, the system logs and displays the first 10 events that occur in 10 seconds from a given source port. If only 7 events occur in the first 10 seconds, the system logs and displays those; if 40 events occur in the first 10 seconds, the system logs and displays 10, then begins counting again when the 10-second time period elapses.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1543222]Note that you can use intrusion event thresholding alone or in any combination with rate-based attack prevention, the detection_filter keyword, and intrusion event suppression. See Adding Dynamic Rule States, Filtering Events, and Configuring Suppression Per Intrusion Policy for more information.
 
     [bookmark: pgfId-1543232]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1543236]Adding and Modifying Intrusion Event Thresholds
 
      	 [bookmark: pgfId-1543240]Setting a Threshold for a Rule
 
      	 [bookmark: pgfId-1597580]Viewing and Deleting Intrusion Event Thresholds
 
     
 
    
 
     
      [bookmark: pgfId-1597588][bookmark: 98650]Adding and Modifying Intrusion Event Thr[bookmark: marker-1597587]esholds
 
     [bookmark: pgfId-1543442]License: Protection
 
     [bookmark: pgfId-1543444]You can set a threshold for one or more specific rules. You can also separately or simultaneously modify existing threshold settings. You can set a a single threshold for each. Adding a threshold overwrites any existing threshold for the rule.
 
     [bookmark: pgfId-1543447]For more information on viewing and deleting threshold configurations, see Viewing and Deleting Intrusion Event Thresholds.
 
     [bookmark: pgfId-1543449]You can also modify the global threshold that applies by default to all rules and preprocessor-generated events. For more information, see Globally Limiting Intrusion Event Logging.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1543458]To add or modify event thresholds:
 
     
 
     [bookmark: pgfId-1579904]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1543464]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1543469]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1543473]The Policy Information page appears.
 
     [bookmark: pgfId-1543540]Step 3 [bookmark: 28388]Click Rules.
 
     [bookmark: pgfId-1543541]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1543542]Step 4 Locate the rule or rules where you want to set a threshold. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543543]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1543544]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1543551]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1543552]Step 5 Select the rule or rules where you want to set a threshold. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543553]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1543554]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1543555]Step 6 Select Event Filtering > Threshold.
 
     [bookmark: pgfId-1543556]The thresholding pop-up window appears.
 
     [bookmark: pgfId-1543651]Step 7 From the Type drop-down list, select the type of threshold you want to set:
 
      
       
       	 [bookmark: pgfId-1543652]Select  Limit to limit notification to the specified number of event instances per time period.
 
       	 [bookmark: pgfId-1543653]Select  Threshold to provide notification for each specified number of event instances per time period.
 
       	 [bookmark: pgfId-1543654]Select  Both to provide notification once per time period after a specified number of event instances.
 
      
 
     
 
     [bookmark: pgfId-1543655]Step 8 From the Track By drop-down list, select whether you want the event instances tracked by Source or Destination IP address.
 
     [bookmark: pgfId-1543656]Step 9 In the Count field, specify the number of event instances you want to use as your threshold.
 
     [bookmark: pgfId-1543657]Step 10 In the Seconds field, specify the number of seconds that make up the time period for which event instances are tracked.
 
     [bookmark: pgfId-1543658]Step 11 Click OK.
 ) next to the rule in the Event Filtering column. If you add multiple event filters to a rule, a number over the icon indicates the number of event filters. 
     
 
     [bookmark: pgfId-1543663]Step 12 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571675]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1543667]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1543839][bookmark: 55878]Viewi[bookmark: marker-1543838]ng and Deleting Intrusion Event Thresholds
 
     [bookmark: pgfId-1543846]License: Protection
 
     [bookmark: pgfId-1543847]You may want to view or delete an existing threshold setting. You can use the Rules Details view to display the configured settings for a threshold to see if they are appropriate for your system. If they are not, you can add a new threshold to overwrite the existing values.
 
     [bookmark: pgfId-1543848]Note that you can also modify the global threshold that applies by default to all rules and preprocessor-generated events. See Globally Limiting Intrusion Event Logging for more information.
 
     [bookmark: pgfId-1543852]To view or delete a threshold:
 
     
 
     [bookmark: pgfId-1579935]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1543858]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1543906]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1543910]The Policy Information page appears.
 
     [bookmark: pgfId-1543912]Step 3 [bookmark: 27311]Click Rules.
 
     [bookmark: pgfId-1543913]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1543914]Step 4 Locate the rule or rules that have a configured threshold you want to view or delete. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543915]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1543916]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1543923]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1543924]Step 5 Select the rule or rules with a configured threshold you want to view or delete. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543925]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1543926]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1543927]Step 6 To remove the threshold for each selected rule, select Event Filtering > Remove Thresholds. Click OK in the confirmation pop-up window that appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1543928]Tip To remove a specific threshold, you can also highlight the rule and click Show details. Expand the threshold settings, then click Delete next to the threshold settings you want to remove. Click OK to confirm that you want to delete the configuration.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1543929]The page refreshes and the threshold is deleted.
 
     [bookmark: pgfId-1543930]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1543934]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1544051][bookmark: 74467]Configur[bookmark: marker-1544049]ing Suppression Per Intrusion Policy
 
     [bookmark: pgfId-1544059]License: Protection
 
     [bookmark: pgfId-1544060]You can suppress intrusion event notification when a specific IP address or range of IP addresses triggers a specific rule or preprocessor. This is useful for eliminating false positives. For example, if you have a mail server that transmits packets that look like a specific exploit, you might suppress event notification for that event when it is triggered by your mail server. The rule triggers for all packets, but you only see events for legitimate attacks.
 
     [bookmark: pgfId-1544061]Note that you can use intrusion event suppression alone or in any combination with rate-based attack prevention, the detection_filter keyword, and intrusion event thresholding. See Adding Dynamic Rule States, Filtering Events, and Configuring Event Thresholding for more information.
 
     [bookmark: pgfId-1544071]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1544075]Suppressing Intrusion Events
 
      	 [bookmark: pgfId-1544117]Viewing and Deleting Suppression Conditions
 
     
 
    
 
     
      [bookmark: pgfId-1544190][bookmark: 53032]Suppressing[bookmark: marker-1544188] Intrusion Events
 
     [bookmark: pgfId-1544197]License: Protection
 
     [bookmark: pgfId-1544199]You can suppress intrusion event notification for a rule or rules. When notification is suppressed for a rule, the rule triggers but events are not generated. You can set one or more suppressions for a rule. The first suppression listed has the highest priority. Note that when two suppressions conflict, the action of the first is carried out. 
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1544204]To suppress event display:
 
     
 
     [bookmark: pgfId-1579960]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1544210]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1544215]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1544219]The Policy Information page appears.
 
     [bookmark: pgfId-1544221]Step 3 [bookmark: 18582]Click Rules.
 
     [bookmark: pgfId-1544222]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1544223]Step 4 Locate the rule or rules where you want to set suppression. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544224]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1544225]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1544232]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1544337]Step 5 Select the rule or rules for which you want to configure suppression conditions. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544338]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1544339]To select all rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1544340]Step 6 Select Event Filtering > Suppression.
 
     [bookmark: pgfId-1544341]The suppression pop-up window appears.
 
     [bookmark: pgfId-1544342]Step 7 Select one of the following Suppression Type options:
 
      
       
       	 [bookmark: pgfId-1544343]Select  Rule to completely suppress events for a selected rule.
 
       	 [bookmark: pgfId-1544344]Select  Source to suppress events generated by packets originating from a specified source IP address.
 
       	 [bookmark: pgfId-1544345]Select  Destination to suppress events generated by packets going to a specified destination IP address.
 
      
 
     
 
     [bookmark: pgfId-1544346]Step 8 If you selected Source or Destination for the suppression type, in the Network field enter the IP address, address block, or variable you want to specify as the source or destination IP address, or a comma-separated list comprised of any combination of these.
 
     [bookmark: pgfId-1544350]For information on using IPv4 CIDR and IPv6 prefix length address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1544432]Step 9 Click OK.
 ) next to the rule in the Event Filtering column next the suppressed rule. If you add multiple event filters to a rule, a number over the icon indicates the number of event filters. 
     
 
     [bookmark: pgfId-1544437]Step 10 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571686]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    
 
     
      [bookmark: pgfId-1544654][bookmark: 85767]Viewing and De[bookmark: marker-1544653]leting Suppression Conditions
 
     [bookmark: pgfId-1544661]License: Protection
 
     [bookmark: pgfId-1544662]You may want to view or delete an existing suppression condition. For example, you can suppress event notification for packets originating from a mail server IP address because the mail server normally transmits packets that look like exploits. If you then decommission that mail server and reassign the IP address to another host, you should delete the suppression conditions for that source IP address.
 
     [bookmark: pgfId-1544663]To view or delete a defined suppression condition:
 
     
 
     [bookmark: pgfId-1579981]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1544669]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1544674]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1544678]The Policy Information page appears.
 
     [bookmark: pgfId-1544680]Step 3 [bookmark: 19617]Click Rules.
 
     [bookmark: pgfId-1544681]The Rules page appears. By default, the page lists rules alphabetically by message. 
 
     [bookmark: pgfId-1544682]Step 4 Locate the rule or rules where you want to view or delete suppressions. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544683]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1544684]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1544691]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1544759]Step 5 Select the rule or rules for which you want to view or delete suppressions. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544760]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1544761]To select all rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1544762]Step 6 You have two options:
 
      
       
       	 [bookmark: pgfId-1544763]To remove all suppression for a rule, select  Event Filtering > Remove Suppressions.  Click  OK in the confirmation pop-up window that appears.
 
       	 [bookmark: pgfId-1544764]To remove a specific suppression setting, highlight the rule and click  Show details . Expand the suppression settings and click  Delete next to the suppression settings you want to remove. Click  OK to confirm that you want to delete your selected settings.
 
      
 
     
 
     [bookmark: pgfId-1544765]The page refreshes and the suppression settings are deleted.
 
     [bookmark: pgfId-1544766]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1544770]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1544882][bookmark: 76570]Adding Dynamic Rule State[bookmark: marker-1544880][bookmark: marker-1544881]s
 
    [bookmark: pgfId-1544890]License: Protection
 
    [bookmark: pgfId-1544891]Rate-based attacks attempt to overwhelm a network or host by sending excessive traffic toward the network or host, causing it to slow down or deny legitimate requests. You can use rate-based prevention to change the action of a rule in response to excessive rule matches for specific rules. 
 
    [bookmark: pgfId-1544892]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1544896]Understanding Dynamic Rule States
 
     	 [bookmark: pgfId-1544900]Setting a Dynamic Rule State
 
    
 
     
      [bookmark: pgfId-1544945][bookmark: 38940]Understanding Dynamic Rul[bookmark: marker-1544944]e States
 
     [bookmark: pgfId-1544952]License: Protection
 
     [bookmark: pgfId-1544953]You can configure your intrusion policies to include a rate-based filter that detects when too many matches for a rule occur in a given time period. You can use this feature on a device deployed inline to block rate-based attacks for a specified time, then revert to a rule state where rule matches only generate events and do not drop traffic. 
 
     [bookmark: pgfId-1544954]Rate-based attack prevention identifies abnormal traffic patterns and attempts to minimize the impact of that traffic on legitimate requests. You can identify excessive rule matches in traffic going to a particular destination IP address or addresses or coming from a particular source IP address or addresses. You can also respond to excessive matches for a particular rule across all detected traffic. 
 
     [bookmark: pgfId-1544955]In the intrusion policy, you can configure a rate-based filter for any intrusion or preprocessor rule. The rate-based filter contains three components: 
 
      
      	 [bookmark: pgfId-1544956]the rule matching rate, which you configure as a count of rule matches within a specific number of seconds
 
      	 [bookmark: pgfId-1544957]a new action to be taken when the rate is exceeded, with three available actions: Generate Events, Drop and Generate Events, and Disable
 
      	 [bookmark: pgfId-1544958]the duration of the action, which you configure as a timeout value
 
     
 
     [bookmark: pgfId-1544959]Note that when started, the new action occurs until the timeout is reached, even if the rate falls below the configured rate during that time period. When the timeout is reached, if the rate has fallen below the threshold, the action for the rule reverts to the action initially configured for the rule.
 
     [bookmark: pgfId-1545033]You can configure rate-based attack prevention in an inline deployment to block attacks, either temporarily or permanently. Without rate-based configuration, rules set to Generate Events do generate events, but the system does not drop packets for those rules. However, if the attack traffic matches rules that have rate-based criteria configured, the rate action may cause packet dropping to occur for the period of time that the rate action is active, even if those rules are not initially set to Drop and Generate Events. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1545034]Note Rate-based actions cannot enable disabled rules or drop traffic that matches disabled rules. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1545035]You can define multiple rate-based filters on the same rule. The first filter listed in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the action of the first rate-based filter is carried out. 
 
     [bookmark: pgfId-1545036]The following diagram shows an example where an attacker is attempting to access a host. Repeated attempts to find a password trigger a rule which has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events after rule matches occur five times in a 10-second span. The new rule attribute times out after 15 seconds. 
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1545116][bookmark: 46417]Setting a [bookmark: marker-1545115]Dynamic Rule State 
 
     [bookmark: pgfId-1545124]License: Protection
 
     [bookmark: pgfId-1545125]In some cases, you may not want to set a rule to the Drop and Generate Events state because you do not want to drop every packet that matches the rule, but you do want to drop packets matching the rule if a particular rate of matches occurs in a specified time. Dynamic rule states let you configure the rate that should trigger a change in the action for a rule, what the action should change to when the rate is met, and how long the new action should persist. 
 
     [bookmark: pgfId-1545126]You set the number of hits for that rule by specifying a count and the number of seconds within which that number of hits should occur to trigger the action change. In addition, you can set a timeout to cause the action to revert to the previous state for the rule when the timeout expires. 
 
     [bookmark: pgfId-1545127]You can define multiple dynamic rule state filters for the same rule. The first filter listed in the rule details in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the action of the first rate-based filter is carried out. 
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1545132]Note Dynamic rule states cannot enable disabled rules or drop traffic that matches disabled rules. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1545414]To add a dynamic rule state:
 
     
 
     [bookmark: pgfId-1579998]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
     [bookmark: pgfId-1545229]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1545234]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1545238]The Policy Information page appears.
 
     [bookmark: pgfId-1545240]Step 3 [bookmark: 89579]Click Rules.
 
     [bookmark: pgfId-1545241]The Rules page appears.
 
     [bookmark: pgfId-1545242]Step 4 Locate the rule or rules where you want to add a dynamic rule state. You have the following options:
 
      
       
       	 [bookmark: pgfId-1545243]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1545244]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1545251]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1545252]Step 5 Select the rule or rules where you want to add a dynamic rule state. You have the following options:
 
      
       
       	 [bookmark: pgfId-1545253]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1545254]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1545255]Step 6 Select Dynamic State > Add Rate-Based Rule State. 
 
     [bookmark: pgfId-1545256]The Add Rate-Based Rule State dialog box appears.
 
     [bookmark: pgfId-1545257]Step 7 From the Track By drop-down list, select how you want the rule matches tracked: 
 
      
       
       	 [bookmark: pgfId-1545258]Select  Source to track the number of hits for that rule from a specific source or set of sources. 
 
       	 [bookmark: pgfId-1545259]Select  Destination to track the number of hits for that rule to a specific destination or set of destinations. 
 
       	 [bookmark: pgfId-1545260]Select  Rule to track all matches for that rule.
 
      
 
     
 
     [bookmark: pgfId-1545261]Step 8 If you set Track By to Source or Destination, enter the address of each host you want to track in the Network field.
 
     [bookmark: pgfId-1545262]You can specify a single IP address, address block, variable, or a comma-separated list comprised of any combination of these. For information on using IPv4 CIDR and IPv6 prefix length address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1545269]Step 9 Next to Rate, indicate the number of rule matches per time period to set the attack rate:
 
      
       
       	 [bookmark: pgfId-1545270]In the  Count field, using an integer between 1 and 2147483647, specify the number of rule matches you want to use as your threshold.
 
       	 [bookmark: pgfId-1545271]In the  Seconds field, using an integer between 1 and 2147483647, specify the number of seconds that make up the time period for which attacks are tracked.
 
      
 
     
 
     [bookmark: pgfId-1545272]Step 10 From the New State drop-down list, specify the new action to be taken when the conditions are met:
 
      
       
       	 [bookmark: pgfId-1545273]Select  Generate Events  to generate an event.
 
       	 [bookmark: pgfId-1545274]Select  Drop and Generate Events  to generate an event and drop the packet that triggered the event in inline deployments or generate an event in passive deployments.
 
       	 [bookmark: pgfId-1545275]Select  Disabled  to take no action.
 
      
 
     
 
     [bookmark: pgfId-1545276]Step 11 In the Timeout field, type the number of seconds you want the new action to remain in effect. After the timeout occurs, the rule reverts to its original state. Specify 0 or leave the Timeout field blank to prevent the new action from timing out. 
 
     [bookmark: pgfId-1545277]Step 12 Click OK.
 ) next to the rule in the Dynamic State column. If you add multiple dynamic rule state filters to a rule, a number over the icon indicates the number of filters. 
     
 
     [bookmark: pgfId-1545282]If any required fields are blank, you receive an error message indicating which fields you must fill.
 
      
       
     
 
     
 
     [bookmark: pgfId-1545283]Tip To delete all dynamic rule settings for a set of rules, select the rules on the Rules page, then select Dynamic State > Remove Rate-Based States. You can also delete individual rate-based rule state filters from the rule details for the rule by selecting the rule, clicking Show details, then clicking Delete by the rate-based filter you want to remove.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1545284]Step 13 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571703]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1545288]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1545679][bookmark: 79224]Addi[bookmark: marker-1545678]ng SNMP Alerts
 
    [bookmark: pgfId-1545686]License: Protection
 
    [bookmark: pgfId-1560008]If you configure SNMP alerting for your ASA FirePOWER module, you can configure specific rules to provide an SNMP alert when the rule generates an event. For more information, see Using SNMP Responses.
 
    [bookmark: pgfId-1545750]To set an SNMP alert:
 
    
 
    [bookmark: pgfId-1580023]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1545756]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1545761]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1545765]The Policy Information page appears.
 
    [bookmark: pgfId-1545767]Step 3 [bookmark: 50356]Click Rules.
 
    [bookmark: pgfId-1545768]The Rules page appears.
 
    [bookmark: pgfId-1545769]Step 4 Locate the rule or rules where you want to set SNMP alerts. You have the following options:
 
     
      
      	 [bookmark: pgfId-1545770]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
      	 [bookmark: pgfId-1545771]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
     
 
    
 
    [bookmark: pgfId-1545778]The page refreshes to display all matching rules.
 
    [bookmark: pgfId-1545779]Step 5 Select the rule or rules where you want to set SNMP alerts: 
 
     
      
      	 [bookmark: pgfId-1545780]To select a specific rule, select the check box next to the rule.
 
      	 [bookmark: pgfId-1545909]To select all the rules in the current list, select the check box at the top of the column.
 
     
 
    
 
    [bookmark: pgfId-1545989]Step 6 Select Alerting > Add SNMP Alert. 
 ) next to the rule in the Alerting column. If you add multiple alert types to a rule, a number over the icon indicates the number of alert types. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1545994]Tip To remove an SNMP alert from a rule, click the check box next to the rule and select Alerting > Remove SNMP Alerts, then click OK to confirm the deletion.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1545995]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    [bookmark: pgfId-1545999]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1546112][bookmark: 93855]Adding Rule Com[bookmark: marker-1546111]ments
 
    [bookmark: pgfId-1546119]License: Protection
 
    [bookmark: pgfId-1546121]You can add comments to a rule. Any comments you add can be seen in the Rule Details view on the Rules page. 
 
    [bookmark: pgfId-1546122]After you commit the intrusion policy changes containing the comment, you can also view the comment by clicking Rule Comment on the rule Edit page. For more information on editing rules, see Modifying Existing Rules.
 
    [bookmark: pgfId-1546126]To add a comment to a rule:
 
    
 
    [bookmark: pgfId-1546131]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy.
 
    [bookmark: pgfId-1546132]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1546137]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1546141]The Policy Information page appears.
 
    [bookmark: pgfId-1546143]Step 3 [bookmark: 31813]Click Rules.
 
    [bookmark: pgfId-1546144]The Rules page appears.
 
    [bookmark: pgfId-1546205]Step 4 Locate the rule or rules where you want to add a comment to a rule. You have the following options:
 
     
      
      	 [bookmark: pgfId-1546206]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
      	 [bookmark: pgfId-1546207]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
     
 
    
 
    [bookmark: pgfId-1546214]The page refreshes to display all matching rules.
 
    [bookmark: pgfId-1546215]Step 5 Select the rule or rules where you want to add a comment: 
 
     
      
      	 [bookmark: pgfId-1546216]To select a specific rule, select the check box next to the rule.
 
      	 [bookmark: pgfId-1546217]To select all the rules in the current list, select the check box at the top of the column.
 
     
 
    
 
    [bookmark: pgfId-1546218]Step 6 Select Comments > Add Rule Comment.
 
    [bookmark: pgfId-1546219]The Add Comment dialog box appears.
 
    [bookmark: pgfId-1546220]Step 7 In the Comment field, type the rule comment.
 
    [bookmark: pgfId-1546250]Step 8 Click OK.
 ) next to the rule in the Comments column. If you add multiple comments to a rule, a number over the icon indicates the number of comments. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1546255]Tip To delete a rule comment, highlight the rule and click Show Details, then click Delete in the Comments section. Note that you can only delete a comment if the comment is cached with uncommitted intrusion policy changes. After intrusion policy changes are committed, the rule comment is permanent.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1546256]Step 9 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
    [bookmark: pgfId-1571722]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    [bookmark: pgfId-1533163]
 
     
     
 
    
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 74479]Detecting Specific Threats 
      
      
 
     
 
 
    [bookmark: pgfId-1576174]You can use several preprocessors in a network analysis policy to detect specific threats to your monitored network, such as Back Orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic. Note that when an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s user interface. For more information, see Limitations of Custom Policies.
 
    [bookmark: pgfId-1565611]You can also use sensitive data detection, which you configure in an intrusion policy, to detect unsecured transmission of sensitive numerical data. 
 
    [bookmark: pgfId-1558057]See the following sections for more information on detecting specific threats:
 
     
     	 [bookmark: pgfId-1530810]Detecting Back Orifice explains detection of Back Orifice attacks.
 
     	 [bookmark: pgfId-1530814]Detecting Portscans describes the different types of portscans and explains how you can use portscan detection to identify threats to your networks before they develop into attacks.
 
     	 [bookmark: pgfId-1530818]Preventing Rate-Based Attacks explains how to limit denial of service (DoS) and SYN flood attacks.
 
     	 [bookmark: pgfId-1530822]Detecting Sensitive Data explains how to detect and generate events on sensitive data such as credit card numbers and Social Security numbers in ASCII text.
 
    
 
   
 
    
     [bookmark: pgfId-1530827][bookmark: 61750]Dete[bookmark: BackOrifice]cting Ba[bookmark: marker-1530826]ck Orifice
 
    [bookmark: pgfId-1576018]License: Protection
 
    [bookmark: pgfId-1576022]The ASA FirePOWER module provides a preprocessor that detects the existence of the Back Orifice program. This program can be used to gain admin access to your Windows hosts. The Back Orifice preprocessor analyzes [bookmark: marker-1576023]UDP traffic for the Back Orifice magic cookie, "*!*QWTY?", which is located in the first eight bytes of the packet and is XOR-encrypted.
 
    [bookmark: pgfId-1530838]The Back Orifice preprocessor has a configuration page, but no configuration options. When it is enabled, you must also enable the preprocessor rules in the following table for the preprocessor to generate corresponding events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1530871]
 
     
      
       
       [bookmark: pgfId-1530848]Table 22-1 [bookmark: 68009]Back Orifice GID:SIDs 
 
       
       
        
        	 
          
          [bookmark: pgfId-1530852]Preprocessor rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1530854]Description 
         
  
       
 
        
        	[bookmark: pgfId-1530856]105:1
  
        	[bookmark: pgfId-1530858]Back Orifice traffic detected
  
       
 
        
        	[bookmark: pgfId-1530860]105:2
  
        	[bookmark: pgfId-1530862]Back Orifice client traffic detected
  
       
 
        
        	[bookmark: pgfId-1530864]105:3
  
        	[bookmark: pgfId-1530866]Back Orifice server traffic detected
  
       
 
        
        	[bookmark: pgfId-1530868]105:4
  
        	[bookmark: pgfId-1530870]Back Orifice snort buffer attack detected
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1530872]To view the Back Orifice Detection page:
 
    
 
    [bookmark: pgfId-1576450]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1576451]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1576456]The access control policy editor appears.
 
    [bookmark: pgfId-1576457]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1576458]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1576463]The Network Analysis and Intrusion Policies pop-up window appears.
 
    [bookmark: pgfId-1576464]Step 5 Click Network Analysis Policy List.
 
    [bookmark: pgfId-1576465]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1530880]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1530884]The Policy Information page appears.
 
    [bookmark: pgfId-1530888]Step 7 In the navigation panel on the left, click Settings.
 
    [bookmark: pgfId-1565971]The Settings page appears.[bookmark: 43002]
 
    [bookmark: pgfId-1565916]Step 8 You have two choices, depending on whether Back Orifice Detection under Specific Threat Detection is enabled:
 
     
      
      	 [bookmark: pgfId-1530889]If the preprocessor is enabled, click  Edit .
 
      	 [bookmark: pgfId-1530890]If the preprocessor is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1530891]The Back Orifice Detection page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1562028]Step 9 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1551910]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1533130][bookmark: 91214]Detecting Por[bookmark: marker-1533129]tscans
 
    [bookmark: pgfId-1530912]License: Protection
 
    [bookmark: pgfId-1530913]A portscan is a form of network reconnaissance that is often used by attackers as a prelude to an attack. In a portscan, an attacker sends specially crafted packets to a targeted host. By examining the packets that the host responds with, the attacker can often determine which ports are open on the host and, either directly or by inference, which application protocols are running on these ports.
 
    [bookmark: pgfId-1530914]Note that when portscan detection is enabled, you must enable rules on the intrusion policy Rules page with generator ID (GID) 122 for enabled portscan types for the portscan detector to generate portscan events. See Setting Rule States and Table 22-5 for more information.
 
    [bookmark: pgfId-1530921]By itself, a portscan is not evidence of an attack. In fact, some of the portscanning techniques used by attackers can also be employed by legitimate users on your network. Cisco’s portscan detector is designed to help you determine which portscans might be malicious by detecting patterns of activity. 
 
     
      
       
       [bookmark: pgfId-1530932]Table 22-2 [bookmark: 89876]Protocol Types 
 
       
       
        
        	 
          
          [bookmark: pgfId-1530936]Protocol 
         
  
        	 
          
          [bookmark: pgfId-1530938]Description 
         
  
       
 
        
        	[bookmark: pgfId-1530940]TCP
  
        	[bookmark: pgfId-1530942]Detects TCP probes such as SYN scans, ACK scans, TCP connect() scans, and scans with unusual flag combinations such as Xmas tree, FIN, and NULL
  
       
 
        
        	[bookmark: pgfId-1530944]UDP
  
        	[bookmark: pgfId-1530946]Detects UDP probes such as zero-byte UDP packets
  
       
 
        
        	[bookmark: pgfId-1530948]ICMP
  
        	[bookmark: pgfId-1530950]Detects ICMP echo requests (pings)
  
       
 
        
        	[bookmark: pgfId-1530952]IP
  
        	[bookmark: pgfId-1530954]Detects IP protocol scans. These scans differ from TCP and UDP scans because the attacker, instead of looking for open ports, is trying to discover which IP protocols are supported on a target host.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1530956]Note For events generated by the portscan connection detector, the protocol number is set to 255. Because portscan does not have a specific protocol associated with it by default, the Internet Assigned Numbers Authority (IANA) does not have a protocol number assigned to it. IANA designates 255 as a reserved number, so that number is used in portscan events to indicate that there is not an associated protocol for the event.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1561846]Table 22-3 [bookmark: 27486]Portscan Types 
 
       
       
        
        	 
          
          [bookmark: pgfId-1561850]Type 
         
  
        	 
          
          [bookmark: pgfId-1561852]Description 
         
  
       
 
        
        	[bookmark: pgfId-1561854]Portscan Detection
  
        	[bookmark: pgfId-1561856]A one-to-one portscan in which an attacker uses one or a few hosts to scan multiple ports on a single target host. 
 [bookmark: pgfId-1561857]One-to-one portscans are characterized by:
 
          
          	 [bookmark: pgfId-1561858]a low number of scanning hosts
 
          	 [bookmark: pgfId-1561859]a single host that is scanned
 
          	 [bookmark: pgfId-1561860]a high number of ports scanned
 
         
 [bookmark: pgfId-1561861]This option detects TCP, UDP, and IP portscans.
  
       
 
        
        	[bookmark: pgfId-1561863]Port Sweep
  
        	[bookmark: pgfId-1561866]A one-to-many [bookmark: marker-1561865]portsweep in which an attacker uses one or a few hosts to scan a single port on multiple target hosts.
 [bookmark: pgfId-1561867]Portsweeps are characterized by:
 
          
          	 [bookmark: pgfId-1561868]a low number of scanning hosts
 
          	 [bookmark: pgfId-1561869]a high number of scanned hosts
 
          	 [bookmark: pgfId-1561870]a low number of unique ports scanned
 
         
 [bookmark: pgfId-1561871]This option detects TCP, UDP, ICMP, and IP portsweeps.
  
       
 
        
        	[bookmark: pgfId-1561873]Decoy Portscan
  
        	[bookmark: pgfId-1561876]A one-to-one portscan in[bookmark: marker-1561875] which the attacker mixes spoofed source IP addresses with the actual scanning IP address.
 [bookmark: pgfId-1561877]Decoy portscans are characterized by:
 
          
          	 [bookmark: pgfId-1561878]a high number of scanning hosts
 
          	 [bookmark: pgfId-1561879]a low number of ports that are scanned only once
 
          	 [bookmark: pgfId-1561880]a single (or a low number of) scanned hosts
 
         
 [bookmark: pgfId-1561881]The decoy portscan option detects TCP, UDP, and IP protocol portscans.
  
       
 
        
        	[bookmark: pgfId-1561883]Distributed Portscan
  
        	[bookmark: pgfId-1561886]A many-to-one portscan in [bookmark: marker-1561885]which multiple hosts query a single host for open ports. 
 [bookmark: pgfId-1561887]Distributed portscans are characterized by:
 
          
          	 [bookmark: pgfId-1561888]a high number of scanning hosts
 
          	 [bookmark: pgfId-1561889]a high number of ports that are scanned only once
 
          	 [bookmark: pgfId-1561890]a single (or a low number of) scanned hosts
 
         
 [bookmark: pgfId-1561891]The distributed portscan option detects TCP, UDP, and IP protocol portscans.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531012]The information that the portscan detector learns about a probe is largely based on seeing negative responses from the probed hosts. For example, when a web client tries to connect to a web server, the client uses port 80/tcp and the server can be counted on to have that port open. However, when an attacker probes a server, the attacker does not know in advance if it offers web services. When the portscan detector sees a negative response (that is, an ICMP unreachable or TCP RST packet), it records the response as a potential portscan. The process is more difficult when the targeted host is on the other side of a device such as a firewall or router that filters negative responses. In this case, the portscan detector can generate filtered portscan events based on the sensitivity level that you select.
 
     
      
       
       [bookmark: pgfId-1561439]Table 22-4 [bookmark: 22132]Sensitivity Levels 
 
       
       
        
        	 
          
          [bookmark: pgfId-1561443]Level 
         
  
        	 
          
          [bookmark: pgfId-1561445]Description 
         
  
       
 
        
        	[bookmark: pgfId-1561447]Low
  
        	[bookmark: pgfId-1561449]Detects only negative responses from targeted hosts. Select this sensitivity level to suppress false positives, but keep in mind that some types of portscans (slow scans, filtered scans) might be missed.
 [bookmark: pgfId-1561450]This level uses the shortest time window for portscan detection.
  
       
 
        
        	[bookmark: pgfId-1561452]Medium
  
        	[bookmark: pgfId-1561454]Detects portscans based on the number of connections to a host, which means that you can detect filtered portscans. However, very active hosts such as network address translators and proxies may generate false positives. 
 [bookmark: pgfId-1561455]Note that you can add the IP addresses of these active hosts to the Ignore Scanned field to mitigate this type of false positive.
 [bookmark: pgfId-1561456]This level uses a longer time window for portscan detection.
  
       
 
        
        	[bookmark: pgfId-1561458]High
  
        	[bookmark: pgfId-1561460]Detects portscans based on a time window, which means that you can detect time-based portscans. However, if you use this option, you should be careful to tune the detector over time by specifying IP addresses in the Ignore Scanned and Ignore Scanner fields.
 [bookmark: pgfId-1561461]This level uses a much longer time window for portscan detection.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531045]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531049]Configuring Portscan Detection
 
     	 [bookmark: pgfId-1531053]Understanding Portscan Events
 
    
 
     
      [bookmark: pgfId-1531058][bookmark: 93051]Confi[bookmark: marker-1531056]guring Por[bookmark: Portscan]tscan Detection
 
     [bookmark: pgfId-1531063]License: Protection
 
     [bookmark: pgfId-1531064]The portscan detection configuration options allow you to finely tune how the portscan detector reports scan activity.
 
     [bookmark: pgfId-1558623]Note that when portscan detection is enabled, you must enable rules on the Rules page with generator ID (GID) 122 for enabled portscan types for the portscan detector to generate portscan events. See Setting Rule States and the Portscan Detection SIDs (GID:122) table for more information.
 
     [bookmark: pgfId-1531072]To configure portscan detection:
 
     [bookmark: pgfId-1566068]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1576511]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1576512]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1576517]The access control policy editor appears.
 
     [bookmark: pgfId-1576518]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1576519]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1576524]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1576525]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1576526]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1531080]If you have unsaved changes in another policy, click OK to discard those changes and continue. See [was Committing Intrusion Policy Changes; update xref] for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1531084]The Policy Information page appears.
 
     [bookmark: pgfId-1566337]Step 7 In the navigation panel on the left, click Settings.
 
     [bookmark: pgfId-1566412]The Settings page appears.
 
     [bookmark: pgfId-1531087]Step 8 You have two choices, depending on whether Portscan Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1531088]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531089]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1531090]The Portscan Detection page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1531094]Step 9 In the Protocol field, specify which of the following protocols you want to enable:
 
      
       
       	 [bookmark: pgfId-1531095]TCP
 
       	 [bookmark: pgfId-1531096]UDP
 
       	 [bookmark: pgfId-1531097]ICMP
 
       	 [bookmark: pgfId-1531098]IP
 
      
 
     
 
     [bookmark: pgfId-1531099]Use Ctrl or Shift while clicking to select multiple protocols or clear individual protocols. See the Protocol Types table for more information.
 
     [bookmark: pgfId-1531103]Note that you must ensure TCP stream processing is enabled to detect scans over TCP, and that UDP stream processing is enabled to detect scans over UDP. 
 
     [bookmark: pgfId-1531104]Step 10 In the Scan Type field, specify which of the following portscans you want to detect:
 
      
       
       	 [bookmark: pgfId-1531105]Portscan Detection 
 
       	 [bookmark: pgfId-1531106]Port Sweep
 
       	 [bookmark: pgfId-1531107]Decoy Portscan
 
       	 [bookmark: pgfId-1531108]Distributed Portscan
 
      
 
     
 
     [bookmark: pgfId-1531109]Use Ctrl or Shift while clicking to select or deselect multiple protocols. See the Portscan Types table for more information.
 
     [bookmark: pgfId-1531113]Step 11 In the Sensitivity Level list, select the level you want to use: low, medium, or high.
 
     [bookmark: pgfId-1531117]See the Sensitivity Levels table for more information.
 
     [bookmark: pgfId-1531118]Step 12 Optionally, in the Watch IP field, specify which host you want to watch for signs of portscan activity, or leave the field blank to watch all network traffic.
 
     [bookmark: pgfId-1531119]You can specify a single IP address or address block, or a comma-separated lists of either or both. For information on using IPv4 and IPv6 address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1531126]Step 13 Optionally, in the Ignore Scanners field, specify which hosts you want to ignore as scanners. Use this field to indicate hosts on your network that are especially active. You may need to modify this list of hosts over time.
 
     [bookmark: pgfId-1531127]You can specify a single IP address or address block, or a comma-separated lists of either or both. For information on using IPv4 and IPv6 address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1531134]Step 14 Optionally, in the Ignore Scanned field, specify which hosts you want to ignore as the target of a scan. Use this field to indicate hosts on your network that are especially active. You may need to modify this list of hosts over time.
 
     [bookmark: pgfId-1531135]You can specify a single IP address or address block, or a comma-separated lists of either or both. For information on using IPv4 and IPv6 address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1531142]Step 15 Optionally, clear the Detect Ack Scans check box to discontinue monitoring of sessions picked up in mid-stream. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1531143]Note Detection of mid-stream sessions helps to identify ACK scans, but may cause false events, particularly on networks with heavy traffic and dropped packets.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1562044]Step 16 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1551933]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1531161][bookmark: 91165]Understanding Portscan[bookmark: marker-1531160] Events
 
     [bookmark: pgfId-1531165]License: Protection
 
     [bookmark: pgfId-1531166]When portscan detection is enabled, you must enable rules with generator ID (GID) 122 and a Snort ID (SID) from among SIDs 1 through 27 to generate events for each enabled portscan type. See Setting Rule States for more information. The Preprocessor Rule SID column in the following table lists the SID for the preprocessor rule you must enable for each portscan type.
 
     [bookmark: pgfId-1531223]
 
      
       
        
        [bookmark: pgfId-1531176]Table 22-5 [bookmark: 48534]Portscan Detection SIDs (GID:122) 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531184]Portscan Type 
          
  
         	 
           
           [bookmark: pgfId-1531186]Protocol: 
          
  
         	 
           
           [bookmark: pgfId-1531188]Sensitivity Level 
          
  
         	 
           
           [bookmark: pgfId-1531190]Preprocessor Rule SID 
          
  
        
 
         
         	[bookmark: pgfId-1531192]Portscan Detection
  
         	[bookmark: pgfId-1531194]TCP 

UDP 

ICMP

IP
  
         	[bookmark: pgfId-1531196]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531198]1
5
17
21
Does not generate events.
Does not generate events.
9
13
  
        
 
         
         	[bookmark: pgfId-1531200]Port Sweep
  
         	[bookmark: pgfId-1531202]TCP

UDP

ICMP

IP
  
         	[bookmark: pgfId-1531204]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531206]3, 27
7
19
23
25
26
11
15
  
        
 
         
         	[bookmark: pgfId-1531208]Decoy Portscan
  
         	[bookmark: pgfId-1531210]TCP

UDP

ICMP

IP
  
         	[bookmark: pgfId-1531212]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531214]2
6
18
22
Does not generate events.
Does not generate events.
10
14
  
        
 
         
         	[bookmark: pgfId-1531216]Distributed Portscan
  
         	[bookmark: pgfId-1531218]TCP

UDP

ICMP

IP
  
         	[bookmark: pgfId-1531220]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531222]4
8
20
24
Does not generate events.
Does not generate events.
12
16
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1531224]When you enable the accompanying preprocessor rules, the portscan detector generates intrusion events that you can view just as you would any other intrusion event. However, the information presented on the packet view is different from the other types of intrusion events. This section describes the fields that appear on the packet view for a portscan event and how you can use that information to understand the types of probes that occur on your network.
 
     [bookmark: pgfId-1531225]Begin by using the intrusion event views to drill down to the packet view for a portscan event.
 
     [bookmark: pgfId-1531229]Note that you cannot download a portscan packet because single portscan events are based on multiple packets; however, the portscan packet view provides all usable packet information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1531230]Note For events generated by the portscan connection detector, the protocol number is set to 255. Because portscan does not have a specific protocol associated with it by default, the Internet Assigned Numbers Authority (IANA) does not have a protocol number assigned to it. IANA designates 255 as a reserved number, so that number is used in portscan events to indicate that there is not an associated protocol for the event.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1531239]Table 22-6 [bookmark: Portscan Packet View Information]Portscan Packet View 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531243]Information 
          
  
         	 
           
           [bookmark: pgfId-1531245]Description 
          
  
        
 
         
         	[bookmark: pgfId-1531247]Device
  
         	[bookmark: pgfId-1531249]The device that detected the event.
  
        
 
         
         	[bookmark: pgfId-1531251]Time
  
         	[bookmark: pgfId-1531253]The time when the event occurred.
  
        
 
         
         	[bookmark: pgfId-1531255]Message 
  
         	[bookmark: pgfId-1531257]The event message generated by the preprocessor.
  
        
 
         
         	[bookmark: pgfId-1531259]Source IP
  
         	[bookmark: pgfId-1531261]The IP address of the scanning host.
  
        
 
         
         	[bookmark: pgfId-1531263]Destination IP
  
         	[bookmark: pgfId-1531265]The IP address of the scanned host.
  
        
 
         
         	[bookmark: pgfId-1531267]Priority Count
  
         	[bookmark: pgfId-1531269]The number of negative responses (for example, TCP RSTs and ICMP unreachables) from the scanned host. The higher the number of negative responses, the higher the priority count.
  
        
 
         
         	[bookmark: pgfId-1531271]Connection Count
  
         	[bookmark: pgfId-1531273]The number of active connections on the hosts. This value is more accurate for connection-based scans such as TCP and IP.
  
        
 
         
         	[bookmark: pgfId-1531275]IP Count
  
         	[bookmark: pgfId-1531277]The number of times that the IP addresses that contact the scanned host changes. For example, if the first IP address is 10.1.1.1, the second IP is 10.1.1.2, and the third IP is 10.1.1.1, then the IP count is 3.
 [bookmark: pgfId-1531278]This number is less accurate for active hosts such as proxies and DNS servers.
  
        
 
         
         	[bookmark: pgfId-1531280]Scanner/Scanned IP Range
  
         	[bookmark: pgfId-1531282]The range of IP addresses for the scanned hosts or the scanning hosts, depending on the type of scan. For portsweeps, this field shows the IP range of scanned hosts. For portscans, this shows the IP range of the scanning hosts.
  
        
 
         
         	[bookmark: pgfId-1531284]Port/Proto Count
  
         	[bookmark: pgfId-1531286]For TCP and UDP portscans, the number of times that the port being scanned changes. For example, if the first port scanned is 80, the second port scanned is 8080, and the third port scanned is again 80, then the port count is 3.
 [bookmark: pgfId-1531287]For IP protocol portscans, the number of times that the protocol being used to connect to the scanned host changes.
  
        
 
         
         	[bookmark: pgfId-1531289]Port/Proto Range
  
         	[bookmark: pgfId-1531291]For TCP and UDP portscans, the range of the ports that were scanned.
 [bookmark: pgfId-1531292]For IP protocol portscans, the range of IP protocol numbers that were used to attempt to connect to the scanned host.
  
        
 
         
         	[bookmark: pgfId-1531294]Open Ports
  
         	[bookmark: pgfId-1531296]The TCP ports that were open on the scanned host. This field appears only when the portscan detects one or more open ports.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531301]Preventing [bookmark: 17387]Rate-Base[bookmark: marker-1531299]d Attacks
 
    [bookmark: pgfId-1531306]License: Protection
 
    [bookmark: pgfId-1531307]Rate-based attacks are attacks that depend on frequency of connection or repeated attempts to perpetrate the attack. You can use rate-based detection criteria to detect a rate-based attack as it occurs and respond to it when it happens, then return to normal detection settings after it stops. For more information on configuring rate-based detection, see the following topics:
 
     
     	 [bookmark: pgfId-1531311]Understanding Rate-Based Attack Prevention
 
     	 [bookmark: pgfId-1531315]Rate-Based Attack Prevention and Other Filters
 
     	 [bookmark: pgfId-1531319]Configuring Rate-Based Attack Prevention
 
     	 [bookmark: pgfId-1531323]Understanding Dynamic Rule States
 
     	 [bookmark: pgfId-1531327]Setting a Dynamic Rule State
 
    
 
     
      [bookmark: pgfId-1531330][bookmark: 85295]Understanding Rate-Based [bookmark: marker-1531329]Attack Prevention
 
     [bookmark: pgfId-1531334]License: Protection
 
     [bookmark: pgfId-1531335]You can configure your network analysis policy to include rate-based filters that detect excessive activity directed at hosts on your network. You can use this feature on a device deployed in inline mode to block rate-based attacks for a specified time, then revert to only generating events and not drop traffic. 
 
     [bookmark: pgfId-1531336]Rate-based attack prevention identifies abnormal traffic patterns and attempts to minimize the impact of that traffic on legitimate requests. Rate-based attacks usually have one of the following characteristics:
 
      
      	 [bookmark: pgfId-1531337]any traffic containing excessive incomplete connections to hosts on the network, indicating a SYN flood attack
 
     
 
     [bookmark: pgfId-1531340]To configure SYN attack detection, see Preventing SYN Attacks.
 
      
      	 [bookmark: pgfId-1531342]any traffic containing excessive complete connections to hosts on the network, indicating a TCP/IP connection flood attack
 
     
 
     [bookmark: pgfId-1531345]To configure simultaneous connection detection, see Controlling Simultaneous Connections.
 
      
      	 [bookmark: pgfId-1531347]excessive rule matches in traffic going to a particular destination IP address or addresses or coming from a particular source IP address or addresses. 
 
     
 
     [bookmark: pgfId-1531350]To configure source or destination-based dynamic rule states, see Setting a Dynamic Rule State.
 
      
      	 [bookmark: pgfId-1531352]excessive matches for a particular rule across all traffic. 
 
     
 
     [bookmark: pgfId-1531355]To configure rule-based dynamic rule states, see Setting a Dynamic Rule State.
 
     [bookmark: pgfId-1531357]In a network analysis policy, you can either configure SYN flood or TCP/IP connection flood detection for the entire policy; in an intrusion policy, you can set rate-based filters for individual intrusion or preprocessor rules. Note that manually adding a rate-based filter to rules 135:1 and 135:2 has no effect. Rules with GID:135 use the client as the source value and the server as the destination value. See Preventing SYN Attacks and Controlling Simultaneous Connections for more information.
 
     [bookmark: pgfId-1531364]Each rate-based filter contains several components: 
 
      
      	 [bookmark: pgfId-1531365]for policy-wide or rule-based source or destination settings, the network address designation
 
      	 [bookmark: pgfId-1531366]the rule matching rate, which you configure as a count of rule matches within a specific number of seconds
 
      	 [bookmark: pgfId-1531367]a new action to be taken when the rate is exceeded
 
     
 
     [bookmark: pgfId-1531368]When you set a rate-based setting for the entire policy, the system generates events when it detects a rate-based attack, and optionally can drop the traffic in an inline deployment. When setting rate-based actions for individual rules, you have three available actions: Generate Events, Drop and Generate Events, and Disable.
 
      
      	 [bookmark: pgfId-1531369]the duration of the action, which you configure as a timeout value
 
     
 
     [bookmark: pgfId-1531370]Note that when started, the new action occurs until the timeout is reached, even if the rate falls below the configured rate during that time period. When the timeout period expires, if the rate has fallen below the threshold, the action for the rule reverts to the action initially configured for the rule. For policy-wide settings, the action reverts to the action of each rule the traffic matches or stops if it does not match any rules.
 
     [bookmark: pgfId-1531371]You can configure rate-based attack prevention in an inline deployment to block attacks, either temporarily or permanently. Without rate-based configuration, rules set to Generate Events create events, but the system does not drop packets for those rules. However, if the attack traffic matches rules that have rate-based criteria configured, the rate action may cause packet dropping to occur for the period of time that the rate action is active, even if those rules are not initially set to Drop and Generate Events. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1531372]Note Rate-based actions cannot enable disabled rules or drop traffic that matches disabled rules. However, if you set a rate-based filter at the policy level, you can generate events on or generate events on and drop traffic that contains an excessive number of SYN packets or SYN/ACK interactions within a designated time period.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1531373]You can define multiple rate-based filters on the same rule. The first filter listed in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the system implements the action of the first rate-based filter. Similarly, policy-wide rate-based filters override rate-based filters set on individual rules if the filters conflict. 
 
     [bookmark: pgfId-1531374]The following diagram shows an example where an attacker is attempting to access a host. Repeated attempts to find a password trigger a rule which has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events after rule matches occur five times in a 10-second span. The new rule attribute times out after 15 seconds. 
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1531387][bookmark: 25426]Preventing [bookmark: marker-1531385]SYN Attacks
 
     [bookmark: pgfId-1531391]License: Protection
 
     [bookmark: pgfId-1531393]The SYN attack prevention option helps you protect your network hosts against SYN floods. You can protect individual hosts or whole networks based on the number of packets seen over a period of time. If your device is deployed passively, you can generate events. If your device is placed inline, you can also drop the malicious packets. After the timeout period elapses, if the rate condition has stopped, the event generation and packet dropping stops.
 
     [bookmark: pgfId-1531394]For example, you could configure a setting to allow a maximum of 10 SYN packets from any one IP address, and block further connections from that IP address for 60 seconds.
 
     [bookmark: pgfId-1531395]Enabling this option also activates rule 135:1. Manually activating this rule has no effect. The rule state is always displayed as Disabled, and never changes. The rule generates events when this option is enabled and a defined rate condition is exceeded.
 
    
 
     
      [bookmark: pgfId-1531400][bookmark: 10682]Controlling Simultaneous Connection[bookmark: marker-1531398][bookmark: marker-1531399]s
 
     [bookmark: pgfId-1531404]License: Protection
 
     [bookmark: pgfId-1531406]You can also limit TCP/IP connections to or from hosts on your network to prevent denial of service (DoS) attacks or excessive activity by users. When the system detects the configured number of successful connections to or from a specified IP address or range of addresses, it generates events on additional connections. The rate-based event generation continues until the timeout period elapses without the rate condition occurring. In an inline deployment you can choose to drop packets until the rate condition times out.
 
     [bookmark: pgfId-1531407]For example, you could configure a setting to allow a maximum of 10 successful simultaneous connections from any one IP address, and block further connections from that IP address for 60 seconds.
 
     [bookmark: pgfId-1531408]Enabling this option also activates rule 135:2. Manually activating this rule has no effect. The rule state is always displayed as Disabled, and never changes. The rule generates events when this option is enabled and a defined rate condition is exceeded.
 
    
 
     
      [bookmark: pgfId-1531411][bookmark: 57013]Rate-Based Attack Pre[bookmark: marker-1531410]vention and Other Filters
 
     [bookmark: pgfId-1531415]License: Protection
 
     [bookmark: pgfId-1531416]The detection_filter keyword and the thresholding and suppression features provide other ways to filter either the traffic itself or the events that the system generates. You can use rate-based attack prevention alone or in any combination with thresholding, suppression, or the detection_filter keyword. 
 
     [bookmark: pgfId-1531417]See the following examples for more information:
 
      
      	 [bookmark: pgfId-1531421]Rate-Based Attack Prevention and Detection Filtering
 
      	 [bookmark: pgfId-1531425]Dynamic Rule States and Thresholding or Suppression
 
      	 [bookmark: pgfId-1531428]Policy-Wide Rate-Based Detection and Thresholding or Suppression
 
      	 [bookmark: pgfId-1531433]Rate-Based Detection with Multiple Filtering Methods
 
     
 
    
 
     
      [bookmark: pgfId-1531436][bookmark: 99237]Rate-Based [bookmark: marker-1531435]Attack Prevention and Detection Filtering
 
     [bookmark: pgfId-1531440]License: Protection
 
     [bookmark: pgfId-1531442]The detection_filter keywor[bookmark: marker-1531441]d prevents a rule from triggering until a threshold number of rule matches occur within a specified time. When a rule includes the detection_filter keyword, the system tracks the number of incoming packets matching the pattern in the rule per timeout period. The system can count hits for that rule from particular source or destination IP addresses. After the rate exceeds the rate in the rule, event notification for that rule begins. 
 
     [bookmark: pgfId-1531443]The following example shows an attacker attempting a brute-force login. Repeated attempts to find a password trigger a rule that also includes the detection_filter keyword, with a count set to 5. This rule has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events for 20 seconds when there are five hits on the rule in a 10-second span.
 
     [bookmark: pgfId-1531444]As shown in the diagram, the first five packets matching the rule do not generate events because the rule does not trigger until the rate exceeds the rate indicated by the detection_filter keyword. After the rule triggers, event notification begins, but the rate-based criteria do not trigger the new action of Drop and Generate Events until five more packets pass. 
 
     [bookmark: pgfId-1531445]After the rate-based criteria are met, events are generated and the packets are dropped until the rate-based timeout period expires and the rate falls below the threshold. After twenty seconds elapse, the rate-based action times out. After the timeout, note that packets are still dropped in the rate-based sampling period that follows. Because the sampled rate is above the threshold rate in the previous sampling period when the timeout happens, the rate-based action continues.
 
     [bookmark: pgfId-1613608]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531454]Note that although the example does not depict this, you can use the Drop and Generate Events rule state in combination with the detection_filter keyword to start dropping traffic when hits for the rule reach the specified rate. When deciding whether to configure rate-based settings for a rule, consider whether setting the rule to Drop and Generate Events and including the detection_filter keyword would achieve the same result, or whether you want to manage the rate and timeout settings in the intrusion policy. For more information, see Setting Rule States.
 
    
 
     
      [bookmark: pgfId-1531460][bookmark: 70325]Dynamic Rule States and Thresholding or Suppress[bookmark: marker-1531459]ion
 
     [bookmark: pgfId-1531464]License: Protection
 
     [bookmark: pgfId-1531465]You can use thresholding and suppression to reduce excessive events by limiting the number of event notifications for a rule or by suppressing notifications altogether for that rule. For more information on the available options for thresholding and suppression, see Configuring Event Thresholding and Configuring Suppression Per Intrusion Policy.
 
     [bookmark: pgfId-1531472]If you apply suppression to a rule, the system suppresses event notifications for that rule for all applicable IP addresses even if a rate-based action change occurs. However, the interaction between thresholding and rate-based criteria is more complex. 
 
     [bookmark: pgfId-1531473]The following example shows an attacker attempting a brute-force login. Repeated attempts to find a password trigger a rule that has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events for 15 seconds when there are five hits on the rule in 10 seconds. In addition, a limit threshold limits the number of events the rule can generate to 10 events in 23 seconds. 
 
     [bookmark: pgfId-1531474]As shown in the diagram, the rule generates events for the first five matching packets. After five packets, the rate-based criteria trigger the new action of Drop and Generate Events, and for the next five packets the rule generates events and the system drops the packet. After the tenth packet, the limit threshold has been reached, so for the remaining packets the system does not generate events but does drop the packets.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531484]Note that although it is not shown in this example, if a new action triggers because of rate-based criteria after a threshold has been reached, the system generates a single event to indicate the change in action. So, for example, when the limit threshold of 10 is reached and the system stops generating events and the action changes from Generate Events to Drop and Generate Events on the 14th packet, the system generates an eleventh event to indicate the change in action. 
 
    
 
     
      [bookmark: pgfId-1531489][bookmark: 14803]Policy-Wide Rate-Based Detection and [bookmark: marker-1531486]Thresholding or Sup[bookmark: marker-1531487][bookmark: marker-1531488]pression
 
     [bookmark: pgfId-1531493]License: Protection
 
     [bookmark: pgfId-1531494]You can use thresholding and suppression to reduce excessive events by limiting the number of event notifications for a source or destination or by suppressing notifications altogether for that rule. For more information on the available options for thresholding and suppression, see Configuring Global Thresholds, Configuring Event Thresholding, and Configuring Suppression Per Intrusion Policy.
 
     [bookmark: pgfId-1531504]If suppression is applied to a rule, event notifications for that rule for all applicable IP addresses are suppressed even if a rate-based action change occurs because of a policy-wide or rule-specific rate-based setting. However, the interaction between thresholding and rate-based criteria is more complex. 
 
     [bookmark: pgfId-1531505]The following example shows an attacker attempting denial of service (DoS) attacks on hosts in your network. Many simultaneous connections to hosts from the same sources trigger a policy-wide Control Simultaneous Connections setting. The setting generates events and drops malicious traffic when there are five connections from one source in 10 seconds. In addition, a global limit threshold limits the number of events any rule or setting can generate to 10 events in 20 seconds. 
 
     [bookmark: pgfId-1531506]As shown in the diagram, the policy-wide setting generates events for the first ten matching packets and drops the traffic. After the tenth packet, the limit threshold is reached, so for the remaining packets no events are generated but the packets are dropped.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531516]Note that although it is not shown in this example, if a new action triggers because of rate-based criteria after a threshold has been reached, the system generates a single event to indicate the change in action. So, for example, if the limit threshold of 10 has been reached and the system stops generating events and the action changes to Drop and Generate events on the 14th packet, the system generates an eleventh event to indicate the change in action. 
 
    
 
     
      [bookmark: pgfId-1531519][bookmark: 65399]Rate-Based Detection with [bookmark: marker-1531518]Multiple Filtering Methods
 
     [bookmark: pgfId-1531523]License: Protection
 
     [bookmark: pgfId-1531524]You may encounter situations where the detection_filter keyword, thresholding or suppression, and rate-based criteria all apply to the same traffic. When you enable suppression for a rule, events are suppressed for the specified IP addresses even if a rate-based change occurs. 
 
     [bookmark: pgfId-1531525]The following example shows an attacker attempting a brute force login, and describes a case where a detection_filter keyword, rate-based filtering, and thresholding interact. Repeated attempts to find a password trigger a rule which includes the detection_filter keyword, with a count set to 5. This rule also has rate-based attack prevention settings that change the rule attribute to Drop and Generate Events for 30 seconds when there are five rule hits in 15 seconds. In addition, a limit threshold limits the rule to 10 events in 30 seconds. 
 
     [bookmark: pgfId-1531526]As shown in the diagram, the first five packets matching the rule do not cause event notification because the rule does not trigger until the rate indicated in the detection_filter keyword is exceeded. After the rule triggers, event notification begins, but the rate-based criteria do not trigger the new action of Drop and Generate Events until five more packets pass. After the rate-based criteria are met, the system generates events for packets 11-15 and drops the packets. After the fifteenth packet, the limit threshold has been reached, so for the remaining packets the system does not generate events but does drop the packets.
 
     [bookmark: pgfId-1531527]After the rate-based timeout, note that packets are still dropped in the rate-based sampling period that follows. Because the sampled rate is above the threshold rate in the previous sampling period, the new action continues. 
 
     [bookmark: pgfId-1613632]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1531538][bookmark: 58910]Configuring Rate-Based Attack [bookmark: marker-1531537]Prevention
 
     [bookmark: pgfId-1531542]License: Protection
 
     [bookmark: pgfId-1531543]You can configure rate-based attack prevention at the policy level to stop SYN flood attacks. You can also stop excessive connections from a specific source or to a specific destination.
 
     [bookmark: pgfId-1531544]To configure rate-based attack prevention:
 
     [bookmark: pgfId-1531545]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1576559]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1576560]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1576565]The access control policy editor appears.
 
     [bookmark: pgfId-1576566]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1576567]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1576572]The Network Analysis and Intrusion Policies pop-up window appears.
 
     [bookmark: pgfId-1576573]Step 5 Click Network Analysis Policy List.
 
     [bookmark: pgfId-1576574]The Network Analysis Policy List pop-up window appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1531552]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1531556]The Policy Information page appears.
 
     [bookmark: pgfId-1566819]Step 7 In the navigation panel on the left, click Settings.
 
     [bookmark: pgfId-1566879]The Settings page appears.
 
     [bookmark: pgfId-1531559]Step 8 You have two choices, depending on whether Rate-Based Attack Prevention under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1531560]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531561]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1531562]The Rate-Based Attack Prevention page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1531566]Step 9 You have two options:
 
      
       
       	 [bookmark: pgfId-1531567]To prevent incomplete connections intended to flood a host, click  Add under  SYN Attack Prevention .
 
      
 
     
 
     [bookmark: pgfId-1531568]The SYN Attack Prevention dialog box appears.
 
      
       
       	 [bookmark: pgfId-1531569]To prevent excessive numbers of connections, click  Add under  Control Simultaneous Connections .
 
      
 
     
 
     [bookmark: pgfId-1531570]The Control Simultaneous Connections dialog box appears.
 
     [bookmark: pgfId-1531571]Step 10 Select how you want to track traffic:
 
      
       
       	 [bookmark: pgfId-1531572]To track all traffic from a specific source or range of sources, select  Source from the  Track By drop-down list and type a single IP address or address block in the  Network field.
 
       	 [bookmark: pgfId-1531573]To track all traffic to a specific destination or range of destinations, select  Destination from the  Track By drop-down list and type an IP address or address block in the  Network field.
 
      
 
     
 
     [bookmark: pgfId-1531574]Note that the system tracks traffic separately for each IP address included in the Network field. Traffic from an IP address that exceeds the configured rate results in generated events only for that IP address. As an example, you might set a source CIDR block of 10.1.0.0/16 for the network setting and configure the system to generate events when there are ten simultaneous connections open. If eight connections are open from 10.1.4.21 and six from 10.1.5.10, the system does not generate events, because neither source has the triggering number of connections open. However, if eleven simultaneous connections are open from 10.1.4.21, the system generates events only for the connections from 10.1.4.21.
 
     [bookmark: pgfId-1531577]For information on using CIDR notation and prefix lengths, see IP Address Conventions.
 
     [bookmark: pgfId-1531582]Step 11 Indicate the triggering rate for the rate tracking setting:
 
      
       
       	 [bookmark: pgfId-1531583]For SYN attack configuration, indicate the number of SYN packets per number of seconds in the  Rate fields.
 
       	 [bookmark: pgfId-1531584]For simultaneous connection configuration, indicate the number of connections in the  Count field.
 
      
 
     
 
     [bookmark: pgfId-1531585]Step 12 To drop packets matching the rate-based attack prevention settings, select Drop. 
 
     [bookmark: pgfId-1531586]Step 13 In the Timeout field, indicate the time period after which to stop generating events, and if applicable, dropping, for traffic with the matching pattern of SYNs or simultaneous connections.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1531587] 
      Caution Timeout values can be integers from 1 to 1,000,000. However, setting a high timeout value may entirely block connection to a host in an inline deployment. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1561992]Step 14 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1551968]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531594][bookmark: 26296]Detecting Se[bookmark: marker-1531593]nsitive Data
 
    [bookmark: pgfId-1531598]License: Protection
 
    [bookmark: pgfId-1531599]Sensitive data such as Social Security numbers, credit card numbers, driver’s license numbers, and so on may be leaked onto the Internet, intentionally or accidentally. The system provides a sensitive data preprocessor that can detect and generate events on sensitive data in ASCII text, which can be particularly useful in detecting accidental data leaks.
 
    [bookmark: pgfId-1531600]The system does not detect encrypted or obfuscated sensitive data, or sensitive data in a compressed or encoded format such as a Base64-encoded email attachment. For example, the system would detect the phone number (555)123-4567, but not an obfuscated version where each number is separated by spaces, as in (5 5 5) 1 2 3 - 4 5 6 7, or by intervening HTML code, such as <b>(555)</b>-<i>123-4567</i>. However, the system would detect, for example, the HTML coded number <b>(555)-123-4567</b> where no intervening codes interrupt the numbering pattern.
 
     
      
    
 
    
 
    [bookmark: pgfId-1531601]Tip The sensitive data preprocessor can detect sensitive data in unencrypted Microsoft Word files that are uploaded and downloaded using FTP or HTTP; this is possible because of the way Word files group ASCII text and formatting commands separately.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1566945]The system detects sensitive data per TCP session by matching individual data types against traffic. You can modify the default settings for each data type and for global options that apply to all data types in your intrusion policy. Cisco provides predefined, commonly used data types. You can also create custom data types.
 
    [bookmark: pgfId-1566949]A sensitive data preprocessor rule is associated with each data type. You enable sensitive data detection and event generation for each data type by enabling the corresponding preprocessor rule for the data type. A link on the configuration page takes you to a filtered view of sensitive data rules on the Rules page, where you can enable and disable rules and configure other rule attributes. 
 
    [bookmark: pgfId-1566976]When you save changes to your intrusion policy, you are given the option to automatically enable the sensitive data preprocessor if the rule associated with a data type is enabled and sensitive data detection is disabled.
 
    [bookmark: pgfId-1531614]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531618]Deploying Sensitive Data Detection
 
     	 [bookmark: pgfId-1531622]Selecting Global Sensitive Data Detection Options
 
     	 [bookmark: pgfId-1531626]Selecting Individual Data Type Options
 
     	 [bookmark: pgfId-1531630]Using Predefined Data Types
 
     	 [bookmark: pgfId-1531634]Configuring Sensitive Data Detection
 
     	 [bookmark: pgfId-1531638]Selecting Application Protocols to Monitor
 
     	 [bookmark: pgfId-1531642]Special Case: Detecting Sensitive Data in FTP Traffic
 
     	 [bookmark: pgfId-1531646]Using Custom Data Types
 
    
 
     
      [bookmark: pgfId-1531649][bookmark: 23336]Deploying [bookmark: marker-1531648]Sensitive Data Detection
 
     [bookmark: pgfId-1531653]License: Protection
 
     [bookmark: pgfId-1531654]Because sensitive data detection can have a high impact on the performance of your system, Cisco recommends that you adhere to the following guidelines:
 
      
      	 [bookmark: pgfId-1573108]Select the No Rules Active default policy as your base intrusion policy; see Understanding System-Provided Base Policies for more information.
 
      	 [bookmark: pgfId-1573110]Ensure that the following settings are enabled in the corresponding network analysis policy:
 
     
 
     [bookmark: pgfId-1573218] – FTP and Telnet Configuration under Application Layer Preprocessors
 
     [bookmark: pgfId-1573293] – IP Defragmentation and TCP Stream Configuration under Transport/Network Layer Preprocessors.
 
      
      	 [bookmark: pgfId-1573112]Apply the access control policy that includes the intrusion policy containing your sensitive data configuration to a device reserved for sensitive data detection; see Deploying Configuration Changes for more information.
 
     
 
    
 
     
      [bookmark: pgfId-1531675][bookmark: 68017]Selecting Global Se[bookmark: marker-1531674]nsitive Data Detection Options
 
     [bookmark: pgfId-1531679]License: Protection
 
     [bookmark: pgfId-1531680]Global sensitive data preprocessor options control how the preprocessor functions. You can modify global options that specify the following:
 
      
      	 [bookmark: pgfId-1531681]whether the preprocessor replaces all but the last four credit card or Social Security numbers in triggering packets
 
      	 [bookmark: pgfId-1531682]which destination hosts on your network to monitor for sensitive data
 
      	 [bookmark: pgfId-1531683]how many total occurrences of all data types in a single session result in an event
 
     
 
     [bookmark: pgfId-1531684]Note that global sensitive data options are policy-specific and apply to all data types.
 
     [bookmark: pgfId-1563035]You can configure the following global sensitive data detection options.
 
     [bookmark: pgfId-1563128][bookmark: 63470]Mask
 
     [bookmark: pgfId-1563130]Replaces with Xs all but the last four digits of credit card numbers and Social Security numbers in the triggering packet. The masked numbers appear in the intrusion event packet view in the user interface and in downloaded packets.
 
     [bookmark: pgfId-1563135]Networks
 
     [bookmark: pgfId-1576123]Specifies the destination host or hosts to monitor for sensitive data. You can specify a single IP address, address block, or a comma-separated list of either or both. The system interprets a blank field as any, meaning any destination IP address. For information on using IPv4 and IPv6 address blocks, see IP Address Conventions.
 
     [bookmark: pgfId-1576127]Global Threshold
 
     [bookmark: pgfId-1563147]Specifies the total number of all occurrences of all data types during a single session that the preprocessor must detect in any combination before generating a global threshold event. You can specify 1 through 65535.
 
     [bookmark: pgfId-1563151]Cisco recommends that you set the value for this option higher than the highest threshold value for any individual data type that you enable in your policy. See Selecting Individual Data Type Options for more information.
 
     [bookmark: pgfId-1563155]Note the following points regarding global thresholds:
 
     [bookmark: pgfId-1563156] – You must enable preprocessor rule 139:1 to detect and generate events on combined data type occurrences. See Setting Rule States for information on enabling rules in your intrusion policy.
 
     [bookmark: pgfId-1563160] – The preprocessor generates up to one global threshold event per session.
 
     [bookmark: pgfId-1563161] – Global threshold events are independent of individual data type events; that is, the preprocessor generates an event when the global threshold is reached, regardless of whether the event threshold for any individual data type has been reached, and vice versa.
 
    
 
     
      [bookmark: pgfId-1563087][bookmark: 45886]Selecting Individu[bookmark: marker-1563086]al Data Type Options
 
     [bookmark: pgfId-1531741]License: Protection
 
     [bookmark: pgfId-1531742]Individual data types identify the sensitive data you can detect and generate events on in your specified destination network traffic. You can modify default settings for data type options that specify the following:
 
      
      	 [bookmark: pgfId-1531743]a threshold that must be met for a detected data type to generate a single per-session event
 
      	 [bookmark: pgfId-1531744]the destination ports to monitor for each data type
 
      	 [bookmark: pgfId-1531745]the application protocols to monitor for each data type
 
     
 
     [bookmark: pgfId-1531746]At a minimum, each data type must specify an event threshold and at least one port or application protocol to monitor.
 
     [bookmark: pgfId-1531750]Each predefined data type provided by Cisco uses an otherwise inaccessible sd_pattern keyword to define a built-in data pattern to detect in traffic. See Table 22-8 for a listing of predefined data types. You can also create custom data types for which you use simple regular expressions to specify your own data patterns. See Using Custom Data Types for more information.
 
     [bookmark: pgfId-1531757]Note that data type names and patterns are system-wide; all other data type options are policy-specific.
 
     [bookmark: pgfId-1531758]The following table describes the data type options you can configure.
 
     [bookmark: pgfId-1531821]
 
      
       
        
        [bookmark: pgfId-1531765]Table 22-7 [bookmark: 62491]Individual Data Type Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531769]Option 
          
  
         	 
           
           [bookmark: pgfId-1531771]Description 
          
  
        
 
         
         	[bookmark: pgfId-1531773]Data Type
  
         	[bookmark: pgfId-1531775]Displays the unique name for the data type.
  
        
 
         
         	[bookmark: pgfId-1531777]Threshold
  
         	[bookmark: pgfId-1531779]Specifies the number of occurrences of the data type when the system generates an event. You receive an error message when you save the policy if you do not set a threshold for an enabled data type. You can specify 1 through 255.
 [bookmark: pgfId-1531780]Note that the preprocessor generates one event for a detected data type per session. Note also that global threshold events are independent of individual data type events; that is, the preprocessor generates an event when the data type event threshold is reached, regardless of whether the global event threshold has been reached, and vice versa.
  
        
 
         
         	[bookmark: pgfId-1531782]Destination Ports
  
         	[bookmark: pgfId-1531784]Specifies destination ports to monitor for the data type. You can specify a single port, a comma-separated list of ports, or any, meaning any destination port. You receive an error message when you save the policy if you enable the rule for a data type without setting at least one port or application protocol for the data type.
  
        
 
         
         	[bookmark: pgfId-1562646]Application Protocols
 [bookmark: pgfId-1531786]Note that this feature requires a Control license.
  
         	[bookmark: pgfId-1531795]Specifies up to eight application protocols to monitor for the data type. You receive an error message when you save the policy if you enable the rule for a data type without setting at least one port or application protocol for the data type.
 [bookmark: pgfId-1531809]See Selecting Application Protocols to Monitor for detailed instructions for selecting application protocols for data types.
  
        
 
         
         	[bookmark: pgfId-1531811]Pattern
  
         	[bookmark: pgfId-1531813]For a custom data type, the specified pattern to detect (data patterns for data types provided by Cisco are predefined). See Using Custom Data Types for more information. The user interface does not display built-in patterns for predefined data types.
 [bookmark: pgfId-1531820]Note that custom and predefined data patterns are system-wide.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1531824][bookmark: 75689]Using Predefined [bookmark: marker-1531823]Data Types
 
     [bookmark: pgfId-1531828]License: Protection
 
     [bookmark: pgfId-1531829]Each intrusion policy includes predefined data types for detecting commonly used data patterns such as credit card numbers, email addresses, U.S. phone numbers, and U.S. Social Security numbers with and without dashes. Each predefined data type is associated with a single sensitive data preprocessor rule that has a generator ID (GID) of 138. You must enable the associated sensitive data rule in the intrusion policy to enable detection, and event generation, for each data type you want to use in your policy. See Setting Rule States for information on enabling rules in an intrusion policy.
 
     [bookmark: pgfId-1531833]To help you enable sensitive data rules, a link on the configuration page takes you to a filtered view of the Rules page that displays all predefined and custom sensitive data rules. You can also display only predefined sensitive data rules by selecting the sensitive-data rule filtering category on the Rules page. See Filtering Rules in an Intrusion Policy for more information. Predefined sensitive data rules are also listed on the Rule Editor page (Policies > Intrusion > Rule Editor), where you can view but not edit them under the sensitive-data rule category.
 
      
       
        
        [bookmark: pgfId-1562556]Table 22-8 [bookmark: 72263]Sensitive Data Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1562562]Data Type 
          
  
         	 
           
           [bookmark: pgfId-1562564]Description 
          
  
         	 
           
           [bookmark: pgfId-1562566]Preprocessor Rule GID:SID 
          
  
        
 
         
         	[bookmark: pgfId-1562568]Credit Card Numbers
  
         	[bookmark: pgfId-1562570]Matches Visa, MasterCard, Discover and American Express fifteen- and sixteen-digit credit card numbers, with or without their normal separating dashes or spaces; also uses the Luhn algorithm to verify credit card check digits.
  
         	[bookmark: pgfId-1562572]138:2
  
        
 
         
         	[bookmark: pgfId-1562574]Email Addresses
  
         	[bookmark: pgfId-1562576]Matches email addresses.
  
         	[bookmark: pgfId-1562578]138:5
  
        
 
         
         	[bookmark: pgfId-1562580]U.S. Phone Numbers
  
         	[bookmark: pgfId-1562582]Matches U.S. phone numbers adhering to the pattern (\d{3}) ?\d{3}-\d{4}.
  
         	[bookmark: pgfId-1562584]138:6
  
        
 
         
         	[bookmark: pgfId-1562586]U.S. Social Security Numbers Without Dashes
  
         	[bookmark: pgfId-1562588]Matches 9-digit U.S. Social Security numbers that have valid 3-digit area numbers, valid 2-digit group numbers, and do not have dashes.
  
         	[bookmark: pgfId-1562590]138:4
  
        
 
         
         	[bookmark: pgfId-1562592]U.S. Social Security Numbers With Dashes
  
         	[bookmark: pgfId-1562594]Matches 9-digit U.S. Social Security numbers that have valid 3-digit area numbers, valid 2-digit group numbers, and dashes.
  
         	[bookmark: pgfId-1562596]138:3
  
        
 
         
         	[bookmark: pgfId-1562604]Custom
  
         	[bookmark: pgfId-1562608]Matches a user-defined data pattern in the specified traffic. See Using Custom Data Types for more information.
  
         	[bookmark: pgfId-1562611]138:>999999
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1531901]To reduce false positives from 9-digit numbers other than Social Security numbers, the preprocessor uses an algorithm to validate the 3-digit area number and 2-digit group number that precede the 4-digit serial number in each Social Security number. The preprocessor validates Social Security group numbers through November 2009.
 
    
 
     
      [bookmark: pgfId-1531905][bookmark: 50107]Configuring Sensitiv[bookmark: marker-1531904]e Data Detection
 
     [bookmark: pgfId-1531910]License: Protection
 
     [bookmark: pgfId-1531911]You can modify default global settings and settings for individual data types. You must also enable the preprocessor rule for each data type you want to detect.
 
     [bookmark: pgfId-1531912]If you enable sensitive data preprocessor rules in your policy without enabling sensitive data detection, you are prompted to enable sensitive data detection when you save changes to your policy. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1531916]The following table describes actions you can take on the Sensitive Data Detection page.
 
     [bookmark: pgfId-1531994]
 
      
       
        
        [bookmark: pgfId-1531923]Table 22-9 [bookmark: 87329]Sensitive Data Configuration Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531927]To... 
          
  
         	 
           
           [bookmark: pgfId-1531929]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1531931]modify global settings
  
         	[bookmark: pgfId-1531936]see Table 22-6 for information on the global settings you can modify.
  
        
 
         
         	[bookmark: pgfId-1531938]modify data type options
  
         	[bookmark: pgfId-1531940]click the data type name in the Targets page area.
 [bookmark: pgfId-1531941]The Configuration page area updates to display the current settings for the data type. See the Individual Data Type Options table for information on the options you can modify.
  
        
 
         
         	[bookmark: pgfId-1531946]add or remove application protocols to monitor for a data type
 [bookmark: pgfId-1531947]Note that this feature requires a Control license.
  
         	[bookmark: pgfId-1531955]click inside the Application Protocols field, or click Edit next to the field. The Application Protocols pop-up window appears:
 
           
           	 [bookmark: pgfId-1531956]To add up to eight application protocols to monitor, select one or more application protocols from the  Available list on the left, then click the right arrow ( > ) button.
 
           	 [bookmark: pgfId-1531957]To remove an application protocol, select it from the  Enabled list on the right, then click the left arrow ( < ) button.
 
          
 [bookmark: pgfId-1531958]Use Ctrl or Shift while clicking to select multiple application protocols. You can also click and drag to select multiple adjacent application protocols.
 application protocol. See Special Case: Detecting Sensitive Data in FTP Traffic for more information.
  
        
 
         
         	[bookmark: pgfId-1531974]create a custom data type
  
         	[bookmark: pgfId-1531976]click the + sign next to Data Types on the left side of the page. The Add Data Type pop-up window appears.
 [bookmark: pgfId-1531977]Specify a unique data type name and the pattern you want to detect with this data type and click OK, or click Cancel to abandon your edits. See Using Custom Data Types for more information.
  
        
 
         
         	[bookmark: pgfId-1531982]display sensitive data preprocessor rules 
  
         	[bookmark: pgfId-1531984]click the Configure Rules for Sensitive Data Detection link above the Global Settings page area. A listing of all sensitive data preprocessor rules appears in a filtered display of the Rules page.
 [bookmark: pgfId-1531985]Optionally, you can enable or disable any of the listed rules. Note that you must enable the sensitive data preprocessor rule for each data type that you want to use in your intrusion policy. See Setting Rule States for more information.
 [bookmark: pgfId-1531989]You can also configure sensitive data rules for any of the other actions available on the Rules page, such as rule suppression, rate-based attack prevention, and so on; see Tuning Intrusion Policies Using Rules for more information.
 [bookmark: pgfId-1531993]Click Back to return to the Sensitive Data Detection page.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1531995]To configure sensitive data detection:
 
     
 
     [bookmark: pgfId-1576754]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1568580]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532003]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532007]The Policy Information page appears.
 
     [bookmark: pgfId-1532008]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532009]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532010]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532011]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532012]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532013]The Sensitive Data Detection page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532019]Step 5 You can take any of the actions described in the Sensitive Data Configuration Actions table.
 
     [bookmark: pgfId-1562008]Step 6 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1551988]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532027][bookmark: 47428]Selecting Application Protocol[bookmark: marker-1532026]s to Monitor
 
     [bookmark: pgfId-1532031]License: Control
 
     [bookmark: pgfId-1532032]You can specify up to eight application protocols to monitor for each data type.
 
     [bookmark: pgfId-1532046]You must specify at least one application protocol or port to monitor for each data type. However, except in the case where you want to detect sensitive data in FTP traffic, Cisco recommends for the most complete coverage that you specify corresponding ports when you specify application protocols. For example, if you specify HTTP, you might also configure the well-known HTTP port 80. If a new host on your network implements HTTP, the system will monitor port 80 during the interval when it is discovering the new HTTP application protocol. 
 
     [bookmark: pgfId-1532050]In the case where you want to detect sensitive data in FTP traffic, you must specify the FTP data application protocol; there is no advantage in specifying a port number. See Special Case: Detecting Sensitive Data in FTP Traffic for more information.
 
     [bookmark: pgfId-1532057]To modify application protocols to detect sensitive data:
 
     [bookmark: pgfId-1532058]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1576779]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1532060]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532065]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532069]The Policy Information page appears.
 
     [bookmark: pgfId-1532070]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532071]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532072]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532073]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532074]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532075]The Sensitive Data Detection page appears.
 
     [bookmark: pgfId-1532076]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532080]Step 5 Click the data type name under Data Types to select the data type you want to modify.
 
     [bookmark: pgfId-1532081]The Configuration area updates to display the current settings for the selected data type.
 
     [bookmark: pgfId-1532082]Step 6 Click inside the Application Protocols field, or click Edit next to the field.
 
     [bookmark: pgfId-1532083]The Application Protocols pop-up window appears.
 
     [bookmark: pgfId-1532084]Step 7 You have two choices:
 
      
       
       	 [bookmark: pgfId-1532085]To add up to eight application protocols to monitor, select one or more application protocols from the  Available list on the left, then click the right arrow ( > ) button.
 
       	 [bookmark: pgfId-1532086]To remove an application protocol, select it from the  Enabled list on the right, then click the left arrow ( < ) button.
 
      
 
     
 
     [bookmark: pgfId-1532087]Use Ctrl or Shift while clicking to select multiple application protocols. You can also click and drag to select multiple adjacent application protocols.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532088]Note To detect sensitive data in FTP traffic, you must add the FTP data application protocol. See Special Case: Detecting Sensitive Data in FTP Traffic for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532092]Step 8 Click OK to add the application protocols.
 
     [bookmark: pgfId-1532093]The Sensitive Data Detection page is displayed and the application protocols are updated.
 
     [bookmark: pgfId-1552015]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532096][bookmark: 82297]Special Case: Detecting Sensitive [bookmark: marker-1532095]Data in FTP Traffic
 
     [bookmark: pgfId-1532100]License: Control
 
     [bookmark: pgfId-1532101]You usually determine which traffic to monitor for sensitive data by specifying the ports to monitor or, optionally, specifying application protocols in deployments. However, specifying ports or application protocols is not sufficient for detecting sensitive data in FTP traffic. Sensitive data in FTP traffic is found in traffic for the FTP application protocol, which occurs intermittently and uses a transient port number, making it difficult to detect. To detect sensitive data in FTP traffic, you must include the following in your configuration:
 
      
      	 [bookmark: pgfId-1532102]Specify the  FTP data application protocol.
 
     
 
     [bookmark: pgfId-1532103]Specifying the FTP data application protocol enables detection of sensitive data in FTP traffic. See Selecting Application Protocols to Monitor for more information.
 
     [bookmark: pgfId-1532108]In the special case of detecting sensitive data in FTP traffic, specifying the FTP data application protocol does not invoke detection; instead, it invokes the rapid processing of the FTP/Telnet processor to detect sensitive data in FTP traffic. See Decoding FTP and Telnet Traffic for more information.
 
      
      	 [bookmark: pgfId-1532122]Ensure that your configuration includes at least one port to monitor for sensitive data. 
 
     
 
     [bookmark: pgfId-1532123]Note that it is not necessary to specify an FTP port except in the unlikely case where you only want to detect sensitive data in FTP traffic. Most sensitive data configurations will include other ports such as HTTP or email ports. In the case where you do want to specify only one FTP port and no other ports to monitor, Cisco recommends that you specify the FTP command port 23. See Configuring Sensitive Data Detection or more information.
 
    
 
     
      [bookmark: pgfId-1532132][bookmark: 29989]Using Custo[bookmark: marker-1532131]m Data Types
 
     [bookmark: pgfId-1532136]License: Protection
 
     [bookmark: pgfId-1532137]You can create and modify custom data types to detect data patterns that you specify. For example, a hospital might create a data type to protect patient numbers, or a university might create a data type to detect student numbers that have a unique numbering pattern.
 
     [bookmark: pgfId-1532138]Each custom date type you create also creates a single sensitive data preprocessor rule that has a generator ID (GID) of 138 and a Snort ID of 1000000 or greater, that is, a SID for a local rule. You must enable the associated sensitive data rule to enable detection, and event generation, for each custom data type you want to use in your policy. See Setting Rule States for information on enabling rules in an intrusion policy.
 
     [bookmark: pgfId-1532142]To help you enable sensitive data rules, a link on the configuration page takes you to a filtered view of the Rules page that displays all predefined and custom sensitive data rules. You can also display custom sensitive data rules along with any local custom rules by selecting the local rule filtering category on the Rules page. See Filtering Rules in an Intrusion Policy for more information. Note that custom sensitive data rules are not listed on the Rule Editor page.
 
     [bookmark: pgfId-1532146]Custom data types you create are added to all intrusion policies. You must enable the associated sensitive data rule in any policy that you want to use to detect and generate events for a particular custom data type.
 
     [bookmark: pgfId-1532147]Note that you must use the Sensitive Data Detection configuration page to create data types and their associated rules. You cannot use the rule editor to create sensitive data rules.
 
     [bookmark: pgfId-1532148]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1532152]Defining Data Patterns in Custom Data Types
 
      	 [bookmark: pgfId-1532156]Configuring Custom Data Types
 
      	 [bookmark: pgfId-1532160]Editing Custom Data Type Names and Detection Patterns
 
     
 
    
 
     
      [bookmark: pgfId-1532162][bookmark: 47501]Defining Data Patterns in Custom Data Types
 
     [bookmark: pgfId-1532166]License: Protection
 
     [bookmark: pgfId-1532167]You define the data pattern for a custom data type using a simple set of regular expressions comprised of the following:
 
      
      	 [bookmark: pgfId-1532168]three metacharacters
 
      	 [bookmark: pgfId-1532169]escaped characters that allow you to use the metacharacters as literal characters
 
      	 [bookmark: pgfId-1532170]six character classes
 
     
 
      
       
        
        [bookmark: pgfId-1532178]Table 22-10 [bookmark: 78237]Sensitive Data Pattern Metacharacters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532184]Metacharacter 
          
  
         	 
           
           [bookmark: pgfId-1532186]Description 
          
  
         	 
           
           [bookmark: pgfId-1532188]Example 
          
  
        
 
         
         	[bookmark: pgfId-1532190]?
  
         	[bookmark: pgfId-1532192]Matches zero or one occurrence of the preceding character or escape sequence; that is, the preceding character or escape sequence is optional.
  
         	[bookmark: pgfId-1532194]colou?r matches color or colour
  
        
 
         
         	[bookmark: pgfId-1532196]{n}
  
         	[bookmark: pgfId-1532198]Matches the preceding character or escape sequence n times.
  
         	[bookmark: pgfId-1532200]For example,
\d{2} matches 55, 12, and so on;
\l{3} matches AbC, www, and so on;
\w{3} matches a1B, 25C, and so on; 
x{5} matches xxxxx
  
        
 
         
         	[bookmark: pgfId-1532202]\
  
         	[bookmark: pgfId-1532204]Allows you to use metacharacters as actual characters and is also used to specify a predefined character class. See Table 22-12 for a description of the character classes you can use in sensitive data patterns.
  
         	[bookmark: pgfId-1532209]\? matches a question mark,
\\ matches a backslash, 
\d matches numeric characters, and so on
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-1532218]Table 22-11 [bookmark: 24764]Escaped Sensitive Data Pattern Characters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532222]Use this escaped character... 
          
  
         	 
           
           [bookmark: pgfId-1532224]To represent this literal character... 
          
  
        
 
         
         	[bookmark: pgfId-1532226]\?
  
         	[bookmark: pgfId-1532228]?
  
        
 
         
         	[bookmark: pgfId-1532230]\{
  
         	[bookmark: pgfId-1532232]{
  
        
 
         
         	[bookmark: pgfId-1532234]\}
  
         	[bookmark: pgfId-1532236]}
  
        
 
         
         	[bookmark: pgfId-1532238]\\
  
         	[bookmark: pgfId-1532240]\
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532242]The following table describes the character classes you can use when defining a custom sensitive data pattern.
 
     [bookmark: pgfId-1532297]
 
      
       
        
        [bookmark: pgfId-1532249]Table 22-12 [bookmark: 65810]Sensitive Data Pattern Character Classes 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532255]Character Class 
          
  
         	 
           
           [bookmark: pgfId-1532257]Description 
          
  
         	 
           
           [bookmark: pgfId-1532259]Character Class Definition 
          
  
        
 
         
         	[bookmark: pgfId-1532261]\d
  
         	[bookmark: pgfId-1532263]Matches any numeric ASCII character 0-9
  
         	[bookmark: pgfId-1532265]0-9
  
        
 
         
         	[bookmark: pgfId-1532267]\D
  
         	[bookmark: pgfId-1532269]Matches any byte that is not a numeric ASCII character
  
         	[bookmark: pgfId-1532271]not 0-9
  
        
 
         
         	[bookmark: pgfId-1532273]\l (lowercase “ell”)
  
         	[bookmark: pgfId-1532275]Matches any ASCII letter
  
         	[bookmark: pgfId-1532277]a-zA-Z
  
        
 
         
         	[bookmark: pgfId-1532279]\L
  
         	[bookmark: pgfId-1532281]Matches any byte that is not an ASCII letter
  
         	[bookmark: pgfId-1532283]not a-zA-Z
  
        
 
         
         	[bookmark: pgfId-1532285]\w
  
         	[bookmark: pgfId-1532287]Matches any ASCII alphanumeric character
 [bookmark: pgfId-1532288]Note that, unlike PCRE regular expressions, this does not include an underscore (_).
  
         	[bookmark: pgfId-1532290]a-zA-Z0-9
  
        
 
         
         	[bookmark: pgfId-1532292]\W
  
         	[bookmark: pgfId-1532294]Matches any byte that is not an ASCII alphanumeric character
  
         	[bookmark: pgfId-1532296]not a-zA-Z0-9
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532298]The preprocessor treats characters entered directly, instead of as part of a regular expression, as literal characters. For example, the data pattern 1234 matches 1234.
 
     [bookmark: pgfId-1532299]The following data pattern example, which is used in predefined sensitive data rule 138:4, uses the escaped digits character class, the multiplier and option-specifier metacharacters, and the literal dash (-) and left and right parentheses () characters to detect U.S. phone numbers:
 
      
      [bookmark: pgfId-1532300](\d{3}) ?\d{3}-\d{4} 
     
 
     [bookmark: pgfId-1532301]Exercise caution when creating custom data patterns. Consider the following alternative data pattern for detecting phone numbers which, although using valid syntax, could cause many false positives:
 
      
      [bookmark: pgfId-1532302](?\d{3})? ?\d{3}-?\d{4} 
     
 
     [bookmark: pgfId-1532303]Because the second example combines optional parentheses, optional spaces, and optional dashes, it would detect, among others, phone numbers in the following desirable patterns:
 
      
      	 [bookmark: pgfId-1532304] (555)123-4567 
 
      	 [bookmark: pgfId-1532305] 555123-4567 
 
      	 [bookmark: pgfId-1532306] 5551234567 
 
     
 
     [bookmark: pgfId-1532307]However, the second example pattern would also detect, among others, the following potentially invalid patterns, resulting in false positives:
 
      
      	 [bookmark: pgfId-1532308] (555 1234567 
 
      	 [bookmark: pgfId-1532309] 555)123-4567 
 
      	 [bookmark: pgfId-1532310] 555) 123-4567 
 
     
 
     [bookmark: pgfId-1532311]Consider finally, for illustration purposes only, an extreme example in which you create a data pattern that detects the lowercase letter a using a low event threshold in all destination traffic on a small company network. Such a data pattern could overwhelm your system with literally millions of events in only a few minutes.
 
    
 
     
      [bookmark: pgfId-1532314][bookmark: 59648]Configuring Cus[bookmark: marker-1532313]tom Data Types
 
     [bookmark: pgfId-1532318]License: Protection
 
     [bookmark: pgfId-1532319]You configure essentially the same data type options for custom data types that you configure for predefined data types. See Selecting Individual Data Type Options for information on setting options that are common to all data types. In addition, you must also specify the name and data pattern for custom data types.
 
     [bookmark: pgfId-1532323]Note that creating a custom data type also creates an associated custom sensitive data preprocessing rule, which you must enable in each policy where you want to use that data type. See Setting Rule States for information on enabling rules in your intrusion policy.
 
     [bookmark: pgfId-1532327]To create or modify a custom data type:
 
     [bookmark: pgfId-1532328]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1576798]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1532330]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532335]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532339]The Policy Information page appears.
 
     [bookmark: pgfId-1532340]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532341]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532342]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532343]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532344]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532345]The Sensitive Data Detection page appears.
 
     [bookmark: pgfId-1532346]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532350]Step 5 You have the following options:
 
      
       
       	 [bookmark: pgfId-1532351]To create a custom data type, click the  + sign next to  Data Types on the left side of the page. The Add Data Type pop-up window appears.
 
      
 
     
 
     [bookmark: pgfId-1532352]Specify a unique data type name and the pattern you want to detect with this data type and click OK, or click Cancel to abandon your edits. See Editing Custom Data Type Names and Detection Patterns for more information.
 
     [bookmark: pgfId-1532356]The Sensitive Data Detection page appears. If you clicked OK, the page updates to display your changes.
 
      
       
       	 [bookmark: pgfId-1532357]To modify any of the options that are common to predefined and custom data types, click the data type name in the  Targets page area.
 
      
 
     
 
     [bookmark: pgfId-1532358]The Configuration page area updates to display the current settings for the data type. See Configuring Sensitive Data Detection for more information.
 
      
       
       	 [bookmark: pgfId-1532362]To edit the system-wide name and data pattern for a custom data type, see Editing Custom Data Type Names and Detection Patterns.
 
       	 [bookmark: pgfId-1532369]To delete a custom data type, click the delete icon (
 
      
 
      [image: ] ) next to the data type you want to remove and then click 
       OK , or click 
       Cancel to abandon deleting the data type. 
     
 
     [bookmark: pgfId-1532370]Note that you cannot delete a data type when the sensitive data rule for that data type is enabled in any intrusion policy. Deleting a custom data type deletes it from all intrusion policies.
 
     [bookmark: pgfId-1552045]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532372][bookmark: 32981]Editing Custom Data Type Names and Detection Patterns
 
     [bookmark: pgfId-1532376]License: Protection
 
     [bookmark: pgfId-1532377]You can modify the system-wide name and detection pattern for custom sensitive data rules. Note that changing these settings changes them in all other policies on the system. Note also that you must reapply any applied access control policies that include intrusion policies that use custom data types that you modify.
 
     [bookmark: pgfId-1532378]Except for custom data type names and data patterns, all data type options are policy-specific for both custom and predefined data types. See Selecting Individual Data Type Options for information on modifying options other than the name and data pattern in your custom data types.
 
     [bookmark: pgfId-1532382]To edit custom data type names and data patterns:
 
     [bookmark: pgfId-1532383]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1532384]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1532385]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532390]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532394]The Policy Information page appears.
 
     [bookmark: pgfId-1532395]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532396]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532397]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532398]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532399]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532400]The Sensitive Data Detection page appears.
 
     [bookmark: pgfId-1532401]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532405]Step 5 In the Targets page area, click the name of the custom data type you want to modify.
 
     [bookmark: pgfId-1532406]The page updates to show the current settings for the data type, and the Edit Data Type Name and Pattern link appears in the upper right of the Configuration page area.
 
     [bookmark: pgfId-1532407]Step 6 Click the Edit Data Type Name and Pattern link.
 
     [bookmark: pgfId-1532408]The Edit Data Type pop-up window appears.
 
     [bookmark: pgfId-1532409]Step 7 Modify the data type name, pattern, or both and click OK, or click Cancel to abandon your edits. See Defining Data Patterns in Custom Data Types for information on specifying the data pattern.
 
     [bookmark: pgfId-1532413]The Sensitive Data Detection page appears. If you clicked OK, the page displays your changes.
 
     [bookmark: pgfId-1552065]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532414]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1531506][bookmark: 60568]Globally Limiting Intr[bookmark: marker-1534486]usion Event Lo[bookmark: marker-1534504]gging 
      
      
 
     
 
 
    [bookmark: pgfId-1532030]You can use thresholds to limit the number of times the system logs and displays intrusion events. Thresholds, which you configure as part of your intrusion policy, cause the system to generate events based on how many times traffic matching a rule originates from or is targeted to a specific address or address range within a specified time period. This can prevent you from being overwhelmed with a large number of events. This feature requires a Protection license.
 
    [bookmark: pgfId-1532032]You can set event notification thresholds in two ways:
 
     
     	 [bookmark: pgfId-1532033]You can set a global threshold across all traffic to limit how often events from a specific source or destination are logged and displayed per specified time period. For more information, see Understanding Thresholding and Configuring Global Thresholds.
 
     	 [bookmark: pgfId-1532046]You can set thresholds per shared object rule, standard text rule, or preprocessor rule in your intrusion policy configuration, as described in Configuring Event Thresholding. 
 
    
 
   
 
    
     [bookmark: pgfId-1532051][bookmark: 22194]Understanding Thresholding
 
    [bookmark: pgfId-1532058]License: Protection
 
    [bookmark: pgfId-1532059]By default, every intrusion policy contains a global rule threshold. The default threshold limits event generation for each rule to one event every 60 seconds on traffic going to the same destination. This global [bookmark: marker-1532060]threshold applies by default to all intrusion rules and preprocessor rules. Note that you can disable the threshold in the Advanced Settings page in an intrusion policy. 
 
    [bookmark: pgfId-1532061]You can also override this threshold by setting individual thresholds on specific rules. For example, you might set a global limit threshold of five events every 60 seconds, but then set a specific threshold of ten events for every 60 seconds for SID 1315. All other rules generate no more than five events in each 60-second period, but the system generates up to ten events for each 60-second period for SID 1315.
 
    [bookmark: pgfId-1532065]For more information on setting rule-based thresholds, see Configuring Event Thresholding.
 
    [bookmark: pgfId-1532067]The following diagram shows an example where an attack is in progress for a specific rule. A global limit threshold limits event generation for each rule to two events every 20 seconds. 
 
    [bookmark: pgfId-1532068]Note that the period starts at one second and ends at 21 seconds. After the period ends, note that the cycle starts again and the next two rule matches generate events, then the system does not generate any more events during that period.
 
    [bookmark: pgfId-1543009]
 
     
     [image: ] 
    
 
     
      [bookmark: pgfId-1532077]Understanding Thresholding Options
 
     [bookmark: pgfId-1532084]License: Protection
 
     [bookmark: pgfId-1532085]Thresholding allows you to limit intrusion event generation by generating only a specific number of events in a time period, or by generating one event for a set of events. When you configure global thresholding, you must first specify the thresholding type, as described in the following table.
 
     [bookmark: pgfId-1532113]
 
      
       
        
        [bookmark: pgfId-1532091]Table 23-1 [bookmark: 82757]Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532095]Option 
          
  
         	 
           
           [bookmark: pgfId-1532097]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532099]Limit
  
         	[bookmark: pgfId-1532101]Logs and displays events for the specified number of packets (specified by the count argument) that trigger the rule during the specified time period. For example, if you set the type to Limit, the Count to 10, and the Seconds to 60, and 14 packets trigger the rule, the system stops logging events for the rule after displaying the first 10 that occur within the same minute.
  
        
 
         
         	[bookmark: pgfId-1532103]Threshold
  
         	[bookmark: pgfId-1532105]Logs and displays a single event when the specified number of packets (specified by the count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event. For example, you set the type to Threshold, Count to 10, and Seconds to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.
  
        
 
         
         	[bookmark: pgfId-1532107]Both
  
         	[bookmark: pgfId-1532109]Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule. For example, if you set the type to Both, Count to 2, and Seconds to 10, the following event counts result:
 
           
           	 [bookmark: pgfId-1532110]If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)
 
           	 [bookmark: pgfId-1532111]If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)
 
           	 [bookmark: pgfId-1532112]If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggered the second time and following events are ignored)
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532114]Next, specify the tracking, which determines whether the event instance count is calculated per source or destination IP address. Finally, specify the number of instances and time period that define the threshold.
 
     [bookmark: pgfId-1532135]
 
      
       
        
        [bookmark: pgfId-1532120]Table 23-2 Thresholding Instance/Time Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532124]Option 
          
  
         	 
           
           [bookmark: pgfId-1532126]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532128]Count
  
         	[bookmark: pgfId-1532130]The number of event instances per specified time period per tracking IP address or address range required to meet the threshold.
  
        
 
         
         	[bookmark: pgfId-1532132]Seconds
  
         	[bookmark: pgfId-1532134]The number of seconds that elapse before the count resets. If you set the threshold type to Limit, the tracking to Source, Count to 10, and Seconds to 10, the system logs and displays the first 10 events that occur in 10 seconds from a given source port. If only seven events occur in the first 10 seconds, the system logs and displays those, if 40 events occur in the first 10 seconds, the system logs and displays 10, then begins counting again when the 10-second time period elapses.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532138][bookmark: 33372]Configuring Glo[bookmark: marker-1532137]bal Thresholds
 
    [bookmark: pgfId-1532145]License: Protection
 
    [bookmark: pgfId-1532146]You can set a global threshold to manage the number of events generated by each rule over a period of time. When you set a global threshold, that threshold applies for each rule that does not have an overriding specific threshold. For more information on configuring thresholds, see Understanding Thresholding.
 
    [bookmark: pgfId-1532150]A global threshold is configured on your system by default. The default values are as follows:
 
     
     	 [bookmark: pgfId-1532151] Type — Limit
 
     	 [bookmark: pgfId-1532152] Track By — Destination
 
     	 [bookmark: pgfId-1532153] Count — 1
 
     	 [bookmark: pgfId-1532154] Seconds — 60
 
    
 
    [bookmark: pgfId-1532155]To configure global thresholding:
 
    
 
    [bookmark: pgfId-1536361]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
    [bookmark: pgfId-1536362]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532166]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532170]The Policy Information page appears.
 
    [bookmark: pgfId-1532172]Step 3 [bookmark: 22526]Click Advanced Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1532173]The Advanced Settings page appears.
 
    [bookmark: pgfId-1532174]Step 4 You have two choices, depending on whether Global Rule Thresholding under Intrusion Rule Thresholds is enabled:
 
     
      
      	 [bookmark: pgfId-1532175]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1532176]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1532177]The Global Rule Thresholding page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1533826]Step 5 From the Type radio buttons, select the type of threshold that will apply over the time specified by the seconds argument. See the Thresholding Options table for more information:
 
     
      
      	 [bookmark: pgfId-1533830]Select  Limit  to log and display an event for each packet that triggers the rule until the limit specified by the count argument is exceeded.
 
      	 [bookmark: pgfId-1532183]Select  Threshold to log and display a single event for each packet that triggers the rule and represents either the instance that matches the threshold set by the count argument or is a multiple of the threshold.
 
      	 [bookmark: pgfId-1532184]Select  Both to log and display a single event after the number of packets specified by the count argument trigger the rule.
 
     
 
    
 
    [bookmark: pgfId-1532185]Step 6 Select the tracking method from the Track By radio buttons:
 
     
      
      	 [bookmark: pgfId-1532186]Select  Source to identify rule matches in traffic coming from a particular source IP address or addresses.
 
      	 [bookmark: pgfId-1532187]Select Destination to identify rule matches in traffic going to a particular destination IP address.
 
     
 
    
 
    [bookmark: pgfId-1532188]Step 7 In the Count field:
 
     
      
      	 [bookmark: pgfId-1533125]For a  Limit threshold, specify the number of event instances per specified time period per tracking IP address required to meet the threshold.
 
      	 [bookmark: pgfId-1532189]For a  Threshold threshold, specify the number of rule matches you want to use as your threshold. 
 
     
 
    
 
    [bookmark: pgfId-1532191]Step 8 In the Seconds field:
 
     
      
      	 [bookmark: pgfId-1532192]For a  Limit threshold, specify the number of seconds that make up the time period when attacks are tracked. 
 
      	 [bookmark: pgfId-1533857]For a  Threshold threshold, specify the number of seconds that elapse before the count resets. Note that the count resets if the number of rule matches indicated by the  Count field occur before the number of seconds indicated elapse.
 
     
 
    
 
    [bookmark: pgfId-1533879]Step 9 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1533862]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1533865]Disabling the [bookmark: marker-1533863]Global [bookmark: marker-1536204]Threshold
 
     [bookmark: pgfId-1532208]License: Protection
 
     [bookmark: pgfId-1532209]By default, a global limit threshold limits the number of events on traffic going to a destination to one event per 60 seconds. You can disable global thresholding in the highest policy layer if you want to threshold events for specific rules and not apply thresholding to every rule by default.
 
     [bookmark: pgfId-1532210]To disable global thresholding:
 
     
 
     [bookmark: pgfId-1537250]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1532216]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532221]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532225]The Policy Information page appears.
 
     [bookmark: pgfId-1532227]Step 3 [bookmark: 60401]Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532228]The Settings page appears.
 
     [bookmark: pgfId-1533912]Step 4 Under Intrusion Rule Thresholds, disable Global Rule Thresholding. 
 
     [bookmark: pgfId-1533924]Step 5 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533917]
 
      
      
 
     
 
     
 
      
       [bookmark: pgfId-1164863]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-4901875][bookmark: 88979]Understanding and[bookmark: marker-4901874] Writing Intrusion Rules 
      
      
 
     
 
 
    [bookmark: pgfId-4905635]An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network by analyzing network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers. If a rule is an alert rule, it generates an intrusion event. If it is a pass rule, it ignores the traffic. You can view and evaluate intrusion events from the ASA FirePOWER module interface.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-2322522] 
     Caution Make sure you use a controlled network environment to test any intrusion rules that you write before you use the rules in a production environment. Poorly written intrusion rules may seriously affect the performance of the system. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3994277]Note the following:
 
     
     	 [bookmark: pgfId-3994219]For a  drop rule in an inline deployment, the system dr[bookmark: marker-3994218]ops the packet and generates an event. For more information on drop rules, see Setting Rule States. 
 
     	 [bookmark: pgfId-4542015]Cisco provides two typ[bookmark: marker-4542010]es of intrusion rule[bookmark: marker-4542011]s: shared object rules and standard text rules. The Cisco Vulnerability Research Team (VRT) can use shared object rules to detect attacks against vulnerabilities in ways that traditional standard text rules cannot. You cannot create shared object rules. When you write your own intrusion rule, you create a standard text rule.
 
    
 
    [bookmark: pgfId-1113601]You can write custom standard text rules to tune the types of events you are likely to see. Note that while this documentation sometimes discusses rules targeted to detect specific exploits, the most successful rules target traffic that may attempt to exploit known vulnerabilities rather than specific known exploits. By writing rules and specifying the rule’s event message, you can more easily identify traffic that indicates attacks and policy evasions. For more information about evaluating events, see Viewing Events.
 
    [bookmark: pgfId-4930593]When you enable a custom standard text rule in a custom intrusion policy, keep in mind that some rule keywords and arguments require that traffic first be decoded or preprocessed in a certain way. This chapter explains the options you must configure in your network analysis policy, which governs preprocessing. Note that if you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy user interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-4930594]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1073578]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1073616]Understanding Rule Anatomy describes the components, including the rule header and rule options, that make up a valid standard text rule.
 
     	 [bookmark: pgfId-4793873]Understanding Rule Headers provides a detailed description of the parts of a rule header.
 
     	 [bookmark: pgfId-4793877]Understanding Keywords and Arguments in Rules explains the usage and syntax of the intrusion rule keywords available in the ASA FirePOWER module.
 
     	 [bookmark: pgfId-4072978]Constructing a Rule explains how to build a new rule using the rule editor.
 
     	 [bookmark: pgfId-2934989]Filtering Rules on the Rule Editor Page explains how to display a subset of rules to help you find specific rules.
 
    
 
   
 
    
     [bookmark: pgfId-2529868][bookmark: 80497][bookmark: 25665]Understanding Rule[bookmark: marker-2529867] Anatomy
 
    [bookmark: pgfId-4237706]License: Protection
 
    [bookmark: pgfId-1064169]All standard text rules contain two logical sections: the rule header and the rule options. The rule header contains:
 
     
     	 [bookmark: pgfId-2018215]the rule's action or type
 
     	 [bookmark: pgfId-1469206]the protocol
 
     	 [bookmark: pgfId-1469255]the source and destination IP addresses and netmasks
 
     	 [bookmark: pgfId-2018297]direction indicators showing the flow of traffic from source to destination
 
     	 [bookmark: pgfId-1469305]the source and destination ports
 
    
 
    [bookmark: pgfId-1469157]The rule options section contains:
 
     
     	 [bookmark: pgfId-1469476]event messages
 
     	 [bookmark: pgfId-1469561]keywords and their parameters and arguments
 
     	 [bookmark: pgfId-2018240]patterns that a packet’s payload must match to trigger the rule
 
     	 [bookmark: pgfId-1469603]specifications of which parts of the packet the rules engine should inspect 
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3632657]Note that the options section of a rule is the section enclosed in parentheses. The rule editor provides an easy-to-use interface to help you build standard text rules.
 
   
 
    
     [bookmark: pgfId-3632507][bookmark: 66535]Understanding [bookmark: marker-3632505]Rule[bookmark: marker-3632506] Headers
 
    [bookmark: pgfId-4542967]License: Protection
 
     
     [image: ] 
    
 
     
      
       
       [bookmark: pgfId-2419999]Table 24-1 [bookmark: 26083]Rule Header Values 
 
       
       
        
        	 
          
          [bookmark: pgfId-2420005]Rule Header Component 
         
  
        	 
          
          [bookmark: pgfId-2420007]Example Value 
         
  
        	 
          
          [bookmark: pgfId-2420009]This Value... 
         
  
       
 
        
        	[bookmark: pgfId-2420011]Action
  
        	[bookmark: pgfId-2420013]alert
  
        	[bookmark: pgfId-2420015]Generates an intrusion event when triggered.
  
       
 
        
        	[bookmark: pgfId-2420017]Protocol
  
        	[bookmark: pgfId-2420019]tcp 
  
        	[bookmark: pgfId-2420021]Tests TCP traffic only.
  
       
 
        
        	[bookmark: pgfId-2420023]Source IP Address
  
        	[bookmark: pgfId-2420025]$EXTERNAL_NET
  
        	[bookmark: pgfId-2420027]Tests traffic coming from any host that is not on your internal network.
  
       
 
        
        	[bookmark: pgfId-2420029]Source Ports
  
        	[bookmark: pgfId-2420031]any
  
        	[bookmark: pgfId-2420033]Tests traffic coming from any port on the originating host.
  
       
 
        
        	[bookmark: pgfId-2420035]Operator
  
        	[bookmark: pgfId-2420037]->
  
        	[bookmark: pgfId-2420039]Tests external traffic (destined for the web servers on your network).
  
       
 
        
        	[bookmark: pgfId-2420041]Destination IP Address
  
        	[bookmark: pgfId-2420043]$HTTP_SERVERS
  
        	[bookmark: pgfId-2420045]Tests traffic to be delivered to any host specified as a web server on your internal network.
  
       
 
        
        	[bookmark: pgfId-2420047]Destination Ports
  
        	[bookmark: pgfId-2420049]$HTTP_PORTS
  
        	[bookmark: pgfId-2420051]Tests traffic delivered to an HTTP port on your internal network.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1059132]Note The previous example uses default variables, as do most intrusion rules. See Working with Variable Sets for more information about variables, what they mean, and how to configure them.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2008714]See the following sections for more information about rule header parameters:
 
     
     	 [bookmark: pgfId-2008718]Specifying Rule Actions describes rule types and explains how to specify the action that occurs when the rule triggers.
 
     	 [bookmark: pgfId-2008722]Specifying Protocols explains how to define the traffic protocol for traffic that the rule should test.
 
     	 [bookmark: pgfId-2008726]Specifying IP Addresses In Intrusion Rules explains how to define the individual IP addresses and IP address blocks in the rule header.
 
     	 [bookmark: pgfId-2008730]Defining Ports in Intrusion Rules explains how to define the individual ports and port ranges in the rule header.
 
     	 [bookmark: pgfId-2008734]Specifying Direction describes the available operators and explains how to specify the direction traffic must be traveling to be tested by the rule. 
 
    
 
     
      [bookmark: pgfId-1066754][bookmark: 40823]Specifying Rule[bookmark: marker-2334537] Actions[bookmark: marker-1059131]
 
     [bookmark: pgfId-4237786]License: Protection
 
     [bookmark: pgfId-1059133]Each rule header includes a parameter that specifies the action the system takes when a packet triggers a rule. Rules with the action set to alert generate an intrusion event against the packet that triggered the rule and log the details of that packet. Rules with the action set to pass do not generate an event against, or log the details of, the packet that triggered the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3768351]Note In an inline deployment, rules with the rule state set to Drop and Generate Events generate an intrusion event against the packet that triggered the rule. Also, if you apply a drop rule in a passive deployment, the rule acts as an alert rule. For more information on drop rules, see Setting Rule States. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1163113]By default, pass rules override alert rules. You can create pass rules to prevent packets that meet criteria defined in the pass rule from triggering the alert rule in specific situations, rather than disabling the alert rule. For example, you might want a rule that looks for attempts to log into an FTP server as the user “anonymous” to remain active. However, if your network has one or more legitimate anonymous FTP servers, you could write and activate a pass rule that specifies that, for those specific servers, anonymous users do not trigger the original rule. 
 
     [bookmark: pgfId-2178391]Within the rule editor, you select the rule type from the Action list. For more information about the procedures you use to build a rule header using the rule editor, see Constructing a Rule.
 
    
 
     
      [bookmark: pgfId-1066869][bookmark: 65354]Specifying Protocols
 
     [bookmark: pgfId-4237803]License: Protection
 
     [bookmark: pgfId-1059165]In each rule header, you must specify the protocol of the traffic the rule inspects. You can specify the following network protocols for analysis:
 
      
      	 [bookmark: pgfId-1059168]ICMP (Internet Control Message Protocol)
 
      	 [bookmark: pgfId-4962833]IP (Internet Protocol)
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4962834]Note The system ignores port definitions in an intrusion rule header when the protocol is set to ip. For more information, see Defining Ports in Intrusion Rules.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-4962838]TCP (Transmission Control Protocol)
 
      	 [bookmark: pgfId-4962839]UDP (User Datagram Protocol)
 
     
 
     [bookmark: pgfId-1132478]Use IP as the protocol type to examine all protocols assigned by IANA, including TCP, UDP, ICMP, IGMP, and many more. See http://www.iana.org/assignments/protocol-numbers for a full list of IANA-assigned protocols.
 
      
       
     
 
     
 
     [bookmark: pgfId-1659536]Note You cannot currently write rules that match patterns in the next header (for example, the TCP header) in an IP payload. Instead, content matches begin with the last decoded protocol. As a workaround, you can match patterns in TCP headers by using rule options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666461]Within the rule editor, you select the protocol type from the Protocol list. See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
    
 
     
      [bookmark: pgfId-4666468][bookmark: 23807]Specify[bookmark: marker-4666466]ing IP A[bookmark: marker-4666467]ddresses In Intrusion Rules
 
     [bookmark: pgfId-4666472]License: Protection
 
     [bookmark: pgfId-4666473]Restricting packet inspection to the packets originating from specific IP addresses or destined to a specific IP address reduces the amount of packet inspection the system must perform. This also reduces false positives by making the rule more specific and removing the possibility of the rule triggering against packets whose source and destination IP addresses do not indicate suspicious behavior.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666474]Tip The system recognizes only IP addresses and does not accept host names for source or destination IP addresses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666475]Within the rule editor, you specify source and destination IP addresses in the Source IPs and Destination IPs fields. See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
     [bookmark: pgfId-4666482]When writing standard text rules, you can specify IPv4 and IPv6 addresses in a variety of ways, depending on your needs. You can specify a single IP address, any, IP address lists, CIDR notation, prefix lengths, a network variable, or a network object or network object group. Additionally, you can indicate that you want to exclude a specific IP address or set of IP addresses. When specifying IPv6 addresses, you can use any addressing convention defined in RFC 4291.
 
      
       
        
        [bookmark: pgfId-4905881]Table 24-2 [bookmark: 46782]Source/Destination IP Address Syntax 
 
        
        
         
         	 
           
           [bookmark: pgfId-4905887]To Specify... 
          
  
         	 
           
           [bookmark: pgfId-4905889]Use... 
          
  
         	 
           
           [bookmark: pgfId-4905891]Example 
          
  
        
 
         
         	[bookmark: pgfId-4905893]any IP address
  
         	[bookmark: pgfId-4905895]any
  
         	[bookmark: pgfId-4905897]any
  
        
 
         
         	[bookmark: pgfId-4905899]a specific IP address
  
         	[bookmark: pgfId-4905901]the IP address
 [bookmark: pgfId-4905902]Note that you would not mix IPv4 and IPv6 source and destination addresses in the same rule.
  
         	[bookmark: pgfId-4905904]192.168.1.1
 [bookmark: pgfId-4905905]2001:db8::abcd
  
        
 
         
         	[bookmark: pgfId-4905907]a list of IP addresses
  
         	[bookmark: pgfId-4905909]brackets ([]) to enclose the IP addresses and commas to separate them 
  
         	[bookmark: pgfId-4905911][192.168.1.1,192.168.1.15]
 [bookmark: pgfId-4905912][2001:db8::b3ff, 2001:db8::0202]
  
        
 
         
         	[bookmark: pgfId-4905914]a block of IP addresses
  
         	[bookmark: pgfId-4905916]IPv4 CIDR block or IPv6 address prefix notation 
  
         	[bookmark: pgfId-4905918]192.168.1.0/24
 [bookmark: pgfId-4905919]2001:db8::/32
  
        
 
         
         	[bookmark: pgfId-4905921]anything except a specific IP address or set of addresses 
  
         	[bookmark: pgfId-4905923]the ! character before the IP address or addresses you want to negate
  
         	[bookmark: pgfId-4905925]!192.168.1.15
 [bookmark: pgfId-4905926]!2001:db8::0202:b3ff:fe1e
  
        
 
         
         	[bookmark: pgfId-4905928]anything in a block of IP addresses except one or more specific IP addresses
  
         	[bookmark: pgfId-4905930]a block of addresses followed by a list of negated addresses or blocks
  
         	[bookmark: pgfId-4905932][10.0.0/8, !10.2.3.4, !10.1.0.0/16]
 [bookmark: pgfId-4905933][2001:db8::/32, !2001:db8::8329, !2001:db8::0202]
  
        
 
         
         	[bookmark: pgfId-4905935]IP addresses defined by a network variable
  
         	[bookmark: pgfId-4905937]the variable name, in uppercase letters, preceded by $
 [bookmark: pgfId-4905938]Note that preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules. See Working with Variable Sets for more information.
  
         	[bookmark: pgfId-4905943]$HOME_NET
  
        
 
         
         	[bookmark: pgfId-4905945]all IP addresses except addresses defined by an IP address variable
  
         	[bookmark: pgfId-4905947]the variable name, in uppercase letters, preceded by !$
 [bookmark: pgfId-4905950]See Excluding IP Addresses in Intrusion Rules for more information.
  
         	[bookmark: pgfId-4905953]!$HOME_NET
  
        
 
         
         	[bookmark: pgfId-4905955]IP addresses defined by a network object or network object group
  
         	[bookmark: pgfId-4905957]the object or group name using the format !{object_name}.
 [bookmark: pgfId-4905960]See Working with Network Objects for more information.
  
         	[bookmark: pgfId-4905963]${192.168sub16}
  
        
 
         
         	[bookmark: pgfId-4905965]all IP addresses except addresses defined by a network object or network object group
  
         	[bookmark: pgfId-4905967]the object or group name, in curly braces ({}), preceded by !$.
 [bookmark: pgfId-4905970]See Working with Network Objects for more information.
  
         	[bookmark: pgfId-4905973]!${192.168sub16}
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4666584]See the following sections for more in-depth information about the syntax you can use to specify source and destination IP addresses, and for information about using variables to specify IP addresses:
 
      
      	 [bookmark: pgfId-4666588]IP Address Conventions.
 
      	 [bookmark: pgfId-4666592]Working with Variable Sets
 
      	 [bookmark: pgfId-4666596]Specifying Any IP Address
 
      	 [bookmark: pgfId-4666600]Specifying Multiple IP Addresses
 
      	 [bookmark: pgfId-4666604]Specifying Network Objects
 
      	 [bookmark: pgfId-4666608]Excluding IP Addresses in Intrusion Rules
 
     
 
    
 
     
      [bookmark: pgfId-4666611][bookmark: 56029]Sp[bookmark: marker-4666610]ecifying Any IP Address
 
     [bookmark: pgfId-4666615]License: Protection
 
     [bookmark: pgfId-4666616]You can specify the word any as a rule source or destination IP address to indicate any IPv4 or IPv6 address.
 
     [bookmark: pgfId-4666617]For example, the following rule uses the argument any in the Source IPs and Destination IPs fields and evaluates packets with any IPv4 or IPv6 source or destination address:
 
      
      [bookmark: pgfId-4666618]alert tcp any any -> any any 
     
 
     [bookmark: pgfId-4666619]You can also specify :: to indicate any IPv6 address.
 
    
 
     
      [bookmark: pgfId-4666621][bookmark: 45634]Specifying Multiple IP Addresses
 
     [bookmark: pgfId-4666625]License: Protection
 
     [bookmark: pgfId-4666626]You can list individual IP addresses by separating the IP addresses with commas and, optionally, by surrounding non-negated lists with brackets, as shown in the following example:
 
      
      [bookmark: pgfId-4666627][192.168.1.100,192.168.1.103,192.168.1.105] 
     
 
     [bookmark: pgfId-4666628]You can list IPv4 and IPv6 addresses alone or in any combination, as shown in the following example:
 
      
      [bookmark: pgfId-4666629][192.168.1.100,2001:db8::1234,192.168.1.105] 
     
 
     [bookmark: pgfId-4666630]Note that surrounding an IP address list with brackets, which was required in earlier software releases, is not required. Note also that, optionally, you can enter lists with a space before or after each comma.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666633]Note You must surround negated lists with brackets. See Excluding IP Addresses in Intrusion Rules for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666635]You can also use IPv4 Classless Inter-Domain Routing (CIDR) notation or IPv6 prefix lengths to specify address blocks. For example:
 
      
      	 [bookmark: pgfId-4666636]192.168.1.0/24 specifies the IPv4 addresses in the 192.168.1.0 network with a subnet mask of 255.255.255.0, that is, 192.168.1.0 through 192.168.1.255. For more information, see IP Address Conventions.
 
      	 [bookmark: pgfId-4666640]2001:db8::/32 specifies the IPv6 addresses in the 2001:db8:: network with a prefix length of 32 bits, that is, 2001:db8:: through 2001:db8:ffff:ffff:ffff:ffff:ffff:ffff.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4666641]Tip If you need to specify a block of IP addresses but cannot express it using CIDR or prefix length notation alone, you can use CIDR blocks and prefix lengths in an IP address list.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4666644][bookmark: 56620]Sp[bookmark: marker-4666643]ecifying Network Objects
 
     [bookmark: pgfId-4666648]License: Protection
 
     [bookmark: pgfId-4666649]You can specify a network object or network object group using the syntax: 
 
      
      [bookmark: pgfId-4666650]${object_name | group_name} 
     
 
     [bookmark: pgfId-4666651]where:
 
      
      	 [bookmark: pgfId-4666652] object_name is the name of a network object
 
      	 [bookmark: pgfId-4666653] group_name is the name of a network object group
 
     
 
     [bookmark: pgfId-4666657]See Working with Network Objects for information on creating network objects and network object groups.
 
     [bookmark: pgfId-4666658]Consider the case where you have created a network object named 192.168sub16 and a network object group named all_subnets. You could specify the following to identify IP addresses using the network object:
 
      
      [bookmark: pgfId-4666659]${192.168sub16} 
     
 
     [bookmark: pgfId-4666660]and you could specify the following to use the network object group:
 
      
      [bookmark: pgfId-4666661]${all_subnets} 
     
 
     [bookmark: pgfId-4666662]You can also use negation with network objects and network object groups. For example:
 
      
      [bookmark: pgfId-4666663]!${192.168sub16} 
     
 
     [bookmark: pgfId-4666667]See Excluding IP Addresses in Intrusion Rules for more information.
 
    
 
     
      [bookmark: pgfId-4666672][bookmark: 89897][bookmark: 70264][bookmark: 58068]Excl[bookmark: marker-4666671]uding IP Addresses in Intrusion Rules
 
     [bookmark: pgfId-4666676]License: Protection
 
     [bookmark: pgfId-4666677]You can use an exclamation point (!) to negate a specified IP address. That is, you can match any IP address with the exception of the specified IP address or addresses. For example, !192.168.1.1 specifies any IP address other than 192.168.1.1, and !2001:db8:ca2e::fa4c specifies any IP address other than 2001:db8:ca2e::fa4c.
 
     [bookmark: pgfId-4666678]To negate a list of IP addresses, place ! before a bracketed list of IP addresses. For example, ![192.168.1.1,192.168.1.5] would define any IP address other than 192.168.1.1 or 192.168.1.5.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666679]Note You must use brackets to negate a list of IP addresses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666680]Be careful when using the negation character with IP address lists. For example, if you use [!192.168.1.1,!192.168.1.5] to match any address that is not 192.168.1.1 or 192.168.1.5, the system interprets this syntax as “anything that is not 192.168.1.1, or anything that is not 192.168.1.5.”
 
     [bookmark: pgfId-4666681]Because 192.168.1.5 is not 192.168.1.1, and 192.168.1.1 is not 192.168.1.5, both IP addresses match the IP address value of [!192.168.1.1,!192.168.1.5], and it is essentially the same as using “any.”
 
     [bookmark: pgfId-4666682]Instead, use ![192.168.1.1,192.168.1.5]. The system interprets this as “not 192.168.1.1 and not 192.168.1.5,” which matches any IP address other than those listed between brackets.
 
     [bookmark: pgfId-4666683]Note that you cannot logically use negation with any which, if negated, would indicate no address.
 
    
 
     
      [bookmark: pgfId-4666686][bookmark: 85429]Defining Ports in Intrusion R[bookmark: marker-4666685]ules
 
     [bookmark: pgfId-4666690]License: Protection
 
     [bookmark: pgfId-4666691]Within the rule editor, you specify source and destination ports in the Source Port and Destination Port fields. See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
     [bookmark: pgfId-4666698]The ASA FirePOWER module uses a specific type of syntax to define the port numbers used in rule headers.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666699]Note The system ignores port definitions in an intrusion rule header when the protocol is set to ip. For more information, see Specifying Protocols.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666703]You can list ports by separating the ports with commas, as shown in the following example:
 
      
      [bookmark: pgfId-4666704]80, 8080, 8138, 8600-9000, !8650-8675 
     
 
     [bookmark: pgfId-4666705]Optionally, the following example shows how you can surround a port list with brackets, which was required in previous software versions but is no longer required:
 
      
      [bookmark: pgfId-4666706][80, 8080, 8138, 8600-9000, !8650-8675] 
     
 
     [bookmark: pgfId-4666707]Note that you must surround negated port lists in brackets, as shown in the following example:
 
      
      [bookmark: pgfId-4666708]![20, 22, 23] 
     
 
     [bookmark: pgfId-4666709]Note also that a list of source or destination ports in an intrusion rule can include a maximum of 64 characters.
 
      
       
        
        [bookmark: pgfId-4907235]Table 24-3 [bookmark: 61865]Source/Destination Port Syntax 
 
        
        
         
         	 
           
           [bookmark: pgfId-4907241]To Specify... 
          
  
         	 
           
           [bookmark: pgfId-4907243]Use 
          
  
         	 
           
           [bookmark: pgfId-4907245]Example 
          
  
        
 
         
         	[bookmark: pgfId-4907247]any port
  
         	[bookmark: pgfId-4907249]any
  
         	[bookmark: pgfId-4907251]any
  
        
 
         
         	[bookmark: pgfId-4907253]a specific port
  
         	[bookmark: pgfId-4907255]the port number
  
         	[bookmark: pgfId-4907257]80
  
        
 
         
         	[bookmark: pgfId-4907259]a range of ports
  
         	[bookmark: pgfId-4907261]a dash between the first and last port number in the range
  
         	[bookmark: pgfId-4907263]80-443
  
        
 
         
         	[bookmark: pgfId-4907265]all ports less than or equal to a specific port 
  
         	[bookmark: pgfId-4907267]a dash before the port number
  
         	[bookmark: pgfId-4907269]-21
  
        
 
         
         	[bookmark: pgfId-4907271]all ports greater than or equal to a specific port 
  
         	[bookmark: pgfId-4907273]a dash after the port number
  
         	[bookmark: pgfId-4907275]80-
  
        
 
         
         	[bookmark: pgfId-4907277]all ports except a specific port or range of ports
  
         	[bookmark: pgfId-4907279]the ! character before the port, port list, or range of ports you want to negate 
 [bookmark: pgfId-4907280]Note that you can logically use negation with all port designations except any, which if negated would indicate no port.
  
         	[bookmark: pgfId-4907282]!20
  
        
 
         
         	[bookmark: pgfId-4907284]all ports defined by a port variable
  
         	[bookmark: pgfId-4907286]the variable name, in uppercase letter, preceded by $
 [bookmark: pgfId-4907290]See Working with Port Variables for more information.
  
         	[bookmark: pgfId-4907292]$HTTP_PORTS
  
        
 
         
         	[bookmark: pgfId-4907294]all ports except ports defined by a port variable
  
         	[bookmark: pgfId-4907296]the variable name, in uppercase letter, preceded by !$
  
         	[bookmark: pgfId-4907298]!$HTTP_PORTS
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-4666788][bookmark: 96359]Specify[bookmark: marker-4666787]ing Direction
 
     [bookmark: pgfId-4237854]License: Protection
 
      
       
        
        [bookmark: pgfId-1466701]Table 24-4 [bookmark: 10879]Directional Options in Rule Headers 
 
        
        
         
         	 
           
           [bookmark: pgfId-1466705]Use... 
          
  
         	 
           
           [bookmark: pgfId-1466707]To Test... 
          
  
        
 
         
         	[bookmark: pgfId-1466709]Directional
  
         	[bookmark: pgfId-1466711]only traffic from the specified source IP address to the specified destination IP address
  
        
 
         
         	[bookmark: pgfId-1466713]Bidirectional
  
         	[bookmark: pgfId-1466715]all traffic traveling between the specified source and destination IP addresses
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1403050]See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
    
 
   
 
    
     [bookmark: pgfId-1058616][bookmark: 74878]Understand[bookmark: marker-1058615]ing Keywords and Arguments in Rules
 
    [bookmark: pgfId-4237875]License: Protection
 
    [bookmark: pgfId-1058617]Using the rules language, you can specify the behavior of a rule by combining keywords. Keywords and their associated values (called arguments) dictate how the system evaluates packets and packet-related values that the rules engine tests. The ASA FirePOWER module currently supports keywords that allow you to perform inspection functions, such as content matching, protocol-specific pattern matching, and state-specific matching. You can define up to 100 arguments per keyword, and combine any number of compatible keywords to create highly specific rules. This helps decrease the chance of false positives and false negatives and focus the intrusion information you receive.
 
    [bookmark: pgfId-4566707]Note that you can also use adaptive profiles to dynamically adapt active rule processing for specific packets based on rule metadata and host information. For more information, see Tuning Preprocessing in Passive Deployments.
 
    [bookmark: pgfId-1091258]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1091259]Defining Intrusion Event Details describes the syntax and use of keywords that allow you to define the event’s message, priority information, and references to external information about the exploit the rule detects.
 
     	 [bookmark: pgfId-4788590]Searching for Content Matches describes how to use the  content  or  protected_content  keywords to test the content of the packet payload.
 
     	 [bookmark: pgfId-4788594]Constraining Content Matches describes how to use modifying keywords for the  content or  protected_content  keywords.
 
     	 [bookmark: pgfId-4002749]Replacing Content in Inline Deployments describes how to use the  replace keyword in inline deployments to replace specified content of equal length.
 
     	 [bookmark: pgfId-1728911]Using Byte_Jump and Byte_Test describes how to use the  byte_jump and  byte_test keywords to calculate where in a packet the rules engine should begin testing for a content match, and which bytes it should evaluate.
 
     	 [bookmark: pgfId-1148902]Searching for Content Using PCRE describes how to use the  pcre keyword to use Perl-compatible regular expressions in rules.
 
     	 [bookmark: pgfId-2641029]Adding Metadata to a Rule describes how to use the  metadata keyword to add information to a rule.
 
     	 [bookmark: pgfId-1091271]Inspecting IP Header Values describes the syntax and use of keywords that test values in the packet’s IP header.
 
     	 [bookmark: pgfId-1091276]Inspecting ICMP Header Values describes the syntax and use of keywords that test values in the packet’s ICMP header.
 
     	 [bookmark: pgfId-4113879]Inspecting TCP Header Values and Stream Size describes the syntax and use of keywords that test values in the packet’s TCP header.
 
     	 [bookmark: pgfId-4113959]Enabling and Disabling TCP Stream Reassembly describes how to enable and disable stream reassembly for a single connection when inspected traffic on the connection matches the conditions of the rule.
 
     	 [bookmark: pgfId-4113963]Extracting SSL Information from a Session describes the use and syntax of keywords that extract version and state information from encrypted traffic.
 
     	 [bookmark: pgfId-4002765]Reading Packet Data into Keyword Arguments describes how to read a value from a packet into a variable that you can use later in the same rule to specify the value for arguments in certain other keywords.
 
     	 [bookmark: pgfId-2763410]Inspecting Application Layer Protocol Values describes the use and syntax of keywords that test application layer protocol properties.
 
     	 [bookmark: pgfId-1091389]Inspecting Packet Characteristics describes the use and syntax of the  dsize ,  sameIP ,  isdataat ,  fragoffset , and  cvs keywords.
 
     	 [bookmark: pgfId-4002773]Initiating Active Responses with Rule Keywords explains how to use the  resp keyword to actively close TCP connections or UDP sessions, the  react keyword to send an HTML page and then actively close TCP connections, and the  config response command to specify the active response interface and the number of TCP resets to attempt in a passive deployment.
 
     	 [bookmark: pgfId-3455995]Filtering Events describes how to prevent a rule from triggering an event unless a specified number packets meet the rule’s detection criteria within a specified time.
 
     	 [bookmark: pgfId-3157541]Evaluating Post-Attack Traffic describes how to log additional traffic for the host or session.
 
     	 [bookmark: pgfId-3719307]Detecting Attacks That Span Multiple Packets describes how to assign state names to packets from attacks that span multiple packets in a single session, then analyze and alert on packets according to their state.
 
     	 [bookmark: pgfId-3719311]Generating Events on the HTTP Encoding Type and Location describes how to generate events on the type of encoding in an HTTP request or response URI, header, or cookie, including set-cookies, before normalization.
 
     	 [bookmark: pgfId-4876221]Detecting File Types and Versions describes how to point to a specific file type or file version using the  file_type or  file_group keyword.
 
     	 [bookmark: pgfId-4876225]Pointing to a Specific Payload Type describes how to point to the beginning of the HTTP response entity body, SMTP payload, or encoded email attachment.
 
     	 [bookmark: pgfId-4216431]Pointing to the Beginning of the Packet Payload describes how to point to the beginning of the packet payload.
 
     	 [bookmark: pgfId-3719315]Decoding and Inspecting Base64 Data describes how you can use the  base64_decode and  base64_data keywords to decode and inspect Base64 data, especially in HTTP requests.
 
    
 
     
      [bookmark: pgfId-2174772][bookmark: 25305]Defining Intrusion [bookmark: marker-4517522]Event Details
 
     [bookmark: pgfId-4237888]License: Protection
 
     [bookmark: pgfId-2019984]As you construct a standard text rule, you can include contextual information that describes the vulnerability that the rule detects attempts to exploit. You can also include external references to vulnerability databases and define the priority that the event holds in your organization. When analysts see the event, they then have information about the priority, exploit, and known mitigation readily available.
 
     [bookmark: pgfId-1091627]See the following sections for more information about event-related keywords:
 
      
      	 [bookmark: pgfId-1091628]Defining the Event Message
 
      	 [bookmark: pgfId-1990813]Defining the Event Priority
 
      	 [bookmark: pgfId-1161938]Defining the Intrusion Event Classification
 
      	 [bookmark: pgfId-1161942]Defining the Event Reference
 
     
 
    
 
     
      [bookmark: pgfId-1161944][bookmark: 62740]Defining the Event Message[bookmark: marker-1161978]
 
     [bookmark: pgfId-4237901]License: Protection
 
     [bookmark: pgfId-1133271]You can specify meaningful text that appears as a message when the rule triggers. The message gives immediate insight into the nature of the vulnerability that the rule detects attempts to exploit. You can use any printable standard ASCII characters except curly braces ({}). The system strips quotes that completely surround the message.
 
      
       
     
 
     
 
     [bookmark: pgfId-2267557]Tip You must specify a rule message. Also, the message cannot consist of white space only, one or more quotation marks only, one or more apostrophes only, or any combination of just white space, quotation marks, or apostrophes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1133274]To define the event message in the rule editor, enter the event message in the Message field. See Constructing a Rule for more information about using the rule editor to build rules.
 
    
 
     
      [bookmark: pgfId-1990460][bookmark: 58759]Defining the Ev[bookmark: marker-3534896]ent Priority
 
     [bookmark: pgfId-4237914]License: Protection
 
     [bookmark: pgfId-1990461]By default, the priority of a rule derives from the event classification for the rule. However, you can override the classification priority for a rule by adding the priority keyword to the rule.
 
     [bookmark: pgfId-1990706]To specify a priority using the rule editor, select priority from the Detection Options list, and select high, medium, or low from the drop-down list. For example, to assign a high priority for a rule that detects web application attacks, add the priority keyword to the rule and select high as the priority. See Constructing a Rule for more information about using the rule editor to build rules.
 
    
 
     
      [bookmark: pgfId-1070349][bookmark: 38136]Defining the Intrusion Event Classification[bookmark: marker-1161976]
 
     [bookmark: pgfId-4237927]License: Protection
 
     [bookmark: pgfId-1068375]For each rule, you can specify an attack classification that appears in the packet display of the event. The following table lists the name and number for each classification.
 
     [bookmark: pgfId-4540023][bookmark: 71706]
 
      
       
        
        [bookmark: pgfId-4907821]Table 24-5 [bookmark: 28264]Rule Classifications 
 
        
        
         
         	 
           
           [bookmark: pgfId-4907827]Number 
          
  
         	 
           
           [bookmark: pgfId-4907829]Classification Name 
          
  
         	 
           
           [bookmark: pgfId-4907831]Description 
          
  
        
 
         
         	[bookmark: pgfId-4907833]1
  
         	[bookmark: pgfId-4907835]not-suspicious
  
         	[bookmark: pgfId-4907837]Not Suspicious Traffic
  
        
 
         
         	[bookmark: pgfId-4907839]2
  
         	[bookmark: pgfId-4907841]unknown
  
         	[bookmark: pgfId-4907843]Unknown Traffic
  
        
 
         
         	[bookmark: pgfId-4907845]3
  
         	[bookmark: pgfId-4907847]bad-unknown
  
         	[bookmark: pgfId-4907849]Potentially Bad Traffic
  
        
 
         
         	[bookmark: pgfId-4907851]4
  
         	[bookmark: pgfId-4907853]attempted-recon
  
         	[bookmark: pgfId-4907855]Attempted Information Leak
  
        
 
         
         	[bookmark: pgfId-4907857]5
  
         	[bookmark: pgfId-4907859]successful-recon-limited
  
         	[bookmark: pgfId-4907861]Information Leak
  
        
 
         
         	[bookmark: pgfId-4907863]6
  
         	[bookmark: pgfId-4907865]successful-recon-largescale
  
         	[bookmark: pgfId-4907867]Large Scale Information Leak
  
        
 
         
         	[bookmark: pgfId-4907869]7
  
         	[bookmark: pgfId-4907871]attempted-dos
  
         	[bookmark: pgfId-4907873]Attempted Denial of Service
  
        
 
         
         	[bookmark: pgfId-4907875]8
  
         	[bookmark: pgfId-4907877]successful-dos
  
         	[bookmark: pgfId-4907879]Denial of Service
  
        
 
         
         	[bookmark: pgfId-4907881]9
  
         	[bookmark: pgfId-4907883]attempted-user
  
         	[bookmark: pgfId-4907885]Attempted User Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907887]10
  
         	[bookmark: pgfId-4907889]unsuccessful-user
  
         	[bookmark: pgfId-4907891]Unsuccessful User Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907893]11
  
         	[bookmark: pgfId-4907895]successful-user
  
         	[bookmark: pgfId-4907897]Successful User Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907899]12
  
         	[bookmark: pgfId-4907901]attempted-admin
  
         	[bookmark: pgfId-4907903]Attempted Administrator Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907905]13
  
         	[bookmark: pgfId-4907907]successful-admin
  
         	[bookmark: pgfId-4907909]Successful Administrator Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907911]14
  
         	[bookmark: pgfId-4907913]rpc-portmap-decode
  
         	[bookmark: pgfId-4907915]Decode of an RPC Query
  
        
 
         
         	[bookmark: pgfId-4907917]15
  
         	[bookmark: pgfId-4907919]shellcode-detect
  
         	[bookmark: pgfId-4907921]Executable Code was Detected
  
        
 
         
         	[bookmark: pgfId-4907923]16
  
         	[bookmark: pgfId-4907925]string-detect
  
         	[bookmark: pgfId-4907927]A Suspicious String was Detected
  
        
 
         
         	[bookmark: pgfId-4907929]17
  
         	[bookmark: pgfId-4907931]suspicious-filename-detect
  
         	[bookmark: pgfId-4907933]A Suspicious Filename was Detected
  
        
 
         
         	[bookmark: pgfId-4907935]18
  
         	[bookmark: pgfId-4907937]suspicious-login
  
         	[bookmark: pgfId-4907939]An Attempted Login Using a Suspicious Username was Detected
  
        
 
         
         	[bookmark: pgfId-4907941]19
  
         	[bookmark: pgfId-4907943]system-call-detect
  
         	[bookmark: pgfId-4907945]A System Call was Detected
  
        
 
         
         	[bookmark: pgfId-4907947]20
  
         	[bookmark: pgfId-4907949]tcp-connection
  
         	[bookmark: pgfId-4907951]A TCP Connection was Detected
  
        
 
         
         	[bookmark: pgfId-4907953]21
  
         	[bookmark: pgfId-4907955]trojan-activity
  
         	[bookmark: pgfId-4907957]A Network Trojan was Detected
  
        
 
         
         	[bookmark: pgfId-4907959]22
  
         	[bookmark: pgfId-4907961]unusual-client-port-connection
  
         	[bookmark: pgfId-4907963]A Client was Using an Unusual Port
  
        
 
         
         	[bookmark: pgfId-4907965]23
  
         	[bookmark: pgfId-4907967]network-scan
  
         	[bookmark: pgfId-4907969]Detection of a Network Scan
  
        
 
         
         	[bookmark: pgfId-4907971]24
  
         	[bookmark: pgfId-4907973]denial-of-service
  
         	[bookmark: pgfId-4907975]Detection of a Denial of Service Attack
  
        
 
         
         	[bookmark: pgfId-4907977]25
  
         	[bookmark: pgfId-4907979]non-standard-protocol
  
         	[bookmark: pgfId-4907981]Detection of a Non-Standard Protocol or Event
  
        
 
         
         	[bookmark: pgfId-4907983]26
  
         	[bookmark: pgfId-4907985]protocol-command-decode
  
         	[bookmark: pgfId-4907987]Generic Protocol Command Decode
  
        
 
         
         	[bookmark: pgfId-4907989]27
  
         	[bookmark: pgfId-4907991]web-application-activity
  
         	[bookmark: pgfId-4907993]Access to a Potentially Vulnerable Web Application
  
        
 
         
         	[bookmark: pgfId-4907995]28
  
         	[bookmark: pgfId-4907997]web-application-attack
  
         	[bookmark: pgfId-4907999]Web Application Attack
  
        
 
         
         	[bookmark: pgfId-4908001]29
  
         	[bookmark: pgfId-4908003]misc-activity
  
         	[bookmark: pgfId-4908005]Misc Activity
  
        
 
         
         	[bookmark: pgfId-4908007]30
  
         	[bookmark: pgfId-4908009]misc-attack
  
         	[bookmark: pgfId-4908011]Misc Attack
  
        
 
         
         	[bookmark: pgfId-4908013]31
  
         	[bookmark: pgfId-4908015]icmp-event
  
         	[bookmark: pgfId-4908017]Generic ICMP Event
  
        
 
         
         	[bookmark: pgfId-4908019]32
  
         	[bookmark: pgfId-4908021]inappropriate-content
  
         	[bookmark: pgfId-4908023]Inappropriate Content was Detected
  
        
 
         
         	[bookmark: pgfId-4908025]33
  
         	[bookmark: pgfId-4908027]policy-violation
  
         	[bookmark: pgfId-4908029]Potential Corporate Privacy Violation
  
        
 
         
         	[bookmark: pgfId-4908031]34
  
         	[bookmark: pgfId-4908033]default-login-attempt
  
         	[bookmark: pgfId-4908035]Attempt to Login By a Default Username and Password
  
        
 
         
         	[bookmark: pgfId-4908037]35
  
         	[bookmark: pgfId-4908039]sdf
  
         	[bookmark: pgfId-4908041]Sensitive Data
  
        
 
         
         	[bookmark: pgfId-4908043]36
  
         	[bookmark: pgfId-4908045]malware-cnc
  
         	[bookmark: pgfId-4908047]Known malware command and control traffic
  
        
 
         
         	[bookmark: pgfId-4908049]37
  
         	[bookmark: pgfId-4908051]client-side-exploit
  
         	[bookmark: pgfId-4908053]Known client side exploit attempt
  
        
 
         
         	[bookmark: pgfId-4908055]38
  
         	[bookmark: pgfId-4908057]file-format
  
         	[bookmark: pgfId-4908059]Known malicious file or file based exploit
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2208939]To specify a classification in the rule editor, select a classification from the Classification list. See Writing New Rules for more information on the rule editor.
 
     [bookmark: pgfId-1526282][bookmark: 52255]Adding Custom Classifications
 
     [bookmark: pgfId-4237942]License: Protection
 
     [bookmark: pgfId-4961678]If you want more customized content for the packet display description of the events generated by a rule you define, create a custom classification.
 
     [bookmark: pgfId-4961679]To add classifications to the Classification list:
 
     
 
     [bookmark: pgfId-4974189]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy > Rule Editor.
 
     [bookmark: pgfId-1895383]The Rule Editor page appears.
 
     [bookmark: pgfId-1895497]Step 2 Click Create Rule. 
 
     [bookmark: pgfId-1937756]The Create Rule page appears.
 
     [bookmark: pgfId-1516150]Step 3 Under the Classification drop-down list, click Edit Classifications.
 
     [bookmark: pgfId-1516277]A pop-up window appears.
 
     [bookmark: pgfId-1516280]Step 4 Type the name of the classification in the Classification Name field.
 
     [bookmark: pgfId-1656602]You can use up to 255 alphanumeric characters, but the page is difficult to read if you use more than 40 characters. The following characters are not supported: <>()\'"&$; and the space character.
 
     [bookmark: pgfId-1516316]Step 5 Type a description of the classification in the Classification Description field.
 
     [bookmark: pgfId-1656604]You can use up to 255 alphanumeric characters and spaces. The following characters are not supported: <>()\'"&$;
 
     [bookmark: pgfId-1516349]Step 6 Select a priority from the Priority list.
 
     [bookmark: pgfId-1516397]You can select high, medium, or low.
 
     [bookmark: pgfId-1516423]Step 7 Click Add.
 
     [bookmark: pgfId-2011503]The new classification is added to the list and becomes available for use in the rule editor.
 
     [bookmark: pgfId-2020727]Step 8 Click Done.
 
     [bookmark: pgfId-4774522]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2187126][bookmark: 72334]Defining the Event Reference[bookmark: marker-2187125]
 
     [bookmark: pgfId-4237965]License: Protection
 
     [bookmark: pgfId-2187127]You can use the reference keyword to add references to external web sites and additional information about the event. Adding a reference provides analysts with an immediately available resource to help them identify why the packet triggered a rule. The following table lists some of the external systems that can provide data on known exploits and attacks.
 
     [bookmark: pgfId-1071105]
 
      
       
        
        [bookmark: pgfId-1447552]Table 24-6 [bookmark: 99506]External Attack Identification Systems 
 
        
        
         
         	 
           
           [bookmark: pgfId-1071108]System ID 
          
  
         	 
           
           [bookmark: pgfId-1071110]Description 
          
  
         	 
           
           [bookmark: pgfId-1134221]Example ID 
          
  
        
 
         
         	[bookmark: pgfId-1071112]bugtraq
  
         	[bookmark: pgfId-1071114]Bugtraq page
  
         	[bookmark: pgfId-1134223]8550
  
        
 
         
         	[bookmark: pgfId-1071116]cve
  
         	[bookmark: pgfId-1071118]Common Vulnerabilities and Exposure page
  
         	[bookmark: pgfId-1134225]CAN-2003-0702
  
        
 
         
         	[bookmark: pgfId-1071124]mcafee
  
         	[bookmark: pgfId-1071126]McAfee page
  
         	[bookmark: pgfId-1134229]98574
  
        
 
         
         	[bookmark: pgfId-1133791]url
  
         	[bookmark: pgfId-1133793]Website reference
  
         	[bookmark: pgfId-1134231]www.example.com?exploit=14
  
        
 
         
         	[bookmark: pgfId-4412739]msb
  
         	[bookmark: pgfId-4412741]Microsoft security bulletin
  
         	[bookmark: pgfId-4412743]MS11-082
  
        
 
         
         	[bookmark: pgfId-4414735]nessus
  
         	[bookmark: pgfId-4414737]Nessus page
  
         	[bookmark: pgfId-4414739]10039
  
        
 
         
         	[bookmark: pgfId-4414729]secure-url
  
         	[bookmark: pgfId-4414731]Secure Website Reference (https://...)
  
         	[bookmark: pgfId-4414733]intranet/exploits/exploit=14
 [bookmark: pgfId-4415194]Note that you can use secure-url with any secure website.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1070984]To specify a reference using the rule editor, select reference from the Detection Options list, and enter a value in the corresponding field as follows:
 
      
      [bookmark: pgfId-1133772]id_system,id 
     
 
     [bookmark: pgfId-1133784]where id_system is the system being used as a prefix, and id is the Bugtraq ID, CVE number, Arachnids ID, or URL (without http://).
 
     [bookmark: pgfId-1071001]For example, to specify the authentication bypass vulnerability on Microsoft Commerce Server 2002 servers documented in Bugtraq ID 17134, enter the following in the reference field:
 
      
      [bookmark: pgfId-1134274]bugtraq,17134 
     
 
     [bookmark: pgfId-1134699]Note the following when adding references to a rule:
 
      
      	 [bookmark: pgfId-4414834]Do not use a space after the comma.
 
      	 [bookmark: pgfId-4414849]Do not use uppercase letters in the system ID.
 
     
 
     [bookmark: pgfId-4414815]See Constructing a Rule for more information about using the rule editor to build rules.
 
    
 
     
      [bookmark: pgfId-1093511][bookmark: 92509]Searching for Content Matches
 
     [bookmark: pgfId-4237978]License: Protection
 
     [bookmark: pgfId-4860326]Use the content keyword or the protected_content keyword to specify content that you want to detect in a packet. See the following sections for more information:
 
      
      	 [bookmark: pgfId-4860330]Using the content Keyword
 
      	 [bookmark: pgfId-4860334]Using the protected_content Keyword
 
      	 [bookmark: pgfId-4860338]Configuring Content Matching
 
     
 
    
 
     
      [bookmark: pgfId-4860340][bookmark: 30566]Using the conte[bookmark: marker-4867202]nt Keyword
 
     [bookmark: pgfId-4708496]When you use the content keyword, the rules engine searches the packet payload or stream for that string. For example, if you enter /bin/sh as the value for one of the content keywords, the rules engine searches the packet payload for the string /bin/sh.
 
     [bookmark: pgfId-1156554]Match content using either an ASCII string, hexadecimal content (binary byte code), or a combination of both. Surround hexadecimal content with pipe characters (|) in the keyword value. For example, you can mix hexadecimal content and ASCII content using something that looks like |90C8 C0FF FFFF|/bin/sh.
 
     [bookmark: pgfId-1058738]You can specify multiple content matches in a single rule. To do this, use additional instances of the content keyword. For each content match, you can indicate that content matches must be found in the packet payload or stream for the rule to trigger.
 
    
 
     
      [bookmark: pgfId-4860371][bookmark: 31807]Using the protecte[bookmark: marker-4867207]d_content Keyword
 
     [bookmark: pgfId-4860373]The protected_content keyword allows you to encode your search content string before configuring the rule argument. The original rule author uses a hash function (SHA-512, SHA-256, or MD5) to encode the string before configuring the keyword. 
 
     [bookmark: pgfId-4860374]When you use the protected_content keyword instead of the content keyword, there is no change to how the rules engine searches the packet payload or stream for that string and most of the keyword options function as expected. The following table summarizes the exceptions, where the protected_content keyword options differ from the content keyword options.
 
     [bookmark: pgfId-4860425]
 
      
       
        
        [bookmark: pgfId-4908793]Table 24-7 protected_content Option Exceptions 
 
        
        
         
         	 
           
           [bookmark: pgfId-4908797]Option 
          
  
         	 
           
           [bookmark: pgfId-4908799]Description 
          
  
        
 
         
         	[bookmark: pgfId-4908801]Hash Type
  
         	[bookmark: pgfId-4908803]New option for the protected_content rule keyword. For more information, see Hash Type.
  
        
 
         
         	[bookmark: pgfId-4908808]Case Insensitive
  
         	[bookmark: pgfId-4908810]Not supported
  
        
 
         
         	[bookmark: pgfId-4908812]Within
  
         	[bookmark: pgfId-4908814]Not supported
  
        
 
         
         	[bookmark: pgfId-4908816]Depth
  
         	[bookmark: pgfId-4908818]Not supported
  
        
 
         
         	[bookmark: pgfId-4908820]Length
  
         	[bookmark: pgfId-4908822]New option for the protected_content rule keyword. For more information, see Length.
  
        
 
         
         	[bookmark: pgfId-4908827]Use Fast Pattern Matcher
  
         	[bookmark: pgfId-4908829]Not supported
  
        
 
         
         	[bookmark: pgfId-4908831]Fast Pattern Matcher Only
  
         	[bookmark: pgfId-4908833]Not supported
  
        
 
         
         	[bookmark: pgfId-4908835]Fast Pattern Matcher Offset and Length
  
         	[bookmark: pgfId-4908837]Not supported
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4860429]Cisco recommends that you include at least one content keyword in rules that include a protected_content keyword to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Position the content keyword before the protected_content keyword in the rule. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument.
 
    
 
     
      [bookmark: pgfId-4860431][bookmark: 40906]Configuring Content Matching
 
     [bookmark: pgfId-4781756]You should almost always follow a content or protected_content keyword by modifiers that indicate where the content should be searched for, whether the search is case sensitive, and other options. See Constraining Content Matches for more information about modifiers to the content and protected_content keywords.
 
     [bookmark: pgfId-2267990]Note that all content matches must be true for the rule to trigger an event, that is, each content match has an AND relationship with the others.
 
     [bookmark: pgfId-4793014]Note also that, in an inline deployment, you can set up rules that match malicious content and then replace it with your own text string of equal length. See Replacing Content in Inline Deployments for more information.
 
     [bookmark: pgfId-4792999]To enter content to be matched: 
 
     
 
     [bookmark: pgfId-1895918]Step 1 In the content field, type the content you want to find (for example, |90C8 C0FF FFFF|/bin/sh). 
 
     [bookmark: pgfId-1895755]If you want to search for any content that is not the specified content, select the Not check box. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2287036] 
      Caution You may invalidate your intrusion policy if you create a rule that includes only one 
      content keyword and that keyword has the 
      Not option selected. For more information, see 
      Not. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1895812]Step 2 Optionally, add additional keywords that modify the content keyword or add constraints for the keyword. 
 
     [bookmark: pgfId-4961565]For more information on other keywords, see Understanding Keywords and Arguments in Rules. For more information on constraining the content keyword, see Constraining Content Matches.
 
     [bookmark: pgfId-2012542]Step 3 Continue with creating or editing the rule. 
 
     [bookmark: pgfId-4961581]See Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774551]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860452]To enter protected content to be matched:
 
     
 
     [bookmark: pgfId-4860458]Step 1 [bookmark: 15399]Using a SHA-512, SHA-256, or MD5 hash generator, encode the content you want to find (for example, run the string Sample1 through a SHA-512 hash generator).
 
     [bookmark: pgfId-4860459]The generator outputs a hash for your string.
 
     [bookmark: pgfId-4860464]Step 2 [bookmark: 24989]In the protected_content field, type the hash you generated in step 1 (for example, B20AABAF59605118593404BD42FE69BD8D6506EE7F1A71CE6BB470B1DF848C814BC5DBEC2081999F15691A71FAECA5FBA4A3F8B8AB56B7F04585DA6D73E5DD15).
 
     [bookmark: pgfId-4860465]If you want to search for any content that is not the specified content, select the Not check box. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-4860466] 
      Caution You may invalidate your intrusion policy if you create a rule that includes only one 
      protected_content keyword and that keyword has the 
      Not option selected. For more information, see 
      Not. 
       
       
 
      
 
     
 
     [bookmark: pgfId-4860473]Step 3 From the Hash Type drop-down list, select the hash function you used in step 1 (for example, SHA-512). Note that the number of bits in the hash entered in step 2 must match the hash type or the system does not save the rule. For more information, see Hash Type.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860483]Tip If you select the Cisco-set Default, the system assumes SHA-512 as the hash function.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860484]Step 4 Type a value in the required Length field. The value must correspond with the length of the original, unhashed string you want to find (for example, the string Sample1 from step 2 has the length 7). 
 
     [bookmark: pgfId-4967330]For more information, see Length.
 
     [bookmark: pgfId-4860491]Step 5 Type a value in either the Offset or Distance field. You cannot mix the Offset and Distance options within a single keyword configuration. 
 
     [bookmark: pgfId-4967341]For more information, see Using Search Location Options in the protected_content Keyword.
 
     [bookmark: pgfId-4860495]Step 6 Optionally, add additional constraining options that modify the protected_content keyword. 
 
     [bookmark: pgfId-4967348]For more information, see Constraining Content Matches.
 
     [bookmark: pgfId-4860499]Step 7 Optionally, add additional keywords that modify the protected_content keyword. 
 
     [bookmark: pgfId-4967355]For more information, see Understanding Keywords and Arguments in Rules.
 
     [bookmark: pgfId-4860510]Step 8 Continue with creating or editing the rule. 
 
     [bookmark: pgfId-4961597]See Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4860514]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3925176][bookmark: 14387]Constraining Content Matches
 
     [bookmark: pgfId-4237992]License: Protection
 
     [bookmark: pgfId-4710583]You can constrain the location and case-sensitivity of content searches with parameters that modify the content or protected_content keyword. Configure options that modify the content or protected_content keyword to specify the content for which you want to search.
 
     [bookmark: pgfId-3628685]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-3153151]Case Insensitive
 
      	 [bookmark: pgfId-4860537]Hash Type
 
      	 [bookmark: pgfId-3153159]Raw Data
 
      	 [bookmark: pgfId-3153219]Not
 
      	 [bookmark: pgfId-3153500]Search Location Options
 
      	 [bookmark: pgfId-3153179]HTTP Content Options
 
      	 [bookmark: pgfId-3153183]Use Fast Pattern Matcher
 
     
 
    
 
     
      [bookmark: pgfId-1225513][bookmark: marker-1225511][bookmark: 20752]Case Insensitive
 
     [bookmark: pgfId-4238013]License: Protection
 
      
       
     
 
     
 
     [bookmark: pgfId-4860542]Note This option is not supported when configuring the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1225514]You can instruct the rules engine to ignore case when searching for content matches in ASCII strings. To make your search case-insensitive, check Case Insensitive when specifying a content search.
 
     [bookmark: pgfId-1896652]To specify Case Insensitive when doing a content search: 
 
     
 
     [bookmark: pgfId-4789117]Step 1 Select Case Insensitive for the content keyword you are adding.
 
     [bookmark: pgfId-4789123]Step 2 Continue with creating or editing the rule. 
 
     [bookmark: pgfId-4961605]See Constraining Content Matches, Searching for Content Matches, Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4775520]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4860551] Hash Type [bookmark: 14612]
 
     [bookmark: pgfId-4860558]License: Protection
 
      
       
     
 
     
 
     [bookmark: pgfId-4860560]Note This option is only configurable with the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860564]Use the Hash Type drop-down to identify the hash function you used to encode your search string. The system supports SHA-512, SHA-256, and MD5 hashing for protected_content search strings. If the length of your hashed content does not match the selected hash type, the system does not save the rule.
 
     [bookmark: pgfId-4860568]The system automatically selects the Cisco-set default value. When Default is selected, no specific hash function is written into the rule and the system assumes SHA-512 for the hash function.
 
     [bookmark: pgfId-4860569]To specify a hash function when doing a protected content search:
 
     
 
     [bookmark: pgfId-4860570]Step 1 From the Hash Type drop-down list, select Default, SHA-512, SHA-256, or MD5 as the hash for the protected_content keyword you are adding.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860574]Tip If you select the Cisco-set Default, the system assumes SHA-512 as the hash function. For more information, see Hash Type.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860581]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4860591]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4784028]  [bookmark: marker-2269760][bookmark: 41514]Raw Data 
 
     [bookmark: pgfId-4238026]License: Protection
 
     [bookmark: pgfId-2269763]The Raw Data option instructs the rules engine to analyze the original packet payload before analyzing the normalized payload data (decoded by a network analysis policy) and does not use an argument value. You can use this keyword when analyzing telnet traffic to check the telnet negotiation options in the payload before normalization.
 
     [bookmark: pgfId-3719338]You cannot use the Raw Data option together in the same content or protected_content keyword with any HTTP content option. See HTTP Content Options for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-3154699]Tip You can configure the HTTP Inspect preprocessor Client Flow Depth and Server Flow Depth options to determine whether raw data is inspected in HTTP traffic, and how much raw data is inspected. For more information, see Selecting Server-Level HTTP Normalization Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2269767]To analyze raw data: 
 
     
 
     [bookmark: pgfId-4788880]Step 1 Select the Raw Data check box for the content or protected_content keyword you are adding.
 
     [bookmark: pgfId-4788886]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774571]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4722917][bookmark: 25080]Not
 
     [bookmark: pgfId-4722921]License: Protection
 
     [bookmark: pgfId-4722922]Select the Not option to search for content that does not match the specified content. If you create a rule that includes a content or protected_content keyword with the Not option selected, you must also include in the rule at least one other content or protected_content keyword without the Not option selected.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2278094] 
      Caution Do not create a rule that includes only one 
      content or 
      protected_content keyword if that keyword has the 
      Not option selected. You may invalidate your intrusion policy. 
       
       
 
      
 
     
 
     [bookmark: pgfId-3719356]For example, SMTP rule 1:2541:9 includes three content keywords, one of which has the Not option selected. A custom rule based on this rule would be invalid if you removed all of the content keywords except the one with the Not option selected. Adding such a rule to your intrusion policy could invalidate the policy.
 
     [bookmark: pgfId-3628838]To search for content that does not match the specified content: 
 
     
 
     [bookmark: pgfId-2271252]Step 1 Select the Not check box for the content or protected_content keyword you are adding.
 
      
       
     
 
     
 
     [bookmark: pgfId-3154827]Tip You cannot select the Not check box and the Use Fast Pattern Matcher check box with the same content keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2280813]Step 2 Include in the rule at least one other content or protected_content keyword that does not have the Not option selected.
 
     [bookmark: pgfId-2271255]Step 3 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774584]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4415460][bookmark: 14171]Search Location Options
 
     [bookmark: pgfId-4784733]License: Protection
 
     [bookmark: pgfId-4860632]You can use search location options to specify where to begin searching for the specified content and how far to continue searching. For details about each option, see:
 
      
      	 [bookmark: pgfId-4860636]Depth
 
      	 [bookmark: pgfId-4860640]Distance
 
      	 [bookmark: pgfId-4860644]Length
 
      	 [bookmark: pgfId-4860648]Offset
 
      	 [bookmark: pgfId-4860652]Within
 
     
 
     [bookmark: pgfId-4860653]For information about how to use search location options within the content or protected_content keyword, see: 
 
      
      	 [bookmark: pgfId-4860657]Using Search Location Options in the content Keyword
 
      	 [bookmark: pgfId-4860661]Using Search Location Options in the protected_content Keyword
 
     
 
     [bookmark: pgfId-4860664][bookmark: 33674]De[bookmark: marker-4860663]pth
 
      
       
     
 
     
 
     [bookmark: pgfId-4860665]Note This option is only supported when configuring the content keyword. For more information, see Using the content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860669]Specifies the maximum content search depth, in bytes, from the beginning of the offset value, or if no offset is configured, from the beginning of the packet payload.
 
     [bookmark: pgfId-4860670]For example, in a rule with a content value of cgi-bin/phf, and offset value of 3, and a depth value of 22, the rule starts searching for a match to the cgi-bin/phf string at byte 3, and stops after processing 22 bytes (byte 25) in packets that meet the parameters specified by the rule header.
 
     [bookmark: pgfId-4860671]You must specify a value that is greater than or equal to the length of the specified content, up to a maximum of 65535 bytes. You cannot specify a value of 0.
 
     [bookmark: pgfId-4860672]The default depth is to search to the end of the packet.
 
     [bookmark: pgfId-4871115][bookmark: 12104][bookmark: marker-4871114]Distance 
 
     [bookmark: pgfId-4871116]Instructs the rules engine to identify subsequent content matches that occur a specified number of bytes after the previous successful content match.
 
     [bookmark: pgfId-4860678]Because the distance counter starts at byte 0, specify one less than the number of bytes you want to move forward from the last successful content match. For example, if you specify 4, the search begins at the fifth byte.
 
     [bookmark: pgfId-4860679]You can specify a value of -65535 to 65535 bytes. If you specify a negative Distance value, the byte you start searching on may fall outside the beginning of a packet. Any calculations will take into account the bytes outside the packet, even though the search actually starts on the first byte in the packet. For example, if the current location in the packet is the fifth byte, and the next content rule option specifies a Distance value of -10 and a Within value of 20, the search starts at the beginning of the payload and the Within option is adjusted to 15. 
 
     [bookmark: pgfId-4860680]The default distance is 0, meaning the current location in the packet subsequent to the last content match.
 
     [bookmark: pgfId-4860683][bookmark: 19234]Length[bookmark: marker-4860682]
 
      
       
     
 
     
 
     [bookmark: pgfId-4860684]Note This option is only supported when configuring the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4867320]The Length protected_content keyword option indicates the length, in bytes, of the unhashed search string. 
 
     [bookmark: pgfId-4867321]For example, if you used the content Sample1 to generate a secure hash, use 7 for the Length value. You must enter a value in this field.
 
     [bookmark: pgfId-4860696][bookmark: 91372]Off[bookmark: marker-4860695]set
 
     [bookmark: pgfId-4860697]Specifies in bytes where in the packet payload to start searching for content relative to the beginning of the packet payload. You can specify a value of-65535 to 65535 bytes.
 
     [bookmark: pgfId-4860698]Because the offset counter starts at byte 0, specify one less than the number of bytes you want to move forward from the beginning of the packet payload. For example, if you specify 7, the search begins at the eighth byte.
 
     [bookmark: pgfId-4860699]The default offset is 0, meaning the beginning of the packet. 
 
     [bookmark: pgfId-4860703][bookmark: 26084][bookmark: marker-4860701]Wit[bookmark: marker-4860702]hin
 
      
       
     
 
     
 
     [bookmark: pgfId-4871012]Note This option is only supported when configuring the content keyword. For more information, see Using the content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860708]The Within option indicates that, to trigger the rule, the next content match must occur within the specified number of bytes after the end of the last successful content match. For example, if you specify a Within value of 8, the next content match must occur within the next eight bytes of the packet payload or it does not meet the criteria that triggers the rule.
 
     [bookmark: pgfId-4860709]You can specify a value that is greater than or equal to the length of the specified content, up to a maximum of 65535 bytes.
 
     [bookmark: pgfId-4860710]The default for Within is to search to the end of the packet.
 
    
 
     
      [bookmark: pgfId-4860712][bookmark: 88153]Using Search Location Options in the content Keyword
 
     [bookmark: pgfId-4784735]You can use either of two content location pairs to specify where to begin searching for the specified content and how far to continue searching, as follows:
 
      
      	 [bookmark: pgfId-4415466]Use  Offset and  Depth together to search relative to the beginning of the packet payload.
 
      	 [bookmark: pgfId-4415467]Use  Distance and  Within together to search relative to the current search location.
 
     
 
     [bookmark: pgfId-4415468]When you specify only one of a pair, the default for the other option in the pair is assumed.
 
     [bookmark: pgfId-4416811]You cannot mix the Offset and Depth options with the Distance and Within options. For example, you cannot pair Offset and Within. You can use any number of location options in a rule.
 
     [bookmark: pgfId-4415469]When no location is specified, the defaults for Offset and Depth are assumed; that is, the content search starts at the beginning of the packet payload and continues to the end of the packet.
 
     [bookmark: pgfId-4971480]You can also use an existing byte_extract variable to specify the value for a location option. See Reading Packet Data into Keyword Arguments for more information.
 
     [bookmark: pgfId-4971484]To specify a search location value in a content keyword: 
 
     
 
     [bookmark: pgfId-4971489]Step 1 Type the value in the field for the content keyword you are adding. You have the following choices:
 
      
       
       	 [bookmark: pgfId-4415503] Offset 
 
       	 [bookmark: pgfId-4543300] Depth 
 
       	 [bookmark: pgfId-4543305] Distance 
 
       	 [bookmark: pgfId-4543321] Within 
 
      
 
     
 
     [bookmark: pgfId-4543322]You can use any number of location options in a rule.
 
     [bookmark: pgfId-4543325]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774610]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4860775][bookmark: 12160]Using Search Location Options in the protected_content Keyword
 
     [bookmark: pgfId-4860777]Use the required Length protected_content location option in combination with either the Offset or Distance location option to specify where to begin searching for the specified content and how far to continue searching, as follows:
 
      
      	 [bookmark: pgfId-4860778]Use  Length and  Offset together to search for the protected string relative to the beginning of the packet payload.
 
      	 [bookmark: pgfId-4860779]Use  Length and  Distance together to search for the protected string relative to the current search location.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4860780]Tip You cannot mix the Offset and Distance options within a single keyword configuration, but you can use any number of location options in a rule. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860781]When no location is specified, the defaults are assumed; that is, the content search starts at the beginning of the packet payload and continues to the end of the packet.
 
     [bookmark: pgfId-4860782]You can also use an existing byte_extract variable to specify the value for a location option. For more information, see Reading Packet Data into Keyword Arguments.
 
     [bookmark: pgfId-4860791]To specify a search location value in a protected_content keyword: 
 
     
 
     [bookmark: pgfId-4860796]Step 1 Type the value in the field for the protected_content keyword you are adding. You have the following choices:
 
      
      	 [bookmark: pgfId-4860797] Length (required)
 
       
       	 [bookmark: pgfId-4860798] Offset 
 
       	 [bookmark: pgfId-4860799] Distance 
 
      
 
     
 
     [bookmark: pgfId-4860800]You cannot mix the Offset and Distance options within a single protected_content keyword, but you can use any number of location options in a rule.
 
     [bookmark: pgfId-4860803]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4860814]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3587343][bookmark: 20004]HTTP Content Options
 
     [bookmark: pgfId-4238112]License: Protection
 
     [bookmark: pgfId-3719458]HTTP content or protected_content keyword options let you specify where to search for content matches within an HTTP message decoded by the HTTP Inspect preprocessor.
 
     [bookmark: pgfId-3719459]Two options search status fields in HTTP responses:
 
      
      	 [bookmark: pgfId-3719460] HTTP Status Code 
 
      	 [bookmark: pgfId-3719461] HTTP Status Message 
 
     
 
     [bookmark: pgfId-3719465]Note that although the rules engine searches the raw, unnormalized status fields, these options are listed here separately to simplify explanation below of the restrictions to consider when combining other raw HTTP fields and normalized HTTP fields.
 
     [bookmark: pgfId-3719466]Five options search normalized fields in HTTP requests, responses, or both, as appropriate (see HTTP Content Options for more information):
 
      
      	 [bookmark: pgfId-3719470] HTTP URI 
 
      	 [bookmark: pgfId-3719471] HTTP Method 
 
      	 [bookmark: pgfId-3719472] HTTP Header 
 
      	 [bookmark: pgfId-3719473] HTTP Cookie 
 
      	 [bookmark: pgfId-3719474] HTTP Client Body 
 
     
 
     [bookmark: pgfId-3719475]Three options search raw (unnormalized) non-status fields in HTTP requests, responses, or both, as appropriate (see HTTP Content Options for more information):
 
      
      	 [bookmark: pgfId-3719479] HTTP Raw URI 
 
      	 [bookmark: pgfId-3719480] HTTP Raw Header 
 
      	 [bookmark: pgfId-3719481] HTTP Raw Cookie 
 
     
 
     [bookmark: pgfId-3719482]Use the following guidelines when selecting HTTP content options:
 
      
      	 [bookmark: pgfId-3719483]HTTP  content options apply only to TCP traffic. 
 
      	 [bookmark: pgfId-3719484]To avoid a negative impact on performance, select only those parts of the message where the specified content might appear.
 
     
 
     [bookmark: pgfId-3719485]For example, when traffic is likely to include large cookies such as those in shopping cart messages, you might search for the specified content in the HTTP header but not in HTTP cookies.
 
      
      	 [bookmark: pgfId-3719487]To take advantage of HTTP Inspect preprocessor normalization, and to improve performance, any HTTP-related rule you create should at a minimum include at least one  content or  protected_content keyword with an  HTTP URI ,  HTTP Method ,  HTTP Header , or  HTTP Client Body option selected.
 
      	 [bookmark: pgfId-3719488]You cannot use the  replace keyword in conjunction with HTTP  content or  protected_content keyword options.
 
     
 
     [bookmark: pgfId-3719489]You can specify a single normalized HTTP option or status field, or use normalized HTTP options and status fields in any combination to target a content area to match. However, note the following restrictions when using HTTP field options:
 
      
      	 [bookmark: pgfId-3719490]You cannot use the  Raw Data option together in the same  content or  protected_content keyword with any HTTP option.
 
      	 [bookmark: pgfId-3719491]You cannot use a raw HTTP field option ( HTTP Raw URI ,  HTTP Raw Header , or  HTTP Raw Cookie ) together in the same  content or  protected_content keyword with its normalized counterpart ( HTTP URI ,  HTTP Header , or  HTTP Cookie , respectively).
 
      	 [bookmark: pgfId-3719492]You cannot select  Use Fast Pattern Matcher in combination with one or more of the following HTTP field options:
 
     
 
     [bookmark: pgfId-3719493]HTTP Raw URI, HTTP Raw Header, HTTP Raw Cookie, HTTP Cookie, HTTP Method, HTTP Status Message, or HTTP Status Code
 
     [bookmark: pgfId-3719494]However, you can include the options above in a content or protected_content keyword that also uses the fast pattern matcher to search one of the following normalized fields:
 
     [bookmark: pgfId-4226542]HTTP URI, HTTP Header, or HTTP Client Body
 
     [bookmark: pgfId-4226543]For example, if you select HTTP Cookie, HTTP Header, and Use Fast Pattern Matcher, the rules engine searches for content in both the HTTP cookie and the HTTP header, but the fast pattern matcher is applied only to the HTTP header, not to the HTTP cookie.
 
      
      	 [bookmark: pgfId-4226491]When you combine restricted and unrestricted options, the fast pattern matcher searches only the unrestricted fields you specify to test whether to pass the rule to the rule editor for complete evaluation, including evaluation of the restricted fields. See Use Fast Pattern Matcher for more information.
 
     
 
     [bookmark: pgfId-4549704]The above restrictions are reflected in the description of each option in the following list describing the HTTP content and protected_content keyword options.
 
     [bookmark: pgfId-4543419]HTTP U[bookmark: marker-4545055]RI
 
     [bookmark: pgfId-4543508]Select this option to search for content matches in the normalized request URI field.
 
     [bookmark: pgfId-4543556]Note that you cannot use this option in combination with the pcre keyword HTTP URI (U) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4543568]Note A pipelined HTTP request packet contains multiple URIs. When HTTP URI is selected and the rules engine detects a pipelined HTTP request packet, the rules engine searches all URIs in the packet for a content match.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4545072]HTTP Ra[bookmark: marker-4545071]w URI
 
     [bookmark: pgfId-4545101]Select this option to search for content matches in the normalized request URI field.
 
     [bookmark: pgfId-4545102]Note that you cannot use this option in combination with the pcre keyword HTTP URI (U) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4545109]Note A pipelined HTTP request packet contains multiple URIs. When HTTP URI is selected and the rules engine detects a pipelined HTTP request packet, the rules engine searches all URIs in the packet for a content match.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4543553]HTTP Me[bookmark: marker-4545414]thod
 
     [bookmark: pgfId-4545431]Select this option to search for content matches in the request method field, which identifies the action such as GET and POST to take on the resource identified in the URI.
 
     [bookmark: pgfId-4545453]HTTP He[bookmark: marker-4545461]ader
 
     [bookmark: pgfId-4545485]Select this option to search for content matches in the normalized header field, except for cookies, in HTTP requests; also in responses when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled.
 
     [bookmark: pgfId-4545486]Note that you cannot use this option in combination with the pcre keyword HTTP header (H) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4545543]HTTP Ra[bookmark: marker-4545568]w Header
 
     [bookmark: pgfId-4545598]Select this option to search for content matches in the raw header field, except for cookies, in HTTP requests; also in responses when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled.
 
     [bookmark: pgfId-4545599]Note that you cannot use this option in combination with the pcre keyword HTTP raw header (D) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4545632]HTTP Co[bookmark: marker-4545631]okie
 
     [bookmark: pgfId-4545650]Select this option to search for content matches in any cookie identified in a normalized HTTP client request header; also in response set-cookie data when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled. Note that the system treats cookies included in the message body as body content.
 
     [bookmark: pgfId-4883768]You must enable the HTTP Inspect preprocessor Inspect HTTP Cookies option to search only the cookie for a match; otherwise, the rules engine searches the entire header, including the cookie. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4883772]Note the following:
 
     [bookmark: pgfId-4545663] – You cannot use this option in combination with the pcre keyword HTTP cookie (C) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4545667] – The Cookie: and Set-Cookie: header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
     [bookmark: pgfId-4545974]HTTP Ra[bookmark: marker-4545973]w Cookie
 
     [bookmark: pgfId-4546004]Select this option to search for content matches in any cookie identified in a raw HTTP client request header; also in response set-cookie data when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled; note that the system treats cookies included in the message body as body content.
 
     [bookmark: pgfId-4546005]You must enable the HTTP Inspect preprocessor Inspect HTTP Cookies option to search only the cookie for a match; otherwise, the rules engine searches the entire header, including the cookie. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4546009]Note the following:
 
     [bookmark: pgfId-4546017] – You cannot use this option in combination with the pcre keyword HTTP raw cookie (K) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4546021] – The Cookie: and Set-Cookie: header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
     [bookmark: pgfId-4546045]HTTP Clie[bookmark: marker-4546044]nt Body
 
     [bookmark: pgfId-4546073]Select this option to search for content matches in the message body in an HTTP client request.
 
     [bookmark: pgfId-4546074]Note that for this option to function, you must specify a value of 0 to 65535 for the HTTP Inspect preprocessor HTTP Client Body Extraction Depth option. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4546094]HTTP Stat[bookmark: marker-4546093]us Code
 
     [bookmark: pgfId-4546114]Select this option to search for content matches in the 3-digit status code in an HTTP response.
 
     [bookmark: pgfId-4546115]You must enable the HTTP Inspect preprocessor Inspect HTTP Responses option for this option to return a match. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4545623]HTTP Sta[bookmark: marker-4546430]tus Message
 
     [bookmark: pgfId-4546461]Select this option to search for content matches in the textual description that accompanies the status code in an HTTP response.
 
     [bookmark: pgfId-4546462]You must enable the HTTP Inspect preprocessor Inspect HTTP Responses option for this option to return a match. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-3719654]To specify an HTTP content option when doing a content search of TCP traffic: 
 
     
 
     [bookmark: pgfId-3719656]Step 1 Optionally, to take advantage of HTTP Inspect preprocessor normalization, and to improve performance, select:
 
      
       
       	 [bookmark: pgfId-4928855]at least one from among the  HTTP URI ,  HTTP Raw URI ,  HTTP Method ,  HTTP Header ,  HTTP Raw Header , or  HTTP Client Body options for the  content or  protected_content keyword you are adding
 
       	 [bookmark: pgfId-4928866]the  HTTP Cookie or  HTTP Raw Cookie  option
 
      
 
     
 
     [bookmark: pgfId-3719660]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774671]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3589405][bookmark: 38097]Use Fa[bookmark: marker-3587952]st Pattern Matcher
 
     [bookmark: pgfId-4238125]License: Protection
 
      
       
     
 
     
 
     [bookmark: pgfId-4860882]Note These options are not supported when configuring the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3719708]The fast pattern matcher quickly determines which rules to evaluate before passing a packet to the rules engine. This initial determination improves performance by significantly reducing the number of rules used in packet evaluation.
 
     [bookmark: pgfId-3719709]By default, the fast pattern matcher searches packets for the longest content specified in a rule; this is to eliminate as much as possible needless evaluation of a rule. Consider the following example rule fragment:
 
      
      [bookmark: pgfId-3719710]alert tcp any any -> any 80 (msg:"Exploit"; content:"GET";
http_method; nocase; content:"/exploit.cgi"; http_uri;
nocase;) 
     
 
     [bookmark: pgfId-3719711]Almost all HTTP client requests contain the content GET, but few will contain the content /exploit.cgi. Using GET as the fast pattern content would cause the rules engine to evaluate this rule in most cases and would rarely result in a match. However, most client GET requests would not be evaluated using /exploit.cgi, thus increasing performance.
 
     [bookmark: pgfId-3719712]The rules engine evaluates the packet against the rule only when the fast pattern matcher detects the specified content. For example, if one content keyword in a rule specifies the content short, another specifies longer, and a third specifies longest, the fast pattern matcher will use the content longest and the rule will be evaluated only if the rules engine finds longest in the payload.
 
     [bookmark: pgfId-3719713]You can use the Use Fast Pattern Matcher option to specify a shorter search pattern for the fast pattern matcher to use. Ideally, the pattern you specify is less likely to be found in the packet than the longest pattern and, therefore, more specifically identifies the targeted exploit.
 
     [bookmark: pgfId-3719714]Note the following restrictions when selecting Use Fast Pattern Matcher and other options in the same content keyword:
 
      
      	 [bookmark: pgfId-3719715]You can specify  Use Fast Pattern Matcher only one time per rule.
 
      	 [bookmark: pgfId-3719716]You cannot use  Distance ,  Within ,  Offset , or  Depth when you select  Use Fast Pattern Matcher in combination with  Not .
 
      	 [bookmark: pgfId-4226991]You cannot select Use Fast Pattern Matcher in combination with any of the following HTTP field options:
 
     
 
     [bookmark: pgfId-4226992]HTTP Raw URI, HTTP Raw Header, HTTP Raw Cookie, HTTP Cookie, HTTP Method, HTTP Status Message, or HTTP Status Code
 
     [bookmark: pgfId-4227006]However, you can include the options above in a content keyword that also uses the fast pattern matcher to search one of the following normalized fields:
 
     [bookmark: pgfId-4227007]HTTP URI, HTTP Header, or HTTP Client Body
 
     [bookmark: pgfId-4227008]For example, if you select HTTP Cookie, HTTP Header, and Use Fast Pattern Matcher, the rules engine searches for content in both the HTTP cookie and the HTTP header, but the fast pattern matcher is applied only to the HTTP header, not to the HTTP cookie.
 
     [bookmark: pgfId-4226773]Note that you cannot use a raw HTTP field option (HTTP Raw URI, HTTP Raw Header, or HTTP Raw Cookie) together in the same content keyword with its normalized counterpart (HTTP URI, HTTP Header, or HTTP Cookie, respectively). See HTTP Content Options for more information.
 
     [bookmark: pgfId-3719725]When you combine restricted and unrestricted options, the fast pattern matcher searches only the unrestricted fields you specify to test whether to pass the packet to the rules engine for complete evaluation, including evaluation of the restricted fields.
 
      
      	 [bookmark: pgfId-3719726]Optionally, when you select  Use Fast Pattern Matcher you can also select  Fast Pattern Matcher Only or  Fast Pattern Matcher Offset and Length , but not both.
 
      	 [bookmark: pgfId-4080082]You cannot use the fast pattern matcher when inspecting Base64 data; see Decoding and Inspecting Base64 Data for more information.
 
     
 
     [bookmark: pgfId-3719727]Using the Fast Pattern Matcher Only
 
     [bookmark: pgfId-3719728]The Fast Pattern Matcher Only option allows you to use the content keyword only as a fast pattern matcher option and not as a rule option. You can use this option to conserve resources when rules engine evaluation of the specified content is not necessary. For example, consider a case where a rule requires only that the content 12345 be anywhere in the payload. When the fast pattern matcher detects the pattern, the packet can be evaluated against additional keywords in the rule. There is no need for the rules engine to reevaluate the packet to determine if it includes the pattern 12345.
 
     [bookmark: pgfId-3719729]You would not use this option when the rule contains other conditions relative to the specified content. For example, you would not use this option to search for the content 1234 if another rule condition sought to determine if abcd occurs before 1234. In this case, the rules engine could not determine the relative location because specifying Fast Pattern Matcher Only instructs the rules engine not to search for the specified content.
 
     [bookmark: pgfId-3719730]Note the following conditions when using this option:
 
      
      	 [bookmark: pgfId-4789892]The specified content is location-independent; that is, it may occur anywhere in the payload; thus, you cannot use positional options ( Distance ,  Within ,  Offset ,  Depth , or  Fast Pattern Matcher Offset and Length ).
 
      	 [bookmark: pgfId-3719732]You cannot use this option in combination with  Not .
 
      	 [bookmark: pgfId-3719733]You cannot use this option in combination with  Fast Pattern Matcher Offset and Length .
 
      	 [bookmark: pgfId-3719734]The specified content will be treated as case-insensitive, because all patterns are inserted into the fast pattern matcher in a case-insensitive manner; this is handled automatically, so it is not necessary to select  Case Insensitive when you select this option.
 
      	 [bookmark: pgfId-4509552]You should not immediately follow a  content keyword that uses the  Fast Pattern Matcher Only  option with the following keywords, which set the search location relative to the current search location:
 
       
       	 [bookmark: pgfId-4510098] isdataat 
 
       	 [bookmark: pgfId-4510099] pcre 
 
       	 [bookmark: pgfId-4510100] content when  Distance or  Within is selected
 
       	 [bookmark: pgfId-4510010] content when  HTTP URI is selected
 
       	 [bookmark: pgfId-4510020] asn1 
 
       	 [bookmark: pgfId-4510026] byte_jump 
 
       	 [bookmark: pgfId-4510037] byte_test 
 
       	 [bookmark: pgfId-4510048] byte_extract 
 
       	 [bookmark: pgfId-4510062] base64_decode 
 
      
 
     
 
     [bookmark: pgfId-3719736][bookmark: 92798]Specifying Fast Pattern Matcher Offset and Length
 
     [bookmark: pgfId-3719737]The Fast Pattern Matcher Offset and Length option allows you to specify a portion of the content to search. This can reduce memory consumption in cases where the pattern is very long and only a portion of the pattern is sufficient to identify the rule as a likely match. When a rule is selected by the fast pattern matcher, the entire pattern is evaluated against the rule. 
 
     [bookmark: pgfId-3719738]You determine the portion for the fast pattern matcher to use by specifying in bytes where to begin the search (offset) and how far into the content (length) to search, using the syntax:
 
      
      [bookmark: pgfId-3719739]offset,length 
     
 
     [bookmark: pgfId-3719740]For example, for the content:
 
      
      [bookmark: pgfId-3719741]1234567 
     
 
     [bookmark: pgfId-3719742]if you specify the number of offset and length bytes as:
 
      
      [bookmark: pgfId-3719743]1,5 
     
 
     [bookmark: pgfId-3719744]the fast pattern matcher searches only for the content 23456.
 
     [bookmark: pgfId-3719745]Note that you cannot use this option together with Fast Pattern Matcher Only.
 
     [bookmark: pgfId-3719746]To specify the content searched for by the fast pattern matcher:
 
     
 
     [bookmark: pgfId-3719748]Step 1 Select Use Fast Pattern Matcher for the content keyword you are adding.
 
     [bookmark: pgfId-3719749]Step 2 Optionally, select Fast Pattern Matcher Only to determine without rules engine evaluation if the specified pattern exists in the packet. 
 
     [bookmark: pgfId-3719750]Evaluation proceeds only if the fast pattern matcher detects the specified content.
 
     [bookmark: pgfId-3719751]Step 3 Optionally, specify in Fast Pattern Matcher Offset and Length a portion of the pattern to search for the content using the syntax:
 
      
      [bookmark: pgfId-3719752]offset,length 
     
 
     [bookmark: pgfId-3719753]where offset specifies how many bytes from the beginning of the content to begin the search, and length specifies the number of bytes to continue.
 
     [bookmark: pgfId-3719757]Step 4 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Using PCRE, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774682]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4002833][bookmark: 27147]Replac[bookmark: marker-4002832]ing Content in Inline Deployments
 
     [bookmark: pgfId-4238138]License: Protection
 
     [bookmark: pgfId-4239444]You can use the replace keyword in an inline deployment to replace specified content.
 
     [bookmark: pgfId-4002842]To use the replace keyword, construct a custom standard text rule that uses the content keyword to look for a specific string. Then use the replace keyword to specify a string to replace the content. The replace value and content value must be the same length.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860890]Note You cannot use the replace keyword to replace hashed content in a protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4002843]Optionally, you can enclose the replacement string in quotation marks for backward compatibility with previous ASA FirePOWER module software versions. If you do not include quotation marks, they are added to the rule automatically so the rule is syntactically correct. To include a leading or trailing quotation mark as part of the replacement text, you must use a backslash to escape it, as shown in the following example:
 
      
      [bookmark: pgfId-4002847]"replacement text plus \"quotation\" marks"" 
     
 
     [bookmark: pgfId-4002848]A rule can contain multiple replace keywords, but only one per content keyword. Only the first instance of the content found by the rule is replaced.
 
     [bookmark: pgfId-4002849]The following explain example uses of the replace keyword:
 
      
      	 [bookmark: pgfId-4002853]If the system detects an incoming packet that contains an exploit, you can replace the malicious string with a harmless one. Sometimes this technique is more successful than simply dropping the offending packet. In some attack scenarios, the attacker simply resends the dropped packet until it bypasses your network defenses or floods your network. By substituting one string for another rather than dropping the packet, you may trick the attacker into believing that the attack was launched against a target that was not vulnerable.
 
      	 [bookmark: pgfId-4002854]If you are concerned about reconnaissance attacks that try to learn whether you are running a vulnerable version of, for example, a web server, then you can detect the outgoing packet and replace the banner with your own text.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4002855]Note Make sure that you set the rule state to Generate Events in the inline intrusion policy where you want to use the replace rule; setting the rule to Drop and Generate events would cause the packet to drop, which would prevent replacing the content.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4002859]As part of the string replacement process, the system automatically updates the packet checksums so that the destination host can receive the packet without error.
 
     [bookmark: pgfId-4002860]Note that you cannot use the replace keyword in combination with HTTP request message content keyword options. See Searching for Content Matches and HTTP Content Options for more information.
 
     [bookmark: pgfId-4002867]To replace content in an inline deployment:
 
     
 
     [bookmark: pgfId-4002869]Step 1 On the Create Rule page, select content in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4002870]The content keyword appears.
 
     [bookmark: pgfId-4002876]Step 2 Specify the content you want to detect in the content field and, optionally, select any applicable arguments. Note that you cannot use the HTTP request message content keyword options with the replace keyword.
 
     [bookmark: pgfId-4002877]Step 3 Select replace in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4002878]The replace keyword appears beneath the content keyword.
 
     [bookmark: pgfId-4002883]Step 4 Specify the replacement string for the specified content in the replace: field.
 
     [bookmark: pgfId-4775542]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3975331][bookmark: 92371]Using Byte_Jump and Byte_Test
 
     [bookmark: pgfId-4238151]License: Protection
 
     [bookmark: pgfId-1231501]You can use byte_jump and byte_test to calculate where in a packet the rules engine should begin testing for a data match, and which bytes it should evaluate.
 
     [bookmark: pgfId-3300270]You can also use the byte_jump and byte_test DCE/RPC argument to tailor either keyword for traffic processed by the DCE/RPC preprocessor. When you use the DCE/RPC argument, you can also use byte_jump and byte_test in conjunction with other specific DCE/RPC keywords. See Decoding DCE/RPC Traffic and DCE/RPC Keywords for more information.
 
     [bookmark: pgfId-1231999]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1232004]byte_jump
 
      	 [bookmark: pgfId-4963720]byte_test
 
     
 
    
 
     
      [bookmark: pgfId-4963722][bookmark: marker-4963736]byte_jump[bookmark: 19434] 
 
     [bookmark: pgfId-4963729]License: Protection
 
     [bookmark: pgfId-1691314]The byte_jump keyword calculates the number of bytes defined in a specified byte segment, and then skips that number of bytes within the packet, either forward from the end of the specified byte segment, or from the beginning of the packet payload, depending on the options you specify. This is useful in packets where a specific segment of bytes describe the number of bytes included in variable data within the packet.
 
      
       
        
        [bookmark: pgfId-1487082]Table 24-8 [bookmark: 43924]Required byte_jump Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1487086]Argument 
          
  
         	 
           
           [bookmark: pgfId-1487088]Description 
          
  
        
 
         
         	[bookmark: pgfId-1487090]Bytes
  
         	[bookmark: pgfId-1487092]The number of bytes to calculate from the packet.
  
        
 
         
         	[bookmark: pgfId-1487094]Offset
  
         	[bookmark: pgfId-4003660]The number of bytes into the payload to start processing. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to jump forward from the beginning of the packet payload or the last successful content match. 
 [bookmark: pgfId-3925717]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-4390439]Table 24-9 [bookmark: 91568]Additional Optional byte_jump Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4390443]Argument 
          
  
         	 
           
           [bookmark: pgfId-4390445]Description 
          
  
        
 
         
         	[bookmark: pgfId-4390447]Relative
  
         	[bookmark: pgfId-4390449]Makes the offset relative to the last pattern found in the last successful content match.
  
        
 
         
         	[bookmark: pgfId-4390451]Align
  
         	[bookmark: pgfId-4390453]Rounds the number of converted bytes up to the next 32-bit boundary.
  
        
 
         
         	[bookmark: pgfId-4390455]Multiplier
  
         	[bookmark: pgfId-4390457]Indicates the value by which the rules engine should multiply the byte_jump value obtained from the packet to get the final byte_jump value.
 [bookmark: pgfId-4390458]That is, instead of skipping the number of bytes defined in a specified byte segment, the rules engine skips that number of bytes multiplied by an integer you specify with the Multiplier argument.
  
        
 
         
         	[bookmark: pgfId-4390460]Post Jump Offset
  
         	[bookmark: pgfId-4390462]The number of bytes -63535 through 63535 to skip forward or backward after applying other byte_jump arguments. A positive value skips forward and a negative value skips backward. Leave the field blank or enter 0 to disable.
 [bookmark: pgfId-4390465]See the DCE/RPC argument in the Endianness Arguments table for byte_jump arguments that do not apply when you select the DCE/RPC argument.
  
        
 
         
         	[bookmark: pgfId-4390468]From Beginning
  
         	[bookmark: pgfId-4390470]Indicates that the rules engine should skip the specified number of bytes in the payload starting from the beginning of the packet payload, rather than from the end of the byte segment that specifies the number of bytes to skip.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4390472]You can specify only one of DCE/RPC, Endian, or Number Type.
 
      
       
        
        [bookmark: pgfId-1447558]Table 24-10 [bookmark: 96362]Endianness Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231536]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231538]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231540]Big Endian
  
         	[bookmark: pgfId-1231542]Processes data in big endian byte order, which is the default network byte order.
  
        
 
         
         	[bookmark: pgfId-1231544]Little Endian
  
         	[bookmark: pgfId-1231546]Processes data in little endian byte order.
  
        
 
         
         	[bookmark: pgfId-3300357]DCE/RPC
  
         	[bookmark: pgfId-3300359]Specifies a byte_jump keyword for traffic processed by the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 [bookmark: pgfId-3300363]The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type, Endian, and From Beginning arguments do not apply.
 [bookmark: pgfId-3300364]When you enable this argument, you can also use byte_jump in conjunction with other specific DCE/RPC keywords. See DCE/RPC Keywords for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231548]Define how the system views string data in a packet by using one of the arguments in the following table.
 
     [bookmark: pgfId-1231570]
 
      
       
        
        [bookmark: pgfId-1447562]Table 24-11 [bookmark: 13353]Number Type Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231551]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231553]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231559]Hexadecimal String
  
         	[bookmark: pgfId-1231561]Represents converted string data in hexadecimal format.
  
        
 
         
         	[bookmark: pgfId-1231563]Decimal String
  
         	[bookmark: pgfId-1231565]Represents converted string data in decimal format.
  
        
 
         
         	[bookmark: pgfId-1231567]Octal String
  
         	[bookmark: pgfId-1231569]Represents converted string data in octal format.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231579]For example, if the values you set for byte_jump are as follows:
 
      
      	 [bookmark: pgfId-1231580]Bytes = 4
 
      	 [bookmark: pgfId-1557505]Offset = 12 
 
      	 [bookmark: pgfId-1557508]Relative enabled
 
      	 [bookmark: pgfId-1557509]Align enabled
 
     
 
     [bookmark: pgfId-1684345]the rules engine calculates the number described in the four bytes that appear 13 bytes after the last successful content match, and skips ahead that number of bytes in the packet. For instance, if the four calculated bytes in a specific packet were 00 00 00 1F, the rules engine would convert this to 31. Because align is specified (which instructs the engine to move to the next 32-bit boundary), the rules engine skips ahead 32 bytes in the packet.
 
     [bookmark: pgfId-1706660]Alternately, if the values you set for byte_jump are as follows:
 
      
      	 [bookmark: pgfId-1706661]Bytes = 4
 
      	 [bookmark: pgfId-1706662]Offset = 12 
 
      	 [bookmark: pgfId-1706663]From Beginning enabled
 
      	 [bookmark: pgfId-1706664]Multiplier = 2
 
     
 
     [bookmark: pgfId-1706665]the rules engine calculates the number described in the four bytes that appear 13 bytes after the beginning of the packet. Then, the engine multiplies that number by two to obtain the total number of bytes to skip. For instance, if the four calculated bytes in a specific packet were 00 00 00 1F, the rules engine would convert this to 31, then multiply it by two to get 62. Because From Beginning is enabled, the rules engine skips the first 63 bytes in the packet.
 
     [bookmark: pgfId-3890173]To use byte_jump:
 
     
 
     [bookmark: pgfId-3890175]Step 1 Select byte_jump in the drop-down list and click Add Option. 
 
     [bookmark: pgfId-3965071]The byte_jump section appears beneath the last keyword you selected.
 
     [bookmark: pgfId-4775593]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1231624]  [bookmark: marker-1231622][bookmark: 73840]byte_test 
 
     [bookmark: pgfId-4238222]License: Protection
 
     [bookmark: pgfId-3567911]The byte_test keyword calculates the number of bytes in a specified byte segment and compares them, according to the operator and value you specify.
 
      
       
        
        [bookmark: pgfId-1447566]Table 24-12 [bookmark: 81640]Required byte_test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231629]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231631]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231633]Bytes
  
         	[bookmark: pgfId-1231635]The number of bytes to calculate from the packet. You can specify 1 to 10 bytes.
  
        
 
         
         	[bookmark: pgfId-1231637]Operator and Value
  
         	[bookmark: pgfId-1231639]Compares the specified value to <, >, =, !, &, ^, !>, !<, !=, !&, or !^. 
 [bookmark: pgfId-4003634]For example, if you specify !1024, byte_test would convert the specified number, and if it did not equal 1024, it would generate an event (if all other keyword parameters matched).
 [bookmark: pgfId-1506186]Note that ! and != are equivalent.
 [bookmark: pgfId-4046872]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
         
         	[bookmark: pgfId-1231641]Offset
  
         	[bookmark: pgfId-4003643]The number of bytes into the payload to start processing. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to count forward from the beginning of the packet payload or the last successful content match. 
 [bookmark: pgfId-1231643]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231645]You can further define how the system uses byte_test arguments with the arguments described in the following table.
 
     [bookmark: pgfId-1231659]
 
      
       
        
        [bookmark: pgfId-1447570]Table 24-13 Additional Optional [bookmark: 21162]byte_test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231648]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231650]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231652]Relative
  
         	[bookmark: pgfId-1231654]Makes the offset relative to the last successful pattern match.
  
        
 
         
         	[bookmark: pgfId-1231656]Align
  
         	[bookmark: pgfId-1231658]Rounds the number of converted bytes up to the next 32-bit boundary.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4227361]You can specify only one of DCE/RPC, Endian, or Number Type.
 
      
       
        
        [bookmark: pgfId-1447574]Table 24-14 Endianness [bookmark: 54171]byte_test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231663]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231665]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231667]Big Endian
  
         	[bookmark: pgfId-1231669]Processes data in big endian byte order, which is the default network byte order.
  
        
 
         
         	[bookmark: pgfId-1231671]Little Endian
  
         	[bookmark: pgfId-1231673]Processes data in little endian byte order.
  
        
 
         
         	[bookmark: pgfId-3300665]DCE/RPC
  
         	[bookmark: pgfId-3300667]Specifies a byte_test keyword for traffic processed by the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 [bookmark: pgfId-3300671]The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian argument do not apply.
 [bookmark: pgfId-3300672]When you enable this argument, you can also use byte_test in conjunction with other specific DCE/RPC keywords. See DCE/RPC Keywords for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231675]You can define how the system views string data in a packet by using one of the arguments in the following table.
 
     [bookmark: pgfId-1231697]
 
      
       
        
        [bookmark: pgfId-1447610]Table 24-15 Number Type [bookmark: 19283]byte-test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231678]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231680]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231686]Hexadecimal String
  
         	[bookmark: pgfId-1231688]Represents converted string data in hexadecimal format.
  
        
 
         
         	[bookmark: pgfId-1231690]Decimal String
  
         	[bookmark: pgfId-1231692]Represents converted string data in decimal format.
  
        
 
         
         	[bookmark: pgfId-1231694]Octal String
  
         	[bookmark: pgfId-1231696]Represents converted string data in octal format.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231708]For example, if the value for byte_test is specified as the following:
 
      
      	 [bookmark: pgfId-1557893]Bytes = 4
 
      	 [bookmark: pgfId-1557935]Operator and Value > 128
 
      	 [bookmark: pgfId-1557936]Offset = 8
 
      	 [bookmark: pgfId-1557939]Relative enabled
 
     
 
     [bookmark: pgfId-1231710]the rules engine calculates the number described in the four bytes that appear 9 bytes away from (relative to) the last successful content match, and, if the calculated number is larger than 128 bytes, the rule is triggered. 
 
     [bookmark: pgfId-3889789]To use byte_test:
 
     
 
     [bookmark: pgfId-3889791]Step 1 On the Create Rule page, select byte_test in the drop-down list and click Add Option.
 
     [bookmark: pgfId-3965110]The byte_test section appears beneath the last keyword you selected.
 
     [bookmark: pgfId-4775666]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2925147][bookmark: 11765]Searching for Content Us[bookmark: marker-3099234]ing PCRE[bookmark: marker-2925144][bookmark: marker-2925145][bookmark: marker-2925146]
 
     [bookmark: pgfId-4238241]License: Protection
 
     [bookmark: pgfId-1219458]The pcre keyword allows you to use Perl-compatible regular expressions (PCRE) to inspect packet payloads for specified content. You can use PCRE to avoid writing multiple rules to match slight variations of the same content. 
 
     [bookmark: pgfId-1219459]Regular expressions are useful when searching for content that could be displayed in a variety of ways. The content may have different attributes that you want to account for in your attempt to locate it within a packet’s payload.
 
     [bookmark: pgfId-2019046]Note that the regular expression syntax used in intrusion rules is a subset of the full regular expression library and varies in some ways from the syntax used in commands in the full library. When adding a pcre keyword using the rule editor, enter the full value in the following format:
 
      
      [bookmark: pgfId-3719777]!/pcre/ ismxAEGRBUIPHDMCKSY 
     
 
     [bookmark: pgfId-1219462]where:
 
      
      	 [bookmark: pgfId-1219463]! is an optional negation (use this if you want to match patterns that  do not match the regular expression).
 
      	 [bookmark: pgfId-1219464] /  pcre  / is a Perl-compatible regular expression.
 
      	 [bookmark: pgfId-3719788] ismxAEGRBUIPHDMCKSY is any combination of modifier options.
 
     
 
      
       
        
        [bookmark: pgfId-2055590]Table 24-16 Escaped PCRE Characters 
 
        
        
         
         	 
           
           [bookmark: pgfId-2055596]You must escape... 
          
  
         	 
           
           [bookmark: pgfId-2055598]with a backslash... 
          
  
         	 
           
           [bookmark: pgfId-2055600]or Hex code... 
          
  
        
 
         
         	[bookmark: pgfId-2055602]# (hash mark)
  
         	[bookmark: pgfId-2055604]\#
  
         	[bookmark: pgfId-2055606]\x23
  
        
 
         
         	[bookmark: pgfId-2055608]; (semicolon)
  
         	[bookmark: pgfId-2055610]\;
  
         	[bookmark: pgfId-2055612]\x3B
  
        
 
         
         	[bookmark: pgfId-2055614]| (vertical bar)
  
         	[bookmark: pgfId-2055616]\|
  
         	[bookmark: pgfId-2055618]\x7C
  
        
 
         
         	[bookmark: pgfId-2055620]: (colon)
  
         	[bookmark: pgfId-2055622]\:
  
         	[bookmark: pgfId-2055624]\x3A
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2218571]Tip Optionally, you can surround your Perl-compatible regular expression with quote characters, for example, pcre_expression or “pcre_expression“.The option of using quotes accommodates experienced users accustomed to previous versions when quotes were required instead of optional. The rule editor does not display quotation marks when you display a rule after saving it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3719802]You can also use m?regex?, where ? is a delimiter other than /. You may want to use this in situations where you need to match a forward slash within a regular expression and do not want to escape it with a backslash. For example, you might use m?regex? ismxAEGRBUIPHDMCKSY where regex is your Perl-compatible regular expression and ismxAEGRBUIPHDMCKSY is any combination of modifier options. See Perl-Compatible Regular Expression Basics for more information about regular expression syntax.
 
     [bookmark: pgfId-1219471]The following sections provide more information about building valid values for the pcre keyword:
 
      
      	 [bookmark: pgfId-1219475]Perl-Compatible Regular Expression Basics describes the common syntax used in Perl-compatible regular expressions.
 
      	 [bookmark: pgfId-1219479]PCRE Modifier Options describes the options you can use to modify your regular expression.
 
      	 [bookmark: pgfId-1219483]Example PCRE Keyword Values gives example usage of the  pcre keyword in rules.
 
     
 
    
 
     
      [bookmark: pgfId-1219533][bookmark: 75645]Perl-Compatible Regular Exp[bookmark: marker-2606539]ression Basics
 
     [bookmark: pgfId-4238260]License: Protection
 
     [bookmark: pgfId-1219534]The pcre keyword accepts standard Perl-compatible regular expression (PCRE) syntax. The following sections describe that syntax.
 
      
       
     
 
     
 
     [bookmark: pgfId-1219535]Tip While this section describes the basic syntax you may use for PCRE, you may want to consult an online reference or book dedicated to Perl and PCRE for more advanced information. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1219537][bookmark: 34628]Metachar[bookmark: marker-3099233]acters
 
     [bookmark: pgfId-4238273]License: Protection
 
     [bookmark: pgfId-1219538]Metacharacters are literal characters that have special meaning within regular expressions. When you use them within a regular expression, you must “escape” them by preceding them with a backslash. 
 
      
       
        
        [bookmark: pgfId-1447508]Table 24-17 [bookmark: 16746]PCRE Metacharacters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1219541]Metacharacter 
          
  
         	 
           
           [bookmark: pgfId-1219543]Description 
          
  
         	 
           
           [bookmark: pgfId-1219545]Example 
          
  
        
 
         
         	[bookmark: pgfId-1219547].
  
         	[bookmark: pgfId-1219549]Matches any character except newlines. If s is used as a modifying option, it also includes newline characters. 
  
         	[bookmark: pgfId-1219551]abc. matches abcd, abc1, abc#, and so on.
  
        
 
         
         	[bookmark: pgfId-1219553]*
  
         	[bookmark: pgfId-1219555]Matches zero or more occurrences of a character or expression.
  
         	[bookmark: pgfId-1219557]abc* matches abc, abcc, abccc, abccccc, and so on.
  
        
 
         
         	[bookmark: pgfId-1219559]?
  
         	[bookmark: pgfId-1219561]Matches zero or one occurrence of a character or expression.
  
         	[bookmark: pgfId-1219563]abc? matches abc.
  
        
 
         
         	[bookmark: pgfId-1219565]+
  
         	[bookmark: pgfId-1219567]Matches one or more occurrences of a character or expression.
  
         	[bookmark: pgfId-1219569]abc+ matches abc, abcc, abccc, abccccc, and so on.
  
        
 
         
         	[bookmark: pgfId-1219571]()
  
         	[bookmark: pgfId-1219573]Groups expressions.
  
         	[bookmark: pgfId-1219575](abc)+ matches abc, abcabc, abcabcabc and so on.
  
        
 
         
         	[bookmark: pgfId-1219577]{}
  
         	[bookmark: pgfId-1219579]Specifies a limit for the number of matches for a character or expression. If you want to set a lower and upper limit, separate the lower limit and upper limit with a comma. 
  
         	[bookmark: pgfId-1219581]a{4,6} matches aaaa, aaaaa, or aaaaaa.
 [bookmark: pgfId-1219582](ab){2} matches abab.
  
        
 
         
         	[bookmark: pgfId-1219584][]
  
         	[bookmark: pgfId-1219586]Allows you to define character classes, and matches any character or combination of characters described in the set. 
  
         	[bookmark: pgfId-1219588][abc123] matches a or b or c, and so on.
  
        
 
         
         	[bookmark: pgfId-1219590]^
  
         	[bookmark: pgfId-1219592]Matches content at the beginning of a string. Also used for negation, if used within a character class.
  
         	[bookmark: pgfId-1219594]^in matches the “in” in info, but not in bin. [^a] matches anything that does not contain a.
  
        
 
         
         	[bookmark: pgfId-1219596]$
  
         	[bookmark: pgfId-1219598]Matches content at the end of a string.
  
         	[bookmark: pgfId-1219600]ce$ matches the “ce” in announce, but not cent.
  
        
 
         
         	[bookmark: pgfId-1219602]|
  
         	[bookmark: pgfId-1219604]Indicates an OR expression.
  
         	[bookmark: pgfId-1219606](MAILTO|HELP) matches MAILTO or HELP.
  
        
 
         
         	[bookmark: pgfId-1219608]\
  
         	[bookmark: pgfId-1219610]Allows you to use metacharacters as actual characters and is also used to specify a predefined character class.
  
         	[bookmark: pgfId-1219612]\. matches a period, \* matches an asterisk, \\ matches a backslash and so on. \d matches the numeric characters, \w matches alphanumeric characters, and so on. See Character Classes for more information about using character classes in PCRE.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1219615][bookmark: 49976]Character Cla[bookmark: marker-3099245]sses
 
     [bookmark: pgfId-4238286]License: Protection
 
     [bookmark: pgfId-1219616]Character classes include alphabetic characters, numeric characters, alphanumeric characters, and white space characters. While you can create your own character classes within brackets (see Metacharacters), you can use the predefined classes as shortcuts for different types of character types. When used without additional qualifiers, a character class matches a single digit or character.
 
      
       
        
        [bookmark: pgfId-2420219]Table 24-18 [bookmark: 90902]PCRE Character Classes 
 
        
        
         
         	 
           
           [bookmark: pgfId-2420225]Character Class 
          
  
         	 
           
           [bookmark: pgfId-2420227]Description 
          
  
         	 
           
           [bookmark: pgfId-2420229]Character Class Definition 
          
  
        
 
         
         	[bookmark: pgfId-2420231]\d
  
         	[bookmark: pgfId-2420233]Matches a numeric character (“digit”).
  
         	[bookmark: pgfId-2420235][0-9]
  
        
 
         
         	[bookmark: pgfId-2420237]\D
  
         	[bookmark: pgfId-2420239]Matches anything that is not an numeric character.
  
         	[bookmark: pgfId-2420241][^0-9]
  
        
 
         
         	[bookmark: pgfId-2420243]\w
  
         	[bookmark: pgfId-2420245]Matches an alphanumeric character (“word”).
  
         	[bookmark: pgfId-2420247][a-zA-Z0-9_]
  
        
 
         
         	[bookmark: pgfId-2420249]\W
  
         	[bookmark: pgfId-2420251]Matches anything that is not an alphanumeric character.
  
         	[bookmark: pgfId-2420253][^a-zA-Z0-9_]
  
        
 
         
         	[bookmark: pgfId-2420255]\s
  
         	[bookmark: pgfId-2420257]Matches white space characters, including spaces, carriage returns, tabs, newlines, and form feeds.
  
         	[bookmark: pgfId-2420259][ \r\t\n\f]
  
        
 
         
         	[bookmark: pgfId-2420261]\S
  
         	[bookmark: pgfId-2420263]Matches anything that is not a white space character.
  
         	[bookmark: pgfId-2420265][^ \r\t\n\f]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1219677][bookmark: 84818]PCRE Mod[bookmark: marker-3099246]ifier Opti[bookmark: marker-2606540]ons
 
     [bookmark: pgfId-4238299]License: Protection
 
     [bookmark: pgfId-1219678]You can use modifying options after you specify regular expression syntax in the pcre keyword’s value. These modifiers perform Perl, PCRE, and Snort-specific processing functions. Modifiers always appear at the end of the PCRE value, and appear in the following format:
 
      
      [bookmark: pgfId-3719816]/pcre/ismxAEGRBUIPHDMCKSY 
     
 
     [bookmark: pgfId-1219680]where ismxAEGRBUPHMC can include any of the modifying options that appear in the following tables.
 
      
       
     
 
     
 
     [bookmark: pgfId-3719827]Tip Optionally, you can surround the regular expression and any modifying options with quotes, for example, “/pcre/ismxAEGRBUIPHDMCKSY”. The option of using quotes accommodates experienced users accustomed to previous versions when quotes were required instead of optional. The rule editor does not display quotation marks when you display a rule after saving it.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1924468]Table 24-19 [bookmark: 46656]Perl-Related Post Regular Expression Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1924472]Option 
          
  
         	 
           
           [bookmark: pgfId-1924474]Description 
          
  
        
 
         
         	[bookmark: pgfId-1924476]i
  
         	[bookmark: pgfId-1924478]Makes the regular expression case-insensitive.
  
        
 
         
         	[bookmark: pgfId-1924480]s
  
         	[bookmark: pgfId-1924482]The dot character (.) describes all characters except the newline or \n character. You can use "s" as an option to override this and have the dot character match all characters, including the newline character.
  
        
 
         
         	[bookmark: pgfId-1924484]m
  
         	[bookmark: pgfId-1924486]By default, a string is treated as a single line of characters, and ^ and $ match the beginning and ending of a specific string. When you use "m" as an option, ^ and $ match content immediately before or after any newline character in the buffer, as well as at the beginning or end of the buffer.
  
        
 
         
         	[bookmark: pgfId-1924488]x
  
         	[bookmark: pgfId-1924490]Ignores white space data characters that may appear within the pattern, except when escaped (preceded by a backslash) or included inside a character class.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1924494]The following table describes the PCRE modifiers you can use after the regular expression.
 
     [bookmark: pgfId-1219723]
 
      
       
        
        [bookmark: pgfId-1447594]Table 24-20 [bookmark: 24447]PCRE-Related Post Regular Expression Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1219708]Option 
          
  
         	 
           
           [bookmark: pgfId-1219710]Description 
          
  
        
 
         
         	[bookmark: pgfId-1219712]A
  
         	[bookmark: pgfId-1219714]The pattern must match at the beginning of the string (same as using ^ in a regular expression).
  
        
 
         
         	[bookmark: pgfId-1219716]E
  
         	[bookmark: pgfId-1219718]Sets $ to match only at the end of the subject string. (Without E, $ also matches immediately before the final character if it is a newline, but not before any other newline characters).
  
        
 
         
         	[bookmark: pgfId-1219720]G
  
         	[bookmark: pgfId-1219722]By default, * + and ? are “greedy,” which means that if two or more matches are found, they will choose the longest match. Use the G character to change this so that these characters always choose the first match unless followed by a question mark character (?). For example, *? +? and ?? would be greedy in a construct using the G modifier, and any incidences of *, +, or ? without the additional question mark will not be greedy.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4224289]The following table describes the Snort-specific modifiers that you can use after the regular expression. 
 
     [bookmark: pgfId-3468842].
 
      
       
        
        [bookmark: pgfId-4756982]Table 24-21 [bookmark: 10200]Snort-Specific Post Regular Expression Modifiers 
 
        
        
         
         	 
           
           [bookmark: pgfId-4756986]Option 
          
  
         	 
           
           [bookmark: pgfId-4756988]Description 
          
  
        
 
         
         	[bookmark: pgfId-4756990]R
  
         	[bookmark: pgfId-4756992]Searches for matching content relative to the end of the last match found by the rules engine.
  
        
 
         
         	[bookmark: pgfId-4756994]B
  
         	[bookmark: pgfId-4756996]Searches for the content within data before it is decoded by a preprocessor (this option is similar to using the Raw Data argument with the content or protected_content keyword).
  
        
 
         
         	[bookmark: pgfId-4756998]U
  
         	[bookmark: pgfId-4757000]Searches for the content within the URI of a normalized HTTP request message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP URI option to search the same content. See HTTP Content Options for more information.
 selected, either with or without an accompanying PCRE expression that uses the U option.
  
        
 
         
         	[bookmark: pgfId-4757006]I
  
         	[bookmark: pgfId-4757008]Searches for the content within the URI of a raw HTTP request message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP Raw URI option to search the same content. See HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757013]P
  
         	[bookmark: pgfId-4757015]Searches for the content within the body of a normalized HTTP request message decoded by the HTTP Inspect preprocessor. See the content and protected_content keyword HTTP Client Body option in HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757020]H
  
         	[bookmark: pgfId-4757022]Searches for the content within the header, excluding cookies, of an HTTP request or response message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP Header option to search the same content. See HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757027]D
  
         	[bookmark: pgfId-4757029]Searches for the content within the header, excluding cookies, of a raw HTTP request or response message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP Raw Header option to search the same content. See HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757034]M
  
         	[bookmark: pgfId-4757036]Searches for the content within the method field of a normalized HTTP request message decoded by the HTTP Inspect preprocessor; the method field identifies the action such as GET, PUT, CONNECT, and so on to take on the resource identified in the URI. See the content and protected_content keyword HTTP Method option in HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757041]C
  
         	[bookmark: pgfId-4757043]When the HTTP Inspect preprocessor Inspect HTTP Cookies option is enabled, searches for the normalized content within any cookie in an HTTP request header, and also within any set-cookie in an HTTP response header when the preprocessor Inspect HTTP Responses option is enabled. When Inspect HTTP Cookies is not enabled, searches the entire header, including the cookie or set-cookie data. 
 [bookmark: pgfId-4757044]Note the following:
 
           
           	 [bookmark: pgfId-4757045]Cookies included in the message body are treated as body content.
 
           	 [bookmark: pgfId-4757046]You cannot use this option in combination with the  content or  protected_content keyword  HTTP Cookie option to search the same content. See HTTP Content Options for more information.
 
           	 [bookmark: pgfId-4757050]The  Cookie: and  Set-Cookie: header names, leading spaces on the header line, and the  CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
          
  
        
 
         
         	[bookmark: pgfId-4757052]K
  
         	[bookmark: pgfId-4757054]When the HTTP Inspect preprocessor Inspect HTTP Cookies option is enabled, searches for the raw content within any cookie in an HTTP request header, and also within any set-cookie in an HTTP response header when the preprocessor Inspect HTTP Responses option is enabled. When Inspect HTTP Cookies is not enabled, searches the entire header, including the cookie or set-cookie data. 
 [bookmark: pgfId-4757055]Note the following:
 
           
           	 [bookmark: pgfId-4757056]Cookies included in the message body are treated as body content. 
 
           	 [bookmark: pgfId-4757057]You cannot use this option in combination with the  content or  protected_content keyword  HTTP Raw Cookie option to search the same content. See HTTP Content Options for more information.
 
           	 [bookmark: pgfId-4757061]The  Cookie: and  Set-Cookie: header names, leading spaces on the header line, and the  CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
          
  
        
 
         
         	[bookmark: pgfId-4757063]S
  
         	[bookmark: pgfId-4757065]Searches the 3-digit status code in an HTTP response. See the content and protected_content keyword HTTP Status Code option in HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757070]Y
  
         	[bookmark: pgfId-4757072]Searches the textual description that accompanies the status code in an HTTP response. See the content and protected_content keyword HTTP Status Message option in HTTP Content Options for more information.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3719843]Note Do not use the U option in combination with the R option. This could cause performance problems. Also, do not use the U option in combination with any other HTTP content option (I, P, H, D, M, C, K, S, or Y).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1219757][bookmark: 18927]Example PCRE Keyword V[bookmark: marker-2606541]alues
 
     [bookmark: pgfId-4238320]License: Protection
 
     [bookmark: pgfId-2204305]The following examples show values that you could enter for pcre, with descriptions of what each example would match.
 
      
      	 [bookmark: pgfId-2204306] /feedback[(\d{0,1})]?\.cgi/U 
 
     
 
     [bookmark: pgfId-1219760]This example searches packet payload for feedback, followed by zero or one numeric character, followed by .cgi, and located only in URI data.
 
     [bookmark: pgfId-1219761]This example would match:
 
      
       
       	 [bookmark: pgfId-1219762] feedback.cgi  
 
       	 [bookmark: pgfId-1219763] feedback1.cgi 
 
       	 [bookmark: pgfId-1219764] feedback2.cgi  
 
       	 [bookmark: pgfId-1219765] feedback3.cgi 
 
      
 
     
 
     [bookmark: pgfId-1219766]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219767] feedbacka.cgi 
 
       	 [bookmark: pgfId-1219768] feedback11.cgi 
 
       	 [bookmark: pgfId-1219769] feedback21.cgi 
 
       	 [bookmark: pgfId-1219770] feedbackzb.cgi 
 
      
 
      	 [bookmark: pgfId-1219771] /^ez(\w{3,5})\.cgi/iU 
 
     
 
     [bookmark: pgfId-1219772]This example searches packet payload for ez at the beginning of a string, followed by a word of 3 to 5 letters, followed by .cgi. The search is case-insensitive and only searches URI data.
 
     [bookmark: pgfId-1219773]This example would match:
 
      
       
       	 [bookmark: pgfId-1219774] EZBoard.cgi 
 
       	 [bookmark: pgfId-1219775] ezman.cgi 
 
       	 [bookmark: pgfId-1219776] ezadmin.cgi 
 
       	 [bookmark: pgfId-1219777] EZAdmin.cgi 
 
      
 
     
 
     [bookmark: pgfId-1219778]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219779] ezez.cgi 
 
       	 [bookmark: pgfId-1219780] fez.cgi 
 
       	 [bookmark: pgfId-1219781] abcezboard.cgi 
 
       	 [bookmark: pgfId-1219782] ezboardman.cgi 
 
      
 
      	 [bookmark: pgfId-1219783] /mail(file|seek)\.cgi/U 
 
     
 
     [bookmark: pgfId-1219784]This example searches packet payload for mail, followed by either file or seek, in URI data.
 
     [bookmark: pgfId-1219785]This example would match:
 
      
       
       	 [bookmark: pgfId-1219786] mailfile.cgi 
 
       	 [bookmark: pgfId-1219787] mailseek.cgi 
 
      
 
     
 
     [bookmark: pgfId-1219788]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219789] MailFile.cgi 
 
       	 [bookmark: pgfId-2204320] mailfilefile.cgi 
 
      
 
      	 [bookmark: pgfId-2204321] m?http\\x3a\x2f\x2f.*(\n|\t)+?U 
 
     
 
     [bookmark: pgfId-2204322]This example searches packet payload for URI content for a tab or newline character in an HTTP request, after any number of characters. This example uses m?regex? to avoid using http\:\/\/ in the expression. Note that the colon is preceded by a backslash.
 
     [bookmark: pgfId-1219793]This example would match:
 
      
       
       	 [bookmark: pgfId-1219794] http://www.example.com?scriptvar=x&othervar=\n\..\.. 
 
       	 [bookmark: pgfId-1219795] http://www.example.com?scriptvar=\t 
 
      
 
     
 
     [bookmark: pgfId-1219796]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219797] ftp://ftp.example.com?scriptvar=&othervar=\n\..\.. 
 
       	 [bookmark: pgfId-1219798] http://www.example.com?scriptvar=|/bin/sh -i| 
 
      
 
      	 [bookmark: pgfId-1219799] m?http\\x3a\x2f\x2f.*=\|.*\|+?sU 
 
     
 
     [bookmark: pgfId-1219800]This example searches packet payload for a URL with any number of characters, including newlines, followed by an equal sign, and pipe characters that contain any number of characters or white space. This example uses m?regex? to avoid using http\:\/\/ in the expression.
 
     [bookmark: pgfId-1219801]This example would match:
 
      
       
       	 [bookmark: pgfId-1219802] http://www.example.com?value=|/bin/sh/ -i| 
 
       	 [bookmark: pgfId-1219803] http://www.example.com?input=|cat /etc/passwd| 
 
      
 
     
 
     [bookmark: pgfId-1219804]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219805] ftp://ftp.example.com?value=|/bin/sh/ -i| 
 
       	 [bookmark: pgfId-1219806] http://www.example.com?value=x&input?|cat /etc/passwd| 
 
      
 
      	 [bookmark: pgfId-2055632] /[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}/i 
 
     
 
     [bookmark: pgfId-2055646]This example searches packet payload for any MAC address. Note that it escapes the colon characters with backslashes.
 
    
 
     
      [bookmark: pgfId-2632531][bookmark: 99850]Adding Metad[bookmark: marker-3099247]ata to a Rule
 
     [bookmark: pgfId-4238333]License: Protection
 
     [bookmark: pgfId-2665479]You can use the [bookmark: marker-2665478]metadata keyword to add descriptive information to a rule. You can use the information you add to organize or identify rules in ways that suit your needs, and to search for rules.
 
     [bookmark: pgfId-4040462]The system validates metadata based on the format:
 
      
      [bookmark: pgfId-4040919]key value 
     
 
     [bookmark: pgfId-4040920]where key and value provide a combined description separated by a space. This is the format used by the Cisco VRT for adding metadata to rules provided by Cisco. 
 
     [bookmark: pgfId-4040973]Alternatively, you can also use the format:
 
      
      [bookmark: pgfId-4040922]key=value 
     
 
     [bookmark: pgfId-4042331]For example, you could use the key value format to identify rules by author and date, using a category and sub-category as follows:
 
      
      [bookmark: pgfId-4042322]author SnortGuru_20050406 
     
 
     [bookmark: pgfId-4042323]You can use multiple metadata keywords in a rule. You can also use commas to separate multiple key value statements in a single metadata keyword, as seen in the following example:
 
      
      [bookmark: pgfId-2683802]author SnortGuru_20050406, revised_by SnortUser1_20050707,
revised_by SnortUser2_20061003, revised_by
SnortUser1_20070123 
     
 
     [bookmark: pgfId-4043663]You are not limited to using a key value or key=value format; however, you should be aware of limitations resulting from validation based on these formats.
 
     [bookmark: pgfId-3708614]Avoiding Restricted Characters
 
     [bookmark: pgfId-4775737]License: Protection
 
     [bookmark: pgfId-4775738]Note the following character restrictions:
 
      
      	 [bookmark: pgfId-4775739]Do not use a semicolon (;) or colon (:) in a  metadata keyword.
 
      	 [bookmark: pgfId-4043715]Be aware when using commas that the system interprets a comma as a separator for multiple  key value or  key  =  value statements. For example:
 
     
 
      
      [bookmark: pgfId-4043886]key value, key value, key value 
     
 
      
      	 [bookmark: pgfId-4042732]Be aware when using the equal to (=) character or space character that the system interprets these characters as separators between  key and  value . For example:
 
     
 
      
      [bookmark: pgfId-4044003]key value 
     
 
      
      [bookmark: pgfId-4044018]key=value 
     
 
     [bookmark: pgfId-4568400]All other characters are permitted.
 
     [bookmark: pgfId-4568401]Adding service Metadata
 
     [bookmark: pgfId-4568402]License: Protection
 
     [bookmark: pgfId-4566805]The rules engine applies active rules with service metadata that match the application protocol information for the host in a packet to analyze and process traffic. If it does not match, the system does not apply the rule to the traffic. If a host does not have application protocol information, or if the rule does not have service metadata, the system checks the port in the traffic against the port in the rule to determine whether to apply the rule to the traffic.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4566815]To match a rule with an identified application protocol, you must define the metadata keyword and a key value statement, with service as the key and an application for the value. For example, the following key value statement in a metadata keyword associates the rule with HTTP traffic:
 
      
      [bookmark: pgfId-4566816]service http 
     
 
     [bookmark: pgfId-4566820]The following table describes the most common application values.
 
      
       
     
 
     
 
     [bookmark: pgfId-4566824]Note Contact Support for assistance in defining applications not in the table. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4568501]
 
      
       
        
        [bookmark: pgfId-4568414]Table 24-22 [bookmark: 20501]service Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-4568418]Value 
          
  
         	 
           
           [bookmark: pgfId-4568420]Description 
          
  
        
 
         
         	[bookmark: pgfId-4568422]dcerpc
  
         	[bookmark: pgfId-4568424]Distributed Computing Environment/Remote Procedure Calls System
  
        
 
         
         	[bookmark: pgfId-4568426]dns
  
         	[bookmark: pgfId-4568428]Domain Name System
  
        
 
         
         	[bookmark: pgfId-4568430]finger
  
         	[bookmark: pgfId-4568432]Finger user information protocol
  
        
 
         
         	[bookmark: pgfId-4568434]ftp
  
         	[bookmark: pgfId-4568436]File Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568438]ftp-data
  
         	[bookmark: pgfId-4568440]File Transfer Protocol (Data Channel)
  
        
 
         
         	[bookmark: pgfId-4568442]http
  
         	[bookmark: pgfId-4568444]Hypertext Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568446]imap
  
         	[bookmark: pgfId-4568448]Internet Message Access Protocol
  
        
 
         
         	[bookmark: pgfId-4568450]isakmp
  
         	[bookmark: pgfId-4568452]Internet Security Association and Key Management Protocol
  
        
 
         
         	[bookmark: pgfId-4568454]netbios-dgm
  
         	[bookmark: pgfId-4568456]NETBIOS Datagram Service
  
        
 
         
         	[bookmark: pgfId-4568458]netbios-ns
  
         	[bookmark: pgfId-4568460]NETBIOS Name Service
  
        
 
         
         	[bookmark: pgfId-4568462]netbios-ssn
  
         	[bookmark: pgfId-4568464]NETBIOS Session Service
  
        
 
         
         	[bookmark: pgfId-4568466]nntp
  
         	[bookmark: pgfId-4568468]Network News Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568470]oracle
  
         	[bookmark: pgfId-4568472]Oracle Net Services
  
        
 
         
         	[bookmark: pgfId-4568474]pop2
  
         	[bookmark: pgfId-4568476]Post Office Protocol, version 2
  
        
 
         
         	[bookmark: pgfId-4568478]pop3
  
         	[bookmark: pgfId-4568480]Post Office Protocol, version 3
  
        
 
         
         	[bookmark: pgfId-4568482]smtp
  
         	[bookmark: pgfId-4568484]Simple Mail Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568486]ssh
  
         	[bookmark: pgfId-4568488]Secure Shell network protocol
  
        
 
         
         	[bookmark: pgfId-4568490]telnet
  
         	[bookmark: pgfId-4568492]Telnet network protocol
  
        
 
         
         	[bookmark: pgfId-4568494]tftp
  
         	[bookmark: pgfId-4568496]Trivial File Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568498]x11
  
         	[bookmark: pgfId-4568500]X Window System
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4568503][bookmark: 18421]Avoiding Reserved Metadata
 
     [bookmark: pgfId-4568507]License: Protection
 
     [bookmark: pgfId-4044201]Avoid using the following words in a metadata keyword, either as a single argument or as the key in a key value statement; these are reserved for use by the VRT:
 
      
      [bookmark: pgfId-2665495]application 
     
 
      
      [bookmark: pgfId-2665496]engine 
     
 
      
      [bookmark: pgfId-4042465]impact_flag 
     
 
      
      [bookmark: pgfId-2665497]os 
     
 
      
      [bookmark: pgfId-4042450]policy 
     
 
      
      [bookmark: pgfId-2665498]rule-type 
     
 
      
      [bookmark: pgfId-4551021]rule-flushing 
     
 
      
      [bookmark: pgfId-4551023]soid 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4570741]Note Contact Support for assistance in adding restricted metadata to local rules that might not otherwise function as expected. See Importing Local Rule Files for more information.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1219153][bookmark: 59115]Inspecting IP[bookmark: marker-2334566] Header Values
 
     [bookmark: pgfId-4238406]License: Protection
 
     [bookmark: pgfId-1058909]You can use keywords to identify possible attacks or security policy violations in the IP headers of packets. See the following sections for more information:
 
      
      	 [bookmark: pgfId-1058910]Inspecting Fragments and Reserved Bits
 
      	 [bookmark: pgfId-1058911]Inspecting the IP Header Identification Value
 
      	 [bookmark: pgfId-1058912]Identifying Specified IP Options
 
      	 [bookmark: pgfId-1058913]Identifying Specified IP Protocol Numbers
 
      	 [bookmark: pgfId-1058914]Inspecting a Packet’s Type of Service
 
      	 [bookmark: pgfId-1058915]Inspecting a Packet’s Time-To-Live Value
 
     
 
    
 
     
      [bookmark: pgfId-1059512][bookmark: 57081]Inspecting Fragments and Reserved Bits
 
     [bookmark: pgfId-4238419]License: Protection
 
     [bookmark: pgfId-1059514]The [bookmark: marker-1059513]fragbits keyword inspects the fragment and reserved bits in the IP header. You can check each packet for the Reserved Bit, the More Fragments bit, and the Don't Fragment bit in any combination. 
 
     [bookmark: pgfId-1059532]
 
      
       
        
        [bookmark: pgfId-1467180]Table 24-23 Fragbits Argument Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-1059517]Argument 
          
  
         	 
           
           [bookmark: pgfId-1059519]Description 
          
  
        
 
         
         	[bookmark: pgfId-1059521]R
  
         	[bookmark: pgfId-1059523]Reserved bit
  
        
 
         
         	[bookmark: pgfId-1059525]M
  
         	[bookmark: pgfId-1059527]More Fragments bit
  
        
 
         
         	[bookmark: pgfId-1059529]D
  
         	[bookmark: pgfId-1059531]Don’t Fragment bit
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1059533]To further refine a rule using the fragbits keyword, you can specify any operator described in the following table after the argument value in the rule. 
 
     [bookmark: pgfId-1467208]
 
      
       
        
        [bookmark: pgfId-1467232]Table 24-24 [bookmark: 98324]Fragbit Operators 
 
        
        
         
         	 
           
           [bookmark: pgfId-1467236]Operator 
          
  
         	 
           
           [bookmark: pgfId-1467238]Description 
          
  
        
 
         
         	[bookmark: pgfId-1467240]plus sign (+)
  
         	[bookmark: pgfId-1467242]The packet must match against all specified bits.
  
        
 
         
         	[bookmark: pgfId-1467244]asterisk (*) 
  
         	[bookmark: pgfId-1467246]The packet can match against any of the specified bits.
  
        
 
         
         	[bookmark: pgfId-1467248]exclamation point (!)
  
         	[bookmark: pgfId-1467347]The packet meets the criteria if none of the specified bits are set.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1467358]For example, to generate an event against packets that have the Reserved Bit set (and possibly any other bits), use R+ as the fragbits value. 
 
    
 
     
      [bookmark: pgfId-1157636][bookmark: 76169]Inspecting the IP Header Identification Value
 
     [bookmark: pgfId-4238432]License: Protection
 
     [bookmark: pgfId-1059565]The [bookmark: marker-1059564]id keyword tests the IP header fragment identification field against the value you specify in the keyword’s argument. Some denial-of-service tools and scanners set this field to a specific number that is easy to detect. For example, in SID 630, which detects a Synscan portscan, the id value is set to 39426, the static value used as the ID number in packets transmitted by the scanner. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1558525]Note id argument values must be numeric.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059594][bookmark: 11702]Identifying Specified IP Options
 
     [bookmark: pgfId-4238445]License: Protection
 
     [bookmark: pgfId-1059596]The [bookmark: marker-1059595]IPopts keyword allows you to search packets for specified IP header options. The following table lists the available argument values.
 
     [bookmark: pgfId-1059634]
 
      
       
        
        [bookmark: pgfId-1447522]Table 24-25 [bookmark: 50271]IPoption Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1059599]Argument 
          
  
         	 
           
           [bookmark: pgfId-1059601]Description 
          
  
        
 
         
         	[bookmark: pgfId-1059603]rr
  
         	[bookmark: pgfId-1059605]record route
  
        
 
         
         	[bookmark: pgfId-1059607]eol
  
         	[bookmark: pgfId-1059609]end of list
  
        
 
         
         	[bookmark: pgfId-1059611]nop
  
         	[bookmark: pgfId-1059613]no operation
  
        
 
         
         	[bookmark: pgfId-1059615]ts
  
         	[bookmark: pgfId-1059617]time stamp
  
        
 
         
         	[bookmark: pgfId-1059619]sec
  
         	[bookmark: pgfId-1059621]IP security option
  
        
 
         
         	[bookmark: pgfId-1059623]lsrr
  
         	[bookmark: pgfId-1059625]loose source routing
  
        
 
         
         	[bookmark: pgfId-1059627]ssrr
  
         	[bookmark: pgfId-1059629]strict source routing
  
        
 
         
         	[bookmark: pgfId-1059631]satid
  
         	[bookmark: pgfId-1059633]stream identifier
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1059635]Analysts most frequently watch for strict and loose source routing because these options may be an indication of a spoofed source IP address.
 
    
 
     
      [bookmark: pgfId-2804378][bookmark: 65505]Identifying Specified IP Protocol Numbers
 
     [bookmark: pgfId-4238458]License: Protection
 
     [bookmark: pgfId-2804380]The [bookmark: marker-2804379]ip_proto keyword allows you to identify packets with the IP protocol specified as the keyword’s value. You can specify the IP protocols as a number, 0 through 255. You can find the complete list of protocol numbers at http://www.iana.org/assignments/protocol-numbers. You can combine these numbers with the following operators: <, >, or !. For example, to inspect traffic with any protocol that is not ICMP, use !1 as a value to the ip_proto keyword. You can also use the ip_proto keyword multiple times in a single rule; note, however, that the rules engine interprets multiple instances of the keyword as having a Boolean AND relationship. For example, if you create a rule containing ip_proto:!3; ip_proto:!6, the rule ignores traffic using the GGP protocol AND the TCP protocol. 
 
    
 
     
      [bookmark: pgfId-1059691][bookmark: 17841]Inspecting a Packet’s Type of Service
 
     [bookmark: pgfId-4238471]License: Protection
 
     [bookmark: pgfId-1059692][bookmark: marker-1161983]Some networks use the type of service (ToS) value to set precedence for packets traveling on that network. The tos keyword allows you to test the packet’s IP header ToS value against the value you specify as the keyword’s argument. Rules using the tos keyword will trigger on packets whose ToS is set to the specified value and that meet the rest of the criteria set forth in the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-2011782]Note Argument values for tos must be numeric.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1152489]The ToS field has been deprecated in the IP header protocol and replaced with the Differentiated Services Code Point (DSCP) field.
 
    
 
     
      [bookmark: pgfId-1078061][bookmark: 98543]Inspecting a Packet’s Time-To-Live Value
 
     [bookmark: pgfId-4238484]License: Protection
 
     [bookmark: pgfId-1078104][bookmark: marker-1161984]A packet’s time-to-live (ttl) value indicates how many hops it can make before it is dropped. You can use the ttl keyword to test the packet’s IP header ttl value against the value, or range of values, you specify as the keyword’s argument. It may be helpful to set the ttl keyword parameter to a low value such as 0 or 1, as low time-to-live values are sometimes indicative of a traceroute or intrusion evasion attempt. (Note, though, that the appropriate value for this keyword depends on your device placement and network topology.) Use syntax as follows:
 
      
      	 [bookmark: pgfId-4110321]Use an integer from 0 to 255 to set a specific value for the TTL value. You can also precede the value with an equal (=) sign (for example, you can specify  5 or  =5 ).
 
      	 [bookmark: pgfId-4110322]Use a hyphen ( - ) to specify a range of TTL values (for example,  0-2  specifies all values 0 through 2,  -5 specifies all values 0 through 5, and  5- specifies all values 5 through 255). 
 
      	 [bookmark: pgfId-4110277]Use the greater than (>) sign to specify TTL values greater than a specific value (for example,  >3 specifies all values greater than 3).
 
      	 [bookmark: pgfId-4110278]Use the greater than and equal to signs (>=) to specify TTL values greater than or equal to a specific value (for example,  >=3 specifies all values greater than or equal to 3). 
 
      	 [bookmark: pgfId-4110281]Use the less than (<) sign to specify TTL values less than a specific value (for example,  <3 specifies all values less than 3). 
 
      	 [bookmark: pgfId-4110282]Use the less than and equal to signs (<=) to specify TTL values less than or equal to a specific value (for example,  <=3 specifies all values less than or equal to 3). 
 
     
 
    
 
     
      [bookmark: pgfId-1078657][bookmark: 12310]Inspecting ICMP[bookmark: marker-2334567] Header Values
 
     [bookmark: pgfId-4238497]License: Protection
 
     [bookmark: pgfId-1161963]The ASA FirePOWER module supports keywords that you can use to identify attacks and security policy violations in the headers of ICMP packets. Note, however, that predefined rules exist that detect most ICMP types and codes. Consider enabling an existing rule or creating a local rule based on an existing rule; you may be able to find a rule that meets your needs more quickly than if you build an ICMP rule from scratch.
 
     [bookmark: pgfId-2019571]See the following sections for more information about ICMP-specific keywords:
 
      
      	 [bookmark: pgfId-1161967]Identifying Static ICMP ID and Sequence Values
 
      	 [bookmark: pgfId-1161971]Inspecting the ICMP Message Type
 
      	 [bookmark: pgfId-1078662]Inspecting the ICMP Message Code
 
     
 
    
 
     
      [bookmark: pgfId-1078663][bookmark: 75032]Identifying Static ICMP ID and Sequence Values
 
     [bookmark: pgfId-4238510]License: Protection
 
     [bookmark: pgfId-1078665]The ICMP identification and sequence numbers help associate ICMP replies with ICMP requests. In normal traffic, these values are dynamically assigned to packets. Some covert channel and Distributed Denial of Server (DDoS) programs use static ICMP ID and sequence values. The following keywords allow you to identify ICMP packets with static values.
 
     [bookmark: pgfId-1078834][bookmark: marker-1161985]icmp_id 
 
     [bookmark: pgfId-1115888]The icmp_id keyword inspects an ICMP echo request or reply packet's ICMP ID number. Use a numeric value that corresponds with the ICMP ID number as the argument for the icmp_id keyword.
 
     [bookmark: pgfId-1078668][bookmark: marker-1078667]icmp_seq 
 
     [bookmark: pgfId-1115889]The icmp_seq keyword inspects an ICMP echo request or reply packet's ICMP sequence. Use a numeric value that corresponds with the ICMP sequence number as the argument for the icmp_seq keyword.
 
    
 
     
      [bookmark: pgfId-1078669][bookmark: 28338]Inspecting the ICMP Message Type
 
     [bookmark: pgfId-4238523]License: Protection
 
     [bookmark: pgfId-1467445]Use the [bookmark: marker-1467444]itype keyword to look for packets with specific ICMP message type values. You can specify either a valid ICMP type value (see http://www.iana.org/assignments/icmp-parameters or http://www.faqs.org/rfcs/rfc792.html for a full list of ICMP type numbers) or an invalid ICMP type value to test for different types of traffic. For example, attackers may set ICMP type values out of range to cause denial of service and flooding attacks.
 
     [bookmark: pgfId-1586372]You can specify a range for the itype argument value using less than (<) and greater than (>).
 
     [bookmark: pgfId-1586373]For example:
 
      
      	 [bookmark: pgfId-1586374]<35
 
      	 [bookmark: pgfId-1586375]>36
 
      	 [bookmark: pgfId-1586376]3<>55
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1471132]Tip See http://www.iana.org/assignments/icmp-parameters or http://www.faqs.org/rfcs/rfc792.html for a full list of ICMP type numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1078672][bookmark: 29110]Inspecting the ICMP Message Code
 
     [bookmark: pgfId-4238536]License: Protection
 
     [bookmark: pgfId-1078674]ICMP messages sometimes include a code value that provides details when a destination is unreachable. (See the second section in http://www.iana.org/assignments/icmp-parameters for a full list of ICMP message codes correlated with the message types for which they can be used.)
 
     [bookmark: pgfId-1079273]You can use the icode[bookmark: marker-1078673] keyword to identify packets with specific ICMP code values. You can choose to specify either a valid ICMP code value or an invalid ICMP code value to test for different types of traffic. 
 
     [bookmark: pgfId-1585964]You can specify a range for the icode argument value using less than (<) and greater than (>).
 
     [bookmark: pgfId-1585966]For example:
 
      
      	 [bookmark: pgfId-1585969]to find values less than 35, specify  <35. 
 
      	 [bookmark: pgfId-2011838]to find values greater than 36, specify  >36. 
 
      	 [bookmark: pgfId-1585953]to find values between 3 and 55, specify  3<>55. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1079524]Tip You can use the icode and itype keywords together to identify traffic that matches both. For example, to identify ICMP traffic that contains an ICMP Destination Unreachable code type with an ICMP Port Unreachable code type, specify an itype keyword with a value of 3 (for Destination Unreachable) and an icode keyword with a value of 3 (for Port Unreachable).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1078428][bookmark: 48480]Inspecting TCP[bookmark: marker-2334568] Header Values and Stream Size
 
     [bookmark: pgfId-4238549]License: Protection
 
     [bookmark: pgfId-1078429]The ASA FirePOWER module supports keywords that are designed to identify attacks attempted using TCP headers of packets and TCP stream size. See the following sections for more information about TCP-specific keywords:
 
      
      	 [bookmark: pgfId-1078433]Inspecting the TCP Acknowledgment Value
 
      	 [bookmark: pgfId-1153514]Inspecting TCP Flag Combinations
 
      	 [bookmark: pgfId-1153515]Applying Rules to a TCP or UDP Client or Server Flow
 
      	 [bookmark: pgfId-1153522]Identifying Static TCP Sequence Numbers
 
      	 [bookmark: pgfId-2641076]Identifying TCP Windows of a Given Size
 
      	 [bookmark: pgfId-1153523]Identifying TCP Streams of a Given Size
 
     
 
    
 
     
      [bookmark: pgfId-1078451][bookmark: 12773]Inspecting the TCP Acknowledgment Value
 
     [bookmark: pgfId-4238562]License: Protection
 
     [bookmark: pgfId-1356154]You can use the [bookmark: marker-1078453]ack keyword to compare a value against a packet’s TCP acknowledgment number. The rule triggers if a packet’s TCP acknowledgment number matches the value specified for the ack keyword. 
 
     [bookmark: pgfId-2012016]Argument values for ack must be numeric.
 
    
 
     
      [bookmark: pgfId-1078455][bookmark: 94359]Inspecting TCP Flag Combinations
 
     [bookmark: pgfId-4238575]License: Protection
 
     [bookmark: pgfId-1078456]You can use the [bookmark: marker-1161986]flags keyword to specify any combination of TCP flags that, when set in an inspected packet, cause the rule to trigger. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1153600]Note In situations where you would traditionally use A+ as the value for flags, you should instead use the flow keyword with a value of established. Generally, you should use the flow keyword with a value of stateless when using flags to ensure that all combinations of flags are detected. See Applying Rules to a TCP or UDP Client or Server Flow for more information about the flow keyword.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1668739]Table 24-26 [bookmark: 64907]flag Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1668743]Argument 
          
  
         	 
           
           [bookmark: pgfId-1668745]TCP Flag 
          
  
        
 
         
         	[bookmark: pgfId-1668804]Ack
  
         	[bookmark: pgfId-1668806]Acknowledges data.
  
        
 
         
         	[bookmark: pgfId-1668992]Psh
  
         	[bookmark: pgfId-1668994]Data should be sent in this packet.
  
        
 
         
         	[bookmark: pgfId-1668747]Syn
  
         	[bookmark: pgfId-1668749]A new connection.
  
        
 
         
         	[bookmark: pgfId-1669180]Urg
  
         	[bookmark: pgfId-1669182]Packet contains urgent data.
  
        
 
         
         	[bookmark: pgfId-1668751]Fin
  
         	[bookmark: pgfId-1668753]A closed connection.
  
        
 
         
         	[bookmark: pgfId-1668755]Rst
  
         	[bookmark: pgfId-1668757]An aborted connection.
  
        
 
         
         	[bookmark: pgfId-1669199]CWR
  
         	[bookmark: pgfId-1669201]An ECN congestion window has been reduced. This was formerly the R1 argument, which is still supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-1668771]ECE
  
         	[bookmark: pgfId-1668773]ECN echo. This was formerly the R2 argument, which is still supported for backward compatibility.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1078503]Tip For more information on Explicit Congestion Notification (ECN), see the information provided at: http://www.faqs.org/rfcs/rfc3168.html.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1467802]Table 24-27 [bookmark: 58804]Operators Used with flags 
 
        
        
         
         	 
           
           [bookmark: pgfId-1467806]Operator 
          
  
         	 
           
           [bookmark: pgfId-1467808]Description 
          
  
         	 
           
           [bookmark: pgfId-1468002]Example 
          
  
        
 
         
         	[bookmark: pgfId-1467810]all
  
         	[bookmark: pgfId-1467812]The packet must contain all specified flags.
  
         	[bookmark: pgfId-1468004]Select Urg and all to specify that a packet must contain the Urgent flag and may contain any other flags. 
  
        
 
         
         	[bookmark: pgfId-1467814]any
  
         	[bookmark: pgfId-1467816]The packet can contain any of the specified flags.
  
         	[bookmark: pgfId-1468226]Select Ack, Psh, and any to specify that either or both the Ack and Psh flags must be set to trigger the rule, and that other flags may also be set on a packet.
  
        
 
         
         	[bookmark: pgfId-1467818]not 
  
         	[bookmark: pgfId-1467820]The packet must not contain the specified flag set.
  
         	[bookmark: pgfId-1468008]Select Urg and not to specify that the Urgent flag is not set on packets that trigger this rule.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1078509][bookmark: 90818]Applying Rules to a TCP or UDP Client or Server Flow
 
     [bookmark: pgfId-4238592]License: Protection
 
     [bookmark: pgfId-1989716]You can use the [bookmark: marker-1989715]flow keyword to select packets for inspection by a rule based on session characteristics. The flow keyword allows you to specify the direction of the traffic flow to which a rule applies, applying rules to either the client flow or server flow. To specify how the flow keyword inspects your packets, you can set the direction of traffic you want analyzed, the state of packets inspected, and whether the packets are part of a rebuilt stream.
 
     [bookmark: pgfId-3293902]Stateful inspection of packets occurs when rules are processed. If you want a TCP rule to ignore stateless traffic (traffic without an established session context), you must add the flow keyword to the rule and select the Established argument for the keyword. If you want a UDP rule to ignore stateless traffic, you must add the flow keyword to the rule and select either the Established argument or a directional argument, or both. This causes the TCP or UDP rule to perform stateful inspection of a packet.
 
     [bookmark: pgfId-3293903]When you add a directional argument, the rules engine inspects only those packets that have an established state with a flow that matches the direction specified. For example, if you add the flow keyword with the established argument and the From Client argument to a rule that triggers when a TCP or UDP connection is detected, the rules engine only inspects packets that are sent from the client.
 
      
       
     
 
     
 
     [bookmark: pgfId-3293904]Tip For maximum performance, always include a flow keyword in a TCP rule or a UDP session rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3293905]To specify flow, select the flow keyword from the Detection Options list on the Create Rule page and click Add Option. Next, select the arguments from the list provided for each field.
 
     [bookmark: pgfId-1561899]The following table describes the stream-related arguments you can specify for the flow keyword:
 
     [bookmark: pgfId-1561921]
 
      
       
        
        [bookmark: pgfId-1561906]Table 24-28 [bookmark: 86925]State-Related flow Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1561910]Argument 
          
  
         	 
           
           [bookmark: pgfId-1561912]Description 
          
  
        
 
         
         	[bookmark: pgfId-1561914]Established
  
         	[bookmark: pgfId-1561916]Triggers on established connections.
  
        
 
         
         	[bookmark: pgfId-1561918]Stateless
  
         	[bookmark: pgfId-1561920]Triggers regardless of the state of the stream processor.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1489095]The following table describes the directional options you can specify for the flow keyword:
 
     [bookmark: pgfId-1078533]
 
      
       
        
        [bookmark: pgfId-1447518]Table 24-29 [bookmark: 53900]flow Directional Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1078514]Argument 
          
  
         	 
           
           [bookmark: pgfId-1078516]Description 
          
  
        
 
         
         	[bookmark: pgfId-1078518]To Client
  
         	[bookmark: pgfId-1078520]Triggers on server responses.
  
        
 
         
         	[bookmark: pgfId-1078522]To Server
  
         	[bookmark: pgfId-1078524]Triggers on client responses.
  
        
 
         
         	[bookmark: pgfId-1078526]From Client
  
         	[bookmark: pgfId-1078528]Triggers on client responses.
  
        
 
         
         	[bookmark: pgfId-1078530]From Server
  
         	[bookmark: pgfId-1078532]Triggers on server responses.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1078535]Notice that From Server and To Client perform the same function, as do To Server and From Client. These options exist to add context and readability to the rule. For example, if you create a rule designed to detect an attack from a server to a client, use From Server. But, if you create a rule designed to detect an attack from the client to the server, use From Client.
 
      
       
        
        [bookmark: pgfId-2391718]Table 24-30 [bookmark: 52569]Stream-Related flow Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-2391722]Argument 
          
  
         	 
           
           [bookmark: pgfId-2391724]Description 
          
  
        
 
         
         	[bookmark: pgfId-2391726]Ignore Stream Traffic
  
         	[bookmark: pgfId-2391728]Does not trigger on rebuilt stream packets.
  
        
 
         
         	[bookmark: pgfId-2391730]Only Stream Traffic
  
         	[bookmark: pgfId-2391732]Triggers only on rebuilt stream packets.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2406861]For example, you can use To Server, Established, Only Stream Traffic as the value for the flow keyword to detect traffic, traveling from a client to the server in an established session, that has been reassembled by the stream preprocessor.
 
    
 
     
      [bookmark: pgfId-1078587][bookmark: 83009]Identifying Static TCP Sequence Numbers
 
     [bookmark: pgfId-4238605]License: Protection
 
     [bookmark: pgfId-1078588]The [bookmark: marker-1161988]seq keyword allows you to specify a static sequence number value. Packets whose sequence number matches the specified argument trigger the rule containing the keyword. While this keyword is used rarely, it is helpful in identifying attacks and network scans that use generated packets with static sequence numbers.
 
    
 
     
      [bookmark: pgfId-1118471][bookmark: 60569]Identifying TCP Windows of a Given Size
 
     [bookmark: pgfId-4238622]License: Protection
 
     [bookmark: pgfId-2804610]You can use the [bookmark: marker-2804609]window keyword to specify the TCP window size you are interested in. A rule containing this keyword triggers whenever it encounters a packet with the specified TCP window size. While this keyword is used rarely, it is helpful in identifying attacks and network scans that use generated packets with static TCP window sizes.
 
    
 
     
      [bookmark: pgfId-2672490][bookmark: 81132]Identifying TCP Streams of a Given Size
 
     [bookmark: pgfId-4238639]License: Protection
 
     [bookmark: pgfId-2672492]You can use the [bookmark: marker-2672491]stream_size keyword in conjunction with the stream preprocessor to determine the size in bytes of a TCP stream, using the format:
 
      
      [bookmark: pgfId-2674667]direction,operator,bytes 
     
 
     [bookmark: pgfId-2674708]where bytes is number of bytes. You must separate each option in the argument with a comma (,).
 
      
       
        
        [bookmark: pgfId-2674673]Table 24-31 [bookmark: 84093]stream_size Keyword Directional Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-2674677]Argument 
          
  
         	 
           
           [bookmark: pgfId-2674679]Description 
          
  
        
 
         
         	[bookmark: pgfId-2674681]client
  
         	[bookmark: pgfId-2674683]triggers on a stream from the client matching the specified stream size.
  
        
 
         
         	[bookmark: pgfId-2674685]server
  
         	[bookmark: pgfId-2674687]triggers on a stream from the server matching the specified stream size.
  
        
 
         
         	[bookmark: pgfId-2674689]both
  
         	[bookmark: pgfId-2674691]triggers on traffic from the client and traffic from the server both matching the specified stream size.
 [bookmark: pgfId-2679579]For example, the argument both, >, 200 would trigger when traffic from the client is greater than 200 bytes AND traffic from the server is greater than 200 bytes.
  
        
 
         
         	[bookmark: pgfId-2674693]either
  
         	[bookmark: pgfId-2674695]triggers on traffic from either the client or the server matching the specified stream size, whichever occurs first.
 [bookmark: pgfId-2679853]For example, the argument either, >, 200 would trigger when traffic from the client is greater than 200 bytes OR traffic from the server is greater than 200 bytes.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2674763]The following table describes the operators you can use with the stream_size keyword:
 
     [bookmark: pgfId-2674560]
 
      
       
        
        [bookmark: pgfId-2674533]Table 24-32 [bookmark: 69774]stream_size Keyword Argument Operators 
 
        
        
         
         	 
           
           [bookmark: pgfId-2674537]Operator 
          
  
         	 
           
           [bookmark: pgfId-2674539]Description 
          
  
        
 
         
         	[bookmark: pgfId-2674541]=
  
         	[bookmark: pgfId-2674543]equal to
  
        
 
         
         	[bookmark: pgfId-2674623]!=
  
         	[bookmark: pgfId-2674625]not equal to
  
        
 
         
         	[bookmark: pgfId-2674545]>
  
         	[bookmark: pgfId-2674547]greater than
  
        
 
         
         	[bookmark: pgfId-2674549]<
  
         	[bookmark: pgfId-2674551]less than
  
        
 
         
         	[bookmark: pgfId-2674553]>=
  
         	[bookmark: pgfId-2674555] greater than or equal to
  
        
 
         
         	[bookmark: pgfId-2674557]<=
  
         	[bookmark: pgfId-2674559]less than or equal to
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4118095]For example, you could use client, >=, 5001216 as the argument for the stream_size keyword to detect a TCP stream traveling from a client to a server and greater than or equal to 5001216 bytes.
 
    
 
     
      [bookmark: pgfId-4118098][bookmark: 94582]Enabling and Disa[bookmark: marker-4118097]bling TCP Stream Reassembly
 
     [bookmark: pgfId-4238656]License: Protection
 
     [bookmark: pgfId-4118113]You can use the stream_reassemble keyword to enable or disable TCP stream reassembly for a single connection when inspected traffic on the connection matches the conditions of the rule. Optionally, you can use this keyword multiple times in a rule.
 
     [bookmark: pgfId-4118114]Use the following syntax to enable or disable stream reassembly:
 
      
      [bookmark: pgfId-4118115]enable|disable, server|client|both, option, option 
     
 
     [bookmark: pgfId-4118119]The following table describes the optional arguments you can use with the stream_reassemble keyword. 
 
     [bookmark: pgfId-4118138]
 
      
       
        
        [bookmark: pgfId-4118123]Table 24-33 [bookmark: 85814]stream_reassemble Optional Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4118127]Argument 
          
  
         	 
           
           [bookmark: pgfId-4118129]Description 
          
  
        
 
         
         	[bookmark: pgfId-4118131]noalert
  
         	[bookmark: pgfId-4118133]Generate no events regardless of any other detection options specified in the rule.
  
        
 
         
         	[bookmark: pgfId-4118135]fastpath
  
         	[bookmark: pgfId-4118137]Ignore the rest of the connection traffic when there is a match.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4118139]For example, the following rule disables TCP client-side stream reassembly without generating an event on the connection where a 200 OK status code is detected in an HTTP response:
 
      
      [bookmark: pgfId-4118140]alert tcp any 80 -> any any (flow:to_client, established; content: “200 OK”; stream_reassemble:disable, client, noalert 
     
 
     [bookmark: pgfId-4118145]To use stream_reassemble:
 
     
 
     [bookmark: pgfId-4118146]Step 1 On the Create Rule page, select stream_reassemble in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4118147]The stream_reassemble section appears.
 
     [bookmark: pgfId-4776215]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4118154][bookmark: 18634]Extracting SSL Info[bookmark: marker-4118153]rmation from a Session
 
     [bookmark: pgfId-4238670]License: Protection
 
     [bookmark: pgfId-2867382]You can use SSL rule keywords to invoke the Secure Sockets Layer (SSL) preprocessor and extract information about SSL version and session state from packets in an encrypted session. 
 
     [bookmark: pgfId-2867383]When a client and server communicate to establish an encrypted session using SSL or Transport Layer Security (TLS), they exchange handshake messages. Although the data transmitted in the session is encrypted, the handshake messages are not. 
 
     [bookmark: pgfId-2867384]The SSL preprocessor extracts state and version information from specific handshake fields. Two fields within the handshake indicate the version of SSL or TLS used to encrypt the session and the stage of the handshake.
 
     [bookmark: pgfId-2867401]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2867405]ssl_state
 
      	 [bookmark: pgfId-2867409]ssl_version
 
     
 
    
 
     
      [bookmark: pgfId-2867411][bookmark: 76982]ssl_state
 
     [bookmark: pgfId-4238683]License: Protection
 
     [bookmark: pgfId-2867422]The ssl_state[bookmark: marker-3099249] keyword can be used to match against state information for an encrypted session. To check for two or more SSL versions used simultaneously, use multiple ssl_version keywords in a rule.
 
     [bookmark: pgfId-4225142]When a rule uses the ssl_state keyword, the rules engine invokes the SSL preprocessor to check traffic for SSL state information.
 
     [bookmark: pgfId-2867423]For example, to detect an attacker’s attempt to cause a buffer overflow on a server by sending a ClientHello message with an overly long challenge length and too much data, you could use the ssl_state keyword with client_hello as an argument then check for abnormally large packets. 
 
     [bookmark: pgfId-2867424]Use a comma-separated list to specify multiple arguments for the SSL state. When you list multiple arguments, the system evaluates them using the OR operator. For example, if you specify client_hello and server_hello as arguments, the system evaluates the rule against traffic that has a client_hello OR a server_hello.
 
     [bookmark: pgfId-3799799]You can also negate any argument; for example:
 
      
      [bookmark: pgfId-4028151]!client_hello, !unknown 
     
 
     [bookmark: pgfId-4028166]To ensure the connection has reached each of a set of states, multiple rules using the ssl_state rule option should be used. The ssl_state keyword takes the following identifiers as arguments:
 
     [bookmark: pgfId-2867460]
 
      
       
        
        [bookmark: pgfId-2867437]Table 24-34 ssl_state Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-2867441]Argument 
          
  
         	 
           
           [bookmark: pgfId-2867443]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-2867445]client_hello
  
         	[bookmark: pgfId-2867447]Matches against a handshake message with ClientHello as the message type, where the client requests an encrypted session.
  
        
 
         
         	[bookmark: pgfId-2867449]server_hello
  
         	[bookmark: pgfId-2867451]Matches against a handshake message with ServerHello as the message type, where the server responds to the client’s request for an encrypted session.
  
        
 
         
         	[bookmark: pgfId-2867453]client_keyx
  
         	[bookmark: pgfId-2867455]Matches against a handshake message with ClientKeyExchange as the message type, where the client transmits a key to the server to confirm receipt of a key from the server.
  
        
 
         
         	[bookmark: pgfId-2867457]server_keyx
  
         	[bookmark: pgfId-2867459]Matches against a handshake message with ServerKeyExchange as the message type, where the client transmits a key to the server to confirm receipt of a key from the server.
  
        
 
         
         	[bookmark: pgfId-2868972]unknown
  
         	[bookmark: pgfId-2868974]Matches against any handshake message type.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2867462][bookmark: 89100]ssl_version
 
     [bookmark: pgfId-4238700]License: Protection
 
     [bookmark: pgfId-2867473]The ssl_version[bookmark: marker-3099250] keyword can be used to match against version information for an encrypted session. When a rule uses the ssl_version keyword, the rules engine invokes the SSL preprocessor to check traffic for SSL version information.
 
     [bookmark: pgfId-2867474]For example, if you know there is a buffer overflow vulnerability in SSL version 2, you could use the ssl_version keyword with the sslv2 argument to identify traffic using that version of SSL.
 
     [bookmark: pgfId-4903200]Use a comma-separated list to specify multiple arguments for the SSL version. When you list multiple arguments, the system evaluates them using the OR operator. For example, if you wanted to identify any encrypted traffic that was not using SSLv2, you could add ssl_version:ssl_v3,tls1.0,tls1.1,tls1.2 to a rule. The rule would evaluate any traffic using SSL Version 3, TLS Version 1.0, TLS Version 1.1, or TLS Version 1.2.
 
     [bookmark: pgfId-4903205]The ssl_version keyword takes the following SSL/TLS version identifiers as arguments:
 
     [bookmark: pgfId-4903238]
 
      
       
        
        [bookmark: pgfId-4903211]Table 24-35 ssl_version Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4903215]Argument 
          
  
         	 
           
           [bookmark: pgfId-4903217]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-4903219]sslv2
  
         	[bookmark: pgfId-4903221]Matches against traffic encoded using Secure Sockets Layer (SSL) Version 2. 
  
        
 
         
         	[bookmark: pgfId-4903223]sslv3
  
         	[bookmark: pgfId-4903225]Matches against traffic encoded using Secure Sockets Layer (SSL) Version 3. 
  
        
 
         
         	[bookmark: pgfId-4903227]tls1.0
  
         	[bookmark: pgfId-4903229]Matches against traffic encoded using Transport Layer Security (TLS) Version 1.0. 
  
        
 
         
         	[bookmark: pgfId-4903231]tls1.1
  
         	[bookmark: pgfId-4903233]Matches against traffic encoded using Transport Layer Security (TLS) Version 1.1. 
  
        
 
         
         	[bookmark: pgfId-4903235]tls1.2
  
         	[bookmark: pgfId-4903237]Matches against traffic encoded using Transport Layer Security (TLS) Version 1.2. 
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3839363][bookmark: 34917]Inspecting Application Layer Protocol Values
 
     [bookmark: pgfId-4238713]License: Protection
 
     [bookmark: pgfId-1064782]Although preprocessors perform most of the normalization and inspection of application layer protocol values, you can continue to inspect application layer values using the keywords described in the following sections:
 
      
      	 [bookmark: pgfId-1232928]RPC
 
      	 [bookmark: pgfId-2627722]ASN.1
 
      	 [bookmark: pgfId-1522891]urilen
 
      	 [bookmark: pgfId-4214956]DCE/RPC Keywords
 
      	 [bookmark: pgfId-4252181]SIP Keywords
 
      	 [bookmark: pgfId-4360101]GTP Keywords
 
      	 [bookmark: pgfId-4360154]Modbus Keywords
 
      	 [bookmark: pgfId-3300962]DNP3 Keywords
 
     
 
    
 
     
      [bookmark: pgfId-1064784][bookmark: 53217]RP[bookmark: marker-2606546]C
 
     [bookmark: pgfId-4238730]License: Protection
 
      
       
        
        [bookmark: pgfId-1447598]Table 24-36 [bookmark: 51776]rpc Keyword Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1079606]Argument 
          
  
         	 
           
           [bookmark: pgfId-1079608]Description 
          
  
        
 
         
         	[bookmark: pgfId-1079610]application
  
         	[bookmark: pgfId-1079612]The RPC application number
  
        
 
         
         	[bookmark: pgfId-1079614]procedure
  
         	[bookmark: pgfId-1079616]The RPC procedure invoked
  
        
 
         
         	[bookmark: pgfId-1079618]version
  
         	[bookmark: pgfId-1079620]The RPC version
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1064785]To specify the arguments for the rpc keyword, use the following syntax:
 
      
      [bookmark: pgfId-1079683]application,procedure,version 
     
 
     [bookmark: pgfId-1153920]where application is the RPC application number, procedure is the RPC procedure number, and version is the RPC version number. You must specify all arguments for the rpc keyword — if you are not able to specify one of the arguments, replace it with an asterisk (*).
 
     [bookmark: pgfId-4009252]For example, to search for RPC portmapper (which is the RPC application indicated by the number 100000), with any procedure or version, use 100000,*,* as the arguments. 
 
    
 
     
      [bookmark: pgfId-1522860][bookmark: 98752]AS[bookmark: marker-2606542]N.1
 
     [bookmark: pgfId-4238747]License: Protection
 
     [bookmark: pgfId-1522882]The asn1 keyword allows you to decode a packet or a portion of a packet, looking for various malicious encodings.
 
     [bookmark: pgfId-1522917]The following table describes the arguments for the asn1 keyword.
 
     [bookmark: pgfId-1525388]
 
      
       
        
        [bookmark: pgfId-1525391]Table 24-37 [bookmark: 87352]asn.1 Keyword Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1525395]Argument 
          
  
         	 
           
           [bookmark: pgfId-1525397]Description 
          
  
        
 
         
         	[bookmark: pgfId-1525399]Bitstring Overflow
  
         	[bookmark: pgfId-1525492]Detects invalid, remotely exploitable bitstring encodings.
  
        
 
         
         	[bookmark: pgfId-1525403]Double Overflow
  
         	[bookmark: pgfId-1525641]Detects a double ASCII encoding that is larger than a standard buffer. This is known to be an exploitable function in Microsoft Windows, but it is unknown at this time which services may be exploitable.
  
        
 
         
         	[bookmark: pgfId-1525407]Oversize Length
  
         	[bookmark: pgfId-1525699]Detects ASN.1 type lengths greater than the supplied argument. For example, if you set the Oversize Length to 500, any ASN.1 type greater than 500 triggers the rule.
  
        
 
         
         	[bookmark: pgfId-1525411]Absolute Offset
  
         	[bookmark: pgfId-1525730]Sets an absolute offset from the beginning of the packet payload. (Remember that the offset counter starts at byte 0.) For example, if you want to decode SNMP packets, set Absolute Offset to 0 and do not set a Relative Offset. Absolute Offset may be positive or negative.
  
        
 
         
         	[bookmark: pgfId-1525415]Relative Offset
  
         	[bookmark: pgfId-1525762]This is the relative offset from the last successful content match, pcre, or byte_jump. To decode an ASN.1 sequence right after the content "foo", set Relative Offset to 0, and do not set an Absolute Offset. Relative Offset may be positive or negative. (Remember that the offset counter starts at 0.) 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1526756]For example, there is a known vulnerability in the Microsoft ASN.1 Library that creates a buffer overflow, allowing an attacker to exploit the condition with a specially crafted authentication packet. When the system decodes the asn.1 data, exploit code in the packet could execute on the host with system-level privileges or could cause a DoS condition. The following rule uses the asn1 keyword to detect attempts to exploit this vulnerability:
 
      
      [bookmark: pgfId-1526757]alert tcp $EXTERNAL_NET any -> $HOME_NET 445
(flow:to_server, established; content:”|FF|SMB|73|”; nocase;
offset:4; depth:5;
asn1:bitstring_overflow,double_overflow,oversize_length
100,relative_offset 54;) 
     
 
     [bookmark: pgfId-1526829]The above rule generates an event against TCP traffic traveling from any IP address defined in the $EXTERNAL_NET variable, from any port, to any IP address defined in the $HOME_NET variable using port 445. In addition, it only executes the rule on established TCP connections to servers. The rule then tests for specific content in specific locations. Finally, the rule uses the asn1 keyword to detect bitstring encodings and double ASCII encodings and to identify asn.1 type lengths over 100 bytes in length starting 55 bytes from the end of the last successful content match. (Remember that the offset counter starts at byte 0.)
 
    
 
     
      [bookmark: pgfId-2626073][bookmark: 98448]urilen
 
     [bookmark: pgfId-4238760]License: Protection
 
     [bookmark: pgfId-2627411]You can use the [bookmark: marker-2644140]urilen keyword in conjunction with the HTTP Inspect preprocessor to inspect HTTP traffic for URIs of a specific length, less than a maximum length, greater than a minimum length, or within a specified range.
 
     [bookmark: pgfId-2631888]After the HTTP Inspect preprocessor normalizes and inspects the packet, the rules engine evaluates the packet against the rule and determines whether the URI matches the length condition specified by the urilen keyword. You can use this keyword to detect exploits that attempt to take advantage of URI length vulnerabilities, for example, by creating a buffer overflow that allows the attacker to cause a DoS condition or execute code on the host with system-level privileges.
 
     [bookmark: pgfId-2670578]Note the following when using the urilen keyword in a rule:
 
      
      	 [bookmark: pgfId-2670579]In practice, you always use the  urilen keyword in combination with the  flow:established  keyword and one or more other keywords.
 
      	 [bookmark: pgfId-2670591]The rule protocol is always TCP. See Specifying Protocols for more information.
 
      	 [bookmark: pgfId-2670594]Target ports are always HTTP ports. See Defining Ports in Intrusion Rules and Optimizing Predefined Default Variables for more information.
 
     
 
     [bookmark: pgfId-2627447]You specify the URI length using a decimal number of bytes, less than (<) and greater than (>).
 
     [bookmark: pgfId-2626074]For example:
 
      
      	 [bookmark: pgfId-2632010]specify 5  to detect a URI 5 bytes long.
 
      	 [bookmark: pgfId-2632011]specify < 5  (separated by one space character) to detect a URI less than 5 bytes long.
 
      	 [bookmark: pgfId-2626607]specify > 5  (separated by one space character) to detect a URI greater than 5 bytes long.
 
      	 [bookmark: pgfId-2626608]specify 3 <> 5  (with one space character before and after  <> ) to detect a URI between 3 and 5 bytes long inclusive.
 
     
 
     [bookmark: pgfId-2627100]For example, there is a known vulnerability in Novell’s server monitoring and diagnostics utility iMonitor version 2.4, which comes with eDirectory version 8.8. A packet containing an excessively long URI creates a buffer overflow, allowing an attacker to exploit the condition with a specially crafted packet that could execute on the host with system-level privileges or could cause a DoS condition. The following rule uses the urilen keyword to detect attempts to exploit this vulnerability:
 
      
      [bookmark: pgfId-2626978]alert tcp $EXTERNAL_NET any -> $HOME_NET $HTTP_PORTS
(msg:"EXPLOIT eDirectory 8.8 Long URI iMonitor buffer
overflow attempt";flow:to_server,established;
urilen:> 8192; uricontent:"/nds/"; nocase;
classtype:attempted-admin; sid:x; rev:1;) 
     
 
     [bookmark: pgfId-2626772]The above rule generates an event against TCP traffic traveling from any IP address defined in the $EXTERNAL_NET variable, from any port, to any IP address defined in the $HOME_NET variable using the ports defined in the $HTTP_PORTS variable. In addition, packets are evaluated against the rule only on established TCP connections to servers. The rule uses the urilen keyword to detect any URI over 8192 bytes in length. Finally, the rule searches the URI for the specific case-insensitive content /nds/.
 
    
 
     
      [bookmark: pgfId-3300998][bookmark: 55995]DCE/RPC Keywords
 
     [bookmark: pgfId-4238773]License: Protection
 
     [bookmark: pgfId-3301015]The three DCE/RPC keywords described in the following table allow you to monitor DCE/RPC session traffic for exploits. When the system processes rules with these keywords, it invokes the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 
     [bookmark: pgfId-3301061]
 
      
       
        
        [bookmark: pgfId-4913639]Table 24-38 [bookmark: 82119]DCE/RPC Keywords 
 
        
        
         
         	 
           
           [bookmark: pgfId-4913645]Use... 
          
  
         	 
           
           [bookmark: pgfId-4913647]In this way... 
          
  
         	 
           
           [bookmark: pgfId-4913649]To detect... 
          
  
        
 
         
         	[bookmark: pgfId-4913651]dce_iface
  
         	[bookmark: pgfId-4913653]alone
  
         	[bookmark: pgfId-4913656]packets identifying a specific DCE/RPC service
  
        
 
         
         	[bookmark: pgfId-4913658]dce_opnum
  
         	[bookmark: pgfId-4913660]preceded by dce_iface
  
         	[bookmark: pgfId-4913663]packets identifying specific DCE/RPC service operations
  
        
 
         
         	[bookmark: pgfId-4913665]dce_stub_data
  
         	[bookmark: pgfId-4913667]preceded by dce_iface + dce_opnum
  
         	[bookmark: pgfId-4913669]stub data defining a specific operation request or response
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3301062]Note in the table that you should always precede dce_opnum with dce_iface, and you should always precede dce_stub_data with dce_iface + dce_opnum.
 
     [bookmark: pgfId-3301063]You can also use these DCE/RPC keywords in combination with other rule keywords. Note that for DCE/RPC rules, you use the byte_jump, byte_test, and byte_extract keywords with their DCE/RPC arguments selected. For more information, see Using Byte_Jump and Byte_Test and Reading Packet Data into Keyword Arguments.
 
     [bookmark: pgfId-3301070]Cisco recommends that you include at least one content keyword in rules that include DCE/RPC keywords to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument. See Searching for Content Matches and Use Fast Pattern Matcher for more information.
 
     [bookmark: pgfId-3301077]You can use the DCE/RPC version and adjoining header information as the matching content in the following cases:
 
      
      	 [bookmark: pgfId-3301078]the rule does not include another  content keyword
 
      	 [bookmark: pgfId-3301079]the rule contains another  content keyword, but the DCE/RPC version and adjoining information represent a more unique pattern than the other content
 
     
 
     [bookmark: pgfId-3301080]For example, the DCE/RPC version and adjoining information are more likely to be unique than a single byte of content.
 
     [bookmark: pgfId-3301081]You should end qualifying rules with one of the following version and adjoining information content matches:
 
      
      	 [bookmark: pgfId-3301082]For connection-oriented DCE/RPC rules, use the content  |05 00 00| (for major version 05, minor version 00, and the request PDU (protocol data unit) type 00).
 
      	 [bookmark: pgfId-3301083]For connectionless DCE/RPC rules, use the content  |04 00| (for version 04, and the request PDU type 00).
 
     
 
     [bookmark: pgfId-3301084]In either case, position the content keyword for version and adjoining information as the last keyword in the rule to invoke the fast pattern matcher without repeating processing already completed by the DCE/RPC preprocessor. Note that placing the content keyword at the end of the rule applies to version content used as a device to invoke the fast pattern matcher, and not necessarily to other content matches in the rule.
 
     [bookmark: pgfId-3301085]See the following sections for more information:
 
      
      	 [bookmark: pgfId-3301089]dce_iface
 
      	 [bookmark: pgfId-3301093]dce_opnum
 
      	 [bookmark: pgfId-3301097]dce_stub_data
 
     
 
    
 
     
      [bookmark: pgfId-3301099][bookmark: 19395]dce_iface
 
     [bookmark: pgfId-4390621]License: Protection
 
     [bookmark: pgfId-4390659]You can use the dce_iface[bookmark: marker-4390660] keyword to identify a specific DCE/RPC service.
 
     [bookmark: pgfId-3301105]Optionally, you can also use dce_iface in combination with the dce_opnum and dce_stub_data keywords to further limit the DCE/RPC traffic to inspect. See dce_opnum and dce_stub_data for more information.
 
     [bookmark: pgfId-3301116]A fixed, sixteen-byte Universally Unique Identifier (UUID) identifies the application interface assigned to each DCE/RPC service. For example, the UUID 4b324fc8-670-01d3-1278-5a47bf6ee188 identifies the DCE/RPC lanmanserver service, also known as the srvsvc service, which provides numerous management functions for sharing peer-to-peer printers, files, and SMB named pipes. The DCE/RPC preprocessor uses the UUID and associated header values to track DCE/RPC sessions.
 
     [bookmark: pgfId-3301117]The interface UUID is comprised of five hexadecimal strings separated by hyphens:
 
      
      [bookmark: pgfId-3301118]<4hexbytes>-<2hexbytes>-<2hexbytes>-<2hexbytes>-<6hexbytes> 
     
 
     [bookmark: pgfId-3301119]You specify the interface by entering the entire UUID including hyphens, as seen in the following UUID for the netlogon interface:
 
      
      [bookmark: pgfId-3301120]12345678-1234-abcd-ef00-01234567cffb 
     
 
     [bookmark: pgfId-3301121]Note that you must specify the first three strings in the UUID in big endian byte order. Although published interface listings and protocol analyzers typically display UUIDs in the correct byte order, you might encounter a need to rearrange the UUID byte order before entering it. Consider the following messenger service UUID shown as it might sometimes be displayed in raw ASCII text with the first three strings in little endian byte order:
 
      
      [bookmark: pgfId-3301122]f8 91 7b 5a 00 ff d0 11 a9 b2 00 c0 4f b6 e6 fc 
     
 
     [bookmark: pgfId-3301123]You would specify the same UUID for the dce_iface keyword by inserting hyphens and putting the first three strings in big endian byte order as follows:
 
      
      [bookmark: pgfId-3301124]5a7b91f8-ff00-11d0-a9b2-00c04fb6e6fc 
     
 
     [bookmark: pgfId-3301125]Although a DCE/RPC session can include requests to multiple interfaces, you should include only one dce_iface keyword in a rule. Create additional rules to detect additional interfaces.
 
     [bookmark: pgfId-3301126]DCE/RPC application interfaces also have interface version numbers. You can optionally specify an interface version with an operator indicating that the version equals, does not equal, is less than, or greater than the specified value.
 
     [bookmark: pgfId-3301127]Both connection-oriented and connectionless DCE/RPC can be fragmented in addition to any TCP segmentation or IP fragmentation. Typically, it is not useful to associate any DCE/RPC fragment other than the first with the specified interface, and doing so may result in a large number of false positives. However, for flexibility you can optionally evaluate all fragments against the specified interface.
 
      
       
        
        [bookmark: pgfId-4913695]Table 24-39 dce_iface[bookmark: 59341] Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4913699]Argument 
          
  
         	 
           
           [bookmark: pgfId-4913701]Description 
          
  
        
 
         
         	[bookmark: pgfId-4913703]Interface UUID
  
         	[bookmark: pgfId-4913705]The UUID, including hyphens, that identifies the application interface of the specific service that you want to detect in DCE/RPC traffic. Any request associated with the specified interface would match the interface UUID.
  
        
 
         
         	[bookmark: pgfId-4913707]Version
  
         	[bookmark: pgfId-4913709]Optionally, the application interface version number 0 to 65535 and an operator indicating whether to detect a version greater than (>), less than (<), equal to (=), or not equal to (!) the specified value.
  
        
 
         
         	[bookmark: pgfId-4913711]All Fragments
  
         	[bookmark: pgfId-4913713]Optionally, enable to match against the interface in all associated DCE/RPC fragments and, if specified, on the interface version. This argument is disabled by default, indicating that the keyword matches only if the first fragment or the entire unfragmented packet is associated with the specified interface. Note that enabling this argument may result in false positives.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3301159][bookmark: 37246]dce_opnum
 
     [bookmark: pgfId-4238802]License: Protection
 
     [bookmark: pgfId-4214994]You can use the dce_opnum[bookmark: marker-4214997] keyword in conjunction with the DCE/RPC preprocessor to detect packets that identify one or more specific operations that a DCE/RPC service provides.
 
     [bookmark: pgfId-3301165]Client function calls request specific service functions, which are referred to in DCE/RPC specifications as operations. An operation number (opnum) identifies a specific operation in the DCE/RPC header. It is likely that an exploit would target a specific operation.
 
     [bookmark: pgfId-3301166]For example, the UUID 12345678-1234-abcd-ef00-01234567cffb identifies the interface for the netlogon service, which provides several dozen different operations. One of these is operation 6, the NetrServerPasswordSet operation.
 
     [bookmark: pgfId-3301167]You should precede a dce_opnum keyword with a dce_iface keyword to identify the service for the operation. See dce_iface for more information.
 
     [bookmark: pgfId-3301175]You can specify a single decimal value 0 to 65535 for a specific operation, a range of operations separated by a hyphen, or a comma-separated list of operations and ranges in any order.
 
     [bookmark: pgfId-3301176]Any of the following examples would specify valid netlogon operation numbers:
 
      
      [bookmark: pgfId-3301177]15 
     
 
      
      [bookmark: pgfId-3301178]15-18 
     
 
      
      [bookmark: pgfId-3301179]15, 18-20 
     
 
      
      [bookmark: pgfId-3301180]15, 20-22, 17 
     
 
      
      [bookmark: pgfId-3301181]15, 18-20, 22, 24-26 
     
 
    
 
     
      [bookmark: pgfId-3301183][bookmark: 47348]dce_stub_data
 
     [bookmark: pgfId-4238821]License: Protection
 
     [bookmark: pgfId-3301184]You can use the dce_stub_data[bookmark: marker-4215002] keyword in conjunction with the DCE/RPC preprocessor to specify that the rules engine should start inspection at the beginning of the stub data, regardless of any other rule options. Packet payload rule options that follow the dce_stub_data keyword are applied relative to the stub data buffer.
 
     [bookmark: pgfId-4390195]DCE/RPC stub data provides the interface between a client procedure call and the DCE/RPC run-time system, the mechanism that provides the routines and services central to DCE/RPC. DCE/RPC exploits are identified in the stub data portion of the DCE/RPC packet. Because stub data is associated with a specific operation or function call, you should always precede dce_stub_data with dce_iface and dce_opnum to identify the related service and operation. 
 
     [bookmark: pgfId-4214236]The dce_stub_data keyword has no arguments. See dce_iface and dce_opnum for more information.
 
    
 
     
      [bookmark: pgfId-4214608][bookmark: 75688]SIP Keywords
 
     [bookmark: pgfId-4238836]License: Protection
 
     [bookmark: pgfId-4214623]Four SIP keywords allow you to monitor SIP session traffic for exploits. 
 
     [bookmark: pgfId-4214624]Note that the SIP protocol is vulnerable to denial of service (DoS) attacks. Rules addressing these attacks can benefit from rate-based attack prevention. See Adding Dynamic Rule States and Preventing Rate-Based Attacks for more information.
 
     [bookmark: pgfId-4214631]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4214634]sip_header
 
      	 [bookmark: pgfId-4214638]sip_body
 
      	 [bookmark: pgfId-4214642]sip_method
 
      	 [bookmark: pgfId-4214646]sip_stat_code
 
     
 
    
 
     
      [bookmark: pgfId-4214649][bookmark: 94104]sip_header
 
     [bookmark: pgfId-4238849]License: Protection
 
     [bookmark: pgfId-4214664]You can use the sip_header[bookmark: marker-4215009] keyword to start inspection at the beginning of the extracted SIP request or response header and restrict inspection to header fields.
 
     [bookmark: pgfId-4214668]The sip_header keyword has no arguments. See sip_method and sip_stat_code for more information.
 
     [bookmark: pgfId-4214673]The following example rule fragment points to the SIP header and matches the CSeq header field:
 
      
      [bookmark: pgfId-4214674]alert udp any any -> any 5060 ( sip_header; content:"CSeq"; ) 
     
 
    
 
     
      [bookmark: pgfId-4214680][bookmark: 87084]sip_body
 
     [bookmark: pgfId-4238863]License: Protection
 
     [bookmark: pgfId-4214695]You can use the sip_body[bookmark: marker-4215014] keyword to start inspection at the beginning of the extracted SIP request or response message body and restrict inspection to the message body.
 
     [bookmark: pgfId-4214697]The sip_body keyword has no arguments.
 
     [bookmark: pgfId-4214698]The following example rule fragment points to the SIP message body and matches a specific IP address in the c (connection information) field in extracted SDP data:
 
      
      [bookmark: pgfId-4214699]alert udp any any -> any 5060 ( sip_body; content:"c=IN 192.168.12.14"; ) 
     
 
     [bookmark: pgfId-4214700]Note that rules are not limited to searching for SDP content. The SIP preprocessor extracts the entire message body and makes it available to the rules engine.
 
    
 
     
      [bookmark: pgfId-4214706][bookmark: 23041]sip_method
 
     [bookmark: pgfId-4238877]License: Protection
 
     [bookmark: pgfId-4215031]A method field in each SIP request identifies the purpose of the request. You can use the sip_method[bookmark: marker-4215034] keyword to test SIP requests for specific methods. Separate multiple methods with commas.
 
     [bookmark: pgfId-4214723]You can specify any of the following currently defined SIP methods:
 
      
      [bookmark: pgfId-4385723]ack, benotify, bye, cancel, do, info, invite, join, message, notify, options, prack, publish, quath, refer, register, service, sprack, subscribe, unsubscribe, update 
     
 
     [bookmark: pgfId-4385730]Methods are case-insensitive. You can separate multiple methods with commas.
 
     [bookmark: pgfId-4214726]Because new SIP methods might be defined in the future, you can also specify a custom method, that is, a method that is not a currently defined SIP method. Accepted field values are defined in RFC 2616, which allows all characters except control characters and separators such as =, (, and }. See RFC 2616 for the complete list of excluded separators. When the system encounters a specified custom method in traffic, it will inspect the packet header but not the message.
 
     [bookmark: pgfId-4234019]The system supports up to 32 methods, including the 21 currently defined methods and an additional 11 methods. The system ignores any undefined methods that you might configure. Note that the 32 total methods includes methods specified using the Methods to Check SIP preprocessor option. See Selecting SIP Preprocessor Options for more information.
 
     [bookmark: pgfId-4233966]You can specify only one method when you use negation. For example:
 
      
      [bookmark: pgfId-4214731]!invite 
     
 
     [bookmark: pgfId-4214732]Note, however, that multiple sip_method keywords in a rule are linked with an AND operation. For example, to test for all extracted methods except invite and cancel, you would use two negated sip_method keywords:
 
      
      [bookmark: pgfId-4214733]sip_method: !invite 
     
 
      
      [bookmark: pgfId-4214734]sip_method: !cancel 
     
 
     [bookmark: pgfId-4214741]Cisco recommends that you include at least one content keyword in rules that include the sip_method keyword to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument. See Searching for Content Matches and Use Fast Pattern Matcher for more information.
 
    
 
     
      [bookmark: pgfId-4214750][bookmark: 89845]sip_stat_code
 
     [bookmark: pgfId-4238891]License: Protection
 
     [bookmark: pgfId-4214765]A three-digit status code in each SIP response indicates the outcome of the requested action. You can use the sip_stat_code[bookmark: marker-4215039] keyword to test SIP responses for specific status codes.
 
     [bookmark: pgfId-4214767]You can specify a one-digit response-type number 1-9, a specific three-digit number 100-999, or a comma-separated list of any combination of either. A list matches if any single number in the list matches the code in the SIP response.
 
     [bookmark: pgfId-4214768]The following table describes the SIP status code values you can specify.
 
     [bookmark: pgfId-4214813]
 
      
       
        
        [bookmark: pgfId-4913801]Table 24-40 sip_stat_code Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-4913809]To detect... 
          
  
         	 
           
           [bookmark: pgfId-4913811]Specify... 
          
  
         	 
           
           [bookmark: pgfId-4913813]For example... 
          
  
         	 
           
           [bookmark: pgfId-4913815]Detects... 
          
  
        
 
         
         	[bookmark: pgfId-4913817]a specific status code
  
         	[bookmark: pgfId-4913819]the three-digit status code
  
         	[bookmark: pgfId-4913821]189
  
         	[bookmark: pgfId-4913823]189
  
        
 
         
         	[bookmark: pgfId-4913825]any three-digit code that begins with a specified single digit
  
         	[bookmark: pgfId-4913827]the single digit
  
         	[bookmark: pgfId-4913829]1
  
         	[bookmark: pgfId-4913831]1xx; that is, 100, 101, 102, and so on
  
        
 
         
         	[bookmark: pgfId-4913833]a list of values
  
         	[bookmark: pgfId-4913835]any comma-separated combination of specific codes and single digits
  
         	[bookmark: pgfId-4913837]222, 3
  
         	[bookmark: pgfId-4913839]222 plus 300, 301, 302, and so on
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4214240]Note also that the rules engine does not use the fast pattern matcher to search for the value specify using the sip_stat_code keyword, regardless of whether your rule includes a content keyword.
 
    
 
     
      [bookmark: pgfId-4251886][bookmark: 57773]GTP Keywords
 
     [bookmark: pgfId-4251972]License: Protection
 
     [bookmark: pgfId-4251906]Three GSRP Tunneling Protocol (GTP) keywords allow you to inspect the GTP command channel for GTP version, message type, and information elements. You cannot use GTP keywords in combination with other intrusion rule keywords such as content or byte_jump. You must use the gtp_version keyword in each rule that uses the gtp_info or gtp_type keyword.
 
     [bookmark: pgfId-4252224]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4373018]gtp_version
 
      	 [bookmark: pgfId-4373048]gtp_type
 
      	 [bookmark: pgfId-4373052]gtp_info
 
     
 
    
 
     
      [bookmark: pgfId-4373054][bookmark: 86989]gtp_ver[bookmark: marker-4517609]sion
 
     [bookmark: pgfId-4351680]You can use the gtp_version keyword to inspect GTP control messages for GTP version 0, 1, or 2.
 
     [bookmark: pgfId-4351685]Because different GTP versions define different message types and information elements, you must use this keyword when you use the gtp_type or gtp_info keyword. You can specify the value 0, 1, or 2.
 
     [bookmark: pgfId-4375995]To specify the GTP version:
 
     
 
     [bookmark: pgfId-4375997]Step 1 On the Create Rule page, select gtp_version in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4375998]The gtp_version keyword appears.
 
     [bookmark: pgfId-4376003]Step 2 Specify 0, 1, or 2 to identify the GTP version.
 
     [bookmark: pgfId-4776228]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4352215][bookmark: 25524]gtp_ty[bookmark: marker-4399758]pe
 
     [bookmark: pgfId-4352216]Each GTP message is identified by a message type, which is comprised of both a numeric value and a string. You can use the gtp_type keyword in combination with the gtp_version keyword to inspect traffic for specific GTP message types.
 
     [bookmark: pgfId-4352221]You can specify a defined decimal value for a message type, a defined string, or a comma-separated list of either or both in any combination, as seen in the following example:
 
      
      [bookmark: pgfId-4352225]10, 11, echo_request 
     
 
     [bookmark: pgfId-4352226]The system uses an OR operation to match each value or string that you list. The order in which you list values and strings does not matter. Any single value or string in the list matches the keyword. You receive an error if you attempt to save a rule that includes an unrecognized string or an out-of-range value.
 
     [bookmark: pgfId-4352227]Note in the table that different GTP versions sometimes use different values for the same message type. For example, the sgsn_context_request message type has a value of 50 in GTPv0 and GTPv1, but a value of 130 in GTPv2.
 
     [bookmark: pgfId-4352228]The gtp_type keyword matches different values depending on the version number in the packet. In the example above, the keyword matches the message type value 50 in a GTPv0 or GTPv1 packet and the value 130 in a GTPv2 packet. The keyword does not match a packet when the message type value in the packet is not a known value for the version specified in the packet.
 
     [bookmark: pgfId-4352229]If you specify an integer for the message type, the keyword matches if the message type in the keyword matches the value in the GTP packet, regardless of the version specified in the packet.
 
     [bookmark: pgfId-4353899]The following table lists the defined values and strings recognized by the system for each GTP message type.
 
     [bookmark: pgfId-4645550]
 
      
       
        
        [bookmark: pgfId-4646773]Table 24-41 [bookmark: 69034]GTP Message Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-4646781]Value 
          
  
         	 
           
           [bookmark: pgfId-4646783]Version 0 
          
  
         	 
           
           [bookmark: pgfId-4646785]Version 1 
          
  
         	 
           
           [bookmark: pgfId-4646787]Version 2 
          
  
        
 
         
         	[bookmark: pgfId-4646789]1
  
         	[bookmark: pgfId-4646791]echo_request
  
         	[bookmark: pgfId-4646793]echo_request
  
         	[bookmark: pgfId-4646795]echo_request
  
        
 
         
         	[bookmark: pgfId-4646797]2
  
         	[bookmark: pgfId-4646799]echo_response
  
         	[bookmark: pgfId-4646801]echo_response
  
         	[bookmark: pgfId-4646803]echo_response
  
        
 
         
         	[bookmark: pgfId-4646805]3
  
         	[bookmark: pgfId-4646807]version_not_supported
  
         	[bookmark: pgfId-4646809]version_not_supported
  
         	[bookmark: pgfId-4646811]version_not_supported
  
        
 
         
         	[bookmark: pgfId-4646813]4
  
         	[bookmark: pgfId-4646815]node_alive_request
  
         	[bookmark: pgfId-4646817]node_alive_request
  
         	[bookmark: pgfId-4646819]N/A
  
        
 
         
         	[bookmark: pgfId-4646821]5
  
         	[bookmark: pgfId-4646823]node_alive_response
  
         	[bookmark: pgfId-4646825]node_alive_response
  
         	[bookmark: pgfId-4646827]N/A
  
        
 
         
         	[bookmark: pgfId-4646829]6
  
         	[bookmark: pgfId-4646831]redirection_request
  
         	[bookmark: pgfId-4646833]redirection_request
  
         	[bookmark: pgfId-4646835]N/A
  
        
 
         
         	[bookmark: pgfId-4646837]7
  
         	[bookmark: pgfId-4646839]redirection_response
  
         	[bookmark: pgfId-4646841]redirection_response
  
         	[bookmark: pgfId-4646843]N/A
  
        
 
         
         	[bookmark: pgfId-4646845]16
  
         	[bookmark: pgfId-4646847]create_pdp_context_request
  
         	[bookmark: pgfId-4646849]create_pdp_context_request
  
         	[bookmark: pgfId-4646851]N/A
  
        
 
         
         	[bookmark: pgfId-4646853]17
  
         	[bookmark: pgfId-4646855]create_pdp_context_response
  
         	[bookmark: pgfId-4646857]create_pdp_context_response
  
         	[bookmark: pgfId-4646859]N/A
  
        
 
         
         	[bookmark: pgfId-4646861]18
  
         	[bookmark: pgfId-4646863]update_pdp_context_request
  
         	[bookmark: pgfId-4646865]update_pdp_context_request
  
         	[bookmark: pgfId-4646867]N/A
  
        
 
         
         	[bookmark: pgfId-4646869]19
  
         	[bookmark: pgfId-4646871]update_pdp_context_response
  
         	[bookmark: pgfId-4646873]update_pdp_context_response
  
         	[bookmark: pgfId-4646875]N/A
  
        
 
         
         	[bookmark: pgfId-4646877]20
  
         	[bookmark: pgfId-4646879]delete_pdp_context_request
  
         	[bookmark: pgfId-4646881]delete_pdp_context_request
  
         	[bookmark: pgfId-4646883]N/A
  
        
 
         
         	[bookmark: pgfId-4646885]21
  
         	[bookmark: pgfId-4646887]delete_pdp_context_response
  
         	[bookmark: pgfId-4646889]delete_pdp_context_response
  
         	[bookmark: pgfId-4646891]N/A
  
        
 
         
         	[bookmark: pgfId-4646893]22
  
         	[bookmark: pgfId-4646895]create_aa_pdp_context_request
  
         	[bookmark: pgfId-4646897]init_pdp_context_activation_request
  
         	[bookmark: pgfId-4646899]N/A
  
        
 
         
         	[bookmark: pgfId-4646901]23
  
         	[bookmark: pgfId-4646903]create_aa_pdp_context_response
  
         	[bookmark: pgfId-4646905]init_pdp_context_activation_response
  
         	[bookmark: pgfId-4646907]N/A
  
        
 
         
         	[bookmark: pgfId-4646909]24
  
         	[bookmark: pgfId-4646911]delete_aa_pdp_context_request
  
         	[bookmark: pgfId-4646913]N/A
  
         	[bookmark: pgfId-4646915]N/A
  
        
 
         
         	[bookmark: pgfId-4646917]25
  
         	[bookmark: pgfId-4646919]delete_aa_pdp_context_response
  
         	[bookmark: pgfId-4646921]N/A
  
         	[bookmark: pgfId-4646923]N/A
  
        
 
         
         	[bookmark: pgfId-4646925]26
  
         	[bookmark: pgfId-4646927]error_indication
  
         	[bookmark: pgfId-4646929]error_indication
  
         	[bookmark: pgfId-4646931]N/A
  
        
 
         
         	[bookmark: pgfId-4646933]27
  
         	[bookmark: pgfId-4646935]pdu_notification_request
  
         	[bookmark: pgfId-4646937]pdu_notification_request
  
         	[bookmark: pgfId-4646939]N/A
  
        
 
         
         	[bookmark: pgfId-4646941]28
  
         	[bookmark: pgfId-4646943]pdu_notification_response
  
         	[bookmark: pgfId-4646945]pdu_notification_response
  
         	[bookmark: pgfId-4646947]N/A
  
        
 
         
         	[bookmark: pgfId-4646949]29
  
         	[bookmark: pgfId-4646951]pdu_notification_reject_request
  
         	[bookmark: pgfId-4646953]pdu_notification_reject_request
  
         	[bookmark: pgfId-4646955]N/A
  
        
 
         
         	[bookmark: pgfId-4646957]30
  
         	[bookmark: pgfId-4646959]pdu_notification_reject_response
  
         	[bookmark: pgfId-4646961]pdu_notification_reject_response
  
         	[bookmark: pgfId-4646963]N/A
  
        
 
         
         	[bookmark: pgfId-4646965]31
  
         	[bookmark: pgfId-4646967]N/A
  
         	[bookmark: pgfId-4646969]supported_ext_header_notification
  
         	[bookmark: pgfId-4646971]N/A
  
        
 
         
         	[bookmark: pgfId-4646973]32
  
         	[bookmark: pgfId-4646975]send_routing_info_request
  
         	[bookmark: pgfId-4646977]send_routing_info_request
  
         	[bookmark: pgfId-4646979]create_session_request
  
        
 
         
         	[bookmark: pgfId-4646981]33
  
         	[bookmark: pgfId-4646983]send_routing_info_response
  
         	[bookmark: pgfId-4646985]send_routing_info_response
  
         	[bookmark: pgfId-4646987]create_session_response
  
        
 
         
         	[bookmark: pgfId-4646989]34
  
         	[bookmark: pgfId-4646991]failure_report_request
  
         	[bookmark: pgfId-4646993]failure_report_request
  
         	[bookmark: pgfId-4646995]modify_bearer_request
  
        
 
         
         	[bookmark: pgfId-4646997]35
  
         	[bookmark: pgfId-4646999]failure_report_response
  
         	[bookmark: pgfId-4647001]failure_report_response
  
         	[bookmark: pgfId-4647003]modify_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647005]36
  
         	[bookmark: pgfId-4647007]note_ms_present_request
  
         	[bookmark: pgfId-4647009]note_ms_present_request
  
         	[bookmark: pgfId-4647011]delete_session_request
  
        
 
         
         	[bookmark: pgfId-4647013]37
  
         	[bookmark: pgfId-4647015]note_ms_present_response
  
         	[bookmark: pgfId-4647017]note_ms_present_response
  
         	[bookmark: pgfId-4647019]delete_session_response
  
        
 
         
         	[bookmark: pgfId-4647021]38
  
         	[bookmark: pgfId-4647023]N/A
  
         	[bookmark: pgfId-4647025]N/A
  
         	[bookmark: pgfId-4647027]change_notification_request
  
        
 
         
         	[bookmark: pgfId-4647029]39
  
         	[bookmark: pgfId-4647031]N/A
  
         	[bookmark: pgfId-4647033]N/A
  
         	[bookmark: pgfId-4647035]change_notification_response
  
        
 
         
         	[bookmark: pgfId-4647037]48
  
         	[bookmark: pgfId-4647039]identification_request
  
         	[bookmark: pgfId-4647041]identification_request
  
         	[bookmark: pgfId-4647043]N/A
  
        
 
         
         	[bookmark: pgfId-4647045]49
  
         	[bookmark: pgfId-4647047]identification_response
  
         	[bookmark: pgfId-4647049]identification_response
  
         	[bookmark: pgfId-4647051]N/A
  
        
 
         
         	[bookmark: pgfId-4647053]50
  
         	[bookmark: pgfId-4647055]sgsn_context_request
  
         	[bookmark: pgfId-4647057]sgsn_context_request
  
         	[bookmark: pgfId-4647059]N/A
  
        
 
         
         	[bookmark: pgfId-4647061]51
  
         	[bookmark: pgfId-4647063]sgsn_context_response
  
         	[bookmark: pgfId-4647065]sgsn_context_response
  
         	[bookmark: pgfId-4647067]N/A
  
        
 
         
         	[bookmark: pgfId-4647069]52
  
         	[bookmark: pgfId-4647071]sgsn_context_ack
  
         	[bookmark: pgfId-4647073]sgsn_context_ack
  
         	[bookmark: pgfId-4647075]N/A
  
        
 
         
         	[bookmark: pgfId-4647077]53
  
         	[bookmark: pgfId-4647079]N/A
  
         	[bookmark: pgfId-4647081]forward_relocation_request
  
         	[bookmark: pgfId-4647083]N/A
  
        
 
         
         	[bookmark: pgfId-4647085]54
  
         	[bookmark: pgfId-4647087]N/A
  
         	[bookmark: pgfId-4647089]forward_relocation_response
  
         	[bookmark: pgfId-4647091]N/A
  
        
 
         
         	[bookmark: pgfId-4647093]55
  
         	[bookmark: pgfId-4647095]N/A
  
         	[bookmark: pgfId-4647097]forward_relocation_complete
  
         	[bookmark: pgfId-4647099]N/A
  
        
 
         
         	[bookmark: pgfId-4647101]56
  
         	[bookmark: pgfId-4647103]N/A
  
         	[bookmark: pgfId-4647105]relocation_cancel_request
  
         	[bookmark: pgfId-4647107]N/A
  
        
 
         
         	[bookmark: pgfId-4647109]57
  
         	[bookmark: pgfId-4647111]N/A
  
         	[bookmark: pgfId-4647113]relocation_cancel_response
  
         	[bookmark: pgfId-4647115]N/A
  
        
 
         
         	[bookmark: pgfId-4647117]58
  
         	[bookmark: pgfId-4647119]N/A
  
         	[bookmark: pgfId-4647121]forward_srns_contex
  
         	[bookmark: pgfId-4647123]N/A
  
        
 
         
         	[bookmark: pgfId-4647125]59
  
         	[bookmark: pgfId-4647127]N/A
  
         	[bookmark: pgfId-4647129]forward_relocation_complete_ack
  
         	[bookmark: pgfId-4647131]N/A
  
        
 
         
         	[bookmark: pgfId-4647133]60
  
         	[bookmark: pgfId-4647135]N/A
  
         	[bookmark: pgfId-4647137]forward_srns_contex_ack
  
         	[bookmark: pgfId-4647139]N/A
  
        
 
         
         	[bookmark: pgfId-4647141]64
  
         	[bookmark: pgfId-4647143]N/A
  
         	[bookmark: pgfId-4647145]N/A
  
         	[bookmark: pgfId-4647147]modify_bearer_command
  
        
 
         
         	[bookmark: pgfId-4647149]65
  
         	[bookmark: pgfId-4647151]N/A
  
         	[bookmark: pgfId-4647153]N/A
  
         	[bookmark: pgfId-4647155]modify_bearer_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647157]66
  
         	[bookmark: pgfId-4647159]N/A
  
         	[bookmark: pgfId-4647161]N/A
  
         	[bookmark: pgfId-4647163]delete_bearer_command
  
        
 
         
         	[bookmark: pgfId-4647165]67
  
         	[bookmark: pgfId-4647167]N/A
  
         	[bookmark: pgfId-4647169]N/A
  
         	[bookmark: pgfId-4647171]delete_bearer_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647173]68
  
         	[bookmark: pgfId-4647175]N/A
  
         	[bookmark: pgfId-4647177]N/A
  
         	[bookmark: pgfId-4647179]bearer_resource_command
  
        
 
         
         	[bookmark: pgfId-4647181]69
  
         	[bookmark: pgfId-4647183]N/A
  
         	[bookmark: pgfId-4647185]N/A
  
         	[bookmark: pgfId-4647187]bearer_resource_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647189]70
  
         	[bookmark: pgfId-4647191]N/A
  
         	[bookmark: pgfId-4647193]ran_info_relay
  
         	[bookmark: pgfId-4647195]downlink_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647197]71
  
         	[bookmark: pgfId-4647199]N/A
  
         	[bookmark: pgfId-4647201]N/A
  
         	[bookmark: pgfId-4647203]trace_session_activation
  
        
 
         
         	[bookmark: pgfId-4647205]72
  
         	[bookmark: pgfId-4647207]N/A
  
         	[bookmark: pgfId-4647209]N/A
  
         	[bookmark: pgfId-4647211]trace_session_deactivation
  
        
 
         
         	[bookmark: pgfId-4647213]73
  
         	[bookmark: pgfId-4647215]N/A
  
         	[bookmark: pgfId-4647217]N/A
  
         	[bookmark: pgfId-4647219]stop_paging_indication
  
        
 
         
         	[bookmark: pgfId-4647221]95
  
         	[bookmark: pgfId-4647223]N/A
  
         	[bookmark: pgfId-4647225]N/A
  
         	[bookmark: pgfId-4647227]create_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647229]96
  
         	[bookmark: pgfId-4647231]N/A
  
         	[bookmark: pgfId-4647233]mbms_notification_request
  
         	[bookmark: pgfId-4647235]create_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647237]97
  
         	[bookmark: pgfId-4647239]N/A
  
         	[bookmark: pgfId-4647241]mbms_notification_response
  
         	[bookmark: pgfId-4647243]update_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647245]98
  
         	[bookmark: pgfId-4647247]N/A
  
         	[bookmark: pgfId-4647249]mbms_notification_reject_request
  
         	[bookmark: pgfId-4647251]update_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647253]99
  
         	[bookmark: pgfId-4647255]N/A
  
         	[bookmark: pgfId-4647257]mbms_notification_reject_response
  
         	[bookmark: pgfId-4647259]delete_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647261]100
  
         	[bookmark: pgfId-4647263]N/A
  
         	[bookmark: pgfId-4647265]create_mbms_context_request
  
         	[bookmark: pgfId-4647267]delete_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647269]101
  
         	[bookmark: pgfId-4647271]N/A
  
         	[bookmark: pgfId-4647273]create_mbms_context_response
  
         	[bookmark: pgfId-4647275]delete_pdn_request
  
        
 
         
         	[bookmark: pgfId-4647277]102
  
         	[bookmark: pgfId-4647279]N/A
  
         	[bookmark: pgfId-4647281]update_mbms_context_request
  
         	[bookmark: pgfId-4647283]delete_pdn_response
  
        
 
         
         	[bookmark: pgfId-4647285]103
  
         	[bookmark: pgfId-4647287]N/A
  
         	[bookmark: pgfId-4647289]update_mbms_context_response
  
         	[bookmark: pgfId-4647291]N/A
  
        
 
         
         	[bookmark: pgfId-4647293]104
  
         	[bookmark: pgfId-4647295]N/A
  
         	[bookmark: pgfId-4647297]delete_mbms_context_request
  
         	[bookmark: pgfId-4647299]N/A
  
        
 
         
         	[bookmark: pgfId-4647301]105
  
         	[bookmark: pgfId-4647303]N/A
  
         	[bookmark: pgfId-4647305]delete_mbms_context_response
  
         	[bookmark: pgfId-4647307]N/A
  
        
 
         
         	[bookmark: pgfId-4647309]112
  
         	[bookmark: pgfId-4647311]N/A
  
         	[bookmark: pgfId-4647313]mbms_register_request
  
         	[bookmark: pgfId-4647315]N/A
  
        
 
         
         	[bookmark: pgfId-4647317]113
  
         	[bookmark: pgfId-4647319]N/A
  
         	[bookmark: pgfId-4647321]mbms_register_response
  
         	[bookmark: pgfId-4647323]N/A
  
        
 
         
         	[bookmark: pgfId-4647325]114
  
         	[bookmark: pgfId-4647327]N/A
  
         	[bookmark: pgfId-4647329]mbms_deregister_request
  
         	[bookmark: pgfId-4647331]N/A
  
        
 
         
         	[bookmark: pgfId-4647333]115
  
         	[bookmark: pgfId-4647335]N/A
  
         	[bookmark: pgfId-4647337]mbms_deregister_response
  
         	[bookmark: pgfId-4647339]N/A
  
        
 
         
         	[bookmark: pgfId-4647341]116
  
         	[bookmark: pgfId-4647343]N/A
  
         	[bookmark: pgfId-4647345]mbms_session_start_request
  
         	[bookmark: pgfId-4647347]N/A
  
        
 
         
         	[bookmark: pgfId-4647349]117
  
         	[bookmark: pgfId-4647351]N/A
  
         	[bookmark: pgfId-4647353]mbms_session_start_response
  
         	[bookmark: pgfId-4647355]N/A
  
        
 
         
         	[bookmark: pgfId-4647357]118
  
         	[bookmark: pgfId-4647359]N/A
  
         	[bookmark: pgfId-4647361]mbms_session_stop_request
  
         	[bookmark: pgfId-4647363]N/A
  
        
 
         
         	[bookmark: pgfId-4647365]119
  
         	[bookmark: pgfId-4647367]N/A
  
         	[bookmark: pgfId-4647369]mbms_session_stop_response
  
         	[bookmark: pgfId-4647371]N/A
  
        
 
         
         	[bookmark: pgfId-4647373]120
  
         	[bookmark: pgfId-4647375]N/A
  
         	[bookmark: pgfId-4647377]mbms_session_update_request
  
         	[bookmark: pgfId-4647379]N/A
  
        
 
         
         	[bookmark: pgfId-4647381]121
  
         	[bookmark: pgfId-4647383]N/A
  
         	[bookmark: pgfId-4647385]mbms_session_update_response
  
         	[bookmark: pgfId-4647387]N/A
  
        
 
         
         	[bookmark: pgfId-4647389]128
  
         	[bookmark: pgfId-4647391]N/A
  
         	[bookmark: pgfId-4647393]ms_info_change_request
  
         	[bookmark: pgfId-4647395]identification_request
  
        
 
         
         	[bookmark: pgfId-4647397]129
  
         	[bookmark: pgfId-4647399]N/A
  
         	[bookmark: pgfId-4647401]ms_info_change_response
  
         	[bookmark: pgfId-4647403]identification_response
  
        
 
         
         	[bookmark: pgfId-4647405]130
  
         	[bookmark: pgfId-4647407]N/A
  
         	[bookmark: pgfId-4647409]N/A
  
         	[bookmark: pgfId-4647411]sgsn_context_request
  
        
 
         
         	[bookmark: pgfId-4647413]131
  
         	[bookmark: pgfId-4647415]N/A
  
         	[bookmark: pgfId-4647417]N/A
  
         	[bookmark: pgfId-4647419]sgsn_context_response
  
        
 
         
         	[bookmark: pgfId-4647421]132
  
         	[bookmark: pgfId-4647423]N/A
  
         	[bookmark: pgfId-4647425]N/A
  
         	[bookmark: pgfId-4647427]sgsn_context_ack
  
        
 
         
         	[bookmark: pgfId-4647429]133
  
         	[bookmark: pgfId-4647431]N/A
  
         	[bookmark: pgfId-4647433]N/A
  
         	[bookmark: pgfId-4647435]forward_relocation_request
  
        
 
         
         	[bookmark: pgfId-4647437]134
  
         	[bookmark: pgfId-4647439]N/A
  
         	[bookmark: pgfId-4647441]N/A
  
         	[bookmark: pgfId-4647443]forward_relocation_response
  
        
 
         
         	[bookmark: pgfId-4647445]135
  
         	[bookmark: pgfId-4647447]N/A
  
         	[bookmark: pgfId-4647449]N/A
  
         	[bookmark: pgfId-4647451]forward_relocation_complete
  
        
 
         
         	[bookmark: pgfId-4647453]136
  
         	[bookmark: pgfId-4647455]N/A
  
         	[bookmark: pgfId-4647457]N/A
  
         	[bookmark: pgfId-4647459]forward_relocation_complete_ack
  
        
 
         
         	[bookmark: pgfId-4647461]137
  
         	[bookmark: pgfId-4647463]N/A
  
         	[bookmark: pgfId-4647465]N/A
  
         	[bookmark: pgfId-4647467]forward_access
  
        
 
         
         	[bookmark: pgfId-4647469]138
  
         	[bookmark: pgfId-4647471]N/A
  
         	[bookmark: pgfId-4647473]N/A
  
         	[bookmark: pgfId-4647475]forward_access_ack
  
        
 
         
         	[bookmark: pgfId-4647477]139
  
         	[bookmark: pgfId-4647479]N/A
  
         	[bookmark: pgfId-4647481]N/A
  
         	[bookmark: pgfId-4647483]relocation_cancel_request
  
        
 
         
         	[bookmark: pgfId-4647485]140
  
         	[bookmark: pgfId-4647487]N/A
  
         	[bookmark: pgfId-4647489]N/A
  
         	[bookmark: pgfId-4647491]relocation_cancel_response
  
        
 
         
         	[bookmark: pgfId-4647493]141
  
         	[bookmark: pgfId-4647495]N/A
  
         	[bookmark: pgfId-4647497]N/A
  
         	[bookmark: pgfId-4647499]configuration_transfer_tunnel
  
        
 
         
         	[bookmark: pgfId-4647501]149
  
         	[bookmark: pgfId-4647503]N/A
  
         	[bookmark: pgfId-4647505]N/A
  
         	[bookmark: pgfId-4647507]detach
  
        
 
         
         	[bookmark: pgfId-4647509]150
  
         	[bookmark: pgfId-4647511]N/A
  
         	[bookmark: pgfId-4647513]N/A
  
         	[bookmark: pgfId-4647515]detach_ack
  
        
 
         
         	[bookmark: pgfId-4647517]151
  
         	[bookmark: pgfId-4647519]N/A
  
         	[bookmark: pgfId-4647521]N/A
  
         	[bookmark: pgfId-4647523]cs_paging
  
        
 
         
         	[bookmark: pgfId-4647525]152
  
         	[bookmark: pgfId-4647527]N/A
  
         	[bookmark: pgfId-4647529]N/A
  
         	[bookmark: pgfId-4647531]ran_info_relay
  
        
 
         
         	[bookmark: pgfId-4647533]153
  
         	[bookmark: pgfId-4647535]N/A
  
         	[bookmark: pgfId-4647537]N/A
  
         	[bookmark: pgfId-4647539]alert_mme
  
        
 
         
         	[bookmark: pgfId-4647541]154
  
         	[bookmark: pgfId-4647543]N/A
  
         	[bookmark: pgfId-4647545]N/A
  
         	[bookmark: pgfId-4647547]alert_mme_ack
  
        
 
         
         	[bookmark: pgfId-4647549]155
  
         	[bookmark: pgfId-4647551]N/A
  
         	[bookmark: pgfId-4647553]N/A
  
         	[bookmark: pgfId-4647555]ue_activity
  
        
 
         
         	[bookmark: pgfId-4647557]156
  
         	[bookmark: pgfId-4647559]N/A
  
         	[bookmark: pgfId-4647561]N/A
  
         	[bookmark: pgfId-4647563]ue_activity_ack
  
        
 
         
         	[bookmark: pgfId-4647565]160
  
         	[bookmark: pgfId-4647567]N/A
  
         	[bookmark: pgfId-4647569]N/A
  
         	[bookmark: pgfId-4647571]create_forward_tunnel_request
  
        
 
         
         	[bookmark: pgfId-4647573]161
  
         	[bookmark: pgfId-4647575]N/A
  
         	[bookmark: pgfId-4647577]N/A
  
         	[bookmark: pgfId-4647579]create_forward_tunnel_response
  
        
 
         
         	[bookmark: pgfId-4647581]162
  
         	[bookmark: pgfId-4647583]N/A
  
         	[bookmark: pgfId-4647585]N/A
  
         	[bookmark: pgfId-4647587]suspend
  
        
 
         
         	[bookmark: pgfId-4647589]163
  
         	[bookmark: pgfId-4647591]N/A
  
         	[bookmark: pgfId-4647593]N/A
  
         	[bookmark: pgfId-4647595]suspend_ack
  
        
 
         
         	[bookmark: pgfId-4647597]164
  
         	[bookmark: pgfId-4647599]N/A
  
         	[bookmark: pgfId-4647601]N/A
  
         	[bookmark: pgfId-4647603]resume
  
        
 
         
         	[bookmark: pgfId-4647605]165
  
         	[bookmark: pgfId-4647607]N/A
  
         	[bookmark: pgfId-4647609]N/A
  
         	[bookmark: pgfId-4647611]resume_ack
  
        
 
         
         	[bookmark: pgfId-4647613]166
  
         	[bookmark: pgfId-4647615]N/A
  
         	[bookmark: pgfId-4647617]N/A
  
         	[bookmark: pgfId-4647619]create_indirect_forward_tunnel_request
  
        
 
         
         	[bookmark: pgfId-4647621]167
  
         	[bookmark: pgfId-4647623]N/A
  
         	[bookmark: pgfId-4647625]N/A
  
         	[bookmark: pgfId-4647627]create_indirect_forward_tunnel_response
  
        
 
         
         	[bookmark: pgfId-4647629]168
  
         	[bookmark: pgfId-4647631]N/A
  
         	[bookmark: pgfId-4647633]N/A
  
         	[bookmark: pgfId-4647635]delete_indirect_forward_tunnel_request
  
        
 
         
         	[bookmark: pgfId-4647637]169
  
         	[bookmark: pgfId-4647639]N/A
  
         	[bookmark: pgfId-4647641]N/A
  
         	[bookmark: pgfId-4647643]delete_indirect_forward_tunnel_response
  
        
 
         
         	[bookmark: pgfId-4647645]170
  
         	[bookmark: pgfId-4647647]N/A
  
         	[bookmark: pgfId-4647649]N/A
  
         	[bookmark: pgfId-4647651]release_access_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647653]171
  
         	[bookmark: pgfId-4647655]N/A
  
         	[bookmark: pgfId-4647657]N/A
  
         	[bookmark: pgfId-4647659]release_access_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647661]176
  
         	[bookmark: pgfId-4647663]N/A
  
         	[bookmark: pgfId-4647665]N/A
  
         	[bookmark: pgfId-4647667]downlink_data
  
        
 
         
         	[bookmark: pgfId-4647669]177
  
         	[bookmark: pgfId-4647671]N/A
  
         	[bookmark: pgfId-4647673]N/A
  
         	[bookmark: pgfId-4647675]downlink_data_ack
  
        
 
         
         	[bookmark: pgfId-4647677]179
  
         	[bookmark: pgfId-4647679]N/A
  
         	[bookmark: pgfId-4647681]N/A
  
         	[bookmark: pgfId-4647683]pgw_restart
  
        
 
         
         	[bookmark: pgfId-4647685]180
  
         	[bookmark: pgfId-4647687]N/A
  
         	[bookmark: pgfId-4647689]N/A
  
         	[bookmark: pgfId-4647691]pgw_restart_ack
  
        
 
         
         	[bookmark: pgfId-4647693]200
  
         	[bookmark: pgfId-4647695]N/A
  
         	[bookmark: pgfId-4647697]N/A
  
         	[bookmark: pgfId-4647699]update_pdn_request
  
        
 
         
         	[bookmark: pgfId-4647701]201
  
         	[bookmark: pgfId-4647703]N/A
  
         	[bookmark: pgfId-4647705]N/A
  
         	[bookmark: pgfId-4647707]update_pdn_response
  
        
 
         
         	[bookmark: pgfId-4647709]211
  
         	[bookmark: pgfId-4647711]N/A
  
         	[bookmark: pgfId-4647713]N/A
  
         	[bookmark: pgfId-4647715]modify_access_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647717]212
  
         	[bookmark: pgfId-4647719]N/A
  
         	[bookmark: pgfId-4647721]N/A
  
         	[bookmark: pgfId-4647723]modify_access_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647725]231
  
         	[bookmark: pgfId-4647727]N/A
  
         	[bookmark: pgfId-4647729]N/A
  
         	[bookmark: pgfId-4647731]mbms_session_start_request
  
        
 
         
         	[bookmark: pgfId-4647733]232
  
         	[bookmark: pgfId-4647735]N/A
  
         	[bookmark: pgfId-4647737]N/A
  
         	[bookmark: pgfId-4647739]mbms_session_start_response
  
        
 
         
         	[bookmark: pgfId-4647741]233
  
         	[bookmark: pgfId-4647743]N/A
  
         	[bookmark: pgfId-4647745]N/A
  
         	[bookmark: pgfId-4647747]mbms_session_update_request
  
        
 
         
         	[bookmark: pgfId-4647749]234
  
         	[bookmark: pgfId-4647751]N/A
  
         	[bookmark: pgfId-4647753]N/A
  
         	[bookmark: pgfId-4647755]mbms_session_update_response
  
        
 
         
         	[bookmark: pgfId-4647757]235
  
         	[bookmark: pgfId-4647759]N/A
  
         	[bookmark: pgfId-4647761]N/A
  
         	[bookmark: pgfId-4647763]mbms_session_stop_request
  
        
 
         
         	[bookmark: pgfId-4647765]236
  
         	[bookmark: pgfId-4647767]N/A
  
         	[bookmark: pgfId-4647769]N/A
  
         	[bookmark: pgfId-4647771]mbms_session_stop_response
  
        
 
         
         	[bookmark: pgfId-4647773]240
  
         	[bookmark: pgfId-4647775]data_record_transfer_request
  
         	[bookmark: pgfId-4647777]data_record_transfer_request
  
         	[bookmark: pgfId-4647779]N/A
  
        
 
         
         	[bookmark: pgfId-4647781]241
  
         	[bookmark: pgfId-4647783]data_record_transfer_response
  
         	[bookmark: pgfId-4647785]data_record_transfer_response
  
         	[bookmark: pgfId-4647787]N/A
  
        
 
         
         	[bookmark: pgfId-4647789]254
  
         	[bookmark: pgfId-4647791]N/A
  
         	[bookmark: pgfId-4647793]end_marker
  
         	[bookmark: pgfId-4647795]N/A
  
        
 
         
         	[bookmark: pgfId-4647797]255
  
         	[bookmark: pgfId-4647799]pdu
  
         	[bookmark: pgfId-4647801]pdu
  
         	[bookmark: pgfId-4647803]N/A
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4646588]To specify GTP message types:
 
     
 
     [bookmark: pgfId-4376054]Step 1 On the Create Rule page, select gtp_type in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4376055]The gtp_type keyword appears.
 
     [bookmark: pgfId-4376060]Step 2 Specify a defined decimal value 0 to 255 for the message type, a defined string, or a comma-separated list of either or both in any combination. See the GTP Message Types table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776399]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4375945][bookmark: 93598]gtp_in[bookmark: marker-4399764]fo
 
     [bookmark: pgfId-4375946]A GTP message can include multiple information elements, each of which is identified by both a defined numeric value and a defined string. You can use the gtp_info keyword in combination with the gtp_version keyword to start inspection at the beginning of a specified information element and restrict inspection to the specified information element.
 
     [bookmark: pgfId-4351156]You can specify either the defined decimal value or the defined string for an information element. You can specify a single value or string, and you can use multiple gtp_info keywords in a rule to inspect multiple information elements.
 
     [bookmark: pgfId-4349466]When a message includes multiple information elements of the same type, all are inspected for a match. When information elements occur in an invalid order, only the last instance is inspected.
 
     [bookmark: pgfId-4349880]Note that different GTP versions sometimes use different values for the same information element. For example, the cause information element has a value of 1 in GTPv0 and GTPv1, but a value of 2 in GTPv2.
 
     [bookmark: pgfId-4350347]The gtp_info keyword matches different values depending on the version number in the packet. In the example above, the keyword matches the information element value 1 in a GTPv0 or GTPv1 packet and the value 2 in a GTPv2 packet. The keyword does not match a packet when the information element value in the packet is not a known value for the version specified in the packet.
 
     [bookmark: pgfId-4350853]If you specify an integer for the information element, the keyword matches if the message type in the keyword matches the value in the GTP packet, regardless of the version specified in the packet.
 
      
       
        
        [bookmark: pgfId-4341076]Table 24-42 [bookmark: 23757]GTP Information Elements 
 
        
        
         
         	 
           
           [bookmark: pgfId-4341084]Value 
          
  
         	 
           
           [bookmark: pgfId-4341086]Version 0 
          
  
         	 
           
           [bookmark: pgfId-4341088]Version 1 
          
  
         	 
           
           [bookmark: pgfId-4341090]Version 2 
          
  
        
 
         
         	[bookmark: pgfId-4341092]1
  
         	[bookmark: pgfId-4341094]cause
  
         	[bookmark: pgfId-4341096]cause
  
         	[bookmark: pgfId-4341098]imsi
  
        
 
         
         	[bookmark: pgfId-4341100]2
  
         	[bookmark: pgfId-4341102]imsi
  
         	[bookmark: pgfId-4341104]imsi
  
         	[bookmark: pgfId-4341106]cause
  
        
 
         
         	[bookmark: pgfId-4341108]3
  
         	[bookmark: pgfId-4341110]rai
  
         	[bookmark: pgfId-4341112]rai
  
         	[bookmark: pgfId-4341114]recovery
  
        
 
         
         	[bookmark: pgfId-4341116]4
  
         	[bookmark: pgfId-4341118]tlli
  
         	[bookmark: pgfId-4341120]tlli
  
         	[bookmark: pgfId-4341122]N/A
  
        
 
         
         	[bookmark: pgfId-4341124]5
  
         	[bookmark: pgfId-4341126]p_tmsi
  
         	[bookmark: pgfId-4341128]p_tmsi
  
         	[bookmark: pgfId-4341130]N/A
  
        
 
         
         	[bookmark: pgfId-4341132]6
  
         	[bookmark: pgfId-4341134]qos 
  
         	[bookmark: pgfId-4341136]N/A
  
         	[bookmark: pgfId-4341138]N/A
  
        
 
         
         	[bookmark: pgfId-4341140]8
  
         	[bookmark: pgfId-4341142]recording_required
  
         	[bookmark: pgfId-4341144]recording_required
  
         	[bookmark: pgfId-4341146]N/A
  
        
 
         
         	[bookmark: pgfId-4341148]9
  
         	[bookmark: pgfId-4341150]authentication
  
         	[bookmark: pgfId-4341152]authentication
  
         	[bookmark: pgfId-4341154]N/A
  
        
 
         
         	[bookmark: pgfId-4341156]11
  
         	[bookmark: pgfId-4341158]map_cause
  
         	[bookmark: pgfId-4341160]map_cause
  
         	[bookmark: pgfId-4341162]N/A
  
        
 
         
         	[bookmark: pgfId-4341164]12
  
         	[bookmark: pgfId-4341166]p_tmsi_sig
  
         	[bookmark: pgfId-4341168]p_tmsi_sig
  
         	[bookmark: pgfId-4341170]N/A
  
        
 
         
         	[bookmark: pgfId-4341172]13
  
         	[bookmark: pgfId-4341174]ms_validated
  
         	[bookmark: pgfId-4341176]ms_validated
  
         	[bookmark: pgfId-4341178]N/A
  
        
 
         
         	[bookmark: pgfId-4341180]14
  
         	[bookmark: pgfId-4341182]recovery
  
         	[bookmark: pgfId-4341184]recovery
  
         	[bookmark: pgfId-4341186]N/A
  
        
 
         
         	[bookmark: pgfId-4341188]15
  
         	[bookmark: pgfId-4341190]selection_mode
  
         	[bookmark: pgfId-4341192]selection_mode
  
         	[bookmark: pgfId-4341194]N/A
  
        
 
         
         	[bookmark: pgfId-4341196]16
  
         	[bookmark: pgfId-4341198] flow_label_data_1
  
         	[bookmark: pgfId-4341200]teid_1
  
         	[bookmark: pgfId-4341202]N/A
  
        
 
         
         	[bookmark: pgfId-4341204]17
  
         	[bookmark: pgfId-4341206] flow_label_signalling
  
         	[bookmark: pgfId-4341208]teid_control
  
         	[bookmark: pgfId-4341210]N/A
  
        
 
         
         	[bookmark: pgfId-4341212]18
  
         	[bookmark: pgfId-4341214] flow_label_data_2
  
         	[bookmark: pgfId-4341216]teid_2
  
         	[bookmark: pgfId-4341218]N/A
  
        
 
         
         	[bookmark: pgfId-4341220]19
  
         	[bookmark: pgfId-4341222] ms_unreachable
  
         	[bookmark: pgfId-4341224]teardown_ind
  
         	[bookmark: pgfId-4341226]N/A
  
        
 
         
         	[bookmark: pgfId-4341228]20
  
         	[bookmark: pgfId-4341230]N/A
  
         	[bookmark: pgfId-4341232]nsapi
  
         	[bookmark: pgfId-4341234]N/A
  
        
 
         
         	[bookmark: pgfId-4341236]21
  
         	[bookmark: pgfId-4341238]N/A
  
         	[bookmark: pgfId-4341240]ranap
  
         	[bookmark: pgfId-4341242]N/A
  
        
 
         
         	[bookmark: pgfId-4341244]22
  
         	[bookmark: pgfId-4341246]N/A
  
         	[bookmark: pgfId-4341248]rab_context
  
         	[bookmark: pgfId-4341250]N/A
  
        
 
         
         	[bookmark: pgfId-4341252]23
  
         	[bookmark: pgfId-4341254]N/A
  
         	[bookmark: pgfId-4341256]radio_priority_sms
  
         	[bookmark: pgfId-4341258]N/A
  
        
 
         
         	[bookmark: pgfId-4341260]24
  
         	[bookmark: pgfId-4341262]N/A
  
         	[bookmark: pgfId-4341264]radio_priority
  
         	[bookmark: pgfId-4341266]N/A
  
        
 
         
         	[bookmark: pgfId-4341268]25
  
         	[bookmark: pgfId-4341270]N/A
  
         	[bookmark: pgfId-4341272]packet_flow_id
  
         	[bookmark: pgfId-4341274]N/A
  
        
 
         
         	[bookmark: pgfId-4341276]26
  
         	[bookmark: pgfId-4341278]N/A
  
         	[bookmark: pgfId-4341280]charging_char
  
         	[bookmark: pgfId-4341282]N/A
  
        
 
         
         	[bookmark: pgfId-4341284]27
  
         	[bookmark: pgfId-4341286]N/A
  
         	[bookmark: pgfId-4341288]trace_ref
  
         	[bookmark: pgfId-4341290]N/A
  
        
 
         
         	[bookmark: pgfId-4341292]28
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         	[bookmark: pgfId-4342060]168
  
         	[bookmark: pgfId-4342516]N/A
  
         	[bookmark: pgfId-4342064]mbms_session_duration
  
         	[bookmark: pgfId-4342532]N/A
  
        
 
         
         	[bookmark: pgfId-4342068]169
  
         	[bookmark: pgfId-4342518]N/A
  
         	[bookmark: pgfId-4342072]addi_mbms_trace_info
  
         	[bookmark: pgfId-4342534]N/A
  
        
 
         
         	[bookmark: pgfId-4342076]170
  
         	[bookmark: pgfId-4342520]N/A
  
         	[bookmark: pgfId-4342080]mbms_session_repetition_num
  
         	[bookmark: pgfId-4342536]N/A
  
        
 
         
         	[bookmark: pgfId-4342084]171
  
         	[bookmark: pgfId-4342522]N/A
  
         	[bookmark: pgfId-4342088]mbms_time_to_data
  
         	[bookmark: pgfId-4342538]N/A
  
        
 
         
         	[bookmark: pgfId-4342092]173
  
         	[bookmark: pgfId-4342524]N/A
  
         	[bookmark: pgfId-4342096]bss
  
         	[bookmark: pgfId-4342540]N/A
  
        
 
         
         	[bookmark: pgfId-4342100]174
  
         	[bookmark: pgfId-4342526]N/A
  
         	[bookmark: pgfId-4342104]cell_id
  
         	[bookmark: pgfId-4342542]N/A
  
        
 
         
         	[bookmark: pgfId-4342108]175
  
         	[bookmark: pgfId-4342544]N/A
  
         	[bookmark: pgfId-4342112]pdu_num
  
         	[bookmark: pgfId-4342576]N/A
  
        
 
         
         	[bookmark: pgfId-4342416]177
  
         	[bookmark: pgfId-4342546]N/A
  
         	[bookmark: pgfId-4342120]mbms_bearer_capab
  
         	[bookmark: pgfId-4342578]N/A
  
        
 
         
         	[bookmark: pgfId-4342418]178
  
         	[bookmark: pgfId-4342548]N/A
  
         	[bookmark: pgfId-4342128]rim_routing_disc
  
         	[bookmark: pgfId-4342580]N/A
  
        
 
         
         	[bookmark: pgfId-4342420]179
  
         	[bookmark: pgfId-4342550]N/A
  
         	[bookmark: pgfId-4342136]list_pfc 
  
         	[bookmark: pgfId-4342582]N/A
  
        
 
         
         	[bookmark: pgfId-4342422]180
  
         	[bookmark: pgfId-4342552]N/A
  
         	[bookmark: pgfId-4342144]ps_xid 
  
         	[bookmark: pgfId-4342584]N/A
  
        
 
         
         	[bookmark: pgfId-4342424]181
  
         	[bookmark: pgfId-4342554]N/A
  
         	[bookmark: pgfId-4342152]ms_info_change_report 
  
         	[bookmark: pgfId-4342586]N/A
  
        
 
         
         	[bookmark: pgfId-4342426]182
  
         	[bookmark: pgfId-4342556]N/A
  
         	[bookmark: pgfId-4342160]direct_tunnel_flags 
  
         	[bookmark: pgfId-4342588]N/A
  
        
 
         
         	[bookmark: pgfId-4342428]183
  
         	[bookmark: pgfId-4342558]N/A
  
         	[bookmark: pgfId-4342168]correlation_id 
  
         	[bookmark: pgfId-4342590]N/A
  
        
 
         
         	[bookmark: pgfId-4342430]184
  
         	[bookmark: pgfId-4342560]N/A
  
         	[bookmark: pgfId-4342176]bearer_control_mode 
  
         	[bookmark: pgfId-4342592]N/A
  
        
 
         
         	[bookmark: pgfId-4342432]185
  
         	[bookmark: pgfId-4342562]N/A
  
         	[bookmark: pgfId-4342184]mbms_flow_id 
  
         	[bookmark: pgfId-4342594]N/A
  
        
 
         
         	[bookmark: pgfId-4342434]186
  
         	[bookmark: pgfId-4342564]N/A
  
         	[bookmark: pgfId-4342192]mbms_ip_multicast 
  
         	[bookmark: pgfId-4342596]N/A
  
        
 
         
         	[bookmark: pgfId-4342196]187
  
         	[bookmark: pgfId-4342566]N/A
  
         	[bookmark: pgfId-4342200]mbms_distribution_ack 
  
         	[bookmark: pgfId-4342598]N/A
  
        
 
         
         	[bookmark: pgfId-4342204]188
  
         	[bookmark: pgfId-4342568]N/A
  
         	[bookmark: pgfId-4342208]reliable_inter_rat_handover 
  
         	[bookmark: pgfId-4342600]N/A
  
        
 
         
         	[bookmark: pgfId-4342212]189
  
         	[bookmark: pgfId-4342570]N/A
  
         	[bookmark: pgfId-4342216]rfsp_index 
  
         	[bookmark: pgfId-4342602]N/A
  
        
 
         
         	[bookmark: pgfId-4342220]190
  
         	[bookmark: pgfId-4342572]N/A
  
         	[bookmark: pgfId-4342224]fqdn 
  
         	[bookmark: pgfId-4342604]N/A
  
        
 
         
         	[bookmark: pgfId-4342228]191
  
         	[bookmark: pgfId-4342574]N/A
  
         	[bookmark: pgfId-4342232]evolved_allocation1 
  
         	[bookmark: pgfId-4342606]N/A
  
        
 
         
         	[bookmark: pgfId-4342236]192
  
         	[bookmark: pgfId-4342608]N/A
  
         	[bookmark: pgfId-4342240]evolved_allocation2 
  
         	[bookmark: pgfId-4342620]N/A
  
        
 
         
         	[bookmark: pgfId-4342244]193
  
         	[bookmark: pgfId-4342610]N/A
  
         	[bookmark: pgfId-4342248]extended_flags 
  
         	[bookmark: pgfId-4342622]N/A
  
        
 
         
         	[bookmark: pgfId-4342252]194
  
         	[bookmark: pgfId-4342612]N/A
  
         	[bookmark: pgfId-4342256]uci 
  
         	[bookmark: pgfId-4342624]N/A
  
        
 
         
         	[bookmark: pgfId-4342260]195
  
         	[bookmark: pgfId-4342614]N/A
  
         	[bookmark: pgfId-4342264]csg_info 
  
         	[bookmark: pgfId-4342626]N/A
  
        
 
         
         	[bookmark: pgfId-4342268]196
  
         	[bookmark: pgfId-4342616]N/A
  
         	[bookmark: pgfId-4342272]csg_id 
  
         	[bookmark: pgfId-4342628]N/A
  
        
 
         
         	[bookmark: pgfId-4342276]197
  
         	[bookmark: pgfId-4342618]N/A
  
         	[bookmark: pgfId-4342280]cmi 
  
         	[bookmark: pgfId-4342630]N/A
  
        
 
         
         	[bookmark: pgfId-4342284]198
  
         	[bookmark: pgfId-4342632]N/A
  
         	[bookmark: pgfId-4342288]apn_ambr 
  
         	[bookmark: pgfId-4342650]N/A
  
        
 
         
         	[bookmark: pgfId-4342292]199
  
         	[bookmark: pgfId-4342634]N/A
  
         	[bookmark: pgfId-4342296]ue_network 
  
         	[bookmark: pgfId-4342652]N/A
  
        
 
         
         	[bookmark: pgfId-4342300]200
  
         	[bookmark: pgfId-4342636]N/A
  
         	[bookmark: pgfId-4342304]ue_ambr 
  
         	[bookmark: pgfId-4342654]N/A
  
        
 
         
         	[bookmark: pgfId-4342308]201
  
         	[bookmark: pgfId-4342638]N/A
  
         	[bookmark: pgfId-4342312]apn_ambr_nsapi
  
         	[bookmark: pgfId-4342656]N/A
  
        
 
         
         	[bookmark: pgfId-4342316]202
  
         	[bookmark: pgfId-4342640]N/A
  
         	[bookmark: pgfId-4342320]ggsn_backoff_timer
  
         	[bookmark: pgfId-4342658]N/A
  
        
 
         
         	[bookmark: pgfId-4342324]203
  
         	[bookmark: pgfId-4342642]N/A
  
         	[bookmark: pgfId-4342328]signalling_priority_indication
  
         	[bookmark: pgfId-4342660]N/A
  
        
 
         
         	[bookmark: pgfId-4342332]204
  
         	[bookmark: pgfId-4342644]N/A
  
         	[bookmark: pgfId-4342336]signalling_priority_indication_nsapi
  
         	[bookmark: pgfId-4342662]N/A
  
        
 
         
         	[bookmark: pgfId-4342340]205
  
         	[bookmark: pgfId-4342646]N/A
  
         	[bookmark: pgfId-4342344]high_bitrate 
  
         	[bookmark: pgfId-4342664]N/A
  
        
 
         
         	[bookmark: pgfId-4342348]206
  
         	[bookmark: pgfId-4342648]N/A
  
         	[bookmark: pgfId-4342352]max_mbr 
  
         	[bookmark: pgfId-4342666]N/A
  
        
 
         
         	[bookmark: pgfId-4342356]251
  
         	[bookmark: pgfId-4342358]charging_gateway_addr
  
         	[bookmark: pgfId-4342360]charging_gateway_addr
  
         	[bookmark: pgfId-4342668]N/A
  
        
 
         
         	[bookmark: pgfId-4342364]255
  
         	[bookmark: pgfId-4342366]private_extension
  
         	[bookmark: pgfId-4342368]private_extension
  
         	[bookmark: pgfId-4342370]private_extension
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4376148]You can use the following procedure to specify a GTP information element.
 
     [bookmark: pgfId-4378087]To specify a GTP information element:
 
     
 
     [bookmark: pgfId-4376150]Step 1 On the Create Rule page, select gtp_info in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4376151]The gtp_info keyword appears.
 
     [bookmark: pgfId-4376156]Step 2 Specify a single defined decimal value 0 to 255 for the information element, or a single defined string. See the GTP Information Elements table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776405]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2626610][bookmark: 22710]Modbus Keywords
 
     [bookmark: pgfId-4360220]License: Protection
 
     [bookmark: pgfId-4367516]You can use Modbus keywords to point to the beginning of the Data field in a Modbus request or response, to match against the Modbus Function Code, and to match against a Modbus Unit ID. You can use Modbus keywords alone or in combination with other keywords such as content and byte_jump.
 
     [bookmark: pgfId-4360859]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4360866]modbus_data
 
      	 [bookmark: pgfId-4360873]modbus_func
 
      	 [bookmark: pgfId-4360880]modbus_unit
 
     
 
    
 
     
      [bookmark: pgfId-4362792][bookmark: 24949]modb[bookmark: marker-4399771]us_data
 
     [bookmark: pgfId-4362793]You can use the modbus_data keyword to point to the beginning of the Data field in a Modbus request or response.
 
     [bookmark: pgfId-4363451]To point to the beginning of the Modbus Data field:
 
     
 
     [bookmark: pgfId-4363453]Step 1 On the Create Rule page, select modbus_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4363454]The modbus_data keyword appears.
 
     [bookmark: pgfId-4363459]The modbus_data keyword has no arguments.
 
     [bookmark: pgfId-4776420]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360420][bookmark: 60489]modb[bookmark: marker-4399776]us_func
 
     [bookmark: pgfId-4360422]You can use the modbus_func keyword to match against the Function Code field in a Modbus application layer request or response header. You can specify either a single defined decimal value or a single defined string for a Modbus function code.
 
     [bookmark: pgfId-4381063]The following table lists the defined values and strings recognized by the system for Modbus function codes.
 
     [bookmark: pgfId-4380199]
 
      
       
        
        [bookmark: pgfId-4380394]Table 24-43 [bookmark: 68960]Modbus Function Codes 
 
        
        
         
         	 
           
           [bookmark: pgfId-4380398]Value 
          
  
         	 
           
           [bookmark: pgfId-4380400]String 
          
  
        
 
         
         	[bookmark: pgfId-4380402]1
  
         	[bookmark: pgfId-4380404]read_coils
  
        
 
         
         	[bookmark: pgfId-4380406]2
  
         	[bookmark: pgfId-4380408]read_discrete_inputs
  
        
 
         
         	[bookmark: pgfId-4380410]3
  
         	[bookmark: pgfId-4380412]read_holding_registers
  
        
 
         
         	[bookmark: pgfId-4380414]4
  
         	[bookmark: pgfId-4380416]read_input_registers
  
        
 
         
         	[bookmark: pgfId-4380418]5
  
         	[bookmark: pgfId-4380420]write_single_coil
  
        
 
         
         	[bookmark: pgfId-4380422]6
  
         	[bookmark: pgfId-4380424]write_single_register
  
        
 
         
         	[bookmark: pgfId-4380426]7
  
         	[bookmark: pgfId-4380428]read_exception_status
  
        
 
         
         	[bookmark: pgfId-4380430]8
  
         	[bookmark: pgfId-4380432]diagnostics
  
        
 
         
         	[bookmark: pgfId-4380434]11
  
         	[bookmark: pgfId-4380436]get_comm_event_counter
  
        
 
         
         	[bookmark: pgfId-4380438]12
  
         	[bookmark: pgfId-4380440]get_comm_event_log
  
        
 
         
         	[bookmark: pgfId-4380442]15
  
         	[bookmark: pgfId-4380444]write_multiple_coils
  
        
 
         
         	[bookmark: pgfId-4380446]16
  
         	[bookmark: pgfId-4380448]write_multiple_registers
  
        
 
         
         	[bookmark: pgfId-4380450]17
  
         	[bookmark: pgfId-4380452]report_slave_id
  
        
 
         
         	[bookmark: pgfId-4380454]20
  
         	[bookmark: pgfId-4380456]read_file_record
  
        
 
         
         	[bookmark: pgfId-4380458]21
  
         	[bookmark: pgfId-4380460]write_file_record
  
        
 
         
         	[bookmark: pgfId-4380462]22
  
         	[bookmark: pgfId-4380464]mask_write_register
  
        
 
         
         	[bookmark: pgfId-4380466]23
  
         	[bookmark: pgfId-4380468]read_write_multiple_registers
  
        
 
         
         	[bookmark: pgfId-4380470]24
  
         	[bookmark: pgfId-4380472]read_fifo_queue
  
        
 
         
         	[bookmark: pgfId-4380474]43
  
         	[bookmark: pgfId-4380476]encapsulated_interface_transport
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4366152]To specify a Modbus function code:
 
     
 
     [bookmark: pgfId-4363956]Step 1 On the Create Rule page, select modbus_func in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4363957]The modbus_func keyword appears.
 
     [bookmark: pgfId-4380083]Step 2 Specify a single defined decimal value 0 to 255 for the function code, or a single defined string. See the Modbus Function Codes table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776426]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4363862][bookmark: 90813]mod[bookmark: marker-4399784]bus_unit
 
     [bookmark: pgfId-4360452]You can use the modbus_unit keyword to match a single decimal value against the Unit ID field in a Modbus request or response header.
 
     [bookmark: pgfId-4364117]To specify a Modbus unit ID:
 
     
 
     [bookmark: pgfId-4364119]Step 1 On the Create Rule page, select modbus_unit in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4364120]The modbus_unit keyword appears.
 
     [bookmark: pgfId-4364125]Step 2 Specify a decimal value 0 through 255.
 
     [bookmark: pgfId-4776443]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360327][bookmark: 69807]DNP3 Keywords
 
     [bookmark: pgfId-4438725]License: Protection
 
     [bookmark: pgfId-4367609]You can use DNP3 keywords to point to the beginning of application layer fragments, to match against DNP3 function codes and objects in DNP3 responses and requests, and to match against internal indication flags in DNP3 responses. You can use DNP3 keywords alone or in combination with other keywords such as content and byte_jump.
 
     [bookmark: pgfId-4367610]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4367614]dnp3_data
 
      	 [bookmark: pgfId-4367618]dnp3_func
 
      	 [bookmark: pgfId-4367655]dnp3_ind
 
      	 [bookmark: pgfId-4367622]dnp3_obj
 
     
 
    
 
     
      [bookmark: pgfId-4365658][bookmark: 10691]dnp3_[bookmark: marker-4517645]data
 
     [bookmark: pgfId-4365659]You can use the dnp3_data keyword to point to the beginning of reassembled DNP3 application layer fragments.
 
     [bookmark: pgfId-4367767]The DNP3 preprocessor reassembles link layer frames into application layer fragments. The dnp3_data keyword points to the beginning of each application layer fragment; other rule options can match against the reassembled data within fragments without separating the data and adding checksums every 16 bytes.
 
     [bookmark: pgfId-4379292]To point to the beginning of reassembled DNP3 fragments:
 
     
 
     [bookmark: pgfId-4379294]Step 1 On the Create Rule page, select modbus_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4379295]The dnp3_data keyword appears.
 
     [bookmark: pgfId-4379300]The dnp3_data keyword has no arguments.
 
     [bookmark: pgfId-4776449]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360920][bookmark: 91334]dnp3_f[bookmark: marker-4517653]unc
 
     [bookmark: pgfId-4360599]You can use the dnp3_func keyword to match against the Function Code field in a DNP3 application layer request or response header. You can specify either a single defined decimal value or a single defined string for a DNP3 function code.
 
     [bookmark: pgfId-4381690]The following table lists the defined values and strings recognized by the system for DNP3 function codes.
 
     [bookmark: pgfId-4381545]
 
      
       
        
        [bookmark: pgfId-4524732]Table 24-44 [bookmark: 71500]DNP3 Function Codes 
 
        
        
         
         	 
           
           [bookmark: pgfId-4524736]Value 
          
  
         	 
           
           [bookmark: pgfId-4524738]String 
          
  
        
 
         
         	[bookmark: pgfId-4524740]0
  
         	[bookmark: pgfId-4524742]confirm
  
        
 
         
         	[bookmark: pgfId-4524744]1
  
         	[bookmark: pgfId-4524746]read
  
        
 
         
         	[bookmark: pgfId-4524748]2
  
         	[bookmark: pgfId-4524750]write
  
        
 
         
         	[bookmark: pgfId-4524752]3
  
         	[bookmark: pgfId-4524754]select
  
        
 
         
         	[bookmark: pgfId-4524756]4
  
         	[bookmark: pgfId-4524758]operate
  
        
 
         
         	[bookmark: pgfId-4524760]5
  
         	[bookmark: pgfId-4524762]direct_operate
  
        
 
         
         	[bookmark: pgfId-4524764]6
  
         	[bookmark: pgfId-4524766]direct_operate_nr
  
        
 
         
         	[bookmark: pgfId-4524768]7
  
         	[bookmark: pgfId-4524770]immed_freeze
  
        
 
         
         	[bookmark: pgfId-4524772]8
  
         	[bookmark: pgfId-4524774]immed_freeze_nr
  
        
 
         
         	[bookmark: pgfId-4524776]9
  
         	[bookmark: pgfId-4524778]freeze_clear
  
        
 
         
         	[bookmark: pgfId-4524780]10
  
         	[bookmark: pgfId-4524782]freeze_clear_nr
  
        
 
         
         	[bookmark: pgfId-4524784]11
  
         	[bookmark: pgfId-4524786]freeze_at_time
  
        
 
         
         	[bookmark: pgfId-4524788]12
  
         	[bookmark: pgfId-4524790]freeze_at_time_nr
  
        
 
         
         	[bookmark: pgfId-4524792]13
  
         	[bookmark: pgfId-4524794]cold_restart
  
        
 
         
         	[bookmark: pgfId-4524796]14
  
         	[bookmark: pgfId-4524798]warm_restart
  
        
 
         
         	[bookmark: pgfId-4524800]15
  
         	[bookmark: pgfId-4524802]initialize_data
  
        
 
         
         	[bookmark: pgfId-4524804]16
  
         	[bookmark: pgfId-4524806]initialize_appl
  
        
 
         
         	[bookmark: pgfId-4524808]17
  
         	[bookmark: pgfId-4524810]start_appl
  
        
 
         
         	[bookmark: pgfId-4524812]18
  
         	[bookmark: pgfId-4524814]stop_appl
  
        
 
         
         	[bookmark: pgfId-4524816]19
  
         	[bookmark: pgfId-4524818]save_config
  
        
 
         
         	[bookmark: pgfId-4524820]20
  
         	[bookmark: pgfId-4524822]enable_unsolicited
  
        
 
         
         	[bookmark: pgfId-4524824]21
  
         	[bookmark: pgfId-4524826]disable_unsolicited
  
        
 
         
         	[bookmark: pgfId-4524828]22
  
         	[bookmark: pgfId-4524830]assign_class
  
        
 
         
         	[bookmark: pgfId-4524832]23
  
         	[bookmark: pgfId-4524834]delay_measure
  
        
 
         
         	[bookmark: pgfId-4524836]24
  
         	[bookmark: pgfId-4524838]record_current_time
  
        
 
         
         	[bookmark: pgfId-4524840]25
  
         	[bookmark: pgfId-4524842]open_file
  
        
 
         
         	[bookmark: pgfId-4524844]26
  
         	[bookmark: pgfId-4524846]close_file
  
        
 
         
         	[bookmark: pgfId-4524848]27
  
         	[bookmark: pgfId-4524850]delete_file
  
        
 
         
         	[bookmark: pgfId-4524852]28
  
         	[bookmark: pgfId-4524854]get_file_info
  
        
 
         
         	[bookmark: pgfId-4524856]29
  
         	[bookmark: pgfId-4524858]authenticate_file
  
        
 
         
         	[bookmark: pgfId-4524860]30
  
         	[bookmark: pgfId-4524862]abort_file
  
        
 
         
         	[bookmark: pgfId-4524864]31
  
         	[bookmark: pgfId-4524866]activate_config
  
        
 
         
         	[bookmark: pgfId-4524868]32
  
         	[bookmark: pgfId-4524870]authenticate_req
  
        
 
         
         	[bookmark: pgfId-4524872]33
  
         	[bookmark: pgfId-4524874]authenticate_err
  
        
 
         
         	[bookmark: pgfId-4524876]129
  
         	[bookmark: pgfId-4524878]response
  
        
 
         
         	[bookmark: pgfId-4524880]130
  
         	[bookmark: pgfId-4524882]unsolicited_response
  
        
 
         
         	[bookmark: pgfId-4524884]131
  
         	[bookmark: pgfId-4524886]authenticate_resp
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4364460]To specify DNP3 function codes:
 
     
 
     [bookmark: pgfId-4364510]Step 1 On the Create Rule page, select dnp3_func in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4364463]The dnp3_func keyword appears.
 
     [bookmark: pgfId-4380136]Step 2 Specify a single defined decimal value 0 to 255 for the function code, or a single defined string. See the DNP3 Function Codes table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776455]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360644][bookmark: 96427]dnp3_i[bookmark: marker-4517667]nd
 
     [bookmark: pgfId-4360646]You can use the dnp3_ind keyword to match against flags in the Internal Indications field in a DNP3 application layer response header.
 
     [bookmark: pgfId-4364602]You can specify the string for a single known flag or a comma-separated list of flags, as seen in the following example:
 
      
      [bookmark: pgfId-4364603]class_1_events, class_2_events 
     
 
     [bookmark: pgfId-4360648]When you specify multiple flags, the keyword matches against any flag in the list. To detect a combination of flags, use the dnp3_ind keyword multiple times in a rule.
 
     [bookmark: pgfId-4382324]The following list provides the string syntax recognized by the system for defined DNP3 internal indications flags.
 
      
      [bookmark: pgfId-4382610]class_1_events 
     
 
      
      [bookmark: pgfId-4382611]class_2_events 
     
 
      
      [bookmark: pgfId-4382612]class_3_events 
     
 
      
      [bookmark: pgfId-4382613]need_time 
     
 
      
      [bookmark: pgfId-4382614]local_control 
     
 
      
      [bookmark: pgfId-4382615]device_trouble 
     
 
      
      [bookmark: pgfId-4382616]device_restart 
     
 
      
      [bookmark: pgfId-4382617]no_func_code_support 
     
 
      
      [bookmark: pgfId-4382618]object_unknown 
     
 
      
      [bookmark: pgfId-4382619]parameter_error 
     
 
      
      [bookmark: pgfId-4382620]event_buffer_overflow 
     
 
      
      [bookmark: pgfId-4382621]already_executing 
     
 
      
      [bookmark: pgfId-4382622]config_corrupt 
     
 
      
      [bookmark: pgfId-4382623]reserved_2 
     
 
      
      [bookmark: pgfId-4382624]reserved_1 
     
 
     [bookmark: pgfId-4364678]To specify DNP3 internal indications flags:
 
     
 
     [bookmark: pgfId-4364680]Step 1 On the Create Rule page, select dnp3_ind in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4364681]The dnp3_ind keyword appears.
 
     [bookmark: pgfId-4364686]Step 2 You can specify the string for a single known flag or a comma-separated list of flags.
 
     [bookmark: pgfId-4776477]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360678][bookmark: 25423]dnp3_[bookmark: marker-4517682]obj
 
     [bookmark: pgfId-4360680]You can use the dnp3_obj keyword to match against DNP3 object headers in a request or response.
 
     [bookmark: pgfId-4360681]DNP3 data is comprised of a series of DNP3 objects of different types such as analog input, binary input, and so on. Each type is identified with a group such as analog input group, binary input group, and so on, each of which can be identified by a decimal value. The objects in each group are further identified by an object variation such as 16-bit integers, 32-bit integers, short floating point, and so on, each of which specifies the data format of the object. Each type of object variation can also be identified by a decimal value.
 
     [bookmark: pgfId-4364831]You identify object headers by specifying the decimal number for the type of object header group and the decimal number for the type of object variation. The combination of the two defines a specific type of DNP3 object.
 
     [bookmark: pgfId-4367560]To specify a DNP3 object:
 
     
 
     [bookmark: pgfId-4367562]Step 1 On the Create Rule page, select dnp3_obj in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4367563]The dnp3_obj keyword appears.
 
     [bookmark: pgfId-4367568]Step 2 Specify a decimal value 0 through 255 to identify a known object group, and another decimal value 0 through 255 to identify a known object variation type.
 
     [bookmark: pgfId-4776487]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360200][bookmark: 29195]Inspecting Packet Characteristics
 
     [bookmark: pgfId-4238908]License: Protection
 
     [bookmark: pgfId-1072591]You can write rules that only generate events against packets with specific packet characteristics. The ASA FirePOWER module provides the following keywords to evaluate packet characteristics:
 
      
      	 [bookmark: pgfId-3926389]dsize
 
      	 [bookmark: pgfId-4002958]isdataat
 
      	 [bookmark: pgfId-3926397]sameip
 
      	 [bookmark: pgfId-1232966]fragoffset
 
      	 [bookmark: pgfId-2771034]cvs
 
     
 
    
 
     
      [bookmark: pgfId-1494941][bookmark: 30570]dsize 
 
     [bookmark: pgfId-4238921]License: Protection
 
     [bookmark: pgfId-1116301]The [bookmark: marker-1161992]dsize keyword tests the packet payload size. With it, you can use the greater than and less than operators (< and >) to specify a range of values. You can use the following syntax to specify ranges:
 
      
      [bookmark: pgfId-1072610]>number_of_bytes 
     
 
      
      [bookmark: pgfId-1072614]<number_of_bytes 
     
 
      
      [bookmark: pgfId-1072615]number_of_bytes<>number_of_bytes 
     
 
     [bookmark: pgfId-1072616]For example, to indicate a packet size greater than 400 bytes, use >400 as the dtype value. To indicate a packet size of less than 500 bytes, use <500. To specify that the rule trigger against any packet between 400 and 500 bytes inclusive, use 400<>500.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1079544] 
      Caution The 
      dsize keyword tests packets before they are decoded by any preprocessors. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-4002965][bookmark: 19073]isda[bookmark: marker-4002964]taat
 
     [bookmark: pgfId-4238942]License: Protection
 
     [bookmark: pgfId-4002970]The isdataat keyword instructs the rules engine to verify that data resides at a specific location in the payload. 
 
      
       
        
        [bookmark: pgfId-4002981]Table 24-45 [bookmark: 86292]isdataat Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4002987]Argument 
          
  
         	 
           
           [bookmark: pgfId-4002989]Type 
          
  
         	 
           
           [bookmark: pgfId-4002991]Description 
          
  
        
 
         
         	[bookmark: pgfId-4002993]Offset
  
         	[bookmark: pgfId-4002995]Required
  
         	[bookmark: pgfId-4002997]The specific location in the payload. For example, to test that data appears at byte 50 in the packet payload, you would specify 50 as the offset value. A ! modifier negates the results of the isdataat test; it alerts if a certain amount of data is not present within the payload.
 [bookmark: pgfId-4002998]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
         
         	[bookmark: pgfId-4003003]Relative
  
         	[bookmark: pgfId-4003005]Optional
  
         	[bookmark: pgfId-4003007]Makes the location relative to the last successful content match. If you specify a relative location, note that the counter starts at byte 0, so calculate the location by subtracting 1 from the number of bytes you want to move forward from the last successful content match. For example, to specify that the data must appear at the ninth byte after the last successful content match, you would specify a relative offset of 8.
  
        
 
         
         	[bookmark: pgfId-4093348]Raw Data
  
         	[bookmark: pgfId-4093350]Optional
  
         	[bookmark: pgfId-4093379]Specifies that the data is located in the original packet payload before decoding or application layer normalization by any ASA FirePOWER module preprocessor. You can use this argument with Relative if the previous content match was in the raw packet data.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003009]For example, in a rule searching for the content foo, if the value for isdataat is specified as the following:
 
      
      	 [bookmark: pgfId-4003010]Offset = !10
 
      	 [bookmark: pgfId-4003011]Relative = enabled
 
     
 
     [bookmark: pgfId-4003015]The system alerts if the rules engine does not detect 10 bytes after foo before the payload ends.
 
     [bookmark: pgfId-4003016]To use isdataat:
 
     
 
     [bookmark: pgfId-4003017]Step 1 On the Create Rule page, select isdataat in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003018]The isdataat section appears.
 
     [bookmark: pgfId-4776507]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1495174][bookmark: 60894]sameip 
 
     [bookmark: pgfId-4238963]License: Protection
 
     [bookmark: pgfId-1158460]The [bookmark: marker-1161993]sameip keyword tests that a packet’s source and destination IP addresses are the same. It does not take an argument. 
 
    
 
     
      [bookmark: pgfId-4093339][bookmark: 36955]frag[bookmark: marker-4093338]offset
 
     [bookmark: pgfId-4238980]License: Protection
 
     [bookmark: pgfId-4093344]The fragoffset keyword tests the offset of a fragmented packet. This is useful because some exploits (such as WinNuke denial-of-service attacks) use hand-generated packet fragments that have specific offsets.
 
     [bookmark: pgfId-2055161]For example, to test whether the offset of a fragmented packet is 31337 bytes, specify 31337 as the fragoffset value.
 
     [bookmark: pgfId-2054987]You can use the following operators when specifying arguments for the fragoffset keyword.
 
     [bookmark: pgfId-2054988]
 
      
       
        
        [bookmark: pgfId-2054991]Table 24-46 fragoffset Keyword Argument Operators 
 
        
        
         
         	 
           
           [bookmark: pgfId-2054995]Operator 
          
  
         	 
           
           [bookmark: pgfId-2054997]Description 
          
  
        
 
         
         	[bookmark: pgfId-2054999]!
  
         	[bookmark: pgfId-2055001]not
  
        
 
         
         	[bookmark: pgfId-2055003]>
  
         	[bookmark: pgfId-2055005]greater than
  
        
 
         
         	[bookmark: pgfId-2055007]<
  
         	[bookmark: pgfId-2055009]less than
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2871094]Note that you cannot use the not (!) operator in combination with < or >.
 
    
 
     
      [bookmark: pgfId-4021634][bookmark: marker-2771035][bookmark: 86688]cvs
 
     [bookmark: pgfId-4238997]License: Protection
 
     [bookmark: pgfId-2867768]The cvs keyword tests Concurrent Versions System (CVS) traffic for malformed CVS entries. An attacker can use a malformed entry to force a heap overflow and execute malicious code on the CVS server. This keyword can be used to identify attacks against two known CVS vulnerabilities: CVE-2004-0396 (CVS 1.11.x up to 1.11.15, and 1.12.x up to 1.12.7) and CVS-2004-0414 (CVS 1.12.x through 1.12.8, and 1.11.x through 1.11.16). The cvs keyword checks for a well-formed entry, and generates alerts when a malformed entry is detected.
 
     [bookmark: pgfId-2867769]Your rule should include the ports where CVS runs. In addition, any ports where traffic may occur should be added to the list of ports for stream reassembly in your TCP policies so state can be maintained for CVS sessions. The TCP ports 2401 (pserver) and 514 (rsh) are included in the list of client ports where stream reassembly occurs. However, note that if your server runs as an xinetd server (i.e., pserver), it can run on any TCP port. Add any non-standard ports to the stream reassembly Client Ports list. For more information, see Selecting Stream Reassembly Options. 
 
     [bookmark: pgfId-2867776]To detect malformed CVS entries:
 
     
 
     [bookmark: pgfId-2867778]Step 1 Add the cvs option to a rule and type invalid-entry as the keyword argument. 
 
     [bookmark: pgfId-4776518]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003028][bookmark: 78615]Reading Packet Data into Keyword Arguments
 
     [bookmark: pgfId-4239010]License: Protection
 
     [bookmark: pgfId-4003033]You can use the [bookmark: marker-4120571]byte_extract keyword to read a specified number of bytes from a packet into a variable. You can then use the variable later in the same rule as the value for specific arguments in certain other detection keywords.
 
     [bookmark: pgfId-4017786]This is useful, for example, for extracting data size from packets where a specific segment of bytes describes the number of bytes included in data within the packet. For example, a specific segment of bytes might say that subsequent data is comprised of four bytes; you can extract the data size of four bytes to use as your variable value.
 
     [bookmark: pgfId-4017816]You can use byte_extract to create up to two separate variables in a rule concurrently. You can redefine a byte_extract variable any number of times; entering a new byte_extract keyword with the same variable name and a different variable definition overwrites the previous definition of that variable.
 
      
       
        
        [bookmark: pgfId-4003045]Table 24-47 [bookmark: 51691]Required byte_extract Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003049]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003051]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003053]Bytes to Extract
  
         	[bookmark: pgfId-4003055]The number of bytes to extract from the packet. You can specify 1, 2, 3, or 4 bytes.
  
        
 
         
         	[bookmark: pgfId-4003057]Offset
  
         	[bookmark: pgfId-4003059]The number of bytes into the payload to begin extracting data. You can specify -65534 to 65535 bytes. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to count forward. For example, specify 7 to count forward 8 bytes. The rules engine counts forward from the beginning of the packet payload or, if you also specify Relative, after the last successful content match. Note that you can specify negative numbers only when you also specify Relative; see the Additional Optional byte_extract Arguments table for more information.
  
        
 
         
         	[bookmark: pgfId-4003064]Variable Name
  
         	[bookmark: pgfId-4003066]The variable name to use in arguments for other detection keywords. You can specify an alphanumeric string that must begin with a letter.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003068]To further define how the system locates the data to extract, you can use the arguments described in the following table.
 
     [bookmark: pgfId-4003103]
 
      
       
        
        [bookmark: pgfId-4003078]Table 24-48 [bookmark: 38048]Additional Optional byte_extract Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003082]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003084]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003086]Multiplier
  
         	[bookmark: pgfId-4003088]A multiplier for the value extracted from the packet. You can specify 0 to 65535. If you do not specify a multiplier, the default value is 1.
  
        
 
         
         	[bookmark: pgfId-4003090]Align
  
         	[bookmark: pgfId-4003092]Rounds the extracted value to the nearest 2-byte or 4-byte boundary. When you also select Multiplier, the system applies the multiplier before the alignment.
  
        
 
         
         	[bookmark: pgfId-4003097]Relative
  
         	[bookmark: pgfId-4003099]Makes Offset relative to the end of the last successful content match instead of the beginning of the payload. See the Required byte_extract Arguments table for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003104]You can specify only one of DCE/RPC, Endian, or Number Type.
 
      
       
        
        [bookmark: pgfId-4003114]Table 24-49 [bookmark: 18197]Endianness byte_extract Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003118]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003120]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003122]Big Endian
  
         	[bookmark: pgfId-4003124]Processes data in big endian byte order, which is the default network byte order.
  
        
 
         
         	[bookmark: pgfId-4003126]Little Endian
  
         	[bookmark: pgfId-4003128]Processes data in little endian byte order.
  
        
 
         
         	[bookmark: pgfId-4003130]DCE/RPC
  
         	[bookmark: pgfId-4003132]Specifies a byte_extract keyword for traffic processed by the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 [bookmark: pgfId-4003136]The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian arguments do not apply.
 [bookmark: pgfId-4003137]When you enable this argument, you can also use byte_extract in conjunction with other specific DCE/RPC keywords. See DCE/RPC Keywords for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003146]You can specify a number type to read data as an ASCII string. To define how the system views string data in a packet, you can select one of the arguments in the following table.
 
     [bookmark: pgfId-4003175]
 
      
       
        
        [bookmark: pgfId-4003156]Table 24-50 [bookmark: 99171]Number Type byte_extract arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003160]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003162]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003164]Hexadecimal String
  
         	[bookmark: pgfId-4003166]Reads extracted string data in hexadecimal format.
  
        
 
         
         	[bookmark: pgfId-4003168]Decimal String
  
         	[bookmark: pgfId-4003170]Reads extracted string data in decimal format.
  
        
 
         
         	[bookmark: pgfId-4003172]Octal String
  
         	[bookmark: pgfId-4003174]Reads extracted string data in octal format.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003176]For example, if the value for byte_extract is specified as the following:
 
      
      	 [bookmark: pgfId-4003177]Bytes to Extract = 4
 
      	 [bookmark: pgfId-4003178]Variable Name = var
 
      	 [bookmark: pgfId-4003179]Offset = 8
 
      	 [bookmark: pgfId-4003180]Relative = enabled
 
     
 
     [bookmark: pgfId-4003181]the rules engine reads the number described in the four bytes that appear 9 bytes away from (relative to) the last successful content match into a variable named var, which you can specify later in the rule as the value for certain keyword arguments.
 
     [bookmark: pgfId-4003185]The following table lists the keyword arguments where you can specify a variable defined in the byte_extract keyword.
 
     [bookmark: pgfId-4003231]
 
      
       
        
        [bookmark: pgfId-4003192]Table 24-51 [bookmark: 47245]Arguments Accepting a byte_extract Variable 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003196]Keyword 
          
  
         	 
           
           [bookmark: pgfId-4003198]Argument 
          
  
         	 
           
           [bookmark: pgfId-4915305]For more information, see... 
          
  
        
 
         
         	[bookmark: pgfId-4003200]content
  
         	[bookmark: pgfId-4003202]Depth, Offset, Distance, Within
  
         	[bookmark: pgfId-4915307]Constraining Content Matches
  
        
 
         
         	[bookmark: pgfId-4003208]byte_jump
  
         	[bookmark: pgfId-4003210]Offset
  
         	[bookmark: pgfId-4915309]byte_jump
  
        
 
         
         	[bookmark: pgfId-4003216]byte_test
  
         	[bookmark: pgfId-4915402]Offset, Value
  
         	[bookmark: pgfId-4915311]byte_test
  
        
 
         
         	[bookmark: pgfId-4003224]isdataat
  
         	[bookmark: pgfId-4003226]Offset
  
         	[bookmark: pgfId-4915313]isdataat
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003232]To use byte_extract:
 
     
 
     [bookmark: pgfId-4003234]Step 1 On the Create Rule page, select t byte_extract in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003235]The byte_extract section appears beneath the last keyword you selected.
 
     [bookmark: pgfId-4776594]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003246][bookmark: 52622]Initiating Ac[bookmark: marker-4003245]tive Responses with Rule Keywords
 
     [bookmark: pgfId-4239023]License: Protection
 
     [bookmark: pgfId-4003254]The system can initiate active responses to close TCP connections in response to triggered TCP rules or UDP sessions in response to triggered UDP rules. Two keywords provide you with separate approaches to initiating active responses. When a packet triggers a rule containing either of the keywords, the system initiates a single active response. You can also use the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment.
 
     [bookmark: pgfId-4003263]Active responses are most effective in inline deployments because resets are more likely to arrive in time to affect the connection or session. For example, in response to the react keyword in an inline deployment, the system inserts a TCP reset (RST) packet directly into the traffic for each end of the connection, which normally should close the connection.
 
     [bookmark: pgfId-4003267]Active responses are not intended to take the place of a firewall for a number of reasons, including that the system cannot insert packets in passive deployments and an attacker may have chosen to ignore or circumvent active responses.
 
     [bookmark: pgfId-4003274]Because active responses can be routed back, the system does not allow TCP resets to initiate TCP resets; this prevents an unending sequence of active responses. The system also does not allow ICMP unreachable packets to initiate ICMP unreachable packets in keeping with standard practice.
 
     [bookmark: pgfId-4003278]You can configure the TCP stream preprocessor to detect additional traffic on a connection or session after an intrusion rule has triggered an active response. When the preprocessor detects additional traffic, it sends additional active responses up to a specified maximum to both ends of the connection or session. See Initiating Active Responses with Intrusion Drop Rules for more information.
 
     [bookmark: pgfId-4003286]See the following sections for information specific to the keywords you can use to initiate active responses:
 
      
      	 [bookmark: pgfId-4003290]Initiating Active Responses by Type and Direction
 
      	 [bookmark: pgfId-4003294]Sending an HTML Page Before a TCP Reset
 
      	 [bookmark: pgfId-4003298]Setting the Active Response Reset Attempts and Interface
 
     
 
    
 
     
      [bookmark: pgfId-4003301][bookmark: 94979]Initiating Active Res[bookmark: marker-4003300]ponses by Type and Direction
 
     [bookmark: pgfId-4239040]License: Protection
 
     [bookmark: pgfId-4003306]You can use the resp keyword to actively respond to TCP connections or UDP sessions, depending on whether you specify the TCP or UDP protocol in the rule header. See Specifying Protocols for more information.
 
     [bookmark: pgfId-4003315]Keyword arguments allow you to specify the packet direction and whether to use TCP reset (RST) packets or ICMP unreachable packets as active responses.
 
     [bookmark: pgfId-4003316]You can use any of the TCP reset or ICMP unreachable arguments to close TCP connections. You should use only ICMP unreachable arguments to close UDP sessions.
 
     [bookmark: pgfId-4003317]Different TCP reset arguments also allow you to target active responses to the packet source, destination, or both. All ICMP unreachable arguments target the packet source and allow you to specify whether to use an ICMP network, host, or port unreachable packet, or all three.
 
      
       
        
        [bookmark: pgfId-4915521]Table 24-52 [bookmark: 35001]resp Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4915525]Argument 
          
  
         	 
           
           [bookmark: pgfId-4915527]Description 
          
  
        
 
         
         	[bookmark: pgfId-4915530][bookmark: marker-4915529]reset_source
  
         	[bookmark: pgfId-4915532]Directs a TCP reset packet to the endpoint that sent the packet that triggered the rule. Alternatively, you can specify rst_snd, which is supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-4915535][bookmark: marker-4915534]reset_dest
  
         	[bookmark: pgfId-4915537]Directs a TCP reset packet to the intended destination endpoint of the packet that triggered the rule. Alternatively, you can specify rst_rcv, which is supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-4915540][bookmark: marker-4915539]reset_both
  
         	[bookmark: pgfId-4915542]Directs a TCP reset packet to both the sending and receiving endpoints. Alternatively, you can specify rst_all, which is supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-4915545][bookmark: marker-4915544]icmp_net
  
         	[bookmark: pgfId-4915547]Directs an ICMP network unreachable message to the sender.
  
        
 
         
         	[bookmark: pgfId-4915550][bookmark: marker-4915549]icmp_host
  
         	[bookmark: pgfId-4915552]Directs an ICMP host unreachable message to the sender.
  
        
 
         
         	[bookmark: pgfId-4915555][bookmark: marker-4915554]icmp_port
  
         	[bookmark: pgfId-4915557]Directs an ICMP port unreachable message to the sender. This argument is used to terminate UDP traffic.
  
        
 
         
         	[bookmark: pgfId-4915560][bookmark: marker-4915559]icmp_all
  
         	[bookmark: pgfId-4915562]Directs the following ICMP messages to the sender:
 
           
           	 [bookmark: pgfId-4915563]network unreachable
 
           	 [bookmark: pgfId-4915564]host unreachable
 
           	 [bookmark: pgfId-4915565]port unreachable
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003404]For example, to configure a rule to reset both sides of a connection when a rule is triggered, use reset_both as the value for the resp keyword.
 
     [bookmark: pgfId-4003405]You can use a comma-separated list to specify multiple arguments as follows:
 
      
      [bookmark: pgfId-4003406]argument,argument,argument 
     
 
     [bookmark: pgfId-4003410]See Setting the Active Response Reset Attempts and Interface for information on using the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment.
 
     [bookmark: pgfId-4973890]To specify active responses:
 
     
 
     [bookmark: pgfId-4973895]Step 1 On the Create Rule page, select resp in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003414]The resp keyword appears.
 
     [bookmark: pgfId-4003426]Step 2 Specify any of the arguments in the resp Arguments table in the resp field; use a comma-separated list to specify multiple arguments.
 
     [bookmark: pgfId-4776600]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003429][bookmark: 65958]Sending an HTML Page Before a TCP Rese[bookmark: marker-4003428]t
 
     [bookmark: pgfId-4239054]License: Protection
 
     [bookmark: pgfId-4003434]You can use the react keyword to send a default HTML page to the TCP connection client when a packet triggers the rule; after sending the HTML page, the system uses TCP reset packets to initiate active responses to both ends of the connection. The react keyword does not trigger active responses for UDP traffic.
 
     [bookmark: pgfId-4003443]Optionally, you can specify the following argument:
 
      
      [bookmark: pgfId-4003445]msg[bookmark: marker-4003444] 
     
 
     [bookmark: pgfId-4003446]When a packet triggers a react rule that uses the msg argument, the HTML page includes the rule event message. See Understanding Rule Anatomy for a description of the event message field.
 
     [bookmark: pgfId-4003450]If you do not specify the msg argument, the HTML page includes the following message:
 
      
      [bookmark: pgfId-4003451]You are attempting to access a forbidden site.
Consult your system administrator for details. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4003452]Note Because active responses can be routed back, ensure that the HTML response page does not trigger a react rule; this could result in an unending sequence of active responses. Cisco recommends that you test react rules extensively before activating them in a production environment.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4003459]See Setting the Active Response Reset Attempts and Interface for information on using the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment.
 
     [bookmark: pgfId-4003460]To send an HTML page before initiating an active responses:
 
     
 
     [bookmark: pgfId-4003462]Step 1 On the Create Rule page, select react in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003463]The react keyword appears.
 
     [bookmark: pgfId-4003472]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-4003473]To send an HTML page that includes the event message configured for the rule to the client before closing a connection, type  msg in the  react field.
 
       	 [bookmark: pgfId-3816180]To send an HTML page that includes the following default message to the client before closing a connection, leave the  react field blank:
 
      
 
     
 
      
      [bookmark: pgfId-4003479]You are attempting to access a forbidden site.
Consult your system administrator for details 
     
 
     [bookmark: pgfId-4776622]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003483][bookmark: 13811]Setting the Ac[bookmark: marker-4003481]tive Response Reset Attempts and Interface
 
     [bookmark: pgfId-4239068]License: Protection
 
     [bookmark: pgfId-4054288]You can use the config response command to further configure the behavior of TCP resets initiated by resp and react rules. This command also affects the behavior of active responses initiated by drop rules; see Initiating Active Responses with Intrusion Drop Rules for more information.
 
     [bookmark: pgfId-4003493]You use the config response command by inserting it on a separate line in the USER_CONF advanced variable. See Understanding Advanced Variables for information on using a USER_CONF variable.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-4003503] 
      Caution Do 
      not use the 
      USER_CONF advanced variable to configure an intrusion policy feature unless you are instructed to do so in the feature description or by Support. Conflicting or duplicate configurations will halt the system. 
       
       
 
      
 
     
 
     [bookmark: pgfId-4003510]To specify active response reset attempts, the active response interface, or both:
 
     
 
     [bookmark: pgfId-4003512]Step 1 Depending on whether you want to specify only the number of active responses, only the active response interface, or both, insert a form of the config response command on a separate line in the USER_CONF advanced variable. You have the following choices:
 
      
       
       	 [bookmark: pgfId-4003513]To specify only the number of active response attempts, insert the command:
  config response: attempts   att 
 
      
 
     
 
     [bookmark: pgfId-4549044]For example: config response: attempts 10
 
      
       
       	 [bookmark: pgfId-4549045]To specify only the active response interface, insert the command:
  config response: device   dev 
 
      
 
     
 
     [bookmark: pgfId-4003516]For example: config response: device eth0
 
      
       
       	 [bookmark: pgfId-4003517]To specify both the number of active response attempts and the active response interface, insert the command:
  config response: attempts   att,  device   dev 
 
      
 
     
 
     [bookmark: pgfId-4003518]For example: config response: attempts 10, device eth0
 
     [bookmark: pgfId-4003519]where:
 
     [bookmark: pgfId-4003520]att is the number 1 to 20 of attempts to land each TCP reset packet within the current connection window so the receiving host accepts the packet. This sequence strafing is useful only in passive deployments; in inline deployments, the system inserts reset packets directly into the stream in place of triggering packets. the system sends only 1 ICMP reachable active response.
 
     [bookmark: pgfId-4003530]dev is an alternate interface where you want the system to send active responses in a passive deployment or insert active responses in an inline deployment.
 
     [bookmark: pgfId-4776636]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3845717][bookmark: 75844]Filtering Events
 
     [bookmark: pgfId-4239081]License: Protection
 
     [bookmark: pgfId-3455604]You can use the [bookmark: marker-3455603]detection_filter keyword to prevent a rule from generating events unless a specified number of packets trigger the rule within a specified time. This can stop the rule from prematurely generating events. For example, two or three failed login attempts within a few seconds could be expected behavior, but a large number of attempts within the same time could indicate a brute force attack.
 
     [bookmark: pgfId-4108364]The detection_filter keyword requires arguments that define whether the system tracks the source or destination IP address, the number of times the detection criteria must be met before triggering an event, and how long to continue the count.
 
     [bookmark: pgfId-4108365]Use the following syntax to delay the triggering of events:
 
      
      [bookmark: pgfId-4108366]track by_src/by_dst, count count, seconds number_of_seconds 
     
 
     [bookmark: pgfId-4108367]The track argument specifies whether to use the packet’s source or destination IP address when counting the number of packets that meet the rule’s detection criteria. Select from the argument values described in the following table to specify how the system tracks event instances. 
 
     [bookmark: pgfId-4108392]
 
      
       
        
        [bookmark: pgfId-4108377]Table 24-53 [bookmark: 44064]detection_filter Track Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4108381]Argument 
          
  
         	 
           
           [bookmark: pgfId-4108383]Description 
          
  
        
 
         
         	[bookmark: pgfId-4108385]by_src
  
         	[bookmark: pgfId-4108387]Detection criteria count by source IP address.
  
        
 
         
         	[bookmark: pgfId-4108389]by_dst
  
         	[bookmark: pgfId-4108391]Detection criteria count by destination IP address.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4108393]The count argument specifies the number of packets that must trigger the rule for the specified IP address within the specified time before the rule generates an event.
 
     [bookmark: pgfId-4108394]The seconds argument specifies the number of seconds within which the specified number of packets must trigger the rule before the rule generates an event.
 
     [bookmark: pgfId-4108395]Consider the case of a rule that searches packets for the content foo and uses the detection_filter keyword with the following arguments:
 
      
      [bookmark: pgfId-3455640]track by_src, count 10, seconds 20 
     
 
     [bookmark: pgfId-3455641]In the example, the rule will not generate an event until it has detected foo in 10 packets within 20 seconds from a given source IP address. If the system detects only 7 packets containing foo within the first 20 seconds, no event is generated. However, if foo occurs 40 times in the first 20 seconds, the rule generates 30 events and the count begins again when 20 seconds have elapsed.
 
     [bookmark: pgfId-3455645]Comparing the threshold and detection_filter Keywords
 
     [bookmark: pgfId-3455647]The detection_filter keyword replaces the deprecated threshold[bookmark: marker-3455646] keyword. The threshold keyword is still supported for backward compatibility and operates the same as thresholds that you set within an intrusion policy.
 
     [bookmark: pgfId-3455648]The detection_filter keyword is a detection feature that is applied before a packet triggers a rule. The rule does not generate an event for triggering packets detected before the specified packet count and, in an inline deployment, does not drop those packets if the rule is set to drop packets. Conversely, the rule does generate events for packets that trigger the rule and occur after the specified packet count and, in an inline deployment, drops those packets if the rule is set to drop packets.
 
     [bookmark: pgfId-3455649]Thresholding is an event notification feature that does not result in a detection action. It is applied after a packet triggers an event. In an inline deployment, a rule that is set to drop packets drops all packets that trigger the rule, independent of the rule threshold.
 
     [bookmark: pgfId-4194865]Note that you can use the detection_filter keyword in any combination with the intrusion event thresholding, intrusion event suppression, and rate-based attack prevention features in an intrusion policy. Note also that policy validation fails if you enable an imported local rule that uses the deprecated threshold keyword in combination with the intrusion event thresholding feature in an intrusion policy. See Configuring Event Thresholding, Configuring Suppression Per Intrusion Policy, Setting a Dynamic Rule State, and Importing Local Rule Files for more information.
 
    
 
     
      [bookmark: pgfId-1100620][bookmark: 93013]Evaluating Post-Attack Traffic
 
     [bookmark: pgfId-4239098]License: Protection
 
     [bookmark: pgfId-1116822]Use the [bookmark: marker-1162033]tag keyword to tell the system to log additional traffic for the host or session. Use the following syntax when specifying the type and amount of traffic you want to capture using the tag keyword:
 
      
      [bookmark: pgfId-1160681]tagging_type, count, metric, optional_direction 
     
 
     [bookmark: pgfId-2544019]The next three tables describe the other available arguments.
 
      
       
        
        [bookmark: pgfId-1447578]Table 24-54 [bookmark: 45475]Tag Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1161053]Argument 
          
  
         	 
           
           [bookmark: pgfId-1161055]Description 
          
  
        
 
         
         	[bookmark: pgfId-1161057]session
  
         	[bookmark: pgfId-1161059]Logs packets in the session that triggered the rule.
  
        
 
         
         	[bookmark: pgfId-1161061]host
  
         	[bookmark: pgfId-1161063]Logs packets from the host that sent the packet that triggered the rule. You can add a directional modifier to log only the traffic coming from the host (src) or going to the host (dst).
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4883958]To indicate how much traffic you want to log, use the following argument:
 
     [bookmark: pgfId-4883977]
 
      
       
        
        [bookmark: pgfId-4883965]Table 24-55 [bookmark: 80039]Count Argument 
 
        
        
         
         	 
           
           [bookmark: pgfId-4883969]Argument 
          
  
         	 
           
           [bookmark: pgfId-4883971]Description 
          
  
        
 
         
         	[bookmark: pgfId-4883973]count
  
         	[bookmark: pgfId-4883975]The number of packets or seconds you want to log after the rule triggers. 
 [bookmark: pgfId-4883976]This unit of measure is specified with the metric argument, which follows the count argument.
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-1924041]Table 24-56 [bookmark: 13997]Logging Metrics Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1924045]Argument 
          
  
         	 
           
           [bookmark: pgfId-1924047]Description 
          
  
        
 
         
         	[bookmark: pgfId-1924049]packets
  
         	[bookmark: pgfId-1924051]Logs the number of packets specified by the count after the rule triggers.
  
        
 
         
         	[bookmark: pgfId-1924053]seconds
  
         	[bookmark: pgfId-1924055]Logs traffic for the number of seconds specified by the count after the rule triggers.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1924057]For example, when a rule with the following tag keyword value triggers:
 
      
      [bookmark: pgfId-1924058]host, 30, seconds, dst 
     
 
     [bookmark: pgfId-1161395]all packets that are transmitted from the client to the host for the next 30 seconds are logged.
 
    
 
     
      [bookmark: pgfId-1493319][bookmark: 94823]Detecting Attacks That Span Multiple Packets
 
     [bookmark: pgfId-4239115]License: Protection
 
     [bookmark: pgfId-3720025]Use the flowbits[bookmark: marker-3720024] keyword to assign state names to sessions. By analyzing subsequent packets in a session according to the previously named state, the system can detect and alert on exploits that span multiple packets in a single session.
 
     [bookmark: pgfId-4413538]The flowbits state name is a user-defined label assigned to packets in a specific part of a session. You can label packets with state names based on packet content to help distinguish malicious packets from those you do not want to alert on. You can define up to 1024 state names. For example, if you want to alert on malicious packets that you know only occur after a successful login, you can use the flowbits keyword to filter out the packets that constitute an initial login attempt so you can focus only on the malicious packets. You can do this by first creating a rule that labels all packets in the session that have an established login with a logged_in state, then creating a second rule where flowbits checks for packets with the state you set in the first rule and acts only on those packets. See flowbits Example Using state_name for an example that uses flowbits to determine if a user is logged in.
 
     [bookmark: pgfId-4413542]An optional group name allows you to include a state name in a group of states. A state name can belong to several groups. States not associated with a group are not mutually exclusive, so a rule that triggers and sets a state that is not associated with a group does not affect other currently set states. See flowbits Example Resulting in a False Positive for an example that illustrates how including a state name in a group can prevent false positives by unsetting another state in the same group.
 
      
       
        
        [bookmark: pgfId-4916611]Table 24-57 [bookmark: 66765]flowbits Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-4916619]Operator 
          
  
         	 
           
           [bookmark: pgfId-4916621]State Option 
          
  
         	 
           
           [bookmark: pgfId-4916623]Group 
          
  
         	 
           
           [bookmark: pgfId-4916625]Description 
          
  
        
 
         
         	 [bookmark: pgfId-4916627]set
  
         	[bookmark: pgfId-4916629]state_name
  
         	[bookmark: pgfId-4916631]optional
  
         	[bookmark: pgfId-4916633]Sets the specified state for a packet. Sets the state in the specified group if a group is defined.
  
        
 
         
         	[bookmark: pgfId-4916637]state_name&state_name
  
         	[bookmark: pgfId-4916639]optional
  
         	[bookmark: pgfId-4916641]Sets the specified states for a packet. Sets the states in the specified group if a group is defined.
  
        
 
         
         	 [bookmark: pgfId-4916643]setx
  
         	[bookmark: pgfId-4916645]state_name
  
         	[bookmark: pgfId-4916647]mandatory
  
         	[bookmark: pgfId-4916649]Sets the specified state in the specified group for a packet, and unsets all other states in the group.
  
        
 
         
         	[bookmark: pgfId-4916653]state_name&state_name
  
         	[bookmark: pgfId-4916655]mandatory
  
         	[bookmark: pgfId-4916657]Sets the specified states in the specified group for a packet, and unsets all other states in the group.
  
        
 
         
         	 [bookmark: pgfId-4916659]unset
  
         	[bookmark: pgfId-4916661]state_name
  
         	[bookmark: pgfId-4916663]no group
  
         	[bookmark: pgfId-4916665]Unsets the specified state for a packet.
  
        
 
         
         	[bookmark: pgfId-4916669]state_name&state_name
  
         	[bookmark: pgfId-4916671]no group
  
         	[bookmark: pgfId-4916673]Unsets the specified states for a packet.
  
        
 
         
         	[bookmark: pgfId-4916677]all
  
         	[bookmark: pgfId-4916679]mandatory
  
         	[bookmark: pgfId-4916681]Unsets all the states in the specified group.
  
        
 
         
         	 [bookmark: pgfId-4916683]toggle
  
         	[bookmark: pgfId-4916685]state_name
  
         	[bookmark: pgfId-4916687]no group
  
         	[bookmark: pgfId-4916689]Unsets the specified state if it is set, and sets the specified state if it is unset.
  
        
 
         
         	[bookmark: pgfId-4916693]state_name&state_name
  
         	[bookmark: pgfId-4916695]no group
  
         	[bookmark: pgfId-4916697]Unsets the specified states if they are set, and sets the specified states if they are unset.
  
        
 
         
         	[bookmark: pgfId-4916701]all
  
         	[bookmark: pgfId-4916703]mandatory
  
         	[bookmark: pgfId-4916705]Unsets all states set in the specified group, and sets all states unset in the specified group.
  
        
 
         
         	 [bookmark: pgfId-4916707]isset
  
         	[bookmark: pgfId-4916709]state_name
  
         	[bookmark: pgfId-4916711]no group
  
         	[bookmark: pgfId-4916713]Determines if the specified state is set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916717]state_name&state_name
  
         	[bookmark: pgfId-4916719]no group
  
         	[bookmark: pgfId-4916721]Determines if the specified states are set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916725]state_name|state_name 
  
         	[bookmark: pgfId-4916727]no group
  
         	[bookmark: pgfId-4916729]Determines if any of the specified states are set in the packet. 
  
        
 
         
         	[bookmark: pgfId-4916733]any
  
         	[bookmark: pgfId-4916735]mandatory
  
         	[bookmark: pgfId-4916737]Determines if any state is set in the specified group.
  
        
 
         
         	[bookmark: pgfId-4916741]all
  
         	[bookmark: pgfId-4916743]mandatory
  
         	[bookmark: pgfId-4916745]Determines if all states are set in the specified group.
  
        
 
         
         	 [bookmark: pgfId-4916747]isnotset
  
         	[bookmark: pgfId-4916749]state_name
  
         	[bookmark: pgfId-4916751]no group
  
         	[bookmark: pgfId-4916753]Determines if the specified state is not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916757]state_name&state_name
  
         	[bookmark: pgfId-4916759]no group
  
         	[bookmark: pgfId-4916761]Determines if the specified states are not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916765]state_name|state_name
  
         	[bookmark: pgfId-4916767]no group
  
         	[bookmark: pgfId-4916769]Determines if any of the specified states is not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916773]any
  
         	[bookmark: pgfId-4916775]mandatory
  
         	[bookmark: pgfId-4916777]Determines if any state is not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916781]all
  
         	[bookmark: pgfId-4916783]mandatory
  
         	[bookmark: pgfId-4916785]Determines if all states are not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916787]reset
  
         	[bookmark: pgfId-4916789](no state)
  
         	[bookmark: pgfId-4916791]optional
  
         	[bookmark: pgfId-4916793]Unsets all states for all packets. Unsets all states in a group if a group is specified.
  
        
 
         
         	[bookmark: pgfId-4916795]noalert
  
         	[bookmark: pgfId-4916797](no state)
  
         	[bookmark: pgfId-4916799]no group
  
         	[bookmark: pgfId-4916801]Use this in conjunction with any other operator to suppress event generation.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4450170]Note the following when using the flowbits keyword: 
 
      
      	 [bookmark: pgfId-4490304]When using the  setx operator, the specified state can only belong to the specified group, and not to any other group.
 
      	 [bookmark: pgfId-4490491]You can define the  setx operator multiple times, specifying different states and the same group with each instance.
 
      	 [bookmark: pgfId-4490631]When you use the  setx operator and specify a group, you cannot use the  set ,  toggle , or  unset operators on that specified group.
 
      	 [bookmark: pgfId-4491151]The  isset and  isnotset operators evaluate for the specified state regardless of whether the state is in a group.
 
      	 [bookmark: pgfId-4491716]During intrusion policy saves, intrusion policy reapplies, and access control policy applies (regardless of whether the access control policy references one intrusion policy or multiple intrusion policies), if you enable a rule that contains the  isset or  isnotset operator  without a specified group, and you do not enable at least one rule that affects  flowbits assignment ( set ,  setx ,  unset ,  toggle ) for the corresponding state name and protocol, all rules that affect  flowbits assignment for the corresponding state name are enabled.
 
      	 [bookmark: pgfId-4798151]During intrusion policy saves, intrusion policy reapplies, and access control policy applies (regardless of whether the access control policy references one intrusion policy or multiple intrusion policies), if you enable a rule that contains the  isset or  isnotset operator  with a specified group, all rules that affect  flowbits assignment ( set ,  setx ,  unset ,  toggle ) and define a corresponding group name are also enabled.
 
     
 
     [bookmark: pgfId-3720100][bookmark: 46849]flowbits Example Using state_name
 
     [bookmark: pgfId-3720101]Consider the IMAP vulnerability described in Bugtraq ID #1110. This vulnerability exists in an implementation of IMAP, specifically in the LIST, LSUB, RENAME, FIND, and COPY commands. However, to take advantage of the vulnerability, the attacker must be logged into the IMAP server. Because the LOGIN confirmation from the IMAP server and the exploit that follows are necessarily in different packets, it is difficult to construct non-flow-based rules that catch this exploit. Using the flowbits keyword, you can construct a series of rules that track whether the user is logged into the IMAP server and, if so, generate an event if one of the attacks is detected. If the user is not logged in, the attack cannot exploit the vulnerability and no event is generated.
 
     [bookmark: pgfId-4467870]The two rule fragments that follow illustrate this example. The first rule fragment looks for an IMAP login confirmation from the IMAP server:
 
      
      [bookmark: pgfId-3720103]alert tcp any 143 -> any any (msg:"IMAP login"; content:"OK
LOGIN"; flowbits:set,logged_in; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720104]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106295]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4467938]Note that flowbits:set sets a state of logged_in, while flowbits:noalert suppresses the alert because you are likely to see many innocuous login sessions on an IMAP server.
 
     [bookmark: pgfId-3720105]The next rule fragment looks for a LIST string, but does not generate an event unless the logged_in state has been set as a result of some previous packet in the session: 
 
      
      [bookmark: pgfId-3720106]alert tcp any any -> any 143 (msg:"IMAP LIST";
content:"LIST"; flowbits:isset,logged_in;) 
     
 
     [bookmark: pgfId-3720107]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106303]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468065]In this case, if a previous packet has caused a rule containing the first fragment to trigger, then a rule containing the second fragment triggers and generates an event.
 
     [bookmark: pgfId-3720109][bookmark: 89941]flowbits Example Resulting in a False Positive
 
     [bookmark: pgfId-3720110]Including different state names that are set in different rules in a group can prevent false positive events that might otherwise occur when content in a subsequent packet matches a rule whose state is no longer valid. The following example illustrates how you can get false positives when you do not include multiple state names in a group.
 
     [bookmark: pgfId-4467898]Consider the case where the following three rule fragments trigger in the order shown during a single session:
 
      
      [bookmark: pgfId-3720112](msg:"JPEG transfer"; content:"image/";pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fp?jpe?g/smi";
flowbits:set,http.jpeg; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720113]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106311]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468145]The content and pcre keywords in the first rule fragment match a JPEG file download, flowbits:set,http.jpeg sets the http.jpeg flowbits state, and flowbits:noalert stops the rule from generating events. No event is generated because the rule’s purpose is to detect the file download and set the flowbits state so one or more companion rules can test for the state name in combination with malicious content and generate events when malicious content is detected.
 
     [bookmark: pgfId-3720114]The next rule fragment detects a GIF file download subsequent to the JPEG file download above:
 
      
      [bookmark: pgfId-3720115](msg:"GIF transfer"; content:"image/"; pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fgif/smi";
flowbits:set,http.tif,image_downloads; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720116]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106319]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468171]The content and pcre keywords in the second rule match the GIF file download, flowbits:set,http.tif sets the http.tif flowbit state, and flowbits:noalert stops the rule from generating an event. Note that the http.jpeg state set by the first rule fragment is still set even though it is no longer needed; this is because the JPEG download must have ended if a subsequent GIF download has been detected.
 
     [bookmark: pgfId-3720117]The third rule fragment is a companion to the first rule fragment:
 
      
      [bookmark: pgfId-3720118](msg:"JPEG exploit";
flowbits:isset,http.jpeg;content:"|FF|"; pcre:"
/\xFF[\xE1\xE2\xED\xFE]\x00[\x00\x01]/";) 
     
 
     [bookmark: pgfId-3720119]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106327]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468190]In the third rule fragment, flowbits:isset,http.jpeg determines that the now-irrelevant http.jpeg state is set, and content and pcre match content that would be malicious in a JPEG file but not in a GIF file. The third rule fragment results in a false positive event for a nonexistent exploit in a JPEG file.
 
     [bookmark: pgfId-4451743]flowbits Example for Preventing False Positives
 
     [bookmark: pgfId-4451782]The following example illustrates how including state names in a group and using the setx operator can prevent false positives. 
 
     [bookmark: pgfId-4467935]Consider the same case as the previous example, except that the first two rules now include their two different state names in the same state group.
 
      
      [bookmark: pgfId-3720121](msg:"JPEG transfer"; content:"image/";pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fp?jpe?g/smi";
flowbits:setx,http.jpeg,image_downloads; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720122]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106335]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468238]When the first rule fragment detects a JPEG file download, the flowbits:setx,http.jpeg,image_downloads keyword sets the flowbits state to http.jpeg and includes the state in the image_downloads group. 
 
     [bookmark: pgfId-4454112]The next rule then detects a subsequent GIF file download:
 
      
      [bookmark: pgfId-3720124](msg:"GIF transfer"; content:"image/"; pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fgif/smi";
flowbits:setx,http.tif,image_downloads; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720125]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106343]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468271]When the second rule fragment matches the GIF download, the flowbits:setx,http.tif,image_downloads keyword sets the http.tif flowbits state and unsets http.jpeg, the other state in the group.
 
     [bookmark: pgfId-3720126]The third rule fragment does not result in a false positive:
 
      
      [bookmark: pgfId-3720127](msg:"JPEG exploit"; 
flowbits:isset,http.jpeg;content:"|FF|"; pcre:"/
\xFF[\xE1\xE2\xED\xFE]\x00[\x00\x01]/";) 
     
 
     [bookmark: pgfId-3720128]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5106351]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468306]Because flowbits:isset,http.jpeg is false, the rules engine stops processing the rule and no event is generated, thus avoiding a false positive even in a case where content in the GIF file matches exploit content for a JPEG file.
 
    
 
     
      [bookmark: pgfId-3720130][bookmark: 69548]Generating Events on the HTTP Encoding Type and Location
 
     [bookmark: pgfId-4239128]License: Protection
 
     [bookmark: pgfId-3720136]You can use the http_encode[bookmark: marker-3720135] keyword to generate events on the type of encoding in an HTTP request or response before normalization, either in the HTTP URI, in non-cookie data in an HTTP header, in cookies in HTTP requests headers, or set-cookie data in HTTP responses.
 
     [bookmark: pgfId-3720144]You must configure the HTTP Inspect preprocessor to inspect HTTP responses and HTTP cookies to return matches for rules using the http_encode keyword. See Decoding HTTP Traffic and Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-3720151]Also, you must enable both the decoding and alerting option for each specific encoding type in your HTTP Inspect preprocessor configuration for the http_encode keyword in an intrusion rule to trigger events on that encoding type. See Selecting Server-Level HTTP Normalization Encoding Options for more information.
 
     [bookmark: pgfId-4227731]Note that the base36 encoding type has been deprecated. For backward compatibility, the base36 argument is allowed in existing rules, but it does not cause the rules engine to inspect base36 traffic.
 
      
       
        
        [bookmark: pgfId-3720165]Table 24-58 [bookmark: 78097]http_encode Encoding Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-3720169]Encoding Type 
          
  
         	 
           
           [bookmark: pgfId-3720171]Description 
          
  
        
 
         
         	[bookmark: pgfId-3720173]utf8
  
         	[bookmark: pgfId-3720175]Detects UTF-8 encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
         
         	[bookmark: pgfId-3720177]double_encode
  
         	[bookmark: pgfId-3720179]Detects double encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
         
         	[bookmark: pgfId-3720181]non_ascii
  
         	[bookmark: pgfId-3720183]Detects non-ASCII characters in the specified location when non-ASCII characters are detected but the detected encoding type is not enabled.
  
        
 
         
         	[bookmark: pgfId-3720189]uencode
  
         	[bookmark: pgfId-3720191]Detects Microsoft %u encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
         
         	[bookmark: pgfId-3720193]bare_byte
  
         	[bookmark: pgfId-3720195]Detects bare byte encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3720197]To identify the HTTP encoding type and location in an intrusion rule:
 
     
 
     [bookmark: pgfId-3720199]Step 1 Add the http_encode keyword to a rule.
 
     [bookmark: pgfId-3720200]Step 2 From the Encoding Location drop-down list, select whether to search for the specified encoding type in an HTTP URI, header, or cookie, including a set-cookie.
 
     [bookmark: pgfId-3720201]Step 3 Specify one or more encoding types using one of the following formats:
 
      
      [bookmark: pgfId-3720202]encode_type 
     
 
      
      [bookmark: pgfId-3720203]encode_type|encode_type|encode_type... 
     
 
      
      [bookmark: pgfId-3720204]!encode_type 
     
 
     [bookmark: pgfId-3720205]where encode_type is one of the following:
 
      
      [bookmark: pgfId-3720206]utf8, double_encode, non_ascii, uencode, bare_byte 
     
 
     [bookmark: pgfId-3720207]Note that you cannot use the negation (!) and OR (|) operators together.
 
     [bookmark: pgfId-3720208]Step 4 Optionally, add multiple http_encode keywords to the same rule to AND the conditions for each. For example, enter two keywords with the following conditions:
 
     [bookmark: pgfId-3720209]First http_encode keyword:
 
      
       
       	 [bookmark: pgfId-3720210] Encoding Location :  HTTP UR I
 
       	 [bookmark: pgfId-3720211] Encoding Type :  utf8 
 
      
 
     
 
     [bookmark: pgfId-3720212]Additional http_encode keyword:
 
      
       
       	 [bookmark: pgfId-3720213] Encoding Location :  HTTP URI 
 
       	 [bookmark: pgfId-3720214] Encoding Type :  uencode 
 
      
 
     
 
     [bookmark: pgfId-3720215]The example configuration searches the HTTP URI for UTF-8 AND Microsoft IIS %u encoding.
 
     [bookmark: pgfId-4776955]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4860915][bookmark: 19614]Detecting File Types and Versions
 
     [bookmark: pgfId-4860922]License:  Protection
 
     [bookmark: pgfId-4876530]The file_type and file_group keywords allow you to detect files transmitted via FTP, HTTP, SMTP, IMAP, POP3, and NetBIOS-ssn (SMB) based on their type and version. Do not use more than one file_type or file_group keyword in a single intrusion rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860925]Tip Updating your vulnerability database (VDB) populates the rule editor with the most up-to-date file types, versions, and groups. For more information, see Updating the Vulnerability Database.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-4893177]Table 24-59 file_type and file_group Intrusion Event Generation 
 
        
        
         
         	 
           
           [bookmark: pgfId-4893181]Transmission Protocol 
          
  
         	 
           
           [bookmark: pgfId-4893183]Required Preprocessor or Preprocessor Option 
          
  
        
 
         
         	[bookmark: pgfId-4893185]FTP
  
         	[bookmark: pgfId-4893187]FTP/Telnet preprocessor and the Normalize TCP Payload inline normalization preprocessor option; see Decoding FTP and Telnet Traffic and Normalizing Inline Traffic.
  
        
 
         
         	[bookmark: pgfId-4893189]HTTP
  
         	[bookmark: pgfId-4893191]HTTP Inspect preprocessor; see Decoding HTTP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893193]SMTP
  
         	[bookmark: pgfId-4893195]SMTP preprocessor; see Decoding SMTP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893197]IMAP
  
         	[bookmark: pgfId-4893199]IMAP preprocessor; see Decoding IMAP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893201]POP3
  
         	[bookmark: pgfId-4893203]POP preprocessor; see Decoding POP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893205]NetBIOS-ssn (SMB)
  
         	[bookmark: pgfId-4893207]the SMB File Inspection DCE/RPC preprocessor option; see Decoding DCE/RPC Traffic.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4891464]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-4860933]file_type
 
      	 [bookmark: pgfId-4876152]file_group
 
     
 
    
 
     
      [bookmark: pgfId-4876154][bookmark: 28097]file_t[bookmark: marker-4876605]ype
 
     [bookmark: pgfId-4876112]The file_type keyword allows you to specify the file type and version of a file detected in traffic. File type arguments (for example, JPEG and PDF) identify the format of the file you want to find in traffic. 
 
      
       
     
 
     
 
     [bookmark: pgfId-4929042]Note Do not use the file_type keyword with another file_type or file_group keyword in the same intrusion rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860942]The system selects Any Version by default, but some file types allow you to select version options (for example, PDF version 1.7) to identify specific file type versions you want to find in traffic.
 
     [bookmark: pgfId-4860943]To view and configure the most up-to-date file types and versions, update your VDB. For more information, see Updating the Vulnerability Database.
 
     [bookmark: pgfId-4860947]To select file types and versions in an intrusion rule:
 
     
 
     [bookmark: pgfId-4876099]Step 1 On the Create Rule page, select file_type from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4876100]The file_type keyword appears.
 
     [bookmark: pgfId-4876086]Step 2 Select one or more file types from the drop-down list. Selecting a file type automatically adds the argument to the rule.
 ) next to the file type you want to remove. 
     
 
     [bookmark: pgfId-4860959]Step 3 Optionally, customize the target versions for each file type. The system selects Any Version by default, but some file types allow you to select individual target versions.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860960]Note Updating your VDB populates the rule editor with the most up-to-date file types and versions. If you select Any Version, the system configures your rule to include new versions when they are added in later VDB updates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860961]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4876076][bookmark: 12593]file_[bookmark: marker-4876610]group
 
     [bookmark: pgfId-4860968]The file_group keyword allows you to select a Cisco-defined group of similar file types to find in traffic (for example, multimedia or audio). File groups also include Cisco-defined versions for each file type in the group.
 
      
       
     
 
     
 
     [bookmark: pgfId-4929497]Note Do not use the file_group keyword with another file_group or file_type keyword in the same intrusion rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4929498]To view and configure the most up-to-date file groups, update your VDB. For more information, see Updating the Vulnerability Database.
 
     [bookmark: pgfId-4860976]To select a file group in an intrusion rule:
 
     
 
     [bookmark: pgfId-4860981]Step 1 On the Create Rule page, select file_group from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4992679]The file_group keyword appears.
 
     [bookmark: pgfId-4860985]Step 2 Select a file group to add to the rule.
 
     [bookmark: pgfId-4860986]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4796353][bookmark: 90176]Pointing to a Specific Payload Type
 
     [bookmark: pgfId-4239141]License: Protection
 
     [bookmark: pgfId-4080034]The file_data keyword provides a pointer that serves as a reference for the positional arguments available for other keywords such as content, byte_jump, byte_test, and pcre. The detected traffic determines the type of data the file_data keyword points to. You can use the file_data[bookmark: marker-4080035] keyword to point to the beginning of the following payload types:
 
      
      	 [bookmark: pgfId-4929479]HTTP response body
 
     
 
     [bookmark: pgfId-4929480]To inspect HTTP response packets, the HTTP Inspect preprocessor must be enabled and you must configure the preprocessor to inspect HTTP responses. See Decoding HTTP Traffic and Inspect HTTP Responses in Selecting Server-Level HTTP Normalization Options for more information. The file_data keyword matches if the HTTP Inspect preprocessor detects HTTP response body data.
 
      
      	 [bookmark: pgfId-4929441]Uncompressed gzip file data
 
     
 
     [bookmark: pgfId-4929442]To inspect uncompressed gzip files in the HTTP response body, the HTTP Inspect preprocessor must be enabled and you must configure the preprocessor to inspect HTTP responses and to decompress gzip-compressed files in the HTTP response body. For more information, see Decoding HTTP Traffic, and the Inspect HTTP Responses and Inspect Compressed Data options in Selecting Server-Level HTTP Normalization Options. The file_data keyword matches if the HTTP Inspect preprocessor detects uncompressed gzip data in the HTTP response body. 
 
      
      	 [bookmark: pgfId-4929411]Normalized JavaScript
 
     
 
     [bookmark: pgfId-4929412]To inspect normalized JavaScript data, the HTTP Inspect preprocessor must be enabled and you must configure the preprocessor to inspect HTTP responses. See Decoding HTTP Traffic and Inspect HTTP Responses in Selecting Server-Level HTTP Normalization Options for more information. The file_data keyword matches if the HTTP Inspect preprocessor detects JavaScript in response body data.
 
      
      	 [bookmark: pgfId-4929393]SMTP payload
 
     
 
     [bookmark: pgfId-4929396]To inspect the SMTP payload, the SMTP preprocessor must be enabled. See Configuring SMTP Decoding for more information. The file_data keyword matches if the SMTP preprocessor detects SMTP data.
 
      
      	 [bookmark: pgfId-4929390]Encoded email attachments in SMTP, POP, or IMAP traffic
 
     
 
     [bookmark: pgfId-4929644]To inspect email attachments in SMTP, POP, or IMAP traffic, the SMTP, POP, or IMAP preprocessor, respectively, must be enabled, alone or in any combination. Then, for each enabled preprocessor, you must ensure that the preprocessor is configured to decode each attachment encoding type that you want decoded. The attachment decoding options that you can configure for each preprocessor are: Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, and Unix-to-Unix Decoding Depth. See Decoding IMAP Traffic, Decoding POP Traffic, and Decoding SMTP Traffic for more information.
 
     [bookmark: pgfId-4929691]You can use multiple file_data keywords in a rule.
 
     [bookmark: pgfId-4929693]To point to the beginning of a specific payload type:
 
     
 
     [bookmark: pgfId-4215207]Step 1 On the Create Rule page, select file_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4215208]The file_data keyword appears.
 
     [bookmark: pgfId-4215259]The file_data keyword has no arguments.
 
     [bookmark: pgfId-4776961]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4216237][bookmark: 32633]Pointing to the Beginning of the Packet Payload
 
     [bookmark: pgfId-4239164]License: Protection
 
     [bookmark: pgfId-4215275]The pkt_data[bookmark: marker-4215274] keyword provides a pointer that serves as a reference for the positional arguments available for other keywords such as content, byte_jump, byte_test, and pcre.
 
     [bookmark: pgfId-4385996]When normalized FTP, telnet, or SMTP traffic is detected, the pkt_data keyword points to the beginning of the normalized packet payload. When other traffic is detected, the pkt_data keyword points to the beginning of the raw TCP or UDP payload.
 
     [bookmark: pgfId-4386088]The following normalization options must be enabled for the system to normalize the corresponding traffic for inspection by intrusion rules:
 
      
      	 [bookmark: pgfId-4386017]To normalize FTP traffic for inspection, you must enable the FTP and Telnet preprocessor  Detect Telnet Escape codes within FTP commands option; see Configuring Server-Level FTP Options.
 
      	 [bookmark: pgfId-4386031]To normalize telnet traffic for inspection, you must enable the FTP & Telnet preprocessor  Normalize telnet option; see Understanding Telnet Options.
 
      	 [bookmark: pgfId-4386009]To normalize SMTP traffic for inspection, you must enable the SMTP preprocessor  Normalize option; see Understanding SMTP Decoding.
 
     
 
     [bookmark: pgfId-4386002]You can use multiple pkt_data keywords in a rule.
 
     [bookmark: pgfId-4385956]To point to the beginning of the packet payload:
 
     
 
     [bookmark: pgfId-4215280]Step 1 On the Create Rule page, select pkt_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4215281]The pkt_data keyword appears.
 
     [bookmark: pgfId-4019186]The pkt_data keyword has no arguments.
 
     [bookmark: pgfId-4776967]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4215225][bookmark: 43136]Decoding and Inspecting Bas[bookmark: marker-4019292]e6[bookmark: marker-4019301]4 Data
 
     [bookmark: pgfId-4239177]License: Protection
 
     [bookmark: pgfId-4029444]You can use the base64_decode and base64_data keywords in combination to instruct the rules engine to decode and inspect specified data as Base64 data. This can be useful, for example, for inspecting Base64-encoded HTTP Authentication request headers and Base64-encoded data in HTTP PUT and POST requests.
 
     [bookmark: pgfId-4030458]These keywords are particularly useful for decoding and inspecting Base64 data in HTTP requests. However, you can also use them with any protocol such as SMTP that uses the space and tab characters the same way HTTP uses these characters to extend a lengthy header line over multiple lines. When this line extension, which is known as folding, is not present in a protocol that uses it, inspection ends at any carriage return or line feed that is not followed with a space or tab.
 
     [bookmark: pgfId-4024197]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4024205]base64_decode
 
      	 [bookmark: pgfId-4024212]base64_data
 
     
 
    
 
     
      [bookmark: pgfId-4024230][bookmark: 34673]base64_decode
 
     [bookmark: pgfId-4239190]License: Protection
 
     [bookmark: pgfId-4024427]The base64_decode keyword instructs the rules engine to decode packet data as Base64 data. Optional arguments let you specify the number of bytes to decode and where in the data to begin decoding.
 
     [bookmark: pgfId-4024237]You can use the base64_decode keyword once in a rule; it must precede at least one instance of the base64_data keyword. See base64_data for more information.
 
     [bookmark: pgfId-4024845]Before decoding Base64 data, the rules engine unfolds lengthy headers that are folded across multiple lines. Decoding ends when the rules engine encounters any the following:
 
      
      	 [bookmark: pgfId-4024846]the end of a header line
 
      	 [bookmark: pgfId-4024847]the specified number of bytes to decode
 
      	 [bookmark: pgfId-4024848]the end of the packet
 
     
 
      
       
        
        [bookmark: pgfId-4024859]Table 24-60 [bookmark: 74525]Optional base64_decode Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4024863]Argument 
          
  
         	 
           
           [bookmark: pgfId-4024865]Description 
          
  
        
 
         
         	[bookmark: pgfId-4024867]Bytes
  
         	[bookmark: pgfId-4024869]Specifiesthenumberofbytestodecode. When not specified, decoding continues to the end of a header line or the end of the packet payload, whichever comes first. You can specify a positive, non-zero value.
  
        
 
         
         	[bookmark: pgfId-4024871]Offset
  
         	[bookmark: pgfId-4024873]Determines the offset relative to the start of the packet payload or, when you also specify Relative, relative to the current inspection location. You can specify a positive, non-zero value.
  
        
 
         
         	[bookmark: pgfId-4024875]Relative
  
         	[bookmark: pgfId-4024877]Specifies inspection relative to the current inspection location.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4025447]To decode Base64 data:
 
     
 
     [bookmark: pgfId-4024976]Step 1 On the Create Rule page, select base64_decode from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4024977]The base64_decode keyword appears.
 
     [bookmark: pgfId-4024984]Step 2 Optionally, select any of the arguments described in the Optional base64_decode Arguments table.
 
     [bookmark: pgfId-4776981]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4024263][bookmark: 75305]base64_data
 
     [bookmark: pgfId-4239212]License: Protection
 
     [bookmark: pgfId-4024274]The base64_data keyword provides a reference for inspecting Base64 data decoded using the base64_decode keyword. The base64_data keyword sets inspection to begin at the start of the decoded Base64 data. Optionally, you can then use the positional arguments available for other keywords such as content or byte_test to further specify the location to inspect.
 
     [bookmark: pgfId-4028570]You must use the base64_data keyword at least once after using the base64_decode keyword; optionally, you can use base64_data multiple times to return to the beginning of the decoded Base64 data.
 
     [bookmark: pgfId-4030110]Note the following when inspecting Base64 data:
 
      
      	 [bookmark: pgfId-4030111]You cannot use the fast pattern matcher; see Use Fast Pattern Matcher for more information.
 
      	 [bookmark: pgfId-4030115]If you interrupt Base64 inspection in a rule with an intervening HTTP content argument, you must insert another  base64_data  keyword in the rule before further inspecting Base64 data; see HTTP Content Options for more information.
 
     
 
     [bookmark: pgfId-4028573]To inspect decoded Base64 data:
 
     
 
     [bookmark: pgfId-4028585]Step 1 On the Create Rule page, select base64_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4028586]The base64_data keyword appears.
 
     [bookmark: pgfId-4776987]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4019583][bookmark: 84829]Constructing a[bookmark: marker-4019582] Rule
 
    [bookmark: pgfId-4239230]License: Protection
 
    [bookmark: pgfId-2507268]Just as you can create your own custom standard text rules, you can also modify existing standard text rules and shared object rule provided by Cisco and save your changes as a new rule. Note that for shared object rules provided by Cisco, you are limited to modifying rule header information such as the source and destination ports and IP addresses. You cannot modify the rule keywords and arguments in a shared object rule.
 
    [bookmark: pgfId-2507295]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1095404]Writing New Rules
 
     	 [bookmark: pgfId-1095408]Modifying Existing Rules
 
     	 [bookmark: pgfId-2476910]Adding Comments to Rules
 
     	 [bookmark: pgfId-2020997]Deleting Custom Rules
 
    
 
     
      [bookmark: pgfId-1095411][bookmark: 41970]Writing New[bookmark: marker-2334571] Rules
 
     [bookmark: pgfId-4239247]License: Protection
 
     [bookmark: pgfId-2594423]You can create your own standard text rules.
 
     [bookmark: pgfId-2804966]In a custom standard text rule, you set the rule header settings and the rule keywords and arguments. Optionally, you can use the rule header settings to focus the rule to only match traffic using a specific protocol and traveling to or from specific IP addresses or ports.
 
     [bookmark: pgfId-2506899]After you create a new rule, you can find it again quickly using the rule number, which has the format GID:SID:Rev. The rule number for all standard text rules starts with 1. The second part of the rule number, the Snort ID (SID) number, indicates whether the rule is a local rule or a rule provided by Cisco. When you create a new rule, the system assigns the rule the next available Snort ID number for a local rule and saves the rule in the local rule category. Snort ID numbers for local rules start at 1,000,000 and the SID for each new local rule is incremented by one. The last part of the rule number is the revision number. For a new rule, the revision number is one. Each time you modify a custom rule the revision number increments by one.
 
      
       
     
 
     
 
     [bookmark: pgfId-2506911]Note The system assigns a new SID to any custom rule in an intrusion policy that you import. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2506886]To write a custom standard text rule using the rule editor:
 
     
 
     [bookmark: pgfId-1932019]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy > Rule Editor.
 
     [bookmark: pgfId-1938391]The Rule Editor page appears.
 
     [bookmark: pgfId-1938393]Step 2 Click Create Rule.
 
     [bookmark: pgfId-2014599]The Create Rule page appears.
 
     [bookmark: pgfId-1095421]Step 3 In the Message field, enter the message you want displayed with the event. 
 
     [bookmark: pgfId-1203883]For details on event messages, see Defining the Event Message.
 
      
       
     
 
     
 
     [bookmark: pgfId-2288901]Tip You must specify a rule message. Also, the message cannot consist of white space only, one or more quotation marks only, one or more apostrophes only, or any combination of just white space, quotation marks, or apostrophes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1203882]Step 4 From the Classification list, select a classification to describe the type of event.
 
     [bookmark: pgfId-1203895]For details on available classifications, see Defining the Intrusion Event Classification.
 
     [bookmark: pgfId-1203887]Step 5 From the Action list, select the type of rule you would like to create. You can use one of the following:
 
      
       
       	 [bookmark: pgfId-1095422]Select  alert to create a rule that generates an event when traffic triggers the rule.
 
       	 [bookmark: pgfId-1095423]Select  pass to create a rule that ignores traffic that triggers the rule.
 
      
 
     
 
     [bookmark: pgfId-1095424]Step 6 From the Protocol list, select the traffic protocol (tcp, udp, icmp, or ip) of packets you want the rule to inspect.
 
     [bookmark: pgfId-1095427]For more information about selecting a protocol type, see Specifying Protocols.
 
     [bookmark: pgfId-3148405]Step 7 In the Source IPs field, enter the originating IP address or address block for traffic that should trigger the rule. In the Destination IPs field, enter the destination IP address or address block for traffic that should trigger the rule.
 
     [bookmark: pgfId-3148406]For more detailed information about the IP address syntax that the rule editor accepts, see Specifying IP Addresses In Intrusion Rules.
 
     [bookmark: pgfId-1095440]Step 8 In the Source Port field, enter the originating port numbers for traffic that should trigger the rule. In the Destination Port field, enter the receiving port numbers for traffic that should trigger the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3148422]Note The system ignores port definitions in an intrusion rule header when the protocol is set to ip.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3148416]For more detailed information about the port syntax that the rule editor accepts, see Defining Ports in Intrusion Rules.
 
     [bookmark: pgfId-1095450]Step 9 From the Direction list, select the operator that indicates which direction of traffic you want to trigger the rule. You can use one of the following:
 
      
       
       	 [bookmark: pgfId-1095451] Directional to match traffic that moves from the source IP address to the destination IP address
 
       	 [bookmark: pgfId-1095452] Bidirectional to match traffic that moves in either direction
 
      
 
     
 
     [bookmark: pgfId-1253301]Step 10 [bookmark: 19542]From the Detection Options list, select the keyword that you want to use.
 
     [bookmark: pgfId-1255399]Step 11 [bookmark: 29624]Click Add Option.
 
     [bookmark: pgfId-2014646]Step 12 [bookmark: 16848]Enter any arguments that you want to specify for the keyword you added. For more information about rule keywords and how to use them, see Understanding Keywords and Arguments in Rules.
 
     [bookmark: pgfId-2014737]When adding keywords and arguments, you can also perform the following:
 
      
       
       	 [bookmark: pgfId-2014738]To reorder keywords after you add them, click the up or down arrow next to the keyword you want to move.
 
       	 [bookmark: pgfId-2014739]To delete a keyword, click the  X next to that keyword.
 
      
 
     
 
     [bookmark: pgfId-1095487]Repeat steps 10 through 12 for each keyword option you want to add. 
 
     [bookmark: pgfId-2015057]Step 13 Click Save As New to save the rule.
 
     [bookmark: pgfId-2015084]The system assigns the rule the next available Snort ID (SID) number in the rule number sequence for local rules and saves it in the local rule category. 
 
     [bookmark: pgfId-4383252]The system does not begin evaluating traffic against new or changed rules until you enable them within the appropriate intrusion policy, and then apply the intrusion policy as part of an access control policy. See Deploying Configuration Changes for more information.
 
     [bookmark: pgfId-4777009]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4383259][bookmark: 83996]Modifying Existing[bookmark: marker-4383258] Rules
 
     [bookmark: pgfId-4239260]License: Protection
 
     [bookmark: pgfId-2506965]You can modify custom standard text rules. You can also modify a standard text rule or shared object rule provided by Cisco and create one or more new instances of the rule by saving it.
 
     [bookmark: pgfId-2805116]Creating a rule or modifying a Cisco rule copies the new rule or revision to the local rule category and assigns the rule the next available Snort ID (SID) greater than 100000.
 
     [bookmark: pgfId-4161618]You can only modify header information for a shared object rule. You cannot modify the rule keywords used in a shared object rule or their arguments. Modifying header information for a shared object rule and saving your changes creates a new instance of the rule with a generator ID (GID) of 3 and the next available SID for a custom rule. The Rule Editor links the new instance of the shared object rule to the reserved soid keyword, which maps the rule you create to the rule created by the VRT. You can delete instances of a shared object rule that you create, but you cannot delete shared object rules provided by Cisco. See Understanding Rule Headers and Deleting Custom Rules for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4169717]Note Do not modify the protocol for a shared object rule; doing so would render the rule ineffective.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1100200]To modify a rule:
 
     
 
     [bookmark: pgfId-4973734]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy > Rule Editor.
 
     [bookmark: pgfId-1897482]The Rule Editor page appears.
 
     [bookmark: pgfId-3007568]Step 2 Locate the rule or rules you want to modify. You have the following options:
 
      
       
       	 [bookmark: pgfId-3007569]To locate rules by browsing rule categories, navigate through the folders to the rule you want and click the edit icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
       	 [bookmark: pgfId-3048207]To locate a rule or rules by filtering the rules displayed on the page, enter a rule filter in the text box indicated by the filter icon (
 
      
 
      [image: ] ) at the upper left of the rule list. Navigate to the rule you want and click the edit icon ( 
      [image: ] ) next to the rule. See 
      Filtering Rules on the Rule Editor Page for more information. 
     
 
     [bookmark: pgfId-3631181]The rule editor opens, displaying the rule you selected.
 
     [bookmark: pgfId-3631245]Note that if you select a shared object rule, the rule editor displays only the rule header information. A shared object rule can be identified on the Rule Editor page by a listing that begins with the number 3 (the GID), for example, 3:1000004.
 
     [bookmark: pgfId-1777587]Step 3 Make any modifications to the rule (see Writing New Rules for more information about rule options) and click Save As New.
 
     [bookmark: pgfId-1095568]The rule is saved to the local rule category. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1095569]Tip If you want to use the local modification of the rule instead of the system rule, deactivate the system rule by using the procedures at Setting Rule States and activate the local rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1095575]Step 4 Activate the intrusion policy by applying it as part of an access control policy as described in Deploying Configuration Changes to apply your changes.
 
     [bookmark: pgfId-4777015]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1513335][bookmark: 83751]Adding[bookmark: marker-2334573] Comments to Rules
 
     [bookmark: pgfId-4239286]License: Protection
 
     [bookmark: pgfId-1516445]You can add comments to any intrusion rule. This allows you to provide additional context and information about the rule and the exploit or policy violation it identifies.
 
     [bookmark: pgfId-1513389]To add a comment to a rule:
 
     
 
     [bookmark: pgfId-4973750]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy > Rule Editor.
 
     [bookmark: pgfId-3007481]The Rule Editor page appears.
 
     [bookmark: pgfId-3007475]Step 2 Locate the rule you want to annotate. You have the following options:
 
      
       
       	 [bookmark: pgfId-2959639]To locate a rule by browsing rule categories, navigate through the folders to the rule you want and click the edit icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
       	 [bookmark: pgfId-3007413]To locate a rule by filtering the rules displayed on the page, enter a rule filter in the text box, which is indicated by the filter icon (
 
      
 
      [image: ] ), at the upper left of the rule list. Navigate to the rule you want and click the edit icon ( 
      [image: ] ) next to the rule. See 
      Filtering Rules on the Rule Editor Page for more information. 
     
 
     [bookmark: pgfId-2954214]The rule editor appears.
 
     [bookmark: pgfId-2954215]Step 3 Click Rule Comment.
 
     [bookmark: pgfId-1513443]The Rule Comment page appears.
 
     [bookmark: pgfId-1513444]Step 4 Enter your comment in the text box and click Add Comment.
 
     [bookmark: pgfId-1513445]The comment is saved in the comment text box.
 
     [bookmark: pgfId-4777050]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2466837][bookmark: 71747]Deleting Custom Rules
 
     [bookmark: pgfId-4239306]License: Protection
 
     [bookmark: pgfId-2466839]You can delete custom rules that are not currently enabled in an intrusion policy. You cannot delete either standard text rules or shared object rules rules provided by Cisco. 
 
     [bookmark: pgfId-4072447]The system stores deleted rules in the deleted category, and you can use a deleted rule as the basis for a new rule. See Modifying Existing Rules for information on editing rules.
 
     [bookmark: pgfId-2530005]The Rules page in an intrusion policy does not display the deleted category, so you cannot enable deleted custom rules.
 
     [bookmark: pgfId-4152435]Note that you can also delete all local rules on the Rule Updates page. See, for example, Using One-Time Rule Updates.
 
     [bookmark: pgfId-4152444]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4152458]For information on creating custom rules, see Writing New Rules.
 
      	 [bookmark: pgfId-4152557]For information on importing local rules, see Importing Rule Updates and Local Rule Files.
 
      	 [bookmark: pgfId-4152506]For information on setting rule states, see Setting Rule States.
 
     
 
     [bookmark: pgfId-4071699]To delete custom rules:
 
     
 
     [bookmark: pgfId-4973778]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy > Rule Editor.
 
     [bookmark: pgfId-4240350]The Rule Editor page appears.
 
     [bookmark: pgfId-4071706]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-4071789]Click  Delete Local Rules , then click  OK .
 
      
 
     
 
     [bookmark: pgfId-4072151]All rules not currently enabled in an intrusion policy whose changes you have saved are deleted from the local rule category and moved to the deleted category.
 
      
       
       	 [bookmark: pgfId-4071804]Navigate through the folders to the local rule category; click on the local rule category to expand it, then click the delete icon (
 
      
 
      [image: ] ) next to a rule you want to delete. 
     
 
     [bookmark: pgfId-4072001]The rule is deleted from the local rule category and moved to the deleted category.
 
     [bookmark: pgfId-4071710]Note that custom standard text rules have a generator ID (GID) of 1 (for example, 1:1000012) and custom shared object rules have a GID of 3 (for example, 3:1000005).
 
      
       
     
 
     
 
     [bookmark: pgfId-4071725]Tip The system also stores shared object rules that you save with modified header information in the local rule category and lists them with a GID of 3. You can delete your modified version of a shared object rule, but you cannot delete the original shared object rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4777066]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2894499][bookmark: 41353]Filtering Rules on the Rule Editor P[bookmark: marker-3099259]age
 
    [bookmark: pgfId-4239337]License: Protection
 
    [bookmark: pgfId-2975513]You can filter the rules on the Rule Editor page to display a subset of rules. This can be useful, for example, when you want to modify a rule or change its state but have difficulty finding it among the thousands of rules available.
 
    [bookmark: pgfId-2975517]When you enter a filter, the page displays any folder that includes at least one matching rule, or a message when no rule matches. Your filter can include special keywords and their arguments, character strings, and literal character strings in quotes, with spaces separating multiple filter conditions. A filter cannot include regular expressions, wild card characters, or any special operator such as a negation character (!), a greater than symbol (>), less than symbol (<), and so on.
 
    [bookmark: pgfId-2975639]All keywords, keyword arguments, and character strings are case-insensitive. Except for the gid and sid keywords, all arguments and strings are treated as partial strings. Arguments for gid and sid return only exact matches.
 
    [bookmark: pgfId-2975641]Optionally, you can expand a folder on the original, unfiltered page and the folder remains expanded when the subsequent filter returns matches in that folder. This can be useful when the rule you want to find is in a folder that contains a large number of rules.
 
    [bookmark: pgfId-2982728]You cannot constrain a filter with a subsequent filter. Any filter you enter searches the entire rules database and returns all matching rules. When you enter a filter while the page still displays the result of a previous filter, the page clears and returns the result of the new filter instead.
 
    [bookmark: pgfId-2982729]You can use the same features with rules in a filtered or unfiltered list. For example, you can edit rules in a filtered or unfiltered list on the Rule Editor page.
 
    [bookmark: pgfId-2971540]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2971814]Using Keywords in a Rule Filter
 
     	 [bookmark: pgfId-2971865]Using Character Strings in a Rule Filter
 
     	 [bookmark: pgfId-2971899]Combining Keywords and Character Strings in a Rule Filter
 
     	 [bookmark: pgfId-2971912]Filtering Rules
 
    
 
     
      [bookmark: pgfId-2899680][bookmark: 61943]Using Keywor[bookmark: marker-3099260]ds in a Rule Filter
 
     [bookmark: pgfId-4239350]License: Protection
 
     [bookmark: pgfId-2971610]Each rule filter can include one or more keywords in the format:
 
      
      [bookmark: pgfId-2971611]keyword:argument 
     
 
     [bookmark: pgfId-2971615]where keyword is one of the keywords in the Rule Filter Keywords table and argument is a single, case-insensitive, alphanumeric string to search for in the specific field or fields relevant to the keyword.
 
     [bookmark: pgfId-2971616]Arguments for all keywords except gid and sid are treated as partial strings. For example, the argument 123 returns "12345", "41235", "45123", and so on. The arguments for gid and sid return only exact matches; for example, sid:3080 returns only SID 3080.
 
      
       
     
 
     
 
     [bookmark: pgfId-2997592]Tip You can search for a partial SID by filtering with one or more character strings. See Using Character Strings in a Rule Filter for more information.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-2971234]Table 24-61 [bookmark: 60908]Rule Filter Keywords 
 
        
        
         
         	 
           
           [bookmark: pgfId-2971240]Keyword 
          
  
         	 
           
           [bookmark: pgfId-2971242]Description 
          
  
         	 
           
           [bookmark: pgfId-2971244]Example 
          
  
        
 
         
         	[bookmark: pgfId-2971246]arachnids
  
         	[bookmark: pgfId-2971248]Returns one or more rules based on all or part of the Arachnids ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971250]arachnids:181
  
        
 
         
         	[bookmark: pgfId-2971252]bugtraq
  
         	[bookmark: pgfId-2971254]Returns one or more rules based on all or part of the Bugtraq ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971256]bugtraq:2120
  
        
 
         
         	[bookmark: pgfId-2971258]cve
  
         	[bookmark: pgfId-2971260]Returns one or more rules based on all or part of the CVE number in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971262]cve:2003-0109
  
        
 
         
         	[bookmark: pgfId-2971264]gid
  
         	[bookmark: pgfId-2971266]The argument 1 returns standard text rules. The argument 3 returns shared object rules. See Table 21-1 for more information.
  
         	[bookmark: pgfId-2971268]gid:3
  
        
 
         
         	[bookmark: pgfId-2971270]mcafee
  
         	[bookmark: pgfId-2971272]Returns one or more rules based on all or part of the McAfee ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971274]mcafee:10566
  
        
 
         
         	[bookmark: pgfId-2971276]msg
  
         	[bookmark: pgfId-2971278]Returns one or more rules based on all or part of the rule Message field, also known as the event message. See Defining the Event Message for more information.
  
         	[bookmark: pgfId-2971280]msg:chat
  
        
 
         
         	[bookmark: pgfId-2971282]nessus
  
         	[bookmark: pgfId-2971284]Returns one or more rules based on all or part of the Nessus ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971286]nessus:10737
  
        
 
         
         	[bookmark: pgfId-2971288]ref
  
         	[bookmark: pgfId-2971290]Returns one or more rules based on all or part of a single alphanumeric string in a rule reference or in the rule Message field. See Defining the Event Reference and Defining the Event Message for more information.
  
         	[bookmark: pgfId-2971292]ref:MS03-039
  
        
 
         
         	[bookmark: pgfId-2971294]sid
  
         	[bookmark: pgfId-2971296]Returns the rule with the exact Signature ID.
  
         	[bookmark: pgfId-2971298]sid:235
  
        
 
         
         	[bookmark: pgfId-2971300]url
  
         	[bookmark: pgfId-2971302]Returns one or more rules based on all or part of the URL in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971304]url:faqs.org
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2976435][bookmark: 82823]Using Character St[bookmark: marker-3099261]rings in a Rule Filter
 
     [bookmark: pgfId-4239363]License: Protection
 
     [bookmark: pgfId-4998986]Each rule filter can include one or more alphanumeric character strings. Character strings search the rule Message field, Signature ID, and Generator ID. For example, the string 123 returns the strings "Lotus123", "123mania", and so on in the rule message, and also returns SID 6123, SID 12375, and so on. For information on the rule Message field, see Defining the Event Message. 
 
     [bookmark: pgfId-4998993]All character strings are case-insensitive and are treated as partial strings. For example, any of the strings ADMIN, admin, or Admin return "admin", "CFADMIN", "Administrator" and so on.
 
     [bookmark: pgfId-2971691]You can enclose character strings in quotes to return exact matches. For example, the literal string "overflow attempt" in quotes returns only that exact string, whereas a filter comprised of the two strings overflow and attempt without quotes returns "overflow attempt", "overflow multipacket attempt", "overflow with evasion attempt", and so on.
 
    
 
     
      [bookmark: pgfId-2971375][bookmark: 60128]Combining Keywords and Character Strings in [bookmark: marker-3099262]a Rule Filter
 
     [bookmark: pgfId-4239380]License: Protection
 
     [bookmark: pgfId-2971785]You can narrow filter results by entering any combination of keywords, character strings, or both, separated by spaces. The result includes any rule that matches all the filter conditions.
 
     [bookmark: pgfId-2971788]You can enter multiple filter conditions in any order. For example, each of the following filters returns the same rules:
 
      
      	 [bookmark: pgfId-2971789] url:at login attempt cve:200 
 
      	 [bookmark: pgfId-2971790] login attempt cve:200 url:at 
 
      	 [bookmark: pgfId-2971791] login cve:200 attempt url:at 
 
     
 
    
 
     
      [bookmark: pgfId-4725694][bookmark: 76964]Filtering Ru[bookmark: marker-4725693]les
 
     [bookmark: pgfId-4725698]License: Protection
 
     [bookmark: pgfId-4725699]You can filter the rules on the Rule Editor page to display a subset of rules so you can more easily find specific rules. You can then use any of the page features.
 
     [bookmark: pgfId-2901241]To filter for specific rules:
 
     
 
     [bookmark: pgfId-4973795]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy > Rule Editor.
 
     [bookmark: pgfId-3048313]The Rule Editor page appears.
 
     [bookmark: pgfId-3048314]Rule filtering can be particularly useful on the Rule Editor page when you want to locate a rule to edit it. See Modifying Existing Rules for more information.
 
     [bookmark: pgfId-3048326]Step 2 Optionally, select a different grouping method from the Group Rules By list.
 
      
       
     
 
     
 
     [bookmark: pgfId-3048327]Tip Filtering may take significantly longer when the combined total of rules in all sub-groups is large because rules appear in multiple categories, even when the total number of unique rules is much smaller.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3048329]Step 3 [bookmark: 68728]Optionally, click the folder next to any group that you want to expand.
 
     [bookmark: pgfId-2950511]The folder expands to show the rules in that group. Note that some rule groups have sub-groups that you can also expand.
 ). 
     
 ) that is inside the text box at the upper left of the rule list. 
     
 
     [bookmark: pgfId-2901461]Step 5 Type your filter constraints and press Enter.
 
     [bookmark: pgfId-2949383]Your filter can include keywords and arguments, character strings with or without quotes, and spaces separating multiple conditions. See Filtering Rules on the Rule Editor Page for more information.
 
     [bookmark: pgfId-2950531]The page refreshes to display any group that contains at least one matching rule.
 
     [bookmark: pgfId-2901481]Step 6 Optionally, open any folder not already opened to display matching rules. You have the following filtering choices:
 
      
       
       	 [bookmark: pgfId-2901482]To enter a new filter, position your cursor inside the filter text box and click to activate it; type your filter and press Enter.
 
       	 [bookmark: pgfId-3023184]To clear the current filtered list and return to the original, unfiltered page, click the filter clearing icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-3023188]Step 7 Optionally, make any changes to the rule that you would normally make on the page. See Modifying Existing Rules.
 
     [bookmark: pgfId-4439062]To put any changes you make into effect, apply the intrusion policy part of an access control policy as described in Deploying Configuration Changes.
 
     [bookmark: pgfId-4777106]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2889271]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3626974]Introduction to Identity Data 
      
      
 
     
 
 
    [bookmark: pgfId-3653716]You can configure identity policies to use User Agents, ISE devices, or captive portal to obtain data about the users on your network.
 
   
 
    
     [bookmark: pgfId-3653787]Uses for Identity Data
 
    [bookmark: pgfId-3653837]Collecting identity data allows you to take advantage of many features, including:
 
     
     	 [bookmark: pgfId-3654027]perform user control by writing access control rules using realm, user, user group, and ISE attribute conditions
 
     	 [bookmark: pgfId-3654184]alert you via SNMP trap or syslog when the system generates an intrusion event with a specific impact flag
 
    
 
     
      [bookmark: pgfId-3658475][bookmark: 98562]User Detection Fundamentals
 
     [bookmark: pgfId-3658597]You can use your identity policies to monitor user activity on your network, which allows you to correlate threat, endpoint, and network intelligence with user identity information. By linking network behavior, traffic, and events directly to individual users, the system can help you to identify the source of policy breaches, attacks, or network vulnerabilities. For example, you could determine:
 
      
      	 [bookmark: pgfId-3658510]who owns the host targeted by an intrusion event that has a Vulnerable (level 1: red) impact level
 
      	 [bookmark: pgfId-3658649]who initiated an internal attack or portscan
 
      	 [bookmark: pgfId-3658651]who is attempting unauthorized access of a server that has high host criticality
 
      	 [bookmark: pgfId-3658660]who is consuming an unreasonable amount of bandwidth
 
      	 [bookmark: pgfId-3658673]who has not applied critical operating system updates
 
      	 [bookmark: pgfId-3658787]who is using instant messaging software or peer-to-peer file-sharing applications in violation of company IT policy
 
     
 
     [bookmark: pgfId-3658900]Armed with this information, you can use other features of the ASA FirePOWER module to mitigate risk, perform access control, and take action to protect others from disruption. These capabilities also significantly improve audit controls and enhance regulatory compliance.
 
     [bookmark: pgfId-3658901]After you configure user identity sources, you can perform user awareness and user control.
 
     [bookmark: pgfId-3659138]User awareness
 
     [bookmark: pgfId-3659139]The ability to view and analyze user data
 
     [bookmark: pgfId-3659140]User control
 
     [bookmark: pgfId-3659160]The ability to configure user access control rule conditions to block users or user activity in traffic on your network, based on conclusions you drew from user awareness.
 
     [bookmark: pgfId-3659206]You can obtain user data from authoritative identity sources (referenced by your identity policy).
 
     [bookmark: pgfId-3659269]An identity source is authoritative if a trusted server validated the user login. You can use the data obtained from authoritative logins to perform user awareness and user control. Authoritative user logins are obtained from passive and active authentications:
 
      
      	 [bookmark: pgfId-3663508] Passive authentications occur when a user authenticates through an external server. The User Agent and ISE are the only passive authentication methods supported by the ASA FirePOWER module.
 
      	 [bookmark: pgfId-3663509] Active authentications occur when a user authenticates through a Firepower device. Captive portal is the only active authentication method supported by the ASA FirePOWER module.
 
     
 
     [bookmark: pgfId-3659554]The following table provides a brief overview of the user identity sources supported by the ASA FirePOWER module.
 
     [bookmark: pgfId-3659557]
 
      
       
        
        [bookmark: pgfId-3669774]Table 29-1 
 
        
        
         
         	 
           
           [bookmark: pgfId-3669788]User Identity Source 
          
  
         	 
           
           [bookmark: pgfId-3669790]Server Requirements 
          
  
         	 
           
           [bookmark: pgfId-3669792]Source Type 
          
  
         	 
           
           [bookmark: pgfId-3669794]Authentication Type 
          
  
         	 
           
           [bookmark: pgfId-3669796]User Awareness? 
          
  
         	 
           
           [bookmark: pgfId-3669798]User Access Control? 
          
  
         	 
           
           [bookmark: pgfId-3669800]For more information, see... 
          
  
        
 
         
         	[bookmark: pgfId-3669802]User Agent
  
         	[bookmark: pgfId-3669804]Microsoft Active Directory
  
         	[bookmark: pgfId-3669806]authoritative logins
  
         	[bookmark: pgfId-3669808]passive
  
         	[bookmark: pgfId-3669810]Yes
  
         	[bookmark: pgfId-3669812]Yes
  
         	[bookmark: pgfId-3669816]The User Agent Identity Source
  
        
 
         
         	[bookmark: pgfId-3669819]ISE
  
         	[bookmark: pgfId-3669821]Microsoft Active Directory
  
         	[bookmark: pgfId-3669823]authoritative logins
  
         	[bookmark: pgfId-3669825]passive
  
         	[bookmark: pgfId-3669827]Yes
  
         	[bookmark: pgfId-3669829]Yes
  
         	[bookmark: pgfId-3669833]The Identity Services Engine (ISE) Identity Source
  
        
 
         
         	[bookmark: pgfId-3669836]Captive portal
  
         	[bookmark: pgfId-3669838]LDAP or Microsoft Active Directory
  
         	[bookmark: pgfId-3669840]authoritative logins
  
         	[bookmark: pgfId-3669842]active
  
         	[bookmark: pgfId-3669844]Yes
  
         	[bookmark: pgfId-3669846]Yes
  
         	[bookmark: pgfId-3669850]The Captive Portal Identity Source
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3659513]Consider the following when selecting identity sources to deploy:
 
      
      	 [bookmark: pgfId-3660955]you must use captive portal to record failed authentication activity. A failed authentication attempt does not add a new user to the list of users in the database.
 
      	 [bookmark: pgfId-3660991]you must deploy an appliance that has an IP address for its sensing interface (for example, a routed interface) in order to use captive portal.
 
     
 
     [bookmark: pgfId-3661006]User Identity Deployments
 
     [bookmark: pgfId-3661036]When the system detects user data from a user login, from any identity source, the user from the login is checked against the list of users in the user database. If the login user matches an existing user, the data from the login is assigned to the user. Logins that do not match existing users cause a new user to be created, unless the login is in SMTP traffic. Non-matching logins in SMTP traffic are discarded.
 
    
 
     
      [bookmark: pgfId-3661082]The User Activity Database
 
     [bookmark: pgfId-3661158]The user activity database on the device contains records of user activity on your network reported by all of your configured identity sources. The system logs events in the following circumstances:
 
      
      	 [bookmark: pgfId-3661201]when it detects individual logins or logoffs
 
      	 [bookmark: pgfId-3661225]when it detects a new user
 
      	 [bookmark: pgfId-3661231]when you manually delete a user
 
      	 [bookmark: pgfId-3661307]when the system detects a user that is not in the database, but cannot add the user because you have reached your user limit
 
     
 
    
 
     
      [bookmark: pgfId-3661326]The Users Database
 
     [bookmark: pgfId-3661422]The users database contains a record for each user reported by your configured identity sources.
 
      
      	 [bookmark: pgfId-3661663]The total number of users the device can store depends on the model. When the limit has been reached, you must delete users (manually or with a database purge) to allow new users to be added. 
 
     
 
     [bookmark: pgfId-3663628]If an identity source is configured to exclude specific user names, user activity data for those user names are not reported to the ASA FirePOWER module. These excluded user names remain in the database, but are not associated with IP addresses.
 
    
 
     
      [bookmark: pgfId-3661588]Current User Identities
 
     [bookmark: pgfId-3661858]When the system detects multiple logins to the same host by different users, the system assumes that only one user is logged into any given host at a time, and that the current user of a host is the last authoritative user login. If multiple users are logged in through remote sessions, the last user reported by the server is the user reported to the ASA FirePOWER module.
 
     [bookmark: pgfId-3661884]When the system detects multiple logins to the same host by the same user, the system records the first time that a user logs into a specific host and disregards subsequent logins. If an individual user is the only person who logs into a specific host, the only login that the system records is the original login.
 
     [bookmark: pgfId-3661920]If another user logs into that host, however, the system records the new login. Then, if the original user logs in again, his or her new login is recorded.
 
    
 
     
      [bookmark: pgfId-3663672]User Database Limits
 
     [bookmark: pgfId-3663673]Your device model determines how many users you can monitor, as well as how many users you can use to perform user control.
 
      
       
     
 
     
 
     [bookmark: pgfId-3662166]Note If your deployment includes an ASA5506-X, ASA5508-X, or ASA5516-X device, you can store a maximum of 2,000 authoritative users.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3662712]The ASA FirePOWER User Limit
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3405103]Realms and Identity Policies 
      
      
 
     
 
 
    [bookmark: pgfId-3569086]A realm consists of one or more LDAP or Microsoft Active Directory servers that share the same credentials. You must configure a realm if you want to perform user and user group queries, user access control, or to configure a User Agent, ISE, or captive portal. After configuring one or more realms, you can configure an identity policy.
 
    [bookmark: pgfId-3569100]An identity policy associates traffic on your network with an authoritative identity source and a realm. After configuring your identity policy, you can associate it with an access control policy and deploy the access control policy to your device.
 
   
 
    
     [bookmark: pgfId-3569088]Realm Fundamentals
 
    [bookmark: pgfId-3606672]License: Any
 
    [bookmark: pgfId-3569406]Realms establish connections between the ASA FirePOWER module and the servers targeted for monitoring. They specify the connection settings and authentication filter settings for the server. Realms can:
 
     
     	 [bookmark: pgfId-3501774]specify the users and user groups whose activity you want to monitor.
 
     	 [bookmark: pgfId-3569434]allow you to query the server for user metadata on authoritative users.
 
    
 
    [bookmark: pgfId-3569734]You can add multiple servers as directories within a realm, but they must share the same basic realm information. The directories within a realm must be exclusively LDAP or exclusively AD servers. After you enable a realm, your saved changes take effect next time the ASA FirePOWER module queries the server.
 
    [bookmark: pgfId-3570873]To perform user awareness, you must configure a realm for any of the supported server types. The module uses these connections to query the servers for data associated with POP3 and IMAP users. The module uses the email addresses in POP3 and IMAP logins to correlate with LDAP users on an Active Directory, OpenLDAP, or Oracle Directory Server Enterprise Edition server. For example, if a device detects a POP3 login for a user with the same email address as an LDAP user, the module associates the LDAP user’s metadata with that user.
 
    [bookmark: pgfId-3570874]To perform user access control, you can configure the following:
 
     
     	 [bookmark: pgfId-3570894]a realm for an AD server configured for either a User Agent or ISE device.
 
     	 [bookmark: pgfId-3570912]a realm for an Oracle or OpenLDAP server configured for captive portal.
 
    
 
    [bookmark: pgfId-3570997]If you configure a realm to download users (for user awareness or user control), the ASA FirePOWER module regularly queries the server to obtain metadata for new and updated users whose activity was detected since the last query.
 
    [bookmark: pgfId-3571036]User activity data is stored in the user activity database and user identity data is stored in the users database. The maximum number of users you can store and use in access control depends on your device model. When choosing which users and groups to include, make sure the total number of users is less than your model limit. If your access control parameters are too broad, the ASA FirePOWER module obtains information on as many users as it can and reports the number of users it failed to retrieve in the task queue.
 
     
      
    
 
    
 
    [bookmark: pgfId-3571244]Note If you remove a user that has been detected by the module from your LDAP servers, the ASA FirePOWER module does not remove that user from its users database; you must manually delete it. However, your LDAP changes are reflected in access control rules when the ASA FirePOWER module next updates its list of authoritative users.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3570877]Supported Servers for Realms
 
     [bookmark: pgfId-3551806]License: Any
 
     [bookmark: pgfId-3573125]You can configure realms to connect to the following types of servers, providing they have TCP/IP access from the ASA FirePOWER module:
 
     [bookmark: pgfId-3573126]
 
      
       
        
        [bookmark: pgfId-3573451]Table 30-1 Supported Servers for Realms
 
        
        
         
         	 
           
           [bookmark: pgfId-3573459]Server Type 
          
  
         	 
           
           [bookmark: pgfId-3573706]Supported for user awareness data retrieval? 
          
  
         	 
           
           [bookmark: pgfId-3573734]Supported for User Agent data retrieval? 
          
  
         	 
           
           [bookmark: pgfId-3573771]Supported for ISE data retrieval? 
          
  
         	 
           
           [bookmark: pgfId-3573784]Supported for captive portal data retrieval? 
          
  
        
 
         
         	[bookmark: pgfId-3573834]Microsoft Active Directory on Windows Server 2003, Windows Server 2008, and Windows Server 2012
  
         	[bookmark: pgfId-3573933]Yes
  
         	[bookmark: pgfId-3573471]Yes
  
         	[bookmark: pgfId-3573473]Yes
  
         	[bookmark: pgfId-3573592]Yes, except Windows Server 2003 if you are using NTLM captive portal
  
        
 
         
         	[bookmark: pgfId-3573475]Oracle Directory Server Enterprise Edition 7.0 on Windows Server 2003 and Windows Server 2008
  
         	[bookmark: pgfId-3573477]Yes
  
         	[bookmark: pgfId-3573479]No
  
         	[bookmark: pgfId-3573481]No
  
         	[bookmark: pgfId-3573594]Yes
  
        
 
         
         	[bookmark: pgfId-3573483]OpenLDAP on Linux
  
         	[bookmark: pgfId-3573485]Yes
  
         	[bookmark: pgfId-3573487]No
  
         	[bookmark: pgfId-3573489]No
  
         	[bookmark: pgfId-3573596]Yes
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3613567]Note the following about your server group configurations:
 
      
      	 [bookmark: pgfId-3613568]If you want to perform user control on user groups or on users within groups, you must configure user groups on the server. The ASA FirePOWER module cannot perform user group control if the server organizes the users in basic object hierarchy.
 
     
 
     [bookmark: pgfId-3613602]Cisco recommends that you limit the size of your LDAP or AD server groups to contain a maximum of 1500 users. Configuring realms to include or exclude oversized groups, or creating access control rules that target oversized user groups may result in performance issues.
 
      
      	 [bookmark: pgfId-3613611]By default, AD servers limit the number of users they report from secondary groups. You must customize this limit so that all of the users in your secondary groups are reported to the ASA FirePOWER module.
 
     
 
    
 
     
      [bookmark: pgfId-3613569]Supported Server Field Names
 
     [bookmark: pgfId-3573133]License: Any
 
     [bookmark: pgfId-3574344]The servers in your realms must use the field names listed in the following table in order for the ASA FirePOWER module to retrieve user metadata the servers. If the field names are incorrect on your server, the ASA FirePOWER module cannot populate its database with the information in that field.
 
     [bookmark: pgfId-3575455]
 
      
       
        
        [bookmark: pgfId-3575406]Table 30-2 Mapping Server Fields to ASA FirePOWER Fields
 
        
        
         
         	 
           
           [bookmark: pgfId-3575416]Metadata 
          
  
         	 
           
           [bookmark: pgfId-3575418]ASA FirePOWER module 
          
  
         	 
           
           [bookmark: pgfId-3575420]Active Directory 
          
  
         	 
           
           [bookmark: pgfId-3575422]Oracle Directory Server 
          
  
         	 
           
           [bookmark: pgfId-3575424]OpenLDAP 
          
  
        
 
         
         	[bookmark: pgfId-3575426]LDAP user name
  
         	[bookmark: pgfId-3575428]Username
  
         	[bookmark: pgfId-3575430]samaccountname
  
         	[bookmark: pgfId-3575432]cn
 [bookmark: pgfId-3577744]uid
  
         	[bookmark: pgfId-3575434]cn
 [bookmark: pgfId-3577769]uid
  
        
 
         
         	[bookmark: pgfId-3575436]first name
  
         	[bookmark: pgfId-3575438]First Name
  
         	[bookmark: pgfId-3575440]givenname
  
         	[bookmark: pgfId-3575442]givenname
  
         	[bookmark: pgfId-3575444]givenname
  
        
 
         
         	[bookmark: pgfId-3575446]last name
  
         	[bookmark: pgfId-3575448]Last Name
  
         	[bookmark: pgfId-3575450]sn
  
         	[bookmark: pgfId-3575452]sn
  
         	[bookmark: pgfId-3575454]sn
  
        
 
         
         	[bookmark: pgfId-3577417]email address
  
         	[bookmark: pgfId-3577419]Email
  
         	[bookmark: pgfId-3577421]mail
 [bookmark: pgfId-3577832]userprincipalname (if mail has no value)
  
         	[bookmark: pgfId-3577423]mail
  
         	[bookmark: pgfId-3577425]mail
  
        
 
         
         	[bookmark: pgfId-3577516]department
  
         	[bookmark: pgfId-3577518]Department
  
         	[bookmark: pgfId-3577520]department
 [bookmark: pgfId-3577892]distinguishedname (if department has novalue)
  
         	[bookmark: pgfId-3577522]department
  
         	[bookmark: pgfId-3577524]ou
  
        
 
         
         	[bookmark: pgfId-3577506]telephone number
  
         	[bookmark: pgfId-3577508]Phone
  
         	[bookmark: pgfId-3577510]telephonenumber
  
         	[bookmark: pgfId-3577512]n/a
  
         	[bookmark: pgfId-3577514]telephonenumber
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3613818]Troubleshooting Issues with Realms
 
     [bookmark: pgfId-3613819]License: Any
 
     [bookmark: pgfId-3613863]If you notice unexpected server connection behavior, consider tuning your realm configuration, device settings, or server settings.
 
     [bookmark: pgfId-3613893]User timeouts are occurring at unexpected times
 
     [bookmark: pgfId-3613978]If you notice the system performing user timeouts at unexpected intervals, confirm that the time on your User Agent or ISE device is synchronized with the time on the ASA FirePOWER module. If the appliances are not synchronized, the system may perform user timeouts at unexpected intervals.
 
     [bookmark: pgfId-3613997]Users are not included or excluded as specified in your realm configuration
 
     [bookmark: pgfId-3614015]If you configure a realm for an Active Directory server that includes or excludes users who are members of a secondary group on your Active Directory server, your server may be limiting the number of users it reports.
 
     [bookmark: pgfId-3614029]By default, Active Directory servers limit the number of users they report from secondary groups. You must customize this limit so that all of the users in your secondary groups are reported to the ASA FirePOWER module.
 
     [bookmark: pgfId-3614043]User download is slow
 
     [bookmark: pgfId-3614052]If you notice that user download is slow, confirm that your LDAP and AD server groups contain a maximum of 1500 users. Configuring realms to include or exclude oversized user groups may result in performance issues. 
 
    
 
     
      [bookmark: pgfId-3613820]Identity Policy Fundamentals
 
     [bookmark: pgfId-3614267]License: Any
 
     [bookmark: pgfId-3613821]Identity policies contain identity rules. Identity rules associate sets of traffic with a realm and an authentication method: passive authentication, active authentication, or no authentication.
 
     [bookmark: pgfId-3575949]You must fully configure the realms and authentication methods you plan to use before you can invoke them in your identity rules:
 
      
      	 [bookmark: pgfId-3575457]You configure realms outside of your identity policy, at  Configuration > ASA FirePOWER Configuration > Integration > Realms .
 
      	 [bookmark: pgfId-3576243]You configure the passive authentication identity sources, the User Agent and ISE, at  Configuration > ASA FirePOWER Configuration > Integration > Identity Sources .
 
      	 [bookmark: pgfId-3576258]You configure the active authentication identity source, captive portal, within the identity policy.
 
     
 
     [bookmark: pgfId-3576274]After you configure one or more identity policies, you must invoke one identity policy in your access control policy. When traffic on your network matches the conditions in your identity rule and the authentication method is passive or active, the module associates the traffic with the specified realm and authenticates the users in the traffic using the specified identity source.
 
     [bookmark: pgfId-3576387]If you do not configure an identity policy, the module does not perform user authentication.
 
    
 
     
      [bookmark: pgfId-3575461][bookmark: 35846]Creating a Realm
 
     [bookmark: pgfId-3606694]License: Control
 
     [bookmark: pgfId-3575463]To create a realm:
 
     
 
     [bookmark: pgfId-3575393]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration.
 
     [bookmark: pgfId-3578794]Step 2 Click Realms.
 
     [bookmark: pgfId-3578795]Step 3 Click New Realm.
 
     [bookmark: pgfId-3464144]Step 4 Configure basic realm information as described in Configuring Basic Realm Information.
 
     [bookmark: pgfId-3464146]Step 5 Configure directories as described in Configuring a Realm Directory.
 
     [bookmark: pgfId-3579081]Step 6 Configure user and user group download (required for access control) as described in Configuring Automatic User Download.
 
     [bookmark: pgfId-3579013]Step 7 Save the realm settings.
 
     [bookmark: pgfId-3579169]Step 8 Optionally, edit the realm and modify the default User Session Timeout settings as described in Configuring Realm User Session Timeouts.
 
     [bookmark: pgfId-3579057]Step 9 Save the realm settings.
 
     [bookmark: pgfId-3464151]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3604971]What to Do Next
 
      
      	 [bookmark: pgfId-3605059]Enable the realm as described in Enabling or Disabling a Realm.
 
      	 [bookmark: pgfId-3605060]Optionally, monitor the task status; see the Task Status page ( Monitoring > ASA FirePOWER Monitoring > Task Status ).
 
     
 
    
 
     
      [bookmark: pgfId-3605061]Realm Fields
 
     [bookmark: pgfId-3405766]License: Any
 
     [bookmark: pgfId-3464300]The following fields are used to configure a realm.
 
    
 
     
      [bookmark: pgfId-3580874] Realm Configuration Fields 
 
     [bookmark: pgfId-3580533]AD Primary Domain
 
     [bookmark: pgfId-3580552]For AD realms only, the domain for the Active Directory server where users should be authenticated.
 
     [bookmark: pgfId-3580570]Description
 
     [bookmark: pgfId-3580588]An optional description for the realm.
 
     [bookmark: pgfId-3580606]Directory Username and Directory Password
 
     [bookmark: pgfId-3580977]The distinguished username and password for a user with appropriate rights to the user information you want to retrieve.
 
     [bookmark: pgfId-3580654]Base DN
 
     [bookmark: pgfId-3580672]The directory tree on the server where the ASA FirePOWER module should begin searching for user data.
 
     [bookmark: pgfId-3581091]Typically, the base DN has a basic structure indicating the company domain and operational unit. For example, the Security organization of the Example company might have a base DN of ou=security,dc=example,dc=com.
 
     [bookmark: pgfId-3581092]Group DN
 
     [bookmark: pgfId-3581117]The directory tree on the server where the ASA FirePOWER module should search for users with the group attribute.
 
     [bookmark: pgfId-3580709]Group Attribute
 
     [bookmark: pgfId-3580787]The group attribute for the server: Member, Unique Member, or Custom.
 
     [bookmark: pgfId-3580801]Name
 
     [bookmark: pgfId-3580811]A unique name for the realm.
 
     [bookmark: pgfId-3580821]Type
 
     [bookmark: pgfId-3581574]The type of realm, AD or LDAP.
 
     [bookmark: pgfId-3581666]User Session Timeout: Authenticated Users
 
     [bookmark: pgfId-3581672]The maximum amount of time, in minutes, before a user's session is timed out.
 
     [bookmark: pgfId-3582112]If a user was passively authenticated and their session times out, they are identified as Unknown and their current session is allowed or blocked depending on their access control rule settings. The module re-identifies the user the next time they log in.
 
     [bookmark: pgfId-3581684]If a user was actively authenticated (captive portal) and their session times out, they are prompted to re-authenticate.
 
     [bookmark: pgfId-3581705]User Session Timeout: Failed Authentication Users
 
     [bookmark: pgfId-3582316]The amount of time, in minutes, after a failed active authentication attempt that a user's session is timed out. When a user fails to authenticate and their session times out, they are prompted to re-authenticate.
 
     [bookmark: pgfId-3581865]User Session Timeout: Guest Users
 
     [bookmark: pgfId-3582435]The maximum amount of time, in minutes, before an actively authenticated (captive portal) guest user's session is timed out. When their session times out, they are prompted to re-authenticate.
 
    
 
     
      [bookmark: pgfId-3581896]Realm Directory Fields
 
     [bookmark: pgfId-3614331]These settings apply to individual servers (directories) within a realm.
 
     [bookmark: pgfId-3581898]Encryption
 
     [bookmark: pgfId-3581900]The encryption method you want to use for the server connection. If you specify an Encryption method, you must specify a host name in this field.
 
     [bookmark: pgfId-3581914]Hostname / IP Address
 
     [bookmark: pgfId-3581929]The hostname or IP address for the server.
 
     [bookmark: pgfId-3581947]Port
 
     [bookmark: pgfId-3582734]The port you want to use for the server connection.
 
     [bookmark: pgfId-3582752]SSL Certificate
 
     [bookmark: pgfId-3583022]The SSL certificate you want to use for authentication to the server. You must configure the Encryption type in order to use an SSL certificate.
 
     [bookmark: pgfId-3583043]If you are using a certificate to authenticate, the name of the server in the certificate must match the server Hostname / IP Address. For example, if you use 10.10.10.250 as the IP address but computer1.example.com in the certificate, the connection fails.
 
    
 
     
      [bookmark: pgfId-3582789]User Download Fields
 
     [bookmark: pgfId-3583154]Download for access control
 
     [bookmark: pgfId-3583231]Selecting this check box configures the automatic download of user data. You can use the data for user awareness and, in some cases, user access control.
 
     [bookmark: pgfId-3583321]Use the Begin automatic download at and Repeat every drop-down menus to configure the download frequency.
 
    
 
     
      [bookmark: pgfId-3464399][bookmark: 29093]Configuring Basic Realm Information
 
     [bookmark: pgfId-3606714]License: Control
 
     [bookmark: pgfId-3464400]To configure basic realm information:
 
     
 
     [bookmark: pgfId-3464405]Step 1 On the Add New Realm page, type a Name and, optionally, a Description.
 
     [bookmark: pgfId-3464410]Step 2 Select a Type from the drop-down list.
 
     [bookmark: pgfId-3464412]Step 3 If you are configuring an AD realm, enter an AD Primary Domain.
 
     [bookmark: pgfId-3583893]Step 4 Enter a distinguished Directory Username and Directory Password for a user with appropriate rights to the user information you want to retrieve.
 
     [bookmark: pgfId-3464425]Step 5 Enter a Base DN for the directory.
 
     [bookmark: pgfId-3464427]Step 6 Enter a Group DN for the directory.
 
     [bookmark: pgfId-3583806]Step 7 Optionally, select a Group Attribute from the drop-down list.
 
     [bookmark: pgfId-3583820]Step 8 Click OK.
 
     [bookmark: pgfId-3406776]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3585174]What to Do Next
 
      
      	 [bookmark: pgfId-3585202]Configure the realm directory as described in Configuring a Realm Directory.
 
     
 
    
 
     
      [bookmark: pgfId-3549936][bookmark: 55972]Configuring a Realm Directory
 
     [bookmark: pgfId-3606732]License: Control
 
     [bookmark: pgfId-3463759]To configure a realm directory:
 
     
 
     [bookmark: pgfId-3463764]Step 1 On the Directory tab, click Add Directory.
 
     [bookmark: pgfId-3463769]Step 2 Enter the Hostname / IP Address and Port for the server.
 
     [bookmark: pgfId-3463771]Step 3 Select an Encryption Mode.
 ) to create an object on the fly. 
     
 
     [bookmark: pgfId-3463789]Step 5 If you want to test the connection, click Test.
 
     [bookmark: pgfId-3465773]Step 6 Click OK.
 
     [bookmark: pgfId-3532586]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3586399]What to Do Next
 
      
      	 [bookmark: pgfId-3586424]Optionally, configure automatic user download as described in Configuring Automatic User Download.
 
     
 
    
 
     
      [bookmark: pgfId-3532625][bookmark: 45885]Configuring Automatic User Download
 
     [bookmark: pgfId-3532632]License: Control
 
     [bookmark: pgfId-3586476]If you do not specify any groups to include, the ASA FirePOWER module retrieves user data for all the groups that match the parameters you provided. For performance reasons, Cisco recommends that you explicitly include only the groups that represent the users you want to use in access control.
 
     [bookmark: pgfId-3532663]To configure automatic user download:
 
     
 
     [bookmark: pgfId-3587847]Step 1 On the User Download tab, select the Download users and groups (required for user access control) check box.
 
     [bookmark: pgfId-3532673]Step 2 Select a time to Begin automatic download at from the drop-down lists.
 
     [bookmark: pgfId-3532675]Step 3 Select a download interval from the Repeat Every drop-down list.
 
     [bookmark: pgfId-3588366]Step 4 To include or exclude user groups from the download, select user groups from the Available Groups column and click Add to Include or Add to Exclude.
 
     [bookmark: pgfId-3620165]Step 5 To include or exclude individual users, type the user into the field below Groups to Include or Groups to Exclude and click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-3588123]Note Excluding users from download prevents you from writing an access control rule with that user as a condition. Separate multiple users with commas. You can also use an asterisk (*) as a wildcard character in this field.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3532684]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3532589][bookmark: 23405]Configuring Realm User Session Timeouts
 
     [bookmark: pgfId-3606750]License: Control
 
      
       
     
 
     
 
     [bookmark: pgfId-3614614]Note If the module is performing user timeouts at unexpected intervals, confirm that the time on your User Agent or ISE device is synchronized with the time on the ASA FirePOWER module.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3587348]To configure realm user session timeouts:
 
     
 
     [bookmark: pgfId-3587353]Step 1 Select the Realm Configuration tab.
 
     [bookmark: pgfId-3587358]Step 2 Enter user session timeout values for Authenticated Users, Failed Authentication Users, and Guest Users.
 
     [bookmark: pgfId-3587360]Step 3 Click Save or continue editing the realm.
 
     [bookmark: pgfId-3587369]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3405841][bookmark: 96685]Configuring an Identity Policy
 
     [bookmark: pgfId-3606776]License: Control
 
     [bookmark: pgfId-3589489]Before You Begin
 
      
      	 [bookmark: pgfId-3589789]Create and enable one or more realms as described in Creating a Realm.
 
     
 
     [bookmark: pgfId-3589719]To configure an Identity Policy:
 
     [bookmark: pgfId-3589527]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3589528]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Identity Policy.
 
     [bookmark: pgfId-3589529]Step 2 Type a Name and, optionally, a Description.
 
     [bookmark: pgfId-3589832]Step 3 If you want to add a rule to the policy, click Add Rule as described in Creating an Identity Rule
 
     [bookmark: pgfId-3589859]Step 4 If you want to add a rule category, click Add Category as described in Adding an Identity Rule Category
 
     [bookmark: pgfId-3589878]Step 5 If you want to configure active authentication using captive portal, click Active Authentication as described in Configuring Captive Portal (Active Authentication).
 
     [bookmark: pgfId-3589531]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3614779]What to Do Next
 
      
      	 [bookmark: pgfId-3614767]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3469992]Captive Portal (Active Authentication) Fields
 
     [bookmark: pgfId-3504041]License: Any
 
     [bookmark: pgfId-3614802]Use the following fields to configure captive portal.
 
     [bookmark: pgfId-3470070]Server Certificate
 
     [bookmark: pgfId-3470071]The server certificate presented by the captive portal daemon.
 
     [bookmark: pgfId-3470081]Port
 
     [bookmark: pgfId-3627448]The port number you want to use for the captive portal connection. The port number in this field must match the port number you configured on the ASA FirePOWER device using the captive-portal CLI command.
 
     [bookmark: pgfId-3590578]Maximum login attempts
 
     [bookmark: pgfId-3590580]The maximum allowed number of failed login attempts before the module denies a user's login request.
 
     [bookmark: pgfId-3590582]Active Authentication Response Page
 
     [bookmark: pgfId-3590685]The ASA FirePOWER module-provided or custom HTTP response page you want to display to captive portal users. You must configure an identity rule with HTTP Response Page as the Authentication Type if you want to display a response page.
 
    
 
     
      [bookmark: pgfId-3591424][bookmark: 26373]Configuring Captive Portal (Active Authentication)
 
     [bookmark: pgfId-3606802]License: Control
 
     [bookmark: pgfId-3591439]For more information about captive portal, see The Captive Portal Identity Source.
 
     [bookmark: pgfId-3591440]Before You Begin
 
      
      	 [bookmark: pgfId-3591441]Confirm that your device manages one or more ASA FirePOWER devices in routed mode running Version 9.5(2) or later.
 
      	 [bookmark: pgfId-3591442]Configure an access control rule to allow traffic destined for the port you plan to use for captive portal.
 
      	 [bookmark: pgfId-3591443]If you want to perform active authentication via captive portal on HTTPS traffic, you must create SSL rules to decrypt the traffic originating from the users you want to authenticate using captive portal.
 
      	 [bookmark: pgfId-3626999]If you want to decrypt traffic in the captive portal connection, create an SSL rule to decrypt the traffic destined for the port you plan to use for captive portal.
 
      	 [bookmark: pgfId-3627000]Use the  captive-portal ASA CLI command to enable captive portal for active authentication and define the port as described in the ASA Firewall Configuration Guide (Version 9.5(2) or later):  http://www.cisco.com/c/en/us/support/security/asa-5500-series-next-generation-firewalls/products-installation-and-configuration-guides-list.html. 
 
     
 
     [bookmark: pgfId-3591445]To configure captive portal:
 
     
 
     [bookmark: pgfId-3591582]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Identity Policy and edit an identity policy.
 
     [bookmark: pgfId-3591455]Step 2 Click Active Authentication.
 ) to create an object on the fly. 
     
 
     [bookmark: pgfId-3591462]Step 4 Type a Port and specify the Maximum login attempts.
 
     [bookmark: pgfId-3591935]Step 5 Optionally, to authenticate users through a HTTP response page, select an Active Authentication Response Page.
 
     [bookmark: pgfId-3591470]Step 6 Click Save.
 
     [bookmark: pgfId-3592020]Step 7 Configure an identity rule with Active Authentication as the Action as described in Creating an Identity Rule. If you selected a response page in step 5, you must also select HTTP Response Page as the Authentication Type.
 
     [bookmark: pgfId-3591475]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3614889]What to Do Next
 
      
      	 [bookmark: pgfId-3615069]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3615070][bookmark: 84707]Excluding Applications From Active Authentication
 
     [bookmark: pgfId-3615077]License: Control
 
     [bookmark: pgfId-3615583]You can select applications (identified by their HTTP User-Agent strings) and exempt them from captive portal (active authentication). This allows traffic from the selected applications to pass through the identity policy without authenticating.
 
     [bookmark: pgfId-3592678]To exclude applications from active authentication:
 
     
 
     [bookmark: pgfId-3593553]Step 1 On the Realm & Settings tab of the identity rule editor page, use Cisco-provided filters in the Application Filters list to narrow the list of applications you want to add to the filter.
 
      
       
       	 [bookmark: pgfId-3593925]Click the arrow next to each filter type to expand and collapse the list.
 
       	 [bookmark: pgfId-3594025]Right-click a filter type and click  Check Al l or  Uncheck All . Note that the list indicates how many filters you have selected of each type.
 
       	 [bookmark: pgfId-3620904]To narrow the filters that appear, type a search string in the  Search by name field; this is especially useful for categories and tags. To clear the search, click the clear icon (
 
      
 
      [image: ] ). 
     
 
      
       
       	 [bookmark: pgfId-3620908]To refresh the filters list and clear any selected filters, click the reload icon (
 
      
 
      [image: ] ). 
     
 
      
       
       	 [bookmark: pgfId-3593990]To clear all filters and search fields, click  Clear All Filters .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3594176]Note The list displays 100 applications at a time.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3592688]Step 2 Select the applications that you want to add to the filter from the Available Applications list:
 
      
       
       	 [bookmark: pgfId-3594308]Select  All apps matching the filter to add all the applications that meet the constraints you specified in the previous step.
 
       	 [bookmark: pgfId-3594324]To narrow the individual applications that appear, type a search string in the  Search by name field. To clear the search, click the clear icon (
 
      
 
      [image: ] ). 
     
 
      
       
       	 [bookmark: pgfId-3594240]Use the paging icons at the bottom of the list to browse the list of individual available applications.
 
       	 [bookmark: pgfId-3594242]To refresh the applications list and clear any selected applications, click the reload icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-3594460]Step 3 Add the selected applications to exclude from external authentication. You can click and drag, or you can click Add to Rule. The result is the combination of:
 
      
      	 [bookmark: pgfId-3594520]the selected Application Filters
 
      	 [bookmark: pgfId-3594538]either the selected individual Available Applications, or  All apps matching the filter 
 
     
 
     [bookmark: pgfId-3592708]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3594631]What to Do Next
 
      
      	 [bookmark: pgfId-3594655]Continue configuring the identity rule as described in Creating an Identity Rule.
 
     
 
    
 
     
      [bookmark: pgfId-3594705]Associating an Identity Policy with an Access Control Policy
 
     [bookmark: pgfId-3606850]License: Control
 
     [bookmark: pgfId-3594993]You can have one identity policy currently applied to an ASA FirePOWER module. You cannot apply an identity policy independently. You cannot delete an identity policy that has been applied or is currently applying.
 
     [bookmark: pgfId-3594857]To associate an Identity Policy with an Access Control Policy:
 
     
 
     [bookmark: pgfId-3594862]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-3594864]Step 2 Select the Advanced tab.
 ) next to Identity Policy Settings. 
     
 
     [bookmark: pgfId-3594866]Step 4 Select an identity policy from the drop-down.
 
     [bookmark: pgfId-3594867]Step 5 Click OK.
 
     [bookmark: pgfId-3594868]Step 6 Click Store ASA FirePOWER Changes to save your changes.
 
     [bookmark: pgfId-3594869]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3594817][bookmark: 79840]Creating an Identity Rule
 
     [bookmark: pgfId-3606868]License: Control
 
     [bookmark: pgfId-3595223]To create an identity rule:
 
     
 
     [bookmark: pgfId-3605391]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Identity Policy.
 
     [bookmark: pgfId-3605396]Step 2 Click Add Rule.
 
     [bookmark: pgfId-3595713]Step 3 Configure basic identity rule information as described in Configuring Basic Identity Rule Information.
 
     [bookmark: pgfId-3595807]Step 4 Optionally, add a zone condition as described in Adding a Zone Condition to an Identity Rule.
 
     [bookmark: pgfId-3595823]Step 5 Optionally, add a network or geolocation condition as described in Adding a Network or Geolocation Condition to an Identity Rule.
 
     [bookmark: pgfId-3595564]Step 6 Optionally, add a port condition as described in Adding a Port Condition to an Identity Rule.
 
     [bookmark: pgfId-3595607]Step 7 Associate the rule with a realm as described in Associating a Realm and Configuring Active Authentication Settings in an Identity Rule.
 
     [bookmark: pgfId-3595609]Step 8 Click Add.
 
     [bookmark: pgfId-3595946]Step 9 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3596941]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3615678]What to Do Next
 
      
      	 [bookmark: pgfId-3615682]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3615800]Identity Rule Fields
 
     [bookmark: pgfId-3615801]Use the following fields to configure identity rules.
 
     [bookmark: pgfId-3615802]Enabled
 
     [bookmark: pgfId-3615803]Selecting this option enables the identity rule in the identity policy. Deselecting this option disables the identity rule.
 
     [bookmark: pgfId-3596172]Action
 
     [bookmark: pgfId-3596951]The type of authentication you want to perform on the users in the specified Realm. You can select Passive Authentication (User Agent or ISE), Active Authentication (captive portal), or No Authentication. You must fully configure the authentication method, or identity source, before selecting it as the action in an identity rule.
 
     [bookmark: pgfId-3596203]Realm
 
     [bookmark: pgfId-3596975]The realm containing the users you want to perform the specified Action on. You must fully configure a realm before selecting it as the realm in an identity rule.
 
     [bookmark: pgfId-3596215]Use active authentication if passive authentication cannot identify user
 
     [bookmark: pgfId-3597110]Selecting this option authenticates users via active authentication if passive authentication fails to identify them. You must configure active authentication (captive portal) in order to select this option.
 
     [bookmark: pgfId-3597162]If you disable this option, users that passive authentication cannot identify are identified as Unknown. You must set the rule action to Passive Authentication in order to see this field.
 
     [bookmark: pgfId-3596227]Identify as Special Identities/Guest if authentication cannot identify user
 
     [bookmark: pgfId-3597181]Selecting this option identifies unknown users as Special Identities/Guest in all areas of the ASDM interface. You must set the rule action to Active Authentication or select Use active authentication if passive authentication cannot identify user in order to see this field.
 
     [bookmark: pgfId-3596239]Authentication Type
 
     [bookmark: pgfId-3597231]The method you want to use to perform active authentication. The selections vary depending on the type of realm, LDAP or AD:
 
     [bookmark: pgfId-3597259] – Select HTTP Basic if you want to authenticate users using an unencrypted HTTP Basic Authentication (BA) connection. Users log in to the network using their browser's default authentication popup window.
 
     [bookmark: pgfId-3597279] – Select NTLM if you want to authenticate users using a NT LAN Manager (NTLM) connection. This selection is only available when you select an AD realm. Users log in to the network using their browser's default authentication popup window. If you select NTLM as your identity rule Authentication Type, you cannot use a 2003 Windows Server as your identity rule realm.
 
     [bookmark: pgfId-3597322] – Select HTTP Negotiate to allow the captive portal server to choose between HTTP Basic or NTLM for the authentication connection. This selection is only available when you select an AD realm. Users log in to the network using their browser's default authentication popup window.
 
     [bookmark: pgfId-3597358] – Select HTTP Response Page if you want to authenticate users using a ASA FirePOWER module-provided or custom HTTP response page. Users log in to the network using the response page you configure.
 
    
 
     
      [bookmark: pgfId-3596557][bookmark: 84144]Configuring Basic Identity Rule Information
 
     [bookmark: pgfId-3606886]License: Control
 
     [bookmark: pgfId-3470677]To configure basic identity rule information:
 
     
 
     [bookmark: pgfId-3470682]Step 1 On the identity rule editor page, type a Name.
 
     [bookmark: pgfId-3606181]Step 2 Specify whether the rule is Enabled.
 
     [bookmark: pgfId-3606185]Step 3 To add the rule to a rule category, see Adding an Identity Rule Category.
 
     [bookmark: pgfId-3606186]Step 4 Select a rule Action from the drop-down list.
 
     [bookmark: pgfId-3473010]Step 5 Click Add or continue editing the rule.
 
     [bookmark: pgfId-3473006]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3470760][bookmark: 61487]Adding a Network or Geolocation Condition to an Identity Rule
 
     [bookmark: pgfId-3470764]License: Control
 
     [bookmark: pgfId-3597496]To add a network or geolocation condition to an Identity Rule:
 
     
 
     [bookmark: pgfId-3597501]Step 1 On the identity rule editor page, select the Networks tab.
 
     [bookmark: pgfId-3616195]Step 2 Find the networks you want to add from the Available Networks, as follows:
 
      
      	 [bookmark: pgfId-3616199]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
      [image: ] ) above the Available Networks list. 
     
 
      
      	 [bookmark: pgfId-3597823]To search for network or geolocation objects to add, select the appropriate tab, click the  Search by name or value prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
     
 
     [bookmark: pgfId-3597503]Step 3 To select an object, click it. To select all objects, right-click and then select Select All.
 
     [bookmark: pgfId-3597504]Step 4 Click Add to Source or Add to Destination.
 
     [bookmark: pgfId-3597903]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually. Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
     [bookmark: pgfId-3597938]Step 6 Click Add or continue editing the rule.
 
     [bookmark: pgfId-3616163]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3616165][bookmark: 76538]Adding a Port Condition to an Identity Rule
 
     [bookmark: pgfId-3616172]License: Control
 
     [bookmark: pgfId-3616118]To add a port condition to an Identity Rule:
 
     
 
     [bookmark: pgfId-3600396]Step 1 On the identity rule editor page, select the Ports tab.
 
     [bookmark: pgfId-3600397]Step 2 Find the TCP ports you want to add from the Available Ports, as follows:
 
      
      	 [bookmark: pgfId-3600389]To add a TCP port object on the fly, which you can then add to the condition, click the add icon (
 
      [image: ] ) above the Available Ports list. 
     
 
      
      	 [bookmark: pgfId-3600361]To search for TCP-based port objects and groups to add, click the  Search by name or value prompt above the  Available Ports list, then type either the name of the object, or the value of a port in the object. The list updates as you type to display matching objects. For example, if you type 443, the ASA FirePOWER module displays the provided HTTPS port object.
 
     
 
     [bookmark: pgfId-3600339]Step 3 To select a TCP-based port object, click it. To select all TCP-based port objects, right-click and then select Select All. If the object includes non-TCP-based ports, you cannot add it to your port condition.
 
     [bookmark: pgfId-3600286]Step 4 Click Add to Source or Add to Destination.
 
     [bookmark: pgfId-3600271]Step 5 Enter a Port under the Selected Source Ports or Selected Destination Ports list to manually specify source or destination ports. You can specify a single port with a value from 0 to 65535.
 
     [bookmark: pgfId-3600258]Step 6 Click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-3600165]Note The ASA FirePOWER module will not add a port to a rule condition that results in an invalid configuration.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3600120]Step 7 Click Add or continue editing the rule.
 
     [bookmark: pgfId-3600121]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3600510][bookmark: 88674]Adding a Zone Condition to an Identity Rule
 
     [bookmark: pgfId-3606944]License: Control
 
     [bookmark: pgfId-3600522]To add a Zone Condition to an Identity Rule:
 
     
 
     [bookmark: pgfId-3600527]Step 1 On the identity rule editor page, select the Zones tab.
 
     [bookmark: pgfId-3602501]Step 2 Find the zones you want to add from the Available Zones. To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones.
 
     [bookmark: pgfId-3602536]Step 3 Click to select a zone. To select all zones, right-click and then select Select All.
 
     [bookmark: pgfId-3600532]Step 4 Click Add to Source or Add to Destination.
 
     [bookmark: pgfId-3600536]Step 5 Click Add or continue editing the rule.
 
     [bookmark: pgfId-3600537]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3600636][bookmark: 25784]Associating a Realm and Configuring Active Authentication Settings in an Identity Rule
 
     [bookmark: pgfId-3606962]License: Control
 
     [bookmark: pgfId-3616254]Associate the identity rule with a realm and, optionally, configure additional settings for active authentication.
 
     [bookmark: pgfId-3600648]To associate Identity Rules With a Realm:
 
     
 
     [bookmark: pgfId-3600653]Step 1 On the identity rule editor page, select the Realm & Settings tab.
 
     [bookmark: pgfId-3600654]Step 2 Select a Realm from the drop-down list.
 
     [bookmark: pgfId-3616351]Step 3 Optionally, select the Use active authentication if passive authentication cannot identify user check box. Note that this check box appears only when configuring a Passive Authentication rule.
 
     [bookmark: pgfId-3616352]Step 4 If you selected the check box in step 3, or if this is an Active Authentication rule, continue with step 4. Otherwise, skip to step 8.
 
     [bookmark: pgfId-3616353]Step 5 Optionally, select the Identify as Special Identities/Guest if authentication cannot identify user check box.
 
     [bookmark: pgfId-3600660]Step 6 Select an Authentication Type from the drop-down list.
 
     [bookmark: pgfId-3616409]Step 7 Optionally, Exclude HTTP User-Agents to exempt specific application traffic from active authentication as described in Excluding Applications From Active Authentication.
 
     [bookmark: pgfId-3600662]Step 8 Click Add or continue editing the rule.
 
     [bookmark: pgfId-3600786]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3598147]Managing Realms
 
     [bookmark: pgfId-3599075]To manage a Realm:
 
     
 
     [bookmark: pgfId-3599076]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Realms.
 ). 
     
 ) next to the realm and make changes as described in 
     Creating a Realm. 
     
 
     [bookmark: pgfId-3620616]Step 4 If you want to enable or disable a realm, click the State slider next to the realm you want to enable or disable as described in Enabling or Disabling a Realm.
 ) as described in 
     Downloading Users and User Groups On-Demand. 
     
 ). 
     
 
     [bookmark: pgfId-3599269]Step 7 If you want to compare realms, see Comparing Realms.
 
     [bookmark: pgfId-3505499]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3600904][bookmark: 86523]Comparing Realms
 
     [bookmark: pgfId-3606998]License: Control
 
     [bookmark: pgfId-3600916]To Compare Realms:
 
     
 
     [bookmark: pgfId-3607214]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Realms.
 
     [bookmark: pgfId-3607215]Step 2 Click Compare Realms.
 
     [bookmark: pgfId-3600925]Step 3 Select Compare Realm from the Compare Against drop-down list.
 
     [bookmark: pgfId-3600926]Step 4 Select the realms you want to compare from the Realm A and Realm B drop-down lists.
 
     [bookmark: pgfId-3600927]Step 5 Click OK.
 
     [bookmark: pgfId-3600928]Step 6 If you want to navigate individually through changes, click Previous or Next above the title bar.
 
     [bookmark: pgfId-3600930]Step 7 Optionally, click Comparison Report to generate the realm comparison report.
 
     [bookmark: pgfId-3603654]Step 8 Optionally, click New Comparison to generate a new realm comparison view.
 
     [bookmark: pgfId-3600931]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3601106][bookmark: 77355]Downloading Users and User Groups On-Demand
 
     [bookmark: pgfId-3607016]License: Control
 
     [bookmark: pgfId-3603934]If you change the user or group download parameters in a realm, or if you change the users or groups on your server and want the changes to be immediately available for user control, you can force the ASA FirePOWER module to perform an on-demand user download from the server.
 
     [bookmark: pgfId-3603984]The maximum number of users the ASA FirePOWER module can retrieve from the server depends on your device model. If the download parameters in your realm are too broad, the ASA FirePOWER module obtains information on as many users as it can and reports the number of users it failed to retrieve in the task queue.
 
     [bookmark: pgfId-3603924]Before You Begin
 
      
      	 [bookmark: pgfId-3604077]Enable the realm as described in Enabling or Disabling a Realm
 
     
 
     [bookmark: pgfId-3603881]To download users and user groups on-demand:
 
     
 
     [bookmark: pgfId-3601123]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Realms.
 ) next to the realm where you want to download users and user groups. 
     
 
     [bookmark: pgfId-3604216]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3604253]What to Do Next
 
      
      	 [bookmark: pgfId-3604284]Optionally, monitor the task status; see the Task Status page ( Monitoring > ASA FirePOWER Monitoring > Task Status ).
 
     
 
    
 
     
      [bookmark: pgfId-3601248][bookmark: 95522]Enabling or Disabling a Realm
 
     [bookmark: pgfId-3607034]License: Control
 
     [bookmark: pgfId-3604379]Only enabled realms allow the ASA FirePOWER module to query servers. To stop queries, disable the realm.
 
     [bookmark: pgfId-3604380]To enable or disable a realm:
 
     
 
     [bookmark: pgfId-3601265]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Realms.
 
     [bookmark: pgfId-3604422]Step 2 Click the State slider next to the realm you want to enable or disable.
 
     [bookmark: pgfId-3601275]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3604504]What to Do Next
 
      
      	 [bookmark: pgfId-3620757]Optionally, monitor the task status; see the Task Status page ( Monitoring > ASA FirePOWER Monitoring > Task Status ).
 
     
 
    
 
     
      [bookmark: pgfId-3620758]Managing the Identity Policy
 
     [bookmark: pgfId-3620765]License: Control
 
     [bookmark: pgfId-3620767]To manage the Identity Policy:
 
     
 
     [bookmark: pgfId-3620772]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Identity Policy.
 ). 
     
 ). 
     
 
     [bookmark: pgfId-3620793]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3620794]Managing Identity Rules
 
     [bookmark: pgfId-3607070]License: Control
 
     [bookmark: pgfId-3601590]To manage Identity Rules:
 
     
 
     [bookmark: pgfId-3605347]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Identity Policy.
 ) and make changes as described in 
     Creating an Identity Rule. 
     
 ). 
     
 
     [bookmark: pgfId-3601601]Step 4 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3601605]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3616455]What to Do Next
 
      
      	 [bookmark: pgfId-3616459]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3601691][bookmark: 42910]Adding an Identity Rule Category
 
     [bookmark: pgfId-3607088]License: Control
 
     [bookmark: pgfId-3601703]To add an Identity Rule Category:
 
     
 
     [bookmark: pgfId-3601708]Step 1 On the identity rule editor page, you have the following choices:
 
      
      	 [bookmark: pgfId-3602040]Select  above Category from the first  Insert drop-down list, then select the category above which you want to position the rule from the second drop-down list.
 
      	 [bookmark: pgfId-3602103]Select  below rule from the drop-down list, then enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
      	 [bookmark: pgfId-3602111]Select  above rule from the drop-down list, then, enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
     
 
     [bookmark: pgfId-3601715]Step 2 Click OK.
 
      
       
     
 
     
 
     [bookmark: pgfId-3602131]Note Rules in a category you delete are added to the category above.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3601717]Step 3 Click Add or continue editing the rule.
 
     [bookmark: pgfId-3601718]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3351539]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3550545][bookmark: 62295]User Identity Sources 
      
      
 
     
 
 
    [bookmark: pgfId-3550547]The ASA FirePOWER module supports the following identity sources:
 
     
     	 [bookmark: pgfId-3560755]Authoritative  User Agent reporting collects user data for user awareness and user access control. If you want to configure User Agents to monitor users when they log in and out of hosts or authenticate with Active Directory credentials, see The User Agent Identity Source.
 
     	 [bookmark: pgfId-3560762]Authoritative  Identity Services Engine (ISE) reporting collects user data for user awareness and user access control. If you have an ISE deployment and you want to configure ISE to monitor users as they authenticate via Active Directory domain controllers (DC), see The Identity Services Engine (ISE) Identity Source.
 
     	 [bookmark: pgfId-3560766]Authoritative  captive portal authentication actively authenticates users on your network and collects user data for user awareness and user control. If you want to configure virtual routers or Firepower Threat Defense devices to perform captive portal authentication, see The Captive Portal Identity Source.
 
    
 
    [bookmark: pgfId-3557905]Data from those identity sources is stored in the ASA FirePOWER module users database and the user activity database.You can configure database-server queries to automatically download new data to your module.
 
    [bookmark: pgfId-3557906]For more information about user detection in the ASA FirePOWER module, see User Detection Fundamentals.
 
     
      [bookmark: pgfId-3561445]Troubleshooting Issues with User Identity Sources
 
     [bookmark: pgfId-3561734]License: Any
 
     [bookmark: pgfId-3561855]See the following sections for information about troubleshooting issues with your identity sources.
 
     [bookmark: pgfId-3561902]User Agent
 
     [bookmark: pgfId-3561950]If you experience issues with the User Agent connection, see the Firepower User Agent Configuration Guide. 
 
     [bookmark: pgfId-3562085]If you experience issues with user data reported by the User Agent, note the following:
 
      
      	 [bookmark: pgfId-3562239]After the system detects activity from a User Agent user whose data is not yet in the database, the system retrieves information about them from the server. In some cases, the system requires up to 60 minutes to successfully retrieve this information from Active Directory servers. Until the data retrieval succeeds, activity seen by the User Agent user is handled by access control rules, and is not displayed in the web interface.
 
     
 
     [bookmark: pgfId-3562330]ISE
 
     [bookmark: pgfId-3562422]If you experience issues with the ISE connection, check the following:
 
      
      	 [bookmark: pgfId-3562502]The pxGrid Identity Mapping feature within ISE must be enabled before you can successfully integrate ISE with the Firepower System.
 
      	 [bookmark: pgfId-3562666]All ISE system certificates and Firepower Management Center certificates must include the  serverAuth and  clientAuth extended key usage values.
 
      	 [bookmark: pgfId-3562835]The time on your ISE device must be synchronized with the time on the Firepower Management Center. If the appliances are not synchronized, the system may perform user timeouts at unexpected intervals.
 
      	 [bookmark: pgfId-3563042]If your deployment includes a primary and a secondary pxGrid node, the certificates for both nodes must be signed by the same certificate authority.
 
      	 [bookmark: pgfId-3563197]If your deployment includes a primary and a secondary MNT node, the certificates for both nodes must be signed by the same certificate authority.
 
     
 
     [bookmark: pgfId-3563359]If you experience issues with user data reported by ISE, note the following:
 
      
      	 [bookmark: pgfId-3563509]After the system detects activity from an ISE user whose data is not yet in the database, the system retrieves information about them from the server. In some cases, the system requires up to 60 minutes to successfully retrieve this information from Active Directory servers. Until the data retrieval succeeds, activity seen by the ISE user is handled by access control rules, and is not displayed in the web interface.
 
     
 
     [bookmark: pgfId-3561930]Captive Portal
 
     [bookmark: pgfId-3563538]If you experience issues with captive portal authentication, note the following:
 
      
      	 [bookmark: pgfId-3563627]After a captive portal user enters their login credentials, the system checks their credentials against the data in the server. In some cases, if the user’s data was not yet in the database, the system requires up to 60 minutes to successfully retrieve this information from Active Directory servers. Until the data retrieval succeeds, the captive portal user is not authenticated.
 
     
 
     [bookmark: pgfId-3564030]If the captive portal user is not authenticated after 25 seconds, the system displays an error message and the captive portal user’s session times out. The user must retry their captive portal login.
 
    
 
   
 
    
     [bookmark: pgfId-3561737][bookmark: 10149]The User Agent Identity Source
 
    [bookmark: pgfId-3558529]License: Any
 
    [bookmark: pgfId-3551142]The User Agent is a passive authentication method and one of the authoritative identity sources supported by the ASA FirePOWER module. When integrated with the ASA FirePOWER module, the agent monitors users when they log in and out of hosts or authenticate with Active Directory credentials. The User Agent does not report failed login attempts. The data gained from the User Agent can be used for user awareness and user control. You invoke passive authentication in your identity policy.
 
    [bookmark: pgfId-3551170]Installing and using User Agents allows you to perform user control; the agents associate users with IP addresses, which allows access control rules with user conditions to trigger. You can use one agent to monitor user activity on up to five Active Directory servers.
 
    [bookmark: pgfId-3551063]The User Agent requires a multi-step configuration, and includes the following:
 
     
     	 [bookmark: pgfId-3551069]Computers or servers with the agent installed.
 
     	 [bookmark: pgfId-3551219]Connections between an ASA FirePOWER module and the computers or Active Directory servers with the agent installed.
 
     	 [bookmark: pgfId-3551321]Connections between the ASA FirePOWER module and the monitored LDAP servers, configured as directories within identity realms.
 
    
 
    [bookmark: pgfId-3551071]You can install an agent on any computer or server running:
 
     
     	 [bookmark: pgfId-3551430]Microsoft Windows Vista
 
     	 [bookmark: pgfId-3551478]Microsoft Windows 7
 
     	 [bookmark: pgfId-3551505]Microsoft Windows 8
 
     	 [bookmark: pgfId-3551523]Microsoft Windows Server 2003
 
     	 [bookmark: pgfId-3551546]Microsoft Windows Server 2008
 
     	 [bookmark: pgfId-3551561]Microsoft Windows Server 2012
 
    
 
    [bookmark: pgfId-3551719]The computer must also have TCP/IP access to the device and the Microsoft Active Directory servers you want to monitor. You can also install an agent on any Active Directory server running one of the supported operating systems. If you want to perform real-time data retrieval, the server must be running Windows Server 2008 or Windows Server 2012.
 
    [bookmark: pgfId-3551751]For detailed information about the multi-step User Agent configuration and a complete discussion of the server requirements, see the User Agent Configuration Guide.
 
    [bookmark: pgfId-3551981]The ASA FirePOWER module connection not only allows you to retrieve metadata for the users whose logins and logoffs were detected by User Agents, but also is used to specify the users and groups you want to use in access control rules. If the agent is configured to exclude specific user names, login data for those user names are not reported to the ASA FirePOWER module. User agent data is stored in the user database and user activity database on the device.
 
     
      
    
 
    
 
    [bookmark: pgfId-3552014]Note User Agents cannot transmit Active Directory user names ending with the $ character to the ASA FirePOWER module. You must remove the final $ character if you want to monitor these users.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3552047]If multiple users are logged into a host using remote sessions, the agent may not detect logins from that host properly. For information about how to prevent this, see the User Agent Configuration Guide.
 
     
      [bookmark: pgfId-3552253]Configuring a User Agent Connection
 
     [bookmark: pgfId-3558498]License: Control
 
     [bookmark: pgfId-3554173]Before you Begin
 
      
      	 [bookmark: pgfId-3552261]If you plan to implement user access control, configure and enable an Active Directory realm for your User Agent connection as described in Creating a Realm
 
     
 
     [bookmark: pgfId-3552255]To configure a User Agent Connection:
 
     
 
     [bookmark: pgfId-3552343]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Identity Sources.
 
     [bookmark: pgfId-3552133]Step 2 Select User Agent for the Service Type to enable the User Agent connection.
 
      
       
     
 
     
 
     [bookmark: pgfId-3552442]Note To disable the connection, select None.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3552419]Step 3 Click the Add New Agent button to add a new agent.
 
     [bookmark: pgfId-3552657]Step 4 Type the Hostname or Address of the computer where you plan to install the agent. You must use an IPv4 address; you cannot configure the ASA FirePOWER module to connect to a User Agent using an IPv6 address.
 
     [bookmark: pgfId-3552142]Step 5 Click Add.
 ) and confirm that you want to delete it. 
     
 
     [bookmark: pgfId-3551659]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3551665]What to Do Next
 
      
      	 [bookmark: pgfId-3552922]Continue User Agent setup as described in the  Firepower User Agent Configuration Guide .
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3552966][bookmark: 58207]The Identity Services Engine (ISE) Identity Source
 
    [bookmark: pgfId-3558547]License: Any
 
    [bookmark: pgfId-3553074]The pxGrid Identity Mapping feature within the Cisco Identity Services Engine (ISE) is a passive authentication method and one of the authoritative identity sources supported by the ASA FirePOWER module. When integrated with the ASA FirePOWER module, this ISE feature monitors users as they authenticate via Active Directory domain controllers (DC). 
 
     
      
    
 
    
 
    [bookmark: pgfId-3566698]Note The ASA FirePOWER module does not support 802.1x machine authentication alongside AD authentication because the system does not associate machine authentication with users. If you use 802.1x active logins, configure ISE to report only 802.1x active logins (both machine and user). That way, a machine login is reported only once to the system. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3566681]ISE does not report failed login attempts. The data gained from ISE can be used on the ASA FirePOWER module for user awareness and user control. You invoke passive authentication in your identity policy.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3560857] 
     Caution If you configure ISE to monitor a large number of user groups, the system may drop user mappings based on groups, due to memory limitations. As a result, access control rules with realm or user conditions may not fire as expected. 
      
      
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3560877]Note Make sure the time on your ISE device is synchronized with the time on the ASA FirePOWER module. If the appliances are not synchronized, the system may perform user timeouts at unexpected intervals.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3553241]Configuring an ISE connection also populates the ASA FirePOWER module database with ISE attribute data: Security Group Tag (SGT), Endpoint Profile, and Endpoint Location. ISE attributes can be used for user awareness and in access control rule conditions.
 
    [bookmark: pgfId-3553532]Security Group Tags (SGT)
 
    [bookmark: pgfId-3553540]The SGT attribute is applied by Cisco TrustSec as packets enter trusted TrustSec networks. With ISE configured, the module identifies users and their SGT, which you can use for access control.
 
    [bookmark: pgfId-3553534]Endpoint Location
 
    [bookmark: pgfId-3553473]The Endpoint Location attribute is applied by Cisco ISE and identifies the IP address of the endpoint device.
 
    [bookmark: pgfId-3553030]Endpoint Profile
 
    [bookmark: pgfId-3553445]The Endpoint Profile attribute is applied by Cisco ISE and identifies the endpoint device type for each packet.
 
    [bookmark: pgfId-3553358]For more information about the Cisco ISE product, see the Cisco Identity Services Engine Administrator Guide.
 
     
      [bookmark: pgfId-3553354]ISE Fields
 
     [bookmark: pgfId-3553373]The following fields are used to configure a connection to ISE.
 
     [bookmark: pgfId-3553398]Primary and Secondary Host Name/IP Address
 
     [bookmark: pgfId-3553400]The hostname or IP address for the primary and, optionally, the secondary ISE servers.
 
     [bookmark: pgfId-3553406]pxGrid Server CA
 
     [bookmark: pgfId-3560924]The certificate authority for the pxGrid framework. If your deployment includes a primary and a secondary pxGrid node, the certificates for both nodes must be signed by the same certificate authority.
 
     [bookmark: pgfId-3553410]MNT Server CA
 
     [bookmark: pgfId-3560943]The certificate authority for the ISE certificate when performing bulk downloads. If your deployment includes a primary and a secondary MNT node, the certificates for both nodes must be signed by the same certificate authority.
 
     [bookmark: pgfId-3553418]MC Server Certificate
 
     [bookmark: pgfId-3553737]The certificate and key that the ASA FirePOWER module should provide to ISE when connecting to ISE or performing bulk downloads.
 
     [bookmark: pgfId-3553581]ISE Network Filter
 
     [bookmark: pgfId-3553812]An optional filter you can set to restrict the networks monitored by ISE. If you provide a filter, ISE monitors the networks within that filter. You can specify a filter in the following ways:
 
     [bookmark: pgfId-3553585] – Leave the field blank to specify any.
 
     [bookmark: pgfId-3553931] – Enter a single IPv4 address block using CIDR notation.
 
     [bookmark: pgfId-3553956] – Enter a list of IPv4 address blocks using CIDR notation, separated by commas.
 
    
 
     
      [bookmark: pgfId-3553617][bookmark: 20590]Configuring an ISE Connection
 
     [bookmark: pgfId-3558636]License: Control
 
     [bookmark: pgfId-3558433]To configure a User Agent Connection:
 
     
 
     [bookmark: pgfId-3558434]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Identity Sources.
 
     [bookmark: pgfId-3553992]Step 2 Select Identity Services Engine for the Service Type to enable the ISE connection.
 
      
       
     
 
     
 
     [bookmark: pgfId-3553993]Note To disable the connection, select None.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3553994]Step 3 Type a Primary Host Name/IP Address and, optionally, a Secondary Host Name/IP Address.
 ) to create an object on the fly. 
     
 
     [bookmark: pgfId-3553996]Step 5 Optionally, type an ISE Network Filter using CIDR block notation.
 
     [bookmark: pgfId-3553997]Step 6 If you want to test the connection, click Test.
 
     [bookmark: pgfId-3553998]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3553621][bookmark: 49865]The Captive Portal Identity Source
 
    [bookmark: pgfId-3558572]License: Any
 
    [bookmark: pgfId-3554452]Captive portal is one of the authoritative identity sources supported by the ASA FirePOWER module. It is the only active authentication method supported by the ASA FirePOWER module, where users can authenticate onto the network through a device.
 
    [bookmark: pgfId-3565755]Active authentication using captive portal is performed on HTTP and HTTPS traffic only. To use captive portal with HTTPS traffic, you must create SSL rules to decrypt the traffic originating from the users you want to authenticate using captive portal.
 
    [bookmark: pgfId-3554468]When configured and deployed, users from specified realms authenticate through ASA FirePOWER devices in routed mode running Version 9.5(2) or later. The authentication data gained from captive portal can be used for user awareness and user control.
 
    [bookmark: pgfId-3566448]Captive portal also records failed authentication attempts. A failed attempt does not add a new user to the list of users in the database. The user activity type for failed authentication activity reported by captive portal is Failed Auth User.
 
    [bookmark: pgfId-3566449]You use the captive-portal ASA CLI command to enable captive portal for active authentication as described in the ASA Firewall Configuration Guide for your version: http://www.cisco.com/c/en/us/support/security/asa-5500-series-next-generation-firewalls/products-installation-and-configuration-guides-list.html. You continue configuring captive portal in your identity policy and invoke it (active authentication) in your identity rules. Identity policies are invoked in your access control policies. For more information, see Configuring Captive Portal (Active Authentication)
 
    [bookmark: pgfId-3554565]Captive portal can e performed only by a device with one or more routed interfaces configured.
 
    [bookmark: pgfId-3566765]The system does not validate the type of interface in ASA with FirePOWER devices. If you apply a captive portal policy to an inline (tap mode) interface on an ASA with FirePOWER device, the policy deployment succeeds but users in traffic matching those rules are identified as Unknown.
 
    [bookmark: pgfId-3500627]Note the following access control rule and SSL rule requirements:
 
     
     	 [bookmark: pgfId-3554664]You must create an access control rule to allow traffic destined for the IP address and port you plan to use for captive portal. Traffic cannot be authenticated using captive portal if the destination port is not allowed in your access control policy.
 
     	 [bookmark: pgfId-3554710]If you want to perform active authentication via captive portal on HTTPS traffic, you must create SSL rules to decrypt the traffic originating from the users you want to authenticate using captive portal.
 
     	 [bookmark: pgfId-3554726]If you want to decrypt traffic in the captive portal connection, you must create an SSL rule to decrypt the traffic destined for the port you plan to use for captive portal.
 
    
 
     
      [bookmark: pgfId-3557089][bookmark: 80506], ASA FirePOWER Module-Server Downloads
 
     [bookmark: pgfId-3558592]License: Any
 
     [bookmark: pgfId-3557389]Connections between the ASA FirePOWER module and your LDAP or AD servers allow you to retrieve user and user group metadata for certain detected users:
 
      
      	 [bookmark: pgfId-3557762]LDAP and AD users authenticated by captive portal or reported by a User Agent or ISE. This metadata can be used for user awareness and user control.
 
      	 [bookmark: pgfId-3557782]POP3 and IMAP user logins detected by traffic-based detection, if those users have the same email address as an LDAP or AD user. This metadata can be used for user awareness.
 
     
 
     [bookmark: pgfId-3557629]You configure an ASA FirePOWER module user database-server connection as a directory within a realm. You must select the Download users and user groups for access control check box to download a realm's user and user group data for user awareness and user control.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3400437]DNS Policies 
      
      
 
     
 
 
    [bookmark: pgfId-3474849]The following topics explain DNS policies, DNS rules, and how to deploy DNS policies.
 
     
     	 [bookmark: pgfId-3406082]DNS Policy Overview
 
     	 [bookmark: pgfId-3406089]DNS Policy Components
 
     	 [bookmark: pgfId-3430021]DNS Rules
 
     	 [bookmark: pgfId-3412610]DNS Policy Deploy
 
    
 
   
 
    
     [bookmark: pgfId-3405300][bookmark: 75141]DNS Policy Overview
 
    [bookmark: pgfId-3443130]License: Any
 
    [bookmark: pgfId-3475712]DNS-based Security Intelligence allows you to whitelist or blacklist traffic based on the domain name requested by a client. Cisco provides domain name intelligence you can use to filter your traffic; you can also configure custom lists and feeds of domain names tailored to your deployment. DNS-based Security Intelligence filtering takes place after hardware-level handling and traffic decryption, and before most other policy-based inspection, analysis, or traffic handling.
 
    [bookmark: pgfId-3475766]Traffic blacklisted by a DNS policy is immediately blocked and therefore is not subject to any further inspection—not for intrusions, exploits, malware, and so on. You can override blacklisting with whitelisting to force access control rule evaluation, and, recommended in passive deployments, you can use a “monitor-only” setting for Security Intelligence filtering. This allows the ASA FirePOWER module to analyze connections that would have been blacklisted, but also logs the match to the blacklist and generates an end-of-connection security intelligence event.
 
    [bookmark: pgfId-3476122]You configure DNS-based Security Intelligence using a DNS policy and associated DNS rules. To deploy it, you must associate your DNS policy with an access control policy, then deploy your configuration.
 
   
 
    
     [bookmark: pgfId-3405727][bookmark: 26789]DNS Policy Components
 
    [bookmark: pgfId-3405571]License: Any
 
    [bookmark: pgfId-3476924]A DNS policy allows you to whitelist or blacklist domain name-based connections. The following list describes the configurations you can change after creating a DNS policy.
 
    [bookmark: pgfId-3476943]Name and Description
 
    [bookmark: pgfId-3476945]Each DNS policy must have a unique name. A description is optional.
 
    [bookmark: pgfId-3476947]Rules
 
    [bookmark: pgfId-3477246]Rules provide a granular method of handling network traffic based on the domain name. Rules in a DNS policy are numbered, starting at 1. The ASA FirePOWER module matches traffic to DNS rules in top-down order by ascending rule number.
 
    [bookmark: pgfId-3477278]When you create a DNS policy, the ASA FirePOWER module populates it with a default Global DNS Whitelist rule, and a default Global DNS Blacklist rule. Each rule is fixed to the first position in their respective categories. You cannot modify these rules, but you can disable them. The module evaluates rules in the following order:
 
    [bookmark: pgfId-3476977] – Global DNS Whitelist rule (if enabled)
 
    [bookmark: pgfId-3477335] – whitelist rules
 
    [bookmark: pgfId-3477341] – Global DNS Blacklist rule (if enabled)
 
    [bookmark: pgfId-3477452] – blacklist and monitor rules
 
    [bookmark: pgfId-3477453]Usually, the module handles domain name-based network traffic according to the first DNS rule where all the rule’s conditions match the traffic. If no DNS rules match the traffic, the module continues evaluating the traffic based on the associated access control policy's rules. DNS rule conditions can be simple or complex.
 
     
      [bookmark: pgfId-3477722][bookmark: 27628]Editing a DNS Policy
 
     [bookmark: pgfId-3486145]License: Protection
 
     [bookmark: pgfId-3478137]Only one person should edit a DNS policy at a time, using a single browser window. If multiple users attempt to save the same policy, only the first set of saved changes are retained.
 
     [bookmark: pgfId-3478160]To protect the privacy of your session, after thirty minutes of inactivity on the policy editor, a warning appears. After sixty minutes, the module discards your changes.
 
     [bookmark: pgfId-3419405]To edit a DNS policy:
 
     
 
     [bookmark: pgfId-3419407]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > DNS Policy.
 
     [bookmark: pgfId-3419414]Step 2 Edit your DNS policy:
 
      
       
       	 [bookmark: pgfId-3419417]Name and Description - To change the name or description, click the field and type the new information. 
 
       	 [bookmark: pgfId-3487099]Rules - To add, categorize, enable, disable, or otherwise manage DNS rules, click the  Rules tab and proceed as described in Creating and Editing DNS Rules.
 
      
 
     
 
     [bookmark: pgfId-3487103]Step 3 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3452774]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3478217]What to Do Next
 
      
      	 [bookmark: pgfId-3478244]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3429950][bookmark: 96756]DNS Rules
 
    [bookmark: pgfId-3429954]License: Any
 
    [bookmark: pgfId-3480427]DNS rules handle traffic based on the domain name requested by a host. As part of Security Intelligence, this evaluation happens after any traffic decryption, and before access control evaluation.
 
    [bookmark: pgfId-3480563]The ASA FirePOWER module matches traffic to DNS rules in the order you specify. In most cases, the module handles network traffic according to the first DNS rule where all the rule’s conditions match the traffic. When you create DNS rules, the module places whitelist rules before monitor and blacklist rules, and evaluates traffic against whitelist rules first.
 
    [bookmark: pgfId-3480492]In addition to its unique name, each DNS rule has the following basic components:
 
    [bookmark: pgfId-3480506]State
 
    [bookmark: pgfId-3481022]By default, rules are enabled. If you disable a rule, the ASA FirePOWER module does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.
 
    [bookmark: pgfId-3480672]Position
 
    [bookmark: pgfId-3481070]Rules in a DNS policy are numbered, starting at 1. The ASA FirePOWER module matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
    [bookmark: pgfId-3481145]Conditions
 
    [bookmark: pgfId-3481168]Conditions specify the specific traffic the rule handles. A DNS rule must contain a DNS feed or list condition, and can also match traffic by security zone or network.
 
    [bookmark: pgfId-3481217]Action
 
    [bookmark: pgfId-3481218]A rule’s action determines how the ASA FirePOWER module handles matching traffic:
 
    [bookmark: pgfId-3481219] – Whitelisted traffic is allowed, subject to further access control inspection.
 
    [bookmark: pgfId-3481253] – Monitored traffic is subject to further evaluation by remaining DNS blacklist rules. If the traffic does not match a DNS blacklist rule, it is inspected with access control rules. The module logs a Security Intelligence event for the traffic.
 
    [bookmark: pgfId-3481291] – Blacklisted traffic is dropped without further inspection. You can also return a Domain Not Found response, or redirect the DNS query to a sinkhole server.
 
     
      [bookmark: pgfId-3480928][bookmark: 14972]Creating and Editing DNS Rules
 
     [bookmark: pgfId-3486208]License: Protection
 
     [bookmark: pgfId-3481345]In a DNS policy, you can add up to a total of 32767 DNS lists to the whitelist and blacklist rules. That is, the number of lists in the DNS policy cannot exceed 32767.
 
     [bookmark: pgfId-3429972]To create and edit DNS Rules:
 
     
 
     [bookmark: pgfId-3463779]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > DNS Policy.
 
     [bookmark: pgfId-3429981]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-3429982]To add a new rule, click  Add DNS Rule .
 
       	 [bookmark: pgfId-3481498]To edit an existing rule, click the edit icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-3429986]Step 3 Enter a Name.
 
     [bookmark: pgfId-3481645]Step 4 Configure the rule components, or accept the defaults:
 
      
       
       	 [bookmark: pgfId-3481615]Action - Select a rule  Action ; see DNS Rule Actions. 
 
       	 [bookmark: pgfId-3481638]Conditions - Configure the rule’s conditions; see DNS Rule Conditions.
 
       	 [bookmark: pgfId-3481666]Enabled - Specify whether the rule is  Enabled .
 
      
 
     
 
     [bookmark: pgfId-3429989]Step 5 Click Add or OK.
 
     [bookmark: pgfId-3491499]Step 6 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3452801]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3481784]DNS Rule Management
 
     [bookmark: pgfId-3486831]License: Any
 
     [bookmark: pgfId-3482943]The Rules tab of the DNS policy editor allows you to add, edit, move, enable, disable, delete, and otherwise manage DNS rules within your policy.
 ) beneath the rule name. 
     
 
    
 
     
      [bookmark: pgfId-3482945]Enabling and Disabling DNS Rules
 
     [bookmark: pgfId-3486249]License: Protection
 
     [bookmark: pgfId-3483022]When you create a DNS rule, it is enabled by default. If you disable a rule, the ASA FirePOWER module does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in a DNS policy, disabled rules are dimmed, although you can still modify them. Note that you can also enable or disable a DNS rule using the DNS rule editor.
 
     [bookmark: pgfId-3482220]To enable and disable DNS Rules:
 
     
 
     [bookmark: pgfId-3483096]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > DNS Policy.
 
     [bookmark: pgfId-3483111]Step 2 In the DNS policy editor that contains the rule you want to enable or disable, right-click the rule and choose a rule state.
 
     [bookmark: pgfId-3483138]Step 3 Click OK.
 
     [bookmark: pgfId-3491609]Step 4 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-3491611]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3483101]What to Do Next
 
      
      	 [bookmark: pgfId-3481829]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3481835]DNS Rule Order Evaluation
 
     [bookmark: pgfId-3486876]License: Any
 
     [bookmark: pgfId-3483193]Rules in a DNS policy are numbered, starting at 1. The ASA FirePOWER module matches traffic to DNS rules in top-down order by ascending rule number. In most cases, the module handles network traffic according to the first DNS rule where all the rule’s conditions match the traffic:
 
      
      	 [bookmark: pgfId-3483229]For Monitor rules, the module logs the traffic, then continues evaluating traffic against lower-priority DNS blacklist rules.
 
      	 [bookmark: pgfId-3483283]For non-Monitor rules, the module does not continue to evaluate traffic against additional, lower-priority DNS rules after that traffic matches a rule.
 
     
 
     [bookmark: pgfId-3483273]Note the following regarding rule order:
 
      
      	 [bookmark: pgfId-3482317]The Global Whitelist is always first, and takes precedence over all other rules.
 
      	 [bookmark: pgfId-3483350]The Whitelist section precedes the Blacklist section; whitelist rules always take precedence over other rules.
 
      	 [bookmark: pgfId-3483372]The Global Blacklist is always first in the Blacklist section, and takes precedence over all other Monitor and blacklist rules.
 
      	 [bookmark: pgfId-3482327]The Blacklist section contains Monitor and blacklist rules.
 
      	 [bookmark: pgfId-3483405]When you first create a DNS rule, the module positions it last in the Whitelist section if you assign a  Whitelist action, or last in the Blacklist section if you assign any other action.
 
     
 
     [bookmark: pgfId-3483327]You can drag and drop rules to reorder them, and change the evaluation order.
 
    
 
     
      [bookmark: pgfId-3486913][bookmark: 51519]DNS Rule Actions
 
     [bookmark: pgfId-3486947]License: Any
 
     [bookmark: pgfId-3486915]Every DNS rule has an action that determines the following for matching traffic:
 
      
      	 [bookmark: pgfId-3482400]handling—foremost, the rule action governs whether the module will whitelist, monitor, or blacklist traffic that matches the rule’s conditions
 
      	 [bookmark: pgfId-3482485]logging—the rule action determines when and how you can log details about matching traffic
 
     
 
     [bookmark: pgfId-3482493]Keep in mind that only devices deployed inline can blacklist traffic. Devices deployed passively can whitelist and log, but not affect, traffic.
 
     [bookmark: pgfId-3482487]Whitelist Action
 
     [bookmark: pgfId-3483541]The Whitelist action allows matching traffic to pass. When you whitelist traffic, it is subject to further inspection either by a matching access control rule, or the access control policy's default action.
 
     [bookmark: pgfId-3483580]The module does not log whitelist matches. However, logging of whitelisted connections depends on their eventual disposition.
 
     [bookmark: pgfId-3482383]Monitor Action
 
     [bookmark: pgfId-3483691]The Monitor action does not affect traffic flow; matching traffic is neither immediately whitelisted nor blacklisted. Rather, traffic is matched against additional rules to determine whether to permit or deny it. The first non-Monitor DNS rule matched determines whether the module blacklists the traffic. If there are no additional matching rules, the traffic is subject to access control evaluation.
 
     [bookmark: pgfId-3483707]For connections monitored by a DNS policy, the ASA FirePOWER module logs end-of-connection Security Intelligence and connection events.
 
     [bookmark: pgfId-3483693]Blacklist Actions
 
     [bookmark: pgfId-3482469]The blacklist actions blacklist traffic without further inspection of any kind:
 
      
      	 [bookmark: pgfId-3482471]The  Drop action drops the traffic.
 
      	 [bookmark: pgfId-3483775]The  Domain Not Found action returns a non-existent internet domain response to the DNS query, which prevents the client from resolving the DNS request.
 
      	 [bookmark: pgfId-3483818]The  Sinkhole action returns a sinkhole object's IPv4 or IPv6 address in response to the DNS query. The sinkhole server can log, or log and block, follow-on connections to the IP address. If you configure a  Sinkhole action, you must also configure a sinkhole object.
 
     
 
     [bookmark: pgfId-3483865]For a connection blacklisted based on the Drop or Domain Not Found actions, the module logs beginning-of-connection Security Intelligence and connection events. Because blacklisted traffic is immediately denied without further inspection, there is no unique end of connection to log.
 
     [bookmark: pgfId-3483904]For a connection blacklisted based on the Sinkhole action, logging depends on the sinkhole object configuration. If you configure your sinkhole object to only log sinkhole connections, the module logs end-of-connection connection events for the follow-on connection. If you configure your sinkhole object to log and block sinkhole connections, the module logs beginning-of-connection connection events for the follow-on connection, then blocks that connection.
 
    
 
     
      [bookmark: pgfId-3482559][bookmark: 56371]DNS Rule Conditions
 
     [bookmark: pgfId-3486965]License: Any
 
     [bookmark: pgfId-3483973]A DNS rule’s conditions identify the type of traffic that rule handles. Conditions can be simple or complex. You must define a DNS feed or list condition. You can additionally control traffic by security zone or network.
 
     [bookmark: pgfId-3482595]When adding conditions to a DNS rule:
 
      
      	 [bookmark: pgfId-3484036]If you do not configure a particular condition for a rule, the module does not match traffic based on that criterion.
 
      	 [bookmark: pgfId-3484052]You can configure multiple conditions per rule. Traffic must match  all the conditions in the rule for the rule to apply to traffic..
 
      	 [bookmark: pgfId-3484121]For each condition in a rule, you can add up to 50 criteria. Traffic that matches  any of a condition’s criteria satisfies the condition. For example, you can use a single rule to blacklist traffic based on up to 50 DNS lists and feeds.
 
     
 
    
 
     
      [bookmark: pgfId-3482636]Controlling Traffic Based on DNS and Security Zone
 
     [bookmark: pgfId-3486322]License: Protection
 
     [bookmark: pgfId-3484162]Zone conditions in DNS rules allow you to control traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces. An option you choose during a device’s initial setup, called its detection mode, determines how the module initially configures the device’s interfaces, and whether those interfaces belong to a security zone.
 
     [bookmark: pgfId-3482676]To control traffic based on DNS and security zone:
 
     
 
     [bookmark: pgfId-3482690]Step 1 In the DNS rule editor, click the Zones tab.
 
     [bookmark: pgfId-3484286]Step 2 Find and select the zones you want to add from the Available Zones. To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones.
 
     [bookmark: pgfId-3482698]Step 3 Click to select a zone, or right-click and then select Select All.
 
     [bookmark: pgfId-3482708]Step 4 Click Add to Source.
 
      
       
     
 
     
 
     [bookmark: pgfId-3484345]Tip You can also drag and drop selected zones.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3482711]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-3482751]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3484809]What to Do Next
 
      
      	 [bookmark: pgfId-3484799]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3482728]Controlling Traffic Based on DNS and Network
 
     [bookmark: pgfId-3486363]License: Protection
 
     [bookmark: pgfId-3484459]Network conditions in DNS rules allow you to control traffic by its source IP address. You can explicitly specify the source IP addresses for the traffic you want to control.
 
     [bookmark: pgfId-3482759]To control traffic based on DNS and network:
 
     
 
     [bookmark: pgfId-3482760]Step 1 In the DNS rule editor, click the Networks tab.
 
     [bookmark: pgfId-3482761]Step 2 Find and select the networks you want to add from the Available Networks, as follows:
 
      
       
       	 [bookmark: pgfId-3484538]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Networks list and proceed as described in 
      Working with Network Objects. 
     
 
      
       
       	 [bookmark: pgfId-3484569]To search for network objects to add, click the  Search by name or value prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3482762]Step 3 Click Add to Source.
 
      
       
     
 
     
 
     [bookmark: pgfId-3484662]Tip You can also drag and drop selected objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3484690]Step 4 Add any source IP addresses or address blocks that you want to specify manually. Click the Enter an IP address prompt below the Source Networks list; then type an IP address or address block and click Add.
 
     [bookmark: pgfId-3484718]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-3482767]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3484833]What to Do Next
 
      
      	 [bookmark: pgfId-3484827]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
     
      [bookmark: pgfId-3486462]Controlling Traffic Based on DNS List, Feed, or Category
 
     [bookmark: pgfId-3486478]License: Protection
 
     [bookmark: pgfId-3486464]DNS conditions in DNS rules allow you to control traffic if a DNS list, feed, or category contains the domain name requested by the client. You must define a DNS condition in a DNS rule.
 
     [bookmark: pgfId-3485499]Regardless of whether you add a global or custom whitelist or blacklist to a DNS condition, the ASA FirePOWER module applies the configured rule action to the traffic. For example, if you add the Global Whitelist to a rule, and configure a Drop action, the module blacklists all traffic that should have been whitelisted.
 
     [bookmark: pgfId-3482852]To control traffic based on DNS list, feed, or category:
 
     
 
     [bookmark: pgfId-3482854]Step 1 In the DNS rule editor, click the DNS tab.
 
     [bookmark: pgfId-3482855]Step 2 Find and select the DNS lists and feeds you want to add from the DNS Lists and Feeds, as follows:
 
      
       
       	 [bookmark: pgfId-3487533]To add a DNS list or feed on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       DNS Lists and Feeds list and proceed as described in 
      Working with the Intelligence Feed 
     
 
      
       
       	 [bookmark: pgfId-3487540]To search for DNS lists, feeds, or categories to add, click the  Search by name or value prompt above the  DNS Lists and Feeds list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3482856]Step 3 Click Add to Rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3485716]Tip You can also drag and drop selected objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3482858]Step 4 Save or continue editing the rule.
 
     [bookmark: pgfId-3485585]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3485594]What to Do Next
 
      
      	 [bookmark: pgfId-3485595]Deploy configuration changes; see Deploying Configuration Changes.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3485588][bookmark: 55841]DNS Policy Deploy
 
    [bookmark: pgfId-3456141]License: Any
 
    [bookmark: pgfId-3481861]After you finishing updating your DNS policy configuration, you must deploy it as part of an access control policy for your changes to take effect. You must do the following:
 
     
     	 [bookmark: pgfId-3481906]Associate your DNS policy with an access control policy, as described in Building the Security Intelligence Whitelist and Blacklist.
 
     	 [bookmark: pgfId-3481898]Deploy configuration changes; see Deploying Configuration Changes.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1871080][bookmark: 19929]Blocking Mal[bookmark: marker-2040882]ware and Prohibited Files 
      
      
 
     
 
 
    [bookmark: pgfId-2009028]Malicious software, or malware, can enter your organization’s network via multiple routes. To help you identify and mitigate the effects of malware, the ASA FirePOWER module’s file control and advanced malware protection components can detect, track, store, analyze, and optionally block the transmission of malware and other types of files in network traffic.
 
    [bookmark: pgfId-1707030]You configure the system to perform malware protection and file control as part of your overall access control configuration. File policies that you create and associate with access control rules handle network traffic that matches the rules. 
 
     
      
       
       [bookmark: pgfId-2134866]Table 26-1 License and Appliance Requirements for Intrusion and File Inspection 
 
       
       
        
        	 
          
          [bookmark: pgfId-2134872]Feature 
         
  
        	 
          
          [bookmark: pgfId-2134874]Description 
         
  
        	 
          
          [bookmark: pgfId-2134876]Add this license... 
         
  
       
 
        
        	[bookmark: pgfId-2134878]intrusion prevention
  
        	[bookmark: pgfId-2134880]detect and optionally block intrusions and exploits
  
        	[bookmark: pgfId-2134885]Protection
  
       
 
        
        	[bookmark: pgfId-2134887]file control
  
        	[bookmark: pgfId-2134889]detect and optionally block the transmission of file types 
  
        	[bookmark: pgfId-2134894]Protection
  
       
 
        
        	[bookmark: pgfId-2134896]advanced malware protection (AMP)
  
        	[bookmark: pgfId-2134902]detect, track, and optionally block the transmission of malware
  
        	[bookmark: pgfId-2134907]Malware
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2102108]For more information, see:
 
     
     	 [bookmark: pgfId-1601945]Understanding Malware Protection and File Control
 
     	 [bookmark: pgfId-1601949]Understanding and Creating File Policies
 
    
 
   
 
    
     [bookmark: pgfId-2060264][bookmark: 83805]Understanding Malware Protection and File Control
 
    [bookmark: pgfId-2060846]License: Protection, Malware, or Any
 
    [bookmark: pgfId-2008994]Using the advanced malware protection feature, you can configure the ASA FirePOWER module to detect, track, analyze, and optionally block malware files being transmitted on your network.
 
    [bookmark: pgfId-1861792]The system can detect and optionally block malware in many types of files, including PDFs, Microsoft Office documents, and others. ASA FirePOWER modules monitor specific application protocol-based network traffic for transmissions of those file types. When the ASA FirePOWER module detects an eligible file, the ASA FirePOWER module then performs a malware cloud lookup[bookmark: marker-2146255] using the file’s SHA-256 hash value. Based on these results, the Cisco cloud returns a file disposition to the ASA FirePOWER module. 
 
    [bookmark: pgfId-2013121]If a file has a disposition in the cloud that you know to be incorrect, you can add the file’s SHA-256 value to a file list:
 
     
     	 [bookmark: pgfId-1965483]To treat a file as if the cloud assigned a clean disposition, add the file to the  clean list [bookmark: marker-2014362].
 
     	 [bookmark: pgfId-1965614]To treat a file as if the cloud assigned a malware disposition, add the file to the  custom detection list. [bookmark: marker-2014367]
 
    
 
    [bookmark: pgfId-1965684]If the system detects a file’s SHA-256 value on a file list, it takes the appropriate action without performing a malware lookup or checking the file disposition. Note that you must configure a rule in the file policy with either a Malware Cloud Lookup or Block Malware action and a matching file type to calculate a file’s SHA value. You can enable use of the clean list or custom detection list on a per-file-policy basis. 
 
    [bookmark: pgfId-2134942]To inspect or block files, you must enable a Protection license on the ASA FirePOWER module. To add files to a file list, you must also enable a Malware license.
 
    [bookmark: pgfId-2134949][bookmark: 17858]Understanding File Dis[bookmark: marker-2134947]positions[bookmark: marker-2134948]
 
    [bookmark: pgfId-1789523]The system determines file dispositions based on the disposition returned by the Cisco cloud. A file can have one of the following file dispositions returned by the Cisco cloud, as a result of addition to a file list, or due to threat score:
 
     
     	 [bookmark: pgfId-1789524] Malware indicates that the cloud categorized the file as malware.
 
     	 [bookmark: pgfId-1789525] Clean indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
     	 [bookmark: pgfId-1789526] Unknown indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The cloud has not categorized the file.
 
     	 [bookmark: pgfId-1872434] Custom Detection  indicates that a user added the file to the custom detection list. 
 
     	 [bookmark: pgfId-2115399] Unavailable indicates that the ASA FirePOWER module could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2170531]Tip If you see several Unavailable malware events in quick succession, check your cloud connection and port configuration. For more information, see Security, Internet Access, and Communication Ports.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2180482] Based on the file disposition, the ASA FirePOWER module either blocks the file or blocks its upload or download. To improve performance, if the system already knows the disposition for a file based on its SHA-256 value, your appliance uses the cached disposition rather than querying the Cisco cloud.
 
    [bookmark: pgfId-2170589]Note that file dispositions can change. For example, the cloud can determine that a file that was previously thought to be clean is now identified as malware, or the reverse—that a malware-identified file is actually clean. When the disposition changes for a file for which you performed a malware lookup in the last week, the cloud notifies the ASA FirePOWER module so the system can take appropriate action the next time it detects that file being transmitted. A changed file disposition is called a retrospective disposition.
 
    [bookmark: pgfId-1846956]File dispositions returned from a malware cloud lookup [bookmark: marker-1863059]have a time-to-live (TTL) value. After a file disposition has been held for the duration specified in the TTL value without update, the system purges the cached information. Dispositions have the following TTL values:
 
     
     	 [bookmark: pgfId-1846958]Clean—4 hours 
 
     	 [bookmark: pgfId-1846959]Unknown—1 hour
 
     	 [bookmark: pgfId-1846960]Malware—1 hour
 
    
 
    [bookmark: pgfId-2009044]If a malware cloud lookup against the cache identifies a cached disposition that timed out, the system performs a fresh lookup to determine a file disposition.
 
    [bookmark: pgfId-2009045]Understanding File Control
 
    [bookmark: pgfId-1719962]If your organization wants to block not only the transmission of malware files, but all files of a specific type (regardless of whether the files contain malware), the file control feature allows you to cast a wider net. As with malware protection, the ASA FirePOWER module monitors network traffic for transmissions of specific file types, then either blocks or allows the file. 
 
    [bookmark: pgfId-1842290]File control is supported for all file types where the system can detect malware, plus many additional file types. These file types are grouped into basic categories, including multimedia (swf, mp3), executables (exe, torrent), and PDFs. Note that file control, unlike malware protection, does not require queries of the Cisco cloud.
 
     
      [bookmark: pgfId-1719704][bookmark: 91168]Configuring Malware Protection and File Con[bookmark: marker-1774720]trol
 
     [bookmark: pgfId-1771361]License: Protection or Malware
 
     [bookmark: pgfId-1871647]You configure malware protection and file control as part of your overall access control configuration by associating file policies with access control rules. This association ensures that before the system passes a file in traffic that matches an access control rule’s conditions, it first inspects the file. 
 
     [bookmark: pgfId-1966815]A file policy, like its parent access control policy, contains rules that determine how the system handles files that match the conditions of each rule. You can configure separate file rules to take different actions for different file types, application protocols, or directions of transfer.
 
     [bookmark: pgfId-1762618]When a file matches a rule, the rule can:
 
      
      	 [bookmark: pgfId-1966656]allow or block files based on simple file type matching 
 
      	 [bookmark: pgfId-1966657]block files based on malware file disposition 
 
      	 [bookmark: pgfId-1966796]In addition, the file policy can automatically treat a file as if it is clean or malware based on entries in the clean list or custom detection list
 
     
 
     [bookmark: pgfId-2127421]As a simple example, you could implement a file policy that blocks your users from downloading executable files. For detailed information on file policies and associating them with access control rules, see Understanding and Creating File Policies.
 
    
 
     
      [bookmark: pgfId-1722515][bookmark: 31276]Logging Events Based on Malware Protection and File Control
 
     [bookmark: pgfId-1759850]License: Protection or Malware
 
     [bookmark: pgfId-1871945]The ASA FirePOWER module logs records of the system’s file inspection and handling as captured files, file events, and malware events:
 
      
      	 [bookmark: pgfId-1985361] File events represent files that the system detected, and optionally blocked, in network traffic.
 
      	 [bookmark: pgfId-1714151] Malware events represent malware files detected, and optionally blocked, in network traffic by the system.
 
      	 [bookmark: pgfId-1714153] Retrospective malware events [bookmark: marker-1714152] represent files whose malware file dispositions have changed.
 
     
 
     [bookmark: pgfId-2276528]Wh[bookmark: marker-2276527]en the system generates a malware event based on detection or blocking of malware in network traffic, it also generates a file event, because to detect malware in a file the system must first detect the file itself. 
 
    
 
   
 
    
     [bookmark: pgfId-2271146][bookmark: 45397][bookmark: 59582]Understanding and Creating File Policie[bookmark: marker-2271145]s
 
    [bookmark: pgfId-2271156]License: Protection or Malware
 
    [bookmark: pgfId-1747380]A file policy is a set of configurations that the system uses to perform advanced malware protection and file control, as part of your overall access control configuration. 
 
    [bookmark: pgfId-2301627]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1747167]The policy has two access control rules, both of which use the Allow action and are associated with file policies. The policy’s default action is also to allow traffic, but without file policy inspection. In this scenario, traffic is handled as follows:
 
     
     	 [bookmark: pgfId-1747168]Traffic that matches  Rule 1 is inspected by  File Policy A .
 
     	 [bookmark: pgfId-1747169]Traffic that does not match  Rule 1 is evaluated against  Rule 2 . Traffic that matches  Rule 2 is inspected by  File Policy B . 
 
     	 [bookmark: pgfId-1747170]Traffic that does not match either rule is allowed; you cannot associate a file policy with the default action.
 
    
 
    [bookmark: pgfId-1886113]A file policy, like its parent access control policy, contains rules that determine how the system handles files that match the conditions of each rule. You can configure separate file rules to take different actions for different file types, application protocols, or directions of transfer.
 
    [bookmark: pgfId-1966883]Once a file matches a rule, the rule can:
 
     
     	 [bookmark: pgfId-1966884]allow or block files based on simple file type matching 
 
     	 [bookmark: pgfId-1966885]block files based on Malware file disposition 
 
     	 [bookmark: pgfId-1966889]In addition, the file policy can automatically treat a file as if it is clean or malware based on entries in the clean list or custom detection list
 
    
 
    [bookmark: pgfId-1758388]You can associate a single file policy with an access control rule whose action is Allow, Interactive Block, or Interactive Block with reset. The system then uses that file policy to inspect network traffic that meets the conditions of the access control rule. By associating different file policies with different access control rules, you have granular control over how you identify and block files transmitted on your network. Note, however, that you cannot use a file policy to inspect traffic handled by the access control default action. For detailed information, see Inspecting Allowed Traffic For Intrusions and Malware.
 
    [bookmark: pgfId-2110472]File R[bookmark: marker-2110471]ules
 
     
      
       
       [bookmark: pgfId-1680277]Table 26-2 File Rule Components 
 
       
       
        
        	 
          
          [bookmark: pgfId-1680281]File Rule Component 
         
  
        	 
          
          [bookmark: pgfId-1680283]Description 
         
  
       
 
        
        	[bookmark: pgfId-1680285]application protocol
  
        	[bookmark: pgfId-1680287]The system can detect and inspect files transmitted via FTP, HTTP, SMTP, IMAP, POP3, and NetBIOS-ssn (SMB). To improve performance, you can restrict file detection to only one of those application protocols on a per-file rule basis.
  
       
 
        
        	[bookmark: pgfId-1680289]direction of transfer
  
        	[bookmark: pgfId-1680291]You can inspect incoming FTP, HTTP, IMAP, POP3, and NetBIOS-ssn (SMB) traffic for downloaded files; you can inspect outgoing FTP, HTTP, SMTP, and NetBIOS-ssn (SMB) traffic for uploaded files.
  
       
 
        
        	[bookmark: pgfId-1680293][bookmark: marker-1697180]file categories and types
  
        	[bookmark: pgfId-1842266]The system can detect various types of files. These file types are grouped into basic categories, including multimedia (swf, mp3), executables (exe, torrent), and PDFs. You can configure file rules that detect individual file types, or on entire categories of file types. 
 [bookmark: pgfId-1842263]For example, you could block all multimedia files, or just ShockWave Flash (swf) files. Or, you could configure the system to alert you when a user downloads a BitTorrent (torrent) file.
 
          
           
         
 
         
 
          
          [bookmark: pgfId-1680297]Caution Frequently triggered file rules can affect system performance. For example, detecting multimedia files in HTTP traffic (YouTube, for example, transmits significant Flash content) could generate an overwhelming number of events. 
           
           
 
          
 
         
  
       
 
        
        	[bookmark: pgfId-1680299]file rule action
  
        	[bookmark: pgfId-1680301]A file rule’s action determines how the system handles traffic that matches the conditions of the rule. 
 [bookmark: pgfId-1680302]Note File rules are evaluated in rule-action, not numerical, order. For more information, see the next section, File Rule Actions and Evaluation Order.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1680305][bookmark: 37584]File Rule Acti[bookmark: marker-1693837]ons and Evaluation Order
 
    [bookmark: pgfId-1716831]Each file rule has an associated action that determines how the system handles traffic that matches the conditions of the rule. You can set separate rules within a file policy to take different actions for different file types, application protocols, or directions of transfer. The rule actions are as follows, in rule-action order:
 
     
     	 [bookmark: pgfId-1694075] Block Files  rules allow you to block specific file types.
 
     	 [bookmark: pgfId-1780942] Block Malware [bookmark: marker-1863138]rules a[bookmark: marker-1863148]llow you to calculate the SHA-256 hash value of specific file types, then use a cloud lookup process to first determine if files traversing your network contain malware, then block files that represent threats.
 
     	 [bookmark: pgfId-1694080] Malware Cloud Lookup [bookmark: marker-1694076] rules allow you to log the malware disposition of files traversing your network based on a cloud lookup, while still allowing their transmission.
 
     	 [bookmark: pgfId-1602121] Detect Files  rules allow you to log the detection of specific file types while still allowing their transmission.
 
    
 
    [bookmark: pgfId-1887841]For each file rule action, you can configure options to reset the connection when a file transfer is blocked and store captured files to the ASA FirePOWER module. The following table details the options available to each file action.
 
    [bookmark: pgfId-1860538]
 
     
      
       
       [bookmark: pgfId-2140581]Table 26-3 [bookmark: 54648]File Rule Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-2140585]Action 
         
  
        	 
          
          [bookmark: pgfId-2140587]Resets Connection? 
         
  
       
 
        
        	[bookmark: pgfId-2140589]Block Files
  
        	[bookmark: pgfId-2140591]yes (recommended)
  
       
 
        
        	[bookmark: pgfId-2140593]Block Malware
  
        	[bookmark: pgfId-2140595]yes (recommended)
  
       
 
        
        	[bookmark: pgfId-2140597]Detect Files
  
        	[bookmark: pgfId-2140599]no
  
       
 
        
        	[bookmark: pgfId-2140601]Malware Cloud Lookup
  
        	[bookmark: pgfId-2140603]no
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2009662]File and Malware Detection, Capture, and Blocking Notes and Limitations
 
    [bookmark: pgfId-2009664]Note the following details and limitations on file and malware detection, capture, and blocking behavior:
 
     
     	 [bookmark: pgfId-2009666]Until a file is detected and block in a session, packets from the session may be subject to intrusion inspection.
 
     	 [bookmark: pgfId-2281891]If an end-of-file marker is not detected for a file, regardless of transfer protocol, the file is not blocked by a  Block Malware rule or by the custom detection list. The system waits to block the file until the entire file has been received, as indicated by the end-of-file marker, and blocks the file after the marker is detected.
 
     	 [bookmark: pgfId-2009667]If the end-of-file marker for an FTP file transfer is transmitted separately from the final data segment, the marker is blocked and the FTP client indicates that the file transfer failed, but the file actually completely transfers to disk.
 
     	 [bookmark: pgfId-2009668]FTP transfers commands and data over different channels. In a passive deployment, the traffic from an FTP data session and its control session may not be load-balanced to the same Snort.
 
     	 [bookmark: pgfId-2126629]If a file matches a rule with an application protocol condition, file event generation occurs after the system successfully identifies a file’s application protocol. Unidentified files do not generate file events.
 
     	 [bookmark: pgfId-2102971]For an access control policy using a file policy with  Block Malware rules for FTP, if you set the default action to an intrusion policy with  Drop when Inline disabled, the system generates events for detected files or malware matching the rules, but does not drop the files. To block FTP fire transfers and use an intrusion policy as the default action for the access control policy where you select the file policy, you must select an intrusion policy with  Drop when Inline enabled.
 
     	 [bookmark: pgfId-2102972]File rules with  Block Files and  Block Malware actions block automatic resumption of file download via HTTP by blocking new sessions with the same file, URL, server, and client application detected for 24 hours after the initial file transfer attempt occurs.
 
     	 [bookmark: pgfId-2009671]In rare cases, if traffic from an HTTP upload session is out of order, the system cannot reassemble the traffic correctly and therefore does not block it or generate a file event. 
 
     	 [bookmark: pgfId-2009672]If you transfer a file over NetBIOS-ssn (such as an SMB file transfer) that is blocked with a  Block Files rule, you may see a file on the destination host. However, the file is unusable because it is blocked after the download starts, resulting in an incomplete file transfer.
 
     	 [bookmark: pgfId-2102815]If you create file rules to detect or block files transferred over NetBIOS-ssn (such as an SMB file transfer), the system does not inspect files transferred in an established TCP or SMB session started before you apply an access control policy invoking the file policy, so those files will not be detected or blocked.
 
     	 [bookmark: pgfId-2102816]A rule configured to block files in a passive deployment does not block matching files. Because the connection continues to transmit the file, if you configure the rule to log the beginning of the connection, you may see multiple events logged for this connection.
 
     	 [bookmark: pgfId-2102817]If the total number of bytes for all file names for files in a POP3, POP, SMTP, or IMAP session exceeds 1024, file events from the session may not reflect the correct file names for files that were detected after the file name buffer filled. 
 
     	 [bookmark: pgfId-2012038]When transmitting text-based files over SMTP, some mail clients convert newlines to the CRLF newline character standard. Since Mac-based hosts use the carriage return (CR) character and Unix/Linux-based hosts use the line feed (LF) character, newline conversion by the mail client may modify the size of the file. Note that some mail clients default to newline conversion when processing an unrecognizable file type.
 
     	 [bookmark: pgfId-2009675]Cisco recommends that you enable  Reset Connection for the  Block Files and  Block Malware actions to prevent blocked application sessions from remaining open until the TCP connection resets. If you do not reset connections, the client session remains open until the TCP connection resets itself.
 
     	 [bookmark: pgfId-2009676]If a file rule is configured with a  Malware Cloud Lookup or  Block Malware action and the ASA FirePOWER module cannot establish connectivity with the cloud, the system cannot perform any configured rule action options until cloud connectivity is restored.
 
    
 
    [bookmark: pgfId-2009839]File Rule Evaluation Example
 
     
      
       
       [bookmark: pgfId-1936747]Table 26-4 File Rule Evaluation Order Example 
 
       
       
        
        	 
          
          [bookmark: pgfId-1936757]App. Protocol 
         
  
        	 
          
          [bookmark: pgfId-1936759]Direction 
         
  
        	 
          
          [bookmark: pgfId-1936761]Action 
         
  
        	 
          
          [bookmark: pgfId-1936763]Action Options 
         
  
        	 
          
          [bookmark: pgfId-1936765]Result 
         
  
       
 
        
        	[bookmark: pgfId-1936767]SMTP
  
        	[bookmark: pgfId-1936769]Upload
  
        	[bookmark: pgfId-1936771]Block Files
  
        	[bookmark: pgfId-1936773]Reset Connection
  
        	[bookmark: pgfId-1936775]Blocks users from emailing PDF files and resets the connection.
  
       
 
        
        	[bookmark: pgfId-1936777]FTP
  
        	[bookmark: pgfId-1936779]Download
  
        	[bookmark: pgfId-1936781]Block Malware
  
        	[bookmark: pgfId-1936783]Reset Connection
  
        	[bookmark: pgfId-1936785]Blocks the download of malware PDF files via file transfer, and resets the connection.
  
       
 
        
        	[bookmark: pgfId-1936787]POP3
 [bookmark: pgfId-2105384]IMAP
  
        	[bookmark: pgfId-1936789]Download
  
        	 
        	[bookmark: pgfId-1936795]Inspects PDF files received via email for malware. 
  
       
 
        
        	[bookmark: pgfId-1936800]Any
  
        	[bookmark: pgfId-1936802]Any
  
        	[bookmark: pgfId-1936804]Detect Files
  
        	[bookmark: pgfId-1936806]none
  
        	[bookmark: pgfId-1936808]Detects and logs, but allows the traffic, when users view PDF files on the web (that is, via HTTP).
  
       
 
       
     
 
    
 ) to designate conflicting file rules. 
    
 
    [bookmark: pgfId-1850781]Note that you cannot perform malware analysis on all file types detected by the system. After you select values from the Application Protocol, Direction of Transfer, and Action drop-down lists, the system constrains the list of file types.
 
    [bookmark: pgfId-1602169][bookmark: marker-2014686]Logging File Events, [bookmark: marker-1693842]Malware Events and Alerts
 
    [bookmark: pgfId-1716837]When you associate a file policy with an access control rule, the system automatically enables file and malware event logging for matching traffic. When the system inspects a file, it can generate the following types of events:
 
     
     	 [bookmark: pgfId-1674725] file events , which represent detected or blocked files, as well as detected malware files
 
     	 [bookmark: pgfId-1694231] malware events , which represent detected malware files
 
     	 [bookmark: pgfId-1694233] retrospective malware events [bookmark: marker-1694232], which are generated when the Malware file disposition for a previously detected file changes
 
    
 
    [bookmark: pgfId-1674651]When a file policy generates a file or malware event, or captures a file, the system automatically logs the end of the associated connection, regardless of the logging configuration of the invoking access control rule. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1868720]Note File events generated by inspecting NetBIOS-ssn (SMB) traffic do not immediately generate connection events because the client and server establish a persistent connection. The system generates connection events after the client or server ends the session.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1868207]For each of these connection events:
 
     
     	 [bookmark: pgfId-1674658]The  Files field contains an icon (
 
     [image: ] ) that indicates the number of files (including malware files) detected in the connection; click the icon to see a list of those files and, for malware files, their file dispositions. 
    
 
     
     	 [bookmark: pgfId-1854191]The  Reason field indicates the reason the connection event was logged, which depends on the file rule action: 
 
    
 
    [bookmark: pgfId-1860605] – File Monitor for Detect Files and Malware Cloud Loo[bookmark: marker-1854192]kup file rules and for files on the clean list
 
    [bookmark: pgfId-1860619] – File Block for B[bookmark: marker-1863184]lock Files or Block Malware file rules
 
    [bookmark: pgfId-1876396] – File Custom Detection if the system encountered a file on the custom detection list
 
    [bookmark: pgfId-1863194] – File Resume Allow where file transmission was originally blocked by a Block Files or Block Malware file rule. After a new access control policy was applied that allowed the file, the HTTP session automatically resumed.
 
    [bookmark: pgfId-1931869] – File Resume Block where file transmission was originally allowed by a Detect Files or Malware Cloud Lookup file rule. After a new access control policy was applied that blocked the file, the HTTP session automatically stopped.
 
     
     	 [bookmark: pgfId-2188121]For connections where a file or malware was blocked, the  Action is  Block. 
 
    
 
    [bookmark: pgfId-2188125]As with any kind of event generated by the ASA FirePOWER module, you can view and analyze file and malware events. You can also use malware events to alert you via SNMP or syslog.
 
    [bookmark: pgfId-1602195]Internet Access
 
    [bookmark: pgfId-2099781]The s[bookmark: marker-1853582]ystem uses port 443 to perform malware cloud lookups for network-based AMP. You must open that port outbound on the ASA FirePOWER module. 
 
    [bookmark: pgfId-1606605]Managing Fi[bookmark: marker-1697316]le Policies
 
    [bookmark: pgfId-1606606]You create, edit, delete, and compare file policies on the File Policies page (Policies > Files), which displays a list of existing file policies along with their last-modified dates. 
 ) for a file policy displays a dialog box that tells you which access control policies use the file policy, then redirects you to the Access Control Policy page. This is because you cannot apply a file policy independently, as a file policy is considered part of its parent access control policies. To use a new file policy, or to apply changes made to an existing file policy, you must apply or reapply the parent access control policies. 
    
 
    [bookmark: pgfId-2284112]Note that you cannot delete a file policy used in a saved or applied access control policy. 
 
    [bookmark: pgfId-1606831]For more information on managing file policies, see the following sections:
 
     
     	 [bookmark: pgfId-1602229]Creating a File Policy
 
     	 [bookmark: pgfId-1602233]Working with File Rules
 
     	 [bookmark: pgfId-2228467]Comparing Two File Policies
 
    
 
     
      [bookmark: pgfId-1602243][bookmark: 35719]Creating a File P[bookmark: marker-1697321]olicy
 
     [bookmark: pgfId-2140770]License: Protection or Malware
 
     [bookmark: pgfId-1863217]After you create a file policy and populate it with rules, you can use it in an access control policy. 
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1602250]To create a file policy:
 
    
 
    [bookmark: pgfId-2140855]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Files.
 
    [bookmark: pgfId-2140856]The File Policies page appears.
 
    [bookmark: pgfId-1602254]Step 2 Click New File Policy.
 
    [bookmark: pgfId-1602255]The New File Policy dialog box appears.
 
    [bookmark: pgfId-1611922]For a new policy, the module interface indicates that the policy is not in use. If you are editing an in-use file policy, the module interface tells you how many access control policies use the file policy. In either case, you can click the text to jump to the Access Control Policies page; see Getting Started with Access Control Policies.
 
    [bookmark: pgfId-1611916]Step 3 Enter a Name and optional Description for your new policy, then click Save.
 
    [bookmark: pgfId-1611917]The File Policy Rules tab appears.
 
    [bookmark: pgfId-1611839]Step 4 Add one or more rules to the file policy.
 
    [bookmark: pgfId-1611840]File rules give you granular control over which file types you want to log, block, or scan for malware. For information on adding file rules, see Working with File Rules.
 
    [bookmark: pgfId-1968001]Step 5 Configure the advanced options. See Configuring Advanced File Policy General Options for more information.
 
    [bookmark: pgfId-1848671]Step 6 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-1602268]To use your new policy, you must add the file policy to an access control rule, then apply the access control policy. If you are editing an existing file policy, you must reapply any access control policies that use the file policy.
 
    [bookmark: pgfId-2074048]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1602270][bookmark: 23561]Working [bookmark: marker-1697341]with File Rules
 
    [bookmark: pgfId-1602271]License: Protection or Malware
 
    [bookmark: pgfId-1716877]To be effective, a file policy must contain one or more rules. You create, edit, and delete rules on the File Policy Rules page, which appears when you create a new file policy or edit an existing policy. The page lists all the rules in the policy, along with each rule’s basic characteristics. 
 
    [bookmark: pgfId-1642958]The page also notifies you of how many access control policies use this file policy. You can click the notification to display a list of the parent policies and, optionally, continue to the Access Control Policies page.
 
    [bookmark: pgfId-1642943]To create a file rule:
 
    
 
    [bookmark: pgfId-1602275]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Files.
 
    [bookmark: pgfId-1602276]The File Policies page appears.
 
    [bookmark: pgfId-1602277]Step 2 You have the following options:
 
     
      
      	 [bookmark: pgfId-1602278]To add rules to a new policy, click  New File Policy to create a new policy; see Creating a File Policy.
 
      	 [bookmark: pgfId-1602282]To add rules to an existing policy, click the edit icon (
 
     
 
     [image: ] ) next to the policy. 
    
 
    [bookmark: pgfId-1602283]Step 3 On the File Policy Rules page that appears, click Add File Rule.
 
    [bookmark: pgfId-1602284]The Add File Rule dialog box appears.
 
    [bookmark: pgfId-1831739]Step 4 Select an Application Protocol from the drop-down list.
 
    [bookmark: pgfId-1831740]Any, the default, detects files in HTTP, SMTP, IMAP, POP3, FTP, and NetBIOS-ssn (SMB) traffic.
 
    [bookmark: pgfId-1603907]Step 5 Select a Direction of Transfer from the drop-down list.
 
    [bookmark: pgfId-1829561]You can inspect the following types of incoming traffic for downloaded files:
 
     
      
      	 [bookmark: pgfId-1975202]HTTP
 
      	 [bookmark: pgfId-1975149]IMAP
 
      	 [bookmark: pgfId-1975152]POP3
 
      	 [bookmark: pgfId-1975155]FTP
 
      	 [bookmark: pgfId-1975159]NetBIOS-ssn (SMB)
 
     
 
    
 
    [bookmark: pgfId-1975059]You can inspect the following types of outgoing traffic for uploaded files:
 
     
      
      	 [bookmark: pgfId-1975181]HTTP
 
      	 [bookmark: pgfId-1975184]FTP 
 
      	 [bookmark: pgfId-1975187]SMTP 
 
      	 [bookmark: pgfId-1975190]NetBIOS-ssn (SMB)
 
     
 
    
 
    [bookmark: pgfId-1975143]Use Any to detect files over multiple application protocols, regardless of whether users are sending or receiving.
 
    [bookmark: pgfId-1974511]Step 6 Select a file rule Action. See the File Rule Actions table for more information. 
 
    [bookmark: pgfId-2006650]When you select either Block Files or Block Malware, Reset Connection is enabled by default. To not reset the connection where a blocked file transfer occurs, clear the Reset Connection check box.
 
     
      
    
 
    
 
    [bookmark: pgfId-2006654]Note Cisco recommends that you leave Reset Connection enabled to prevent blocked application sessions from remaining open until the TCP connection resets.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1602295]For detailed information on file rule actions, see File Rule Actions and Evaluation Order.
 
    [bookmark: pgfId-1850717]Step 7 Select one or more File Types. Use the Shift and Ctrl keys to select multiple file types. You can filter the list of file types in the following ways:
 
     
      
      	 [bookmark: pgfId-1602298]Select one or more  File Type Categories .
 
      	 [bookmark: pgfId-1602299]Search for a file type by its name or description. For example, type  Windows in the  Search name and description field to display a list of Microsoft Windows-specific files.
 
     
 
    
 
    [bookmark: pgfId-1832839]The file types that you can use in a file rule vary depending on your selections for Application Protocol, Direction of Transfer, and Action. 
 
    [bookmark: pgfId-1832840]For example, selecting Download as the Direction of Transfer removes GIF, PNG, JPEG, TIFF, and ICO from the Graphics category to prevent an excess of file events. 
 
    [bookmark: pgfId-1676481]Step 8 Add the selected file types to the Selected Files Categories and Types list:
 
     
      
      	 [bookmark: pgfId-1676482]Click  Add to add selected file types to the rule.
 
      	 [bookmark: pgfId-1676463]Drag and drop one or more file types into the  Selected Files Categories and Types list.
 
      	 [bookmark: pgfId-1855882]With a category selected, click  All types in selected Categories , then either click  Add or drag and drop that selection to the  Selected Files Categories and Types list.
 
     
 
    
 
    [bookmark: pgfId-1602305]Step 9 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-1829964]The file rule is added to the policy. If you are editing an existing file policy, you must reapply any access control policies that use the file policy for your changes to take effect.
 
    [bookmark: pgfId-2074079]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1969270][bookmark: 50520]Configuring Advanced File Policy General Options
 
    [bookmark: pgfId-1969529]License: Malware
 
    [bookmark: pgfId-2212312]In a file policy, you can set the following advanced options in the General section.
 
    [bookmark: pgfId-1969912]
 
     
      
       
       [bookmark: pgfId-2105438]Table 26-5 [bookmark: 91200]Advanced File Policy General Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-2105444]Field 
         
  
        	 
          
          [bookmark: pgfId-2105446]Description 
         
  
        	 
          
          [bookmark: pgfId-2105448]Default Value 
         
  
       
 
        
        	[bookmark: pgfId-2105450]Enable Custom Detection List
  
        	[bookmark: pgfId-2105452]Select this to block files on the custom detection list when detected. 
  
        	[bookmark: pgfId-2105454]enabled
  
       
 
        
        	[bookmark: pgfId-2105456]Enable Clean List
  
        	[bookmark: pgfId-2105458]Select this to allow files on the clean list when detected. 
  
        	[bookmark: pgfId-2105460]enabled
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1969370]To configure advanced file policy general options:
 
    
 
    [bookmark: pgfId-1973723]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Files.
 
    [bookmark: pgfId-1973724]The File Policies page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1973809]The File Policy Rule page appears. 
 
    [bookmark: pgfId-1969271]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1969272]The Advanced tab appears.
 
    [bookmark: pgfId-1969292]Step 4 Modify the options as described in the Advanced File Policy General Options table.
 
    [bookmark: pgfId-1974035]Step 5 Click Store ASA FirePOWER Changes.
 
    [bookmark: pgfId-1974036]You must reapply any access control policies that use the file policy you edited.
 
    [bookmark: pgfId-2074119]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2228852][bookmark: 28528][bookmark: 24804]Comparing Two Fi[bookmark: marker-2228851]le Policies
 
    [bookmark: pgfId-2228859]License: Protection
 
    [bookmark: pgfId-2228861]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between any two file policies, or two revisions of the same policy. 
 
    [bookmark: pgfId-2228862]The file policy comparison view displays two file policies or revisions in a side-by-side format, with the time of last modification and the last user to modify displayed next to each policy name. Differences between the two policies are highlighted:
 
     
     	 [bookmark: pgfId-2228863]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
     	 [bookmark: pgfId-2228864]Green indicates that the highlighted setting appears in one policy but not the other.
 
    
 , which is a PDF version of the comparison view. 
    
 
    [bookmark: pgfId-2228869]To compare two file policies:
 
    
 
    [bookmark: pgfId-2228874]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Files.
 
    [bookmark: pgfId-2228875]The File Policies page appears.
 
    [bookmark: pgfId-2228876]Step 2 Click Compare Policies.
 
    [bookmark: pgfId-2228877]The Select Comparison dialog box appears.
 
    [bookmark: pgfId-2228878]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
     
      
      	 [bookmark: pgfId-2228879]To compare two different policies, select either  Running Configuration or  Other Policy . The practical difference between the two options is that if you select  Running Configuration , the system limits one of your comparison choices to the set of currently applied file policies.
 
      	 [bookmark: pgfId-2228880]To compare revisions of the same policy, select  Other Revision .
 
     
 
    
 
    [bookmark: pgfId-2228881]The dialog box refreshes, displaying your comparison options.
 
    [bookmark: pgfId-2228882]Step 4 Depending on the comparison type you selected, you have the following choices:
 
     
      
      	 [bookmark: pgfId-2228883]If you are comparing two different policies, select the policies you want to compare:  Policy A or  Target/Running Configuration A , and  Policy B .
 
      	 [bookmark: pgfId-2228884]If you are comparing revisions of the same policy, select the  Policy you want to use, then select the two revisions:  Revision A and  Revision B . Revisions are listed by date and user name.
 
     
 
    
 
    [bookmark: pgfId-2228885]Step 5 Click OK.
 
    [bookmark: pgfId-2228886]The comparison view appears.
 
    [bookmark: pgfId-2228888]Optionally, click Comparison Report to generate a file policy comparison report. You are prompted to save the report to your computer.
 
    [bookmark: pgfId-1813762]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 29886]Logging Connections in Network Traffic 
      
      
 
     
 
 
    [bookmark: pgfId-1562069]As devices monitor traffic generated by the hosts on your network, they can generate logs of the connections they detect. Various settings in access control policies give you granular control over which connections you log, when you log them, and where you store the data. An access control rule’s specific logging configuration also determines whether you log file and malware events associated with the connection.
 
    [bookmark: pgfId-1594139]In most cases, you can log a connection at its beginning and its end. When you log a connection, the system generates a connection event. You can also log a special kind of connection event, called a Security Intelligence event, whenever a connection is blacklisted (blocked) by the reputation-based Security Intelligence feature. 
 
    [bookmark: pgfId-1561346]Connection events contain data about the detected sessions.
 
    [bookmark: pgfId-1682574]You should log connections according to the security and compliance needs of your organization.
 
    [bookmark: pgfId-1682532]For more information on logging connection data, see:
 
     
     	 [bookmark: pgfId-1543531]Deciding Which Connections To Log
 
     	 [bookmark: pgfId-1543564]Logging Security Intelligence (Blacklisting) Decisions
 
     	 [bookmark: pgfId-1545312]Logging Connections Based on Access Control Handling
 
     	 [bookmark: pgfId-1546417]Logging URLs Detected in Connections
 
     	 [bookmark: pgfId-1704646]Logging Encrypted Connections
 
    
 
   
 
    
     [bookmark: pgfId-1545314][bookmark: 98684]Deciding Which Connections To Log
 
    [bookmark: pgfId-1562232]License: Any
 
    [bookmark: pgfId-1636520]Using various settings in access control policies, you can log any connection that your ASA FirePOWER module monitors. In most cases, you can log a connection at its beginning and its end. However, because blocked traffic is immediately denied without further inspection, the system can log only beginning-of-connection events for blocked or blacklisted traffic; there is no unique end of connection to log.
 
    [bookmark: pgfId-1636524]When you log a connection event, you can view it in the event viewer. You can also send connection data to an external syslog or SNMP trap server.
 
     
      
    
 
    
 
    [bookmark: pgfId-1637707]Tip To perform detailed analysis of connection data using the ASA FirePOWER module, Cisco recommends you log the ends of critical connections. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1637711]For more information, see:
 
     
     	 [bookmark: pgfId-1554855]Logging Critical Connections
 
     	 [bookmark: pgfId-1555235]Logging the Beginning And End of Connections
 
     	 [bookmark: pgfId-1555248]Logging Connections to the ASA FirePOWER Module or External Server
 
     	 [bookmark: pgfId-1591033]Understanding How Access Control Rule Actions Affect Logging
 
     	 [bookmark: pgfId-1563278]License Requirements for Connection Logging
 
    
 
     
      [bookmark: pgfId-1562739][bookmark: 85668]Logging Critical Connections
 
     [bookmark: pgfId-1599848]License: Any
 
     [bookmark: pgfId-1562767]You should log connections according to the security and compliance needs of your organization. If your goal is to limit the number of events you generate and improve performance, only enable logging for the connections critical to your analysis. However, if you want a broad view of your network traffic for profiling purposes, you can enable logging for additional connections. Various settings in access control policies give you granular control over which connections you log, when you log them, and where you store the data. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1654697] 
      Caution Logging blocked TCP connections during a Denial of Service (DoS) attack can overwhelm the system with multiple similar events. Before you enable logging for an Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1637689]In addition to the logging that you configure, the system automatically logs most connections where the system detects a prohibited file, malware, or intrusion attempt. The system saves these end-of-connection events for further analysis. All connection events reflect why they were automatically logged using the Action and Reason fields.
 
     [bookmark: pgfId-1554790]Security Intelligence Blacklisting Decisions (Optional)
 
     [bookmark: pgfId-1617083]You can log a connection whenever it is blacklisted (blocked) by the reputation-based Security Intelligence feature. Optionally, and recommended in passive deployments, you can use a monitor-only setting for Security Intelligence filtering. This allows the system to further analyze connections that would have been blacklisted, but still log the match to the blacklist. 
 
     [bookmark: pgfId-1617084]When you enable Security Intelligence logging, blacklist matches generate Security Intelligence events as well as connection events. A Security Intelligence event is a special kind of connection event that you can view and analyze separately, and that is also stored and pruned separately. For more information, see Logging Security Intelligence (Blacklisting) Decisions.
 
     [bookmark: pgfId-1554792]Access Control Handling (Optional)
 
     [bookmark: pgfId-1616814]You can log a connection when it is handled by an access control rule or the access control default action. You configure this logging on a per-access control rule basis so that you only log critical connections. For more information, see Logging Connections Based on Access Control Handling.
 
     [bookmark: pgfId-1616820][bookmark: 91752]Connec[bookmark: marker-1616819]tions Associated with Intrusions (Automatic)
 
     [bookmark: pgfId-1637678]When an intrusion policy invoked by an access control rule (see Tuning Traffic Flow Using Access Control Rules) detects an intrusion and generates an intrusion event, the system automatically logs the end of the connection where the intrusion occurred, regardless of the logging configuration of the rule.
 
     [bookmark: pgfId-1558178]However, when an intrusion policy associated with the access control default action (see Setting Default Handling and Inspection for Network Traffic) generates an intrusion event, the system does not automatically log the end of the associated connection. Instead, you must explicitly enable default action connection logging. This is useful for intrusion prevention-only deployments where you do not want to log any connection data. 
 
     [bookmark: pgfId-1558274]For connections where an intrusion was blocked, the action for the connection in the connection log is Block, with a reason of Intrusion Block, even though to perform intrusion inspection you must use an Allow rule.
 
     [bookmark: pgfId-1616803][bookmark: 65073]Conne[bookmark: marker-1616802]ctions Associated with File and Malware Events (Automatic)
 
     [bookmark: pgfId-1637666]When a file policy invoked by an access control rule detects a prohibited file (including malware) and generates a file or malware event, the system automatically logs the end of the connection where the file was detected, regardless of the logging configuration of the access control rule. You cannot disable this logging.
 
      
       
     
 
     
 
     [bookmark: pgfId-1557905]Note File events generated by inspecting NetBIOS-ssn (SMB) traffic do not immediately generate connection events because the client and server establish a persistent connection. The system generates connection events after the client or server ends the session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1604679]For connections where a file was blocked, the action for the connection in the connection log is Block even though to perform file and malware inspection you must use an Allow rule. The connection’s reason is either File Monitor (a file type or malware was detected), or Malware Block or File Block (a file was blocked).
 
    
 
     
      [bookmark: pgfId-1604681][bookmark: 15726]Logging the Beginning And End of Connections
 
     [bookmark: pgfId-1604685]License: Any
 
     [bookmark: pgfId-1555365]When the system detects a connection, in most cases you can log it at its beginning and its end.
 
     [bookmark: pgfId-1622138]However, because blocked traffic is immediately denied without further inspection, in most cases you can log only beginning-of-connection events for blocked or blacklisted traffic; there is no unique end of connection to log.
 
      
       
     
 
     
 
     [bookmark: pgfId-1616418]Note For a single non-blocked connection, the end-of-connection event contains all of the information in the beginning-of-connection event, as well as information gathered over the duration of the session. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1616432] Note that monitoring a connection for any reason forces end-of-connection logging; see Understanding Logging for Monitored Connections.
 
     [bookmark: pgfId-1616419]The following table details the differences between beginning and end-of-connection events, including the advantages to logging each. 
 
     [bookmark: pgfId-1637650]
 
      
       
        
        
        
         
         	 
           
           [bookmark: pgfId-1637613]Beginning-of-Connection Events 
          
  
         	 
           
           [bookmark: pgfId-1637615]End-of-Connection Events 
          
  
        
 
         
         	[bookmark: pgfId-1637617]Can be generated...
  
         	[bookmark: pgfId-1637619]when the system detects the beginning of a connection (or, after the first few packets if event generation depends on application or URL identification)
  
         	[bookmark: pgfId-1637621]when the system:
 
           
           	 [bookmark: pgfId-1637622]detects the close of a connection
 
           	 [bookmark: pgfId-1637623]does not detect the end of a connection after a period of time
 
           	 [bookmark: pgfId-1637624]can no longer track the session due to memory constraints
 
          
  
        
 
         
         	[bookmark: pgfId-1637626]Can be logged for...
  
         	[bookmark: pgfId-1655122]all connections evaluated by Security Intelligence or access control rules
  
         	[bookmark: pgfId-1655166]all connections are configurable, though the system cannot log the end of blocked or blacklisted connections
  
        
 
         
         	[bookmark: pgfId-1637634]Contain...
  
         	[bookmark: pgfId-1637636]only information that can be determined in the first packet (or the first few packets, if event generation depends on application or URL identification)
  
         	[bookmark: pgfId-1637638]all information in the beginning-of-connection event, plus information determined by examining traffic over the duration of the session, for example, the total amount of data transmitted or the timestamp of the last packet in the connection
  
        
 
         
         	[bookmark: pgfId-1637640]Are useful...
  
         	 
           
           	 [bookmark: pgfId-1637648]perform any kind of detailed analysis on information collected over the duration of the session
 
           	 [bookmark: pgfId-1637649]view connection data in graphical format
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1637655][bookmark: 61659]Logging Connections to the ASA FirePOWER Module or External Server
 
     [bookmark: pgfId-1637776]License: Any
 
     [bookmark: pgfId-1654302]You can log connection events to the ASA FirePOWER module, as well as to an external syslog or SNMP trap server. Before you can log connection data to an external server, you must configure a connection to that server called an alert response; see Working with Alert Responses.
 
    
 
     
      [bookmark: pgfId-1633679][bookmark: 90887]Understanding How Access Control Rule Actions Affect Logging
 
     [bookmark: pgfId-1633683]License: feature dependent
 
     [bookmark: pgfId-1633684]Every access control rule has an action that determines not only how the system inspects and handles the traffic that matches the rule, but also when and how you can log details about matching traffic.
 
     [bookmark: pgfId-1594186]For more information, see:
 
      
      	 [bookmark: pgfId-1591739]Using Rule Actions to Determine Traffic Handling and Inspection
 
      	 [bookmark: pgfId-1591743]Understanding Logging for Monitored Connections
 
      	 [bookmark: pgfId-1591747]Understanding Logging for Trusted Connections
 
      	 [bookmark: pgfId-1591751]Understanding Logging for Blocked and Interactively Blocked Connections
 
      	 [bookmark: pgfId-1591755]Understanding Logging for Allowed Connections
 
      	 [bookmark: pgfId-1592002]Disabling File and Malware Event Logging for Allowed Connections
 
     
 
    
 
     
      [bookmark: pgfId-1591365][bookmark: 79731]Understanding Loggin[bookmark: marker-1591364]g for Monitored Connections
 
     [bookmark: pgfId-1637551]License: feature dependent
 
     [bookmark: pgfId-1637555]The system always logs the ends of the following connections to the ASA FirePOWER module, regardless of the logging configuration of the rule or default action that later handles the connection:
 
      
      	 [bookmark: pgfId-1613854]connections matching a Security Intelligence blacklist set to monitor
 
      	 [bookmark: pgfId-1614001]connections matching an access control Monitor rule
 
     
 
     [bookmark: pgfId-1614637]In other words, if a packet matches a Monitor rule or Security Intelligence monitored blacklist, the connection is always logged, even if the packet matches no other rules and you do not enable logging on the default action. Whenever the system logs a connection event as the result of Security Intelligence filtering, it also logs a matching Security Intelligence event, which is a special kind of connection event that you can view and analyze separately; see Logging Security Intelligence (Blacklisting) Decisions.
 
     [bookmark: pgfId-1602790]Because monitored traffic is always later handled by another rule or by the default action, the action associated with a connection logged due to a monitor rule is never Monitor. Rather, it reflects the action of the rule or default action that later handles the connection. 
 
     [bookmark: pgfId-1637534]The system does not generate a separate event each time a single connection matches an access control Monitor rule. Because a single connection can match multiple Monitor rules, each connection event logged to the ASA FirePOWER module can include and display information on the first eight Monitor access control rules that the connection matches.
 
     [bookmark: pgfId-1591378]Similarly, if you send connection events to an external syslog or SNMP trap server, the system does not send a separate alert each time a single connection matches a Monitor rule. Rather, the alert that the system sends at the end of the connection contains information on the Monitor rules the connection matched.
 
    
 
     
      [bookmark: pgfId-1591385][bookmark: 41321]Understanding Logging for Trusted Connections
 
     [bookmark: pgfId-1633716]License: feature dependent
 
     [bookmark: pgfId-1655286]A trusted connection is one that is handled by a Trust access control rule or the default action in an access control policy. You can log the beginnings and ends of these connections; however, keep in mind that trusted connections are not inspected for intrusions, or prohibited files and malware. Therefore, connection events for trusted connections contain limited information.
 
    
 
     
      [bookmark: pgfId-1639980][bookmark: 75420]Understanding Logging for Blocked and Interactively Blocked Connections[bookmark: marker-1639979]
 
     [bookmark: pgfId-1633739]License: feature dependent
 
     [bookmark: pgfId-1654613]For access control rules and access control policy default actions that block traffic (including interactive blocking rules), the system logs beginning-of-connection events. Matching traffic is denied without further inspection.
 
     [bookmark: pgfId-1608292]Connection events for sessions blocked by an access control rule have an action of Block or Block with reset.
 
     [bookmark: pgfId-1608293]Interactive blocking access control rules, which cause the system to display a warning page when a user browses to a prohibited website, log ends of connections. This is because if the user clicks through the warning page, the connection is considered a new, allowed connection which the system can monitor and log; see Understanding Logging for Allowed Connections.
 
     [bookmark: pgfId-1591398]Therefore, for packets that match an Interactive Block or Interactive Block with reset rule, the system can generate the following connection events:
 
      
      	 [bookmark: pgfId-1591399]a beginning-of-connection event when a user’s request is initially blocked and the warning page is displayed; this event has an associated action of Interactive Block or  Interactive Block with reset 
 
      	 [bookmark: pgfId-1591400]multiple beginning- or end-of-connection events if the user clicks through the warning page and loads the originally requested page; these events have an associated action of  Allow and a reason of  User Bypass 
 
     
 
     [bookmark: pgfId-1607588]Note that only devices deployed inline can block traffic. Because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1654663] 
      Caution Logging blocked TCP connections during a Denial of Service (DoS) attack can overwhelm the system with multiple similar events. Before you enable logging for an Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1654665][bookmark: 81351]Understanding Logging for Allowed Connections
 
     [bookmark: pgfId-1654669]License: feature dependent
 
     [bookmark: pgfId-1594618]Allow access control rules permit matching traffic to pass to the next phase of inspection and traffic handling.
 
     [bookmark: pgfId-1655532]When you allow traffic with an access control rule, you can use an associated intrusion or file policy (or both) to further inspect traffic and block intrusions, prohibited files, and malware before the traffic can reach its final destination.
 
     [bookmark: pgfId-1655533]Connections for traffic matching an Allow access control rule are logged as follows:
 
      
      	 [bookmark: pgfId-1639351]When an intrusion policy invoked by an access control rule detects an intrusion and generates an intrusion event, the system automatically logs the end of the connection where the intrusion occurred to the ASA FirePOWER module, regardless of the logging configuration of the rule.
 
      	 [bookmark: pgfId-1637524]When a file policy invoked by an access control rule detects a prohibited file (including malware) and generates a file or malware event, the system automatically logs the end of the connection where the file was detected to the ASA FirePOWER module, regardless of the logging configuration of the access control rule.
 
      	 [bookmark: pgfId-1597662]Optionally, you can enable beginning- and end-of-connection logging for any allowed traffic, including traffic that the system deems safe or that you do not inspect with an intrusion or file policy.
 
     
 
     [bookmark: pgfId-1597972]For all of the resulting connection events, the Action and Reason fields reflect why the events were logged. Note that:
 
      
      	 [bookmark: pgfId-1596473]An action of  Allow represents explicitly allowed and user-bypassed interactively blocked connections that reached their final destination.
 
      	 [bookmark: pgfId-1596474]An action of  Block represents a connection that was at first allowed by an access control rule, but where an intrusion, prohibited file, or malware was detected.
 
     
 
    
 
     
      [bookmark: pgfId-1596465][bookmark: 29120]Disabling F[bookmark: marker-1596464]ile and Malware Event Logging for Allowed Connections
 
     [bookmark: pgfId-1591420]License: Protection or Malware
 
     [bookmark: pgfId-1591429]When you allow traffic with an access control rule, you can use an associated file policy to inspect transmitted files, and block prohibited files and malware before it can reach its destination; see Tuning Intrusion Prevention Performance.
 
     [bookmark: pgfId-1637499]When the system detects a prohibited file, it automatically logs one of the following types of event to the ASA FirePOWER module: 
 
      
      	 [bookmark: pgfId-1637503] file events , which represent detected or blocked files, including malware files
 
      	 [bookmark: pgfId-1591447] malware events , which represent detected or blocked malware files only
 
      	 [bookmark: pgfId-1591448] retrospective malware events , which are generated when the malware disposition for a previously detected file changes
 
     
 
     [bookmark: pgfId-1591449]If you do not want to log file or malware events, you can disable this logging on a per-access-control-rule basis by clearing the Log Files check box on the Logging tab of the access control rule editor.
 
      
       
     
 
     
 
     [bookmark: pgfId-1591456]Note Cisco recommends you leave file and malware event logging enabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1637488]Regardless of whether you save file and malware events, when network traffic violates a file policy, the system automatically logs the end of the associated connection to the ASA FirePOWER module, regardless of the logging configuration of the invoking access control rule; see Connections Associated with File and Malware Events (Automatic).
 
    
 
     
      [bookmark: pgfId-1546076][bookmark: 67019]License Requirements for Conn[bookmark: marker-1569991]ection Logging
 
     [bookmark: pgfId-1570119]License: feature dependent
 
     [bookmark: pgfId-1637825]Because you configure connection logging in access control policies, you can log any connection that those policies can successfully handle.
 
     [bookmark: pgfId-1654726]Although you can create access control policies regardless of the licenses on your ASA FirePOWER module, certain aspects of access control require that you enable specific licensed capabilities before you can apply the policy.
 
      
       
        
        [bookmark: pgfId-1637853]Table 27-2 License Requirements for Connection Logging in Access Control Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1637857]To log connections... 
          
  
         	 
           
           [bookmark: pgfId-1637859]License 
          
  
        
 
         
         	[bookmark: pgfId-1637861]for traffic handled using, network, port, or literal URL criteria
  
         	[bookmark: pgfId-1637863]Any
  
        
 
         
         	[bookmark: pgfId-1637865]for traffic handled using geolocation data
  
         	[bookmark: pgfId-1637870]Any
  
        
 
         
         	[bookmark: pgfId-1637872]associated with:
 
           
           	 [bookmark: pgfId-1637873]IP addresses with a poor reputation (Security Intelligence filtering)
 
           	 [bookmark: pgfId-1637874]intrusions or prohibited files
 
          
  
         	[bookmark: pgfId-1637879]Protection
  
        
 
         
         	[bookmark: pgfId-1637881]associated with malware
  
         	[bookmark: pgfId-1637886]Malware
  
        
 
         
         	[bookmark: pgfId-1637888]for traffic handled by user control or application control
  
         	[bookmark: pgfId-1637893]Control
  
        
 
         
         	[bookmark: pgfId-1637895]for traffic that the system filters using URL category and reputation data, and to display URL category and URL reputation information for URLs requested by monitored hosts
  
         	[bookmark: pgfId-1637900]URL Filtering
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1530799][bookmark: 27595]Logging Sec[bookmark: marker-1556874]urity Intelligence (Blacklisting) Decisions
 
    [bookmark: pgfId-1556931]License: Protection
 
    [bookmark: pgfId-1570864]As a first line of defense against malicious Internet content, the ASA FirePOWER module includes the Security Intelligence feature, which allows you to immediately blacklist (block) connections based on the latest reputation intelligence, removing the need for a more resource-intensive, in-depth analysis. This traffic filtering takes place before any other policy-based inspection, analysis, or traffic handling. 
 
    [bookmark: pgfId-1617392]Optionally, and recommended in passive deployments, you can use a monitor-only setting for Security Intelligence filtering. This allows the system to further analyze connections that would have been blacklisted, but still log the match to the blacklist.
 
    [bookmark: pgfId-1617396]Enabling Security Intelligence logging logs all blocked and monitored connections handled by an access control policy. However, the system does not log whitelist matches; logging of whitelisted connections depends on their eventual disposition.
 
    [bookmark: pgfId-1612338]When the system logs a connection event as the result of Security Intelligence filtering, it also logs a matching Security Intelligence event, which is a special kind of connection event that you can view and analyze separately. Both types of events use the Action and Reason fields to reflect the blacklist match. Additionally, so that you can identify the blacklisted IP address in the connection, host icons next to blacklisted and monitored IP addresses look slightly different in the event viewer.
 
    [bookmark: pgfId-1610212]Logging Blocked Blacklisted Connections
 
    [bookmark: pgfId-1609557]For a blocked connection, the system logs beginning-of-connection Security Intelligence and connection events. Because blacklisted traffic is immediately denied without further inspection, there is no unique end of connection to log. For these events, the action is Block and the reason is IP Block.
 
    [bookmark: pgfId-1613064]IP Block connection events have a threshold of 15 seconds per unique initiator-responder pair. That is, once the system generates an event when it blocks a connection, it does not generate another connection event for additional blocked connections between those two hosts for the next 15 seconds, regardless of port or protocol.
 
    [bookmark: pgfId-1609464]Logging Monitored Blacklisted Connections
 
    [bookmark: pgfId-1637395]For connections monitored—rather than blocked—by Security Intelligence, the system logs end-of-connection Security Intelligence and connection events to the ASA FirePOWER module. This logging occurs regardless of how the connection is later handled by an access control rule or the access control default action.
 
    [bookmark: pgfId-1627248]For these connection events, the action depends on the connection’s eventual disposition. The Reason field contains IP Monitor, as well as any other reason why the connection may have been logged.
 
    [bookmark: pgfId-1615062]Note that the system may also generate beginning-of-connection events for monitored connections, depending on the logging settings in the access control rule or default action that later handles the connection.
 
    [bookmark: pgfId-1556980]To log blacklisted connections:
 
    
 
    [bookmark: pgfId-1573004]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1573005]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1573010]The access control policy editor appears.
 
    [bookmark: pgfId-1573011]Step 3 Select the Security Intelligence tab.
 
    [bookmark: pgfId-1573012]Security Intelligence settings for the access control policy appear.
 ). 
    
 
    [bookmark: pgfId-1573295]The Blacklist Options pop-up window appears.
 
    [bookmark: pgfId-1556990]Step 5 Select the Log Connections check box.
 
    [bookmark: pgfId-1638509]Step 6 Specify where to send connection and Security Intelligence events. You have the following choices:
 
     
      
      	 [bookmark: pgfId-1638516]To send events to the ASA FirePOWER module, select  Event Viewer .
 
      	 [bookmark: pgfId-1638517]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
     
 
     [image: ] ); see 
     Creating a Syslog Alert Response. 
    
 
     
      
      	 [bookmark: pgfId-1637333]To send connection events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
     
 
     [image: ] ); see 
     Creating an SNMP Alert Response. 
    
 
    [bookmark: pgfId-1637343]You must send events to the Event Viewer if you want to set blacklisted objects to monitor-only, or perform any other ASA FirePOWER module-based analysis on connection events generated by Security Intelligence filtering. For more information, see Logging Connections to the ASA FirePOWER Module or External Server.
 
    [bookmark: pgfId-1573167]Step 7 Click OK to set your logging options.
 
    [bookmark: pgfId-1557014]The Security Intelligence tab appears again.
 
    [bookmark: pgfId-1557015]Step 8 Click Store ASA FirePOWER Changes.
 
   
 
    
     [bookmark: pgfId-1533579][bookmark: 80249][bookmark: 14699]Logging Connections Based on Access Control Handling
 
    [bookmark: pgfId-1590887]License: Any
 
    [bookmark: pgfId-1590888]Within an access control policy, access control rules provide a granular method of handling network traffic. So that you can log only critical connections, you enable connection logging on a per-access-control-rule basis—if you enable connection logging for a rule, the system logs all connections handled by that rule.
 
    [bookmark: pgfId-1588561]You can also log connections for the traffic handled by the default action of your access control policy. The default action determines how the system handles traffic that matches none of the access control rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic).
 
    [bookmark: pgfId-1638732]Note that even if you disable logging for all access control rules and the default action, end-of-connection events may still be logged to the ASA FirePOWER module if the connection matches an access control rule and contains an intrusion attempt, prohibited file, or malware
 
    [bookmark: pgfId-1587839]Depending on the rule or default policy action and the associated inspection options that you configure, your logging options differ. For more information, see:
 
     
     	 [bookmark: pgfId-1579006]Logging Connections Matching an Access Control Rule
 
     	 [bookmark: pgfId-1579012]Logging Connections Handled by the Access Control Default Action
 
    
 
     
      [bookmark: pgfId-1587551][bookmark: 31190]Logging Connections Matching an Access Control Rule
 
     [bookmark: pgfId-1621507]License: Any
 
     [bookmark: pgfId-1587552]To log only critical connections, you enable connection logging on a per-access-control-rule basis. If you enable logging for a rule, the system logs all connections handled by that rule.
 
     [bookmark: pgfId-1636988]Depending on the rule action and intrusion and file inspection configuration of the rule, your logging options differ; see Understanding How Access Control Rule Actions Affect Logging. Also, note that even if you disable logging for an access control rule, end-of-connection events for connections matching that rule may still be logged to the ASA FirePOWER module if the connection: 
 
      
      	 [bookmark: pgfId-1655699]contains an intrusion attempt, prohibited file, or malware
 
      	 [bookmark: pgfId-1655701]previously matched at least one access control Monitor rule
 
     
 
     [bookmark: pgfId-1588424]To configure an access control rule to log connection, file, and malware information:
 
     
 
     [bookmark: pgfId-1640216]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1574146]The Access Control Policy page appears.
 ) next to the access control policy you want to modify. 
     
 
     [bookmark: pgfId-1574151]The access control policy editor appears, focused on the Rules tab.
 ) next to the rule where you want to configure logging. 
     
 
     [bookmark: pgfId-1574153]The access control rule editor appears.
 
     [bookmark: pgfId-1574154]Step 4 Select the Logging tab.
 
     [bookmark: pgfId-1574155]The Logging tab appears.
 
     [bookmark: pgfId-1574160]Step 5 Specify whether you want to Log at Beginning and End of Connection, Log at End of Connection, or you want No Logging at Connection.
 
     [bookmark: pgfId-1575666]Step 6 Use the Log Files check box to specify whether the system should log any file and malware events associated with the connection.
 
     [bookmark: pgfId-1582232]The system automatically enables this option when you associate a file policy with the rule to perform either file control or AMP. Cisco recommends you leave this option enabled; see Disabling File and Malware Event Logging for Allowed Connections. 
 
     [bookmark: pgfId-1638990]Step 7 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1638997]To send connection events to the ASA FirePOWER module, select  Event Viewer . You cannot disable this option for Monitor rules.
 
       	 [bookmark: pgfId-1638940]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1639028]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1654816]You must send events to the event viewer if you want to perform ASA FirePOWER module-based analysis on connection events. For more information, see Logging Connections to the ASA FirePOWER Module or External Server.
 
     [bookmark: pgfId-1654847]Step 8 Click Store ASA FirePOWER Changes to save the rule. 
 
     [bookmark: pgfId-1654824]Your rule is saved. You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1576614]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1576616][bookmark: 10479]Logging Conn[bookmark: marker-1576618]ections Handled by the Access Control Default Action
 
     [bookmark: pgfId-1576624]License: Any
 
     [bookmark: pgfId-1577766]You can log connections for the traffic handled by the default action of your access control policy. The default action determines how the system handles traffic that matches none of the access control rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic); see Setting Default Handling and Inspection for Network Traffic.
 
      
       
        
        [bookmark: pgfId-1578550]Table 27-3 Access Control Default Action Logging Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1578556]Default Action 
          
  
         	 
           
           [bookmark: pgfId-1578558]Compare To 
          
  
         	 
           
           [bookmark: pgfId-1578560]See... 
          
  
        
 
         
         	[bookmark: pgfId-1578562]Access Control: Block All Traffic
  
         	[bookmark: pgfId-1578564]Block rules
  
         	[bookmark: pgfId-1578568]Understanding Logging for Blocked and Interactively Blocked Connections
  
        
 
         
         	[bookmark: pgfId-1578571]Access Control: Trust All Traffic
  
         	[bookmark: pgfId-1578573]Trust rules
  
         	[bookmark: pgfId-1578577]Understanding Logging for Trusted Connections
  
        
 
         
         	[bookmark: pgfId-1578580]Intrusion Prevention
  
         	[bookmark: pgfId-1578582]Allow rules with associated intrusion policies
  
         	[bookmark: pgfId-1578586]Understanding Logging for Allowed Connections
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1577636]However, there are some differences between logging connections handled by access control rules versus the default action:
 
      
      	 [bookmark: pgfId-1576519]The default action has no file logging options. You cannot perform file control or AMP using the default action.
 
      	 [bookmark: pgfId-1576520]When an intrusion policy associated with the access control default action generates an intrusion event, the system does  not automatically log the end of the associated connection. This is useful for intrusion detection and prevention-only deployments, where you do not want to log any connection data. 
 
     
 
     [bookmark: pgfId-1576521]An exception to this rule occurs if you enable beginning- and end-of-connection logging for the default action. In that case, the system does log the end of the connection when an associated intrusion policy triggers, in addition to logging the beginning of the connection. 
 
     [bookmark: pgfId-1636866]Note that even if you disable logging for the default action, end-of-connection events for connections matching that rule may still be logged to the ASA FirePOWER module if the connection previously matched at least one access control Monitor rule.
 
     [bookmark: pgfId-1576538]To log connections in traffic handled by the access control default action:
 
     
 
     [bookmark: pgfId-1640237]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
     [bookmark: pgfId-1576364]The Access Control Policy page appears.
 ) next to the access control policy you want to modify. 
     
 
     [bookmark: pgfId-1576369]The access control policy editor appears, focused on the Rules tab.
 drop-down list. 
     
 
     [bookmark: pgfId-1576448]The Logging pop-up window appears.
 
     [bookmark: pgfId-1576449]Step 4 Specify whether you want to Log at Beginning and End of Connection, Log at End of Connection, or you want No Logging at Connection.
 
     [bookmark: pgfId-1579831]For a single non-blocked connection, the end-of-connection event contains all of the information in the beginning-of-connection event, as well as information gathered over the duration of the session. Because blocked traffic is immediately denied without further inspection, the system logs only beginning-of-connection events for the Block All Traffic default action. For this reason, when you set the default action to Access Control: Block All Traffic you are prompted Log at Beginning of Connection.
 
     [bookmark: pgfId-1636848]Step 5 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1636855]To send connection events to the ASA FirePOWER module, select  Event Viewer . You cannot disable this option for Monitor rules.
 
       	 [bookmark: pgfId-1577530]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1639177]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1639187]You must send events to the event viewer if you want to perform ASA FirePOWER module-based analysis on connection events. For more information, see Logging Connections to the ASA FirePOWER Module or External Server.
 
     [bookmark: pgfId-1579685]Step 6 Click Store ASA FirePOWER Changes to save the policy.
 
     [bookmark: pgfId-1579688]Your policy is saved. You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1530975]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1544536][bookmark: 26694]Logging URLs Detected in Connections
 
    [bookmark: pgfId-1636802]License: Any
 
    [bookmark: pgfId-1636806]When you log an end-of-connection event to the ASA FirePOWER module for HTTP traffic, the system records the URL requested by the monitored host during the session.
 
    [bookmark: pgfId-1544551]By default, the system stores the first 1024 characters of the URL in the connection log. However, you can configure the system to store up to 4096 characters per URL to make sure you capture the full URLs requested by monitored hosts. Or, if you are uninterested in the individual URLs visited, you can disable URL storage entirely by storing zero characters. Depending on your network traffic, disabling or limiting the number of stored URL characters may improve system performance.
 
    [bookmark: pgfId-1544552]Note that disabling URL logging does not affect URL filtering. Access control rules properly filter traffic based on requested URLs, their categories, and reputations, even though the system does not record the individual URLs requested in the traffic handled by those rules. For more information, see Blocking URLs.
 
    [bookmark: pgfId-1544553]To customize the number of URL characters you store:
 
    
 
    [bookmark: pgfId-1640262]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Access Control Policy.
 
    [bookmark: pgfId-1635379]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1635384]The access control policy editor appears.
 
    [bookmark: pgfId-1544565]Step 3 Select the Advanced tab. 
 
    [bookmark: pgfId-1544566]Advanced settings for the access control policy appear. 
 ) next to General Settings. 
    
 
    [bookmark: pgfId-1544571]The General Settings pop-up window appears.
 
    [bookmark: pgfId-1544572]Step 5 Type the Maximum URL characters to store in connection events.
 
    [bookmark: pgfId-1544573]You can specify any number from zero to 4096. Storing zero characters disables URL storage without disabling URL filtering.
 
    [bookmark: pgfId-1544574]Step 6 Click OK.
 
    [bookmark: pgfId-1544575]Advanced settings for the access control policy appear.
 
    [bookmark: pgfId-1580130]Step 7 Click Store ASA FirePOWER Changes to save the policy.
 
    [bookmark: pgfId-1580131]Your policy is saved. You must apply the access control policy for your changes to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-1580135]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1704668][bookmark: 62432]Logging Encrypted Connec[bookmark: marker-1704667]tions
 
    [bookmark: pgfId-1704672]License: Any
 
    [bookmark: pgfId-1704680]As part of access control, the SSL inspection feature allows you to use an SSL policy to decrypt encrypted traffic for further evaluation by access control rules. You can force the system to log these decrypted connections, regardless of how the system later handles or inspects the traffic. You can also log connections when you block encrypted traffic, or when you allow it to pass to access control rules without decryption. 
 
    [bookmark: pgfId-1704681]Connection logs for encrypted sessions contain details about the encryption, such as the certificate used to encrypt that session. You configure connection logging for encrypted sessions in the SSL policy on a per-SSL rule basis so that you only log critical connections. 
 
    [bookmark: pgfId-1704682]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1704686]Logging Decryptable Connections with SSL Rules
 
     	 [bookmark: pgfId-1704690]Setting Default Logging for Encrypted and Undecryptable Connections
 
    
 
     
      [bookmark: pgfId-1704694][bookmark: 88098][bookmark: 12006]Logging Decryptable [bookmark: marker-1704693]Connections with SSL Rules
 
     [bookmark: pgfId-1704698]License: Any
 
     [bookmark: pgfId-1705590]Within an SSL policy, SSL rules provide a granular method of handling encrypted traffic across multiple managed devices. So that you can log only critical connections, you enable connection logging on a per-SSL-rule basis—if you enable connection logging for a rule, the system logs all connections handled by that rule.
 
     [bookmark: pgfId-1705593]For encrypted connections inspected by an SSL policy, you can log connection events to an external syslog or SNMP trap server. You can log only end-of-connection events, however: 
 
      
      	 [bookmark: pgfId-1704711]for blocked connections (Block, Block with reset), the system immediately ends the session and generates an event
 
      	 [bookmark: pgfId-1704712]for monitored connections (Monitor) and connections that you pass to access control rules (Decrypt, Do not decrypt), the system generates an event when the session ends, regardless of the logging configuration of the access control rule or default action that later handles it
 
     
 
     [bookmark: pgfId-1704715]For more information, see Understanding How Access Control Rule Actions Affect Logging.
 
     [bookmark: pgfId-1704717]To log decryptable connections:
 
     
 
     [bookmark: pgfId-1704722]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
     [bookmark: pgfId-1704723]The SSL Policy page appears.
 ) next to the rule where you want to configure logging. 
     
 
     [bookmark: pgfId-1704733]The SSL rule editor appears.
 
     [bookmark: pgfId-1704734]Step 3 Select the Logging tab.
 
     [bookmark: pgfId-1704735]The Logging tab appears. 
 
     [bookmark: pgfId-1704736]Step 4 Select Log at End of Connection.
 
     [bookmark: pgfId-1704737]Step 5 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1704748]To send events to an external syslog, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1704755]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1704772]Step 6 Click Add to save your changes. 
 
     [bookmark: pgfId-1704773]You must apply the access control policy the SSL policy is associated with for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1704777]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1704781][bookmark: 38174]Setting Default Logging for Encrypted and Undecryptable [bookmark: marker-1704780]Connections
 
     [bookmark: pgfId-1704785]License: SSL
 
     [bookmark: pgfId-1704794]You can log connections for the traffic handled by the default action of your SSL policy. These logging settings also govern how the system logs undecryptable sessions.
 
     [bookmark: pgfId-1704795]The SSL policy default action determines how the system handles encrypted traffic that matches none of the SSL rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic). If your SSL policy does not contain any SSL rules, the default action determines how all encrypted sessions on your network are logged. For more information, see Setting Default Handling and Inspection for Encrypted Traffic. 
 
     [bookmark: pgfId-1704802]You can configure the SSL policy default action to log connection events to an external syslog or SNMP trap server. You can log only end-of-connection events, however: 
 
      
      	 [bookmark: pgfId-1704803]for blocked connections (Block, Block with reset), the system immediately ends the sessions and generates an event
 
      	 [bookmark: pgfId-1704804]for connections that you allow to pass unencrypted to access control rules (Do not decrypt), the system generates an event when the session ends
 
     
 
     [bookmark: pgfId-1704805]Note that even if you disable logging for the SSL policy default action, end-of-connection events may still be logged if the connection previously matched at least one SSL Monitor rule, or later matches an access control rule or the access control policy default action.
 
     [bookmark: pgfId-1704809]To set the default handling for encrypted and undecryptable traffic:
 
     [bookmark: pgfId-1704813]Access: Admin/Access Admin/Network Admin/Security Approver
 
     
 
     [bookmark: pgfId-1704814]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > SSL.
 
     [bookmark: pgfId-1704815]The SSL Policy page appears.
 drop-down list. 
     
 
     [bookmark: pgfId-1704825]The Logging pop-up window appears.
 
     [bookmark: pgfId-1704826]Step 3 Select Log at End of Connection to enable logging connection events.
 
     [bookmark: pgfId-1704827]Step 4 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1704835]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can configure a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1704842]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can configure an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1704859]Step 5 Click OK to save your changes.
 
     [bookmark: pgfId-1704860]You must apply the access control policy the SSL policy is associated with for your changes to take effect; see Deploying Configuration Changes.
 
     [bookmark: pgfId-1704864]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1530828]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 55324]Viewing Events 
      
      
 
     
 
 
    [bookmark: pgfId-1687173]You can view real-time events logged against the traffic inspected by the ASA FirePOWER module. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1688255]Note The module only caches the most recent 100 events in memory.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1688257]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1687360]Accessing ASA FirePOWER Real-Time Events
 
     	 [bookmark: pgfId-1687383]Understanding ASA FirePOWER Event Types
 
     	 [bookmark: pgfId-1687386]Event Fields in ASA FirePOWER Events
 
     	 [bookmark: pgfId-1687389]Intrusion Rule Classifications
 
    
 
   
 
    
     [bookmark: pgfId-1687430][bookmark: 98429]Accessing ASA FirePOWER Real-Time Events
 
    [bookmark: pgfId-1687434]You can view events detected by the ASA FirePOWER module in several predefined event views or create a custom event view to view the event fields you select.
 
     
      
    
 
    
 
    [bookmark: pgfId-1688337]Note The module only caches the most recent 100 events in memory.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1687438]To view ASA FirePOWER events:
 
    
 
    [bookmark: pgfId-1687479]Step 1 Select Monitoring > ASA FirePOWER Monitoring > Real-time Eventing.
 
    [bookmark: pgfId-1687480]Step 2 You have two choices: 
 
     
      
      	 [bookmark: pgfId-1687481]Click an existing tab for the type of event you want to view: connection events, security intelligence events, intrusion events, file events, or malware events. 
 
      	 [bookmark: pgfId-1687442]Click the + icon to create a custom event view and select the event fields you want to include in the view. 
 
     
 
    
 
    [bookmark: pgfId-1687506]For more information, see Understanding ASA FirePOWER Event Types and Event Fields in ASA FirePOWER Events.
 
    [bookmark: pgfId-1687443]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1687416][bookmark: 73456]Understanding ASA FirePOWER Event Types
 
    [bookmark: pgfId-1687108]The ASA FirePOWER module provides real-time event viewing of event fields from five event types: connection events, security intelligence events, intrusion events, file events, and malware events.
 
    [bookmark: pgfId-1680438]Connection Events
 
    [bookmark: pgfId-1680576]Connection logs, called connection events, contain data about the detected sessions. The information available for any individual connection event depends on several factors, but in general includes:
 
     
     	 [bookmark: pgfId-1680577]basic connection properties: timestamp, source and destination IP address, ingress and egress zones, the device that handled the connection, and so on
 
     	 [bookmark: pgfId-1680578]additional connection properties discovered or inferred by the system: applications, requested URLs, or users associated with the connection, and so on
 
     	 [bookmark: pgfId-1680579]metadata about why the connection was logged: which access control rule (or other configuration) in which policy handled the traffic, whether the connection was allowed or blocked, and so on
 
    
 
    [bookmark: pgfId-1680580]Various settings in access control give you granular control over which connections you log, when you log them, and where you store the data. You can log any connection that your access control policies can successfully handle. You can enable connection logging in the following situations:
 
     
     	 [bookmark: pgfId-1680581]when a connection is blacklisted (blocked) or monitored by the reputation-based Security Intelligence feature
 
     	 [bookmark: pgfId-1680583]when a connection is handled by an access control rule or the access control default action
 
    
 
    [bookmark: pgfId-1680584]In addition to the logging that you configure, the system automatically logs most connections where the system detects a prohibited file, malware, or intrusion attempt. 
 
    [bookmark: pgfId-1680637]Security Intelligence Events
 
    [bookmark: pgfId-1680669]When you enable Security Intelligence logging, blacklist matches automatically generate Security Intelligence events as well as connection events. A Security Intelligence event is a special kind of connection event that you can view and analyze separately. For detailed information on configuring connection logging, including Security Intelligence blacklisting decisions, see Logging Connections in Network Traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1680646]Tip General information about connection events also pertains to Security Intelligence events, unless otherwise noted. For more information on Security Intelligence, see Blacklisting Using Security Intelligence IP Address Reputation.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1680554]Intrusion Events
 
    [bookmark: pgfId-1687085]The system examines the packets that traverse your network for malicious activity that could affect the availability, integrity, and confidentiality of a host and its data. When the system identifies a possible intrusion, it generates an intrusion event, which is a record of the date, time, type of exploit, and contextual information about the source of the attack and its target. 
 
    [bookmark: pgfId-1680530]File Events
 
    [bookmark: pgfId-1683637]File events represent files that the system detected, and optionally blocked, in network traffic.
 
    [bookmark: pgfId-1683653]The system logs the file events generated when a managed device detects or blocks a file in network traffic, according to the rules in currently applied file policies. 
 
    [bookmark: pgfId-1680511]Malware Events
 
    [bookmark: pgfId-1683692]Malware events represent malware files detected, and optionally blocked, in network traffic by the system. 
 
    [bookmark: pgfId-1683792]With a Malware license, your ASA FirePOWER module can detect malware in network traffic as part of your overall access control configuration; see Understanding and Creating File Policies. 
 
    [bookmark: pgfId-1683796]The following scenarios can lead to generating malware events:
 
     
     	 [bookmark: pgfId-1683800]If a managed device detects one of a set of specific file types, the ASA FirePOWER module performs a malware cloud lookup, which returns a file disposition to the ASA FirePOWER module of  Malware ,  Clean , or  Unknown . 
 
     	 [bookmark: pgfId-1683807]If the ASA FirePOWER module cannot establish a connection with the cloud, or the cloud is otherwise unavailable, the file disposition is  Unavailable . You may see a small percentage of events with this disposition; this is expected behavior.
 
     	 [bookmark: pgfId-1683819]If the managed device detects a file on the clean list, the ASA FirePOWER module assigns a file disposition of  Clean to the file. 
 
    
 
    [bookmark: pgfId-1683823]The ASA FirePOWER module logs records of files’ detection and dispositions, along with other contextual data, as malware events.
 
    [bookmark: pgfId-1683785]Files detected in network traffic and identified [bookmark: marker-1683719]as malware by the ASA FirePOWER module generate both a file event and a malware event. This is because to detect malware in a file, the system must first detect the file itself. 
 
   
 
    
     [bookmark: pgfId-1682315][bookmark: 31546]Event Fields in ASA FirePOWER Events
 
    [bookmark: pgfId-1680753]Action
 
    [bookmark: pgfId-1681211]For connection or security intelligence events, the action associated with the access control rule or default action that logged the connection:
 
    [bookmark: pgfId-1681212] – Allow represents explicitly allowed and user-bypassed interactively blocked connections.
 
    [bookmark: pgfId-1681213] – Trust represents trusted connections. TCP connections detected by a trust rule on the first packet only generate an end-of-connection event. The system generates the event one hour after the final session packet.
 
    [bookmark: pgfId-1681225] – Block and Block with reset represent blocked connections. The system also associates the Block action with connections blacklisted by Securit[bookmark: marker-1681226]y Intelligence, connections where an exploit was detected by an intrusion policy, and connections where a file was blocked by a file policy.
 
    [bookmark: pgfId-1681227] – Interactive Block and Interactive Block with reset mark the beginning-of-connection event that you can log when the system initially blocks a user’s HTTP request using an Interactive Block rule. If the user clicks through the warning page that the system displays, any additional connection events you log for the session have an action of Allow.
 
    [bookmark: pgfId-1681228] – Default Action indicates the connection was handled by the default action.
 
    [bookmark: pgfId-1681229] – For Security Intelligence-monitored connections, the action is that of the first non-Monitor access control rule triggered by the connection, or the default action. Similarly, because traffic matching a Monitor rule is always handled by a subsequent rule or by the default action, the action associated with a connection logged due to a monitor rule is never Monitor.
 
    [bookmark: pgfId-1684831]For file or malware events, the file rule action associated with the rule action for the rule the file matched, and any associated file rule action options.
 
    [bookmark: pgfId-1680754]Allowed Connection
 
    [bookmark: pgfId-1680904]Whether the system allowed the traffic flow for the event. 
 
    [bookmark: pgfId-1680755]Application
 
    [bookmark: pgfId-1680987]The application detected in the connection.
 
    [bookmark: pgfId-1680756]Application Business Relevance
 
    [bookmark: pgfId-1681418]The business relevance associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those. 
 
    [bookmark: pgfId-1681422]Application Categories
 
    [bookmark: pgfId-1682794]Categories that characterize the application to help you understand the application's function. 
 
    [bookmark: pgfId-1680997]Application Risk
 
    [bookmark: pgfId-1681298]The risk associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated risk; this field displays the highest of those. 
 
    [bookmark: pgfId-1680998]Application Tag
 
    [bookmark: pgfId-1682830]Tags that characterize the application to help you understand the application's function. 
 
    [bookmark: pgfId-1680999]Block Type
 
    [bookmark: pgfId-1685316]The type of block specified in the access control rule matching the traffic flow in the event: block or interactive block. 
 
    [bookmark: pgfId-1680761]Client
 
    [bookmark: pgfId-1683059]The client application detected in the connection.
 
    [bookmark: pgfId-1683060]If the system cannot identify the specific client used in the connection, this field displays client appended to the application protocol name to provide a generic name, for example, FTP client.
 
    [bookmark: pgfId-1681442]Client Business Relevance
 
    [bookmark: pgfId-1681450]The business relevance associated with the client traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of client detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those. 
 
    [bookmark: pgfId-1681444]Client Categories
 
    [bookmark: pgfId-1682850]Categories that characterize the client detected in the traffic to help you understand the client’s function. 
 
    [bookmark: pgfId-1680764]Client Risk
 
    [bookmark: pgfId-1681507]The risk associated with the client traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of client detected in the connection has an associated risk; this field displays the highest of those. 
 
    [bookmark: pgfId-1680765]Client Tag
 
    [bookmark: pgfId-1683039]Tags that characterize the client detected in the traffic to help you understand the client’s function. 
 
    [bookmark: pgfId-1680766]Client Version
 
    [bookmark: pgfId-1683081]The version of the client detected in the connection.
 
    [bookmark: pgfId-1680767]Connection
 
    [bookmark: pgfId-1681031]The unique ID for the traffic flow, internally generated. 
 
    [bookmark: pgfId-1680768]Connection Blocktype Indicator
 
    [bookmark: pgfId-1685287]The type of block specified in the access control rule matching the traffic flow in the event: block or interactive block. 
 
    [bookmark: pgfId-1685845]Connection Bytes
 
    [bookmark: pgfId-1685846]The total bytes for the connection. 
 
    [bookmark: pgfId-1685847]Connection Time
 
    [bookmark: pgfId-1685945]The time for the beginning of the connection.
 
    [bookmark: pgfId-1685946]Connection Timestamp
 
    [bookmark: pgfId-1685953]The time the connection was detected.
 
    [bookmark: pgfId-1680772]Context
 
    [bookmark: pgfId-1684254]The metadata identifying the security context through which the traffic passed. Note that the system only populates this field for devices in multiple context mode.
 
    [bookmark: pgfId-1680773]Denied Connection
 
    [bookmark: pgfId-1683577]Whether the system denied the traffic flow for the event. 
 
    [bookmark: pgfId-1680774]Destination Country and Continent
 
    [bookmark: pgfId-1685799]The country and continent of the receiving host.
 
    [bookmark: pgfId-1680775]Destination IP
 
    [bookmark: pgfId-1685827]The IP address used by the receiving host.
 
    [bookmark: pgfId-1680776]Destination Port, Destination Port Icode, Destination Port/ICMP Code
 
    [bookmark: pgfId-1684308]The destination port or ICMP code used by the session responder.
 
    [bookmark: pgfId-1680779]Direction
 
    [bookmark: pgfId-1681067]The direction of transmission for a file. 
 
    [bookmark: pgfId-1680780]Disposition
 
    [bookmark: pgfId-1686064]One of the following file dispositions:
 
    [bookmark: pgfId-1686065] – Malware indicates that the cloud categorized the file as malware.
 
    [bookmark: pgfId-1686066] – Clean indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
    [bookmark: pgfId-1686067] – Unknown indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The file is uncategorized.
 
    [bookmark: pgfId-1686068] – Custom Detection indicates that a user added the file to the custom detection list.
 
    [bookmark: pgfId-1686072] – Unavailable indicates that the ASA FirePOWER module could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
    [bookmark: pgfId-1681070] – N/A indicates a Detect Files or Block Files rule handled the file and the ASA FirePOWER module did not perform a malware cloud lookup.
 
    [bookmark: pgfId-1680781]Egress Interface
 
    [bookmark: pgfId-1683193]The egress interface associated with the connection. Note that, if your deployment includes an asynchronous routing configuration, the ingress and egress interface may belong to the same interface set.
 
    [bookmark: pgfId-1680782]Egress Security Zone
 
    [bookmark: pgfId-1683211]The egress security zone associated with the connection.
 
    [bookmark: pgfId-1680783]Event
 
    [bookmark: pgfId-1687033]The event type. 
 
    [bookmark: pgfId-1680784]Event Microseconds
 
    [bookmark: pgfId-1681082]The time, in microseconds, when the event was detected. 
 
    [bookmark: pgfId-1680785]Event Seconds
 
    [bookmark: pgfId-1687015]The time, in seconds, when the event was detected. 
 
    [bookmark: pgfId-1680786]Event Type
 
    [bookmark: pgfId-1681088]The type of event. 
 
    [bookmark: pgfId-1680787]File Category
 
    [bookmark: pgfId-1681091]The general categories of file type, for example: Office Documents, Archive, Multimedia, Executables, PDF files, Encoded, Graphics, or System Files.
 
    [bookmark: pgfId-1680788]File Event Timestamp
 
    [bookmark: pgfId-1681094]The time and date the file or malware file was created.
 
    [bookmark: pgfId-1680789]File Name
 
    [bookmark: pgfId-1681097]The name of the file or malware file.
 
    [bookmark: pgfId-1680790]File SHA256
 
    [bookmark: pgfId-1681100]The SHA-256 hash value of the file.
 
    [bookmark: pgfId-1680791]File Size
 
    [bookmark: pgfId-1681103]The size of the file or malware file, in kilobytes.
 
    [bookmark: pgfId-1680792]File Type
 
    [bookmark: pgfId-1681106]The file type of the file or malware file, for example, HTML or MSEXE.
 
    [bookmark: pgfId-1680793]File/Malware Policy
 
    [bookmark: pgfId-1684588]The file policy associated with the generation of the event.
 
    [bookmark: pgfId-1680794]Filelog Blocktype Indicator
 
    [bookmark: pgfId-1685215]The type of block specified in the file rule matching the traffic flow in the event: block or interactive block. 
 
    [bookmark: pgfId-1680795]Firewall Policy Rules/SI Category
 
    [bookmark: pgfId-1685196]The name of the blacklisted object that represents or contains the blacklisted IP address in the connection. The Security Intelligence category can be the name of a network object or group, the global blacklist, a custom Security Intelligence list or feed, or one of the categories in the Intelligence Feed. Note that this field is only populated if the Reason is IP Block or IP Monitor; entries in Security Intelligence event views always display a reason. 
 
    [bookmark: pgfId-1681271]Firewall Rule
 
    [bookmark: pgfId-1681279]The access control rule or default action that handled the connection, as well as up to eight Monitor rules matched by that connection.
 
    [bookmark: pgfId-1683117]First Packet
 
    [bookmark: pgfId-1683124]The date and time the first packet of the session was seen.
 
    [bookmark: pgfId-1680798]HTTP Referrer
 
    [bookmark: pgfId-1683156]The HTTP referrer, which represents the referrer of a requested URL for HTTP traffic detected in the connection (such as a website that provided a link to, or imported a link from, another URL).
 
    [bookmark: pgfId-1680799]IDS Classification
 
    [bookmark: pgfId-1686124]The classification where the rule that generated the event belongs. See the Rule Classifications table for a list of rule classification names and numbers.
 
    [bookmark: pgfId-1680800]Impact
 
    [bookmark: pgfId-1685553]The impact level in this field indicates the correlation between intrusion data, network discovery data, and vulnerability information. 
 
    [bookmark: pgfId-1680801]Impact Flag
 
    [bookmark: pgfId-1681133]See Impact. 
 
    [bookmark: pgfId-1683174]Ingress Interface
 
    [bookmark: pgfId-1683175]The ingress interface associated with the connection. Note that, if your deployment includes an asynchronous routing configuration, the ingress and egress interface may belong to the same interface set.
 
    [bookmark: pgfId-1683232]Ingress Security Zone
 
    [bookmark: pgfId-1683263]The ingress security zone associated with the connection.
 
    [bookmark: pgfId-1683972]Initiator Bytes
 
    [bookmark: pgfId-1684001]The total number of bytes transmitted by the session initiator.
 
    [bookmark: pgfId-1680804]Initiator Country and Continent
 
    [bookmark: pgfId-1681142]When a routable IP is detected, the country and continent associated with the host IP address that initiated the session. 
 
    [bookmark: pgfId-1684168]Initiator IP
 
    [bookmark: pgfId-1684169]The host IP address (and host name, if DNS resolution is enabled) that initiated the session responder. 
 
    [bookmark: pgfId-1680805]Initiator Packets
 
    [bookmark: pgfId-1684128]The total number of packets transmitted by the session initiator.
 
    [bookmark: pgfId-1680806]Inline Result 
 
    [bookmark: pgfId-1685574]One of the following:
 
    [bookmark: pgfId-1685575] – a black down arrow, indicating that the system dropped the packet that triggered the rule
 
    [bookmark: pgfId-1685576] – a gray down arrow, indicating that IPS would have dropped the packet if you enabled the Drop when Inline intrusion policy option (in an inline deployment), or if a Drop and Generate rule generated the event while the system was pruning
 
    [bookmark: pgfId-1685577] – blank, indicating that the triggered rule was not set to Drop and Generate Events
 
    [bookmark: pgfId-1685578] – Note that the system does not drop packets in a passive deployment, including when an inline interface is in tap mode, regardless of the rule state or the inline drop behavior of the intrusion policy.
 
    [bookmark: pgfId-1684187]IPS Blocktype Indicator
 
    [bookmark: pgfId-1685455]The action of the intrusion rule matching the traffic flow in the event. 
 
    [bookmark: pgfId-1680807]Last Packet
 
    [bookmark: pgfId-1683140]The date and time the last packet of the session was seen.
 
    [bookmark: pgfId-1680808]MPLS Label
 
    [bookmark: pgfId-1686574]The Multiprotocol Label Switching label associated with the packet that triggered this intrusion event.
 
    [bookmark: pgfId-1680809]Malware Blocktype Indicator
 
    [bookmark: pgfId-1685506]The type of block specified in the file rule matching the traffic flow in the event: block or interactive block. 
 
    [bookmark: pgfId-1680810]Message
 
    [bookmark: pgfId-1686104]The explanatory text for the event. 
 
    [bookmark: pgfId-1686117]For rule-based intrusion events, the event message is pulled from the rule. For decoder- and preprocessor-based events, the event message is hard coded.
 
    [bookmark: pgfId-1686100]For malware events, any additional information associated with the malware event. For network-based malware events, this field is populated only for files whose disposition has changed.
 
    [bookmark: pgfId-1680811]Monitor Rules
 
    [bookmark: pgfId-1686924]Up to eight Monitor rules matched by that connection.
 
    [bookmark: pgfId-1680812]Netbios Domain
 
    [bookmark: pgfId-1684148]The NetBIOS domain used in the session.
 
    [bookmark: pgfId-1680814]Policy
 
    [bookmark: pgfId-1684516]The access control, intrusion, or network analysis policy (NAP), if any, associated with the generation of the event.
 
    [bookmark: pgfId-1680815]Policy Revision
 
    [bookmark: pgfId-1686877]The revision of the access control, file, intrusion, or network analysis policy (NAP), if any, associated with the generation of the event.
 
    [bookmark: pgfId-1680816]Priority
 
    [bookmark: pgfId-1686910]The event priority as determined by the Cisco VRT.
 
    [bookmark: pgfId-1680817]Protocol
 
    [bookmark: pgfId-1681183]The protocol detected in the connection.
 
    [bookmark: pgfId-1680818]Reason
 
    [bookmark: pgfId-1684205]The reason or reasons the connection was logged, in the following situations:
 
    [bookmark: pgfId-1684206] – User Bypass indicates that the system initially blocked a user’s HTTP request, but the user chose to continue to the originally requested site by clicking through a warning page. A reason of User Bypass is always paired with an action of Allow.
 
    [bookmark: pgfId-1684207] – IP Block indicates that the system denied the connection without inspection, based on Security Intelligence data. A reason of IP Block is always paired with an action of Block.
 
    [bookmark: pgfId-1684208] – IP Monitor indicates that the system would have denied the connection based on Security Intelligence data, but you configured the system to monitor, rather than deny, the connection.
 
    [bookmark: pgfId-1684209] – File Monitor indicates that the system detected a particular type of file in the connection.
 
    [bookmark: pgfId-1684210] – File Block indicates the connection contained a file or malware file that the system prevented from being transmitted. A reason of File Block is always paired with an action of Block.
 
    [bookmark: pgfId-1684211] – File Custom Detection indicates the connection contained a file on the custom detection list that the system prevented from being transmitted. 
 
    [bookmark: pgfId-1684212] – File Resume Allow indicates that file transmission was originally blocked by a Block Files or Block Malware file rule. After a new access control policy was applied that allowed the file, the HTTP session automatically resumed. Note that this reason only appears in inline deployments.
 
    [bookmark: pgfId-1684213] – File Resume Block indicates that file transmission was originally allowed by a Detect Files or Malware Cloud Lookup file rule. After a new access control policy was applied that blocked the file, the HTTP session automatically stopped. Note that this reason only appears in inline deployments.
 
    [bookmark: pgfId-1684215] – Intrusion Block indicates the system blocked or would have blocked an exploit (intrusion policy violation) detected in the connection. A reason of Intrusion Block is paired with an action of Block for blocked exploits and Allow for would-have-blocked exploits.
 
    [bookmark: pgfId-1684216] – Intrusion Monitor indicates the system detected, but did not block, an exploit detected in the connection. This occurs when the state of the triggered intrusion rule is set to Generate Events.
 
    [bookmark: pgfId-1680819]Receive Times
 
    [bookmark: pgfId-1681189]The time the destination host or responder responded to the event.
 
    [bookmark: pgfId-1680820]Referenced Host
 
    [bookmark: pgfId-1684236]If the protocol in the connection is DNS, HTTP, or HTTPS, this field displays the host name that the respective protocol was using.
 
    [bookmark: pgfId-1680821]Responder Bytes
 
    [bookmark: pgfId-1684024]The total number of bytes transmitted by the session responder.
 
    [bookmark: pgfId-1680822]Responder Country and Continent
 
    [bookmark: pgfId-1684080]When a routable IP is detected, the country and continent associated with the host IP address for the session responder. 
 
    [bookmark: pgfId-1680823]Responder Packets
 
    [bookmark: pgfId-1684108]The total number of packets transmitted by the session responder.
 
    [bookmark: pgfId-1680824]Responder IP
 
    [bookmark: pgfId-1683319]The host IP address (and host name, if DNS resolution is enabled) that responded to the session initiator. 
 
    [bookmark: pgfId-1685387]Signature
 
    [bookmark: pgfId-1685388]The signature ID of the intrusion rule matching the traffic for the event.
 
    [bookmark: pgfId-1685389]Source Country and Continent
 
    [bookmark: pgfId-1685680]The country and continent of the sending host.
 
    [bookmark: pgfId-1685391]Source IP
 
    [bookmark: pgfId-1685641]The IP address used by the sending host in an intrusion event.
 
    [bookmark: pgfId-1685393]Source or Destination
 
    [bookmark: pgfId-1685394]The host originating or receiving the connection for the event.
 
    [bookmark: pgfId-1685395]Source Port, Source Port Type, Source Port/ICMP Type
 
    [bookmark: pgfId-1684274]The source port or ICMP type used by the session initiator.
 
    [bookmark: pgfId-1680846]TCP Flags
 
    [bookmark: pgfId-1685535]The TCP flags detected in the connection.
 
    [bookmark: pgfId-1680847]URL
 
    [bookmark: pgfId-1684348]The URL requested by the monitored host during the session. 
 
    [bookmark: pgfId-1680848]URL Category
 
    [bookmark: pgfId-1684366]The category associated with the URL requested by the monitored host during the session, if available. 
 
    [bookmark: pgfId-1680849]URL Reputation
 
    [bookmark: pgfId-1684442]The reputation associated with the URL requested by the monitored host during the session, if available. 
 
    [bookmark: pgfId-1680850]URL Reputation Score
 
    [bookmark: pgfId-1684466]The reputation score associated with the URL requested by the monitored host during the session, if available. 
 
    [bookmark: pgfId-1680851]User
 
    [bookmark: pgfId-1681912]The user of the host (Receiving IP) where the event occurred.
 
    [bookmark: pgfId-1680852]User Agent
 
    [bookmark: pgfId-1684498]User agent application information extracted from HTTP traffic detected in the connection.
 
    [bookmark: pgfId-1680853]VLAN
 
    [bookmark: pgfId-1686595]The innermost VLAN ID associated with the packet that triggered the event.
 
    [bookmark: pgfId-1680854]Web App Business Relevance
 
    [bookmark: pgfId-1681467]The business relevance associated with the web application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of web application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those. 
 
    [bookmark: pgfId-1680855]Web App Categories
 
    [bookmark: pgfId-1682882]Categories that characterize the web application detected in the traffic to help you understand the web application's function. 
 
    [bookmark: pgfId-1680856]Web App Risk
 
    [bookmark: pgfId-1681540]The risk associated with the web application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of web application detected in the connection has an associated risk; this field displays the highest of those. 
 
    [bookmark: pgfId-1680857]Web App Tag
 
    [bookmark: pgfId-1682932]Tags that characterize the web application detected in the traffic to help you understand the web application's function. 
 
    [bookmark: pgfId-1680749]Web Application 
 
    [bookmark: pgfId-1682956]The web application detected in the traffic. 
 
   
 
    
     [bookmark: pgfId-1686137][bookmark: 22247]Intrusion Rule Classifications
 
    [bookmark: pgfId-1686448]Intrusion rules include an attack classification. The following table lists the name and number for each classification
 
    [bookmark: pgfId-1686389][bookmark: 71706]
 
     
      
       
       [bookmark: pgfId-1686149]Table 28-1 [bookmark: 28264]Rule Classifications 
 
       
       
        
        	 
          
          [bookmark: pgfId-1686155]Number 
         
  
        	 
          
          [bookmark: pgfId-1686157]Classification Name 
         
  
        	 
          
          [bookmark: pgfId-1686159]Description 
         
  
       
 
        
        	[bookmark: pgfId-1686161]1
  
        	[bookmark: pgfId-1686163]not-suspicious
  
        	[bookmark: pgfId-1686165]Not Suspicious Traffic
  
       
 
        
        	[bookmark: pgfId-1686167]2
  
        	[bookmark: pgfId-1686169]unknown
  
        	[bookmark: pgfId-1686171]Unknown Traffic
  
       
 
        
        	[bookmark: pgfId-1686173]3
  
        	[bookmark: pgfId-1686175]bad-unknown
  
        	[bookmark: pgfId-1686177]Potentially Bad Traffic
  
       
 
        
        	[bookmark: pgfId-1686179]4
  
        	[bookmark: pgfId-1686181]attempted-recon
  
        	[bookmark: pgfId-1686183]Attempted Information Leak
  
       
 
        
        	[bookmark: pgfId-1686185]5
  
        	[bookmark: pgfId-1686187]successful-recon-limited
  
        	[bookmark: pgfId-1686189]Information Leak
  
       
 
        
        	[bookmark: pgfId-1686191]6
  
        	[bookmark: pgfId-1686193]successful-recon-largescale
  
        	[bookmark: pgfId-1686195]Large Scale Information Leak
  
       
 
        
        	[bookmark: pgfId-1686197]7
  
        	[bookmark: pgfId-1686199]attempted-dos
  
        	[bookmark: pgfId-1686201]Attempted Denial of Service
  
       
 
        
        	[bookmark: pgfId-1686203]8
  
        	[bookmark: pgfId-1686205]successful-dos
  
        	[bookmark: pgfId-1686207]Denial of Service
  
       
 
        
        	[bookmark: pgfId-1686209]9
  
        	[bookmark: pgfId-1686211]attempted-user
  
        	[bookmark: pgfId-1686213]Attempted User Privilege Gain
  
       
 
        
        	[bookmark: pgfId-1686215]10
  
        	[bookmark: pgfId-1686217]unsuccessful-user
  
        	[bookmark: pgfId-1686219]Unsuccessful User Privilege Gain
  
       
 
        
        	[bookmark: pgfId-1686221]11
  
        	[bookmark: pgfId-1686223]successful-user
  
        	[bookmark: pgfId-1686225]Successful User Privilege Gain
  
       
 
        
        	[bookmark: pgfId-1686227]12
  
        	[bookmark: pgfId-1686229]attempted-admin
  
        	[bookmark: pgfId-1686231]Attempted Administrator Privilege Gain
  
       
 
        
        	[bookmark: pgfId-1686233]13
  
        	[bookmark: pgfId-1686235]successful-admin
  
        	[bookmark: pgfId-1686237]Successful Administrator Privilege Gain
  
       
 
        
        	[bookmark: pgfId-1686239]14
  
        	[bookmark: pgfId-1686241]rpc-portmap-decode
  
        	[bookmark: pgfId-1686243]Decode of an RPC Query
  
       
 
        
        	[bookmark: pgfId-1686245]15
  
        	[bookmark: pgfId-1686247]shellcode-detect
  
        	[bookmark: pgfId-1686249]Executable Code was Detected
  
       
 
        
        	[bookmark: pgfId-1686251]16
  
        	[bookmark: pgfId-1686253]string-detect
  
        	[bookmark: pgfId-1686255]A Suspicious String was Detected
  
       
 
        
        	[bookmark: pgfId-1686257]17
  
        	[bookmark: pgfId-1686259]suspicious-filename-detect
  
        	[bookmark: pgfId-1686261]A Suspicious Filename was Detected
  
       
 
        
        	[bookmark: pgfId-1686263]18
  
        	[bookmark: pgfId-1686265]suspicious-login
  
        	[bookmark: pgfId-1686267]An Attempted Login Using a Suspicious Username was Detected
  
       
 
        
        	[bookmark: pgfId-1686269]19
  
        	[bookmark: pgfId-1686271]system-call-detect
  
        	[bookmark: pgfId-1686273]A System Call was Detected
  
       
 
        
        	[bookmark: pgfId-1686275]20
  
        	[bookmark: pgfId-1686277]tcp-connection
  
        	[bookmark: pgfId-1686279]A TCP Connection was Detected
  
       
 
        
        	[bookmark: pgfId-1686281]21
  
        	[bookmark: pgfId-1686283]trojan-activity
  
        	[bookmark: pgfId-1686285]A Network Trojan was Detected
  
       
 
        
        	[bookmark: pgfId-1686287]22
  
        	[bookmark: pgfId-1686289]unusual-client-port-connection
  
        	[bookmark: pgfId-1686291]A Client was Using an Unusual Port
  
       
 
        
        	[bookmark: pgfId-1686293]23
  
        	[bookmark: pgfId-1686295]network-scan
  
        	[bookmark: pgfId-1686297]Detection of a Network Scan
  
       
 
        
        	[bookmark: pgfId-1686299]24
  
        	[bookmark: pgfId-1686301]denial-of-service
  
        	[bookmark: pgfId-1686303]Detection of a Denial of Service Attack
  
       
 
        
        	[bookmark: pgfId-1686305]25
  
        	[bookmark: pgfId-1686307]non-standard-protocol
  
        	[bookmark: pgfId-1686309]Detection of a Non-Standard Protocol or Event
  
       
 
        
        	[bookmark: pgfId-1686311]26
  
        	[bookmark: pgfId-1686313]protocol-command-decode
  
        	[bookmark: pgfId-1686315]Generic Protocol Command Decode
  
       
 
        
        	[bookmark: pgfId-1686317]27
  
        	[bookmark: pgfId-1686319]web-application-activity
  
        	[bookmark: pgfId-1686321]Access to a Potentially Vulnerable Web Application
  
       
 
        
        	[bookmark: pgfId-1686323]28
  
        	[bookmark: pgfId-1686325]web-application-attack
  
        	[bookmark: pgfId-1686327]Web Application Attack
  
       
 
        
        	[bookmark: pgfId-1686329]29
  
        	[bookmark: pgfId-1686331]misc-activity
  
        	[bookmark: pgfId-1686333]Misc Activity
  
       
 
        
        	[bookmark: pgfId-1686335]30
  
        	[bookmark: pgfId-1686337]misc-attack
  
        	[bookmark: pgfId-1686339]Misc Attack
  
       
 
        
        	[bookmark: pgfId-1686341]31
  
        	[bookmark: pgfId-1686343]icmp-event
  
        	[bookmark: pgfId-1686345]Generic ICMP Event
  
       
 
        
        	[bookmark: pgfId-1686347]32
  
        	[bookmark: pgfId-1686349]inappropriate-content
  
        	[bookmark: pgfId-1686351]Inappropriate Content was Detected
  
       
 
        
        	[bookmark: pgfId-1686353]33
  
        	[bookmark: pgfId-1686355]policy-violation
  
        	[bookmark: pgfId-1686357]Potential Corporate Privacy Violation
  
       
 
        
        	[bookmark: pgfId-1686359]34
  
        	[bookmark: pgfId-1686361]default-login-attempt
  
        	[bookmark: pgfId-1686363]Attempt to Login By a Default Username and Password
  
       
 
        
        	[bookmark: pgfId-1686365]35
  
        	[bookmark: pgfId-1686367]sdf
  
        	[bookmark: pgfId-1686369]Sensitive Data
  
       
 
        
        	[bookmark: pgfId-1686371]36
  
        	[bookmark: pgfId-1686373]malware-cnc
  
        	[bookmark: pgfId-1686375]Known malware command and control traffic
  
       
 
        
        	[bookmark: pgfId-1686377]37
  
        	[bookmark: pgfId-1686379]client-side-exploit
  
        	[bookmark: pgfId-1686381]Known client side exploit attempt
  
       
 
        
        	[bookmark: pgfId-1686383]38
  
        	[bookmark: pgfId-1686385]file-format
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-2044947][bookmark: 42062]Configur[bookmark: marker-2044945]ing External Alerting 
      
      
 
     
 
 
    [bookmark: pgfId-2044951]While the ASA FirePOWER module provides various views of events within the module interface, you may want to configure external event notification to facilitate constant monitoring of critical systems. You can configure the module to generate alerts that notify you via SNMP trap, or syslog when one of the following is generated:
 
     
     	 [bookmark: pgfId-2042533]a network-based malware event or retrospective malware event
 
     	 [bookmark: pgfId-2027465]a connection event, triggered by a specific access control rule
 
    
 
    [bookmark: pgfId-2044468]To have the ASA FirePOWER module send these alerts, you must first create an alert response, which is a set of configurations that allows the module to interact with the external system where you plan to send the alert. Those configurations may specify, for example, SNMP alerting parameters or syslog facilities and priorities.
 
    [bookmark: pgfId-2071563]After you create the alert response, you associate it with the event that you want to use to trigger the alert. Note that the process for associating alert responses with events is different depending on the type of event:
 
     
     	 [bookmark: pgfId-2071564]You associate alert responses with malware events using their own configuration pages.
 
     	 [bookmark: pgfId-2026886]You associate SNMP and syslog alert responses with logged connections using access control rules and policies.
 
    
 
    [bookmark: pgfId-2044696]There is another type of alerting you can perform in the ASA FirePOWER module, which is to configure SNMP and syslog intrusion event notifications for individual intrusion events. You configure these notifications in intrusion policies; see Configuring External Alerting for Intrusion Rules and Adding SNMP Alerts. The following table explains the licenses you must have to generate alerts.
 
     
      [bookmark: pgfId-2021242]
 
      
       
        
        [bookmark: pgfId-2021216]Table 29-1 License Requirements for Generating Alerts 
 
        
        
         
         	 
           
           [bookmark: pgfId-2021220]To generate an alert based on... 
          
  
         	 
           
           [bookmark: pgfId-2021222]You need this license... 
          
  
        
 
         
         	[bookmark: pgfId-2026489]an intrusion event
  
         	[bookmark: pgfId-2026497]Protection
  
        
 
         
         	[bookmark: pgfId-2042781]a network-based malware event
  
         	[bookmark: pgfId-2042783]Malware
  
        
 
         
         	[bookmark: pgfId-2021239]a connection event
  
         	[bookmark: pgfId-2021241]the license required to log the connection
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2018625]For more information, see:
 
      
      	 [bookmark: pgfId-2019160]Working with Alert Responses
 
      	 [bookmark: pgfId-2027641]Logging Connections in Network Traffic
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2027735][bookmark: 64563]Working with Alert Responses
 
    [bookmark: pgfId-2020496]License: Any
 
    [bookmark: pgfId-2021012]The first step in configuring external alerting is to create an alert response, which is a set of configurations that allows the ASA FirePOWER module to interact with the external system where you plan to send the alert. You can create alert responses to send alerts via a simple network management protocol (SNMP) trap or a system log (syslog).
 
    [bookmark: pgfId-2028468]The information you receive in an alert depends on the type of event that triggered the alert. 
 
    [bookmark: pgfId-2072170]When you create an alert response, it is automatically enabled. Only enabled alert responses can generate alerts. To stop alerts from being generated, you can temporarily disable alert responses rather than deleting your configurations.
 
    [bookmark: pgfId-2072171]You manage alert responses on the Alerts page (ASA FirePOWER Configuration > Policies > Actions Alerts). The slider next to each alert response indicates whether it is active; only enabled alert responses can generate alerts. The page also indicates whether the alert response is being used in a configuration, for example, to log connections in an access control rule. You can sort alert responses by name, type, in use status, and enabled/disabled status by clicking the appropriate column header; click the column header again to reverse the sort.
 
    [bookmark: pgfId-2032638]For more information, see:
 
     
     	 [bookmark: pgfId-2028124]Creating an SNMP Alert Response
 
     	 [bookmark: pgfId-2062303]Creating a Syslog Alert Response
 
     	 [bookmark: pgfId-2062310]Modifying an Alert Response
 
     	 [bookmark: pgfId-2062314]Deleting an Alert Response
 
     	 [bookmark: pgfId-2072119]Enabling and Disabling Alert Responses
 
    
 
     
      [bookmark: pgfId-2018367][bookmark: 35376]Creating an SN[bookmark: marker-2034488]MP Alert Response
 
     [bookmark: pgfId-2018396]License: Any
 
     [bookmark: pgfId-2022407]You can create SNMP alert responses using SNMPv1, SNMPv2, or SNMPv3.
 
      
       
     
 
     
 
     [bookmark: pgfId-2040223]Note If you want to monitor 64-bit values with SNMP, you must use SNMPv2 or SNMPv3. SNMPv1 does not support 64-bit monitoring.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2022520]To create an SNMP alert response:
 
     
 
     [bookmark: pgfId-2022641]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Actions Alerts.
 
     [bookmark: pgfId-2022642]The Alerts page appears.
 
     [bookmark: pgfId-2022643]Step 2 From the Create Alert drop-down menu, select Create SNMP Alert.
 
     [bookmark: pgfId-2022742]The Create SNMP Alert Configuration pop-up window appears.
 
     [bookmark: pgfId-2023152]Step 3 In the Name field, type the name that you want to use to identify the SNMP response.
 
     [bookmark: pgfId-2022953]Step 4 In the Trap Server field, type the hostname or IP address of the SNMP trap server, using alphanumeric characters.
 
     [bookmark: pgfId-2032767]Note that the system does not warn you if you enter an invalid IPv4 address (such as 192.169.1.456) in this field. Instead, the invalid address is treated as a hostname.
 
     [bookmark: pgfId-2022532]Step 5 From the Version drop-down list, select the SNMP version you want to use.
 
     [bookmark: pgfId-2022533]SNMP v3 is the default. If you select SNMP v1 or SNMP v2, different options appear.
 
      
       
     
 
     
 
     [bookmark: pgfId-2095580]Note SNMPv2 only supports read-only communities and SNMPv3 only supports read-only users.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2022545]Step 6 Which version of SNMP did you select?
 
      
       
       	 [bookmark: pgfId-2023193]For SNMP v1 or SNMP v2, type the SNMP community name, using alphanumeric characters or the special characters  * or  $, in the  Community String field and skip to step 12.
 
       	 [bookmark: pgfId-2031620]For SNMP v3, type the name of the user that you want to authenticate with the SNMP server in the  User Name field and continue with the next step.
 
      
 
     
 
     [bookmark: pgfId-2023276]Step 7 From the Authentication Protocol drop-down list, select the protocol you want to use for authentication.
 
     [bookmark: pgfId-2023386]Step 8 In the Authentication Password field, type the password required for authentication with the SNMP server.
 
     [bookmark: pgfId-2023387]Step 9 From the Privacy Protocol list, select None to use no privacy protocol or DES to use Data Encryption Standard as the privacy protocol.
 
     [bookmark: pgfId-2031574]Step 10 In the Privacy Password field, type the privacy password required by the SNMP server.
 
     [bookmark: pgfId-2031575]Step 11 In the Engine ID field, type an identifier for the SNMP engine, in hexadecimal notation, using an even number of digits.
 
     [bookmark: pgfId-2031576]When you use SNMPv3, the system uses an Engine ID value to encode the message. Your SNMP server requires this value to decode the message. 
 
     [bookmark: pgfId-2033580]Cisco recommends that you use the hexadecimal version of the ASA FirePOWER module’s IP address. For example, if the ASA FirePOWER module has an IP address of 10.1.1.77, use 0a01014D0.
 
     [bookmark: pgfId-2023501]Step 12 [bookmark: 32704]Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-2023541]The alert response is saved and is automatically enabled.
 
     [bookmark: pgfId-2063453]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2018585][bookmark: 16300]Creating a Syslog Al[bookmark: marker-2034496]ert Response
 
     [bookmark: pgfId-2018586]License: Any
 
     [bookmark: pgfId-2023562]When configuring a syslog alert response, you can specify the severity and facility associated with the syslog messages to ensure that they are processed properly by the syslog server. The facility indicates the subsystem that creates the message and the severity defines the severity of the message. Facilities and severities are not displayed in the actual message that appears in the syslog, but are instead used to tell the system that receives the syslog message how to categorize it.
 
      
       
     
 
     
 
     [bookmark: pgfId-2023563]Tip For more detailed information about how syslog works and how to configure it, refer to the documentation for your system. On UNIX systems, the man pages for syslog and syslog.conf provide conceptual information and configuration instructions.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2023564]Although you can select any type of facility when creating a syslog alert response, you should select one that makes sense based on your syslog server; not all syslog servers support all facilities. For UNIX syslog servers, the syslog.conf file should indicate which facilities are saved to which log files on the server. 
 
     [bookmark: pgfId-2023573]The following table list[bookmark: marker-2023572]s the syslog facilities you can select.
 
      
       [bookmark: pgfId-2023656]
 
       
        
         
         [bookmark: pgfId-2023580]Table 29-2 [bookmark: 15541]Available Syslog Facilities 
 
         
         
          
          	 
            
            [bookmark: pgfId-2023584]Facility 
           
  
          	 
            
            [bookmark: pgfId-2023586]Description 
           
  
         
 
          
          	[bookmark: pgfId-2050382]ALERT
  
          	[bookmark: pgfId-2050384]An alert message.
  
         
 
          
          	[bookmark: pgfId-2050399]AUDIT
  
          	[bookmark: pgfId-2050401]A message generated by the audit subsystem.
  
         
 
          
          	[bookmark: pgfId-2024437]AUTH
  
          	[bookmark: pgfId-2024439]A message associated with security and authorization.
  
         
 
          
          	[bookmark: pgfId-2024441]AUTHPRIV
  
          	[bookmark: pgfId-2024443]A restricted access message associated with security and authorization. On many systems, these messages are forwarded to a secure file.
  
         
 
          
          	[bookmark: pgfId-2050412]CLOCK
  
          	[bookmark: pgfId-2050414]A message generated by the clock daemon.
 [bookmark: pgfId-2050644]Note that syslog servers running a Windows operating system will use the CLOCK facility. 
  
         
 
          
          	[bookmark: pgfId-2024450]CRON
  
          	[bookmark: pgfId-2024452]A message generated by the clock daemon.
 [bookmark: pgfId-2050854]Note that syslog servers running a Linux operating system will use the CRON facility.
  
         
 
          
          	[bookmark: pgfId-2024454]DAEMON
  
          	[bookmark: pgfId-2024456]A message generated by a system daemon.
  
         
 
          
          	[bookmark: pgfId-2024458]FTP
  
          	[bookmark: pgfId-2024460]A message generated by the FTP daemon.
  
         
 
          
          	[bookmark: pgfId-2024462]KERN
  
          	[bookmark: pgfId-2024464]A message generated by the kernel. On many systems, these messages are printed to the console when they appear.
  
         
 
          
          	[bookmark: pgfId-2024466]LOCAL0-LOCAL7
  
          	[bookmark: pgfId-2024468]A message generated by an internal process.
  
         
 
          
          	[bookmark: pgfId-2024470]LPR
  
          	[bookmark: pgfId-2024472]A message generated by the printing subsystem.
  
         
 
          
          	[bookmark: pgfId-2024474]MAIL
  
          	[bookmark: pgfId-2024476]A message generated by a mail system.
  
         
 
          
          	[bookmark: pgfId-2024478]NEWS
  
          	[bookmark: pgfId-2024480]A message generated by the network news subsystem.
  
         
 
          
          	[bookmark: pgfId-2050364]NTP
  
          	[bookmark: pgfId-2050366]A message generated by the NTP daemon.
  
         
 
          
          	[bookmark: pgfId-2024486]SYSLOG
  
          	[bookmark: pgfId-2024488]A message generated by the syslog daemon.
  
         
 
          
          	[bookmark: pgfId-2024490]USER
  
          	[bookmark: pgfId-2024492]A message generated by a user-level process.
  
         
 
          
          	[bookmark: pgfId-2024494]UUCP
  
          	[bookmark: pgfId-2024496]A message generated by the UUCP subsystem.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-2027192]The following table lists the standard[bookmark: marker-2023657] syslog severity levels you can select.
 
     
 
      
       [bookmark: pgfId-2023704]
 
       
        
         
         [bookmark: pgfId-2023665]Table 29-3 [bookmark: 83000]Syslog Severity Levels 
 
         
         
          
          	 
            
            [bookmark: pgfId-2023669]Level 
           
  
          	 
            
            [bookmark: pgfId-2023671]Description 
           
  
         
 
          
          	[bookmark: pgfId-2024518]ALERT
  
          	[bookmark: pgfId-2024520]A condition that should be corrected immediately.
  
         
 
          
          	[bookmark: pgfId-2024514]CRIT
  
          	[bookmark: pgfId-2024516]A critical condition.
  
         
 
          
          	[bookmark: pgfId-2024522]DEBUG
  
          	[bookmark: pgfId-2024524]Messages that contain debugging information.
  
         
 
          
          	[bookmark: pgfId-2024526]EMERG 
  
          	[bookmark: pgfId-2024528]A panic condition broadcast to all users.
  
         
 
          
          	[bookmark: pgfId-2024530]ERR
  
          	[bookmark: pgfId-2024532]An error condition.
  
         
 
          
          	[bookmark: pgfId-2024534]INFO
  
          	[bookmark: pgfId-2024536]Informational messages.
  
         
 
          
          	[bookmark: pgfId-2024538]NOTICE
  
          	[bookmark: pgfId-2024540]Conditions that are not error conditions, but require attention.
  
         
 
          
          	[bookmark: pgfId-2024542]WARNING
  
          	[bookmark: pgfId-2024544]Warning messages.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-2024178]Before you start sending syslog alerts, make sure that the syslog server can accept remote messages.
 
      [bookmark: pgfId-2024179]To create a syslog alert:
 
      
 
      [bookmark: pgfId-2024223]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Actions Alerts.
 
      [bookmark: pgfId-2024224]The Alerts page appears.From the Create Alert drop-down menu, select Create Syslog Alert.
 
      [bookmark: pgfId-2024226]The Create Syslog Alert Configuration pop-up window appears.
 
      [bookmark: pgfId-2033246]Step 2 In the Name field, type the name you want to use to identify the saved response.
 
      [bookmark: pgfId-2033247]Step 3 In the Host field, type the hostname or IP address of your syslog server.
 
      [bookmark: pgfId-2033248]Note that the system does not warn you if you enter an invalid IPv4 address (such as 192.168.1.456) in this field. Instead, the invalid address is treated as a hostname.
 
      [bookmark: pgfId-2023720]Step 4 In the Port field, type the port the server uses for syslog messages. 
 
      [bookmark: pgfId-2024411]By default, this value is 514.
 
      [bookmark: pgfId-2023721]Step 5 From the Facility list, select a facility.
 
      [bookmark: pgfId-2023725]See the Available Syslog Facilities table for a list of the available facilities.
 
      [bookmark: pgfId-2023726]Step 6 From the Severity list, select a severity.
 
      [bookmark: pgfId-2023730]See the Syslog Severity Levels table for a list of the available severities.
 
      [bookmark: pgfId-2023731]Step 7 In the Tag field, type the tag name that you want to appear with the syslog message.
 
      [bookmark: pgfId-2024608]Use only alphanumeric characters in tag names. You cannot use spaces or underscores.
 
      [bookmark: pgfId-2053544]As an example, if you wanted all messages sent to the syslog to be preceded with FromDC, type FromDC in the field.
 
      [bookmark: pgfId-2053545]Step 8 Click Store ASA FirePOWER Changes.
 
      [bookmark: pgfId-2028214]The alert response is saved and is automatically enabled.
 
      [bookmark: pgfId-2063469]
 
       
       
 
      
 
      
 
     
 
    
 
     
      [bookmark: pgfId-2028216][bookmark: 12806]Modifying an Alert Res[bookmark: marker-2034523]ponse
 
     [bookmark: pgfId-2031836]License: Any
 
     [bookmark: pgfId-2031875]For most types of alerting, if an alert response is enabled and in use, changes to the alert response take effect immediately. However, for alert responses used in access control rules to log connection events, changes do not take effect until you reapply the access control policy.
 
     [bookmark: pgfId-2031877]To edit an alert response:
 
     
 
     [bookmark: pgfId-2025017]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Actions Alerts.
 
     [bookmark: pgfId-2025018]The Alerts page appears.
 ). 
     
 
     [bookmark: pgfId-2025059]A configuration pop-up window for that alert response appears.
 
     [bookmark: pgfId-2025081]Step 3 Make changes as needed.
 
     [bookmark: pgfId-2025137]Step 4 Click Store ASA FirePOWER Changes.
 
     [bookmark: pgfId-2025138]The alert response is saved.
 
     [bookmark: pgfId-2063491]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2024735][bookmark: 95899]Deleting an Alert Res[bookmark: marker-2034528]ponse
 
     [bookmark: pgfId-2028902]License: Any
 
     [bookmark: pgfId-2024767]You can delete any alert response that is not in use.
 
     [bookmark: pgfId-2024768]To delete an alert response:
 
     
 
     [bookmark: pgfId-2024817]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Actions Alerts.
 
     [bookmark: pgfId-2024818]The Alerts page appears.
 ). 
     
 
     [bookmark: pgfId-2025676]Step 3 Confirm that you want to delete the alert response.
 
     [bookmark: pgfId-2024773]The alert response is deleted.
 
     [bookmark: pgfId-2063503]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2018510][bookmark: 38030]Enabling and Disab[bookmark: marker-2034533]ling Alert Responses
 
     [bookmark: pgfId-2028931]License: Any
 
     [bookmark: pgfId-2025464]Only enabled alert responses can generate alerts. To stop alerts from being generated, you can temporarily disable alert responses rather than deleting your configurations. Note that if an alert is in use when you disable it, it is still considered in use even though it is disabled.
 
     [bookmark: pgfId-2024919]To enable or disable an alert response:
 
     
 
     [bookmark: pgfId-2025271]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies > Actions Alerts.
 
     [bookmark: pgfId-2025272]The Alerts page appears.
 
     [bookmark: pgfId-2025273]Step 2 Next to the alert response you want to enable or disable, click the enable/disable slider.
 
     [bookmark: pgfId-2025342]If the alert response was enabled, it is disabled. If it was disabled, it is enabled.
 
     [bookmark: pgfId-2084776]
 
      
      
 
     
 
     
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1056300][bookmark: 42062]Configuring External [bookmark: marker-1608792]Alerting for Intrusion Rules 
      
      
 
     
 
 
    [bookmark: pgfId-2018771]While the ASA FirePOWER module provides various views of intrusion events within the user interface, some enterprises prefer to define external intrusion event notification to facilitate constant monitoring of critical systems. You can enable logging to syslog facilities or send event data to an SNMP trap server.
 
    [bookmark: pgfId-2019475]Within each intrusion policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events.
 
     
      
    
 
    
 
    [bookmark: pgfId-2078448]Tip Some analysts prefer not to receive multiple alerts for the same intrusion event, but want to control how often they are notified of a given intrusion event occurrence. See Filtering Intrusion Event Notification Per Policy for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2078452]There is another type of alerting you can perform in the ASA FirePOWER module, outside of your intrusion policies. You can configure SNMP and syslog alert responses for other types of events, including connection events logged by specific access control rules. For more information, see Configuring External Alerting.
 
    [bookmark: pgfId-1478832]See the following sections for more information on external intrusion event notification:
 
     
     	 [bookmark: pgfId-1870324]Using SNMP Responses describes the options you can configure to send event data to specified SNMP trap servers and provides the procedure for specifying the SNMP alerting options.
 
     	 [bookmark: pgfId-1801760]Using Syslog Responses describes the options you can configure to send event data to an external syslog and provides the procedure for specifying the syslog alerting options.
 
    
 
   
 
    
     [bookmark: pgfId-1872629][bookmark: 54493]Using SN[bookmark: marker-1872628]MP Responses
 
    [bookmark: pgfId-2007368]License: Protection
 
    [bookmark: pgfId-2042002]An SNMP trap is a network management notification. You can configure the device to send intrusion event notifications as SNMP traps, also known as SNMP alerts. Each SNMP alert includes:
 
     
     	 [bookmark: pgfId-2042003]the name of the server generating the trap
 
     	 [bookmark: pgfId-2042004]the IP address of the device that detected it
 
     	 [bookmark: pgfId-2042005]the name of the device that detected it
 
     	 [bookmark: pgfId-2042006]the event data
 
    
 
    [bookmark: pgfId-2042007]You can set a variety of SNMP alerting parameters. Available parameters vary depending on the version of SNMP you use. For details on enabling and disabling SNMP alerting, see Configuring Advanced Settings in an Intrusion Policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-2041879]Tip If your network management system requires a management information base file (MIB), you can obtain it from the ASA FirePOWER module at /etc/sf/DCEALERT.MIB.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2041884][bookmark: 98026]SNMPv2 Options
 
    [bookmark: pgfId-2090962]For SNMPv2, you can specify the options described in the following table.
 
     
      [bookmark: pgfId-2091130]
 
      
       
        
        [bookmark: pgfId-2091105]Table 30-1 [bookmark: 20799]SNMPv2 Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-2091109]Option 
          
  
         	 
           
           [bookmark: pgfId-2091111]Description 
          
  
        
 
         
         	[bookmark: pgfId-2091113]Trap Type
  
         	[bookmark: pgfId-2091115]The trap type to use for IP addresses that appear in the alerts.
 [bookmark: pgfId-2091116]If your network management system correctly renders the INET_IPV4 address type, then you can select as Binary. Otherwise, select as String. For example, HP Openview requires the string type.
  
        
 
         
         	[bookmark: pgfId-2091118]Trap Server
  
         	[bookmark: pgfId-2091120]The server that will receive SNMP traps notification.
 [bookmark: pgfId-2091121]You can specify a single IP address or hostname.
  
        
 
         
         	[bookmark: pgfId-2091123]Community String
  
         	[bookmark: pgfId-2091125]The community name.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2091345]Note SNMPv2 only supports read-only communities.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2091132][bookmark: 23758]SNMPv3 Options
 
     [bookmark: pgfId-2091133]For SNMPv3, you can specify the options described in the following table.
 
      
       
     
 
     
 
     [bookmark: pgfId-2091244]Note When using SNMPv3, the appliance uses an Engine ID value to encode the message. Your SNMP server requires this value to decode the message. Currently, this Engine ID value will always be the hexadecimal version of the appliance’s IP address with 01 at the end of the string. For example, if the appliance sending the SNMP alert has an IP address of 172.16.1.50, the Engine ID is 0xAC10013201 or, if the appliance has an IP address of 10.1.1.77, 0x0a01014D01 is used as the Engine ID.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2091282]
 
      
       
        
        [bookmark: pgfId-2091251]Table 30-2 [bookmark: 50665]SNMPv3 Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-2091255]Option 
          
  
         	 
           
           [bookmark: pgfId-2091257]Description 
          
  
        
 
         
         	[bookmark: pgfId-2091259]Trap Type
  
         	[bookmark: pgfId-2091261]The trap type to use for IP addresses that appear in the alerts.
 [bookmark: pgfId-2091262]If your network management system correctly renders the INET_IPV4 address type, then you can select as Binary. Otherwise, select as String. For example, HP Openview requires the string type.
  
        
 
         
         	[bookmark: pgfId-2091264]Trap Server
  
         	[bookmark: pgfId-2091266]The server that will receive SNMP traps notification.
 [bookmark: pgfId-2091267]You can specify a single IP address or hostname.
  
        
 
         
         	[bookmark: pgfId-2091269]Authentication Password
  
         	[bookmark: pgfId-2091271]The password required for authentication. SNMPv3 uses either the Message Digest 5 (MD5) hash function or the Secure Hash Algorithm (SHA) hash function to encrypt this password, depending on configuration.
 [bookmark: pgfId-2091272]If you specify an authentication password, authentication is enabled.
  
        
 
         
         	[bookmark: pgfId-2091274]Private Password
  
         	[bookmark: pgfId-2091276]The SNMP key for privacy. SNMPv3 uses the Data Encryption Standard (DES) block cipher to encrypt this password.
 [bookmark: pgfId-2091277]If you specify a private password, privacy is enabled. If you specify a private password, you must also specify an authentication password.
  
        
 
         
         	[bookmark: pgfId-2091279]User Name
  
         	[bookmark: pgfId-2091281]Your SNMP user name.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2091326]Note SNMPv3 only supports read-only users and encryption with AES128.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2091286]For information about configuring SNMP Alerting, see Configuring SNMP Responses.
 
    
 
     
      [bookmark: pgfId-2025184][bookmark: 85777]Config[bookmark: marker-2025182]uring SNMP Responses
 
     [bookmark: pgfId-2007402]License: Protection
 
     [bookmark: pgfId-2042150]You can configure SNMP alerting in an intrusion policy. After you apply the policy as part of an access control policy, the system notifies you of any intrusion events it detects via SNMP trap. For more details on SNMP alerting, see Using SNMP Responses.
 
     [bookmark: pgfId-2042158]To configure SNMP alerting options:
 
     
 
     [bookmark: pgfId-2079719]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1956471]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1956484]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1898720]The Policy Information page appears.
 
     [bookmark: pgfId-1940546]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1940547]The Advanced Settings page appears.
 
     [bookmark: pgfId-1940548]Step 4 You have two choices, depending on whether SNMP Alerting under External Responses is enabled:
 
      
       
       	 [bookmark: pgfId-1940549]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1940550]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1879665]The SNMP Alerting page appears.
 
     [bookmark: pgfId-2007512]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1872793]Step 5 Specify the trap type format that you want to use for IP addresses that appear in the alerts, as Binary or as String.
 
      
       
     
 
     
 
     [bookmark: pgfId-1872794]Note If your network management system correctly renders the INET_IPV4 address type, then you can use the as Binary option. Otherwise, use the as String option. For example, HP OpenView requires the as String option.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1872795]Step 6 Select either SNMPv2 or SNMPv3:
 
      
       
       	 [bookmark: pgfId-2090939]To configure SNMPv2, enter the IP address and the community name of the trap server you want to use in the corresponding fields. See SNMPv2 Options.
 
       	 [bookmark: pgfId-2090943]To configure SNMPv3, enter the IP address of the trap server you want to use, an authentication password, a private password, and a user name in the corresponding fields. See SNMPv3 Options for more information.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2042271]Note You must select SNMPv2 or SNMPv3. SNMPv2 only supports read-only communities and SNMPv3 only supports read-only users.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2042272]Note When you enter an SNMPv3 password, the password displays in plain text during initial configuration but is saved in encrypted format.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2076139]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-2072561]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1653690][bookmark: 34839]Using Syslog[bookmark: marker-1653689] Responses
 
    [bookmark: pgfId-2007575]License: Protection
 
    [bookmark: pgfId-1052269]The system log, or syslog, is the standard logging mechanism for network event logging. You can send syslog alerts, which are intrusion event notifications, to the syslog on an appliance. The syslog allows you to categorize information in the syslog by priority and facility. The priority reflects the severity of the alert and the facility indicates the subsystem that generated the alert. Facilities and priorities are not displayed in the actual message that appears in syslog, but are instead used to tell the system that receives the syslog message how to categorize it.
 
    [bookmark: pgfId-1592301]Syslog alerts contain the following information:
 
     
     	 [bookmark: pgfId-1592302]date and time of alert generation
 
     	 [bookmark: pgfId-1592303]event message
 
     	 [bookmark: pgfId-1592304]event data
 
     	 [bookmark: pgfId-1592305]generator ID of the triggering event
 
     	 [bookmark: pgfId-1592306]Snort ID of the triggering event
 
     	 [bookmark: pgfId-1592307]revision
 
    
 
    [bookmark: pgfId-1592040]In an intrusion policy, you can turn on syslog alerting and specify the syslog priority and facility associated with intrusion event notifications in the syslog. When you apply the intrusion policy as part of an access control policy, the system then sends syslog alerts for the intrusion events it detects to the syslog facility on the local host or on the logging host specified in the policy. The host receiving the alerts uses the facility and priority information you set when configuring syslog alerting to categorize the alerts.
 
    [bookmark: pgfId-1239717]The following table lists the facilities you can select when configuring syslog alerting. Be sure to configure a facility that makes sense based on the configuration of the remote syslog server you use. The syslog.conf file located on the remote system (if you are logging syslog messages to a UNIX- or Linux-based system) indicates which facilities are saved to[bookmark: marker-1608797] which log files on the server.
 
     
      [bookmark: pgfId-1239800]
 
      
       
        
        [bookmark: pgfId-1602706]Table 30-3 [bookmark: 64377]Available Syslog Facilities 
 
        
        
         
         	 
           
           [bookmark: pgfId-1239728]Facility 
          
  
         	 
           
           [bookmark: pgfId-1239730]Description 
          
  
        
 
         
         	[bookmark: pgfId-1877269]AUTH
  
         	[bookmark: pgfId-1877271]A message associated with security and authorization.
  
        
 
         
         	[bookmark: pgfId-1877289]AUTHPRIV
  
         	[bookmark: pgfId-1877291]A restricted access message associated with security and authorization. On many systems, these messages are forwarded to a secure file.
  
        
 
         
         	[bookmark: pgfId-1877309]CRON
  
         	[bookmark: pgfId-1877311]A message generated by the clock daemon.
  
        
 
         
         	[bookmark: pgfId-1877329]DAEMON
  
         	[bookmark: pgfId-1877331]A message generated by a system daemon.
  
        
 
         
         	[bookmark: pgfId-1877349]FTP
  
         	[bookmark: pgfId-1877351]A message generated by the FTP daemon.
  
        
 
         
         	[bookmark: pgfId-1239732]KERN
  
         	[bookmark: pgfId-1239734]A message generated by the kernel. On many systems, these messages are printed to the console when they appear.
  
        
 
         
         	[bookmark: pgfId-1877369]LOCAL0-LOCAL7
  
         	[bookmark: pgfId-1877371]A message generated by an internal process.
  
        
 
         
         	[bookmark: pgfId-1877389]LPR
  
         	[bookmark: pgfId-1877391]A message generated by the printing subsystem.
  
        
 
         
         	[bookmark: pgfId-1239740]MAIL
  
         	[bookmark: pgfId-1239742]A message generated by a mail system.
  
        
 
         
         	[bookmark: pgfId-1877409]NEWS
  
         	[bookmark: pgfId-1877411]A message generated by the network news subsystem.
  
        
 
         
         	[bookmark: pgfId-1239752]SYSLOG
  
         	[bookmark: pgfId-1239754]A message generated by the syslog daemon.
  
        
 
         
         	[bookmark: pgfId-1877429]USER
  
         	[bookmark: pgfId-1877431]A message generated by a user-level process.
  
        
 
         
         	[bookmark: pgfId-1239764]UUCP
  
         	[bookmark: pgfId-1239766]A message generated by the UUCP subsystem.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1239801]Select one of the following standard syslog priority levels[bookmark: marker-1608798] to display on all notifications generated by this alert:
 
    
 
     
      [bookmark: pgfId-1239847]
 
      
       
        
        [bookmark: pgfId-1877519]Table 30-4 Syslog Priority Levels 
 
        
        
         
         	 
           
           [bookmark: pgfId-1877523]Level 
          
  
         	 
           
           [bookmark: pgfId-1877525]Description 
          
  
        
 
         
         	[bookmark: pgfId-1877527]EMERG 
  
         	[bookmark: pgfId-1877529]A panic condition broadcast to all users
  
        
 
         
         	[bookmark: pgfId-1877531]ALERT
  
         	[bookmark: pgfId-1877533]A condition that should be corrected immediately
  
        
 
         
         	[bookmark: pgfId-1877535]CRIT
  
         	[bookmark: pgfId-1877537]A critical condition
  
        
 
         
         	[bookmark: pgfId-1877539]ERR
  
         	[bookmark: pgfId-1877541]An error condition
  
        
 
         
         	[bookmark: pgfId-1877543]WARNING
  
         	[bookmark: pgfId-1877545]Warning messages
  
        
 
         
         	[bookmark: pgfId-1877547]NOTICE
  
         	[bookmark: pgfId-1877549]Conditions that are not error conditions, but require attention
  
        
 
         
         	[bookmark: pgfId-1877551]INFO
  
         	[bookmark: pgfId-1877553]Informational messages
  
        
 
         
         	[bookmark: pgfId-1877555]DEBUG
  
         	[bookmark: pgfId-1877557]Messages that contain debug information
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1592279]For more detailed information about how syslog works and how to configure it, refer to the documentation that accompanies your system. If you are logging to a UNIX- or Linux-based system’s syslog, the syslog.conf man file (type man syslog.conf at the command line) and syslog man file (type man syslog at the command line) provide information about how syslog works and how to configure it.
 
    
 
     
      [bookmark: pgfId-1483625][bookmark: 35015]Configur[bookmark: marker-1483624]ing Syslog Responses
 
     [bookmark: pgfId-2007609]License: Protection
 
     [bookmark: pgfId-1583672]You can configure syslog alerting in an intrusion policy. After you apply the policy as part of an access control policy, the system notifies you of any intrusion events it detects via the syslog. For more information on syslog alerting, see Using Syslog Responses.
 
     [bookmark: pgfId-1483626]To configure syslog alerting options:
 
     
 
     [bookmark: pgfId-2079732]Step 1 Select Configuration > ASA FirePOWER Configuration > Policies> Intrusion Policy.
 
     [bookmark: pgfId-1956538]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1956551]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1898733]The Policy Information page appears.
 
     [bookmark: pgfId-1940621]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1940622]The Advanced Settings page appears.
 
     [bookmark: pgfId-1940623]Step 4 You have two choices, depending on whether Syslog Alerting under External Responses is enabled:
 
      
       
       	 [bookmark: pgfId-1940624]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1940625]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1880884]The Syslog Alerting page appears.
 
     [bookmark: pgfId-2007719]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-2030590]Step 5 Optionally, in the Logging Hosts field, enter the remote access IP address you want to specify as logging host. Separate multiple hosts with commas.
 
     [bookmark: pgfId-2030592]Step 6 Select facility and priority levels from the drop-down lists.
 
     [bookmark: pgfId-1067364]See Using Syslog Responses for details on facility and priority options.
 
     [bookmark: pgfId-2076155]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-2072575]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2083119]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-4389373][bookmark: 90386]Using the ASA FirePOWER Dashbo[bookmark: marker-4389370]ard 
      
      
 
     
 
 
    [bookmark: pgfId-4478869]The ASA FirePOWER module dashboard provides you with at-a-glance views of current system status. The dashboard displays widgets in a three-column layout. Widgets are small, self-contained components that provide insight into different aspects of the ASA FirePOWER module. Your system is delivered with several predefined widgets. For example, the Appliance Information widget tells you the appliance name, model, and currently running version of the ASA FirePOWER module software.
 
    [bookmark: pgfId-4296663]The dashboard has a time range that constrains its widgets. You can change the time range to reflect a period as short as the last hour or as long as the last year.
 
    [bookmark: pgfId-4296673]Each ap[bookmark: marker-4296671]pliance is delivered with a default dashboard, named Sum[bookmark: marker-4296672]mary Dashboard. This dashboard provides the casual user with general system status information for your ASA FirePOWER module deployment.
 
    [bookmark: pgfId-4296875]For more information on the dashboard and its contents, see the following sections:
 
     
     	 [bookmark: pgfId-4296879]Understanding Dashboard Widgets
 
     	 [bookmark: pgfId-4296883]Understanding the Predefined Widgets
 
     	 [bookmark: pgfId-4296887]Working with the Dashboard
 
    
 
   
 
    
     [bookmark: pgfId-4296890][bookmark: 35085]Understanding Dash[bookmark: marker-4296889]board Widgets
 
    [bookmark: pgfId-4296891]License: Any
 
    [bookmark: pgfId-4296908]The dashboard displays multiple widgets in a three-column layout. The ASA FirePOWER module is delivered with several predefined dashboard widgets, each of which provides insight into a different aspect of the system. You can minimize and maximize widgets, as well as rearrange the widgets.
 
    [bookmark: pgfId-4296913]For more information, see: 
 
     
     	 [bookmark: pgfId-4296921]Understanding Widget Preferences
 
     	 [bookmark: pgfId-4296925]Understanding the Predefined Widgets
 
     	 [bookmark: pgfId-4296929]Working with the Dashboard
 
    
 
     
      [bookmark: pgfId-4297276][bookmark: 77484]Understanding Widg[bookmark: marker-4297275]et Preferences
 
     [bookmark: pgfId-4297277]License: Any
 
     [bookmark: pgfId-4297278]Each widget has a set of preferences that determines its behavior.
 
     [bookmark: pgfId-4297279]Widget preferences can be simple. For example, you can set preferences for the Current Interface Status widget, which displays the current status of all enabled interfaces on the internal network. You can only configure the update frequency for this widget.
 
     [bookmark: pgfId-4297284]To modify a widget’s preferences:
 
     
 ). 
     
 
     [bookmark: pgfId-4297290]The preferences section for that widget appears.
 
     [bookmark: pgfId-4297291]Step 2 Make changes as needed.
 
     [bookmark: pgfId-4297292]Your changes take effect immediately. For information on the preferences you can specify for individual widgets, see Understanding the Predefined Widgets.
 ) to hide the preferences section. 
     
 
     [bookmark: pgfId-4331135]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4297302][bookmark: 47157]Understanding the Predefin[bookmark: marker-4297301]ed Widgets
 
    [bookmark: pgfId-4297303]License: Any
 
    [bookmark: pgfId-4297307]The ASA FirePOWER module is delivered with several predefined widgets that can provide you with at-a-glance views of current system status.
 
    [bookmark: pgfId-4297311]For detailed information on the widgets, see the following sections:
 
     
     	 [bookmark: pgfId-4297315]Understanding the Appliance Information Widget
 
     	 [bookmark: pgfId-4297327]Understanding the Current Interface Status Widget
 
     	 [bookmark: pgfId-4297339]Understanding the Disk Usage Widget
 
     	 [bookmark: pgfId-4297355]Understanding the Product Licensing Widget
 
     	 [bookmark: pgfId-4297359]Understanding the Product Updates Widget
 
     	 [bookmark: pgfId-4297367]Understanding the System Load Widget
 
     	 [bookmark: pgfId-4297371]Understanding the System Time Widget
 
    
 
     
      [bookmark: pgfId-4297381][bookmark: 89442]Understanding the Appliance Information Widget
 
     [bookmark: pgfId-4297382]License: Any
 
     [bookmark: pgfId-4479661]The Appliance Information widget provides:
 
      
      	 [bookmark: pgfId-4297389]the name, IPv4 address, IPv6 address, and model of the appliance 
 
      	 [bookmark: pgfId-4297393]the versions of the ASA FirePOWER module software, rule update, and geolocation update installed on the appliance
 
     
 
     [bookmark: pgfId-4297408]You can configure the widget to display more or less information by modifying the widget preferences to display a simple or an advanced view; the preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4297464][bookmark: 44888]Understanding the Current Inte[bookmark: marker-4297463]rface Status Widget
 
     [bookmark: pgfId-4297465]License: Any
 
     [bookmark: pgfId-4479767]The Current Interface Status widget shows the status of all interfaces on the appliance, enabled or unused. For each interface, the widget provides:
 
      
      	 [bookmark: pgfId-4350788]the name of the interface
 
      	 [bookmark: pgfId-4350789]the link state of the interface
 
      	 [bookmark: pgfId-4350790]the link mode (for example, 100Mb full duplex, or 10Mb half duplex) of the interface
 
      	 [bookmark: pgfId-4355010]the type of interface, that is, copper or fiber
 
      	 [bookmark: pgfId-4355011]the amount of data received (Rx) and transmitted (Tx) by the interface
 
     
 
     [bookmark: pgfId-4355012]The color of the ball representing link state indicates the current status, as follows:
 
      
      	 [bookmark: pgfId-4350814]green: link is up and at full speed
 
      	 [bookmark: pgfId-4350901]yellow: link is up but not at full speed
 
      	 [bookmark: pgfId-4350952]red: link is not up
 
      	 [bookmark: pgfId-4350979]gray: link is administratively disabled
 
      	 [bookmark: pgfId-4351024]blue: link state information is not available (for example, ASA)
 
     
 
     [bookmark: pgfId-4297484]The widget preferences control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299188][bookmark: 62645][bookmark: 73429]Understanding the D[bookmark: marker-4299187]isk Usage Widget
 
     [bookmark: pgfId-4299189]License: Any
 
     [bookmark: pgfId-4481507]The Disk Usage widget displays the space used on the hard drive, based on disk usage category. It also indicates the space used on and capacity of each partition of the appliance’s hard drive. The By Category stacked bar displays each disk usage category as a proportion of the total available disk space used. The following table describes the available categories.
 
     [bookmark: pgfId-4299235]
 
      
       
        
        [bookmark: pgfId-4299204]Table 31-1 Disk Usage Categories 
 
        
        
         
         	 
           
           [bookmark: pgfId-4299208]Disk Usage Category 
          
  
         	 
           
           [bookmark: pgfId-4299210]Description 
          
  
        
 
         
         	[bookmark: pgfId-4299212]Events
  
         	[bookmark: pgfId-4299214]all events logged by the system
  
        
 
         
         	[bookmark: pgfId-4299216]Files
  
         	[bookmark: pgfId-4299218]all files stored by the system
  
        
 
         
         	[bookmark: pgfId-4299220]Backups
  
         	[bookmark: pgfId-4299222]all backup files
  
        
 
         
         	[bookmark: pgfId-4299224]Updates
  
         	[bookmark: pgfId-4299226]all files related to updates, such as rule updates and system updates
  
        
 
         
         	[bookmark: pgfId-4299228]Other
  
         	[bookmark: pgfId-4299230]system troubleshooting files and other miscellaneous files
  
        
 
         
         	[bookmark: pgfId-4299232]Free
  
         	[bookmark: pgfId-4299234]free space remaining on the appliance
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4299240]You can configure the widget to display only the By Category stacked bar, or you can show the stacked bar plus the admin (/), /Volume, and /boot partition usage, as well as the /var/storage partition if the malware storage pack is installed, by modifying the widget preferences.
 
     [bookmark: pgfId-4498916]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299245]The widget preferences also control how often the widget updates, as well as whether it displays the current disk usage or collected disk usage statistics over the dashboard time range. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299381][bookmark: 72517]Understanding the Prod[bookmark: marker-4299380]uct Licensing Widget
 
     [bookmark: pgfId-4299382]License: Any
 
     [bookmark: pgfId-4299383]The Product Licensing widget shows the device and feature licenses currently installed. It also indicates the number of items (such as hosts or users) licensed and the number of remaining licensed items allowed.
 
     [bookmark: pgfId-4299391]The top section of the widget displays all device and feature licenses installed, including temporary licenses, while the Expiring Licenses section displays only temporary and expired licenses.
 
     [bookmark: pgfId-4299404]The bars in the widget background show the percentage of each type of license that is being used; you should read the bars from right to left. Expired licenses are marked with a strikethrough. 
 
     [bookmark: pgfId-4299405]You can configure the widget to display either the features that are currently licensed, or all the features that you can license, by modifying the widget preferences. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4299409]You can click any of the license types to go to the License page of the local configuration and add or delete feature licenses. For more information, see Licensing the ASA FirePOWER Module.
 
    
 
     
      [bookmark: pgfId-4299415][bookmark: 16968]Understanding the Product U[bookmark: marker-4299414]pdates Widget
 
     [bookmark: pgfId-4380269]License: Any
 
     [bookmark: pgfId-4380272]The Product Updates widget provides you with a summary of the software (ASA FirePOWER module software and rule updates) currently installed on the appliance as well as information on available updates that you have downloaded, but not yet installed, for that software. 
 
     [bookmark: pgfId-4299421]Note that the widget displays Unknown as the latest version of the software unless you have configured a scheduled task to download, push, or install software updates; the widget uses scheduled tasks to determine the latest version. For more information, see Scheduling Tasks.
 
     [bookmark: pgfId-4299425]The widget also provides you with links to pages where you can update the software
 
     [bookmark: pgfId-4299433]You can configure the widget to hide the latest versions by modifying the widget preferences. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4299437]On the Product Updates widget, you can:
 
      
      	 [bookmark: pgfId-4299438]manually update an appliance by clicking the current version of the ASA FirePOWER module software, rule update, or geolocation update:
 
       
       	 [bookmark: pgfId-4299442]to update the system software, or geolocation database, see Updating ASA FirePOWER Module Software.
 
       	 [bookmark: pgfId-4299448]to import the newest rule update, see Importing Rule Updates and Local Rule Files.
 
      
 
      	 [bookmark: pgfId-4299452]create a scheduled task to download the latest version of the ASA FirePOWER module software or rule update by clicking the latest version; see Scheduling Tasks.
 
     
 
    
 
     
      [bookmark: pgfId-4299491][bookmark: 63658]Understanding the Sys[bookmark: marker-4299490]tem Load Widget
 
     [bookmark: pgfId-4299492]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299498]You can configure the widget to show or hide the load average by modifying the widget preferences. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299504][bookmark: 95948]Understanding the Syst[bookmark: marker-4299503]em Time Widget
 
     [bookmark: pgfId-4299505]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299511]You can configure the widget to hide the boot time by modifying the widget preferences. The preferences also control how often the widget synchronizes with the appliance’s clock. For more information, see Understanding Widget Preferences.
 
    
 
   
 
    
     [bookmark: pgfId-4299550][bookmark: 65839]Working with the Dashbo[bookmark: marker-4389443]ard
 
    [bookmark: pgfId-4299552]License: Any
 
    [bookmark: pgfId-4299553]You can view and modify the widgets that appear on the dashboard. 
 
    [bookmark: pgfId-4299563]For more information on working with the dashboard, see:
 
     
     	 [bookmark: pgfId-4299571]Viewing the Dashboard
 
     	 [bookmark: pgfId-4299575]Modifying the Dashboard
 
     	 [bookmark: pgfId-4299583]Exporting Configurations
 
    
 
     
      [bookmark: pgfId-4299631][bookmark: 77774]Viewing the Dashb[bookmark: marker-4389481]oard
 
     [bookmark: pgfId-4299632]License: Any
 
     [bookmark: pgfId-4299633] At any time, to view the dashboard for your ASA FirePOWER module, select Home > ASA FirePOWER Dashboard.
 
     [bookmark: pgfId-4299641]The dashboard has a time range that constrains its widgets. You can change the time range to reflect a period as short as the last hour (the default) or as long as the last year. When you change the time range, the widgets that can be constrained by time automatically update to reflect the new time range. 
 
     [bookmark: pgfId-4299642]Note that not all widgets can be constrained by time. For example, the dashboard time range has no effect on the Appliance Information widget, which provides information that includes the appliance name, model, and current version of the ASA FirePOWER module software.
 
     [bookmark: pgfId-4299664]To view the dashboard:
 
     
 
     [bookmark: pgfId-4482024]Step 1 Select Home > ASA FirePOWER Dashboard. 
 
     [bookmark: pgfId-4299669]The ASA FirePOWER dashboard appears.
 
     [bookmark: pgfId-4331328]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299670]To change the dashboard time range:
 
     
 
     [bookmark: pgfId-4299672]Step 1 From the Show the Last drop-down list, choose a dashboard time range.
 
     [bookmark: pgfId-4299673]All appropriate widgets on the page update to reflect the new time range.
 
     [bookmark: pgfId-4331362]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299690][bookmark: 94090]Modifying the Dashboar[bookmark: marker-4389560]d
 
     [bookmark: pgfId-4299691]License: Any
 
     [bookmark: pgfId-4299693]The dashboard displays widgets in a three-column layout. You can minimize and maximize widgets, as well as rearrange the widgets.
 
     [bookmark: pgfId-4299708]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-4299732]Rearranging Widgets
 
      	 [bookmark: pgfId-4299736]Minimizing and Maximizing Widgets
 
     
 
    
 
     
      [bookmark: pgfId-4299849][bookmark: 88329][bookmark: 36396]Rearranging Widg[bookmark: marker-4299848]ets
 
     [bookmark: pgfId-4299850]License: Any
 
     [bookmark: pgfId-4299851]You can change the location of any widget.
 
     [bookmark: pgfId-4299852]To move a widget:
 
     
 
     [bookmark: pgfId-4299854]Step 1 Click the title bar of the widget you want to move, then drag it to its new location.
 
     [bookmark: pgfId-4331518]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299857][bookmark: 94334]Minimizing and Max[bookmark: marker-4299856]imizing Widgets
 
     [bookmark: pgfId-4299858]License: Any
 
     [bookmark: pgfId-4299859]You can minimize widgets to simplify your view, then maximize them when you want to see them again.
 
     [bookmark: pgfId-4299860]To minimize a widget:
 
     
 ) in a widget’s title bar. 
     
 
     [bookmark: pgfId-4331534]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299866]To maximize a widget:
 
     
 ) in a minimized widget’s title bar. 
     
 
     [bookmark: pgfId-2766149]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-6753877]Using ASA FirePOWER Reporting 
      
      
 
     
 
 
    [bookmark: pgfId-7222332]You can view reports on various time periods to analyze the traffic on your network. Reports aggregate information on various aspects of your network traffic. In most cases, you can drill down from general information to specific information. For example, you can view a report on all users, then view details about specific users.
 
    [bookmark: pgfId-7220078]Overview and detail reports include multiple report components such as top policies and web categories. These reports show the most often occurring items of that type for the report you are viewing. For example, if you are viewing the detail report for a specific user, the top policies show the policy hits most associated with that user.
 
    [bookmark: pgfId-7222581]For more information, see:
 
     
     	 [bookmark: pgfId-7222585]Understanding Available Reports
 
     	 [bookmark: pgfId-7222592]Report Basics
 
    
 
   
 
    
     [bookmark: pgfId-7222587][bookmark: 37546]Understanding Available Reports
 
    [bookmark: pgfId-7223479]License: Any
 
    [bookmark: pgfId-7220152]Available reports include the main reports available in the ASA FirePOWER module. You can view these reports from the ASA FirePOWER Reporting menu.
 
    [bookmark: pgfId-7220173]In general, you can click on many items, including names and View More links, to get more detailed information about individual items or about the monitored category as a whole.
 
    [bookmark: pgfId-7220188]Network Overview
 
    [bookmark: pgfId-7220209]This report shows summary information about the traffic in the network. Use this information to help identify areas that need deeper analysis, or to verify that the network is behaving within general expectations.
 
    [bookmark: pgfId-7220421]Users
 
    [bookmark: pgfId-7220474]This report shows the top users of your network. Use this information to help identify anomalous activity for a user.
 
     
      
    
 
    
 
    [bookmark: pgfId-7220475]Tip User names are available only when user identity information is associated with traffic flows. If you want to ensure that user identity is available in reports for the majority of traffic, the access control policy should use active authentication.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7220476]Applications
 
    [bookmark: pgfId-7220386]This report displays applications, which represent the content or requested URL for HTTP traffic detected in the traffic that triggered an intrusion event. Note that if the module detects an application protocol of HTTP, but cannot detect a specific web application, the module supplies a generic web browsing designation here.
 
    [bookmark: pgfId-7220255]Web categories
 
    [bookmark: pgfId-7220389]This report shows which categories of web sites, such as gambling, advertisements, or search engines and portals are being used in the network based on the categorization of web sites visited. Use this information to help identify the top categories visited by users and to determine whether your access control policies are sufficiently blocking undesired categories. 
 
    [bookmark: pgfId-7220273]Policies
 
    [bookmark: pgfId-7220392]This report shows how your access control policies have been applied to traffic in the network. Use this information to help evaluate policy efficacy.
 
    [bookmark: pgfId-7226446]Ingress zones
 
    [bookmark: pgfId-7226447]This report displays the ingress security zone of the packet that triggered an event.
 
    [bookmark: pgfId-7226500]Egress zones
 
    [bookmark: pgfId-7226502]This report displays the egress security zone of the packet that triggered the event.
 
    [bookmark: pgfId-7226503]Destinations
 
    [bookmark: pgfId-7220401]This report shows which applications, such as Facebook, are being used in the network based on the analysis of the traffic in the network. Use this information to help identify the top applications used in the network and to determine whether additional access control policies are needed to reduce the usage of unwanted applications.
 
    [bookmark: pgfId-7220334]Attackers
 
    [bookmark: pgfId-7224686]This report displays the source IP addresses, used by the sending hosts, that triggered an event.
 
    [bookmark: pgfId-7220345]Targets
 
    [bookmark: pgfId-7222217]This report displays the destination IP addresses, used by the receiving hosts, that triggered an event.
 
    [bookmark: pgfId-7220354]Threats
 
    [bookmark: pgfId-7222239]This report displays the unique identifying number and explanatory text assigned to each detected threat to your network.
 
    [bookmark: pgfId-7220363]Files logs
 
    [bookmark: pgfId-7222251]This report displays the type of files detected, for example, HTML or MSEXE.
 
   
 
    
     [bookmark: pgfId-7220380][bookmark: 23446]Report Basics
 
    [bookmark: pgfId-7223525]License: Any
 
    [bookmark: pgfId-7220633]The following sections explain the basics of using reports. These topics apply to reports in general and not to any single specific report.
 
    [bookmark: pgfId-7220593]For more information, see:
 
     
     	 [bookmark: pgfId-7222626]Understanding Report Data
 
     	 [bookmark: pgfId-7222645]Drilling into Reports
 
     	 [bookmark: pgfId-7222651]Changing the Report Time Range
 
     	 [bookmark: pgfId-7222658]Controlling the Data Displayed in Reports
 
     	 [bookmark: pgfId-7222665]Understanding Report Columns
 
    
 
     
      [bookmark: pgfId-7220588][bookmark: 77787]Understanding Report Data
 
     [bookmark: pgfId-7223719]License: Any
 
     [bookmark: pgfId-7223082]Report data is collected immediately from the device, so there is little lag time between the data reflected in a report and network activity. However, keep the following points in mind when analyzing the data:
 
      
      	 [bookmark: pgfId-7223083]Data is collected for traffic that matches an access control policy applied to your ASA FirePOWER module.
 
      	 [bookmark: pgfId-7223130]Data is aggregated into 5 minute buckets, and 30 minute and one hour graphs show data points in 5 minute increments. At the end of the hour, the 5 minute buckets are aggregated into one hour buckets, which are subsequently aggregated into day and week buckets. The 5 minute buckets are kept for 7 days, the one hour buckets for 31 days, and the day buckets for up to 365 days. The farther back you look, the more aggregated the data. When you query for old data, you get the best results if you align your queries to the availability of these data buckets.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7223150]Note If a data point is missing, for example, because the device was unreachable for longer than 5 minutes, there will be gaps in line charts.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7223085][bookmark: 96342]Drilling into Reports
 
     [bookmark: pgfId-7223591]License: Any
 
     [bookmark: pgfId-7220771]Reports include many links to help you drill down to the information that you need. Mouse over items to see which ones might take you to more information about the item.
 
     [bookmark: pgfId-7220792]For example, in a typical reporting item, you can click the View More link to go to the summary report for that item.
 
     [bookmark: pgfId-7220807]You can also get to a detail report on a specific item by clicking the item in a summary report. For example, clicking Hypertext Transfer Protocol (HTTP) in the applications summary report takes you to the applications detail report for HTTP.
 
    
 
     
      [bookmark: pgfId-7220855][bookmark: 49803]Changing the Report Time Range
 
     [bookmark: pgfId-7223765]License: Any
 
     [bookmark: pgfId-7220896]When you view a report, you can change the time range that defines the information to include in the report using the Time Range list. The time range list appears at the top of each report, and allows you to select predefined time ranges, such as the last hour or week, or to define a custom time range with specific start and end times. The time range you select is carried over to any other report that you view until you change the selection.
 
     [bookmark: pgfId-7220913]Reports automatically update every 10 minutes.
 
     [bookmark: pgfId-7223398]The following table explains the time range options.
 
     [bookmark: pgfId-7223430]Table 32-1 Time Ranges for reports
 
      
       
        
         
         	 
           
           [bookmark: pgfId-7223401]Time Range 
          
  
         	 
           
           [bookmark: pgfId-7223403]Data Returned In 
          
  
        
 
         
         	[bookmark: pgfId-7223405]Last 30 minutes
  
         	[bookmark: pgfId-7223407]30 complete minutes in five minute intervals, plus up to five additional minutes.
  
        
 
         
         	[bookmark: pgfId-7223409]Last hour
  
         	[bookmark: pgfId-7223411]60 complete minutes in five minute intervals, plus up to five additional minutes.
  
        
 
         
         	[bookmark: pgfId-7223413]Last 24 hours 
  
         	[bookmark: pgfId-7223415]One hour intervals for the last 24 hours rounded to the previous hour boundary. For example, if the current time is 13:45, the Last 24 Hour period is from 13:00 yesterday to 13:00 today. 
  
        
 
         
         	[bookmark: pgfId-7223417]Last 7 days 
  
         	[bookmark: pgfId-7223419]One hour intervals for the last seven days rounded to the previous hour boundary. 
  
        
 
         
         	[bookmark: pgfId-7223421]Last 30 days
  
         	[bookmark: pgfId-7223423]One day intervals for the last 30 days starting from the previous midnight.
  
        
 
         
         	[bookmark: pgfId-7223425]Custom Range 
  
         	[bookmark: pgfId-7223427]The time range you define. Edit boxes are displayed for start date, start time, end date, and end time; click in each box and select the desired value. Click Apply to update the report when you are finished. 
 [bookmark: pgfId-7223428]When constructing a custom time range, you should align your range with the availability of data buckets. For ranges 7-31 days in the past, align your query on the hour. For older ranges, align them on the day; for ranges over a year, align them on the week.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7221331][bookmark: 54431]Controlling the Data Displayed in Reports
 
     [bookmark: pgfId-7223802]License: Any
 
     [bookmark: pgfId-7221335]Overview and detail reports include several subordinate reports such as Top Policies and Web Categories. Each report panel includes controls that let you view different aspects of the data. You can use the following controls:
 
     [bookmark: pgfId-7221337]Transactions or Data Usage
 
     [bookmark: pgfId-7221339]Click these links to view charts based on the number of transactions or the amount of data in the transactions.
 
     [bookmark: pgfId-7221341]All, Denied, Allowed
 
     [bookmark: pgfId-7221343]The unlabeled drop-down list in the upper right of each report includes these options. Use them to change whether you see denied connections only, allowed connections only, or all connections whether denied or allowed.
 
     [bookmark: pgfId-7221347]View More
 
     [bookmark: pgfId-7221349]Click the View More link to go to the report for the item you are viewing. For example, clicking View More in the Web Categories chart of the Destinations report takes you to the Web Categories report. If you are viewing the report in a detailed report, you go to the detailed Web Categories report for the item you are viewing details about.
 
    
 
     
      [bookmark: pgfId-7221351][bookmark: 16296]Understanding Report Columns
 
     [bookmark: pgfId-7223822]License: Any
 
     [bookmark: pgfId-7221353]Reports typically contain one or more tables to present information in addition to the information displayed in graphical format. 
 
      
      	 [bookmark: pgfId-7226697]The meaning of many columns is modified by the report in which they are included. For example, the transactions column shows the number of transactions for the type of item reported on. You can also toggle the values between raw numbers and as a percentage of the total reported raw values for the item by clicking  Values or  Percentages .
 
      	 [bookmark: pgfId-7226698]You can change the sort order of the columns by clicking the column heading.
 
     
 
     [bookmark: pgfId-7221355]The following table explains the standard columns that you can find in the various reports.
 
     [bookmark: pgfId-7221359]Table 32-2 Report Columns
 
      
       
        
         
         	 
           
           [bookmark: pgfId-7221976]Column 
          
  
         	 
           
           [bookmark: pgfId-7221978]Description 
          
  
        
 
         
         	[bookmark: pgfId-7221984]Transactions
  
         	[bookmark: pgfId-7225612]The total number of transactions for the reported item.
  
        
 
         
         	[bookmark: pgfId-7221988]Transactions allowed
  
         	[bookmark: pgfId-7221990]The number of transactions that were allowed for the reported item.
  
        
 
         
         	[bookmark: pgfId-7221992]Transactions denied
  
         	[bookmark: pgfId-7221994]The number of transactions that were blocked (based on policy) for the reported item.
  
        
 
         
         	[bookmark: pgfId-7221996]Total bytes
  
         	[bookmark: pgfId-7221998]The sum of bytes sent and received for the reported item.
  
        
 
         
         	[bookmark: pgfId-7225545]Bytes received
  
         	[bookmark: pgfId-7225547]The number of bytes received for the reported item.
  
        
 
         
         	[bookmark: pgfId-7222000]Total Bytes Sent
  
         	 
          
  
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1049219][bookmark: 24880]Scheduling[bookmark: marker-4846376] Tasks 
      
      
 
     
 
 
    [bookmark: pgfId-1898624]You can schedule many different types of administrative tasks to run at designated times, either once or on a recurring basis.
 
     
      
    
 
    
 
    [bookmark: pgfId-5510671]Note Some tasks (such as those involving automated software updates) may place a significant load on networks with low bandwidths. You should schedule tasks like these to run during periods of low network use.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1911928]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1915450]Configuring a Recurring Task explains how to set up a scheduled task so that it runs at regular intervals.
 
     	 [bookmark: pgfId-4652624]Automating Backup Jobs provides procedures for scheduling backup jobs.
 
     	 [bookmark: pgfId-5375854]Automating Certificate Revocation List Downloads provides procedures for automatically refreshing the certificate revocation list (CRL) for an appliance.
 
     	 [bookmark: pgfId-5403043]Automating Applying an Intrusion Policy provides procedures for queuing an intrusion policy apply.
 
     	 [bookmark: pgfId-5437747]Automating Geolocation Database Updates provides procedures for scheduling automatic updates of the geolocation database (GeoDB).
 
     	 [bookmark: pgfId-5437740]Automating Software Updates provides procedures for scheduling the download, push, and installation of software updates.
 
     	 [bookmark: pgfId-5384756]Automating URL Filtering Updates provides procedures for automating updates of URL filtering data.
 
     	 [bookmark: pgfId-5384760]Viewing Tasks describes how to view and manage tasks after they are scheduled.
 
     	 [bookmark: pgfId-4925446]Editing Scheduled Tasks describes how to edit an existing task.
 
     	 [bookmark: pgfId-1918501]Deleting Scheduled Tasks describes how to delete one-time tasks and all instances of recurring tasks.
 
    
 
   
 
    
     [bookmark: pgfId-4635130][bookmark: 16104]Configuring a[bookmark: marker-4846378] Recurring Task
 
    [bookmark: pgfId-5367951]License: Any
 
    [bookmark: pgfId-4635135]You set the frequency for a recurring task using the same process for all types of tasks.
 
    [bookmark: pgfId-4790807]Note that the time displayed on most pages on the user interface is the local time, which is determined by using the time zone you specify in your local configuration. Further, the ASA FirePOWER module automatically adjusts its local time display for daylight saving time (DST), where appropriate. However, recurring tasks that span the transition dates from DST to standard time and back do not adjust for the transition. That is, if you create a task scheduled for 2:00 AM during standard time, it will run at 3:00 AM during DST. Similarly, if you create a task scheduled for 2:00 AM during DST, it will run at 1:00 AM during standard time.
 
    [bookmark: pgfId-5496759]To configure a recurring task:
 
    
 
    [bookmark: pgfId-5496761]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling.
 
    [bookmark: pgfId-5496762]The Scheduling page appears.
 
    [bookmark: pgfId-4635368]Step 2 Click Add Task.
 
    [bookmark: pgfId-4635369]The New Task page appears.
 
    [bookmark: pgfId-4635393]Step 3 From the Job Type list, select the type of task that you want to schedule.
 
    [bookmark: pgfId-4635421]Each of the types of tasks you can schedule is explained in its own section.
 
    [bookmark: pgfId-4635442]Step 4 For the Schedule task to run option, select Recurring.
 
    [bookmark: pgfId-4635492]The page reloads with the recurring task options.
 
    [bookmark: pgfId-4635513]Step 5 In the Start On field, specify the date when you want to start your recurring task. You can use the drop-down list to select the month, day, and year.
 
    [bookmark: pgfId-4635682]Step 6 In the Repeat Every field, specify how often you want the task to recur. You can specify a number of hours, days, weeks, or months. 
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-4635910]Step 7 In the Run At field, specify the time when you want to start your recurring task.
 
   [bookmark: pgfId-4635950]Step 8 If you selected Weeks for Repeat Every, a Repeat On field appears. Select the check boxes next to the days of the week when you want to run the task.
 
   [bookmark: pgfId-5399374]Step 9 If you selected Months for Repeat Every, a Repeat On field appears. Use the drop-down list to select the day of the month when you want to run the task.
 
   [bookmark: pgfId-5399375]The remaining options on the New Task page are determined by the task you are creating. See the following sections for more information:
 
   [bookmark: pgfId-5046715] – Automating Backup Jobs
 
   [bookmark: pgfId-5384042] – Automating Certificate Revocation List Downloads
 
   [bookmark: pgfId-5497411] – Automating Applying an Intrusion Policy
 
   [bookmark: pgfId-5046719] – Automating Software Updates
 
   [bookmark: pgfId-5384123] – Automating URL Filtering Updates
 
   [bookmark: pgfId-5472188]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1901557][bookmark: 48889]Automating Backup[bookmark: marker-4846379] Jobs
 
    [bookmark: pgfId-5495299]You can use the scheduler to automate backups of your ASA FirePOWER module. You must design a backup profile before you can configure a backup as a scheduled task. For more information, see Creating Backup Profiles.
 
    [bookmark: pgfId-5495164]To automate backup tasks:
 
    
 
    [bookmark: pgfId-5368066]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
    [bookmark: pgfId-1913677]The Scheduling page appears.
 
    [bookmark: pgfId-2105567]Step 2 Click Add Task.
 
    [bookmark: pgfId-2105568]The New Task page appears.
 
    [bookmark: pgfId-4652182]Step 3 From the Job Type list, select Backup.
 
    [bookmark: pgfId-4652710]The page reloads to show the backup options.
 
    [bookmark: pgfId-4651741]Step 4 [bookmark: 40879]Specify how you want to schedule the backup, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-4652123]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-4652127]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5487034]Step 5 [bookmark: 34749]In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5487035]Step 6 From the Backup Profile list, select the appropriate backup profile.
 
    [bookmark: pgfId-5487039]For more information on creating new backup profiles, see Creating Backup Profiles.
 
    [bookmark: pgfId-1914413]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-1914417]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5486830]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5487361]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5487365]Step 9 Click Save.
 
    [bookmark: pgfId-5379725]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472194]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5375685][bookmark: 25711]Automating Certificate Rev[bookmark: marker-5407155]ocation List Downloads
 
    [bookmark: pgfId-5386471]You can use the scheduler to automatically refresh the certificate revocation list (CRL) for the appliance web server on an appliance where you enable user certificates for the appliance. The Download CRL task is automatically created when you enable fetching of a CRL in the local appliance configuration, so this procedure explains how to open the scheduled task to set the frequency. 
 
     
      
    
 
    
 
    [bookmark: pgfId-5386472]Tip You must enable and configure user certificates and set a CRL download URL before scheduling this task.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5386476]To automate download of certificate revocation lists:
 
    
 
    [bookmark: pgfId-5386478]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
    [bookmark: pgfId-5386479]The Scheduling page appears.
 ). 
    
 
    [bookmark: pgfId-5386481]The Edit Task page appears, showing the download options.
 
    [bookmark: pgfId-5386489]Step 3 Specify how you want to schedule the CRL download, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5386490]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-5401964]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5401969]Step 4 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5386503]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5386504]Step 5 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5386505]You must have a valid email relay server configured on the ASA FirePOWER module to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5386509]Step 6 Click Save.
 
    [bookmark: pgfId-5386510]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472267]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5392436][bookmark: 13850][bookmark: 22283]Automating Applyin[bookmark: marker-5407212]g an Intrusion Policy
 
    [bookmark: pgfId-5392514]License: Protection
 
    [bookmark: pgfId-5498926]You can queue an intrusion policy apply to the ASA FirePOWER module. This task only applies the intrusion policy if an access control policy that references the intrusion policy is applied to the ASA FirePOWER module when the task runs. Otherwise, the task aborts before completion.
 
    [bookmark: pgfId-5419085]You must associate an intrusion policy with an access control policy and apply the access control policy to a device before scheduling this task; see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-5419030]To queue a policy apply:
 
    
 
    [bookmark: pgfId-5393070]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling.
 
    [bookmark: pgfId-5393113]The schedule calendar page for the current month appears.
 
    [bookmark: pgfId-5393180]Step 2 Click Add Task.
 
    [bookmark: pgfId-5393216]The New Task page appears.
 
    [bookmark: pgfId-5393552]Step 3 From the Job Type list, select Queue Intrusion Policy Apply.
 
    [bookmark: pgfId-5393543]The page reloads to show the options for queuing a policy apply. 
 
    [bookmark: pgfId-5393666]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5393667]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the ASA FirePOWER module.
 
      	 [bookmark: pgfId-5393671]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5393675]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5393596]Step 6 In the Intrusion Policy field, you have the following options:
 
     
      
      	 [bookmark: pgfId-5396809]Select an intrusion policy to apply to the ASA FirePOWER module. 
 
      	 [bookmark: pgfId-5396812]Select  All intrusion policies to apply all intrusion policies already applied to the ASA FirePOWER module.
 
     
 
    
 
    [bookmark: pgfId-5435872]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5393751]Tip The comment field appears in the Tasks Details section at the bottom of the schedule calendar page, so you should limit the size of your comment.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5393752]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5393753]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5393757]Step 9 Click Save.
 
    [bookmark: pgfId-5393758]The task is added. You can check the status of a running task in the Task Details section of the calendar page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5393762]Step 10 To edit your saved task, click the task anywhere it appears on the schedule calendar page.
 ). 
    
 
    [bookmark: pgfId-5472351]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5437511][bookmark: 55744]Automating Geolocation Database Updates
 
    [bookmark: pgfId-5505853]License: Any
 
    [bookmark: pgfId-5465443]You can use the scheduler to automate recurring geolocation database (GeoDB) updates. Recurring GeoDB updates run once every 7 days (weekly); you can configure the time the update recurs each week. For more information on GeoDB updates, see Updating the Geolocation Database.
 
    [bookmark: pgfId-5438076]To automate geolocation database updates:
 
    
 
    [bookmark: pgfId-5438180]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Updates.
 
    [bookmark: pgfId-5438205]The Product Updates page appears.
 
    [bookmark: pgfId-5438254]Step 2 Click the Geolocation Updates tab.
 
    [bookmark: pgfId-5438302]The Geolocation Updates page appears.
 
    [bookmark: pgfId-5438377]Step 3 Under Recurring Geolocation Updates, select the Enable Recurring Weekly Updates check box.
 
    [bookmark: pgfId-5438767]The Update Start Time field appears.
 
    [bookmark: pgfId-5438808]Step 4 In the Update Start Time field, specify the time and day of the week when you want weekly GeoDB updates to occur.
 
    [bookmark: pgfId-5439056]Step 5 Click Save.
 
    [bookmark: pgfId-5439071]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472390]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5375667][bookmark: 97453][bookmark: 75941]Automating Software[bookmark: marker-5003423] Updates
 
    [bookmark: pgfId-5368096]You can automatically download and apply most patches and feature releases to the ASA FirePOWER module.
 
     
      
    
 
    
 
    [bookmark: pgfId-5499087]Note You must manually upload and install updates in two situations. First, you cannot schedule major updates to the ASA FirePOWER module. Second, you cannot schedule updates for or pushes from appliances that cannot access the Support Site. For information on manually updating the ASA FirePOWER module, see Updating ASA FirePOWER Module Software.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4791571]If you want to have more control over this process, you can use the Once option to download and install updates during off-peak hours after you learn that an update has been released.
 
    [bookmark: pgfId-4779007]See the following sections for more information:
 
     
     	 [bookmark: pgfId-4779011]Automating Software Downloads
 
     	 [bookmark: pgfId-4779019]Automating Software Installs
 
    
 
     
      [bookmark: pgfId-4779074][bookmark: 86279]Automating Software[bookmark: marker-4846381] Downloads
 
     [bookmark: pgfId-5382242]You can create a scheduled task that automatically downloads the latest software updates from Cisco. You can use this task to schedule download of updates you plan to install manually.
 
     [bookmark: pgfId-5382247]To automate software update downloads:
 
     
 
     [bookmark: pgfId-5368138]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
     [bookmark: pgfId-4779081]The Scheduling page appears.
 
     [bookmark: pgfId-4779082]Step 2 Click Add Task.
 
     [bookmark: pgfId-4779083]The New Task page appears.
 
     [bookmark: pgfId-4779084]Step 3 From the Job Type list, select Download Latest Update.
 
     [bookmark: pgfId-4779085]The New Task page reloads to show the update options.
 
     [bookmark: pgfId-5403264]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-4779095]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-4779096]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-4779100]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-5368143]Step 6 In the Update Items section, select Software.
 
     [bookmark: pgfId-4779125]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-4779126]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4779127]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368156]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-4779132]Step 9 Click Save.
 
     [bookmark: pgfId-5379801]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472449]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4779203][bookmark: 73801][bookmark: 73560]Automating Software[bookmark: marker-4846383] Installs
 
      
       
     
 
     
 
      
      [bookmark: pgfId-5288718] 
      Caution Depending on the update being installed, the appliance may reboot after the software is installed. 
       
       
 
      
 
     
 
     [bookmark: pgfId-4779210]To schedule a software installation task:
 
     
 
     [bookmark: pgfId-5368216]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
     [bookmark: pgfId-4779212]The Scheduling page appears.
 
     [bookmark: pgfId-4779213]Step 2 Click Add Task.
 
     [bookmark: pgfId-4779214]The New Task page appears.
 
     [bookmark: pgfId-4779215]Step 3 From the Job Type list, select Install Latest Update.
 
     [bookmark: pgfId-4779216]The page reloads to show the options for installing updates.
 
     [bookmark: pgfId-4779225]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-4779226]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-4779227]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-4779231]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-4784881]Step 6 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-4779239]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4779240]Step 7 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368223]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-4779245]Step 8 Click Save.
 
     [bookmark: pgfId-5407511]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472490]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5376726][bookmark: 94523]Automating URL Filt[bookmark: marker-5407284]ering Updates
 
    [bookmark: pgfId-5376780]License: URL Filtering
 
    [bookmark: pgfId-5391761]You can use the scheduler to automate updates of URL filtering data from the Collective Security Intelligence Cloud. For a URL filtering update task to succeed:
 
     
     	 [bookmark: pgfId-5391876]The ASA FirePOWER module must have access to the Internet or it cannot contact the cloud.
 
     	 [bookmark: pgfId-5391904]You must enable URL filtering, as described in Enabling Cloud Communications. 
 
    
 
    [bookmark: pgfId-5391826]Note that when you enable URL filtering, you can also enable automatic updates. This forces the ASA FirePOWER module to contact the cloud every 30 minutes for URL filtering data updates. If you have enabled automatic updates, you should not create a scheduled task to update URL filtering data.
 
    [bookmark: pgfId-5405759]Although daily updates tend to be small, if it has been more than five days since your last update, new URL filtering data may take up to 20 minutes to download, depending on your bandwidth. Then, it may take up to 30 minutes to perform the update itself.
 
    [bookmark: pgfId-5391541]To automate URL filtering data tasks:
 
    
 
    [bookmark: pgfId-5391543]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
    [bookmark: pgfId-5391544]The Scheduling page appears.
 
    [bookmark: pgfId-5391545]Step 2 Click Add Task.
 
    [bookmark: pgfId-5391546]The New Task page appears.
 
    [bookmark: pgfId-5391547]Step 3 From the Job Type list, select Update URL Filtering Database.
 
    [bookmark: pgfId-5391548]The page reloads to show the URL filtering update options.
 
    [bookmark: pgfId-5391554]Step 4 Specify how you want to schedule the update, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5391555]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-5391556]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5391561]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5391567]Step 6 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5391568]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5391569]Step 7 Optionally, in the Email Status To field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5391570]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5391574]Step 8 Click Save.
 
    [bookmark: pgfId-5391575]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472640]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4925936][bookmark: 16954]Viewing[bookmark: marker-4925935] Tasks
 
    [bookmark: pgfId-1898938]After adding scheduled tasks, you can view them and evaluate their status. The View Options section of the page allows you to view scheduled tasks using a calendar and a list of scheduled tasks. 
 
    [bookmark: pgfId-1918633]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1918650]Using the Calendar
 
     	 [bookmark: pgfId-1918686]Using the Task List
 
    
 
     
      [bookmark: pgfId-1898804][bookmark: 54729]Using the[bookmark: marker-4846396] Calendar
 
     [bookmark: pgfId-1899104]The Calendar view option allows you to view which scheduled tasks occur on which day.
 
     [bookmark: pgfId-1899137]To view scheduled tasks using the calendar:
 
     
 
     [bookmark: pgfId-5368939]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
     [bookmark: pgfId-4488722]The Scheduling page appears.
 
     [bookmark: pgfId-5041742]Step 2 You can perform the following tasks using the calendar view:
 
      
       
       	 [bookmark: pgfId-5041744]Click the double left arrow icon (
 
      
 
      [image: ] ) to move back one year. 
     
 
      
       
       	 [bookmark: pgfId-5397911]Click the single left arrow icon (
 
      
 
      [image: ] ) to move back one month. 
     
 
      
       
       	 [bookmark: pgfId-5397915]Click the single right arrow icon (
 
      
 
      [image: ] ) to move forward one month. 
     
 
      
       
       	 [bookmark: pgfId-5397918]Click the double right arrow icon (
 
      
 
      [image: ] ) to move forward one year. 
     
 
      
       
       	 [bookmark: pgfId-5041764]Click  Today to return to the current month and year.
 
       	 [bookmark: pgfId-5048165]Click  Add Task to schedule a new task.
 
       	 [bookmark: pgfId-1918548]Click a date to view all scheduled tasks for the specific date in a task list table below the calendar.
 
       	 [bookmark: pgfId-1918552]Click a specific task on a date to view the task in a task list table below the calendar.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1918572]Note For more information about using the task list, see Using the Task List.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5472655]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1898850][bookmark: 96273]Using the[bookmark: marker-4846397] Task List
 
      
       
        
        [bookmark: pgfId-1899406]Table 33-1 Task List Columns 
 
        
        
         
         	 
           
           [bookmark: pgfId-1899410]Column 
          
  
         	 
           
           [bookmark: pgfId-1899412]Description 
          
  
        
 
         
         	[bookmark: pgfId-1899414]Name
  
         	[bookmark: pgfId-1899416]Displays the name of the scheduled task and the comment associated with it.
  
        
 
         
         	[bookmark: pgfId-1899418]Type
  
         	[bookmark: pgfId-1899420]Displays the type of scheduled task.
  
        
 
         
         	[bookmark: pgfId-1899422]Start Time
  
         	[bookmark: pgfId-1899424]Displays the scheduled start date and time.
  
        
 
         
         	[bookmark: pgfId-1899426]Frequency
  
         	[bookmark: pgfId-1899428]Displays how often the task is run.
  
        
 
         
         	[bookmark: pgfId-1899434]Status
  
         	[bookmark: pgfId-2108567]Describes the current status for a scheduled task: 
 
           
           	 [bookmark: pgfId-2108568]A check mark icon (
 
           [image: ] ) indicates that the task ran successfully. 
          
 
           
           	 [bookmark: pgfId-2108563]A question mark icon (
 
           [image: ] ) indicates that the task is in an unknown state. 
          
 
           
           	 [bookmark: pgfId-4655992]An exclamation mark icon (
 
           [image: ] ) indicates that the task failed. 
          
  
        
 
         
         	[bookmark: pgfId-1899438]Creator
  
         	[bookmark: pgfId-1899440]Displays the name of the user that created the scheduled task.
  
        
 
         
         	[bookmark: pgfId-5390977]Edit
  
         	[bookmark: pgfId-5390979]Edits the scheduled task.
  
        
 
         
         	[bookmark: pgfId-1899442]Delete
  
         	[bookmark: pgfId-1899444]Deletes the scheduled task.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4656016][bookmark: 49458]Editing Scheduled [bookmark: marker-4925617]Tasks
 
    [bookmark: pgfId-4925606]You can edit a scheduled task that you previously created. This feature is especially useful if you want to test a scheduled task once to make sure that the parameters are correct. Later, after the task completes successfully, you can change it to a recurring task.
 
    [bookmark: pgfId-4925477]To edit an existing scheduled task:
 
    
 
    [bookmark: pgfId-5368979]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-4925479]The Scheduling page appears.
 
    [bookmark: pgfId-4925480]Step 2 Click either the task that you want to edit or the day on which the task appears. 
 
    [bookmark: pgfId-4925481]The Task Details table containing the selected task or tasks appears.
 ) 
    
 
    [bookmark: pgfId-4925483]The Edit Task page appears, showing the details of the task you selected.
 
    [bookmark: pgfId-4925555]Step 4 Edit the task to meet your needs, including the start time, the job name, the comment, and how often the task runs, once or recurring. You cannot change the type of job.
 
    [bookmark: pgfId-4951420]The remaining options are determined by the task you are editing. See the following sections for more information:
 
     
      
      	 [bookmark: pgfId-5384473]Automating Backup Jobs
 
      	 [bookmark: pgfId-5384477]Automating Certificate Revocation List Downloads
 
      	 [bookmark: pgfId-5384493]Automating Software Updates
 
      	 [bookmark: pgfId-5384501]Automating URL Filtering Updates
 
     
 
    
 
    [bookmark: pgfId-4925583]Step 5 Click Save to save your edits.
 
    [bookmark: pgfId-4925590]Your change are saved and the Scheduling page appears again.
 
    [bookmark: pgfId-5472669]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4925447][bookmark: 49144]Deleting Scheduled[bookmark: marker-4846398] Tasks
 
    [bookmark: pgfId-1918190]There are two types of deletions you can perform from the Schedule View page. You can delete a specific one-time task that has not yet run or you can delete every instance of a recurring task. If you delete an instance of a recurring task, all instances of the task are deleted. If you delete a task that is scheduled to run once, only that task is deleted.
 
    [bookmark: pgfId-2109444]The following sections describe how to delete tasks:
 
     
     	 [bookmark: pgfId-2109461]To delete all instances of a task, see Deleting a Recurring Task.
 
     	 [bookmark: pgfId-2109489]To delete a single instance of a task, see Deleting a One-Time Task.
 
    
 
     
      [bookmark: pgfId-2109502][bookmark: 75002]Deleting a Recurring Task
 
     [bookmark: pgfId-2109590]When you delete one instance of a recurring task, you automatically delete all instances of that task.
 
     [bookmark: pgfId-1918238]To delete a recurring task:
 
     
 
     [bookmark: pgfId-5499231]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
     [bookmark: pgfId-5499232]The Scheduling page appears.
 
     [bookmark: pgfId-1918262]Step 2 On the calendar, select an instance of the recurring task you want to delete.
 
     [bookmark: pgfId-1918266]The page reloads to display a table of tasks below the calendar.
 ). 
     
 
     [bookmark: pgfId-1918295]All instances of the recurring task are deleted.
 
     [bookmark: pgfId-5472683]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1918316][bookmark: 58447]Deleting a One-Time Task
 
     [bookmark: pgfId-2109562]You can delete a one-time scheduled task or delete the record of a previously run scheduled task using the task list.
 
     [bookmark: pgfId-2109599]To delete a single task or, if it has already run, delete a task record:
 
     
 
     [bookmark: pgfId-5369057]Step 1 Select In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Scheduling. 
 
     [bookmark: pgfId-4488741]The Scheduling page appears.
 
     [bookmark: pgfId-1918397]Step 2 Click the task that you want to delete or the day on which the task appears. 
 
     [bookmark: pgfId-4558198]A table containing the selected task or tasks appears.
 ). 
     
 
     [bookmark: pgfId-1918466]The instance of the task you selected is deleted.
 
     [bookmark: pgfId-5472692]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2514234]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7820487][bookmark: 78653]Managing Syste[bookmark: marker-7820486]m Policies 
      
      
 
     
 
 
    [bookmark: pgfId-8230468]A system policy allows you to manage the following on your ASA FirePOWER module:
 
     
     	 [bookmark: pgfId-8230457]audit log settings
 
     	 [bookmark: pgfId-8275726]the mail relay host and notification address
 
     	 [bookmark: pgfId-8275728]SNMP polling settings
 
     	 [bookmark: pgfId-8275730]STIG compliance
 
    
 
    [bookmark: pgfId-8144845]See the following sections for more information:
 
     
     	 [bookmark: pgfId-8144849]Creating a System Policy
 
     	 [bookmark: pgfId-7820548]Editing a System Policy
 
     	 [bookmark: pgfId-7820552]Applying a System Policy
 
     	 [bookmark: pgfId-7820556]Deleting System Policies
 
    
 
   
 
    
     [bookmark: pgfId-7967083][bookmark: 99111]Creating a System [bookmark: marker-7967082]Policy
 
    [bookmark: pgfId-8075095]License: Any
 
    [bookmark: pgfId-7820579]When you create a system policy, you assign it a name and a description. Next, you configure the various aspects of the policy, each of which is described in its own section. 
 
    [bookmark: pgfId-7876165]Instead of creating a new policy, you can export a system policy from another ASA FirePOWER module and then import it onto your ASA FirePOWER module. You can then edit the imported policy to suit your needs before you apply it. For more information, see Importing and Exporting Configurations.
 
    [bookmark: pgfId-8232826]To create a system policy:
 
    
 
    [bookmark: pgfId-8268481]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
    [bookmark: pgfId-8268482]The System Policy page appears.
 
    [bookmark: pgfId-7820589]Step 2 Click Create Policy.
 
    [bookmark: pgfId-7820590]The Create Policy page appears.
 
    [bookmark: pgfId-7820595]Step 3 From the drop-down list, select an existing policy to use as a template for your new system policy.
 
    [bookmark: pgfId-8051591]Step 4 Type a name for your new policy in the New Policy Name field.
 
    [bookmark: pgfId-8051612]Step 5 Type a description for your new policy in the New Policy Description field.
 
    [bookmark: pgfId-8051593]Step 6 Click Create.
 
    [bookmark: pgfId-7820598]Your system policy is saved and the Edit System Policy page appears. For information about configuring each aspect of the system policy, see one of the following sections:
 
     
      
      	 [bookmark: pgfId-7820606]Configuring Audit Log Settings
 
      	 [bookmark: pgfId-7820630]Configuring a Mail Relay Host and Notification Address
 
      	 [bookmark: pgfId-7994301]Configuring SNMP Polling
 
      	 [bookmark: pgfId-7820654]Enabling STIG Compliance
 
     
 
    
 
    [bookmark: pgfId-8195329]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7820678][bookmark: 86555]Editing a System Pol[bookmark: marker-7820677]icy
 
    [bookmark: pgfId-8075158]License: Any
 
    [bookmark: pgfId-7820681]You can edit an existing system policy. If you edit a system policy that is currently applied to an ASA FirePOWER module, reapply the policy after you have saved your changes. For more information, see Applying a System Policy.
 
    [bookmark: pgfId-8233246]To edit an existing system policy:
 
    
 
    [bookmark: pgfId-8233251]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
    [bookmark: pgfId-8233252]The System Policy page appears, including a list of the existing system policies.
 ) next to the system policy that you want to edit. 
    
 
    [bookmark: pgfId-7820690]The Edit Policy page appears. You can change the policy name and policy description. For information about configuring each aspect of the system policy, see one of the following sections:
 
     
      
      	 [bookmark: pgfId-7820698]Configuring Audit Log Settings
 
      	 [bookmark: pgfId-7820722]Configuring a Mail Relay Host and Notification Address
 
      	 [bookmark: pgfId-7994314]Configuring SNMP Polling
 
      	 [bookmark: pgfId-7820746]Enabling STIG Compliance
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7820755]Note If you are editing a system policy applied to an ASA FirePOWER module, make sure you reapply the updated policy when you are finished. See Applying a System Policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8051864]Step 3 Click Save Policy and Exit to save your changes. The changes are saved, and the System Policy page appears.
 
    [bookmark: pgfId-8195340]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8052860][bookmark: 80463]Applying a System P[bookmark: marker-8052859]olicy
 
    [bookmark: pgfId-8144720]License: Any
 
    [bookmark: pgfId-8234295]You can apply a system policy to an ASA FirePOWER module. If a system policy is already applied, any changes you make do not take effect until you reapply it.
 
    [bookmark: pgfId-8234300]To apply a system policy:
 
    
 
    [bookmark: pgfId-8036164]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
    [bookmark: pgfId-7820776]The System Policy page appears.
 ) next to the system policy that you want to apply. 
    
 
    [bookmark: pgfId-7820795]Step 3 Click Apply.
 
    [bookmark: pgfId-7820796]The System Policy page appears. A message indicates the status of applying the system policy.
 
    [bookmark: pgfId-8195356]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7820811][bookmark: 78405]Deleting System Polic[bookmark: marker-7820810]ies
 
    [bookmark: pgfId-7962906]License: Any
 
    [bookmark: pgfId-7820813]You can delete a system policy, even if it is in use. If the policy is still in use, it is used until a new policy is applied. Default system policies cannot be deleted.
 
    [bookmark: pgfId-7820814]To delete a system policy:
 
    
 
    [bookmark: pgfId-8036218]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
    [bookmark: pgfId-7820817]The System Policy page appears.
 
    
 
    [bookmark: pgfId-8066476]The System Policy page appears. A pop-up message appears, confirming the policy deletion.
 
    [bookmark: pgfId-8195400]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7891831]Configuring a System Policy
 
    [bookmark: pgfId-7962913]License: Any
 
    [bookmark: pgfId-7891870]You can configure various system policy settings. For information about configuring each aspect of the system policy, see one of the following sections:
 
     
      
      	 [bookmark: pgfId-8271474]Configuring the Access List for Your Appliance
 
      	 [bookmark: pgfId-7891878]Configuring Audit Log Settings
 
      	 [bookmark: pgfId-7891902]Configuring a Mail Relay Host and Notification Address
 
      	 [bookmark: pgfId-7891914]Configuring SNMP Polling
 
      	 [bookmark: pgfId-7891930]Enabling STIG Compliance
 
     
 
    
 
     
      [bookmark: pgfId-8271581][bookmark: 37585][bookmark: 84330]Configuring the [bookmark: marker-8271579]Access List for Your Appliance
 
     [bookmark: pgfId-8271585]License: Any
 
     [bookmark: pgfId-8271587]The Access List page allows you to control which computers can access your appliance on specific ports. By default, port 443 (Hypertext Transfer Protocol Secure, or HTTPS), which is used to access the web interface, and port 22 (Secure Shell, or SSH), which is used to access the command line, are enabled for any IP address. You can also add SNMP access over port 161. Note that you must add SNMP access for any computer you plan to use to poll for SNMP information. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8271588] 
      Caution By default, access to the appliance is 
      not restricted. To operate the appliance in a more secure environment, consider adding access to the appliance for specific IP addresses and then deleting the default 
      any option. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8271589]The access list is part of the system policy. You can specify the access list either by creating a new system policy or by editing an existing system policy. In either case, the access list does not take effect until you apply the system policy.
 
     [bookmark: pgfId-8271590]Note that this access list does not also control external database access. For more information on the external database access list, see Enabling Cloud Communications.
 
     [bookmark: pgfId-8271594]To configure the access list:
 
     [bookmark: pgfId-8271598]Access: Admin
 
     
 
     [bookmark: pgfId-8273160]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
     [bookmark: pgfId-8271600]The System Policy page appears.
 
     [bookmark: pgfId-8271601]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8271605]To modify the access list in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-8271606]To configure the access list as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-8271609]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8271611]In either case, the Access List page appears.
 ). 
     
 
     [bookmark: pgfId-8271616]The setting is removed.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8271617] 
      Caution If you delete access for the IP address that you are currently using to connect to the appliance interface, and there is no entry for “ 
      IP=any port=443”, you will lose access to the system when you apply the policy. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8271618]Step 4 Optionally, to add access for one or more IP addresses, click Add Rules.
 
     [bookmark: pgfId-8271619]The Add IP Address page appears.
 
     [bookmark: pgfId-8271620]Step 5 In the IP Address field, you have the following options, depending on the IP addresses you want to add: 
 
      
       
       	 [bookmark: pgfId-8271621]an exact IP address (for example, 192.168.1.101)
 
       	 [bookmark: pgfId-8271622]an IP address block using CIDR notation (for example, 192.168.1.1/24)
 
      
 
     
 
     [bookmark: pgfId-8271629]For information on using CIDR in the FireSIGHT System, see IP Address Conventions.
 
      
       
       	 [bookmark: pgfId-8271630] any , to designate any IP address
 
      
 
     
 
     [bookmark: pgfId-8271631]Step 6 Select SSH, HTTPS, SNMP, or a combination of these options to specify which ports you want to enable for these IP addresses.
 
     [bookmark: pgfId-8271632]Step 7 Click Add.
 
     [bookmark: pgfId-8271633]The Access List page appears again, reflecting the changes you made. 
 
     [bookmark: pgfId-8271634]Step 8 Click Save Policy and Exit.
 
     [bookmark: pgfId-8271635]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8271639]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7820940][bookmark: 68211]Configuring A[bookmark: marker-7891172]udit Log Settings
 
     [bookmark: pgfId-7963032]License: Any
 
     [bookmark: pgfId-8239432]You can configure the system policy so that the ASA FirePOWER module streams an audit log to an external host.
 
      
       
     
 
     
 
     [bookmark: pgfId-8239433]Note You must ensure that the external host is functional and accessible from the ASA FirePOWER module sending the audit log.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7820945]The sending host name is part of the information sent. You can further identify the audit log stream with a facility, a severity, and an optional tag. The ASA FirePOWER module does not send the audit log until you apply the system policy.
 
     [bookmark: pgfId-8072839]After you apply a policy with this feature enabled, and your destination host is configured to accept the audit log, the syslog messages are sent. The following is an example of the output structure:
 
     [bookmark: pgfId-8072840]Date Time Host [Tag] Sender: [User_Name]@[User_IP], [Subsystem], [Action]
 
     [bookmark: pgfId-8072841]where the local date, time, and hostname precede the bracketed optional tag, and the sending device name precedes the audit log message. 
 
     [bookmark: pgfId-8072842]For example:
 
     [bookmark: pgfId-8072843]Mar 01 14:45:24 localhost [TAG] Dev-DC3000: admin@10.1.1.2, Operations > Monitoring, Page View
 
     [bookmark: pgfId-7820946]To configure the audit log settings:
 
     
 
     [bookmark: pgfId-8036251]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
     [bookmark: pgfId-7820949]The System Policy page appears.
 
     [bookmark: pgfId-7820950]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7820951]To modify the audit log settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7820952]To configure the audit log settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7820953]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7820958]Step 3 Click Audit Log Settings.
 
     [bookmark: pgfId-8126571]The Audit Log Settings page appears.
 
     [bookmark: pgfId-8126573]Step 4 Select Enabled from the Send Audit Log to Syslog drop-down menu. (The default setting is Disabled.)
 
     [bookmark: pgfId-7820961]Step 5 Designate the destination host for the audit information by using the IP address or the fully qualified name of the host in the Host field. The default port (514) is used. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8056118] 
      Caution If the computer you configure to receive an audit log is not set up to accept remote messages, the host will not accept the audit log. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8056119]Step 6 Select a syslog facility from the Facility field.
 
     [bookmark: pgfId-8056120]Step 7 Select a severity from the Severity field. 
 
     [bookmark: pgfId-7820965]Step 8 Optionally, insert a reference tag in the Tag (optional) field.
 
     [bookmark: pgfId-8126649]Step 9 To send regular audit log updates to an external HTTP server, select Enabled from the Send Audit Log to HTTP Server drop-down list. The default setting is Disabled.
 
     [bookmark: pgfId-8126887]Step 10 In the URL to Post Audit field, designate the URL where you want to send audit information. You must enter an URL that corresponds to a listener program that expects the HTTP POST variables as listed:
 
      
       
       	 [bookmark: pgfId-8127494] subsystem 
 
       	 [bookmark: pgfId-8127538] actor 
 
       	 [bookmark: pgfId-8127545] event_type 
 
       	 [bookmark: pgfId-8127562] message 
 
       	 [bookmark: pgfId-8127571] action_source_ip 
 
       	 [bookmark: pgfId-8127589] action_destination_ip 
 
       	 [bookmark: pgfId-8127612] result 
 
       	 [bookmark: pgfId-8127621] time 
 
       	 [bookmark: pgfId-8127630] tag (if defined, as above)
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8127128] 
      Caution To allow encrypted posts, you must use an HTTPS URL. Note that sending audit information to an external URL may affect system performance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7820966]Step 11 Click Save Policy and Exit.
 
     [bookmark: pgfId-8167784]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information. 
 
     [bookmark: pgfId-8195629]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7821834][bookmark: 73416][bookmark: 50482]Configuring a Mail Relay Host and[bookmark: marker-7821833] Notification Address
 
     [bookmark: pgfId-7968027]License: Any
 
     [bookmark: pgfId-7821837]You must configure a mail host if you plan to:
 
      
      	 [bookmark: pgfId-7821838]email event-based reports
 
      	 [bookmark: pgfId-7821839]email status reports for scheduled tasks
 
      	 [bookmark: pgfId-8023323]email change reconciliation reports
 
      	 [bookmark: pgfId-7821843]email data pruning notifications
 
     
 
     [bookmark: pgfId-8149358]You can select an encryption method for the communication between appliance and mail relay host, and can supply authentication credentials for the mail server if needed. After configuring settings, you can test the connection between the appliance and the mail server using the supplied settings.
 
     [bookmark: pgfId-7949458]To configure a mail relay host:
 
     
 
     [bookmark: pgfId-8036357]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
     [bookmark: pgfId-7821865]The System Policy page appears.
 
     [bookmark: pgfId-7821866]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7821867]To modify the email settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821868]To configure the email settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7821869]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7821874]Step 3 Click Email Notification.
 
     [bookmark: pgfId-7821875]The Configure Email Notification page appears.
 
     [bookmark: pgfId-7948272]Step 4 In the Mail Relay Host field, type the hostname or IP address of the mail server you want to use. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7821881]Note The mail host you enter must allow access from the appliance.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7994508]Step 5 Enter the port number to use on the email server in the Port Number field. Typical ports include 25, when using no encryption, 465, when using SSLv3, and 587, when using TLS. 
 
     [bookmark: pgfId-7994509]Step 6 To select an encryption method, you have the following options:
 
      
       
       	 [bookmark: pgfId-7994510]To encrypt communications between the appliance and the mail server using Transport Layer Security, select  TLS from the  Encryption Method drop-down list.
 
       	 [bookmark: pgfId-7994511]To encrypt communications between the appliance and the mail server using Secure Socket Layers, select  SSLv3 from the  Encryption Method drop-down list.
 
       	 [bookmark: pgfId-8057402]To allow unencrypted communication between the appliance and the mail server, select  None  from the  Encryption Method drop-down list.
 
      
 
     
 
     [bookmark: pgfId-8057425]Note that certificate validation is not required for encrypted communication between the appliance and mail server. 
 
     [bookmark: pgfId-7994514]Step 7 Enter a valid email address in the From Address field for use as the source email address for messages sent by the appliance. 
 
     [bookmark: pgfId-7994515]Step 8 Optionally, to supply a user name and password when connecting to the mail server, select Use Authentication. Enter a user name in the Username field. Enter a password in the Password field.
 
     [bookmark: pgfId-7994516]Step 9 To send a test email using the configured mail server, click Test Mail Server Settings. 
 
     [bookmark: pgfId-7994517]A message appears next to the button indicating the success or failure of the test.
 
     [bookmark: pgfId-7949495]Step 10 Click Save Policy and Exit.
 
     [bookmark: pgfId-8219610]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8219614]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7994800][bookmark: 29722]Config[bookmark: marker-7996113]uring SNMP Polling
 
     [bookmark: pgfId-8048808]License: Any
 
     [bookmark: pgfId-8048810]You can enable Simple Network Management Protocol (SNMP) polling of an appliance using the system policy. The SNMP feature supports use of versions 1, 2, and 3 of the SNMP protocol.
 
     [bookmark: pgfId-8048413]Note that enabling the system policy SNMP feature does not cause the appliance to send SNMP traps; it only makes the information in the MIBs available for polling by your network management system.
 
      
       
     
 
     
 
     [bookmark: pgfId-7994814]Note Y[bookmark: marker-8071663]ou must add SNMP access for any computer you plan to use to poll the appliance. For more information, see Configuring the Access List for Your Appliance. Note that the SNMP MIB contains information that could be used to attack your appliance. Cisco recommends that you restrict your access list for SNMP access to the specific hosts that will be used to poll for the MIB. Cisco also recommends you use SNMPv3 and use strong passwords for network management access.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7994818]To configure SNMP polling:
 
     
 
     [bookmark: pgfId-8036460]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
     [bookmark: pgfId-7994821]The System Policy page appears.
 
     [bookmark: pgfId-7994822]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7994823]To modify the SNMP polling settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7994824]To configure the SNMP polling settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7994827]Provide a name and description for the system policy as described in Creating a System Policy, and click Create.
 
     [bookmark: pgfId-7994830]Step 3 If you have not already added SNMP access for each computer you plan to use to poll the appliance, do so now. For more information, see Configuring the Access List for Your Appliance.
 
     [bookmark: pgfId-7994834]Step 4 Click SNMP.
 
     [bookmark: pgfId-7994835]The SNMP page appears.
 
     [bookmark: pgfId-8048036]Step 5 From the SNMP Version drop-down list, select the SNMP version you want to use.
 
     [bookmark: pgfId-8048059]The drop-down list displays the version you selected.
 
     [bookmark: pgfId-8048082]Step 6 [bookmark: 75965]You have the following options:
 
      
       
       	 [bookmark: pgfId-8048083]If you selected  Version 1 or  Version 2 , type the SNMP community name in the  Community String field. Go to step  15 .
 
       	 [bookmark: pgfId-8062681]If you selected  Version 3 , click  Add User to display the user definition page.
 
      
 
     
 
     [bookmark: pgfId-8048198]Step 7 Enter a username in the Username field.
 
     [bookmark: pgfId-8062754]Step 8 Select the protocol you want to use for authentication from the Authentication Protocol drop-down list.
 
     [bookmark: pgfId-8048367]Step 9 Type the password required for authentication with the SNMP server in the Authentication Password field. 
 
     [bookmark: pgfId-8062975]Step 10 Retype the authentication password in the Verify Password field just below the Authentication Password field.
 
     [bookmark: pgfId-8048368]Step 11 Select the privacy protocol you want to use from the Privacy Protocol list, or select None to not use a privacy protocol.
 
     [bookmark: pgfId-8063190]Step 12 Type the SNMP privacy key required by the SNMP server in the Privacy Password field.
 
     [bookmark: pgfId-8063204]Step 13 [bookmark: 29082]Retype the privacy password in the Verify Password field just below the Privacy Password field.
 
     [bookmark: pgfId-8063192]Step 14 [bookmark: 88438]Click Add.
 ) to delete a user. 
     
 
     [bookmark: pgfId-7994860]Step 15 [bookmark: 69031]Click Save Policy and Exit.
 
     [bookmark: pgfId-7994861]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195872]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8145056][bookmark: 67083]Enabling STIG Compli[bookmark: marker-8153881]ance
 
     [bookmark: pgfId-8145104]License: Any
 
     [bookmark: pgfId-8145131]O[bookmark: marker-8152221]rganizations within the United States federal government sometimes need to comply with a series of security checklists set out in Security Technical Implementation Guides (STIGs). The STIG Compliance option enables settings intended to support compliance with specific requirements set out by the United States Department of Defense. 
 
     [bookmark: pgfId-8150083]If you enable STIG compliance on any ASA FirePOWER module in your deployment, you must enable it on all ASA FirePOWER modules.
 
     [bookmark: pgfId-8146067]Enabling STIG compliance does not guarantee strict compliance to all applicable STIGs. 
 
     [bookmark: pgfId-8146534]When you enable STIG compliance, password complexity and retention rules for local shell access accounts change. In addition, you cannot use ssh remote storage when in STIG compliance mode. 
 
     [bookmark: pgfId-8150419]Note that applying a system policy with STIG compliance enabled forces appliances to reboot. If you apply a system policy with STIG enabled to an appliance that already has STIG enabled, the appliance does not reboot. If you apply a system policy with STIG disabled to an appliance that has STIG enabled, STIG remains enabled and the appliance does not reboot.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8146308] 
      Caution You cannot disable this setting without assistance from Support. In addition, this setting may substantially impact the performance of your system. Cisco does not recommend enabling STIG compliance except to comply with Department of Defense security requirements. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8146358]To enable STIG compliance:
 
     
 
     [bookmark: pgfId-8146360]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > System Policy.
 
     [bookmark: pgfId-8146361]The System Policy page appears.
 
     [bookmark: pgfId-8146362]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8146363]To modify the time settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-8146367]To configure the time settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-8146368]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8146373]Step 3 Click STIG Compliance.
 
     [bookmark: pgfId-8146374]The STIG Compliance page appears.
 
     [bookmark: pgfId-8146382]Step 4 If you want to permanently enable STIG compliance on the appliance, select Enable STIG Compliance.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8147322] 
      Caution You cannot disable STIG compliance on an appliance after you apply a policy with STIG compliance enabled. If you need to disable compliance, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8150699]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-8150700]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8150740]When you apply a system policy that enables STIG compliance to an appliance, note that the appliance reboots. Note that if you apply a system policy with STIG enabled to an appliance that already has STIG enabled, the appliance does not reboot. 
 
     [bookmark: pgfId-8195887]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8277017][bookmark: 78649]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-8671370][bookmark: 75906]Configuring ASA FirePOWER Module [bookmark: marker-8671368][bookmark: marker-8671369]Settings 
      
      
 
     
 
 
     
      
       
       [bookmark: pgfId-8431984]Table 35-1 [bookmark: 51785]Local Configuration Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-8431990]Option 
         
  
        	 
          
          [bookmark: pgfId-8431992]Description 
         
  
        	 
          
          [bookmark: pgfId-8431994]For more information, see... 
         
  
       
 
        
        	[bookmark: pgfId-8431996]Information
  
        	[bookmark: pgfId-8431998]Allows you to view current information about the appliance. You can also change the appliance name. 
  
        	[bookmark: pgfId-8432002]Viewing and Modifying the Appliance Information
  
       
 
        
        	[bookmark: pgfId-8432114]Cloud Services
  
        	[bookmark: pgfId-8432116]Allows you to download URL filtering data from the Collective Security Intelligence Cloud, perform lookups for uncategorized URLs, and send diagnostic information on detected files to Cisco.
  
        	[bookmark: pgfId-8432120]Enabling Cloud Communications
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-8432585][bookmark: 69128]Viewing and Modifying the[bookmark: marker-8432584] Appliance Information
 
    [bookmark: pgfId-8533662]License: Any
 
    [bookmark: pgfId-8533663]The Information page provides you with information about your ASA FirePOWER module. The information includes read-only information, such as the product name and model number, the operating system and version, and the current system policy. The page also provides you with an option to change the name of the appliance.
 
    [bookmark: pgfId-6413442]The following table describes each field.
 
    [bookmark: pgfId-6413515]
 
     
      
       
       [bookmark: pgfId-8648700]Table 35-2 [bookmark: 64505]Appliance Information 
 
       
       
        
        	 
          
          [bookmark: pgfId-8648704]Field 
         
  
        	 
          
          [bookmark: pgfId-8648706]Description 
         
  
       
 
        
        	[bookmark: pgfId-8648708]Name
  
        	[bookmark: pgfId-8648710]A name you assign to the appliance. Note that this name is only used within the context of the ASA FirePOWER module. Although you can use the hostname as the name of the appliance, entering a different name in this field does not change the hostname.
  
       
 
        
        	[bookmark: pgfId-8648715]Product Model
  
        	[bookmark: pgfId-8648717]The model name for the appliance.
  
       
 
        
        	[bookmark: pgfId-8672466]Serial Number
  
        	[bookmark: pgfId-8672468]The chassis serial number of the appliance.
  
       
 
        
        	[bookmark: pgfId-8648719]Software Version
  
        	[bookmark: pgfId-8648721]The version of the software currently installed.
  
       
 
        
        	[bookmark: pgfId-8648747]Operating System
  
        	[bookmark: pgfId-8648749]The operating system currently running on the appliance.
  
       
 
        
        	[bookmark: pgfId-8648751]Operating System Version
  
        	[bookmark: pgfId-8648753]The version of the operating system currently running on the appliance.
  
       
 
        
        	[bookmark: pgfId-8648763]IPv4 Address
  
        	[bookmark: pgfId-8648765]The IPv4 address of the default (eth0) management interface of the appliance. If IPv4 management is disabled for the appliance, this field indicates that.
  
       
 
        
        	[bookmark: pgfId-8648767]IPv6 Address
  
        	[bookmark: pgfId-8648769]The IPv6 address of the default (eth0) management interface of the appliance. If IPv6 management is disabled for the appliance, this field indicates that.
  
       
 
        
        	[bookmark: pgfId-8648771]Current Policies
  
        	[bookmark: pgfId-8648773]The appliance-level policies currently applied. If a policy has been updated since it was last applied, the name of the policy appears in italics.
  
       
 
        
        	[bookmark: pgfId-8648775]Model Number
  
        	[bookmark: pgfId-8648777]The model number for the appliance. This number may be important for troubleshooting.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8672713]To modify the appliance information:
 
    
 
    [bookmark: pgfId-8672716]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > Configuration.
 
    [bookmark: pgfId-8672717]The Information page appears.
 
    [bookmark: pgfId-6801162]Step 2 To change the appliance name, type a new name in the Name field.
 
    [bookmark: pgfId-4778991]The name must be alphanumeric characters and cannot be composed of numeric characters only.
 
    [bookmark: pgfId-4779267]Step 3 To save your changes, click Save.
 
    [bookmark: pgfId-8348847]The page refreshes and your changes are saved.
 
    [bookmark: pgfId-8751195]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8428235][bookmark: 27938]Enabling Clo[bookmark: marker-8455524]ud Communications
 
    [bookmark: pgfId-8429079]License: URL Filtering or Malware
 
    [bookmark: pgfId-8429081]The ASA FirePOWER module contacts Cisco’s Collective Security Intelligence Cloud to obtain various types of information:
 
     
     	 [bookmark: pgfId-8435295]File policies associated with access control rules allow devices to detect files transmitted in network traffic. The ASA FirePOWER module uses data from the Cisco cloud to determine if the files represent malware; see Understanding and Creating File Policies.
 
     	 [bookmark: pgfId-8435444]When you enable URL filtering, the ASA FirePOWER module can retrieve category and reputation data for many commonly visited URLs, as well as perform lookups for uncategorized URLs. You can then quickly create URL conditions for access control rules; see Performing Reputation-Based URL Blocking.
 
    
 
    [bookmark: pgfId-8567932]Use the ASA FirePOWER module’s local configuration to specify the following options:
 
    [bookmark: pgfId-8465638]Enable URL Filtering
 
    [bookmark: pgfId-8465793]You must enable this option to perform category and reputation-based URL filtering.
 
    [bookmark: pgfId-8465794]Query Cloud for Unknown URL
 
    [bookmark: pgfId-8436664]Allows the system to query the cloud when someone on your monitored network attempts to browse to a URL that is not in the local data set.
 
    [bookmark: pgfId-8436665]If the cloud does not know the category or reputation of a URL, or if the ASA FirePOWER module cannot contact the cloud, the URL does not match access control rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
 
    [bookmark: pgfId-8436669]Disable this option if you do not want your uncategorized URLs to be cataloged by the Cisco cloud, for example, for privacy reasons.
 
    [bookmark: pgfId-8436670]Enable Automatic Updates
 
    [bookmark: pgfId-8686980]Allows the system to contact the cloud on a regular basis to obtain updates to the URL data in your appliances’ local data sets. Although the cloud typically updates its data once per day, enabling automatic updates forces the ASA FirePOWER module to check every 30 minutes to make sure that you always have up-to-date information. 
 
    [bookmark: pgfId-8436675]Although daily updates tend to be small, if it has been more than five days since your last update, new URL filtering data may take up to 20 minutes to download, depending on your bandwidth. Then, it may take up to 30 minutes to perform the update itself.
 
    [bookmark: pgfId-8436676]If you want to have strict control of when the system contacts the cloud, you can disable automatic updates and use the scheduler instead, as described in Automating URL Filtering Updates. 
 
     
      
    
 
    
 
    [bookmark: pgfId-8436683]Note Cisco recommends that you either enable automatic updates or use the scheduler to schedule updates. Although you can manually perform on-demand updates, allowing the system to automatically contact the cloud on a regular basis provides you with the most up-to-date, relevant URL data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8374929]Licen[bookmark: licensing]sing
 
    [bookmark: pgfId-8441204]Performing category and reputation-based URL filtering and device-based malware detection require that you enable the appropriate licenses on your ASA FirePOWER module; see Licensing the ASA FirePOWER Module.
 
    [bookmark: pgfId-8441934]You cannot configure cloud connection options if you have no URL Filtering license on the ASA FirePOWER module. The Cloud Services local configuration page displays only the options for which you are licensed. ASA FirePOWER modules with expired licenses cannot contact the cloud.
 
    [bookmark: pgfId-8676641]Note that, in addition to causing the URL Filtering configuration options to appear, adding a URL Filtering license to your ASA FirePOWER module automatically enables Enable URL Filtering and Enable Automatic Updates. You can manually disable the options if needed.
 
    [bookmark: pgfId-8676656]Internet Access
 
    [bookmark: pgfId-8676660]The system uses ports 80/HTTP and 443/HTTPS to contact the Cisco cloud.
 
    [bookmark: pgfId-8428344]The following procedures explain how to enable communications the Cisco cloud, and how to perform an on-demand update of URL data. Note that you cannot start an on-demand update if an update is already in progress.
 
    [bookmark: pgfId-8750578]To enable communications with the cloud:
 
    
 
    [bookmark: pgfId-8750581]Step 1 Select Configuration > ASA FirePOWER Configuration > Local > Configuration.
 
    [bookmark: pgfId-8750582]The Information page appears.
 
    [bookmark: pgfId-8428679]Step 2 Click Cloud Services.
 
    [bookmark: pgfId-8428680]The Cloud Services page appears. If you have a URL Filtering license, the page displays the last time URL data was updated.
 
    [bookmark: pgfId-8369429]Step 3 Configure cloud connection options as described above.
 
    [bookmark: pgfId-8428824]You must Enable URL Filtering before you can Enable Automatic Updates or Query Cloud for Unknown URLs.
 
    [bookmark: pgfId-8372036]Step 4 Click Save.
 
    [bookmark: pgfId-8687029]Your settings are saved. If you enabled URL filtering, depending on how long it has been since URL filtering was last enabled, or if this is the first time you enabled URL filtering, the ASA FirePOWER moduleretrieves URL filtering data from the cloud.
 
    [bookmark: pgfId-8550288]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8428916]To perform an on-demand update of the system’s URL data:
 
    
 
    [bookmark: pgfId-8372091]Step 1 Select Configuration > ASA FirePOWER Configuration > Integration > Cisco CSI.
 
    [bookmark: pgfId-8372092]The Information page appears.
 
    [bookmark: pgfId-8372093]Step 2 Click URL Filtering.
 
    [bookmark: pgfId-8372148]The URL Filtering page appears.
 
    [bookmark: pgfId-8372149]Step 3 Click Update Now.
 
    [bookmark: pgfId-8372150]The ASA FirePOWER module contacts the cloud and updates its URL filtering data if an update is available.
 
    [bookmark: pgfId-8550302]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8744977]Time
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7707274][bookmark: 75906]Licensing the ASA FirePOWER Module 
      
      
 
     
 
 
    [bookmark: pgfId-8344469]You can license a variety of features to create an optimal ASA FirePOWER deployment for your organization.
 
    [bookmark: pgfId-8342533]For more information, see:
 
     
     	 [bookmark: pgfId-8345123]Understanding Licensing
 
     	 [bookmark: pgfId-8358208]Viewing Your Licenses
 
     	 [bookmark: pgfId-8358235]Adding a License to the ASA FirePOWER module
 
     	 [bookmark: pgfId-8358267]Deleting a License
 
    
 
   
 
    
     [bookmark: pgfId-8374361][bookmark: 98698]Understanding[bookmark: marker-8374359] Licensing
 
    [bookmark: pgfId-8322151]License: Any
 
    [bookmark: pgfId-8439978]You can license a variety of features to create an optimal ASA FirePOWER deployment for your organization.
 
    [bookmark: pgfId-8439985]Licenses allow your device to perform a variety of functions including:
 
     
     	 [bookmark: pgfId-8422488]intrusion detection and prevention
 
     	 [bookmark: pgfId-8422503]Security Intelligence filtering
 
     	 [bookmark: pgfId-8422510]file control and advanced malware protection
 
     	 [bookmark: pgfId-8473259]application, user, and URL control
 
    
 
    [bookmark: pgfId-8477524]There are a few ways you may lose access to licensed features in the ASA FirePOWER module. You can remove licensed capabilities. In addition, some licenses may expire. Though there are some exceptions, you cannot use the features associated with an expired or deleted license.
 
    [bookmark: pgfId-8518753]This section describes the types of licenses available in an ASA FirePOWER module deployment. The licenses you can enable on an appliance can depend the other licenses enabled.
 
    [bookmark: pgfId-8518757]The following table summarizes ASA FirePOWER module licenses.
 
    [bookmark: pgfId-8518831]
 
     
      
       
       [bookmark: pgfId-8518767]Table 36-1 [bookmark: 72441]ASA FirePOWER Module Licenses 
 
       
       
        
        	 
          
          [bookmark: pgfId-8518773]License 
         
  
        	 
          
          [bookmark: pgfId-8518775]Granted Capabilities 
         
  
        	 
          
          [bookmark: pgfId-8518777]Requires 
         
  
       
 
        
        	[bookmark: pgfId-8518782]Protection

  
        	[bookmark: pgfId-8518784]intrusion detection and prevention
 [bookmark: pgfId-8518785]file control
 [bookmark: pgfId-8518786]Security Intelligence filtering
  
        	[bookmark: pgfId-8518788]none
  
       
 
        
        	[bookmark: pgfId-8518793]Control
  
        	[bookmark: pgfId-8518795]user and application control
  
        	[bookmark: pgfId-8518800]Protection
  
       
 
        
        	[bookmark: pgfId-8518805]Malware
  
        	[bookmark: pgfId-8518807]advanced malware protection (network-based malware detection and blocking)
  
        	[bookmark: pgfId-8518812]Protection
  
       
 
        
        	[bookmark: pgfId-8518817]URL Filtering
  
        	[bookmark: pgfId-8518819]category and reputation-based URL filtering
  
        	[bookmark: pgfId-8518824]Protection
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8438506]For more information, see:
 
     
     	 [bookmark: pgfId-8408724]Protection
 
     	 [bookmark: pgfId-8408744]Control
 
     	 [bookmark: pgfId-8408764]Malware
 
     	 [bookmark: pgfId-8408788]URL Filtering
 
    
 
     
      [bookmark: pgfId-8362667][bookmark: 87196][bookmark: 84072][bookmark: 21372]Protection
 
     [bookmark: pgfId-8450444]License: Protection
 
     [bookmark: pgfId-8462022]A Protection lice[bookmark: marker-8462021]nse allows you to perform intrusion detection and prevention, file control, and Security Intelligence filtering:
 
      
      	 [bookmark: pgfId-8462023] Intrusion detection and prevention allows you to analyze network traffic for intrusions and exploits and, optionally, drop offending packets.
 
      	 [bookmark: pgfId-8419740] File control allows you to detect and, optionally, block users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. With a Malware license (see Malware), you can also inspect and block a restricted set of those file types based on their malware dispositions.
 
      	 [bookmark: pgfId-8425070] Security Intelligence filtering allows you to blacklist—deny traffic to and from—specific IP addresses, before the traffic is subjected to analysis by access control rules. Dynamic feeds allow you to immediately blacklist connections based on the latest intelligence. Optionally, you can use a “monitor-only” setting for Security Intelligence filtering.
 
     
 
     [bookmark: pgfId-8422019]Although you can configure an access control policy to perform Protection-related inspection without a license, you cannot apply the policy until you first add a Protection license to the ASA FirePOWER module.
 
     [bookmark: pgfId-8419178]If you delete your Protection license from the ASA FirePOWER module, the ASA FirePOWER module stops detecting intrusion and file events. Additionally, the ASA FirePOWER module will not contact the internet for either Cisco-provided or third-party Security Intelligence information. You cannot reapply existing policies until you re-enable Protection.
 
     [bookmark: pgfId-8423378]Because a Protection license is required for URL Filtering, Malware, and Control licenses, deleting or disabling a Protection license has the same effect as deleting or disabling your URL Filtering, Malware, or Control license.
 
    
 
     
      [bookmark: pgfId-8388117][bookmark: 36712][bookmark: 97657]Control
 
     [bookmark: pgfId-8388121]License: Control
 
     [bookmark: pgfId-8472007]A Control licen[bookmark: marker-8472006]se allows you to implement user and application control by adding user and application conditions to access control rules. To enable Control, you must also enable Protection.
 
     [bookmark: pgfId-8368944]Although you can add user and application conditions to access control rules without a Control license, you cannot apply the policy until you first add a Control license to the ASA FirePOWER module.
 
     [bookmark: pgfId-8373917]If you delete your Control license, you cannot reapply existing access control policies if they include rules with user or application conditions.
 
    
 
     
      [bookmark: pgfId-8362872][bookmark: 44381]URL Filtering
 
     [bookmark: pgfId-8362886]License: URL Filtering
 
     [bookmark: pgfId-8448446]URL filtering allo[bookmark: marker-8439653]ws you to write access control rules that determine the traffic that can traverse your network based on URLs requested by monitored hosts, correlated with information about those URLs, which is obtained from the Cisco cloud by the ASA FirePOWER module. To enable URL Filtering, you must also enable a Protection license.
 
      
       
     
 
     
 
     [bookmark: pgfId-8381118]Tip Without a URL Filtering license, you can specify individual URLs or groups of URLs to allow or block. This gives you granular, custom control over web traffic, but does not allow you to use URL category and reputation data to filter network traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8368186]URL filtering requires a subscription-based URL Filtering license. Although you can add category and reputation-based URL conditions to access control rules without a URL Filtering license, the ASA FirePOWER module will not contact the cloud for URL information. You cannot apply the access control policy until you first add a URL Filtering license to the ASA FirePOWER module.
 
     [bookmark: pgfId-8374618]You may lose access to URL filtering if you delete the license from the ASA FirePOWER module. Also, URL Filtering licenses may expire. If your license expires or if you delete it, access control rules with URL conditions immediately stop filtering URLs, and your ASA FirePOWER module can no longer contact the cloud. You cannot reapply existing access control policies if they include rules with category and reputation-based URL conditions.
 
    
 
     
      [bookmark: pgfId-8384352][bookmark: 88923]Malware
 
     [bookmark: pgfId-8384353]License: Malware
 
     [bookmark: pgfId-8448499]A Malware licen[bookmark: marker-8394496]se allows you to perform advanced malware protection, that is, use devices to detect and block malware in files transmitted over your network. To enable Malware on a device, you must also enable Protection.
 
     [bookmark: pgfId-8397186]You configure malware detection as part of a file policy, which you then associate with one or more access control rules. File policies can detect your users uploading or downloading files of specific types over specific application protocols. The Malware license allows you to inspect a restricted set of those file types for malware. The Malware license also allows you to add specific files to a file list and enable the file list within a file policy, allowing those files to be automatically allowed or blocked on detection.
 add a Malware license. If you later delete the license, you cannot reapply an existing access control policy to those devices if it includes file policies that perform malware detection. 
     
 
     [bookmark: pgfId-8519521]If you delete your Malware license or it expires, the ASA FirePOWER module stops performing malware cloud lookups, and also stops acknowledging retrospective events sent from the Cisco cloud. You cannot reapply existing access control policies if they include file policies that perform malware detection. Note that for a very brief time after a Malware license expires or is deleted, the system can use cached dispositions for files detected by Malware Cloud Lookup file rules. After the time window expires, the system assigns a disposition of Unavailable to those files, rather than performing a lookup.
 
    
 
   
 
    
     [bookmark: pgfId-8391887][bookmark: 19801][bookmark: 58828][bookmark: 55836][bookmark: 34526][bookmark: 91845]Viewing Your Lic[bookmark: marker-8391886]enses
 
    [bookmark: pgfId-8391888]License: Any
 
    [bookmark: pgfId-8349539]Use the Licenses page to view the licenses for an ASA FirePOWER module. 
 
    [bookmark: pgfId-8425527]Other than the Licenses page, there are a few other ways you can view licenses and license limits:
 
     
     	 [bookmark: pgfId-8350281]The Product Licensing dashboard widget provides an at-a-glance overview of your licenses.
 
     	 [bookmark: pgfId-8439271]The Device page ( Configuration > ASA FirePOWER Configuration > Device Management > Device ) lists the licenses.
 
    
 
    [bookmark: pgfId-8478097]To view your licenses:
 
    
 
    [bookmark: pgfId-8478100]Step 1 Select Configuration > ASA FirePOWER Configuration > Licenses.
 
    [bookmark: pgfId-8478101]The Licenses page appears.
 
    [bookmark: pgfId-8456641]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8350791][bookmark: 48506]Adding a Licen[bookmark: marker-8375281]se to the ASA FirePOWER module
 
    [bookmark: pgfId-8353562]License: Any
 
    [bookmark: pgfId-8479307]Before you add a license to the ASA FirePOWER module, make sure you have the activation key provided by Cisco when you purchased the license. You must add licenses before you can use licensed features. 
 
     
      
    
 
    
 
    [bookmark: pgfId-8443327]Note If you add licenses after a backup has completed, these licenses will not be removed or overwritten if this backup is restored. To prevent a conflict on restore, remove those licenses before restoring the backup, noting where the licenses were used, and add and reconfigure them after restoring the backup. If a conflict occurs, contact Support.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8353563]To add a license:
 
    
 
    [bookmark: pgfId-8353496]Step 1 Select Configuration > ASA FirePOWER Configuration > Licenses.
 
    [bookmark: pgfId-8353497]The Licenses page appears.
 
    [bookmark: pgfId-8353420]Step 2 Click Add New License.
 
    [bookmark: pgfId-8353421]The Add License page appears.
 
    [bookmark: pgfId-8353426]Step 3 Did you receive an email with your license?
 
     
      
      	 [bookmark: pgfId-8353747]If yes, copy the license from the email, paste it into the  License field, and click  Submit License .
 
     
 
    
 
    [bookmark: pgfId-8353781]If the license is correct, the license is added. Skip the rest of the procedure.
 
     
      
      	 [bookmark: pgfId-8353758]If no, click  Get License .
 
     
 
    
 
    [bookmark: pgfId-8353428]The Product License Registration portal appears. If you cannot access the Internet, switch to a computer that can. Note the license key at the bottom of the page and browse to https://www.cisco.com/go/license.
 
    [bookmark: pgfId-8353968]Step 4 Follow the on-screen instructions to obtain your license, which will be sent to you in an email.
 
     
      
    
 
    
 
    [bookmark: pgfId-8374069]Tip You can also request a license on the Licenses tab after you log into the Support Site.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8353969]Step 5 Copy the license from the email, paste it into the License field in the ASA FirePOWER module’s web user interface, and click Submit License.
 
    [bookmark: pgfId-8353436]If the license is valid, it is added.
 
    [bookmark: pgfId-8456679]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8350818][bookmark: 26572]Deleting a Lic[bookmark: marker-8375289]ense
 
    [bookmark: pgfId-8350972]License: Any
 
    [bookmark: pgfId-8350995]Use the following procedure if you need to delete a license for any reason. Keep in mind that because Cisco generates licenses based on each ASA FirePOWER module’s unique license key, you cannot delete a license from one ASA FirePOWER module and then reuse it on a different ASA FirePOWER module.
 
    [bookmark: pgfId-8351604]In most cases, deleting a license removes your ability to use features enabled by that license. For more information, see Understanding Licensing.
 
    [bookmark: pgfId-8351577]To delete a license:
 
    
 
    [bookmark: pgfId-8351579]Step 1 Select Configuration > ASA FirePOWER Configuration > Licenses.
 
    [bookmark: pgfId-8351580]The Licenses page appears.
 ). 
    
 
    [bookmark: pgfId-8374680]Step 3 Confirm that you want to delete the license.
 
    [bookmark: pgfId-8374681]The license is deleted.
 
    [bookmark: pgfId-8456693]
 
     
     
 
    
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-8558516][bookmark: 75941]Upd[bookmark: marker-8566973]ating ASA FirePOWER Module Softw[bookmark: marker-8558518]are 
      
      
 
     
 
 
    [bookmark: pgfId-8567355]Cisco electronically distributes several different types of updates, including major and minor updates to the ASA FirePOWER module software itself, as well as rule updates, geolocation database (GeoDB) updates, and Vulnerability Database (VDB) updates.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8567305] 
     Caution This section contains general information on updating the ASA FirePOWER module. Before you update, including the VDB, GeoDB, or intrusion rules, you 
     must read the release notes or advisory text that accompanies the update. The release notes provide important information, including prerequisites, warnings, and specific installation and uninstallation instructions. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8567185]Unless otherwise documented in the release notes or advisory text, updating does not modify configurations; the settings remain intact.
 
    [bookmark: pgfId-8567109]See the following sections for more information:
 
     
     	 [bookmark: pgfId-8135728]Understanding Update Types
 
     	 [bookmark: pgfId-7775092]Performing Software Updates
 
     	 [bookmark: pgfId-2561142]Uninstalling Software Updates
 
     	 [bookmark: pgfId-8024887]Updating the Vulnerability Database
 
     	 [bookmark: pgfId-8036580]Importing Rule Updates and Local Rule Files
 
     	 [bookmark: pgfId-8157497]Updating the Geolocation Database
 
    
 
   
 
    
     [bookmark: pgfId-8036582][bookmark: 84942]Understanding Update Types
 
    [bookmark: pgfId-8024902]License: Any
 
    [bookmark: pgfId-8558496]Cisco electronically distributes several different types of updates, including major and minor updates to the ASA FirePOWER module software itself, as well as intrusion rule updates and VDB updates.
 
    [bookmark: pgfId-8558500]The following table describes the types of updates provided by Cisco. For most update types, you can schedule their download and installation; see Scheduling Tasks and Using Recurring Rule Updates. 
 
    [bookmark: pgfId-8237873]
 
     
      
       
       [bookmark: pgfId-8237791]Table 37-1 [bookmark: 11019]ASA FirePOWER Module Update Types
 
       
       
        
        	 
          
          [bookmark: pgfId-8237799]Update Type 
         
  
        	 
          
          [bookmark: pgfId-8237801]Description 
         
  
        	 
          
          [bookmark: pgfId-8237803]Schedule? 
         
  
        	 
          
          [bookmark: pgfId-8237805]Uninstall? 
         
  
       
 
        
        	[bookmark: pgfId-8237809]patches
  
        	[bookmark: pgfId-8237812]Patches include a limited range of fixes (and usually change the fourth digit in the version number; for example, 5.4.0.1).
  
        	[bookmark: pgfId-8237814]yes
  
        	[bookmark: pgfId-8237816]yes
  
       
 
        
        	[bookmark: pgfId-8237818]feature updates
  
        	[bookmark: pgfId-8237823]Feature updates are more comprehensive than patches and generally include new features (and usually change the third digit in the version number; for example, 5.4.1).
  
        	[bookmark: pgfId-8237825]yes
  
        	[bookmark: pgfId-8237827]yes
  
       
 
        
        	[bookmark: pgfId-8237829]major updates (major and minor version releases)
  
        	[bookmark: pgfId-8237834]Major updates, sometimes referred to as upgrades, include new features and functionality and may entail large-scale changes (and usually change the first or second digit in the version number; for example, 5.3 or 5.4). 
  
        	[bookmark: pgfId-8237839]no
  
        	[bookmark: pgfId-8237841]no
  
       
 
        
        	[bookmark: pgfId-8237843]VDB 
  
        	[bookmark: pgfId-8237847]VDB updates affect the database of known vulnerabilities to which hosts may be susceptible.
  
        	[bookmark: pgfId-8237850]yes
  
        	[bookmark: pgfId-8237852]no
  
       
 
        
        	[bookmark: pgfId-8237854]intrusion rules
  
        	[bookmark: pgfId-8237856]Intrusion rule updates provide new and updated intrusion rules and preprocessor rules, modified states for existing rules, and modified default intrusion policy settings. Rule updates may also delete rules, provide new rule categories and default variables, and modify default variable values. 
  
        	[bookmark: pgfId-8237858]yes
  
        	[bookmark: pgfId-8237860]no
  
       
 
        
        	[bookmark: pgfId-8237862]geolocation database (GeoDB)
  
        	[bookmark: pgfId-8237868]GeoDB updates provide updated information on physical locations, connection types, and so on that your system can associate with detected routable IP addresses. You can use geolocation data as a condition in access control rules. You must install the GeoDB to view geolocation details.
  
        	[bookmark: pgfId-8237870]yes
  
        	[bookmark: pgfId-8237872]no
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8237877]Note that while you can uninstall patches and other minor updates, you cannot uninstall major updates or return to previous versions of the VDB, GeoDB, or intrusion rules. If you updated to a new major version and you need to revert to an older version, contact Support.
 
   
 
    
     [bookmark: pgfId-7775954][bookmark: 37465]Performing Software Updates[bookmark: marker-7775943]
 
    [bookmark: pgfId-8135490]License: Any
 
    [bookmark: pgfId-8241246]There are a few basic steps to updating. First, you must prepare for the update by reading the release notes and completing any required pre-update tasks. Then, you can begin the update. You must verify the update’s success. Finally, complete any required post-update steps.
 
    [bookmark: pgfId-8217979]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-8135592]Planning for the Update
 
     	 [bookmark: pgfId-8128296]Understanding the Update Process
 
     	 [bookmark: pgfId-8127335]Updating the ASA FirePOWER Module Software
 
     	 [bookmark: pgfId-8127639]Monitoring the Status of Major Updates
 
    
 
     
      [bookmark: pgfId-8127195][bookmark: 31352]Planning for the Update
 
     [bookmark: pgfId-8128391]License: Any
 
     [bookmark: pgfId-8220655]Before you begin the update, you must thoroughly read and understand the release notes, which you can download from the Support Site. The release notes describe new features and functionality, and known and resolved issues. The release notes also contain important information on prerequisites, warnings, and specific installation and uninstallation instructions.
 
     [bookmark: pgfId-8131497]The following sections provide an overview of some of the factors you must consider when planning for the update.
 
     [bookmark: pgfId-8224988]Software Version Requirements
 
     [bookmark: pgfId-8224989]You must make sure you are running the correct software version. The release notes indicate the required version. If you are running an earlier version, you can obtain updates from the Support Site.
 
     [bookmark: pgfId-8129462]Time and Disk Space Requirements
 
     [bookmark: pgfId-8132713]Make sure you have enough free disk space and allow enough time for the update. The release notes indicate space and time requirements.
 
     [bookmark: pgfId-8132755]Configuration Backup Guidelines
 
     [bookmark: pgfId-8558470]Before you begin a major update, Cisco recommends that you delete any backups that reside on the ASA FirePOWER module after copying them to an external location. Regardless of the update type, you should also back up current configuration data to an external location. See Using Backup and Restore.
 
     [bookmark: pgfId-8134302]When to Perform the Update
 
     [bookmark: pgfId-8134303]Because the update process may affect traffic inspection and traffic flow, and because the Data Correlator is disabled while an update is in progress, Cisco recommends you perform the update in a maintenance window or at a time when the interruption will have the least impact.
 
    
 
     
      [bookmark: pgfId-8128501][bookmark: 50647]Understanding the Update Process
 
     [bookmark: pgfId-8128537]License: Any
 
     [bookmark: pgfId-8558621]You use the ASA FirePOWER module interface to update the ASA FirePOWER module.
 
     [bookmark: pgfId-8224931]The Product Updates page (Configuration > ASA FirePOWER Configuration > Updates) shows the version of each update, as well as the date and time it was generated. It also indicates whether a software reboot is required as part of the update. When you upload updates obtained from Support, they appear on the page. Uninstallers for patch and feature updates also appear; see Uninstalling Software Updates. The page can also list VDB updates.
 
      
       
     
 
     
 
     [bookmark: pgfId-8222695]Tip For patches and feature updates, you can take advantage of the automated update feature; see Automating Software Updates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8138551][bookmark: 68883]Traffic Flow and Inspection
 
     [bookmark: pgfId-8223791]When you install or uninstall updates, the following capabilities may be affected:
 
      
      	 [bookmark: pgfId-8223792]traffic inspection, including application and user awareness and control, URL filtering, Security Intelligence filtering, intrusion detection and prevention, and connection logging 
 
      	 [bookmark: pgfId-8138554]traffic flow
 
     
 
     [bookmark: pgfId-8154432]The Data Correlator does not run during system updates. It resumes when the update is complete.
 
     [bookmark: pgfId-8558431]The manner and duration of network traffic interruption depends on how yourASA FirePOWER module is configured and deployed, and whether the update reboots the ASA FirePOWER module. For specific information on how and when network traffic is affected for a particular update, see the release notes.
 
     [bookmark: pgfId-8558425][bookmark: 15703]Using the ASA FirePOWER Module During the Update
 
     [bookmark: pgfId-8558426]Regardless of the type of update, do not use the ASA FirePOWER module to perform tasks other than monitoring the update.
 
     [bookmark: pgfId-8558412]To prevent you from using the ASA FirePOWER module during a major update, and to allow you to easily monitor a major update’s progress, the system streamlines the ASA FirePOWER module interface. You can monitor a minor update's progress in the task queue (Monitoring > ASA FirePOWER Monitoring > Task Status). Although you are not prohibited from using the ASA FirePOWER module during a minor update, Cisco recommends against it.
 
     [bookmark: pgfId-8558396]Even for minor updates, the ASA FirePOWER module may become unavailable during the update process. This is expected behavior. If this occurs, wait until you can again access the ASA FirePOWER module. If the update is still running, you must continue to refrain from using the ASA FirePOWER module until the update has completed. Note that while updating, the ASA FirePOWER module may reboot a second time; this is also expected behavior.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8122532] 
      Caution If you encounter issues with the update (for example, if the update has failed or if a manual refresh of the Update Status page shows no progress), do 
      not restart the update. Instead, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8116625][bookmark: 92195]After the Update
 
     [bookmark: pgfId-8124746]You must complete all of the post-update tasks listed in the release notes to ensure that your deployment is performing properly.
 
     [bookmark: pgfId-8124747]The most important post-update task is to reapply access control policies. Note that applying an access control policy may cause a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected; see Deploying Configuration Changes.
 
     [bookmark: pgfId-8118900]Additionally, you should:
 
      
      	 [bookmark: pgfId-8224841]verify that the update succeeded
 
      	 [bookmark: pgfId-8224843]update your intrusion rules, VDB, and GeoDB, if necessary
 
      	 [bookmark: pgfId-8138530]make any required configuration changes, based on the information in the release notes
 
      	 [bookmark: pgfId-8558369]perform any additional post-update tasks listed in the release notes
 
     
 
    
 
     
      [bookmark: pgfId-8558376][bookmark: 21634]Upda[bookmark: marker-8558371]tin[bookmark: marker-8558372]g the ASA FirePOWER Module Software
 
     [bookmark: pgfId-8558380]License: Any
 
     [bookmark: pgfId-8558356]Update the ASA FirePOWER module software in one of two ways, depending on the type of update and whether your ASA FirePOWER module has access to the Internet:
 
      
      	 [bookmark: pgfId-8558365]You can obtain the update directly from the Support Site if your ASA FirePOWER module has access to the Internet. This option is  not supported for major updates.
 
      	 [bookmark: pgfId-8558342]You can manually download the update from the Support Site and then upload it to the ASA FirePOWER module. Choose this option if your ASA FirePOWER module does not have access to the Internet or if you are performing a major update.
 
     
 
     [bookmark: pgfId-8558306]For major updates, updating the ASA FirePOWER module removes uninstallers for previous updates.
 
     [bookmark: pgfId-8558312]To update the ASA FirePOWER Module Software:
 
     
 
     [bookmark: pgfId-8558270]Step 1 Read the release notes and complete any required pre-update tasks.
 
     [bookmark: pgfId-8558274]Pre-update tasks may include making sure that: the ASA FirePOWER module is running the correct version of the Cisco software, you have enough free disk space to perform the update, you set aside adequate time to perform the update, you backed up configuration data, and so on.
 
     [bookmark: pgfId-8558260]Step 2 Upload the update. You have two options, depending on the type of update and whether your ASA FirePOWER module has access to the Internet:
 
      
       
       	 [bookmark: pgfId-8558267]For all except major updates, and if your ASA FirePOWER module has access to the Internet, select  Configuration > ASA FirePOWER Configuration > Updates , then click  Download Updates  to check for the latest updates on either of the following Support Sites:
 
      
 
     
 
     [bookmark: pgfId-8208722] – Sourcefire: (https://support.sourcefire.com/)
 
     [bookmark: pgfId-8558237] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
      
       
       	 [bookmark: pgfId-8558241]For major updates, or if your ASA FirePOWER module does not have access to the Internet, you must first manually download the update from either of the following Support Sites:
 
      
 
     
 
     [bookmark: pgfId-8208916] – Sourcefire: (https://support.sourcefire.com/)
 
     [bookmark: pgfId-8208848] – Cisco: (http://www.cisco.com/cisco/web/support/index.html) 
 
      
       
       	 [bookmark: pgfId-8208867]Select  Configuration > ASA FirePOWER Configuration > Updates , then click  Upload Update . Click  Choose File  to navigate to and select the update and click  Upload .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7740139]Note Download the update directly from the Support Site, either manually or by clicking Download Updates on the Product Updates tab. If you transfer an update file by email, it may become corrupted.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8245942]The update is uploaded.
 
     [bookmark: pgfId-8569104]Step 3 Select Monitoring > ASA FirePOWER Monitoring > Task Status to view the task queue and make sure that there are no jobs in process.
 
     [bookmark: pgfId-8491300]Tasks that are running when the update begins are stopped and cannot be resumed; you must manually delete them from the task queue after the update completes. The task queue automatically refreshes every 10 seconds. You must wait until any long-running tasks are complete before you begin the update.
 
     [bookmark: pgfId-8240412]Step 4 Select Configuration > ASA FirePOWER Configuration > Updates.
 
     [bookmark: pgfId-8077012]The Product Updates page appears.
 
     [bookmark: pgfId-8077013]Step 5 Click the install icon next to the update you uploaded.
 
     [bookmark: pgfId-8240966]The update process begins. How you monitor the update depends on whether the update is a major or minor update. See the ASA FirePOWER Module Update Types table and the release notes to determine your update type:
 
      
       
       	 [bookmark: pgfId-8246174]For minor updates, you can monitor the update's progress in the task queue ( Monitoring >  ASA FirePOWER Monitoring > Task Status ).
 
       	 [bookmark: pgfId-8558226]For major updates, you can begin monitoring the update’s progress in the task queue. However, after the ASA FirePOWER module completes its necessary pre-update checks, you are locked out of the module interface. When you regain access, the Upgrade Status page appears. See Monitoring the Status of Major Updates for information.
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8558207] 
      Caution Regardless of the update type, do 
      not use the ASA FirePOWER module to perform tasks other than monitoring the update until the update has completed and, if necessary, the ASA FirePOWER module reboots. For more information, see 
      Using the ASA FirePOWER Module During the Update. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8558179]Step 6 After the update finishes, access the ASA FirePOWER module interface and refresh the page. Otherwise, the interface may exhibit unexpected behavior. If you are the first user to access the interface after a major update, the End User License Agreement (EULA) may appear. You must review and accept the EULA to continue.
 
     [bookmark: pgfId-8558163]Step 7 If the rule update available on the Support Site is newer than the rules on your ASA FirePOWER module, import the newer rules. 
 
     [bookmark: pgfId-8242070]For more information, see Importing Rule Updates and Local Rule Files.
 
     [bookmark: pgfId-8042642]Step 8 Reapply access control policies.
 
     [bookmark: pgfId-8042643]Applying an access control policy may cause a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected. For more information, see Deploying Configuration Changes.
 
     [bookmark: pgfId-8027234]Step 9 If the VDB available on the Support Site is newer than the most recently installed VDB, install the latest VDB.
 
     [bookmark: pgfId-8086718]Installing a VDB update causes a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected. For more information, see Updating the Vulnerability Database.
 
     [bookmark: pgfId-8202918]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7819128][bookmark: 46258]Monitoring the Status of Major Updates
 
     [bookmark: pgfId-8640879]License: Any
 
     [bookmark: pgfId-8491511]For major updates, the ASA FirePOWER module provides you with a streamlined interface so that you can easily monitor the update process. The streamlined interface also prevents you from using the ASA FirePOWER module to perform tasks other than monitoring the update.You can begin monitoring the update’s progress in the task queue (Monitoring > ASA FirePOWER Monitoring > Task Status). However, after the ASA FirePOWER module completes its necessary pre-update checks, you are locked out of the user interface until a streamlined update page appears.
 
     [bookmark: pgfId-8244001]The streamlined interface displays the version you are updating from, the version you are updating to, and the time that has elapsed since the update began. It also displays a progress bar and gives details about the script currently running.
 
      
       
     
 
     
 
     [bookmark: pgfId-7819180]Tip Click show log for current script to see the update log. Click hide log for current script to hide the log again.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7819181]If the update fails for any reason, the page displays an error message indicating the time and date of the failure, which script was running when the update failed, and instructions on how to contact Support. Do not restart the update.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8558134] 
      Caution If you encounter any other issue with the update (for example, if a manual refresh of the page shows no progress for an extended period of time), do 
      not restart the update. Instead, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8558135]When the update completes, the ASA FirePOWER module displays a success message and reboots. After the ASA FirePOWER module finishes rebooting, complete any required post-update steps.
 
    
 
   
 
    
     [bookmark: pgfId-8138835][bookmark: 64693]Uninstalling Software[bookmark: marker-8138834] Updates
 
    [bookmark: pgfId-8224779]License: Any
 
    [bookmark: pgfId-8224783]When you apply a patch or feature update, the update process creates an uninstaller that allows you to remove the update.
 
    [bookmark: pgfId-8224770]When you uninstall an update, the resulting Cisco software version depends on the update path. For example, consider a scenario where you updated directly from Version 5.0 to Version 5.0.0.2. Uninstalling the Version 5.0.0.2 patch might result in Version 5.0.0.1, even though you never installed the Version 5.0.0.1 update. For information on the resulting Cisco software version when you uninstall an update, see the release notes.
 
     
      
    
 
    
 
    [bookmark: pgfId-8224730]Note Uninstalling is not supported for major updates. If you updated to a new major version and you need to revert to an older version, contact Support.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8135971][bookmark: 56105]Traffic Flow and Inspection
 
    [bookmark: pgfId-8135942]Uninstalling an update may affect traffic inspection and traffic flow. For specific information on how and when network traffic is affected for a particular update, see the release notes.
 
    [bookmark: pgfId-8178569][bookmark: 57869]After the Uninstallation
 
    [bookmark: pgfId-8224495]After you uninstall the update, verify that the uninstall succeeded. For specific information for each update, see the release notes.
 
    [bookmark: pgfId-2560996]To uninstall a patch or feature update:
 
    
 
    [bookmark: pgfId-2561000]Step 1 Select Configuration > ASA FirePOWER Configuration > Updates.
 
    [bookmark: pgfId-7732963]The Product Updates page appears.
 
    [bookmark: pgfId-8228417]Step 2 Click the install icon next to the uninstaller for the update you want to remove.
 
    [bookmark: pgfId-8558127]If prompted, confirm that you want to uninstall the update and reboot the ASA FirePOWER module. 
 
    [bookmark: pgfId-8558128]The uninstall process begins. You can monitor its progress in the task queue (Monitoring > ASA FirePOWER Monitoring > Task Status).
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8558121] 
     Caution Do 
     not use the ASA FirePOWER module interface to perform tasks until the uninstall has completed and, if necessary, the ASA FirePOWER module reboots. For more information, see 
     Using the ASA FirePOWER Module During the Update. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8492493]Step 3 Refresh the page. Otherwise, the interface may exhibit unexpected behavior.
 
    [bookmark: pgfId-8202846]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8025560][bookmark: 75380]Updating the Vulne[bookmark: marker-8075892]rability Databa[bookmark: marker-8025559]se
 
    [bookmark: pgfId-8239095]License: Any
 
    [bookmark: pgfId-8768453]The Cisco Vulnerability Database (VDB) is a database of known vulnerabilities to which hosts may be susceptible. The Cisco Vulnerability Research Team (VRT) issues periodic updates to the VDB. To update the VDB, use the Product Updates page. 
 
     
      
    
 
    
 
    [bookmark: pgfId-8768627]Note Installing a VDB update with detection updates may cause a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected.You may want to schedule the update during low system usage times to minimize the impact of any system downtime.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-8768631]Note After you complete a VDB update, reapply any out-of-date access control policy. Keep in mind that installing a VDB or reapplying an access control policy can cause a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected. For more information, see Deploying Configuration Changes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8244672]This section explains how to plan for and perform manual VDB updates. 
 
    [bookmark: pgfId-8025621]To update the vulnerability database:
 
    
 
    [bookmark: pgfId-8025623]Step 1 Read the VDB Update Advisory Text for the update.
 
    [bookmark: pgfId-8557137]The advisory text includes information about the changes to the VDB made in the update.
 
    [bookmark: pgfId-8557138]Step 2 Select Configuration > ASA FirePOWER Configuration > Updates.
 
    [bookmark: pgfId-8557139]The Product Updates page appears.
 
    [bookmark: pgfId-8558095]Step 3 Upload the update:
 
     
      
      	 [bookmark: pgfId-8558099]If your ASA FirePOWER module has access to the Internet, click  Download Updates  to check for the latest updates on either of the following Support Sites: 
 
     
 
    
 
    [bookmark: pgfId-8209231] – Sourcefire: (https://support.sourcefire.com/)
 
    [bookmark: pgfId-8558085] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
     
      
      	 [bookmark: pgfId-8558089]If your ASA FirePOWER module does not have access to the Internet, manually download the update from one of the following Support Sites, then click  Upload Update . Click  Choose File  to navigate to and select the update and click  Upload :
 
     
 
    
 
    [bookmark: pgfId-8209589] – Sourcefire: (https://support.sourcefire.com/)
 
    [bookmark: pgfId-8209584] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
     
      
    
 
    
 
    [bookmark: pgfId-8203374]Note Download the update directly from the Support Site either manually or by clicking Download Updates. If you transfer an update file by email, it may become corrupted.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8043272]The update is uploaded.
 
    [bookmark: pgfId-8043266]Step 4 Click the install icon next to the VDB update.
 
    [bookmark: pgfId-8685122]The Install Update page appears.
 
    [bookmark: pgfId-8685867]Step 5 Click Install.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8679738] 
     Caution The update process begins. You can monitor the update's progress in the task queue ( 
     Monitoring > ASA FirePOWER 
      Monitoring > Task Status). If you encounter issues with the update (for example, if the task queue indicates that the update has failed) 
     do not restart the update. Instead, contact Support. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8565772]You must reapply any out-of-date access control policies for the VDB update to take effect; see Deploying Configuration Changes.
 
    [bookmark: pgfId-8565761]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7762995][bookmark: 25091]Importing Rule Upd[bookmark: marker-8075897]ates and Loca[bookmark: marker-7762994]l Rule Files
 
    [bookmark: pgfId-8541943]License: Any
 
    [bookmark: pgfId-8566038]As new vulnerabilities become known, the Cisco Vulnerability Research Team (VRT) releases rule updates that you can first import onto your ASA FirePOWER module, then implement by applying affected access control, network analysis, and intrusion policies.
 
    [bookmark: pgfId-8565872]Rule updates are cumulative, and Cisco recommends you always import the latest update. You cannot import a rule update that either matches or predates the version of the currently installed rules.
 
     
      
    
 
    
 
    [bookmark: pgfId-8565879]Note Rule updates may contain new binaries, so make sure your process for downloading and installing them complies with your security policies. In addition, rule updates may be large, so import rules during periods of low network use.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8565880]A rule update may provide the following:
 
     
     	 [bookmark: pgfId-8565881] new and modified rules and rule states —Rule updates provide new and updated intrusion and preprocessor rules. For new rules, the rule state may be different in each system-provided intrusion policy. For example, a new rule may be enabled in the Security over Connectivity intrusion policy and disabled in the Connectivity over Security intrusion policy. Rule updates may also change the default state of existing rules, or delete existing rules entirely.
 
     	 [bookmark: pgfId-8565882] new rule categories —Rule updates may include new rule categories, which are always added.
 
     	 [bookmark: pgfId-8565883] modified preprocessor and advanced settings —Rule updates may change the advanced settings in the system-provided intrusion policies and the preprocessor settings in system-provided network analysis policies. They can also update default values for the advanced preprocessing and performance options in your access control policies.
 
     	 [bookmark: pgfId-8565884] new and modified variables —Rule updates may modify default values for existing default variables, but do not override your changes. New variables are always added.
 
    
 
    [bookmark: pgfId-8565885]Understanding When Rule Updates Modify Policies
 
    [bookmark: pgfId-8565886]Rule updates can affect both system-provided and custom network analysis policies, as well as all access control policies:
 
     
     	 [bookmark: pgfId-8565887] system provided —Changes to system-provided network analysis and intrusion policies, as well as any changes to advanced access control settings, automatically take effect when you reapply the policies after the update.
 
     	 [bookmark: pgfId-8565888] custom —Because every custom network analysis and intrusion policy uses a system-provided policy as its base, or as the eventual base in a policy chain, rule updates can affect custom network analysis and intrusion policies. However, you can prevent rule updates from automatically making those changes. This allows you to update system-provided base policies manually, on a schedule independent of rule update imports. Regardless of your choice (implemented on a per-custom-policy basis), updates to system-provided policies do  not override any settings you customized. For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
    
 
    [bookmark: pgfId-8565892]Note that importing a rule update discards all cached changes to network analysis and intrusion policies. For your convenience, the Rule Updates page lists policies with cached changes. For more information, see Resolving Conflicts and Committing Policy Changes.
 
    [bookmark: pgfId-8565896]Reapplying Policies
 
    [bookmark: pgfId-8565897]For changes made by a rule update to take affect, you must reapply any modified policies. When importing a rule update, you can configure the system to automatically reapply intrusion or access control policies. This is especially useful if you allow the rule update to modify system-provided base policies.
 
     
     	 [bookmark: pgfId-8565898]Reapplying an access control policy also reapplies associated network analysis and file policies, but does  not reapply intrusion policies. It also updates the default values for any modified advanced settings. Because you cannot apply a network analysis policy independently, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     	 [bookmark: pgfId-8565899]Reapplying intrusion policies allows you to update rules and other changed intrusion policy settings. You can reapply intrusion policies in conjunction with access control policies, or you can apply only intrusion policies to update intrusion rules without updating any other access control configurations.
 
    
 
    [bookmark: pgfId-8565903]When a rule update includes shared object rules, applying an access control or intrusion policy for the first time after the import causes a short pause in traffic flow and processing, and may also cause a few packets to pass uninspected. For more information on applying access control and intrusion policies, including requirements, other effects, and recommendations, see Deploying Configuration Changes.
 
    [bookmark: pgfId-8565907]For more information on importing rule updates, see:
 
     
     	 [bookmark: pgfId-8542003]Using One-Time Rule Updates explains how to import a single rule update from the Support Site.
 
     	 [bookmark: pgfId-8058786]Using Recurring Rule Updates explains how to use an automated feature to download and install rule updates from the Support Site.
 
     	 [bookmark: pgfId-8080020]Importing Local Rule Files explains how to import a copy of a standard text rules file that you have created on a local machine. 
 
     	 [bookmark: pgfId-8080071]Viewing the Rule Update Log explains the rule update log.
 
    
 
     
      [bookmark: pgfId-8058806][bookmark: 64286]Using One-Time Rule Updates
 
     [bookmark: pgfId-8025789]License: Any
 
     [bookmark: pgfId-7763291]There are two methods that you can use for one-time rule updates:
 
      
      	 [bookmark: pgfId-8236181]Using Manual One-Time Rule Updates explains how to manually download a rule update from the Support Site and then manually install the rule update.
 
      	 [bookmark: pgfId-8236185]Using Automatic One-Time Rule Updates explains how to use an automated feature to search the Support Site for new rule updates and upload them.
 
     
 
    
 
     
      [bookmark: pgfId-7889325][bookmark: 13906]Using Manual One-Time Rule Updates[bookmark: marker-7889324]
 
     [bookmark: pgfId-8025807]License: Any
 
     [bookmark: pgfId-8558077]The following procedure explains how to import a new rule update manually. This procedure is especially useful if your ASA FirePOWER module does not have Internet access.
 
     [bookmark: pgfId-8558081]To manually import a rule update:
 
     
 
     [bookmark: pgfId-8041256]Step 1 From a computer that can access the Internet, access either of the following sites:
 
      
       
       	 [bookmark: pgfId-8209316] Sourcefire:  (https://support.sourcefire.com/)
 
       	 [bookmark: pgfId-8209292] Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
      
 
     
 
     [bookmark: pgfId-7763345]Step 2 Click Download, then click Rules.
 
     [bookmark: pgfId-7763349]Step 3 Navigate to the latest rule update.
 
     [bookmark: pgfId-8566449]Rule updates are cumulative; you cannot import a rule update that either matches or predates the version of the currently installed rules.
 
     [bookmark: pgfId-8246399]Step 4 Click the rule update file that you want to download and save it to your computer.
 
     [bookmark: pgfId-8246402]Step 5 [bookmark: 89805]Select Configuration > ASA FirePOWER Configuration > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-7763394]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8491954]Tip You can also click Import Rules on the Rule Editor page (Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8246682]Step 6 Optionally, click Delete All Local Rules, then click OK to move all user-defined rules that you have created or imported to the deleted folder. See Deleting Custom Rules for more information.
 
     [bookmark: pgfId-8566598]Step 7 Select Rule Update or text rule file to upload and install and click Choose File to navigate to and select the rule update file.
 
     [bookmark: pgfId-8566599]Step 8 Optionally, reapply policies after the update completes:
 
      
      	 [bookmark: pgfId-8566600]Select  Reapply intrusion policies after the rule update import completes to automatically reapply intrusion policies. Choose only this option to update rules and other changed intrusion policy settings without having to update any other access control configurations you may have made. You  must select this option to reapply intrusion policies in conjunction with access control policies; reapplying access control policies in this case does not perform a complete apply.
 
      	 [bookmark: pgfId-8566601]Select  Reapply access control policies after the rule update import completes to automatically reapply access control policies and their associated network analysis and file policies, but not intrusion policies. Selecting this option also updates the default values for any modified access control advanced settings. Because you cannot apply a network analysis policy independently of its parent access control policy, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     
 
     [bookmark: pgfId-8543259]Step 9 Click Import.
 
     [bookmark: pgfId-8543262]The system installs the rule update and displays the Rule Update Log detailed view; see Understanding the Rule Update Import Log Detailed View. The system also applies policies as you specified in the previous step; see Deploying Configuration Changes and Applying an Intrusion Policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-8216393]Note Contact Support if you receive an error message while installing the rule update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202802]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763450][bookmark: 30475]Using Automatic One-Time Rule Updates[bookmark: marker-7763449]
 
     [bookmark: pgfId-8025902]License: Any
 
     [bookmark: pgfId-8558073]The following procedure explains how to import a new rule update by automatically connecting to the Support Site. You can use this procedure only if the ASA FirePOWER module has Internet access.
 
     [bookmark: pgfId-8558074]To automatically import a rule update:
 
     
 
     [bookmark: pgfId-8025918]Step 1 Select Configuration > ASA FirePOWER Configuration > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8493882]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8566538]Tip You can also click Import Rules on the Rule Editor page (Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8493884]Step 2 Optionally, click Delete All Local Rules, then click OK to move all user-defined rules that you have created or imported to the deleted folder. See Deleting Custom Rules for more information.
 
     [bookmark: pgfId-7763501]Step 3 Select Download new Rule Update from the Support Site.
 
     [bookmark: pgfId-8566635]Step 4 [bookmark: 86752][bookmark: 68930]Optionally, reapply policies after the update completes:
 
      
      	 [bookmark: pgfId-8566636]Select  Reapply intrusion policies after the rule update import completes to automatically reapply intrusion policies. Choose only this option to update rules and other changed intrusion policy settings without having to update any other access control configurations you may have made. You  must select this option to reapply intrusion policies in conjunction with access control policies; reapplying access control policies in this case does not perform a complete apply.
 
      	 [bookmark: pgfId-8722837]Select  Reapply access control policies after the rule update import completes to automatically reapply access control, network analysis, and file policies, but not intrusion policies. Selecting this option also updates the default values for any modified access control advanced settings. Because you cannot apply a network analysis policy independently of its parent access control policy, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     
 
     [bookmark: pgfId-8543324]Step 5 Click Import.
 
     [bookmark: pgfId-8543327]The system installs the rule update and displays the Rule Update Log detailed view; see Understanding the Rule Update Import Log Detailed View. The system also applies policies as you specified in the previous step; see Deploying Configuration Changes and Applying an Intrusion Policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-8216373]Note Contact Support if you receive an error message while installing the rule update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202786]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763541][bookmark: 43355]Using Recurring Rule Updates[bookmark: marker-7763540]
 
     [bookmark: pgfId-8025994]License: Any
 
     [bookmark: pgfId-8543595]You can import rule updates on a daily, weekly, or monthly basis, using the Rule Updates page.
 
     [bookmark: pgfId-8566685]Applicable subtasks in the rule update import occur in the following order: download, install, base policy update, and policy reapply. When one subtask completes, the next subtask begins. Note that you can only apply policies previously applied by the ASA FirePOWER module where the recurring import is configured.
 
     [bookmark: pgfId-8566689]To schedule recurring rule updates:
 
     
 
     [bookmark: pgfId-8568903]Step 1 Select Configuration > ASA FirePOWER Configuration > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8040360]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8566555]Tip You can also click Import Rules on the Rule Editor page (Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8053324]Step 2 Optionally, click Delete All Local Rules, then click OK to move all user-defined rules that you have created or imported to the deleted folder. See Deleting Custom Rules for more information.
 
     [bookmark: pgfId-8053331]Step 3 Select Enable Recurring Rule Update Imports.
 
     [bookmark: pgfId-7835066]The page expands to display options for configuring recurring imports. Import status messages appear beneath the Recurring Rule Update Imports section heading. Recurring imports are enabled when you save your settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-7763620]Tip To disable recurring imports, clear the Enable Recurring Rule Update Imports check box and click Save.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8543439]Step 4 In the Import Frequency field, select Daily, Weekly, or Monthly from the drop-down list.
 
     [bookmark: pgfId-8543440]If you selected a weekly or monthly import frequency, use the drop-down lists that appear to select the day of the week or month when you want to import rule updates. Select from a recurring task drop-down list either by clicking or by typing the first letter or number of your selection one or more times and pressing Enter.
 
     [bookmark: pgfId-7763634]Step 5 In the Import Frequency field, specify the time when you want to start your recurring rule update import.
 
     [bookmark: pgfId-8543361]Step 6 [bookmark: 40964][bookmark: 14941]Optionally, reapply policies after the update completes:
 
      
      	 [bookmark: pgfId-8566878]Select  Reapply intrusion policies after the rule update import completes to automatically reapply intrusion policies. Choose only this option to update rules and other changed intrusion policy settings without having to update any other access control configurations you may have made. You  must select this option to reapply intrusion policies in conjunction with access control policies; reapplying access control policies in this case does not perform a complete apply.
 
      	 [bookmark: pgfId-8566879]Select  Reapply access control policies after the rule update import completes to automatically reapply access control policies and their network analysis and file policies, but not intrusion policies. Selecting this option also updates the default values for any modified access control advanced settings. Because you cannot apply a network analysis policy independently of its parent access control policy, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     
 
     [bookmark: pgfId-7763647]Step 7 Click Save to enable recurring rule update imports using your settings.
 
     [bookmark: pgfId-8543496]The status message under the Recurring Rule Update Imports section heading changes to indicate that the rule update has not yet run. At the scheduled time, the system installs the rule update and applies policies as you specified in the previous step; see Deploying Configuration Changes and Applying an Intrusion Policy.
 ), and you can view messages as they occur in the Rule Update Log detailed view. Depending on the rule update size and content, several minutes may pass before status messages appear. For more information, see 
     Viewing the Rule Update Log. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8224305]Note Contact Support if you receive an error message while installing the rule update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202763]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763701][bookmark: 76591]Importing Local[bookmark: marker-7763700] Rule Files
 
     [bookmark: pgfId-8026123]License: Any
 
     [bookmark: pgfId-7832209]A local rule is a custom standard text rule that you import from a local machine as a plain text file with ASCII or UTF-8 encoding. You can create local rules using the instructions in the Snort users manual, which is available at http://www.snort.org.
 
     [bookmark: pgfId-7763711]Note the following regarding importing local rules:
 
      
      	 [bookmark: pgfId-7763712]The text file name can include alphanumeric characters, spaces, and no special characters other than underscore ( _ ), period ( . ), and dash ( - ).
 
      	 [bookmark: pgfId-8175133]You do not have to specify a Generator ID (GID); if you do, you can specify only GID 1 for a standard text rule or 138 for a sensitive data rule.
 
      	 [bookmark: pgfId-7768440]Do  not specify a Snort ID (SID) or revision number when importing a rule for the first time; this avoids collisions with SIDs of other rules, including deleted rules.
 
     
 
     [bookmark: pgfId-7763716]The system will automatically assign the rule the next available custom rule SID of 1000000 or greater, and a revision number of 1.
 
      
      	 [bookmark: pgfId-7763720]You  must include the SID assigned by the system and a revision number greater than the current revision number when importing an updated version of a local rule that you have previously imported.
 
     
 
     [bookmark: pgfId-8492062]To view the revision number for a current local rule, display the Rule Editor page, click on the local rule category to expand the folder, then click Edit next to the rule.
 
      
      	 [bookmark: pgfId-7763725]You can reinstate a local rule that you have deleted by importing the rule using the SID assigned by the system and a revision number greater than the current revision number. Note that the system automatically increments the revision number when you delete a local rule; this is a device that allows you to reinstate local rules.
 
     
 
     [bookmark: pgfId-8492067]To view the revision number for a deleted local rule, display the Rule Editor page, click on the deleted rule category to expand the folder, then click Edit next to the rule.
 
      
      	 [bookmark: pgfId-8143355]You cannot import a rule file that includes a rule with a SID greater than 2147483647; the import will fail.
 
      	 [bookmark: pgfId-8143547]If you import a rule that includes a list of source or destination ports that is longer than 64 characters, the import will fail.
 
      	 [bookmark: pgfId-8143356]The system always sets local rules that you import to the disabled rule state; you must manually set the state of local rules before you can use them in your intrusion policy. See Setting Rule States for more information.
 
      	 [bookmark: pgfId-7763747]You must make sure that the rules in the file do not contain any escape characters.
 
      	 [bookmark: pgfId-8466856]The rules importer requires that all custom rules are imported in ASCII or UTF-8 encoding.
 
      	 [bookmark: pgfId-8466857]All imported local rules are automatically saved in the local rule category.
 
      	 [bookmark: pgfId-8492072]All deleted local rules are moved from the local rule category to the deleted rule category.
 
      	 [bookmark: pgfId-8466859]The system imports local rules preceded with a single pound character (#).
 
      	 [bookmark: pgfId-8002676]The system ignores local rules preceded with two pound characters (##) and does not import them.
 
      	 [bookmark: pgfId-8002678]Policy validation fails if you enable an imported local rule that uses the deprecated  threshold keyword in combination with the intrusion event thresholding feature in an intrusion policy. See Configuring Event Thresholding for more information.
 
     
 
     [bookmark: pgfId-7763762]To import local rule files:
 
     
 
     [bookmark: pgfId-8493968]Step 1 Select Configuration > ASA FirePOWER Configuration > Update, then select the Rule Updates tab.
 
     [bookmark: pgfId-8493969]The Rule Updates page appears.
 
     [bookmark: pgfId-8493970]Step 2 Select Rule Update or text rule file to upload and install and click Choose File to navigate to the rule file. Note that all rules uploaded in this manner are saved in the local rule category.
 
      
       
     
 
     
 
     [bookmark: pgfId-8566950]Tip You can import only plain text files with ASCII or UTF-8 encoding.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7763795]Step 3 Click Import.
 
     [bookmark: pgfId-7763796]The rule file is imported. Make sure you enable the appropriate rules in your intrusion policies. The rules are not activated until the next time you apply the affected policies. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7763800]Note The system does not use the new rule set for inspection until after you apply your intrusion policies. See Deploying Configuration Changes for procedures.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202736]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763810][bookmark: 45056]Viewing th[bookmark: marker-7763805]e Rule Update Log
 
     [bookmark: pgfId-8558056]License: Any
 
     [bookmark: pgfId-8558061]The ASA FirePOWER module generates a record for each rule update and local rule file that you import.
 
      
      
 
      [bookmark: pgfId-8080775] 
      
 
      
 
       
        
        [bookmark: pgfId-8080754]Table 37-2 [bookmark: 62720]Rule Update Log Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8080758]To... 
          
  
         	 
           
           [bookmark: pgfId-8080760]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8080762]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-8080766]find more information in Understanding the Rule Update Log Table.
  
        
 
         
         	[bookmark: pgfId-8080769]delete an import file record from the import log, including detailed records for all objects included with the file
  ) next to the file name for the import file. Note Deleting the file from the log does not delete any object imported in the import file, but only deletes the import log records. 
        
 
         
         	[bookmark: pgfId-8080777]view details for each object imported in a rule update or local rule file
  ) next to the file name for the import file. 
        
 
        
      
 
     
 
     [bookmark: pgfId-8080784]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8080920]Understanding the Rule Update Log Table describes the fields in the list of rule updates and local rule files that you import.
 
      	 [bookmark: pgfId-8080957]Viewing Rule Update Import Log Details describes the detailed record for each object imported in a rule update or local rule file.
 
      	 [bookmark: pgfId-8080972]Understanding the Rule Update Import Log Detailed View describes each field in the Rule Update Log detailed view.
 
     
 
     [bookmark: pgfId-8080786]To view the Rule Update Log:
 
     
 
     [bookmark: pgfId-8056672]Step 1 Select Configuration > ASA FirePOWER Configuration > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8543096]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8566568]Tip You can also click Import Rules on the Rule Editor page (Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8543098]Step 2 Click Rule Update Log.
 
     [bookmark: pgfId-8068989]The Rule Update Log page appears. This page lists each imported rule update and local rule file.
 
     [bookmark: pgfId-8202709]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763903][bookmark: 64770]Unders[bookmark: marker-7763899]tanding the Rule Update Log Table
 
     [bookmark: pgfId-8026246]License: Any
 
     [bookmark: pgfId-8071166]The fields in the list of rule updates and local rule files that you import are described in the following table.
 
     [bookmark: pgfId-8071225]
 
      
       
        
        [bookmark: pgfId-8071179]Table 37-3 [bookmark: 68046]Rule Update Log Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-8071183]Field 
          
  
         	 
           
           [bookmark: pgfId-8071185]Description 
          
  
        
 
         
         	[bookmark: pgfId-8071187]Summary
  
         	[bookmark: pgfId-8071189]The name of the import file. If the import fails, a brief statement of the reason for the failure appears under the file name.
  
        
 
         
         	[bookmark: pgfId-8071191]Time
  
         	[bookmark: pgfId-8071193]The time and date that the import started.
  
        
 
         
         	[bookmark: pgfId-8071195]User ID
  
         	[bookmark: pgfId-8071197]The user name of the user that triggered the import.
  
        
 
         
         	[bookmark: pgfId-8071199]Status
  
         	[bookmark: pgfId-8071201]Whether the import:
 
           
           	 [bookmark: pgfId-8071205]succeeded (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-8071209]failed or is currently in progress (
 
           [image: ] ) 
          
 [bookmark: pgfId-8071210]Tip The red status icon indicating an unsuccessful or incomplete import appears on the Rule Update Log page during the import and is replaced by the green icon only when the import has successfully completed.  
        
 
        
      
 
     
 ) to delete the file record and all detailed object records imported with the file. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8071232]Tip You can view import details as they appear while a rule update import is in progress.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8071241][bookmark: 19390]Viewing Rule Update Import Log Details
 
     [bookmark: pgfId-8026264]License: Any
 
     [bookmark: pgfId-8026273]The Rule Update Import Log detailed view lists a detailed record for each object imported in a rule update or local rule file. You can also create a custom workflow or report from the records listed that includes only the information that matches your specific needs.
 
      
       
        
        [bookmark: pgfId-8026294]Table 37-4 [bookmark: 48634]Rule Update Import Log Detailed View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8026298]To... 
          
  
         	 
           
           [bookmark: pgfId-8026300]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8026302]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-8026306]find more information in Understanding the Rule Update Import Log Detailed View.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7764100]To view the Rule Update Import Log Detailed View:
 
     
 
     [bookmark: pgfId-8535765]Step 1 Select Configuration > ASA FirePOWER Configuration > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8535766]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8566585]Tip You can also click Import Rules on the Rule Editor page (Configuration > ASA FirePOWER Configuration > Policies > Intrusion Policy > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8494067]Step 2 Click Rule Update Log.
 
     [bookmark: pgfId-8071669]The Rule Update Log page appears.
 ) next to the file whose detailed records you want to view. 
     
 
     [bookmark: pgfId-7764118]The table view of detailed records appears.
 
     [bookmark: pgfId-8202691]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8026414][bookmark: 88409]Understand[bookmark: marker-8026410]ing the Rule Update Import Log Detailed View
 
     [bookmark: pgfId-8026428]License: Any
 
     [bookmark: pgfId-8071790]You can view a detailed record for each object imported in a rule update or local rule file. The fields in the Rule Update Log detailed view are described in the following table.
 
     [bookmark: pgfId-8739818]
 
      
       
        
        [bookmark: pgfId-8739737]Table 37-5 [bookmark: 88968]Rule Update Import Log Detailed View Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-8739741]Field 
          
  
         	 
           
           [bookmark: pgfId-8739743]Description 
          
  
        
 
         
         	[bookmark: pgfId-8739745]Time
  
         	[bookmark: pgfId-8739747]The time and date the import began.
  
        
 
         
         	[bookmark: pgfId-8739749]Name
  
         	[bookmark: pgfId-8739751]The name of the imported object, which for rules corresponds to the rule Message field, and for rule update components is the component name.
  
        
 
         
         	[bookmark: pgfId-8739753]Type
  
         	[bookmark: pgfId-8739755]The type of imported object, which can be one of the following:
 
           
           	 [bookmark: pgfId-8739756] rule update component (an imported component such as a rule pack or policy pack)
 
           	 [bookmark: pgfId-8739757] rule (for rules, a new or updated rule; note that in Version 5.0.1 this value replaced the  update value, which is deprecated)
 
           	 [bookmark: pgfId-8739758] policy apply  (the  Reapply intrusion policies after the Rule Update import completes option was enabled for the import)
 
          
  
        
 
         
         	[bookmark: pgfId-8739760]Action
  
         	[bookmark: pgfId-8739762]An indication that one of the following has occurred for the object type:
 
           
           	 [bookmark: pgfId-8739767] new (for a rule, this is the first time the rule has been stored on this ASA FirePOWER module)
 
           	 [bookmark: pgfId-8739768] changed (for a rule update component or rule, the rule update component has been modified, or the rule has a higher revision number and the same GID and SID)
 
           	 [bookmark: pgfId-8739769] collision (for a rule update component or rule, import was skipped because its revision conflicts with an existing component or rule)
 
           	 [bookmark: pgfId-8739771] deleted (for rules, the rule has been deleted from the rule update)
 
           	 [bookmark: pgfId-8739772] enabled (for a rule update edit, a preprocessor, rule, or other feature has been enabled in a system-provided policy)
 
           	 [bookmark: pgfId-8739775] disabled (for rules, the rule has been disabled in a system-provided policy)
 
           	 [bookmark: pgfId-8739777] drop (for rules, the rule has been set to Drop and Generate Events in a system-provided policy)
 
           	 [bookmark: pgfId-8739778] error (for a rule update or local rule file, the import failed)
 
           	 [bookmark: pgfId-8739779] apply (the  Reapply intrusion policies after the Rule Update import completes option was enabled for the import)
 
          
  
        
 
         
         	[bookmark: pgfId-8739781]Default Action
  
         	[bookmark: pgfId-8739783]The default action defined by the rule update. When the imported object type is rule, the default action is Pass, Alert, or Drop. For all other imported object types, there is no default action.
  
        
 
         
         	[bookmark: pgfId-8739785]GID
  
         	[bookmark: pgfId-8739795]The generator ID for a rule. For example, 1 (standard text rule) or 3 (shared object rule).
  
        
 
         
         	[bookmark: pgfId-8739798]SID
  
         	[bookmark: pgfId-8739800]The SID for a rule.
  
        
 
         
         	[bookmark: pgfId-8739802]Rev
  
         	[bookmark: pgfId-8739804]The revision number for a rule.
  
        
 
         
         	[bookmark: pgfId-8739806]Policy
  
         	[bookmark: pgfId-8739808]For imported rules, this field displays All, which indicates that the imported rule was included in all system-provided intrusion policies. For other types of imported objects, this field is blank.
  
        
 
         
         	[bookmark: pgfId-8739811]Details
  
         	[bookmark: pgfId-8739813]A string unique to the component or rule. For rules, the GID, SID, and previous revision number for a changed rule, displayed as previously (GID:SID:Rev). This field is blank for a rule that has not changed.
  
        
 
         
         	[bookmark: pgfId-8739815]Count
  
         	[bookmark: pgfId-8828050][bookmark: 14076][bookmark: 92136]Updating the [bookmark: marker-8739823]Geolocation Database
 [bookmark: pgfId-8739831]License: Any
 [bookmark: pgfId-8569034]The Cisco Geolocation Database (GeoDB) is a database of geographical data associated with routable IP addresses. The ASA FirePOWER module provides the country and continent. When your system detects GeoDB information that matches a detected IP address, you can view the geolocation information associated with that IP address. Cisco issues periodic updates to the GeoDB. 
 [bookmark: pgfId-8768201]To update the GeoDB, use the Geolocation Updates page (Configuration > ASA FirePOWER Configuration > Updates > Geolocation Updates). When you upload GeoDB updates, they appear on this page. 
 [bookmark: pgfId-8768205]The installation usually takes 30 to 40 minutes. Although a GeoDB update does not interrupt any other system functions (including the ongoing collection of geolocation information), the update does consume system resources while it completes. Consider this when planning your updates.
 [bookmark: pgfId-8167707]This section explains how to plan for and perform manual GeoDB updates. You can also take advantage of the automated update feature to schedule GeoDB updates; for more information, see Automating Geolocation Database Updates. 
 [bookmark: pgfId-8167711]To update the geolocation database:
 
          
 [bookmark: pgfId-8474052]Step 1 Select Configuration > ASA FirePOWER Configuration > Updates.
 [bookmark: pgfId-8247814]The Product Updates page appears.
 [bookmark: pgfId-8159814]Step 2 Click the Geolocation Updates tab.
 [bookmark: pgfId-8159856]The Geolocation Updates page appears.
 [bookmark: pgfId-8558038]Step 3 Upload the update.
 
           
            
            	 [bookmark: pgfId-8661259]If your ASA FirePOWER module has access to the Internet, click  Download and install geolocation update from the Support Site  to check for the latest updates on either of the following Support Sites:
 
           
 
          
 [bookmark: pgfId-8661261] – Sourcefire: (https://support.sourcefire.com/)
 [bookmark: pgfId-8558028] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
           
            
            	 [bookmark: pgfId-8558032]If your ASA FirePOWER module does not have access to the Internet, manually download the update from either of the Support Sites, then click  Upload and install geolocation update . Click  Choose File  to navigate to and select the update and click  Import :
 
           
 
          
 [bookmark: pgfId-8246861] – Sourcefire: (https://support.sourcefire.com/)
 [bookmark: pgfId-8209353] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
           
            
          
 
          
 [bookmark: pgfId-8160214]Note Download the update directly from the Support Site, either manually or by clicking Download and install geolocation update from the Support Site on the Geolocation Updates page. If you transfer an update file by email, it may become corrupted.
 
           
           
 
          

 [bookmark: pgfId-8224276]The update process begins. The average duration of update installation is 30 to 40 minutes. You can monitor the update’s progress in the task queue (Monitoring > ASA FirePOWER Monitoring > Task Status).
 [bookmark: pgfId-8160358]Step 4 After the update finishes, return to the Geolocation Updates page to confirm that the GeoDB build number matches the update you installed.
 [bookmark: pgfId-8160939]The GeoDB update overrides any previous versions of the GeoDB and is effective immediately. Although it may take a few minutes for a GeoDB update to take effect throughout your deployment, you do not have to reapply access control policies after you update.
 [bookmark: pgfId-8202685]
 
           
           
 
          

 [bookmark: pgfId-7729185]
 
          
  
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-3510725][bookmark: 11549]Monitori[bookmark: marker-3510724]ng the System 
      
      
 
     
 
 
    [bookmark: pgfId-3614639]The ASA FirePOWER module ASA FirePOWER module provides many useful monitoring features to assist you in the daily administration of your system, all on a single page. For example, on the Host Statistics page you can monitor basic host statistics. The following sections provide more information about the monitoring features that the system provides:
 
     
     	 [bookmark: pgfId-1870447]Viewing Host Statistics describes how to view host information such as:
 
      
      	 [bookmark: pgfId-2187702]system uptime
 
      	 [bookmark: pgfId-2187707]disk and memory usage
 
      	 [bookmark: pgfId-2187724]system processes
 
      	 [bookmark: pgfId-3731042]intrusion event information
 
     
 
     	 [bookmark: pgfId-3862566]Monitoring System Status and Disk Space Usage describes how to view basic event and disk partition information.
 
     	 [bookmark: pgfId-1870490]Viewing System Process Status describes how to view basic process status.
 
     	 [bookmark: pgfId-2187738]Understanding Running Processes describes the basic system processes that run on the appliance.
 
    
 
   
 
    
     [bookmark: pgfId-2682497][bookmark: 37283]Viewing[bookmark: marker-3717508] Host Statistics
 
    [bookmark: pgfId-3838141]License: Any
 
    [bookmark: pgfId-3729628]The Statistics page lists the current status of the following:
 
     
     	 [bookmark: pgfId-3729629]general host statistics; see the  Host Statistics  table for details
 
     	 [bookmark: pgfId-3864492]intrusion event information (requires Protection); see Viewing Events or details
 
    
 
    [bookmark: pgfId-3897848]The following table describes the host statistics listed on the Statistics page.
 
    [bookmark: pgfId-3739557]
 
     
      
       
       [bookmark: pgfId-3739520]Table 38-1 [bookmark: 88115]Host Statistics 
 
       
       
        
        	 
          
          [bookmark: pgfId-3739524]Category 
         
  
        	 
          
          [bookmark: pgfId-3739526]Description 
         
  
       
 
        
        	[bookmark: pgfId-3739528]Time
  
        	[bookmark: pgfId-3739530]The current time on the system.
  
       
 
        
        	[bookmark: pgfId-3739532]Uptime
  
        	[bookmark: pgfId-3739534]The number of days (if applicable), hours, and minutes since the system was last started.
  
       
 
        
        	[bookmark: pgfId-3739536]Memory Usage
  
        	[bookmark: pgfId-3739538]The percentage of system memory that is being used.
  
       
 
        
        	[bookmark: pgfId-3739540]Load Average
  
        	[bookmark: pgfId-3739542]The average number of processes in the CPU queue for the past 1 minute, 5 minutes, and 15 minutes.
  
       
 
        
        	[bookmark: pgfId-3739544]Disk Usage
  
        	[bookmark: pgfId-3739546]The percentage of the disk that is being used. Click the arrow to view more detailed host statistics. See Monitoring System Status and Disk Space Usage for more information.
  
       
 
        
        	[bookmark: pgfId-3739551]Processes
  
        	[bookmark: pgfId-3739553]A summary of the processes running on the system. See Viewing System Process Status for more information.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3864542]To view the Statistics page:
 
    
 
    [bookmark: pgfId-3731105]Step 1 Select Monitoring > ASA FirePOWER Monitoring > Statistics.
 
    [bookmark: pgfId-3731106]The Statistics page appears.
 
    [bookmark: pgfId-3892374]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2449040][bookmark: 40699]Monitoring System Status and[bookmark: marker-3717509] Disk Space Usage
 
    [bookmark: pgfId-3838174]License: Any
 
    [bookmark: pgfId-1870771]The Disk Usage section of the Statistics page provides a quick synopsis of disk usage, both by category and by partition status. If you have a malware storage pack installed on a device, you can also check its partition status. You can monitor this page from time to time to ensure that enough disk space is available for system processes and the database. 
 
    [bookmark: pgfId-1870772]To access disk usage information:
 
    
 
    [bookmark: pgfId-1879473]Step 1 Select Monitoring > ASA FirePOWER Monitoring > Statistics.
 
    [bookmark: pgfId-2319474]The Statistics page appears. 
 
    [bookmark: pgfId-3884294]For more information on the disk usage categories, see Understanding the Disk Usage Widget.
 
    [bookmark: pgfId-1879474]Step 2 Click the down arrow next to Total to expand it.
 
    [bookmark: pgfId-1879480]The Disk Usage section expands, displaying partition usage. If you have a malware storage pack installed, the /var/storage partition usage is also displayed.
 
    [bookmark: pgfId-3900653]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1880095][bookmark: 96982][bookmark: 95994]Viewing System Process Status[bookmark: marker-1880094]
 
    [bookmark: pgfId-3838205]License: Any
 
    [bookmark: pgfId-1747404]The Processes section of the Host Statistics page allows you to see the processes that are currently running on an appliance. It provides general process information and specific information for each running process. 
 
    [bookmark: pgfId-3740913]The following table describes each column that appears in the process list.
 
    [bookmark: pgfId-3740968]
 
     
      
       
       [bookmark: pgfId-3741008]Table 38-2 [bookmark: 39796]Process Status 
 
       
       
        
        	 
          
          [bookmark: pgfId-3740916]Column 
         
  
        	 
          
          [bookmark: pgfId-3740918]Description 
         
  
       
 
        
        	[bookmark: pgfId-3740920]Pid
  
        	[bookmark: pgfId-3740922]The process ID number
  
       
 
        
        	[bookmark: pgfId-3740924]Username
  
        	[bookmark: pgfId-3740926]The name of the user or group running the process
  
       
 
        
        	[bookmark: pgfId-3740928]Pri
  
        	[bookmark: pgfId-3740930]The process priority
  
       
 
        
        	[bookmark: pgfId-3740932]Nice
  
        	[bookmark: pgfId-3740934]The nice value, which is a value that indicates the scheduling priority of a process. Values range between -20 (highest priority) and 19 (lowest priority)
  
       
 
        
        	[bookmark: pgfId-3740936]Size
  
        	[bookmark: pgfId-3740938]The memory size used by the process (in kilobytes unless the value is followed by m, which indicates megabytes)
  
       
 
        
        	[bookmark: pgfId-3740940]Res
  
        	[bookmark: pgfId-3740942]The amount of resident paging files in memory (in kilobytes unless the value is followed by m, which indicates megabytes)
  
       
 
        
        	[bookmark: pgfId-3740944]State
  
        	[bookmark: pgfId-3740946]The process state:
 
          
          	 [bookmark: pgfId-3740947]D — process is in uninterruptible sleep (usually Input/Output)
 
          	 [bookmark: pgfId-3740948]N — process has a positive nice value
 
          	 [bookmark: pgfId-3740949]R — process is runnable (on queue to run)
 
          	 [bookmark: pgfId-3740950]S — process is in sleep mode
 
          	 [bookmark: pgfId-3740951]T — process is being traced or stopped
 
          	 [bookmark: pgfId-3740952]W — process is paging
 
          	 [bookmark: pgfId-3740953]X — process is dead
 
          	 [bookmark: pgfId-3740954]Z — process is defunct
 
          	 [bookmark: pgfId-3740955]< — process has a negative nice value
 
         
  
       
 
        
        	[bookmark: pgfId-3740957]Time
  
        	[bookmark: pgfId-3740959]The amount of time (in hours:minutes:seconds) that the process has been running
  
       
 
        
        	[bookmark: pgfId-3740961]Cpu
  
        	[bookmark: pgfId-3740963]The percentage of CPU that the process is using
  
       
 
        
        	[bookmark: pgfId-3740965]Command
  
        	[bookmark: pgfId-3740967]The executable name of the process
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1885825]To expand the process list:
 
    
 
    [bookmark: pgfId-2319485]Step 1 Select Monitoring > ASA FirePOWER Monitoring > Statistics.
 
    [bookmark: pgfId-2319486]The Statistics page appears.
 
    [bookmark: pgfId-3672686]Step 2 Click the down arrow next to Processes.
 
    [bookmark: pgfId-2432789]The process list expands, listing general process status information that includes the number and types of running tasks, the current time, the current system uptime, the system load average, CPU, memory, and swap information, and specific information about each running process.
 
    [bookmark: pgfId-2432791]Cpu(s) lists the following CPU usage information:
 
     
      
      	 [bookmark: pgfId-1886317]user process usage percentage
 
      	 [bookmark: pgfId-1886318]system process usage percentage
 
      	 [bookmark: pgfId-1886319]nice usage percentage (CPU usage of processes that have a negative nice value, indicating a higher priority)
 
     
 
    
 
    [bookmark: pgfId-1886320]Nice values indicate the scheduled priority for system processes and can range between -20 (highest priority) and 19 (lowest priority).
 
     
      
      	 [bookmark: pgfId-1886321]idle usage percentage
 
     
 
    
 
    [bookmark: pgfId-1886322]Mem lists the following memory usage information: 
 
     
      
      	 [bookmark: pgfId-1886323]total number of kilobytes in memory
 
      	 [bookmark: pgfId-1886324]total number of used kilobytes in memory
 
      	 [bookmark: pgfId-1886325]total number of free kilobytes in memory
 
      	 [bookmark: pgfId-1886326]total number of buffered kilobytes in memory
 
     
 
    
 
    [bookmark: pgfId-1886327]Swap lists the following swap usage information:
 
     
      
      	 [bookmark: pgfId-1886328]total number of kilobytes in swap
 
      	 [bookmark: pgfId-1886329]total number of used kilobytes in swap
 
      	 [bookmark: pgfId-1886330]total number of free kilobytes in swap
 
      	 [bookmark: pgfId-1886331]total number of cached kilobytes in swap
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2193309]Note For more information about the types of processes that run on the appliance, see Understanding Running Processes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3892398]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1887296]To collapse the process list:
 
    
 
    [bookmark: pgfId-1885848]Step 1 Click the up arrow next to Processes.
 
    [bookmark: pgfId-3643515]The process list collapses.
 
    [bookmark: pgfId-3892392]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3643554][bookmark: 22287][bookmark: 90556]Understanding Running Pr[bookmark: marker-3784440]ocesses
 
    [bookmark: pgfId-3866960]License: Any
 
    [bookmark: pgfId-1766117]There are two different types of processes that run on an appliance: daemons and executable files. Daemons always run, and executable files are run when required.
 
    [bookmark: pgfId-1869869]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1766122]Understanding System Daemons
 
     	 [bookmark: pgfId-1766126]Understanding Executables and System Utilities
 
    
 
     
      [bookmark: pgfId-1766160][bookmark: 35744]Understanding[bookmark: marker-3717510] System Daemons
 
     [bookmark: pgfId-3866982]License: Any
 
     [bookmark: pgfId-1766161]Daemons continually run on an appliance. They ensure that services are available and spawn processes when required. The following table lists daemons that you may see on the Process Status page and provides a brief description of their functionality.
 
      
       
     
 
     
 
     [bookmark: pgfId-1766168]Note The table below is not an exhaustive list of all processes that may run on an appliance.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1766264]
 
      
       
        
        [bookmark: pgfId-3737802]Table 38-3 [bookmark: 94643]System Daemons 
 
        
        
         
         	 
           
           [bookmark: pgfId-3737806]Daemon 
          
  
         	 
           
           [bookmark: pgfId-3737808]Description 
          
  
        
 
         
         	[bookmark: pgfId-3737810]crond
  
         	[bookmark: pgfId-3737812]Manages the execution of scheduled commands (cron jobs)
  
        
 
         
         	[bookmark: pgfId-3737814]dhclient
  
         	[bookmark: pgfId-3737816]Manages dynamic host IP addressing
  
        
 
         
         	[bookmark: pgfId-3737822]httpd
  
         	[bookmark: pgfId-3737824]Manages the HTTP (Apache web server) process
  
        
 
         
         	[bookmark: pgfId-3737826]httpsd
  
         	[bookmark: pgfId-3737828]Manages the HTTPS (Apache web server with SSL) service, and checks for working SSL and valid certificate authentication; runs in the background to provide secure web access to the appliance
  
        
 
         
         	[bookmark: pgfId-3737833]keventd
  
         	[bookmark: pgfId-3737835]Manages Linux kernel event notification messages
  
        
 
         
         	[bookmark: pgfId-3737837]klogd
  
         	[bookmark: pgfId-3737839]Manages the interception and logging of Linux kernel messages
  
        
 
         
         	[bookmark: pgfId-3737841]kswapd
  
         	[bookmark: pgfId-3737843]Manages Linux kernel swap memory
  
        
 
         
         	[bookmark: pgfId-3737845]kupdated
  
         	[bookmark: pgfId-3737847]Manages the Linux kernel update process, which performs disk synchronization
  
        
 
         
         	[bookmark: pgfId-3737849]mysqld
  
         	[bookmark: pgfId-3737854]Manages ASA FirePOWER module database processes
  
        
 
         
         	[bookmark: pgfId-3737856]ntpd
  
         	[bookmark: pgfId-3737858]Manages the Network Time Protocol (NTP) process
  
        
 
         
         	[bookmark: pgfId-3737860]pm
  
         	[bookmark: pgfId-3737865]Manages all Cisco processes, starts required processes, restarts any process that fails unexpectedly
  
        
 
         
         	[bookmark: pgfId-3737867]reportd
  
         	[bookmark: pgfId-3737869]Manages reports
  
        
 
         
         	[bookmark: pgfId-3737878]safe_mysqld
  
         	[bookmark: pgfId-3737883]Manages safe mode operation of the database; restarts the database daemon if an error occurs and logs runtime information to a file
  
        
 
         
         	[bookmark: pgfId-3737896]sfmgr
  
         	[bookmark: pgfId-3737898]Provides the RPC service for remotely managing and configuring an appliance using an sftunnel connection to the appliance
  
        
 
         
         	[bookmark: pgfId-3737925]sftroughd
  
         	[bookmark: pgfId-3737927]Listens for connections on incoming sockets and then invokes the correct executable (typically the Cisco message broker, sfmb) to handle the request
  
        
 
         
         	[bookmark: pgfId-3737929]sftunnel
  
         	[bookmark: pgfId-3737931]Provides the secure communication channel for all processes requiring communication with a remote appliance
  
        
 
         
         	[bookmark: pgfId-3737933]sshd
  
         	[bookmark: pgfId-3737935]Manages the Secure Shell (SSH) process; runs in the background to provide SSH access to the appliance
  
        
 
         
         	[bookmark: pgfId-3737940]syslogd
  
         	[bookmark: pgfId-3737942]Manages the system logging (syslog) process
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1766274][bookmark: 13617]Understanding Executables and[bookmark: marker-3717511] System Utilities
 
     [bookmark: pgfId-3866993]License: Any
 
     [bookmark: pgfId-1766275]There are a number of executables on the system that run when executed by other processes or through user action. The following table describes the executables that you may see on the Process Status page.
 
     [bookmark: pgfId-3852883]
 
      
       
        
        [bookmark: pgfId-3864169]Table 38-4 [bookmark: 81495]System Executables and Utilities 
 
        
        
         
         	 
           
           [bookmark: pgfId-3864173]Executable 
          
  
         	 
           
           [bookmark: pgfId-3864175]Description 
          
  
        
 
         
         	[bookmark: pgfId-3864177]awk
  
         	[bookmark: pgfId-3864179]Utility that executes programs written in the awk programming language
  
        
 
         
         	[bookmark: pgfId-3864181]bash
  
         	[bookmark: pgfId-3864183]GNU Bourne-Again SHell
  
        
 
         
         	[bookmark: pgfId-3864185]cat
  
         	[bookmark: pgfId-3864187]Utility that reads files and writes content to standard output
  
        
 
         
         	[bookmark: pgfId-3864189]chown
  
         	[bookmark: pgfId-3864191]Utility that changes user and group file permissions
  
        
 
         
         	[bookmark: pgfId-3864193]chsh
  
         	[bookmark: pgfId-3864195]Utility that changes the default login shell
  
        
 
         
         	[bookmark: pgfId-3864210]cp
  
         	[bookmark: pgfId-3864212]Utility that copies files
  
        
 
         
         	[bookmark: pgfId-3864214]df
  
         	[bookmark: pgfId-3864216]Utility that lists the amount of free space on the appliance
  
        
 
         
         	[bookmark: pgfId-3864218]echo
  
         	[bookmark: pgfId-3864220]Utility that writes content to standard output
  
        
 
         
         	[bookmark: pgfId-3864222]egrep
  
         	[bookmark: pgfId-3864224]Utility that searches files and folders for specified input; supports extended set of regular expressions not supported in standard grep
  
        
 
         
         	[bookmark: pgfId-3864226]find
  
         	[bookmark: pgfId-3864228]Utility that recursively searches directories for specified input
  
        
 
         
         	[bookmark: pgfId-3864230]grep
  
         	[bookmark: pgfId-3864232]Utility that searches files and directories for specified input
  
        
 
         
         	[bookmark: pgfId-3864234]halt
  
         	[bookmark: pgfId-3864236]Utility that stops the server
  
        
 
         
         	[bookmark: pgfId-3864238]httpsdctl
  
         	[bookmark: pgfId-3864240]Handles secure Apache Web processes
  
        
 
         
         	[bookmark: pgfId-3864242]hwclock
  
         	[bookmark: pgfId-3864244]Utility that allows access to the hardware clock
  
        
 
         
         	[bookmark: pgfId-3864246]ifconfig
  
         	[bookmark: pgfId-3864248]Indicates the network configuration executable. Ensures that the MAC address stays constant
  
        
 
         
         	[bookmark: pgfId-3864250]iptables
  
         	[bookmark: pgfId-3864252]Handles access restriction based on changes made to the Access Configuration page. See Configuring the Access List for Your Appliance for more information about access configuration.
  
        
 
         
         	[bookmark: pgfId-3864257]iptables-restore
  
         	[bookmark: pgfId-3864259]Handles iptables file restoration
  
        
 
         
         	[bookmark: pgfId-3864261]iptables-save
  
         	[bookmark: pgfId-3864263]Handles saved changes to the iptables
  
        
 
         
         	[bookmark: pgfId-3864265]kill
  
         	[bookmark: pgfId-3864267]Utility that can be used to end a session and process
  
        
 
         
         	[bookmark: pgfId-3864269]killall
  
         	[bookmark: pgfId-3864271]Utility that can be used to end all sessions and processes
  
        
 
         
         	[bookmark: pgfId-3864273]ksh
  
         	[bookmark: pgfId-3864275]Public domain version of the Korn shell
  
        
 
         
         	[bookmark: pgfId-3864277]logger
  
         	[bookmark: pgfId-3864279]Utility that provides a way to access the syslog daemon from the command line
  
        
 
         
         	[bookmark: pgfId-3864281]md5sum
  
         	[bookmark: pgfId-3864283]Utility that prints checksums and block counts for specified files
  
        
 
         
         	[bookmark: pgfId-3864285]mv
  
         	[bookmark: pgfId-3864287]Utility that moves (renames) files
  
        
 
         
         	[bookmark: pgfId-3864289]myisamchk
  
         	[bookmark: pgfId-3864291]Indicates database table checking and repairing
  
        
 
         
         	[bookmark: pgfId-3864293]mysql
  
         	[bookmark: pgfId-3864295]Indicates a database process; multiple instances may appear
  
        
 
         
         	[bookmark: pgfId-3864297]openssl
  
         	[bookmark: pgfId-3864299]Indicates authentication certificate creation
  
        
 
         
         	[bookmark: pgfId-3864301]perl
  
         	[bookmark: pgfId-3864303]Indicates a perl process
  
        
 
         
         	[bookmark: pgfId-3864305]ps
  
         	[bookmark: pgfId-3864307]Utility that writes process information to standard output
  
        
 
         
         	[bookmark: pgfId-3864323]sed
  
         	[bookmark: pgfId-3864325]Utility used to edit one or more text files
  
        
 
         
         	[bookmark: pgfId-3864341]sh
  
         	[bookmark: pgfId-3864343]Public domain version of the Korn shell
  
        
 
         
         	[bookmark: pgfId-3864345]shutdown
  
         	[bookmark: pgfId-3864347]Utility that shuts down the appliance
  
        
 
         
         	[bookmark: pgfId-3864349]sleep
  
         	[bookmark: pgfId-3864351]Utility that suspends a process for a specified number of seconds
  
        
 
         
         	[bookmark: pgfId-3864353]smtpclient
  
         	[bookmark: pgfId-3864355]Mail client that handles email transmission when email event notification functionality is enabled
  
        
 
         
         	[bookmark: pgfId-3864357]snmptrap
  
         	[bookmark: pgfId-3864359]Forwards SNMP trap data to the SNMP trap server specified when SNMP notification functionality is enabled
  
        
 
         
         	[bookmark: pgfId-3864361]snort
(requires Protection)
  
         	[bookmark: pgfId-3864366]Indicates that Snort is running
  
        
 
         
         	[bookmark: pgfId-3864368]ssh
  
         	[bookmark: pgfId-3864370]Indicates a Secure Shell (SSH) connection to the appliance
  
        
 
         
         	[bookmark: pgfId-3864372]sudo
  
         	[bookmark: pgfId-3864374]Indicates a sudo process, which allows users other than admin to run executables
  
        
 
         
         	[bookmark: pgfId-3864376]top
  
         	[bookmark: pgfId-3864378]Utility that displays information about the top CPU processes
  
        
 
         
         	[bookmark: pgfId-3864380]touch
  
         	[bookmark: pgfId-3864382]Utility that can be used to change the access and modification times of specified files
  
        
 
         
         	[bookmark: pgfId-3864384]vim
  
         	[bookmark: pgfId-3864386]Utility used to edit text files
  
        
 
         
         	[bookmark: pgfId-3864388]wc
  
         	[bookmark: pgfId-3864390]Utility that performs line, word, and byte counts on specified files
  
        
 
        
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1898576][bookmark: 22742][bookmark: 85440]Using Backup[bookmark: marker-6083429] and Restore 
      
      
 
     
 
 
    [bookmark: pgfId-7832682]Backup and restoration is an essential part of any system maintenance plan. While each organization’s backup plan is highly individualized, the ASA FirePOWER module provides a mechanism for archiving data so that data can be restored in case of disaster. 
 
    [bookmark: pgfId-7832690]Note the following limitations about backup and restore:
 
     
     	 [bookmark: pgfId-7821195]Backups are valid only for the product version on which you create them.
 
     	 [bookmark: pgfId-7125268]You can restore a backup only when running the same version of the ASA FirePOWER module software as that used to create the backup. 
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7727342] 
     Caution Do not use the backup and restore process to copy the configuration files between ASA FirePOWER modules. The configuration files include information that uniquely identifies an ASA FirePOWER module and cannot be shared. 
      
      
 
     
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7779097] 
     Caution If you applied any intrusion rule updates, those updates are not backed up. You need to apply the latest rule update 
     after you restore. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7739546]You can save backup files to the appliance or to your local computer. 
 
    [bookmark: pgfId-7739588]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7739531]See Creating Backup Files for information about creating backup files. 
 
     	 [bookmark: pgfId-7773204]See Creating Backup Profiles for information about creating backup profiles that you can use later as templates for creating backups. 
 
     	 [bookmark: pgfId-7259067]See Uploading Backups from a Local Host for information about uploading backup files from a local host.
 
     	 [bookmark: pgfId-1845557]See Restoring the Appliance from a Backup File for information about how to restore a backup file to the appliance.
 
    
 
   
 
    
     [bookmark: pgfId-1759507][bookmark: 69459]Creating Ba[bookmark: marker-1759506]ckup Files
 
    [bookmark: pgfId-7808470]License: Any
 
    [bookmark: pgfId-7849487]You can perform backups of the ASA FirePOWER module using the module interface. To view and use existing system backups, go to the Backup Management page. You should periodically save a backup file that contains all of the configuration files required to restore the appliance, in addition to event data. You may also want to back up the system when testing configuration changes so that you can revert to a saved configuration if needed. You can choose to save the backup file on the appliance or on your local computer. 
 
    [bookmark: pgfId-7833433]You cannot create a backup file if your appliance does not have enough disk space; backups may fail if the backup process uses more than 90% of available disk space. If necessary, delete old backup files, transfer old backup files off the appliance.
 
    [bookmark: pgfId-7832951]As an alternative, or if your backup file is larger than 4GB, copy it via SCP to a remote host. Uploading a backup from your local computer does not work on backup files larger than 4GB. 
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7832990] 
     Caution If you configured any interface associations with security zones, these associations are not backed up. You must reconfigure them after you restore. For more information, see 
     Working with Security Zones. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7833145]To create a backup file of the ASA FirePOWER module:
 
    
 
    [bookmark: pgfId-7833063]Step 1 Select Configuration > ASA FirePOWER Configuration > Tools > Backup/Restore.
 
    [bookmark: pgfId-7833064]The Backup Management page appears.
 
    [bookmark: pgfId-7833065]Step 2 Click Device Backup. 
 
    [bookmark: pgfId-7824980]The Create Backup page appears. 
 
    [bookmark: pgfId-7825178]Step 3 In the Name field, type a name for the backup file. You can use alphanumeric characters, punctuation, and spaces.
 
    [bookmark: pgfId-7825266]Step 4 Optionally, to be notified when the backup is complete, select the Email check box and type your email address in the accompanying text box.
 
     
      
    
 
    
 
    [bookmark: pgfId-7825269]Note To receive email notifications, you must configure a relay host as described in Configuring a Mail Relay Host and Notification Address.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7825274]Step 5 Optionally, to use secure copy (SCP) to copy the backup archive to a different machine, select the Copy when complete check box, then type the following information in the accompanying text boxes:
 
     
      
      	 [bookmark: pgfId-7825275]in the  Host field, the hostname or IP address of the machine where you want to copy the backup
 
      	 [bookmark: pgfId-7825276]in the  Path field, the path to the directory where you want to copy the backup
 
      	 [bookmark: pgfId-7825277]in the  User field, the user name you want to use to log into the remote machine
 
      	 [bookmark: pgfId-7825278]in the  Password field, the password for that user name
 If you prefer to access your remote machine with an SSH public key instead of a password, you must copy the contents of the  SSH Public Key field to the specified user’s  authorized_keys file on that machine.
 
     
 
    
 
    [bookmark: pgfId-7825279]With this option cleared, the system stores temporary files used during the backup on the remote server; temporary files are not stored on the remote server when this option is selected.
 
     
      
    
 
    
 
    [bookmark: pgfId-7825283]Tip Cisco recommends that you periodically save backups to a remote location so the appliance can be restored in case of system failure.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7825477]Step 6 You have the following options:
 
     
      
      	 [bookmark: pgfId-7825478]To save the backup file to the appliance, click  Start Backup . 
 
     
 
    
 
    [bookmark: pgfId-7825483]The backup file is saved [bookmark: marker-7825479]in the /var/sf/backup directory.
 
    [bookmark: pgfId-7825487]When the backup process is complete, you can view the file on the Restoration Database page. For information about restoring a backup file, see Restoring the Appliance from a Backup File.
 
     
      
      	 [bookmark: pgfId-7825491]To save this configuration as a backup profile that you can use later, click  Save As New .
 
     
 
    
 
    [bookmark: pgfId-7825492]You can modify or delete the backup profile by selecting Configuration > ASA FirePOWER Configuration > Tools > Backup/Restore, then clicking Backup Profiles. See Creating Backup Profiles for more information.
 
    [bookmark: pgfId-7825018]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7823568][bookmark: 90686]Creating[bookmark: marker-7773385] Backup Profiles
 
    [bookmark: pgfId-7795650]License: Any
 
    [bookmark: pgfId-7795360]You can use the Backup Profiles page to create backup profiles that contain the settings that you want to use for different types of backups. You can later select one of these profiles when you back up the files on your appliance.
 
     
      
    
 
    
 
    [bookmark: pgfId-7773404]Tip When you create a backup file as described in Creating Backup Files, a backup profile is automatically created.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7773405]To create a backup profile:
 
    
 
    [bookmark: pgfId-7773407]Step 1 Select Configuration > ASA FirePOWER Configuration > Tools > Backup/Restore.
 
    [bookmark: pgfId-7773408]The Backup Management page appears.
 
    [bookmark: pgfId-7773409]Step 2 Click the Backup Profiles tab.
 
    [bookmark: pgfId-7773410]The Backup Profiles page appears with a list of existing backup profiles.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7773416]Step 3 Click Create Profile.
 
   [bookmark: pgfId-7773417]The Create Backup page appears.
 
   [bookmark: pgfId-7773418]Step 4 Type a name for the backup profile. You can use alphanumeric characters, punctuation, and spaces.
 
   [bookmark: pgfId-7773420]Step 5 Configure the backup profile according to your needs.
 
   [bookmark: pgfId-7773424]See Creating Backup Files for more information about the options on this page.
 
   [bookmark: pgfId-7773425]Step 6 Click Save As New to save the backup profile.
 
   [bookmark: pgfId-7773426]The Backup Profiles page appears and your new profile appears in the list.
 
   [bookmark: pgfId-7826358]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7784333][bookmark: 42599]Uploading Backups from a Local Host
 
    [bookmark: pgfId-7795316]License: Any
 
    [bookmark: pgfId-7807700]If you download a backup file to your local host using the download function described in the Backup Management table, you can upload it to an ASA FirePOWER module.
 
    [bookmark: pgfId-7815908]If your backup file contains PKI objects, private keys associated with internal CA and internal certificate objects are re-encrypted on upload with a randomly generated key.
 
     
      
    
 
    
 
    [bookmark: pgfId-7807708]Tip You cannot upload a backup larger than 4GB from your local host. As an alternative, copy the backup via SCP to a remote host and retrieve it from there. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7258834]To upload a backup from your local host:
 
    
 
    [bookmark: pgfId-7842609]Step 1 Select Configuration > ASA FirePOWER Configuration > Tools > Backup/Restore.
 
    [bookmark: pgfId-7842610]The Backup Management page appears.
 
    [bookmark: pgfId-7258838]Step 2 Click Upload Backup.
 
    [bookmark: pgfId-7258839]The Upload Backup page appears.
 
    [bookmark: pgfId-7258840]Step 3 Click Choose File and navigate to the backup file you want to upload.
 
    [bookmark: pgfId-7258841]After you select the file to upload, click Upload Backup.
 
    [bookmark: pgfId-7258842]Step 4 Click Backup Management to return to the Backup Management page.
 
    [bookmark: pgfId-7258843]The backup file is uploaded and appears in the backup list. After the ASA FirePOWER moduleverifies the file integrity, refresh the Backup Management page to reveal detailed file system information.
 
    [bookmark: pgfId-7813227]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1759625][bookmark: 16670]Restor[bookmark: marker-1759621]ing the Appliance from a Backup File
 
    [bookmark: pgfId-7832607]License: Any
 
    [bookmark: pgfId-7801762]You can restore the appliance from backup files using the Backup Management page. To restore a backup, the VDB version in the backup file must match the current VDB version on your appliance. After you complete the restoration process, you must apply the latest Cisco Rule Update.
 
    [bookmark: pgfId-7808029]If you use local storage, backup files are saved to /var/sf/backup, which is listed with the amount of disk space used in the /var partition at the bottom of the Backup Management page. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7803516]Note If you add licenses after a backup has completed, these licenses will not be removed or overwritten if this backup is restored. To prevent a conflict on restore, remove those licenses before restoring the backup, noting where the licenses were used, and add and reconfigure them after restoring the backup. If a conflict occurs, contact Support.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1773354]Table 39-1 [bookmark: 90577]Backup Management 
 
       
       
        
        	 
          
          [bookmark: pgfId-1773358]Functionality 
         
  
        	 
          
          [bookmark: pgfId-1773360]Description 
         
  
       
 
        
        	[bookmark: pgfId-7256250]System Information
  
        	[bookmark: pgfId-7256252]The originating appliance name, type, and version. Note that you can only restore a backup to an identical appliance type and version.
  
       
 
        
        	[bookmark: pgfId-7256238]Date Created
  
        	[bookmark: pgfId-7256240]The date and time that the backup file was created
  
       
 
        
        	[bookmark: pgfId-1773366]File Name
  
        	[bookmark: pgfId-1773368]The full name of the backup file
  
       
 
        
        	[bookmark: pgfId-7803306]VDB Version
  
        	[bookmark: pgfId-7803308]The build of the vulnerability database (VDB) running on the appliance at the time of backup. 
  
       
 
        
        	[bookmark: pgfId-7312224]Location
  
        	[bookmark: pgfId-7312226]The location of the backup file
  
       
 
        
        	[bookmark: pgfId-1773370]Size (MB)
  
        	[bookmark: pgfId-1773372]The size of the backup file, in megabytes
  
       
 
        
        	[bookmark: pgfId-1773378]View
  
        	[bookmark: pgfId-1773380]Click the name of the backup file to view a list of the files included in the compressed backup file.
  
       
 
        
        	[bookmark: pgfId-1773382]Restore
  
        	[bookmark: pgfId-1773387]Click with the backup file selected to restore it on the appliance. If your VDB version does not match the VDB version in the backup file, this option is disabled.
  
       
 
        
        	[bookmark: pgfId-1773389]Download
  
        	[bookmark: pgfId-1773391]Click with the backup file selected to save it to your local computer.
  
       
 
        
        	[bookmark: pgfId-7257065]Delete
  
        	[bookmark: pgfId-7257067]Click with the backup file selected to delete it.
  
       
 
        
        	[bookmark: pgfId-1773393]Move
  
        	[bookmark: pgfId-1773395]When you have a previously created local backup selected, click to send the backup to the designated remote backup location.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1759686]To restore the appliance from a backup file:
 
    
 
    [bookmark: pgfId-7773829]Step 1 Select Configuration > ASA FirePOWER Configuration > Tools > Backup/Restore.
 
    [bookmark: pgfId-7773833]The Backup Management page appears.
 
    [bookmark: pgfId-5171103]Step 2 To view the contents of a backup file, click the name of the file.
 
    [bookmark: pgfId-5171108]The manifest appears, listing the name of each file, its owner and permissions, and its file size and date.
 
    [bookmark: pgfId-1759691]Step 3 Click Backup Management to return to the Backup Management page.
 
    [bookmark: pgfId-5171283]Step 4 Select the backup file that you want to restore and click Restore.
 
    [bookmark: pgfId-1759692]The Restore Backup page appears.
 
    [bookmark: pgfId-7791113]Note that if the VDB version in the backup does not match the VDB version currently installed on your appliance, the Restore button is grayed out.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-5911160] 
     Caution This procedure overwrites all configuration files and all event data. 
      
      
 
     
 
    
 
    [bookmark: pgfId-5911164]Step 5 To restore files, select either or both:
 
     
      
      	 [bookmark: pgfId-7313035] Replace Configuration Data 
 
      	 [bookmark: pgfId-7313043] Restore Event Data 
 
     
 
    
 
    [bookmark: pgfId-1759705]Step 6 Click Restore to begin the restoration.
 
    [bookmark: pgfId-1759710]The appliance is restored using the backup file you specified.
 
    [bookmark: pgfId-7833380]Step 7 Reboot the appliance.
 
    [bookmark: pgfId-7833384]Step 8 Apply the latest Cisco Rule Update to reapply rule updates.
 
    [bookmark: pgfId-7833385]Step 9 Reapply any access control, intrusion, and system policies to the restored system.
 
    [bookmark: pgfId-7813233]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2514234]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7891710]Generating Troubleshooting Files 
      
      
 
     
 
 
     
     [bookmark: pgfId-7903574]This option... 
    
 
     
     [bookmark: pgfId-7903576]Reports... 
    
 
    [bookmark: pgfId-7903578]Snort Performance and Configuration
 
    [bookmark: pgfId-7903580]data and configuration settings related to Snort on the appliance
 
    [bookmark: pgfId-7903582]Hardware Performance and Logs
 
    [bookmark: pgfId-7903584]data and logs related to the performance of the appliance hardware
 
    [bookmark: pgfId-7903586]System Configuration, Policy, and Logs
 
    [bookmark: pgfId-7903588]configuration settings, data, and logs related to the current system configuration of the appliance
 
    [bookmark: pgfId-7903590]Detection Configuration, Policy, and Logs
 
    [bookmark: pgfId-7903592]configuration settings, data, and logs related to detection on the appliance
 
    [bookmark: pgfId-7903594]Interface and Network Related Data
 
    [bookmark: pgfId-7903596]configuration settings, data, and logs related to inline sets and network configuration of the appliance
 
    [bookmark: pgfId-7903598]Discovery, Awareness, VDB Data, and Logs
 
    [bookmark: pgfId-7903600]configuration settings, data, and logs related to the current discovery and awareness configuration on the appliance
 
    [bookmark: pgfId-7903602]Upgrade Data and Logs
 
    [bookmark: pgfId-7903604]data and logs related to prior upgrades of the appliance
 
    [bookmark: pgfId-7903606]All Database Data
 
    [bookmark: pgfId-7903608]all database-related data that is included in a troubleshoot report
 
    [bookmark: pgfId-7903610]All Log Data
 
    [bookmark: pgfId-7903612]all logs collected by the appliance database
 
    [bookmark: pgfId-7903614]Network Map Information
 
    [bookmark: pgfId-7903616]current network topology data
 
   
 
   [bookmark: pgfId-7903618]Note that some options overlap in terms of the data they report, but the troubleshooting files will not contain redundant copies, regardless of what options you select.
 
   [bookmark: pgfId-7903619]For more information, see the following sections:
 
    
     
     	 [bookmark: pgfId-7903623]Generating Appliance Troubleshooting Files
 
     	 [bookmark: pgfId-7903627]Downloading Troubleshooting Files
 
    
 
   
 
    
     [bookmark: pgfId-7903629][bookmark: 92961]Generating Appliance Troubleshooting Files
 
    [bookmark: pgfId-7903633]License: Any
 
    [bookmark: pgfId-7903634]Use the following procedure to generate customized troubleshooting files that you can send to Support. 
 
    [bookmark: pgfId-7903645]To generate troubleshooting files:
 
    
 
    [bookmark: pgfId-7903945]Step 1 In ASDM, select Configuration > ASA FirePOWER Configuration > Tools > Troubleshooting.
 
    [bookmark: pgfId-7903656]Step 2 Click Generate Troubleshooting Files.
 
    [bookmark: pgfId-7903657]The Troubleshooting Options pop-up window appears.
 
    [bookmark: pgfId-7903658]Step 3 Select All Data to generate all possible troubleshooting data, or select individual check boxes to customize your report. For more information, see the Selectable Troubleshoot Options table.
 
    [bookmark: pgfId-7903662]Step 4 Click OK.
 
    [bookmark: pgfId-7903666]The ASA FirePOWER module generates the troubleshooting files. You can monitor the file generation process in the task queue (Monitoring > ASA FirePOWER Monitoring > Task Status).
 
    [bookmark: pgfId-7903670]Step 5 Continue with the procedure in the next section, Downloading Troubleshooting Files.
 
    [bookmark: pgfId-7903671]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7903673][bookmark: 54370]Downloading Troubleshooting Files
 
    [bookmark: pgfId-7903677]License: Any
 
    [bookmark: pgfId-7903678]Use the following procedure to download copies of your generated troubleshooting files.
 
    [bookmark: pgfId-7903679]To download troubleshooting files:
 
    
 
    [bookmark: pgfId-7903684]Step 1 In ASDM, select Monitoring > ASA FirePOWER Monitoring > Task Status.
 
    [bookmark: pgfId-7903685]The Task Status page appears.
 
    [bookmark: pgfId-7903686]Step 2 Find the task that corresponds to the troubleshooting files you generated.
 
    [bookmark: pgfId-7903687]Step 3 After the appliance generates the troubleshooting files and the task status changes to Completed, click Click to retrieve generated files.
 
    [bookmark: pgfId-7903688]Step 4 Follow your browser’s prompts to download the files. 
 
    [bookmark: pgfId-7903689]The files are downloaded in a single .tar.gz file.
 
    [bookmark: pgfId-7903693]Step 5 Follow the directions from Support to send the troubleshooting files to Cisco.
 
    [bookmark: pgfId-7903694]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7757460]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7891710][bookmark: 56385]Importing and[bookmark: marker-7891708] Exporting Configurations 
      
      
 
     
 
 
    [bookmark: pgfId-7882069]You can use the Import/Export feature to copy several types of configurations, including policies, from one appliance to another appliance of the same type. Configuration import and export is not intended as a backup tool, but can be used to simplify the process of adding new ASA FirePOWER modules.
 
    [bookmark: pgfId-7742978]You can import and export the following configurations:
 
     
     	 [bookmark: pgfId-7864168]access control policies and their associated network analysis and file policies
 
     	 [bookmark: pgfId-7899453]intrusion policies
 
     	 [bookmark: pgfId-7899481]system policies
 
     	 [bookmark: pgfId-7864152]alert responses
 
    
 
    [bookmark: pgfId-7832678]To import an exported configuration, both ASA FirePOWER modules must be running the same software version. To import an exported intrusion or access control policy, the rule update versions on both appliances must also match.
 
    [bookmark: pgfId-7832685]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7832689]Exporting Configurations
 
     	 [bookmark: pgfId-5908582]Importing Configurations
 
    
 
   
 
    
     [bookmark: pgfId-7889770][bookmark: 89678]Exporting[bookmark: marker-7889769] Configurations
 
    [bookmark: pgfId-7889771]License: Any
 
    [bookmark: pgfId-7914160]You can export a single configuration, or you can export a set of configurations (of the same type or of different types) at once. When you later import the package onto another appliance, you can choose which configurations in the package to import.
 
    [bookmark: pgfId-7914161]When you export a configuration, the appliance also exports revision information for that configuration. The ASA FirePOWER module uses that information to determine whether you can import that configuration onto another appliance; you cannot import a configuration revision that already exists on an appliance.
 
    [bookmark: pgfId-7868280]In addition, when you export a configuration, the appliance also exports system configurations that the configuration depends on.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7868313]You can export the following configurations:
 
    
    	 [bookmark: pgfId-7843329] Alert responses — An alert response is a set of configurations that allows the ASA FirePOWER module to interact with the external system where you plan to send the alert.
 
    	 [bookmark: pgfId-7843334] Access control policies — Access control policies include a variety of components that you can configure to determine how the system manages traffic on your network. These components include access control rules; associated intrusion, file, and network analysis policies; and objects the rules and policies use, including intrusion variable sets. Exporting an access control policy exports all settings and components for the policy except (where present) URL reputations and categories, which are equivalent across appliances and which users cannot change. Note that to import an access control policy, the rule update version on the exporting and importing ASA FirePOWER module must match.
 
   
 
   [bookmark: pgfId-7885176]If an access control policy that you export contains rules that reference geolocation data, the importing module’s geolocation database (GeoDB) update version is used.
 
    
    	 [bookmark: pgfId-7865137] Intrusion policies — Intrusion policies include a variety of components that you can configure to inspect your network traffic for intrusions and policy violations. These components are intrusion rules that inspect the protocol header values, payload content, and certain packet size characteristics, and other advanced settings.
 
   
 
   [bookmark: pgfId-7899250]Exporting an intrusion policy exports all settings for the policy. For example, if you choose to set a rule to generate events, or if you set SNMP alerting for a rule, or if you turn on the sensitive data preprocessor in a policy, those settings remain in place in the exported policy. Custom rules, custom rule classifications, and user-defined variables are also exported with the policy.
 
   [bookmark: pgfId-7899251]Note that if you export an intrusion policy that uses a layer that is shared by a second intrusion policy, that shared layer is copied into the policy you are exporting and the sharing relationship is broken. When you import the intrusion policy on another appliance, you can edit the imported policy to suit your needs, including deleting, adding, and sharing layers.
 
   [bookmark: pgfId-7912263]If you export an intrusion policy from one ASA FirePOWER module to another, the imported policy may behave differently if the second ASA FirePOWER module has differently configured default variables.
 
    
     
   
 
   
 
   [bookmark: pgfId-7843336]Note You cannot use the Import/Export feature to update rules created by the Vulnerability Research Team (VRT). Instead, download and apply the latest rule update version; see Importing Rule Updates and Local Rule Files.
 
    
    
 
   
 
   
 
    
    	 [bookmark: pgfId-7871587] System policies — A system policy controls the aspects of an ASA FirePOWER module that are likely to be similar to other ASA FirePOWER modules in your deployment, including time settings, SNMP settings, and so on.
 
   
 
    
     
   
 
   
 
   [bookmark: pgfId-7779373]Note Depending on the number of configurations being exported and the number of objects those configurations reference, the export process may take several minutes.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7889868]To export one or more configurations:
 
   
 
   [bookmark: pgfId-7904436]Step 1 Make sure that the ASA FirePOWER module where you are exporting the configurations and the ASA FirePOWER module where you plan to import the configurations are running the same version. If you are exporting an intrusion or access control policy, make sure that the rule update versions match.
 
   [bookmark: pgfId-7791764]If the versions of the ASA FirePOWER module (and, if applicable, the rule update versions) do not match, the import will fail.
 
   [bookmark: pgfId-5907628]Step 2 Select Configuration > ASA FirePOWER Configuration > Tools > Import Export.
 
   [bookmark: pgfId-5907629]The Import/Export page appears, including a list of the configurations on the ASA FirePOWER module. Note that configuration categories with no configurations to export do not appear in this list.
 
    
     
   
 
   
 
   
 
   [bookmark: pgfId-7822292]Step 3 Select the check boxes next to the configurations you want to export and click Export.
 
   [bookmark: pgfId-6048117]Step 4 Follow the prompts to save the exported package to your computer.
 
   [bookmark: pgfId-7891867]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7811316][bookmark: 12026]Importing[bookmark: marker-7811315] Configurations
 
    [bookmark: pgfId-7811342]License: Any
 
    [bookmark: pgfId-7811318]After you export a configuration from an appliance, you can import it onto a different appliance as long as that appliance supports it.
 
    [bookmark: pgfId-7754532]Depending on the type of configuration you are importing, you should keep the following points in mind:
 
     
     	 [bookmark: pgfId-7792694]You must make sure that the ASA FirePOWER module where you import a configuration is running the same version as the ASA FirePOWER module you used to export the configuration. If you are importing an intrusion or access control policy, the rule update versions on both appliances must also match. If the versions do not match, the import will fail.
 
     	 [bookmark: pgfId-7902206]If you import an access control policy that evaluates traffic based on zones, you must map the zones in the imported policy to zones on the importing ASA FirePOWER module. When you map zones, their types must match. Therefore, you must create any zone types you need on the importing ASA FirePOWER module before you begin the import. For more information about security zones, see Working with Security Zones.
 
     	 [bookmark: pgfId-7883300]If you import an access control policy that includes an object or object group that has an identical name to an existing object or group, you must rename the object or group.
 
     	 [bookmark: pgfId-7887114]If you import an access control policy or an intrusion policy, the import process replaces existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved.
 
     	 [bookmark: pgfId-7754279]If you import an intrusion policy that used a shared layer from a second intrusion policy, the export process breaks the sharing relationship and the previously shared layer is copied into the package. In other words, imported intrusion policies do not contain shared layers. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7804937]Note You cannot use the Import/Export feature to update rules created by the Vulnerability Research Team (VRT). Instead, download and apply the latest rule update version; see Importing Rule Updates and Local Rule Files.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7841063]ASA FirePOWER moduleBecause you can export several configurations in a single package, when you import the package you must choose which configurations in the package to import.
 
    [bookmark: pgfId-7883539]When you attempt to import a configuration, your ASA FirePOWER module determines whether that configuration already exists on the appliance. If a conflict exists, you can:
 
     
     	 [bookmark: pgfId-7883589]keep the existing configuration,
 
     	 [bookmark: pgfId-7883596]replace the existing configuration with a new configuration,
 
     	 [bookmark: pgfId-7883599]keep the newest configuration, or
 
     	 [bookmark: pgfId-7883602]import the configuration as a new configuration.
 
    
 
    [bookmark: pgfId-7883610]If you import a configuration and then later make a modification to the configuration on the destination system, and then re-import the configuration, you must choose which version of the configuration to keep.
 
    [bookmark: pgfId-7817209]Depending on the number of configurations being imported and the number of objects those configurations reference, the import process may take several minutes.
 
    [bookmark: pgfId-7749482]To import one or more configurations:
 
    
 
    [bookmark: pgfId-7791624]Step 1 Make sure that the ASA FirePOWER module where you are exporting the configurations and the module where you plan to import the configurations are running the same version. If you want to import an intrusion or access control policy, you must also make sure that the rule update versions match.
 
    [bookmark: pgfId-7791631]If the versions of the ASA FirePOWER module (and, if applicable, the rule update versions) do not match, the import will fail.
 
    [bookmark: pgfId-6583219]Step 2 Export the configurations you want to import; see Exporting Configurations.
 
    [bookmark: pgfId-5908222]Step 3 On the appliance where you want to import the configurations, select Configuration > ASA FirePOWER Configuration > Tools > Import Export.
 
    [bookmark: pgfId-5909446]The Import Export page appears.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7822930]Step 4 Click Upload Package.
 
   [bookmark: pgfId-5909462]The Upload Package page appears.
 
   [bookmark: pgfId-5909463]Step 5 You have two options:
 
    
     
     	 [bookmark: pgfId-6048429]Type the path to the package you want to upload.
 
     	 [bookmark: pgfId-6048436]Click  Upload File to locate the package.
 
    
 
   
 
   [bookmark: pgfId-5909469]Step 6 Click Upload. 
 
   [bookmark: pgfId-7749435]The result of the upload depends on the contents of the package:
 
    
     
     	 [bookmark: pgfId-7749446]If the configurations in the package exactly match versions that already exist on your appliance, a message displays indicating that the versions already exist. The appliance has the most recent configurations, so you do not need to import them.
 
     	 [bookmark: pgfId-7749447]If there is an ASA FirePOWER module or (if applicable) rule update version mismatch between your appliance and the appliance where the package was exported, a message appears, indicating that you cannot import the package. Update the ASA FirePOWER module or the rule update version and attempt the process again.
 
     	 [bookmark: pgfId-5909538]If the package contains any configurations or rule versions that do not exist on your appliance, the Package Import page appears. Continue with the next step.
 
    
 
   
 
   [bookmark: pgfId-5914626]Step 7 [bookmark: 57560]Select the configurations you want to import and click Import.
 
   [bookmark: pgfId-5909683]The import process resolves, with the following results: 
 
    
     
     	 [bookmark: pgfId-5914084]If the configurations you import do not have previous revisions on your ASA FirePOWER module, the import completes automatically and a success message appears. Skip the rest of the procedure.
 
     	 [bookmark: pgfId-7847893]If you are importing an access control policy that includes security zones, the Access Control Import Resolution page appears. Continue with step 8.
 
     	 [bookmark: pgfId-6786106]If the configurations you import do have previous revisions on your appliance, the Import Resolution page appears. Continue with step 9.
 
    
 
   
 
   [bookmark: pgfId-7844235]Step 8 [bookmark: 76031]Next to each incoming security zone, select an existing local security zone of a matching type to map to and click Import.
 
   [bookmark: pgfId-7844410]Return to step 7.
 
   [bookmark: pgfId-7844245]Step 9 [bookmark: 29845]Expand each configuration and select the appropriate option:
 
    
     
     	 [bookmark: pgfId-7844236]To keep the configuration on your appliance, select  Keep existing .
 
     	 [bookmark: pgfId-5914114]To replace the configuration on your appliance with the imported configuration, select  Replace existing .
 
     	 [bookmark: pgfId-5914123]To keep the newest configuration, select  Keep newest .
 
     	 [bookmark: pgfId-7846540]To save the imported configuration as a new configuration, select  Import as new and, optionally, edit the configuration name.
 
    
 
   
 
   [bookmark: pgfId-7878275]If you are importing an access control policy that includes a file policy with either the clean list or custom detection list enabled, the Import as new option is not available.
 
    
     
     	 [bookmark: pgfId-7846541]If you are importing an access control policy or saved search that includes a dependent object, either accept the suggested name or rename the object. The system always imports these dependent objects as new. You do not have the option to keep or to replace existing objects. Note that the system treats objects and object groups in the same manner.
 
    
 
   
 
   [bookmark: pgfId-7844911]Step 10 Click Import.
 
   [bookmark: pgfId-5918872]The configurations are imported.
 
   [bookmark: pgfId-7891873]
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7757460]
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7707637][bookmark: 79376]Viewing the Status of Long-Runn[bookmark: marker-5488702]ing Tasks 
      
      
 
     
 
 
    [bookmark: pgfId-7730125]Some tasks that you can perform on the ASA FirePOWER module, such as applying a policy or installing updates, do not complete instantly and require some time to run. You can check the progress of these long-running tasks in the task queue. The task queue also reports when they are successfully or unsuccessfully resolved.
 
    [bookmark: pgfId-7708932]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7709212]Viewing the Task Queue
 
     	 [bookmark: pgfId-7709277]Managing the Task Queue
 
    
 
   
 
    
     [bookmark: pgfId-7708951][bookmark: 37691]Viewing the Task Q[bookmark: marker-7712776]ueue
 
    [bookmark: pgfId-7722540]License: Any
 
    [bookmark: pgfId-7709557]When you perform long-running tasks, such as applying a policy or installing updates, the status of these tasks is reported in the task queue. The task queue provides information about complex tasks and reports when they are complete.
 
    [bookmark: pgfId-7722545]You view the task queue on the Task Status page, which automatically refreshes every 10 seconds. 
 
    [bookmark: pgfId-7715685]The Job Summary section displays the state of the tasks listed on the page, as described in the following table.
 
    [bookmark: pgfId-7715327]
 
     
      
       
       [bookmark: pgfId-7725962]Table C-1 [bookmark: 84902]Task Queue Task Types 
 
       
       
        
        	 
          
          [bookmark: pgfId-7725966]Task Type 
         
  
        	 
          
          [bookmark: pgfId-7725968]Description 
         
  
       
 
        
        	[bookmark: pgfId-7725970]Running
  
        	[bookmark: pgfId-7725972]The number of tasks currently in progress.
  
       
 
        
        	[bookmark: pgfId-7725974]Waiting
  
        	[bookmark: pgfId-7725976]The number of tasks waiting for an in-progress task to complete before running.
  
       
 
        
        	[bookmark: pgfId-7725978]Completed
  
        	[bookmark: pgfId-7725980]The number of tasks that completed successfully.
  
       
 
        
        	[bookmark: pgfId-7725982]Retrying
  
        	[bookmark: pgfId-7725984]The number of tasks that are automatically retrying. Note that not all tasks are permitted to try again.
  
       
 
        
        	[bookmark: pgfId-7731189]Stopped
  
        	[bookmark: pgfId-7731191]The number of tasks that were interrupted due to a system update. Stopped tasks cannot be resumed; you must manually delete them from the task queue.
  
       
 
        
        	[bookmark: pgfId-7725986]Failed
  
        	[bookmark: pgfId-7725988]The number of tasks that did not complete successfully.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-7725280]The Jobs section provides information about each task, including a brief description, when the task was launched, the current status of the task, and when the status last changed. Tasks of the same type appear together in a task group.
 
    [bookmark: pgfId-7715328]To make sure that the Task Status page loads quickly, once per week, the ASA FirePOWER module removes from the queue all completed, failed, and stopped tasks that are over a month old, as well the oldest tasks from any task group that contains over 1000 tasks. You can also manually remove tasks from the queue; see Managing the Task Queue for directions.
 
    [bookmark: pgfId-7715332]To view the task queue:
 
    
 
    [bookmark: pgfId-4761129]Step 1 You have two options:
 
     
      
      	 [bookmark: pgfId-4761130]If you manually launched the task, click the  Task Status  link in the notification box that appeared when you launched the task.
 
     
 
    
 
    [bookmark: pgfId-4761131]The Task Status page appears in a pop-up window.
 
     
      
      	 [bookmark: pgfId-7737859]If you scheduled a task, or if a task was launched from a page you are not viewing, select  Monitoring > ASA FirePOWER Monitoring > Task Status .
 
     
 
    
 
    [bookmark: pgfId-7737860]The Task Status page appears.
 
    [bookmark: pgfId-7710498]For information on the actions you can perform on the Task Status page, see Managing the Task Queue.
 
    [bookmark: pgfId-7735318]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7708970][bookmark: 17166]Managing the Task Queu[bookmark: marker-7712781]e
 
    [bookmark: pgfId-7722578]License: Any
 
    [bookmark: pgfId-7727095]There are several actions you can perform while viewing the task queue (see Viewing the Task Queue), as described in the following table.
 
    [bookmark: pgfId-7727188]
 
     
     
 
     [bookmark: pgfId-7727257]Note that you cannot delete a running task. If you need to delete a running task (for example, if a task repeatedly fails), contact Support.
 
     
 
     
 
      
       
       [bookmark: pgfId-7727203]Table C-2 Task Queue Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7727239]To... 
         
  
        	 
          
          [bookmark: pgfId-7727241]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7727243]remove all completed tasks from the task queue
  
        	[bookmark: pgfId-7727245]click Remove Completed Jobs.
  
       
 
        
        	[bookmark: pgfId-7727247]remove all failed tasks from the task queue
  
        	[bookmark: pgfId-7727249]click Remove Failed Jobs.
  
       
 
        
        	[bookmark: pgfId-7727251]remove a single task from the task queue
  ) next to the task you want to delete. 
       
 
        
        	[bookmark: pgfId-7727262]collapse a task group and hide tasks
  ) next to the expanded task group. 
       
 
        
        	[bookmark: pgfId-7727269]expand a task group and view tasks
  ) next to the collapsed task group. 
       
 
       
     
 
    
 
    [bookmark: pgfId-7727142]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7735646][bookmark: 89960][bookmark: marker-7735645]Security, Internet Access, and Communication Ports 
      
      
 
     
 
 
    [bookmark: pgfId-7735652]To safeguard the ASA FirePOWER module, you should install it on a protected internal network. Although the ASA FirePOWER module is configured to have only the necessary services and ports available, you must make sure that attacks cannot reach it from outside the firewall.
 
    [bookmark: pgfId-7742860]Also note that specific features of the ASA FirePOWER module require an Internet connection. By default, the ASA FirePOWER module is configured to directly connect to the Internet. Additionally, the system requires certain ports remain open for secure appliance access and so that specific system features can access the local or Internet resources to operate correctly.
 
    [bookmark: pgfId-7733073]For more information, see:
 
     
     	 [bookmark: pgfId-7733077]Internet Access Requirements
 
     	 [bookmark: pgfId-7733081]Communication Ports Requirements
 
    
 
   
 
    
     [bookmark: pgfId-7733083][bookmark: 66695]Internet Access Requirements
 
    [bookmark: pgfId-7733087]By default, the ASA FirePOWER module is configured to directly connect to the Internet on ports 443/tcp (HTTPS) and 80/tcp (HTTP), which are open by default on the ASA FirePOWER module; see Communication Ports Requirements.
 
     
     [bookmark: pgfId-7743004]Feature 
    
 
     
     [bookmark: pgfId-7743006]Internet access is required to... 
    
 
    [bookmark: pgfId-7743030]intrusion rule, VDB, and GeoDB updates
 
    [bookmark: pgfId-7743032]download or schedule the download of a intrusion rule, GeoDB, or VDB update directly to an appliance.
 
    [bookmark: pgfId-7743034]network-based AMP
 
    [bookmark: pgfId-7743036]perform malware cloud lookups.
 
    [bookmark: pgfId-7743045]Security Intelligence filtering
 
    [bookmark: pgfId-7743047]download Security Intelligence feed data from an external source, including the Intelligence Feed.
 
    [bookmark: pgfId-7743049]system software updates
 
    [bookmark: pgfId-7743051]download or schedule the download of a system update directly to an appliance.
 
    [bookmark: pgfId-7743053]URL filtering
 
    [bookmark: pgfId-7743055]download cloud-based URL category and reputation data for access control, and perform lookups for uncategorized URLs.
 
    [bookmark: pgfId-7743057]whois
 
    [bookmark: pgfId-7743059]request whois information for an external host.
 
   
 
    
     [bookmark: pgfId-7733280][bookmark: 15750]Communication Ports Requirements
 
    [bookmark: pgfId-7733281] Open ports allow:
 
     
     	 [bookmark: pgfId-7733282]access to an appliance’s user interface
 
     	 [bookmark: pgfId-7733283]secure remote connections to an appliance
 
     	 [bookmark: pgfId-7733284]certain features of the system to access the local or Internet resources they need to function correctly
 
    
 
    [bookmark: pgfId-7733285]In general, feature-related ports remain closed until you enable or configure the associated feature.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7733295] 
     Caution Do 
     not close an open port until you understand how this action will affect your deployment. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7733296]For example, closing port 25/tcp (SMTP) outbound on a manage device blocks the device from sending email notifications for individual intrusion events (see Configuring External Alerting for Intrusion Rules).
 
    [bookmark: pgfId-7733328]The following table lists the open ports required so that you can take full advantage of ASA FirePOWER module features.
 
     
      [bookmark: pgfId-7734516]
 
      
       
        
        [bookmark: pgfId-7743384]Table D-2 [bookmark: 98142]Default Communication Ports for ASA FirePOWER module Features and Operations 
 
        
        
         
         	 
           
           [bookmark: pgfId-7743393]Port 
          
  
         	 
           
           [bookmark: pgfId-7743395]Description 
          
  
         	 
           
           [bookmark: pgfId-7743397]Direction 
          
  
         	 
           
           [bookmark: pgfId-7743399]Is Open to... 
          
  
        
 
         
         	[bookmark: pgfId-7743401]22/tcp
  
         	[bookmark: pgfId-7743403]SSH/SSL
  
         	[bookmark: pgfId-7743405]Bidirectional
  
         	[bookmark: pgfId-7743407]allow a secure remote connection to the appliance.
  
        
 
         
         	[bookmark: pgfId-7743409]25/tcp
  
         	[bookmark: pgfId-7743411]SMTP
  
         	[bookmark: pgfId-7743413]Outbound
  
         	[bookmark: pgfId-7743415]send email notices and alerts from the appliance.
  
        
 
         
         	[bookmark: pgfId-7743417]53/tcp
  
         	[bookmark: pgfId-7743419]DNS
  
         	[bookmark: pgfId-7743421]Outbound
  
         	[bookmark: pgfId-7743423]use DNS.
  
        
 
         
         	[bookmark: pgfId-7743425]67/udp
 [bookmark: pgfId-7743426]68/udp
  
         	[bookmark: pgfId-7743428]DHCP
  
         	[bookmark: pgfId-7743430]Outbound
  
         	[bookmark: pgfId-7743432]use DHCP.
 by default.
  
        
 
         
         	[bookmark: pgfId-7743444]
  
         	[bookmark: pgfId-7743446]
  
         	[bookmark: pgfId-7743448]Bidirectional
  
         	[bookmark: pgfId-7743450]update custom and third-party Security Intelligence feeds via HTTP.
 [bookmark: pgfId-7743451]download URL category and reputation data (port 443 also required).
  
        
 
         
         	[bookmark: pgfId-7743453]161/udp
  
         	[bookmark: pgfId-7743455]SNMP
  
         	[bookmark: pgfId-7743457]Bidirectional
  
         	[bookmark: pgfId-7743459]allow access to an appliance’s MIBs via SNMP polling.
  
        
 
         
         	[bookmark: pgfId-7743461]162/udp
  
         	[bookmark: pgfId-7743463]SNMP
  
         	[bookmark: pgfId-7743465]Outbound
  
         	[bookmark: pgfId-7743467]send SNMP alerts to a remote trap server.
  
        
 
         
         	[bookmark: pgfId-7743469]389/tcp
 [bookmark: pgfId-7743470]636/tcp
  
         	[bookmark: pgfId-7743472]LDAP
  
         	[bookmark: pgfId-7743474]Outbound
  
         	[bookmark: pgfId-7743476]communicate with an LDAP server for external authentication.
  
        
 
         
         	[bookmark: pgfId-7743478]389/tcp
 [bookmark: pgfId-7743479]636/tcp
  
         	[bookmark: pgfId-7743481]LDAP
  
         	[bookmark: pgfId-7743483]Outbound
  
         	[bookmark: pgfId-7743485]obtain metadata for detected LDAP users.
  
        
 
         
         	[bookmark: pgfId-7743487]443/tcp
  
         	[bookmark: pgfId-7743489]HTTPS
  
         	[bookmark: pgfId-7743491]Inbound
  
         	[bookmark: pgfId-7743493]access an appliance’s user interface.
  
        
 
         
         	[bookmark: pgfId-7743495]443/tcp
  
         	[bookmark: pgfId-7743497]HTTPS
 [bookmark: pgfId-7743499]cloud comms.
  
         	 [bookmark: pgfId-7743501]Bidirectional
  
         	[bookmark: pgfId-7743503]obtain:
 
           
           	 [bookmark: pgfId-7743504]software, intrusion rule, VDB, and GeoDB updates
 
           	 [bookmark: pgfId-7743505]URL category and reputation data (port 80 also required)
 
           	 [bookmark: pgfId-7743506]the Intelligence Feed and other secure Security Intelligence feeds
 
           	 [bookmark: pgfId-7743511]malware dispositions for files detected in network traffic
 
          
  
        
 
         
         	[bookmark: pgfId-7743514]
  
         	[bookmark: pgfId-7743516]
  
         	[bookmark: pgfId-7743520]download software updates using the device’s localuser interface.
  
        
 
         
         	[bookmark: pgfId-7743530]514/udp
  
         	[bookmark: pgfId-7743532]syslog 
  
         	[bookmark: pgfId-7743534]Outbound
  
         	[bookmark: pgfId-7743536]send alerts to a remote syslog server.
  
        
 
         
         	[bookmark: pgfId-7743586]8305/tcp
  
         	[bookmark: pgfId-7743588]appliance comms.
  
         	[bookmark: pgfId-7743590]Bidirectional
  
         	[bookmark: pgfId-7743592]securely communicate between appliances in a deployment. Required.
  
        
 
         
         	[bookmark: pgfId-7743594]8307/tcp
  
         	[bookmark: pgfId-7743596]host input client
  
         	[bookmark: pgfId-7743598]Bidirectional
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      [bookmark: pgfId-999712]Version 6.0.0
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